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À propos de cet ouvrage de référence

Cet ouvrage de référence est un guide complet de toutes les fonctions de Sibelius. Pour comprendre

les fonctions de base de Sibelius et se familiariser avec le programme, il est recommandé de

commencer avec le Manuel ou le livret Mise à jour vers Sibelius 6 si vous avez déjà utilisé une

version antérieure de Sibelius.

L’ouvrage de référence peut être consulté à l’écran, et sous forme de livre qui peut être acheté

directement chez Sibelius ou auprès du distributeur de votre pays.(www.sibelius.com/buy).

Dans les deux cas, il s’agit du même texte.

Chapitres et rubriques
Cet ouvrage de référence est divisé en neuf chapitres divisés eux-mêmes en rubriques plus petites.

La liste de toutes les rubriques se trouve dans la Table des matières, mais l’Index sera

probablement plus utile pour rechercher des informations sur des points précis du programme.

Consultez l’Index visuel si vous avez une idée de ce que vous cherchez sans savoir comment cela

s’appelle. Le Glossaire explique des termes musicaux et techniques.

Utiliser les références à l’écran
Pour lancer référence à l’écran, cliquez sur le bouton de la barre d’outils illustré à droite, ou

choisissez Aide > Documentation > Référence de Sibelius (raccourci F1 ou X?).

Selon l’application utilisée par votre ordinateur pour visualiser les fichiers PDF – sous Windows,

c’est normalement Adobe Reader, et sur Mac en général c’est Preview – les références apparaîtront

à l’écran. Pour naviguer, utiliser les liens et les fonctions internes Éditer > Rechercher de Adobe

Reader et de Preview.

Les liens sont semblables à la table des matières d’un document que vous lisez, et permettent

d’aller à n’importe quel chapitre, rubrique ou sous-rubrique des références. Pour afficher les liens:

* Dans Adobe Reader, choisissez Affichage > Panneau de navigation > Signets; un panneau tel

que celui illustré ci-dessous apparaîtra à gauche de votre écran

* Dans Preview sur Mac, choisissez Affichage > Tiroir; un panneau comme celui illustré ci-

dessous à droite se déroulera à droite de la fenêtre.

http://www.sibelius.com/buy
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Pour faire des recherches dans les références à l’écran, vous pouvez choisir soit la fonction Éditer >

Rechercher, ou :

* Dans Adobe Reader, tapez dans le cadre Rechercher dans la barre d’outils telle qu’illustrée ci-

dessous à gauche, puis utilisez les boutons en arrière et en avant pour passer aux résultats

précédents ou suivants

* Dans Preview sur Mac, tapez dans la boîte du Rechercher du Tiroir, affiché ci-dessous à droite,

puis cliquez dans la liste verticale des résultats.

Renvois
b 4.3 Ligatures signifie “consultez la rubrique Ligatures du chapitre 4 de l’ouvrage de

référence”.

Consultez le manuel séparé pour en savoir plus sur les autres conventions de typographie et la

terminologie utilisées.
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Saisie

1.1 Saisie des notes

b 1.3 Fenêtre Clavier, 1.4 Flexi-time™, 1.7 Saisie de tablature de guitare,

1.8 Fenêtre Manche, 2.1 Altérations, 2.3 Articulations, 2.6 Groupement des
ligatures, 2.14 Notes ornementales, 2.25 Têtes de note, 2.30 Hampes et lignes
supplémentaires, 2.34 Trémolos, 2.35 Triolets et autres multiplets, 2.36 Voix,

8.9 L’espacement entre les notes.

Il y a six manières de créer et de modifier des notes, des accords et des silences:

* La saisie à la souris – cf. ci-dessous

* La saisie alphabétique et la saisie en mode pas-à-pas – cf. ci-dessous

* La saisie en mode Flexi-time – b 1.4 Flexi-time™

* L’importation de fichiers provenant d’autres programmes (par ex. des fichiers MIDI et

MusicXML) – b 9.5 Ouvrir des fichiers MIDI, 9.6 Ouvrir des fichiers MusicXML

* La numérisation de musique imprimée – b 1.5 Numérisation.

* Chanter ou jouer dans un microphone – b 1.6 Entrée audio.

La plupart de ces méthodes sont abordées dans le Manuel. Cette rubrique est un résumé détaillé de

la saisie à la souris, en mode pas-à-pas et en mode alphabétique.

Saisie alphabétique et saisie en mode pas-à-pas
La saisie alphabétique (au clavier de l’ordinateur) et la saisie en mode pas-à-pas (clavier MIDI)

sont peut-être les manières les plus efficaces d’écrire de la musique dans Sibelius, car on peut créer

les autres objets (tels que les indications de mesure, les armures et le texte) au fur et à mesure.

Pour commencer la saisie alphabétique ou en mode pas-à-pas:

* Sélectionnez un silence (vous pouvez également sélectionner n’importe quoi d’autre, comme un

objet textuel ou une ligne, ce qui commencera la saisie de note à cet endroit)

* Choisissez Notes > Saisie de notes (raccourci N). Cela fera apparaître le signe d’insertion, une

ligne verticale dont la couleur varie en fonction de la voix pour laquelle vous faites la saisie).

* Choisissez une valeur de note sur le pavé (sauf si la valeur souhaitée est déjà sélectionnée)

* Si nécessaire, vous pouvez choisir d’autres indications dans les différentes formes du pavé:

% Altérations dans le premier ou le sixième pavé (inutile pour la saisie en mode pas-à-pas)

% articulations dans le premier ou le quatrième pavé

% liaisons et points rythmique dans le premier ou le deuxième pavé (celui-ci pour les doubles

points)

% Notes ornementales et de réplique dans le deuxième pavé 

% Tremolos et ligatures dans le troisième pavé

% Symboles de jazz et notes de réplique à partir du cinquième pavé

* Tous ces boutons restent enfoncés pour des notes successives jusqu’à ce que vous les choisissiez à

nouveau, à l’exception des altérations sur le premier et le sixième pavé. Cela signifie que vous

pouvez, par exemple, entrer plusieurs notes avec la même articulation.
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* Vous pouvez enfoncer des boutons sur plus d’une forme du pavé à la fois – ils seront tous

appliqués à la note / l’accord lorsque vous en ferez la saisie. (faites défiler les différents pavés en

appuyant sur la touche +; F7 sous Windows et – sur Mac vous ramène au premier pavé.)

* Entrez ensuite la note en:

% appuyant sur A–G ou R (qui répète la note / l’accord précédent, avec toutes les modifications

faites sur le pavé); ou

% jouez une note / un accord sur votre clavier MIDI

* Pour entrer un silence de la valeur de note sélectionnée, appuyez simplement sur 0 sur le

premier pavé (touche F7). (Pour continuer la saisie de silences de la même valeur de note,

continuez à appuyer sur 0.)

* Pour saisir une mesure complète de silence, appuyez sur 0 sur le deuxième pavé (touche F8).

* Retournez à la première étape pour entrer la note / l’accord suivant.

La note saisie peut faire l’objet de diverses opérations avant que la note suivante ne soit saisie:

* Pour corriger une erreur, vous pouvez modifier la hauteur de la note que vous avez entrée avec 3

ou 2; maintenez Ctrl ou X enfoncé pour changer la note d’octave

* Pour construire un accord en utilisant la saisie alphabétique, entrez une note de l’accord puis

ajoutez des notes supplémentaires de l’une des façons suivantes:

% maintenez Maj enfoncé et entrez la lettre correspondant à la note que vous souhaitez ajouter:

pour ajouter un Sol#, appuyez d’abord sur 8 sur le premier pavé pour sélectionner le dièse,

puis appuyez sur Maj-G pour ajouter la note; ou

% entrez un chiffre de 1–9 (à partir du clavier principal, pas du pavé) pour ajouter une note de

cet intervalle au-dessus de la note active: pour ajouter une note une sixte plus haut, appuyez

sur 6; Maj-1–9 ajoute des notes en dessous de la note active: Maj-4 ajoute une note une

quarte en dessous de la note active (de façon très pratique, cela fonctionne également pour

des passages sélectionnés, par ex. pour créer des octaves); ou

% choisissez l’option appropriée dans les sous-menus Notes > Ajouter la note ou Notes >

Ajouter l’intervalle, bien qu’il soit plus rapide d’utiliser les raccourcis décrits plus haut.

* Pour ajouter une liaison rythmique, appuyez sur Entrée sur le pavé numérique après avoir saisi

la note

* Pour créer un multiplet, appuyez sur Ctrl+2–9 ou X+2–9 (ou choisissez Insertion > Multiplet)

après avoir entré la première note du multiplet

* Pour écrire l’enharmonie d’une note (saisie sur un clavier MIDI par exemple), choisissez Notes >

Enharmonie (raccourci Retour sur le clavier principal) après l’avoir saisie.

Touches utiles
Un certain nombre de commandes très utiles sont à portée de main lorsque vous créez des notes:

* Si vous faites une erreur, appuyez sur Suppr ou Retour arrière, ce qui supprime la note et

sélectionne la note précédente.

(ce qui se produit exactement lorsque vous supprimez une note diffère subtilement en fonction

du contexte musical: si vous supprimez une note, elle est convertie en un silence d’une durée

identique; si vous supprimez un silence ou une mesure de silence, le signe d’insertion se placera
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après, le ou la laissant inchangé(e); si vous supprimez toutes les notes d’un multiplet, le crochet /

le chiffre du multiplet sera sélectionné – supprimez-le et il sera remplacé par un silence de la

durée du multiplet.)

* Vous pouvez également utiliser 0/1 pour vous déplacer entre les notes et les mesures de silence 

* Vous pouvez faire passer la note sélectionnée dans une autre voix en appuyant sur Alt+1/2/3/4
ou z1/2/3/4; vous pourriez donc sélectionner une note d’un accord en voix 1 et appuyez par

exemple sur Alt+2 ou z2 pour la faire passer en voix 2, la fusionnant éventuellement avec la /

les note(s) déjà présente(s) dans cette voix

* Pour ajouter une indication de mesure au cours de la création de notes, appuyez sur T et

choisissez-la dans la boîte de dialogue, puis appuyez sur Retour ou cliquez sur OK pour la créer

au début de la mesure suivante

* Pour ajouter un changement d’armure, appuyez sur K et choisissez l’armure appropriée dans la

boîte de dialogue puis appuyez sur Retour ou cliquez sur OK pour le créer au début de la mesure

suivante

* Pour ajouter du texte, tapez le raccourci habituel (ex. Ctrl+E ou XE pour texte d’expression),

puis entrez le texte souhaité; appuyez sur Échap pour revenir à la création de notes. Le texte est

créé à sa position par défaut au-dessus ou en dessous de la portée, à la même position

horizontale que la note qui était sélectionnée.

* Vous pouvez également ajouter n’importe quel autre objet à partir du menu Insertion pendant

la saisie de notes. Les symboles et les diagrammes d’accord, par exemple, apparaissent tous à

leur position par défaut au-dessus ou en dessous de la portée à la même position horizontale que

la note sélectionnée.

Pour les lignes (spécialement les liaisons de phrasé et les soufflets), seules celles qui ne durent

que deux notes peuvent être placées sans interrompre temporairement la saisie; cela est dû au

fait que l’extrémité droite de la ligne a besoin d’une note à laquelle s’attacher, et vous n’aurez

probablement pas encore entré cette note. Il est donc généralement plus facile de revenir ajouter

les lignes après avoir saisi un certain nombre de notes, par exemple une phrase complète

* Échap termine la saisie de notes (le signe d’insertion disparaît).

Saisie à la souris
La saisie à la souris est quasi identique à la saisie alphabétique et en mode pas-à-pas, excepté que

rien ne doit être sélectionné avant de commencer (appuyez sur Échap pour tout désélectionner):

* Choisissez Notes > Saisie de notes (raccourci N); le pointeur de souris change de couleur (il

devient bleu foncé, pour indiquer qu’il s’agit de la voix 1)

* Choisissez une valeur de note dans le premier pavé; vous pouvez également choisir des

altérations, des articulations, etc. dans les autres pavés (cf. ci-dessus). Pour créer un silence,

enfoncez le bouton de silence dans le premier pavé.

* Pendant que vous déplacez le pointeur au-dessus de la partition, une ombre apparaît, pour

indiquer où la note va être créée lorsque vous cliquerez. Lorsque vous déplacez le pointeur

verticalement au-dessus de la portée, les lignes supplémentaires nécessaires s’affichent; lorsque

vous déplacez le pointeur horizontalement le long d’une mesure, l’ombre de la note est comme

aimantée par les différents temps de la mesure (ce mécanisme est configurable – cf. Options
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pour la saisie des notes ci-dessous ). Fort utilement, l’ombre indique également le type de

tête de note de la note sur le point d’être créée, et les éventuelles altérations choisies.

* Pour entrer une note, cliquez simplement à l’endroit où vous souhaitez la créer

* Un signe d’insertion (une ligne verticale) apparaît dans la partition à la droite de la note créée –

vous pouvez soit commencer la saisie de notes en mode pas-à-pas ou en mode alphabétique, ou

sinon continuer simplement à cliquer dans la partition pour créer plus de notes, en modifiant la

valeur de note et ses autres attributs sur le pavé si nécessaire. Pour constituer un accord, cliquez

simplement au-dessus ou en dessous de la note juste créée. Si vous créez une note ailleurs dans la

mesure et revenez ensuite cliquer au-dessus ou en dessous d’une note existante afin de constituer

un accord, Sibelius supprime ce qui se trouve là et crée une nouvelle note à la place.

* Quand une note de valeur longue est placée en début d’une mesure, si, avant qu’elle ne soit finie,

une autre note est ajoutée, par défaut, Sibelius remplace la note longue par des silences; en

option il peut créer la note ajoutée en voix 2 – activez Utilisez la voix 2 en cas de conflit de
rythmes dans la page Souris de Fichier > Préférences (dans le menu Sibelius sur Mac)

* Pour entrer un silence, cliquez sur le bouton de silence (ou appuyez sur 0) sur le premier pavé

puis cliquez dans la partition

* Il n’est pas obligatoire, lors de la saisie à la souris, d’entrer les notes strictement de gauche à

droite – on peut passer d’un endroit à l’autre de la partition et entrer des notes où l’on veut.

Vous pouvez aussi utiliser la souris pour saisir des notes à l’aide du clavier à l’écran et de la fenêtre

des grilles d’accord – b 1.3 Fenêtre Clavier et b 1.8 Fenêtre Manche.

Réentrer les hauteurs de notes
Il est souvent utile de pouvoir modifier les hauteurs d’une séquence de notes/d’accords sans

recréer leur rythme. On utilisera cela principalement lors de l’écriture pour plusieurs instruments

qui jouent des notes différentes sur le même rythme – il suffit simplement de recopier la musique

d’un instrument et de refaire ensuite la saisie des hauteurs de note. Vous pouvez modifier la

hauteur de notes individuelles en utilisant la souris, les touches 3/2, les lettres A-G, ou en jouant

une note sur le clavier MIDI; cependant, pour refaire la saisie des hauteurs de note pour un passage

entier:

* Sélectionnez une note à partir de laquelle vous voulez refaire la saisie des hauteurs (soit avec la

souris, ou en l’atteignant avec les flèches)

* Choisissez Notes > Réentrer les hauteurs de notes (raccourci Ctrl+Maj+I ou xXI)

* Un signe d’insertion pointillé apparaît (plutôt que la ligne solide normale) pour indiquer que

Sibelius remplacera les hauteurs des note mais pas leur rythme

* Appuyez sur A–G (notes en anglais) ou jouez la nouvelle note (ou accord) sur le clavier MIDI

* Sibelius modifie la hauteur de la première note puis sélectionne la suivante (chevauchant

silences et notes ornementales éventuels) dont la hauteur pourra se modifier immédiatement.

* Si vous devez changer l’enharmonie d’une note resaisie, il suffit de choisir Notes > Enharmonie
(raccourci Retour sur le clavier principal) pour la réorthographier.

* Lorsque vous refaites la saisie des hauteurs de note à l’aide du clavier de l’ordinateur vous devez

entrer les altérations et les articulations après le nom de note, pas avant (contrairement à la saisie

de notes ou à la modification de notes individuelles)
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* Si aucune note particulière n’est à modifier, appuyez sur 0 sur le pavé pour passer à la suivante

* Pour transformer une note existante en un silence, appuyez sur 1 pour la sélectionner sans

modifier sa hauteur puis appuyez sur 0 sur le premier pavé (raccourci F7)

* Pour transformer un silence en une note, utilisez 1/0 pour vous déplacer jusqu’au silence, puis

entrez la hauteur souhaitée

* Cela fait, choisissez Notes > Réentrer les hauteurs de note à nouveau ou appuyez sur Échap
pour revenir dans la partition, ou encore, appuyez sur N pour continuer la saisie de notes.

Lorsque vous refaites la saisie des hauteurs de note, vous pouvez également construire des accords

à partir des notes existantes de la même manière que vous entrez des notes: sélectionnez une note

et appuyez soit sur Maj-A–G, soit sur 1–9 ou Shift-1–9 sur le clavier principal – cf. Saisie
alphabétique et saisie en mode pas-à-pas ci-dessus.

Modifier les valeurs de note, les altérations, les articulations, etc.
* Sélectionnez une note, un accord ou un silence (soit à la souris, ou avec les flèches)

* Pour modifier la valeur de note, choisissez simplement une nouvelle valeur de note sur le

premier ou le deuxième pavé.

Si la nouvelle valeur de note est plus longue que l’ancienne, les notes ultérieures seront

remplacées par des silences appropriés; si la nouvelle valeur de note est plus courte que

l’ancienne, des silences sont créés afin de correspondre à l’ancienne durée.

* Pour modifier les autres attributs de note, telles que les altérations ou les articulations, choisissez

simplement le bouton approprié sur le pavé, et la note sera instantanément adaptée (par exemple

cliquez # ou appuyez sur 8 pour ajouter un dièse à une note).

Notes > Enharmonie (raccourci Retour sur le clavier principal) écrit l’enharmonie d’une note –

cette commande n’est normalement nécessaire qu’après la saisie en mode pas-à-pas ou avec Flexi-

time ou lorsque vous modifiez un fichier MIDI importé.

Options pour la saisie des notes
La page Saisie des notes de la boîte de dialogue Fichier > Préférences (dans le menu Sibelius sur

Mac) propose différentes options concernant la saisie des notes:
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* Accords en pas-à-pas: il détermine la vitesse à laquelle vous devez jouer pour que Sibelius

interprète les notes comme un accord plutôt que comme un série de notes individuelles. Par

défaut le curseur est avancé du côté de Serré, qui est le réglage adéquat pour la saisie par clavier

MIDI (en général les accords y sont plutôt plaqués qu’égrénés), de sorte que si vous utilisez une

guitare MIDI, il vaudra mieux déplacer le curseur vers Relâché pour obtenir la position la

mieux adaptée à votre style de jeu.

* Transposition des portées: lorsque vous recopiez de la musique écrite en notes transposées, il

est utile de régler cette option sur Saisie en notes écrites; le réglage par défaut est Saisie en
notes réelles – cf. Les instruments transpositeurs á la page 152.

* Portées de percussion: vous pouvez faire la saisie de note sur des portées de percussions avec

votre clavier MIDI soit en utilisant les touches de votre clavier qui produisent le son correct, ou

en utilisant les hauteurs définies dans le type de portée de la portée sélectionnée –

b 2.26 Percussion.

* Les deux options de Modifier permettent de déterminer si Sibelius doit Jouer les notes en
cours de modification (par exemple chaque fois qu’une note est saisie, sélectionnée ou éditée)

et si Sibelius doit Rétablir les caractéristiques originales après sélection de mesure
simple. Si cette option est désactivée, Sibelius rétablira l’indication de mesure, l’armure ou la

clef d’origine à la fin de la sélection si celle-ci est plus longue qu’une mesure.

* Pour en savoir plus sur les options de doigtés de tablatures de guitare, b 1.7 Saisie de
tablature de guitare.

* Omission des fausses notes: Ces options empêche Sibelius d’écrire des valeurs trop courtes,

trop aiguës ou trop graves ou des notes trop faibles quand on réalise la saisie avec un clavier ou

une guitare MIDI:

% Les notes situées entre x et y: cette option est désactivée par défaut (parce que ces réglages

sont inadéquats pour d’autres périphériques d’entrée MIDI tels que les claviers), mais si vous

utilisez une guitare MIDI pour la saisie, activez cette option et indiquez les hauteurs des notes

extrêmes, la plus aiguë et la plus grave qui peuvent être écrites. Toute note jouée au-delà de

ces extrêmes sera ignorée.

% Notes avec des vélocités plus élevées que x: pour éviter que des notes à peine effleurées

par erreur soient écrites, ajustez la vélocité minimum. Jouez quelques notes le plus

doucement possible sur votre guitare; quand une note dépasse le seuil minimum, le petit

indicateur noir de la boîte de dialogue s’allume. Réglez-en la valeur pour que ce seuil accepte

la note la plus douce que vous souhaitez écrire.

% Notes plus longues que x impulsions: pour éviter que des notes trop courtes soient notées

involontairement, ajustez la longueur minimum. 256 impulsions = 1 noire, de sorte que la

valeur par défaut de 10 impulsions est un peu plus courte que la quintuple croche. S’il vous

semble que jamais vous n’utilisez cette valeur, faites un réglage plus élevé.

Masquer des notes
Il est parfois utile de masquer des notes exécutées, par ex. pour un ornement. Sélectionnez la (les)

note(s) à masquer et choisissez Édition > Masquer ou Afficher > Masquer (raccourci

Ctrl+Maj+H ou xXH). Toute altération, articulation, hampe et/ou ligature associée(s) à cette
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note sera (seront) automatiquement masquée(s). Pour en savoir plus sur les notes masquées,

b 5.9 Masquer des objets.

Transformer en silences
Pour transformer une note, un accord ou un passage en silences, appuyez simplement sur Suppr,

ou choisissez le bouton de silence (raccourci 0) sur le premier pavé.

La subtile différence entre Suppr et 0 est que, lorsque vous transformez un passage en silences,

Suppr regroupe les silences (en silences plus longs ou en mesures de silence) alors que 0
transforme chaque note en un silence individuel (ce qui est moins utile). Pour en savoir plus sur les

mesures de silence b 2.5 Mesures et mesures de silences.

Si vous vous retrouvez avec une ou plusieurs mesures qui ne contiennent que des silences de

diverses longueurs, vous pouvez transformer ceux-ci en une mesure de silence en sélectionnant la

mesure ou le passage (de façon à ce qu’il soit entouré d’un cadre bleu clair) et en appuyant sur

Suppr.

Déplacer les silences
Vous pouvez déplacer les silences vers le haut ou vers le bas à l’aide de la souris ou des flèches,

exactement comme les notes.

Pour de la musique à une seule voix, en principe, il n’est pas nécessaire de modifier la position

verticale des silences, car la position utilisée par Sibelius est tout à fait standard. Cependant, dans

l’écriture à plusieurs voix, il est parfois nécessaire d’en ajuster la position verticale afin de faire de la

place aux autres voix. Sibelius déplace légèrement les silences vers le haut ou le bas dans des

portées à plusieurs voix, mais il vous est loisible d’ajuster leur position manuellement.

Silences masqués
Si vous appuyez sur Suppr lorsqu’un silence est sélectionné, il sera masqué; l’espace qu’il occupait

est toujours là, et la musique des autres portées du système est alignée comme si le silence était

toujours là. Si Affichage > Objets masqués est activé (raccourci Ctrl+Alt+H ou zXH), le silence

sera affiché à l’écran en gris clair.

En fait, il est possible de supprimer complètement un silence en sélectionnant un silence masqué

et en appuyant sur Suppr à nouveau, mais il n’y a généralement aucune bonne raison de le faire.

Vous ne devriez masquer les silences que pour un motif valable, car la longueur de la mesure aura

l’air incorrecte ce qui peut être déroutant pour le lecteur inattentif. Il y a cependant deux bonnes

raisons pour masquer un silence:

* Pour faire disparaître une voix avant la fin d’une mesure, ou la faire apparaître après le début.

Dès que les silences indésirables sont masqués dans la seconde voix, la musique repasse à une

seule voix (avec des hampes tant vers le haut que vers le bas) – b 2.36 Voix.

* Afin de le remplacer par un symbole ou une ligne représentant un effet qui ne peut être indiqué

par des notes. En musique contemporaine, c’est le cas par exemple des effets sonores sur bande,

notés par une ligne ondulée qui remplace le silence masqué de la longueur appropriée.
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1.2 Pavé

b 1.1 Saisie des notes, 2.36 Voix, 5.17 Propriétés.

Le pavé reflète à l’écran la disposition des touches du pavé numérique du clavier de l’ordinateur.

Il indique les caractéristiques des note(s), accord(s) ou silence(s) sélectionné(s), ou de la note sur

le point d’être créée en mode de saisie alphabétique ou en mode pas-à-pas.

Pour masquer ou afficher le pavé, choisissez Fenêtre > Pavé (raccourci Ctrl+Alt+K ou zXK).

Agencements du pavé
Le pavé se présente sous six formes différentes (cf. ci-dessous) que l’on permute comme suit :

* cliquez sur les onglets au sommet du pavé ; ou

* cliquez  sur le pavé pour que les 6 formes se succèdent à l’écran (raccourci +), et cliquez 

pour revenir au premier pavé (raccourci F7, aussi Maj-+ sous Windows ou – sur Mac) ; ou

* appuyez sur l’une des 5 touches de F7 à F12 pour afficher les six formes du pavé.

Le premier pavé est celui que l’on utilise le plus, car il contient les valeurs de note et les altérations

les plus courantes, mais voici les six pavés, à titre de référence :

* Les deux premiers pavés concernent la saisie et l’édition des notes; les liaisons rythmiques sont

créées avec la touche Entrée sur le pavé F7; les notes de réplique sont créées avec la touche

Entrée sur le pavé F8. Ne confondez pas le point de la touche * (/ sur Mac) qui est l’articulation

staccato avec le point de la touche. (point des décimales) qui est le point rythmique.

Notes usuelles (F7) Plus de notes (F8) Ligatures/trémolos (F9)

F11 Jazz Altérations (F12)Articulations (F10)
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* Les valeurs de note très courtes ou très longues, ainsi que les double et triple points rythmiques

sont créés à partir du pavé F8 – b 1.1 Saisie des notes.

* Le troisième pavé (raccourci F9) concerne les ligatures (b 2.6 Groupement des ligatures)

et la création des trémolos et des roulements (b 2.34 Trémolos).

* Le quatrième pavé (raccourci F10) est utilisé pour l’ajout d’articulations ; remarquez les trois

touches inutilisées en haut du pavé, auxquelles vous pouvez assigner vos propres articulations –

b 2.3 Articulations.

* Le cinquième pavé (raccourci F11) concerne les articulations de jazz (b 2.19 Articulations
de jazz), les lignes d’arpège pour le clavier et la musique à la harpe, et les mesures répétées

(b 2.27 Mesures répétées).

* Le sixième pavé (raccourci F12) contient bon nombre d’altérations – b 2.1 Altérations.

La touche 0 fait le “vide” en plaçant des silences ou en supprimant articulations ou altérations.

Afficher et modifier les caractéristiques des notes
Lorsqu’une note est sélectionnée, le pavé montre les caractéristiques de la sélection. Par exemple,

lorsque vous sélectionnez une noire dans la partition, le bouton de la noire sur le premier pavé

s’allume. De la même manière, sélectionner un silence de noire pointée fera s’allumer les boutons

de noire, de silence et de point sur le pavé.

Les touches du pavé fonctionnent comme des interrupteurs permettant de modifier tous les

attributs de chaque objet sélectionné de la manière suivante, soit :

* en cliquant l’icône avec la souris ;

* en tapant la touche correspondante sur le pavé numérique du clavier de l’ordinateur ;

Si, par exemple, le premier pavé étant affiché, vous souhaitez transformer la note sélectionnée en

blanche, il suffit simplement d’appuyer sur la touche 5 du pavé numérique. Pour ajouter une

liaison, appuyez sur la touche Entrée du pavé numérique, et ainsi de suite. De façon analogue,

pour supprimer une liaison, sélectionnez la note sur laquelle commence la liaison et appuyez sur

Entrée. Il est possible d’ajouter et de supprimer les attributs de cette façon à partir de n’importe

quel pavé: pour ajouter un point d’orgue à la blanche, appuyez simplement sur F10 (pour passer au

quatrième pavé), puis appuyez sur 1 sur le pavé numérique ce qui ajoutera le point d’orgue.

Si une note comporte des attributs qui ne figurent pas sur le pavé en cours d’affichage, les onglets

des autres pavés concernés apparaîtront également en bleu pour les signaler. Par exemple, en ayant

à l’écran le premier pavé, si vous sélectionnez une noire précédée d’un demi-bémol et surmontée

d’un point d’orgue, les onglets des quatrième et sixième pavés apparaîtront également en bleu.

Voix
La rangée de boutons en bas du pavé est utilisée pour spécifier à quelles voix appartiennent les

notes, le texte attaché aux portées et les lignes – b 2.36 Voix.
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Raccourcis supplémentaires pour les fonctions du pavé
Même s’il existe une corrélation évidente entre les éléments du pavé à l’écran et le pavé numérique

du clavier de l’ordinateur, vous pouvez aussi assigner vos propres raccourcis-clavier à des éléments

spécifiques du pavé à l’écran. Par exemple, si vous voulez assigner un raccourci spécifique au point

d’orgue sur le quatrième pavé – pour éviter de taper F10 (qui est le raccourci pour afficher ce pavé)

suivi de 1 sur le pavé numérique (pour ajouter le point d’orgue), il est possible de taper un

raccourci simple sans rapport avec le pavé – voici comment faire:

* Choisissez Fichier > Préférences (dans le menu Sibelius menu sur Mac) puis la page Menus et
raccourcis

* Après avoir choisi votre propre jeu de fonction dans lequel sera créé le nouveau raccourci,

choisissez Pavé (F10 articulations) dans la liste Menu ou Catégorie

* Dans la liste Fonction, choisissez point d’orgue (pause), puis cliquez sur Ajouter pour ajouter

votre raccourci-clavier.

Pour en savoir plus sur les manières de définir vos propres raccourcis-clavier, b 5.12 Menus et
raccourcis.

Accéder aux touches du pavé numérique sur un ordinateur portable
La plupart des portables ne possèdent pas de pavé numérique séparé mais permettent en général

d’en remplacer les touches en combinant la touche marquée Fn avec d’autres touches du clavier

(sauf pour les modèles récents d’Apple MacBook). Sibelius dispose de certains raccourcis

alternatifs intégrés qui s’avèrent plus pratiques.

Pour commencer, choisissez la page Menus et raccourcis de Fichier > Préférences (dans le menu

Sibelius sous Mac) et choisissez le jeu de fonction Fonctions pour les portables : Au lieu

d’utiliser les chiffres du pavé, vous utilisez les chiffres standard du clavier principal qui

correspondent aux chiffres du pavé. Quand cette fonction est active, utilisez Maj-1 à Maj-9 pour

entrer les intervalles au-dessus d’une note – b 5.12 Menus et raccourcis.

Utiliser le pavé avec Mac OS X
Par défaut, Mac OS X assigne les touches F9, F10 et F11 aux fonctions Exposé, et F12 à la fonction

Dashboard ; dès lors, ces raccourcis qui permettent de changer de pavé dans Sibelius ne

fonctionneront pas.

Pour réassigner les raccourcis Exposé et Dashboard à d’autres fonctions (par ex. F2, F3, F4 et

F5), utilisez les panneaux Dashboard et Exposé dans les Préférences du Système.
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1.3 Fenêtre Clavier

La fenêtre de clavier à l’écran de Sibelius est un moyen pratique de saisir des notes via une interface

de clavier piano standard, en utilisant soit la souris ou le clavier de votre ordinateur, et fait

également office de second écran de lecture.

Afficher et masquer la fenêtre de clavier
Pour afficher ou masquer la fenêtre de clavier, cliquez sur le bouton de la barre d’outils

indiqué à droite, ou choisissez Fenêtre > Clavier (raccourci Ctrl+Alt+B ou zXB).

La fenêtre Clavier se présente comme suit :

La fenêtre Clavier comporte trois tailles (dont l’intermédiaire est affichée ci-dessus), et il est

possible de la redimensionner en cliquant sur son rebord inférieur (ou son rebord supérieur, sous

Windows) et en la faisant glisser. Vous pouvez également changer la largeur de la fenêtre Clavier en

faisant glisser son rebord gauche ou droit (Windows) ou le rebord inférieur droit (Mac). Do moyen

est appelé C4.

Saisie à la souris via la fenêtre Clavier
Pour saisir des notes avec la souris en cliquant sur la fenêtre Clavier, sélectionnez simplement

l’endroit dans la partition où vous souhaitez commencer la saisie de notes, puis cliquez sur la note

de la fenêtre Clavier que vous souhaitez saisir. Si vous cliquez sur une note noire et que vous

souhaitez changer l’orthographe enharmonique, appuyez simplement sur Retour (sur le clavier

principal) immédiatement après avoir saisi la note.

Le signe d’insertion de saisie de note avance automatiquement après avoir saisi chaque note.

Si vous souhaitez saisir un accord, cliquez sur le bouton de mode d’accord sur la barre

d’outils de la fenêtre Clavier, indiqué à droite. Maintenant, chaque note sur laquelle vous

cliquez est ajoutée à l’accord actuel, et pour avancer le signe d’insertion, vous devez cliquer sur le

bouton de flèche droite à droite du bouton de mode d’accord.

Saisie sous clavier informatique via la fenêtre Clavier
Vous pouvez aussi saisir des notes via la fenêtre Clavier à l’aide du clavier de votre ordinateur.

Normalement, lors de la saisie de notes via le clavier de votre ordinateur, vous devez saisir le nom

de la note que vous souhaitez saisir (ex. C pour C, G pour G, etc.). Avec la fenêtre Clavier, en

revanche, vous utilisez un ensemble de touches différent, grossièrement disposées sous la forme

d’un octave de touches sur un clavier de piano. Cela s’appelle le mode QWERTY, ainsi baptisé à

cause de la rangée de touches supérieure sur un clavier anglais.
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Du fait que la plupart des touches sur le clavier de votre ordinateur sont pré-définies (ex. T
pour Créer > Indication de mesure, Q pour Créer > Clé, etc.), vous devez signaler à

Sibelius que vous souhaitez contourner ces raccourcis irréguliers afin d’utiliser le mode QWERTY,

ce qu’il est possible de faire en cliquant sur le bouton de la barre d’outils de la fenêtre Clavier,

affichée en haut à droite, ou saisissez le raccourci Maj+Alt+Q ou xzQ.

Quand le mode QWERTY est activé, sachez que toutes les octaves, à l’exception d’une seule, sur la

fenêtre Clavier, sont grisées :

L’octave éclairée indique la hauteur des notes que vous allez saisir quand vous saisissez les touches

sur le clavier de votre ordinateur. Les touches à utiliser sont affichées en grisé dans l’image ci-

dessous :

A correspond à C, W à C# ou Db, S à D, E à D# or Eb, etc., jusqu’à K, qui correspond à C un octave

au-dessus. Z passe à l’octave inférieure, et X à l’octave supérieure. Retenez que G entre un G, F
entre un F, et E un Eb.

Pour saisir un accord en mode QWERTY, appuyez simplement sur deux ou trois touches ensemble.

Selon le clavier de votre ordinateur, vous risquez de ne pas pouvoir saisir d’accords de quatre notes

ou plus simultanément.

Le mode QWERTY ne fonctionne que si la fenêtre Clavier est affichée : dès que vous la masquez, le

mode QWERTY est désactivé.

Si vous utilisez un clavier avec une disposition différente (ex. AZERTY au lieu de QWERTY), vous

devrez modifier les raccourcis-clavier utilisés dans le mode QWERTY, que vous trouverez dans la

catégorie Fenêtre Clavier de la page Menus et raccourcis du menu Fichier > Préférences (menu

Sibelius sous Mac) – b 5.12 Menus et raccourcis.

Suivre la partition durant l’exécution
Outre la saisie de notes, la fenêtre Clavier peut également vous indiquer quelles notes sont jouées

lors de la lecture. Vous pouvez choisir les instruments à suivre à l’aide du menu à gauche de la

barre d’outils de la fenêtre Clavier.

Par défaut, il est configuré sur Auto, ce qui signifie qu’il suivra toutes les portées sauf les portées

de percussions sans hauteur de note), à moins d’avoir sélectionné une ou plusieurs portée(s) avant

de commencer la lecture, auquel cas il suivra uniquement ces portées. Si vous souhaitez toujours
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suivre une portée précise pendant la lecture, choisissez le nom de la portée dans le menu sur la

barre d’outils de la fenêtre Clavier.

Notez que les touches sur la fenêtre Clavier s’éclairent de la même couleur que les couleurs de voix

utilisées ailleurs dans Sibelius.

Affichage de la note ou de l’accord sélectionné
La fenêtre Clavier indique également la note actuellement sélectionnée quand vous éditez des

notes, ce qui peut être utile pour vérifier la disposition d’un accord. La fenêtre Clavier affiche

toujours des notes à hauteur réelle, même si Notes > Transposition de partition est activé.
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1.4 Flexi-time™

b 1.1 Saisie des notes.

Flexi-time est le mode intelligent de saisie en temps réel spécifique à Sibelius.

Saisie en temps réel
La saisie en temps réel pour les autres programmes consiste à comprendre à la fois les hauteurs et

le rythme de la musique jouée sur un clavier MIDI, et puis à transcrire le mieux possible.

Le gros problème est posé par le rythme: personne ne joue les rythmes exactement comme ils sont

notés à cause d’un rubato (variation de vitesse) inconscient; par conséquent la saisie en temps réel

peut facilement produire des aberrations telles des notes liées à des quadruple croches.

Pour pallier à cette situation, on utilise habituellement la quantification, une fonction qui arrondit

les valeurs de note à la double croche la plus proche, ou à n’importe quelle unité spécifiée.

Malheureusement, ce procédé n’améliore que la musique assez simple; si vous accélérez ou

ralentissez, l’ordinateur se désynchronise du jeu et produit des données incorrectes.

Avec Flexi-time, cependant, Sibelius détecte un jeu rubato et compense en conséquence. Il réalise

automatiquement la quantification, sans qu’il soit nécessaire de spécifier une unité, et utilise un

algorithme intelligent qui varie la quantification en fonction du contexte. Par exemple, si des notes

courtes sont jouées, l’unité de quantification sera plus petite que s’il s’agissait de notes longues.

Autre fonction utile, l’Exécution enregistrée conserve les subtiles nuances de votre interprétation

enregistrée de manière distincte de la partition. Quand on la lit, on peut donc entendre l’exécution

de la musique telle qu’elle a été entrée en mode Flexi-time, jusqu’à la moindre variation de

longueur et de nuance pour chaque note, tandis que la notation reste claire et nette.

Enregistrer avec Flexi-time
* Bien qu’il soit possible de modifier l’indication métronomique à tout moment, il est

recommandé de placer l’indication adéquate dès le début, de façon à ce que le

métronome indique les temps correctement.

* Cliquez sur une mesure, une note ou un silence à partir duquel démarrera l’enregistrement, ou:

% si vous souhaitez enregistrer sur deux portées adjacentes (par ex. un piano), sélectionnez les

deux portées: cliquez d’abord sur la portée supérieure, puis utilisez utilisant Maj-clic

% si vous enregistrez pour un seul instrument à partir du début de la partition, rien n’est à

sélectionner puisque l’endroit où commence l’enregistrement est évident

* Cliquez sur le bouton rouge d’enregistrement sur la barre d’outils ou choisissez Notes > Flexi-
time (raccourci Ctrl+Shift+F ou xXF)

* Sibelius lancera le métronome. Celui-ci va battre une mesure complète de décompte; attendez la

fin de celle-ci avant de commencer à jouer!

* Vous pouvez ajuster la vitesse de l’enregistrement en faisant glisser le curseur du tempo;

l’affichage sur la barre d’outils changera en conséquence. (Si vous souhaitez enregistrer plus

lentement, démarrez l’enregistrement, ajustez le curseur du tempo sur le point désiré, puis
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appuyez sur Espace et relancez l’enregistrement; Sibelius se souviendra du tempo que vous avez

défini.)

* Commencez à jouer au clavier, en suivant le clic du métronome (approximativement du moins).

Au fur et à mesure que vous jouez, les notes vont apparaître à l’écran.

Si vous accélérez ou ralentissez, le métronome accélérera ou ralentira pour vous suivre, tant que

vous ne brusquez pas le tempo.

* Dès que vous avez terminé, appuyez sur Espace pour arrêter.

Si vous ajoutez de la musique sur différentes portées avec Flexi-time, Sibelius exécute la musique

existante pendant que vous enregistrez.

Si vous souhaitez ajouter une autre mélodie à la même portée, vous pouvez enregistrer dans l’une

des autres voix; cf. Voix ci-dessous.

Options du clic
Les réglages pour le clic du métronome du Flexi-time sont contrôlés par la boîte de dialogue

Fenêtre > Table de mixage (raccourci Ctrl+Alt+M ou M), ou sont accessibles à partir du bouton

Clic dans la boîte de dialogue Notes > Options Flexi-time (raccourci Ctrl+Maj+O ou xXO).

Par défaut, le clic indique le premier temps de chaque mesure avec un son de woodblock aigu, et

les temps suivants avec un woodblock grave. Dans les mesures composées telles que 6/8, il

subdivise également les temps en croches. Pour les mesures complexes telles que du 7/8, le

comportement par défaut consiste à mettre l’accent sur chaque groupe de temps.

Pour en savoir plus sur ces réglages, b 4.3 Table de mixage.

Conseils
* Écoutez le décompte des temps par Sibelius et commencez avec le premier temps de la mesure

suivante. Si vous commencez trop tôt, ou à un tempo différent du décompte, Sibelius ne

comprendra pas ce que vous faites.

* N’enregistrez qu’une seule portée à la fois, plutôt que deux ensemble si c’est trop difficile!

* Jouez legato (sans à-coups).

* Si vous souhaitez que la musique soient notées avec les staccatos, assurez-vous que l’option

Staccato est activée dans les options Notes > Options Flexi-time. Si cette option est

désactivée, jouer staccato produira des valeurs de notes courtes avec des silences.

* La plupart des gens sont assez laxistes en ce qui concerne le jeu simultané des notes dans un

accord. Si vous arpégez sensiblement les accords, Sibelius écrira ce que vous avez joué

littéralement plutôt que d’ajouter, par exemple, une ligne d’arpège.

* Sibelius peut détecter les modifications de tempo extrêmement rapidement bien plus vite que

n’est capable de le faire un être humain! Cependant, si vous faites un changement de tempo trop

brusque, Sibelius ne pourra le comprendre. Évitez donc de faire des modifications soudaines de

tempo pendant l’enregistrement.

Si Sibelius perd le rythme et ne vous suit plus, arrêtez-vous et retournez au point de

désynchronisation. Si vous continuez tout de même, Sibelius va peut-être vous rattraper, mais

corriger le rythme prendra bien plus de temps que de simplement rejouer le passage.
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* Si la notation produite avec Flexi-time vous paraît compliquée et que vous voulez la simplifier,

utilisez les extensions du dossier Extensions > Simplifier la notation et particulièrement

l’extension Réécrire l’exécution enregistrée – b 6.1 Travailler avec des extensions.

Saisie dans deux instruments
Si on le souhaite, il est possible de réaliser la saisie simultanée de deux d’instruments différents –

par ex. la flûte et la basson – à condition qu’ils figurent sur des portées adjacentes sans portée

masquée les séparant. Comme pour la saisie du piano, avant d’enregistrer normalement,

sélectionnez les deux portées (faites un clic sur la portée supérieure puis Maj-clic sur celle

inférieure)

Enregistrer d’autres données MIDI 
En mode Flexi-time, Sibelius enregistre les données des contrôleurs MIDI en même temps que les

notes. Par exemple, si on utilise une pédale de maintien en mode Flexi-time, Sibelius note les

messages MIDI appropriés et les masque automatiquement dans la partition. Les autres données

de contrôleur MIDI enregistrables comprennent le “pitch bend”, la modulation, le volume, etc.

Si vous préférez que ces messages MIDI ne soient pas enregistrés lorsque vous faites la saisie en

mode Flexi-time, désactivez les options appropriées sur la page Notation de la boîte de dialogue

Notes > Options Flexi-time - cf. Options Flexi-time ci-dessous.

Exécution enregistrée
Par défaut, Sibelius lit la musique entrée en mode Flexi-time en utilisant l’Exécution enregistrée,

qui conserve les nuances de votre jeu (spécifiquement, les nuances et la durée précise de chaque

note). Chaque détail de l’interprétation est modifiable, mais pour entendre la musique strictement

écrite, désactivez Exécution > Exécution enregistrée (raccourci Maj-L).

Pour en savoir plus, b 4.8 Exécution enregistrée.

Options Flexi-time
Pour modifier les nombreuses options Flexi-time, choisissez Notes > Options Flexi-time
(raccourci Ctrl+Maj+O ou xXO):

Vous trouverez dans l’onglet Flexi-time les options suivantes:

* Variabilité du tempo: contrôle dans quelle mesure Sibelius suit votre tempo. Si vous êtes

habitué à jouer avec un métronome, réglez cette option sur Aucune (non rubato), et Sibelius
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maintiendra un tempo fixe. Plus le réglage de la flexibilité est élevé, plus Sibelius aura tendance à

suivre votre tempo. Si Sibelius change de tempo de manière curieuse, c’est qu’il vous trouve

difficile à suivre, réduisez donc la flexibilité ou réglez-la sur Aucune (non rubato).

* Introduction ... mesures: détermine combien de mesures de décompte seront jouées avant que

ne commence l’enregistrement

* Enregistrer jusqu’à ... mesures: si la partition comporte peu de mesures vides dans lesquelles

enregistrer, ceci permet d’en ajouter automatiquement dès le début de l’enregistrement

* Le bouton Clic... vous emmène dans la boîte de dialogue qui détermine le comportement du

métronome pendant l’enregistrement – b 4.3 Table de mixage.

* Options de Voix:

% Enregistrer dans une seule voix: pour spécifier que seule une voix est enregistrée

% Enregistrer dans des voix multiples est une alternative: avec la case est cochée, Sibelius

scinde automatiquement la musique en deux voix si nécessaire; cf. Voix ci-dessous.

* Remplacer et Superposer contrôle l’action de Sibelius si on enregistre un passage qui contient

déjà de la musique; en réglant sur Remplacer, Sibelius effacera la musique existante avant de

noter la nouvelle musique jouée; en réglant sur Superposer, Sibelius ajoutera la nouvelle

musique enregistrée à la musique existante pour en faire des accords.

* Repères temporels pour MIDI interne : si votre ordinateur possède deux processeurs ou un

processeur avec l’hyper-threading, il peut arriver que le rythme noté devienne de plus en plus

imprécis au fur et à mesure que l’enregistrement avance. Si vous rencontrez ce type de problème,

activez cette option (Windows uniquement). 

Sur l’onglet Notation se trouvent les options suivantes:

* Options de Valeurs de note: 

% Ajuster les rythmes pour que Sibelius “nettoie” ce que vous jouez. Conservez cette option!

% Valeur de note minimale: définit la valeur de note minimale que Sibelius écrira. Cette

valeur n’est pas une unité de quantification car celle-ci se fait en fonction d’un algorithme

complexe et varie en fonction du contexte. Par conséquent, cette valeur n’est pas appliquée

rigidement; elle a une valeur indicative. Si vous la réglez par exemple sur une noire, et

qu’ensuite vous jouez des doubles croches, Sibelius sera bien obligé de noter des notes plus

courtes que des noires, sous peine d’écrire des aberrations.

% Noter: il s’agit des options pour noter les staccatos et tenutos; activez ces options si vous êtes

sûr de pouvoir les jouer les articulations telles doivent être notées. Si de nombreuses

articulations de staccato et de tenuto erronées figurent dans la partition après avoir utilisé le

mode Flexi-time, désactivez-les, ou ajustez les seuils Si plus court que / Si plus long que
(représentant le pourcentage de la valeur notée) au-delà desquels les articulations sont

notées.

% Enlever les silences entre les notes sur les portées de percussion: activée par défaut

Cette option réécrit les notes trop courtes en les unissant pour enlever les silences superflus

dans les parties de percussion.

* Portées de clavier : quand la saisie se fait sur deux portées, le point de scission détermine

quelles notes vont dans chaque portée (les notes sur ou au-dessus du point de scission vont sur la
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portée supérieure, et les notes en dessous sur la portée inférieure). En choisissant

Automatique, Sibelius essayera de deviner à tout moment où sont vos mains sur le clavier et

assignera les notes en conséquence. Il est également possible de fixer un point de scission Fixe.

(Notez que dans Sibelius, le Do central est appelé C4, ce qui peut différer d’autres programmes.)

* Multiplets: pour chacun des multiplets de la liste, vous pouvez choisir ceux que Sibelius

détectera: Aucun/Simple/Modére/Complexe. Un “simple” triolet signifie un triolet avec trois

notes égales. Pour les multiplets tels qu’une noire suivie d’une croche, utilisez Modéré et pour

les multiplets avec des silences et des rythmes pointés, utilisez Complexe.

* Options de Messages MIDI:

% Conserver les messages de changement de programme / banque ajoute les

changements de programme et de banque à la partition en utilisant le format de texte MIDI

de Sibelius. Ces messages sont masqués automatiquement.

% Conserver les messages des contrôleurs ajoute tous les messages des contrôleurs (tel que

le “pitch bend”, la pédale, le volume, etc.) et les masque dans la partition.

% Conserver les autres messages ajoute de la même façon les autres messages MIDI.

Les réglages des options Flexi-time recommandés sont en fait les valeurs par défaut; Ajuster les
rythmes: activé, Valeur de note minimale: double croche, Variabilité du tempo: réglé sur

Faible, Staccato et Tenuto activés avec des seuils de 35% et 110% respectivement. Pour les

multiplets, réglez 3 sur Simple ou Modéré, peut-être 6 de la même façon et les autres sur Aucun
à moins que vous ne soyez un fanatique des septuplets.

Enregistrer en notes écrites
Dans la page Saisie de notes du Fichier > Préférences (dans le menu Sibelius sur Mac), activez

l’option Saisie en notes écrites si vous enregistrez en jouant les notes d’une partition transposée;

sinon, Sibelius considérera que vous jouez les notes réelles.

“Orthographe” des altérations
Comme pour la saisie en mode pas-à-pas, Sibelius devine comment écrire les touches noires jouées

(par ex. comme Fa# ou Solb); l’orthographe de n’importe quelle note ou sélection de notes peut être

modifiée après-coup en appuyant simplement sur Retour (sur le clavier principal) ou en utilisant

l’une des extensions pour les altérations (b 6.1 Travailler avec des extensions).

Voix
Par défaut, Sibelius scinde les notes en deux voix lorsque c’est nécessaire (par ex. si vous jouez de la

musique polyphonique telle qu’une fugue). Dans la plupart des cas, cela est souhaitable, mais

quand on entre la musique sur une seule portée ou pour un instrument monophonique, il est

préférable d’imposer à Sibelius d’écrire tout dans une seule voix. Pour modifier ce réglage, cochez

la case appropriée dans la boîte de dialogue Notes > Options Flexi-time (cf. ci-dessus).

Bien que Sibelius prenne généralement de bonnes décisions sur la scission de la musique en

plusieurs voix, il faudra peut-être modifier certains passages pour que la notation corresponde

mieux à vos intentions. Vous pourriez par exemple filtrer la note inférieure des accords de la voix 1

(b 5.7 Rechercher et filtrer) puis par exemple la basculer en voix 2 en appuyant sur Alt+2 ou

z2 – consultez Répartir en plusieurs voix dans b 2.36 Voix pour en savoir plus.
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1.5 Numérisation

INTRODUCTION
PhotoScore Lite Ultimate de Neuratron est un programme de numérisation de musique conçu

pour travailler avec Sibelius - il s’agit en fait de l’équivalent musical d’un programme de texte OCR.

(En l’absence de traduction de Photoscore, le nom des commandes est en anglais - N.D.T.)

Photoscore un programme sophistiqué extrêmement puissant. Si vous projetez de numériser des

partitions relativement complexes, comme une partition d’orchestre ou une partition de plusieurs

pages, nous vous recommandons vivement de commencer avec une partition plus simple et de

vous familiariser avec la section FONCTIONS AVANCÉES.

Aide à l’écran
Outre ce paragraphe, PhotoScore Lite possède sa propre aide intégrée: pour y accéder, choisissez

Aide > Neuratron PhotoScore aide (raccourci F1) dans le menu PhotoScore Lite.

PhotoScore Ultimate
Une version évoluée de PhotoScore Lite, appelée PhotoScore Ultimate est disponible séparément,

avec des fonctions plus complètes. PhotoScore Ultimate lit les indications musicales (comme les

multiplets, les liaisons de phrasé et les textes) et lit les partitions contenant plus de 12 portées.

Pour en savoir plus sur PhotoScore Ultimate, choisissez Aide > PhotoScore Ultimate, ou

contactez votre revendeur Sibelius.

Numérisation
Numériser un texte est une tâche difficile pour un ordinateur, et les résultats obtenus ne sont

vraiment valables que depuis quelques années. Numériser de la musique est une tâche encore plus

compliquée à cause du grand nombre de symboles utilisés et aussi à cause de la “grammaire”

bidimensionnelle de la notation musicale.

La difficulté vient du fait qu’en numérisant une page de texte ou de musique, un ordinateur ne

“comprend pas“ ce qu’il numérise. En effet, pour l’ordinateur, une page numérisée représente une

grille contenant des millions de points noirs et blancs qui peuvent représenter du texte, de la

musique, une image ou toute autre chose.

Le processus d’interprétation de ces points en musique, texte ou image est extrêmement complexe

et difficilement compréhensible. Au niveau du cerveau humain, une bonne part des milliers de

connections neuronales est consacrée à la reconnaissance de ce type de choses.

Installation et désinstallation de PhotoScore Lite
Reportez-vous au Manuel pour savoir comment installer ou désinstaller PhotoScore Lite.

État des originaux
PhotoScore Lite est conçu pour lire des partitions originales qui:

* sont de préférence imprimées plutôt que manuscrites (et utilisent des notes d’apparence

“imprimées” plutôt que des notes d’apparence “manuscrites”)
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* s’ajustent à votre scanner (par exemple pour un scanner A4, que la musique soit comprise dans

ce format, même si le papier en lui-même est plus grand)

* ont une taille de portée d’au moins 0.12"/3mm

* n’utilisent pas plus de 12 portées par page et 2 voix par portée (toutes voix ou portées

supplémentaires seront ignorées.)

* sont assez claires – par exemple les portées doivent être continues et non interrompues ou

tâchées, les rondes et blanches ainsi que les bémols doivent avoir leur circonférence bien

dessinée et non interrompue, les espaces entre les ligatures des doubles croches ou des valeurs

plus petites doivent être suffisants, et les objets séparés (par exemple, les têtes de note et les

altérations qui les précèdent) ne peuvent pas se superposer.

Les partitions qui ne respectent pas ces conditions manqueront certainement de précision.

Numériser une partition photocopiée n’est pas particulièrement recommandé car la qualité de la

copie est moindre que celle de l’original. Il se peut cependant que vous deviez numériser une

photocopie réduite de votre partition, mais attendez-vous dans ce cas à obtenir moins de précision.

Utiliser PhotoScore Lite sans scanner
Outre la lecture de partitions numérisées par vos soins à l’aide d’un scanner, il est possible de “lire”

des partitions sans scanner, soit en ouvrant des pages individuelles que vous avez sauvegardées en

tant que fichiers d’image, ou en ouvrant des fichiers PDF.

Pour travailler avec des images, chaque page doit figurer dans l’ordinateur sous forme de fichiers

image séparés au format .bmp (bitmap) sous Windows, ou TIFF et PICT sur Mac.

PhotoScore Lite peut aussi lire des fichiers PDF. Cette faculté peut s’avérer utile pour des partitions

existant au format PDF sur un site web, ou si vous voulez convertir un fichier provenant d’un autre

programme de musique par le biais de fichier PDF que vous ouvrirez dans PhotoScore Lite.

Avant de décider d’utiliser des fichiers PDF comme moyen de conversion de fichiers créés dans un

autre programme de musique, vérifiez si ce dernier ne peut pas exporter un fichier sous un format

lisible directement par Sibelius, tel que le MusicXML, qui est préférable aux fichiers PDF.

Sous Windows, PhotoScore Lite nécessite que vous ayez Ghostscript installé pour pouvoir ouvrir

les fichiers PDF. Si vous n’avez pas installé Ghostscript lors de l’installation de PhotoScore Lite,

vous pouvez le charger à l’adresse www.ghostscript.com.

Partitions avec copyright
Prenez garde au fait que si vous numérisez la partition d’un tiers sans avoir son autorisation, vous

ne respectez pas le copyright. Numériser des documents sous copyright est un acte illégal, passible

d’amende, et dans tous les cas est interdit par votre contrat de licence de Sibelius.

La plupart des partitions mentionne un copyright et leur titulaire. Si vous voulez numériser une

partition dont vous ne savez pas si elle est sous copyright ou non, veuillez contacter l’éditeur, le

compositeur ou l’arrangeur.

http://www.ghostscript.com/
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Premiers pas
Tout comme pour Sibelius, les fonctions de PhotoScore Lite seront identiques que vous soyez sous

Windows ou sur un Mac. Vous pouvez démarrer PhotoScore Lite en choisissant Fichier >

Numériser dans le menu de Sibelius, en cliquant sur l’icône Numériser avec PhotoScore de

la barre d’outils, ou en l’exécutant depuis le menu Démarrage (Windows) ou en faisant un double-

clic sur son icône (Mac). Il n’est pas nécessaire que Sibelius fonctionne pour utiliser PhotoScore

Lite.

Les quatre étapes
L’utilisation de PhotoScore Lite se déroule selon les quatre étapes suivantes:

* Numériser les pages ou ouvrir un fichier PDF. Quand vous numérisez une page, PhotoScore Lite

prend une “photographie” de votre original. De la même manière, quand vous ouvrez un fichier

PDF, PhotoScore Lite en prend une “photographie”, de sorte qu’il peut le lire à l’étape suivante.

* Lire les pages. Ceci est plus futé; c’est à ce stade que PhotoScore Lite “lit” les pages numérisées

pour déterminer quelles sont les notes et les autres indications.

* Editer la musique résultante. C’est à ce moment que vous pouvez corriger les erreurs que

PhotoScore Lite a pu faire. Éditer une partition dans PhotoScore Lite se fait de la même manière

que dans Sibelius. La plupart des indications peuvent être corrigées ou encodées dans

PhotoScore Lite, mais il est essentiel de corriger à ce stade les erreurs de rythme – les autres

corrections pouvant être faites après avoir envoyé la musique dans Sibelius selon votre

convenance.

* Envoyer la musique dans Sibelius. Il suffit de cliquer sur le bouton. Après quelques instants, la

musique apparaîtra comme une partition Sibelius, comme si vous l’aviez saisie vous-même.

Vous pouvez ensuite exécuter la partition, la réarranger, la transposer, créer des parties ou

l’imprimer.

Démarrage rapide
Avant d’examiner en détail PhotoScore Lite, voici rapidement le processus suivi lors de ces quatre

étapes.

La première étape consiste donc à numériser la partition ou à ouvrir une page numérisée au

préalable:

* Pour numériser une page, choisissez File > Scan pages (raccourci Ctrl+W ou XW); l’interface

de votre scanner s’activera. Numérisez la page et cette-ci apparaîtra dans la liste des pages

numérisées de Photoscore.

* Pour ouvrir un fichier d’images, choisissez File > Open; lorsque vous êtes invité à vérifier la

résolution à laquelle l’image a été numérisée, choisissez les réglages adéquats et cliquez sur OK.

Les fichiers d’images seront ainsi ajoutés à la liste des pages numérisées.

* Pour ouvrir un fichier PDF, choisissez File > Open PDFs. Il vous sera ensuite demandé de choisir

la résolution; normalement le réglage par défaut de 300 dpi étant adéquat, cliquez sur OK. Si le

PDF est protégé par un mot de passe, celui-ci vous sera demandé.
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Dès qu’une page est numérisée ou ouverte en tant que PDF ou fichier d’image, elle apparaît dans la

panneau pages, qui est à gauche dans la fenêtre principale de PhotoScore. Chaque page apparaît

sous Pending Pages, et PhotoScore Lite commence immédiatement à lire la page ajoutée.

La lecture d’une page peut prendre un certain temps (en fonction de la vitesse de l’ordinateur) ce

qu’indique une barre de progression verte placée sous le nom dans la liste Pending Pages. Dès que

PhotoScore Lite a fini de lire la page, elle se déplace dans la liste du dessous intitulée Read Pages.

Lorsque PhotoScore Lite a terminé la lecture de l’image, la fenêtre d’édition principale apparaît:

C’est dans cette fenêtre que vous pouvez corriger d’éventuelles erreurs.

Dès que vous êtes satisfait de vos corrections, choisissez File > Send to > Sibelius (raccourci

Ctrl+D ou XD) pour envoyer la musique dans Sibelius.

Si Sibelius ne fonctionne pas encore, il sera lancé automatiquement, et la boîte de dialogue Ouvrir
un fichier PhotoScore apparaîtra; elle vous permettra de choisir différentes options concernant

le choix des instruments utilisés dans la partition. Vous pouvez à ce stade ignorer cette opération et

cliquez sur OK. Quelques instants plus tard, la partition s’affichera à l’écran, prête à être éditée,

exactement comme si vous l’aviez encodée vous-même.

1. NUMÉRISATION OU OUVERTURE D’UN PDF
Avant de numériser, choisissez File > Scanner Setup pour choisir si vous voulez utiliser l’interface

de numérisation de Photoscore – dans ce cas choisissez PhotoScore – ou l’interface de votre

scanner – dans ce cas choisissez TWAIN (scanner default) – et cliquez sur OK. Par défaut,

PhotoScore Lite utilisera l’interface de votre scanner, qui vous est probablement plus familière.

Ensuite, mesurez la hauteur des portées de la page à numériser et choisissez une résolution en

utilisant la table suivante, puis numérisez en noir & blanc ou en gris – pas en couleur

Dimension des portées Résolution

0.25"/6 mm ou plus 200 dpi

0.15-0.25"/4–6 mm 300 dpi

0.12-0.15"/3–4 mm 400 dpi
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La précision de lecture ainsi que la vitesse seront considérablement réduites si vous numérisez à

une résolution trop haute ou trop basse. Par exemple, ne numérisez pas à 400 dpi si la portée n’est

pas réellement petite.

Habituellement, vous pourrez choisir si vous voulez numériser en noir et blanc ou en échelle de

gris. Numériser en gris donne des résultats plus précis – si cette option n’est pas disponible dans la

boîte de dialogue de votre scanner, consultez sa documentation.

Vous pouvez à présent numériser votre première page – essayez une ou deux pages d’une musique

simple pour clavier, ou quelque chose de similaire:

* Placez l’original dans le scanner, face vers le bas.

Ajustez le bord de la feuille contre le bord de la vitre.

Vous pouvez mettre la page sur le côté. PhotoScore Lite la tournera automatiquement de 90° si

nécessaire. Cependant, veillez à aligner le dessus de la page avec le bord gauche du scanner pour

éviter que la page soit à l’envers, bien qu’il soit très facile de corriger cela par la suite.

Si vous numérisez en gris, la page n’a pas besoin d’être tout à fait droite, un décalage de

maximum 8° peut être toléré – PhotoScore Lite va automatiquement réajuster la page (par pas

de 0.1 degré) sans perte de qualité. Une rotation sera toujours faite si la numérisation a été faite

en noir et blanc, mais il y aura une perte dans les détails entraînant un résultat moins précis.

* Choisissez File > Scan Pages, ou cliquez sur le bouton Scan Pages sur la barre d’outils de

PhotoScore Lite.

* Après un moment, vous entendrez le bourdonnement du scanner et la partition sera transférée

dans votre ordinateur. (Si cela ne se produit pas, cf. PROBLÈMES POSSIBLES ci-dessous.)

* Si vous numérisez depuis un livre, appuyez légèrement ce dernier sur la vitre du scanner afin

qu’elle reste bien en contact.

* Une fenêtre apparaît dans laquelle vous pourrez encoder le nom de la page (nommée par défaut

Page 1. Vous pourrez modifier ce nom (bien que pour éviter les erreurs, il vaut mieux que le

nom se termine par un numéro) - quelque chose comme Piano p1 devrait faire l’affaire - tapez

sur la touche OK. Les pages suivantes que vous numériserez seront automatiquement

numérotées, par exemple Piano p2, mais vous pouvez modifier ce nom si vous le désirez.

* Attendez quelques secondes pendant que PhotoScore Lite règle le niveau de l’image, choisit la

meilleure brillance et localise les portées

* PhotoScore est maintenant prêt à scanner la première page. Placez donc la page de musique dans

le scanner, puis cliquez sur le bouton indiquant à votre scanner de relancer le scan, et faites

comme pour la première page. Si l’interface de scan ne réapparaît pas, recliquez simplement sur

le bouton Scan Pages.

* Continuez jusqu’à ce que vous ayez scanné toutes les pages souhaitées.

* Une numérisation de la première page apparaît. Le papier coloré indique que vous regardez une

image numérisée de la page originale.

Vérifiez que toutes les portées sont surlignées en bleu - preuve que Photoscore les a bien

détectées. 

Si dans la page, il y a des systèmes de deux ou plusieurs portées, vérifiez que celles-ci sont bien

jointes sur la gauche par un trait rouge vertical (ou proche du vertical).
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Si aucune portée n’est surlignée en bleu, ou si aucune portée à l’intérieur d’un système n’est

jointe, vous pouvez manuellement signaler à Photoscore où elles se trouvent (cf. FONCTIONS
AVANCÉES ci-dessous ).

(Ignorez les autres boutons au-dessus de cette fenêtre, ils seront expliqués dans FONCTIONS
AVANCÉES ci-dessous.)

En résumé
Lorsque vous aurez numériser quelques pages, la procédure vous semblera très simple. Elle peut se

résumer comme suit:

* Placez la page dans le scanner

* Cliquez sur le bouton du scanner ou choisissez File > Scan Pages

* Choisissez la résolution et si vous voulez numériser en gris ou en noir et blanc

* Cliquez sur Scan

* Entrez le nom de la page (ou laissez le nom par défaut)

* Passez à la page suivante.

Catalogue des pages numérisées
Lorsque vous numérisez plusieurs pages, il est important de comprendre que PhotoScore Lite les

ajoute à une liste ou “catalogue” d’où elles seront lues plus tard. La sauvegarde est automatique et

vous n’avez donc pas besoin de sauver le catalogue.

Cela signifie que lorsque vous utilisez PhotoScore, il se souviendra des pages numérisées

auparavant. (Vous pouvez évidemment effacer les pages dont vous n’avez plus besoin)

Nous vous en dirons plus sur le catalogue plus loin dans ce manuel.

Astuces concernant la numérisation
* Si vous voulez lire une page de musique plus petite que la taille du scanner, vérifiez que seule

cette portion sera numérisée.

La plupart des scanners offre la possibilité de numériser une partie de la page, habituellement en

cliquant un bouton Prévisualisation qui produit une page en réduction, qui peut parfois

sembler un peu “concentrée”. Vous pouvez alors l’ajuster en étirant les bords de l’image.

Cliquez sur Scan pour numériser la partie sélectionnée en haute résolution. Après cela, chaque

fois que vous cliquerez sur Scan seule la partie sélectionnée sera numérisée, jusqu’au prochain

changement.

* Vérifiez que toute la page que vous voulez numériser se trouve sur la vitre du scanner.

Peu importe si votre original est plus grand que Lettre/A4, tant que la musique elle-même

s’ajuste à Lettre/A4.

* Si vous numérisez une page plus petite que le format Lettre/A4, la position de la feuille sur la

vitre a moins d’importance. Cependant, ajuster le bord de la feuille au bord de la vitre vous

assurera que votre page est bien droite.

* Si vous voulez numériser un petit livre de partitions, vous pourriez avoir envie de numériser

deux pages en même temps, en tenant le livre ouvert sur la vitre du scanner; ne le faites pas,
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étant donné que PhotoScore Lite ne peut lire qu’une seule page à la fois. Numérisez donc chaque

page séparément.

* Pour plus de simplicité, nous vous recommandons de numériser toutes les pages d’une partition

avant de les lire. Il vous est loisible de numériser une page, de la lire, puis d’en numériser une

nouvelle et ainsi de suite, (cf. FONCTIONS AVANCÉES ci-dessous ), mais nous ne vous

suggérons pas de le faire tant que vous n’êtes pas familiarisé avec PhotoScore Lite.

2. LECTURE
Comme mentionné ci-dessus, le résultat d’une numérisation représente, pour l’ordinateur, une

grille de millions de points noirs ou blancs, et ce, que le document numérisé soit une photo, un

texte, ou une partition.

“Lire” la musique est la partie la plus intelligente, au cours de laquelle Photoscore Lite “reconnaît”

la musique sur la page numérisée.

Le panneau “pages”
À gauche de la fenêtre de PhotoScore Lite vous devriez voir le panneau

pages, tel qu’affiché ci-contre. Si vous ne pouvez pas le voir, choisissez

View > Toggle Pages Pane.

Les pages qui n’ont pas été lues apparaîtront dans la partie supérieure du

panneau pages, sous l’intitulé Pending Pages. Remarquez que

PhotoScore Lite affiche de manière bien pratique une prévisualisation de

la page numérisée quand vous déplacez le pointeur de la souris au-

dessus de son nom.

Pour lancer la lecture d’une page numérisée, cliquez sur la petite coche à

droite, qui s’agrandit en affichant Read quand vous passez le pointeur de

la souris dessus. PhotoScore Lite va commencer à agir et la barre bleue

sous le nom de la page va devenir verte tandis que PhotoScore lit la page.

Si vous avez accidentellement numérisé des pages dans un ordre

incorrect, vous pouvez le modifier dans la liste Pending Pages en

cliquant la page souhaitée et en la déplaçant simplement à la bonne place.

Si vous avez seulement numérisé quelques pages ou ouvert un PDF, vos pages auront déjà été lues

par PhotoScore Lite, et figureront dans la partie inférieure du panneau pages, sous l’intitulé Read
Pages. Les pages sont automatiquement regroupées dans les partitions; vous pouvez afficher ou

masquer des pages individuelles dans chaque partition en cliquant le bouton + ou – à gauche.

Pour afficher une page en vue de l’éditer, cliquez-en le nom sous Read Pages.

Que lit Photoscore Lite
PhotoScore Lite lit les symboles musicaux suivants:

* Les notes et les accords (ainsi que la direction des hampes, des ligatures), les silences.

* Les dièses, bémols et bécarres

* Les clés de sol et de fa, les armures et les indications de mesure
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* Les portées de 5 lignes (normales ou réduites), les barres de mesures standard et les portées de

tablature de guitare à 6 lignes

* Le format de la page, y compris la taille de la page, la taille de la portée, les marges ainsi que la

fin des systèmes.

PhotoScore Ultimate, disponible séparément, lit aussi les textes (tels que les paroles, les nuances,

les noms des instruments, les doigtés, etc....), un grand nombre de clés et d’altérations

accidentelles, les multiplets, les diagrammes d’accord et diverses autres indications tels que les

codas, les signes de reprise, les ornements, les pédales et les lignes de fin de reprise. Photoscore

Ultimate peut même lire de la musique soigneusement manuscrite.

Astuces concernant la lecture
* Bien que ce soit à éviter, si vous deviez interrompre la lecture, pressez Esc ou X., ou cliquez sur

Cancel dans la fenêtre de progression des tâches. PhotoScore Lite vous montrera la partie de la

page qui a déjà été lue. Vous pouvez effacer cette page en cliquant sur Edit > Delete page avant

de recommencer à numériser ou à lire la page.

* Si l’ordinateur affiche un avertissement pendant la lecture de la page, ou s’il vous semble que le

temps de lecture est très long, consultez la section PROBLÈMES POSSIBLES ci-dessous.

* Si vous le désirez, vous pouvez demander à PhotoScore Lite de lire juste une seule page scannée,

ou faire une sélection de plusieurs pages au lieu de la partition entière; consultez FONCTIONS
AVANCÉES ci-dessous la section.

3. ÉDITION
Lorsque PhotoScore Lite a terminé de lire la musique, l’interprétation de la première page apparaît

à l’écran, dans une fenêtre appelée fenêtre de sortie. C’est ici que vous pouvez corriger les erreurs

faites par PhotoScore Lite.

Notez que le panneau des pages n’apparaît pas dans l’illustration ci-dessus; pour avoir plus de place

quand on édite la partition, on peut la masquer en choisissant View > Toggle Pages Pane
(raccourci Ctrl+E ou XE).
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La partie supérieure de la fenêtre (avec un fond coloré) affiche la partition originale. La fenêtre

Full detail view dans le coin supérieur droit affiche une portion agrandie de la page originale,

selon l’endroit où se trouve le pointeur de la souris.

La grande partie inférieure de la fenêtre (avec un fond gris) montre comment PhotoScore Lite a

interprété la première page numérisée– ce qu’il pense de ce que doit être la première page, en

somme. C’est dans cette partie que les erreurs peuvent se produire.

Dans le coin supérieur gauche de la fenêtre, vous pourrez voir (par exemple) Page 1 of 2, et en

cliquant sur les flèches, vous pourrez naviguer entre toutes les pages lues. Il paraît logique d’éditer

complètement la première page, puis de passer à la suivante et ainsi de suite.

Dans le coin inférieur droit de la fenêtre se trouve le pavé, qui comporte des fonctions similaires à

celles que l’on peut trouver dans Sibelius. Vous pouvez repositionner cette fenêtre en la saisissant

par sa barre de titre et en la tirant.

Il y a un menu Insertion au-dessus de la fenêtre, qui reprend aussi des fonctions similaires à celles

du menu Insertion de Sibelius, les fonctions non adaptées à PhotoScore Lite étant ignorées.

Que pouvez vous corriger?
La correction minimale à effectuer avant de transférer la partition dans Sibelius est d’adapter

l’indication de métrique ainsi que l’armure. D’autres erreurs comme la hauteur de note peuvent

être corrigées dans Sibelius, mais corriger les armures et les indications de mesure est bien plus

facile dans PhotoScore Lite, et nous vous recommandons donc de le faire.

En particulier, si vous numérisez une partition transposée, vous devrez corriger l’armure des

instruments transposés – pour effacer une armure, sélectionnez-la et tapez Ctrl+Effacer ou X-

Effacer. Ajouter alors la bonne armure: choisissez Insertion > Armure (raccourci K), et Ctrl+clic

ou X-clic sur la portée à laquelle vous voulez ajouter l’armure.

Pour corriger les erreurs rythmiques, ajoutez d’abord la bonne indication de métrique si ce n’est

déjà fait: choisissez Insertion > Indication de mesure (T) et cliquez sur l’une des portées pour

l’ajouter. Une fois cette indication métrique connue de PhotoScore Lite, toutes les imprécisions

rythmiques seront indiquées par des petites notes rouges sur la portée, montrant les temps

manquants ou en trop. Lorsque ces erreurs seront corrigées, ces petites notes disparaîtront, vous

pourrez alors transférer votre partition vers Sibelius.

Lorsque vous serez plus habitué avec PhotoScore Lite, vous pourrez totalement corriger la

partition dans PhotoScore Lite avant de l’envoyer dans Sibelius. L’avantage de cette méthode est

que vous pourrez comparer la partition scannée (fichier image) et la partition lue sur laquelle vous

effectuez les corrections.

Vérifier les erreurs
Vérifiez les erreurs en comparant la partie inférieure de la partition avec le fichier original au-

dessus. Les parties supérieures et inférieures bougent en fonction de la partie de la page pointée

par la souris.

Évitez la tentation de comparer les pages obtenues avec l’original sur papier – c’est toujours

beaucoup plus rapide de faire la comparaison à l’écran.
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Dans le coin supérieur droit de la fenêtre de sortie se trouve une vue détaillée montrant la partie de

l’original pointée par la souris. Ctrl+clic ou X-clic sur cette fenêtre agrandira ou réduira la fenêtre.

Cette fenêtre peut être repositionnée en la tirant par sa barre de titre.

Exécution MIDI
Une autre manière de contrôler les erreurs est d’exécuter la partition. Votre ordinateur devra être

équipé d’un matériel MIDI pour pouvoir exploiter cette fonction (si vous avez plus d’un instrument

MIDI connecté, uniquement celui par défaut sera utilisé).

Pour exécuter la partition depuis le début, assurez-vous qu’aucune partie n’est sélectionnée en

cliquant sur un emplacement vide de la partition. Choisissez alors Exécution > Exécuter/Stopper
(raccourci Espace), ou cliquez le bouton Exécuter dans la barre d’outils. Faites de même pour

arrêter la musique. Pour jouer à partir d’un emplacement précis de la page, sélectionnez un objet

dans chacune des portées que vous voulez exécuter. L’exécution débutera depuis le début de la

mesure contenant la première sélection.

Par défaut, toutes les portées seront jouées avec un son de piano, mais vous pouvez modifier ce

son: faites un clic droit ou Ctrl-clic sur les noms au début du premier système (par exemple Portée
1), choisissez Instruments dans le menu Contexte puis cliquez sur Renommer. Vous verrez une

boîte de dialogue similaire à celle de Sibelius Insertion > Instruments, depuis laquelle vous

pourrez choisir le nom désiré (et aussi le son) utilisé par la portée.

Pendant que la musique est exécutée, la mesure en cours est surlignée en gris. 

4. ENVOYER VERS SIBELIUS
Une fois les pages éditées, vous pourrez les envoyer vers Sibelius.

Choisissez File > Send to > Sibelius (raccourci Ctrl+D ou XD), ou

cliquez sur l’icône  près du bouton Sauvegarder dans le haut de la

fenêtre de sortie.

Si Sibelius n’est pas déjà lancé, il s’ouvrira et la boîte de dialogue

Ouvrir un fichier PhotoScore ou AudioScore apparaîtra:

* Ceci est une partition transposée: activez cette option si votre

partition contient des instruments transpositeurs, vous serez alors

invités à choisir l’instrument adéquat lorsque vous cliquerez

sur OK

* Utiliser les instruments par défaut: ouvre le fichier sans se préoccuper des instruments

utilisés dans la partition

* Choisissez les instruments: vous permet de spécifier un instrument pour chaque portée

depuis une boîte de dialogue similaire à celle de Instruments; choisissez la portée de la musique

scannée que vous voudriez remplacer par un instrument de Sibelius, cliquez alors sur Ajouter.

Si vous ajoutez un instrument qui habituellement utilise deux portées (comme le piano), deux

des portées se trouvant dans la liste la plus à gauche de la boîte de dialogue seront utilisées.

* Laisser Sibelius choisir les instruments: avec cette option active, Sibelius va tenter de

déterminer quels instruments sont utilisés dans la partition en utilisant le nom des portées
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réglées dans Photoscore – si pour une portée, le nom ne peut être reconnu, Sibelius ouvrira le

fichier avec le son de piano

* Utiliser les dimensions de la page numérisée: cette option indique à Sibelius de formater la

partition en fonction de la taille de la page suggérée par Photoscore. Par défaut, c’est la taille du

papier manuscrit qui sera utilisée, mais vous pouvez modifier cette donnée.

* Les options de Paramètres de document permettent de choisir le format de la page, le style
maison et l’orientation (Portrait ou paysage) de la partition obtenue

Une fois que votre musique a été ouverte dans Sibelius, vous pouvez la modifier comme vous le

désirez, comme si vous l’aviez encodé vous même – mais vous pouvez consulter Instruments à
plusieurs portées plus loin pour en savoir plus.

Éditer les erreurs rythmiques
Si vous envoyez dans Sibelius une partition qui contient des mesures dans lesquelles il manque des

temps, ou qui contiennent des temps de trop, Sibelius va allonger ou raccourcir les mesures.

Pour cela, Sibelius compare la longueur de la mesure avec l’indication de métrique prédominante.

Si une mesure est trop courte, Sibelius la complétera en y insérant des silences à la fin. Si la mesure

est trop longue, Sibelius la raccourcira en ignorant une ou plusieurs notes/silences à la fin de la

mesure.

Bien que Sibelius ajuste la longueur des mesures de cette manière, il est vivement conseillé

d’effectuer les corrections rythmiques dans Photoscore, cela vous fera gagner du temps.

Format
Sibelius utilise Assembler en un système et Assembler en une Page pour s’assurer que le

format de la partition soit le même que l’original. Cependant, si les notes semblent trop proches ou

trop éloignées, essayez de modifier la taille de la portée dans la boîte de dialogue Mise en page >

Configuration de document (raccourci Ctrl+D ou XD). Alternativement, si vous n’avez pas

besoin que la mise en forme de la partition corresponde à l’original, sélectionnez toute la partition

(Ctrl+A ou XA) et déverrouillez la mise en forme (Ctrl+Shift+U ou xXU).

Instruments à plusieurs portées
Pour les instruments qui par défaut utilisent deux portées, comme le piano, avoir des ligatures qui

croisent les portées peut vous sembler impossible. Cela provient du fait que PhotoScore Lite

considère toutes les portées comme instruments séparés, ce qui signifie que, par défaut, les

instruments à portées multiples, comme les claviers, seront envoyés vers Sibelius sous forme de

deux portées distinctes. 

Lorsque vous envoyez un fichier Photoscore vers Sibelius, vous pouvez utiliser la boîte de dialogue

Ouvrir un fichier Photoscore pour indiquer à Sibelius que les portées 1 et 2, par exemple, sont

respectivement la main droite et la main gauche d’un système de piano – ou choisissez les

instruments vous-même, ou encore cliquez sur Laisser Sibelius choisir les instruments.

Pour les portées multiples d’instruments, comme Flûtes 1+2, vous pouvez spécifier qu’elles soient

écrites sur des portées reliées avec un seul nom, vous pourriez aussi importer chaque portée

comme portée de flûte, modifier le nom et les relier dans Sibelius, ou importer les deux portées

comme portée de piano et changer le nom ainsi que le son (b 4.3 Table de mixage).
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Si votre original contient des instruments qui ont un nombre différent de portées sur différents

systèmes (par exemple les cordes qui sont parfois divisi), reportez vous à la section – cf.

FONCTIONS AVANCÉES ci-dessous.

Supprimer la partition éditée
Une fois la partition numérisée et envoyée dans Sibelius, et si vous êtes satisfait du résultat, vous

pouvez l’effacer dans Photoscore Lite si vous voulez en numériser une nouvelle. Pour cela, cliquez

sur le bouton Fichier > Effacer la partition qui se trouve au-dessus de la fenêtre de sortie.

Supprimer les numérisations non désirées
PhotoScore Lite sauve chaque page que vous numérisez en un fichier image, ce qui occupe une

place non négligeable sur votre disque dur, vous pouvez donc régulièrement effacer les

numérisations qui ont été lues automatiquement. En revanche, vous ne pouvez pas supprimer les

scans avant de scanner le prochain morceau.

Pour effacer ces fichiers:

* Si le panneau pages n’est pas en cours d’affichage, choisissez View > Toggle Pages Pane
(raccourci Ctrl+E ou XE)

* Cliquez sur le nom de la page à supprimer; vous pouvez sélectionner plus d’une page à la fois en

maintenant enfoncé Maj et en cliquant ailleurs dans la liste. Quand une page est sélectionnée, le

mot Remove apparaît à droite du nom: cliquez sur Remove pour supprimer les pages.

* PhotoScore vous avertira que vous êtes en train de supprimer ces pages: cliquez sur Yes pour

confirmer la suppression.

PROBLÈMES POSSIBLES

La numérisation prend beaucoup de temps
Si vous ne voyez aucune activité au niveau de la numérisation, – par exemple, après avoir cliqué sur

le bouton Scan ou Preview le scanner reste silencieux – la communication entre l’ordinateur et le

scanner a probablement été interrompue.

Vérifiez que le scanner est bien allumé, et que le câble reliant le scanner à l’ordinateur est bien

branché des deux côtés. Si cela ne fonctionne pas, essayez de réinstaller le pilote TWAIN de votre

scanner.

Tenez compte du fait que certains scanners ont besoin d’être allumés avant que l’ordinateur ne

démarre.

Certaines portées ou systèmes ne sont pas détectés
Si après une numérisation, toutes les portées ne sont pas surlignées en bleu, ou si les portées ne

sont pas correctement reliées en systèmes par un trait vertical rouge, il peut y avoir plusieurs

causes:

* La partition a 13 (ou plus) portées sur une page; seul PhotoScore Ultimate peut numériser les

partitions de plus de 12 portées.
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* L’original n’est pas bien placé sur la vitre du scanner: fermez toujours le couvercle pendant la

numérisation, à moins que vous ne scanniez un livre épais. Vous pouvez également appuyer

légèrement sur le couvercle du scanner pendant la numérisation.

* La page est numérisée à une résolution trop faible (par exemple, les portées sont plus petites que

vous ne le pensiez): contrôlez la taille des portées, modifiez les réglages du scanner et

recommencez.

* Vous tentez de numériser une double page (par exemple depuis une partition miniature), mais

PhotoScore Lite ne peut pas lire les pages en une fois. Recommencez la numérisation de chacune

des pages séparément. Assurez-vous que la musique sur le seconde page n’est pas sur la vitre car

Photoscore pourrait ne pas pouvoir lire le tout correctement.

* Les portées ne sont pas assez claires dans l’original que pour être détectées; dans ce cas, vous

pouvez signaler à Photoscore Lite l’emplacement des portées manquantes sur FONCTIONS
AVANCÉES ci-dessous.

La lecture prend beaucoup de temps
* Si la page a été numérisée sans être correctement contre la vitre ou avec le couvercle ouvert, vous

pourriez obtenir une bordure noire qui pourrait cacher certaines parties de la partition.

Cela peut rendre l’opération de lecture très longue. Si cela produit, interrompez la lecture et

recommencez la numérisation.

* Si toutes les pages ne sont pas détectées après la numérisation (par exemple, certaines ne sont

pas surlignées en bleu): la lecture peut être ralentie. Cf. ci-dessus Certaines portées ou
systèmes ne sont pas détectés.

La musique est lue de manière inexacte
Si vous trouvez que la lecture de la musique manque de précision:

* l’original n’est pas de bonne qualité, par exemple une photocopie ou une édition plus ancienne;

* l’original est écrit à la main (ou utilise une police de caractère qui imite l’écriture à la main):

PhotoScore Lite n’est pas conçu pour lire la musique manuscrite;

* la musique utilise plus de deux voix;

* la page a été scannée en noir et blanc et n’est pas assez droite, recommencez la numérisation en

gris;

* la page n’était pas assez droite et l’option Make image level n’était pas sélectionnée dans les

préférences (cf. FONCTIONS AVANCÉES ci-dessous );

* les symboles musicaux utilisés dans l’original ont une taille ou une forme non standard.

FONCTIONS AVANCÉES
PhotoScore Lite propose plusieurs options et caractéristiques pour un usage avancé.

Il est vivement recommandé que vous vous familiarisiez avec cette section avant de vous lancer

dans une numérisation intensive, comme des partitions d’orchestre, ou contenant plusieurs pages.

Choisir le scanner
Si plusieurs scanners sont connectés à votre ordinateur, sélectionnez celui que vous voulez utiliser

en choisissant Fichier > Sélectionner le scanner.
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Ajuster les portées/systèmes détectés
Lorsque vous numériser une page, PhotoScore Lite surligne en bleu les portées qu’il détecte, et

joint les systèmes par un trait vertical rouge.

Cependant, si la page originale est de faible qualité, PhotoScore Lite peut ne pas détecter certaines

portées/systèmes; vous devrez alors indiquer à Photoscore Lite où ces portées/systèmes se

trouvent.

La méthode la plus facile est de sélectionner la portée surlignée en bleu la plus proche (en cliquant

dessus) et de la copier (Alt+clic ou z-clic) sur la ligne centrale de la portée manquante (la position

horizontale a peu d’importance).

Vous pouvez créer une portée bleue directement numérisée en la cliquant et en tirant avec le

bouton gauche de la souris.

Après avoir créé la portée, assurez-vous qu’elle est reliée aux autres portées du même système

(voyez plus bas).

PhotoScore Lite placera automatiquement la portée à sa place, en ajustant sa position et sa taille,

s’il trouve une portée appropriée en dessous. Si cela ne se fait pas correctement, étirez l’image à sa

taille entière (en cliquant sur le bouton noté 100 sur le dessus) et ajustez-le en utilisant les

“poignées” bleues.

* Vous pouvez aussi tirer vers le haut ou le bas toutes les portées bleues avec le bouton gauche de la

souris. Cela aussi place automatiquement la portée.

* Vous pouvez étirer la fin des portées bleues, et aussi les mettre dans un angle. 

* Vous pouvez modifier la taille de n’importe quelle portée bleue – tirez les “poignées” dans le

milieu de la portée, vers le haut ou le bas. PhotoScore Lite peut lire des pages qui présentent des

portées de différentes tailles, et chaque portée bleue peut avoir une taille différente. La poignée

circulaire au-dessus de la portée permet de modifier sa courbure ce qui peut vous être utile

lorsque vous numérisez des pages depuis un livre relativement épais.

* Si une portée numérisée reste sans portée bleue au-dessus d’elle, la portée numérisée et ce qui y

est inscrits seront ignorés lors de la lecture de la page. Cela peut ralentir la lecture, mais reste

tout à fait inoffensif.

* Pour relier deux portées adjacentes dans un même système, cliquez sur une portée; elle devient

rouge, faites alors Alt+clic ou z-clic sur l’autre portée. Elles seront reliées par un trait vertical

rouge.

* Pour séparer deux portées en deux systèmes distincts, procédez de la même manière que pour

relier deux portées.

* PhotoScore Lite devinera automatiquement si des portées doivent être jointes ou non lorsque

vous en créez de nouvelles, ou déplacez des portées existantes.

* Si vous avez manqué la portée bleue et voulez recommencer, faites Ctrl+double-clic ou

X-double-clic sur la numérisation et PhotoScore Lite rétablira les portées bleues à leur position

originale.

* Une fois que l’édition des portées/systèmes est terminée, vérifiez que les portées sont

correctement reliées en systèmes car vous ne pourrez plus modifier quoi que ce soit une fois la

lecture faite.
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Options de la fenêtre de numérisation
Si vous avez choisi d’utiliser l’interface de numérisation de PhotoScore dans File > Scanner Setup,

vous verrez plusieurs options et boutons supplémentaires disponibles dans la fenêtre de

numérisation:

* Le bouton Read this page lira uniquement cette numérisation. Cliquez sur la flèche, un menu

vous permettra de spécifier l’endroit auquel cette page doit être insérée dans la partition.

* Scale donne la possibilité d’agrandir ou réduire la numérisation. Le bouton sur la droite de

Scale agrandira l’image de telle sorte qu’elle occupe toute la fenêtre; 50 zoomera à 50%; 100 à

100%.

* Upside down retourne rapidement l’image de 180°, dans le cas où elle a été numérisée à

l’envers.

* Re-scan renumérise la page à nouveau.

* On side fait pivoter l’image de 90°, si elle a été numérisée du mauvais côté.

Portées ignorées
Dans les partitions contenant beaucoup d’instruments, et particulièrement dans les partitions

d’orchestre, les portées inutilisées sont souvent ignorées.

Si vous remplacez le nom par défaut de l’instrument (par exemple portée 1) par son nom propre,

Photoscore Lite allouera les instruments aux portées des systèmes concernés, en respectant l’ordre

du haut vers le bas. Cependant, si la page originale ignore un instrument d’un système, certaines

portées auront un nom inexact. Dans ce cas, pour corriger les noms, faites un clic droit ou

Contrôle-clic sur le nom existant (contre la portée en question) et choisissez le nom correct dans

la liste des instruments.

Dans tout système présentant des portées ignorées, vous aurez probablement à corriger plusieurs

noms d’instruments de la même manière. Faites-le avec précaution, au risque de provoquer une

certaine confusion.

Instruments à plusieurs portées
Pour les instruments à portées multiples, comme les claviers ou les cordes ou bois divisés,

PhotoScore Lite traitera chaque portée comme un instrument séparé.

Si le nombre de portées pour un tel instrument varie dans l’original, par exemple où les cordes sont

divisées, il vaut mieux donner des noms différents pour éviter les confusions, par exemple Alto a
et Alto b. Vous pourrez modifier les noms une fois la partition envoyée dans Sibelius.

Dans les cas où des portées sont ignorées, voyez la section Portées ignorées, cf. ci-dessus.

N.B. Si le nombre de portées de l’instrument augmente (passant de 1 à 2) dans la partition, et que

la seconde portée ne s’est pas présentée auparavant, traitez-la Instruments/portées
introduits après le début en suivant (cf. ci-dessous).

Instruments/portées introduits après le début
Certaines partitions contiennent des instruments ou portées qui ne sont pas présents dans le

premier système.
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Dans ce cas, dans les systèmes sur lesquels sont introduits les instruments/portées pour la

première fois, pratiquez de la façon suivante:

* Corrigez d’abord le nom de chaque portée:

Faites un clic-droit (Windows) ou Contrôle-clic (Mac) sur chaque nom et choisissez le nom

correct depuis la liste d’instruments.

* Indiquez alors à PhotoScore Lite le nom des instruments/portées nouvellement introduits

* Placez le pointeur au-dessus du nom qu’il a rempli (comme par exemple Portée 5 ou encore le

nom d’un instrument omis). Faites un Clic droit (Windows) ou Contrôle-clic (Mac), cliquez sur

Nouveau et prenez un nom à partir de la liste des instruments affichés (liste similaire à celle de

la boîte de dialogue Instruments de Sibelius). Si vous souhaitez un nom qui n’est pas standard,

vous pouvez modifier le nom au bas.

Exécutez ceci avec précaution afin d’éviter que des confusions n’apparaissent.

Petites portées
Dans la fenêtre de sortie, les portées réduites sont affichées en pleine taille pour qu’elles soient bien

lisibles, mais elles sont notées du symbole ci-dessous à la fin de la porté:

Autres préférences
La boîte de dialogue File > Preferences contient d’autres options, décrites ci-dessous.

Sur la page Scanning :

% Automatic scanning et Scan more quickly sont seulement disponibles dans PhotoScore

Ultimate

% PhotoScore: si ceci est sélectionné, PhotoScore utilise sa propre interface de numérisation

% TWAIN (scanner default): si c’est l’option choisie, l’interface standard TWAIN (qui

fonctionne avec tous les scanners) sera utilisée quand vous choisirez File > Scan pages

% Select TWAIN scanner sert à choisir le scanner à utiliser par PhotoScore

% Make scans level: avec cette option activée, PhotoScore Lite vérifiera si la numérisation n’est

pas inclinée et remettra les portées horizontales si elles ne l’étaient pas. Il est recommandé de

laisser cette option activée.

% Read pages after scanning/opening est seulement disponible dans PhotoScore Ultimate.

* Sur la page Reading, dont la plupart des options sont désactivées (car elles ne sont disponibles

que dans PhotoScore Ultimate), la seule option que vous pouvez activer ou désactiver est Ties,
Slurs and Hairpins, qui est partiellement fonctionnelle car Photoscore Lite ne reconnaît que les

liaison rythmiques.

* Sur la page Editing :

% Automatic page margins: crée des marges sur chaque page.

% Attach scanned staff panel to current staff: dans la fenêtre de sortie, la numérisation

originale sera placée juste au-dessus de la portée surlignée au lieu d’être dans la partie
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supérieure de la fenêtre, ce qui peut être plus facile pour faire les comparaisons. ce qui peut

être plus facile pour faire les comparaisons.

% Drag paper by: vous permet de spécifier si vous tirez le papier en le cliquant et tirant, ou en

maintenant Maj enfoncé et tirant (de la même manière que proposent les options de la

page Souris de la boîte de dialogue Fichier > Préférences).

* Sur la page Avancé :

% MIDI playback device vous permet de choisir quels périphériques d’exécution Photoscore

utilisera pour l’exécution

% System playback properties lance la boîte de dialogue de votre système qui concerne les

propriétés des périphériques de son et d’audio, pour que vous puissiez y choisir les

périphériques d’exécution et d’enregistrement et votre périphérique MIDI favori

% Display splash screen at start-up: désactive l’affichage du panneau de démarrage de

PhotoScore Lite

% Auto-save to backup file every n minutes: réalise automatiquement la sauvegarde de la

partition à intervalles réguliers spécifiés préalablement.

Si vous modifiez l’une de ces options, elles seront les nouveaux réglages par défaut jusqu’à ce que

vous les modifiez à nouveau.
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1.6 Entrée audio

AudioScore Lite de Neuratron est un programme de transcription conçu pour fonctionner avec

Sibelius. Vous pouvez l’utiliser pour entrer de la musique dans Sibelius en jouant un instrument

acoustique monophonique (comme une flûte, clarinette ou trompette) ou en chantant dans un

microphone – ou vous pouvez importer un fichier audio existant au format .wav ou .aiff.

AudioScore écoute votre performance, transcrit les notes, et vous permet de les éditer avant de les

envoyer vers Sibelius pour une modification ultérieure.

Aide à l’écran
Outre ce paragraphe, AudioScore Lite possède sa propre aide intégrée : pour y accéder, choisissez

Aide > Neuratron AudioScore aide dans les menus d’AudioScore Lite.

AudioScore Ultimate
Une version évoluée de AudioScore Lite, appelée AudioScore Ultimate est disponible séparément.

AudioScore Ultimate peut reconnaître jusqu’à 16 instruments ou notes simultanément, peut

importer des fichiers audio MP3, lire de la musique directement depuis un CD audio, et prend en

charge une modification de notes plus avancée. La version Windows d’AudioScore Ultimate peut

également servir à entrer directement des notes dans Sibelius, en saisie en mode pas-à-pas ou

Flexi-time.

Pour en savoir plus sur AudioScore Ultimate, contactez votre revendeur Sibelius.

Installer et désinstaller AudioScore Lite
Reportez-vous au Manuel individuel pour savoir comment installer ou désinstaller AudioScore Lite.

Microphones compatibles
AudioScore Lite est compatible avec tout microphone relié à votre ordinateur via USB, ports

d’entrée microphone ou ports d’entrée haut-niveau. Toutefois, les microphones bon marché – qui

produisent généralement de grandes quantités de parasites sonores – risquent de ne pas donner de

bons résultats. Indice que votre microphone risque de ne pas être de qualité suffisante : l’indication

de niveau d’AudioScore Lite à l’enregistrement affiche un niveau élevé, même lorsque vous ne

jouez ou ne chantez pas.

AudioScore Lite tentera de reconnaître la performance indépendamment de ces éléments, mais le

résultat sera moins précis, notamment aux extrémités des hauteurs de note. Jouer ou chanter plus

fort ou plus près du microphone (en veillant à ne pas y toucher ou souffler dessus) peut aider, mais

si vous souhaitez exploiter AudioScore au meilleur de sa capacité, un microphone de bonne qualité

améliorera la qualité des résultats que vous pouvez obtenir.

Performances adaptées
Pour de meilleurs résultats, essayez de jouer ou de chanter de manière aussi claire et nette que

possible, en suivant un tempo régulier. Par exemple, si vous jouez du violon, déplacez vos doigts

entre les cordes aussi silencieusement que possible, et évitez de cogner contre le corps de

l’instrument avec l’archet ou vos doigts. Essayez de jouer ou de chanter dans un environnement

aussi calme que possible (notamment en ce qui concerne les interférences électriques, qui

produiront la plupart du temps un souffle rauque si vos câblages sont mal protégés).
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Partitions avec copyright
Prenez garde au fait que si vous enregistrez la partition d’un tiers sans avoir son autorisation, vous

ne respectez pas le copyright. Outrepasser le copyright est illégal et dans tous les cas est interdit

dans le contrat de licence de Sibelius.

Démarrer avec AudioScore Lite
Le meilleur moyen de commencer consiste à choisir Fichier > Transcrire avec AudioScore dans

les menus de Sibelius. AudioScore Lite (ou AudioScore Ultimate, si installé) sera exécuté.

Dans AudioScore Lite, choisissez Fichier > Choisir périphériques pour vérifier si les

périphériques d’entrée audio et de sortie MIDI sont sélectionnés. Vous devez veiller à bien choisir

le périphérique d’entrée qui correspond à l’entrée à laquelle votre microphone est relié ; à moins

que votre microphone soit branché via USB, cela peut être quelque peu obscur.

Les trois étapes
L’utilisation de AudioScore Lite se déroule selon les trois étapes suivantes :

* Créer des pistes. AudioScore enregistre votre performance, décrypte les notes et les hauteurs de

note jouées, et détermine le rhythme de votre performance. AudioScore Lite vous permet de

créer jusqu’à quatre pistes (soit quatre instruments, ou quatre portées dans Sibelius) dans un

seul projet.

* Editer des pistes. Editer la performance pour créer une partition de base contenant le rythme et

les hauteurs de notes souhaités.

* Envoyer vers Sibelius. Il suffit de cliquer sur un bouton. Après quelques instants, la musique

apparaît dans Sibelius, comme si vous l’aviez saisie avec une autre méthode d’entrée.

Vous pouvez ensuite exécuter la partition, la réarranger, la transposer, créer des parties ou

l’imprimer.

1. CREER DES PISTES
La première étape consiste à créer une ou plusieurs pistes, soit en enregistrant à l’aide d’un

microphone, ou en ouvrant un fichier audio existant (au format .wav ou .aiff).

Enregistrer une nouvelle piste à l’aide d’un microphone
Cliquez sur Enregistrer nouvelle piste sur la barre d’outils (raccourci * sur le clavier numérique).

Avant le début de l’enregistrement, cette boîte de dialogue apparaît :
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* Si vous souhaitez enregistrer suivant un clic de métronome, vous pouvez choisir parmi l’un des

tempos prédéfinis (ex. Adagio (lent) ou Allegro (rapide)), ou entrer un tempo de votre choix

en quarts de note (noire) par minute.

* Si vous souhaitez enregistrer à votre propre rythme sans clic de métronome, choisissez Calcul
sur performance. AudioScore fera de son mieux pour calculer automatiquement les durées de

note, et il est facile de les corriger s’il commet des erreurs.

* Que vous enregistriez suivant un clic ou non, vous devez régler l’indication de mesure avant de

commencer : seules les indications de mesure simples sont disponibles dans AudioScore Lite, et

si vous avez besoin d’indications de mesure composées (comme 6/8) vous devrez passer à

AudioScore Ultimate.

Vous pouvez maintenant cliquer simplement sur Enregistrer ou Ouvrir, auquel cas AudioScore

déterminera automatiquement l’instrument à utiliser, ou cliquer sur Instrument pour choisir

l’instrument avec lequel vous allez enregistrer :

* Tout d’abord, choisissez si vous souhaitez nommer vos instruments en anglais, en allemand ou

en italien.

* Ensuite, choisissez la famille d’instrument appropriée dans la liste Section.

* Enfin, choisissez l’instrument dans la liste Disponible, et définissez un Nom personnalisé si

vous le souhaitez.

Vous pouvez activer Configurer comme instrument par défaut pour toutes les pistes dans
cette composition si vous ne souhaitez pas avoir à choisir à nouveau l’instrument pour toute

autre piste que vous ajouterez par la suite.

Cliquez sur Enregistrer, et si vous choisissez de jouer suivant un clic de métronome, AudioScore

jouera une mesure de clics ; autrement, il commencera d’enregistrer immédiatement. Chantez ou

jouez dans votre microphone, et ce faisant, vous verrez la musique apparaître dans la moitié

supérieure de la fenêtre, appelée zone de performance :
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La zone de performance affiche l’interprétation d’AudioScore de la piste actuelle en termes de

hauteur de note et de temps, et est également l’endroit où vous éditez la hauteur, la position et la

durée des notes.

En dessous de la zone de performance figure la zone d’aperçu de partition, qui montre

l’interprétation d’AudioScore de toutes les pistes dans la notation : la piste actuelle indiquée dans la

zone de performance est mise en valeur en bleu clair dans la zone d’aperçu de partition.

Vous pouvez redimensioner la zone de performance et la zone d’aperçu de partition en cliquant et

en déposant la ligne de division entre les deux zones.

Vous verrez également une petite fenêtre de niveau d’entrée, qui montre le niveau d’entrée actuel en

provenance de votre microphone. Vous pouvez redimensionner cette fenêtre en cliquant et en

faisant glisser ses rebords.

Lorsque vous avez terminé l’enregistrement, cliquez sur Arrêter l’enregistrement sur la barre

d’outils, appuyez sur Espace (Windows uniquement), ou appuyez sur * sur le clavier numérique.

Selon la vitesse de votre ordinateur, AudioScore peut avoir besoin de terminer la reconnaissance de

notes dans votre performance avant de poursuivre : la barre d’informations en bas de la fenêtre

d’AudioScore vous indique la progression.

Enregistrer une autre piste
Pour enregistrer une autre piste, cliquez à nouveau simplement sur Enregistrer nouvelle piste.

La nouvelle piste est insérée directement en dessous de la piste sélectionnée dans la zone d’aperçu

de partition. Pour sélectionner une piste, cliquez sur le nom d’instrument dans la zone d’aperçu de

partition ; vous pouvez sélectionner plusieurs pistes adjacentes en cliquant sur Shift, ou plusieurs

pistes non-adjacentes via Ctrl+clic ou X-clic.

En enregistrant votre nouvelle piste, AudioScore reproduira toutes les pistes existantes (si aucune

piste a été sélectionnée avant de commencer l’enregistrement), ou seulement les pistes que vous

avez sélectionnées avant de commencer l’enregistrement. AudioScore utilisera les mêmes réglages
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de tempo et de métronome que ceux utilisés pour la piste précédente. Si votre première piste a été

enregistrée librement sans métronome, AudioScore utilisera le tempo déterminé d’après votre

première performance comme base en clic de métronome pour les pistes suivantes.

Insérer de la musique dans une piste existante
Pour insérer ou annexer plus de musique à une piste existante, sélectionnez la piste dans la zone

d’aperçu de partition en cliquant sur son nom, puis cliquez sur la zone de performance à l’endroit

où vous souhaitez insérer plus de musique. Choisissez Fichier > Enregistrer vers piste actuelle,

ou cliquez sur le petit bouton d’enregistrement  en haut à gauche de la zone de performance (pas

le bouton principal Enregistrer nouvelle piste sur la barre d’outils).

Créer une nouvelle piste à partir d’un fichier audio
Pour créer une nouvelle piste à partir d’un fichier audio, choisissez Fichier > Ouvrir, et choisissez le

fichier .wav ou .aiff que vous souhaitez ouvrir. De même que pour enregistrer une piste à l’aide

d’un microphone, AudioScore vous invite à choisir le tempo, l’indication de mesure et

l’instrument, et vous pouvez consulter Enregistrer une nouvelle piste à l’aide d’un
microphone pour obtenir de l’aide concernant ces réglages. A moins que vous ne connaissiez

déjà le tempo de votre fichier audio, vous devez choisir Calcul sur performance au lieu de l’un

des tempos prédéfinis.

2. EDITER DES PISTES
Après avoir enregistré une ou plusieurs pistes, la prochaine étape consiste à les éditer.

Lire la performance
Pour reproduire votre performance, cliquez sur la zone de performance pour définir la position de

démarrage, puis choisissez Lire > Lire/mettre original en pause (raccourci O) ou cliquez sur le

petit bouton de lecture vert  en haut à droite de la zone de performance. Les notes dans la zone

de performance sont mises en valeur pendant la lecture.

Reproduire une note individuelle
Pour reproduire une note individuelle, cliquez simplement sur la zone de performance. Si la note

fait partie d’un accord, double-cliquez sur la note pour lire tout l’accord.

Supprimer des pistes
Pour supprimer la piste actuelle (soit celle affichée sur la zone de performance, et mise en valeur

dans la zone d’aperçu de partition), choisissez Editer > Supprimer piste actuelle.

Pour supprimer plusieurs pistes, sélectionnez-les dans la zone d’aperçu de partition avec Shift-clic

ou Ctrl+clic ou X-clic, puis choisissez Editer > Supprimer pistes sélectionnées.

Attention : supprimer une piste ne peut être annulé, soyez vigilant !
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Modifier les notes
Vous ne pouvez modifier de notes que dans la zone de performance, pas dans la zone d’aperçu de

partition. En déplaçant le curseur de la souris au-dessus de la zone de performance, le curseur

change pour vous aider à comprendre quel genre de modifications vous pouvez effectuer. Notez

également que la barre d’informations noire en bas de l’écran se met à jour pour afficher des

informations utiles sur les éléments que votre curseur survole :

Pour sélectionner une seule note, cliquez simplement dessus. Pour sélectionner une étendue de

notes, cliquez dessus et faites-les glisser sur une portion vide de la zone de performance. Vous

pouvez également sélectionner une étendue continue de notes avec Shift-clic, ou ajouter des notes

individuelles à la selection via Ctrl+clic ou X-clic.

Les modifications suivantes peuvent être effectuées :

* Faites glisser une note vers le haut ou vers le bas pour changer sa hauteur. Maintenez la touche

Alt enfoncée ou z pour changer la hauteur par demi-mesures (semi-tons).

* Faites glisser l’extrémité gauche ou droite d’une note pour changer sa durée. Des silences sont

automatiquement créés dans la zone d’aperçu de partition si les notes ne sont pas liées. Lorsque

les notes sont liées, faire glisser la frontière entre les notes rallonge la première et raccourcit la

seconde.

* Faites glisser une note à gauche ou à droite pour changer sa position sur la mesure.

* Supprimez une note en la sélectionnant et en appuyant sur Supprimer.

* Pour diviser une note (ex. parce que AudioScore n’a pas détecté correctement deux notes ou plus

de la même hauteur l’une après l’autre), sélectionnez-la, puis choisissez Notes > Diviser en
deux/trois/quatre ; vous pouvez aussi cliquer droit (Windows) ou faire Control-clic (Mac) sur

une note pour voir ces options.

* Pour lier deux notes ou plus à une note individuelle (qui terminera par la hauteur de la première

note), sélectionnez les notes que vous souhaitez lier, et choisissez Notes > Lier notes en une.

Cette option est également disponible quand vous cliquez droit (Windows) ou faites Control-clic

(Mac) sur une note.

Déplacer des barres de mesure
Les lignes verticales dans la zone de performance indiquent les temps et barres de mesure : les

temps sont affichés en gris clair et les barres de mesure affichées en noir. Vous pouvez déplacer des

barres de mesure en cliquant simplement dessus et en les faisant glisser. Ce faisant, la zone

d’aperçu de partition s’actualise pour présenter la notation résultante.

Si votre performance originale a été enregistrée sur clic, vous pouvez disposer les barres de mesure

dans n’importe quel ordre, mais si votre performance originale a été enregistrée librement, vous

devez disposer les barres de mesure de gauche à droite.

Type d’objet Position de temps Hauteur Fréquence Mesure d’accord Tempo
 de note
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Insérer une mesure
Si vous devez insérer une mesure, cliquez sur la zone de performance à l’endroit où vous souhaitez

insérer une mesure, puis choisissez l’une des options dans le sous-menu Notes > Insérer mesure :

* Dans piste actuelle ajoute une seule mesure vide à la piste actuelle

* Dans toutes les pistes ajoute une seule mesure vide à toutes les pistes

* Autre vous permet d’ajouter plus d’une mesure à la piste actuelle à la(aux) piste(s)

sélectionée(s), ou à toutes les pistes. Dans la boîte de dialogue qui apparaît, vous pouvez

également activer Remplir avec des notes pour remplir les nouvelles mesures avec des notes.

Changer l’armure
AudioScore tente de déterminer automatiquement l’armure appropriée, mais dans le cas où vous

souhaiteriez la changer, choisissez Composition > Armure, puis choisissez l’armure souhaitée

depuis le sous-menu Armure majeure ou Armure mineure.

Changer l’indication de mesure
Si vous souhaitez changer l’indication de mesure après avoir fait votre choix initial lors de

l’enregistrement de la première piste, choisissez Composition > Indication de mesure, choisissez

l’indication de mesure souhaitée, et cliquez sur OK.

Changer d’instrument
Si vous souhaitez changer l’instrument utilisé par la piste actuelle, choisissez Composition >

Déterminer l’instrument pour la piste actuelle, choisissez l’instrument souhaité, et cliquez

sur OK.

Affichage de portée et affichage de trémolo de piano
AudioScore comporte deux modes pour afficher les notes dans la zone de performance. Par défaut,

il affiche les hauteurs de note sur une portée standard à 5 lignes. Quand vous faites glisser une note

vers le haut et le bas en mode diatonique, elle passe à la hauteur diatonique suivante, à moins de

maintenir enfoncé Alt ou z pour déplacer la note par demi-tons. 

Vous pouvez passer à l’affichage de roulement de piano en cliquant sur le bouton  en haut de la

zone de performance. Un clavier de piano apparaît à gauche de la zone de performance, et la note

sélectionnée est mise en valeur sur le clavier. Revenez à l’affichage de portée en cliquant sur .

3. ENVOYER VERS SIBELIUS
Une fois que vous êtes satisfait de l’apparence des pistes dans la zone d’aperçu de partition, vous

pouvez envoyer votre musique vers Sibelius.

Créer partition
Vous pouvez choisir Fichier > Créer partition pour formater la musique depuis la zone d’aperçu

de partition sous une page de musique, que vous pouvez éditer de manière similaire pour éditer de

la musique scannée dans PhotoScore (b 1.5 Numérisation). Toutefois, compte tenu du fait que

AudioScore Lite ne peut pas imprimer, et que vous possédez Sibelius, vous pouvez normalement

envoyer une partition directement vers Sibelius.
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Envoyer vers Sibelius
Pour envoyer votre partition vers Sibelius, cliquez simplement sur le bouton Envoyer vers
Sibelius sur la barre d’outils, ou choisissez Fichier > Envoyer vers > Sibelius (raccourci Ctrl+D ou

XD). Si Sibelius n’est pas encore exécuté, il sera lancé et une boîte de dialogue va apparaître en

vous invitant à choisir des instruments et à définir le format de page. Cette boîte de dialogue est la

même que celle qui apparaît lorsque vous envoyez de la musique depuis PhotoScore vers Sibelius –

pour en savoir plus, consultez la rubrique 4. ENVOYER VERS SIBELIUS à la page 36.

Enregistrer un fichier .opt
Si, pour une raison quelconque, cliquer sur le bouton Envoyer vers Sibelius ne fonctionne pas,

vous pouvez utiliser Fichier > Enregistrer sous pour enregistrer votre projet AudioScore en cours

sous un fichier PhotoScore (.opt). Une fois votre projet AudioScore enregistré sous un fichier

.opt, vous pouvez ouvrir le fichier .opt directement dans Sibelius via Fichier > Ouvrir.
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1.7 Saisie de tablature de guitare

b 2.10 Les symboles d’accord, 2.15 Guitare-notation normale ou tablature,

2.22 Tablature de luth.

Cet article explique comment entrer une tablature directement à partir du clavier de l’ordinateur,

ou en convertissant de la notation normale en tablature. Voici d’autres méthodes possibles:

* utiliser la fenêtre à la fenêtre Manche, b 1.8 Fenêtre Manche;

* importer un fichier MIDI, b 9.5 Ouvrir des fichiers MIDI;

* importer un ficher de tablature ASCII, b 1.5 Numérisation.

Sibelius est capable d’écrire automatiquement n’importe quel accord en notation normale ou en

tablature, cela sans aucune opération particulière; la tablature n’est qu’une autre manière d’afficher

la musique. Donc, avec une tablature, à peu près tout ce qui se réalise en notation normale est pos-

sible: lire, transposer, copier (vers d’autres portées de tablature ou de notation normale), etc.

Par conséquent, il est possible de saisir une tablature puis de la transformer en notation normale,

ou vice-versa, ou de transformer une tablature standard en tablature spécifique. Ou sitar.

Ou théorbe basse.

Créer un instrument en tablature
Les portées de tablature se créent automatiquement en choisissant la guitare ou tout autre instru-

ment à frettes avec le suffixe [tab] dans Insertion > Instruments (raccourci I). Dans la boîte de

dialogue, elles s’appellent par ex. Guitare [tablature].

Sinon, on peut transformer une portée normale en tablature avec un changement d’instrument:

choisissez Insertion > Autre > Changement d’instrument, choisissez l’instrument à tablature,

puis cliquez au début de la partition.

Transformer de la notation en tablature et vice-versa
Pour obtenir deux portées, l’une en notation normale et l’autre en tablature, affichant toutes deux

la même musique - ou pour transformer de la notation en tablature et vice-versa, il suffit simple-

ment de copier la musique entre les portées.

* Créez deux guitares, l’une normale, l’autre en tablature, ou utilisez simplement le papier à

musique Guitare + tablature 

* Entrez toute la musique sur, par exemple, la portée de notation

* Faites une sélection de type passage de toute la musique en triple-cliquant la portée de notation

* Copiez-la sur la portée de tablature en faisant un Alt+clic ou z-clic sur la première mesure. La

musique se transformera comme par magie en tablature:

* On peut ensuite modifier la tablature pour, par ex. déplacer certaines notes sur d’autres cordes,
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Vous pouvez également procéder dans l’autre sens: faites la saisie de la tablature, et copiez-la dans

la portée de notation. Vous pouvez ensuite, si vous n’avez pas besoin des deux portées (ou si vous

avez juste fait une conversion entre notation et tablature) supprimer la portée originale.

Sur une portée normale, la guitare s’écrit une octave plus haut que la hauteur réelle; donc, si la

musique est copiée d’une autre portée (par ex. d’un instrument non transpositeur tel que le piano),

elle apparaîtra une octave plus haut sur la portée de guitare bien qu’exécutée à la hauteur réelle.

Saisie d’une tablature
Réaliser une saisie de tablature à partir du clavier d’ordinateur est très simple; voici en quelques

lignes les opérations de base à suivre:

* Sélectionnez la mesure où commence la saisie, puis Notes > Saisie de notes (raccourci N)

* Le signe d’insertion (une courte ligne verticale) apparaît, indiquant sur quelle corde on se trouve

* Choisissez la longueur de note voulue en utilisant la fenêtre du pavé, ou en appuyant sur la

touche correspondante du pavé numérique de votre clavier

* Utilisez les touches 3 et 2 pour vous déplacer en haut ou en bas dans les cordes, et 0 et 1 pour

vous déplacer de gauche à droite dans la mesure

* Pour saisir une note, entrez le numéro de frette en utilisant les touches numériques sur le clavier

principal (pas le pavé numérique)

* Pour créer des quarts-de-ton sur une portée de tablature, créez la note normalement, puis (avec

la note sélectionnée) appuyez =. Un quart-de-ton apparaît sur une portée de tablature comme

un numéro de frette suivi d’un .5. Pour créer des quarts-de-ton sur une portée de notation, utili-

sez les altérations appropriées à partir du sixième pavé.

Il est possible de modifier la valeur de note par défaut qui définit le déplacement dans la mesure

avec les touches 0 et 1 dans la boîte de dialogue Notes > Options pour la saisie des notes; choi-

sissez Valeur définissant les positions d’insertion pour définir la valeur souhaitée. Désactivez

l’option Aligner lors de la saisie de tablature si vous préférez que le déplacement avec les

touches 0 et 1 s’effectue selon la valeur de note sélectionnée sur le pavé, sauf si une note figure

entre la position courante du signe d’insertion et la suivante, auquel cas celle-ci sera sélectionnée.

Notes hors tessiture
Lorsqu’on copie de la musique d’une portée sur une autre, par exemple d’une portée de tablature de

guitare à 6 cordes vers une portée de tablature de guitare à 4 cordes, ou d’une portée normale vers

une portée de tablature de guitare, certaines notes peuvent être injouables. Dans ce cas un point

d’interrogation rouge (?) apparaît sur la portée de tablature, pour montrer les accords à corriger.

Options des doigtés de tablature de guitare
Sibelius essaie de produire des tablatures comportant les doigtés les plus confortables quelque soit

le mode de création de la tablature: copie d’une portée de notation normale vers une portée de

tablature, copie d’une portée de tablature vers une autre pour un instrument d’accordage différent,

saisie à partir d’un clavier ou d’une guitare MIDI ou encore par importation d’un fichier MIDI

La section Doigtés de tablature de guitare de la page Saisie des notes du Fichier > Pré-
férences (dans le menu Sibelius sur Mac) sert à spécifier la longueur de touche à utiliser pour les
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doigtés, les frettes inférieures ou supérieures à choisir de préférence et si possible, l’utilisation des

cordes à vide si c’est possible, et l’extension maximale en frettes pour les accords.

Ces options sont seulement des recommandations et ne sont donc pas systématiquement respec-

tées. Par exemple, si l’option Utiliser de préférence des cordes à vide est désactivée mais que la

seule note possible doit être jouée sur une corde à vide, Sibelius écrira un doigté de corde à vide

plutôt que de ne pas écrire la note.

Sibelius ne fera pas la mise à jour de la tablature déjà existante dans la partition si vous faites une

modification dans cette boîte de dialogue. Pour appliquer les nouveaux réglages à une tablature

existante, utilisez simplement Notes > Réinitialiser les doigtés de tablature (cf. ci-dessous).

Réinitialiser les doigtés de tablature
Il est possible de réinitialiser à tout moment les doigtés d’une portée de tablature pour les faire cor-

respondre aux étendues préférentielles. Sélectionnez simplement le passage pour lequel vous vou-

lez réinitialiser les doigtés et choisissez Notes > Réinitialiser les doigtés de tablature.

Par exemple, si un passage particulier vous semble plus confortable s’il est joué autour de la cin-

quième frette plutôt que près du sillet, il suffit de définir de nouvelles préférences dans la page

Saisie des notes du Fichier > Préférences (dans le menu Sibelius sur Mac, cf. ci-dessus), puis

d’appliquez ces préférences à ce passage avec Notes > Réinitialiser les doigtés de tablature.

Quand Sibelius réinitialise-t-il automatiquement les doigtés de tablature ?
De manière générale, les doigtés sont maintenus si vous copiez à l’intérieur de la même portée, ou

vers une autre portée avec le même accord. Si vous copiez la musique vers une portée de notation

ou une portée de tablature avec un accord différent, Sibelius recalculera les doigtés en fonction des

réglages Saisie des notes du Fichier > Préférences (dans le menu Sibelius sur Mac).

Cependant, dans le cas spécifique de partitions dont la musique figure à la fois sur une portée nor-

male et sur une portée de tablature, il est utile de conserver les informations de doigtés copiées

entre les portées, car vous copierez probablement d’une portée à l’autre de manière répétée. Dans

ce cas, activez l’option Se souvenir des doigtés lors de la copie vers une portée de notation
dans la page Saisie des notes du Fichier > Préférences (dans le menu Sibelius sur Mac).

Utiliser une guitare MIDI
Sibelius accepte la saisie réalisée avec une guitare MIDI à plusieurs canaux MIDI –

b 1.10 Périphériques d’entrée.



1.8 Fenêtre Manche

55

Saisie

1.8 Fenêtre Manche

La fenêtre du Manche de Sibelius facilite la saisie de notes pour guitare ou basse à l’aide de la souris

et s’avère particulièrement pratique pour savoir comment un riff ou un accord donné peut être

réalisé.

Afficher ou occulter la fenêtre Manche
Pour afficher ou occulter la fenêtre Manche, cliquez le bouton de la barre d’outils sur la droite

ou sélectionnez Fenêtre > Manche (raccourci Ctrl+Alt+E ou zXE). La fenêtre Manche se

présente de la manière suivante :

À l’aide du menu sur la droite de la barre d’outils du Manche, vous pouvez sélectionnez la touche

guitare érable, palissandre et acoustique six cordes, basse érable et palissandre quatre cordes ou

basse palissandre 5 cordes.

La fenêtre Manche propose trois tailles (dont la moyenne est affichée ci-dessus) et peut être

redimensionnée en cliquant sur la limite inférieure (ou supérieur sous Windows) et en tirant.

Saisie à la souris à l’aide de la fenêtre Manche
Bien qu’il soit plus naturel d’utiliser la fenêtre Manche pour saisir des notes pour des partitions de

guitares, vous pouvez utiliser le Manche pour saisir tout type d’instruments dans la partition.

Pour saisir les notes à l’aide de la fenêtre Manche, sélectionnez simplement la mesure ou le silence

à partir duquel vous souhaitez effectuer la saisie. Sibelius sélectionnera automatiquement le type

de Manche le plus approprié selon le type d’instrument sélectionné. Cliquez maintenant sur la

frette adéquate et la corde appropriée pour la note que vous souhaitez saisir.

Le curseur de saisie de note avance automatiquement après la saisie de chaque note.

Par conséquent, si vous souhaitez introduire un accord, cliquez sur le bouton de mode

accord sur la barre d’outils de la fenêtre Manche, montré sur la droite. Désormais, toutes les

positions de frette sur lesquelles vous cliquez sont ajoutées à l’accord en cours. Cliquez sur le

bouton de flèche droite à droite du bouton de mode accord pour faire avancer le curseur.

Suivre la partition durant l’exécution
En plus de la saisie de notes, la fenêtre Manche peut afficher quelles notes seront exécutées lors de

l’exécution. Vous pouvez choisir quel instrument suivre sur la gauche de la barre d’outils de la

fenêtre Manche.

Par défaut, la configuration est Auto, ce qui signifie qu’il suivra la portée de guitare ou de basse

supérieure, sauf si vous avez sélectionné une ou plusieurs portées avant de lancer la lecture. Dans

ce cas de figure, il suivra la portée supérieure parmi la sélection. Si vous souhaitez toujours suivre
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une portée donnée lors de l’exécution, sélectionnez le nom de la portée depuis le menu sur la

gauche de la barre d’outils de la fenêtre Manche.

Gardez à l’esprit que la fenêtre Manche peut uniquement suivre les notes de la voix 1 lors de

l’exécution ; les autres voix sont simplement omises. Si une note est trop haute pour être affichée

sur le manche affiché, elle est indiquée avec une flèche pointant vers la plus haute corde ; de la

même manière, si une note est trop basse pour être affichée sur le manche, elle est indiquée avec

une flèche pointant vers la corde la plus basse.

La fenêtre Manche peut aussi suivre les symboles d’accord sur la partition, montrant comment ils

peuvent être réalisés sur la guitare ; sélectionnez simplement Symboles d’accord dans le menu de

la barre d’outils Manche.

Affichage de la note ou de l’accord sélectionné
La fenêtre Manche affiche aussi la note, l’accord ou le symbole d’accord actuellement sélectionné

quand vous éditez les notes, vous permettant ainsi de vérifier le voicing d’un accord. La fenêtre

Manche montre toujours les notes dans le ton en cours, même si Notes > Partition transposée est

activée.
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1.9 À propos des sélections et des passages 

b 5.7 Rechercher et filtrer.

Dès qu’on sélectionne n’importe quel objet dans la partition, celui-ci se colore pour indiquer qu’il

est prêt à subir une opération réalisée avec la souris ou le clavier. Dans Sibelius, la plupart des

opérations nécessite des sélections préalables.

Il y a trois sortes de sélection:

* la sélection simple, quand seul un objet est sélectionné

* la sélection multiple, quand plusieurs objets séparés sont sélectionnés

* la sélection de passage, quand il s’agit d’un continuum musical sélectionné, qui est entourée soit

d’un cadre bleu clair (“passage de portée”), soit d’un double cadre violet (“passage de système”)

Pratiquement toutes les mêmes opérations peuvent s’appliquer à ces trois types de sélection.

La principale différence, c’est la manière dont les objets ont été sélectionnés en premier lieu.

De plus, il est possible de sélectionner un rectangle de musique dans le but de l’exporter en tant

qu’images – b 9.8 Exporter des images.

Couleurs de sélection
Quand un objet est sélectionné, il change de couleur pour indiquer qu’il est sélectionné:

* Les notes, le texte et les lignes attachés à la portée sont colorés suivant la ou les voix auxquelles

ils appartiennent (la 1re voix est en bleu foncé, la 2ème en vert, la voix 3ème en orange et la

4ème en rose). Si un objet appartient à plus d’une voix, ou à toutes les voix il est de couleur bleu

clair.

* Les autres objets de portée, par exemple les symboles, les clefs, les changements de type de

portée, les changements de transposition qui s’appliquent à toutes les voix sont aussi colorés en

bleu clair.

* Les objets de systèmes (par exemple les textes de système, les lignes et les symboles, les

indications de mesure, les armures, etc...) sont colorés en violet.

Sélections simples
Pour réaliser une sélection simple, il suffit de cliquer sur une note ou tout autre objet ; ce n’est pas

plus compliqué. Si vous cliquez sur une note, Sibelius l’exécute, vous permettant ainsi de percevoir

sa hauteur. Vous pouvez faire glisser une note vers le haut ou le bas pour modifier sa hauteur, ou

faire glisser un objet pour le déplacer, ce qui entraînera l’objet à se fixer à de nouvelles positions

rythmiques le long de la portée, voire d’une autre portée, si vous le glissez suffisamment loin

(b 8.7 Attaches). Vous pouvez aussi maintenir certaines touches enfoncées en faisant glisser

un objet: cliquez d’abord sur l’objet, et maintenez le bouton de la souris enfoncé, puis ajoutez la

touche de modification:

* Maj-glisser: retreint le mouvement de l’élément dans le sens du premier déplacement.

* Alt+glisser: déplace l’élément sans déplacer le point de fixation.
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* Ctrl+glisser (X-glisser sous Mac): désactive provisoirement Mise en page magnétique pour cet

élément pour pouvoir le déplacer où que vous le glissiez, puis revient en position quand vous

relâchez Ctrl ou X.

Ces modificateurs peuvent également servir en combinaison (ex. en maintenant Maj et Alt pour

restreindre le mouvement d’un élément dans un sens donné et le déplacer sans le refixer à un

point). Mais elles ne s’appliquent pas aux notes.

Pour sélectionner et déplacer une note ou tout autre objet sans la souris et sans aucune sélection

préalable : tapez Tab pour sélectionner le premier objet au sommet de la page Ensuite:

* Pour sélectionner l’objet suivant sur la portée, utilisez les touches de flèches ou Tab (pour

sélectionner l’objet précédent, tapez Maj-Tab) Sibelius exécute chaque note ou accord au fil de la

sélection.

* Vous pouvez également utiliser 0/1 pour vous déplacer rapidement entre les notes et les

silences. Si vous sélectionnez une note dans un accord, Sibelius exécute toutes les notes de cet

accord dans la même voix, de sorte à pouvoir entendre les notes et accords en contexte lorsque

vous les parcourez rapidement.

* Pour sélectionner une tête de note spécifique dans un accord, utilisez Alt+3/2 ou z3/2 pour

sélectionner la note suivante la plus haute ou la plus basse de l’accord. Si la note la plus haute ou

la plus basse de l’accord est sélectionnée, tapez Alt+3/2 ou z3/2 pour sélectionner un

trémolo sur la hampe (si présent), tapez à nouveau Alt+3/2 ou z3/2 pour sélectionner la

poignée à l’extrémité de la hampe (si cette dernière pointe dans cette direction). Enfin, tapez-le à

nouveau pour sélectionner l’articulation la plus proche de la note (si présente). Puisqu’il est

possible de sélectionner les notes séparément les unes des autres dans un accord, seule la note

sélectionnée est jouée.

* Maj+Alt+3/2 ou xz3/2 vous permet de sélectionner la note la plus haute ou la plus basse

dans la voix suivante utilisée (ainsi, si vous avez par exemple sélectionné la note la plus basse

d’un accord dans la voix 1 et tapé Maj+Alt+2 ou xz2, Sibelius sélectionnera la note la plus

haute dans la voix 2, si il y en a une ; le cas contraire, la note la plus haute dans la voix 3, ou la

voix 4). Seule la note sélectionnée est jouée.

* Ctrl+Alt+2 ou zX2 sélectionne la hauteur ou le silence le/la plus haut(e) dans la voix

numérotée la plus basse de la portée du dessous ; Ctrl+Alt+3 ou zX3 sélectionne la hauteur

ou le silence le/la plus bas dans la voix numérotée la plus haute de la portée du dessus. Seule la

note sélectionnée est jouée.

S’il n’existe aucune note ou aucun silence à la même position rythmique dans la voix ou portée

suivante, Sibelius sélectionnera plus tôt dans la même mesure, la note ou le silence ayant la

position rythmique la plus similaire. Les voix non présentes sont simplement ignorées. De

même, lors d’un déplacement entre portées, les portées masquées sont ignorées.

* Certaines parties de notes et d’accords peuvent aussi se déplacer avec Alt+0/1 ou z0/1. Lors

de la saisie Alt+1 ou z1, l’ordre de la sélection de gauche à droite est comme suit : ligne

d’arpèges ; scoop ou plop ; altération ; tête de note ; point de rythme ; fall ou doit; extrémité

gauche de la liaison rythmique ; liaison rythmique ; extrémité droite de la liaison rythmique (ces

raccourcis sont également valables pour les lignes – b 2.21 Lignes et b 2.28 Liaisons de
phrasé).
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Il est parfois difficile de sélectionner avec la souris un objet s’il est trop proche d’un autre. Si c’est le

cas, tapez Tab (ou Maj-Tab) pour déplacer la sélection sur l’objet à sélectionner, ou utilisez le zoom

pour agrandir l’image et réessayez; si cela n’est pas suffisant, déplacez momentanément l’objet.

Une autre manière de faire une sélection simple consiste à utiliser la fonction Édition >

Rechercher (raccourci Ctrl+F ou XF) – b 5.7 Rechercher et filtrer.

Sélections multiples
* Cliquez sur une note ou tout autre objet, puis sur Ctrl+clic ou -Xclic pour ajouter d’autres notes

ou objets à la sélection. Ctrl+clic ou X-cliquez à nouveau sur un objet si vous souhaitez le

supprimer de la sélection. Si vous sélectionnez plusieurs notes d’un même accord, Sibelius

exécute toutes les notes sélectionnées.

* Une autre méthode consiste à faire Maj-clic ou X-clic sur le papier puis à tirer la boîte gris clair

autour des objets qu’ils convient de sélectionner (on appelle cela parfois une sélection en lasso).

Si vous tirez sur une portée entière, vous obtenez une sélection de passage. Vous pouvez ajouter

ou enlever des objets d’une sélection avec Ctrl+clic ou X-clic. Si vous utilisez souvent cette

fonction, modifiez le réglage Pour faire glisser le papier dans la boîte de dialogue Fichier >

Préférences > Général (dans le menu Sibelius sur Mac OS X) pour pouvoir faire une sélection

simplement en cliquant et tirant (sans maintenir Maj ou X).

* Avec des sélections de texte multiples, vous pouvez aussi étendre une sélection simple en

choisissant Édition > Sélectionner > Sélectionner Plus (taper Ctrl+Shift+A ou xXA), qui

sélectionne tous les objets similaires (c’est-à-dire dans le même style) attachés à la même portée

dans le même système. C’est une méthode rapide pour faire une sélection d’un ensemble

d’accords, de paroles, de doigtés ou d’indications d’expression.

* Si une note d’un accord est sélectionnée, utiliser Édition > Sélectionner > Sélectionner Plus
sélectionnera toutes les notes de cet accord; de la même manière, si une note isolée, un silence

ou un accord sont sélectionnés, Édition > Sélectionner > Sélectionner Plus sélectionnera la

mesure entière.

* Vous pouvez aussi utiliser les filtres pour faire des sélections multiples – b 5.7 Rechercher
et filtrer.

Les sélections multiples sont particulièrement utiles pour pouvoir agir sur des objets autres que les

notes, les accords et les silences, par exemple pour supprimer des articulations ou des portions de

texte.

Sélections de passages
Un “passage” est un ensemble continu de musique, que ce soit de deux notes à la partition entière,

et s’étalant sur une portée ou la partition entière. C’est en quelque sorte un “rectangle” de

musique– un rectangle qui court sur plusieurs systèmes et sur plusieurs pages, et qui peut aussi

inclure des portées non adjacentes.

À l’inverse des sélections multiples, les sélections de passage sont surtout utiles pour des

opérations sur un ensemble de notes, d’accords ou de soupirs.

Il y a deux sortes de passage: les passages de portée, les plus fréquents, sont entourés d’un simple

cadre bleu clair et peuvent inclure n’importe quelle combinaison de portées d’une partition ; les
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passages de système (ou sélection transversale), par contraste sont entourés d’un double cadre de

couleur violet et incluent toutes les portées d’une partition.

Pour sélectionner un passage en cliquant: 

* Cliquez sur la note/l’accord/le silence se trouvant dans un coin du rectangle à sélectionner (par

exemple le coin supérieur gauche). Si la sélection doit se faire à partir du début d’une mesure, une

technique rapide consiste à cliquer sur une partie vide de cette mesure.

* Faites un Maj-clic sur la note/accord/silence dans le coin opposé du rectangle (par exemple le

coin droit inférieur) du “rectangle”. De nouveau, si la sélection doit s’achever à la fin d’une

mesure, cliquez sur une partie vide.

* Tous les objets sélectionnés vont se colorés et un cadre bleu clair apparaîtra autour de la

sélection. Celle-ci apparaîtra aussi dans le navigateur, ce qui est pratique pour voir des passages

qui s’étalent sur plusieurs pages.

* Pour ajouter des portées supplémentaires à la sélection, maintenez enfoncé Ctrl ou X et cliquez

sur les portées souhaitées; ce procédé peut s’utiliser pour ajouter des portées non adjacentes à la

sélection

* Pour exclure certaines portées d’une sélection de passage maintenez enfoncé Ctrl ou X et

cliquez sur les portées à enlever.

Vous pouvez aussi faire une sélection de passage avec la boîte de dialogue Édition > Sélectionner >

Sélectionner des mesures (raccourci Ctrl+Alt+A ou zXA). Cette commande est utile si vous

savez ce que vous voulez sélectionner, par exemple, les 16 premières mesures d’une portée, ou

quand on veut commencer la sélection à partir de la position en cours jusqu’à la fin de la partition.

L’option Faire une sélection de système transforme la sélection de passage en sélection de

système.

Pour sélectionner un passage de système, faites la même chose, mais commencez par Ctrl+clic ou

X-cliquez sur une partie vide d’une mesure, et maintenez enfoncé Ctrl ou X tant que vous cliquez

sur d’autres notes/accords/silences dans d’autres portées pour étendre le passage.

Il est bien sûr possible de sélectionner un passage en utilisant juste le clavier:

* En partant d’une note sélectionnée, tapez Maj-0/1 pour étendre la sélection horizontalement

d’une note à la fois, ou tapez Ctrl+Shift+0/1 ou xX0/1 pour l’étendre d’une mesure à la fois.

C’est le même processus que dans les traitements de texte (comme pour d’autres usages des

touches de flèches).

* Pour sélectionner plusieurs portées en ajoutant une portée à la fois au passage, tapez Maj-3/2 

* Pour que la sélection en cours devienne une sélection de système, choisissez Édition >

Sélectionner > Passage de système (raccourci Shift+Alt+A ou xzA).

Pour sélectionner un passage en déplaçant la souris: maintenez enfoncé Maj ou X et tirez un

rectangle en commençant au-dessus de la portée du passage souhaité et en finissant en-dessous de

la portée inférieure à la fin du cadre. Cette méthode n’est utile que pour des brefs passages.



1.9 À propos des sélections et des passages

61

Saisie

Effacer une sélection
Pour une sélection de passage individuelle comme multiple ou de passage, vous pouvez toujours

effacer la sélection en tapant Echap. Si vous préférez procéder avec la souris, vous pouvez effacer

une sélection en cliquant sur la page en dehors de votre sélection actuelle (ex. dans la marge ou

entre deux portées). Vous pouvez aussi cliquer sur le bouton de curseur de la souris ( ) en haut à

gauche du pavé (b 1.2 Pavé), ce qui est pratique si vous travaillez avec un tableau interactif ou

un tablet PC.

Il peut aussi s’avérer utile d’utiliser Edition > Annuler et Edition > Rétablir pour annuler et établir

les changements de sélection.

Techniques rapides
Il existe plusieurs moyens de faire certaines sélections rapidement:

* Cliquer sur une partie vide d’une mesure la sélectionne uniquement sur la portée à laquelle elle

appartient (utile par exemple pour copier une mesure)

* Double-cliquer une partie vide d’une mesure sélectionne la portée à laquelle elle appartient sur

toute la longueur du système (utile par exemple pour copier les mesures de la portée)

* Triple-cliquer une partie vide d’une mesure sélectionne la portée dans toute la partition (utile

par exemple pour supprimer un instrument complet)

* Après un simple-, double- ou triple-clic, on peut soit faire un Maj-clic sur une autre portée pour

ajouter à la sélection toutes les portées situées entre la première portée sélectionnée et la

seconde, ou (cf. ci-dessous) ajouter ou enlever des portées individuellement avec Ctrl+clic ou

X-clic

* Si Ctrl ou X est enfoncé avant le simple-, double- ou triple-clic, c’est un passage de système qui

est sélectionné (dans un double cadre de couleur violet)

* La partition entière peut être sélectionnée avec Édition > Sélectionner > Sélectionner tout
(raccourci Ctrl+A ou XA). C’est particulièrement utile pour en transposer ou en modifier le

format en une seule opération ou pour sélectionner des types d’objets spécifiques (cf. ci-

dessous).

(Si cela ne vous semble pas très clair, sachez que Édition > Sélectionner > Sélectionner tout
produit exactement le même résultat que Ctrl+triple-clic ou X-triple-clic. Vu ?

Que faire avec des sélections multiples et des sélections de passages?
Il est virtuellement possible d’appliquer à une sélection multiple ou une sélection de passage, tout,

et même un peu plus, ce qu’il est possible d’appliquer à une note sélectionnée:

* Copier n’importe où avec Alt+clic ou z-clic – vraiment très pratique pour l’arrangement et

l’orchestration. (Copier remplace le contenu à l’endroit du clic à moins que la sélection de

passage soit faite avec Ctrl ou X, ce qui dans ce cas l’insérera)

* Supprimer – il suffit de taper Suppr .Si le passage était sélectionné avec Ctrl ou X (et donc

entouré d’un double cadre violet), les mesures elles-même sont supprimées.

* Répéter avec R – cf. Répéter n’importe quelle sélection ci-dessous 
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* Transposer soit avec la boîte de dialogue transposer (b 5.20 Transposition) pour transposer

d’un intervalle spécifique, ou par intervalle diatonique avec les touches 3 /2. Ctrl+3/2 ou X3/

2 transpose d’une octave.

* Produire des accords en lui ajoutant des notes au-dessus ou en dessous: tapez 1–9 joute

l’intervalle supérieur, Maj-1–9 ajoute l’intervalle inférieur (sauf dans ce dernier cas si vous

utilisez les fonctions de combinaison de touches de clavier d’un portable – b 5.12 Menus et
raccourcis)

* Écouter avec Exécution > Déplacer la ligne de lecture jusqu’à la sélection ou tapez Y, puis

cliquez sur le bouton lecture dans la fenêtre de lecture ou tapez Espace

* Arranger la musique pour une combinaison différente d’instruments, “distribuer” le passage sur

un plus grand nombre de portées, ou “réduire” sur un nombre plus petit– b 5.1 Arranger

* Lancer une extension pour vérifier, éditer ou ajouter des éléments à la sélection –

b 6.1 Travailler avec des extensions

* Ajouter des articulations pour les notes/accords en utilisant le premier et le quatrième pavé

* Régler l’espacement des notes par défaut avec la commande Mise en page > Réinitialiser
l’espacement des notes (raccourci Ctrl+Shift+N ou xXN).

Copie multiple
La copie multiple permet de copier une sélection simple, multiple ou de passage plusieurs fois de

suite horizontalement (sur la même portée), verticalement (sur plus d’une portée), ou les deux en

même temps.

Copie multiple d’un seul objet
Un objet isolé tel qu’une note ou du texte peut être copié verticalement sur un nombre quelconque

de portées. Ce procédé est particulièrement utile pour copier des nuances (par exemple mf ) sur

plusieurs portées en une fois:

* Sélectionnez un seul objet et choisissez Édition > Copier (raccourci Ctrl+C ou XC) pour le

copier dans le presse-papiers.

* Sélectionnez un passage d’une ou de plusieurs portées et choisissez Édition > Coller (raccourci

Ctrl+V ou XV) pour le copier une fois au début du passage uniquement, et sur chaque portée.

Copie multiple d’une sélection multiple
Plusieurs objets peuvent aussi être copiés verticalement sur un nombre quelconque de portées.

Cette forme plus développée du processus décrit ci-dessus est particulièrement utile pour copier

une rangée de nuances:

* Faites une sélection multiple avec – Ctrl+clic ou X-clic sur les objets à copier ou sélectionnez-les

avec un filtre (par exemple Édition > Filtrer > Nuances), puis choisissez Édition > Copier
(raccourci Ctrl+C ou XC) pour les copier dans le presse-papiers.

* Sélectionnez un passage dans une ou plus d’une portée et choisissez Édition > Coller (raccourci

Ctrl+V ou XV) pour copier la sélection au début du passage uniquement, sur chaque portée, en

conservant les distances originales relatives entre les objets dans les nouvelles copies. Si des

portées masquées figurent dans le passage de destination, la copie multiple s’y applique aussi.
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Copie multiple d’un passage
* Sélectionnez un passage dans une ou plusieurs portées et choisissez Édition > Copier (raccourci

Ctrl+C ou XC) pour les copier dans le presse-papiers.

* Sélectionnez un autre passage et choisissez Édition > Coller (raccourci Ctrl+V ou XV) pour

remplir le passage avec plusieurs copies du passage original. Le nouveau passage se remplit ainsi:

% Horizontalement: si le passage de destination est plus long que l’original, un nombre entier de

copies est collé dans le nouveau passage (l’excédent de mesures est laissé tel quel en fin de

passage). S’il est plus court que l’original, une seule copie est réalisée.

% Verticalement: si le passage de destination contient plus de portées que l’original, un nombre

entier de copies est faite en partant du haut (l’excédent de portées est laissé tel dans le bas du

passage). S’il contient moins de portées que l’original, une seule copie est réalisée.

Ne perdez pas de vue que la copie multiple remplace le contenu original du passage de destination,

et s’installe aussi sur toutes les portées masquées.

Répéter n’importe quelle sélection
Voici une autre manière de faire une copie multiple de n’importe quelle sélection avec Édition >

Répéter (raccourci R):

* Faites une sélection quelconque de note, d’accord, de passage, de ligne, de texte, de symbole, de

diagramme d’accord, d’image importée, de changement de portée, de clef, d’armure ou de barre

de mesure et tapez R.

* La sélection est répétée une fois sur la droite; pour recommencer, continuez à appuyer sur R.
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1.10 Périphériques d’entrée

b 1.1 Saisie des notes, 1.4 Flexi-time™, 1.11 HyperControl™.

Si un clavier MIDI ou un autre périphérique externe d’entrée est connecté à l’ordinateur, vous pou-

vez utiliser le mode pas-à-pas et le mode Flexi-time. Pour en savoir plus sur le réglage des entrées

MIDI de l’ordinateur, b Configuration MIDI pour Windows et Configuration MIDI sur
Mac dans le manuel.

Choisir des périphériques d’entrée
La page Périphériques d’entrée du menu Fichier > Préférences (dans le menu Sibelius sur Mac)

propose des options concernant les entrées MIDI :

Le tableau du haut expose la liste de tous les périphériques MIDI d’entrée que vous possédez.

Les options sont les suivantes :

* Utiliser: si la case de cette colonne est cochée, Sibelius acceptera toute entrée de ce périphérique;

si elle n’est pas cochée, Sibelius en ignorera toute entrée. par défaut, toutes les cases Utiliser sont

cochées pour tous les périphériques.

* Nom du périphérique : cette colonne indique le nom du périphérique d’entrée. Si votre port

MIDI est fourni par une carte son ou par une interface MIDI externe, vous verrez le nom du port

MIDI lui-même (par ex. MIDISport USB 2x2 A ou SB Live! MIDI Out) plutôt que le nom du

périphérique connecté au port MIDI ou à l’interface. Si votre périphérique MIDI est connecté à

l’ordinateur directement (par ex. via USB), à la place, vous verrez probablement son nom réel

(par ex. M-Audio Oxygen 8).
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* Type : Cette colonne indique le type de périphérique. Quand on clique, un menu déroulant

apparaît, qui permet de choisir soit Clavier (par défaut) ou Guitare. Si vous choisissez Guitare,

alors les contrôleurs de Canaux MIDI pour la guitare situés sous la table sont activés – cf.

Guitares MIDI ci-dessous.

* Table d’entrée : cette colonne vous permet de spécifier exactement à quelle sorte de clavier

appartient votre périphérique. C’est très utile car beaucoup de claviers possèdent des interrup-

teurs, curseurs et autres boutons que Sibelius peut exploiter – cf. ci-dessous Tables d’entrée.

Jouez quelques notes sur le clavier (ou tout autre périphérique MIDI d’entrée) tant que la boîte de

dialogue est ouverte. Si tout fonctionne normalement, le petit indicateur noir marqué Test devrait

passer au vert tant que vous jouez. Si l’indicateur ne s’allume pas, vérifiez vos connexions MIDI et

assurez-vous que vous avez sélectionné le bon périphérique d’entrée (s’il y en a plus d’un).

N’activez la case MIDI Thru que si et seulement si votre clavier n’a pas de son intégré – avec cette

option Sibelius reproduit les notes jouées sur le clavier en utilisant votre carte-son ou un autre

périphérique de lecture.

Utiliser une saisie MIDI à latence basse permet à Sibelius de tirer parti des possibilités évoluées

des pilotes de votre périphérique d’entrée pour obtenir une saisie à latence basse. Cette option

devrait rester activée sauf si vous rencontrez des problèmes en utilisant la saisie pas-à-pas ou en

mode Flexi-time.

Jouer les notes en arrière-fond détermine si Sibelius devra continuer l’exécution des notes

jouées sur le clavier MIDI quand le programme n’est pas à l’avant-plan (par ex. quand vous utilisez

un autre programme sur votre ordinateur). Cette option est activée par défaut et n’a d’effet que si

MIDI thru est aussi activé.

Libérer les périphériques MIDI à la sortie (Windows uniquement) détermine si Sibelius doit

explicitement libérer les ports d’entrée MIDI sur tous les périphériques actifs lorsque vous quittez

l’application. Normalement, cela devrait rester activé, mais pour certains périphériques, il peut

s’avérer nécessaire de le désactiver, si vous découvrez que vous ne pouvez pas redémarrer Sibelius

après l’avoir quitté (à moins de redémarrer votre ordinateur).

Rechercher de nouveaux périphériques d’entrée
Si vous connectez à l’ordinateur un périphérique d’entrée MIDI externe, tel qu’un clavier ou un

tableau de contrôle alors que Sibelius est déjà en fonctionnement, il ne sera pas automatiquement

disponible comme entrée. Pour rafraîchir la liste des périphériques d’entrée disponibles, cliquez

sur Rechercher de nouveaux périphériques d’entrée à la page Périphériques d’entrée.

Il existe des périphériques que le système d’exploitation de l’ordinateur ne détecte pas correcte-

ment, de sorte que si votre périphérique n’apparaît pas après que vous ayez cliqué ce bouton, sau-

vegardez votre travail et relancez le programme, en veillant à ce que le périphérique soit allumé

avant le lancement de Sibelius.
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Problèmes avec l’entrée MIDI
Si l’entrée MIDI semble ne pas fonctionner, vérifier si MIDI OUT sur le clavier est bien connecté à

MIDI IN sur l’ordinateur, et de même (si votre clavier a des sons intégrés) si MIDI IN sur le clavier

est connecté à MIDI OUT sur l’ordinateur– donc pas MIDI OUT à MIDI OUT ni MIDI IN à MIDI

IN. Si l’ordinateur, dans le cas où l’ordinateur possède deux prises MIDI IN, vous avez branché à

l’une sans succès, essayez l’autre.

Tables d’entrée
Si votre clavier MIDI possède une pléthore de boutons, interrupteurs et autres curseurs, ils pour-

ront servir dans Sibelius à contrôler par ex. les curseurs de la table de mixage, l’exécution, etc.

Il suffit de choisir l’élément le plus approprié de la liste Table d’entrée dans la boîte du haut de la

page Périphériques d’entrée dans Fichier Préférences (dans le menu Sibelius sur Mac) ; si vous

possédez un clavier qui figure dans la liste, vous en choisirez la table d’entrée. Sinon utilisez le

réglage par défaut Clavier MIDI qui fonctionne avec la plupart des claviers MIDI.

Voici les tables d’entrées pour la plupart des claviers les plus populaires de M-Audio :

Axiom 25 :

Réglez votre Axiom 25 sur le programme par défaut. Les huit boutons au-dessus du clavier sont

assignés aux curseurs des huit premières portées de la partition dans la table de mixage, et les bou-

tons de déplacement sous l’écran LCD correspondent aux fonctions identiques de la fenêtre de

l’exécution.

Axiom 49 + 61 :

Réglez votre Axiom 49 ou Axiom 61 sur le programme par défaut. Par défaut, les huit premiers

curseurs au-dessus du clavier sont assignés aux curseurs des huit premières portées de la partition

dans la table de mixage, mais vous pouvez les activer pour contrôler les curseurs de sortie des ins-

truments virtuels grâce à un changement de programme vers le programme 2. Le neuvième cur-



1.10 Périphériques d’entrée

67

Saisie

seur est toujours assigné au contrôle du volume maître. Les boutons à gauche des curseurs font

passer en solo la portée ou l’instrument virtuel correspondant. Les boutons ronds à droite du pan-

neau de contrôle des curseurs contrôlent le panoramique pour les huit premières portées de la

table de mixage. Les boutons de déplacement sous l’écran LCD correspondent aux fonctions iden-

tiques de la fenêtre de l’exécution.

Axiom Pro 49 + 61 :

Sibelius ne prend pas encore en charge la fonctionnalité complète HyperControl du clavier de

contrôleur Axiom Pro (b 1.11 HyperControl™), mais si vous n’utilisez pas HyperControl, les

boutons de déplacement et curseurs sont tous assignés aux fonctions utiles dans Sibelius. Réglez

votre Axiom Pro 49 ou Axiom Pro 61 sur le programme 1. Par défaut, les huit premiers curseurs

au-dessus du clavier sont assignés aux curseurs des huit premières portées de la partition dans la

table de mixage, mais vous pouvez les activer pour contrôler les curseurs de sortie des instruments

virtuels grâce à un changement de programme vers le programme 2. Le neuvième curseur est tou-

jours assigné au contrôle du volume maître. Les boutons de déplacement correspondent aux fonc-

tions identiques de la fenêtre de l’exécution

KeyStudio 49i (également appelé ProKeys Sono 49)

Le bouton Volume de piano règle le curseur de volume maître dans la Table de mixage.

Keystation Pro 88 :

Réglez votre Keystation Pro 88 pour utiliser le Preset 7. Les boutons de déplacement au-dessus des

molettes de modulation et de pitch bend à gauche du clavier correspondent aux fonctions iden-

tiques de la fenêtre de l’exécution. Le bouton 9 sur le clavier à droite de l’écran LCD affiche ou
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masque la fenêtre de la table de mixage. Par défaut, les huit premiers curseurs au-dessus du clavier

sont assignés aux curseurs des huit premières portées de la partition dans la table de mixage, mais

vous pouvez les activer pour contrôler les curseurs de sortie des instruments virtuels grâce à un

changement de programme vers le programme 2. Le neuvième curseur est toujours assigné au

contrôle du volume maître. Les boutons à gauche des curseurs font passer en solo la portée ou

l’instrument virtuel correspondant. Les boutons ronds à gauche des curseurs ontrôlent le panora-

mique pour les huit premières portées de la table de mixage; la rangée du milieu contrôle le pano-

ramique pour les portées 9–16.

MK-425c :

Réglez votre MK-425c sur le programme par défaut. Les huit boutons ronds au-dessus du clavier

permettent d’ajuster le volume des huit premières portées de la table de mixage, et les boutons

numérotés de 1–8 à gauche du clavier font passer en solo la portée correspondante.

MK-449 + 461 :

Réglez votre MK-449 ou MK-461 sur le programme par défaut. Par défaut les huit curseurs au-des-

sus du clavier sont assignés aux curseurs des huit premières portées de la partition dans la table de

mixage, mais vous pouvez les activer pour contrôler les curseurs de sortie des instruments virtuels

grâce à un changement de programme vers le programme 11 (envoyez un changement de pro-

gramme au programme 10 pour rétablir le contrôle du volume des portées). Le neuvième curseur

est toujours assigné au contrôle du volume maître. Les boutons à gauche des curseurs font passer

en solo la portée ou l’instrument virtuel correspondant. Les boutons ronds à droite des curseurs

contrôlent le panoramique pour les huit premières portées.
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Oxygen 8 :

Réglez votre Oxygen 8 sur le programme par défaut. Les boutons ronds au-dessus du clavier sont

assignés aux curseurs des huit premières portées de la partition dans la table de mixage. Les bou-

tons de déplacement sous les boutons ronds correspondent aux fonctions identiques de la fenêtre

de l’exécution

Oxygen 49 + 61 :

Réglez votre Oxygen 49 ou Oxygen 61 sur le programme par défaut. Par défaut les huit curseurs

au-dessus du clavier sont assignés aux curseurs des huit premières portées de la partition dans la

table de mixage, mais vous pouvez les activer pour contrôler les curseurs de sortie des instruments

virtuels grâce à un changement de programme vers le programme 2 (envoyez un changement de

programme au programme 1 pour rétablir le contrôle du volume des portées). Le neuvième cur-

seur est toujours assigné au contrôle du volume maître. Les boutons à gauche des curseurs font

passer en solo la portée ou l’instrument virtuel correspondant. Les boutons ronds à droite des cur-

seurs contrôlent le panoramique pour les huit premières portées. Les boutons de déplacement sous

les boutons ronds correspondent aux fonctions identiques de la fenêtre de l’exécution

UC-33 :
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Réglez votre UC-33 sur le programme par défaut. Par défaut les huit premiers curseurs sont assi-

gnés aux curseurs des huit premières portées de la partition dans la table de mixage, mais vous

pouvez les activer pour contrôler les curseurs de sortie des instruments virtuels grâce à un change-

ment de programme vers le programme 2 (envoyez un changement de programme au programme

1 pour rétablir le contrôle du volume des portées). Le neuvième curseur est toujours assigné au

contrôle du volume maître. Les boutons numérotés de 1 à 8 à droite des curseurs font passer en

solo la portée ou l’instrument virtuel correspondant. Les boutons ronds de la rangée inférieure

contrôlent le panoramique pour les huit premières portées. La rangée du milieu contrôle le volume

des portées 1 à 8, et la rangée supérieure le volume des portées 9 à 16. Les boutons de déplacement

dans le coin inférieur droit correspondent aux fonctions identiques de la fenêtre de l’exécution.

D’autres tables d’entrée sont disponibles dans la section d’aide du site Web de Sibelius, que vous

pouvez visiter en choisissant Aide > Assistance en ligne.

Guitares MIDI
Si vous utilisez une guitare MIDI, Sibelius vous permet d’assigner chaque canal MIDI à une corde

de sorte que les doigtés apparaîtront sur la bonne corde d’une portée de tablature. Vous pouvez

aussi régler différents filtres pour éliminer le “bruit” et éviter qu’il ne soit traité en tant que notes.

Si vous possédez une guitare avec un micro hexaphonique (tel que le Roland GK-2A ou GK-3) et

une interface de guitare MIDI (telle que l’Axon AX100, le Roland GR-33 ou GI-20, etc.), Sibelius

peut écrire sur la bonne corde d’une tablature les notes jouées sur la corde réelle, que vous soyez en

mode pas-à-pas ou en Flexi-time.

Pour indiquer à Sibelius que vous utilisez une guitare MIDI dont chaque corde correspond à un

canal séparé, il suffit de régler le Type sur Guitare en face de l’instrument approprié dans la liste

des périphériques d’entrée. Si votre guitare MIDI envoie tout ce qui est joué sur un seul canal, il

conviendra de laisser cette option désactivée (Saisir > Clavier). Note : si cette option est activée

(Saisir > Guitare), les options Doigtés de tablature de guitare de la page Saisie des notes du

menu Fichier > Préférences (dans le menu Sibelius sur Mac) seront sans effet durant la saisie

(même si elles sont effectives quand par ex. de la musique est copiée d’une portée vers une autre).

Ensuite :

* Régler le Nombre de cordes comme il convient

* Régler le Canal MIDI de la corde la plus aiguë, si nécessaire. Sibelius considère que les cordes

de votre guitare MIDI sont numérotées en se suivant ; si elles ne le sont pas, consultez la docu-

mentation de votre interface de guitare MIDI, et réglez-en les options de manière adéquate.

Vous pouvez aussi si nécessaire, régler certaines options sous Ne pas tenir compte des fausses
notes, décrites en détail dans Options pour la saisie des notes à la page 13. Un des pro-

blèmes habituels de la saisie avec une guitare MIDI est la sensibilité du programme aux notes

détectées par le micro MIDI : même si votre jeu est très propre, des notes très courtes ou effleurées

à peine par accident apparaîtront dans la partition, et de même si le micro détecte parfois des har-

moniques graves ou aiguës. Sibelius autorise un réglage de la sensibilité adapté à votre jeu. (Vous

trouverez également d’autres options fort utiles pour les périphériques d’entrée autre que la guitare

MIDI.)
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Pour en savoir plus sur l’entrée MIDI (avec un clavier ou une guitare), consultez la Guide de
l’utilisateur ou b 1.1 Saisie des notes et b 1.4 Flexi-time™.

Astuces pour une saisie réussie avec la guitare MIDI
Sibelius transcrit précisément tout ce qui est joué, vraiment avec fidélité. Cependant quelques fac-

teurs peuvent être à l’origine d’une transcription imprécise. Même si Sibelius peut filtrer des notes

de très basse vélocité (cf. Options pour la saisie des notes à la page 13), l’idéal est de s’assu-

rer que les réglages de la sensibilité du convertisseur MIDI sont suffisamment bas pour une utilisa-

tion avec guitare MIDI; frottements accidentels de corde, notes fantômes et autres anomalies

apparaîtront si la sensibilité est trop élevée.

Une vibration de la corde contre les frettes ou un réglage imprécis entraîne des erreurs du conver-

tisseur MIDI et produit des notes erratiques; faites vérifier votre guitare par un technicien expéri-

menté si celle-ci affiche les symptômes de vibration intempestive contre les frettes.

Sur l’interface MIDI de votre guitare, expérimentez les différents modes de jeux des cordes.

Les modèles Roland et Axon acceptent l’option jeu avec plectre et celle avec les doigts via des

réglages internes. Expérimentez-les, car pour certaines personnes le jeu avec les doigts est plus

précis que celui avec plectre, et vice-versa.

Sibelius ne transcrit pas les informations de pitch bend, les slides et autres bends lors de la saisie.

Vous pouvez les créer ultérieurement dans la partition, mais quand vous entrez les notes, jouez

proprement et bannissez les vibratos, glissés et autres bends pour garantir une notation précise.

Un dernier point : les cordes à filet plat (flatwound) sont celles qui produisent dans Sibelius la

notation la plus propre.
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1.11 HyperControl™

b 1.10 Périphériques d’entrée.

Sibelius prend en charge HyperControl, la technologie d’assignation

MIDI utilisée par les claviers de contrôleur M-Audio Axiom Pro. Grâce à

un lien bidirectionnel permettant la synchronisation constante entre les

commandes du clavier et les réglages de Sibelius, HyperControl assigne

automatiquement les curseurs, boutons rotatifs, pads de percussion et

boutons du pavé numérique sur le clavier pour l’exécution, la table de

mixage et les commandes de saisie de notes dans Sibelius. L’écran LCD

d’Axiom Pro se met constamment à jour afin d’afficher les valeurs réelles,

pour assurer une modification parfaitement efficace et d’éviter les sauts de paramètres.

Activer HyperControl
Avant de travailler avec HyperControl dans Sibelius, vous devez installer les pilotes fournis avec

votre clavier Axiom Pro. Veuillez suivre les instructions d’installation du pilote du Guide de

démarrage rapide, fourni avec votre clavier.

Pour activer HyperControl dans Sibelius :

* choisissez Fichier > Préférences (menu Sibelius sur Mac) puis la page Périphériques de saisie.

* Quatre périphériques apparaissent correspondant à votre clavier Axiom Pro. Pour permettre la

saisie de MIDI régulière, cochez la case Utiliser pour le périphérique Axiom Pro USB A In ;

notez que la colonne Carte d’entrée est automatiquement configurée sur Axiom Pro 49+61
ou Axiom Pro 25 selon les besoins. Pour activer HyperControl, cochez la case Utiliser pour

Axiom Pro HyperControl In ; la colonne Carte d’entrée est automatiquement configurée sur

M-Audio HyperControl (sur Mac OS X 10,4 Tiger, Axiom Pro USB A In s’affiche en tant que

Axiom Pro Port 1, et Axiom Pro HyperControl In en tant que Axiom Pro Port 2).

* Cliquez sur OK

Utiliser HyperControl
HyperControl utilise les curseurs de volume, les boutons rotatifs ainsi que les boutons normaux

sur le clavier Axiom Pro, tel qu’indiqué dans l’image ci-dessous :

TM

Curseur 
maître

Bouton 
curseur

Bouton
Inverser

Boutons 
rotatifs

Des commandes 
de transport

Pavé 
numérique

Pads de 
percussion

Des touches 
programmables Curseurs

Des touches 
Fonctions
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(L’image ci-dessus indique les commandes sur l’Axiom Pro 49 ; celles de l’Axiom Pro 61 sont

identiques, tandis que l’Axiom Pro 25 n’inclut ni curseur de volume, bouton curseur, curseur

maître, ni bouton Inverser).

Les boutons exécutent les fonctions suivantes :

* A l’aide du pavé numérique, vous pouvez accéder à la plupart des fonctions du pavé à l’écran de

Sibelius, notamment pour l’édition de notes et la saisie en mode pas-à-pas. Les chiffres du pavé

sont disposés dans l’ordre inverse d’un pavé commun ; de ce fait, le chiffre 9 sur l’Axiom Pro

équivaut au chiffre 3 sur votre ordinateur. De même, le chiffre 1 sur l’Axiom Pro équivaut au

chiffre 7 sur votre pavé, et ainsi de suite. Alternez entre les différents pavés en appuyant sur –
d’Axiom Pro. + équivaut au . (point) de votre pavé numérique (p.e. pour ajouter des points de

rythme).

* Les touches programmables exécutent la fonction indiquée directement au-dessus sur l’écran

LCD.

* Les touches “Fonctions” agissent comme suit :

% F1 (appelé Mode) permet d’alterner entre les deux modes principaux de HyperControl :

Table de mixage et Sélection.

% F2 et F3 (appelés Piste) sélectionnent la rangée de la table de mixage précédente ou suivante

en mode Table de mixage, ou sélectionnent la portée précédente ou suivante en mode

Sélection.

% F4 (appelé Sourdine) permet de mettre en sourdine ou non la rangée de la table de mixage

en mode Table de mixage.

% F5 (appelé Solo) permet de basculer en mode solo ou non la rangée de la table de mixage

sélectionnée en mode Table de mixage.

% F6 et F7 (appelés Banque) déplacent la sélection de huit rangées en mode Table de mixage,

ou de huit octaves en mode Sélection.

* Les curseurs vous permettent d’ajuster le volume de la table de mixage, par rangées de portées

individuelles, ou par rangées de groupes.

* Le curseur maître ajuste constamment le niveau du volume maître sur la table de mixage.

* En mode Table de mixage, les boutons rotatifs d’encodeur vous permettent d’ajuster les

paramètres supplémentaires pour les portées de la table de mixage ; en mode Sélection, les

boutons rotatifs d’encodeur vous permettent de naviguer dans une barre ou une page, de zoomer

ou de dézoomer.

* Les boutons de transport agissent comme vous le souhaitez. Maintenez les boutons Répéter en
boucle et Marche arrière enfoncés pour déplacer la ligne d’exécution en début de partition, et

maintenez Répéter en boucle et Marche avant rapide enfoncés pour la déplacer vers la fin.

* Les pads de percussion sont conformes aux standards de la table d’assignation de General MIDI

et peuvent être utilisés pour la saisie de notation de sets de batterie, si l’option relative aux

portées des percussions est configurée sur La table d’assignation des notes du périphérique
de la page Saisie des notes de Préférences. Maintenez les deux boutons Peek (à droite des

touches programmables) enfoncés pour afficher l’assignation de pads sur l’écran d’Axiom Pro.
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Mode Table de mixage
En mode Table de mixage, les quatre touches programmables sont appelées Accueil, Pan, Param
et Groupe. Sur l’écran d’Axiom Pro, vous pouvez également voir le nom de la partition en cours

d’utilisation dans Sibelius.

Par défaut, si vous déplacez les curseurs, le volume des huit premières portées de la partition

s’ajustera. Notez que l’écran d’Axiom Pro n’affiche aucune modification avant que le curseur

physique du clavier s’accorde à la position du curseur correspondant sur la table de mixage : on

appelle cela une priorité légère, ce qui permet d’éviter tout changement brusque du volume lors de

l’ajustement. Appuyez sur la touche programmable Groupe pour assigner les curseurs aux rangées

de groupes dans la table de mixage. Pour ajuster le volume des portées individuelles, appuyez sur

la touche programmable Niveau ; en mode Groupes, cette dernière devient l’étiquette de la

quatrième touche programmable.

Vous pouvez passer en mode sourdine ou solo dans une portée ou un groupe spécifique en

appuyant respectivement sur F4 ou F5, en fonction du mode (Niveau ou Groupes). Pour afficher le

volume ou les niveaux de groupe de la banque suivante de huit portées (ou, moins communément,

des groupes), appuyez sur F7 ; pour retourner à la banque précédente, appuyez sur F6.

Par défaut, les boutons rotatifs d’encodeur permettent d’ajuster le niveau des panneaux des huit

premières portées de la partition. Appuyez sur la touche programmable Param pour assigner les

six premiers boutons rotatifs d’encodeur aux paramètres supplémentaires de la table de mixage

pour les sons joués par le Sibelius Player : l’écran d’Axiom Pro indique les paramètres des portée en

cours d’édition, ainsi que le nom de chaque paramètre et sa valeur. Les deux derniers boutons

rotatifs d’encodeur sont respectivement assignés aux commandes de la Réverbération et Refrain.

Pour afficher les paramètres de la portée suivante, appuyez sur F3 ; pour afficher les paramètres de

la portée précédente, appuyez sur F2.

Mode Sélection
Pour activer le mode Sélection, appuyez sur F1 : l’écran affiche la fonction de chaque bouton rotatif

d’encodeur. Pour sélectionner une portée, appuyez sur le bouton curseur correspondant (p.e. pour

sélectionner la première portée d’un système, appuyez sur le bouton curseur situé sous le premier

curseur). Vous pouvez appuyer sur un autre bouton curseur pour sélectionner une portée

différente, ou bien passer la sélection vers la portée du dessous à l’aide de la touche F3, et vers la

portée du dessus à l’aide de F2. Pour étendre la sélection et inclure la portée du dessous, tournez le

quatrième bouton encodeur vers la droite ; pour supprimer une portée de la sélection, tournez-le

vers la gauche.

Par défaut, Sibelius sélectionne la première mesure de la page la plus proche du centre de la vue :

l’écran d’Axiom Pro indiquera le nom de la portée sélectionnée, ainsi que le numéro de la mesure

au début de la sélection. Pour sélectionner la mesure suivante, tournez le deuxième encodeur vers

la droite. Tournez-le vers la gauche si vous souhaitez sélectionner la mesure précédente. Pour

sélectionner la première mesure de la page suivante, tournez le troisième encodeur vers la droite ;

pour sélectionner la première mesure de la page précédente, tournez-le vers la gauche.

Le cinquième encodeur permet de faire défiler la vue vers le haut/bas (équivaut à Page
précédente/Page suivante), tandis que le sixième encodeur permet de zoomer : tournez vers la

droite pour zoomer, ou vers la gauche pour dézoomer.
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Vous pouvez utiliser le pavé numérique sur Axiom Pro pour la saisie des notes lorsque vous êtes en

mode Sélection : sélectionnez simplement la mesure dans laquelle vous souhaitez commencer la

saisie, appuyez sur le bouton correspondant du pavé, puis commencez à jouer les notes et accords

sur le clavier MIDI.

Pour commencer la saisie Flexi-Time, sélectionnez la mesure dans laquelle vous souhaitez

commencer, puis étendez la sélection jusqu’à la portée du dessous en tournant le quatrième

encodeur vers la droite : appuyez sur le bouton d’enregistrement des commandes de transport

d’Axiom Pro pour débuter l’enregistrement.

Quitter le mode HyperControl
A la fermeture de Sibelius, l’Axiom Pro est réinitialisé à son paramètre par défaut, en mode non

HyperControl.
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2.1 Altérations

b 1.1 Saisie des notes.

Création d’une altération avec une note
Lors de la saisie des notes avec la souris ou avec les touches du clavier, il est possible d’attribuer à

chaque note une altération, choisie dans le premier ou le sixième pavé (raccourcis F7/F12) avant

de l’écrire dans la partition. (De même, à partir du pavé numérique, peuvent s’ajouter

simultanément des articulations, des rythmes pointés, des trémolos et des ligatures spécifiques.)

Les altérations sont automatiquement créées lors de la saisie avec un clavier MIDI.

Ajout des altérations à des notes existantes
Sélectionnez les notes, puis choisissez une altération dans le premier ou le sixième pavé.

Pour ajouter en une seule opération une altération identique à toutes les notes d’un accord,

effectuez un double-clic sur une des notes puis choisissez l’altération.

Suppression d’altérations en particulier
* Sélectionnez les notes, puis choisissez l’altération à nouveau dans le pavé afin de la désactiver.

* Un autre moyen plus lent et moins facile consiste à sélectionner une ou plusieurs altérations avec

la souris (veillez à ne pas sélectionner les têtes de note), puis à les effacer en tapant Suppr.

Suppression simultanée de plusieurs altérations
Sélectionnez toutes les notes, puis servez-vous du sixième pavé (raccourci F12) et

tapez 0 sur le clavier numérique ou sur le bouton correspondant illustré ci-contre.

Masquer des altérations
Dans certains cas (par exemple un trait qui enjambe une portée voisine; Ligatures entre
portées à la page 107), on doit cacher l’altération plutôt que de la supprimer (pour qu’elle sonne

en restant invisible).

Voici comment faire: sélectionnez l’altération elle-même (pas la tête de note) et choisissez

Édition > Masquer ou afficher > Masquer (raccourci Ctrl+Maj+H ou xXH). Pour en savoir

plus, b 5.9 Masquer des objets.

Indications de précaution automatiques
Une indication de précaution (ou de courtoisie) sert à montrer qu’une note comportait une

altération dans la mesure précédente pour rappeler au joueur que la note doit être jouée

conformément à l’armure. Sibelius montre automatiquement des altérations de précaution dans

les conditions suivantes :

* Au début d’une mesure où la note précédente comportait une altération différente

* A l’endroit où toute note dans la mesure précédente comportait une altération

* A l’endroit où une note non-initiale dans la mesure suivante comporte une altération

* A l’endroit où toute note dans la mesure précédente et toute note dans la mesure suivante

comportent une altération différente
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* A l’endroit où une note comportant une altération est liée à une barre de mesure, toute note à la

même hauteur de note dans la mesure suivante comporte une précaution “annulant” l’altération

* A l’endroit où une note précédente dans une octave différente comportait une altération

différente (ex. si vous écrivez C#5 C4, Sibelius montrera une bécarre de précaution sur le C4)

* Lorsqu’une note précédente dans une voix différente comportait une altération différente, soit

dans la même mesure ou dans la mesure précédente.

Autre convention courante pour les altérations de précaution : indiquer la précaution seulement

sur la première note de la mesure, c.-à.-d. si la première note de la mesure suivante est à la même

hauteur qu’une note comportant une altération dans la mesure précédente. Pour que Sibelius

utilise cette convention, choisissez Style maison > Règles de gravure, rendez-vous à la page

Altérations et points, et activez Appliquer des précautions auto uniquement jusqu’à la
première note de la première mesure.

Si vous préférez que Sibelius n’indique pas d’altération de précaution lorsqu’une altération

différente survient sur une autre voix, vous pouvez désactiver Réajuster altération si aperçu
dans nouvelle voix sur la page Altérations et points de Style maison > Règles de gravure. Si

vous écrivez de la musique où deux joueurs ou chanteurs partagent la même portée, il est

recommandé de laisser cette option activée. Toutefois, si vous écrivez de la musique à l’endroit où

toutes les voix sur une portée doivent être lues par le même artiste, vous pouvez la désactiver.

Les changements d’armure annulent les altérations de précaution par défaut : si vous êtes en C

majeur et rencontrez un F# dans une mesure, puis changez une touche explicite par A (par ex.)

dans la mesure suivante, un F# dans la mesure suivante n’indiquera pas d’altération de précaution,

car l’armure la rend redondante. Si vous souhaitez néanmoins que Sibelius indique des altérations

de précaution dans ces circonstances, désactivez Réinitialiser altérations de précaution sur la

page Clefs et armures de Style maison > Règles de gravure.

Altérations de précaution entre parenthèses
Par défaut, Sibelius ne place pas d’altérations de précaution entre parenthèses et vous pouvez

modifier ce réglage en activant Afficher les altérations de précaution entre parenthèses (et

Afficher les altérations réajustées dans une nouvelle voix entre parenthèses, au besoin) sur

la page Altérations et points de Style maison > Règles de gravure.

Vous pouvez manuellement ajouter des parenthèses à toute altération si vous le souhaitez – voir

Altérations ajoutées par l’éditeur ci-dessous.

Suppression d’altérations de précaution
Vous pouvez masquer une altération de précaution automatique en sélectionnant la note

sur laquelle figure l’altération de précaution, et en choisissant le bouton Supprimer
altération de précaution (raccourci 0) sur le sixième pavé (raccourci F12), comme

indiqué à droite.

Altérations sur notes liées
Lorsqu’une note liée comporte une altération, et s’avère divisée par un saut de système ou de page,

Sibelius réajuste automatiquement l’altération, entre parenthèses au début du nouveau système.
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Si vous préférez que Sibelius n’indique pas l’altération réajustée entre parenthèses, désactivez

Indiquer altérations réajustées sur liaisons entre parenthèses, sur la page Altérations et
points de Style maison > Règles de gravure. Si vous préférez que Sibelius ne réajuste pas du tout

l’altération, désactivez Réajuster altération si la note est liée sur un saut de système.

Altérations ajoutées par l’éditeur
Des altérations ajoutées par l’éditeur sont parfois écrites entre parenthèses et d’autres fois entre

crochets.

Pour mettre entre parenthèses l’altération d’une note (ou celles d’un groupe de notes) choisissez le

bouton de parenthèse sur le sixième pavé (raccourci F12).

Pour ajouter manuellement des crochets à une altération, saisissez les crochets en tant que texte

Technique. (Pour les utilisateurs expérimentés: si vous devez utiliser fréquemment des altérations

entre parenthèses droites, il est plus simple de créer des nouveaux symboles d’altérations courantes

entre crochets ou de modifier les altérations entre parenthèses déjà disponibles.)

Altérations de taille réduite
Les altérations sont automatiquement réduites lorsqu’elles affectent des notes de réplique ou des

notes ornementales. Toutefois, si vous souhaitez placer une altération de taille réduite devant une

note de taille normale, créez l’altération depuis la fenêtre Créer > Symbole et avant de cliquer sur

OK, choisissez Taille de note de réplique ou Taille de note ornementale. N’oubliez pas que,

comme tous les symboles créés de cette manière, ces altérations ne seront ni jouées ni transposées.

Les altérations doubles et les quarts de ton
Celles-ci se trouvent sur le sixième pavé et se comportent comme des altérations normales.

Les quarts de ton transposent automatiquement. Essayez mentalement de transposer Mi avec un

quart de ton une septième majeure plus haut (réponse en fin de notice! Faites ensuite l’essai d’écrire

la gamme de Mi - quart de bémol - mineur mélodique). En outre, Sibelius réalise les enharmonies

des quarts de ton (cf. ci-dessous).

Enfin, Sibelius intègre une extension appelée Exécution des quarts de ton – cf. Lecture et
exécution des altérations microtonales ci-dessous.

Autres divisions du ton
Il est possible de dessiner d’autres symboles de micro-intervalle plus

sophistiqués mais en tant que symboles graphiques, ils ne seront ni

joués ni transposés automatiquement. Les symboles existants peuvent

aussi être modifiés. Par exemple, si vous préférez utiliser des bémols

en quarts de ton pleins et noirs, remplacez le bémol retourné de la

quatrième colonne de la fenêtre Style maison > Modifier les
symboles par un caractère de bémol retourné plein – cf. dans

Modifier les symboles existants à la page 708 pour en savoir

plus.

Altérations doubles
Les altérations doubles 

s’utilisent dans des tons peu 

usités tels que Sol # mineur 

pour éviter un excès de 

bécarres. La sixième note de la 

gamme de Ré b mineur est Si bb, 
correspondant au La.

Les Symboles §b et §# s’utilisent 

parfois à la place de b et # pour 

annuler un double bémol ou 

un double dièse.
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“Orthographe” des altérations
Lors de la saisie via un clavier MIDI (Flexi-time, pas à pas, ou fichier MIDI), Sibelius devine selon

l’armure et le contexte s’il faut orthographier les touches noires jouées en dièse ou en bémol.

Pour corriger l’orthographe enharmonique des notes (par exemple changer Fa# en Solb,
sélectionnez Notes > Enharmonie (raccourci Retour sur le clavier principal).

Cette fonction change l’orthographe d’une double altération (p. ex. Sibb) en bécarre (La) mais pas

l’inverse, car d’habitude on élimine les doubles altérations plutôt qu’on ne les crée. De même

l’orthographe des quarts de ton est subtilement affectée. (La plupart des quarts de ton s’écrivent de

trois façons: Do quart de dièse équivaut à Ré trois quarts de bémol et à Si trois quarts de dièse.)

Sibelius propose également deux extensions pour la réécriture des altérations : Réorthographier
les bémols en dièses et Réorthographier les dièses en bémols - b 6.2 Extensions pour
les altérations.

Simplification des altérations
Quand on transpose ou quand on ajoute une armure, de nombreuses altérations indésirables

peuvent parfois apparaître. Une extension telle que Extensions > Altérations > Simplifier les
altérations permet de résoudre ce type de problème – Simplifier les altérations à la page 546.

Si toute une partition comporte des doubles altérations gênantes qu’il convient d’éliminer, il suffit

de la sélectionner entièrement (choisir Édition > Sélectionner > Sélectionner tout, raccourci

Ctrl+A ou XA) puis Notes > Transposer (raccourci Shift-T) et de la transposer d’un unisson
ascendant (Majeur/Unisson parfait) avec l’option utiliser des double dièses / bémols
désactivée. Tous les doubles altérations seront alors remplacées par leurs équivalents simplifiés.

Ajouter des altérations aux notes
Sibelius propose deux extensions qui permettent d’ajouter rapidement des altérations à toutes les

notes d’une sélection. Pour ajouter des altérations aux notes qui ne résultent pas de l’armure,

choisissez Extensions > Altérations > Ajouter l’altération de toutes les notes dièses ou
bémol. On l’utilisera pour, par exemple, ajouter l’altération à tous les Sib en Do majeur et à tous les

Ré bécarre en Mi majeur. De plus, on peut aussi ajouter leur altération à toutes les notes d’une

sélection en choisissant Extensions > Altérations > Ajouter des altérations à toutes les notes.

Unissons altérés
“Unissons altérés” correspond à deux têtes de note dans un accord partageant la même hauteur

mais dont les altérations sont différentes, par exemple Solb et Sol#.

Certains compositeurs comme Messiaen les écrivent avec deux têtes de note

côte-à-côte précédées de deux altérations, plutôt qu’un intervalle de seconde

(cf.l’exemple de gauche de l’illustration ci-contre). Le moyen le plus indiqué

pour ce genre de notation consiste à créer un accord avec deux têtes de note à la même hauteur,

puis d’ajouter à chacune d’elles une altération de la façon habituelle.

D’autres compositeurs ajoutent une seconde tête de note à une deuxième hampe en diagonale (cf.

l’exemple de droite de l’illustration ci-dessus). Pour écrire cela, ajoutez une tête de note en pédicule

en utilisant un des symboles disponibles dans la fenêtre Insertion > Symbole (raccourci Z).
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(Évidemment, ce type de notation avec une tête de note supplémentaire présente l’inconvénient

d’être impossible à transposer ou à lire lors de l’exécution, puisqu’elle est purement graphique.)

Les altérations dans du texte
Il est parfois nécessaire d’introduire des altérations dans des éléments textuels d’une partition, par

exemple pour mentionner la tonalité d’un morceau dans le titre.

Pour introduire des altérations dans du texte, tapez Ctrl ou X et la touche numérique

correspondant à l’altération dans le premier pavé (raccourci F7), par exemple Ctrl+8 ou X8
donne un dièse et Ctrl+9 ou X9 un bémol. Remarquez que Verr Num doit être activé pour que

cela fonctionne. Autrement, vous pouvez aussi choisir l’altération dans le menu contextuel qui

s’affiche en effectuant un clic droit (Windows) ou Contrôle-clic (Mac).

Déplacement des altérations
Les altérations sont positionnées automatiquement. Par exemple, si vous ajoutez une altération à

un accord préexistant, les altérations se repositionnent afin de ne pas entrer en collision.

Si malgré tout, vous devez déplacer une altération, glissez-la horizontalement avec la souris ou,

après l’avoir sélectionnée, tapez Shift+Alt+0/1 ou xz0/1. Pour un déplacement plus

important, utilisez Ctrl+Shift+Alt+0/1 ou xzX0/1.

Si vous avez besoin d’altérations au-dessus de la portée (par exemple pour une altération de type

ficta) utilisez un symbole de la fenêtre Créer > Symbole et si le ficta doit être joué, utilisez

l’extension Ajouter des fictas au-dessus des notes – cf. Ajouter l’altération Ficta à la page

545.

Lecture et exécution des altérations microtonales
La plupart des périphériques de lecture possèdent une fonction de pitch bend qui peut altérer une

note en divisions équivalentes à 1/32 d’un demi-ton, facilement activée par Extensions >

Exécution > Exécution des quarts de ton.

Pour altérer une note, ajoutez-lui d’abord une altération de quart de ton. Répétez-la si nécessaire,

puis sélectionnez le passage à traiter (veillez à inclure la première note de hauteur normale qui

suivra, pour que le contrôleur MIDI du pitch bend repasse à zéro). Choisissez Extensions >

Exécution > Exécution des quarts de ton, et cliquez sur OK deux fois.

Maintenant, est attachée à toutes les notes concernées une commande MIDI de pitch bend

invisible (que l’on peut visualiser en grisé en activant Affichage > Objets masqués) qui élève la

hauteur d’un quart de ton : ~B0,80, suivie de ~B0,64 qui rétablit la hauteur normale à l’endroit de

la portée affectée. Il est possible de modifier cette commande de pitch bend en appliquant des

valeurs différentes du quart de ton en cliquant dessus et en la changeant comme ceci:

* ~B0,64 = hauteur normale

* ~B0,80 = demi-dièse (un quart de ton plus haut)

* ~B0,96 = dièse (un demi-ton)

* ~B0,48 = demi-bémol (un quart de ton plus bas), etc.

Chaque incrément est approximativement de 3 centièmes, le centième étant 1/100 d’un demi-ton.

Donc si vous voulez une hauteur précise, par exemple 15 centièmes d’un bémol, la valeur de la
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commande de pitch bend sera obtenu en soustrayant 5 (15/3) de 64, soit ~B0,59. (Baisser d’un

tiers de tierce créerait un accord plus harmonieux.) Si vous n’utilisez pas de tels quarts de ton et

que vous n’en voulez pas du tout, vous pouvez le supprimer et le message MIDI de pitch bend

restera ainsi.

Notez qu’en raison de la nature des canaux MIDI, seule une commande de pitch bend par

instrument n’est possible, de sorte que différentes notes d’un accord ne peuvent être altérées de

manière différente. Si vous tentez de le faire, l’extension marquera l’accord d’un X pour vous

informer de l’échec de la tentative d’altérer les notes de l’accord au pitch bend souhaité.

Pour en savoir plus sur les extensions cf. Exécution des demi-dièses à la page 576. Pour en

savoir plus sur les messages pitch bend MIDI, cf. Pitch bend à la page 406.

options des règles de gravure
Dans le cas encore plus improbable où vous devriez modifier l’espace à laisser entre ou autour des

altérations tout au long d’une partition, des options très performantes sont proposées dans les

pages Altérations et points et Clefs et armures de la boîte de dialogue Style maison > Règles
de gravure (raccourci Ctrl+Shift+E ou xXE).

(Réponse à la question de transposition: Ré quart de dièse. Pas si simple, n’est-ce pas?)
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2.2 Arpèges

b 1.2 Pavé, 2.21 Lignes, 4.9 Dictionnaire de l’exécution.

Dans la musique pour clavier, harpe et guitare, il est habituel de voir une ligne ondulée verticale

indiquant que les notes de l’accord adjacent doivent être “ étalées” de bas en haut (ou dans la direc-

tion indiquée par une flèche sur la ligne).

Créer un arpège
Pour créer un arpège, sélectionnez une note ou un accord, puis choisissez le cinquième pavé

(raccourci F11), où vous trouverez trois variantes : une ligne d’arpège normale (raccourci / sur

Windows, = sur Mac); une ligne d’arpège avec une flèche pointant vers le haut (raccourci * sur

Windows, / sur Mac); et une ligne d’arpège avec une flèche pointant vers le bas (raccourci – sur

Windows, * sur Mac).

Sibelius crée automatiquement l’arpège à une longueur appropriée, et en ajoutant ou en suppri-

mant des notes de l’accord, ou si vous changez leurs hauteurs de note, la longueur est mise à jour

automatiquement. Vous pouvez également régler la longueur d’une ligne d’arpège individuelle en

faisant glisser l’une des extrémités (ou en sélectionnant la fin de l’arpège et en utilisant les touches

3/2). Pour restaurer la longueur par défaut, choisissez Mise en page > Réinitialiser la position.

Vous pouvez aussi déplacer les arpèges à gauche et à droite via Shift+Alt+0/1 ou xz0/1, au

besoin.

Options des règles de gravure
La page Lignes de Style maison > Règles de gravure contient plusieurs options subtiles pour

déterminer la longueur par défaut et le positionnement des arpèges.

Espace avant les arpèges
Vous pouvez changer la distance minimum que Sibelius essaie de maintenir avant des lignes

d’arpège dans Style maison > Règle d’espacement des notes – b 8.9 L’espacement entre
les notes.

Changer la conception d’arpège
Si nécessaire, on peut modifier l’épaisseur des ondulations utilisées par ces arpèges –

b 8.15 Modifier les lignes.

Interprétation durant l’exécution
Vous pouvez définir la rapidité à laquelle les trois types d’arpège doivent être lus en choisissant

Arpège, Arpège descendant ou Arpège ascendant sur la page Lignes de portée de Exécu-
tion > Dictionnaire – b 4.9 Dictionnaire de l’exécution.

Problèmes d’impression
Certains pilotes d’imprimante ont une bogue qui provoque l’impression des textes inclinés ou des

lignes ondulées selon un angle erroné; si vous êtes concerné, b 5.16 Imprimer.
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2.3 Articulations

b 1.1 Saisie des notes.

Les articulations sont les symboles placés au-dessus ou en dessous des notes, accords ou silences,

qui indiquent une technique de jeu (par ex. staccato, accent ou coup d’archet). En général, la

manière de les créer ou de les supprimer est identique à celle utilisée pour les altérations.

Créer des articulations avec une note
Quand on crée une note, on peut lui adjoindre simultanément

une ou plusieurs articulations choisies dans le premier et/ou le

quatrième pavé(s), avant de déposer la note sur la partition.

(Vous pouvez également ajouter simultanément des altérations,

des liaisons rythmiques, des points rythmiques, des têtes de

notes, des tremolos et des ligatures spécifiques à partir du pavé

numérique.)

Ajouter des articulations à des notes existantes
Pour ajouter une ou plusieurs articulations à une ou plusieurs

notes sélectionnées, choisissez-la (les) simplement dans le

premier et/ou le quatrième pavé(s).

Pour l’ajout d’articulations à un accord, n’importe quelle tête de

note sélectionnée convient puisque l’articulation s’applique à

toutes les notes de l’accord.

Enlever une articulation spécifique
* Sélectionnez la (ou les) note(s) concernée(s) puis choisissez la (ou les) touche(s) sur le pavé pour

les désélectionner.

* Un autre moyen, plus lent et moins facile, consiste à sélectionner une ou plusieurs altérations

avec la souris (en évitant de sélectionner des notes associées à celles-ci), puis à taper Suppr.

* Pour enlever les articulations en une fois, sélectionnez la (ou les) note(s), puis

sur le quatrième pavé (raccourci F10) tapez 0 ou cliquez la touche ci-contre:.

Déplacer des articulations
Les articulations sont positionnées de façon automatique. Par exemple, si on ajoute une

articulation à une note déjà articulée, les deux articulations vont adapter leur position pour

apparaître dans le bon ordre, la première laissant de la place pour la nouvelle. Sibelius suit

également les conventions les plus courantes pour le placement d’articulations liées aux liaisons de

legato et les crochets des multiplets, de manière à ce que les coups d’archet et les points d’orgue

(pauses) soient toujours positionnés à l’extérieur des liaisons de legato et des multiplet, les

articulations tenuto et staccato de la première ou la dernière note d’une portée, dans la liaison et

toutes les autres articulations quant à elles sont positionnées au milieu de la portée ou dans un

crochet de multiplet.

Symboles d’articulations 
inhabituelles
Voici des articulations peu courantes :

Staccatissimo (très court)

Marcato

Arrêt moyen

Arrêt court

Pousser (instruments à cordes)

Tirer (instruments à cordes)

Harmonique, charleston ouvert

Charleston fermé (percussions), 

sourdine ou main dans le pavillon 

(cuivres), pizzicato à la main 

gauche, trille (musique baroque)
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Sibelius déplace également les articulations pour les empêcher d’entrer en collision avec les liaisons

rythmiques qui inversent les articulations avec hampe en bas ou toute autre situation similaire (à

condition que la fonction Mise en page magnétique soit activée).

Vous pouvez parfois vouloir déplacer vous-même une articulation. Par exemple, si une articulation

est placée du côté inverse des autres. Prenons le cas de six notes en staccato : l’une d’elles a la

hampe et donc l’articulation à l’inverse des cinq autres ; vous pouvez en déplacer le staccato pour

respecter la suite logique des articulations plutôt que de le laisser à sa place normale.

Pour inverser une articulation, sélectionnez-la et choisissez Edition > Retourner (raccourci X)

pour la retourner de l’autre côté de la note. Lorsque vous inversez une articulation, l’opération

s’applique à toutes les articulations liées à une note, hormis pour les articulations qui ne peuvent

figurer qu’au-dessus de la note. Celles-là resteront où elles sont. Dans le cas improbable où vous

auriez besoin de placer certaines articulations au-dessus de la note et d’autres en-dessous d’une

manière qui n’est pas automatiquement prise en charge par Sibelius, vous pouvez utiliser des

symboles depuis le menu Créer > Symbole au lieu d’articulations réelles.

Utilisez les touches de flèche (ou la souris) pour déplacer l’articulation verticalement. (Comme

d’habitude, Ctrl+3/2 ou X3/2 permettent un déplacement plus rapide.) Si plusieurs

articulations sont superposées au-dessus ou en-dessous d’une note, déplacer l’articulation près de

la note déplacera les autres articulations d’un montant équivalent ; si vous souhaitez augmenter la

distance entre deux articulations individuelles, sélectionnez celle la plus éloignée de la tête de note

et déplacez-la.

Pour annuler tous les changements de position produits par le retournement ou le déplacement

d’articulations, sélectionnez la note concernée et choisissez Mise en page > Réinitialiser la
position. Pour restaurer une articulation individuelle à sa position initiale, sélectionnez seulement

cette articulation et choisissez Mise en page > Réinitialiser la position.

Pour les ajuster dans toute la partition cf. Options des règles de gravure ci-dessous.

Copier des articulations
Quand on copie des articulations avec Alt+clic ou z-clic ou Édition > Répéter (raccourci R), les

articulations sont copiées elles aussi, ce qui est un gain de temps appréciable. Vous pouvez aussi

utiliser l’extension Extensions > Notes et silences > Copier les articulations et les liaisons de
phrasé pour copier des successions d’articulations sans affecter les notes elles-même – pour en

savoir plus Copie les articulations et les liaisons à la page 566.

Interprétation lors de la lecture
Sibelius lit les articulations de manière aussi réaliste que le permettent les périphériques de lecture

– b 4.2 Interprétation de la partition et b 4.9 Dictionnaire de l’exécution.

Articulations sur des silences
Les trois types de point d’orgue (pause) sont les seules articulations que l’on peut placer au-dessus

des silences ; en principe, en utiliser d’autres n’a aucun sens.

Cependant dans le cas exceptionnel où on souhaiterait placer d’autres articulations sur un silence,

il faudra les créer en tant que symbole. (Par exemple, chez Stockhausen ainsi que chez d’autres
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compositeurs contemporains, des accents apparaissent parfois au-dessus des silences, indiquant

qu’il faut prendre une vive inspiration d’air pour donner un effet de syncope inattendu.)

Si on ajoute un point d’arrêt à une mesure de silence, celui-ci s’applique à toutes les portées ; il sera

donc copié sur toutes les portées (ainsi que sur toute partie séparée extraite).

Points d’orgue sur les barres de mesure
Il est parfois nécessaire de placer un point d’orgue au-dessus ou en dessous d’une barre de mesure ;

Pour cela, créez-le avec Créer > Symbole (raccourci Z), et activez l’option Attaché au système.

Ceci crée un symbole de système qui apparaîtra dans toutes les parties séparées.

Raccourcis-clavier
Bien que toutes les articulations soient accessibles via les raccourcis standard du clavier, il est

toutefois possible d’assigner des raccourcis supplémentaires pour des articulations individuelles –

b 1.2 Pavé.

Redéfinir des articulations
La présentation des articulations peut se modifier par la boîte de dialogue Style maison >

Modifier les symboles – b 8.17 Modifier les symboles.

Sur le quatrième pavé se trouvent trois touches vierges auxquelles il est possible d’assigner des

articulations supplémentaires. Il suffit de créer les symboles souhaités dans la rangée

Articulations de la boîte de dialogue Style maison > Modifier les symboles:

Quand elles sont combinées avec d’autres, les nouvelles articulations sont empilées, selon l’ordre

des emplacements ;  l’articulation 1 sera la plus proche de la tête de note, et la 3 sera la plus

éloignée. Comme vous le voyez sur l’image ci-dessus, il faut définir pour chaque articulation un

symbole “supérieur” et un symbole “inférieur”, même si dans la plupart des cas, le même symbole

est utilisé plutôt que son contraire.

Une fois vos trois touches personnalisées définies, notez que les boutons du quatrième pavé ne

refléteront pas ce changement et n’afficheront pas vos nouveaux symboles. Cette personnalisation

ne vaudra que dans la partition en cours; afin de la rendre active dans d’autres partitions, il vous

faudra exporter le style maison (b 8.8 Style maison).

Articulations au-dessus de la portée
Dans l’écriture de certains instruments, par exemple les percussions ou les chanteurs, il est

préférable de disposer les articulations toujours au-dessus de la portée. Sibelius réalise cela

automatiquement selon les instruments.

Pour contraindre les articulations à apparaître au-dessus de la portée d’un autre instrument,

activez l’option Articulations toujours au-dessus de la portée dans le tableau Notes et

Articulation personnalisée1
Articulation personnalisée

Articulation personnalisée 3
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silences de la boîte de dialogue Type de portée (accessible dans la boîte de dialogue Éditer
l’Instrument – b 8.14 Modifier les instruments).

Options des règles de gravure
La page Articulations de la boîte de dialogue Style Maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) propose plusieurs options étonnantes : Les cinq rangées de cases détermine

la façon dont se positionnent le texte les 16 types d’articulations :

* Toujours en dessous : la plupart des articulations sont placées en dessous lorsque les hampes

de note sont dirigées vers le haut, mais certaines (dont les coups d’archet) se trouvent au-dessus

des notes indépendamment de la direction de leur hampe. Dans certains types de partitions (ex.

musique jazz ou commerciale), il peut s’avérer préférable d’afficher toutes les articulations au-

dessus de la portée – cf. Articulations au-dessus de la portée ci-dessus.

* Autorisé dans les portées : la plupart des éditeurs placent les staccatos et les tenutos dans la

portée, certains le font avec les harmoniques, quelques uns avec les accents. Il n’est pas

recommandé de placer d’autres articulations dans la portée : selon la police de musique utilisée,

elles ne s’ajusteraient pas entre deux lignes de portée et manqueraient de lisibilité.

* ...au debut ou à la fin d’une liaison : il existe différentes conventions pour savoir si le point

d’extrémité d’une liaison de phrasé ou certaines articulations doivent apparaître plus près de la

tête de note. Sibelius suit la convention la plus courante par défaut, via laquelle les articulations

staccato et tenuto doivent se placer dans la liaison de phrasé, et d’autres articulations doivent se

placer à l’extérieur.

* ...au milieu de la liaison : par convention, la plupart des articulations peuvent apparaître au

sein de l’arc de la liaison, mais certaines articulations, y compris les coups d’archet et les points

d’orgue (pauses) doivent être positionnées à l’extérieur de la liaison. Ces options prennent

uniquement effet à condition que l’option Mise en page magnétique soit activée.

* ...dans le multiplet : comme pour les liaisons de phrasé, il existe différentes conventions pour

savoir si le crochet de multiplet ou certaines articulations doivent figurer plus près de la tête de

note. Par défaut, Sibelius ne positionne les coups d’archet et les points d’orgue qu’en dehors des

crochets de multiplet. Si un crochet de multiplet et une liaison coïncident, les options ...dans le
multiplet ont priorité sur les options de la liaison, dans la mesure où les crochets des multiplets

se placent généralement plus près des notes que les liaisons.
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Les options de Position de l’articulation près de la hampe sont :

* Centrer les staccatos sur la hampe : ce réglage (par défaut) positionne automatiquement

toute articulation à l’extrémité de la hampe de la note. Si les articulations sont du côté de la

hampe, il les centre sur celle-ci dans le cas d’un staccato, d’un staccatissimo ou d’un lourré. Si les

articulations sont du côté de la tête de note, elles sont positionnées normalement.

Certains éditeurs suivent une convention selon laquelle un staccato est centré sur la hampe

uniquement s’il s’agit de la seule articulation du côté de la hampe ; un staccato combiné avec une

autre articulation au niveau de la hampe doit par ailleurs être centré. Pour que Sibelius utilise

cette convention, activez même extrémité.

Une autre convention moins commune consiste à centrer un staccato du côté de la hampe sur la

tête de note si une autre articulation est présente du côté de la tête de note. Pour que Sibelius

utilise cette convention, activez extrémité opposée.

* Centrer à moitié les staccatos sur la hampe : cette option est identique à Centrer les
staccatos sur la hampe, sauf qu’elle centre les articulations à mi-chemin entre la hampe et le

centre de la tête de note, dans le cas d’un staccato, d’un staccatissimo ou d’un lourré.

* Tout centrer sur les hampes : De façon assez évidente, ici les articulations se centrent sur la

hampe plutôt que sur la tête de note puisqu’elles se trouvent du côté de la hampe.

* Tout centrer sur les têtes de note : cette option place les articulations du côté de la hampe

mais les centre sur la tête de note.

Les options de Position verticale sont :

* n dents depuis la tête de note : quand l’articulation est du côté de la tête de note (ou de

l’accord), ceci représente la distance de l’articulation la plus proche. Si l’articulation est chassée

en dehors de la portée, elle sera plus éloignée.

* n dents de la hampe : définit la distance correspondante lorsque l’articulation est du côté de la

hampe.

* n dents entre les articulations : détermine la distance entre chaque articulation lorsqu’il y en

a plusieurs attachées à la même note.

* n dents au-dessus de la portée pour les articulations non-autorisées dans la portée :

détermine la distance entre la ligne de portée inférieure et supérieure et l’articulation située le

plus à l’intérieur qu’il n’est pas autorisé d’afficher dans la portée.

* Points d’orgue sur une mesure de silence n dents au-dessus de la portée contrôle la

distance au-dessus de la portée des points d’orgue sur une mesure de silence. Normalement, cela
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doit être défini à la même valeur que n dents au-dessus de la portée pour les articulations
non-autorisées dans la portée.

* Nouvelle règle de positionnement d’articulation doit normalement être activé, car cela

améliore le positionnement d’articulations de diverses manières subtiles

* Autoriser plus d’espace pour les accents, marcatos, lourrés et staccatissimos dans la
portée : une fois activée, cette option veillera à ce que les accents, marcatos, lourrés et

staccatissimos ne figurent pas dans l’espace adjacent à une note dans les deux espaces

intermédiaires de la portée. Au lieu de cela, l’articulation la plus proche va apparaître une dent

plus près de la tête de note. Cette option n’a d’effet que si des accents, marcatos, lourrés ou

staccatissimos sont définis sur Autorisé dans les portées.

* Autoriser les articulations “toujours au-dessus” à être inversées en dessous doit

normalement être désactivé. Dans les versions précédentes de Sibelius, il était possible de

retourner des articulations dont Toujours au-dessus est activé en-dessous de la portée; cette

option consiste à veiller à ce que des partitions créées dans des versions précédentes figurent

dans la version actuelle de Sibelius.

* Autoriser la division d’articulations sous la ligne médiane d’un crochet de multiplet doit

être normalement activé. Lorsque c’est le cas, Sibelius autorisera l’apparition de ces articulations

avec la case …dans multiplet activée dans la médiane d’un crochet de multiplet (autrement dit,

ni sur la première ni sur la dernière note d’un crochet de multiplet).



2. Notations

92

2.4 Barres de mesure

Sibelius propose un large éventail de barres de mesure, dont certaines sont adaptées à des genres

musicaux spécifiques; elles peuvent être placées en fin ou en milieu de mesure:

Barres de mesure en fin de mesure
Les barres de mesure normales apparaissent automatiquement lors de la création des mesures.

On peut les déplacer vers la gauche ou vers la droite avec la souris ou avec les 0/1(ajouter Ctrl ou

X augmente le déplacement), ce qui modifie l’espace après la dernière note ou le dernier silence.

Pour fusionner deux mesures, il faut doubler la valeur de l’indicateur de mesure (ou créer une

mesure irrégulière) car il est impossible de supprimer une barre de mesure. De la même manière,

pour diviser une mesure en deux, il faut normalement raccourcir la valeur de l’indication de

mesure plutôt que d’essayer d’ajouter une nouvelle barre de mesure.

Autres barres de mesure
On entend par là les doubles barres, les barres discontinues, celles de

répétition, celles pour la musique ancienne, etc. Pour les créer,

sélectionnez la note qui précède l’endroit où doit se placer la barre de

mesure puis choisissez le type de barre de mesure dans Insertion >

Barre de mesure. Autre méthode à la souris; taper d’abord Échap
pour tout désélectionner puis déposer la barre sélectionnée.

Pour mettre une barre au milieu d’une mesure, remplissez d’abord

celle-ci avec les notes et/ou les silences, puis ajoutez-y ensuite la

barre de mesure. (Si la barre est placée en premier lieu, son

emplacement exact sera incertain lors de la saisie du contenu.) La

barre de mesure peut être trop proche de la première note qui suit; si cela se produit, sélectionnez

cette barre et changez le paramètre X dans le panneau Général de la fenêtre des propriétés afin

d’en modifier la position.

Si une barre de mesure doit être placée au milieu d’une mesure de silence, il convient de diviser

cette mesure, de manière à placer un silence de chaque côté pour obtenir une écriture conforme.

Pour scinder une mesure par une double barre ou une barre de répétition, par exemple à la fin

d’une ligne dans un hymne, créez deux mesures plus courtes (irrégulières) et utilisez un saut de

système pour que la scission entre les deux systèmes soit effective – b 2.5 Mesures et
mesures de silences et 8.5 Les sauts.
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Vous pouvez copier, glisser et supprimer tous ces types de barres de mesure; leur suppression (y

compris celle d’une barre invisible) rétablit la barre de mesure normale.

Double barre de mesure finale
Chaque nouvelle partition reçoit d’office une barre de mesure finale, aisément supprimable si

nécessaire.

De même, cela ne pose aucun problème de placer plusieurs double barres finales dans une

partition, par exemple quand il s’agit d’une pièce en plusieurs mouvements.

Barres de reprise
Les barres de reprise initiales et finales se créent de la même manière que les autres barres de

mesure. Pour créer un primo et un secundo, b 2.21 Lignes.

Pour ajouter des ailettes aux barres de reprise, comme c’est l’usage dans l’écriture manuscrite ou en

jazz, activez Ailettes sur les barres de reprise sur la page Barres de mesure dans Style
maison > Règles de gravure.

Pour créer une double barre de reprise à la jonction de deux sections à répéter,

installez une barre de mesure Fin de reprise à la fin de la première mesure et une barre Début de
reprise au début de la seconde. Si nécessaire, elles seront éloignées ou rapprochées par glissement.

Les barres de mesure dans la musique ancienne
Pour l’édition de la musique ancienne, Sibelius propose une série de barres de mesure spécifiques.

Dans la musique vocale antérieure à la notation mesurée, une des méthodes utilisées par les

éditeurs pour aider les interprètes d’aujourd’hui à comprendre la division rythmique consiste à

ajouter des barres de mesure entre les portées (ces barres sont parfois appelées mensurstriche).

Pour les utiliser, choisissez Entre les portées dans Type de barre de mesure par défaut dans la

page Barres de mesure de Style Maison > Règles de gravure (raccourci Ctrl+Shift+E ou xXE).

Deux conventions existent selon les éditeurs: dans l’une, on considère que les barres de mesure

sont présentes, avec des notes liées d’une mesure à l’autre (cf. ci-dessous à gauche) dans l’autre, la

musique est écrite comme s’il n’y avait pas du tout de barres de mesure (cf. ci-dessous à droite):

Sibelius lie automatiquement les notes traversant les barres de mesure, donc par défaut c’est la

première convention qui s’applique. Si vous préférez l’autre convention, utilisez des mesures

irrégulières (b 2.5 Mesures et mesures de silences), pour créer une seule mesure de la

longueur de deux mesures normales puis ajoutez la barre de mesure à l’endroit adéquat.

         









    Liaisons à travers les barres de mesure

          Des temps de noire pointée

     

 
1 mesure

      
1 mesure

        
1 mesure
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Pour la notation du plain-chant des quarts de barre et des demi-barres sont proposés:

Ces barres de mesures sont très utiles dans les passages de musique pour instrument soliste (ou

voix) mais elles peuvent aussi s’utiliser dans la musique pour plusieurs instruments si nécessaire.

Créer vos propres barres de mesure
Même s’il n’est pas possible de créer des nouveaux types de barres de mesure qui apparaîtraient

dans le menu Insertion > Barre de mesure, il est possible de modifier la présentation des barres

de mesure d’un instrument par le biais de ses caractéristiques en utilisant la boîte de dialogue

Style maison > Modifier les instruments – b 8.14 Modifier les instruments.

La jonction des barres de mesure
Sibelius relie automatiquement les portées des instruments

similaires d’un même groupe (voir l’encadré) avec les barres de

mesure. Voici comment les modifier, si nécessaire:

* De préférence rechercher un endroit de la partition sans portée

masquée pour être sûr d’y voir toutes les barres jointes existantes

* Cliquer soigneusement sur le sommet ou la base d’une barre de

mesure normale dans la partition (les barres de mesure spéciales

ne peuvent être utilisées); une poignée carrée violette apparaît

* Glisser la poignée vers le haut ou vers le bas du système pour

allonger ou raccourcir la barre de mesure. Ceci affecte

simultanément tout le système dans toute la partition

* En allongeant ou en raccourcissant les barres de mesure en bas

du système, vous pouvez réorganiser à volonté la manière dont

les portées sont groupées par les barres de mesures.

Barres de mesure invisibles
On peut masquer une barre de mesure à la fin d’une mesure en la

remplaçant par une barre invisible choisie dans le menu

Insertion > Barre de mesure. Cette barre de mesure invisible

sera affichée en gris clair si l’option Affichage > Objets
masqués (raccourci Ctrl+Alt+H ou zXH) est activée, mais

n’apparaîtra pas si cette option est désactivée.

La barre de mesure invisible est principalement utilisée lors de la

scission d’une mesure entre deux systèmes (Mesures divisées
cf. ci-dessous). Utiliser deux mesures séparées à la place d’une seule entraîne trois conséquences

inévitables: certains rythmes ne peuvent pas traverser la barre de mesure invisible (on utilisera des

notes liées); la numérotation des mesures compte une mesure en trop après la barre invisible

(installer un changement de numéro de mesure permettra d’y remédier – b 3.5 Numéros de
mesure); en cas de mesure de silence, deux mesures de silence (avec le symbole de pause de

Jonction des barres de 
mesure
En général, une barre de mesure 

continue traverse les portées 

d’instruments similaires ce qui, en 

les regroupant, apporte plus de lisi-

bilité. Ces groupes reflètent souvent 

(mais pas toujours) la manière dont 

les portées sont groupées par des cro-

chets (b 2.9 Crochets et acco-

lades).

Dans les partitions d’orchestre, les 

portées à l’intérieur des différentes 

sections (vents, cuivres, percussions 

et cordes) sont en général jointes par 

des barres de mesures.

En musique vocale, les portées ne 

sont jamais reliées entre elles ou aux 

portées d’autres instruments. Les 

portées des instruments à clavier 

sont jointes entre elles mais séparées 

de celles des autres instruments.

Quand une partition ne contient que 

quelques instruments (comme par 

ex. un quintette à vent), une barre 

de mesure continue est utilisée pour 

éviter toute confusion.
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mesure de silence) apparaissent de part et d’autre. Par conséquent, il convient d’utiliser avec

prudence les barres de mesure invisibles.

Pour masquer toutes les barres de mesure d’une partition, dans la page Barres de mesure de la

boîte de dialogue Style Maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE)

sélectionnez Invisible pour Type de barre de mesure par défaut.

Pour masquer toutes les barres de mesure par ex. d’une portée ou de toutes les portées d’un pupitre

d’instruments, cf. Masquer les barres de mesure de portées spécifiques ci-dessous.

Masquer les barres de mesure de portées spécifiques
Pour masquer toutes les barres de mesure d’un famille d’instruments (c’est-à-dire les portées

jointes par une barre de mesure continue), cliquez sur le haut ou sur le bas de la barre de mesure

de sorte qu’une poignée violette apparaisse, puis presser sur Suppr. Pour rétablir les barres de

mesure de ces portées, cliquez sur le haut ou sur le bas de la barre de mesure de la portée adjacente

et tirez-la à travers les portées qui n’ont plus leurs barres.

Pour masquer toutes les barres de mesure d’une portée en particulier, on créera un nouveau type

de portée sans barre de mesures (b 8.14 Modifier les instruments):

* Sélectionnez une mesure de la portée dont vous souhaitez masquer les barres de mesure

* Choisissez Style maison > Modifier les instruments

* Une boîte de dialogue apparaît avec l’instrument concerné sélectionné; cliquez sur Nouvel
Instrument, et cliquez sur Oui pour confirmer votre volonté de continuer

* Dans la boîte de dialogue Nouvel Instrument qui apparaît, changez le Nom de la boîte de
dialogue de manière à pouvoir vous en rappeler, puis cliquez sur Modifier le type de portée

* Dans l’onglet Général, désactivez l’option Barres de mesure, puis cliquez sur OK

* Cliquez sur OK dans la boîte de dialogue Nouvel instrument et assurez-vous que votre nouvel

instrument est dans l’ensemble qui convient de manière à pouvoir le retrouver.

* Si vous voulez qu’une portée spécifique à travers toute la partition soit sans barre de mesure,

vérifiez qu’il n’y a rien de sélectionné, puis choisissez Insertion > Autres > Changement
d’instruments, choisissez le nouvel instrument, cliquez sur OK, puis cliquez au début de la

portée sur la première page, à gauche de la barre de mesure initiale.

* Si vous voulez que ce soit un passage sans barre de mesure, sélectionnez la mesure dans laquelle

le changement doit se produire, puis Insertion > Autres > Changement d’instrument,

choisissez le nouvel instrument et cliquez sur OK.

Barres de mesure initiales dans un système à portée unique
Dans les lead sheets, l’usage est de placer une barre de mesure initiale au début de chaque système,

alors qu’en principe cette barre ne s’utilise que si au moins deux portées existent. Pour qu’une barre

de mesure initiale apparaisse dans un système à une portée, activez l’option Barre de mesure au
début d’une portée unique dans la page Barres de mesure de la boîte de dialogue Style
maison > Règles de gravure.
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Mesures divisées
Il est parfois nécessaire de scinder une mesure en deux moitiés, la première en fin de système et la

seconde au début du système suivant. Pour effectuer ceci, utilisez Extensions > Autres > Diviser
une mesure – b 6.1 Travailler avec des extensions.

Parce que les mesures divisées sont réellement séparées par une barre de mesure invisible, cela

entraîne trois conséquences inévitables (cf. ci-dessus).

Options des règles de gravure
Les options de la page Barres de mesure de la boîte de dialogue Style maison > Règles de
gravure (raccourci Ctrl+Maj+E ou xXE) permettent de modifier les réglages par défaut des

barres de mesure de la partition pour en changer l’aspect, ce qui peut servir pour les partitions

dont la plupart ou toutes les barres de mesure sont invisibles, en pointillé, ou entre les portées, etc.

Vous pouvez choisir d’utiliser ou non des barres de reprise à ailettes, de rétrécir l’épaisseur des

barres ou l’intervalle entre les double barres, s’il vous en prend le besoin irrépressible.
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2.5 Mesures et mesures de silences

b 1.1 Saisie des notes, 2.24 Mesures de comptage.

Ajout de mesures à la fin d’une partition
Choisissez Insertion > Mesure > À la fin (raccourci Ctrl+B ou XB) pour ajouter une seule mesure

à la fin de la partition.

Pour ajouter un grand nombre de mesures, maintenez Ctrl+B ou XB enfoncé et après un bref

moment, l’action se répétera automatiquement.

Ajout de mesures au milieu d’une partition
Choisissez Insertion > Mesure > Une seule (raccourci Ctrl+Maj+B ou xXB), cliquez ensuite sur

l’endroit où vous voulez créer la mesure.

Si Insertion > Mesure > Une seule est utilisé alors qu’une note, un silence ou autre objet est sélec-

tionné, la nouvelle mesure sera créée après celle de l’objet sélectionné.

Autrement, sélectionnez l’endroit de la partition où vous souhaitez ajouter des mesures, choisissez

Insertion > Mesure > Autre (raccourci Alt+B ou zB); tapez le Nombre de mesures souhaité, cli-

quez sur OK, et Sibelius ajoutera les mesures. Si rien n’est sélectionné au moment de choisir Inser-
tion > Mesure > Autre, le pointeur de la souris changera de couleur pour indiquer qu’elle est

“chargée” avec les mesures vides, que l’on déposera d’un clic à l’endroit voulu dans la partition.

Suppression complète d’une mesure entière
Pour supprimer une mesure, il suffit de la sélectionner, puis de choisir Édition > Supprimer des
mesures (raccourci Ctrl+Suppr ou X-Suppr). Cela supprime tout ce qui se trouve dans la mesure

et la mesure elle-même. Pour supprimer plusieurs mesures, sélectionnez-les préalablement

comme passage de système – Sélections de passages à la page 59.

Suppression du contenu d’une mesure dans une seule portée
* Cliquez sur une partie vide de la mesure qui sera alors entourée d’un cadre bleu clair

* Tapez Suppr pour la convertir en mesure vide. Cela supprime également tout autre objet attaché

à la portée dans cette mesure (par exemple du texte).

Pour supprimer le contenu de plusieurs mesures en une fois ou le contenu d’une mesure sur plusieurs

portées, sélectionnez les mesures et tapez sur Suppr – Sélections de passages à la page 59.

Création de mesures irrégulières
Une mesure irrégulière est une mesure dont le contenu rythmique n’est pas conforme à l’indication

de mesure. Les mesures d’anacrouse en sont un exemple. Pour créer une mesure irrégulière:

* Choisissez Créer > Mesure > Autre (raccourci Alt+B ou zB)

* Dans la fenêtre qui apparaît, cliquez sur Irrégulière

* Dans le menu déroulant, choisissez une ou plusieurs valeurs de notes ou tapez-les sur le pavé

numérique (avec Verr num activé)

* Vous pouvez aussi spécifier un Nombre de mesures si vous souhaitez plusieurs mesures irré-

gulières de la même longueur
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* Cliquez sur OK

* Cliquez dans la partition à l’endroit où vous voulez créer la ou les mesures.

Les anacrouses (ou mesure de levée)
Bon nombre de partitions commencent par une mesure courte, appelée mesure de levée ou

anacrouse. Le plus simple est de les créer lors de l’installation de l’indication de mesure

(b 2.33 Indications de mesure). Sibelius affichera le nombre exact de temps de l’anacrouse

sous forme de silences, en les répartissant selon les réglages de Groupement de ligatures (notes
et silences) créés avec l’indication de mesure. Pour ajouter une anacrouse après avoir créé une

indication de mesure:

* Rien ne doit être sélectionné; pour en être sûr, tapez Échap.

* Choisissez Insertion > Mesure > Autre

* Créez une mesure de la longueur adéquate et cliquez au début de la portée pour la placez-la au

début de la portée avant la première complète.

* Sélectionnez l’indication de mesure de la première mesure complète et tapez Suppr, à la ques-

tion concernant la réécriture des mesures suivantes, répondez Non.

* Créez l’indication de mesure de nouveau au début de la nouvelle mesure d’anacrouse, avec la

commande Réécrire les mesures jusqu’au changement de mesure suivant désactivée
(b 2.33 Indications de mesure).

* Enfin utilisez Insertion > Autres > Changement de numéro de mesure pour créer un change-

ment de numéro de mesure avec 0 placé au début de l’anacrouse (b 3.5 Numéros de
mesure).

Changement de la longueur rythmique des mesures
Il est parfois nécessaire qu’une mesure soit d’une longueur différente de celle donnée par

l’indication de mesure; b 2.33 Indications de mesure.

Voici comment procéder pour changer la longueur d’une mesure individuelle (soit qu’il est

nécessaire de conserver la musique existante et d’y ajouter des notes, soit qu’une partie est

supprimée):

* Créez une mesure irrégulière de la longueur désirée (voir ci-dessous) juste avant ou après la

mesure à modifier

* Copiez-y la musique que vous voulez conserver préalablement sélectionnée (b 1.9 À propos
des sélections et des passages)

* Supprimez la mesure originale.

Création d’une pause de mesure vide pour une seule voix
* Sélectionnez une note ou un silence de la mesure

* Tapez N pour faire apparaître le curseur de saisie des notes

* Appelez le second pavé (raccourci F8)

* Choisissez le numéro de la voix sur le pavé à l’aide des boutons au bas du pavé (raccourci Alt+1-

4 ou z1-4)

* Choisissez le bouton de pause de mesure (raccourci 0).
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Cette méthode peut également être utilisée pour placer une pause (de mesure vide) pour une voix

qui n’existait pas encore dans une mesure, ou pour convertir une mesure d’une seule voix en

mesure de silence. L’installation du symbole ne supprime que les notes ou silences. Pour supprimer

du texte, des lignes et d’autres objets attachés, sélectionnez la mesure et tapez sur Suppr.

Gardez à l’esprit que la pause de mesure vide,

bien qu’identique d’aspect (et portant le

même nom), est différente de la pause nor-

male. Les pauses de mesure vide sont centrées

tandis que les pauses normales sont alignées

sur la gauche de la mesure, à la place qu’occu-

perait une ronde comme illustré à droite:

La suppression d’une pause de mesure vide
Les mesures vierges sont utiles car on peut y placer tout ce qu’on veut, un symbole amusant par

exemple. Sélectionnez la pause de mesure et choisissez Edition > Masquer ou afficher > Masquer
(raccourci Ctrl+Shift+H ou xXH); la pause de mesure vide apparaîtra ensuite grisée si

Affichage > Objets masqués est activé. Sinon, elle sera invisible. Si la musique comporte deux

voix, appuyez d’abord sur Suppr pour effacer la mesure et restaurer la pause de mesure vide. 

Si vous souhaitez des mesures vierges dans toute la partition, désactivez Afficher les pauses de
mesure dans la page Mesures de silence du menu Style maison > Règles de gravure.

Changer la largeur d’une mesure vide
Il suffit de déplacer la barre de mesure à l’extrémité.

Double pause de mesure vide ou mesure vierge
En 4/2 et autres indications de mesure où la longueur de mesure équivaut à huit quarts de note

(noires), Sibelius affiche une double pause de mesure vide au lieu d’une pause de mesure vide nor-

male. Si vous préférez que Sibelius affiche des pauses de mesure vides dans toutes les indications

de mesure, désactivez Utiliser des double pauses de mesure vide en 4/2 sur la page Mesures
de silence de Style maison > Règles de gravure (raccourci Ctrl+Shift+E ou xXE).

Déplacer une pause de mesure
(Seulement requis quand il ya deux voix au moins)

Sélectionnez simplement le symbole de la pause de mesure et tapez 3 ou 2. Sibelius ne permet de

déplacement horizontal car – il faut voir les choses en face – ce n’est pas du tout utile.

Si vous tapez Ctrl+3/2 ou X3/2, la pause de mesure se déplace d’une dent et demi, qui est la dis-

tance entre les deux lignes des tablatures de guitare qui sont plus larges que les portées normales.

Mesures divisées
Il est parfois nécessaire de scinder une mesure en deux moitiés, la première en fin de système et la

seconde au début du système suivant. Pour effectuer ceci, utilisez Extensions > Autres > Diviser
une mesure – Diviser une mesure à la page 572.

Pause de mesure de comptage
Une pause générale est un silence sur tous les instruments, durant normalement le temps d’une

mesure. Pour plus de clarté, envisagez d’écrire G.P. au-dessus de la mesure de silence générale à

l’aide d’un style de texte système comme Tempo.





Pause de mesure vide

    
     

Pause de mesure



2. Notations

100

2.6 Groupement des ligatures

b 2.7 Positions des ligatures, 2.8 Silences ligaturés et petites hampes.

Les ligatures sont les lignes épaisses utilisées pour relier des valeurs courtes en groupe. Sibelius

placent automatiquement les ligatures des notes ; bien sûr, il est possible de les modifier.

Toute modification peut s’appliquer à un grand nombre de mesures à la fois ou note par note si

nécessaire, par exemple pour des notations spéciales telles que les ligatures d’une portée à l’autre.

Changer des groupements de ligature
Les ligatures sont adaptées à chaque métrique de la partition par défaut mais on peut préférer

différentes façons de grouper selon le contexte musical. La manière de grouper les ligatures peut se

modifier quand une nouvelle métrique est créée ou dans un passage de musique existante.

* Pour changer la manière de grouper pour une nouvelle indication de mesure, choisissez

Insertion > Indication de mesures (raccourci T), sélectionnez l’indication de mesure que vous

voulez créer, puis cliquez sur Groupement de ligatures (notes et silences).

* Pour modifier les groupes de ligatures dans un passage existant, cf. Réinitialiser le
groupement des ligatures ci-dessous.

Dans les deux cas, vous verrez une fenêtre affichant les options suivantes:

On peut modifier les groupes de ligature indépendamment pour différentes valeurs de note.

Les groupes de ligature sont représentés par les nombres de notes dans chaque groupe, séparés par

des virgules. L’addition de ces nombres doit correspondre au total affiché dans la colonne Total
(mes.).
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Par exemple, en 4/4 vous pourriez prendre l’option Grouper par croches comme suit:

Quand vous définissez une valeur de note en vue d’un regroupement des ligatures, les valeurs plus

courtes seront groupées de la même façon (sauf en 4/4 lorsque les croches assemblées en deux

groupes de quatre, un cas spécial traité ci-dessous). Cela signifie que des groupes de croches de

croches assemblées en 5,2,1 produisent des doubles croches assemblées en 10,4,2.

Si vous le souhaitez, vous pouvez imposer un autre comportement en réglant d’autres options de la

fenêtre appelées Grouper différemment les doubles croches et Grouper différemment les
triples croches. Encore une fois, vous devez vous assurer du fait que le total des valeurs des

groupes correspondent bien au nombre figurant dans la colonne Total dans la mesure.

Reprenons notre exemple en 4/4 dont voici quelques possibilités:

Pour toute métrique dont le dénominateur est plus grand que 8 (p. ex. 9/16, 15/32, etc.) la plus

longue valeur de note que vous puissiez définir est celle qui représente le dénominateur (par

exemple en 9/16 vous ne pouvez pas grouper les ligatures par valeur de croche – elles seront

toujours groupées par deux par défaut ; en 15/32 vous ne pouvez pas les grouper par valeur de

sextuple croche non plus; ces mesures hériteront toujours de groupements par croches).

Ligatures primaires et secondaires
La ligature primaire est celle qui se trouve la plus éloignée des têtes de note; les autres sont les

ligatures secondaires, par exemple:

Les notes groupées par des ligatures secondaires (que nous appellerons “sous-groupes”) devraient

toujours permettre de percevoir la division rythmique le plus clairement possible; cela se fait par

une scission en sous-groupes conformément aux plus petites unités du temps. Dans les mesures

simples, les sous-groupes sont généralement constitués de deux croches et dans les mesures

composées de trois croches. Sibelius tient compte de cette particularité mais permet de définir de

sous-groupes dans les fenêtres Groupement par ligature (notes et silences) et Réinitialiser le
groupement des ligatures si nécessaire.

  
4,4

    
2,2,2,2

          
5,2,1

         














Grouper les croches comme suit :

                       

     

4,4 2,2,2,2 5,2,1

Grouper différemment les doubles croches :
8,8 5,3,1,4,3 4,6,3,3

ligature primaire

ligature secondaire
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Pour définir un sous-groupe, activez Subdiviser les ligatures secondaires pour les croches et/ou

les doubles croches puis introduisez les sous-groupes séparés par des virgules en vous assurant

d’atteindre exactement le nombre figurant dans le colonne Total dans la mesure. Par exemple, en

6/8 vous pourriez subdiviser les ligatures secondaires de sextuples croches comme suit:

Sibelius ne tolère les groupements par croches que pour les ligatures primaires, par ex. une simple

ligature. Dans certaines situations, vous pourriez avoir besoin de ligatures primaires en double

croches; dans ce cas, ajoutez la ligature supplémentaire avec la ligne proposée dans la boîte de

dialogue Insertion > Ligne (b 2.21 Lignes).

Réinitialiser le groupement des ligatures
Pour grouper les notes avec des ligatures, sélectionnez-les simplement comme passage, puis

choisissez Notes > Réinitialiser le groupement des ligatures; une fenêtre de dialogue

apparaîtra. Si vous voulez rétablir les groupements de ligature par défaut de Sibelius pour la

mesure en cours, cliquez simplement sur OK sans effectuer aucun changement. Si vous désirez un

regroupement selon vos préférences propres, changez les réglages dans la fenêtre (cf. Changer
des groupements de ligature ci-dessus pour plus de détails) et cliquez sur OK.

Les réglages choisis dans la boîte de dialogue Notes > Réinitialiser le groupement des ligatures
ne s’applique pas au reste de la partition ; si des valeurs des notes sont modifiées par la suite dans

les mesures déjà réinitialisées, les groupes de ligature seront restaurés selon les groupes spécifiques

à la mesure en cours. Si nécessaire, vous pouvez créer une nouvelle métrique avec les groupes de

ligature désirés, cliquez sur Oui quand il vous est demandé si vous voulez que les mesures

suivantes soient réécrites. Ensuite, supprimez-les après avoir terminé la saisie et les modifications,

cette fois en répondant Non quand il vous est demandé si vous voulez que les mesures suivantes

soient réécrites.

Réutiliser des groupements de ligature
Si au moment de créer une indication de mesure donnée (par ex. 7/8), vous en réglez les

groupements de ligature, ceux-ci s’appliquent sur toutes les mesures suivantes jusqu’au premier

changement d’indication de mesure qui survient. Mais si d’autres indications de mesure en 7/8

apparaissent ailleurs dans la partition, il se peut que leurs groupements de ligature soient

différents – les réglages des groupements de ligature n’affectent qu’une seule indication de mesure.

Cependant, si vous voulez d’autres indications de mesure en 7/8 qui utilisent les mêmes

groupements, il suffit de copier l’indication de mesure.

Si vous voulez des mesures de 7/8 avec des groupements différents, une mesure en 2+2+3 suivie de

mesures en 3+2+2, créez deux indications de mesure de 7/8 avec des groupements différents,

copiez les mesures ou les passages concernés, faites la saisie des notes, puis supprimer toutes les






Grouper les croches comme suit :
3,3     


Sous-diviser leurs ligatures secondaires :
2,2,2,2,2,2           
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indications de mesure superflues (choisissez Non quand il vous sera demandé si la musique doit

être réécrite).

Editer des groupements de ligature
Pour ajuster les ligatures localement plutôt que dans tout un passage ou dans toute la partition,

vous pouvez utiliser les boutons du troisième pavé (raccourci F9). Sélectionnez simplement la ou

les notes, petites notes ou silence(s) que vous voulez ajuster puis choisissez le bouton approprié.

Ligatures à travers les barres de mesure, Sauts de système et sauts de page
Pour ligaturer une note à la dernière de la mesure précédente, sélectionnez la note en début de

mesure, choisissez le troisième pavé (raccourci F9) et tapez 8 sur le pavé numérique.

Si une ligature enjambe une barre de mesure placée à un saut de page ou à un saut de système,

Sibelius accepte que la ligature continue au-delà du saut, comme dans l’exemple ci-dessous tiré de

la partie de clarinette basse du Petrouchka de Stravinsky:

Pour prolonger une ligature au-delà d’une barre de mesure, placée sur un saut de page ou de

système, utilisez le pavé F10 pour régler la dernière note de la fin du système sur Début de
ligature (raccourci 7 sur le pavé) ou Milieu de ligature (raccourci 8), et la première note du

système suivant sur Milieu de la ligature (raccourci 8) ou Fin de ligature (raccourci 9).

Si vous devez ajuster l’angle de la ligature, déplacez la poignée de la hampe de la dernière note du

groupe placé avant le saut, et la poignée de la hampe de la dernière note du groupe après le saut.

Si vous n’utilisez pas les positions de ligature en mode Optical (cf. Options des règles de
gravure à la page 109), ajuster la longueur des hampes des notes au début de la ligature affectera

l’inclinaison de la hampe. Si une ligature enjambant les portées se relie à une seule note après le

saut, sa ligature est horizontale.

Interrompt la ligature depuis la note précédente

Relie les ligatures aux notes précédentes

Termine la ligature en cours (c-à-d. détache la ligature des notes qui suivent)

Isoler la note des celles qui l’entourent

Relie uniquement la ligature primaire aux notes précédentes.
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Ligature des multiplets
Si un multiplet tombe dans un groupe, il est généralement attaché à d’autres notes dans le groupe

(à moins que les notes dans le multiplet soient de même durée que les notes de l’autre côté). Mais il

se peut aussi que vous préfériez toujours séparer des multiplets de chaque côté, pour rendre le

rythme aussi clair que possible.

L’option Séparer les multiplets des notes adjacentes dans la boîte de dialogue Groupement
de ligatures, activée par défaut, contrôle ce comportement. Vous pouvez voir son effet dans cet

exemple:

Ligature des croches en 4/4
Par défaut, Sibelius ligature les croches par quatre dans les mesures simples (p. ex. 2/4, 4/4, 2/2).

Lorsque quatre croches consécutives tombent dans une division de temps, elles sont ligaturées.

Sibelius interrompt automatiquement la ligature si le rythme change à l’intérieur du groupe, p. ex.

Si vous souhaitez modifier ce comportement, définissez de nouveaux groupements de ligatures

(réglez par ex. l’option Grouper les croches selon sur 2,2,2,2 etc.) lorsque vous créez l’indication

de mesure, ou lorsque vous choisissez Notes > Réinitialiser le groupements des ligatures pour

réinitialiser les ligatures d’un passage existant. Sibelius n’applique pas cette règle lorsque l’option

Ligatures à travers des silences (sur la page Ligatures et hampes de Style maison > Règles de
gravure) est activé (b 2.8 Silences ligaturés et petites hampes).

Ligatures en éventail
Dans la musique contemporaine, des ligatures supplémentaires s’évasent parfois pour indiquer un

accelerando ou un ritenuto, comme ceci:

Pour créer une ligature en éventail, sélectionnez la première note d’un groupe de notes ligaturées

d’un sous-groupe, passez au troisième pavé (raccourci F9), puis choisissez le type de groupe de

notes ligaturées souhaité: cliquez  (raccourci 0) pour une ligature accelerando, ou 

(raccourci) pour une ligature ritenuto.

Les ligatures en éventail ne se reproduisent pas comme accelerando ou ritenuto: si vous souhaitez

produire une approximation à des fins de lecture, essayez d’utiliser des multiplets imbriqués avec

des crochets masqués – cf. Multiplets imbriqués à la page 221.

Désactivé
(par défaut)

   
Activé

   
3 3

                    3

     
            


p ffp ff
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Masquer les ligatures, les crochets de note et les fractions de ligature
Pour masquer une ligature, sélectionnez-la (pas la note) et choisissez Édition > Masquer ou
afficher > Masquer (raccourci Ctrl+Shift+H ou xXH). Comme pour les autres objets, les

ligatures masquées sont affichées en grisé si Affichage > Objets masqués est activé (raccourci

Ctrl+Alt+H ou zXH), et invisibles dans le cas contraire.

Vous pouvez aussi masquer les crochets de note et les fractions de ligature (p. ex. des croches) de la

façon suivante: sélectionnez le crochet ou la fraction de ligature et choisissez Édition > Masquer
ou afficher > Masquer. Si vous avez ligaturé des notes avec des fractions de ligature (par ex. une

croche pointée suivie d’une double croche), vous pouvez même masquer la fraction de ligature

indépendamment de la ligature principale.

Lorsque vous masquez, par exemple, la ligature de deux croches, vous ne les transformez pas en

noires, elles en prennent seulement l’apparence!

options des règles de gravure
La page Ligatures et hampes de Style maison > Règles de gravure contient toutes les options

concernant l’apparence et la position des ligatures. Les options Positions de ligature sont

expliquées page 109, et les options Silences dans les ligatures sont expliquées page 112.

Les options sous Aspect des ligatures sont assez explicites; sont contrôlés l’épaisseur et l’espace

de séparation des lignes de la ligature et si les groupes de notes ligaturées peuvent commencer avec

par un silence.

L’option la plus spectaculaire est Ligatures à la française qui évite l’effet “cage à

poules” en raccourcissant les hampes des notes intérieures comme illustré à
droite. Cette convention est particulièrement usitée en France (d’où le nom).
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2.7 Positions des ligatures

b 2.6 Groupement des ligatures, 2.8 Silences ligaturés et petites hampes.

Les ligatures sont positionnées à la verticale dans et au-dessus de la portée suivant un ensemble

complexe de conventions prévues pour assurer une lisibilité maximum : en règle générale, l’angle

d’une ligature est déterminée d’après le contour des notes dans le groupe de ligatures, et l’angle de

la ligature est déterminé par la position de chaque extrémité, qui doit se placer sur, chevaucher

(c.-à.-d. centrée au-dessus) ou s’accrocher à une ligne de portée.

Sibelius suit ces principes d’après un ensemble de règles que nous appelons Position des ligatures

en mode Optical, de sorte que vous n’avez pas à vous préoccuper des positions de le ligature à

moins que vous le souhaitiez vraiment. Si cela se produit, il convient d’ajuster la position des

ligatures, soit au cas par cas ou pour toute la partition, et Sibelius vous propose un contrôle

complet.

Angles de ligature
Occasionnellement, vous pourriez désirer ajuster une inclinaison ou une position de ligature, tant

pour éviter une collision avec une petite note ou un autre obstacle que pour l’application de vos

principes sur les ligatures si vous êtes graveur. Si vous voulez ajuster plusieurs ligatures, l’idéal est

de modifier les réglages dans les Règles de gravure pour les ligatures (cf. Options des règles
de gravure

 ci-dessous); l’angle des ligatures y est réglé de manière globale. Pour déplacer une ligature,

affichez-là en agrandissement afin de voir ce que vous faites et glissez simplement son extrémité,

soit avec les flèches vers le haut et vers le bas, soit avec la souris. Alternativement, sélectionnez

l’une des extrémités, puis déplacez-la à l’aide des touches 3 ou 2. Ctrl+3/2 ou X3/2 déplace la

ligature par dents entières. Vous pouvez aussi faire des ajustements rapides de l’angle d’une ligature

en la sélectionnant elle-même et en la glissant vers le haut ou vers le bas ; ceci déplace l’extrémité

gauche de la ligature.

Pour replacer une ligature à sa position normale, choisissez Notes > Réinitialiser les hampes et
les angles de ligature; cela fonctionne aussi pour un passage ou pour une sélection multiple.

L’ajustement d’un angle de ligature se fait exactement de la même manière que l’ajustement de la

longueur des hampes qui lui sont attachées.

Ligatures droites
Dans certaines musiques (p. ex. pour percussions) il est habituel de toujours écrire les ligatures

droites, sans aucune inclinaison. Sibelius utilise toujours par défaut des ligatures droites pour les

portées de percussion mais si vous voulez utiliser cette convention pour d’autres instruments,

éditez l’instrument en question via Style maison > Modifier les instruments. Dans la boîte de

dialogue Modifier l’instrument, activez Ligatures toujours horizontales sur la page Notes et
silences de la fenêtre Modifier le type de portée se rapportant au type de portée –

b 8.14 Modifier les instruments.
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Inversion des ligatures
Pour placer en dessous des notes une ligature placée au-dessus - c’est-à-dire pour inverser la

direction des hampes de toutes les notes de la ligature - sélectionnez n’importe quelle note du

groupe (une seule suffira) et retournez-la en choisissant Édition > Retourner (raccourci X) ;

b 2.30 Hampes et lignes supplémentaires si vous n’êtes pas sûr de la procédure. Pour

rétablir la direction de hampe initiale, retournez la même note à nouveau, ou sélectionnez le

groupe de notes et choisissez Notes > Réinitialiser les hampes et les angles de ligature.

Si Édition > Retourner ne fonctionne pas pour une note ligaturée, sélectionnez toutes les notes du

groupe et choisissez Notes > Réinitialiser les hampes et les angles de ligature. Ensuite, faites

simplement basculer la première note.

Inverser les ligatures divisées
Parfois, un tronçon de ligature dans un groupe de notes ligaturées se trouve du mauvais côté de la

hampe, à droite au lieu d’être à gauche, ou vice-versa. Pour le placer de l’autre côté, sélectionner la

note, et dans le panneau Notes de la fenêtre du menu Fenêtre Propriété activez Inverser ligature
divisée.

Ligatures entre portées
La musique pour instruments à clavier contient souvent des notes ligaturées suivant la trajectoire

des mains comme ceci:

Voici comment obtenir ce résultat :

* Saisissez toute la musique sur la portée principalement utilisée par la musique passant d’une

main à l’autre – la portée supérieure dans ce cas :

* Sélectionnez les notes qui devraient passer sur la portée inférieure – dans ce cas le Si et les Sol

avec lignes supplémentaires

* Faites-les enjamber la portée en choisissant Notes > Enjambement de portée > Déplacer vers
la portée inférieure (raccourci Ctrl+Maj+2 ou xX2).

Bien entendu, Notes > Enjambement de portée > Déplacer vers la portée supérieure
(raccourci Ctrl+Maj+ 3 ou xX3) crée un enjambement à la portée supérieure.

Si cela devient trop confus, vous pouvez utiliser Notes  > Enjambement de portée > Passer à la
portée initiale.
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* Vous pouvez placer les ligatures au-dessus des deux portées (comme dans le premier groupe

ligaturé dans l’image ci-dessus) ou entre les portées (comme dans le dernier groupe ligaturé) en

retournant simplement la direction des hampes de la façon appropriée à l’aide de Édition >

Retourner (raccourci X).

Ne le faites pas en glissant les hampes du côté opposé des notes, ça n’aura pas l’effet désiré !

* Dans la première illustration ci-dessus, les hampes des trois dernières notes de la main gauche

ont aussi été inversées pour ne pas entraver celles de la main droite.

Quelques remarques :

* La hampe d’une note ne doit pas traverser de portée adjacente. On peut aussi envoyer les silences

sur une autre portée.

* Les notes ne peuvent enjamber une autre portée que s’il s’agit du même instrument.

* Vous pouvez ligaturer à travers trois portées en effectuant la saisie sur la portée du milieu puis en

répartissant les notes sur les portées supérieure et inférieure. (Si nécessaire, laissez des notes sur

la portée centrale !)

* Les notes passant sur une autre portée n’affectent en rien les voix de cette portée. Une portée

peut avoir jusqu’à quatre voix, plus les notes enjambant les portées adjacentes vers celle-ci !

* Les notes respectent toujours les instructions relatives à la portée auxquelles elles sont attachées.

Par exemple, si vous transposez un passage d’une portée originale, toutes les notes déplacées

ensuite sur une autre portée resteront toujours transposées.

* Parfois vous pourriez rencontrer des altérations redondantes en envoyant des notes sur une

portée voisine. Sélectionnez simplement les altérations et masquez-les pour résoudre ce

problème – b 2.1 Altérations.

Ligatures entre les notes d’une même portée
Dans les anciennes partitions, particulièrement dans la musique pour violon, si

un groupe comprend des notes très graves puis d’autres très aiguës (ou vice

versa), vous verrez parfois la ligature entre les notes avec les hampes dirigées

différemment comme dans l’illustration à gauche.

Pour obtenir ceci avec Sibelius, faites une saisie normale de note, puis sélectionnez la ligature

placée au-dessus ou en dessous des notes et déplacez-la (ou utilisez les touches de flèche) pour

amener la ligature entre les notes. Pour en ajuster l’angle, sélectionnez l’extrémité droite et

déplacez-la avec la souris ou avec les flèches 3/2.

Répartition des accords entre les portées
Il est habituel dans la musique pour clavier de répartir certains accords entre deux portées :

Pour cela, écrivez chaque note de l’accord à répartir sur la portée et

la voix les plus appropriées ; par exemple dans le cas illustré,

mettez les notes aiguës de l’accord à la voix 1 de la portée

supérieure et les notes graves à la voix 2 de la portée inférieure.

Utilisez ensuite Édition > Retourner (raccourci X) pour faire

pointer les hampes des notes de la portée inférieure vers le bas.
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Enfin, glissez vers le bas l’extrémité de chaque hampe de la main droite afin de rencontrer les

hampes des notes de la main gauche.

Dans le cas d’accords utilisant des notes plus courtes qu’une noire, masquez les crochets ou les

ligatures en les sélectionnant puis en appuyant sur Ctrl+Maj+H ou xXH, puis étendez leurs

hampes, en les retournant si nécessaire à l’aide de Édition > Retourner, pour rencontrer le reste de

l’accord.

Options des règles de gravure
La page Ligatures et hampes de Style maison > Règles de gravure vous permet de contrôler les

positions des ligatures et aussi leur aspect (cf. page 105).

La plupart des options de Position des ligatures s’appliquent seulement si position des
ligatures en mode Optical est activé. (Désactiver Ligatures en mode Optical rétablit les

ligatures, bien moins belles, telles qu’elles apparaissaient dans Sibelius 3 et les versions

précédentes.)

Si l’intervalle entre la première et la dernière note ne dépasse pas l’octave, vous pouvez spécifier un

angle “idéal” pour chaque intervalle dans Inclinaison par défaut selon l’intervalle. Pour

certaines liaisons, l’angle doit être ajusté car elles ne peuvent apparaître dans certaines position,

par exemple entre deux portées. De même si deux notes sont très proches l’une de l’autre, avec une

ligature trop inclinée, l’angle pourra être réduit à la valeur spécifiée dans Gradient maximum de
ligature : au-delà de l’octave, 1 pour n.

Gradient maximum de ligature : 1 pour n contrôle l’angle pour des intervalles plus grands

qu’une octave. La ligature suit l’angle entre la première et la dernière tête de note sans dépasser cette

valeur.

Si des notes au milieu de la ligature sont trop éloignées à l’opposé de la ligature, l’obligeant à

prendre une forme concave, alors il est préférable qu’elle reste horizontale. Pour contrôler cela,

utilisez Horizontal si les notes au milieu interfèrent de n dents (qui spécifie la distance entre

une note centrale et la ligne imaginaire de la première note à la dernière note au-delà de laquelle la

ligature sera horizontale). Par défaut, cette même règle s’applique aussi aux groupes de ligatures

incluant des silences au milieu du groupe (désactivez Silences intermédiaires également si vous

souhaitez exclure des silences dans la ligature pour savoir si la ligature doit ou non être

horizontale).

Éviter les coins simples évite les cas de formation de coins dans les groupes de croches. Cela se

produit quand une ligature, une hampe et une ligne de portée forment un triangle blanc ce qui a le

don d’irriter certains graveurs de musique. D’autres ne sentent absolument pas concernés par ce

phénomène. L’option permet de l’éviter en allongeant les hampes, avec un résultat que certains

estiment pire que les coins eux-mêmes. C’est pourquoi cette option est vraiment une option !

Les longueurs des hampes spécifiées dans Longueur par défaut des hampes de notes
ligaturées sont en général plus courtes que celles des notes normales (et se raccourcissent encore

plus pour les notes très aiguës ou très graves). Cependant, ceci est compensé par le fait que des

hampes sont allongées à nouveau, si nécessaire, pour que la ligature se place correctement. Vous

pouvez aussi contrôler la longueur des hampes de toutes les notes, ligaturées ou non en utilisant

Longueur minimum n dents en bas de la page.
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Les ligatures entre les portées sont toujours horizontales par défaut (étant acquis que Ligatures en
mode Optical est activé), et se placent entre les deux portées. Si vous voulez des ligatures entre

portées avec un angle, il faut les régler à la souris au cas par cas.

L’option Utiliser les matrices précises de mise en page magnétique permet d’améliorer la

précision de la mise en page magnétique pour les objets de forme irrégulière ou inclinée, tels que

les ligatures, les crochets de multiplet, les soufflets, etc. Lorsque cette fonction est désactivée,

Sibelius utilise uniquement des matrices rectangulaires et les articulations et liaisons sont par

conséquent mal positionnées. Il est donc vivement conseillé d’activer cette option pour toutes les

partitions utilisant la fonction de mise en page magnétique.



2.8 Silences ligaturés et petites hampes

111

N
o

tatio
ns

2.8 Silences ligaturés et petites hampes

b 2.6 Groupement des ligatures, 2.7 Positions des ligatures.

Le ligaturage à travers des silences peut faciliter la lecture des rythmes. Dans certaines partitions

modernes, les silences dans les ligatures sont parfois accompagnés de “petites hampes” (parfois

appelées “demi-hampes”). Ce sont des hampes courtes qui s’étendent de la ligature au silence (ou à

proximité du silence). Sibelius peut automatiquement ligaturer à travers des silences, aussi bien

dans un groupe qu’à son extrémité, à l’aide de “petites hampes”, si nécessaire.

Ligatures à travers des silences
Vous pouvez déterminer si Sibelius doit ligaturer à travers des silences avec les options suivantes

sur la page Ligatures et hampes de Style maison > Règles de gravure :

* Ligaturer depuis et vers les silences permet à un groupe ligaturé de commencer ou de se

terminer par un silence

* Ligaturer à travers les silences signifie que les silences ne vont pas interrompre les groupes de

ligature s’ils sont englobés dans ceux-ci.

Voici quelques exemples concrets de ces options :

Vous remarquerez que les ligatures sont toujours horizontales dans les groupes ligaturés qui

commencent ou se finissent avec un silence, quelque soient les hauteurs des notes sous la ligature.

Quand les silences interviennent au milieu d’un groupe ligaturé, pas au début ou à la fin, l’angle de

ligature suivra le contour des notes comme d’habitude.

Quand les notes interviennent sur de nombreuses lignes supplémentaires au-dessus ou au-dessous

de la portée dans les passages pour une seule voix, Sibelius place les silences au milieu de la portée,

normalement, et s’assure que la ligature n’entre pas en collision avec les silences, permettant ainsi

aux hampes d’être plus longues que d’habitude, comme indiqué sur l’image en bas à gauche.

Si vous déplacez le silence (en le sélectionnant et pressant 3/2), la ligature se déplacera

automatiquement jusqu’à ce que les hampes fassent une longueur idéale, comme indiqué sur

l’image en bas à droite.

Si vous ne souhaitez pas que Sibelius fonctionne de cette manière, désactivez Modifier la
longueur des hampes pour éviter les silences dans les ligatures sur la page Ligatures et
hampes de Style maison > Règles de gravure, mais soyez con4scients qu’une fois cette option

désactivée, les ligatures peuvent entrer en collision avec les silences au milieu des groupes

ligaturés.

Ligaturer depuis et vers les silences

         
Ligaturer à travers les silences 
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Quand des silences de même longueur que les notes environnantes apparaissent dans un groupe

ligaturé, certains éditeurs préfèrent casser la seconde ligature au-dessus ou au-dessous du silence :

Par défaut, Sibelius produit le résultat montré en haut à gauche. Mais vous pouvez obtenir le

résultat en haut à droite en activant Diviser les ligatures secondaires sur la page Ligatures et
hampes de Style maison > Règles de gravure.

Modifier les ligatures à travers des silences
Vous pouvez choisir si les silences doivent être ou non ligaturés individuellement à l’aide des

boutons sur le troisième pavé (raccourci F9), quelque soient les options de Ligatures à travers
des silences ou Ligaturer depuis et vers les silences. Pour en savoir plus sur le fonctionnement

de ce pavé, reportez-vous à page 103.

Pour rétablir un silence ligaturé à son état par défaut, sélectionnez-le et choisissez Mise en page >

Rétablir l’aspect original.

Hampes courtes
Pour utiliser des petites hampes dans votre partition, sélectionnez Utiliser des petites hampes
sur les ligatures sur la page Ligatures et hampes de Style maison > Règles de gravure.

Les autres options concernant les petites hampes sont :

* Faire des ligatures horizontales pour les groupes avec des petites hampes dit à Sibelius

que la ligature doit toujours être horizontale si une petite hampe est utilisée dans le groupe.

* Quand Étendre les petites hampes à la portée est activé, les petites hampes peuvent être

dessinées sur la portée vers les silences auxquels elles appartiennent. Sibelius n’autorisera pas

qu’une petite hampe soit plus longue que la plus courte des hampes sur n’importe quelle note du

groupe ligaturé par défaut, les petites hampes se terminent toujours dans l’espace hors du dessus

ou du dessous du silence.

Quand Étendre les petites hampes à la portée est activé, les petites hampes sont dessinées

hors de la portée et terminent à un demi-espace au-dessus ou au-dessous de la ligne supérieure

ou inférieure de la portée (selon si la ligature est au-dessus ou au-dessous de la portée). Sibelius

applique la valeur Longueur minimum de petite hampe dans ce cas et par conséquent les

groupes ligaturés qui incluent des petites hampes seront toujours horizontaux quand Étendre
les petites hampes à la portée est activée.

* Longueur minimum de petite hampe n dents détermine la distance d’extension de la petite

hampe depuis la ligature intérieure. C’est une longueur minimum plus qu’une longueur absolue,

 
       

 
       

Diviser les ligatures secondaires Lier les ligatures secondaires

 
Créer des ligatures horizontales pour les groupes 
avec de petites hampes

hors

   
sur

   
hors

Étendre les petites hampes à la portée 

   
sur
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étant donné que la longueur peut varier selon l’angle de la ligature et d’autres paramètres qui

s’appliquent aux petites hampes.

Les groupes ligaturés qui débutent ou se terminent avec un silence doivent toujours être dessinés

avec des ligatures horizontales. Toutefois, les autres groupes ligaturés présenteront des angles de

ligatures normaux (sauf si Étendre les petites hampes à la portée est désactivé). Si vous

préférez que les petites hampes présentent toujours des ligatures horizontales, activez Faire des
ligatures horizontales pour les groupes avec des petites hampes.

Modifier la longueur d’une petite hampe
Pour régler la longueur d’une petite hampe, cliquez sur l’extrémité de la petite hampe dans la

ligature : une petite poignée apparaît. Cliquez et tirez la souris ou utilisez 3/2 (avec Ctrl ou X

pour de plus grands incréments) pour les régler. Vous pouvez également utiliser le paramètre Y du

panneau Général des Propriétés pour ajuster numériquement la longueur des hampes courtes.

Pour rétablir la longueur par défaut d’une petite hampe, sélectionnez-la et choisissez Mise en
page > Réinitialiser les positions.

Modification manuelle des petites hampes
Les petites hampes peuvent être ajoutées ou supprimées pour les silences individuels à

l’aide du nouveau bouton de petite hampe sur le troisième pavé (raccourci – dans

Windows, * sur Mac), indiqué à gauche. De cette manière, vous pouvez créer des petites

hampes sur des silences ligaturés spécifiques même si Utiliser des petites hampes sur les
silences ligaturés est désactivé ou les supprimer de silences ligaturés spécifiques comme dans le

reste de la partition.

Pour rétablir un silence ligaturé à son état par défaut, sélectionnez-le et choisissez Mise en page >

Rétablir l’aspect original.
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2.9 Crochets et accolades

Les crochets et les accolades sont placés à gauche d’un système pour grouper les instruments

similaires. Par défaut, Sibelius propose des groupements, que vous pouvez modifier à votre guise.

Déplacement des crochets et des accolades
Dans une partition on peut choisir quelles portées seront

reliées par un crochet ou une accolade:

* De préférence, recherchez un endroit dans la partition où

il n’y a pas de portées masquées de manière à pouvoir

visualiser en une fois tous les crochets et accolades

* Cliquez sur l’extrémité d’un crochet, d’un crochet

secondaire ou d’une accolade, lequel deviendra violet

* Glissez-le vers le haut ou vers le bas pour l’étirer ou le

raccourcir

* Pour ajouter un crochet, un crochet secondaire ou une

accolade, tapez simplement Suppr.

Ajouter un crochet, un crochet secondaire 
ou une accolade
* Dans le menu Insertion > Autres > Crochet ou
accolade, choisissez-le en cliquant parmi ces trois

symboles, Crochet, Crochet secondaire ou Accolade

* Cliquez à gauche d’une portée à l’endroit où doit venir le

symbole choisi

* Cliquez et glissez le sommet ou la base de celui-ci pour

l’étendre à d’autres portées.

Crochets
Sibelius masque automatiquement les crochets et accolades s’il n’y a pas de barre de mesure initiale

à gauche du système. Par exemple, si vous masquez une des deux portées d’une partie de piano,

une seule portée sera visible et Sibelius masquera l’accolade; de la même manière, si tout un

groupe de portées reliées par un crochet dans un ou plusieurs systèmes est masqué, Sibelius

masque le crochet.

Si vous souhaitez masquer un crochet ou une accolade dans d’autres situations (par exemple dans

une partition avec des fragments de portée), sélectionnez la mesure qui suit le crochet à masquer,

ouvrez ensuite le panneau Mesures de la fenêtre des propriétés et désactivez Crochets. Pour en

savoir plus à propos des propriétés des objets, b 5.17 Propriétés.

Règles de gravure
Il arrive parfois que dans la musique pour clavier (et particulièrement dans celle pour orgue) il soit

nécessaire de placer une accolade au milieu d’un système. Cela se produit aussi dans certaines

partitions contemporaines fragmentées (cf. Portées interrompues par des espaces à la

Crochets et accolades
D’habitude, les portées des instruments d’une 

même famille (bois, cuivres, percussions, par 

exemple) sont reliées par un crochet, contraire-

ment aux percussions et instruments solistes.

Les portées des instruments divisés en deux 

voire plus, tels que les cordes en divisi, sont 

jointes par un crochet secondaire (un fin crochet 

à gauche du principal). Des crochets secon-

daires sont aussi quelques fois utilisés pour 

grouper des instruments similaires, par ex. les 

flûtes et le piccolo ou les violons I et II. Dans les 

partitions orchestrales plus anciennes, les cro-

chets secondaires sont parfois remplacés par des 

accolades, spécialement pour le groupe des cors.

Les portées pour claviers sont jointes par une 

accolade mais il n’y a pas d’accolade entre la 

portée de pédale d’orgue et celle des claviers 

d’orgue.

Les petits groupes d’instruments ne sont généra-

lement pas reliés du tout.

Les instruments reliés par un crochets, un cro-

chet secondaire ou une accolade sont normale-

ment reliés à l’identique au niveau des barres de 

mesure.
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page 198), dans lesquelles un instrument est introduit en plein milieu d’une page.

Si vous avez besoin d’introduire une accolade en milieu de système:

* Sélectionnez la mesure qui sera précédée de l’accolade

* Ouvrez le panneau Mesures des propriétés, et dans Espace avant la mesure augmentez de très

peu la valeur (par exemple de 0,03 ou 0,06) jusqu’à ce qu’apparaisse une accolade. (Ceci crée de

fait un système fragmenté, comme dans le cas d’une coda mais avec un minuscule interstice

entre les fragments.)

* Puis dans le même panneau désactivez Barres de mesure initiales et Clefs.

Vraisemblablement, la première note de la mesure précédée de l’accolade devra être déplacée vers

la gauche pour combler l’espace laissé par les clefs enlevées: déplacez-la vers la gauche autant que

possible, puis diminuer la valeur en X du panneau Général des propriétés jusqu’à obtenir la

position correcte (il faudra procéder de la sorte pour toute note ou silence placé au début de la

main gauche). Glissez ensuite la deuxième note vers la gauche jusqu’à ce que l’espace entre les deux

premières notes redevienne normal.

Remarquez toutefois que cette méthode demande un réajustement des crochets et accolades de

toutes les portées apparaissant à cet endroit, ce qui n’est pas vraiment pratique dans une partition

contemporaine avec de nombreux fragments. Dans ce cas, il vaut mieux définir un nouveau type

de portée dont l’option Crochet (dans l’onglet Général de la boîte de dialogue Modifier les types
de portée, accessible dans la boîte de dialogue Modifier les instruments); il suffira alors

d’appliquer un changement d’instrument à toutes les portées apparaissant à cet endroit. Pour en

savoir davantage, b 8.14 Modifier les instruments.

Style de crochets et des accolades
Plusieurs options peu évidentes sont proposées dans la page Crochets de la boîte de dialogue

Style maison > Règles de gravure (raccourci Ctrl+Shift+E ou xXE), elles permettent d’ajuster

l’épaisseur et la position des crochets, crochets secondaires et accolades. Ces options sont

explicites, excepté l’option Dessiner comme une accolade, qui permet de suivre la pratique

ancienne qui consiste à joindre les portées de Violon I et II (par exemple) avec une accolade plutôt

qu’avec un crochet secondaire.

Si vous utilisez la police de Sibelius Helsinki, vous remarquerez que son accolade est légèrement

plus fine et plus incurvée que celle d’Opus. 

Pour utiliser un crochet sans extrémités saillantes, ainsi que le font certains compositeurs comme

Penderecki, créez-en un modèle dans la boîte de dialogue Style maison > Modifier les lignes;

pour chaque option Terminaison cochez Aucune. N’apparaissant pas automatiquement au début

de chaque système, ce symbole sera à placer manuellement dans la partition.

Les accolades sont dessinées par mise à l’échelle du symbole { , qui se trouve dans la rangée

Général de la boîte de dialogue Insertion > Symbole. Pour modifier la forme d’une accolade,

choisissez le caractère {b 2.31 Symboles dans une autre police de caractère musicale ou de

texte (). Certaines imprimantes n’arrivent pas à imprimer une accolade étirée; si votre imprimante

n’imprime les accolades qu’avec l’option Remplacer accolades activée dans la boîte de dialogue

Fichier > Imprimer, alors elle est affectée par cette restriction et l’aspect des accolades ne pourra

pas être modifié dans Sibelius.
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2.10 Les symboles d’accord

Les symboles d’accord sont des objets qui décrivent l’harmonie à l’endroit de la partition où il sont

placés et sont généralement rencontrés dans les compositions musicales de jazz, de pop et de

musique commerciale. Bien que de nombreuses conventions de symboles d’accord soient utilisées,

principalement selon le style de musique, la convention la plus récurrente utilise les noms de notes

comme base du symbole d’accord.

Dans Sibelius, un symbole d’accord est composé de deux parties, qui peuvent être

affichées indépendamment de l’autre si vous le souhaitez : le texte de l’accord ou son

diagramme. Les diagrammes d’accords sont parfois appelés grilles d’accord, grilles de

Manche, cadres de guitare et montrent graphiquement les doigtés sur les frettes et les

cordes. 

Que vous désiriez l’un ou l’autre ou les deux, n’importe quel symbole d’accord peut être saisi d’une

ou deux manières différentes : en le saisissant dans la partition ou en le jouant sur un clavier MIDI

(ou guitare MIDI).

Aperçu de la création des symboles d’accord
* Sélectionnez la note ou le silence sur la portée au dessus duquel vous souhaitez ajouter les

symboles d’accord et choisissez Créer > Symbole d’accord (raccourci Ctrl+K or XK, pour

“kord”).

* Un curseur clignotant apparaît au dessus de la portée. Vous pouvez alors soit :

% saisir le symbole d’accord désiré, p.e. “Cmaj7” - cf. Créer des symboles d’accord au
clavier ci-dessous ; soit

% jouer l’accord sur votre clavier MIDI dans n’importe quel voicing - cf. Créer des symboles
d’accord lors de l’exécution ci-dessous.

* Pressez Espace pour faire avancer le curseur à la note ou position rythmique suivante (si vous

saisissez un symbole d’accord avec votre clavier MIDI, le curseur avance

automatiquement) ; pressez Tab pour faire avancer le curseur au début de la prochaine mesure.

* Si vous faites une erreur, pressez Ret. arrière pour modifier le symbole d’accord précédent ou

pressez Maj-Tab pour revenir au début de la mesure précédente.

Aperçu de la modification des symboles d’accord
Vous pouvez modifier les symboles d’accord globalement ou individuellement. Les modifications

globales incluent diverses possibilités comme la manière dont vous souhaitez que tous les accords

septièmes majeurs s’affichent ou si vous souhaitez que les diagrammes d’accord de guitare

apparaissent sur toutes les portées ou seulement sur les portées de notation pour guitare, etc. Ces

paramètres sont modifiables sur la page Symboles d’accord de Style maison > Règles de
gravure et dans Style maison > Modifier les symboles d’accord, et sont expliqués en détails

dans b 8.13 Modifier les symboles d’accord.

Les modifications individuelles affectent uniquement le symbole d’accord sélectionné.

* Pour modifier un symbole d’accord existant, sélectionnez-le puis pressez Retour (sur le clavier

principal) ou double-cliquez dessus.

3fr

C&7(b9)
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* Pour corriger un symbole d’accord saisi au clavier MIDI, p.e. un symbole d’accord basé sur Fa#
qui devrait être basé sur Solb, sélectionnez le symbole d’accord et choisissez Edition > Symbole
d’accord > Corriger le symbole d’accord, qui est aussi disponible dans le menu contextuel

quand vous cliquez-droit (Windows) ou Control-cliquez (Mac) sur un symbole d’accord

sélectionné.

* Pour afficher ou occulter un diagramme d’accord pour un symbole d’accord donné,

sélectionnez-le puis choisissez Edition > Symbole d’accord > Ajouter/Supprimer le
diagramme d’accord.

* Pour afficher ou occulter un nom d’accord pour un symbole d’accord donné, sélectionnez-le

puis choisissez Edition > Symbole d’accord > Ajouter/Supprimer le nom d’accord.

* Pour faire apparaître la note fondamentale d’un texte d’accord avec une note de basse altérée

(par exemple, C/E) ou la faire disparaître (par exemple, /E) pour un symbole d’accord

individuel, sélectionnez-la puis choisissez Edition > Symbole d’accord > Ajouter/Supprimer
un texte d’accord.

* Pour faire défiler les différents types de symboles d’accord équivalent (p.e. Dom7(b5) et DoØ7),

sélectionnez le symbole d’accord et choisissez Edition > Symbole d’accord > Symbole
d’accord équivalent.

* Pour faire défiler les différents voicings possibles pour un diagramme d’accord de guitare,

sélectionnez-le et choisissez Edition > Symbole d’accord > Resélectionnez le voicing du
diagramme d’accord.

Créer des symboles d’accord au clavier
Pour saisir des symboles d’accord au clavier de l’ordinateur, vous n’avez pas besoin de savoir

comment saisir les symboles spéciaux, comme  pour demi-diminué ou  pour majeur (ou de

septième majeur) : commencer simplement en utilisant le raccourci Ctrl+K ou XK, puis saisisse

une version française de l’accord que vous souhaitez et Sibelius créera les éventuels symboles

spéciales automatiquement, tout en suivant les préférences que vous avez paramétrées sur la page

Symboles d’accord de Style maison > Règles de gravure et Style maison > Modifier les
symboles d’accord.

Pour saisir une note fondamentale, entrez simplement son nom, p.e. “Do#” ou “Sib”. Si vous désirez

saisir une note de basse altérée, ajoutez une barre oblique suivie du nom de la note, par exemple,

“/Mi.”.

Les différents éléments suivants la note fondamentale, créant des symboles d’accord plus

complexe, sont appelés éléments suffixe et Sibelius est compatible avec une liste spécifique

d’éléments suffixe que vous pouvez saisir au clavier, de la manière suivante :

halfdim add9 6/9 b5

add6/9 maj7 aug #4

sus2/4 dim9 alt nc

omit5 dim7 b13 9

omit3 sus9 #11 7

maj13 sus4 13 6

add13 add4 11 5
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La liste ci-dessus parle pour elle-même, sauf “nc”, qui signifie “no chord” (pas d’accord) et produit

le symbole d’accord µ et “/”, généralement utilisé avant une note de basse altérée, ou seul pour

produire une barre oblique de rythme ( ).

À l’aide des éléments suffixe ci-dessus, vous pouvez saisir rapidement n’importe quel symbole

d’accord complexe le plus facilement du monde (essayez de saisir “Domaj7b13b9b5”). Vous n’avez

pas besoin d’inclure de parenthèses ou d’autres séparateurs dans votre texte ou de saisir les

éléments suffixe dans un ordre particulier (étant donné que l’ordre de saisie est totalement écartée

lors de l’affichage du symbole d’accord : Sibelius affiche toujours les altérations dans l’ordre

décroissant par défaut).

Si vous saisissez un suffixe d’accord non reconnu (p.e. un mot imprévisible comme “banane”) ou

produisez une combinaison de suffixes d’accord que Sibelius ne comprend pas (p.e. un symbole

d’accord absurde comme “Rémaj9b11”), Sibelius affiche en rouge la saisie et avance le curseur.

Vous devriez revenir en arrière et résoudre l’erreur de saisie de symbole d’accord !

Si vous souhaitez définir votre propre texte pour un type d’accord en particulier, p.e. pour accélérer

la saisie d’un type d’accord particulièrement complexe, vous pouvez le faire dans Style maison >

Modifier les symboles d’accord – b 8.13 Modifier les symboles d’accord.

Pour parcourir la partition lors de la saisir des symboles d’accord, Espace passe à la note ou au

temps suivant (le premier arrivé), Tab déplace jusqu’au début de la mesure suivante, Ret. arrière
revient au symbole d’accord précédent et Maj-Tab revient au début de la mesure précédente.

Créer des symboles d’accord lors de l’exécution
Avant d’essayer de saisir des symboles d’accord depuis votre clavier MIDI ou votre guitare MIDI,

vérifiez d’abord qu’il ou elle est correctement branché et que vous pouvez introduire des notes

dans votre dispositif MIDI – b 1.10 Périphériques d’entrée.

Pour saisir des symboles d’accord en les jouant, lancez la saisie de symboles d’accord avec le

raccourci clavier Ctrl+K ou XK, puis, une fois le curseur clignotant, jouez simplement l’accord que

vous souhaitez saisi ; le curseur clignotant passe automatiquement à la prochaine note ou temps.

Par défaut, Sibelius utilise le voicing de l’accord que vous jouez, pour déterminer non seulement le

type d’accord mais aussi la manière spécifique de le noter. Par exemple, si vous jouez l’accord dans

l’une de ses inversions, Sibelius produira un symbole d’accord avec une note de basse altérée, p.e.

R /Fa#.

Sibelius produira normalement l’orthographe enharmonique correcte pour la note fondamentale

(et la note de basse altérée, le cas échéant) selon l’armure actuelle. Si vous désirez réorthographier

le symbole de l’accord après sa saisie, rien de plus simple – cf. Réorthographier le symbole
d’accord ci-dessous.

maj11 sus2 #9 4

dim13 add2 b9 2

dim11 maj b6 m

maj9 dim #5 /
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Si vous jouez un accord que Sibelius ne reconnaît pas, Sibelius affichera le nom des notes que vous

avez joué et fera avancer le curseur. Vous devriez revenir en arrière et résoudre l’erreur de saisie de

symbole d’accord !

Si vous souhaitez définir vos propres voicings d’entrée MIDI spécifiques pour un type d’accord

particulier, p.e. pour faciliter la saisie d’un type d’accord habituel, vous pouvez le faire dans Style
maison > Modifier les symboles d’accord – b 8.13 Modifier les symboles d’accord.

La navigation lors de la saisie des symboles d’accord via clavier MIDI se fait de la même manière

que lors de la saisie via le clavier de l’ordinateur, cf. Créer des symboles d’accord au clavier
ci-dessus.

Modification d’un symbole d’accord existant
Pour modifier un symbole d’accord, double-cliquez-le, ou sélectionnez-le et appuyez sur Retour
(sur le clavier principal). Vous pouvez soit effacer le texte existant de façon à saisir un nouveau

symbole d’accord ou jouer simplement un nouvel accord sur votre clavier MIDI pour le remplacer.

Il existe d’autres manières de modifier les symboles d’accord en sélectionnant simplement un ou

plusieurs symboles d’accord, puis en sélectionnant l’utilisation désirée depuis le sous-menu

Edition > Symbole d’accord, aussi disponible quand vous cliquez-droit (Windows) ou Control-
cliquez (Mac) sur un symbole d’accord.

Texte d’accord équivalent
Il existe souvent plusieurs manières de représenter le même patron d’intervalles dans un symbole

d’accord. Sibelius permet de faire défiler les différentes possibilités. C’est particulièrement pratique

si vous avez joué un symbole d’accord et que Sibelius n’a pas choisi celui que vous préférez.

Sélectionnez simplement le symbole d’accord (ou les symboles d’accord) dont vous souhaitez

changer le texte d’accord, puis sélectionnez Edition > Symbole d’accord > Texte d’accord
équivalent (raccourci Ctrl+Shift+K ou xXK) ; à chaque fois que vous le choisissez, Sibelius

sélectionne le texte d’accord équivalent suivant, en le faisant éventuellement défiler de nouveau à

l’apparence d’origine de l’accord.

Si vous souhaitez déterminer quel type d’accord Sibelius doit produire par défaut quand vous jouez

un accord donné sur votre clavier MIDI, assurez-vous d’avoir bien défini un voicing d’entrée MIDI

personnalisé pour votre type d’accord préféré (même si le voicing par défaut est votre préféré car ce

dernier sera partagé par d’autres type d’accord et que la présence d’un voicing utilisateur indiquera

à Sibelius de préférer ce type d’accord) – b 8.13 Modifier les symboles d’accord.

Resélectionner le voicing du diagramme d’accord
Il existe toujours de nombreuses manières différentes de jouer un type d’accord donné sur une

guitare. Chaque type d’accord a un diagramme d’accord favori qui lui est associé (que vous pouvez

modifier dans Style maison > Modifier les symboles d’accord), qui correspond au diagramme

d’accord affiché par défaut pour ce type d’accord.

Pour sélectionner un autre diagramme d’accord, sélectionnez le symbole de l’accord (ou les

symboles d’accord) puis sélectionnez Edition > Symbole d’accord > Resélectionner le voicing
du diagramme d’accord (raccourci Ctrl+Shift+Alt+K ou xzXK) ; à chaque fois que vous le

sélectionner, Sibelius choisit le voicing suivant.
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Par défaut, Sibelius fait se succéder les différents voicings disponibles : pour que Sibelius préfère

les voicings que vous avez préalablement créés à partir de Style maison > Modifier les symboles
d’accord , activez l’option Préférer les diagrammes d’accord de l’utilisateur lors de la
répartition des voix du diagramme d’accord sur la page Autres de Fichier > Préférences
(menu Sibelius sous Mac).

Réorthographier le symbole d’accord
Après avoir saisi un symbole d’accord via votre clavier MIDI, vous pouvez souhaiter changer

l’orthographe enharmonique de sa note fondamentale, de sa note de basse altérée ou les deux. Pour

ce faire, sélectionnez le symbole d’accord (ou les symboles d’accord), puis sélectionnez Modifier >

Symbole d’accord > Réorthographier le symbole d’accord ;  à chaque fois que vous le

choisissez, Sibelius réorthographie l’accord.

Toutes les orthographes valides pour une note fondamentale sont considérées, par conséquent Do

arrivera jusqu’à Si# et Réº avant de revenir à Do. Les notes de basses altérées ne seront jamais

orthographiées avec des altérations doubles à moins que la note fondamentale de l’accord ne le

soit.

Sélectionner quand les diagrammes d’accords doivent apparaître
Sibelius choisit intelligemment si afficher ou non les composants de diagramme d’accord et de

texte d’accord des symboles d’accord selon le type d’instrument auquel ce dernier est rattaché.

Par défaut, Sibelius affiche uniquement le texte d’accord pour tous les instruments sauf pour les

portées de notation (en opposition aux portées de tablatures) pour les guitares (à l’exception des

basses) et autres instruments à frettes.

Quand un symbole d’accord est rattaché à une portée de notation, Sibelius détermine l’apparence

du diagramme d’accord selon l’accordage implicite de cette guitare ou d’un autre instrument à

frettes ; si l’instrument n’est ni une guitare ni un autre genre d’instrument à frettes, si Sibelius

affiche un diagramme d’accord de guitare, c’est pour une guitare à six cordes dans l’accordage

standard.

Pour modifier si Sibelius doit ou non afficher les composants de diagramme d’accord et de texte

d’accord des symboles d’accord dans votre partition, sélectionnez Style maison > Règles de
gravure et rendez-vous sur la page Symboles d’accord, puis sélectionnez le bouton radio

approprié dans le groupe Apparence.

Pour modifier le type d’instrument ou l’accordage que Sibelius doit utiliser pour les diagrammes

d’accord sur une portée donnée, sélectionnez une mesure sur cette portée puis choisissez Style
maison > Modifier instrument. Le type d’instrument utilisé par la portée est sélectionné pour vous

dans la boîte de dialogue, cliquez alors sur Modifier instrument, puis Oui lorsque l’on vous

demande si vous êtes sur de vouloir continuer. Dans la boîte de dialogue Modifier instrument,

sélectionnez l’accordage ou l’instrument dans le menu Désigner l’instrument à utiliser pour les
accordages des cordes dans le coin inférieur droit de la boîte de dialogue, puis cliquez OK et

Fermer pour confirmer votre choix (b 8.14 Modifier les instruments).

Si vous souhaitez modifier si le composant de diagramme d’accord ou de texte d’accord d’un

symbole d’accord donné doit apparaître, sélectionnez le symbole d’accord puis choisissez
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Modifier > Symbole d’accord > Ajouter/supprimer un texte d’accord ou Ajouter/supprimer
un diagramme d’accord le cas échéant.

Pour défaire les éventuels changements que vous avez réalisé sur un symbole d’accord donné et

revenir à son apparence par défaut, sélectionnez-le et choisissez Mise en page > Réinitialiser
l’aspect.

Transposer les symboles d’accord
Les symboles d’accord sont automatiquement transposés quand vous transposez la musique ou

que vous basculez une partition entre la hauteur de concert et celle transposée. (Il n’y a pas de

transposition si vous modifiez simplement la hauteur de la note sous le symbole d’accord).

Symboles d’accord pour les instruments transposés
Quand vous utilisez votre clavier MIDI pour saisir des symboles d’accord pour un instrument

transposé (tel qu’un saxophone alto), Sibelius interprète votre entrée selon les paramètres de

Saisie des hauteurs réelles ou de Saisie des hauteurs écrites sur la page Saisie des notes de

Fichier > Préférences (dans le menu Sibelius sur Mac). Par exemple, quand Saisie des hauteurs
réelles est sélectionnée et Notes > Partition transposée est activée, l’interprétation d’un accord

Mib 7 sur la portée d’un saxophone alto produit un symbole d’accord de Do 7.

Bien que les symboles d’accord se transposent automatiquement pour les instruments transposés,

soyez conscients que le composant du diagramme d’accord ne se transpose pas (car les guitares ne

sont pas des instruments transposables et que l’accord qu’un guitariste interprète sera le même

quelque soit le texte d’accord affiché).

Exécution des symboles d’accord
Les symboles d’accord ne sont pas exécutés automatiquement, mais Sibelius inclus une extension

qui génère des accompagnements simples d’après les symboles et les diagrammes d’accords de la

partition; consultez Réaliser les symboles d’accord à la page 555 pour en savoir plus.

Modifier les dimensions des diagrammes d’accord
* Pour modifier les dimensions du composant de texte d’accord de tous les symboles d’accord

dans votre partition, modifiez la taille du point définie par le style de texte Symboles d’accord
– cf. Modifier la police utilisée pour les symboles d’accord ci-dessous.

* Pour modifier la taille du texte de l’accord d’un seul symbole d’accord, ouvrez le panneau Texte
des Propriétés et réglez les Dimensions (b 5.17 Propriétés).

* Pour modifier les dimensions du composant de diagramme d’accord de tous les symboles

d’accord dans votre partition, réglez le curseur Taille par défaut sur la page Guitare de Style
maison > Règles de gravure. (Cela affecte aussi la taille par défaut de tous les diagrammes de

gammes de guitare dans votre partition – b 2.16 Diagrammes de gammes guitare).

* Pour modifier la taille d’un seul diagramme d’accord, sélectionnez le symbole d’accord, ouvrez le

panneau Général des Propriétés et réglez l’Echelle (b 5.17 Propriétés).

Pour réinitialiser l’apparence d’un symbole d’accord, défaire les éventuels changements effectués

dans la fenêtre Propriétés, choisissez simplement Mise en page > Réinitialiser l’aspect original
(raccourci Ctrl+Shift+D ou xXD).
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Modifier la police utilisée pour les symboles d’accord
Sibelius est uniquement compatible avec ses propres jeux de polices pour les symboles d’accord,

qui sont les suivantes :

* Opus Chords est la police de symboles d’accord standard.

* Opus PlainChords utilise des altérations et des chiffres qui ne sont pas en exposant.

* Opus Chords Sans est une police sans serif qui est celle par défaut des styles maison dont Arial

est la police de texte principale.

* Opus Chords Sans Condensed est une police condensée adaptée aux accords complexes et qui

prend moins de place.

* Inkpen2 Chords correspondant à la police Inkpen2 qui est celle par défaut des styles maison

Inkpen2.

* Reprise Chords correspondant à la police Reprise qui est celle par défaut des styles maison

Reprise.

Généralement la police la plus appropriée sera celle sélectionnée dès le départ avec votre style

maison lors de la création de la partition mais vous pouvez utiliser n’importe quelle police de

symbole d’accord dans votre partition. Voici comment procéder :

* Choisissez Style maison > Modifier les styles de texte (raccourci Ctrl+maj+Alt+T ou

xzXT)

* Faites un double-clic sur le style de texte Symboles d’accord à modifier

* Dans l’onglet Général, faites le changement avec les polices souhaitées.

* Vous pouvez aussi régler la taille du point par défaut des symboles d’accord ici, si vous le

souhaitez.

* Cliquez sur OK

Toutefois, ne modifiez pas la police vers une police de texte standard ou une police tierce-partie

(p.e. une police de jazz). Si vous souhaitez utiliser une police différente des six fournies, vous

devrez utiliser des symboles d’accord patrimoniaux au lieu des symboles d’accord intelligents de

Sibelius – cf. Saisie de symbole d’accord Legacy ci-dessous.

7[á ] B 7[ á ] B¨7[áÆ] B¨7[áÆ]

B 7 B¨7[áÆ]


Opus Chords


Opus PlainChords


Opus Chords Sans Opus Chords Sans Condensed



 



Inkpen2 Chords

 





Reprise Chords
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Position verticale par défaut
La position verticale par défaut des symboles d’accord peut être modifiée depuis la boîte de

dialogue Style maison > Position par défaut. Choisissez le bouton radio Autres objets en haut à

gauche de la boîte de dialogue, puis choisissez Symbole d’accord dans la liste d’objets du côté

gauche – b 8.12 Positions par défaut.

Aligner une rangée de symboles d’accord
Si vous avez saisi des symboles d’accord le long d’une portée et que Sibelius a du en déplacer

certains pour éviter les collisions avec les notes, il essaye de conserver leur alignement sur une

même rangée mais parfois vous devrez les réaligner tous manuellement de nouveau.

Pour ce faire, sélectionnez n’importe quel symbole d’accord, choisissez Modifier > Sélection >

Sélectionner plus (raccourci Ctrl+Shift+A ou xXA), qui sélectionne tous les symboles d’accord

le long de la portée. Vous pouvez alors :

* Alignez-les sur une rangée en choisissant Mise en page > Aligner sur une rangée (raccourci

Ctrl+Maj+R ou xXR), puis les déplacer en bloc verticalement au moyen des flèches ; ou

* Choisissez Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou xXP) pour

replacer les symboles d’accord à leur position verticale par défaut.

Modifier l’alignement horizontal des diagrammes d’accord
Par défaut, les symboles d’accord sont centrés sur les notes, ce qui est idéal pour de nombreux

genres de musique publiée, notamment lorsque des diagrammes d’accord de guitare sont utilisés.

Toutefois, pour certains genres de musiques, vous pouvez préférer que les symboles d’accord

soient alignés à gauche de telle sorte que le bord gauche du symbole d’accord soit aligné avec le

bord gauche de la tête de note.

Pour aligner les symboles d’accord à gauche dans votre partition :

* Choisissez Style maison > Modifier les styles de texte

* Sélectionnez le style de texte Symbole d’accord.

* Cliquez sur Edition, et allez à l’onglet Position horizontale

* Choisissez Gauche à partir des options Aligner sur la note, puis cliquez sur OK

* Sibelius vous indiquera que la position par défaut des symboles d’accord doit également être

ajustée et vous le proposera : cliquez sur Oui pour que Sibelius le fasse maintenant.

Si vous ne souhaitez pas que Sibelius modifie pour vous les positions par défaut, vous devrez le

faire vous-même de la manière suivante :

* Choisissez Style maison > Positions par défaut, puis cliquez sur le bouton Texte

* Sélectionnez Symbole d’accord dans la liste à gauche.

* Définissez Position horizontale par rapport à la note de n dents à 0 pour la Partition et les

Parties

* Cliquez sur le bouton Autres objets

* Sélectionnez Symbole d’accord dans la liste à gauche

* Définissez Position horizontale par rapport à la note de n dents à 0 pour la Partition et les

Parties
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* Cliquez sur OK.

Les symboles d’accord créés seront alignés à gauche, mais ceux existants dans votre partition ne le

seront tant que vous ne les aurez pas sélectionnés dans Mise en page > Réinitialiser la position.

Options des règles de gravure
La page Symboles d’accord de Style maison > Règles de gravure contient un nombre

vertigineux d’options, vous permettant de contrôler de nombreux aspects de l’apparence par défaut

des symboles d’accord dans votre partition :

Les options dans le groupe Apparence vous permettent de déterminer si les composants du

diagramme d’accord ou du texte d’accord doivent ou non être affichés - cf. Sélectionner quand
les diagrammes d’accords doivent apparaître ci-dessus.

Cliquez Modifier le style de texte pour modifier le style de texte Symboles d’accord – cf.

Modifier la police utilisée pour les symboles d’accord ci-dessus.

Les options du groupe Eléments suffixe vous permettent de choisir entre un grand nombre

d’apparences alternatives pour les éléments suffixe habituels.
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Les options dans le groupe Parenthèses déterminent quand Sibelius doit utiliser les parenthèses

autour de plusieurs éléments suffixe :

* Eléments de suffixe d’extension/altération pour n ou plus altérations/extensions
détermine si Sibelius doit utiliser ou non des parenthèses quand il y a un certain nombre

d’altérations ou d’extensions dans le symbole d’accord ; par défaut, il est réglé sur 1, mais vous

Triades majeures/mineures :

Do / Dom Do / Dom

Doma / Domi Do, / Do.

DoMA / DoMI Do< / Do>

Domaj / Domin Do / Do

DoM / Dom (ligne de base) DoM / Dom

DoM / Dom (exposant) Do / Do

Do^ / Do- (ligne de base) Do / Do-

Do^ / Do- (exposant) Do^ / Do

Accords de septième majeur :

Doma7 Do 7

DoMA7 Do<7

Domaj7 Do 7

DoM7 (ligne de base) DoM7

DoM7 (exposant) Do 7

Do^ (ligne de base) Do

Do^ (exposant) Do^

Do^7 (ligne de base) Do 7

Do^7 (exposant) Do^7

Altérations/extensions :

Utilise les altérations # / b Dom7(b5) / Do7(#5)

Après les numéros Dom7(5b) / Do7(#5)

Utilise les altérations + / - Dom7( 5) / Do7(&5)

Utilise l’arrangement par piles Do 7[áÃ]

Utilise l’arrangement linéaire Do 7(b13b5)

Inverti l’ordre numérique Do 7(b5b13)

Déplace les altérations à la fin de l’accord Toujours on Do7("4b9) , sinon Do7(b9"4)

...Si les altérations apparaissent juste après la fondamen-
tale on

Do("4#11) , sinon Do#11("4)

Modificateurs de texte :

sus, add, omit Do("4) / Do( 4) / Do(;3)

SUS, ADD, OMIT Do( 4) / Do(@4) / Do(:3)

Utilisez “no” au lieu de “omit” On : Do( 3) / Off : Do(:3)

Afficher un “4” pour les accords de quarte suspendue On : Do("4) / Off : Do(")

Accords augmentés, diminués et demi-diminués :

aug / dim / half-dim Doaug / Dodim / Dohalf-dim7

+ / O / Ø Do+ / Do / Do

Symboles de ligne de base (grand) Do+ / Do / Do

Exposant (petit) Do& / Doº / DoØ

Afficher un ‘7’ pour les accords de septième diminuée et
demi-diminuée : accords

On : DoØ7 / Off : DoØ

Doaug7 / Do+7 Doaug7 / Do+ 7

Do7aug / Do7+ Do7aug / Do7&

Notes fondamentales

Altérations de la fondamentale de la ligne de base Fa / Si

Altérations de la fondamentale de l’exposant Fa# / Sib
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pouvez trouver les parenthèses inutiles pour les accords avec deux extensions tout au plus, dans

ce cas, vous devriez le régler sur 3.

* Modificateurs de mots (sus, add, omit) détermine si Sibelius doit ou non placer des

modificateurs de mots tels que “sus” dans les parenthèses. Cette option est par défaut activée.

* Septièmes majeures pour les accords mineurs détermine si Sibelius doit écrire,

p.e., Dom(,7) ou Dom,7. Cette option est par défaut activée.

Enfin, le menu Langage vous permet de choisir comment les notes fondamentales doivent être

écrites :

* Anglais : le choix par défaut, les noms des notes apparaissent sous la forme A–G, avec B et Bb.
* Allemand : les noms des apparaissent sous la forme A-G, avec (p.e.) Fis pour F#, Ees pour Eb, H

pour B et B pour Bb.
* Scandinave : les noms des notes apparaissent sous la forme A-G, avec H pour B, mais Bb

pour Bb.
* Solfège (do, re, mi, etc.) : les noms des notes apparaissent sous la forme Do, Re, Mi, etc.

* Solfège (do, ré, mi, etc.) :les noms des notes apparaissent sous la forme Do, Ré, Mi, etc.

Le réglage Langage affecte uniquement l’affichage des symboles d’accord : pour la saisie de texte

des symboles d’accord, vous devriez toujours utiliser les noms de notes anglaises standard.

Vous pouvez désactiver les choix globaux faits sur la page Symboles d’accord de Style maison >

Règles de gravure pour les types d’accord donnés à l’aide de Style maison > Modifier les
symboles d’accord – b 8.13 Modifier les symboles d’accord.

Saisie de symbole d’accord Legacy
Dans les versions précédentes de Sibelius, les symboles d’accord étaient une sorte de texte et

devaient être saisis à l’aide de raccourcis clavier spéciaux ou depuis des morceaux de symbole dans

un menu textuel. Dans le cadre d’une compatibilité avec ces versions, il est possible d’activer la dite

Saisie de symbole d’accord Legacy, qui fait que les symboles d’accord fonctionnent comme ils le

faisaient dans les versions antérieures, en cochant la case Utiliser la saisie de symbole d’accord
Legacy sur la page Autres de Fichier > Préférences (dans le menu Sibelius sous Mac).

Soyez conscient que les symboles d’accord Legacy ne répondent pas aux modifications possibles

dans le sous-menu Edition > Symboles d’accord, et ne change pas d’apparence lorsque vous

modifiez les options sur la page Symboles d’accord de Style maison > Règles de gravure. Par

conséquent, nous vous recommandons vivement d’utiliser des symboles d’accord réels.

Si vous avez parfois besoin d’un symbole d’accord legacy, vous pouvez choisir Créer > Texte >

Texte spécial > Symbole d’accord pour saisir un seul symbole d’accord legacy dans votre

partition. Si vous le souhaitez, vous pouvez affecter un raccourci clavier au style de texte

Symboles d’accord, et utiliser ce raccourci à chaque fois que vous avez besoin des symboles

d’accord legacy – b 5.12 Menus et raccourcis.
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2.11 Clés

Les clés apparaissent automatiquement en début de chaque système, et tout nouvel instrument créé

reçoit la clé qui est normalement la sienne. Par conséquent, seule l’utilisation des changements de

clé nécessite un peu d’attention.

Créer un changement de clé
* Si vous voulez installer le changement de clé au milieu

d’une mesure, entrez les notes préalablement, puis créez la

clé en leur milieu

* Sélectionnez la note ou le silence que la clé doit précéder,

choisissez Insertion > Clé (raccourci Q pour “qlef”), et

cliquez sur la clé souhaitée dans la liste conséquente qui

s’affiche (les clés usuelles sont au sommet de la liste.)

* Vous pouvez indiquer à Sibelius d’utiliser une clé diffé-

rente si Notes > Partition transposée est activée, ce qui

est utile pour certains instruments transpositeurs (par ex.

les cuivres graves et les instruments à vent) ; pour le faire,

activez l’option clé transposée et choisissez la clé à utili-

ser

* L’option Afficher sur les portées suivantes, de manière assez explicite, permet d’afficher la

nouvelle clé sur tous les systèmes qui suivent ; la désactiver n’est utile que pour certains types de

partition comme les lead sheets, si bien qu’il est préférable de la laisser activée.

* Cliquez sur OK. Tout ce qui suit la clé va monter ou descendre de manière à ce que la hauteur

réelle des notes reste identique

On peut placer un changement de clé avec la souris. Assurez-vous que rien n’est sélectionné (tapez

Échap) ; choisissez la clé souhaitée dans la boîte de dialogue Insertion > Clef ; pointez l’endroit qui

convient et cliquez. Par exemple, pour changer la clé d’un instrument pour toute la partition, pla-

cez la clé choisie sur la clé existante tout au début de la partition.

Les changements de clés peuvent être copiés (par exemple avec Alt+clic ou z-clic), contrairement

aux clés de taille normale qui figurent au début des portées. 

Déplacer des clés
Si vous déplacez une clé, au fur et à mesure, l’affichage de la musique s’adapte automatiquement,

tout en conservant la hauteur réelle des notes, donc celle réellement jouée.

Essayez ceci : créez un changement de clé à un endroit quelconque, puis déplacez-le de gauche à

droite ou de haut en bas, et admirez l’effet sautillant. Si vous n’avez rien de mieux à faire, voici des

heures de distraction en perspective absolument sans danger (du moins espérons-le).
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Clés disponibles
Les clés suivantes sont disponibles à partir de la boîte de dialogue Clé (chacune indique une hau-

teur de Do) :


Clé de sol Clé alto, pour 

violon alto


Clé de ténor, pour

basson aigu,

trombone et

violon


Clé grave


Clé pour

percussion

sans hauteur 

de note




Clé pour

percusion 

sans hauteur 

de note

Clé pour

tablature standard


Clé de sol sur deux

octaves, pour

glockenspiel dans

des partitions 

modernes




Clé de sol sur une

octave, pour piccolo

etc., dans des 

partitions

modernes




Clé de sol pour une

une octave en-dessous, 

pour ténor et guitare 



 
Clé de sol

facultativement 

pour une une 

octave en-dessous, 

pourvoix féminine

 ou masculine

Clé de sol

grave ; ancienne 

version de la 

clé de sol d’une

octave en-dessous


Clé française de 

violon parfois 

utilisée violon 

avant 1800


Clé de soprano

utilisée avant 1800


Clé de mezzo-soprano,

parfois utilisée 

avant 1800




Clé de ténor à une  

octave en-dessous,

 pour les parties

aiguës de contrebasse

dans les partitions

modernes

Clé de baryton,

parfois utilisée 

avant 1800


Clé de Fa une

octave au-dessus, 

pour main gauche 

de célesta

et flûte à bec basse


Clé de Fa

une octave 

en-dessous, pour

les parties de contrebasse

dans les partitions modernes


Clé de Fa deux 

octaves en-dessous




Clé de baryton,

parfois utilisée 

avant 1800

Clé de Fa grave

parfois utilisée 

pour les parties

graves



Clé blanche Clé de tablature

guitare basse


Clé de tablature 

plus grande



   



1

  

    

    

 


1
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Supprimer des clés
Les changements de clés peuvent être supprimés avec Suppr. Si la clé à supprimer figure en début

de système, supprimez le changement de clef qui apparaît à la fin du système précédent. (Un mot

d’explication : la petite clé à la fin du système précédent est l’endroit effectif du changement ; la

grosse clé au début du système suivant n’est rien de plus que l’indication normale de la clé en cours.)

Pour les instruments de percussion à sons indéterminés, il est possible d’utiliser une “clé vide” (en

fait un petit morceau de portée vide). Une telle clé, occupant le même espace, bien que vide, en

début de portée comme une autre clé pourra être utilisée pour “effacer” une clé existante plutôt que

de la supprimer.

Quand un changement de clé vide est placé quelque part, vous ne pouvez ni le sélectionner, ni le

supprimer, car il n’y rien à sélectionner. Le seul moyen pour le supprimer, c’est de remettre une

autre clé et de taper Suppr.

Masquer les clés au début d’un système
Si on veut faire apparaître une clé sur le premier système mais pas sur les suivants, par exemple

dans le cas d’un lead sheet, il suffit simplement de désactiver Afficher sur les portées suivantes
au moment de créer la clé ; surtout n’essayez pas de supprimer individuellement chaque clé en

début de chaque système et a fortiori ne les supprimez pas !

Si vous voulez qu’il n’y ait de clé nulle part sur une portée spécifique, sélectionnez toutes les

mesures de cette portée et désactivez Clés dans la fenêtre Mesures des propriétés

(b 5.17 Propriétés).

Masquer des changements de clé de précaution
Si une partition contient plusieurs mouvements ou plusieurs chansons, en général on ne souhai-

tera pas que figure en fin de section une clé de précaution due à un changement de clé en début de

portée de la nouvelle section. Pour y parvenir, masquez la clé de précaution en la sélectionnant

puis en choisissant Édition > Masquer ou Afficher > Masquer (raccourci Ctrl+Shift+H ou

xXH).

Pour en savoir plus sur les objets masqués, b 5.9 Masquer des objets.

Clés avec octava
Il arrive parfois qu’on écrive la clé de la flûte piccolo avec une clé de sol normale surmontée d’un

“8” (particulièrement dans les partitions de musique contemporaine) ; il s ’agit là d’une pratique

qui relève plutôt d’une question de goût. Une flûte piccolo réelle avec une telle clé de sol (donc sur-

montée d’un “8”) ne jouera pas une octave plus haut qu’une flûte piccolo jouant la même partition

avec une clé de sol normale ; on entendra exactement la même chose. En d’autres mots, le “8” est

juste une indication ou un moyen de rappeler au lecteur qu’il s’agit d’un instrument transpositeur.

Donc, dans Sibelius, les clés avec ou sans “8”(ou “15”) sont équivalentes. Le fait qu’un piccolo

sonne une octave plus haut qu’une flûte est dû à l’instrument lui-même, pas à la clé (d’ailleurs, le

piccolo utilisent aussi la clé de sol normale comme la flûte). Sibelius fait sonner le piccolo une

octave plus haut parce ce type de portée comporte par défaut le changement de transposition

configuré pour transposer une octave plus haut à la fois dans les partitions normales (non transpo-

sées) et transposées. Pour créer vous-même une transposition, utilisez la boîte de dialogue Style
maison > Modifiez les instruments (b 8.14 Modifier les instruments). 
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L’”instrument” voix de ténor dans Sibelius fonctionne de manière similaire : c’est le changement de

transposition qui agit dans les partitions transposées ou non. La clé dite “de ténor” est juste une

indication pour le lecteur, une autre manière d’écrire une clé de sol normale sans conséquence sur

la hauteur réelle des notes.

Options des règles de gravure
La page Clés et Armures de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) permet de changer l’Espace avant la clé initiale et l’Espace après la clé
initiale, si tel est votre souhait.

L’option Taille des notes de réplique de la page Notes et trémolos détermine la taille des chan-

gements de clés (en fonction de leur taille normale).
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2.12 Répliques

b 2.14 Notes ornementales, b 7.1 Travailler avec des parties séparées.

Les notes de réplique sont des petites notes utilisées dans un ou deux cas. Dans les parties

instrumentales, les répliques sont placées pour aider l’interprète à se situer et ne sont pas destinées

à être jouées. Les réplique peuvent aussi servir à indiquer des passages en option, par exemple un

solo d’harmonica dans une partie de clarinette avec l’indication “à jouer s’il n’y a pas d’harmonica

pour le faire”.

Ne confondez pas les notes de réplique et les appogiatures (b 2.14 Notes ornementales): les

notes de réplique occupent un espace rythmique dans la mesure et s’exécutent comme des notes

normales. Parce qu’une réplique peut contenir des appogiatures ou des notes à tête spéciale, toute

note – qu’elle soit normale, à tête spéciale ou même ornementale – peut être mise en taille de note

de réplique. De même, les silences, les pauses de mesure et bien d’autres objets tels que du texte,

des lignes et des symboles peuvent être en taille de note de réplique.

Il existe d’autres utilisations importantes de petites notes telles que la réalisation des

accompagnements de clavier dans les chorals et l’écriture instrumentale, les parties solo

d’accompagnement de clavier, mais dans ces cas, il vaut mieux éviter les notes de réplique. Le

résultat sera bien meilleur en utilisant les portées adéquates qui sont de petite taille, et dont toutes

les notes et objets sont à la taille correspondante – b 2.29 Portées.

La taille des notes de réplique est proportionnelle à la taille de la portée; d’habitude, elles figurent

sur des portées de taille normale, mais si vous les placez sur des petites portées, elles seront

réduites en proportion. Vous pouvez même placer des appogiatures en taille de note de réplique,

mais cela paraîtra vraiment petit.

Coller en tant que réplique
Créer une réplique avec Édition > Coller comme réplique ne prend qu’un instant:

* Assurez-vous que vous êtes dans le conducteur et non dans une des parties dynamiques. Bien

qu’il soit possible d’utiliser Édition > Coller comme réplique dans une partie dynamique, il est

plus pratique de le faire dans le conducteur, de manière à visualiser la portée qui servira de base

à la réplique et de la coller sur plusieurs instruments en même temps

* Copier la musique souhaitée comme réplique dans le presse-papiers en la sélectionnant, puis

choisissez Édition > Copie (raccourci Ctrl+C ou XC)

* Sélectionnez la pause de mesure ou le silence de la (des) portée(s) qui doit(vent) recevoir la

réplique et choisissez Édition > Coller comme réplique (raccourci Ctrl+Shift+Alt+V ou

xzXV). Si vous sélectionnez plus d’une portée, Sibelius collera la réplique sur toutes les

portées sélectionnées grâce au processus de copie multiple (b 1.9 À propos des sélections
et des passages).

C’est tout! Voici tout ce qui se produit automatiquement lorsqu’un passage en réplique est collé:

* La musique copiée apparaît dans la première voix inutilisée; toutes les notes et autres indications

sont à taille de note de réplique
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* La réplique est masquée dans le conducteur mais affichée dans les parties séparées (bien qu’il

soit possible de l’afficher dans le conducteur – cf. Préférences de coller une réplique ci-

dessous)

* Toutes les transpositions difficiles (par ex. une réplique de clarinette en La sur une portée de cor

en Fa) sont réalisées et si nécessaire, une clef adéquate ou un octava est ajouté pour permettre

une lecture aisée selon vos préférences – cf. ci-dessous Préférences de coller une réplique

* Le nom de l’instrument jouant la réplique est écrit au-dessus de la réplique, en style de texte de

portée Nom d’instrument (répliques)(que vous pouvez modifier si vous voulez en changer

l’aspect ou la position par défaut – b 3.9 Modifier les styles de texte)

* Si le type de portée (par ex. le nombre de lignes) de l’instrument jouant la réplique ne

correspond pas à celui de l’instrument de destination, les changements d’instrument appropriés

sont créés au début et à la fin de la réplique

* Les indications spécifiques (telles que les paroles, les nuances, les liaisons de phrasé et les

soufflets) sont automatiquement incluses ou excluses, selon vos préférences – cf. ci-dessous

Préférences de coller une réplique

* Tout changement d’instrument dans le passage d’origine est automatiquement exclu

* Les notes de réplique sont réglées de manière à ne pas être exécutées (en désactivant

automatiquement les cases de Jouer lors de l’exécution dans le panneau Exécution des

propriétés – cf. Quand jouer des notes à la page 331)

* Les pauses de mesure sont ajoutées dans une voix inutilisée à la fois dans le conducteur et les

parties, de manière correcte (mais si vous le préférez, vous pouvez spécifier de ne pas ajouter des

pauses de mesure dans les parties – cf. ci-dessous Préférences de coller une réplique).

En fait la seule chose que Sibelius ne fera pas, c’est de décider quel instrument doit être utilisé

comme réplique; mais il peut suggérer des emplacements, comme expliqué maintenant:

L’extension proposer des répliques
Quand on prépare des parties pour une exécution, une des choses qui prend le plus de temps, c’est

de déterminer l’emplacement des répliques les plus utiles. Vous pouvez ajouter des répliques après

un certain nombre de pauses de mesure, ou après un certain temps. C’est la tâche réalisée par

Extensions > Autres > Proposer des emplacements de réplique – cf. Suggérer des
emplacements de réplique à la page 573.

L’extension vérifier les répliques
Tout changement réalisé dans la partition après avoir installé les répliques est une source

potentielle d’erreurs dans ces répliques car Sibelius n’établit pas de lien automatique entre le

passage d’origine de la réplique et celui de sa destination. Cependant, une extension pratique est

proposée, qui permet de vérifier les répliques par rapport à leur portée d’origine et indique toute

omission; il suffit de sélectionner le passage en question et de choisir Extensions > Corrections
d’épreuves > Vérifier les répliques - cf. Vérifier les répliques à la page 578 pour en savoir

plus.
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Préférences de coller une réplique
Ce qui se produit quand on utilise Édition > Coller comme réplique dépend de différentes

options déterminées à la page Coller comme réplique de Fichier > Préférences (dans le menu

Sibelius sur Mac), et décrites ci-dessous.

Les options Hauteur des répliques proposent trois manières différentes de résoudre les

différences de tessiture entre les portées d’origine et de destination:

* Changer la clé si nécessaire ajoute une clé au début de la réplique collée, si les clés utilisées

par les portées d’origine et de destination ne correspondent pas. Si vous collez une réplique, par

ex. une portée de cello sur une portée de flûte, Sibelius va créer une clé de fa au début de la

réplique et rétablira une clé de sol à la fin. Notez que ces changements de clés ne sont visibles que

dans les parties.

* Ajout d’octava si nécessaire ajoute une ligne d’octava (jusqu’à deux octaves au-dessus ou en

dessous, c’est-à-dire 8va, 15ma, 8vb ou 15mb) sur la réplique collée si Sibelius doit transposer la

réplique d’une ou plusieurs octaves pour garantir un placement confortable sur la portée.

* Sons entendus collera simplement la réplique dans la portée de destination en respectant la clé

et sans changer d’octaves.

Les options de Copier dans la réplique permettent de

déterminer si Sibelius va incorporer dans la réplique

collée les Liaisons de phrasé, les Articulations, les

Nuances, les Paroles et le Texte technique.

Par convention, on ajoute dans les répliques des pauses

de mesure pour indiquer clairement à l’interprète qu’il

s’agit bien de notes à ne pas jouer figurant à titre

informatif. Cependant, dans certains styles de

musique, tels que le jazz, en général on n’ajoute pas de

pauses de mesure. Inclure les pauses de mesure
(dans les parties) permet de choisir la convention à

suivre: activée (par défaut), les pauses de mesure

d’origine de la partie sont affichées en plus des notes de

réplique; désactivée, seules les notes de réplique

apparaissent.

De nouveau, dans certains styles de musique, le jazz principalement, le mot “Jouez” figure après la

réplique, pour rappeler à l’interprète que c’est le moment de recommencer à jouer. Ajouter
l’indication ‘Jouez’ après les répliques dans les parties, est l’option, désactivée par défaut, qui

réalise cela. Elle est surtout utile si l’option Inclure les mesure de silence (dans les parties) est

désactivée.

Dans la plupart des styles de musique, la convention consiste à n’afficher les répliques que dans les

parties, de sorte que Masquer les répliques dans le conducteur est activé par défaut.

Cependant, dans certains cas spécifiques, par exemple la musique de théâtre, on affiche les

répliques dans le conducteur, de sorte que désactiver cette option peut parfois s’avérer utile dans

certaines situations.
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Soyez attentif au fait que changer les options ici n’affectent pas les options déjà collées; seules

seront affectées les répliques créées par la suite avec Édition > Coller comme réplique.

Créer des notes de réplique, des silences et d’autres objets
si vous devez créer des objets en taille de note de réplique, par exemple une note, un

silence, un symbole ou un objet de portée, sélectionnez-le et choisissez le bouton taille de

note de réplique illustré à droite (raccourci Entrée) sur le second pavé (raccourci Entrée).

Si vous faites la saisie avec la souris et les touches ou en mode pas-à-pas, les notes créées

continuent de l’être en taille de réplique jusqu’à ce que le bouton soit désactivé.

Pour mettre tout un passage en taille de note de réplique, il suffit de sélectionner le passage et de

choisir ce même bouton sur le second pavé. Vous pouvez rétablir la taille normale en

recommençant la même sélection et en choisissant le même bouton.

Les textes de système, les symboles de système ou les lignes de système ne peuvent être mises en

taille de note de réplique car ils ne sont jamais incorporés dans les passages de réplique (puisqu’ils

apparaissent déjà dans toutes les parties).

Le panneau Général des propriétés comporte aussi un case taille de note de réplique, qui

fonctionne exactement comme le bouton taille de note de réplique.

Options des règles de gravure
La page Notes et Trémolos de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) vous permet de modifier la taille des notes de réplique et des notes

ornementales relativement aux notes normales. Les notes ornementales sont généralement plus

petites que les notes de réplique (60% de la taille normale au lieu de 75%).

Grosses notes
Si par hasard vous voulez utiliser des grosses notes sur des portées normales (comme Stockhausen

l’utilise parfois pour mettre en évidence des notes à jouer fort) et que vous ne devez pas utiliser de

notes de réplique, réglez Taille de note de réplique dans la page Notes et Trémolos de la boîte

de dialogue Style maison > Règles de gravure par exemple sur 130%, et saisissez les grosses

notes en tant que notes de réplique.
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2.13 Rythme non mesuré

La musique en rythme non mesuré signifie qu’il n’y a pas d’indication de mesure (comme dans les

récitatifs, dans une certaine musique d’avant-garde, ou dans le plain-chant), ou que l’indication

métronomique en cours est ignorée (comme pour une cadence). Quelquefois, plusieurs

instruments jouent des rythmes non mesurés à différents tempi et les notes ne sont par

conséquent pas alignées, comme dans la musique aléatoire.

Rythme non mesuré normal
Pour du rythme non mesuré dans un seul instrument, ou pour plusieurs pour lesquels le rythme

s’aligne, créez des mesures irrégulières de la longueur appropriée (choisissez Créer > Mesure >

Autre, raccourci Alt+B ou zB) dans lesquelles placer la musique.

Selon le type de musique, vous pouvez entrer la musique dans une longue mesure ou dans

plusieurs mesures plus courtes avec des barres de mesure invisibles. Cette dernière option a

l’avantage que la musique peut être scindée à n’importe laquelle des barres de mesures invisibles,

ce qui serait nécessaire pour une longue cadence qui ne tiendrait pas sur un système. Le

désavantage est que les mesures supplémentaires vont affecter la numérotation des mesures, bien

que vous puissiez corriger cela en plaçant le changement de numéro de mesure approprié à la fin

(b 3.5 Numéros de mesure).

Rythmes non mesurés indépendants
Quelquefois des instruments jouent des rythmes indépendants en même temps, comme ceci:

Notez cela de la manière décrite ci-dessus, mais définissez l’une des portées en tant que rythme

“fondamental” et faites-en la saisie en premier. Entrez ensuite les autres rythmes, mais changez

leur vitesse apparente en utilisant des multiplets d’une fraction appropriée - ç-à-d choisissez

Aucun élément et désactivez Crochet dans la boîte de dialogue Créer > Multiplet (ou modifiez-

les après coup à partir du panneau Notes de la fenêtre de Propriétés). Par exemple, dans la

musique ci-dessus, les trois premières notes de la portée inférieure sont un triolet masqué, de

façon à s’aligner aux deux premières notes de la portée supérieure.

Sibelius jouera même les rythmes correctement, comme s’il lisait de la notation spatiale.

Musique avec de multiples indications de mesure
...ou avec des barres de mesure à différents endroits de différentes portées: b 2.33 Indications
de mesure.
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Plain-chant
Pour écrire du plain-chant, utilisez des mesures irrégulières (choisissez Créer > Mesure > Autres)

de longueur appropriée (b 2.5 Mesures et mesures de silences), et utilisez des notes sans

hampe (b 2.25 Têtes de note).

Récitatif
Utilisez des mesures irrégulières (choisissez Créer > Mesure > Autres) de longueur appropriée.

Pour en savoir plus sur les paroles dans les récitatifs, b 3.3 Paroles.

Cadences
Voici quelques façons d’approcher la notation des cadences dans Sibelius. Il est utile de calculer la

longueur de votre cadence (en termes de valeurs de note) avant d’en commencer la saisie:

* Créez une mesure irrégulière, ou une série de mesures irrégulières en utilisant Créer > Mesure >

Autres (raccourci Alt+B ou zB). Rappelez-vous que chaque mesure que vous créez ne peut être

plus longue qu’un système, vous aurez par conséquent peut-être besoin de plusieurs mesures

séparées de barres de mesure invisibles. Vous pouvez spécifier la durée exacte de la (des)

mesure(s), aussi complexe(s) soit-elle(s), et la (les) remplir de musique de la manière habituelle.

Vous devriez éviter si possible de supprimer (masquer) les silences indésirés, car ils auront un

effet sur l’espacement de note même s’ils sont masqués. 

* Si vous avez besoin d’avoir à la fois des mesures régulières de musique et des rythmes non

mesurés, cf. Rythmes non mesurés indépendants ci-dessus.
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2.14 Notes ornementales

b 2.12 Répliques.

Les notes ornementales sont plus petites que les notes normales, et sont écrites entre celles-ci.

Contrairement aux notes de réplique, les notes ornementales ne comptent pas dans la durée totale

de la mesure. C’est le travail de l’interprète de les placer entre les notes principales. Les notes

ornementales dont la hampe est barrée d’une ligne diagonale sont les acciacaturas et celles sans

sont les appogiatures (selon la terminologie de Sibelius).

Créer des notes ornementales...
Les notes ornementales sont toujours attachées à la note

principale suivante de la mesure (par conséquent créer

automatiquement des notes ornementales à la fin d’une

mesure est impossible; cf. ci-dessous). Pour créer de telles

notes, deux méthodes existent, détaillées ci-dessous.

La méthode rapide: entrer les notes ornementales au fur et

à mesure, pendant la saisie alphabétique ou en mode pas-

à-pas; la méthode lente: entrer d’abord les notes normales

puis ajouter ensuite les notes ornementales.

...la méthode rapide
Entrée des notes au fur et à mesure de la saisie:

* Commencer la création de notes (b 1.1 Saisie des
notes)

* Au moment d’entrer une note ornementale, passez au

second pavé (raccourci F8) et activez le bouton approprié: 

* Créez ensuite les notes normalement, en choisissant les

valeurs de notes dans le premier pavé (raccourci F7)

* Pour interrompre la saisie de notes ornementales,

désactivez le bouton de note ornementale sur le second

pavé.

...la méthode lente
Pour ajouter des notes ornementales à un passage de musique existant:

* Lorsque rien n’est sélectionné (appuyez sur Échap), choisissez la valeur de note et le type de note

ornementale dans le premier et le second pavé

* Le pointeur de souris change de couleur pour vous indiquer dans quelle voix vous êtes sur le

point de créer une note ornementale; cliquez là où doit aller la note

Notes ornementales
Les notes ornementales sont normalement 

écrites avec la hampe pointant vers le haut, 

quelque soit leur hauteur de note. Elles sont 

uniquement écrites avec la hampe descen-

dante pour éviter les collisions avec d’autres 

objets, par exemple dans une seconde voix, 

et dans la musique de cornemuse.

Les acciacaturas (avec une ligne à travers la 

hampe) sont normalement uniquement 

utilisées pour des notes ornementales 

isolées. Les notes ornementales isolées, et 

particulièrement les acciacaturas, sont 

presque toujours écrites en croches 

indépendamment de leur durée effective. 

Les paires de notes ornementales sont 

généralement écrites en double croches, et 

les triple croches sont utilisées pour les 

groupes de quatre ou plus de notes orne-

mentales.

Les notes ornementales sont généralement 

liées par un phrasé de la première note 

ornementale à la note principale suivante. 

La liaison de phrasé se place normalement 

au-dessus si la note principale est plus 

haute que la note ornementale, ou si la note 

ornementale ou la note principale ont des 

lignes supplémentaires au-dessus de la por-

tée; autrement, la liaison de phrasé se place 

en dessous.

Acciaccatura Appogiature
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* Si vous n’avez pas spécifié de valeur de note avant de la créer, la note ornementale apparaîtra

comme une croche. Vous pouvez modifier la valeur de note ultérieurement de la même manière

que pour les notes normales.

* Appuyez sur A-G ou utilisez votre clavier MIDI pour produire d’autres notes ornementales après

celle-la.

* Appuyez sur 1-9 (ou Maj-1-9 pour des notes en dessous) pour produire des accords de notes

ornementales, ou jouez les accords sur votre clavier MIDI. 

Modifier les notes ornementales
La plupart des opérations d’édition pour les notes ornementales sont identiques à celles utilisées

pour les notes normales, que ce soit glisser, copier, supprimer, ajouter/supprimer des altérations et

des articulations, ligaturer, modifier les valeurs de note ou les têtes de note.

Notes ornementales à la fin d’une mesure
Comme les notes ornementales s’attachent à la note ou au silence qui les suivent, quand on

souhaite créer une note ornementale à la fin d’une mesure (par exemple après un trille ou un autre

ornement), il n’y a rien pour l’attacher. Par conséquent, pour créer un note ornementale à la fin

d’une mesure, entrez une note dans la mesure suivante et créez les (la) note(s) ornementale(s)

avant cette note, puis modifiez leur (sa) position(s) à avant la barre de mesure en utilisant le

paramètre X dans le panneau Général de la fenêtre des propriétés (b 5.17 Propriétés). La note

principale après les notes ornementales peut ensuite être supprimé si nécessaire. (Pour déplacer la

note ornementale ultérieurement, n’utilisez que la fenêtre des propriétés - pas la souris ni les

flèches - sinon la note ornementale pourrait se rattacher à une note différente.)

Notes ornementales dans percussions sans hauteur de note
Les notes ornementales servent à l’écriture des percussions sans hauteur de note pour représenter

des “flams”, “drags” et roulements. Pour écrire ces rudiments de percussion, ajoutez simplement

une note ornementale (deux pour un “drag”) avant une note principale, et ajoutez une liaison de

phrasé à partir de la/des note(s) ornementale(s) à la note principale suivante.

Espacement des notes ornementales
Dans la boîte de dialogue Style maison > Espacement de note, vous pouvez spécifier l’Espace
autour des notes ornementales (c’est-à-dire la séparation entre chaque note ornementale) et

l’espace supplémentaire après la dernière note ornementale (c’est-à-dire la dernière note

ornementale avant la note normale suivante).

options des règles de gravure
La page Notes et Trémolos de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) vous permet de modifier la taille des notes de réplique et des notes

ornementales relativement aux notes normales. Les notes ornementales sont généralement plus

petites que les notes de réplique (60% de la taille normale au lieu de 75%).
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2.15 Guitare-notation normale ou tablature

b 1.7 Saisie de tablature de guitare, 2.10 Les symboles d’accord, 2.22 Tablature
de luth.

La musique pour la guitare utilise une grande quantité de symboles spécifiques (que la majorité

des guitaristes désignent en anglais, comme nous le ferons) tels que les bends, les bends préparés,

les slides et autres hammers-on et pulls-off parfaitement gérés par Sibelius et dont les plus

courants sont présentés ci-dessous Ils se transcrivent aussi bien sur portée que sur tablature et, à

quelques exceptions près (cf. ci-dessous), leur présentation s’adapte automatiquement lors du

passage de l’une notation vers l’autre.

Certains signes de tablature quand ils sont transcrits sur portée utilisent des notes masquées,

visibles si l’option Affichage > Objets masqués (raccourci Ctrl+Alt+H ou zXH) est activée.

Bend
Un bend est un effet qui consiste à obtenir une deuxième note à partir d’une note

originale en déplaçant la corde à l’emplacement de la frette. Les intervalles des

bends sont en général d’un demi-ton ou d’un ton vers le haut ou vers le bas mais il

est possible de réaliser des bends d’un micro-intervalle.

En notation de portée, un bend est transcrit par une ligne formant un angle entre

deux notes, comme le serait une liaison un peu déformée. Dans les tablatures on le

transcrit par une flèche vers le haut si la deuxième note est plus haute et vers le bas

si la deuxième est plus grave. Dans les tablatures la deuxième note des bends vers le haut est

remplacée par la fraction 1/2 (pour demi-ton) au-dessus de la flèche ; par défaut, un bend d’un ton

s’écrit full (entier) plutôt que 1 (pour changer cette option désactivez la commande Utiliser “Full”
sur les bends de tablature dans la fenêtre guitare de la boîte de dialogue Style maison > Règles
de gravure).

Pour créer un bend, sélectionnez la première note et tapez J (choisi pour la ressemblance avec le

dessin du bend dans une tablature) ; la ligne de bend se place automatiquement entre cette note et

la suivante (ou apparaîtra à la création de cette seconde note). Vous pouvez aussi créer un bend à la

souris ; assurez-vous que rien n’est sélectionné dans la partition, choisissez Créer > Ligne
(raccourci L) et sélectionnez la ligne de bend (présentée pour la notation sur portée) dans le

panneau Lignes de portées. Le pointeur de la souris change de couleur et vous pouvez cliquer sur

la partition pour placer la ligne.

Les lignes de bend se comportent comme les liaisons de legato : tapez espace pour étendre le bend

à la note suivante, ou Maj-espace pour la rétracter ; en notation de portée, choisissez Édition >

Retourner (raccourci X) pour placer le bend de l’autre côté de la note. Comme les liaisons de

legato, les bends sont magnétiques et se placent automatiquement.

La position et la forme des bends en notation de portée peuvent ête modifiées de la même manière

que les autres lignes : après avoir sélectionné le bend souhaité, utilisez Alt+0/1 ou z0/1 pour le

déplacer à gauche, au milieu ou à droite de la ligne : utilisez les flèches pour ajuster la position du

point sélectionné (avec Ctrl ou X pour de grands incréments). Pour réinitialiser la position des

extrémités de ligne de bend, choisissez Mise en page > Réinitialiser la position ; pour
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réinitialiser sa forme après avoir déplacé le centre, sélectionnez Mise en page > Réinitialiser
l’aspect original. Si un bend traverse un saut de système ou un saut de page, vous pouvez ajuster

la position et la forme de chacune des moitiés de la ligne indépendamment.

Dans les tablatures, Alt+0/1 ou z0/1 permet de vous déplacer entre l’extrémité gauche de la

ligne et la tête de flèche et/ou le numéro ; vous pouvez également utiliser les flèches (avec Ctrl ou

X pour de grands incréments) pour vous déplacer jusqu’à chaque extrémité de la ligne. Pour

rétablir la longueur d’une ligne, sélectionnez Mise en page > Réinitialiser la position. Lorsqu’un

bend traverse un saut de système ou un saut de page, Sibelius fait en sorte que la continuation du

bend sur le nouveau système commence au dessus de la portée en tablature, de manière à ce que

vous puissiez facilement le lire. Comme avec un bend sur des portées de notation, vous pouvez

ajuster la position de chaque moitié de la ligne de chaque côté du saut de système

indépendamment.

Intervalle du bend
L’intervalle d’un bend écrit sur une portée se modifie en changeant la hauteur de la seconde note.

Étant en mode d’écriture de tablature, veillez à activer Affichage > Objets masqués (raccourci

Ctrl+Alt+H ou zXH), puis sélectionnez la seconde note masquée et modifiez-en la hauteur (soit

avec le clavier MIDI, soit en entrant le numéro de frette sur le clavier principal.

Pour créer un bend léger ou bend d’un micro-intervalle, créez un bend puis tapez Maj-espace qui

rétracte la poignée de droite et l’attache à la même note que la poignée de gauche. Un bend léger

est représenté par une ligne incurvée sur une portée et par un quart de ton sur une tablature.

Pour modifier la police ou la taille des numéros au-dessus des bends, modifiez le style de texte

Frette de diagramme d’accord – b 3.9 Modifier les styles de texte.

Pour obtenir des bends sans flèche désactivez l’option Utiliser des flèches sur les bends de
tablature de la page Guitare de la boîte de dialogue Style maison > Règles de gravure.

Bend tiré & relâché
Un bend tiré-relâché est un bend vers le haut suivi d’un retour à la note originale.

Pour transcrire cet effet, insérez un bend vers le haut suivi d’un bend vers le bas.

Dans une tablature, la note finale est général entre parenthèses (car elle n’est pas

jouée) ; pour mettre une note entre parenthèses, sélectionnez-la et choisissez le

bouton parenthèse ( , raccourci 1) sur le second pavé (raccourci F8).

Petite note du bend et bend préparé
La technique pour écrire ces deux bends est identique: à partir du deuxième

pavé (raccourci F8) créez une petite note ( , raccourci* sous Windows, = sur

Mac), ou une note de bend préparé ( , raccourci – sous Windows, * sur Mac);

tapez J pour créer un bend; insérez ensuite la seconde note.

Dans une tablature, un bend préparé est représenté par une flèche verticale.
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Bend préparé et relâché
Un bend préparé et relâché est quasi créé de la même manière qu’une petite note de

bend ou qu’un bend préparé (cf. ci-dessus) ; de manière prévisible, créez une note de

bend préparé suivie d’une note ornementale, créez un bend, ensuite créez une note de

taille normale, puis créez un autre bend entre la note ornementale et la note de taille

normale. N’oubliez pas de mettre la dernière note entre parenthèses dans la tablature.

(cf. Bend tiré & relâché ci-dessus ).

Bend à l’unisson
On parle de bend à l’unisson quand deux notes sont jouées ensemble en appliquant

un bend qui amène la plus grave des deux notes à la hauteur de l’autre. Sur une

portée, le bend à l’unisson est écrit comme le bend préparé (cf. ci-dessus) avec deux

têtes de notes pour la note supérieure.

Sur une portée de tablature, vous devrez entrer la plus haute des deux notes initiales

sous forme de texte ; choisissez Créer > Texte > Texte spécial > Chiffres de
tablature et tapez le nombre.

Slide (ou glissé)
Un slide est obtenu en jouant la première note puis en glissant le même doigt

vers le haut ou vers la bas à la note suivante qui, si elle est grattée, produit un

shift slide et si elle ne l’est pas, produit un slide legato.

En notation normale ou sur tablature, les shift slides sont notés au moyen d’une

ligne droite (cf. ci-contre). Les slides legato le sont au moyen d’une ligne et d’une

liaison. Si la seconde note du slide est plus aiguë, la ligne monte ; si la seconde

note est plus grave, la ligne descend. Dans les tablatures, la ligne comporte un angle déterminé

invariable, en notation normale, l’angle est déterminé d’après la position des notes qu’il relie.

Pour créer un slide, entrez la première note du slide et cliquez sur le bouton glissando ( ,

raccourci .) du deuxième pavé (raccourci F8), introduisez ensuite la seconde note. Le slide peut

être créé si les deux existent déjà : sélectionnez simplement la première des deux et cliquez sur le

bouton glissando. S’il s’agit d’un slide legato, ajoutez une liaison de phrasé normale

(b 2.28 Liaisons de phrasé).

Les slides sont magnétiques et se positionnent automatiquement. La position de chaque extrémité

de la ligne de bend peut se modifier en utilisant la souris ou les touches de flèches.

Si plusieurs notes d’un accord reçoivent un slide, le principe est admis que tous les slides ont la

même direction. Si ce n’est pas le cas utilisez les lignes droite proposées dans la boîte de dialogue

Créer > Ligne (raccourci L) pour créer des slides de direction opposé.

“Plongeon et retour” (whammy) à l’aide de la tige de vibrato
La note ou l’accord est baissé d’un intervalle de plusieurs tons à l’aide de la

tige du vibrato (whammy bar) avant de retrouver sa hauteur d’origine.

Sur une portée, un “plongeon et retour” s’écrit à l’aide de deux lignes de bend

(cf. Bend ci-dessus) et de la ligne “w/bar” de Créer > Ligne (raccourci L).
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Dans une tablature, supprimez la note du milieu et mettez la dernière note entre parenthèses.

Utilisez deux fois le symbole ligne droite de la fenêtre au moyen de Créer > Ligne pour créer le V

(sinon des bends avec leurs flèches apparaîtront). Tapez le nombre sous la tablature à l’aplomb du

V en utilisant Créer > Texte > Texte spécial > Chiffres de tablature.

Vibrato bar scoop (soulevé de la tige de vibrato)
Un “Vibrato bar scoop” s’obtient en appuyant sur la tige du vibrato juste

avant de jouer la note, puis en la relâchant rapidement.

Pour retranscrire cet effet, utilisez le symbole adéquat de la rangée Guitare
de la fenêtre Créer > Symbole (raccourci Z). Sur une portée normale, il

convient d’ajouter la ligne w/bar au moyen de Créer > Ligne (raccourci L) ;

pour allonger la ligne vers la droite, utilisez la touche Espace.

Vibrato bar dip (enfoncement de la tige de vibrato)
Un “Vibrato bar dip” consiste à attaquer une note, la baisser d’un certain nombre

de demi-tons avec la tige, puis à la relâcher pour retrouver la hauteur de départ.

Pour noter cet effet il faut insérer le symbole V de la rangée Guitare de la boîte

de dialogue Créer > Symbole, taper le nombre de demi-tons en utilisant Créer >

Texte > Autre texte de portée > Texte en petits caractères, et si on écrit sur

une portée en notation normale, ajouter une ligne “w/bar” de la boîte de

dialogue Créer > Ligne.

Autres techniques d’exécution
Les autres effets techniques suivants se retranscrivent très facilement :

* Hammer-on et pull-off : utilisez les liaisons de phrasé – b 2.28 Liaisons de phrasé

* Tapping : utilisez les liaisons de legato avec une articulation + au dessus de la première note si

nécessaire (b 2.3 Articulations) ; Pour le tapping à la main gauche utilisez le symbole  de

la rangée Techniques de la boîte de dialogue Créer > Symbole (b 2.31 Symboles)

* Vibrato et wide vibrato : des lignes adéquates sont proposées dans le haut de la liste que déroule

la boîte de dialogue Créer > Ligne – b 2.21 Lignes

* Trille : utilisez une ligne de trille – b 2.21 Lignes

* Arpeggiate : utilisez une ligne d’arpège – b 2.2 Arpèges

* Tremolo picking : utilisez un trémolo – b 2.34 Trémolos

* Shake : utilisez un symbole de shake – b 2.31 Symboles

* Harmoniques : en notation normale, utilisez des têtes de notes en forme de losange

(b 2.25 Têtes de note), et en tablature, écrivez “Harm.”, “H.H.” (harmonique de harpe), ou

“P.H.” (harmonique pincé) au-dessus de la note avec du texte en petits caractères

* Slap : écrivez “T” au-dessus de la note avec du texte en petits caractères

* Pop : écrivez “P” au-dessus de la note avec du texte en petits caractères

* Tête de note en X: sélectionnez une note et choisissez la tête de note en forme de X dans le

panneau Notes de la fenêtre des propriétés

°
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* Pick scrape : utilisez une ligne inclinée de gliss. de la boîte de dialogue Créer > Ligne et écrivez

“P.S.” au-dessus de la portée de tablature avec du texte en petits caractères; en notation normale,

utilisez une tête de note en forme de croix

* Cordes étouffées : utilisez des têtes de note en forme de croix – b 2.25 Têtes de note

* Rake : en notation normale, créez des notes ornementales avec des têtes de note en forme de

croix, sur des tablatures, copiez la musique soit à partir d’une notation normale (et dans ce cas

les têtes de note sont automatiquement copiées avec des croix) ou changer les têtes après en avoir

créé les notes et ajoutez la ligne de “Rake” adéquate dans la boîte de dialogue Créer > Ligne.

* Doigté : utilisez Créer > Texte > Autre texte de portée > Doigté de guitare (p i m a) et écrivez

le doigté au-dessus de chaque note ou de chaque accord

La boîte de dialogue Créer > Ligne (raccourci L) contient des lignes pour écrire la plupart des effets

techniques habituels dans le jeu de la guitare, tels que s “w/bar,” “P.M.” (palm muting - étouffer

avec le plat de la main), etc. Si vous souhaitez créer d’autres lignes d’effets “guitaristiques”,

b 8.15 Modifier les lignes.

Afficher l’accordage dans les tablatures
Quand on utilise des accordages de guitare peu usités, il est utile d’afficher la

hauteur de chaque corde directement dans la tablature comme illustré ci-contre (il

s’agit de l’Open de Do).

Sibelius affiche les hauteurs par défaut pour les accordages non standard. Si vous

n’en voulez pas, sélectionnez une mesure de la portée, choisissez Style maison > Modifier les
Instruments, cliquez sur Modifier l’instrument, cliquez sur Oui, puis cliquez sur Modifier le
type de portée, et enfin désactivez l’option Armures / Accord de la page Général
(b 8.14 Modifier les instruments).

Personnaliser les tablatures, les accordages et les instruments à frette
Sibelius propose plus de 20 accordages de guitare (sans mentionner la demi-douzaine pour le

banjo, 11 pour le dobro, 2 pour le sitar et plusieurs pour le luth !), et si cela ne vous suffit pas, les

paragraphes qui suivent vous expliquent comment créer les vôtres.

Changer l’accordage d’un instrument
Pour changer l’accordage d’une portée d’une partition, il suffit d’en changer l’instrument. Si rien

n’est sélectionné dans la partition, choisissez Créer > Autres > Changement d’instrument,

sélectionnez l’instrument avec l’accordage souhaité, cliquez sur OK, puis cliquez à gauche de la

barre initiale de la portée tout au début de la partition.

Si l’accordage recherché n’existe pas, vous pouvez facilement transformer un accordage existant ou

en créer un nouveau en utilisant la boîte de dialogue Style maison > Modifier les instruments –

b 8.14 Modifier les instruments.

Utiliser du blanc autour des notes dans les tablatures
Diverses conventions existent selon les éditeurs pour savoir si les numéros dans les portées de

tablature se placent directement sur les lignes de portée ou s’ils sont entourés d’un fin pourtour

blanc (empêchant que les lignes de portée ne les traversent). Bien entendu, Sibelius permet de

spécifier vos propres réglages pour chaque type de portée dans la boîte de dialogue Style maison >
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Modifier les instruments. Choisissez l’instrument dans la boîte de dialogue, puis cliquez sur

Modifier l’instrument ; si l’instrument existe déjà dans la partition, répondez Oui à la question

de savoir si vous voulez poursuivre, puis dans la boîte de dialogue Modifier l’instrument cliquez

sur Modifier le type de portée. L’option recherchée Fond blanc autour des notes se trouve

dans la page Tablature.

Voici par défaut les réglages de Sibelius :

* Pour chaque type de portée qui affiche le rythme avec des hampes dans la portée, c’est l’option

Fond blanc autour des notes qui est activée, ce qui fait mieux ressortir les hampes.

* Pour les types de portée qui affichent les hampes à l’extérieur de la portée, et ceux qui n’affichent

pas les rythmes, l’option Fond blanc autour des notes est désactivée.

Les tablatures, une partie de plaisir
Absolument !

Dans Sibelius, les tablatures de guitare sont considérées comme un type spécial de portée (plutôt

que comme une portée de percussion) et tout comme Sibelius permet de changer le nombre de

lignes d’une portée en cours de partition, une portée normale pourra se transformer en tablature à

n’importe quel endroit de la partition, où évidemment l’accordage pourra se modifier aussi.

Faites l’essai: dans Créer > Autres > Changement d’instrument, choisissez comme instrument

une tablature de guitare, ensuite cliquez au milieu d’une portée avec des notes. A partir de là, la

notation de portée devient une tablature et ce changement est matérialisé par un objet (comme

une clé), qui affiche un rectangle violet quand on le sélectionne. Déplacez maintenant ce rectangle

de gauche à droite ou de haut en bas d’une portée à l’autre et voyez comment Sibelius réalise

instantanément le passage d’une notation à l’autre. Génial, non?

Options des règles de gravure
La page Guitare de la boîte de dialogue Style maison > Règles de gravure (raccourci Ctrl+Maj+E
ou xXE) dont l’essentiel se rapporte à la problématique des diagrammes d’accord (expliqué

page 689), propose cependant quelques options spécifiques aux tablatures :

* Utiliser “Full” sur les bends de tablature: avec cette option activée, les bends de guitare d’un

intervalle d’un ton sont surmontés de l’indication full (entier en anglais) ; lorsque l’option est

désactivée c’est le chiffre 1 qui s’affiche à la place

* Utiliser des flèches sur les bends de tablature: désactivez cette option si vous préférez des

bends sans flèches dans les tablatures.

* Afficher les petites notes avec du style de texte de lettres de tablature: cette option

permet d’ajuster la taille des petites notes dans les tablatures indépendamment de la taille des

petites notes utilisée pour la notation normale. Lorsque l’option est activée, la taille de petites

notes de tablature est déterminée dans le style de texte Lettres de tablature. Cette option est

désactivée par défaut.

Pour modifier les numéros de tablature, il suffit de cliquer sur le bouton Modifier le style de
texte.
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2.16 Diagrammes de gammes guitare

Les diagrammes de gammes de guitare se trouvent généralement dans les livres de formation et les

méthodes de guitare. Ils montrent tout ou partie du manche d’une guitare, horizontalement ou

verticalement, avec des points pour montrer les positions de chaque doigt pour jouer une gamme

particulière.

Sibelius est livré avec une bibliothèque de centaines de diagrammes de gammes de guitare prêtes à

l’emploi pour plus de 25 types de gammes. Vous pouvez facilement les modifier ou en créer de

nouveaux.

Ajouter un diagramme de gamme de guitare à une partition
Pour ajouter un diagramme de gamme de guitare à votre partition, choisissez simplement Créer >

Autre > Diagramme de gamme de guitare. La boîte de dialogue suivante apparaît :

* Le menu Instrument vous permet de sélectionner à quel instrument est destiné votre

diagramme de gamme : les diagrammes de gammes prêts à l’emploi sont tous destinés aux

guitares à six cordes et accordage standard, par conséquent selon votre choix il est possible que

vous n’ayez aucun diagramme à choisir.

* Diagrammes de gamme par défaut et Diagrammes de gamme de l’utilisateur vous

permettent de choisir si les diagrammes de gamme prêts à l’emploi, celles de l’utilisateur ou les

deux doivent apparaitre.

* Choisissez la Tonalité et le Type à l’aide des menus déroulants pour déterminer quels

diagrammes de gamme apparaissent dans l’affichage du dessous.

Pour sélectionner un diagramme de gamme, cliquez simplement sur la zone d’affichage, puis

cliquez sur OK. Si aucune sélection n’a été effectuée dans votre partition avant l’ouverture de la

boîte de dialogue, votre curseur de souris devient bleu et le diagramme sera créé là où vous

cliquerez ; si au contraire, vous aviez effectué une sélection, le diagramme de gamme est créé au

début de la sélection.

Modifier les dimensions des diagrammes de gammes
Pour réduire ou agrandir vos diagrammes de gamme sur votre partition dans les mêmes

proportions, sélectionnez Style maison > Règles de gravure et rendez-vous sur la page Guitare,
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où vous trouverez le curseur Taille par défaut. Faites-le glisser vers la droite pour agrandir tous

les diagrammes et vers la gauche pour les réduire. Soyez conscient que la modification du curseur

Taille par défaut modifie également les dimensions de tous les diagrammes d’accords de guitare

au dessus des symboles d’accords dans votre partition.

Pour modifier la taille d’un seul diagramme d’accord, sélectionnez-le dans la partition puis ouvrez

le panneau General des Propriétés et augmentez ou réduisez la valeur Echelle n%.

Modification ou création d’un nouveau diagramme de gamme de guitare
Pour modifier un diagramme de gamme guitare existant, double-cliquez sur celui-ci dans la

partition ou sélectionnez-le dans la zone d’affichage de la boîte de dialogue Diagramme de
gamme de guitare, puis cliquez sur Modifier. Pour créer un nouveau diagramme de gamme

guitare, sélectionnez le diagramme existant le plus proche dans la boîte Diagramme de gamme
guitare, puis cliquez sur Nouveau. Dans tous les cas, voici la boîte de dialogue qui s’affiche :

Dans cette boîte de dialogue, vous pouvez choisir si le diagramme doit être dessiné

Horizontalement (comme ci-dessus, le sillet du côté gauche) ou Verticalement (le sillet en

haut). Vous pouvez désactiver le nombre de frets par défaut sur le diagramme (comme indiqué sur

la page Guitare de Style maison > Règles de gravure) en basculant l’option Toujours affiché n

frets par diagramme et en sélectionnant le nombre de frets (de 3 à 15).

Pour ajouter un point à une corde, cliquez simplement sur la position désirée ; Maj-cliquez pour

faire défiler les formes de points disponibles (cercle noir, cercle blanc, losange noir, losange blanc,

diamant noir, diamant blanc). Pour supprimer un point, cliquez-droit (Windows) ou Control-
cliquez (Mac) sur le point que vous souhaitez supprimer. Pour ajouter un marqueur de corde à vide

sur le sillet, cliquez simplement sur la gauche ou en haut, selon le cas échéant ; Maj-cliquez pour

afficher une X (indiquant que la corde ne doit pas être jouée). Pour supprimer un O une X, cliquez-

droit (Windows) ou Control-cliquez(Mac) dessus.

Vous pouvez aussi ajouter un numéro de doigt ou un nom de note sur un point en double-cliquant

dessus : un curseur clignotant apparaît. Saisissez le numéro ou la lettre que vous souhaitez voir

apparaître dans le point et cliquez-droit (Windows) ou Control-cliquez (Mac) pour voir un menu

texte, sur lequel vous pouvez sélectionner les altérations.
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Pour changer le type de gamme ou la note fondamentale, choisissez les valeurs désirées dans les

menus Tonalité et Type au bas de la boîte de dialogue et cliquez OK pour sauvegarder le

diagramme nouveau ou modifié.

Afficher la hauteur des cordes et les numéros de frets
La page Guitare de Style maison > Règes de gravure contient des options pour afficher la

hauteur des cordes sur la gauche des diagrammes de gammes guitare horizontaux et les numéros

de frets au dessous – cf. Options des règles de gravure à la page 689.

Partager les diagrammes de gammes guitare
Tous les diagrammes de gammes de guitare que vous avez créés ou modifiés sont sauvegardés dans

votre bibliothèque personnelle de diagrammes de gammes. C’est un fichier appelé Scale
library.scl, que vous trouverez dans un dossier appelé Scale Diagrams dans votre dossier de

données utilisateur – cf. Fichiers que peut créer l’utilisateur à la page 716. Vous pouvez

envoyer ce fichier à vos collègues ou amis si vous le souhaitez et ainsi partager vos bibliothèques de

gammes avec eux.
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2.17 Soufflets

b 2.21 Lignes.

Soufflet est le terme familier pour une ligne qui représente un changement graduel de

dynamiques... généralement sur un espace relativement restreint, alors que les textes comme cresc.

ou dim. sont préférables pour des changements de dynamiques sur de plus longs délais.

Création et extension des soufflets
Sélectionnez la note à partir de laquelle vous souhaitez que le soufflet commence et pressez H pour

un crescendo ou Maj-H pour un diminuendo. Comme avec d’autres lignes, vous pouvez étendre et

raccourcir l’extrémité droite du soufflet en utilisant Espace et Maj-espace respectivement.

Utilisez Alt+0/1 pour placer d’une poignée à l’autre du soufflet ; vous pouvez utiliser 0/1 (avec

Ctrl ou X pour des incréments plus importants) pour faire des réglages fins sur la position de

chaque extrémité du soufflet.

Les soufflets ont souvent des dynamiques explicites du côté gauche ou du côté droit... ou des deux

côtés :

Créez simplement la dynamique en utilisant le Texte d’expression et Sibelius réglera

automatiquement la longueur du soufflet pour accommoder la dynamique. Vous pouvez même

tirer une dynamique au milieu d’un soufflet et Sibelius rompt automatiquement le soufflet :

Les soufflets peuvent être inclinés en tirant l’une ou l’autre des extrémités de celui-ci, mais il est

généralement recommandé qu’ils soient le plus horizontal possibles.

Types de soufflet
Créer > Ligne contient également des soufflets discontinus, pointillés et des soufflets “de / jusqu’au

silence”, tandis que la boîte de dialogue Créer > Symbole propose des symboles “exponentiels”

appropriés pour les fins de crescendo si nécessaire.

Soufflets sur deux systèmes
Quand un soufflet couvre deux systèmes, Sibelius dessine le soufflet en deux moitiés. La position

verticale de chaque soufflet peut être réglée indépendamment de l’autre.

Interstices des soufflets
Par défaut, Sibelius crée des interstices (c’est-à-dire la distance entre les deux lignes à l’ouverture

du soufflet) identiques, quelque soit la longueur du soufflet. Dans la musique éditée, toutefois,

l’interstice du soufflet s’élargit légèrement plus celui-ci est long. Sibelius vous permet de reproduire

cette apparence. Vous pouvez régler l’interstice de tous les soufflets en utilisant les paramètres

 

mf p

        

p f ff
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dans Style maison > Règles de gravure, ou d’un soufflet individuel en utilisant le panneau

Lignes des propriétés - lisez la suite.

Réglage global des interstices des soufflets
La page Lignes de Style maison > Règles de gravure présente les options suivantes pour les

interstices des soufflets :

* Petit interstice de n espaces : l’interstice des soufflets est plus petit que celui indiqué dans

Grand interstice si plus large que n espaces

* Grand interstice de n espaces : l’interstice des soufflets est plus grand que celui spécifié dans

Grand interstice si plus large que n espaces

* Continuation de petit interstice de n espaces : l’interstice à la fin du premier segment d’un

soufflet de crescendo sur un système ou saut de page ou l’interstice au début du second segment

d’un diminuendo sur un système ou saut de page.

* Continuation de grand interstice de n espaces : l’interstice à la fin du second segment d’un

soufflet de crescendo sur un système ou saut de page ou l’interstice au début du premier segment

d’un diminuendo sur un système ou saut de page.

Réglage individuel des interstices d’un soufflet
Si vous souhaitez qu’un soufflet en particulier ait une ouverture inhabituelle, vous pouvez la

modifier dans les options du panneau Lignes des propriétés (b 5.17 Propriétés). Ouverture
de terminaison des soufflets et Ouverture de continuation des soufflets contrôlent les

quatre points possibles d’un soufflet quand il est scindé par un saut de système ou de page :

* Fermée (a. dans l’exemple ci-dessus) est l’extrémité fermée du soufflet, qui peut être réglée sur 0

si nécessaire pour ouvrir le soufflet à une extrémité,

* Ouverte (d. dans l’exemple ci-dessus) est l’extrémité ouverte du soufflet. Pour contourner la

valeur par défaut, cochez la case “Ouvrir”.

* Petit (c. dans l’exemple ci-dessus) est le segment du soufflet qui utilise la Continuation de petit
interstice (comme défini dans Style maison > Règles de gravure) ; cela n’a d’effet que si le

soufflet est scindé par un saut de système ou de page

* Grand (b. dans l’exemple ci-dessus) est le segment du soufflet qui utilise la Continuation de
grand interstice ; cela n’a d’effet que si le soufflet est scindé par un saut de système ou de page.

Interprétation lors de la lecture
Vous pouvez modifier la lecture d’un soufflet donné à partir du panneau Lecture de la fenêtre des

propriétés – voir Soufflets à la page 300.

Position par défaut
Sibelius positionne automatiquement les soufflets sous les portées instrumentales et au-dessus des

portées vocales. Vous pouvez régler la position par défaut de chaque type de soufflet à l’aide de

Style maison > Positions par défaut – b 8.12 Positions par défaut.
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2.18 Instruments et portées

b 2.29 Portées, 3.8 Noms d’instrument, 8.14 Modifier les instruments.

Instruments ou portées?
Dans l’acception légèrement technique du mot “instrument” utilisée dans Sibelius, un instrument

consiste en une ou plusieurs portées avec un seul nom d’instrument apparaissant à gauche de la

portée. Un piano comprenant deux portées compte pour un instrument car son nom n’apparaît

qu’une seule fois, entre les portées. Cela signifie que les Violons I comptent pour un instrument,

bien qu’il y ait normalement plusieurs violonistes. Même si la partie de premier violon est divisée

sur deux portées, le nom n’apparaîtrait qu’une seule fois entre elles, et pour Sibelius, il s’agira donc

toujours d’un seul instrument. Les chanteurs sont considérés également comme instruments.

S’il n’y a qu’une seule portée de percussion, elle compte comme un instrument, même si elle peut

être utilisée simultanément pour une caisse-claire, des cymbales, des tom-toms, etc...

Créer des instruments
Vous pouvez à tout moment insérer un nouvel instrument dans la partition - choisissez

simplement Créer > Instruments (raccourci I).

La boîte de dialogue qui s’affiche est identique à celle obtenue en cliquant Changer
d’Instruments dans la boîte de dialogue Fichier > Nouveau utilisée quand on crée une nouvelle

partition

La boîte de dialogue est divisée en deux parties: la moitié gauche sert à choisir les nouveaux

instruments à ajouter à la partition, et la moitié droite vous montre les portées déjà présentes dans

la partition, en vous permettant de les supprimer, d’en modifier l’ordre et d’ajouter des portées

supplémentaires aux instruments existants.

Pour ajouter un nouvel instrument:

* Réglez la liste Choisir parmi sur l’option correspondant le mieux au type d’ensemble pour lequel

vous écrivez, car selon les ensembles les instruments s’organisent parfois différemment:

% Tous les instruments affiche la liste de pas moins de 600 instruments connus de Sibelius.
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% Instruments courants omet les instruments ésotériques tels les flageolets et les violes basse

% Instruments d’orchestre d’harmonie inclut tous les instruments susceptibles de figurer

dans les fanfares, les harmonies militaires, les drum corps et les brass band

% Instruments de jazz affiche tous les instruments des groupes de jazz et des big bands.

% Instruments d’orchestre compte tous les bois, cuivres, percussions et cordes que l’on trouve

généralement dans un orchestre

% Instruments Rock et Pop propose des guitares, claviers, chanteurs, etc...

% Instruments ethniques énumère les instruments ethniques par région géographique.

* Choisissez la famille instrumentale à partir de la liste Famille par ex. bois, cuivres, cordes, etc.

* Sélectionnez l’instrument que vous souhaitez ajouter à partir de la liste Instrument ; cliquez sur

Ajouter à la partition pour l’ajouter à la liste Portées présentes dans la partition, où il

apparaîtra avec un + devant son nom pour indiquer qu’il est nouveau. Il est inséré à la position à

laquelle il apparaîtra dans la partition lorsque vous cliquerez sur OK. Vous pouvez ajouter
plusieurs instruments adjacents rapidement en glissant la souris sur plusieurs instruments de la

liste Instrument.

* Si vous changez d’avis, vous pouvez sélectionner une portée dans la liste Portées présentes
dans la partition et cliquer sur Supprimer de la partition pour l’enlever

* Vous pouvez également sélectionner une portée et utiliser les boutons Vers le haut et Vers le
bas pour déplacer la portée verticalement. Toutes les portées d’un seul instrument (par ex. les

deux portées d’un piano ou d’une harpe, ou toutes les portées des 1er violons) se déplacent

toujours ensemble.

* Si vous souhaitez réduire une ou plusieurs portées, ex. pour un instrument solo, sélectionnez-le

dans la liste Portées présentes dans la partition et activez la case Petite portée.

* Lorsque vous cliquez sur OK, Sibelius réalise tous les changements nécessaires dans la partition,

ajoutant, supprimant et / ou réorganisant les portées.

Vous pouvez également utiliser cette boîte de dialogue pour ajouter des portées supplémentaires à

des instruments existants dans la partition – cf. Instruments à plusieurs portées dans

b 2.29 Portées pour en savoir plus. Quand un nouvel instrument est ajouté dans une partition,

Sibelius en crée automatiquement la partie dynamique – b 7.1 Travailler avec des parties
séparées.

Supprimer des instruments
Pour supprimer des instruments, choisissez Créer > Instruments, sélectionnez la ou les portées

que vous souhaitez supprimer des Portées présentes dans la partition, et cliquez sur

Supprimer de la partition; vous pouvez aussi les sélectionner en tant que passage dans toute la

partition au moyen d’un triple-clic, et tapez sur Suppr.

Vous serez averti que l’opération supprimera également toute musique présente sur ces portées ; si

vous voulez continuer, cliquez sur Oui puis sur OK pour fermer la boîte de dialogue.

Séparateurs de système
Les séparateurs de systèmes sont deux lignes épaisses parallèles placées entre les systèmes, en

général sur le côté gauche, pour faciliter la lecture. Les séparateurs de système sur la droite sont
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rarement utilisés, mais Sibelius, dans son implacable exhaustivité, ne pouvait manquer de vous les

proposer.

Vous pouvez activer ou désactiver les séparateurs de système en utilisant l’option Dessiner le
séparateur de gauche/droite dans la page Instruments de la boîte de dialogue Style maison >

Règles de gravure. On peut aussi régler le nombre minimum de portées requis pour

qu’apparaissent les séparateurs de système, ainsi que la distance les séparant de la marge.

Comme cette option est conservée lors de l’extraction des parties séparées, on peut facilement

contrôler quelles parties extraites afficheront des séparateurs; si par exemple, ils doivent apparaître

uniquement dans des parties de percussion complexe de plusieurs portées, disons 3 ou plus, il

suffira de régler le nombre minimum de portées sur 3 dans le conducteur et toutes les parties se

conformeront à cette option.

Tessiture des instruments
Sibelius peut afficher les notes en rouge si elles sont trop

hautes ou trop basses pour la tessiture d’un instrument

(activez Affichage > Couleurs de note > Notes hors
tessiture – b 5.23 Menu affichage). Chaque instru-

ment possède deux tessitures: la tessiture “profession-

nelle”, et la tessiture “confortable”, que vous pouvez toutes

deux modifier.

La tessiture professionnelle, de manière générale, définit

la note la plus haute et la note la plus basse absolue pour

un instrument particulier; les notes en dehors de cette

tessiture sont colorées en rouge vif. La tessiture confor-

table définit la note la plus haute et la note la plus basse

qu’un interprète non-professionnel utilise régulièrement;

les notes en dehors de cette tessiture mais encore dans la

tessiture professionnelle sont colorées en rouge foncé.

Bien entendu, la plupart des instruments n’ont pas une tessiture clairement définie (pensez aux

chanteurs, par exemple). Les adaptations aux instruments les plus courantes, telles que la corde Do

grave des contrebasses, le Si grave des flûtes et le Do aigu du piano (par opposition au La aigu) sont

généralement incluses dans la tessiture professionnelle mais pas dans la tessiture confortable

Si vous voulez modifier les tessitures dans la partition, b 8.14 Modifier les instruments.

Les instruments transpositeurs
Sibelius résout automatiquement toutes les complications liées à l’emploi d’instruments

transpositeurs:

* Vous pouvez entrer les notes soit à la hauteur écrite, soit à la hauteur réelle. Pour basculer

instantanément entre les deux écritures, choisissez simplement Notes > Partition transposée
(raccourci Ctrl+Maj+T ou xXT) ou cliquez sur le bouton approprié de la barre d’outils.

* Lorsque vous copiez de la musique entre des instruments transpositeurs, Sibelius transpose

automatiquement la musique en fonction des nécessités, de façon à ce qu’elle sonne toujours de

Ordre usuel des instruments
L’ordre vertical dans lequel apparaissent les 

instruments dépend généralement du style de 

musique. En musique orchestrale, par exem-

ple, les bois se placent au sommet, suivis des 

cuivres, des percussions, des chanteurs, des 

claviers et des cordes. Chaque section suit un 

ordre habituel qui est celui de la boîte de dia-

logue Instruments et portées.

Voici quelques exceptions:

* L’instrument soliste a un rôle prédominant 

et se place à la portée supérieure

* Percussions : l’ordre des instruments à l’inté-

rieur de la section de percussions peut varier 

selon les partitions

* De la musique pour deux orchestres, chœurs, 

etc.
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la même manière. Cela vous épargne quelques migraines lorsqu’il faut copier (par exemple)

d’une clarinette en La vers un cor en Fa.

* Lorsque vous faites l’extraction d’une partie séparée pour un instrument transpositeur, vous

n’avez même pas à vous préoccuper de la transposition - Sibelius s’en occupe automatiquement.

* Vous pouvez faire la saisie de la musique via un clavier MIDI en jouant soit à la hauteur réelle

soit à la hauteur écrite - par ex. vous pouvez jouer les parties transposées dans Sibelius pour

produire une partition en notes réelles. Activez simplement Saisie en notes écrites dans la

page Saisie des notes de Fichier > Préférences (dans le menu Sibelius sur Mac).

Altérations et armures des instruments transpositeurs
Par défaut Sibelius réalise correctement les transpositions en utilisant les altérations appropriées

dans des tonalités éloignées. Si par exemple, un la bémol est écrit pour un saxophone alto dans une

tonalité de Fa majeur, en activant la partition transposée, Sibelius écrira un Fa naturel qui est la

note correcte en Ré majeur. 

Avec les armures dont les signes changent lors de la transposition, des problèmes potentiels

d’orthographe (concernant les enharmonies) peuvent survenir. Par exemple, une partition en Fa

dièse majeur avec une partie de clarinette en Si bémol doit être transposée en La bémol majeur.

Normalement Sibelius devrait transposer vers le haut d’une seconde majeure pour la clarinette en

si bémol, mais dans ce cas l’intervalle est une tierce diminuée (Fa dièse devient donc La bémol

plutôt que Sol dièse).

Sibelius possède une option qu’il suffit d’activer pour gérer automatiquement ce détail plutôt

casse-pieds: Adapter l’orthographe des notes des instruments transpositeurs lors des
changements d’armures dans la page Clefs et armures de Style maison > Règles de gravure.

En général, cette option devrait rester activée, mais si votre partition contient des cas particuliers

incompatibles avec l’écriture habituelle, désactiver l’option pourra remédier aux problèmes dûs à la

transposition. Par exemple, un La double bémol joué par une clarinette en Si bémol dans la

tonalité de Fa dièse majeur ne sera pas transposé idéalement par une tierce diminuée! (Il en

résulterait un Do triple bémol, tellement peu utilisé qu’il n’existe aucun moyen de l’écrire.)

Dans la situation où un instrument transpositeur peut être écrit soit avec des dièses, soit avec des

bémols, Sibelius permet d’utiliser soit l’armure obtenue en transposant la tonalité réelle, ou de

simplifier l’armure en utilisant son équivalent enharmonique.

À titre d’exemple, considérons un morceau en Si bémol majeur avec une partie de clarinette en Si

bémol. On peut souhaiter écrire cette partie en Do dièse majeur avec sept dièses à la clé ou choisir

la tonalité de Ré bémol qui, avec cinq bémols, simplifie quelque peu l’armure. Par défaut, Sibelius

simplifiera les tonalités éloignées si cela se produit. Cependant si vous préférez la forme non

simplifiée, désactivez Adapter l’orthographe des notes des instruments transpositeurs lors
des changements d’armures dans la page Clefs et armures de Style maison > Règles de
gravure.

Plusieurs instrumentistes et divisi...
Les instruments à vent utilisent fréquemment plusieurs instruments numérotés, par ex.

Trompettes 1, 2 et 3. Les cordes sont souvent divisées sur deux portées (“divisi”) et parfois sur

plusieurs portées numérotées par pupitre. Les portées de chœur sont souvent divisées en deux. Il y

a deux manières de gérer ces situations, selon le cas:
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...le cas facile
Si votre partition est homogène du début à la fin, sans variation dans la correspondance entre les

instrumentistes et les portées qu’ils jouent, alors il n’y a pas de problème. Par exemple, si les trois

trompettes d’une partition sont toujours sur la même portée, créez simplement un seul instrument

Trompette et renommez-le en (par ex.) “Trompettes 1.2.3” au début.

De la même manière, si les trompettes 1+2 sont toujours ensemble sur une portée et la trompette 3

toujours sur une portée séparée, créez simplement deux instruments séparés (l’un appelé

“Trompette 1.2” et l’autre “Trompette 3”), ou encore créez un seul instrument (“Trompettes”) et

ajoutez-lui une seconde portée.

...le cas plus complexe
Les complications ne surviennent que si les instrumentistes sautent d’une portée à une autre au

milieu de la partition; en effet, cela nécessite de modifier le nom d’instrument apparaissant à

gauche au milieu de la partition.

Par exemple, les trois trompettes jouent à l’unisson sur une seule portée “Trompettes 1.2.3” à

certains endroits, elles peuvent se diviser en deux portées (“Trompettes 1.2” et “Trompette 3”)

ailleurs, et dans des passages complexes peuvent même être divisées en trois portées séparées.

Comme le nom à gauche devra changer au milieu de la partition, vous devriez créer un instrument

“Trompette” pour chaque nom à utiliser - dans une partition complexe, il se peut que vous créiez 5

instruments pour trois trompettes, appelés respectivement Trompettes 1.2.3, Trompettes 1.2,

Trompette 1, Trompette 2, Trompette 3. Écrivez ensuite simplement la musique sur la portée

appropriée, et masquer les portées restantes lorsqu’elles ne sont pas utilisées b 2.29 Portées ().

Indiquez quand les portées se divisent et se rejoignent, ou lorsque les instrumentistes changent en

utilisant le style de texte Technique pour écrire (par ex.) “1.2” ou “a 2” ou “div.” ou “unis.”

Lorsque le nombre de portées change, vous devriez placer un saut de système, sinon des portées

partiellement utilisées vont apparaître ce qui peut donner une mise en page assez bizarre.

Si vous souhaitez extraire les parties séparées pour les instruments, b 7.4 Extraction des
parties.

Plusieurs instruments pour un musicien
Il s’agit du cas où un seul instrumentiste joue de deux instruments voire plus. Dans la plupart des

cas, il convient d’utiliser Créer > Autres > Changement d’instrument là où le musicien change

d’instrument (cf. ci-dessous).

Une exception possible concerne les percussions à sons indéterminés, tels que le triangle, la caisse

claire et la grosse caisse sur la même portée. Pour un exposé détaillé cf. b 2.26 Percussion.

Changement d’instruments
Sibelius permet de changer facilement d’instruments n’importe où sur la portée en utilisant

Créer > Autres > Changement d’instrument. Tout d’abord il faut déterminer si le changement

d’instrument est effectif jusqu’à la fin de la partition (ou jusqu’à un changement d’instrument

existant plus loin dans la partition), ou s’il est temporaire pour un passage spécifique.
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* Pour changer d’instrument temporairement, sélectionnez d’abord le passage affecté par le

changement; Sibelius rétablira automatiquement l’instrument original à la fin de la sélection.

* Pour changer d’instrument de manière permanente, sélectionnez la note précédant l’endroit du

changement d’instrument, ou ne faites aucune sélection (et dans ce cas placez d’un clic le

changement à l’endroit souhaité).

* Une fois sélectionné l’endroit où commence le changement et éventuellement l’endroit où il finit,

choisissez Créer > Autres > Changement d’instrument (raccourci Ctrl+Shift+Alt+I ou

xzXI). La boîte de dialogue illustrée ci-dessous apparaît.

* Choisissez dans la liste l’instrument qui sera installé par le changement. Les deux options sui-

vantes peuvent être ajoutées:

% Si Ajouter la clef (si nécessaire) est activé, Sibelius créera un changement de clé à l’endroit

où le changement de clé apparaît, si la clé du nouvel instrument est différente de l’instrument

original

% Si Annoncer à la dernière note de l’instrument précédent est activé, Sibelius créera un

avertissement, “prendre [instrument]”, au début des silences qui précèdent le changement. Si

vous souhaitez que Sibelius utilise un terme plutôt que “Vers” devant le nom de l’instrument

dans l’avertissement, changez Texte précédant le nom d’instrument.

* Maintenant cliquez sur OK: Si vous n’avez pas fait de sélection avant d’avoir ouvert la boîte de

dialogue, votre pointeur de souris devient bleu, et vous pouvez cliquer sur la partition pour

placer le changement d’instrument; sinon Sibelius crée automatiquement le(s) changement(s) à

l’endroit de la sélection.

Voici ce que Sibelius réalise automatiquement lors de la création d’un changement d’instrument:

* Il change le son de la portée de manière appropriée pour l’exécution

* Il change le nom de l’instrument sur les systèmes qui suivent (ce que vous pouvez modifier si

vous le souhaitez). Si vous ne souhaitez pas que le nom de l’instrument change, choisissez Style
maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE), puis dans la page Instruments,

activez Ne pas changer les nom d’instruments au début des systèmes qui suivent les
changements d’instrument
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* Il écrit le nom du nouvel instrument au-dessus de la portée, là où il commence à jouer (ce que

vous pouvez modifier si vous le souhaitez, ou changer le nom d’instrument par défaut dans

Style maison > Modifier instruments - b 8.14 Modifier les instruments)

* Il change la transposition de la portée, si nécessaire (par exemple pour passer d’une clarinette en

Sib à une clarinette en La), affichant un changement d’armure si Notes > Partition transposée
est activé

* Il change le type de portée, si nécessaire (par ex. il modifie le nombre de lignes de portée, installe

une tablature ou une portée normale, etc.).

Les exemples ci-dessous illustrent comment les changements d’instruments apparaissent dans une

partition, dans le cas d’un changement d’une clarinette en Sib en Saxophone alto (en Mib). À

gauche, Affichage > Objets masqués est activé (de sorte que vous pouvez voir exactement le

changement sous forme de rectangle gris), et Notes > Partition transposée est désactivé (les

notes sont donc à hauteur réelle); à droite, Notes > Partition transposée est désactivé.

Quand on active ou désactive Notes > Partition transposée le changement d’instrument peut

prendre plus ou moins de place. Si l’espacement vous paraît bizarre, sélectionnez les mesures

affectées et choisissez Mise en page > Réinitialiser l’espacement des notes (raccourci

Ctrl+Maj+N ou xXN).

Modifier les changements d’instrument
Vous pouvez déplacer le changement d’instrument tout le long d’une portée soit en déplaçant avec

la souris le rectangle gris ou l’armure vers la gauche ou vers la droite ou en utilisant les flèches

0/1. Si un changement de clé a été créé à côté du changement d’instrument, remarquez qu’il ne se

déplace pas en même temps que le changement d’instrument lui-même – ce sont des objets

séparés. (Ce qui signifie aussi que si vous supprimez le changement d’instrument, la clé reste en

place et vice-versa.)

L’indication de texte au-dessus du changement d’instrument peut être déplacée indépendamment

du changement d’instrument lui-même, en le sélectionnant et en le déplaçant avec la souris ou

avec les touches de flèches. Vous pouvez modifier le texte en le double-cliquant, tout comme

n’importe quel objet; vous pouvez aussi masquer le texte en le sélectionnant et en choisissant

Édition > Masquer ou afficher > Masquer (raccourci Ctrl+Maj+H ou xXH).

Vous pouvez aussi copier, coller et supprimer des changements d’instrument tout comme

n’importe quel objet dans Sibelius.

Les changements d’instrument et les parties dynamiques
Par défaut, les changements d’instrument créé dans un conducteur apparaissent dans les parties

dynamiques, mais vous pouvez les supprimer dans les parties si vous le voulez sans affecter le

conducteur. Les changements d’instrument que vous créez dans les parties dynamiques

n’apparaîtront pas dans toute la partition. Cela vous permet de créer des parties dynamiques pour

des instruments différents ou pour différentes transpositions – cf. Parties existant sous
différentes transpositions à la page 614.
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2.19 Articulations de jazz

b 2.3 Articulations, b 2.21 Lignes.

Ce sont un certain nombre de notations spéciales pour les instruments à vent et les cuivres dans les

ensembles de jazz... tous très faciles à manipuler dans Sibelius.

Plops, scoops, doits et falls
Le cinquième pavé (raccourci F11) fournit un accès facile et rapide pour créer quatre genres

classiques d’effets spéciaux :

* Un plop (raccourci 5) est utilisé pour approcher une note cible depuis une hauteur de départ

indéfinie plus haute

* Un scoop (raccourci 7), appelé aussi parfois “rip”, est utilisé pour approcher une note cible

depuis une hauteur de départ indéfinie plus basse

* Un doit (raccourci 9), appelé aussi parfois “lift”, part d’une hauteur définie et glisse vers le haut

vers une hauteur d’arrivée indéfinie

* Un fall (raccourci 8), appelé aussi parfois “fall-off” ou “spill”, est une chute depuis une note

spécifique vers une hauteur d’arrivée indéfinie.

Si vous ajoutez l’une de ces articulations de jazz à un accord, Sibelius l’ajoutera automatiquement à

toutes les notes de l’accord, tout en prenant en compte les facteurs comme les backnotes

(lorsqu’une ou plusieurs notes est à l’opposé de la hampe), les points de rythme, etc.

Pour régler la position horizontale d’un plop, scoop, doit ou fall donné, sélectionnez-le et pressez

Maj+Alt+0/1 ou xz0/1 (pour sélectionner l’articulation jazz sans utiliser la souris, utilisez

Alt+0/1 ou z0/1 une fois la note sélectionnée).

Si votre partition est jouée par un dispositif compatible avec la lecture de ces symboles, Sibelius les

jouera. Vous pouvez modifier les changements de sons ID de sortie sur la page Symboles de

Lecture > Dictionnaire (b 4.9 Dictionnaire de l’exécution).

Shakes
Un shake est une oscillation rapide entre la note

originale et la note la plus haute suivante dans les séries

de partiels ou parfois un intervalle encore plus grand

pour un effet plus dramatique, habituellement exécuté

par un cuivre.

Le symbole d’un shake est une ligne ondulée, qui peut être créé à partir de la boîte de dialogue

Créer > Ligne. Si vous avez besoin de créer un grand nombre de shakes, il peut s’avérer pratique


Plop


Scoop


Doit


Fall
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d’affecter un raccourci clavier à la ligne ondulée, appelée Vibrato, vous pouvez la trouver dans la

catégorie Styles de lignes (b 5.12 Menus et raccourcis). Vous préférerez même peut-être la

version plus large de la ligne Vibrato ample.

Flip ou turn
Un flip, appelé aussi parfois “turn”, est un gliss vers une hauteur

voisine ou indéfinie suivi d’un gliss vers le bas, exécuté lors du

passage d’une hauteur supérieure à une inférieure.

Les flips utilisent les même lignes que les bends de guitare

(b 2.15 Guitare-notation normale ou tablature). Pour en créer un, sélectionnez la note

depuis laquelle vous souhaitez que le flip débute et pressez J.

Bend ou smear
Un bend, parfois appelé aussi “smear”, correspond au passage d’une note plus

bémol que celle écrite et glisse vers la hauteur correcte. Ajoutez un bend en

utilisant le symbole de la quatrième rangée Autres ornements vers le bas de

Créer > Symbole (raccourci Z).

Long falls
Un long fall est, comme son nom l’indique, similaire à un fall normal sauf que

son effet dure plus longtemps et que parfois la hauteur cible est inférieure à

celle d’un fall normal.

Pour créer un long fall, utilisez la ligne de glissando ondulée dans Créer >

Ligne (raccourci L).

Options des règles de gravure
Pour régler la position par défaut des plops, scoops, doits et falls, sélectionnez Style maison >

Règles de gravure (raccourci Ctrl+Shift+E ou xXE), et rendez-vous à la page Articulations de
jazz. Vous y trouverez un jeu complet d’options pour les positions horizontales et verticales de ces

symbole de jazz pour tout ce qui concerne les têtes de note, sur les lignes et dans les espaces.
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2.20 Armure

b 5.20 Transposition.

Les armures apparaissent automatiquement au début de chaque système, en tenant compte de la

clef. Elles sont transposées pour les intruments transpositeurs et sont éventuellement omises pour

les instruments qui ne les utilisent normalement pas (par exemple la plupart des percussions).

La seule intervention nécessaire concernant les armures consiste à les entrer en début de partition

ou lors d’un changement de tonalité.

Insérer une armure
Choisissez Créer > Armure (raccourci K) et cliquez sur

l’armure souhaitée. Basculez entre les tons majeurs et

mineurs en utilisant les boutons dans la partie gauche de la

boîte de dialogue. (La distinction entre les tons majeurs et

mineurs existe essentiellement pour que Sibelius sache

comment orthographier les altérations saisies sur un clavier

MIDI; par exemple, en La mineur Ré# sera choisi plutôt que

Mib, alors qu’en Do majeur ce sera Mib plutôt que Ré#.)

Si une note ou un silence est sélectionnée quand vous créez

une armure, celle-ci se place juste après. 

Si vous insérez un changement d’armure au milieu d’un morceau, celui-ci sera automatiquement

précédé d’une double barre de mesure, que, bien sûr vous pouvez supprimer si cela vous chante.

Si vous souhaitez remplacer l’armure par un nombre de mesures puis revenir à la tonalité

originale, sélectionnez simplement les mesures où vous souhaitez appliquer la nouvelle tonalité

avant de la créer. Sibelius créera votre nouvelle armure au début de la sélection, et restaurera

l’armure originale à la fin de la sélection.

Si vous souhaitez transposer votre musique et modifier l’armure, utilisez plutôt Notes >

Transposer – b 5.20 Transposition.

Pour créer une armure au début de la partition, vérifiez que rien n’est sélectionné, puis choisissez

Créer > Armure, choisissez l’armure puis cliquez au début de la partition. Vous pouvez également

utiliser cette méthode pour insérer un changement d’armure à la souris n’importe où dans la

partition.

Si votre partition est une partition transposée, choisissez une armure à hauteur réelle – elle sera

automatiquement transposée pour les instruments transpositeurs.
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Déplacer et supprimer des changements d’armure
Vous pouvez déplacer les silences vers le haut ou vers le bas à l’aide de la souris.

Pour supprimer l’armure au début d’une partition, vous pouvez soit la choisir dans la boîte de

dialogue Fichier > Nouveau lors de la création de cette partition, ou bien créer une armure du type

Sans armure/Atonal, Do majeur ou La mineur et la placer sur l’armure existante.

Pour supprimer une armure ailleurs (c’est-à-dire un changement d’armure), sélectionnez l’armure

et appuyez sur Suppr. Pour supprimer un changement d’armure qui commence au début d’un

système, supprimez l’indication de précaution se trouvant à la fin du système précédent.

Indication de changement d’armure de précaution
Si une nouvelle section, une mélodie ou un mouvement d’une même partition commence dans une

nouvelle tonalité, on souhaitera vraisemblablement ne pas voir figurer l’indication de changement

d’armure de précaution qui apparaît normalement à la fin du système précédent. Pour l’éviter, rien

de plus facile: au moment de créer l’armure au début du nouveau mouvement il suffit de cocher la

case Masquer dans la boîte de dialogue Créer > Armure.

Pour masquer une indication de changement d’armure de précaution déjà créée, sélectionnez-la et

choisissez Édition > Masquer ou Afficher > Masquer (raccourci Ctrl+Maj+H ou xXH). Dans

tous les cas, assurez-vous que le système précédent se termine par un saut de système ou un saut

de page, car si la partition est remise en forme, l’armure masquée peut se retrouver en milieu de

système à un endroit pas tout à fait évident à retrouver. Pour en savoir plus sur les objets masqués,

b 5.9 Masquer des objets.

Sans armure / Atonal
Il arrive que certaines partitions transposées qui semblent être en Do majeur soient également

sans armure dans les parties d’instruments transpositeurs. Le compositeur a omis toutes les

armures, soit parce que la tonalité change constamment, soit parce qu’aucune tonalité ne

s’applique au morceau.

Si vous rencontrez l’une de ces situations, choisissez Tonalité ouverte/Atonal en haut à droite de la

boîte de dialogue Créer > Armure.

A tout moment en cours de morceau, on pourra insérer si nécessaire une armure normale (par

exemple Do majeur). Le cas d’école typique est Le sacre du printemps de Stravinsky, qui est

principalement atonal avec quelques moments de tonalité; la plupart du temps aucune armure ne

figure dans les parties des instruments transpositeurs à l’exception de quelques passages.

Si votre partition utilise l’armure Tonalité ouverte/Atonal, il faudra afficher les altérations là où

c’est nécessaire. Voici différentes approches pour les faire apparaître:

* Dès la première apparition dans une mesure d’une note dièse ou bémol, mais pas pour leurs

occurrences suivantes; c’est l’option par défaut de Sibelius

* À toutes les notes dièses ou bémols, quel que soit l’endroit où elles apparaissent: pour cela,

utilisez Extensions > Altérations > Ajouter des altérations à toutes les notes dièses ou
bémols

* Sur chaque note, y compris celles bécarres: utiliser Extensions > Altérations > Ajouter des
altérations à toutes les notes.
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b 6.1 Travailler avec des extensions pour en savoir plus.

Instruments sans armure
Les portées de percussions à sons indéterminés n’ont jamais d’armure, les timbales et les cors n’en

ont que rarement, la trompette et la harpe n’en ont quelquefois pas. Bien que Sibelius propose des

instruments spécifiques dans la boîte de dialogue Créer > Instruments pour les exceptions

habituelles, si vous voulez spécifier d’autres instruments sans armure:

* Sélectionnez une mesure de l’instrument concerné, et choisissez Style maison > Modifier les
instruments

* Cliquez sur Modifier les instruments, cliquez sur Oui à la question, puis dans la boîte de

dialogue qui apparaît cliquez sur Modifier le type de portée

* Dans la page Général de la boîte de dialogue Modifier le type de portée, désactivez

Armures / Accordage

* Cliquez sur OK, puis encore un fois OK, et enfin Terminer.

Pour en savoir plus sur la manière de modifier les instruments, b 8.14 Modifier les
instruments.

Armures enharmoniques
Occasionnellement, une partition aura à la fois une armure en dièse et une en bémol

simultanément de façon à simplifier l’écriture des instruments transpositeurs. Par exemple, si une

partition est en Si majeur (hauteur réelle) avec 5 dièses, les trompettes en Sib seront souvent écrites

non pas en Do# majeur (7 dièses) mais dans l’équivalent enharmonique plus facile à lire, Réb
majeur (5bémols). Sibelius réalise cela automatiquement avec l’option activée Réorthographier
les changements d’armures des partitions transposées dans la page Clefs et armures de la

boîte de dialogue Style maison > Règles de gravure.

Une autre astuce peut être utilisée pour les instruments non transpositeurs, tels que la harpe. Par

exemple, dans votre partition en Si majeur, s’il vous paraît préférable que la harpe soit écrite en

Dob majeur, voici comment procéder:

* Créez une armure de Dob majeur pour chacune des portées de harpe en utilisant l’option Une
seule portée (cf. ci-dessous)

* Sélectionnez les portées de harpe et choisissez Extensions > Altérations > Simplifier les
altérations, qui réécrira les portées de harpe en Dob majeur, mais ne touchera pas aux autres

portées.

Armures différentes simultanées
Dans certaines partitions de musique contemporaine, plusieurs armures différentes sont utilisées

pour différents instruments (à ne pas confondre avec la situation plus ordinaire dans laquelle les

instruments transpositeurs ont une armure différente). Pour créer une armure qui ne s’applique

qu’à une portée, activez Une seule portée dans la boîte de dialogue Créer > Armure lorsque vous

la créez. Cette option peut être utile quand on écrit dans des tonalités avec de nombreuses

altérations (par ex. F# major), et que pour certains instruments la tonalité enharmonique

équivalente est préférable (par ex. Gb major).
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L’espacement des notes des autres portées peut être affecté par l’insertion d’une armure sur une

seule portée; pour corriger cela, sélectionnez la mesure et choisissez Mise en page > Réinitialiser
l’espacement des notes (raccourci xXN ou Ctrl+Maj+N).

Options des règles de gravure
La page Clefs et Armures de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Shift+E ou xXE) propose, comme il se doit, quelques réglages pas forcément évidents.

La principale option qui devrait vous intéresser est Bécarres de précaution qui ajoute des

bécarres de précaution aux changements d’armure pour annuler les dièses ou les bémols de la

tonalité précédente.

Avec cette option désactivée, les bécarres de précaution n’apparaîtront plus sauf si la nouvelle

armure est soit Do majeur, soit La min ou Tonalité ouverte/Atonal; dans ces cas précis, sans ces

altérations de précaution, le changement d’armure serait quelque peu difficile à voir (comme il

fallait y penser!).
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2.21 Lignes

b 2.2 Arpèges, 2.17 Soufflets, 2.28 Liaisons de phrasé, 5.7 Rechercher et filtrer,

8.15 Modifier les lignes.

La boîte de dialogue Créer > Ligne (raccourci L) propose les lignes spéciales utilisées en musique

telles que les trilles, les phrasés, les soufflets, les glissandi, etc. prêtes à être placées dans la

partition. Pour modifier les lignes existantes ou en créer de nouvelles – b 8.15 Modifier les
lignes.

Insérer des lignes
Toutes les lignes sont créées de la même manière:

* Les lignes sont soit créées automatiquement à la position de la note / du silence sélectionné, ou

peuvent être placées à la souris:

% Pour positionner la ligne automatiquement, sélectionnez soit la note / le silence où vous

désirez que la ligne commence, soit le passage de notes qu’elle doit affecter

% Si vous souhaitez placer la ligne à la souris, assurez-vous que rien n’est sélectionné; appuyez

Échap

* Choisissez Créer > Ligne (raccourci L). La boîte de dialogue est divisée en deux: Lignes de portée

(qui s’appliquent à une seule portée) à gauche, et Lignes de système (qui s’appliquent à toutes les

portées et sont extraites dans toutes les parties séparées) à droite

* Sélectionnez la ligne à insérer et cliquez sur OK. La ligne sera soit placée automatiquement dans

la partition à l’objet / au passage sélectionné, ou bien le pointeur de souris changera de couleur

pour indiquer qu’il est “chargé” d’un objet; cliquez dans la partition pour créer la ligne.

* Pour prolonger la ligne vers la droite d’une note à la fois, appuyez sur Espace ; pour la rétracter à

nouveau, appuyez sur Maj-Espace. Vous pouvez également tirer sur l’une des extrémités à la

souris. Les lignes de système ne peuvent être prolongées ou rétractées au clavier.

* Lorsque l’une des extrémités d’une ligne est sélectionnée (ce qui est indiqué par un petit carré

bleu), sa position peut être ajustée finement en utilisant les flèches (avec Ctrl ou X pour de plus

grands incréments).

Liaisons de phrasé
Les liaisons de phrasés sont considérées comme étant un type de ligne particulier –

b 2.28 Liaisons de phrasé.

Soufflets
Les soufflets sont eux aussi assez spéciaux pour avoir leur propre rubrique – b 2.17 Soufflets.

Rit. et accel.
Différents types de lignes de rit. et accel. sont disponibles dans le panneau Lignes de système de

la boîte de dialogue Créer > Ligne. Pour les insérer dans la partition, cliquez et tirez tout

simplement.
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Comme ce sont des lignes de système, les lignes de rit. et accel. sont répétées dans la partition de la

même manière que les autres objets système, par ex. le texte de tempo, et sont extraits dans toutes

les parties séparées.

En musique pour clavier et en musique vocale, rit. et accel. sont normalement écrits en italiques.

En musique chorale, on l’écrit sur la portée de chaque voix, et pas seulement sur celle du dessus.

Pour noter cela, créez une ligne de rit./accel. en italiques sur la portée supérieure et utilisez du texte

d’Expression pour écrire les indications sur les autres portées.

En musique pour clavier solo, les instructions de rit. / accel. se placent généralement entre les

portées. Pour noter cela, il suffit de créer une ligne de rit./accel. au-dessus de la portée supérieure

et de la tirer entre les portées.

Pour paramétrer comment les lignes de rit. / accel. affectent l’exécution, cf. Rit. et accel. à la page

302.

Trilles
Pour créer un trille, sélectionnez-le dans la boîte de dialogue Créer > Ligne puis cliquez et tirez sur

la ligne pour la prolonger vers la droite à partir du symbole tr. Si vous voulez un trille avec une

ligne ondulée, cliquez et faites glisser la poignée de trille dans la partition le plus à gauche possible.

Pour configurer la façon dont les trilles sont exécutés, Trilles à la page 301.

Indications de pédale
En plus de la ligne de pédale standard, la boîte de

dialogue Créer > Ligne inclut diverses autres

lignes pour vous permettre d’écrire la notation de

changement de pédale en “encoche”. Vous pouvez

également insérer des indications de pédale sans

lignes où la levée de pédale est indiquée par une

astérisque se trouvant dans la boîte de dialogue.

Pour configurer la façon dont les lignes de pédale sont exécutées, Indications de pédale à la

page 304.

1re, 2e et 3e fins (prima,secunda, tertia volta)
Les 1re, 2e et 3e fins dans le panneau Lignes de système
de la boîte de dialogue Créer > Ligne apparaissent au

sommet du système et s’appliquent à tous les instruments.

Dans de grandes partitions, une ou plusieurs occurrences

apparaissent également en milieu de système (par ex. au-

dessus des cordes dans les partitions orchestrales) pour plus

de clarté, comme c’est le cas pour le texte de tempo et les

repères de répétition. Vous pouvez ajuster les positions ou

ces occurrences apparaîtront, ou encore les supprimer

individuellement – b 8.1 Mise en page et mise en
forme.

Positionner les soufflets, les trilles 
et les pédales
Les soufflets se placent en dessous de la portée, 

avec les autres nuances, sauf s’ils affectent la 

1re ou la 3e voix dans une écriture à plusieurs 

voix, ou lorsqu’il y a des paroles. Ils se placent 

entre les portées d’instruments à clavier quand 

ils s’appliquent aux deux mains. Les soufflets 

ne devraient normalement pas être en diago-

nale.

Les trilles se placent au-dessus de la portée, 

sauf s’ils affectent une 2e ou une 4e voix

Les indications de pédale vont invariablement 

en dessous de la portée piano inférieure.
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Pour configurer la façon dont ces lignes sont exécutées, 1re et 2de ligne de fin à la page 329.

Vous pouvez créer des lignes arbitraires de xème fin simplement en créant une nouvelle ligne

basée sur une des lignes existantes et en modifiant le texte du début de ligne – b 8.15 Modifier
les lignes.

Les lignes d’octava (8/15)
Ces lignes sont essentiellement utilisées pour éviter de nombreuses lignes supplémentaires sur une

portée. Bien que souvent utilisées dans la musique pour clavier, ces lignes apparaissent rarement

dans les autres instruments. Des lignes 8va et 15va (respectivement pour une et deux octaves au-

dessus) et 8vb et 15vb (respectivement pour une et deux octaves en dessous) sont incluses dans le

panneau Lignes de portée de la boîte de dialogue Créer > Ligne.

Si vous préférez ne pas utiliser de terminologie italienne, vous pouvez modifier la ligne pour qu’elle

affiche simplement 8 plutôt que 8va, ou encore, modifier la ligne 8vb en 8va bassa –

b 8.15 Modifier les lignes.

Gliss. et port.
Une ligne de gliss. est généralement droite et inclut le mot gliss.

incliné le long de sa longueur (bien que Sibelius omette le mot

automatiquement si la ligne n’est pas assez longue), quelquefois la

ligne elle-même est ondulée. Une ligne de portamento (port.) est

similaire mais n’est normalement représentée que par une ligne

seule.

Si vous souhaitez modifier l’épaisseur des ondulations utilisées par

la ligne de gliss. ondulée, modifiez la ligne (b 8.15 Modifier les
lignes) et choisissez un autre type de ligne dans le menu Style.

Dans certaines partitions, des lignes de gliss. sans l’indication gliss.

sont parfois nécessaires, même si la ligne est assez longue pour

qu’elle y figure; c’est souvent le cas pour des partitions avec de

nombreux glissandi; seuls les premiers présenteront l’indication

gliss. Pour faire cela, modifiez la ligne de port., supprimez-en le

texte, et utilisez-la comme ligne de gliss. sans texte –

b 8.15 Modifier les lignes.

Pour configurer la façon dont ces lignes sont exécutées, Gliss. et port. à la page 303.

Certains pilotes d’imprimante ont une bogue qui provoque l’impression des textes inclinés ou des

lignes ondulées selon un angle erroné; si vous êtes concerné, b 5.16 Imprimer.

Lignes d’arpège
Les arpèges (pour clavier et harpe) sont créés dans le cinquième clavier – b 2.2 Arpèges.

Crochets pour la musique à clavier et les doubles cordes
Les crochets s’utilisent ou bien dans la musique pour clavier, pour indiquer que des notes placées

sur deux portées doivent être jouées d’une seule main ou dans l’écriture des double cordes pour les

instruments à cordes. Ces lignes se trouvent dans le panneau Lignes de portées dans la boîte de

Position des lignes 
d’octava
Les lignes d’8va et de 15va se pla-

cent toujours dessus d’une portée 

en clef de sol, alors que les lignes 

8vb et 15vb sont toujours en des-

sous d’une portée de clef de fa.

L’alignement du texte 8va propre-

ment dit doit être centré sur la tête 

de note, et la fin du crochet d’8va 

doit se prolonger légèrement au-

delà de la dernière note affectée.

Les altérations qui ont pu survenir 

plus tôt dans la mesure, avant la 

ligne d’octava, doivent être répé-

tées si la note est reproduite après 

le début de la ligne d’octava. 
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dialogue Créer > Ligne. Au moment de les créer, cliquez et tirez pour obtenir la longueur désirée.

Veillez à tirer vers le haut pour conserver la même orientation que celle de la boîte de dialogue.

Rectangle
Un rectangle, nécessaire à la notation “encadrée” utilisée par certains compositeurs modernes

comme Lutoslawski est inclus dans le panneau Lignes de portée de la boîte de dialogue Créer >

Ligne. (Pour les non-initiés, un rectangle ou “cadre” dessiné autour d’un groupe de notes indique

généralement qu’elles devraient être répétées encore et encore en rythme non mesuré)

Pour entrer un rectangle, assurez-vous d’abord que rien n’est sélectionné dans la partition

(appuyez sur Échap) puis sélectionnez simplement le rectangle plutôt aplati de la boîte de dialogue

Créer > Ligne, cliquez dans la partition là ou un des coins du rectangle doit être placé puis tirez le

coin opposé. Si vous tirez le rectangle autour de quelques notes, il s’élargira ou rétrécira de façon à

entourer les notes si l’espacement de note change.

Ligne de ligature
Le panneau Lignes de portée de la boîte de dialogue Créer > Ligne inclut une ligature qui, placée

sur les notes, permet de créer des effets spéciaux.

Lignes discontinues
Ces lignes servent à indiquer l’étendue d’une indication telle qu’un cresc. Utilisez ces lignes plutôt

que d’entrer une rangée de tirets; si l’espacement de la partition est modifié, ces lignes se

prolongeront ou se rétracteront automatiquement ce que ne pourra faire une rangée de tirets de

longueur fixe.

Lignes de guitare
Des lignes pour toutes les techniques de guitare courantes tant pour les portées de tablature que de

notation sont proposées en bas du panneau Lignes de portée de la boîte de dialogue Créer >

Ligne, ainsi qu’un jeu complet de lignes indicatrices de corde (un chiffre encerclé suivi d’une ligne

horizontale avec un crochet à l’extrémité droite), convenant au positionnement au-dessus comme

en dessous de la portée. b 2.15 Guitare-notation normale ou tablature.

Hauptstimme et Nebenstimme
Principalement utilisées par les compositeurs de la Second Viennese School, les lignes

Hauptstimme indiquent l’instrument le plus important dans un passage; les lignes nebenstimme

indiquent le second passage le plus important.

Positions par défaut
Les positions verticales par défaut des lignes relatives à la portée, et les positions horizontales par

défaut des lignes relatives aux notes, sont définies dans Style maison > Positions par défaut.

b 8.12 Positions par défaut.

Réinitialiser les positions
La fonction Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou xXP) aligne

la terminaison des lignes avec les notes, et les place à leur position verticale par défaut.

b 8.1 Mise en page et mise en forme.
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Remise en forme des lignes
Comme vous l’avez certainement déjà deviné, les lignes se comportent très intelligemment si

l’espacement des notes change ou si la musique est remise en forme. Fondamentalement, les deux

extrémités d’une ligne sont attachées de façon indépendante à une note ou une autre position

rythmique, par conséquent si vous modifiez l’espacement des notes alors toutes les lignes aux

environs se prolongeront ou se rétracteront façon appropriée.

Essayez par vous-même: placez simplement un soufflet sous quelques notes, et essayez de tirer une

des notes vers la gauche et vers la droite pour voir ce qui se produit. De plus, Sibelius divisera

automatiquement des lignes traversant plusieurs systèmes ou réunira les morceaux à nouveau, si la

mise en forme de la musique change de manière plus drastique. Voyez plus bas en savoir plus à ce

propos.

Un effet secondaire du comportement intelligent des lignes c’est de vous éviter de perdre du temps

à corriger les lignes dans les parties séparées - Sibelius s’en charge pour vous.

Lignes se prolongeant sur deux systèmes ou plus
Pour entrer avec la souris une ligne se prolongeant sur deux systèmes (ou plus) comme la liaison

illustrée ci-dessous :

n’entrez pas deux lignes séparées! À la place, entrez simplement une ligne normalement, en

sélectionnant la note et en appuyant sur S au point 1, puis en appuyant sur Espace jusqu’à ce que

la liaison de phrasé se prolonge jusqu’au point 2. Même lorsque vous créez les lignes à la souris,

vous n’avez pas besoin de tirer horizontalement le long de la portée supérieure - allez directement

au point 2 sans passer par la case Départ et Sibelius se chargera du reste.

En fait, Sibelius accomplit bon nombre de choses intelligentes comme dans ce cas-ci - si vous

dessinez un 8va à travers plus d’un système, Sibelius placera un (8) de précaution au début du

second système. Vous pouvez changer ce qu’il écrit comme indication de précaution en modifiant

la ligne (b 8.15 Modifier les lignes). De la même manière, un soufflet de crescendo divisé sur

deux systèmes aura une extrémité ouverte du côté gauche du second système.

Pour des lignes horizontales telles qu’un 8va, Sibelius permet également de déplacer la seconde

moitié de la ligne plus haut ou plus bas indépendamment de la portée supérieure, ce qui est utile

quand vous avez besoin d’éviter une note aiguë. Sélectionnez simplement la portion de ligne que

vous souhaitez ajuster et déplacez-la vers le haut et vers le bas. Ceci ne s’applique pas aux soufflets ;

si un soufflet continue au-delà d’un système, vous ne pouvez pas modifier la position verticale du

soufflet indépendamment sur les systèmes suivants, car le soufflet se déplacerait plutôt en

diagonale.
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Si une ligne continue au-delà de plus de deux systèmes, vous ne pouvez ajuster la position verticale

de la partie du système original et de tous les systèmes ultérieurs qu’ensemble (en d’autres termes,

vous ne pouvez pas ajustez les systèmes ultérieurs indépendamment).

Pour ajuster la position horizontale des terminaisons aux coupures de lignes longues de plusieurs

systèmes, voyez la page Lignes de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) :

* L’option Terminaison à droite contrôle l’espacement entre la terminaison droite de la ligne et la

fin du système

* La case Terminaison à gauche contrôle si la prolongation d’une ligne de système commence

alignée sur le début de l’armure. La case est décochée par défaut, ce qui aligne la terminaison

gauche sur la fin de l’armure.

Masquer les lignes
Pour masquer une ligne, ce qui est surtout nécessaire pour ajouter des soufflets masqués de façon

à peaufiner l’exécution, sélectionnez la ligne et choisissez Édition > Masquer ou afficher >

Masquer (raccourci Ctrl+Maj+H ou xXH). Pour en savoir plus sur les objets masqués,

b 5.9 Masquer des objets.
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2.22 Tablature de luth

b 2.15 Guitare-notation normale ou tablature.

Sibelius propose un large éventail de styles de tablature, et plusieurs accords différents. Par défaut,

toutes les tablatures de luth sont en style français / anglais; les styles italien et espagnol sont

également disponibles en sélectionnant le type de portée approprié.

Créer une tablature de luth
Pour faire la saisie d’une tablature de luth, on procède de la même manière que pour toutes les

autres tablatures (b 1.7 Saisie de tablature de guitare), mais en plus, il convient d’utiliser

les chiffres du clavier principal pour représenter les lettres de tablature; par ex. 0 produit un la, 2
produit un do, 5 produit un fa, etc.

Pour commencer une nouvelle partition, le plus simple est d’utiliser le papier à musique Tablature
de luth – b 2.23 Papier à musique.

Différents styles de tablature de luth
Les conventions de notation pour les trois types de tablature de luth proposés sont les suivantes:

* français / anglais: la corde la plus grave du luth est la ligne inférieure sur la portée de tablature, et

les lettres dans les intervalles sont utilisées pour représenter les notes.

* espagnol: la corde la plus grave du luth est la ligne inférieure de la portée, et les chiffres sur les

cordes (comme dans la tablature moderne de guitare) sont utilisés pour représenter les notes.

* italien: identique au style espagnol, à part le fait que la corde la plus grave du luth est la ligne

supérieure de la portée, pas la ligne inférieure.

La tablature de luth en style allemand (qui utilise des lettres pour représenter les notes, mais

n’inclut pas de lignes de portée de tout) n’est pas prise en charge par Sibelius.

Pour créer n’importe quel type de tablature de luth, il suffit de le choisir dans la boîte de dialogue

Créer > Instruments – b 2.18 Instruments et portées.

Rythmes
Lorsqu’on écrit des rythmes au-dessus des portées de tablature de luth, en général on n’utilise pas

de ligature pour les croches et les autres notes de valeur inférieure. Comme Sibelius ligature

automatiquement ces notes, il faudra les séparer, ce qui se fait très rapidement et sans difficulté: il

suffit d’abord de sélectionner le passage où la séparation doit avoir lieu (on peut aussi faire un

triple clic sur la portée de luth pour la sélectionner à travers toute la partition), puis d’appuyer sur

F9 pour choisir le troisième pavé et ensuite appuyer sur la touche 7 du pavé numérique pour que

les notes sélectionnées soient déligaturées.

Il est impossible de noter une hampe à l’envers, que ce soit pour une blanche ou une autre note, car

elle apparaîtrait avec une hampe sans crochet, comme une noire.

Si vous souhaitez supprimer la hampe et la ligature ou le crochet soit d’une note soit d’un passage

sélectionné (car c’est une valeur de note répétée), choisissez la tête de note n8 dans le panneau
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Notes des propriétés. (Pour faire réapparaître la hampe et la ligature ou le crochet à nouveau à

l’endroit souhaité, choisissez le type de tête de note n°0.)

Diapasons
Les diapasons sont les cordes supplémentaires qui ne sont pas notées sur la portée elle-même.

Dans le style de tablature italien, les diapasons sont notés au-dessus de la portée, entre la ligne

supérieure de la portée et l’extrémité inférieure des hampes indiquant le rythme; utilisez le texte

technique (raccourci Ctrl+T ou XT) pour écrire les lettres les désignant.

Dans le style de tablature français, les diapasons sont écrits directement en dessous de la portée;

dans ce cas, utilisez le texte de baguettes de percussion (choisissez Créer > Texte > Autre texte de
portée > Baguettes de percussion).
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2.23 Papier à musique

Au moment de commencer une nouvelle partition se pose le problème du papier à musique.

Le plus simple consiste à choisir parmi les nombreux modèles de mise en page proposés par

Sibelius; ils conviennent parfaitement pour les combinaisons instrumentales les plus diverses.

Outre leur disposition graphique complètement préparée, l’autre intérêt des papiers à musique,

c’est leurs réglages spécifiques qui garantissent une présentation et une exécution optimales de la

partition.

Il n’y a aucune obligation d’utiliser les instruments tels qu’ils se présentent dans un modèle de

papier à musique; n’hésitez pas à en supprimer ou à en ajouter.

Il est préférable d’utiliser un papier à musique proposant des instruments plutôt que de

commencer à partir d’une page blanche, car même si l’instrumentation ne convient pas

exactement – il est aisé de la modifier – on bénéficie des réglages spécifiques au type de musique

pour lequel le papier à musique a été conçu.

Types de papier à musique
Il y a plus de 60 papiers à musique prédéfinis fournis avec Sibelius, dont notamment:

* Vierge n’a pas d’instrument prédéfini

* Piano 

* Orchestres d’harmonie: un large éventail de papiers à musique appropriés pour les orchestres

d’harmonie, les fanfares, les harmonies militaires, les “brass band”, les batteries-fanfares et

autres ensembles

* Orchestre: Les orchestres classique, romantique, moderne, concert, à cordes et de musique de

film sont tous inclus. Le papier à musique Orchestre, film a été conçu par Alf Clausen et Kyle

Clausen, les compositeurs de la musique de The Simpsons.

* Chœur: différents papiers à musique pour Chœur sont inclus, certains (appelés réduction) avec

les chanteurs réduits sur deux portées (“partition fermée”), d’autres avec accompagnement

d’orgue ou de piano.

* Voix et clavier 

* Jazz: plusieurs modèles utilisant le style maison “manuscrit”, notamment Lead sheet, Big band
et Quatuor de Jazz – b 8.8 Style maison

* Guitare: divers papiers à musique pour la notation et la tablature, y compris la Tablature de
luth

* Ensembles à vents de différentes tailles

* Quatuor et orchestre à cordes (également utilisable pour un quintette à cordes)

* Divers autres ensembles tels que les cloches manuelles, les batteries-fanfares, les groupes de

salsa ou de musique pop, l’instrumentarium Orff.

En utilisant les options de la boîte de dialogue Fichier > Nouveau (raccourci Ctrl+N ou XN) vous

pouvez ajouter ou supprimer des instruments, modifier la police musicale, ajouter des indications

de mesure et des armures, et même créer une page de titre.
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Si vous voulez créer intégralement des feuilles d’exercices, le plus simple c’est de choisir un modèle

dans Fichier > Créateur d’exercices plutôt que de commencer à partir de Fichier > Nouveau –

b 5.25 Créateur d’exercices.

Créer votre propre papier à musique
Si vous écrivez souvent pour des groupes d’instruments inhabituels ou pour des configurations

spécifiques, l’idéal consiste à créer son propre papier à musique; le gain de temps au moment de

commencer une nouvelle partition sera considérable. Comme pour du vrai papier à musique, vous

pouvez choisir différents formats de papier, différentes tailles de portées et définir les instruments

qui figureront sur le papier à musique comme s’il était pré-imprimé. De plus, vous pouvez

également y inclure des réglages plus complexes, tels que ceux du menu Style maison. En

utilisant chaque fois un même papier à musique, vous serez sûrs d’obtenir une apparence

homogène sans devoir recommencer tous les réglages à chaque fois.

* Créez une partition avec tous les réglages que doit comporter le papier à musique, par exemple le

format et l’orientation du papier, la taille des portée, les instruments, les options des règles de

gravure, les styles de texte, la police musicale, les têtes de note.

* Sauvegardez-la à l’endroit souhaité, en lui donnant le nom qui sera utilisé pour le papier à

musique (par ex. Chœur, Grand papier, Brouillons)

* Choisissez ensuite Fichier > Exporter > Papier à musique

* Le fichier original peut être désormais supprimé; quoiqu’il arrive le papier à musique sera

conservé

* Au moment de commencer une nouvelle partition, le nouveau papier à musique apparaîtra dans

la liste des Papiers à musique.

Quand on a effectué de nombreux réglages dans une partition, on peut souhaiter créer un nouveau

papier à musique qui en reprend les caractéristiques; pour ce faire exportez le style maison de la

partition existante, créez une nouvelle partition, importez le style maison sauvegardé puis

sauvegardez la partition comme papier à musique. Pour en savoir plus sur l’exportation ou

l’importation d’un style maison, b 8.8 Style maison.

Comme n’importe quel autre fichier, on peut renommer ou supprimer un papier à musique; les

fichiers papier à musique se trouvent dans un sous-dossier appelé Papier à musique à l’intérieur

du dossier du programme Sibelius lui-même (cf. Fichiers que peut créer l’utilisateur dans

b 9.1 Manipuler les fichiers).
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2.24 Mesures de comptage

b 2.5 Mesures et mesures de silences, 3.5 Numéros de mesure, 7.1 Travailler avec
des parties séparées, 8.4 Sauts de page automatiques.

Une mesure de comptage (en anglais multirest - N.d.Tr.) est une expression qui désigne une seule

mesure représentant plusieurs mesures de silence consécutives (à compter donc) et au-dessus de

laquelle est écrit le nombre de mesures à compter. Les mesures de comptage ne se retrouvent

généralement que dans les parties instrumentales séparées, bien qu’elles apparaissent

occasionnellement dans des partitions complètes (par exemple le Tapiola de Sibelius, mesures

28-29).

Utilisation des mesures de comptage
Les mesures de comptage sont en fait une option d’affichage dans Sibelius; dans une partition

contenant des mesures de silence, les mesures de silence peuvent être affichées individuellement

ou regroupées en une mesure de comptage.

Pour afficher instantanément les mesures de silence en une mesure de comptage, choisissez Mise
en page > Sauts automatiques et activez Utiliser des mesures de comptage. Cette opération

est réalisée automatiquement lors de l’extraction des parties séparées. Le raccourci spécial pour

activer ou désactiver Utiliser des mesures de comptage – Ctrl+Maj+M ou xXM. 

Sibelius scinde automatiquement les mesures de comptage aux indications de mesure, aux repères

de répétition, aux changements d’armure, de clef, aux indications de tempo, etc... Pour scinder une

mesure de comptage manuellement, cf. Forcer la division d’une mesure de comptage ci-

dessous.

Créer une mesure de comptage
Créer une mesure de comptage équivaut à créer plusieurs mesures de silences séparées: choisissez

Créer > Mesure > Autre; entrez le Nombre de mesures souhaité, cliquez sur OK puis cliquez à

l’endroit où vous souhaitez placer la mesure de comptage.

Vous pouvez aussi copier une mesure de comptage existante en utilisant Ctrl+clic ou X-clic, puis

en utilisant Alt+clic ou z-clic.

Saisie dans une mesure de comptage
Les mesures de comptage fonctionnent comme les mesures de silence normales – vous pouvez y

entrer des notes, ou y coller de la musique. Au fur et à mesure que vous entrez des notes dans une

mesure de comptage, Sibelius lui enlèvera des mesures pour y placer les notes, et réduira le nombre

de mesures à compter en conséquence.
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Modifier la longueur d’une mesure de comptage
Pour modifier le nombre de mesures à compter dans une mesure de comptage, choisissez Mise en
page > Sauts automatiques, puis désactivez Utiliser des mesures de comptage pour la

retourner à l’état de mesures de silences séparées, puis ajoutez ou supprimez des mesures. Enfin,

activez à nouveau Utiliser des mesures de comptage dans Mise en page > Sauts
automatiques.

Forcer la division d’une mesure de comptage
Sibelius peut diviser automatiquement les mesures de comptage– cf. Mise en page
automatique des mesures de comptage ci-dessous.

Si vous devez forcer la scission d’une mesure de comptage:

* Désactivez Utiliser des mesures de comptage dans l’onglet Mise en page > Sauts
automatiques. 

* Choisissez une barre de mesure et choisissez Mise en page > Saut > Scinder la mesure de
comptage; un petit symbole de mesure de comptage apparaîtra à l’écran au-dessus de la barre

de mesure si Affichage > Marques de mise en page est activé

* Si vous activez Utiliser des mesures de comptage à nouveau ou faites l’extraction des parties

séparées, la mesure de comptage sera maintenant scindée à la barre de mesure choisie. 

Si, après avoir désactivé Utiliser des mesures de comptage dans Mise en page > Sauts
automatiques, vous sélectionnez un passage et choisissez Mise en page > Saut > Scinder la
mesure de comptage, le passage sera scindé aux deux extrémités pour devenir une seule mesure

de comptage (lorsque Utiliser des mesures de comptage sera réactivé). Si une note, du texte ou

d’autres objets figurent dans le passage, ils scinderaient de toute façon la mesure de comptage.

Empêcher la division des mesures de comptage dans les parties
Les mesures de comptage dans les parties sont automatiquement divisées quand il y a des objets de

système. Si vous ne voulez pas que ces objets apparaissent dans les parties, vous pouvez empêcher

que les mesures de comptage soient automatiquement divisées dans les parties en sélectionnant

dans les parties et en choisissant Édition > Masquer ou afficher > Masquer (raccourci

Ctrl+Maj+H ou xXH) – b 7.1 Travailler avec des parties séparées.

Déterminer les raisons qui provoquent la division des mesures de comptage
Il arrive parfois dans une partie qu’une mesure de comptage se divise de manière inattendue.

En général, cela arrive quand un objet de système est attaché à un endroit inadéquat; pour

résoudre ce problème, sélectionnez l’objet en question, tapez W pour revenir au conducteur,

coupez l’objet en le plaçant dans le presse-papiers avec Ctrl+X ou XX, puis collez-le dans la bonne

mesure avec Ctrl+V ou XV.

Si vous ne parvenez pas à voir pourquoi la mesure de comptage est divisée, lancez Extensions >

Corrections d’épreuve > Détection et décompte. Vérifiez les résultats pour des objets textuels

de système, qui sont d’ordinaire la source du problème. Une fois détecté, résolvez-le selon le

processus décrit ci-dessus.
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Masquer une mesure de comptage
Pour masquer une mesure de comptage, sélectionnez-la et appuyez simplement Suppr. Cela effa-cera le

symbole, mais laissera les mesures à compter intactes. (Ceci consiste en fait à supprimer la première

mesure qui se trouve “à l’intérieur” de la mesure de comptage.)

Supprimer une mesure de comptage
Pour supprimer complètement une mesure de comptage, faites un Ctrl-clic ou X-clic à l’intérieur

pour créer un passage de système (entouré d’un double cadre violet), puis appuyez sur Suppr.

Mise en page automatique des mesures de comptage
Pour en savoir plus sur la manière de diviser automatiquement les mesures de comptage,

b 8.4 Sauts de page automatiques.

Affichage du nombre de mesures à compter
Sibelius peut afficher le nombre de mesures à compter qui est associé aux mesures de comptage

soit en dessous, soit au-dessus de la mesure – cf. Présentation et fréquence dans

b 3.5 Numéros de mesure.

options des règles de gravure
La page Mesures à compter de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Maj+E ou xXE) comprend diverses options assez explicites.

Principalement, vous pouvez choisir de noter les mesures de comptage comme des barres en H,

des barres en H étroites (afin de laisser de la place des deux côtés pour les additions de dernière

minute dans un séance d’enregistrement), comme un petit rectangle dans le “style ancien”, ou

complètement vide (pour les annotations dans les parties jazz).

Les parties séparées incluent souvent un chiffre au-dessus de toutes les mesures de comptage,

qu’elles durent une seule mesure ou plusieurs. Pour afficher 1 au-dessus de toutes les mesures de

silence isolées, activez l’option Utiliser une mesure de comptage pour une seule mesure à

compter dans la page Mesures à compter de la boîte de dialogue Style maison > Règles de
gravure. Cette option est également disponible lors de l’extraction des parties séparées –

b 7.1 Travailler avec des parties séparées.

Une autre option utile sur la page Mesures à compter est Donner une apparence manuscrite
aux barres en H (police Inkpen2): cela utilise un symbole étiré plutôt que de dessiner un

rectangle pour produire la barre épaisse d’une barre en H. Cette option est désactivée par défaut,

mais vous souhaiterez peut-être l’activer lorsque vous utilisez la police Inkpen2, car cela donnera

aux mesures de comptage une apparence manuscrite. (Cependant prenez garde au fait que des

bogues dans certains pilotes d’imprimante peuvent provoquer une mauvaise impression des barres

en H, voire même un plantage de l’ordinateur lorsque cette option est activée – faites un test pour

vérifier si cela fonctionne avec votre imprimante avant d’en faire une utilisation systématique.)

  
Barre en H Barre en H étroite


Style ancien

  
Vide
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Sibelius vous permet de déterminer la longueur des barres en H. Pour changer cette valeur,

modifiez Distance entre les mesures de comptage et les barres de mesure. Le réglage par

défaut est 1 dent, et plus les chiffres sont élévés, plus grande est la distance entre le symbole en H

et les barres de mesure adjacentes.

La longueur spatiale des mesures de comptage est calibrée en fonction de leur durée. Vous pouvez

déterminer les dents (unité d’espacement) à ajouter pour les mesures de comptage de plus de dix

mesures. Pour modifier cela, changez Dent supplémentaires pour les mesures de comptage
de plus de dix mesures. Le réglage par défaut est 12 ce qui signifie que Sibelius ajoutera 12 dents

à la mesure de comptage et plus encore en fonction de la longueur de la mesure de comptage.

L’échelle utilisée est logarithmique pour éviter que les mesures ne s’agrandissent trop si le nombre

augmente. Pour désactiver complètement cette fonction, entrez 0.

Vous pouvez aussi modifier les styles de texte Mesures de comptage (nombre) et Mesures de
comptage (tacet) utilisés pour écrire les nombres et le texte au-dessus des mesures de comptage,

par exemple pour en modifier la position verticale – b 3.9 Modifier les styles de texte.

Positionner les nombres des mesure de comptage sous la barre en forme de H
Les nombres de mesures de comptage se placent en général au-dessus de la mesure; cependant si

vous voulez les placer en dessous, changez le réglage pour Position verticale relative à la portée
du style de texte Mesures de comptage (nombres) dans Style maison > Positions par défaut,

par ex. -6.
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2.25 Têtes de note

b 2.6 Groupement des ligatures, 2.26 Percussion, 2.30 Hampes et lignes
supplémentaires, 8.16 Modifier les têtes de note.

Sibelius inclut de nombreuses têtes de note de formes spéciales telles que des losanges, des croix et

des barres obliques, et vous pouvez également créer vos propres têtes de note personnalisées. Vous

pouvez également contrôler si une tête de note particulière est exécutée, transposée, a des hampes

et des lignes supplémentaires, etc. ou pas (b 8.16 Modifier les têtes de note).

Les têtes de note sont distinctes des valeurs de note; une tête de note en croix peut être également

appliquée à une croche, à une blanche ou à une double ronde et changera légèrement son

apparence en conséquence.

Choisir une tête de note
Pour changer le type de tête de note déjà en cours d’utilisation, sélectionnez une note ou un

passage et utilisez le menu déroulant sur le panneau Notes de la fenêtre des propriétés. Vous

pouvez également choisir la tête de note en maintenant enfoncées les touches Maj+Alt ou xz et

en entrant le numéro à partir de la rangée supérieure du clavier principal (pas le pavé numérique);

cf. ci-dessous pour les numéros des têtes de note. Pour obtenir un numéro de tête de note

supérieur à 9 (par exemple, la tête de note 13), entrez les deux chiffres rapidement l’un après

l’autre. Si vous n’êtes pas sûr de ce que vous recherchez, vous pouvez également passer d’une tête de

note à l’autre en tapant Maj-+/-.

Choisissez simplement le type de tête de note souhaité à partir de la fenêtre des propriétés ou

entrez le raccourci avant d’entrer la note. Le type de tête de note choisi sera utilisé par toutes les

notes suivantes jusqu’à ce que vous le changiez à nouveau.

Comme les têtes de note sont personnalisables, les raccourcis affichés dans cet article (et tout au

long de ce guide de l’utilisateur) peuvent ne pas être corrects (si vous avez modifié des types de tête

de note existants).

Têtes de note courantes
Les têtes de notes en croix (raccourci Maj+Alt+1 ou xz1) indiquent des notes dont la hauteur de

note n’est pas clairement définie, en général pour les percussions à sons indéterminés. Une blanche

en croix peut être écrite comme une blanche normale traversée d’une croix en notation de musique

d’avant-garde ou comme un losange dans de la notation pour batterie (raccourci Maj+Alt+5 ou

xz5).

Les têtes de note en losange (raccourci Maj+Alt+2 ou xz2) indiquent généralement des notes à

entendre selon une technique spéciale, comme par ex. les harmoniques des instruments à cordes

cf. Harmoniques dans b 4.2 Interprétation de la partition), ou (en musique d’avant-

garde) des touches de piano enfoncées silencieusement. Pour les harmoniques de guitare, les

noires et les notes plus courtes sont écrites avec un losange noir (raccourci Maj+Alt+6 ou xz6).

Les barres obliques indiquent le rythme des accords improvisés sur des symboles d’accord en jazz,

en rock et en musique commerciale. Deux types de barres obliques sont fournis, l’un avec hampe
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(raccourci Maj+Alt+4 ou xz4) autre sans (raccourci Maj+Alt+3 ou xz3). Ces têtes de note ne

sont ni exécutées ni transposées et s’écrivent d’habitude sur la ligne médiane de la portée.

Les notes sans tête (raccourci Maj+Alt+7 ou xz7) indiquent les rythmes en musique

contemporaine, soit lorsqu’une note ou un accord précédent est répété, ou lorsque (comme pour la

tête de note en croix) la hauteur est indéfinie ou improvisée. Le problème, c’est les rondes sans

tête...

Les notes sans hampes (raccourci Maj+Alt+8 ou xz8) sont utiles pour de la musique

arythmique telle que le plain-chant.

Les notes silencieuses (raccourci Maj+Alt+9 ou xz9) ont exactement la même apparence que les

notes normales, mais ne sont pas exécutées, ce qui peut être utile dans certaines situations.

Les têtes de note au format des notes de réplique (raccourci Maj+Alt+10 ou xz10) sont utilisées

pour mélanger des têtes de note normale et de réplique dans un même accord (pour des notes de

réplique normales, voyez plus bas). Notez bien que l’utilisation de ce type de tête de note ne

diminue pas la taille des objets associés tels que les altérations.

Les têtes de note traversées d’une barre oblique (raccourcis Maj+Alt+11/12 ou xz11/12) sont

utilisées en notation de percussions par exemple pour les rim-shots.


0 - normal

   
1 - croix

    2 - losange

   
3 - temps sans ligature


4 - temps 5 - croix ou losange

   
6 - losange noir et blanc

   
7 - sans tête


8 - sans hampe    9 - silencieux   

10 - peti t    11 - avec barre oblique   


12  - avec barre oblique 

   inversée   
13 - flèche du bas

   
14 -flèche du haut    15 - triangle inversé

   


16–23 - formes de notes

               

             23 est 19 à utiliser avec une hampe 
orientée vers le bas   


24 - croix avec un petit cercle   25 - notation stick 26 - grande croix 27 - grande barre sans hampe   


28 - grande barre avec hampe    29 - croix (en gras)    30 - jonction
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Les têtes de note en flèche vers le bas (raccourci Maj+Alt+13 ou xz13) ou en flèche vers le haut

(raccourci Maj+Alt+14 ou xz14) qui ne peuvent être utilisées qu’avec des hampes pointant

respectivement vers le haut et vers le bas, sont utilisées pour indiquer des notes non spécifiées

dans l’extrême grave ou l’extrême aigu. Ces têtes de notes sont dessinées sans lignes

supplémentaires.

Les têtes de note 16–23 sont utilisées pour la musique selon la forme de note, connue aussi sous le

nom de musique de “harpe sacrée”, telle que formulée dans un recueil Américain de mélodies de B.F.

White et E.J. King en 1844. Dans cette technique appelée “fasola” (c’est-à-dire fa – so – la, une forme

de solmisation), des têtes de note de formes différentes sont utilisées pour les différents degrés de la

gamme. Utilisez l’extension Extensions > Notes et silences > Appliquer les formes de note pour

créer cette notation automatiquement – Appliquer les formes de note à la page 565.

La tête de note 24 est une alternative à la tête de note en forme de croix dont la tête de note de

blanche est plus petite; elle s’utilise parfois à la place de la tête 1. La tête de note 29 est une autre

alternative à la tête de note en forme de croix, avec une croix plus épaisse.

La tête de note 25 est utilisée pour la notation Kodály.

La tête de note 26 est une utilisée pour les “marching percussion”, et signifie d’habitude que les

tambours jouent à l’unisson.

Les têtes de note 27 et 28 sont des alternatives aux têtes de note en oblique, parfois utilisées à la

place des têtes de note 3 et 4.

La tête de note 30 s’utilise parfois en percussion pour représenter un “ping,” un “rimshot”

spécifique.

Différentes tailles de têtes de note
Vous ne devriez créer des petites têtes de note du type 10 que si des têtes de notes normales et petites

sont toutes deux nécessaires dans le même accord. Pour transformer une seule note ou un accord

complet en notes de réplique, utilisez plutôt le bouton de notes de réplique (raccourci Entrée) sur le

second pavé (raccourci F8), car cela réduira également la taille de la hampe ainsi que les éventuels

accents et / ou altérations – b 2.14 Notes ornementales.

Si vous préférez une tête de note légèrement plus grande tout au long d’une partition, vous pouvez

utiliser le papier à musique Vierge (grandes notes) – b 2.23 Papier à musique – ou importer

le style maison Standard (grandes notes) dans une partition existante – b 8.8 Style maison.

Notes entre parenthèses
Vous pouvez mettre n’importe quelle note entre parenthèses (y compris les notes

ornementales) en utilisant le bouton parenthèses du second pavé (raccourci F8).

Les parenthèses s’adapteront automatiquement afin d’entourer les altérations, etc...

Nom des notes à l’intérieur des têtes de note
En musique, pour les étudiants commençant d’apprendre un instrument, il peut s’avérer utile de

montrer le nom de la note à l’intérieur de la tête de note elle-même. Pour cette opération, consultez

Ajouter les noms des notes aux têtes de note à la page 569.
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2.26 Percussion

b 2.25 Têtes de note, 2.34 Trémolos.

Cette rubrique concerne exclusivement l’écriture des percussions à sons indéterminés. L’écriture

des percussions à sons déterminés est très semblable à celle des autres instruments à sons

déterminés, ce qui ne nécessite aucune connaissance particulière.

Les percussions à sons indéterminés peuvent être notées de différentes façons, dépendant de la

musique et aussi de l’ensemble pour lequel la partition est écrite. Par exemple, en rock, en jazz et en

musique commerciale, différentes hauteurs et têtes de notes sont utilisées pour noter différents

instruments sur la même portée (ce qu’on appelle set de batterie - en anglais drum kit).

Dans la musique orchestrale, les ensembles de percussions, ou autres, on rencontre d’autres

possibilités:

* chaque instrument (ou groupe d’instruments) peut avoir une portée différente (par exemple

cymbale, grosse caisse, triangle); ou

* une seule portée est utilisée, avec un texte indiquant à quel endroit il faut passer d’un instrument

à un autre; ou

* chaque percussionniste dispose de sa propre portée ou de son ensemble de portées; ce qui est

utile pour extraire chaque partie individuellement.

Sibelius comporte la plupart des instruments à percussion à sons déterminés et indéterminés et en

facilite l’écriture quelle que soit la manière de les présenter.

Instruments à sons indéterminés
Chaque instrument à sons indéterminés intégrés dans Sibelius possède sa propre table

d’assignation des notes, c’est-à-dire une liste de correspondance entre le son d’une percussion (par

ex. une cloche, une grosse caisse) et la position sur la portée et le type de tête de note (par ex.

normale, en forme de croix, en losange) de la note utilisée pour l’écrire.

Pour la plupart des percussions à sons indéterminés, la table d’assignation est très simple.

Par exemple les percussions qui utilisent des portées à 1 ligne sont d’ordinaire réglées pour

produire le son adéquat quand on saisit sur la ligne elle-même une note dont la tête est normale, en

forme de croix ou en losange.

Cependant, certains instruments à percussion, plus complexes, nécessitent plus de lignes de portée

et plus de têtes de note. Par exemple le kit de batterie, les tambours de marche, les grosses caisse et

les cymbales utilisent des portées à cinq lignes, et différentes têtes de note pour produire différents

sons à chaque endroit différent de la portée.

Parce qu’il existe une multitude de percussion à sons indéterminés dans Sibelius, il n’est pas

possible de décrire en détail la table d’assignation de chaque instrument. Voici, par exemple

comment visualiser la table d’un instrument spécifique:

* Sélectionnez une mesure de l’instrument concerné, si vous l’utilisez déjà dans votre partition

* Choisissez Style maison > Modifier les instruments
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* Si vous avez sélectionné une note ou une mesure, l’instrument doit apparaître sélectionné; si ce

n’est pas le cas, sélectionnez-le dans la liste Instruments dans la famille

* Cliquez sur Modifier l’instrument; répondez Oui s’il vous est demandé d’accepter qu’une

modification de l’instrument modifie la partition

* Cliquez maintenant sur Modifier le type de portée, et choisissez la page Percussion.

* Dans la partie supérieure de la boîte de dialogue apparaissent les notes assignées; pour savoir le

son que produit une tête de note spécifique, sélectionnez-la et regardez le Son associé en

dessous. Vous pouvez aussi voir quelle touche du clavier MIDI il faut jouer pour saisir la note –

cf. Saisie des notes pour les percussions à sons indéterminés ci-dessous.

Pour en savoir plus sur cette boîte de dialogue et comment modifier les instruments à percussion

existants ou créer les vôtres, b 8.14 Modifier les instruments.

Cependant, la notation d’un set de batterie est suffisamment standardisée pour que nous nous y

attardions à présent.

Notation d’un set de batterie (drum kit)
Pour créer une portée de set de batterie dans Sibelius, choisissez Créer > Instruments (raccourci

I), et sélectionnez soit Set de batterie ou Drum Kit (deux noms pour la même chose).

Les instruments Ensemble percussions et Kit percussions utilisent un système de notation basé

sur les recommandations du “Percussive Arts Society” (dans le livre de Norman Weinberg, “Guide

To Standardized Drumset Notation”), que voici :

Saisie des notes pour les percussions à sons indéterminés
Quand on réalise la saisie dans des portées de percussion, n’importe quelle méthode de saisie

convient, mais comme les instruments de percussion utilisent différents types de têtes de note, il

est plus rapide d’utiliser la méthode pas-à-pas ou Flexi-time que la saisie à la souris ou en mode

alphabétique.

Considérons l’exemple suivant, pour une grosse caisse, une caisse claire et un charleston (ouvert ou

fermé) d’un set de batterie habituel:

Les noires de la voix 2 utilisent la tête de note par défaut, tandis que les croches et double croches

de la voix 1 ont une tête de note en forme de croix. (Si vous n’utilisez pas ces notes l’effet ouvert-

fermé n’est pas exécuté).


Pédale
Charleston


Grosse

caisse 1


Grosse caisse

acoustique


Tomtom
bas


Tomtom
haut


Tomtom
grave


Tambourin


Caisse claire

acoustique


Caisse 
claire
électrique


 Wood block

grave




Side stick


Tomtom
entré bas


Wood 
block aigu


Tomtom
entré aigu


Cloche


Tomtom
aigu


Cymbales
1


Charleston
fermé


Charleston

ouvert


Crash

cymbal 1



Triangle
ouvert
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Si vous faites la saisie avec la souris ou avec la saisie alphabétique, une fois celle terminée, vous

devez changer la voix 1 pour y placer les têtes de note en forme de croix:

* Sélectionnez les mesures dont les têtes de note doivent être changées (b 1.9 À propos des
sélections et des passages)

* Filtrer soit en fonction de la voix, c’est-à-dire Édition > Filtrer > Voix 1, ce qui notre objectif pour

l’exemple ci-dessus, ou filtrer selon les hauteurs spécifiques à changer avec Édition > Filtrer > Filtre
avancé. Le filtre des hauteurs traite les clés de percussion comme des clés de sol, de sorte que :

% dans les portées à 1 ligne, la hauteur de la ligne de portée est Si4 (parce que cette ligne

correspond au milieu de la portée à 5 lignes)

% dans les portées à 2 lignes, les hauteurs sont (de bas en haut) Sol4 et Ré5

% dans les portées à 3 lignes, les hauteurs sont Mi4, Si4 et Fa5

% dans les portées à 4 lignes, les hauteurs sont Fa4, La4, Do5 et Mi5

% dans les portées à 5 lignes, la ligne du milieu est B4.

Pour en savoir plus sur les fonctions de filtre de Sibelius, b 5.7 Rechercher et filtrer.

* Changez les têtes de note en tapant v+Alt+n ou xzn, n étant le numéro sur le clavier principal

(pas le clavier numérique); dans l’exemple ci-dessus, il faut taper Maj+Alt+1 ou xz1.

Une autre méthode consiste à choisir la tête de note dans le menu du panneau Notes des

propriétés (b 2.25 Têtes de note).

Si par contre vous faites la saisie en pas-à-pas avec un clavier MIDI ou en mode Flexi-time, Sibelius

connaît et attribue automatiquement la tête de note (ainsi que son articulation si elle est spécifiée)

en fonction de la hauteur jouée. Si vous jouez une hauteur pour laquelle il y a plus d’une tête de

note attribuée dans le type de portée, Sibelius choisit la première tête de note qui apparaît dans la

liste de la table de répartition des notes.

Vous pouvez choisir soit d’utiliser la table de répartition de l’instrument lui-même, soit que les

hauteurs soient données via un périphérique MIDI spécifique (par ex. votre clavier ou votre

module de sons). Cette option se règle dans Portées de percussion de la page Saisie des notes
dans Fichier > Préférences (dans le menu Sibelius sur Mac).

Par défaut, Sibelius est réglé sur L’instrument, ce qui signifie qu’il attribue les valeurs jouées selon

la définition de l’instrument. Avec ce réglage, une portée de 1 ligne est traitée comme la ligne

centrale d’une portée à 5 lignes (c-à-d Si4), une portée de 2 lignes comme les 2e et 4e lignes (c-à-d

Sol4 et Ré5), une portée de 3 lignes comme les 1re, 3e et 5e lignes (c-à-d Mi4, Si4, et Fa5), une portée

de 4 lignes comme les interlignes (c-à-d Fa4, La4, Do5, et Mi5). Donc on saisira la note de la portée

d’une ligne en jouant le Si au-dessus du Do moyen.

Si vous préférez que les notes jouées sur votre clavier MIDI correspondent au son souhaité, réglez

l’option de Portées de percussion sur la table d’assignation des notes du périphérique. Vous

entendrez alors le son tel que vous le saisissez, et Sibelius transcrira la note jouée selon la table de

répartition de la portée.

Exécution de percussion atonale
Bien qu’il soit possible de positionner n’importe quelle tête de note à tout emplacement sur une

portée de percussion atonale, Sibelius n’exécutera que les têtes de note figurant spécifiquement

dans la définition d’instrument – cf. Page Percussion à la page 702.
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Différentes portées pour différents instruments
Dans les partitions d’orchestre, il est courant d’utiliser plusieurs portées d’une ligne pour chaque

instrument de percussion à sons indéterminés utilisé, comme ceci:

De nombreux instruments individuels sont accessibles depuis la boîte de dialogue Créer >

Instruments. Voici par exemple, comment écrire pour une grosse caisse, un triangle et des

cymbales dans une partition:

* Dans la boîte de dialogue Créer > Instruments choisissez la famille Percussion/Tambours et

ajouter les instruments Cymbales, Triangle et Grosse caisse.

* Cliquez sur Créer et les instruments sont ajoutés à la partition.

Tous ces instruments seront exécutés en utilisant le son adéquat. Remarquez également comme les

hampes pointent vers le haut sur les portées à une ligne.

Créer votre propre table d’assignation
Si vous voulez écrire plusieurs instruments de percussion sur la même portée avec des sons, des

têtes de note ou des positions qui n’existent pour aucun instrument prédéfini, il faut créer votre

propre instrument avec sa propre table d’assignation des notes.

Par exemple, pour écrire ceci:

* Choisissez Style maison > Modifier les instruments

* Dans l’ensemble Instruments courants sélectionnez la famille Percussion et tambours, puis

sélectionnez le set de batterie (basique) dans la liste Instruments dans la famille.

(l’instrument choisi n’est pas très important, car il va être modifié, mais celui-là a le nombre de

lignes de portées qui convient et pas trop de têtes de note dans sa table d’assignation.)

* Cliquez sur Nouvel Instrument, et répondez Oui quand il vous sera demandé si vous souhaitez

créer un nouvel instrument basé sur celui-là

* Changez Nom dans les boîtes de dialogue par une appellation du genre Grosse caisse,
Cymbale, Triangle, de manière à le retrouver facilement

* Changez Nom complet dans la partition par une appellation du genre Grosse
caisse\n\Cymbale\n\Triangle (\n\ indiquant qu’il faut aller à la ligne)

* Cliquez sur Modifier le type de portée, et allez dans l’onglet Percussion de la boîte de

dialogue qui apparaît

* Dans notre exemple, trois hauteurs de notes sur la portée doivent être attribuées à des sons

spécifiques: la ligne du haut sera pour le triangle, celle du milieu pour les cymbales, et celle du

bas pour la grosse caisse; sélectionnez les notes en trop et cliquez sur Suppr pour les supprimer
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* Pour chacune des notes conservées, sélectionnez la tête de note, puis choisissez le son correct

dans le menu déroulant Son.

* Il faut aussi changer la Tête de note pour un instrument spécifique; parfois on déterminera

même un son différent si une Articulation spécifique est utilisée avec une tête de note, mais

cette fois ce n’est pas nécessaire

* Une fois les sons réglés, cliquez sur OK pour confirmer les changements de type de portée

* Cliquez sur OK pour confirmer les changements apportés au nouvel instrument.

* Vérifiez que le nouvel instrument Grosse caisse, Cymbale, Triangle soit dans l’ensemble

Instruments courants: déplacez-le dans la liste Instruments dans la famille depuis la liste

Instruments hors de l’ensemble en cliquant sur Ajouter à la famille, puis cliquez sur

Fermer pour fermer la boîte de dialogue Modifier les instruments

* Maintenant choisissez Insertion > Instruments, sélectionnez votre nouvel instrument dans la

liste et cliquez sur Ajouter dans la partition pour le créer, puis cliquez sur OK

* Faites la saisie des notes sur la portée avec les trois hauteurs définies dans le type de portée; vous

pouvez utiliser des voix si vous préférez – b 2.36 Voix.

Une seule portée pour chaque exécutant
Si votre partition requiert plus d’un percussionniste, ou si un percussionniste doit changer

d’instrument, il est courant de noter tous les instruments de percussion sur une seule ligne, avec

un texte indiquant les changements. Pour réaliser cela dans Sibelius, on utilise les changements

d’instrument – b 2.18 Instruments et portées.

Il existe de nombreux instruments de percussion prédéfinis avec les sons appropriés; par ex.

l’instrument Cymbale [1 ligne] joue avec un son de cymbale. Naturellement si on le souhaite, il

est possible de créer ses propres instruments de percussion.

Symboles de percussion
Sibelius propose de nombreux symboles représentant les instruments, les types de mailloches et

les techniques de jeu correspondant à un large éventail d’instruments à sons déterminés et

indéterminés. Pour ajouter un tel symbole dans une partition, choisissez Insertion > Symbole
(raccourci Z) et cliquez sur le symbole souhaité dans les rangées Percussion, Tambour,

Métalliques, Mailloches etc... –b 2.31 Symboles.

Enlever le cadre des symboles de mailloches de percussion
Si on le souhaite, il est possible d’enlever le cadre autour du symbole des mailloches de percussion:

* Choisissez Style maison > Modifier les symboles

* Cliquez sur le symbole de cadre vide à l’extrême droite de la rangée des mailloches

* Cliquez sur Modifier, entrez 0 dans le champs Numéro puis cliquez sur OK.

Roulements de tambour (Z sur la hampe)
Le symbole de roulement de tambour est utilisé dans l’écriture des percussions pour indiquer les

coups de roulement; Sibelius permet d’ajouter ce symbole sur toutes les notes et les accords.

Choisissez le troisième pavé (raccourci F9) et tapez 6. Pour en savoir plus sur les roulements de

tambour, b 2.34 Trémolos.
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2.27 Mesures répétées

Le signe de mesure de répétition indique que la mesure dans laquelle il apparaît est une répétition

de la précédente.

Un reste de l’époque de la musique copiée à la main, ce signe est toujours utilisé dans les parties de

section rythmique (pour les batteries, les guitares, etc.) car son utilisation facilite la lecture des

musiciens plutôt que la répétition sur des mesures successives.

Différentes versions de ce signe sont utilisées pour montrer que les deux ou les quatre dernières

mesures doivent être répétées, p.e. :

Création de mesures de répétition
Les mesures de répétition sont créées à partir du cinquième pavé (raccourci F11). Pour saisir une

mesure de répétition lors de la saisie de notes, p.e. si le curseur de saisie de notes est visible

(b 1.1 Saisie des notes):

* Pressez F12 pour choisir le cinquième pavé (b 1.2 Pavé)

* Appuyez sur 1 sur le pavé numérique pour une répétition d’une mesure, 2 pour une répétition

de deux mesures ou 4 pour une répétition de quatre mesures.

* Le signe de mesure de répétition requis est créé à la position du curseur ; si le curseur est au

milieu d’une mesure qui contient déjà des notes dans la même voix que le signe de mesure de

répétition que vous créez, elles seront effacées. Lors de la création de mesures de répétition de

deux ou quatre mesures, toutes les notes des mesures suivantes dans la même voix, couvertes par

la mesure de répétition seront aussi effacées.

* Pour introduire davantage de mesures de répétition, pressez simplement 1, 2 ou 4 le nombre de

fois nécessaire.

Vous pouvez aussi créer des lots de mesures de répétition en une seule fois : sélectionnez le passage

que vous souhaitez voir répéter, puis pressez F12 pour choisir le cinquième pavé et pressez 1, 2 ou

4. Toutes les mesures “restantes” (p.e. si vous avez neuf mesures sélectionnées et avez créé des

répétitions de quatre mesures) seront conservées.

Copie de mesures de répétition
Les mesures de répétition peuvent être copiées comme n’importe quel autre objet et peuvent aussi

être rapidement répétées en utilisant Modifier > Répétition (raccourci R).
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Effacer les mesures de répétition
Pour effacer une mesure de répétition, sélectionnez simplement la mesure et pressez Supprimer
(qui vide la mesure et laisse une pause de mesure). La création d’une note dans la même voix que la

mesure de répétition efface aussi la répétition.

Numérotage des mesures de répétition
Sibelius numérote automatique les mesures de répétition toutes les quatre mesures. La première

mesure de répétition est toujours numérotée “2” (pour refléter que c’est la deuxième fois que la

musique est jouée). Vous trouverez des options pour contrôler ce numérotage automatique dans la

page Mesures à compter de Style maison > Règles de gravure :

* Numéroter les mesures de répétition toutes les n mesures vous permet de choisir si les

mesures de répétition doivent être numérotées à chaque mesure ou toutes les deux, quatre (par

défaut) ou huit mesures.

* Par défaut, les répétitions de deux ou quatre mesures indiquent simplement “2” ou “4” au-des-

sus du signe de mesure de répétition, mais vous pouvez activer Numéroter les mesures à
répétition de deux mesures ou Numéroter les mesures à répétition de quatre mesures si

vous préférez.

* Compter les structures avec reprise lorsque les mesures de reprises sont numérotées,
et indiquer en tant que vous permet d’indiquer le nombre réel de répétitions d’une série de

mesures de reprise dans un passage lui-même répété (à l’aide de barres de reprise). Lorsque

l’option est activée, Sibelius indique un numéro correspondant à chaque répétition de une, deux

ou quatre mesures dans la structure. La liste déroulante vous permet de choisir comment les

numéros répétés doivent être indiqués (cette option n’est applicable que si les reprises sont

activées pour l’exécution dans le menu Exécution > Reprises) :

* Afficher les numéros des mesures entre parenthèses détermine si les numéros doivent ou

non être dessinés entre parenthèses.

* Vous pouvez choisir de réinitialiser le numérotage aux Doubles barres de mesure et aux

Repères de répétition si vous le souhaitez.

Pour modifier la police et la taille des numéros sur les mesures de répétition, modifiez le style de

texte des Numéros de mesures de répétition (b 3.9 Modifier les styles de texte).

Pour changer la position des numéros, utilisez Style maison > Positions par défaut
(b 8.12 Positions par défaut).

Formatage des mesures de répétition
Sibelius ne permettra jamais qu’un système ou un saut de page ne survienne au milieu d’une répé-

tition de deux ou quatre mesures. Vous pouvez sélectionner n’importe quelle barre de mesure au

milieu des répétitions de deux ou quatre mesures dans votre partition et créez un système ou un

saut de page (b 8.5 Les sauts) et la marque de mise en page apparaît sur la barre de mesure (si

Affichage > Marques de mise en page est activée), mais le saut ne se fera que si vous effacez les

mesures répétées.
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Réplique dans les mesures de répétition
Vous pouvez parfois souhaiter répliquer la mélodie ou le rythme joué par un autre instrument

pour faciliter l’exécution de l’interprète des mesures de répétition, dans ce cas utilisez une voix

inutilisée pour ces notes. Assurez-vous que les cases Jouer lors de l’exécution du panneau Exé-
cution des Propriétés sont décochées pour ces notes, de manière à éviter les interférences avec

l’exécution de la mesure de répétition – voir Quand jouer des notes à la page 331.

Mesures de répétition pour les claviers
Il est conventionnel d’afficher les mesures de répétition sur les deux portées du clavier : pour ce

faire, créez les mesures de répétition sur chaque portée à part ou copiez-les d’une portée sur l’autre.

Exécution des mesures de répétition
Quand Sibelius trouve une mesure de répétition, il revient automatiquement à l’exécution de la

mesure (ou des deux ou quatre mesures) précédente. Soyez conscients que si une mesure de répé-

tition inclue aussi des notes dans une autre voix à exécuter, Sibelius exécutera uniquement ces

notes et ignorera le signe de mesure de répétition.

Vous pouvez souhaiter parfois, p.e., modifier les dynamiques des mesures de répétition, comme

suit :

Sibelius exécutera les dynamiques sur les mesures de répétition, mais toutes les instructions qui

provoquent un changement de son (p.e., “pizz” ou “mute”) n’affecteront que la première note

suivant les mesures de répétition.
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2.28 Liaisons de phrasé

b 2.21 Lignes.

Les liaisons sont utilisées pour indiquer le phrasé et la technique d’interprétation. Les liaisons qui

indiquent le phrasé sont aussi parfois appelées ”liaisons de phrasé” mais étant donné que ces

repères sont simplement de grandes liaisons, nous utiliserons le mot “liaison” pour couvrir les

deux. Cette terminologie est considérée standard dans la gravure musicale.

Comme c’est le cas pour d’autres objets dans Sibelius (p.e. les multiplets), les liaisons de legato sont

magnétiques, ce qui signifie qu’elles sont placées intelligemment, le long des notes tout en évitant

les collisions avec tout objet sous leur arc – p.e., notes, altérations et articulations – en modifiant

leur forme et en déplaçant automatiquement leurs extrémités jusqu’au meilleur fusionnement.

Il est possible de créer une liaison de legato non magnétique, qui ne colle pas aux notes ou qui soit

positionnée automatiquement, très pratique dans certaines situations.

Création et extension des liaisons
Pour créer une liaison magnétique, il faut soit :

* Sélectionner une note (ou une note ornementale) et presser S. Ce qui installe une liaison jusqu’à

la note suivante ; ou

* Sélectionner le passage de notes (sur une seule portée) à lier et presser S, ce qui installe une

liaison au-dessus du passage sélectionné.

La liaison peut être allongée jusqu’à la note suivante en tapant Espace (par analogie avec le

mécanisme de placement des paroles), ou réduite avec Maj-espace.

Ces touches déplacent l’extrémité sélectionnée comme

l’indique l’affichage d’une petite “poignée” carrée.

Cherchez la petite “poignée” carrée – en effet, les

liaisons de legato sont munies de poignées lorsqu’elles

sont sélectionnées. On peut utiliser Espace et Maj-
espace avec d’autres lignes

Vous pouvez aussi sélectionner et déplacer l’extrémité

gauche de la même manière, soit avec les flèches, la

souris ou en pressant Espace/Maj-espace.

Tout en élargissant ou réduisant la liaison, elle peut passer de l’autre côté des notes. Si les hampes

de toutes les notes sous la liaison vont vers le haut (p.e. elles sont toutes sous la ligne médiane de la

portée), Sibelius positionne la liaison sous les notes, réalisant la courbe vers le bas. Si, toutefois,

l’une des hampes des notes sous la liaison va vers le bas, Sibelius positionne la liaison au dessus des

notes, réalisant la courbe vers le haut.

Positionnement des liaisons 
Les liaisons se situent généralement au 

bout d’une hampe sur deux voix ou plus.

Une liaison de phrasé doit commencer sur 

la première des deux notes liées ryth-

miquement et se terminer sur la dernière 

des deux notes liées.

Pour assurer une parfaite visibilité, les 

extrémités ou le sommet et le bas de l’arc ne 

doivent toucher aucune ligne de portée.
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Si vous préférez aller à l’encontre d’une convention vieille de plusieurs siècles en ce qui concerne le

placement, vous pouvez bien sur choisir d’inverser la liaison que vous avez créé en la sélectionnant

et en choisissant Modifier > Inverser (raccourci X).

Poignées des liaisons
Bien que les réglages par défaut de Sibelius produisent des formes de liaisons agréables dans la

plupart des situations, vous pouvez parfois préférer personnaliser une liaison déterminée de

manière à la rendre la plus gracieuse possible. Quand vous sélectionnez une liaison, un cadre gris

apparaît vous montrant les poignées de la liaison :

(Si vous préférez que les poignées soient visibles à tout moment, basculez Affichage > Poignées –

b 5.23 Menu affichage.)

Maintenez Alt ou z enfoncé et pressez 0/1 pour faire défiler les six poignées de la manière

suivante : extrémité gauche, point courbe gauche, milieu supérieur, milieu inférieur, point courbe

droit et extrémité droite de la liaison.

Une poignée sélectionnée, vous pouvez utiliser les flèches (tout en pressant Ctrl ou X pour des

incréments plus importants) pour régler sa position.

* Si vous déplacez l’extrémité gauche ou droite avec les flèches, vous pouvez modifier la position

relative à sa note mais elle ne se liera pas à une autre note ; pour modifier les liens de la liaison,

utilisez Espace ou Maj-espace.

* Si vous déplacez la poignée du milieu inférieur, vous modifiez sa position verticale relative aux

notes auxquelles elle est attachée, sans toutefois changer sa courbure.

* Si vous déplacez la poignée du milieu supérieur, vous modifiez la hauteur de la liaison tout en

conservant sa courbure relative. Vous pouvez aussi modifier l’angle de courbure de la liaison en

déplaçant la poignée centrale supérieure vers la gauche ou la droite.

* En déplaçant le point de courbe gauche ou droit, vous modifiez la courbure de la liaison,

permettant de réaliser un réglage fin du contour de celle-ci.

Vous pouvez aussi déplacer les poignées de la liaison en utilisant les contrôles du panneau Lignes
des Propriétés :

* Extrémité X et Y montrent le décalage à gauche et à droite de la liaison, le cas échéant, mesuré

en espaces. (Généralement, X et Y afficheront 0.)

* La courbe gauche X et Y ainsi que la courbe droite X et Y expriment la position des points de

courbe gauche et droit, s’ils ont été modifiés. La valeur X est exprimée en pourcentage de la

longueur de la liaison et la valeur Y en espaces. Vous pouvez réinitialiser la position de chaque

point de courbe en décochant la case pertinente.

Enfin, on peut changer l’aspect d’une liaison en déplaçant ses poignées avec la souris.
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Pour réinitialiser la forme d’une liaison, sélectionnez la ligne même de la liaison et choisissez Mise
en page > Réinitialiser le dessin (raccourci Ctrl+Maj+D ou xXD) ; pour réinitialiser la position

d’une seule poignée, sélectionnez simplement cette poignée et choisissez Réinitialiser l’aspect.

Cela permet aussi de rétablir la position d’une liaison, si vous l’avez inversé avec Modifier >

Inverser.

Pour réinitialiser la position des extrémités gauche et droite de la liaison, sélectionnez n’importe

quelle partie de celle-ci et choisissez Mise en page > Réinitialiser la position (raccourci

Ctrl+Maj+P ou xXP).

Épaisseur de la liaison
Les liaisons sont effilées à leurs extrémités et plus épaisses en leur milieu. Vous pouvez modifier

l’épaisseur par défaut sur la page Liaisons de Style maison > Règles de gravure :

* Pour modifier l’épaisseur par défaut des extrémités effilées des liaisons, modifiez Épaisseur des
bordures n dents.

* Épaisseur du milieu n dents détermine l’épaisseur de la liaison en sont point le plus épais.

La valeur représente l’épaisseur de la largeur de la liaison moins l’épaisseur minimum de celle-ci

(par conséquent une valeur de 0,5 dent produit une liaison moitié plus épaisse que la normale -

c’est très épais !).

Vous pouvez aussi régler l’épaisseur d’une seule liaison, en la sélectionnant et en réglant le contrôle

Épaisseur de la liaison du panneau Lignes des Propriétés.

Cambrure de la liaison
La cambrure d’une liaison contrôle le taux d’attaque de la courbure de la liaison et cette valeur

change selon la longueur de celle-ci : les liaisons les plus longues requièrent une cambrure plus

importante, pour qu’elles atteignent leur hauteur maximale plus rapidement que les plus liaisons

plus courtes.

Vous pouvez régler la plage par défaut des valeurs de cambrure sur la page Liaisons de Style
maison > Règles de gravure : modifiez Cambrure pour les petites liaisons n% et Cambrure
pour les longues liaisons n% pour changer subtilement le taux d’attaque de la courbure des

liaisons.

Hauteur de la liaison
Sibelius par défaut dessine des liaisons de manière à ce qu’une courte (définie comme liaison de deux

espaces de longueur) soit d’une dent de hauteur et l’échelonne en utilisant une fonction exponentielle

qui approche une asymptote à mesure que la longueur de la liaison augmente ; dans les faits, les

liaisons ne sont jamais plus hautes que quatre dents par défaut.

Vous pouvez régler la hauteur par défaut des liaisons sur la page Liaisons de Style maison >

Règles de gravure, en modifiant la valeur Échelle de hauteur : une valeur de 200% produit des

liaisons qui tendent vers une hauteur de huit dents ; une valeur de 50% produit des liaisons qui

tendent vers deux dents de hauteur.

À l’inverse, vous pouvez souhaiter vous assurer que les liaisons longues n’occupent pas trop

d’espace verticale et ne ressemblent pas trop à une “boucle” : activez Hauteur limitée pour les
liaisons longues et réglez Hauteur maximum n dents à une valeur adéquate.
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C’est particulièrement pratique si vous souhaitez des liaisons courbées tout en garantissant que les

liaisons les plus longues ne soient pas trop marquées.

Sibelius remplacera ces réglages s’il est nécessaire d’agrandir la liaison de legato afin d’éviter toute

collision avec une note, une articulation ou une altération sous son arc. Vous pouvez ajuster

Déplacer les extrémités si la liaison dépasse de n en hauteur de dents afin de déterminer la

balance entre la courbe de la liaison et la distance des extrémités jusqu’aux notes auxquelles elles

sont rattachées.

Liaisons s’étendant sur deux systèmes
Quand une liaison est divisée sur deux systèmes, Sibelius dessine chaque moitié de celle-ci comme

des arcs séparés, vous permettant de régler entièrement la position des deux segments, comme s’il

s’agissait de deux liaisons séparées.

Le réglage de la forme et de la position d’une liaison qui couvre un saut de système se fait comme

celui d’une liaison normale, sauf que vous pouvez utiliser Alt+0/1 ou z0/1 pour faire défiler les

poignées des deux côtés du saut de système.

Il est aussi possible de dessiner une liaison sur le saut de système comme un seul arc, en dessinant

une moitié sur le premier système et une seconde sur l’autre. Toutefois, cette apparence est

vraiment très rarement utilisée dans la musique publiée. Si vous souhaitez l’utiliser, activez Rogner
en fin de système dans la page Liaisons de Style maison > Règles de gravure.

Liaisons s’étendant sur plus de deux systèmes
Quand une liaison est divisée sur trois systèmes ou plus, Sibelius dessine la liaison selon le nombre

approprié d’arcs, mais n’offre pas un contrôle complet sur la position et la courbure de tous les

segments de la liaison. Vous pouvez modifier une liaison sur trois systèmes ou plus de la manière

suivante :

* Seul le déplacement de l’extrémité gauche du premier segment de la liaison déplace le point lui-

même. Le déplacement de l’extrémité gauche des autres segments déplacent les extrémités de

tous les segments sauf le premier.

* Le déplacement de l’extrémité droite du premier segment déplace l’extrémité droite de tous les

segments, sauf celui du dernier système ; seule l’extrémité droite du dernier segment déplace ce

point.

* Le déplacement du point de courbe gauche ou droit ou du milieu supérieur du premier segment

règle la courbure de tous les segments de la liaison, sauf celle du dernier segment ; le

déplacement du point de courbe gauche ou droit ou du milieu supérieur du dernier segment

règle la courbure de ce segment uniquement.

* Le déplacement du milieu inférieur du premier segment change la position verticale de la liaison

sur tous les systèmes sauf le dernier ; le déplacement du milieu inférieur du dernier segment

règle la position verticale de celui-ci uniquement.

Dans certaines circonstances, il peut être nécessaire d’utiliser des liaisons séparées sur chaque

système de manière à obtenir une apparence idéale.
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Liaisons en S
Parfois l’écriture pour clavier nécessite d’utiliser des liaisons en forme de

S avec deux arcs, en passant en dessous et au-dessus des notes.

Pour créer une liaison en S, introduisez une liaison normale, puis tirez

la poignée de courbe gauche ou droite au-dessus ou au-dessous de la

courbure de la liaison, selon le cas échéant.

Liaisons sur des enjambements de portée
Les liaisons magnétiques ne s’attachent pas aux notes qui enjambent d’autres portées, mais restent

placées comme si la note avait conservé sa place originale sur la portée. On peut cependant en

déplacer les extrémités aux endroits souhaités.

Désactivation de la mise en page magnétique pour les liaisons de legato
Si, pour quelque raison que ce soit, vous souhaitez empêcher Sibelius d’ajuster automatiquement la

forme d’une liaison magnétique afin d’éviter toute collision avec des objets sous son arc, vous

pouvez procéder comme suit :

* Pour garder la forme actuelle d’une liaison, mais en empêchant Sibelius d’effectuer tout autre

ajustement, sélectionnez la liaison de legato et choisissez Mise en page > Bloquer les positions
de mise en page magnétique ; cette méthode désactive entièrement la Mise en page

magnétique pour une liaison de legato, de sorte que des objets puissent entrer en collision avec

cette dernière.

* Pour réinitialiser la forme de la liaison de legato par défaut, tout en préservant tout autre objet

extérieur à la liaison de legato (p.e. du texte, soufflets, etc.) d’entrer en collision avec cette

dernière, sélectionnez la liaison et désactivez Eviter les collisions sous l’arc du panneau des

Propriétés Lignes (cette boîte n’est disponible que si Ajuster la forme pour éviter les
collisions sous l’arc, sur la page des Liaisons de legato de Style maison > Règles de
gravure, est activé, et que Mise en page magnétique est également activé pour la partition).

Notez que le cadre de la liaison et les poignées sont en rouge pour vous indiquer qu’il n’est plus

possible d’ajuster la forme de la liaison de legato par la Mise en page magnétique.

Si vous souhaitez désactiver la Mise en page magnétique pour les liaisons de legato de votre

partition, désactivez alors Ajuster la forme pour éviter les collisions sous l’arc de la page des

Liaisons de legato de Style maison > Règles de gravure.

Liaisons non magnétiques
Bien que cela ne soit pas recommandé, vous pourrez, dans certaines circonstances spéciales, créer

des liaisons “non magnétiques” moins intelligentes en créant une liaison sans sélection avec la

souris depuis la boîte de dialogue Créer > Ligne. Les liaisons non magnétiques ne collent pas aux

notes, et ne parviennent pas à éviter les collisions avec les notes, mais elles peuvent s’avérer utiles

dans certaines situations.

Les liaisons non magnétiques apparaissent en rouge (avec un cadre et une poignée rouges)

lorsqu’elles sont sélectionnées, vous suggérant ainsi d’utiliser plutôt une liaison magnétique.

Si Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou xXP) est utilisé pour

rétablir la position d’une liaison, cela rend magnétique toute liaison qui ne l’était pas.
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Liaisons discontinues utilisant des traits ou des points
Des liaisons discontinues (trait ou point) sont proposées dans la boîte de

dialogue Créer > Ligne (raccourci L). Si aucune note n’est sélectionnée au

moment de les créer, elles ne seront pas magnétiques ; pour qu’elles le

soient, utilisez Mise en page > Réinitialiser les positions.

L’aspect des liaisons discontinues se modifie en changeant la longueur

des traits et des espaces – b 8.15 Modifier les lignes.

Liaisons dans les paroles
Si une petite liaison doit figurer après un mot dans les paroles (par exemple à la fin d’une ligne d’un

verset d’un hymne), n’utilisez pas une vraie liaison mais le caractère prévu à cet effet.

b 3.3 Paroles pour en savoir plus.

Pour ajouter des liaisons dans les portées de chant (pour faire ressortir la construction du texte),

utilisez l’extension Extensions > Texte > Ajouter des liaisons aux paroles (b 6.1 Travailler
avec des extensions).

Copier des liaisons
Quand on copie des passages contenant des liaisons, celles-ci sont copiées avec les notes. Sibelius

retient tout réglage effectué sur les formes des liaisons copiées.

On peut aussi utiliser l’extension Copier les articulations et les liaisons pour copier les liaisons

d’une formule rythmique spécifique sur des phrases similaires de la partition – page 566.

Options des règles de gravure
La page Liaisons de Style maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE) propose

plusieurs options d’un ésotérisme rassurant en plus de celles vues ci-dessus :

* Positionnement des liaisons sur notes à hampes mélangées au-dessus des notes assure

que Sibelius crée uniquement des courbes pointant vers le bas, si la hampe de toutes les notes

dans l’ambitus de la liaison pointe vers le haut ; dans le cas contraire, la liaison pointera vers le

haut. Si vous désactivez cette option, la direction de la liaison de legato sera déterminée par la

direction de la hampe des deux notes initiales sous la liaison, ce qui a très peu de chances d’être

correct.

* Pour les liaisons qui sont positionnées près des têtes de notes :

% Horizontalement n dents depuis le centre de la note détermine la position horizontale

par défaut de l’extrémité de la liaison magnétique, relative à la largeur de la tête de note.

% Verticalement n dents depuis la tête de la note détermine la position verticale par défaut

des extrémités gauche et droite d’une liaison magnétique, relative au haut et au bas de la tête

de note.

% Verticalement n dents supplémentaires pour éviter la liaison détermine l’espace

supplémentaire au-dessus ou au-dessous de la tête de note, pour assurer que l’extrémité de la

liaison magnétique n’entre pas en collision avec la liaison.

* Pour les liaisons qui sont positionnées près des hampes :

% Horizontalement n dents depuis la hampe détermine la position horizontale par défaut

de l’extrémité de la liaison magnétique sur la gauche ou la droite de la hampe de la note liée.
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% Verticalement n dents au-delà la hampe détermine l’espace par défaut au-dessus ou au-

dessous de l’extrémité de la hampe et l’extrémité de la liaison magnétique ; une valeur

négative déplace l’extrémité vers la tête de note.

% Verticalement n dents au-delà de la hampe (croches ou plus courtes) est la valeur que

Sibelius utilise pour l’espace entre l’extrémité d’une liaison magnétique et la hampe de la note

liée, si celle-ci à un crochet ou une ligature.

* Distance minimale x dents de la ligne de portée évite que l’extrémité des liaisons ne

touchent les lignes de portée

* Les options d’Évitement des articulations spécifient la distance entre les extrémités des

liaisons et les articulations au niveau d’une note.

* Ajuster la forme pour éviter les collisions permet à Sibelius d’ajuster la forme des liaisons

magnétiques pour éviter toute collision si la Mise en page magnétique est activée.
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2.29 Portées

b 2.15 Guitare-notation normale ou tablature, 2.18 Instruments et portées,

2.26 Percussion, 7.1 Travailler avec des parties séparées, 5.8 Portées en vue ciblée,

8.14 Modifier les instruments.

Pour déplacer ou aligner des portées, b 8.10 Espacement des portées.

Création des portées
Pour créer une portée d’un nouvel instrument, choisissez Créer > Instruments (raccourci I) –

b 2.18 Instruments et portées.

Instruments à plusieurs portées
Un certain nombre d’instruments utilisent plus d’une portée:

* Instruments à clavier: main gauche et main droite

* Instruments à vents: quand le pupitre comporte plusieurs musiciens

* Percussion: par exemple le célesta, ou le marimba dans certaines partitions élaborées

* Chanteurs: quand ils sont parfois divisés

* Cordes: souvent aussi divisés.

Voici comment ajouter une portée supplémentaire à un instrument: 

* Tout d’abord, si la portée s’ajoute dans toute la partition, assurez-vous que rien n’est sélectionné.

Si par contre elle doit apparaître à un point précis de la partition, sélectionnez la mesure où elle

doit commencer.

* Choisissez Créer > Instruments (raccourci I)

* Dans la liste de Portées présentes dans la partition, sélectionnez ensuite la portée à laquelle

doit s’ajouter la nouvelle

* Cliquez sur Portée supplémentaire Au-dessus ou Portée supplémentaire En dessous

* Cliquez sur OK

De cette manière, on peut ajouter autant de portées que l’on veut. Un seul instrument peut recevoir

un nombre indéterminé de portées (5 par exemple, voire 47391082), même s’il est peu probable

que ce soit plus de deux ou trois. Si le nombre de portées utilisées par un instrument est modifié

pour toute une partition, il faut peut être envisager de modifier les réglages de l’exécution –

b 4.1 Utiliser du texte.

Toutes les portées d’un instrument partagent un seul nom centré verticalement sur les portées.

Ossias
Un ossia est une mesure - ou un peu plus d’une mesure - d’un format de portée de petite taille qui

placée au-dessus d’une portée normale propose une solution alternative pour jouer un passage.

Rien n’est plus simple que de créer des ossias avec Sibelius: Simplement:
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* Sélectionner le passage au-dessus duquel doit figurer l’ossia, par exemple en cliquant sur une

mesure (quelques notes sélectionnées suffisent aussi; sélectionner plusieurs mesures est inutile)

* Dans Insertion > Autres > Portée en ossia, choisissez Ossia au-dessus, ou Ossia en dessous.

* La (ou les) mesure(s) d’ossia apparaîtra (ont) automatiquement, dans la taille réduite adéquate.

Il ne restera plus qu’à copier la musique originale (avec Alt+clic ou z-clic) et apporter les

modifications voulues.

La création d’un ossia consiste à créer effectivement une petite portée au-dessus ou en dessous

d’une autre, avec un changement de portée préalable (pour la faire apparaître) et à la fin (pour la

faire disparaître). En déplaçant ces changements de type de portée on peut modifier la largeur de

l’ossia.

Créer un ossia entraîne donc toujours la création d’une portée supplémentaire. Si vous créez deux

ossias sur le même système en utilisant la méthode décrite ci-dessus, il sera peut être difficile de les

distinguer car Sibelius aura créé une portée supplémentaire de plus au-dessus de la première

sélectionnée. On créera de préférence un second ossia en utilisant la portée déjà utilisée pour le

premier puis pour le faire disparaître Aucun instrument (masqué) (b 2.18 Instruments et
portées).

Systèmes indentés à gauche
Les systèmes sont automatiquement indentés pour laisser la place aux noms complets de

l’instrument, par exemple au début de nouvelles sections. Vous pouvez aussi indenter la première

portée des parties manuellement – b 7.1 Travailler avec des parties séparées.

Pour indenter un système manuellement, déplacez simplement la barre de mesure initiale

(à gauche de la clef) ou l’extrémité de la portée elle-même.

L’indentation s’applique uniquement à cette barre de mesure, de sorte que pour être sûr de

conserver le même format, il est recommandé de placer un saut de page ou de système à la fin du

système précédent s’il existe. (Sinon, si cette barre de mesure se retrouve au milieu d’un système et

un espace vide apparaîtra devant comme pour une mesure de coda, laissant le système fragmenté

de manière ingénieuse mais inattendue.)

Pour rétablir l’indentation d’une portée modifiée, sélectionnez la barre de mesure initiale ou

l’extrémité gauche de la portée et choisissez Mise en page > Réinitialiser les positions (raccourci

Ctrl+Shift+P ou xXP).

Systèmes indentés à droite
Il est parfois utile qu’un système s’arrête avant la marge, par exemple pour des exemples musicaux,

des feuilles d’exercices ou de questions. Pour faire cela:

* En premier lieu, placez un saut de système à la dernière mesure du système à raccourcir en

sélectionnant la barre de mesure et en tapant Retour (sur le clavier principal)

* Activez maintenant Affichage > Poignées, ce qui vous permet de trouver plus facilement la

poignée que vous recherchez

* Sélectionnez la poignée grise dessinée à droite de la barre de mesure à droite du système.

La poignée vire au violet pour indiquer qu’elle est sélectionnée.
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* Tirez la poignée vers la gauche, ou utilisez les raccourcis 0/1 (avec Ctrl ou X pour de plus

grands incréments), pour augmenter l’indentation à droite du système. Vous pouvez alors

désactiver Affichage > Poignées à nouveau.

Pour rétablir la longueur par défaut d’un système, sélectionnez la poignée et choisissez Mise en
page > Réinitialiser les positions (raccourci Ctrl+Shift+P ou xXP).

Masquer des portées
Sibelius propose deux méthodes pour masquer les portées, chacune aux objectifs différents:

* Pour masquer de manière temporaire des portées avec du contenu musical soit dans le but de

faciliter le travail sur des portées spécifiques d’une grande partition sans être gêné par les autres

portées, soit parce qu’on veut préparer une version spéciale d’une partition dont certaines

portées sont exécutées sans être visibles, il convient d’utiliser Affichage > Portées en vue
ciblée –b 5.8 Portées en vue ciblée.

* Par contre s’il s’agit de masquer des portées sans contenu musical pour économiser de la place et

faciliter la lecture, on utilisera l’option Mise en page > Masquer les portées vides décrite ci-

dessous.

Si l’option Affichage > Marques de mise en page est activée, Sibelius affichera de manière très

pratique l’emplacement des portées masquées par une ligne bleue en pointillé à travers la page –

b 8.5 Les sauts.

Préservez les arbres – masquez les portées vides
Si une portée d’un système contient uniquement des mesures de silence, elle peut être masquée

dans ce système, comme cela se pratique dans les grandes partitions:

* Faites un double-clic sur la portée pour la sélectionner entièrement sur le système (ou

sélectionnez plusieurs portées en tant que passage)

* Choisissez Mise en page > Masquer les portées vides (raccourci Ctrl+Shift+Alt+H ou

xzXH).

Cela peut se réaliser sur plusieurs portées, ou sur un passage d’autant de mesures souhaitées, ou

même sur la partition en entier. Les portées seront masquées uniquement dans les systèmes soit

sans musique, soit avec de la musique masquée (par ex. les passages de réplique).

Pour masquer des portées vides dans toute la partition, choisissez simplement Édition >

Sélectionner > Sélectionner tout (raccourci Ctrl+A ou XA) puis Mise en page > Masquer les
portées vides: toutes les portées non employées de la partition disparaîtront et celle-ci sera

complètement reformatée sur moins de pages, ce dont quelques arbres seront reconnaissants.

Quand l’option Mise en page > Masquer les portées vides, est activée, le résultat peut paraître

bizarre avec les portées d’instrument à clavier dont seule une main est jouée. Dans ce cas, faites

une vérification de la partie de clavier et réaffichez les portées masquées là où c’est nécessaire,

sinon pour éviter la vérification, n’incluez pas les portées de clavier dans les portées à masquer.

Naturellement, il n’est pas possible de masquer l’unique portée d’un système, car la présence d’au

moins une portée est la condition d’existence d’un système. Pour supprimer toutes les mesures
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d’une portée unique, il suffit de sélectionner les mesures comme passage de système et de taper

Suppr.

Afficher les portées masquées
Pour afficher à nouveau des portées préalablement masquées avec Mise en page > Masquer les
portées vides:

* Cliquez une mesure dont on veut faire réapparaître les portées

* Choisissez Mise en page > Afficher les portées vides (raccourci Ctrl+Shift+Alt+S ou

xzXS)

* Dans la boîte de dialogue qui apparaît, cliquez sur OK pour afficher toutes les portées masquées,

ou sélectionnez les portées spécifiques qui doivent apparaître.

Ce type d’action ne permet d’afficher que les portées qui avaient été masquées avec Mise en page >

Masquer les portées vides (puisqu’elles ne contiennent pas de musique). Par conséquent, ne

s’afficheront pas:

* les portées cachées suite à un changement d’instrument de type Pas d’instrument (masqué) –

pour les faire réapparaître, utilisez un autre changement d’instrument qui rétablira l’instrument

original

* les portées en vue ciblée; pour les faire réapparaître, désactivez Affichage > Portées en vue
ciblée.

Suppression définitive de portées
Pour supprimer une portée et son contenu de manière définitive, choisissez Insertion >

Instruments (raccourci I), sélectionnez la ou les portées à supprimer dans Portées présentes
dans la partition, et cliquez sur Supprimer de la partition, puis cliquez sur OK. Une autre

méthode consiste à faire un triple-clic sur la portée à supprimer ce qui la sélectionne dans toute la

partition, puis tapez Suppr.

Dimension des portées
La dimension des portées détermine la dimension de tous les éléments d’une partition. Si vous

doublez la dimension de la portée, la dimension de tous les éléments doublent aussi (texte, lignes

etc...) Une partition trop chargée pourra être allégée en diminuant la dimension des portées;

b 8.6 Paramètres du document.

Petites portées
Pour qu’une portée soit plus petite que les autres, choisissez Insertion > Instruments, sélectionnez

la portée en question dans la liste de Portées présentes dans la partition, cochez la case petite
portée puis cliquez sur OK.

Par défaut, les portées de petite taille sont à 75% du format normal, mais ce pourcentage peut se

modifier dans la page Portées de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE).

Portées interrompues par des espaces
Penderecki, Stockhausen et d’autres compositeurs contemporains n’aiment pas que figurent des

portées là où les instruments ne jouent pas. Cela donne aux partitions un aspect un peu morcelé
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avec des fragments de musique disséminés sur la page. Dans la musique chorale, les versets et les

réponses sont souvent écrits de la même manière.

Grâce aux changements d’instruments, c’est assez facile à réaliser; voici comment:

* Tout d’abord, activez Affichage > Objets masqués (raccourci Shift+Alt+H ou xzH) si ce

n’est déjà fait; les changements d’instruments s’afficheront sous la forme de rectangles gris (si

cette option n’est pas activée, ils n’apparaissent pas du tout !)

* Sélectionnez l’endroit où les lignes de portées doivent disparaître; par exemple, s’il s’agit du

début d’une mesure, sélectionnez la barre de mesure; si c’est après une note spécifique,

sélectionnez cette note. Étendez la sélection jusqu’à l’endroit où les portées doivent réapparaître

en utilisant Maj-1 (maintenez Ctrl ou X enfoncé pour étendre la sélection sur toutes les

mesures).

* Choisissez Insertion > Autre > Changement d’instrument. Dans la boîte de dialogue qui

apparaît, régler Choisir dans tous les instruments, Famille sur Autre, puis sélectionner Pas
d’instrument (masqué) dans la liste des instruments.

* Cliquez sur OK et Sibelius créera deux changement d’instruments: au début de la sélection pour

créer un changement d’instrument selon Pas d’instrument (masqué), qui masquera les lignes

de la portée; à la fin de la sélection pour créer le changement d’instrument rétablissant

l’instrument original.

* Dans le cas où Sibelius ne positionnerait pas l’un des changements d’instruments de manière

précise, sélectionnez le rectangle gris qui symbolise le changement et déplacez-le vers la gauche

ou vers la droite avec les touches de flèches 0/1 (avec Ctrl ou X pour de plus grands

incréments), ou en le tirant avec la souris.

Créer un incipit
Bien que l’incipit d’un morceau doive à strictement parler se rapporter aux quelques premières

notes, les incipits surviennent sur de nombreux types de partitions, généralement sous forme de

court fragment de musique précédant le premier système complet, souvent indenté à droite

comme à gauche de la page.

Les incipits peuvent représenter plusieurs choses  : par exemple, une tonalité de plain-chant

précédant un mouvement de chorale; un graphique indiquant quelles cloches sont utilisées dans

une composition; ou même un riff ou une collection de symboles d’accords utilisés dans une

chanson pop spécifique.

Indépendamment de son contenu, vous pouvez créer tout type d’incipit comme celui-ci:

* Ajouter un instrument supplémentaire à la partition (par exemple. Portée en clef de sol dans

la famille Autres)

* Entrez les notes requises pour l’incipit

* Désormais, le navigateur dispose de zones de défilement à gauche et à droite (cf. Systèmes
indentés à gauche et Systèmes indentés à droite ci-dessus)

* Utilisez Mise en page > Masquer les portées vides pour masquer toutes les autres portées de

ce premier système (cf. Préservez les arbres – masquez les portées vides ci-dessus)
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* Utilisez Insertion > Autre > Changement de numéro de mesure pour placer le chiffre 1 à la

mesure 1 au début du second système pour que le morceau commence avec la bonne

numérotation.

Créer des portées liminaires
Les portées liminaires sont couramment utilisées dans les éditions d’exécution modernes de

musique ancienne, et montrent généralement la clef initiale, l’armure, l’indication de mesure pour

chaque portée; elles peuvent aussi indiquer la première note sur chaque portée, écrite dans sa

valeur de note initiale et à la position appropriée pour la clef initiale.

Contrairement à un incipit, qui figure généralement comme une portée individuelle au-dessus du

premier système de musique complet, les portées liminaires figurent au début du premier système,

avec un écart entre les portées liminaires et la première mesure de musique complète.

Pour créer des portées liminaires:

* Placez les portées d’incipit au niveau de la première mesure de la partition (ce qui nécessitera

sans doute de créer une mesure irrégulière), avec les notes et/ou les symboles adéquats.

* Sélectionnez ensuite la barre de mesure en fin des portées d’incipit, et choisissez Mise en page >

Saut > Diviser un système. Cette opération répète les clefs, l’accolade, etc... au début de la

deuxième mesure. Pour supprimer l’espace après l’incipit, sélectionnez la barre de mesure qui

suit l’espace et choisissez Mise en page > Réinitialiser les positions.

* En sélectionnant la barre de mesure avant ou après la mesure d’incipit, on peut déterminer dans

le panneau Mesures de la fenêtre des propriétés si les clefs, l’armure, les accolades et la barre de

mesure elle-même apparaîtront. Modifiez Espace avant la mesure pour ajuster la taille de

l’espace suivant les portées liminaires à partir de ce panneau.

* Au moment de créer les nouvelles clefs et l’armure dans la première mesure réelle, n’oubliez pas

d’activer Masquer, et pour les indications de mesure, de désactiver Annoncer le changement
de mesure.

* Enfin utilisez Insertion > Autres > Changement de numéro de mesure pour créer un

changement de numéro de mesure avec 1 placé au début de la première mesure de musique

complète. Elle commence ainsi avec le numéro de mesure complet.

Comparer deux portées
Si dans la même partition, deux portées doivent être comparées pour détecter d’éventuelles

différences, utilisez l’extension proposée dans Extensions > Analyse > Comparer les portées –

b 6.1 Travailler avec des extensions.
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2.30 Hampes et lignes supplémentaires

Inverser la direction d’une hampe
La règle pour les directions des hampes est assez stricte (cf.

l’encadré ci-contre). La seule direction de hampe qui peut être

inversée est celle des notes sur la ligne centrale de la portée.

Pour inverser la hampe d’une note, sélectionnez-la et choisissez

Édition > Retourner (raccourci X). Cette action retourne la liaison

rythmique éventuellement présente (si nécessaire, celle-ci peut

s’inverser indépendamment).

Ne confondez pas les hampes inversées et l’écriture de musique

ordinaire en deux voix. Dans l’écriture à deux voix, inutile

d’intervenir car les hampes sont automatiquement dans la bonne

direction (b 2.36 Voix).

Pour inverser les hampes d’un groupe de notes ligaturées, inverser

la hampe d’une seule note suffit. (Attention de bien sélectionner la

note dont la direction de hampe n’a pas été affectée par le

placement de la ligature.)

Pour inverser les hampes d’un groupe de notes ligaturées dans un passage à plusieurs voix, il suffit

de sélectionner la hampe de la première note du groupe.

Ligatures sur la ligne centrale
Les hampes des notes sur la ligne centrale de la portée sont généralement orientées vers le bas

(cf. Directions des hampes l’encadré ci-contre) avec pour seules exceptions, les portées de

percussion à 1 ligne qui pointent vers le haut. Sibelius réalise cela automatiquement selon les

spécificités de chaque instrument. Pour en modifier les réglages,– b 8.14 Modifier les
instruments.

Imposer une direction de hampe
Dans quelques cas assez rares (par exemple les partitions de cornemuse), on souhaitera que toutes

les hampes soient vers le bas ou vers le haut, quelle que soit la hauteur des notes. Pour cela, vous

pouvez modifier un instrument – b 8.14 Modifier les instruments.

Modifier la longueur des hampes
Normalement la longueur des hampes ne doit jamais être modifiée, car les règles les concernant

sont assez strictes et suivies à la lettre par Sibelius. Exceptionnellement, vous pourrez allonger une

hampe dans le but, par exemple, d’éviter une collision avec une ligature ou une note ornementale,

ou, en musique contemporaine, pour y placer un symbole spécial. De même, vous pourrez les

raccourcir pour éviter des collisions en situations encombrées, particulièrement dans l’écriture à

plusieurs voix.

Directions des hampes
Croire que l’on puisse choisir 

quelle orientation donner à la 

hampe d’une note isolée sur la 

ligne centrale d’une portée est une 

erreur fréquente. En fait, elle doit 

être orientée vers le bas, sauf si la 

place manque. Remarquez égale-

ment comme les hampes pointent 

vers le haut sur les portées à une 

ligne.

Pour les accords et les groupes de 

notes ligaturées, c’est la moyenne 

des hauteurs qui est détermi-

nante.

A plusieurs voix, toutes les notes 

des voix 1 & 3 ont la hampe vers 

le haut, celles des voix 2 & 4, vers 

le bas, quelle que soit la hauteur.
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Pour ajuster la longueur d’une hampe, tirez son extrémité ou cliquez-la et utilisez les flèches.

Ctrl+3/2 ou X3/2 déplace d’un 1/4 de dent. Il est souvent utile de faire un zoom sur la hampe

pour mieux contrôler l’opération.

Les hampes peuvent être baissées jusqu’à donner l’apparence d’une note sans hampe, mais l’idéal

est d’utiliser directement des têtes de note sans hampe – b 2.25 Têtes de note.

Il est possible aussi d’inverser la hampe en la faisant passer du mauvais côté de la note, mais c’est

sans grand intérêt.

Notes sans hampe
Pour créer des têtes de note sans tête, utilisez la tête de note n°8; sélectionnez le passage dont les

hampes doivent disparaître et tapez Maj+Alt+8 ou xz8 (sur le clavier principal).

Symboles placés sur des hampes
En musique contemporaine, des symboles sont parfois ajoutés aux

hampes pour spécifier des techniques de jeux spéciales ;

b 2.31 Symboles. Cependant, Sibelius positionne et exécute

automatiquement les trémolos et les roulements de tambour;

b 2.34 Trémolos.

Masquer les lignes supplémentaires
Quand on crée des notes au-dessus ou en dessous de la portée, Sibelius

ajoute automatiquement les lignes supplémentaires. Si on veut les

masquer, il a y deux approches possibles: soit une ou plusieurs portées

ne doivent comporter aucune ligne supplémentaire; désactivez l’option

Lignes supplémentaires dans les paramètres du type de portée (b 8.14 Modifier les
instruments); soit on masque les lignes supplémentaires d’un passage spécifique; utilisez un

type de tête de notes dont l’option Lignes supplémentaires est désactivée (b 8.16 Modifier
les têtes de note).

Options des règles de gravure
Dans la page Notes et trémolos de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE) se trouvent quelques options excitantes:

* Lignes supplémentaires x dents d’épaisseur pour changer l’épaisseur des lignes; la valeur par

défaut est de 0.16 dents. Les lignes supplémentaires sont légèrement plus épaisses que les lignes

de portée.

* Les lignes supplémentaires s’étendent au-dessus de la tête de note de plus de x% de
leur largeur pour changer la longueur des lignes supplémentaires pour les notes ; la valeur par

défaut est 28%

* Les lignes supplémentaires s’étendent au-dessus du silence de plus de x% de leur
largeur pour changer la longueur des lignes supplémentaires pour les demi-notes (blanches) et

les silences plus longs ; la valeur par défaut est 28%

Dans la page Ligatures et hampes de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE) se trouvent quelques options encore plus excitantes:

Lignes 
supplémentaires
Les lignes supplémentaires 

de notes successives ne doi-

vent jamais se toucher, 

même si les valeurs de notes 

sont très courtes.

Si cela arrive dans un pas-

sage, sélectionnez-le puis 

augmentez-en légèrement 

l’espace entre les notes.
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* Hampes x dents d’épaisseur permet de modifier l’épaisseur des hampes; la valeur par défaut

est de 0,1 dents

* Longueur minimale x dents permet de spécifier une longueur minimum pour toutes les

hampes, pour empêcher à le raccourcissement des hampes de notes aiguës ou basses quand il y a

deux voix. Par défaut, cette valeur est 2.75.

* Ajuster les ligatures chevauchant les portées et entre les notes garantit que la hampe est

toujours du bon côté de la tête de note. Cette option est activée par défaut, et devrait être

désactivée uniquement pour les partitions créées avec des versions précédentes de Sibelius et

dans lesquelles vous avez ajusté manuellement les hampes qui apparaissaient du mauvais côté de

la tête de note, par ex. dans les ligatures complexes chevauchant les portées.

* Nouvelle règle de longueur des hampes: cette option activée affecte, quelle que soit leur

direction, la longueur des hampes des notes placées sur la ligne centrale de la portée en

l’augmentant d’une valeur de 0,25 dents. Activée par défaut, cette option est appréciée par

beaucoup de graveurs et d’éditeurs.
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2.31 Symboles

b 8.11 Polices musicales, 8.17 Modifier les symboles.

Tous les symboles musicaux standards de Sibelius sont accessibles non seulement via le pavé et les

menus, mais aussi via la grande boîte de dialogue Créer > Symbole qui propose de nombreux

autres symboles. Comme le texte et les lignes, les symboles s’attachent soit à une portée, soit à un

système.

Mais contrairement aux autres objets, les symboles peuvent se positionner n’importe où. Cela per-

met de passer outre à toutes règles de positionnement de Sibelius en plaçant par exemple un sym-

bole tel qu’un dièse n’importe où, même à un endroit insolite où ne figure normalement pas un

dièse.

Le désavantage des symboles par rapport aux autres symboles est leur absence d’intelligence.

Par exemple, si un symbole de dièse est placé devant une note, il ne se déplace pas verticalement si

la note monte ou descend, il n’est pas exécuté et il ne se change pas en bécarre (ou autre) en cas de

transposition. Conclusion: n’utilisez pas un symbole là où un autre objet peut faire l’affaire.

Les symboles sont malgré tout un peu malins – il s’attachent aux portées et aux positions ryth-

miques et donc restent au bon endroit lors de l’extraction des parties séparées (b 8.7 Attaches).

Insérez un symbole
* Sélectionnez la note à côté de laquelle vous souhaitez ajouter un symbole puis choisissez Créer >

Symbole (raccourci Z pour “zymbole”)

* Sélectionnez un symbole dans la boîte de dialogue et, si nécessaire, ajustez la taille du symbole à

l’aide des quatre options de taille. (Les symboles sont réduits automatiquement lorsqu’ils sont

attachés à une portée de petite taille, vous devriez donc normalement laisser la taille sur Nor-
male lorsque vous placez un symbole sur une petite portée.)

* Choisissez si le symbole s’attache à la Portée ou au Système. N’utilisez un symbole de système

que s’il doit apparaître sur toutes les portées lors de l’extraction des parties séparées (par ex. un

point d’orgue au-dessus d’une barre de mesure, ou un symbole de coda ou de segno).
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* Cliquez sur OK et le symbole sera inséré dans la partition à côté de la note sélectionnée. (double-

cliquer sur le symbole dans la boîte de dialogue produit le même effet que cliquer sur OK.)

Vous pouvez également placer les symboles à la souris. Pour faire cela:

* Rien n’étant sélectionné (sinon appuyez sur Échap), choisissez Créer > Symbole

* Sélectionnez un symbole et cliquez sur OK

* Le pointeur de la souris change de couleur, et il vous suffit de cliquer dans la partition pour pla-

cer le symbole.

Les symboles peuvent être copiés et supprimés comme n’importe quel autre objet.

Déplacer les symboles
Il est souvent utile de déplacer très légèrement les symboles à l’aide des flèches; maintenez Ctrl ou

X enfoncé pour augmenter la taille des pas d’exactement une dent. Mise en page > Réinitialiser
les positions (raccourci Ctrl+Shift+P ou xXP) replace un symbole à sa position par défaut. 

Modifier les symboles
Pour en savoir plus sur la modification et la création de symboles, b 8.17 Modifier les sym-
boles.

Exécution des symboles
Les symboles ne peuvent être exécutés, excepté un petit nombre (tels que les “scoops” et les “falls”)

si votre périphérique de lecture le permet. Pour régler l’exécution d’autres symboles en utilisant la

boîte de dialogue Exécution > Dictionnaire – b 4.9 Dictionnaire de l’exécution.

Symboles particuliers
La boîte de dialogue Créer > Symbole est groupée par catégories, et chaque symbole indique son

nom une fois sélectionné dans la boîte de dialogue. Voici quelques symboles moins courants::

Catégorie Symboles Signification

Reprises Répéter le dernier groupe de croches, généralement dans la musique manuscrite; répéter la

dernière mesure; répéter les deux dernières mesures. Comprend également divers symboles

de barre de mesure à utiliser pour les portées aux barres de mesure indépendantes. Deux

types de symbole de coda et de segno sont fournis, dont une paire au design utilisé plutôt au

Japon.

Général Parenthèses à placer autour des symboles (par ex. des altérations, des 8va, des trilles); acco-

lades de clavier; fins de reprises à ailettes / crochets

Ornements Comprend des mordants, des grupetti, etc. non exécutés automatiquement; pour créer des

trilles qui sont exécutés, b 2.21 Lignes; pour l’exécution des mordants et des grupetti,

b 6.1 Travailler avec des extensions. Des symboles d’ornements supplémentaires

se trouvent dans la rangée Plus d’ornements qui se trouve plus bas dans la boîte de dia-

logue (cf. ci-dessous).

Clavier Symboles de pédale pour modifier l’apparence de la ligne de pédale (b 2.21 Lignes);

symboles de talon et pointe pour le pédalier d’orgue (pied gauche et droit

Percussion Ces rangées comprennent la plupart des symboles de la célèbre police Ghent™. La première

rangée comprend les symboles pour divers instruments à percussion.

…baguettes Comprend des baguettes pour divers instruments (celles illustrés à gauche sont des baguettes

respectivement douce, medium et dure)



2. Notations

206

Guitare Comprend des diagrammes d’accord avec différents nombres de cordes; des effets de barre de

vibrato

Articulations Les deux premières rangées sont ordonnées selon la proximité relative de la tête de note (un

point staccato, par ex., est plus près de la tête de note qu’un symbole d’archet tiré); les sym-

boles de la première rangée se placent au-dessus de la note, ceux de la seconde en dessous.

La troisième rangée contient d’autres articulations:

Plusieurs staccatos, à utiliser sur des notes répétées écrites en un trémolo d’une note; pizzi-

cato de Bartók pour instruments à cordes, également parfois dessiné dans l’autre sens

Virgule et coche, indiquant une respiration, généralement dans la musique chorale (la virgule

indique également un court silence pour des instruments comme le piano, qui ne peut pas lit-

téralement respirer); césures en deux épaisseurs différentes

Marques d’accentuation et de non accentuation (au-dessus et en dessous) utilisées par

Schoenberg; staccato en encoche, utilisé quelquefois en musique ancienne

Altérations Les neufs premiers symboles des deux rangées sont classés du plus “bémol” au plus “dièse”, en

comprenant les micro-intervalles; souvenez-vous que, comme il s’agit de symboles, ces alté-

rations ne sont ni transposées automatiquement, ni exécutées. Utilisez donc une altération

normale quand c’est possible.

Des symboles alternatifs pour les micro-intervalles sont disponibles dans la rangée Plus
d’altérations qui se trouve plus bas dans la boîte de dialogue.

Notes Ces notes ne sont pas utilisées par Sibelius pour dessiner des notes ordinaires; elles sont

fournies pour le cas où vous souhaiteriez écrire des notes à des endroits tout à fait insolites.

Sibelius dessine ces notes à l’aide d’une tête de note (de la rangée Têtes de note) et d’un cro-

chet (de la rangée Notes) pour les valeurs courtes.

Les passionnés de crochets souhaiteront peut-être examiner de plus près comment sont con-

struits les crochets de double croches et de notes plus courtes: la partie du crochet près de la

tête de note en est légèrement plus incurvée. (Les non-passionnés n’y verrons aucun intérêt)

Barré de note ornementale pour les hampes d’acciacatura; symbole de liaison laissez vibrer

(dans certaines circonstances préférable à l’utilisation d’une vraie liaison) qui peut également

être utilisé pour des liaisons vers des 2des fins (secunda volta) et des codas; trait de trémolo;

point rythmique

Symbole de cluster; en en superposant plusieurs, vous pouvez créer un accord en cluster de

n’importe quelle taille

Têtes de note Pour modifier une tête de note, n’utilisez pas un symbole – b 2.25 Têtes de note.

Comprend également un symbole de “tige” pour les unissons altérés –

b 2.1 Altérations. Plus de symboles moins fréquents de têtes de notes pour la musique

d’avant-garde et moderne sont disponibles dans la rangée Autour des têtes de note pro-

posée plus bas dans la boîte de dialogue.

Les silences Tous les silences standards, y compris les symboles de mesure à compter en style ancien;

comprend également les composants des barres en H – b 2.24 Mesures de
comptage

Catégorie Symboles Signification

bémol de 1 ½ demi-tons

bémol de 1 1/4 demi-tons, ou parfois bémol de 1 ½ demi-tons

bémol de 1/2 demi-ton

bémol de 1/4 demi- -tons ou bémol de 1/2 demi-ton

dièse de 1/4 demi-ton ou bémol de ½ demi-ton

dièse de ½ demi-ton

dièse de 1 1/4 demi-tons ou parfois dièse de 1 1/2 demi-tons

dièse de 1 ½ demi-tons
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Direction Placez ces symboles à l’extrémité droite d’une portée (en musique chorale, par ex.) pour indi-

quer qu’elle va se diviser au système suivant. Ils peuvent dépasser dans la marge droite de la

page. Vous pouvez également utiliser les flèches individuellement, en les pointant dans l’autre

sens pour indiquer que deux portées vont se joindre à nouveau.

Battue, battue de main gauche, de main droite, longue. Le symbole à l’extrême gauche est le

seul standard; les autres sont utilisés occasionnellement (par Lutoslawski par ex.) selon

diverses significations. Dans le conducteur elles indiquent au chef comment battre la mesure

aux endroits délicats; dans les parties séparées elles signalent aux musiciens l’existence d’une

battue.

Double et triple battues (pour un seul temps, utilisez l’une des flèches ci-dessus ou un simple

ligne verticale). Placées au-dessus de certains passages elles indiquent comment le chef va

battre en représentant le mouvement de la baguette. On en trouve par ex. dans Le Marteau

sans maître de Boulez. Le jeu de dessous est pour les mesures composées. Des symboles sup-

plémentaires sont proposés dans la rangée Plus pour la direction située plus bas.

Clés Comprend toutes les clefs standards – b 2.11 Clés. Le 8 et le 15 sont des symboles

séparés (à droite dans la seconde rangée) que vous pouvez modifier afin de modifier toutes

les clefs appropriées en une fois. Des clés moins courantes clefs (par exemple tête en bas ou

inversée) sont proposées dans la rangée Plus de clés proposée plus bas dans la boîte de dia-

logue.

Octavas Utilisés pour des lignes d’8va etc. – b 2.21 Lignes

Marques de 
mise en page

Utilisées par Sibelius pour afficher les pages/sauts etc. – elles sont rarement nécessaires.

Techniques Cette rangée contient une myriade de symboles inhabituels et excitants:

“Lift” (doit) et “fall” pour la notation jazz; sourdine, pour les instruments à cordes

Doigtés d’instruments à vent: ouvert, demi-ouvert et fermé

À attacher à la hampe d’une note ou d’un accord. Ils signifient: chuchoté ou sprechstimme; sif-

flement (ou une action équivalente sur des percussions); sul ponticello (sur le chevalet);

“buzz” de harpe (lors d’un changement de pédale, et que la corde concernée vibre), aussi ut-

lisé par Penderecki pour noter un trémolo de cordes non mesuré joué le plus vite possible.

Une hampe avec une indication en “z” légèrement différente est disponible sur le troisième

pavé.

Courbes de crescendo “exponentiel” pour des soufflets de crescendo longs ou courts -

b 2.17 Soufflets.

Accordéon Pour l’’accordéon, 25 diagrammes d’accouplement pour la clé de sol et 21 pour la clé de fa,

plus des diagrammes vides et des éléments superposables pour créer plus de combinaisons

Cloches Tous les symboles utilisés couramment dans la musique pour cloches manuelles sont ici

Plus
d’ornements

Plus de 50 symboles d’ornement supplémentaires, dont pincé, secoué, port de voix, cadence,

cadence coupée, etc., dans pas moins de 4 rangées.

Clusters Symboles pour des clusters en note noire ou blanche en intervalles de la seconde à l’octave.

Hampes 
spéciales

Assortiment de symboles de hampe alternatifs à utiliser avec des notes sans hampe; ils

indiquent différentes techniques de jeu.

Prolations Symboles pour le tempus perfectus, tempus imperfectus, prolatio perfectus (prolation majeur),

prolatio imperfectus (prolation mineure), etc. pour les éditions de musique médiévale.

Divers Des symboles de ligne supplémentaire de largeur différente (normal, ronde, note de réplique)

sont proposés; les aligner sur les lignes de portées en garantit le positionnement correct

Noms des 
notes

Têtes de note spéciales qui affichent le nom des notes à l’intérieur des têtes de note. Pour les

utiliser, b 6.8 Autres extensions.

Catégorie Symboles Signification
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2.32 Liaisons rythmiques

Les liaisons rythmiques sont utilisées pour indiquer que des notes de même hauteur sont reliées

les unes aux autres pour former une note plus longue. La dernière note et toute note centrale qui

existerait n’est pas rejouée. Les liaisons rythmiques sont différentes des liaisons de phrasé, utilisées

pour indiquer des phrases ou, dans le cas d’instruments à archet ou à vent, pour indiquer les notes

à jouer en un coup d’archet ou dans une seule respiration – b 2.28 Liaisons de phrasé.

Liaisons rythmiques et liaisons de phrasé
N’utilisez jamais une liaison de phrasé à la place d’une liaison rythmique; malgré une apparence

similaire, les liaisons de phrasé ne se comportent pas du tout comme les liaisons rythmiques en cas

d’exécution ou de transposition. De même, évitez une liaison rythmique à la place d’une liaison de

phrasé, car lors de l’exécution une note liée à rien (ni note, ni silence) est tenue indéfiniment.

Création des liaisons
Les liaisons rythmiques sont créées avec premier pavé. Il suffit de sélectionner une note et de

choisir la touche du premier pavé (raccourci Entrée). Pour ajouter une liaison à toutes les notes

d’un accord en une fois, faites un double-clic sur une des notes (ou choisissez Édition >

Sélectionner > Sélectionner Plus, raccourci Ctrl+Maj+A ou xXA) avant de sélectionner la

liaison sur le pavé.

Il est possible de modifier la taille et la position des liaisons de plusieurs manières:

* Pour inverser une liaison, sélectionnez-la et choisissez Édition > Retourner (raccourci X); Pour

rétablir la position originale d’une liaison, choisissez Mise en page > Rétablir l’aspect original
(raccourci Ctrl+Shift+P ou xXP)

* Sélectionnez soit une des extrémités (utilisez Alt+0/1 ou z0/1 pour sélectionner l’une des

extrémités) et déplacez-la ou tapez Maj+Alt+0/1 ou xz0/1; appuyez sur Ctrl ou X pour un

déplacement plus rapide. Quoiqu’il arrive, la liaison reste toujours horizontale et symétrique.

* Pour ajuster la position des extrémités des liaisons et leur cambrure utilisez le panneau Notes
de la fenêtre des propriétés (b 5.17 Propriétés). Pour les ajuster dans toute la partition cf.

Options des règles de gravure ci-dessous.

* Le milieu de la liaison peut être sélectionné et déplacé avec la souris (ou avec les 3/2) pour en

modifier le degré de courbure

* Pour rétablir l’aspect initial d’une liaison après en avoir modifié la cambrure, choisissez Mise en
page > Rétablir l’aspect original (raccourci Ctrl+Shift+D ou xXD).

Liaisons interrompue par un saut
Si une liaison traverse une page ou un saut de système, la liaison sera tirée en deux segments,

chacune ressemblant à une liaison complète. Vous pouvez ajuster les deux points d’extrémité et la

courbe de chaque segment de la liaison indépendamment de l’autre, mais retenez que vous ne

pouvez déplacer aucun segment de la liaison verticalement sans également déplacer l’autre

segment.
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Si vous préférez afficher les liaisons au-dessus des sauts en une seule liaison divisée, activez

Rogner en fin de système dans la page Liaison 1 de la boîte de dialogue Style maison > Règles
de gravure.

Liaisons sur les changements d’indication de mesure
Pour certaines publications musicales, si une liaison traverse un changement d’indication de

mesure, la liaison est rompue de chaque côté de l’indication de mesure. Pour cette opération,

consultez Utiliser des couches pour rompre des liaisons sur les indications de
mesure à la page 482.

Liaisons de Laissez vibrer
Dans l’écriture pour la percussion ou le piano, on peut créer un effet de laissez vibrer en liant une

note ou un accord à un silence de la manière normale (Entrée sur le clavier numérique) pour

indiquer que l’accord ou la note est tenu jusqu’à la fin. Lors de l’exécution, cet effet fonctionne aussi

(par l’envoi d’un NoteOn et pas d’un NoteOff); le résultat sonore (particulièrement si la note est

rejouée) dépendra du niveau de sophistication de la carte son ou du périphérique MIDI utilisé

pour l’exécution. Si le résultat ne vous plaît pas, utilisez à la place les symboles de laissez vibrer

proposés dans les rangées Notes de la boîte de dialogue Créer > Symbole (raccourci Z).

Les liaisons rythmiques dans les arpèges
Dans la musique à clavier et pour harpe, des cas comme celui illustré à

droite sont assez courants. Pour réaliser cela, il suffit de saisir les notes

comme d’habitude, en ajoutant à chacune une liaison. Il suffira après d’

en étirer l’extrémité avec la souris jusqu’à la note suivante.

Ayez à l’esprit que Sibelius ne “sait” pas que ces liaisons doivent rester attachées à la seconde note,

si bien qu’en cas de changement de mise en page ou d’espacement, l’ajustement n’est pas

automatique. Il est donc préférable de réaliser l’étirement une fois la mise en page terminée.
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Notes liées début d’un secundo
Quand la première note d’une mesure de secundo est la seconde note

liée à une précédente jouée, la liaison rythmique doit apparaître au

début de mesure. Pour cela, utilisez les symboles de laissez vibrer

mentionnés ci-dessus, ou une liaison non magnétique

(b 2.28 Liaisons de phrasé), même si aucune de ces méthodes

ne permet une exécution correcte.

Options des règles de gravure
Un groupe stupéfiant d’options figurent dans les pages Liaisons 1 et

Liaisons 2 de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE). La plupart de ces options sont

indisponibles si Règle de position des liaisons de Liaisons 1 est

réglé sur Liaisons en mode Optical. À moins d’avoir une bonne

raison de ne pas le faire, utilisez les liaisons en mode Optical.

Voici les autres options de Liaisons1:

* Les réglages sous Forme déterminent l’importance de la cambrure à

donner aux liaisons. On peut considérer la cambrure comme le

contraire de l’incurvation de la liaison: plus la cambrure est élevée

plus les liaisons sont aplaties. Sibelius peut automatiquement

augmenter la cambrure, pour éviter que les liaisons ne soient trop

incurvées.

* Normalement, les liaisons rythmiques qui enjambent un saut de système ou de page figurent

comme deux liaisons complètes de part et d’autre du saut. Si vous préférez qu’apparaissent

plutôt les deux moitiés de la liaison, activez Rogner en fin de système.

* Les options dans Epaisseur vous permettent de spécifier l’épaisseur de bordure par défaut et

l’épaisseur intermédiaire des liaisons, de la même manière que pour les liaisons de phrasé

(b 2.28 Liaisons de phrasé).

* Liaisons au-dessus/en dessous du côté de la tête de notes détermine si les liaisons qui

s’incurvent à l’opposé des hampes (plutôt que du même côté), se placeront entre les têtes de note,

au-dessus ou en dessous. Par défaut, Sibelius dessine les liaisons de notes isolées au-dessus ou en

dessous (l’option Utiliser avec des notes individuelles est activée), et les liaisons d’accords

entre les têtes de note (l’option Utiliser avec les accords est désactivée). Les autres options de

cette section permettent de spécifier la distance de la liaison par rapport à la tête de note pour les

cas où elles se trouvent au-dessus ou en dessous.

Les options de Liaisons 2 sont de la même veine:

* Liaisons vers le haut/vers le bas du côté de la hampe détermine si les liaisons doivent se

positionner ou non en fonction de l’orientation de la hampe, spécialement quand elles

s’incurvent du côté de la hampe, ce qui arrive fréquemment dans l’écriture à 2 voix. Certains

éditeurs préfèrent que la liaison la plus intérieure (c-à-d la plus proche de l’extrémité des

hampes) soit positionnée un peu plus haut que la normale, si bien qu’elle paraît un peu plus

longue. Les réglages par défaut de Sibelius sont conçus pour que les liaisons soit aussi

Positionnement des 
liaisons rythmiques
Malgré leur ressemblance, les 

liaisons rythmiques et les liai-

sons de phrasé observent des 

règles de gravure différentes 

pour leur positionnement.

Les liaisons rythmiques sont 

plus fines que les liaisons de 

phrasé et leurs extrémités se 

placent à proximité des têtes de 

note et jamais du côté des 

hampes.

Pour que les liaisons soient 

bien visibles, leurs extrémités et 

le point central de l’arc doivent 

éviter de toucher une ligne de 

portée.

Si des liaisons figurent ensem-

ble avec des liaisons de phrasé, 

les liaisons doivent toujours 

être positionnées au plus près 

des notes.
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symétriques que possible; les accords ne sont donc pas traités spécifiquement (l’option Utiliser
avec les accords est désactivée), mais les liaisons sur les notes isolées peuvent être déplacées

(l’option Utiliser avec des notes individuelles est activée), en utilisant les autres options qui

permettent de spécifier la distance verticale et horizontale dont la liaison la plus à l’intérieure

sera déplacée.

* Liaisons entre les notes sont les options qui s’appliquent quand les liaisons ne sont pas

positionnées au-dessus ou en dessous de la tête de note, ou quand elles ont été déplacées suite au

réglages de Liaisons vers le haut/vers le bas du côté de la hampe. Vous pouvez déterminer

la manière dont Sibelius décide de l’orientation de la courbure des liaisons dans les accords et

spécifier comment Sibelius doit positionner les extrémités gauche et droite des liaisons. Comme

mentionné plus haut, les réglages de Sibelius sont conçus pour que les liaisons soient

symétriques, de sorte que les deux options Aligner les extrémités gauche des liaisons entre
les accords et Aligner les extrémités droites des liaisons entre les accords sont activées

par défaut, pour que les liaisons restent lisibles (surtout si elles se conjuguent aux options

Dimension (en dent) des liaisons – cf. ci-dessous) même dans les accords complexes où

figurent des secondes et des clusters.

Les liaisons commencent après les points rythmiques agit comme son intitulé le suggère et

est activé par défaut (bien que les liaisons placées par contrainte du côté de la hampe ne

commencent pas après le point rythmique, mais plutôt au-dessus et même un peu à gauche).

Les autres options permettent de contrôler précisément les distances que Sibelius utilisera pour

positionner les liaisons entre les notes et les accords.

* Dimension (en dent) des liaisons détermine si l’option De préférence une dent par liaison
doit être suivie ou non. Cette option est utile pour éviter des collisions dans les accords dont

deux notes aux moins forment des clusters ou un intervalle de seconde. Si cette option est

activée, Sibelius va faire en sorte qu’une seule liaison soit contenue dans une dent de large sur la

portée, et déplacera les autres liaisons d’après les valeurs définies dans les deux options

Maximum. Il est préférable que le maximum soit 1 pour la position au-delà de la tête de note la

plus haute de l’accord, mais il peut être plus élevé pour la position du côté des hampes (La valeur

de Sibelius par défaut est 2).

Si des sentiments divers vous animent concernant le positionnement des liaisons, nous vous

encourageons à expérimenter ces réglages pour déterminer la meilleure combinaison possible

correspondant à vos goûts. Une fois ces options déterminées précisément, la nécessité d’un réglage

manuel devrait se faire assez rare (mais si cela arrive, utilisez le panneau Notes de la fenêtre des

propriétés).
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2.33 Indications de mesure

Créer des indications de mesure
* Sélectionnez une note, un silence, une ligne ou un autre objet dans la partition

* Choisissez Créer > Indications de mesure (raccourci T) et cliquez sur l’indication de mesure

désirée ; cliquez sur Autre et utilisez la liste déroulante pour créer des indications de mesure

plus compliquées

* Cliquez OK ou tapez Entrée; l’indication de mesure est créée au début de la mesure suivante.

Pour créer une indication de mesure au début d’une partition le plus simple consiste à la choisir

dans la boîte de dialogue Fichier > Nouveau au moment de créer la partition. Pour la créer ou la

modifier ultérieurement, assurez-vous que rien ne soit sélectionné (tapez Esc), puis choisissez

Créer > Indication de mesure, sélectionnez-y l’indication de mesure souhaitée et cliquez sur OK.

Le pointeur de la souris change alors de couleur pour indiquer qu’il “contient” un objet ; cliquez au

début de la partition pour placer l’indication de mesure initiale.

Les anacrouses (ou mesure de levée)
Si la partition commence avec une mesure d’anacrouse (ou de levée), le plus simple consiste à le

spécifier au moment de la création de l’indication de mesure initiale. Cliquez sur Commencez
par une mesure contenant dans la boîte de dialogue Créer > Indication de mesure, et choisissez

la longueur de la mesure dans la liste des valeurs proposées, ou tapez-la sur le pavé numérique

(avec Verr Num activé). Vous pouvez choisir plus qu’une seule valeur de note si la mesure

d’anacrouse est d’une longueur équivalente par exemple à une noire plus une croche.

Remarquez que les mesures d’anacrouse affichent correctement le nombre de temps de la mesure

avec des silences, répartis selon les réglages de Groupements de ligature (notes et silences)
établis lors de la création de l’indication de mesure.

Si vous oubliez de créer la mesure d’anacrouse à ce moment, il sera possible de la créer comme

mesure irrégulière plus tard – b 2.5 Mesures et mesures de silences.

Quand une partition commence avec une mesure d’anacrouse, l’usage est de commencer la

numérotation des mesures à partir de la première mesure complète. Sibelius lui attribuera

automatiquement le numéro 1, tandis que la mesure d’anacrouse recevra le numéro 0.

Modifier la répartition rythmique des mesures
Quand on installe une indication de mesure à un endroit contenant déjà de la musique, Sibelius va

répartir le contenu rythmique des mesures existantes dans des nouvelles mesures, et installer si

nécessaire des liaisons rythmiques entre les nouvelles mesures formées, sauf si vous avez désactivé

l’option Réécrire les mesures jusqu’au changement de mesure suivant dans Créer >

Indication de mesure.

Sibelius ne change la répartition des mesures que jusqu’au changement de mesure suivant, s’il

existe. Cependant, si vous avez commencé par sélectionner un passage avant de créer une

indication de mesure, Sibelius restaurera l’indication originale à la fin de la sélection et réécrira la
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musique seulement à partir de cet endroit. Il s’agit de quelque chose de très utile quand il faut

modifier la répartition rythmique de quelques mesures au milieu d’une partition.

Bien que ce soit fort improbable, il se peut que parfois quelques mesures d’une partition ne

correspondent pas à l’indication de mesure placée en leur début. Voici comment faire pour les

réorganiser afin de respecter l’indication : sélectionnez l’indication de mesure et supprimez-la.

Il vous sera alors demandé si les mesures doivent être réécrites ; Cliquez sur Non puis

réintroduisez la même indication de mesure en vous assurant que Réécrire les mesures jusqu’au
changement de mesure suivant est activé.

Indications de mesure de précaution
Annoncer le changement de mesure à la fin du système précédent est une option qui annonce

l’indication de début de système en l’installant également en fin du système précédent. Cette

option devrait être désactivée uniquement si l’indication figure au début d’un nouveau morceau,

d’une chanson ou d’un mouvement d’une partition assez longue. (comme on le fait aussi pour les

armures et les clefs.)

Indications de mesure complexes
Pour créer une indication de mesure non reprise parmi les plus courantes proposées dans la boîte

de dialogue Créer > Indications de mesure, cliquez sur Autre et choisissez dans les listes

déroulantes les nombres souhaités.

Si le “numérateur” doit apparaître sous la forme d’une addition comme par exemple dans la

mesure 3+2+2/8, tapez 3+2+2 dans le cadre de la liste supérieure plutôt que de la dérouler. Sous

Mac, vous devez utiliser la touche + du clavier numérique et non du clavier principal.

Éventuellement, si l’indication de mesure doit s’écrire 7/8 et qu’en plus la répartition 2+2+3 (ou

tout autre texte) doit figurer dans la même police et au-dessus de l’indication de mesure, utilisez le

style de spécial Indication de mesure; cf. Plusieurs indications de mesure ci-dessous.

Groupements de ligature (notes et silences)
Sibelius gère automatiquement la manière de grouper les ligatures pour chaque indication de

mesure créée. Il est possible, cependant, d’effectuer les réglages en cliquant sur Groupements de
ligature (notes et silence) dans la boîte de dialogue Créer > Indications de mesure, et de les

modifier dans une partition en cours dans la boîte de dialogue Notes > Réinitialiser le
groupement des ligatures. Pour en savoir plus, b 2.6 Groupement des ligatures.

Mesures irrégulières et rythme non mesuré
Pour créer des mesures de longueur irrégulière (c’est-à-dire d’une longueur différente de celle de

qui respecterait l’indication de mesure), b 2.5 Mesures et mesures de silences.

Pour d’autres situations de rythme non mesuré, b 2.13 Rythme non mesuré.

Plusieurs indications de mesure
Dans certaines partitions il arrive parfois que deux indications de mesure figurent dans la même

mesure sur des portées différentes, par exemple 2/4 contre 6/8. Pour résoudre ce type de situation:

* Créez une indication de mesure de 2/4 et procédez à la saisie normalement
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* Entrez le passage en 6/8 sous forme de triolets de croches et pour le premier triolet au moins

utilisez la boîte de dialogue Créer > Multiplet, activez Aucun élément et désactivez Crochet,

pour qu’il soit impossible de voir qu’il s’agit de triolets

* Copiez rapidement cette mesure de 6/8 avec son schéma rythmique sur les suivantes

* Quand toute la musique a été saisie, supprimez l’indication 2/4 et déplacez la première note vers

la droite de manière à ne pas laisser vide l’espace qu’occupait le 2/4

* 2/4 et 6/8 seront maintenant entrés sous forme de texte ; en veillant que rien ne soit sélectionné,

utilisez Créer > Texte > Texte spécial > Indications de mesure (une portée seulement)

* Cliquez sur l’endroit où doit se placer l’indication de mesure, tapez le chiffre supérieur, puis

Retour (sur le clavier principal) et le chiffre inférieur.

Dans les cas où deux (ou plusieurs) indications de mesure avec des longueurs de mesure différentes

sont nécessaires, telles que 4/4 et 5/4 :

* Calculez le plus petit commun multiple entre les deux métriques - dans le cas présent, 20/4 - et

insérez cela comme indication de mesure

* Lorsque toute la musique a été saisie, supprimez l’indication de mesure 20/4 et tirez la première

note vers la droite jusqu’à ce qu’il y ait assez de place pour une indication de mesure de

remplacement

* Entrez le 4/4 et le 5/4 en utilisant du texte - vous aurez besoin, pour faire cela, de créer un

nouveau style de texte (cf ci-dessus)

* Ajoutez les barres de mesure supplémentaires à l’aide de la ligne verticale de la boîte de dialogue

Créer > Ligne.

Cette méthode a l’avantage d’assurer que les barres de mesure coïncident à la fin d’un système.

Si plusieurs indications de mesure simultanées ont des barres de mesure à différents endroits,

adoptez la même procédure mais supprimez les barres de mesure sur une portée (consultez

Masquer les barres de mesure de portées spécifiques dans b 2.4 Barres de
mesure), puis utilisez la ligne verticale du panneau Lignes de portée de la boîte de dialogue

Créer > Ligne pour dessiner les barres de mesure où vous les souhaitez.

Indications de mesure alternées
Pour écrire une indication de mesure composite telle que par exemple 2/4 3/4 pour de la musique

alternant entre 2/4 et 3/4 :

* Entrez une indication de mesure 2/4 et copiez-la dans les mesures alternées

* Faites la même chose avec 3/4 dans les mesures restantes

* Faites la saisie de la musique

* Supprimez ensuite toutes les indications de mesure à l’exception du 2/4 initial (en répondant

Non lorsqu’il vous est demandé si vous souhaitez réécrire la musique)

* Ecrivez finalement une indication de mesure 3/4 immédiatement après le 2/4 initial de la façon

décrite plus haut dans Plusieurs indications de mesure ci-dessus.
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Modifier des indications de mesure
Vous pouvez copier et supprimer les indications de mesure de la même manière que les autres

objets. Vous pouvez également les déplacer vers la gauche ou vers la droite en les tirant à la souris -

et cela même dans des endroits insolites. Nous ne recommandons toutefois pas de les déplacer en

dehors de la mesure à laquelle elles appartiennent

Indications de mesure géantes, etc....
Les grandes indications de mesure placées entre les portées sont souvent utilisées dans les

partitions de musique contemporaine quand la métrique change fréquemment.

Sur la page Indications de mesure de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE), cliquez soit sur Indication de mesure (grande) ou même sur

le plus grand encore Indication de mesure (géante). En réalité, ce sont des styles de texte que les

indications de mesure peuvent utiliser à la place. Ces styles de texte affectent toutes les indications

de mesure de la partition.

Pour modifier la taille, la police ou la position des grandes indications de mesure, cliquez sur

Modifier le style de texte; b 3.9 Modifier les styles de texte. Cela vous permet également

de préciser au-dessus de quelles portées se placent les grandes indications de mesures.

L’autre option très attractive présente dans Style maison > Règles de gravure vous donne la

possibilité d’ajuster l’espace par défaut avant les indications de mesure.
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2.34 Trémolos

b 2.26 Percussion.

On désigne par trémolos un groupe de notes répétées très rapidement. Un trémolo d’une note est la

répétition d’une seule note; un trémolo de deux notes est la répétition de deux notes jouées en

alternance; un roulement est une sorte spéciale de trémolo utilisée pour les percussions à sons

indéterminés.

Trémolos d’une note
Les trémolos d’une note se notent avec des barres sur la hampe de la

note ou de l’accord, par exemple.

Pour écrire ceci, choisissez le nombre de barres dans le troisième

pavé (soit avant, soit après avoir créé la note).

Pour ajouter des trémolos à une note ou à un accord après l’avoir

créé, sélectionnez la note ou l’accord et choisissez le nombre de

barres dans le troisième pavé (tapez 1/2/3/4/5 pour 02/01/03/4/5

barres).

Les trémolos s’enlèvent en appuyant sur le même bouton du pavé.

Le nombre de répétitions d’un trémolo d’une seule note est parfois

indiqué au moyen de plusieurs staccatos placés au-dessus de la note,

en plus des barres de la hampe. Un groupe de staccatos sera créé

comme symbole – b 2.31 Symboles.

Trémolos de deux notes
Les trémolos de deux notes s’écrivent avec des barres similaires aux ligatures placées entre les notes

et les accords, par exemple.

Sélectionnez la première note ou le premier accord et choisissez simplement le nombre de

barres souhaitées sur le premier pavé (tapez 1/2/3/4/5 pour 02/01/03/4/5 barres), cliquez

ensuite sur le bouton de trémolo de deux notes affiché ci-contre (raccourci Entrée).

La même opération peut être faite avant ou après avoir créé la seconde note.

Chacune des notes est écrite avec la durée complète du

trémolo, ce qui en double la valeur écrite. Cette opération est

automatique dans Sibelius. Pour écrire un trémolo de deux

notes qui dure une blanche, écrivez deux noires et utilisez le

troisième pavé pour ajouter le trémolo:

Trémolos d’une note
Ajouter une barre de trémolo à 

une noire ou à une note plus 

longue indique qu’elle doit être 

jouée comme deux croches. 

Ajouter deux barres indique 

qu’elle doit être jouée comme 

quatre doubles croches, etc.... 

Trois ou quatre barres sont aussi 

utilisées pour indiquer que la 

note doit être répétée aussi vite 

que possible (trémolo “non 

mesuré”), par exemple pour 

indiquer un roulement de tam-

bour.

Sur une croche ou une valeur 

plus courte, une barre indique 

qu’elle doit être divisée en deux, 

deux barres une division en 4, 

etc....

Trémolos de deux notes
Les barres placées entre deux notes 

ou deux accords indiquent qu’ils 

doivent se répéter en alternance. 

Le nombre de barres signifie exacte-

ment la même chose que pour les 

trémolos d’une note.
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Les trémolos se désactivent en choisissant sur le pavé les mêmes boutons utilisés pour les créer.

Les trémolos de deux notes peuvent être écrits entre les portées (l’une des deux notes étant placée

sur l’autre portée – b 2.7 Positions des ligatures), et à travers les barres de mesure.

L’inclinaison de la barre d’un trémolo de deux notes se règle en modifiant la longueur des hampes.

Si le trémolo de deux notes s’applique à deux rondes, c’est la barre elle-même que l’on peut déplacer

(l’effet produit est identique à celui qui serait appliqué à la hampe de la première note, si elle

existait !)

La page Notes et Trémolos de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Shift+E ou xXE) propose trois options de présentation des trémolos de deux notes, qui

devrait satisfaire toute velléité de changement:

Le roulement (Z sur la hampe)
Les roulements sont notés en ajoutant le symbole Z (illustré à droite) sur la hampe d’une

note ou d’un accord; utilisés dans l’écriture des percussion ils indiquent un roulement qui

résulte d’une frappe répétée. Pour ajouter un roulement à une note ou un accord juste créé,

sélectionnez-la/le et sur le troisième pavé (raccourci F9), tapez 6. Sibelius exécute les

roulements aussi vite que les trémolos. b 2.26 Percussion.

Les tribulations de l’écriture des trémolos
La pratique étrange qui consiste à doubler la valeur des notes trémolos de deux notes a entraîné

l’apparition de diverses anomalies.

Au XIXème siècle, une convention un peu stupide consistait à doubler la valeur des notes

uniquement si le trémolo durait au moins une noire. Donc seules des croches et des blanches

pouvaient recevoir des trémolos mais jamais les noires. De quoi devenir nerveux !

Cependant, une autre particularité a survécu jusqu’à nos jours: pour écrire un trémolo de deux

notes qui dure deux mesures de 4/4, il convient d’écrire une ronde dans chaque mesure avec le

trémolo à travers la barre de mesure plutôt que d’utiliser des carrées (double rondes). La plupart

des gens vivent sans connaître cette exception mystérieuse - ils ne connaissent pas leur bonheur.

Avant Aprés

Entre les hampes Touchant les hampes Hors trémolo
touchant les hampes
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2.35 Triolets et autres multiplets

b 5.7 Rechercher et filtrer, 5.9 Masquer des objets.

“Multiplet” désigne un groupe de notes comme le triolet dont les valeurs sont moindres que la

normale.

(Multiplet est un néologisme, d’un usage plus pratique que groupes irréguliers, et plus élégant que

nolet, dont le seul mérite est d’offrir une rime plus riche avec duolet, triolet, etc...)

Méthode rapide pour créer les multiplets
* Entrez ou sélectionnez une seule note qui sera la

première du multiplet et dont la valeur en deviendra

l’unité (cf. l’encadré).

Si par exemple, le triolet équivaut à la valeur d’une

blanche, la première note à entrer sera une noire.

* Tapez Ctrl+3 ou X3 pour obtenir un triolet, multiplet le

plus fréquent, ou Ctrl+2–9 ou X2–9 pour obtenir tous

les autres multiplets

* Le multiplet apparaîtra, complété par les silences

adéquats. Ajouter les notes normalement.

Pour déterminer la présentation du multiplet et les options

concernant le crochet, utilisez la boîte de dialogue Créer >

Multiplet(cf. Méthode lente pour créer les
multiplets ci-dessous ).

Méthode lente pour créer les multiplets
* Entrez ou sélectionnez une note qui sera la première du multiplet et dont la valeur deviendra

l’unité

* Choisissez Créer > Multiplet

* Tapez un nombre ou un rapport, même complexe (par exemple 13, ou 99:64)

* Cliquez sur Nombre pour écrire un nombre uniquement (ou le premier nombre d’un rapport),

Rapport pour écrire un rapport (par exemple 5:3), Rapport+note pour écrire par exemple

5:3x, et Aucun élément si rien ne doit être mentionné

Multiplets à un chiffre
Le cas le plus simple est le triolet; un 3 

placé au dessus de q�q�q�signifie 3 

noires à jouer dans le temps de 2. La 

noire est l’unité du multiplet dans ce cas.

Si d’autres chiffres que 3 sont utilisés, on 

considère que la durée correspond à la 

valeur inférieure la plus proche obtenue 

en puissance de 2; donc 5 signifie 5 dans 

le temps de 4, 15 signifie 15 dans le 

temps de 8, etc... Les exceptions à cette 

règle sont 2 et 4, 2 dans le temps de 3 et 

4 dans le temps de 6.

Si de nombreux triolets se succèdent, 

souvent le 3 n’apparaît qu’au-dessus du 

premier. Evidemment si toute la parti-

tion est écrite comme cela, mieux vaut 

envisager de changer de métrique !
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* Par défaut, Sibelius crée les multiplets avec l’option Crochet
automatique activé; cela signifie que le crochet disparaît si

une ligature joint toutes les notes comme l’aurait fait le

crochet. Si malgré tout, vous souhaitez contrôler si le

multiplet doit recevoir ou non un crochet, choisissez une des

autres options.

* La durée des multiplets est configurée par défaut sur

Etendre jusqu’à la dernière note du multiplet. Ainsi,

l’extrémité droite du crochet (si indiqué) sera positionnée à

droite de la hampe si elle se trouve à l’extrémité, ou bien

alignée au niveau du bord droit de la tête de note si elle se

trouve à l’extrémité de cette dernière. Si vous souhaitez que le

crochet du multiplet s’étende davantage, choisissez plutôt

Etendre jusqu’à la première note après le multiplet.

* Cliquez sur OK; le multiplet apparaîtra et vous pourrez introduire normalement les notes pour

le compléter.

Modifier les multiplets
Un certain nombre d’extensions est destiné à l’édition des multiplets – cf. b 6.14 Extensions de
multiplets pour en savoir plus.

Copier des multiplets
Copier le crochet ou le nombre d’un multiplet sur une autre note la transforme en un élément d’un

nouveau multiplet.

Il est possible bien sûr, de copier des passages contenant des multiplets. La seule chose impossible

à faire est la copie d’un passage contenant une partie de multiplet, comme la première note, car

une telle portion de rythme isolée n’a pas beaucoup de sens. Si un avertissement soudain s’affiche

vous informant que vous tentez de copier un fragment de multiplet, il faudra recommencer

l’opération en veillant à ce que le nombre et/ou le crochet soient copiés avec toutes les notes.

Supprimer des multiplets
Pour supprimer un multiplet, sélectionnez-en le nombre ou le crochet et tapez Suppr. Cette action

supprime non seulement le nombre mais aussi les notes puisque sans multiplet la valeur des notes

serait trop longue.
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Choisir la valeur de l’unité
Parfois la première note d’un multiplet n’a pas la même valeur

rythmique que l’unité: un triolet d’une longueur de trois noires

peut commencer par une croche, par exemple. Si c’est le cas, on

entrera la première note en lui attribuant la valeur de l’unité

(dans le cas présent une noire) afin que Sibelius puisse

déterminer la longueur du multiplet, puis on entrera le multiplet

et enfin on modifiera la première note pour qu’elle reçoive sa

valeur exacte (dans le cas présent une croche).

Multiplets spéciaux
Certains multiplets mentionne un nombre qui n’a pas la

signification normale; par exemple, en 6/8, on pourra rencontrer

ceci:

Le rapport est de 7:6. Pour obtenir ceci, utilisez la boîte de

dialogue Créer > Multiplet, tapez 7:6 (pour que Sibelius

comprenne de quel multiplet il s’agit), et réglez Présentation sur

Nombre (pour que seul le 7 ne soit écrit).

Certains compositeurs écrivent 7 pour 7:8 et 15 pour 15:16, car la

valeur du second nombre est beaucoup plus proche du nombre

joué que dans la notation standard. Pour transcrire cela,

choisissez un rapport, par exemple 7:8 et réglez Présentation
sur Nombre.

Déplacer les multiplets
Sibelius décide si le multiplet se place au-dessus ou en dessous des notes et selon quel angle. Les

crochets et les numéros de multiplet se situent au-dessus des notes par défaut, à moins que les

hampes de toutes les notes du multiplet ne pointent vers le bas, ou dans le cas où les ligatures

utilisées comprenant les notes du multiplet forceraient les hampes à pointer vers le bas.

Les multiplets sont “magnétiques”, comme les liaisons de phrasé et se positionnent

automatiquement (b 2.28 Liaisons de phrasé). Le nombre du multiplet et le crochet se

déplace automatiquement pour éviter les collisions, soit entre les extrémités du crochet et les

notes, soit entre le crochet et les articulations éventuelles. Ce mécanisme se produit aussi

automatiquement lors d’une transposition et permet d’éviter toute collision avec les notes.

Si l’endroit où Sibelius place un multiplet ne convient pas, il suffit de le placer de l’autre côté des

notes: sélectionnez le nombre (ou le crochet) et choisissez Édition > Retourner (raccourci X).

On peut descendre ou remonter l’ensemble d’un multiplet en déplaçant le nombre (ou le milieu du

crochet si celui ne comporte pas de nombre) avec la souris ou en utilisant les flèches; cependant,

pour le placer de l’autre côté des notes, il faut utiliser Édition > Retourner (raccourci X).

Les crochets des multiplets
Un crochet englobe souvent les notes 

d’un multiplet. Le nombre utilisé 

devrait s’écrire au-dessus ou en des-

sous du crochet, mais pour gagner 

de la place, la pratique actuelle con-

siste à interrompre le crochet en son 

milieu ce qui dégage un espace pour 

y insérer le chiffre.

Dans les partitions anciennes, des 

liaisons de phrasé sont souvent utili-

sées à la place des crochets, même si 

les notes ne sont pas liées; de nos 

jours, les liaisons ne sont jamais 

détournées de leur usage premier.

Quelques compositeurs, tels que 

Britten et Holloway, écrivent juste 

un crochet à la place d’un triolet.

Dans les partitions récentes les cro-

chets s’étendent vers la droite, le plus 

près possible de la note suivante. 

Cela améliore nettement la lisibilité 

car tous les crochets de multiplets 

simultanés, par exemple des triolets 

de noires et des sextolets de croches, 

ont l’extrémité qui se termine au 

même endroit.
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L’inclinaison du crochet et du numéro peut se modifier en déplaçant chaque extrémité du crochet.

Pour rétablir la position par défaut d’un multiplet déplacé, sélectionnez-le et choisissez Mise en
page > Réinitialiser lespositions (raccourci Ctrl+Maj+P ou xXP).

Multiplets imbriqués
Les multiplets imbriqués (c’est-à-dire des multiplets dans

d’autres multiplets) peuvent sembler un peu confus et difficile à

lire, mais sont très appréciés de compositeurs tels que Brian

Ferneyhough. Sibelius permet non seulement d’écrire des multiplets imbriqués quel que soit leur

hiérarchie ou leur complexité, mais aussi est capable de les exécuter correctement.

La saisie des multiplets imbriqués se réalisent comme toute saisie de multiplets, si ce n’est qu’il

convient de commencer par le plus extérieur (c’est-à-dire le plus long) que l’on remplira ensuite.

Multiplets masqués
Les multiplets peuvent être masqués soit en masquant le crochet et le

nombre (b 5.9 Masquer des objets), soit en désactivant le crochet

et le nombre dans la boîte de dialogue Créer > Multiplet au moment de

les créer. Cela permet d’avoir des notes espacées différemment des

autres portées sans que l’indication de multiplet n’apparaisse. C’est très

utile pour des groupes rapides de notes et autres exemples de “rythme

non mesuré” pour lesquels écrire le rythme exact serait fastidieux. Une

autre utilisation est l’écriture de métriques différentes simultanées

telles que 4/4 contre 6/8. b 2.13 Rythme non mesuré,

2.33 Indications de mesure.

Changer la présentation de multiplets déjà présents dans la partition
Si, après avoir déjà créé un certain nombre de multiplets, on décide d’en changer la présentation, il

convient d’utiliser les filtres et la fenêtre des Propriétés.

Voici par exemple, comment masquer les crochets et les nombres des multiplets déjà présents dans

une partition:

* Choisissez Édition > Filtrer > Multiplets

* Tous les crochets et nombres des multiplets de la partition sont alors sélectionnés. Ensuite :

% Pour en masquer tous les crochets et les nombres, choisissez simplement Édition > Masquer
ou Afficher > Masquer (raccourci Ctrl+Maj+H ou xXH) ou choisissez Masquer dans le

panneau Général de la fenêtre des propriétés

% Pour changer la présentation d’un multiplet, utilisez les options du panneau Notes de la

fenêtre des propriétés. Toutes les options disponibles depuis la boîte de dialogue Créer >

Multiplet concernant l’apparence des numéros et crochets et la durée des crochets, sont

également disponibles ici.

Le filtres sont un moyen très puissant de changer un grand nombre d’objets de la partition en une

seule opération – b 5.7 Rechercher et filtrer.

Rapport des multiplets
En musique contemporaine, il 

n’est pas rare d’écrire par 

exemple 5:4 c’est-à-dire “5 

dans le temps de 4”. 

Le rapport s’utilise aussi pour 

expliciter les multiplets, par 

exemple 3:2 pour un triolet ou 

pour spécifier des rythmes 

inhabituels tels que 5:3. 

Le second chiffre doit être plus 

de la moitié et moins du 

double du premier. chiffre.
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Crochets horizontaux de multiplets
Si vous voulez que vos crochets de multiplets soient toujours horizontaux, choisissez Style
maison > Modifier les lignes, sélectionnez la ligne de crochet de multiplet dans la liste des lignes
de portée, cliquez sur Modifier, et dans la boîte de dialogue Modifier la ligne activez l’option

Horizontal (b 8.15 Modifier les lignes). Cependant, soyez attentif au fait qu’en contraignant

les crochet des multiplets à rester horizontaux, certaines propriétés “magnétiques” disparaîtront.

Multiplets enjambant des barres de mesure
Sibelius n’écrit pas automatiquement les multiplets au-dessus des barres de mesure ; cependant,

réaliser l’exemple ci-dessous n’est pas compliqué; il suffit de :

* Créer une mesure irrégulière de deux fois la longueur normale donnée par l’indication de

mesure en choisissant Créer > Mesure > Autre (raccourci Alt+B ou zB)

* Écrire le contenu des deux mesures avec le multiplet qui enjambe la barre de mesure

* Ajouter la barre de mesure qui convient - dans l’exemple donné ci-dessus elle s’obtient en

choisissant Créer > Barre de mesure > Normal - en cliquant à l’endroit approprié, puis en

ajustant sa position relative à la note suivante à l’aide du paramètre X dans le panneau Général
des Propriétés.

* Si des numéros de mesure sont utilisés, il faut créer un changement de numéro de mesure dans

la mesure suivante pour compenser la perte d’une “vraie” mesure en choisissant Créer > Autres >

Changement de numéro de mesure.

Présentation des multiplets
Vous pouvez changer l’aspect des nombres et des crochets des multiplets dans Style maison >

Modifier les styles de texte et Style maison > Modifier les Lignes. Si vous modifiez les polices

des nombres de multiplets, l’usage normal est une police medium italique avec sérif.

b 3.9 Modifier les styles de texte, 8.15 Modifier les lignes.

Options des règles de gravure
Plusieurs options concernant la présentation des multiplets sont proposées dans la page

Multiplets de la boîte de dialogue Style maison > Règles de gravure (raccourci Ctrl+Maj+E ou

E):

* L’option disponible dans le groupe Positionner sur les notes vous permet d’examiner toutes les

notes du multiplet pour déterminer si le multiplet doit se situer au-dessus ou au-dessous des

notes (Positionner les multiplets comme si toutes les notes étaient ligaturées, option par

défaut) ou bien si les notes doivent se positionner elles-mêmes au-dessus ou au-dessous, selon la

direction de hampe de la première note (Positionner les multiplets par rapport à la
première note). Dans ce cas, vous pouvez également déterminer l’extrémité de la note à laquelle

les multiplets doivent se situer à la fois avec et sans crochets. Il est cependant fortement

recommandé d’utilisé l’option par défaut.



2.35 Triolets et autres multiplets

223

N
o

tatio
ns

* Par défaut, Toujours au-dessus des portées vocales est activé, et permet de positionner les

crochets et les numéros des multiplets au-dessus de la portée, afin de s’assurer qu’ils

n’interfèrent pas avec les paroles situées sous la portée. 

* Pivoter les chiffres uniques contrôle si l’unique chiffre d’un multiplet (comme celui d’un

triolet) doit suivre le même angle que le crochet; les chiffres isolés sont mieux présentés quand

ils sont écrits à l’horizontale, raison pour laquelle l’option est désactivée par défaut. Les

multiplets qui comportent deux chiffres (par exemple 12 ou 3:2) sont écrits en suivant

l’inclinaison de l’accolade et ne sont pas concernés par cette option.

* Masquer les crochets lorsque les notes sont jointes par une seconde ligature affecte les

multiplets qui utilisent les crochets automatiques. Lorsque l’option est activée, et lorsqu’un

multiplet utilise un crochet automatique, Sibelius masquera le crochet si :

% le multiplet entier est contenu dans une ligature ;

% la dernière note avant le début du multiplet doit être une croche, ou la première note du

multiplet doit avoir l’option Démarrer une seconde ligature activée via le pavé ;

% la première note après un multiplet doit être une croche, ou doit avoir l’option l’option

Démarrer une seconde ligature activée ;

% toutes les notes du multiplet doivent avoir la même durée (ou une durée inférieure) que la

première et la dernière note du multiplet, et aucune d’entre elles ne doit avoir l’option

Démarrer une seconde ligature activée.

* Distance verticale des notes contrôle la distance par défaut de placement des multiplets par

rapport aux notes.

* Les options Distance horizontale depuis les notes vous permettent de spécifier avec

précision la position par défaut des extrémités gauche et droite des crochets du multiplet :

Dans l’image ci-dessus, les réglages n dents depuis la tête de la première note et n dents
depuis la tête de la dernière note sont tous deux configurés à 0,5 dents pour les besoins de

l’illustration ; par défaut, les deux réglages sont configurés à 0 dents, car les crochets des

multiplets sont en règle générale alignés avec le bord de la tête de note. Les réglages n dents
depuis la hampe de la première note et n dents depuis la hampe de la dernière note sont

configurés à 0,5 dents par défaut (valeur identique à celle indiquée plus haut), afin d’éviter que le

crochet de multiplet à l’extrémité de la hampe ne semble croiser la hampe elle-même.

Le nouveau contrôle n dents depuis la première note après le multiplet vous permet de

spécifier la distance entre le crochet de multiplet et la note suivante après le multiplet, à l’aide de

l’option de durée Etendre jusqu’à la première note après le multiplet.


n dents à partir 
de la tête de la 
première note

n dents à partir 
de la hampe de la 
dernière note

n dents à partir de
la hampe de la 
première note

3

n dents à partir de
la tête de la 
dernière note

3
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2.36 Voix

Qu’est-ce qu’une voix
En musique, chaque portée comporte au moins une voix formée de notes, d’accords et de silences.

Suivant la hauteur des notes les hampes sont orientées vers le haut ou vers le bas:

Deux voix peuvent apparaître sur une portée avec éventuellement des rythmes différents. On

distingue les voix par l’orientation des hampes: elles sont vers le haut pour la 1re voix et vers le bas

pour la 2nde voix:

Remarquez le placement différencié des silences suivant la voix, plus haut pour la 1re voix, plus bas

pour la 2nde voix. D’habitude on écrit un seul silence pour les deux voix s’ils sont identiques.

Les partitions pour guitare et pour orgue, ainsi que celles pour quelques autres instruments,

peuvent présenter une troisième voix (avec les hampes vers le haut) voire une quatrième (avec les

hampes vers le bas).

Utilisation des voix
Sibelius accepte jusqu’à quatre voix indépendantes par portée, chacune d’une couleur différente: la

1re voix est bleu foncé, la 2ème est verte, la 3ème est orange et la 4ème est rose.

Les notes, bien sûr n’appartiennent qu’à une seule voix. Par contre, le texte de portée ou les lignes

peuvent être attachés à une ou plusieurs voix, voire même à toutes; cela ne change en rien l’aspect

de la partition, mais peut s’avérer utile pour l’exécution (par exemple un soufflet qui s’applique à

toutes les voix). 

Pour changer de voix, utilisez les boutons de voix sur le pavé, ou utilisez le sous-menu Édition >

Voix, ou les raccourcis clavier Alt+1/2/3/4 ou z1/2/3/4 (pour “toutes les voix” utilisez Alt+5 ou

z5).

Pour attribuer une voix à une note (soit sélectionnée, ou sur le point d’être créée), cliquez sur le

bouton de voix approprié sur le pavé, ou utilisez le raccourci clavier.

Pour qu’un texte ou une ligne soit attribué à toutes les voix, tapez simplement Alt+5 ou z5 (ou

cliquez sur le bouton Tous sur le pavé). Si, cependant, vous décidez d’appliquer une combinaison

de voix, il est préférable d’utiliser les boutons du pavé que les raccourcis; si un texte ou une ligne se

trouve dans la 1re voix, et que l’on clique sur le bouton de la 2ème sur le pavé, l’objet sera attribué

aux deux voix (et prendra une couleur bleu clair pour le montrer).

Juste une voix

Voix 1

Voix 2
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Il est impossible de créer automatiquement du texte ou des lignes attribués en combinaison à

plusieurs voix; un objet est toujours créé pour une voix, ce n’est qu’après qu’il peut être attribué à

d’autres voix.

D’autres objets tels que les clés, les armures ou les texte de système (par exemple le titre et les

indications de tempo) et les lignes de système (par exemple les lignes de rit./accel., les primo et

secundo) sont toujours en bleu clair (pour les objets de portée) ou de couleur pourpre (pour les

objets de système) quand ils sont sélectionnés. Le choix de la voix n’a aucune importance pour

créer ces objets.

Afficher les voix en couleur
Il peut s’avérer utile de voir en permanence à quelle voix appartiennent les notes et pas seulement

quand elles sont sélectionnées. Pour obtenir cela, activez Affichage > Couleurs de note > Couleur
par voix.

Commencer une voix supplémentaire avec des notes
Pour commencer une nouvelle voix avec le clavier ou en utilisant la saisie pas à pas:

* Sélectionnez une note, un silence, ou un autre objet (tel que du texte ou une ligne) à l’endroit où

doit commencer la nouvelle voix

* Tapez N (le raccourci pour Notes > Saisie de notes) suivi de Alt+2 ou z2 pour activer la 2nde

voix; le curseur devient vert

* Entrez la première note normalement; elle doit apparaître à la 2nde voix tandis que le reste de la

mesure se remplit des silences adéquats

* Continuez ensuite à entrer le reste des notes de la 2nde voix normalement.

Pour commencer une nouvelle voix avec la souris:

* Si rien dans la partition n’est sélectionné, choisissez sur le pavé le bouton de la voix, la valeur de

la note et ses attributs éventuels

* Cliquez dans la partition à l’endroit où vous souhaitez que la nouvelle voix commence; Sibelius

fait apparaître la note et remplit pour cette voix le reste de la mesure avec les silences adéquats

* Continuer ensuite à entrer le reste des notes de la 2nde voix normalement.

Pour enregistrer avec Flexi-time une nouvelle voix, choisissez-la dans la boîte de dialogue Notes >

Options Flexi-time (raccourci Ctrl+Shift+O ou xXO). Si cette voix existe déjà dans la

partition, il suffit d’en sélectionner un silence et de lancer Flexi-time normalement –

b 1.4 Flexi-time™.

Mesures partiellement à deux voix
Si vous ne souhaitez pas qu’une mesure se remplisse de silences aux deux voix, sélectionnez les

silences indésirables et appuyez Suppr pour les masquer.

Si vous souhaitez que la 2nde voix commence au milieu d’une mesure, entrez les notes en pointant

avec la souris l’endroit souhaité où elle doit commencer. Autrement, commencer au début de la

mesure avec des silences suivis des notes, puis masquer les silences indésirables avec Suppr.

Parfois, l’orientation des hampes de la 1re voix s’inversent quand des silences sont supprimés.
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Supprimer la voix 2
Pour supprimer dans une mesure certaines parties de la voix, il suffit de supprimer les silences,

comme décrit ci-dessous. Cependant, si vous voulez supprimer complètement cette voix d’une

mesure, créez un silence de mesure à partir du second pavé, puis après l’avoir sélectionné, appuyez

sur Suppr.

Vous pouvez aussi utiliser les filtres pour enlever un passage dans une voix en particulier –

b 5.7 Rechercher et filtrer.

Concentrer les voix
Si vous souhaitez concentrer toutes les voix d’un passage en une seule voix, sélectionnez ce passage

et choisissez la voix souhaitée sur le pavé ou Édition > Voix (raccourci Alt+1/2/3/4 ou z1/2/3/4):

Il est impossible de concentrer des voix qui contiennent des multiplets; Sibelius laissera de côté

toute voix où des multiplets apparaissent.

Concentrer des portées sous forme de voix
Si vous voulez concentrer le contenu de deux portées ou plus, chacune utilisant une seule voix, sur

une seule portée de plusieurs voix, l’idéal est d’utiliser la fonction Arranger (b 5.1 Arranger),

sauf si vous souhaitez garder le contrôle complet de la réduction; dans ce cas, voici un exemple:

Imaginez qu’on veuille réduire deux portées de violon sur une seule portée de violon; voici

comment procéder:

* Créez la nouvelle portée (de destination) de violon

* Faites une sélection de passage (c’est-à-dire entouré d’un simple cadre bleu) de la portée

originale (de départ) qui doit devenir la 1re voix

* Alt+clic ou z-cliquez sur la portée de destination pour déposer le passage sélectionné

* Faites une sélection de passage de la deuxième portée dont le contenu doit devenir la deuxième

voix (hampe vers le bas) dans la portée de destination

* Choisissez maintenant Édition > Filtrer > Voix 1 (raccourci Ctrl+Shift+Alt+1 ou xzX1); la

sélection de passage sera converti en sélection multiple (le cadre bleu clair disparaît et seules les

têtes de notes sont colorées en bleu)

* Choisissez Édition > Voix > Voix 2 (raccourci Alt+2 or z2); toutes les notes sélectionnées dans

cette portée deviennent des notes de voix 2

* Pour terminer, copiez ce passage avec Alt+clic ou z-clic dans la portée de destination.

L’étape importante de la procédure décrite ci-dessus est l’opération de filtrage

(b 5.7 Rechercher et filtrer): elle convertit une sélection de passage en sélection multiple.

Si vous copiez la sélection de passage de la voix 2 sur l’autre portée, la musique présente sur la

portée de destination sera effacée, car une sélection de passage remplace toute musique existante,

alors que la sélection multiple s’ajoute à la musique existante. Pour en savoir plus sur ce type

d’opération, b 1.9 À propos des sélections et des passages.

Avant Après
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Répartir en plusieurs voix
Parfois il est utile de répartir un passage écrit à une voix sur deux voix ou plus, par exemple si vous

avez entré de la musique polyphonique sous forme d’une seule voix en utilisant Flexi-time, ou un

fichier MIDI importé.

Pour répartir la musique de la Figure 1 ci-dessus sur deux voix (et obtenir la Figure 3), procédez

comme suit:

* Sélectionnez la musique à répartir comme passage

* Choisissez Édition > Filtrer > Notes inférieures ou Notes seules (raccourci Ctrl+Alt+B ou

zXB), puis choisissez voix 2 sur le pavé ou Édition > Voix > 2 (raccourci Alt+2 ou z2); le

résultat devrait ressembler à la Figure 2

* Enfin, modifiez les valeurs de notes liées (ou utilisez l’extension Combiner des notes liées et
de silences – cf. Combiner les notes liées et les silences à la page 584); finalement vous

devriez obtenir la Figure 3.

Les voix qui contiennent des multiplets ne peuvent être réparties ainsi; Sibelius ne prend pas en

compte les voix où des multiplets apparaissent.

Voix 3 et 4
Ajouter une 3re et une 4me voix fonctionne de la manière que pour la 2nde voix. Si vous souhaitez

utiliser trois voix, choisissez la combinaison 1+2+3 ou 1+2+4 en fonction de la direction des

hampes qu’elles doivent avoir. Les hampes des voix 1 et 3 pointent vers le haut, celles des voix 2 et 4

vers le bas.

Aucune règle n’existe pour positionner trois voix ou plus, si bien qu’il peut s’avérer nécessaire de

déplacer les notes horizontalement pour éviter des collisions. Voyez Croisement de voix
ci-dessous.

Intervertir des voix
Si vous avez réalisé la saisie dans la mauvaise voix, plutôt que de tout effacer et de recommencer,

faites une sélection du passage et intervertissez les voix entre elles.

Plusieurs options existent dans Édition > Voix. S’il s’agit simplement d’intervertir les voix 1 et 2 il

suffit de taper le raccourci Maj-V.

Figure 1 Figure 2

Figure 3



2. Notations

228

Copier des voix
Pour copier une seule voix d’une portée qui en contient plusieurs, sélectionnez le passage à copier

et utilisez Édition > Filtre > Voix 2 (raccourci Ctrl+Shift+Alt+2 ou xzX2) pour filtrer

uniquement les notes de la voix 2. Avec Alt+clic ou z-clic, vous pouvez les copier n’importe où

normalement.

La copie se réalise dans la même voix dont proviennent les éléments copiés. Cependant, si vous

voulez copier d’une voix vers une autre...

Copier d’une voix vers une autre
Utilisez Extensions > Notes et silences > Coller dans la voix – cf. Coller dans la voix à la

page 567.

Cependant, si vous voulez copier d’une voix vers une autre manuellement, on utilisera l’inversion

des voix. Par exemple, supposez qu’on doive à un endroit copier des notes de la 1re voix dans la

2nde voix:

* Intervertissez les voix 1 et 2 dans le passage qui doit être copié, de manière à ce que les notes à

copier soient en voix 2. Pour réaliser cela, faites une sélection de passage et choisissez Édition >

Voix > Intervertir 1 et 2 (raccourci Maj-V).

* Pour sélectionner les notes de la voix 2, faites une sélection de passage et filtrez pour obtenir les

notes de cette voix en sélection multiple, comme décrit dans le paragraphe Copier des voix ci-

dessus

* Copiez les notes, qui seront en voix 2 puisque c’est la voix dont elles viennent.

* Intervertissez de nouveau les deux voix dans le passage original.

Les silences
Quand des silences apparaissent sur plusieurs voix, Sibelius les place automatiquement plus haut

ou plus bas que leur position normale pour qu’il apparaisse clairement à quelle voix ils

appartiennent. Vous pouvez déplacer les silences de haut en bas avec la souris ou avec les touches

de flèches si ils se trouvent dans le chemin des autres voix.

Une subtilité: quand vous supprimez des silences (par exemple dans la voix 2) ils sont masqués

mais complètement enlevés, de sorte que l’espacement des notes sera plus large si le silence caché

est d’une valeur plus courte que les autres notes qui tombent en même temps. Cela ne devrait pas

poser de problèmes, mais si c’est le cas, activez Affichage > Objets masqués et Supprimez les

objets masqués (affichés en gris).

Masquer des voix
Dans certaines situations on peut souhaiter vouloir cacher des notes dans une ou plusieurs voix,

par exemple si la partition affiche une mélodie mais s’exécute avec un accompagnement. Pour faire

Pour faire cela, ajouter les accords dans une ou plusieurs autres voix que celle de la mélodie, puis

utiliser les filtres (b 5.7 Rechercher et filtrer) pour en sélectionner toutes les notes et

choisissez Édition > Masquer ou Afficher > Masquer (raccourci Ctrl+Shift+H ou xXH) pour

les masquer.
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Croisement de voix
Bien qu’en général les notes de la première voix soient plus hautes que celles de la seconde voix, ce

n’est pas obligatoire; les voix peuvent se croiser, et même si elles contiennent des accords peuvent

s’entremêler. Sibelius essaie de positionner automatiquement les deux voix pour éviter toute

collision. Cependant, si une portée contient une troisième voix ou plus, des collisions risquent de

se produire car il n’existe aucune règle efficace permettant de gérer cette situation.

Si cela se produit, il convient d’ajuster la position horizontale des notes, silences et accord comme

suit:

* Sélectionner la note, l’accord ou le silence qui doit être déplacé

* Ouvrez le panneau Général de la fenêtre des propriétés

* Tapez la distance (en dents) dont la note doit s e déplacer dans le cadre X; un nombre positif

déplace vers la droite, un nombre négatif vers la gauche

* Si seul le point rythmique d’une note doit être déplacé, sélectionnez-le et déplacez-le avec la

souris.

Options des règles de gravure
Les règles pour positionner les notes dans plusieurs voix sont vraiment compliquées et le commun

des mortels devrait éviter de s’y intéresser. Sibelius, cependant, propose de choisir parmi trois

règles de positionnement des voix, disponible dans la page Notes et Trémolos de la boîte de

dialogue Style maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE). La règle par défaut

Version 2 est recommandée, mais si le besoin se fait sentir d’utiliser une règle ancienne, n’hésitez

pas à la choisir.
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3.1 Utiliser du texte

b 3.2 Styles de texte usuels, 3.9 Modifier les styles de texte, 5.7 Rechercher et
filtrer.

Cette rubrique explique en détail les différentes méthodes de création et d’édition de texte dans

Sibelius. Pour une introduction rapide, consultez le Manuel.

Créer du texte rapidement
Il y a de nombreuses façons de créer rapidement du texte:

* Sélectionnez d’abord une note près de laquelle vous souhaitez que le texte apparaisse, puis

utilisez les raccourcis clavier Ctrl+E ou XE, Ctrl+T ou XT et Ctrl+L ou XL pour obtenir les trois

styles de texte les plus courants, c’est-à-dire Expression, Technique et Paroles 1

* Les autres styles de texte avec un raccourci sont: Paroles, 2d couplet (raccourci Ctrl+Alt+L ou

zXL) et Tempo (Ctrl+Alt+T ou zXT)

* Si une note ou un autre objet est sélectionné, Sibelius créera automatiquement le texte à cet

endroit de la partition; si rien n’est sélectionné, le pointeur de souris changera de couleur pour

indiquer qu’il “contient” un objet, ici du texte à créer, qui le sera à l’endroit où on cliquera.

* Pour créer des mots usuels tels que cresc., utilisez les menus contextuels– cf. Menus
contextuels ci-dessous 

* Si le même texte est utilisé plusieurs fois, copiez le simplement avec Alt+clic ou z-clic, ou

encore faites-en une copie multiple (par exemple pour placer la même nuance à tous les

instruments) – b 1.9 À propos des sélections et des passages

* Vous pouvez copier le texte dans le presse-papiers puis le coller ailleurs dans la partition, dans

une autre partition ou même dans / à partir d’un autre programme – cf. Copier du texte et
des lignes de texte entre différents programmes ci-dessous 

* Vous pouvez également “copier” le signe d’insertion lui-même pour commencer un nouveau

morceau de texte. Recherchez dans la partition du texte dans le style dont vous avez besoin,

double-cliquez pour faire apparaître le signe d’insertion puis faites Alt+clic ou z-clic à l’endroit

souhaité.

Menus contextuels
Vraiment pratiques, les menus contextuels proposent les mots les plus courants utilisés pour créer

du texte. Chaque style de texte a son propre menu contextuel. Ainsi, Expression propose un menu

avec par exemple des nuances, celui de Tempo contient de quoi faire une indication

métronomique, etc.

Un menu contextuel s’affiche en faisant un clic-droit (Windows) ou Contrôle-clic (Mac) quand on

crée ou qu’on modifie du texte. Certains mots ou caractères proposés dans ces menus ont leur

propre raccourci clavier; b 5.12 Menus et raccourcis ou les menus eux-mêmes pour les

obtenir.
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Vous pouvez aussi modifier les menus contextuels, assigner vos propres raccourcis aux mots,

redimensionner la taille d’affichage de chaque menu, ou créer vos propres menus; cf. Créer et
modifier des menus contextuels ci-dessous.

Édition de texte
Les touches d’édition de texte sont similaires à celles des autres programmes. Les principaux

raccourcis sont:

* Pour modifier un objet texte existant, double-cliquez-le ou appuyez sur Retour (sur le clavier

principal)

* Pour interrompre l’édition, appuyez sur Échap

* Pour sélectionner tout le contenu de l’objet textuel en cours d’édition, appuyez sur Ctrl+A ou XA

* Pour une nouvelle ligne, appuyez sur Retour (sur le clavier principal)

* Pour rendre le texte gras / non-gras, cliquez sur B (raccourci Ctrl+B ou XB) dans le panneau

Texte de la fenêtre des propriétés. Cela (ainsi que italique / souligné) affecte le texte sur le point

d’être entré, toute portion de texte ou tout(s) texte(s) en entier sélectionné(s)

* Pour mettre le texte en italique / non-italique, cliquez sur I (raccourci Ctrl+I ou XI) dans le

panneau Texte de la fenêtre des propriétés

* Pour rétablir la police par défaut d’un style de texte en cours d’édition, tapez Ctrl+Alt+Espace
ou ^z-Espace

* Pour rendre le texte souligné / non-souligné, cliquez sur U (raccourci Ctrl+U ou XU) dans le

panneau Texte de la fenêtre des propriétés. Notez qu’on souligne rarement dans les partitions.

* Pour modifier la taille du texte, modifiez la valeur dans le panneau Texte de la fenêtre des

propriétés (idéalement, vous devriez plutôt modifier le style de texte)

* Il existe d’autres raccourcis pour l’édition: b 5.12 Menus et raccourcis pour en savoir plus.

Si vous souhaitez seulement modifier la police / la taille / les attributs (gras/italique/souligné)

d’une petite portion de texte, les options du panneau Texte de la fenêtre des propriétés peuvent

convenir. Cependant, des modifications plus importantes nécessitent des méthodes plus efficaces:

* Pour modifier les polices de tout le texte d’une partition (par ex. pour modifier la police du titre,

des noms d’instrument, des paroles, des indications techniques, etc. en une seule opération),

choisissez Style maison > Modifier toutes les polices, et choisissez une nouvelle Police de
texte principale 

* Pour modifier dans une partition tout le texte d’un seul style de texte particulier, il vaut mieux

modifier le style de texte lui-même (b 3.9 Modifier les styles de texte); cela affectera tout

le texte existant ainsi que tout texte qui sera créé dans ce style. Par exemple, pour attribuer aux

paroles une police différente, on modifiera le style de texte plutôt que chaque mot existant.

* Pour modifier une grande quantité de texte, mais pas tout le texte dans un style, par exemple

pour avoir les refrains en italique, définissez un nouveau style de texte basé sur le style existant

le plus proche et utilisez à la place ce nouveau style de texte (voyez Changer le style de
texte d’un texte existant ci-dessous si vous avez déjà entré le texte dans votre partition).
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Sélectionner une ligne de texte
Pour sélectionner tout le texte d’un style le long d’une portée, sélectionnez un seul objet puis

choisissez Édition > Sélectionner > Sélectionner Plus (tapez Ctrl+Maj+A ou xXA). Cela

permet de:

* déplacer tous les objets ensembles à la souris ou avec les flèches

* copier le texte dans le presse-papiers pour le coller ailleurs dans la partition ou dans un autre

logiciel (voir plus bas)

* aligner tous les objets (par ex. des paroles et des symboles d’accord) en cas de déplacement

accidentel: utilisez Mise en page > Aligner sur une rangée (raccourci Ctrl+Maj+R ou xXR)

ou Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou xXP) – b 8.1 Mise
en page et mise en forme.

Copier du texte et des lignes de texte entre différents programmes
Vous pouvez copier des objets textuels de Sibelius de diverses façons:

* dans la même partition ou entre différentes partitions, en utilisant soit Alt+clic ou z-clic (avec

en option Shift enfoncé pour placer le texte à sa position verticale par défaut) ou en utilisant

Édition > Copier et Édition > Coller – ceci étant particulièrement utile pour les paroles

(b 3.3 Paroles)

* vers un autre programme (par ex. Microsoft Word): sélectionnez simplement le texte à copier,

utilisez Édition > Copier (raccourci Ctrl+C ou XC) pour le copier dans le presse-papiers,

basculez vers l’autre programme et utilisez Édition > Coller (raccourci généralement Ctrl+V ou

XV) pour coller le texte.

Si vous copiez plusieurs objets textuels à la fois dans un autre programme, ils seront collés les uns

après les autres avec une espace entre eux; pour les paroles, les syllabes séparées d’un même mot

sont collées avec les traits d’union entre elles – b 3.3 Paroles. Lorsque du texte est copié dans un

autre programme, les polices, etc. sont ignorées; par conséquent les nuances et les notes des

indications métronomiques (qui utilisent la police de caractères musicaux, définie dans la boîte de

dialogue Style maison > Modifier toutes les polices) n’apparaissent pas comme telles

lorsqu’elles sont collées dans un document Word, par exemple, à moins d’utiliser la police correcte

par la suite.

Pour copier du texte dans Sibelius à partir d’autres programmes:

* Sélectionnez le texte et copiez-le dans le presse-papiers avec Édition > Copier (raccourci normal

Ctrl+C ou XC)

* Passez dans Sibelius et créez un signe d’insertion dans un style de texte approprié, par ex.

sélectionnez une note et appuyez sur Ctrl+T ou XT pour du texte technique

* Choisissez Édition > Coller (raccourci Ctrl+V ou XV) pour coller le texte.

Coller dans Sibelius des paroles d’un autre programme se fait un peu différemment –

b 3.3 Paroles.
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Changer le style de texte d’un texte existant
Vous pouvez changer le style de texte d’un objet textuel existant. Sélectionnez le texte et ouvrez le

panneau Texte de la boîte de dialogue des propriétés, dans lequel un menu déroulant vous permet

de changer le style de texte avec les restrictions suivantes:

* Changer du texte de portée en texte de système et vice-versa est impossible, de même que

* changer un style de texte de paroles en style de texte qui ne le soit pas et vice-versa.

Masquer du texte
Pour masquer du texte, ce qui est essentiellement utilisé pour les nuances et d’autres indications

d’exécution, sélectionnez le texte à masquer et choisissez Édition > Masquer ou afficher >

Masquer (raccourci Ctrl+Maj+H ou xXH). Pour en savoir plus, b 5.9 Masquer des objets.

Tout texte suivant un tilde (~) est automatiquement masqué par Sibelius et ne sera pas imprimé.

En principe, cela ne s’utilise que pour écrire des messages MIDI (b 4.17 Messages MIDI).

Réinitialiser les positions
Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P or xXP) réinitialise le texte à

sa position par défaut. 

Réinitialiser l’aspect original
Si vous souhaitez changer un objet textuel vers sa taille ou sa police originale (définies dans Style
maison > Modifier les styles de texte), si par exemple vous avez modifié la police ou mis du

texte en italiques, sélectionnez-le et choisissez Mise en page > Rétablir l’aspect original
(raccourci Ctrl+Maj+D ou xXD).

Texte à gauche d’un système
Quand on veut placer du texte à la gauche d’un système, c’est en général pour spécifier quels

instrumentistes jouent une partie d’instrument, auquel cas, b 8.5 Les sauts.

Si, cependant, vous avez une bonne raison d’écrire du texte à la gauche d’un système, aucun

problème; il faut juste placer un saut de système à la fin du système précédent pour s’assurer que le

texte restera à sa place si la mise en forme de la musique est modifiée. b 2.18 Instruments et
portées.

Texte entre les portées
Lorsque vous créez du texte entre les portées à l’aide de la souris, par ex. des nuances pour clavier,

Sibelius essaie de deviner à quelle portée l’attacher en fonction de la position verticale par défaut

du style de texte (b 8.12 Positions par défaut). En général cela fonctionne bien – par

exemple, si on crée des paroles entre les portées, Sibelius les attachera à la portée supérieure car

c’est là que sont normalement attachées les paroles. Mais si vous placez du texte entre les deux

portées, assurez-vous qu’il est attaché à la portée correcte (b 8.7 Attaches), sinon le texte

n’aura pas le comportement approprié si vous déplacez la portée ou faites l’extraction des parties

séparées.

Évitez de placer entre deux instruments séparés, du texte qui devrait s’appliquer aux deux (ce qui

d’ailleurs n’est pas recommandé). Sinon, lors de l’extraction des parties instruments séparées, seule
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l’une d’entre elle inclura le texte. Il est par contre tout à fait acceptable de placer un seul texte entre

les deux portées d’un instrument à clavier, car elles sont extraites dans la même partie séparée.

Plusieurs fragments de texte
Il est souvent nécessaire d’avoir des fragments de texte côte à côte sur différentes notes, comme des

doigtés ou des syllabes de mots étalés comme cre – scen – do. Chaque fois qu’un tel cas se présente,

utilisez des fragments de texte séparés; n’entrez surtout le texte d’un seul tenant en utilisant des

espaces. En effet, si la partition est remise en forme, il y a de fortes chances que les fragments

séparés se rapprochent ou s’écartent l’un de l’autre.

Lorsque vous entrez un long mot qui s’étale sur plusieurs mesures sous forme de syllabes séparées,

évitez d’utiliser les traits d’union; à la place, insérez entre les syllabes une ligne discontinue créée

dans la boîte de dialogue Créer  > Ligne (raccourci L) De la sorte, si l’espacement entre les syllabes

se modifie, le nombre de traits placés entre variera en conséquence (exactement de la même

manière que les traits d’union dans les paroles).

Créer des objets spéciaux avec du texte
Sibelius comporte quelques fonctions fort utiles peu évidentes à première vue. C’est le cas de la

fonction Créer > Texte > Texte spécial qui propose plusieurs styles pour créer spécialement divers

objets tels que des repères de répétition, des indications de mesure et des numéros de mesure.

Voici un exemple pour illustrer l’intérêt de pouvoir les créer de manière spéciale plutôt que

normale:

Supposons que l’on souhaite placer au début d’une partition un repère de répétition appelé

DÉPART. Ce repère, ne pouvant s’insérer ni dans une séquence alphabétique, ni dans une séquence

numérique, ne peut être créé de manière normale par Sibelius. Comme solution on peut envisager

de créer un nouveau style de texte pour du grand texte encadré, et de l’utiliser pour écrire le mot

DÉPART.

Mais le plus simple consiste à utiliser Créer > Texte > Texte spécial > Repère de répétition. Cela

crée un texte qui n’est pas un vrai repère de répétition, mais qui utilise le même style de texte et

aura donc la même apparence (et généralement le même comportement) qu’un vrai repère de

répétition. Lorsque vous taperez DÉPART avec le style Repère de répétition, le texte apparaîtra

en grand et en gras dans un cadre, il sera reproduit plus bas dans la partition (par ex. au-dessus des

cordes) et sera également extrait automatiquement dans les parties séparées. Intéressant, n’est-ce

pas?

Plusieurs styles de texte peuvent être utilisés pour créer des objets spéciaux de cette manière:

* Indication de mesure: pour créer d’étranges indications de mesure à la Ferneyhoug telles que

5/6

* Repères de répétition: pour écrire des repères de répétition qui ne sont pas séquentiels (bien

qu’il soit possible de redémarrer la séquence des repères de répétition à n’importe quel point).

À partir d’ici, les choses sont moins évidentes:

* Numéros de page: pour ajouter par ex. des numéros de folio dans une édition de musique

ancienne
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* Lettres / Chiffres de tablature: sans être vraiment indispensable, pour écrire des lettres ou

chiffres spéciaux dans les tablatures

* Multiplets: pour des formats inhabituels tels que “3 en 2”.

Créer et modifier des menus contextuels
Choisissez la page Menus contextuels dans la boîte de dialogue Fichier > Préférences (dans le

menu Sibelius sur Mac; raccourci Ctrl+, ou X,), pour voir cette boîte de dialogue:

* Cliquez sur un menu contextuel existant pour le modifier, ou entrer le nom pour un nouveau

menu contextuel dans Nom de menu et cliquez sur Nouveau sous la liste des menus

contextuels

* Pour changer le nom d’un menu contextuel nouveau ou déjà existant, entrez le nouveau nom

dans Nom de menu et cliquer sur Appliquer

* Pour ajouter un nouveau mot au menu, cliquez sur le bouton Nouveau sous la liste des Mots,

puis entrez-le dans la boîte Texte et cliquer sur Appliquer

* Pour ajouter un nouveau mot dans un menu, sélectionnez-le dans la liste, puis modifiez-le dans

la boîte Texte et cliquer sur Appliquer

* pour changer l’ordre dans lequel les mots apparaissent dans le menu, utilisez les boutons

Déplacer vers le haut et Déplacer vers le bas

* En plus de créer ou de modifier des mots on peut également leur assigner un raccourci-clavier:

cliquez dans la boîte Raccourci et tapez la combinaison de touches voulue. Vous pouvez

assigner tout raccourci qui vous plaît, mais prenez garde aux combinaisons de touches déjà

utilisées par votre système d’exploitation (par exemple évitez Ctrl+F4 sous Windows ou zXM
sur Mac).

* Cliquez sur Utiliser une police de caractères musicaux si éventuellement vous envisagez

d’utiliser des caractères musicaux de la police de texte musical (telle que définie dans la boîte de

dialogue Style maison > Modifier toutes les polices – b 8.11 Polices musicales). Cela

peut s’avérer utile pour des indications telles que mf.
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* Pour supprimer un mot de la liste, sélectionnez-le puis cliquez sur Suppr sous la liste des mots

* Pour supprimer un menu entier de mots, sélectionnez-le puis cliquez sur Suppr sous la liste des

menus de mots.

* Pour changer la taille d’affichage du menu contextuel, choisissez la taille de police souhaitée

dans Taille de police du menu

* Lorsque vous avez terminé, cliquez sur OK.

Tout nouveau menu contextuel créé peut être assigné à un style de texte; ouvrez l’onglet Général
de la boîte de dialogue Modifier le style de texte pour le style de texte souhaité

(b 3.9 Modifier les styles de texte) et réglez Menu contextuel sur le menu que vous avez

créé.

Pour personnaliser d’autres raccourcis que ceux des menus contextuels, b 5.12 Menus et
raccourcis.

Caractères spéciaux
En plus de proposer des mots, la plupart des menus contextuels proposent également des

caractères spéciaux tels que f ou e.

La plupart de ces caractères proviennent de la police de texte pour la musique (par ex. Opus Text),

quelle que soit la police utilisée pour les caractères normaux. Pour utiliser une autre police –

b 8.11 Polices musicales. Les chiffres de basse chiffrée proviennent de la police Opus Figured

Bass.

Créer des instructions textuelles dans des scripts
Sibelius utilise le jeu de caractère standard Unicode™, ce qui signifie qu’il est possible d’écrire

n’importe quel script dans Sibelius, pourvu que l’on possède des polices contenant les caractères

requis. Unicode garantit que le texte des scripts complexes se traduit automatiquement de Mac à

Windows.

Quand vous créez du texte dans des langues européennes qui utilisent l’alphabet romain avec des

signes diacritiques, certains des caractères accentués sont disponibles dans les menus contextuels

b 5.12 Menus et raccourcis – pour une liste complète des raccourcis pour les lettres

accentuées.

Pour écrire du texte dans un alphabet non romain (par ex. japonais, cyrillique, grec, coréen, etc...),

vous devez en général utiliser une méthode de saisie qui lui est spécifique, parce que la plupart de

des alphabets non romains contiennent plus de caractères que le clavier physique des ordinateurs.

Ces méthodes de saisie sont l’objet de logiciels fournis avec votre système d’exploitation et dans

lesquels sont données les combinaisons de touche pour les caractères spécifiques d’un alphabet

non romain. La manière d’utiliser ces méthodes de saisie varient en fonction de l’alphabet pour

lequel elles ont été conçues.

Sous Windows, il existe différentes méthodes de saisie qui utilisent des composants logiciels

appelés Input Method Editors (IMEs). Une introduction aux IMEs est proposée à cette adresse:

http://www.microsoft.com/globaldev/handson/user/IME_Paper.mspx

Sur Mac OS X, les méthodes sont à choisir dans le menu saisie, qui est activé comme ceci:

http://www.microsoft.com/globaldev/handson/user/IME_Paper.mspx
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* Lancez Préférences Système et faites un double-clic sur International

* Cliquez sur l’onglet Menu Saisie, recherchez l’alphabet souhaité

dans la liste des méthodes de saisie, et cochez-le.

* Vérifiez si Afficher le menu Saisie dans la barre des menus est

activé.

* Un menu dont l’icône est un drapeau national apparaîtra dans la

barre des menus, telle qu’illustrée à droite, et vous pourrez y choisir

l’une des méthodes de saisie actives.

Notez que la police utilisée pour le texte dans Sibelius doit contenir les caractères de l’alphabet

utilisé sinon ceux-ci seront remplacés par des rectangles vides. Dans la page Menus contextuels
de Sibelius > Préférences, vous pouvez activer Utilisez automatiquement la police qui
correspond à la saisie choisie à l’origine (dans le menu saisie), pour que Mac OS X se règle

automatiquement sur la meilleure police pour l’alphabet choisi. Cette option est désactivée par

défaut.

Mac OS X propose aussi une fenêtre pratique appelée Palette de caractères qui permet d’entrer

visuellement des caractères: Pour l’activer:

* Allez à la page International du Menu Saisie, et dans la liste des méthodes de saisie

disponibles, activez Palette de caractères.

* Choisissez Afficher la Palette de caractères dans le menu saisie de la barre de menu principal.

* La fenêtre de la palette de caractère apparaîtra alors. 

* Choisissez le caractère à entrer et cliquez sur Insérer. Le caractère sera placé dans l’objet textuel

en cours d’édition dans Sibelius et dans la police qui y est utilisée. Si vous constatez que la police

utilisée ne contient pas le caractère souhaité, annulez et cliquez alors sur Insérer avec la police.
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3.2 Styles de texte usuels

b 3.1 Utiliser du texte, 3.3 Paroles, 3.4 Basse chiffrée et chiffres romains,

3.5 Numéros de mesure, 3.6 Numéros de page, 3.7 Repères de répétition.

Sibelius propose beaucoup de style de textes utilisables dans une partition. Cet article décrit la

plupart de ces styles en détail, même si certains sont suffisamment importants pour qu’un article

entier leur soit consacré – cf. ci-dessous.

Mais, qu’est-ce donc un style de texte?
Ils existent différents styles de texte utilisés dans une partition, tels que: les paroles qui se placent

sous les portées; les indications d’expression, qui sont en italiques, et qui se placent sous la portée

(excepté quand des paroles sont présentes, dans ce cas elles se placent au-dessus); les titres qui sont

en grands caractères gras, et centrés au sommet de la page; etc....

Chaque sorte de texte peut utiliser une police différente en format (tels que le gras, l’italique ou le

surligné), en justification (tel qu’aligné à gauche-, au milieu - ou à droite), et en position (soit que

le texte se place au-dessus ou en dessous d’une portée ou de toutes, ou peut-être au sommet ou au

bas de la page). Tous ces réglages pris ensemble forment un style de texte.

Comme Sibelius possède des styles de texte pour chaque sorte de texte que vous pourriez utiliser

dans une partition, il n’est pas nécessaire de les régler vous-même: choisissez simplement le style

approprié et Sibelius produira du texte bien présenté et en bonne place sur la page.

L’autre avantage des styles de texte, c’est la facilité pour en changer un paramètre qui se répercute

dans toute la partition – par exemple, pour écrire des paroles plus grosses, ou changer la police des

indications de tempo - il suffit de changer le style lui-même, et Sibelius va automatiquement

mettre à jour tous les textes qui utilisent ce style.

Pour savoir comment modifier un style de texte existant ou en créer un nouveau,

b 3.9 Modifier les styles de texte.

Trois types de texte
Il y a trois types de texte dans texte dans Sibelius (à répéter 3 fois très vitttte!):

* Texte de portée: ce texte s’applique à une seule portée, en général il s’agit d’instructions pour un

seul instrument

* Texte de système: ce texte s’applique à toutes les portées de la partition (bien qu’il puisse

seulement au-dessus de l’une ou deux), et apparaît dans toutes les parties (si elles existent) – en

général, il s’agit du tempo, de repères de répétition, etc...

* Texte de page blanche: ce texte peut seulement être créé sur une page blanche, en général il s’agit

du titre, d’indications d’interprétation, etc....
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Styles de texte importants
Le tableau ci-dessous énumère les styles de texte les plus importants et à quoi ils servent.

Nom Utilisé pour…

T
ex

te
 d

e 
po

rt
ée

Expression …écrire les nuances et les indications d’expression telles que mp, cresc. et legato

Raccourci: Ctrl+E ou XE

Technique écrire des indications techniques telles que “sourdine”, “pizz.”, etc.

Raccourci: Ctrl+T ou XT

Paroles, paroles 2e verset etc... …écrire des paroles en musique vocale – b 3.3 Paroles

Raccourci: Ctrl+L ou XL (Ligne 1), Ctrl+Alt+L ou zXL (Ligne 2)

Texte normal …écrire des paroles en paragraphe, des commentaires éditoriaux, etc.

Chiffres romains …écrire des symboles d’accords avec des renversements, en chiffres romains –

b 3.4 Basse chiffrée et chiffres romains

Basse chiffrée …réaliser la basse chiffrée du continuo en musique baroque – b 3.4 Basse
chiffrée et chiffres romains

Doigté …écrire des doigtés dans la musique pour claviers, cuivres ou cordes

Doigté de guitare (p i m a) …écrire des doigtés dans la musique pour guitare

Texte encadré …écrire des techniques de jeu, par ex. pour les percussions

Texte en petits caractères …écrire des techniques de jeu spécifiques

Chiffrage d’accords en conven-
tion Nashville 

…écrire par ex. 6/3 

Note en bas de page …écrire des notes d’éditeur en bas de page d’une seule page (différent de pied de

T
ex

te
 d

e 
sy

st
èm

e

Titre …écrire le titre d’un morceau ou d’un mouvement

Sous-titre …écrire les sous-titres (par ex. pour un mouvement spécifique)

Compositeur …écrire le nom du compositeur (toujours en CAPITALES) ou de l’arrangeur ou de

l’orchestrateur (pas en capitales)

Parolier …écrire le nom du parolier, du librettiste, du poète, ou tout autre source de texte

Dédicace …écrire une dédicace (par ex. Pour le chœur de la cathédrale Saint Jean)

Tempo …écrire une indication de tempo telle que Andante
Raccourci Ctrl+Alt+T ou zXT

Indications métronomiques …écrire des indications métriques et des modulations métriques

Copyright …écrire les mentions de copyright de la partition

En-tête etc... …écrire un en-tête sur chaque page

Pied-de-page etc. …écrire un pied de page sur chaque page (différent de Note bas de page)

Rit./Accel. …écrire des instructions de tempo spécifiques

T
ex

te
 d

e 
pa

ge
-

Compositeur (page blanche) …écrire le nom du compositeur sur une page de titre au début de la partition

Dédicace (page blanche) …écrire une dédicace sur une page de titre au début de la partition

Texte normal (page blanche) …écrire de l’instrumentation, des indications d’exécution, etc. sur des pages

Sous-titre (page blanche) …écrire un sous-titre sur une page blanche

Titre (page blanche) …écrire le titre de l’œuvre sur une page de titre au début de la partition
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Expression
Ce style de texte est conçu pour écrire les nuances et d’autres

instructions similaires, par exemple legato, animé, marcato,

normalement en italiques. Le texte d’expression est positionné en

dessous de la portée pour les portées instrumentales, et au-dessus

de la portée pour les portées vocales avec des paroles.

Les nuances telles que mf ou sfz sont écrites en caractères italiques

gras spéciaux qui utilisent une police spéciale (b 8.11 Polices
musicales), normalement Opus Text. Vous pouvez créer ces

caractères à partir du menu contextuel (clic-droit ou Contrôle-

clic), ou en maintenant enfoncé Ctrl ou X et en appuyant sur les

lettres, par ex. Ctrl+MF ou XMF pour produire mf. Attention à

l’exception z, pour lequel vous devez entrer Ctrl+Shift+Z ou

xXZ (car Ctrl+Z ou XZ est le raccourci pour Édition > Annuler).

Pour vous éviter de devoir les taper, toutes les indications

d’expression les plus courantes peuvent être créées rapidement à

partir du menu contextuel.

La plupart des nuances insérées dans la partition sont exécutées

automatiquement, à l’exception des nuances notées par cresc. et

dim. (car ni l’intensité ni la durée ne peuvent être clairement

déterminées); si celles-ci doivent être exécutées, créez des soufflets

appropriés et masquez-les (b 2.17 Soufflets). Quelques effets

spéciaux, par exemple fp ne sont pas exécutés correctement; si

leur exécution est impérieuse, utilisez des messages MIDI pour

obtenir l’effet équivalent.

Les nuances ne s’appliquent qu’à une seule portée (sauf dans la musique pour clavier –

b 4.1 Utiliser du texte); cependant voici comment les placer rapidement sur plusieurs

portées:

* Copiez la nuance avec Édition > Copier (raccourci Ctrl+C ou XC), puis sélectionnez les portées

de destination et appuyez sur Ctrl+V ou XV pour la coller dans toutes les portées sélectionnées.

Ce procédé est appelé “copie multiple” – b 1.9 À propos des sélections et des passages

* Sélectionnez la nuance et utilisez Alt+click ou z-clic pour la copier sur les autres portées; vous

pouvez maintenir Maj enfoncé avec Alt+clic ou z-clic pour placer chaque nuance à sa position

verticale par défaut; pour les aligner, sélectionnez-les dans toutes les mesures puis choisissez

Édition > Filtrer > Nuances (raccourci Maj+Alt+D ou xzD) et utilisez Mise en page >

Aligner sur une colonne (raccourci Ctrl+Maj+C ou xXC).

Technique
Ce style de texte est conçu pour écrire les indications techniques qui ne sont pas normalement

écrites en italiques, par ex. sourdine, pizz., a2, solo, tremolo. Vous pouvez également écrire des

symboles musicaux tels que des altérations en texte technique en utilisant le menu contextuel, ce

qui est utile par exemple dans la musique pour harpe.

Positionner du texte 
d’expression et du texte 
technique
Le texte d’expression se place en 

dessous de la portée à laquelle elle 

s’applique, mais au-dessus dans les 

portées avec des paroles. Le texte 

de technique se place au-dessus de 

la portée. Pour de la musique à 

deux voix, tant le texte d’expres-

sion que le texte de technique se 

placent au-dessus de la portée 

pour la voix 1 et en dessous pour 

la voix 2. Si le texte d’expression 

ou de technique s’applique aux 

deux mains d’un instrument à cla-

vier, il devrait être placé entre les 

portées.

L’extrémité gauche du texte 

d’expression se place normalement 

juste à la gauche de la note à 

laquelle il s’applique.

Si f doit être écrit sur une portée 

(ce qu’il est préférable d’éviter), la 

mesure croisée doit être position-

née au-dessus d’une ligne de por-

tée pour plus de clarté. De même, 

p�sur une portée doit être centré 

sur un espace.
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Indications métronomiques
Les indications métronomiques ressemblent en général à ceci q = 72 et sont souvent

accompagnées par une indication de tempo (voir Tempo ci-dessous). Voici comment les écrire :

* Sélectionnez un objet (par ex. une note ou un silence) dans la partition à l’endroit où doit se

placer l’indication, généralement la première note d’une mesure, et choisissez Insertion >

Texte > Indication métronomique; un signe d’insertion clignotant apparaît. (Si rien n’est

sélectionné, choisissez Insertion > Texte > Indication métronomique puis cliquez pour placer

le texte.)

* Écrivez une valeur de note sélectionnée dans le menu contextuel obtenu par clic-droit

(Windows) ou Contrôle-clic (Mac). Vous pouvez aussi utiliser la touche Ctrl ou X

conjointement avec le pavé numérique.

* Entrez ensuite = 60 ou un autre nombre. Entrez une Espace de chaque côté du signe =.

Si une indication métronomique doit figurer après une indication de tempo, par ex. Allegro q =
60, évitez d’utiliser deux morceaux de texte séparés (texte de tempo plus indication

métronomique) car ils pourraient entrer en collision si les notes de la mesure auxquelles ils sont

attachés se rapprochent. Écrivez tout en texte de Tempo; arrivé à l’indication métronomique,

désactivez Gras et choisissez une taille de corps de texte légèrement inférieure dans le panneau

Texte des propriétés.

Une extension permet d’ajouter une indication métronomique en tapant le tempo souhaité à la

souris – cf. Déterminer des indications métronomiques à la page 572.

Modulations métriques
Les modulations métriques (désignées par l’istesso tempo, ce qui signifie “le même tempo”,) sont

utilisées pour illustrer la relation entre des valeurs de note à différents tempi, par ex.:

Elles sont également couramment utilisées pour indiquer un style rythmique “swing”, par ex..

Pour créer une modulation métrique, choisissez Insertion > Texte > Autre texte de système >

Modulation métrique. Le menu contextuel de ce style de texte contient toutes les modulations

métriques habituelles et les indications de swing, à la fois avec et sans parenthèses. Ce style de

texte utilise la police Opus Metronome.
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Tempo
Le texte de tempo apparaît généralement au début d’une partition, par

ex. Allegro non troppo et est souvent accompagné d’une indication

métronomique (voir plus haut). Il est plus rapide de créer ces

indications dans la boîte de dialogue Fichier > Nouveau lors de la

création de la partition, mais on peut facilement les ajouter par la

suite. Choisissez simplement Insertion > Texte > Tempo.

Sibelius connaît la signification d’un grand nombre d’indications de

tempo et les exécute même sans indication métronomique –

b 4.9 Dictionnaire de l’exécution. Pour obtenir le menu

contextuel, faites le clic-droit (Windows) ou le Contrôle-clic (Mac)

habituel.

Pour créer des rit. et des accel. il est recommandé d’utiliser les lignes

de rit./accel. (b 2.21 Lignes), plutôt que de les entrer comme texte,

car celles-ci sont exécutées. Notez que les indications A tempo et I
Tempo ne sont pas exécutées; créez donc une indication métronomique (masquée si nécessaire)

pour rétablir le tempo original.

Dans de grandes partitions, les textes de tempo et d’indication métronomique apparaissent

automatiquement non seulement au sommet, mais également plus bas dans la partition (en

général au-dessus des cordes ou du clavier). Les occurrences s’imitent automatiquement – si vous

en modifiez une, du texte de tempo, par exemple, toutes les occurrences changeront

instantanément.

Cependant, chaque occurrence peut être glissée verticalement ou supprimée de façon

indépendante, et Sibelius déplacera souvent automatiquement les occurrences verticalement (via

Mise en page magnétique) pour éviter les collisions avec des notes aiguës ou basses, etc.

Pour supprimer toutes les occurrences du texte Tempo en même temps, supprimez celle du haut.

Pour supprimer une occurrence inférieure, sélectionnez-la et appuyez sur Suppr; pour la rétablir,

sélectionnez l’occurrence supérieure et choisissez Mise en page > Rétablir l’aspect original
(raccourci Ctrl+Shift+D ou xXD).

Vous pouvez paramétrer combien de d’occurrences du texte vous souhaitez voir apparaître, et au-

dessus de quelles portées – b 3.9 Modifier les styles de texte et 8.8 Style maison.

D’autres objets de système se comportent de manière similaire, comme les repères de répétition.

Paroles
Les styles de texte dans le sous-menu Insertion > Texte > Paroles sont quelque peu spéciaux –

b 3.3 Paroles.

Typographie du texte de 
tempo et d’indication 
métronomique
Les modifications soudaines du 

tempo devraient être écrites en 

majuscules pour attirer l’atten-

tion: Molto vivace, TempoI, 

Più mosso. Les modifications 

graduelles de tempo commen-

cent par une lettre minuscule: 

poco rit., accel.

Si le texte de tempo ou l’indica-

tion métronomique est placé 

au-dessus d’une indication de 

mesure, son extrémité gauche 

s’aligne sur l’indication.
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Titre, Sous-titre, Compositeur, Parolier, Dédicace
Il est plus rapide de créer la plupart de ces textes dans la boîte de

dialogue Fichier > Nouveau lorsque vous créez votre partition,

même si on peut les ajouter facilement ultérieurement. Par défaut,

ces styles de texte sont alignés sur la gauche, le centre ou la droite

de la page, ce qui signifie que le texte dans ces styles ne peut se

déplacer que verticalement, pas horizontalement.

Vous pouvez placer des titres au-dessus de n’importe quel système

dans la partition, pas seulement au début – comme c’est le cas pour

ajouter un nouveau titre au début d’une nouvelle section, d’une

mélodie ou d’un mouvement, par exemple; cependant si vous faites

cela, il est recommandé de placer un saut de système ou de page à

la fin du système précédent pour garder les sections séparées.

On souhaitera parfois que ces styles de texte aient une position fixe

sur la page plutôt qu’une position relative à la portée supérieure.

Pour cela, réglez pour chaque style l’onglet Pos. verticale de la

boîte de dialogue Style maison > Modifier les styles de texte (raccourci Ctrl+Shift+Alt+T ou

xzXT) sur une valeur fixe de mm de la marge supérieure.

Doigté
(Dans Insertion > Texte > Autre texte de portée.) C’est le style des doigtés de clavier, cuivres et

cordes. Appuyez sur Retour (clavier principal) après chaque chiffre et sur Espace pour la note

suivante.

Sibelius peut ajouter automatiquement des doigtés de cuivre et de corde, et repositionner les

doigtés pour éviter les collisions avec les notes – b 6.1 Travailler avec des extensions.

Texte en petits caractères et texte encadré
Ces styles servent à certaines instructions de type technique. Le texte encadré est utile pour des

instructions importantes telles qu’un changement d’instrument.

Copyright
Une ligne de copyright est généralement écrite sur la première page d’une partition. Ce style de

texte (choisissez Insertion > Texte > Autre texte de système > Copyright) se place en bas de la

page, est centré, et est extrait dans toutes les parties séparées. Le symbole © est disponible à partir

du menu contextuel.

Vous devriez créer le texte à la première mesure de la partition – bien qu’il apparaîtra en bas de la

page, il sera en fait attaché à la première mesure, ce qui garantit qu’il restera toujours sur la

première page même si la mise en forme de la partition est modifiée.

Note en bas de page
Ce style place le texte en bas de la page. Pour créer une note en bas de page, sélectionnez une note

de la mesure concernée, puis choisissez Insertion > Texte > Autre texte de portée > Note en bas
de page. Le signe d’insertion apparaîtra toutefois en bas de la page.

Règles pour les doigtés
Dans la musique pour clavier, les 

doigtés pour la main droite se pla-

cent au-dessus des notes et pour la 

main gauche en dessous. Les tri-

olets et autres multiplets doivent 

être déplacés de l’autre côté des 

notes si nécessaire pour éviter les 

collisions.

Les doigtés sont centrés horizon-

talement sur les notes. Quand ils 

se suivent, il n’est pas indispens-

able qu’ils soient alignés sur une 

rangée – il est préférable qu’ils 

restent proches de chaque note 

auxquelles ils s’appliquent et 

qu’ainsi, ils puissent en suivre la 

hauteur.
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Vous pouvez renvoyer à la note en bas de page par une astérisque ou un chiffre en utilisant par

exemple du texte de technique au-dessus de la portée. La note en bas de page entrée restera

toujours sur la même page que la mesure à laquelle elle se rapporte. Elle sera également

uniquement extraite dans la partie séparée de la portée concernée.

En-tête et en-tête (après la 1ère page)
L’en-tête est le texte qui est placé au sommet de chaque page – par ex. le nom du morceau, ou de

l’instrument dans une partie séparée.

En-tête (dans Autre texte de système) produit le même texte sur chaque page; si vous modifiez

l’en-tête sur n’importe quelle page, elle changera automatiquement sur toutes les autres pages.

Les en-têtes et les pieds-de-page apparaissent sur la page où vous les placez ainsi que sur toutes les

pages suivantes, mais pas sur les pages précédentes. Vous devriez normalement placer l’en-tête et

le pied-de-page sur la première page pour qu’ils apparaissent tout au long de la partition. En-tête
(après la 1ère page) fonctionne de la même manière mais est absent de la première page pour

éviter d’empiéter sur le titre. L’en-tête est un texte de système et est donc extraite dans toutes les

parties séparées.

Pied de page
Le pied-de-page est le texte qui se place en bas de chaque page. Insertion > Texte > Autre texte de
portée > Pied-de-page (bord extérieur) se place sur la droite des pages de droite et sur la gauche

des pages de gauche; Pied-de-page (bord intérieur) se place du côté intérieur.

Comme pour les en-têtes, vous devriez normalement créer le pied-de-page sur la première ou

peut-être la seconde page; il apparaîtra automatiquement sur toutes les pages suivantes (mais pas

les précédentes). Si vous modifiez le pied-de-page sur n’importe quelle page, il changera

automatiquement sur toutes les autres pages. Le pied-de-page est un texte de système et est donc

extrait dans toutes les parties séparées.

Texte normal
Pour créer du simple texte dans votre partition, par exemple pour taper diverses instructions

d’interprétation ou des paroles en blocs, utilisez Insertion > Texte > Autre texte de portée >

Texte normal.
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3.3 Paroles

b 3.1 Utiliser du texte, 3.9 Modifier les styles de texte.

On définit les paroles comme le texte placé sous les notes et destiné à être chanté. Il y a trois façons

de créer les paroles :

* en les tapant directement ;

* en les copiant dans Sibelius à partir d’un traitement de texte ou d’un autre programme ;

* en plaçant automatiquement les paroles dans la partition à partir d’un fichier texte, avec

installation automatique des traits d’union de césure entre les syllabes.

Les paroles qui forment un ensemble, pour des couplets supplémentaires d’une chanson ou d’un

hymne, sont créés selon un autre procédé, car elles ne s’alignent pas avec les notes – cf. ci-dessous

Paroles en paragraphe.

Saisir des paroles
Pour saisir des paroles directement dans Sibelius :

* Entrez les notes pour lesquelles vous voulez écrire des paroles

* Sélectionnez la note à partir de laquelle vous souhaitez que commencent les paroles et choisissez

Créer > Texte > Paroles > Strophe 1 (raccourci Ctrl+L ou XL)

* Commencer la saisie des paroles

* Appuyez sur - (trait d’union) à la fin de chaque syllabe d’un mot

* Appuyez sur Espace à la fin de chaque mot

* Si une syllabe dure deux ou plus de deux notes, appuyez sur Espace ou - une fois pour chaque note

* Si un mot est suivi d’une virgule, d’un point ou d’un autre signe de ponctuation, tapez-le avant

d’appuyer sur Espace.

Si vous avez besoin de plus d’une note par mot ou d’une élision, cf. Plusieurs mots par note et
élisions ci-dessous.

Modifier les paroles
Les paroles peuvent se modifier à peu près de la même manière que tout autre texte. On peut les

changer, les altérer, les déplacer, les copier ou les supprimer.

Pour modifier un mot, double-cliquez-le, ou sélectionnez-le et appuyez sur Retour (sur le clavier

principal). Les flèches avant et arrière s’utilisent pour se déplacer entre les mots et les syllabes.

En supprimant une syllabe, on supprime également toute ligne ou tout trait d’union qui

apparaîtrait à sa droite (ils sont attachés à la syllabe).

On peut déplacer une syllabe vers la gauche ou vers la droite en la sélectionnant (de manière à ce

qu’elle devienne bleu foncé, sans que le signe d’insertion n’apparaisse) et en appuyant sur Espace
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ou Maj-Espace. De la même manière, vous pouvez prolonger ou rétracter une ligne de parole ou

une rangée de traits d’union en sélectionnant l’extrémité droite et en appuyant sur Espace ou Maj-
Espace.

Strophes, refrains et traductions
Il est courant en musique vocale que deux strophes voire plus

apparaissent sous la même musique. On l’indique par le numéro

de la strophe écrit avant le premier mot ou la première syllabe de

chaque strophe, par ex. “1. Le”

Dans cet exemple, vous taperiez “1. Le” comme un seul objet

textuel en utilisant une espace sans rupture (cf. ci-dessous

Plusieurs mots par note et élisions).

Pour entrer une seconde strophe, choisissez simplement Créer >

Texte > Paroles > Strophe 2 (raccourci Ctrl+Alt+L ou zXL) et

procédez de la même manière que pour les autres paroles; elles

apparaîtront automatiquement en dessous de la première strophe.

Pour placer une traduction en italique sur la seconde ligne, utilisez

Strophe 2 et modifiez-en le style de texte de façon à obtenir des

italiques (b 3.9 Modifier les styles de texte), ou activez

temporairement les italiques en appuyant sur Ctrl+I ou XI.
Pour des chorus en ligne 1, utilisez plutôt Créer > Texte > Paroles > Paroles (chorus), qui est réglé

sur italique.

Les styles de texte sont prédéfinis pour cinq strophes. Les styles des strophes 3,4 et 5 se trouvent

dans Créer > Texte > Paroles. Pour créer plus de strophes, utilisez Style maison > Modifier les
styles de texte (raccourci Ctrl+Maj+Alt+T ou xzXT) – b 3.9 Modifier les styles de
texte.

Pour ajouter rapidement des numéros de strophe à votre partition après avoir entré les paroles,

utilisez l’extension Extensions > Texte > Ajouter des numéros de strophe – b 6.1 Travailler
avec des extensions.

Copier des paroles dans Sibelius
Vous pouvez copier et coller des paroles entre différents programmes (tels que les traitements de

texte) et Sibelius, d’une partie de partition vers une autre dans Sibelius, ou d’une partition à l’autre.

Le texte copié peut être normal, sans césure ou déjà avec les traits d’union entre les syllabes, par

exemple :

Ma-ry had a lit-tle lamb, 
its fleece was white as snow.

Si le texte n’a pas encore de césure, Sibelius va diviser les syllabes automatiquement.

Vous pouvez à indiquer à Sibelius quelle langue est utilisée pour les paroles et réglez d’autres

options dans la page Autres de Fichier > Préférences (dans le menu Sibelius sur Mac). D’autre

options similaires se trouvent aussi dans la boîte de dialogue Créer > Texte > Paroles > À partir
d’un fichier texte (cf. Créer des paroles à partir d’un fichier texte ci-dessous ).

Quelques règles de gravure 
pour les paroles
Les paroles se placent normalement 

en dessous de la portée. Elles ne 

sont écrites au-dessus de la portée 

que si deux portées partagent le 

même texte (par ex. dans un 

hymne), ou si une portée comporte 

deux voix avec les mêmes paroles.

Les syllabes chantées sur différentes 

notes sont séparées plusieurs traits 

d’union. Si la dernière syllabe d’un 

mot se prolonge sur plusieurs notes, 

une “ligne de parole” est dessinée 

après la dernière syllabe le long des 

notes chantées sur cette syllabe. La 

ponctuation se place avant la ligne 

de parole.
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Pour copier les paroles dans Sibelius :

*  Sélectionnez le texte destiné à être copié

%  Si vous copiez à partir de Sibelius, sélectionnez les paroles à copier: utilisez soit une sélection

en lasso (b 1.9 À propos des sélections et des passages) ou sélectionnez une seule

syllabe et choisissez Édition > Sélectionner > Sélectionner Plus (ou appuyez sur

Ctrl+Maj+A ou xXA) pour sélectionner une ligne de paroles, puis choisissez Édition >

Copier (raccourci Ctrl+C ou XC)

% Si vous copiez à partir d’un autre programme, sélectionnez le texte que vous souhaitez copier

et dans les menus de ce programme choisissez Edition > Copier (raccourci, normalement,

Ctrl+C ou XC) pour le copier dans le presse-papiers 

* Sélectionnez la note sous laquelle commenceront les paroles copiées puis choisissez Créer >

Texte > Paroles > Strophe 1 (raccourci Ctrl+L ou XL); un signe d’insertion clignotant apparaît

* Appuyez ensuite sur Ctrl+V ou XV, ce qui colle une syllabe ou un mot d’une syllabe jusqu’à

l’espace ou à la césure suivante (c’est donc le texte de la valeur d’une note qui est collé)

* S’il est nécessaire de prolonger le mot ou la syllabe au-delà d’une note appuyez sur Espace ou -
(trait d’union) ; le texte copié se manipule aussi normalement que s’il était tapé directement.

* Pour entrer le mot ou la syllabe qui suit, rappuyez sur Ctrl+V ou XV 

* En cas d’erreur, vous pouvez choisir Édition > Annuler (raccourci Ctrl+Z ou XZ) ce qui

supprimera de la partition le dernier mot ou la dernière syllabe collé et le replacera dans le

presse-papiers où il sera à nouveau disponible pour être collé.

Si le texte copié contient des traits d’union ou des espaces supplémentaires entre les mots ou les

syllabes, ou des syllabes chantées sur plus d’une note, le collage n’en tient pas compte. Cela s’avère

utile, par exemple, quand on copie des paroles d’une portée sur une autre dont le rythme diffère.

Astuce : Quand vous collez des paroles comme celles-là, vous pouvez taper Espace entre chaque

syllabe, même au milieu d’un mot – Sibelius écrira malgré tout une césure là où c’est requis.

Copier une ligne entière de paroles
Voici cependant une méthode rapide pour copier une ligne entière de paroles à un autre endroit de

la partition lorsque le rythme en est identique :

* Sélectionnez la ligne de parole originale en sélectionnant un mot ou une syllabe et en choisissant

Édition > Sélectionner > Sélectionner Plus (raccourci Ctrl+Maj+A ou xXA)

* Choisissez Édition > Copier (raccourci Ctrl+C ou XC)

* Sélectionnez la première note du passage de destination où commenceront les paroles à coller

* Choisissez Édition > Coller (raccourci Ctrl+V ou XV), sans choisir préalablement Créer >

Texte > Paroles > Strophe 1 pour que les paroles se collent en une fois.

Si, une fois collées, les paroles entrent en collision, sélectionnez le passage incriminé et choisissez

Mise en page > Réinitialiser l’espacement des notes (raccourci Ctrl+Maj+N ou xXN).
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Copier des paroles d’une ligne (ou d’un couplet) vers un autre
Il est assez courant dans les chansons que des paroles identiques se placent dans les phrases

similaires des différents couplets, ce qui rend intéressant la possibilité de pouvoir copier dans un

couplet les paroles déjà écrites dans un autre. Par exemple, si vous voulez copier les paroles en style

de texte Paroles ligne 1 vers le style Paroles ligne 3 :

* Faites une sélection de passage de la musique qui contient les paroles à copier

* Choisissez Édition > Filtrer > Filtre avancé (raccourci Ctrl+Maj+Alt+F ou xzXF)

* Dans la boîte de dialogue qui apparaît, désactivez les options Rechercher pour Texte

* Dans la liste des styles de texte qui apparaît à droite, cliquez sur Aucun et choisissez Paroles
ligne 1

* Cliquez sur Sélectionner

* Copiez les paroles du presse-papiers en utilisant Édition > Copier (raccourci Ctrl+C ou XC)

* Sélectionnez la note où doivent commencer les paroles copiées et choisissez Édition > Coller
(raccourci Ctrl+V ou XV)

* Dans le panneau Texte de la fenêtre des propriétés, faites passer le style de texte des paroles du

style Paroles ligne 1 au style Paroles ligne 3

* Choisissez Mise en page > Réinitialiser les positions (Ctrl+Maj+P ou xXP).

Copier des paroles à partir de Sibelius
Il peut être utile de copier et de coller des paroles venant de Sibelius, soit dans un autre programme

(par ex. un traitement de texte) ou encore dans un paragraphe à la fin d’une partition dans Sibelius

(cf. Paroles en paragraphe ci-dessous ). Voici comment procéder :

* Sélectionnez les paroles que vous souhaitez copier (par ex. sélectionnez un passage ou la

partition entière puis choisissez Édition > Filtrer > Paroles) et choisissez Édition > Copier
(raccourci Ctrl+C ou XC) pour les copier dans le presse-papier

* Collez maintenant les paroles à l’endroit désiré :

% Pour copier les paroles dans Sibelius, créez un signe d’insertion approprié, par ex. pour un

paragraphe de paroles, choisissez Créer > Texte > Autre texte de portée > Texte normal et

cliquez dans la partition, puis choisissez Édition > Coller (raccourci Ctrl+V ou XV) pour

coller les paroles

% Pour coller les paroles dans un autre programme, basculez dans celui-ci et choisissez

Édition > Coller (raccourci, normalement Ctrl+V ou XV).

Le texte collé contiendra des traits d’union entre les syllabes qu’il faudra supprimer.

Si vous souhaitez sauvegarder rapidement toutes les paroles d’une partition, utilisez Extensions >

Texte > Exporter des paroles – b 6.1 Travailler avec des extensions.

Créer des paroles à partir d’un fichier texte
Sibelius peut lire les paroles d’un fichier texte et les incorporer dans une partition

automatiquement, en installant les césures dans les mots et en les répartissant sous les notes d’une

portée, y compris sous forme de mélisme, qui est une syllabe isolée ou un mot chanté sur plus

d’une note, ce qu’indique la liaison de legato qui surmonte les notes concernées.
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Tout d’abord, parcourez la partition et vérifiez si vous avez créé

des liaisons partout où vous souhaitez que Sibelius installe des

mélismes.

Ensuite, il faut vous assurer que les paroles du fichier texte soient

en format normal. Si vous utilisez Word, choisissez Fichier >

Enregistrer sous, et réglez le document type sur texte normal
(ou Texte seulement sur Mac) ; si vous utilisez une autre

application, les étapes devraient se ressembler.

Dès que c’est prêt, sélectionnez les mesures de la portée ou des

portées qui doivent recevoir les paroles, puis choisissez Créer >

Texte > Paroles > À partir d’un fichier texte. Une simple boîte

de dialogue apparaît telle qu’illustrée à droite.

* Choisissez le fichier texte qui contient les paroles en cliquant

sur Parcourir

* Choisir la langue des paroles devrait être réglé sur la langue utilisée par les paroles (sont

proposés l’anglais, le français, l’allemand, l’italien, l’espagnol et le latin) ; Sibelius devrait deviner

la langue automatiquement, mais en cas d’erreur c’est ici qu’il faut corriger avant l’opération

* Placement intelligent des syllabes des mots ambigus détermine comment Sibelius travaille

quand il rencontre des mots dont les césures peuvent être placées à différents endroits (par ex.

“everything” peut être séparé en “ev-er-y-thing” ou “ev’-ry-thing”). Quand l’option est activée,

Sibelius examine à la fois la structure de la musique à laquelle les paroles sont ajoutées, et le

phrasé du texte lui-même, dans le but de déterminer le résultat musical le plus satisfaisant.

Si l’option est désactivée, Sibelius vous demandera de choisir la césure qui convient pour chaque

mot ambigu.

* Style de texte des paroles détermine quel type de texte Sibelius utilisera pour les paroles

ajoutées à la partition

* Supprimer d’abord les paroles existantes enlèvera dans le passage sélectionné toutes les

paroles d’un style choisi, avant d’ajouter des nouvelles paroles ; cette option est pratique à utiliser

de manière successive, par exemple après avoir corrigé une erreur dans la musique ou après

avoir ajouté une liaison pour corriger un mélisme.

* Indiquer une apostrophe pour les pseudo-diphtongues est l’option qui oblige Sibelius à

indiquer pour les mots ambigus où il choisit de combiner deux syllabes en une seule; par ex. en

scindant “everything” en trois syllabes plutôt que quatre, avec l’option activée, il écrira “ev’-ry-

thing”, et avec l’option désactivée il écrira “eve-ry-thing”. Comme en général on utilise une

apostrophe dans ce type de situation, il est recommandé de laisser l’option activée.

* Si Avertir quand les paroles ne peuvent correspondre à la musique est activé, Sibelius vous

demandera de déterminer s’il y a trop de paroles pour la musique ou vice-versa et vous

proposera l’option à utiliser si nécessaire.

Quand vous cliquez sur OK, Sibelius ajoute les paroles au passage sélectionné dans la partition. Si

Sibelius est incapable de déterminer ce qui convient pour les mots ambigus, il vous demandera de

l’aider: la boîte de dialogue Placement des césures apparaîtra, affichant le mot à problème et

permettant de choisir entre différentes manières de faire la césure; passez avec la souris sur la boîte
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déroulante découvrir un outil astucieux qui affiche le mot dans son contexte. Vous pouvez activer

Placer les césures de la même manière pour les mots ressemblants pour obliger Sibelius à

utiliser le même schéma de césure pour les mots aux caractéristiques semblables (par ex. le même

suffixe).

Si les paroles passe d’une langue à l’autre, vous pouvez ajouter une commande spéciale au fichier

de texte qui indique à Sibelius où changer de règles de césure pour l’autre langue; il suffit de placer

le nom de la langue entre deux accolades, par ex. {Anglais} ou {Allemand}.

Pour obliger un mot à se scinder d’une manière particulière, il suffit d’ajouter les césures dans le ou

les mots dans le fichier de texte qui contient les paroles à ajouter.

Dans certaines langues, telles que l’espagnol ou l’italien, il est habituel de faire l’élision de la fin d’un

mot avec le début du suivant, pour traiter deux syllabes en une (par ex. “donde irà” en espagnol

peut être chanté en trois syllabes plutôt que quatre, par exemple, “don-de_i-rà”). Sibelius réalise

cela automatiquement de manière adéquate.

Division syllabique
Lors du placement des césures, il est important de scinder aux bons endroits, sinon les syllabes

peuvent être difficiles à lire. Voici à vue de nez quelques règles à suivre (même si des exceptions

sont possibles) :

* Considérez les préfixes et les suffixes comme des syllabes séparées

* Si entre deux syllabes il n’y a qu’une seule consonne (par ex. labeur), scindez avant la consonne

(la-beur)

* Si entre deux syllabes il y a deux consonnes (par ex. meilleur, Batman), scindez entre les deux

(meil-leur, Bat-man).

Comme il y a des exceptions, en cas de doute, assurez-vous que chaque syllabe peut être lue et

prononcée correctement isolément ; par ex., “polyptyque” pourrait être scindé en “polyp-tyque”

plutôt qu’en “poly-ptyque”, ce qui sonnera différemment à la lecture.

Naturellement en cas de problème, n’hésitez pas à consulter un dictionnaire !

Vérifier les césures
Faire une erreur en plaçant les césures soi-même est quelque chose qui arrive très facilement ;

heureusement Sibelius propose une extension pratique qui vérifie les césures des paroles d’une

partition – cf. Vérifier les césures à la page 581.

Partager des paroles
Si deux portées ont des rythmes identiques ou quasi identiques,

vous pouvez écrire une seule ligne de paroles entre elles qui

s’applique aux deux portées ; lorsque les rythmes diffèrent

légèrement vous devriez positionner les syllabes horizontalement

entre les notes (comme pour le “-ry” et le “on” de l’illustration).

Paroles dans deux voix
Dans la musique chorale, il est fréquent que deux lignes vocales se partagent la même portée (par

exemple sopranos et altos sur une seule portée). Souvent un seul jeu de paroles est suffisant car

dans ce genre de musique les rythmes des deux lignes vocales sont en général similaires ; quand les

rythmes sont dissemblables, il est plus clair d’écrire chaque ligne vocale sur une portée séparée.
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Si cependant les rythmes ou les paroles différent sensiblement durant quelques mesures

seulement, l’idéal est écrire une ligne supplémentaire de paroles au-dessus pour la voix 1 et une

ligne séparée en dessous pour la voix 2. La ligne de paroles supplémentaire peut apparaître

seulement pour quelques notes, car si elle n’est pas présente pour tout le système, il est beaucoup

plus clair qu’elle n’apparaisse que lorsque la musique se divise en deux voix :

Lorsque vous ajoutez des paroles pour de la musique à deux voix, vous pouvez choisir la voix pour

laquelle vous souhaitez créer les paroles avant de commencer :

* Créez toutes les notes (tant pour la voix 1 que la voix 2)

* Pour créer les paroles de la voix 1 au-dessus de la portée, choisissez Créer > Texte > Autre texte
de portée > Paroles au-dessus de la portée

* Pour ajouter des paroles à la voix 2, sélectionnez la première note de voix 2 à laquelle vous

souhaitez ajouter des paroles, puis choisissez Créer > Texte > Paroles > Strophe 1 (raccourci

Ctrl+L ou XL).

Plusieurs mots par note et élisions
Dans les dialogues chantés (comme les récitatifs) il arrive souvent que plusieurs mots doivent être

chantés sur une seule longue note. Dans ce cas, il n’est pas possible de placer une espace ou un trait

d’union après la première syllabe, car le signe d’insertion se déplacerait immédiatement à la note

suivante.

Pour éviter cela utilisez la combinaison spéciale Ctrl+Espace ou z-Espace et Ctrl+- (trait

d’union) ou z-– q produit des espaces et des traits d’union sans rupture (c-à-d qui ne déplacent

pas à la note suivante). Ces combinaisons de touches s’avèrent parfois utiles pour la création

d’autres types de texte, comme les symboles d’accord.

De la même manière, en italien et quelques autres langues, deux syllabes élidées sont souvent

écrites sur la même note avec un caractère d’élision entre elles, par ex. Ky – ri – e_e – lei – son. Pour

obtenir cela, tapez simplement _ (souligné) lorsque vous créez des paroles pour obtenir un

caractère d’élision.

Vous pouvez également utiliser le caractère d’élision comme une liaison dans les paroles en

paragraphe, par exemple, à la fin d’une ligne d’un hymne.

Liaisons et ligatures
Quand plusieurs notes sont chantées sur la même syllabe, vous

pouvez les joindre avec une liaison de legato pour que le début et

la fin de la syllabe soient bien clairs. L’extension Extensions >

Texte > Ajouter des liaisons aux paroles réalise cela

automatiquement. Pour éviter d’encombrer la partition avec des

liaisons non indispensables, une bonne stratégie consiste à les

utiliser uniquement si l’agencement du texte est complexe ou

prête à confusion. Les longues liaisons de phrasé devraient être

évitées dans la musique vocale.

 

La ponctuation dans les paroles
Quand les paroles sont tirées d’un 
poème, il faut respecter l’usage des 
majuscules (au début des lignes) et 
la ponctuation (à la fin des lignes et 
ailleurs) du texte original. La 
ponctuation se place avant la ligne 
de parole.

Si une partie de phrase qui n’est pas 
répétée dans le texte original, placez 
une virgule avant la répétition, par 
ex. “My sister, my sister, my sister”.
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Dans les partitions anciennes, les notes chantées sur des syllabes séparées ne sont jamais ligaturées

ensemble, pour que soit bien clair le lien entre les notes et les syllabes. Cette convention est de plus

en plus abandonnée (parce qu’elle rend le rythme difficile à lire) mais si malgré tout vous souhaitez

l’utiliser, choisissez l’extension Extensions > Texte > Ligatures traditionnelles avec les paroles qui

réalise cela automatiquement.

Pour en savoir plus sur ces extensions, b 6.12 Extensions de texte.

Ponctuation suspendue 
Si vous tapez le mot “Oh,” comme parole, alors Sibelius en centrera les lettres sous les notes sans

tenir compte de l’espace occupé par la virgule, qui se déportera à droite. De la même manière, si un

verset commence avec “1. The” le mot “The” est centré et le “1.” est déporté à gauche. Ce sont des

exemples de cette jolie expression typographique Ponctuation suspendue.

Si vous ne souhaitez pas que Sibelius utilise la ponctuation suspendue, désactivez ponctuation
suspendue dans la page Texte de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Maj+E ou xXE).

Position horizontale
La position horizontale des paroles est contrôlée par Sibelius selon des règles complexes. Tandis

que vous tapez chaque syllabe, Sibelius en ajuste la position précise d’après sa largeur et le nombre

de notes concernées :

* Les paroles sont centrées si un mot ou une syllabe est suivi d’un autre mot ou d’une autre syllabe

sur la note suivante

* Les paroles ne sont pas centrées si un mot ou une syllabe est suivi par :

% Un nouveau mot, deux notes au moins plus loin ; dans ce cas, le mot est aligné à gauche sur la

note concernée et est suivi d’une ligne de prolongation.

% Une nouvelle syllabe, deux notes au moins plus loin; par défaut la syllabe est alignée à gauche

sur la note concernée et est suivie d’un ou plusieurs traits d’union; mais la syllabe sera centrée

si Centrer les syllabes suivies d’une césure dans la page Texte de la boîte de dialogue

Style maison > Règles de gravure est activé.

Une fois que les paroles ont été entrées, vous pouvez déplacer les syllabes individuellement vers la

gauche ou la droite comme tout autre texte pour modifier leur position si nécessaire.

Les syllabes sont attachées aux notes sous lesquelles elles sont écrites, de sorte que si vous modifiez

l’espacement elles se déplacent aussi. S’ajoute à cela le fait que plus on éloigne deux syllabes

séparées par des traits d’union et plus ceux-ci apparaissent en s’ajustant pour rester centrés entre

les syllabes.

Si vous voulez ajuster vous-même l’espacement horizontal des paroles, sélectionnez la mesure ou le

passage en question, et utilisez Maj+Alt+0/1 ou xz0/1 pour resserrer ou élargir l’espacement à

volonté (Ctrl+Maj+Alt+0/1 ou xzX0/1 pour obtenir de plus grands espacements) –

b 8.9 L’espacement entre les notes.

Pour rétablir l’espacement par défaut, il suffit de sélectionner le passage concerné et choisir Mise
en page > Réinitialiser l’espacement des notes (raccourci Ctrl+Maj+N ou xXN).
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Le comportement de cette fonction est déterminée par l’option Laisser de l’espace pour les
paroles dans Style maison > Règle d’espacement des notes, qui doit être activée pour éviter

des collisions en utilisant Mise en page > Réinitialiser l’espacement des notes. Si vous

désactivez cette option, Sibelius ignorera complètement les paroles au moment de réespacer la

musique, donc garder cette option activée est recommandé.

Les syllabes particulièrement longues centrées sur la première note d’une mesure peuvent

chevaucher la barre de mesure précédente, ce qui dans les passages serrés, peut provoquer une

collision avec les paroles qui terminent la mesure précédente ; si vous préférez éviter ce

comportement, désactivez Autoriser la première syllabe à chevaucher la barre de mesure
dans la boîte de dialogue Style maison > Règle d’espacement des notes.

Parfois l’espacement à devoir allouer aux paroles très larges rend l’espacement des notes inégal;

c’est un des cauchemars de la gravure musicale qui requiert de faire un compromis entre le

meilleur espace pour les paroles et celui pour les notes. Pour des exemples et des conseils à ce sujet,

b 8.9 L’espacement entre les notes.

Les traits d’union de césure des paroles
Quand des syllabes sont réparties entre les notes, un trait d’union indiquant la césure apparaît

entre elles ; là où des syllabes sont chantées sur plusieurs notes, plusieurs traits d’union

apparaissent en fonction de la distance entre les syllabes.

Le trait d’union individuel qui sépare deux syllabes sous deux notes est très précisément centré

entre les syllabes. S’il y a plusieurs traits d’union, leur placement suit les options de la page Texte
de la boîte de dialogue Style maison > Règles de gravure – cf. Options des règles de
gravure ci-dessous.

En anglais, on accepte l’absence de trait d’union entre les syllabes quand la place manque (par ex.

des mots tels que, “little” sur des notes brèves et rapprochées). Cependant dans les autres langues,

l’absence de trait d’union peut changer complètement la signification du texte. Sibelius essayera

toujours de laisser suffisamment d’espace pour un trait d’union entre deux syllabes, mais dans les

situations très serrées, ce n’est pas toujours possible. (Si vous ne voulez pas que Sibelius garantisse

le placement du trait d’union, désactivez Autoriser de l’espace supplémentaire pour les traits

d’union dans la boîte de dialogue Style maison > Règle d’espacement des notes).

Quand des mots sont scindés à la fin d’un système, deux écoles existent concernant la nécessité de

faire apparaître un trait d’union au début du second système en plus de celui de fin de système

précédent. Sibelius prévoit les deux conventions: si vous voulez que les tirets apparaissent au début

des systèmes, activez l’option dans la boîte de dialogue Style maison > Règles de gravure.

Cependant Sibelius ne peut garantir qu’un trait d’union apparaîtra au début du second système,

même si Autoriser les traits d’union en début de système est activé. Si vous constatez qu’un

trait d’union n’apparaît pas à un endroit où il est nécessaire, augmentez un petit peu l’espace avant

la première note du système qui suit le saut, et le trait d’union apparaîtra.

Si vous trouvez qu’un trait d’union n’est pas correctement centré entre deux syllabes, sélectionnez-

le et choisissez Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou xXP).

Après les avoir sélectionné, vous pouvez aussi déplacer les traits d’union vers la gauche ou vers la

droite avec la souris.
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Position verticale
Sibelius place les paroles à une position verticale standard en dessous de la portée, et s’assurera

qu’elles ne rentreront pas en collision avec d’autres notes ou indications, afin de vous éviter à avoir

à le faire. Cependant, vous pouvez déplacer les syllabes individuellement de haut en bas comme

pour tout autre texte.

Pour déplacer une ligne de paroles, cliquez sur l’un des mots et choisissez Édition > Sélectionner >

Sélectionner plus (raccourci Ctrl+Maj+A ou xXA) pour sélectionner la ligne entière, puis

déplacez les paroles à l’aide des flèches (Ctrl+3/2 ou X3/2 pour de grands incréments).

Alternativement, après avoir sélectionné une ligne de paroles de cette manière vous pouvez les

aligner sur une rangée en utilisant Mise en page > Aligner sur une rangée (raccourci

Ctrl+Maj+R ou xXR), les replacer à leur position verticale par défaut en utilisant Mise en page >

Réinitialiser les positions (Ctrl+Maj+P ou xXP), ou les Supprimer.

Pour aligner rapidement toutes les paroles de la partition, utilisez l’extension Extensions > Texte >

Aligner les paroles – b 6.1 Travailler avec des extensions.

Pour modifier la position verticale des paroles, b 8.12 Positions par défaut.

Style de texte
Vous pouvez modifier l’apparence des paroles de diverses manières:

* En utilisant Style maison > Modifier les styles de texte (raccourci Ctrl+Maj+Alt+T ou

xzXT) pour modifier les styles de texte de parole globalement (par ex. si vous souhaitez que

toutes les paroles de la partition soit dans une police particulière, ou toutes en italiques) –

b 3.9 Modifier les styles de texte

* Toute modification faite à l’apparence des paroles par la fenêtre des propriétés

(b 5.17 Propriétés) pendant l’édition des paroles s’applique à tout le texte ultérieur, par ex. si

vous changez pour une police en italiques puis appuyez sur Espace pour aller au mot suivant,

celui-ci et tous les suivants seront en italiques jusqu’à ce que vous les désactiviez explicitement

ou que vous interrompiez la saisie de paroles.

Si vous souhaitez rétablir l’apparence par défaut des paroles (c’est-à-dire les réglages définis dans

Style maison > Modifier les styles de texte), sélectionnez-les et choisissez Mise en page >

Rétablir l’aspect original (raccourci Ctrl+Maj+D ou xXD).

Si vous changez la police ou la taille des paroles – soit en modifiant le style de texte avec Style
maison > Modifier toutes les polices ou en important un style maison (b 8.8 Style maison)

– il sera peut être nécessaire d’utiliser Mise en page > Réinitialiser l’espacement des notes
(raccourci Ctrl+Maj+N ou xXN), si les paroles occupent plus ou moins d’espace horizontal

qu’auparavant.

Paroles en paragraphe
Les strophes supplémentaires d’une chanson ou d’un hymne peuvent faire l’objet d’un paragraphe

séparé placé en fin de partition. Puisqu’il va de soi qu’elles ne s’alignent pas sur les notes, il faut

considérer ces paroles comme un autre type de texte que les paroles normales.

Pour entrer un paragraphe de paroles, utilisez Créer > Texte > Autre texte de système >

Paragraphe de paroles. Entrez simplement les paroles et appuyez sur Retour (sur le clavier
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principal) à la fin de chaque ligne, ou copiez les paroles à partir d’un autre endroit de la partition si

c’est possible (cf. Copier des paroles à partir de Sibelius ci-dessus). Il est pratique d’entrer

chaque strophe comme un objet textuel séparé, de façon à pouvoir les déplacer séparément.

Directions des hampes
Les notes sur la ligne médiane de la portée ont souvent leur hampe qui pointe vers le bas ; cependant,

quand il y a des paroles, la hampe est souvent orientée vers le haut pour éviter des collisions avec les

mots. Pour que cela se fasse automatiquement, modifiez les types de portées utilisées par les

instruments vocaux de votre partition via Style maison > Modifier les instruments – cf. Page
Notes et silences à la page 700.

Options des règles de gravure
Sur la page Texte de la boîte de dialogue Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE) vous pouvez définir la position des lignes de paroles et l’espacement des

traits d’union, ainsi que quelques autres options :

* Utiliser des traits d’union en texte (pas des symboles) pour que les traits d’union dans les

paroles soit écrits dans la police utilisée pour les paroles, plutôt que d’utiliser un symbole spécial

de la boîte de dialogue Créer > Symboles. Activée par défaut, cette option est appréciée par

beaucoup de graveurs et d’éditeurs.

* Un trait d’union maximum pour qu’un et un seul trait d’union soit utilisé, même si les syllabes

sont très espacées. Cette option est désactivée par défaut.

* Traits d’union autorisés en début de système contrôle si un trait d’union peut apparaître au

début d’un système lorsqu’il y a une syllabe sur la première note. Cette option est désactivée par

défaut.

* Ponctuation suspendue contrôle si Sibelius prend en compte la ponctuation suspendue lors-

qu’il positionne les paroles (cf. Ponctuation suspendue ci-dessus).

* Centrer les syllabes suivies d’un trait d’union aligne au centre les syllabes mélismatiques

(c-à-d maintenues sur plusieurs notes) qui sont suivies de traits d’union, plutôt que de les aligner

sur la gauche selon le comportement par défaut. Cette option est désactivée par défaut.

* Centrer toutes les syllabes contenant des caractères est-asiatiques est activé par défaut.

Les règles d’alignement des paroles pour les alphabets occidentaux ne sont pas appropriées pour

les langues est-asiatiques, dans lesquelles la plupart des paroles sont d’un seul caractère.

* Dessiner des liaisons entre les caractères est-asiatiques dessine de petites liaisons de

legato sous chaque partie de parole contenant plus d’un caractère est-asiatique, entre le premier

et le dernier caractère est-asiatique dans la syllabe, clarifiant le fait qu’elles doivent toutes être

chantées sur la même note. Activée par défaut, cette option est appréciée par beaucoup de

graveurs et d’éditeurs.
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3.4 Basse chiffrée et chiffres romains

b 3.1 Utiliser du texte.

La basse chiffrée, ou basse continue, est d’habitude utilisée dans la musique de la période baroque.

Les chiffres sont ajoutés à la ligne de basse là où des renversements et des changements

chromatiques sont requis; s’il n’y a pas de chiffres, cela signifie que l’interprète doit jouer les

accords parfaits construits d’après la note de basse en respectant l’armure.

Les chiffres romains sont d’habitude utilisés pour l’analyse harmonique. Sibelius permet de créer des

noms d’accord selon les conventions soit en lettre, soit en chiffre pour indiquer les renversements.

Par exemple, Sibelius peut afficher des accords de tonique renversés tels que Ic ou I6$.

Créer de la basse chiffrée
Sibelius propose un jeu complet de symboles pour la basse chiffrée avec la police Opus Figured

Bass, qui ressemble à la police Times.

Pour saisir de la basse chiffrée:

* Saisissez les notes sur la portée de basse ou du continuo

* Sélectionnez la première note, choisissez ensuite Créer > Texte > Autre texte de portée > Basse
chiffrée

* Pour entrer des chiffres sans altération, tapez les chiffres normalement sur le clavier

* Pour entrer des chiffres suivis d’un bécarre, utilisez les lettres minuscules sur la rangée W à O,

(clavier Qwerty), chaque lettre correspondant au chiffre au-dessus sur le clavier (par ex. W est w

). Pour ajouter le bécarre à gauche du chiffre (par ex. W), maintenez la touche Maj enfoncée

pendant que la touche appropriée est frappée.

* Pour entrer des chiffres suivis d’un dièse, utilisez les lettres S à K, chaque lettre correspondant au

chiffre au-dessus sur le clavier (par ex. S est s ). Pour ajouter le dièse à gauche du chiffre (par ex.

S), maintenez la touche Maj enfoncée pendant que la touche appropriée est frappée.

* Pour entrer des chiffres suivis d’un bémol, utilisez les lettres X à M, chaque lettre correspondant

au chiffre au-dessus sur le clavier (par ex. X est x ). Pour ajouter le bémol à gauche du chiffre

(par ex. X), maintenez la touche Maj enfoncée pendant que la touche appropriée est frappée.

* Tapez Retour (sur le clavier principal) pour installer une nouvelle ligne qui formera une colon-

ne de chiffres 

* Tapez Ctrl ou X avec les touches de chiffre du clavier principal pour ajouter des chiffres barrés.

La seule exception à cette règle est &, dont le raccourci est Maj-7.

* Pour avancer à la note ou au temps suivant, tapez Espace.
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D’autres caractères spéciaux sont proposés:

* Vous trouverez d’autres caractères dans le menu contextuel (clic-droit sous Windows ou

Contrôle-clic sur Mac), avec des raccourcis-clavier supplémentaires

* Tapez Espace pour avancer jusqu’à la note ou au temps suivant, qui arrive en premier.

La police Opus Figured Bass a été conçue par Tage Mellgren (www.editionglobal.com).

Créer des chiffres romains
Pour saisir des chiffres romains, choisissez Créer > Texte > Autre texte de portée > Chiffres
romains.

Pour entrer des accords contenant uniquement des caractères alphabétiques, tapez simplement les

lettres de l’accord.

Entrez des accords avec des chiffres est un peu plus compliqué, mais une fois compris, le processus

est très simple. Convenons que pour l’accord à entrer VY6£, le 6 est le chiffre en exposant supérieur

et 3 le chiffre en exposant inférieur:

* Tapez d’abord la racine alphabétique de l’accord de manière normale (par ex. V)

* Si le chiffre en exposant supérieur est affecté d’une altération, tapez X (dièse), Y (bémol) ou Z
(bécarre) selon ce qui convient, sinon passez à l’étape suivante

* Si le chiffre en exposant inférieur est affecté d’une altération, tapez Maj-X (dièse), Maj-Y
(bémol) ou Maj-Z (bécarre) selon ce qui convient, sinon passez à l’étape suivante

* Si vous avez entré des altérations que ce soit pour des chiffres en exposant supérieur ou inférieur,

avancez le curseur en tapant Maj-.

* Si l’accord comporte un chiffre en exposant supérieur, entrez-le en tapant le chiffre (par ex. 6)

* Si l’accord comporte un chiffre en exposant inférieur, entrez-le en tapant le chiffre tout en

maintenant enfoncée la touche Maj (c’est-à-dire Maj-3)

* Pour entrer des chiffres barrés en exposant supérieur, tapez les lettres de M à U, M pour le

chiffre 1, N pour le 2, etc... Si vous souhaitez entrer un chiffre en exposant inférieur, maintenez

la touche Maj enfoncée tout en tapant la lettre appropriée.

* Pour avancer à la note ou au temps suivant, tapez Espace.

q Q Q Maj-Q p P

P Maj-P a A A Maj-A

l L   L Maj-L z Z

Z Maj-Z = = , ,

< Maj-,  ; ;  : Maj-;

< Maj-,
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Symboles de fonction
Les symboles de fonction sont utilisés pour décrire la structure harmonique de la musique, en

utilisant des symboles tels que T pour désigner la tonique, D pour la dominante, etc....

Utilisez Créer > Texte > Autre texte de portée > Symboles de fonction pour créer des symboles

de fonction:

* Tapez Espace pour avancer jusqu’à la note ou au temps suivant.

* Si le symbole de fonction nécessite des parenthèses, U et I installent des parenthèses droites,

tandis que Maj-U et Maj-I installent des parenthèses normales.

* Si le symbole de fonction contient un chiffre en exposant inférieur sous le symbole principal,

tapez celui-là d’abord maintenant Alt ou z enfoncé et le chiffre compris entre 1 et 9, puis tapez

le symbole principal.

* Les principaux symboles sont entrés par les touches éponymes, par ex. d, D, t, T, s, S, g, G.

Les caractères de ligne de base ou  en exposant supérieur sont a et A.  est sur Shift-F; 

est sur Alt+F ou zF;  est sur Alt+D ou zD.

* Si un symbole de fonction est formé de deux rangées de chiffres suivant le symbole principal,

tapez le chiffre (sur-exposant supérieur) du haut en premier, puis l’autre (exposant supérieur). Si

le(s) chiffre(s) suivant le symbole supérieur sont eux-même suivis de “<“ ou ”>”, tapez tous les

chiffres avant “<“ ou ”>”.

* Pour les chiffres en exposant supérieur, tapez 1–9 sur le clavier principal. L’exposant supérieur

“v” est obtenu en tapant v. Les caractères “<“ et ”>” qui suivent les chiffres en exposant

supérieur sont obtenus en tapant, (virgule) et . (point).

* Pour les chiffres en sur-exposant supérieur, tapez Maj-1 à Maj-9 sur le clavier principal. Le sur-

exposant supérieur “v” est sur V. Les caractères “<“ et ”>” qui suivent les chiffres suivants en

exposant supérieur sont obtenus en tapant < et >.
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3.5 Numéros de mesure

Dans les partitions, les numéros de mesure apparaissent normalement au-dessus de la première

mesure de chaque système. On peut en ajuster la fréquence et la présentation selon tout desiderata.

Pour faciliter la navigation dans les grandes partitions on peut afficher à l’écran les numéros de

chaque mesure avec Affichage > Noms des portées et numéros de mesure; le nom de chaque

portée s’affichera aussi à gauche de l’écran – b 5.23 Menu affichage.

Toutes les options nécessaires pour ajuster les numéros de mesure imprimés dans la partition se

trouvent dans la page Numéros de mesure de Style maison > Règles de gravure (raccourci

Ctrl+Maj+E ou xXE).

Présentation et fréquence
Voici les options du groupe Présentation:

* Les choix sous Fréquence permettent de choisir si vous voulez voir les numéros de mesure

Toutes les n mesures, À chaque système (c’est le réglage par défaut), ou Pas de numéro de
mesure. Avec Toutes les n mesures, les numéros de mesure apparaissent à intervalles définis:

les valeurs habituelles en musique éditée sont 1, 5 et 10. L’écriture des numéros de mesure à

chaque mesure est une convention utilisée pour les exemples, pour la musique pour carillons ou

dans les partitions pour les enfants (pour éviter toute rouspétance ou s’ils sont incapables de
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compter) et dans les parties séparées de certains musiciens (pour éviter toute rouspétance ou

s’ils sont incapables de compter).

* Afficher au début de sections, qui est désactivé par défaut, détermine si le numéro de mesure

est affiché sur la première mesure de la partition, et sur les mesures qui suivent une Fin de
section (pour autant que la mesure soit en début de système). Activez cette option si vous avez

paramétré les numéros de mesure pour qu’ils apparaissent sur chaque mesure; sinon, aucun

numéro n’apparaîtra sur la première mesure de la partition.

* Masquer aux repères de répétition donne l’instruction à Sibelius de masquer

automatiquement les numéros de mesure qui tombent sur les même barres de mesure que les

repères de répétition, pour éviter toute collision.

* Prendre en compte les répétitions, qui est désactivé par défaut, détermine si Sibelius prend

en compte les répétitions dans la numérotation des mesures – cf. ci-dessous Numéros de
mesure dans une structure avec reprise

* Afficher l’étendue des mesures dans les mesures de comptage (par
ex. 5-8) permet d’utiliser la convention souvent en usage dans la musique

commerciale, de film ou pour la TV, selon laquelle les mesures comprises

dans une mesure de comptage sont numérotées au-dessus ou en dessous de

la mesure, comme illustré à droite. Si contrairement aux autres numéros de mesure de la

partition qui ne sont pas centrés, vous souhaitez que l’étendue des numéros de mesure s’affiche

au centre et en dessous de la mesure de comptage, activez Placer l’étendue au milieu de la
mesure de comptage. Si l’étendue est placée sous la mesure on peut en spécifier la distance
avec n dents de distance sous la portée.

Afficher les options des portées
Les options de Affichage sur les portées permettent de choisir quelles portées doivent afficher

les numéros de mesure. Cela fonctionne de la même manière que pour d’autres objets de systèmes

tels que les repères de répétition et le texte de tempo dans la boîte de dialogue Style maison >

Positions des objets de système (b 8.12 Positions par défaut), mais spécifiquement pour

les numéros de mesure. 

D’habitude les numéros de mesure se placent au-dessus de la portée supérieure de la partition et

au-dessus d’une ou de plusieurs familles d’instruments dans la musique d’orchestre et pour band,

ou parfois sous la portée inférieure de la partition. Choisissez le bouton Portées sélectionnées,

puis sélectionnez les portées sur lesquelles vous souhaitez que les numéros de mesure

apparaissent:

* Pour sélectionner plus d’une portée dans la liste, maintenez enfoncé Ctrl ou X et cliquez: vous

pouvez sélectionner jusqu’à cinq portées, y compris la portée supérieure et Sous la portée
inférieure.

* Pour placer les numéros sous la portée inférieure, cf. ci-dessous Placer les numéros de
mesure sous la portée inférieure.

* Pour placer les numéros de mesure entre les portées d’un instrument à clavier (ce qui se fait

occasionnellement), sélectionnez la portée supérieure dans la liste Portées sélectionnées, puis

positionnez les numéros de mesure sous la portée supérieure – cf. Options de position
verticale ci-dessous.
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Il est très rare de vouloir faire apparaître les numéros de mesure sur toutes les portées d’une

partition, mais si c’est votre souhait, choisissez le bouton Toutes les portées. Si c’est pour voir

dans quelle mesure vous vous trouvez lors d’une session de travail, un moyen plus simple consiste

à activer Affichage > Noms des portées et numéros de mesure (b 5.23 Menu affichage).

Options de style de texte
Pour changer la police ou la taille du point utilisée par les numéros de mesure d’un conducteur ou

des parties dynamiques, cliquez sur Modifier Style de texte. Pour les options spécifiques pour

les numéros de mesure une version spéciale de la boîte de dialogue Modifier Style de texte est

affichée – b 3.9 Modifier les styles de texte.

Options de position horizontale
En activant Au centre de la mesure désactive toutes les autres options sous Position
horizontale, et s’applique à tous les changements de numéros de mesure créés (cf. ci-dessous). Si

les numéros de mesure ne sont pas centrés, Sibelius permet de choisir des positions différentes pour

les numéros de mesure de début de système et les autres numéros de mesure.

Par défaut, Premier numéro de mesure du système est réglé sur Justifié à gauche sur la
barre de mesure initiale. Si vous choisissez Après la clé Sibelius placera le numéro à droite de la

clé, et si vous choisissez Comme les autres numéros de mesure, Sibelius suivra le réglage des

Autres numéros de mesure.

Autres numéros de mesure est réglé par défaut sur Centré, ce qui signifie qu’ils apparaissent

centré au-dessus des barres de mesure. Choisir justifié à gauche aligne le côté gauche du numéro

de mesure sur la barre de mesure, et choisir justifié à droite aligne le côté droit du numéro sur la

barre de mesure à la fin de la mesure.

Options de position verticale
Les options sous Afficher sur les portées déterminent les portées sur lesquelles les numéros de

mesure devraient apparaître (cf. Afficher les options des portées ci-dessus ), et les options

sous Position verticale détermine la position des numéros de mesure relative aux portées

choisies.

Les options Au-dessus de la portée, Au-dessus au milieu de la portée, Sous le milieu de la
portée, En dessous au bas de la portée sont identiques à celles qui figurent dans Style
maison > Positions par défaut (b 8.12 Positions par défaut), et détermine depuis quelle

ligne de la portée, centrale, supérieure ou inférieure, est appliquée la valeur Par rapport à la
portée n dents. 

Placer les numéros de mesure sous la portée inférieure
Dans certains types de musique, la musique de film par exemple, il est d’usage que les numéros de

mesure apparaissent sous la portée, et soient aussi centrés sur chaque mesure. Voici comment

procéder :

* Choisissez Style maison > Règles de gravure et sélectionnez la page Numéros de mesure

* Sous Présentation, choisissez Toutes les n mesures, et réglez n sur 1
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* Sous Affichage sur les portées, choisissez Portées sélectionnées, et sélectionnez seulement

Sous la portée inférieure (utilisez Ctrl+clic ou X -clic pour désélectionner toutes les autres

portées).

* Sous Position horizontale, activez Au centre de la mesure

* Sous Position verticale, choisissez En dessous au bas de la portée, et réglez sous

Conducteur la valeur Par rapport à la portée n dents sur par exemple 3 dents

* Cliquez sur OK.

Si vous souhaitez la même présentation dans les parties dynamiques, alors affichez une des parties

et répétez-y la procédure décrite ci-dessus. Ensuite, toujours avec la partie affichée, choisissez

Style maison > Exporter Style maison et exportez le style maison de cette partie. Pour

l’importer dans les autres parties, utilisez la boîte de dialogue Présentation des parties
multiples – cf. Exporter les styles maisons depuis les parties à la page 614 pour en savoir

plus.

Numéros de mesure dans une structure avec reprise
Quand une partition contient des passages répétés, d’habitude la numérotation se fait comme si les

mesures n’étaient jouées qu’une seule fois; en d’autres mots, le fait que certaines mesures soient

répétées ne se reflète pas dans la manière de les numéroter.

Cependant, si malgré tout, les mesures doivent être numérotées d’après leur succession réelle

d’exécution, c’est très facile: activez Prendre en compte les répétitions dans la page Numéros
de mesure de Style maison > Règles de gravure, et choisissez le format désiré dans le menu

déroulant:

* 10: les numéros de mesure ne sont affichés qu’une fois, mais les numéros de mesure après les

sections répétées prennent en compte les numéros de mesure répétées

* 10 (20): les numéros de mesure pour les mesures répétées sont affichés entre-parenthèses; c’est

l’option par défaut

* 10/20: les numéros de mesure répétés sont affichés après une barre oblique

* 10–20: les numéros de mesure répétés sont affichés après un tiret.

Voici ci-dessous le résultat produit par chaque option:

Si vous utilisez Numéro de mesure comme format de vos repères de répétition (à la page

Repères de répétition de Style maison > Règles de gravure), notez que Prendre en compte
les répétitons changera aussi l’affichage des repères de répétition.
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Sélectionner les numéros de mesure 
Les numéros de mesure peuvent être sélectionnés comme n’importe quel objet, pour être déplacés

ou masqués (cf. ci-dessous), mais il est impossible de les copier ou de les supprimer. (on peut

cependant copier ou supprimer des changements de numéros de mesure– cf. Changement de
numéro de barre de mesure ci-dessous.)

Pour sélectionner rapidement un groupe de numéros de mesure, vous pouvez:

* Sélectionner un numéro de mesure isolé, puis choisir Édition > Sélectionner > Sélectionner
Plus pour sélectionner tous les numéros de mesure du système; ou

* Sélectionner un passage de musique, puis choisir Édition > Filtrer > Numéros de mesure pour

sélectionner seulement les numéros de mesure dans ces mesures; ou

* Faire une sélection d’ensemble, avec Maj-déplacer ou X-déplacer.

Une fois qu’une étendue de numéros de mesure est sélectionnée, vous pouvez les déplacer ou les

supprimer comme expliqué ci-dessous.

Déplacer les numéros de mesure
Les numéros de mesure peuvent être déplacés horizontalement ou verticalement – il suffit de

sélectionner un ou plusieurs numéros de mesure et de les déplacer avec la souris ou avec les

touches de flèche (avec Ctrl ou X pour de plus grands incréments). Pour rétablir les numéros de

mesure à leur position originale, sélectionnez-les et choisissez Mise en page > Réinitialiser la
position (raccourci Ctrl+Maj+P ou xXP).

Si des numéros de mesure sont aussi affichés au-dessus ou en dessous d’autres portées de la

partition, déplacer un numéro change la position de toutes ses occurrences sur les autres portées.

Masquer les numéros de mesure
Pour masquer les numéros de mesure, il suffit de sélectionner les numéros de mesure, choisissez

Edition > Masquer ou afficher > Masquer (raccourci Ctrl+Maj+H ou xXH).

Pour en savoir plus sur les objets masqués, b 5.9 Masquer des objets.

Changement de numéro de barre de mesure
Pour que la numérotation recommence à un numéro spécifique, (par ex. au début d’une nouvelle

section, chanson ou mouvement), ou pour changer le format de numéro de mesure (par exemple

pour numéroter des mesures ajoutées sous la forme “1a, 1b, 1c,” etc.), vous pouvez créer un

changement de numéro de mesure:

* Pour recommencer à numéroter à partir d’une mesure spécifique, sélectionnez-la, ou si rien n’est

sélectionné, choisissez Insertion > Autres > Changements de numéros de mesure; ou

* Si vous voulez changer les numéros de mesure pour un ensemble de mesures, sélectionnez les

mesures dont les numéros doivent changer, puis choisissez Insertion > Autres > Changements
de numéros de mesure. (Cette option est particulièrement utile pour changer de format de

numéro de mesure; Sibelius rétablit ensuite de manière fort pratique le format original à la fin

du passage sélectionné.)
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Dans tous les cas, voici la boîte de dialogue qui s’affiche:

Voici les options déterminées par les boutons:

* Nouveau numéro de mesure permet de spécifier un nouveau numéro de mesure à partir

duquel on recommence à numéroter; régler sur 1 si vous voulez recommencer à numéroter au

début d’un nouveau mouvement

* Continuer la séquence en cours est très utile en combinaison avec l’option ci-dessous

Changer de format ; cela permet de continuer une séquence existante tout en utilisant un

nouveau format. Par exemple si le numéro de mesure avant le changement est 2, en choisissant

Continuer la séquence en cours et en réglant Changer de format sur 1a, 1b, 1c..., le

numéro de mesure qui apparaîtra sera “2a.”

* Ne pas numéroter cette mesure permet d’indiquer à Sibelius qu’il ne faut pas prendre en

compte la mesure à laquelle ce changement de numéro est attaché, une option très utile par

exemple pour une mesure scindée à la fin d’un système en deux mesures irrégulières et dont on

veut être sûr que la deuxième ne comportera pas de numéro de mesure. Ce changement de

numéro de mesure est seulement visible si Affichage > Objets masqués est activé, et s’affiche

alors sous forme d’un numéro de mesure entre crochets.

La différence entre Continuer la séquence en cours et Nouveau numéro de mesure consiste

dans le fait que le numéro de mesure installé avec Continuer la séquence en cours sera

éventuellement mis à jour si la numérotation varie; dans notre exemple ci-dessus, vous pouvez

déplacer le numéro “2a” vers la droite, et il se changera en “3a”, “4a”, “5a”, etc., tandis qu’un

changement de numéro de mesure réglé sur Nouveau numéro de mesure restera toujours tel

quel. De la même manière que Continuer la séquence en cours, les changements de mesure

réglés sur Ne pas numéroter cette mesure se mettent à jour de manière dynamique quand on

les déplace dans la partition.

Normalement, si vous changez le format des numéros de mesure, vous réglerez Continuer la
séquence en cours, et vous sélectionnerez le passage de mesures à renuméroter de manière à ce

que Sibelius puisse automatiquement rétablir la numérotation à la fin du passage.

La case Ajouter du texte permet de spécifier si du texte doit être ajouté avant ou après les

numéros de mesure; si par exemple vous ajoutez le texte “nouveau” (remarquez l’espace préalable)

pour qu’il apparaisse après le numéro de mesure, vous obtiendrez des numéros de mesure tels que

1 nouveau, 2 nouveau, 3 nouveau, etc. De même si le texte “orig” (remarquez l’espace finale)

doit apparaître avant le numéro de mesure, vous obtiendrez des numéros de mesure tels que orig
1, orig 2, orig 3, etc.
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Changer de format permet de spécifier un nouveau format de numéro de mesure:

* 1, 2, 3...: le format standard de numéro de mesure qui utilise les chiffres uniquement

* 1a, 1b, 1c... et 1A, 1B, 1C...: ce format est habituellement utilisé dans les partitions pour les

productions théâtrales, pour lesquelles les modifications de dernière minute (tel que l’ajout de

mesures supplémentaires dans l’ouverture pour permettre aux acteurs de prendre leurs

marques) ne peuvent venir changer la numérotation du reste de la représentation. Les mesures

ainsi insérées sont toujours numérotées d’après la mesure originale qu’elles suivent; si vous

insérez quatre mesures après l’ancienne mesure 2, les nouvelles mesures seront numérotées 2a,

2b, 2c, 2d, et la mesure suivante sera numérotée 3. Ce format est parfois aussi utilisé pour

numéroter les secundos (les mesures à jouer à la reprise).

* a, b, c... et A, B, C...: ce format est habituellement utilisé pour les passages d’introduction; par

exemple les huit premières mesures d’une chanson avant l’entrée du chanteur sont numérotées

a–h, et la neuvième est numérotée 1.

Remarquez que, si vous réglez un numéro de mesure sur un format autre que 1, 2, 3..., Sibelius

affiche toujours tous les numéros sur chaque mesure, outrepassant éventuellement le choix établi

dans les options Fréquence de la page Numéros de mesure de Style maison > Règles de
gravure.

Vous pouvez copier et supprimer des changements de numéro de mesure (contrairement aux

numéros de mesure normaux), et vous pouvez aussi déplacer un numéro de mesure

horizontalement et verticalement de trois dents à partir de la barre de mesure à laquelle il

appartient – au-delà, il s’accrochera a à la mesure la plus proche.

Aller à la mesure
Pour passer rapidement à une autre mesure, choisissez Édition > Aller à la mesure (raccourci

Ctrl+Alt+G ou zXG), tapez le numéro de mesure et cliquez sur OK. Voici deux choses un peu

subtiles à connaître concernant cette fonction:

* Vous pouvez taper tous les formats supportés, et si Sibelius est incapable de trouver le numéro de

mesure qui correspond exactement, il retrouvera le numéro le plus proche.

* Si le même numéro de mesure apparaît plusieurs fois dans la partition (parce que, par exemple,

plusieurs mouvements figurent dans le même fichier), Sibelius commence la recherche au début

de la partition ou de la sélection en cours; pour aller au numéro de mesure suivant

correspondant, il suffit de choisir de nouveau Édition > Aller à la mesure puis de cliquer sur

OK sans changer le numéro de mesure recherché.

Numéro de la première mesure
Dans le cas où la partition commence par un numéro de mesure autre que 1 (par exemple une

nouvelle section d’une partition longue) entrez un changement de numéro dès le début (cf. ci-

dessus).

Les anacrouses (ou mesure de levée)
Si la partition commence avec une anacrouse (un temps levé), l’usage est d’attribuer le numéro 1 à

la première mesure complète qui suit plutôt que 2. Sibelius attribue donc automatiquement le

numéro 0 à la mesure d’anacrouse.
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Les numéros de mesure dans les parties
Vous pouvez utiliser des styles de texte différents dans le conducteur et les parties grâce aux styles

de texte spécifiques proposés par Sibelius pour la partition (Numéros de mesure) et les parties

(Numéros de mesure (parties)). 

Si vous désirez modifier la présentation des numéros de mesures de toutes les parties

simultanément plutôt que d’éditer chaque partie individuelle, utiliser la page Style maison de la

boîte de dialogue Présentation des parties multiples (b 7.3 Présentation des parties
multiples).
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3.6 Numéros de page

Sibelius numérote automatiquement les pages des partitions, selon les conventions séculaires

(aussi bien dans l’édition des livres que musicale) qui consistent à toujours placer les numéros pairs

à gauche et les numéros impairs à droite, tandis que la première page n’est pas numérotée.

Dans les impressions en recto-verso (vis-à-vis), les numéros de page sont d’habitude positionnés à

l’extérieur (c’est-à-dire du côté opposé à la reliure), tandis que dans l’impression en simple face le

numéro est placé à droite (ou parfois au centre, ce qui est peu apprécié des typographes éclairés!),

pour que le numéro tombe sous le pouce assurant une meilleure visibilité quand on feuillette.

Quelle que soit la reliure, les numéros de page se placent toujours en haut de la page.

Comme Sibelius respecte automatiquement ces conventions, en principe il ne sera que rarement

nécessaire d’intervenir sur ce sujet, sauf dans le cas de mise en page complexe avec pages blanches

au début de la partition ou pour plusieurs partitions dans le même fichier; pour ces cas, il faut

intervenir dans la numérotation des pages, d’où l’intérêt de la commande Insertion > Autres >

Changement de numéro de page.

Changement de numéro de page
Avec un changement de numéro de page, on peut activer plusieurs formats de numéros de page,

commencer la numérotation n’importe où, et même masquer des numéros de page. En premier

lieu, sélectionnez quelque chose dans la page (par ex. une mesure) qui doit subir le changement,

puis choisissez Insertion > Autres > Changement de numéro de page. une boîte de dialogue

apparaît:

* Nouveau numéro de page permet de spécifier la première page de la séquence; si vous

désactivez cette case, le numéro de page créé s’établira simplement selon la séquence existante

* Vous pouvez choisir entre 4 options de Format :

% 1, 2, 3... est le format par défaut en chiffre arabe

% a, b, c... et A, B, C... utilisent les lettres respectivement en minuscule et majuscule et sont

utiles dans les préfaces par exemple

% i, ii, iii... and I, II, III... utilisent les chiffres romains en minuscule et majuscule, et sont aussi

utilisés dans les préfaces par exemple.
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* Enfin, vous pouvez choisir comment afficher les numéros de page affectés par le changement de

numéro de page créé:

% Afficher les numéros de page affiche tous les numéros de page (jusqu’au changement de

numéro de page suivant)

% Masquer le premier numéro de page masquera le premier numéro de page du

changement réalisé, et affichera tous les numéros suivants (jusqu’au changement de numéro

de page suivant)

% Masquer les numéros de page masquera tous les numéros de page du changement
réalisé, et affichera tous les numéros suivant (jusqu’au changement de numéro de page

suivant).

% Masquer les numéros de page jusqu’à la page suivante de musique s’utilisera quand la

partition commence par une ou plusieurs pages blanches et que l’on souhaite que les numéros

de page ne commence qu’à la seconde page de musique.

Quand vous cliquez sur OK, Sibelius crée le changement de numéro de page approprié. Remarquez

que Sibelius crée aussi un saut de page à la fin de la page, et cela pour fixer la mise en page et

garantir que le numéro de page restera à l’endroit exact tel que vous l’avez indiqué à Sibelius.

Pour placer un changement de numéro de page sur une page blanche (créée avec un saut de page

spécial – b 8.5 Les sauts), assurez-vous que rien n’est sélectionné avant de choisir Insertion >

Autres > Changement de numéro de page, puis après avoir cliqué sur OK dans la boîte de

dialogue, cliquez sur la page blanche sur laquelle s’applique le changement.

Sélectionner des numéros de page
Les numéros de page résultant de changement de numéro de page peuvent être sélectionnés,

contrairement à ceux créés automatiquement par défaut par Sibelius.

Pour sélectionner des changements de numéros de page dans une partition, vous pouvez par

exemple sélectionner la partition entière avec Édition > Sélectionner > Sélectionner Tout
(raccourci Ctrl+A ou XA), puis choisir Édition > Filtrer > Changements de numéro de page.

Vous pouvez ensuite masquer ou supprimer les changements de numéro de page – cf. ci-dessous.

Masquer les numéros de page
Si vous décidez de masquer des numéros de page après avoir créé un changement de numéro de

page, il n’est pas nécessaire de créer un nouveau changement; il suffit de sélectionner une des pages

affectées par le changement et de choisir Modifier > Masquer ou Afficher > Masquer (raccourci

Ctrl+Maj+H ou xXH).

Si vous voulez masquer uniquement la première page d’un changement de page, veillez à ne

sélectionner que le numéro de cette page; en sélectionnant tout autre numéro de page qui suit le

changement masquerait tous les numéros de page du changement.

Pour en savoir plus sur la manière de masquer les objets, b 5.9 Masquer des objets.

Supprimer des numéros de page
Il est impossible de supprimer des numéros de page automatiques (même si on peut les masquer);

par contre ceux résultant d’un changement de numéro de page peuvent l’être – il suffit de les
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sélectionner (cf. ci-dessus) et de taper Suppr. Supprimer le saut de page auquel le changement de

numéro de page est attaché le supprime aussi, mais l’inverse n’est pas vrai (donc si vous supprimez

le changement, le saut de page n’est pas supprimé).

Si vous souhaitez qu’aucun numéro de page n’apparaisse dans la partition, sélectionnez une

mesure de la première page et utilisez Insertion > Autres > Changement de numéro de page et

activez masquer les numéros de page.

Numéros de page dans les parties séparées
D’habitude les parties instrumentales sont numérotées dès la page 1, indépendamment du

conducteur. C’est le réglage par défaut de Sibelius, mais si vous souhaitez que vos parties reçoivent

les mêmes numéros que le conducteur utilisez les options de la page Mise en page de

Présentations des parties multiple – b 7.3 Présentation des parties multiples.

Vous pouvez aussi créer un changement de numéro de page dans une partie, ce qui affectera

seulement cette partie.

Afficher le numéro de page sur la page 1
Par défaut, Sibelius numérote la partition à partir de la page 1, mais n’en affiche pas le numéro; si

Affichage > Objets masqués est affiché vous verrez un chiffre “1” grisé dans le coin supérieur

droit de la page. Pour rendre ce numéro visible, si c’est votre intention, utilisez Insertion > Autres >

Changement de numéro de page pour créer un changement de numéro de page 1 à la première

page de la partition, et choisissez Afficher les numéros de page.

Numéro en première page
Voici quelques recommandations concernant des cas qui pourraient justifier la présence d’un

numéro sur la première page; cela devrait faire de vous un expert en la matière:

* Si la partition commence sur une page de gauche, créez un changement de numéro de page

commençant à 2 sur la première page (sauf si votre fichier Sibelius comporte une page de titre en

page 1).

* Si la partition n’a pas de couverture (la musique étant en première page), la première page est la

page 1.

* Si la partition est “auto-couvrante” – la première page est une couverture du même papier que le

reste de la partition – la couverture est alors traitée comme page 1; et donc la partition

commençant sur une page de gauche, créez un changement de numéro commençant à 2, (sauf si

la partition comporte une page de titre).

* Si la partition a une couverture cartonnée séparée, d’habitude la première page à l’intérieur de la

couverture est numérotée comme page 1.

Toutefois, rappelez-vous qu’en général, le numéro de la première page n’est pas imprimé.

Position des numéros de page en fonction de la marge
Par défaut, les numéros de page sont alignés sur les marges de gauche et de droite des pages.

Cependant, il arrive que certains éditeurs préfèrent que les numéros de page gauche s’alignent sur

le début de la portée; voici comment faire si vous voulez suivre cette convention:

* Choisissez Style maison > Modifier les styles de texte
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* Choisissez Numéros de page dans la liste des styles de texte, et cliquez sur Modifier

* Dans la boîte de dialogue qui apparaît Style de texte de système, choisissez l’onglet Position
horizontale, ensuite activez (même si c’est peu explicite) l’option À gauche de la page, aligner
sur la marge de la portée ‘Pas de nom’

* Cliquez sur OK et Fermer.

Numéros de page dans les partitions imprimées sur une face
Si vous souhaitez imprimer en simple face plutôt qu’en recto-verso, il convient de changer la

position des numéros de page afin qu’ils apparaissent dans le coin droit de la page:

* Choisissez Style maison > Modifier les styles de texte

* Choisissez Numéros de page dans la liste des styles de texte, et cliquez sur Modifier

* Dans la boîte de dialogue Style de texte de système qui apparaît, choisissez l’onglet position
horizontale, et réglez Aligner sur la page à Droite

* Cliquez sur OK et Fermer.

Numéros de page dans du texte
Les numéros de page sont parfois affichés dans un en-tête ou un pied de page permanent. Si c’est

votre souhait, vous pouvez ajouter le numéro de la page en cours dans un en-tête ou un pied de

page (ou tout autre texte d’ailleurs) en utilisant la formule magique \$PNumPage\. Par exemple:

* Tout d’abord, il faut masquer les numéros de page automatique. Sélectionnez la première

mesure de la partition et choisissez Insertion > Autres > Changement de numéro de page.

* Cliquez le bouton Masquer les numéros de page, puis cliquez sur OK. (Activez Affichage >

Objets masqués, si ce n’est pas déjà fait, et vous remarquerez que les numéros de page existent

toujours mais sont masqués.)

* Maintenant modifiez votre texte d’en-tête existant, ou utilisez Insertion > Texte > Autres textes
de système > En-tête (après la première page) pour en créer un nouveau.

* Ajoutez \$PageNum\ à l’en-tête; votre en-tête en cours d’édition devrait ressembler à ceci:

\$Titre\ – \$Compositeur\ – p.\$NumPage\, et donner comme résultat quelque chose dans

ce genre “Symphonie no. 40 – Mozart – p.15”. Ce résultat n’est visible qu’une fois l’édition

terminée quand Sibelius a substitué la formule magique.

Pour en savoir plus sur les formules magiques, b 3.10 Formules magiques.

Aller à la page
Pour atteindre rapidement n’importe quelle page, choisissez Édition > Aller à la page
(Ctrl+Maj+G ou xXG), tapez le numéro de page et cliquez sur OK. Vous pouvez taper le numéro

dans tous les formats que Sibelius comprend. 
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3.7 Repères de répétition

Les repères de répétition sont les grands chiffres ou les grandes lettres indiquant les endroits

importants d’une partition. Il sont automatiquement numérotés ou lettrés en succession par

Sibelius – il suffit d’indiquer où ils se placent. Cela signifie qu’il est possible de créer et de

supprimer des repères librement sans se préoccuper d’une numérotation ou d’un lettrage à devoir

refaire.

Créer des repères de répétition
* Choisissez Créer > Repère de répétition. La boîte de dialogue suivante apparaît:

* Consécutifs signifie que le repère de répétition créé continue la séquence déjà commencée (ou

devient le premier repère de la séquence), en utilisant le format spécifié dans Style maison >

Règles de gravure (cf. dessous). Comme c’est souvent ce qui est souhaité, ce résultat est obtenu

avec le raccourci Ctrl+R ou XR, sans que la boîte de dialogue ne soit affichée.

Par exemple, si des repères sont ajoutés au fur et à mesure sur une portée, ils apparaîtront sous la

forme A B C D E. Si on supprime ensuite B, les repères suivant sont automatiquement modifiés

de C D E à B C D pour conserver la séquence. De la même manière, si vous créez un nouveau

repère de répétition entre deux repères existants, les marques suivantes seront adaptées.

* Commençant par permet de créer un repère de répétition hors de la séquence, et de

recommencer à un endroit spécifique. Tapez simplement l’indication voulue dans la boîte;

Sibelius continuera la séquence pour les repères Consécutifs suivants – si vous lui demandez

par ex. de commencer avec Y2, il continuera avec Z2 puis A3, B3, etc... 

* Nouveau préfixe/suffixe permet d’ajouter un texte constant placé avant ou après le repère de

répétition, de manière à produire des séquences spéciales telles que A1, A2, A3, A4, ou 1A, 2A,

3A, 4A, etc. différentes de la séquence standard (un préfixe ou un suffixe peut être attribué à

tous les repères si nécessaire – cf. Options des règles de gravure ci-dessous ). Tapez le

Préfixe ou le Suffixe voulu dans les cases prévues. L’option Ne pas tenir compte des
préférences permet de choisir si le préfixe/suffixe spécifié prévaut sur le préfixe/suffixe défini

dans Style maison > Règles de gravure; si c’est votre souhait, activez cette option.

* Maintenant, cliquez sur OK.

% Si aucune note n’est sélectionnée, le pointeur de la souris changera de couleur et il ne vous

restera plus qu’à cliquer sur une barre de mesure pour placer le repère de répétition

% Si une note est sélectionnée, le repère de répétition est automatiquement placé au-dessus de

la barre de mesure qui commence la mesure suivante.
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Modifier les repères de répétition
Vous pouvez tirer, copier et supprimer les repères de répétition de la façon habituelle. Lorsque

vous les faites glisser, ils sont aimantés horizontalement aux barres de mesures.

Comme pour le texte de tempo, les grandes partitions ont souvent plus d’une occurrence de

chaque repère de répétition - par ex. un au-dessus du système et un autre au-dessus des cordes.

Si vous supprimez le repère de répétition supérieur, tous ses clônes en-dessous dans la partition

seront supprimés comme lui. Vous pouvez déplacer indépendamment la position verticale de

chaque repère de répétition vers le bas du système, même si cela ne devrait pas être nécessaire

puisque la mise en page magnétique veillera à ce que les repères de répétition n’entrent en collision

avec rien.

Vous pouvez modifier les portées au-dessus desquelles se placent les repères de répétition et les

autres objets de système – cf. Positions des objets de système à la page 682.

Si vous avez à déplacer un repère de répétition légèrement à gauche ou à droite de la barre de

mesure afin d’éviter un obstacle, sélectionnez-le et modifiez sa valeur X sur le panneau Général de

la fenêtre des propriétés.

Options des règles de gravure
Tous les formats possibles des repères de répétition sont proposés à la page Repères de répétition
de la boîte de dialogue Style maison > Règles de gravure (raccourci Ctrl+Shift+E ou xXE).

Le choix professionnel est:

* A-Z, A1-Z1, A2... 
* A-Z, AA-ZZ, AAA... 
* 1, 2, 3... 
* Numéro de mesure 

* Masquer tout 

Le format change pour tous les repères de répétition existant; par conséquent la séquence YZ AA
BB deviendrait 25 26 27 28 si on choisit de la modifier selon le troisième format.

(Amusons-nous un peu: réglez les repères de répétition sur le format Numéro de mesure. Créez

un repère de répétition et regardez ce qui se passe lorsque vous le glissez d’une mesure à l’autre.)

Les options Préfixe et Suffixe permettent de spécifier le texte à placer avant ou après la partie

automatique de tous les repères de répétition. Cela s’avère utile si la police utilisée pour les repères

possède des caractères spéciaux pour encadrer les lettres et les chiffres, comme c’est le cas de la

police de Sibelius Reprise Rehearsal (Faites par exemple l’essai avec les styles maison Reprise).

La police, le corps de texte, le cadre, etc. sont contrôlés en cliquant sur le bouton Modifier le style
de texte. b 3.9 Modifier les styles de texte.

Les repères de répétition sont automatiquement rétréci à une taille inférieure dans les parties

séparées. Vous pouvez contrôler leur taille après rétrécissement en modifiant le style de texte

Repères de répétition. Choisissez Style maison > Modifier les styles de texte (raccourci

Ctrl+Maj+Alt+T ou xzXT sur Mac), sélectionnez le style de texte Repères de répétition et

cliquez sur Modifier. Ajuster la taille des parties dans la page Général de la boîte de dialogue

Style de texte comme souhaité. Pour en savoir plus sur la manipulation des parties

b 7.1 Travailler avec des parties séparées.
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3.8 Noms d’instrument

b 2.18 Instruments et portées, 8.14 Modifier les instruments.

Chaque instrument existe sous deux noms ; le nom complet qui se trouve normalement devant le

premier système, et le nom abrégé qui se trouve normalement devant les systèmes suivants. Si l’un

est modifié, l’autre doit être ajusté. Tout changement apporté aux noms se répercutent dans toute

la partition, et pas seulement sur le système sur lequel la modification est apportée.

Modifier les noms des instruments
Vous pouvez modifier le nom de n’importe quel instrument de la partition - pour utiliser une

langue étrangère par exemple, ou pour nommer un chanteur d’après son personnage, par ex.

Wozzeck au lieu de Baryton. Il suffit de cliquer sur le nom à gauche de l’un des systèmes et de le

modifier comme n’importe quel autre texte.

Remplacer le nom d’un instrument par celui d’un autre qui est transpositeur n’installe pas de

transposition; par conséquent, modifier “Violon” en “Flûte” n’en fera pas une flûte. De même,

modifier “Cor en Fa” en “Cor en Mib” ne changera pas la transposition et n’en fera pas un

instrument en Mib. Pour faire ce type de changement, utilisez plutôt Insertion > Autre >

Changement d’instrument – b 2.18 Instruments et portées.

Vous pouvez modifier le nom de l’instrument au début du système suivant le changement

d’instrument exactement comme n’importe quel autre instrument - cf. Nom et changements
d’instrument ci-dessous

Si la partition comporte plusieurs instruments identiques dont le nom doit se modifier de la même

manière, il est plus rapide d’utiliser Style maison > Modifier les instruments plutôt que de

changer le nom individuellement – b 8.14 Modifier les instruments.

Masquer les noms des instruments
Si vous ne voulez pas que les noms d’instrument soient affichés du tout, désactivez-les à partir de

la boîte de dialogue Style maison > Règles de gravure (cf. Format et style des noms ci-

dessous).

Si vous souhaitez supprimer le nom d’un seul instrument, sélectionnez le nom et appuyez sur

Suppr - si vous souhaitez ultérieurement le restaurer, il suffit de double-cliquer à l’endroit d’origine

du nom, et le signe d’insertion apparaîtra, permettant d’entrer le nom à nouveau.

Déplacer les noms des instruments
Vous pouvez déplacer un nom d’instrument à la souris, ce qui en déplacera toutes les occurrences.

Cependant, l’ajustement de la position des noms d’instrument se fait normalement en modifiant

leur alignement - cf. Format et style des noms ci-dessous.

Format et style des noms
Pour modifier le format des noms d’instrument, choisissez Style maison > Règles de gravure
(raccourci Ctrl+Shift+E ou xXE) et sélectionnez la page Instruments.
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Les diverses options vous permettent de choisir s’il faut utiliser le nom complet, le nom abrégé ou

pas de nom du tout au début de la partition, sur les systèmes suivants, et à chaque nouvelle section

(cf. ci-dessous).

Les réglages recommandés sont les suivants:

* Pour les partitions avec de nombreux instruments (par ex. partition d’orchestre ou d’harmonie),

spécifiez les noms complets au début (et peut-être aux nouvelles sections), et les noms complets

ou abrégés ensuite.

* Pour des partitions pour un instrument soliste et des partitions pour un petit nombre

d’instruments sans portée masquée, spécifiez les noms complets au début (et peut-être aux

nouvelles sections), et pas de nom ensuite.

* Pour les parties séparées, les partitions pour instrument soliste et les exemples musicaux, vous

pourriez spécifier pas de nom tout au long. Dans les parties séparées, Sibelius ne place par

défaut aucun nom à côté des systèmes, et écrit à la place le nom d’instrument au sommet de la

page.

Les noms d’instruments sont gouvernés par un style de texte, par conséquent leur police, leur

taille, etc. peuvent être ajustés comme pour les autres styles de texte en choisissant Style maison >

Modifier les styles de texte (raccourci Ctrl+Shift+Alt+T ou xzXT). Sélectionnez Noms
d’instrument dans la liste à gauche puis cliquez sur Modifier. Vous pouvez même ajuster

l’alignement horizontal des noms d’instrument à partir de l’onglet Pos. horizontale
(b 3.9 Modifier les styles de texte), ainsi que la distance à laquelle ils apparaissent depuis

la barre de mesure de départ à l’aide de l’option Espace entre le nom d’instrument et la barre
de mesure initiale dans la page Instruments de Style maison > Règles de gravure.

D’habitude, les noms d’instrument sont centrés dans une colonne, mais si certains noms sont très

larges, d’autres peuvent se trouver trop éloignés de la portée à laquelle ils se réfèrent. C’est la raison

pour laquelle on les aligne parfois à droite (ou très occasionnellement à gauche, comme pour la

musique pour harmonie). Il est inutile de soucier de cela si vous utilisez un papier à musique

approprié pour créer la partition, car les papiers à musique intègrent tous les réglages adaptés pour

les noms d’instrument.

Voici quelques formats de nom d’instrument quelque peu inhabituels:

Vous pouvez écrire ceci au début de la partition en double-cliquant simple-

ment le nom pour le modifier. (il faudra probablement également modifier

le nom abrégé sur la page suivante.)

Pour obtenir ceci, double-cliquez simplement sur le nom d’instrument et

appuyez sur Retour (sur le clavier principal) entre chaque nom.

Dans ce cas-ci, créez une seule flûte, puis ajoutez une portée supplémen-

taire en dessous (b 2.29 Portées), et modifiez enfin le nom d’instru-

ment: appuyez sur “1 Retour Retour Fl. espace espace Retour Retour 2”.

Le 1 et le 2 seront correctement positionnés verticalement mais seront légè-

rement déplacés si vous changez la valeur par défaut de l’espace entre les

portées.

4 cors

Tri.
S.D.
B.D.
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Noms d’instruments aux nouvelles sections
Les partitions qui comportent plusieurs morceaux, chansons ou mouvements sont considérés

comme formés de plusieurs “sections”, commençant le plus souvent par un nouveau titre. À chaque

nouvelle section, on écrit le nom des instruments en entier, même si ailleurs ils sont abrégés ou

absents. Pour faire cela:

* Sélectionner la mesure finale de la section précédente

* Choisissez Fenêtre > Propriétés (raccourci Ctrl+Alt+P ou zXP), ouvrez le panneau Mesures
et activez Fin de section

* Dans la boîte de dialogue Style maison > Règles de gravure, à la page Instruments, réglez la

présentation des noms de Aux nouvelles sections sur Complet (ou peut-être sur Abrégé).

Pour en savoir plus sur les partitions formées de plusieurs sections, b 9.3 Diviser et joindre
des partitions.

Nom et changements d’instrument
Lorsque vous créez un changement d’instrument sur une portée, le nom d’instrument par défaut

au début du système suivant est mis à jour pour indiquer le nom du nouvel instrument. Si vous ne

souhaitez pas que le nom de l’instrument change, choisissez Style maison > Règles de gravure
(raccourci Ctrl+Maj+E ou E), puis dans la page Instruments, désactivez Changer les nom
d’instruments au début des systèmes qui suivent les changements d’instrument

Noms d’instruments dans les parties dynamiques
D’habitude, les noms des instruments ne sont pas imprimés à gauche de chaque portée dans les

parties instrumentales, mais placés dans le coin supérieur gauche de la première page et en en-tête

Vous pouvez obtenir cet effet en créant le nom dans un style de texte justifié

à droite avec un espacement de ligne réglé sur 50%; appuyez sur “1 Retour
Clarinette espace espace espace Retour 2”. Puisqu’il faut régler le style

de texte Noms d’instrument sur un interligne de 50%, les autres noms

d’instrument qui s’étendent sur plus d’une ligne auront besoin d’un Retour
supplémentaire entre les lignes pour être espacés correctement.

Ici le nom d’instrument est “Violon I” et “divisi” a simplement été ajouté en

entrant du texte d’Expression dans la marge. Remarquez que ce “divisi” est

attaché à la première mesure de la portée, par conséquent une remise en

forme de la partition pourrait le déplacer. Pour l’éviter et être sûr qu’il ne

soit pas déplacé, créez un saut de système à la fin du système précédent.

Dans certaines partitions chorales, le nom d’instrument n’est pas placé

devant la portée. Mais à part, en texte de technique majuscule, au-dessus de

chaque portée (en commençant au-dessus de la clef) au début de la pièce, et

ensuite chaque fois que sur le même système on change de chanteurs. Cette

convention est souvent utilisée dans les éditions de musique ancienne et

dans les partitions pour lesquelles les mêmes portées apparaissent sur la

plupart des systèmes. Les noms d’instruments pour des chanteurs sont sou-

vent écrits en majuscules.

Clarinette

Violon I
divisi
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des pages suivantes. Avec les parties dynamiques, Sibelius traite automatiquement tout cela au

moyen des formules magiques (b 3.10 Formules magiques), sans qu’il soit nécessaire

d’intervenir au niveau de l’en-tête. Cependant, si vous préférez modifier vous-même les en-têtes

sans utiliser les formules magiques, vous pouvez empêcher que Sibelius ne réalise cette opération

et vous lancer dans la mêlée. Voici trois situations à problèmes qui devraient vous y contraindre:

Toutes les parties affichent le même nom d’instrument dans le coin supérieur gauche de la première

page

Cette situation se produit quand on a modifié directement l’objet textuel existant dans le coin

supérieur gauche de la première page du conducteur ou d’une partie, ce qu’il vaut mieux éviter. La

formule magique utilisée pour ce texte est \$NomPartie\, dont le contenu est défini dans le

champ Nom de la partie dans la boîte de dialogue Fichier > Informations sur la partition. Pour

résoudre ce problème, il suffit de réparer l’objet textuel:

* Passez si nécessaire dans le conducteur en tapant W

* Faites un double-clic sur l’objet textuel dans le coin supérieur gauche de la première page pour le

modifier

* Supprimez le texte existant et remplacez-le par l’enchaînement \$NomPartie\, puis tapez sur

Échap pour terminer

* Remarquez que le texte qui apparaît est “Conducteur”

* Si le texte s’affiche dans le conducteur mais que vous souhaitez le masquer, choisissez Édition >

Masquer ou afficher > Afficher dans les parties.

Si vous voulez changer ce texte dans toutes les parties, l’astuce consiste à modifier le contenu de

Nom de la partie dans les Infos sur la partition. Voici deux manières de le faire:

* Soit, faites un seul clic sur le nom de la partie dans la fenêtre des parties et entrez-y le nouveau

nom puis tapez Entrée pour terminer; ou

* Afficher la partie en question, puis choisissez Fichier > Informations sur la partition et

modifiez-y Nom de la partie.

Aucun nom d’instrument n’apparaît dans les parties

Si vous ne voulez pas de nom d’instrument dans le coin supérieur gauche de la première page et

en-tête des pages suivantes, voici la marche à suivre:

* D’abord, vérifiez si Affichage > Objets masqués est activé; ensuite regardez au début du

conducteur. Le nom de l’instrument devrait être visible, soit en grisé (ce qui signifie qu’il est

masqué) soit en noir (ce qui signifie qu’il est affiché).

* Si le nom d’instrument figure en grisé, sélectionnez-le, puis choisissez Édition > Masquer ou
Afficher > Afficher dans les parties, ce qui le masquera dans le conducteur mais l’affichera

dans toutes les parties.

* Si aucun nom d’instrument n’apparaît, il a été supprimé pour une raison quelconque. Pour le faire

réapparaître:

% Vérifiez que vous affichez la première mesure du conducteur ou de la partie

% Sélectionnez la première mesure du conducteur ou de la partie de manière à ce qu’elle soit

entourée d’un cadre violet à une ligne
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% Choisissez Insertion > Texte > Texte spécial > Nom d’instrument en haut à gauche

% Un curseur clignotant apparaît: entrez \$tNomPartie\ et tapez Échap.

Dans les parties de plusieurs portées, le nom des instruments est manquant à gauche de chaque

portée

Par défaut, Sibelius n’affiche pas les noms d’instrument à gauche de chaque portée dans les parties

dynamiques, parce que la plupart des parties ne contiennent qu’une seule partie. Cependant, dans

les cas où plusieurs portées figurent dans la même partie, il peut être nécessaire d’afficher les noms

d’instrument au début du premier système (et éventuellement sur les suivants). Voici comment

procéder :

* Affichez la partie dans laquelle vous voulez que les noms d’instrument apparaissent

* Choisissez Style maison > Règles de gravure et allez à la page Instruments

* Réglez les noms des instruments pour qu’ils apparaissent sous la forme Complet au Début de
la partition (et abrégé pour suivre, si nécessaire), et cliquez sur OK.

Si le nom d’instrument doit apparaître sur de nombreuses parties, plutôt que de répéter l’opération

dans chaque partie individuellement, il sera plus rapide d’exporter le style maison d’une partie et

de l’importer dans les autres – cf. Exporter les styles maisons depuis les parties à la

page 614.

Pour en savoir plus sur les parties dynamiques, b 7.1 Travailler avec des parties séparées.

Portées sans nom
Pour créer des portées sans nom, dans la boîte de dialogue Insertion > Instruments, sélectionnez

l’ensemble Tous les instruments, et choisissez la famille Autres, qui propose portée en clé de
sol et portée en clé de fa. Ces portées ne représentent aucun instrument précis.

Si cependant vous ne souhaitez aucun nom d’instrument dans toute la partition, modifiez les

options de la page Instruments de la boîte de dialogue Style maison > Règles de gravure (cf.

Format et style des noms ci-dessus).
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3.9 Modifier les styles de texte

b 3.1 Utiliser du texte, 8.12 Positions par défaut.

Cet article vous explique comment changer la police, la taille, l’alignement et d’autres

caractéristiques d’un style de texte.

Vous pouvez redéfinir non seulement les styles du menu Insertion Texte, mais également

également ceux d’éléments comme les repères de répétition, les chiffres de multiplet, les numéros

de mesure, de pages, et les noms d’instrument. Toutes les modifications que vous faites sont

reflétées instantanément dans tout le texte de ce style quel que soit l’endroit ou il apparaît dans la

partition.

Si vous souhaitez faire des changements rapides de police pour tous les styles de texte de votre

partition, utilisez la boîte de dialogue Style maison > Modifier toutes les polices; si, par contre,

vous devez ajuster un style de texte individuel, utilisez la boîte de dialogue Style maison >

Modifier les styles de texte.

Boîte de dialogue Modifier toutes les polices
Pour modifier toutes les polices utilisées dans la partition,

choisissez Style maison > Modifier toutes les polices. Cette

boîte de dialogue permet de modifier en une fois les polices

utilisées par de nombreux styles de texte.

* Police de texte principale: détermine la famille de polices

utilisée pour des styles de texte tels que Titre, Compositeur,

Tempo, Expression, Technique, Paroles, etc. Modifier ce réglage

peut modifier de manière spectaculaire l’aspect d’une partition.

* Police musicale principale: détermine la famille de polices

utilisée pour les symboles musicaux de la partition, tels que les

notes, les silences, les clefs, les indications de mesure, etc... . b 8.11 Polices musicales.

* Police de texte musical: détermine la police utilisée pour les instructions textuelles qui

utilisent des symboles spéciaux (par ex. mf). Il est souvent préférable d’utiliser une police de

texte musical de la même famille que la police musicale: si vous choisissez Opus, Helsinki ou une

autre police musicale “gravée”, choisissez Opus Text, Helsinki Text, ou l’équivalent d’une police

spécifique, si elle est disponible; si vous choisissez Reprise, Inkpen2 ou une autre police musicale

“manuscrite”, choisissez Reprise Text ou Inkpen2 Text.

Lorsque vous cliquez sur OK, Sibelius fait instantanément la mise à jour de l’aspect de la partition.

Si vous n’êtes pas satisfait du résultat, choisissez simplement Édition > Annuler (raccourci Ctrl+Z
ou XZ).

Après avoir modifié la police, la commande Mise en page > Réinitialiser l’espacement des
notes (raccourci Ctrl+Maj+N ou xXN) appliquée à toute la partition pourrait améliorer l’aspect

de la partition, surtout si les nouvelles polices choisies sont sensiblement plus larges ou étroites
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que celles utilisées précédemment. On procèdera de même pour des partitions avec paroles dont la

police de texte principale a été modifiée.

La boîte de dialogue Modifier les styles de texte
Pour modifier un style de texte, choisissez Style maison > Modifier les styles de texte
(raccourci Ctrl+Maj+Alt+T ou xzXT). Conseil utile  si vous sélectionnez un objet de texte dans

la partition avant de choisir Modifier les styles de texte, Sibelius sélectionnera

automatiquement le style de texte approprié dans la boîte de dialogue pour que vous n’ayez pas à le

chercher dans la liste.

Supposons que vous souhaitiez modifier un Style de texte de portée, tel que Technique; cliquez

sur Technique dans la liste, puis cliquez sur Modifier.

Si, par contre, vous souhaitez créer un nouveau style de texte basé sur Technique, sélectionnez-le

dans la liste, puis cliquez sur Nouveau. Choisissez un style de texte similaire à celui que vous

souhaitez créer, par ex. si vous désirez un nouveau style de texte de paroles, basez-le sur un style de

paroles ligne 1 existant. Il vous sera demandé si vous désirez vraiment créer un nouveau style

basé sur le style existant; cliquez sur Oui.

Que se soit pour modifier un style de texte existant ou en créer un nouveau, la boîte de dialogue à

onglets qui s’affiche doit ressembler à ceci:

Remarquez le titre de la boîte de dialogue qui indique quelle catégorie de texte est en cours

d’édition; il pourra s’agir de Style de texte de portée, Style de texte de système ou Style de
texte de page blanche. Il est impossible de changer la catégorie d’un type de texte existant –

mais on peut sans problème créer un nouveau style de texte basé sur celui existant, ce nouveau

style étant de la même catégorie (portée, système ou page blanche) que le style d’origine.

Dès que les réglages du style vous plaisent, cliquez sur OK et il s’appliqueront instantanément à la

partition, modifiant tout le texte de ce style existant.
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Onglet général
Nom est le nom du style, que vous pouvez changer si vous le désirez. Le modifier ne crée pas un

nouveau style, il renomme seulement le style existant. Cela peut s’avérer utile si vous désirez

utiliser un style pour d’autres fonctions; par exemple, si vous ne voulez pas utiliser le style

technique du tout, mais plutôt un style similaire appelé “Didascalies”, il suffit simplement de

modifier le nom du style “Technique” pour décrire son nouvel usage. Autrement, vous devriez

créer un nouveau style basé sur Technique de la manière décrite ci-dessus. Les styles spéciaux tels

que Numéros de mesure se comporteront toujours de manière spéciale même si vous en changez le

nom.

Police permet, chose étonnante, de choisir la police. Pour modifier une police, cliquez sur son

nom dans la liste. Il est aussi possible de transformer une police selon les options Gras, Italique ou

Souligné. Le soulignement est extrêmement rare en musique, ne le faites donc pas sauf si vous êtes

vraiment sûr de ce que vous voulez. Lisez ci-dessous quelques conseils sur les polices et les styles à

utiliser en musique.

Angle permet d’écrire du texte incliné, ce qui, à nouveau, est rarement nécessaire. Certaines

imprimantes ont un bogue qui provoque l’impression du texte incliné selon un angle erroné; si c’est

le cas, cliquez sur Remplacer Arpèges, gliss., etc. dans la boîte de dialogue Fichier > Imprimer.

Taille est la taille du corps de caractère, qui permet à Sibelius un réglage différent entre le

conducteur et les parties séparées (b 7.1 Travailler avec des parties séparées). Le texte en

musique est toujours proportionnel à la taille de portée: si la portée est de grande taille, il en sera

de même des nuances, des paroles, etc. Le chiffre de gauche est donc la taille relative: c’est la taille

dans laquelle le texte apparaîtrait si la taille de portée était de 7 mm (0.28"). Il est généralement

plus simple de spécifier les tailles de texte en musique pour une portée de dimension standard

comme celle-là. Le chiffre de droite est la taille absolue, c’est-à-dire, de quelle grandeur le texte sera

réellement pour la taille de portée actuelle. Vous pouvez modifier l’un de ces deux chiffres, et

l’autre changera automatiquement. 

Conserver en absolu permet de créer des styles de texte qui restent toujours à la même taille,

indépendamment de la taille de la portée. Cette option peut être utile pour, par exemple, appliquer

une taille constante aux titres dans les parties, ou pour que les repères de répétition apparaissent

toujours à la même taille même associés à des petites portées.

Transposer les noms d’accord est utilisé uniquement pour les symboles d’accord, pour indiquer

à Sibelius qu’ils doivent être transposés quand la musique l’est aussi.

Interpréter lors de l’exécution spécifie si l’objet textuel de ce type de texte doit être ou non

exécuté par le dictionnaire de l’exécution lors de l’exécution – b 4.9 Dictionnaire de
l’exécution.

Menu contextuel permet de choisir la liste de mots utiles qui apparaîtront lorsque vous faites un

clic-droit (Windows) ou Contrôle-clic (Mac) lors de la saisie du texte dans le style concerné.

b 3.1 Utiliser du texte.
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L’onglet Bordure
Cercle dessine un cercle autour du texte. Le texte encerclé est rare

en musique (à part pour spécifier les cordes de guitare), mais il est

occasionnellement utilisé pour les numéros de mesure et même

pour les repères de répétition.

Cadre dessine un cadre autour du texte. Ceci est plus courant que les

cercles, et est utilisé pour les repères de répétition, et moins souvent

pour les numéros de mesure et pour des instructions importantes

pour les interprètes.

Sibelius permet même d’avoir du texte encerclé et encadré - bien que

ce soit une nécessité très, très, très rare.

L’épaisseur de la ligne utilisée pour dessiner le cadre et le cercle est

contrôlée par Bordure de texte sur la page Texte de la boîte de

dialogue Style maison > Règles de gravure (raccourci Ctrl+Maj+E
ou xXE).

Effacer l’arrière-plan concerne le texte qui chevauche des lignes de portée ou des barres de

mesure. Cette option est surtout prévue pour les chiffres de tablature, mais elle peut s’avérer utile,

par exemple, pour des nuances qui chevauchent une barre de mesure.

Position spécifie la taille et l’emplacement du cercle ou du cadre, et la taille de la zone effacée par

l’option Effacer l’arrière-plan. Sibelius vous propose par défaut des valeurs sensées.

onglet position horizontale
Comme le texte de portée ne peut être attaché qu’à une position rythmique dans une mesure,

seules les options Aligner sur la note sont disponibles pour ce type de texte. Le texte de système

peut être attaché soit à des positions rythmiques (par ex. Tempo) ou à la page (par ex. En-tête
(après la première page)), de sorte que, soit Aligner sur la note, soit Aligner sur la page
peuvent être choisis. Le texte de page blanche ne peut jamais être attaché à une position rythmique

dans une mesure (étant donné l’absence de mesures dans une page blanche!), de sorte que seul

Aligner sur la page peut être choisi.

Gauche / Centré /Droit spécifient comment le texte est justifié relativement à l’endroit où il est

créé. Cela affecte également l’alignement de plusieurs lignes de texte dans le même objet textuel.

La justification à gauche est le réglage courant. Cependant, vous pouvez vouloir justifier certains

types de texte différemment - par exemple les doigtés qui sont souvent centrés au-dessus de la

note.

Pour régler la distance horizontale du texte d’après son emplacement d’origine,

b 8.12 Positions par défaut.

Les options Aligner sur la page (uniquement pour les types de texte de système et de page

blanche) justifie le texte à gauche/au centre/à droite comme prévu – par exemple, le titre d’un

morceau est toujours centré sur la page. Mais vous pouvez aussi choisir Bordure intérieure /

Bordure extérieure utilisées pour l’impression recto-verso, qui méritent une explication: lors

d’une impression simple face, les numéros de page sont généralement placé du côté droit; mais lors

Taille du texte
En imprimerie, les tailles de 

texte sont indiquées en points 

(pt), qui est égal à 1/72 pouce 

(approx. 0,35mm). Comme les 

lettres varient en taille - même 

les majuscules varient légère-

ment en hauteur - la mesure 

utilisée pour spécifier la taille est 

la distance entre le sommet de la 

lettre la plus haute et le bas de la 

plus basse. Ce qui est environ 

une fois et demi la hauteur 

d’une majuscule. La taille du 

texte dans les livres est normale-

ment d’environ 10 pts.
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d’une impression recto-verso, les numéros de page vont généralement sur la droite des pages de

droite et sur la gauche des pages de gauche - c’est-à-dire sur les extrémités extérieures.

Le texte aligné sur la page est toujours solidaire de la première mesure d’un système (par ex.. le

texte de Titre) ou de la première mesure sur la page si le texte est aligné verticalement sur la page

(par ex. Pied de page).

Aligner sur la page offre trois options supplémentaires:

* À gauche de la page, aligner sur la marge “Pas de nom” est conçue pour les numéros de

page – b 3.6 Numéros de page.

* Aligner sur la marge évite que le texte ne soit éloigné de la marge sur laquelle il est aligné.

* Relatif aux marges de la première page exclusivement indique à Sibelius que ce type de

texte reste aligné sur les marges du début de la partition, sans tenir compte de tout changement

de marge ultérieur (qui résulterait de sauts de page spéciaux – b 8.5 Les sauts). Cette option

est particulièrement utile pour les en-têtes, les pieds de page et les numéros de page.

Onglet position verticale
Pour définir la distance verticale du texte de l’endroit où il est créé, b 8.12 Positions par
défaut.

Interligne définit la distance entre les lignes de texte lorsque vous appuyez sur Retour (sur le

clavier principal) à la fin d’une ligne. La valeur est exprimée en pourcentage du corps de texte.

120 % est un réglage courant pour les livres, mais 100% est plus adapté à du texte en musique.

À propos, l’interligne est connu dans le jargon d’imprimeur comme le plombage (“leading”) en

réminiscence du temps ou des bandes de plomb supplémentaires devaient être placées entre les

lignes de texte pour les espacer. C’était le bon vieux temps.

Afficher au sommet / bas de la page est utile pour positionner le texte qui a une position fixe

sur la page, comme les numéros de page, les en-têtes, pieds-de-page et les notes en bas de page.

Si vous cochez cette case, vous pouvez alors définir les mm de la marge supérieur / inférieure
pour le style de texte (1 pouce = 25.4 mm) – b 7.1 Travailler avec des parties séparées.

Les titres, les repères de répétition, les numéros de mesure, le nom du compositeur, etc. devraient

normalement être positionnés par rapport à la portée supérieure plutôt que par rapport à la marge.

Avec l’option Relatif aux marges de la première page exclusivement, vous pouvez aussi

spécifier que ces types de texte soient uniquement positionnés selon ce critère, pour ne pas tenir

compte de nouveau des changements de marge induits par les sauts de page spéciaux.

Positions multiples d’objet de système, disponible uniquement pour le texte de système, vous

permet d’écrire du texte au-dessus de plus d’une portée. Par exemple, les titres vont uniquement

au-dessus de la portée supérieure (cochez donc seulement Portée supérieure), alors que les

repères de répétition dans les partitions orchestrales vont normalement au-dessus de la portée

supérieure et également au-dessus des cordes (cochez donc Portée supérieure et 2me position).

Vous pouvez définir quelles portées constituent les 2me, 3me et 4me positions dans la boîte de

dialogue Style maison > Positions des objets de système – b 8.8 Style maison.

Portée inférieure est utilisé occasionnellement pour placer des numéros de barre de mesure ou

même des repères de répétition en dessous de la portée inférieure. Pour faire cela, vous devrez
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également activer En dessous de la portée inférieure dans la boîte de dialogue Style maison >

Positions des objets de système.

Onglet répéter
Ceci est uniquement disponible pour le texte de système, et est uniquement utile pour les en-têtes,

les pieds-de-page, les lignes de copyright etc. Cela fait apparaître le texte que vous entrez sur de

multiples pages.

Il est courant pour des éditeurs d’avoir différents en-têtes ou pieds-de-page sur les pages de gauche

et de droite - par exemple, vous pouvez avoir le nom d’une anthologie ou d’un album sur chaque

page de gauche et le nom de la pièce en cours sur chaque page de droite.

Supprimer des styles de texte
Le bouton Supprimer de la boîte de dialogue Style Maison > Modifier les styles de texte
supprime le style de texte sélectionné, comme on pouvait le soupçonner. Les styles de texte

prédéfinis et les styles de texte qui sont couramment utilisés dans la partition en peuvent pas être

supprimés.

Polices de bon goût
En musique, il est d’usage de n’utiliser qu’une famille de police pour tout le texte, à l’exception

peut-être des titres et des noms d’instrument. Une famille de police consiste en variantes d’une

police de base - normalement des versions en gras, italique et gras italique, bien que certaines

familles de police ont également des polices de type plus lourd (de trait plus épais) et plus léger (de

trait plus fin) et / ou condensé (écrasé). Vous devriez utiliser deux ou grand maximum trois

familles de police dans une seule partition.

Par défaut, tous les styles de texte utilisent la famille de police Times New Roman (à moins que

vous n’utilisiez un papier à musique ou un style maison manuscrit basé sur les polices Reprise ou

Inkpen2 fonts), parce que Times a une bonne apparence et est déjà installé sur votre ordinateur. Si

vous souhaitez lui substituer une autre famille, nous vous recommandons fortement d’utiliser une

police à serif, à l’exception peut-être d’un ou deux styles de texte spécifiés ci-dessous. Les polices à

serif (telles que celle-ci) ont des terminaisons obliques appelées serifs aux extrémités des lettres,

par opposition aux polices sans serif. Les polices à sérif sont utilisées dans la plupart des livres et

des journaux pour l’essentiel du texte alors que les polices sans sérif ne sont utilisées presque que

pour les titres, quand elles le sont.

Nous vous recommandons de conserver approximativement la même taille de corps de caractère

pour chaque style de texte que les réglages par défaut de Sibelius (sauf avis contraires ci-dessous).

Lorsque vous modifiez une police, vous souhaiterez peut-être ajuster légèrement la taille car

certaines polices sont un peu plus grandes ou plus petites que d’autres pour la même taille en

points.

Si vous projetez de changer la police de texte principale au moment de commencer une nouvelle

partition, il est préférable d’utiliser des styles maison avec Georgia ou Arial plutôt que Times, car

elles sont plus proches en taille des autres polices que ne l’est Times. Cela permet de garantir que la

police principale n’est pas trop grosse par rapport à l’ensemble de la partition.

Voici quelques conseils pour recréer les styles de texte principaux sans faute de goût:
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* Expression: vous devez utiliser une police italique non-gras (à part pour les nuances telles que

mf, qui utilisent une police de texte musicale spéciale comme OpusText).

* Technique: vous devez utiliser une police non-italique non-gras.

* Paroles premier verset: Times New Roman et Times ont la vertu d’être assez étroites, les

utiliser pour les paroles causent donc moins de perturbations dans l’espacement des notes. Une

autre police classique pour les paroles est Plantin, utilisée par l’Oxford University Press. 

Si vous écrivez une seconde ligne de paroles pour une traduction ou un refrain, il est d’usage

d’utiliser l’italique. Pour les secondes, troisièmes, etc. strophes, n’utilisez pas d’italique.

* Symboles d’accord: utilise par défaut la police Opus Chords (ou Reprise Chords ou Inkpen2

Chords, selon le style maison). Vous pourriez lui substituer une autre police moyenne, de

préférence sans sérif, mais n’oubliez pas que les symboles d’accord nécessitent certains

caractères spéciaux non fournis avec les polices de texte ordinaires.

* Titre, Sous-titre, Compositeur, Parolier, Dédicace: pour le titre et peut-être le sous-titre,

vous pouvez régler la police et la taille sur à peu près tout ce que vous voulez. Pour le

compositeur, le parolier et la dédicace, vous devriez normalement utiliser la même police et la

même taille que Technique, avec toutefois la dédicace en italiques.

* Tempo et Indication métronomique: la taille de ces styles varie grandement de partition à

partition. Tempo est presque toujours en gras et plus grand que l’indication métronomique, qui

est généralement pas en gras.

* Instruments: vous pouvez peut-être vous en tirer avec une police sans sérif de bon goût, mais

soyez prudent.

* Numéros de mesure: généralement en italiques. Vous pouvez ajouter un cadre pour attirer

l’attention sur les chiffres, mais utilisez alors une police non italique. (les italiques pourraient

déborder sur le cadre)

* Numéros de page: utiliser une police ni en gras ni en italique. b 3.6 Numéros de page
pour des conseils sur le positionnement.

* Repères de répétition: utilisez de préférence un police en gras pour la clarté, mais pas

d’italique (ils pourraient déborder sur le cadre). Ce peut être une bonne idée d’utiliser la même

police que le titre, même si celui-ci est dans une police inhabituelle. Vous pouvez omettre le

cadre, mais cette pratique est dépassée pour la simple et bonne raison que les repères de

répétition sans cadre ne sont pas assez visibles.

* Indications de mesure: utilise par défaut Opus, Helsinki, Reprise ou Inkpen2 font. Vous

pouvez substituer n’importe quelle autre police musicale standard, ou même une police en gras.

Si c’est votre intention, vous devriez ajuster l’interlignage dans l’onglet Position verticale.

* Multiplets: une police italique sans serif est normale, bien que du non italique et/ou sans serif

sont parfois présentes dans les partitions modernes qui utilisent beaucoup de multiplets.

* Autres styles de texte: de préférence suivre les styles décrits ci-dessus, par ex. texte encadré et

Pied de page devrait être identique ou similaire à Technique.

* Styles des symboles (par ex. Symboles usuels, Instruments à percussion): ces styles

spécifient la police utilisée par les symboles musicaux, qui ne fonctionnent pas comme les autres

objets textuels. b 8.11 Polices musicales pour des conseils, et ne changez ces styles que si

vous êtes sûr de ce que vous faites.
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3.10 Formules magiques

Une formule magique (en anglais wildcard) est un code qui, une fois placé dans un objet texte, est

automatiquement remplacé par un ou plusieurs mots déterminés à un emplacement particulier.

Sibelius comporte plusieurs formules magiques très pratiques. On pourra par exemple placer le

titre d’un morceau et le numéro de page dans un en-tête, qui seront automatiquement mis à jour si

vous changez le titre (et cela fonctionne aussi dans les papiers à musique).

À quoi ressemble une formule magique
Les formules magiques dans Sibelius commencent par \$ et finissent par \ ; voici un exemple

\$Titre\. Quand on édite un objet textuel contenant une formule magique, le code lui-même

apparaît (comme illustré ci-dessous à gauche). Dès qu’on arrête l’édition, c’est le texte auquel réfère

la formule magique qui apparaît à sa place (comme illustré ci-dessous à droite).

Formules magiques
Pour les formules magiques suivantes, les mots ou expressions qui leur correspondent ont été

entrés pour la plupart dans la boîte de dialogue Fichier > Infos sur la partition
(b 9.1 Manipuler les fichiers), et pour les autres dans la page finale de la boîte de dialogue

Fichier > Nouveau utilisée pour créer une nouvelle partition:

Si nécessaire toutes ces formules magiques peuvent recevoir différents réglages selon qu’elles

apparaissent dans le conducteur ou les parties séparées. Grâce à cela Sibelius garantit que les

parties dynamiques reçoivent une appellation exacte. – cf. ci-dessous Nom des parties et
changements d’instrument.

* \$Title\
* \$Subtitle\
* \$Composer\
* \$Arranger\
* \$Artist\
* \$Copyright\
* \$PartName\
* \$InstrumentChanges\

* \$Lyricist\
* \$Copyist\
* \$Publisher\
* \$Dedication\
* \$OpusNumber\
* \$ComposerDates\
* \$YearOfComposition\
* \$MoreInfo\
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Il existe d’autres formules magiques:

* \$DateShort\: la date du jour au format “date courte” des options régionales de votre système

(c’est-à-dire jj:mm:aaaa)

* \$DateLong\: la date du jour au format “date longue” des options régionales de votre système

(c’est-à-dire jourmois année)

* \$Time\: la durée au format hh:mm:ss (24 heures)

* \$User\: le nom de l’utilisateur en cours de session sur l’ordinateur

* \$FilePath\: le nom du fichier et le chemin d’accès de la partition en cours. (Cela ne fonctionne

pas tant qu’une partition n’a pas été sauvegardée.)

* \$FileName\: le nom du fichier de la partition en cours sans son chemin. (Cela ne fonctionne

pas tant qu’une partition n’a pas été sauvegardée.)

* \$FileDate\: la date et l’heure de la dernière sauvegarde, dans le format défini dans votre

système au niveau local (par ex. jj MM aaaa hh:mm:ss)

* \$PageNum\: le numéro de la page en cours.

Nom des parties et changements d’instrument
Dans un conducteur, \$PartName\ est réglé par défaut sur “Conducteur”, tandis que

\$InstrumentChanges\ donne une liste de tous les instruments utilisés dans la partition (y sont

énumérés tous les instruments au début de chaque portée, et tous les changements d’instruments

qui apparaissent sur chaque portée), séparés par un alinéa.

Dans une partie dynamique, à la fois \$PartName\ et \$InstrumentChanges\ donnent une liste

de tous les instruments utilisés dans la partie, séparés par des alinéas.

De plus, il existe deux formules magiques supplémentaires, \$HeaderPartName\ et

\$HeaderInstrumentChanges\, qui séparent chaque nom d’instrument par une virgule plutôt

que par un alinéa.

Pourquoi tant de formules magiques si semblables?

* Sibelius utilise \$PartName\ pour le nom (ou les noms) d’instrument qui apparaît/ssent dans le

coin supérieur gauche de la première page de chaque partie dynamique (et dans le conducteur

aussi, mais ce texte est masqué par défaut)

* Sibelius utilise \$HeaderPartName\ pour le nom (ou les noms) d’instrument qui apparaît

(ssent) en en-tête de page à partir de la deuxième de chaque partie dynamique (et dans le

conducteur aussi mais, de nouveau, ce texte est masqué par défaut)

* Quand une partie contient deux instruments joués par le même musicien, la convention consiste

à donner un nom tel que “Anches 1”. Dans ce cas, c’est ce nom qu’il faut introduire pour Nom
Partie dans Fichier > Informations sur la partition; le texte du coin supérieur gauche de la

première page et les en-têtes suivants seront mis à jour. Si de plus vous voulez afficher la liste des

instruments utilisés dans la partie, la formule \$InstrumentChanges\ convient parfaitement.

Dans les illustrations ci-dessous, les fragments de gauche montrent ce qu’il faut entrer dans

l’objet textuel dans le coin supérieur gauche de la première page; les fragments de droite

montrent le résultat obtenu une fois l’édition du texte finie. Dans les deux cas, le résultat est

visible dans Fichier > Infos sur la partition.
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Dans les deux derniers fragments, remarquez que la formule \$NomPartie\ est en gras, de même

que le texte “ANCHES 1”. Lisez la suite pour connaître la méthode pour former d’autres types de

formules magiques.

Utiliser les formules magiques
On peut utiliser les formules magiques dans n’importe quel objet textuel, et plusieurs peuvent

coexister dans un même objet. Par exemple, si vous créez un objet textuel tel que \$Title\ –
Dernière édition\$User\ le\$FileDate\, voici ce qu’on pourrait obtenir “L’Oiseau de feu –

Dernière édition par Igor Stravinsky le 16 Mai 1910 02:15:28”.

Vous pouvez aussi changer le format des formules magiques; par exemple, si l’objet textuel se

présente comme ceci \$Title\ – \$Composer\ et que vous voulez mettre le titre de la partition en

gras:

* Éditez le texte (par ex. en tapant Retour, F2 ou le double-cliquant)

* Sélectionnez uniquement la formule magique \$Title\ (par ex. avec Maj+0/1)

* Tapez Ctrl+B ou XB (ou activez B dans le panneau Texte Texte des propriétés) pour qu’il se

mette en gras.

Vous pouvez utiliser la même procédure pour changer de police, mettre en italiques, agrandir la

taille, etc...

Voici quelques trucs supplémentaires pour une utilisation réussie des formules magiques:

* Les formules magiques ne sont pas sensibles à la casse, de sorte que \$TITlE\, \$title\ et

\$Title\ sont tous équivalents. De plus, la casse elle-même de la formule n’a pas d’effet sur le

texte substitué.

\$PartName\ Clarinette en Si
Saxophone alto

\$InstrumentChanges\
\$PartName\
\$InstrumentChanges\
\$PartName\
\$PartName\
\$InstrumentChanges\

ANCHES 1
Clarinette en Si
Saxophone alto

b

b
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* Cependant, les formules magiques ne contiennent pas d’espace, de sorte que si vous entrez \$
ComposerDates\ à la place de \$ComposerDates\, la formule ne fonctionnera pas.

* Si vous utilisez une formule magique qui ne renvoie à rien, par exemple si vous tapez \$Title\
mais que rien ne figure dans le champ Titre de la fenêtre Fichier > Infos sur la partition, dès

que vous arrêtez l’édition de l’objet textuel, celui-ci peut disparaître. Il est donc préférable

d’attribuer un contenu pour une formule magique avant de l’utiliser.

* Évitez d’entrer les formules magiques elles-même dans les boîtes de dialogue, par exemple dans

les champs de Fichier > Infos sur la partition. Tapez-les directement dans les objets textuels de

la partition. Il n’est donc pas possible d’utiliser une formule magique pour définir un autre

formule (d’ailleurs un tel désir semble bien mystérieux).

Ajouter des changements de format dans les infos sur la partition
Sibelius permet d’ajouter des sauts de ligne et des changements de police, de caractère et de style

n’importe où pour tout texte entré dans la boîte de dialogue Fichier > Infos sur la partition. La

plupart de ces changements de format sont simplement compris entre deux barres obliques – par

ex. \n\.

* \fnompolice\ – utiliser la police mentionnée (par ex. \fArial\ pour passer à Arial)

* \staille\ – régler la taille de la police sur taille x 1/32me de dents (par ex. \s64\ règle la taille de
la police sur deux dents)

* ^ – utiliser la Police de texte musical (selon le réglage de Style maison > Modifier toutes les
polices) pour le caractère qui suit.

Par exemple, supposons que vous réalisiez l’arrangement d’un morceau d’un autre compositeur et

que vous voulez que votre nom et le sien figurent sur deux lignes dans le champ Compositeur de

la boîte de dialogue Fichier > Infos sur la partition. Vous pouvez entrer quelque chose comme

ceci: J.S. Bach\n\arr. Aran Gerr et voici ce que la formule magique \$Compositeur\ intégrée

dans un texte de la partition produirait:

“J.S. Bach 

arr. Aran Gerr”

* \B\ – en gras on

* \I\ – en italiques

* \U\ – en souligné

* \n\ – alinéa

* \b\ – plus en gras

* \i\ – plus en italiques

* \u\ – plus en souligné

* \f\ – rétablir le style de texte par défaut de la

police
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3.11 Polices de substitution

Utilisateurs avertis uniquement

Quand on ouvre une partition qui utilise une police qui n’est pas installée sur l’ordinateur, Sibelius

lui substitue une police similaire. Cela fonctionne tant pour les polices de texte (par exemple si

Helvetica n’est pas installée, Arial sera utilisée à la place) que pour les polices musicales (par

exemple si Petrucci n’est pas installée, Opus sera utilisée à la place).

Il est possible de contrôler quelles polices sont substituées en utilisant la page Polices de
substitution de la boîte de dialogue Fichier > Préférences (dans le menu Sibelius sur Mac):

Supposons que quelqu’un vous envoie un fichier qui contient la police Didot, et que celle-ci n’est

pas installée dans votre ordinateur. Vous pouvez indiquer à Sibelius de remplacer cette police par

Palatino Linotype, de manière à ce que chaque fois que vous ouvrez une partition contenant la

police Didot manquante celle-ci soit remplacée par Palatino Linotype. Voici comment attribuer

une police de substitution à une police manquante:

* Entrez le nom de la police manquante à remplacer dans le champ de gauche Police, ou

choisissez dans la liste des polices en cliquant sur le bouton Choisir. Quand vous avez entré le

nom de la police, cliquez sur le bouton Ajouter une police. La police sera ajoutée dans la liste

des polices à gauche.

* Pour substituer une police à une autre, sélectionnez la police manquante dans la liste de gauche

et dans le champ intitulé Si la police n’est pas disponible, la remplacer par une de celles-
ci, entrez le nom de la police que Sibelius devra utiliser en remplacement de l’autre, ou utilisez le

bouton Choisir pour la sélectionner dans la liste des polices disponibles installées sur

l’ordinateur. Une fois entré le nom de la police de substitution, cliquez sur le bouton Ajouter
une police de substitution. Sibelius ajoutera la police à la liste des polices de substitution dans

la liste de droite.

* Pour ajouter des polices supplémentaires de substitution, refaites les étapes décrites ci-dessus

autant de fois que nécessaire.

Pour ajuster l’ordre de préférence des polices de substitution, utilisez les boutons de droite

Déplacer vers le haut et Déplacer vers le bas pour les descendre ou les remonter dans la liste.
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Sibelius choisit toujours la police la plus haute dans la liste; cela signifie que la police au sommet de

la liste sera utilisée si elle est installée, sinon ce sera celle en dessous, etc....

Pour enlever une police à remplacer ou de substitution dans l’une des listes, sélectionnez-la et

cliquez sur le bouton Enlever.

Vous pouvez utiliser des polices de tierces parties dans Sibelius. Pour en savoir plus sur la manière

de gérer ces polices, consultez Utiliser d’autres polices que celles fournies avec Sibelius
dans b 8.11 Polices musicales.
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b 4.3 Table de mixage, 4.8 Exécution enregistrée, 4.4 Sibelius Sounds Essentials,

4.17 Messages MIDI.

Sibelius est capable d’exécuter vos partitions avec un minimum de complications. Il n’est pas

nécessaire d’être un expert en MIDI ou en séquenceur pour obtenir de Sibelius de belles

exécutions, il suffit de se lancer !

Cet article présente différentes fonctions en quelques lignes et vous indique quels autres articles

lire pour en savoir plus.

Périphériques et configuration d’exécution
Sibelius nécessite un ou plusieurs périphériques d’exécution pour produire des sons. Un

périphérique d’exécution est un périphérique logiciel (par ex. un instrument virtuel, un logiciel

synthétiseur) ou matériel (par ex. une carte-son, un module de sons MIDI externe) qui peut

produire un ou plusieurs sons. Vous pouvez disposer de plusieurs périphériques sur votre

ordinateur et les utiliser avec Sibelius dans n’importe quelle combinaison, que vous réglez sous

forme d’une configuration d’exécution.

Pour en savoir plus sur les différents types de périphériques d’exécution et la manière de régler vos

propres configurations d’exécution en utilisant Exécution > Périphériques d’exécution,

b 4.12 Périphériques d’exécution.

Sibelius est aussi livré avec son propre jeu de sons prédéfinis appelé Sibelius Sounds Essentials.

Pour en savoir plus, b 4.4 Sibelius Sounds Essentials.

Contrôler l’exécution
L’exécution se contrôle dans la fenêtre de l’exécution (affiché à

droite), ou avec les commandes correspondantes dans le menu

Exécuter ou leurs raccourcis-clavier. Pour afficher la fenêtre

de l’exécution s’il n’est pas déjà visible, choisissez Fenêtre >

Exécution (raccourci Ctrl+Alt+Y ou zXY).

Ligne de lecture
La ligne de lecture est une ligne verte qui suit la musique durant l’exécution, et qui indique où

Sibelius commencera à jouer lors de la prochaine exécution. Vous pouvez contrôler la position de

la ligne de lecture quand il n’y a pas d’exécution en utilisant la fenêtre d’exécution. Si vous voulez

cacher la ligne de lecture quand il n’y a pas d’exécution, désactivez Affichage > Ligne de lecture.

Suivre la partition durant l’exécution
Sibelius suit automatiquement la partition durant l’exécution, et en agrandit l’affichage pour

permettre de voir ce qui est exécuté. Vous pouvez naviguer dans la partition tout comme lorsque

l’exécution est arrêtée, et modifier le niveau du zoom (Sibelius se rappellera du niveau choisi lors

de l’exécution suivante).
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Vous pouvez changer ce comportement en utilisant les options de la page Position de la partition
de Fichier > Préférences (dans le menu Sibelius sur Mac) – b 5.15 Préférences.

Exécution durant la saisie et l’édition
Chaque fois qu’une note est saisie, cliquée ou déplacée elle est exécutée. Si vous trouvez cela gênant,

désactivez Jouer les notes en cours de modification dans la page Saisie des notes de Fichier >

Préférences (dans le menu Sibelius sur Mac).

Choix des sons
Sibelius choisit automatiquement les meilleurs sons possibles pour l’exécution en utilisant les

périphériques disponibles, grâce à un moyen unique de classement et d’organisation des sons

appelé SoundWorld™ (b 4.18 SoundWorld™).

Pour changer les sons, utilisez la table de mixage, que vous pouvez masquer ou afficher en

choisissant Fenêtre > Table de mixage, ou en tapant Ctrl+Alt+M ou M (b 4.3 Table de
mixage).

Vous pouvez aussi modifier les sons à mi-partition à l’aide des modifications d’instrument

(cf. Changement d’instruments à la page 154).

Interprétation de la partition
Sibelius est conçu pour interpréter automatiquement tous les signes et indications de la partition

(b 4.2 Interprétation de la partition); normalement il n’est pas nécessaire d’en ajuster les

effets, mais si c’est votre souhait, il suffit d’utiliser Exécution > Dictionnaire
(b 4.9 Dictionnaire de l’exécution).

Sibelius peut aussi produire une interprétation remarquablement proche de la réalité en utilisant

Espressivo™ et Rubato™, que vous pouvez contrôler via Exécution > Exécution enregistrée
(b 4.5 Interprétation).

Vous pouvez même concevoir la votre en utilisant Live Tempo (b 4.7 Live Tempo).

All Notes Off
Exécution > Extinction de toutes les notes (raccourci Maj-O) éteint toutes les notes en train

d’être jouées. Cela peut s’avérer nécessaire:

* si l’ordinateur, la carte-son ou le périphérique MIDI est saturé par une avance ou un recul rapide

de la lecture (ce qui arrive si le périphérique n’est pas très puissant ou si l’action est réalisée dans

une partition complexe)

* Si l’exécution est arrêtée alors que la pédale de soutien est enfoncée.

Maj-O peut aussi être utilisé en cours d’exécution si une note est “accrochée”; Sibelius “nettoiera”

toutes les notes et reprendra l’exécution.

Les causes les plus fréquentes de note “accrochée” sont les liaisons orphelines (c’est-à-dire une note

liée mais non suivie d’une autre note à la même hauteur). Sibelius propose une extension qui

détecte et élimine de telles liaisons dans les partitions – cf. Supprimer les liaisons orphelines
à la page 568.
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4.2 Interprétation de la partition

b 2.21 Lignes, 2.26 Percussion, 4.6 Reprises, 4.9 Dictionnaire de l’exécution.

En concevant les fonctions de lecture et d’exécution, notre philosophie était de faire en sorte qu’une

partition écrite normalement, comme un manuscrit, puisse s’exécuter sans réglage

supplémentaire.

Voici comment procéder :

* Sibelius choisit par défaut le meilleur son disponible pour chaque instrument

* Lors de l’exécution d’une partition, Sibelius lit pratiquement tout ce qui est écrit dans la partition

de la manière souhaitée. Sibelius comprend même des indications telles que�ff, pizz., ou accel.

ainsi que toute nouvelle expression ou nouveau terme créés par l’utilisateur dans le dictionnaire

de l’exécution.

Que lit Sibelius
Pratiquement tout le contenu musical d’une partition est lu correctement, à savoir:

* Les notes, les accords, les silences, les altérations, les liaisons rythmiques et les notes

ornementales

* Les clefs, les armures et les indications de mesure

* Les instruments, c’est-à-dire la détermination des sons utilisés, que l’on peut changer à volonté

* Les articulations usuelles, par exemple l’accent, le staccato, le marcato, etc....

* Les trémolos et les roulements de tambour (z sur la hampe)

* Le texte indiquant des nuances telles que pp, sfz, fort

* Les indications de tempo, comme Allegro, indications de métronome telles que q = 108, et les

changements de métriques tels que q = e et pauses (fermatas)

* Les autres textes, par exemple con sord, pizz., legato – b 4.9 Dictionnaire de l’exécution
pour en savoir plus sur l’exécution des textes

* Les reprises, dont les primos et les secundos, les barres de mesure de reprise, les codas et les

indication de type “al segno” – b 4.6 Reprises

* Les lignes telles que les liaisons de phrasé, les trilles, les lignes d’octava (8va), les pédales, rit./

accel., les gliss. et les soufflets

* Les indications de jeu de la guitare telles que les bends et les slides

* Les têtes de notes utilisées dans les percussions

* Les instruments transpositeurs (qui jouent toujours à la hauteur réelle)

* Les messages MIDI messages entrés comme texte de commande pour le contrôle précis de

l’exécution – b 4.17 Messages MIDI

* Les objets masqués, par exemple les indications de métronome, les notes ou les nuances, ou

même des portées entières – b 3.1 Utiliser du texte, 5.9 Masquer des objets,

5.8 Portées en vue ciblée.
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Les nuances
Les nuances consistent en de discrètes instructions de texte Expression comme mf et soufflets, qui

sont des lignes spécifiant un changement graduel des nuances – cf. Soufflets ci-dessous.

Tous les objets de portée affectent uniquement la portée et la voix ou les voix auxquelles il sont

attachés. En cas d’erreur de placement des nuances, l’exécution s’en ressent particulièrement.

(b 8.7 Attaches). Pour les instruments écrits sur plusieurs portées, tels que les instruments à

clavier, cf. Instruments à plusieurs portées ci-dessous.

Si une nuance n’est pas attachée à la bonne portée, déplacez-la jusqu’à celle qui convient; dès que la

ligne d’attache grise relie la nuance à cette nouvelle portée, replacez la nuance à la bonne place.

(Il n’est possible de modifier l’attachement d’un objet que dans une partition entière. Si vous

déplacez un objet dans une partie dynamique, il ne sera pas réattaché.)

Pour changer la voix ou les voix auxquelles s’appliquent la nuance, sélectionnez-la et tapez Alt+1/

2/3/4 ou z1/2/3/4 pour l’assigner à une autre voix; Alt+5 ou z5 l’assigne à toutes les voix). Si la

nuance s’applique à une combinaison de voix, utilisez les boutons de voix en bas dans le pavé

(b 1.2 Pavé).

Toute nuance créée avec le texte d’expression (cf. Expression à la page 243), possède des

caractéristiques déterminées dans le dictionnaire d’exécution (b 4.9 Dictionnaire de
l’exécution) – par exemple fff équivaut à une vélocité MIDI de 127. Mais la vélocité d’une note

dépend aussi d’autres paramètres tels que le niveau d’Espressivo et les éventuelles articulations

(par ex. un accent) qui lui sont attribuées.

Soufflets
Quand on place un soufflet, par défaut Sibelius en établit la nuance finale. S’il existe une nuance

finale écrite en fin de soufflet à droite (par ex. ff), elle sera utilisée; sinon Sibelius va augmenter ou

diminuer la nuance d’un cran (Par ex. un soufflet de crescendo qui commence à mp finira à mf,

tandis qu’un soufflet de diminuendo qui commence à ff finira à f ).

Si vous voulez spécifier la nuance finale de manière plus précise, soit par une nuance explicite, soit

selon un pourcentage de la nuance initiale, sélectionnez le soufflet concerné et ouvrez le panneau

Exécution de la fenêtre des propriétés (raccourci Ctrl+Alt+P ou zXP). Dans la liste déroulante

remplacez le réglage par défaut auto soit par Changer qui utilise un pourcentage de la valeur

initiale, ou par Maximum qui utilise un pourcentage la valeur maximum de nuances. Si vous

spécifiez dans les propriétés une nuance finale spécifique, cette nuance sera toujours utilisée même

si un objet textuel d’expression est ajouté, déplacé ou enlevé à la fin du soufflet.

Dans le monde réel, les nuances sont jouées différemment selon les catégories d’instruments. Les

instruments à percussion (tels que le piano, les timbales, la harpe, etc.) peuvent seulement changer

la nuance à l’attaque de la note, tandis que les instruments qui tiennent le son (tels que la plupart

des vents, cuivres et instruments à cordes) peuvent changer de nuance pendant la production de la

note.

Sibelius joue les nuances de manière aussi réaliste que le périphérique de lecture le permet. Pour

de nombreux périphériques de lecture, dont la bibliothèque d’échantillons Sibelius Sounds

Essentials, Sibelius jouera un changement de nuance fluide au cours de la durée du soufflet, écrit

pour des instruments tenant le son (ex. vents, cuivres, instruments à cordes et chant). D’autres
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périphériques, dont la plupart des modules de sons et les cartes-sons, ne possèdent pas ce type de

réglage, et pour ces périphériques, Sibelius peut seulement spécifier la nuance à l’attaque de la note

sans pouvoir modifier la nuance au milieu de la note.

Si Sibelius n’exécute pas les soufflets automatiquement pour des instruments tenant le son sur

votre périphérique de lecture, vous pouvez ajouter des messages MIDI pour modifier le volume à

l’aide d’une extension – cf. Exécution Cresc./Dim. à la page 574.

Comme tout texte d’expression (cf. Les nuances ci-dessous), toute ligne de portées, comme l’est

le soufflet, s’applique uniquement à la portée et à la voix (ou les voix) auxquelles elle est attachée.

Trilles
Par défaut, le trille alterne 12 fois par seconde deux notes séparées d’un intervalle diatonique –

c’est-à-dire un demi-ton ou un ton entier, en fonction de la hauteur de la note déterminée par la

tonalité en cours.

pour changer l’exécution d’un trille isolé, sélectionnez-le, puis changez les contrôleurs du panneau

Exécution de la fenêtre des propriétés:

* Pour spécifier un intervalle d’un demi-ton, désactivez Diatonique, puis réglez Demi-tons sur

l’intervalle souhaité. (Pour transformer un trille en trémolo d’une note dans une percussion,

sélectionnez le trille et réglez Demi-tons sur 0.)

* Pour changer la vitesse d’un trille, réglez Vitesse sur le nombre de notes souhaitées par seconde

* Activez Jeu régulier si vous ne voulez pas que Sibelius fasse des petites variations de rythme en

jouant le trille. Avec cette option désactivée, les notes jouées donneront un trille très mécanique.

* Activer Attaque par la note supérieure si vous voulez que le trille commence par la note

supérieure plutôt que par la note inférieure.

Vous pouvez écrire une petite altération sous forme de symbole au-dessus du trille pour indiquer

l’intervalle, mais Sibelius ne le lira pas directement.

Les autres ornements ne sont pas exécutés automatiquement, mais Sibelius propose une extension

pour l’exécution des mordants et des gruppetti – cf. Exécution des ornements à la page 575.

Tempo
Pour changer le tempo d’une partition, utilisez un morceau de texte de tempo – tel que Allegro,

Slow, Presto, etc...– ou utilisez une indication métronomique - comme q = 120 - qui sera écrite

en texte d’indication métronomique. Pour savoir comment entrer ces indications dans la partition

sous forme de texte, cf. Tempo à la page 245 et Indications métronomiques à la page 244.

Pour changer la manière dont Sibelius doit suivre les indications métronomiques telles que

Allegro, b 4.9 Dictionnaire de l’exécution.

Vous pouvez ajuster le tempo de la partition avec le curseur de tempo de la fenêtre d’exécution,

mais cette manière de faire ne peut servir à régler le tempo de manière générale, car la position du

curseur n’est pas mémorisée et n’est donc pas appliquée lors des ouvertures futures de la partition.
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Modulations métriques
Sibelius exécute les changements de métrique pourvu qu’elles soient entrées en utilisant un style de

texte de système (par exemple celui de tempo ou d’indication métronomique) – cf. Modulations
métriques à la page 244 pour en savoir plus sur la manière de les créer.

Sibelius comprend des formes complexes telles que q = q._x etc...; le nombre de notes (avec ou sans

points) reliées avec des liaisons ou des signes + n’est pas limité. La seule restriction vient du fait que

Sibelius se base sur les entrées du dictionnaire dans la boîte de dialogue Exécution > Dictionnaire
utilisées pour les indications de métronomes régulières pour reconnaître les changements de

métrique. Cela signifie que, pour que soient compris les changements de métrique décrits par une

combinaison de notes, de liaisons ou de signes + à gauche du signe = , de nouveaux termes doivent

être définis pour chaque nouveau type de changement de métrique utilisé. (b 4.9 Dictionnaire
de l’exécution).

Rit. et accel.
Sibelius est capable d’exécuter les rits. et accels. à l’aide de lignes spéciales (b 2.21 Lignes).

Les lignes de Rit./accel. permettent de spécifier l’intensité d’un rit./accel. et l’endroit où il se

termine, à savoir à la fin de la ligne. La ligne peut être une ligne soit visible, soit invisible ne servant

alors qu’à indiquer où s’arrête l’effet (si Affichage > Objets masqués est activé, elle s’affiche sous

forme d’une ligne grise continue). Il est possible de spécifier la valeur finale du tempo du rit./accel.

dans le panneau Exécution de la fenêtre des propriétés (b 5.17 Propriétés):

* Tempo final: permet de spécifier soit un tempo absolu en temps par minute (tpm), ou sous

forme de pourcentage du tempo initial (par défaut le réglage est de 75% pour une ligne de rit., et

de 133% pour une ligne d’accel. )

* Il est possible aussi de spécifier la manière dont le tempo varie durant l’accel. ou le rit.:

% Avancé: le tempo se modifie plus vite en début de ligne

% Retardé: le tempo se modifie plus vite en fin de ligne

% Linéaire: le changement de tempo s’effectue de manière constante tout le long de la ligne.

Pour retrouver le tempo original après un accel. ou un rit., il suffit de créer une indication de

tempo telle que A tempo en texte de Tempo. Cependant, Sibelius n’interprétera pas A tempo
automatiquement (parce que souvent le tempo à rétablir n’est pas établi de manière évidente), de

sorte qu’il faut créer une indication de métronome masquée (cf. Indications métronomiques
à la page 244).

Vous pouvez ajuster la lecture des instructions de rit. et accel. en enregistrant une performance

Live Tempo – b 4.7 Live Tempo.

Points d’orgue (pauses)
Sibelius joue les points d’orgue (pauses) à l’aide d’articulations ajoutées du quatrième clavier (F10)

(b 2.3 Articulations).

Quand vous souhaitez spécifier une pause, veillez à créer un point d’orgue sur chaque portée,

notamment si les rythmes diffèrent entre les portées; Sibelius peut seulement déterminer

comment jouer au mieux la pause si un point d’orgue est présent sur toutes les portées comportant

des notes. Si un point d’orgue est absent d’une ou de plusieurs portées, Sibelius jouera simplement
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le rythme sur ces portées tel qu’écrit, puis maintiendra la dernière note qui coïncide avec la/les

point(s) d’orgue sur d’autres portées.

La longueur d’un point d’orgue dépend soit du réglage par défaut sur la page Articulations de

Jouer > Dictionnaire (b 4.9 Dictionnaire de l’exécution), ou des réglages sur le panneau

des Propriétés Exécution, qui ignore les paramètres par défaut le cas échéant. Pour régler

l’exécution d’une pause individuelle:

* si chaque portée a un rythme différent, sélectionnez la note avec un point d’orgue qui termine en

dernier (pas le point d’orgue lui-même) et activez la case Fermata dans le panneau des

Propriétés Exécution 

* Définissez Étendre la durée au pourcentage souhaité de la durée de la valeur de la note écrite

(ex. pour faire durer un point d’orgue sur une ronde de huit quarts de note, genre 200)

* Si vous souhaitez que le point d’orgue soit suivi d’un espace avant la note suivante, définissez

Ajouter espace au pourcentage de la durée de la valeur de la note écrite (ex. pour un espace de

noire suivant un point d’orgue sur une ronde, genre 25).

Vous pouvez aussi régler l’exécution de points d’orgue en enregistrant une performance Live

Tempo – b 4.7 Live Tempo.

Gliss. et port.
Les lignes Gliss. et port. (b 2.21 Lignes) s’exécutent, en appliquant par défaut le type de

glissando que joue l’instrument, c’est-à-dire par paliers chromatiques pour les instruments à vent,

mais de manière continue pour les cordes. Pour modifier la manière dont s’exécute une ligne,

sélectionnez-la et utilisez le panneau Exécution de la fenêtre des propriétés:

* La liste déroulante type de Glissando propose différentes sortes de glissando. En principe le

réglage Selon l’instrument doit être conservé.

* Pour le type de glissando Continu (un glissement continu donc), la vitesse du glissando est exprimée

sous forme de “courbe”:

% Avancé: exécute le début du gliss. plus rapidement

% Retardé: exécute la fin du gliss. plus rapidement

% Linéaire: exécute le gliss. à une vitesse constante du début jusqu’à la fin.

Harmoniques
Bien que Sibelius n’exécute pas automatiquement les harmoniques, il n’est pas compliqué de les

faire jouer en utilisant l’extension Exécution > Exécution des harmoniques (b 6.1 Travailler
avec des extensions), ou en utilisant des notes masquées et des têtes de note silencieuses.

Les harmoniques naturelles (par exemple chez les cuivres) sont généralement notées par le

symbole “o” au-dessus de la note. Pour que la note harmonique soit exécutée, utilisez pour la note

écrite une tête de note silencieuse, et ajoutez cette fois la note réellement jouée en utilisant une

note masquée placée à une autre voix – pour en savoir plus, 2.25 Têtes de note et

b 5.9 Masquer des objets.

Les harmoniques artificielles (par exemple dans les instruments à cordes) sont notées au moyen

d’une tête de note en forme de losange une quarte ou une quinte juste au-dessus de la hauteur

écrite. Utilisez une tête de note silencieuse pour la hauteur écrite et une tête en losange pour
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l’harmonique. Si vous voulez que la tête en losange soit aussi silencieuse, – b 8.16 Modifier les
têtes de note. Comme expliqué ci-dessus, ajoutez la hauteur de l’harmonique qui doit être

exécutée en utilisant une note masquée dans une autre voix.

Indications de pédale
Les indications de pédale sont exécutées, tant qu’elles sont indiquées par des lignes (pas par des

symboles ou du texte). Elles s’appliqueront aux deux portées de l’instrument, à condition que

Utiliser le même emplacement pour toutes les portées d’instrument à clavier soit activé

(réglage par défaut) sur la page Exécution de Fichier > Préférences (dans le menu Sibelius sur

Mac).

Instruments à plusieurs portées
Si un instrument de la partition utilise deux portées, tel qu’un piano ou une harpe, pour que les

deux portées exécutent la même nuance, il suffit de la créer sur la portée supérieure si elle se

trouve au milieu des deux. Notez que cela s’appliquera aussi à tous les instruments créés avec deux

portées (par exemple si vous créez une flûte avec deux portées, les nuances entre les deux portées

s’appliqueront aux deux portées).

Dans les rares occasions où une nuance ne doit pas s’appliquer aux deux portées d’un instrument à

clavier, placez la nuance le plus près possible d’une des portées ou à l’extérieur (c’est-à-dire au-

dessus de la portée de la main droite ou en dessous de la portée de la main gauche). Si les nuances

ne s’appliquent jamais aux deux portées simultanément désactivez l’option Affecte la portée
adjacente dans la boîte de dialogue Exécution > Interprétation. Dans cette boîte de dialogue

vous pouvez aussi ajuster la distance à partir de laquelle une nuance doit s’appliquer à la portée

adjacente. Pour en savoir plus, b 4.5 Interprétation.

Si le nombre de portées utilisées pour un instrument se modifie en cours de partition, par exemple

parce que l’instrument se divise en plusieurs portées pour différents exécutants avant de se

rejoindre plus loin, il sera peut être nécessaire de placer des nuances ou des indications de jeu (par

exemple pizz., sourdine) masquées au début du système suivant pour prolonger l’effet existant

avant la modification des portées. En effet Sibelius ne peut savoir quand un exécutant passe d’une

portée à l’autre, c’est le seul moyen pour les effets pour l’exécution s’appliquent tout le long de la

même portée.

Notes muettes et texte/lignes non exécutées
Pour qu’un objet quelconque ne soit pas exécuté (par exemples des nuances, des notes) désactivez

toutes les cases de Jouer lors de l’exécution du panneau Exécution de la fenêtre des propriétés –

b 4.6 Reprises. 

Une autre méthode pour éviter que certaines notes ne soient jouées consiste à utiliser des têtes de

note silencieuses (raccourci Shift+Alt+9 ou xz9) – b 2.25 Têtes de note.

Vous pouvez aussi spécifier que tous les textes dans un certain style de texte n’auront aucun effet

sur l’exécution en désactivant l’option Interprétation durant la lecture de la page Général de

Modifier les style de texte – b 3.9 Modifier les styles de texte.
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4.3 Table de mixage

La fenêtre de la table de mixage de Sibelius permet de modifier les sons utilisés pour l’exécution,

notamment leur volume et leur position spatiale (panoramique) ainsi que d’ajuster les réglages des

instruments virtuels et des effets utilisés dans la configuration d’exécution active.

Pour afficher ou masquer la table de mixage, choisissez Fenêtre > Table de mixage, ou

utilisez le raccourci Ctrl+Alt+M (Windows) ou M (Mac), ou cliquez sur le bouton de la barre

d’outils illustré à droite. Voici les différentes sections de la table de mixage:

Rangée des boutons pour masquer ou

afficher d’autres rangées de la table de mixage et

d’utilisation du CPU

Rangées des portées pour attribuer à chaque

portée de la partition le son ID initial et en régler le

volume ou solo/éteint, le panoramique et le canal

MIDI (si approprié)

Rangée de la piste du métronome pour

ajuster le clic du métronome durant l’exécution et

la saisie en mode Flexi-time

Rangées des groupes, pour régler par

groupes le volume ou les basculer sur solo ou éteint

Rangées des instruments virtuels, pour

régler chaque instrument virtuel dans sa propre

fenêtre, basculer sur solo ou éteint toutes les portées

qu’il gère et ajuster la quantité de signal envoyé à

chaque bus d’effets

Rangées des bus d’effets, pour régler

chaque effet dans sa propre fenêtre et en ajuster le

niveau de sortie et l’ordre

Rangée du volume maître, pour ajuster le

volume global de tous les instruments virtuels et

régler chaque effet maître dans sa propre fenêtre



4. Exécution et vidéo

306

La largeur de la table de mixage est fixe, mais sa hauteur peut se modifier en déplaçant le côté

inférieur (Windows) ou le coin inférieur (Mac). Chaque rangée peut être masquée ou affichée

individuellement avec les boutons de la rangée de bouton, et donc être plus petite qu’illustrée.

Rangée des boutons
La rangée de boutons au sommet de la table de mixage permet d’afficher ou de masquer chacun des

autres types de rangée:

Par défaut, seules les rangées des portées et de volume principal sont affichées quand on ouvre la

table de mixage. Les boutons des rangées d’instruments virtuels et des bus d’effets sont désactivés

si votre configuration d’exécution active n’utilise aucun de ces effets ou instruments virtuels.

Le témoin d’utilisation du CPU dans la rangée des boutons vous donne une indication sur

l’utilisation du processeur au niveau du système audio, concernant donc les instruments virtuels et

les effets de votre configuration d’exécution active (cela ne concerne donc pas l’utilisation du

processeur pour tout l’ordinateur). Si le témoin devient rouge durant l’exécution cela signifie que

l’ordinateur prend plus de temps pour restituer l’audio que pour le jouer, et donc que des parasites

ou du bégaiement sont susceptibles de se produire durant l’exécution.

Si cela se produit, vous pouvez toujours exporter un fichier audio de la partition, ce qui garantit

une exécution sans accrocs (b 9.10 Exporter des fichiers audio), sinon pour réduire ces

parasites durant l’exécution, cf. Comment tirer le meilleur parti des instruments
virtuels et des effets à la page 390.

Rangées des portées
Chaque portée d’une partition possède sa propre rangée de portée:

Portée

rangées

Rangées des instru-

ments virtuels

Rangée de volume 

maître

Groupe

rangées

Bus d’effets

rangées

utilisation du 

CPU métrique

Rangée de portée fermée

Cliquer sur la flèche pour

ouvrir ou fermer la rangée

Fermer la rangée de l’instru-

ment virtuel

Nom de la portée Curseur de volume et 

indication de niveau

Solo/éteint

Son ID initial ou

nom de programme

utilisé par la portée

Curseur du 

panoramique

Canal ou 

emplacement 

MIDI

Masquer/afficher la 

fenêtre de l’instru-

ment virtuel

Périphérique 

jouant la portée

Curseur du 

panoramique

Reverb & Chorus

Autres contrôles pour

Sibelius Player sounds
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Vous pouvez ouvrir ou fermer chaque rangée de portée en cliquant sur la flèche à gauche de la

rangée. Pour ouvrir ou fermer toutes les rangées de portée, maintenez Maj enfoncé et cliquez sur la

flèche; pour ouvrir ou fermer toutes les rangées de table de mixage de tout type, maintenez Ctrl
enfoncé ou X et cliquez sur la flèche à gauche de la rangée.

Voici à quoi servent les contrôleurs de chaque rangée:

* L’écran “Nom de la portée” affiche le nom de la portée qui figure dans Insertion > Instruments;

il n’est pas modifiable. Pour changer de nom d’instrument, b 3.8 Noms d’instrument.

* Pour ajuster le volume, déplacez le curseur vers la gauche (pour diminuer le volume) ou vers la

droite (pour augmenter le volume). Le curseur possède une position “aimantée” par défaut (100

sur 127), et vous pouvez aussi réinitialiser son volume par défaut en double-cliquant sur le

curseur. Durant l’exécution, le curseur s’allume pour indiquer quel est le niveau de la portée.

Cela permet de corriger la balance relative des portées sans devoir écrire des nuances trop fortes

pour les instruments qui jouent fort et des nuances trop faibles pour ceux de faible volume. Les

périphériques jouent souvent tous les instruments quasi au même volume par défaut, de sorte

que, par ex., le volume d’une section complète de violons 1 sonnera plus fort qu’un solo de flûte.

* Pour entendre juste une portée, cliquez sur le bouton solo ( ). Les boutons “éteint” de toutes les

portées sont alors indisponibles (il s’affichent comme ceci: ). Pour obtenir plusieurs portées

solo simultanées, il suffit de cliquer sur leur bouton solo. Quand vous appuyez de nouveau sur

les boutons “solo” pour les désactiver, les boutons “éteint” sont de nouveau disponibles.

Cf. Éteint et solo à la page 313.

* Pour éteindre une portée, cliquez sur le bouton “éteint”( ). Cliquer une fois pour que la portée

soit à moitié éteinte ( ) et deux fois pour l’éteindre complètement ( ). Un troisième clic la

rallume. Cf. Éteint et solo à la page 313.

* Pour ajuster la position panoramique de la portée – c’est-à-dire sa position dans un espace stéréo

entre la gauche et la droite – ouvrez d’abord la rangée en cliquant sur la flèche d’ouverture, puis

déplacez simplement le curseur vers la gauche ou vers la droite. Celui-ci a une position

“magnétique” centrée. Il est préférable de ne pas positionner les portées trop aux extrémités.

Attention: certains instruments virtuels (ex. Vienna Symphonic Library Vienna Instruments) ne

répondent pas à ce curseur du panoramique. Par conséquent, si vous utilisez ce genre

d’instrument virtuel, vous n’entendrez aucun effet en changeant le panoramique ici. A la place,

vous pouvez changer le panoramique de la sortie audio de cet instrument virtuel – cf. Rangées
des instruments virtuels à la page 311.

* Le menu périphérique permet de changer le périphérique utilisé pour exécuter le son initial

d’une portée donnée, mais il vaut mieux ne pas le faire ici; utilisez plutôt la page Sons préférés
dans Exécution > Périphériques de lecture pour indiquer à Sibelius que vous préférez un autre

périphérique, car ce choix sera sauvegardé dans votre configuration d’exécution et s’appliquera

d’office à toutes vos partitions – cf. Page des sons de préférence à la page 375.

Pour changer de périphérique utilisé pour exécuter une portée, choisissez-le dans la liste de tous

les périphériques de votre configuration d’exécution. En haut de liste figure une entrée

supplémentaire (auto) à choisir si l’on veut que Sibelius choisisse automatiquement ce

périphérique lors des prochaines exécutions.
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Après avoir explicitement choisi un périphérique pour une portée donnée, le nom du

périphérique ne figure plus entre parenthèses, et le menu de sons ID ou noms de programme ci-

dessous n’affichera que les sons fournis par le périphérique que vous avez choisi.

Vous pouvez modifier le périphérique de toutes les portées en maintenant Maj enfoncé quand

vous choisissez un périphérique dans le menu Périphériques. Vous devez normalement ne

choisir qu’(Auto) en faisant cela, ce qui réinitialise toutes les portées à leur emplacement

automatique.

* Le bouton à droite du menu périphérique ( ) n’est activé que si le périphérique utilisé pour

cette portée est un instrument virtuel dont la fenêtre s’affichera si on clique dessus et disparaîtra

si on reclique dessus. Cliquez de nouveau pour masquer la fenêtre.

* Le contrôleur de canal MIDI ou d’emplacement affiche un relevé du canal utilisé par cette portée,

mais vous ne serez normalement pas en mesure de le modifier. Normalement il n’est pas

nécessaire de changer cela, car Sibelius attribue intelligemment le canal ou emplacement de

chaque portée. Le contrôleur de canal MIDI ou d’emplacement permet uniquement de changer

le canal MIDI utilisé par la portée si le périphérique en cours utilise un jeu de sons manuels (cf.

Page jeux de sons manuels à la page 372.

* L’écran du son ID affiche le nom du programme ou son ID utilisé par la portée au début de la

partition. Si la portée contient après la première mesure des objets qui provoquent un

changement de son utilisé pour l’exécution – par ex. des changements d’instruments, des

instructions textuelles pour des techniques de jeu, etc... – cet écran ne se mettra pas à jour.

Maintenez le curseur de votre souris au-dessus de l’écran pour lire une inscription indiquant le

son ID et le programme que Sibelius utilise actuellement pour cette portée.

Par défaut, cet écran indique le nom de programme utilisé par la portée. Si vous préférez voir le

son ID à la place quand cela est possible (pour en savoir plus sur les sons ID,

b 4.18 SoundWorld™), changez l’option Affichage sur la page Exécution de Fichier >

Préférences (dans le menu Sibelius sur Mac) – cf. Préférences d’exécution à la page 380.

Notez que, par défaut, le nom de son est affiché entre parenthèses: cela indique que le choix de

son est automatiquement déterminé par Sibelius. Après avoir choisi un nom de programme ou

de son ID dans le menu, le nom de son s’affiche sans parenthèses.

Pour modifier le son initial d’une portée, cliquez sur la flèche pour ouvrir le menu de son:

% Si les noms de programme sont affichés, vous verrez un menu hiérarchique. Si aucun

périphérique spécifique n’est choisi pour la portée, le premier niveau du menu affiche les

noms des jeux de sons dans votre configuration actuelle, et le deuxième niveau affiche ensuite

les noms des groupes dans lesquels les noms de programme sont divisés (ex. Cordes, Bois,

etc.); le troisième niveau affiche les familles d’instrument (ex. Violon, Fûtes, etc.); enfin, le

quatrième niveau affiche les noms de programme eux-mêmes. Quand vous choisissez un

programme spécifique, Sibelius configurera également cette portée pour qu’elle s’exécute

toujours via le périphérique sur lequel le programme est disponible.

% Si les sons ID sont affichés, vous verrez un menu hiérarchique différent, en répertoriant tous

les sons ID dans le S3W et tout autre son ID fourni par les périphériques dans votre

configuration d’exécution actuelle. Si un périphérique spécifique a déjà été choisi pour la

portée, le menu inclut alors également les sons ID fourni par le jeu de sons utilisé par ce

périphérique.
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Comme pour le menu de périphérique, vous pouvez réinitialiser une portée pour choisir à

nouveau des sons automatiquement en choisissant (Auto) dans le menu. Vous pouvez

réinitialiser toutes les portées en attribution de son automatique en maintenant Maj enfoncé et

en choisissant (Auto) dans le menu.

Vous pouvez aussi modifier les sons utilisés pour différents instruments dans votre partition en

éditant la définition d’instrument elle-même dans Style maison > Modifier les instruments;

cette approche est recommandée si vous souhaitez régler le son, par ex. de plusieurs instruments

identiques dans votre partition à un endroit, ou si vous souhaitez exporter ce réglage pour

pouvoir l’importer vers une autre partition via un style maison (b 8.14 Modifier les
instruments).

* Le bouton à droite du menu de son ( ) vous permet de tester le choix de son actuel pour cette

portée.

* Si la portée est exécutée à l’aide du Sibelius Player intégré, jusqu’à six autres curseurs peuvent

apparaître, selon le son. Ces curseurs vous permettent de régler des aspects subtils du son,

comme l’intonation, le timbre, la distorsion (pour les guitares), la vitesse de trémolo (pour les

vibraphones et les claviers électroniques), etc. Pour réinitialiser l’un de ces curseurs

supplémentaires à sa valeur par défaut, double-cliquez simplement ici. Ces six curseurs

répondent aux contrôleurs MIDI 91, 93, 74, 71, 73 et 72 respectivement.

Durant l’exécution, seuls le volume (y compris “solo” et “éteint”), le panoramique et les autres

commandes de son du Sibelius Player (le cas échéant) peuvent être modifiés pour chaque portée;

les autres réglages ne sont accessibles qu’en dehors de l’exécution.

La rangée du métronome
La rangée du métronome se trouve toujours en dessous des rangées de portées:

La rangée du métronome est très semblable aux autres

rangées de portées, si ce n’est que, plutôt que de choisir un

son ID initial, vous pouvez cliquer sur Réglages pour

afficher la boîte de dialogue Réglages du métronome,

illustrée ici à droite.

* Subdiviser les temps est utile dans les indications de

mesure telles que 6/8, pour marquer chaque croche

légèrement

Curseur de volume et indication de niveau Solo/éteint

Boîte de dialogue
de réglages du

métronome

Curseur du 

panoramique

Canal

MIDI

Masquer/afficher la fenêtre 

de l’instrument virtuel

Périphérique 

jouant la portée
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* Accentuer les groupes de temps irréguliers accentue les temps dans la mesure en fonction

des groupes de temps définis pour des indications de mesure irrégulières telles que 7/8

(b 2.33 Indications de mesure).

* Vous pouvez aussi choisir les sons de percussion utilisés par le métronome sur le premier temps

de la mesure ou sur les temps suivants, selon votre choix dans la page Exécution de Fichier >

Préférences (dans le menu Sibelius sur Mac).

En plus du bouton solo ou éteint de la rangée du métronome lui-même, vous pouvez aussi éteindre

ou allumer la portée du métronome en cliquant sur le bouton Métronome pendant l’exécution
dans la fenêtre de l’exécution.

Rangées de groupes
Les rangées de groupes permettent d’ajuster le volume relatif et le panoramique de chaque famille

d’instruments utilisées dans la partition. C’est très pratique pour, par exemple, augmenter le

volume des cordes par rapport à celui des bois, etc... Voici ce qu’on peut contrôler :

* À gauche de la rangée se trouve l’écran d’affichage du nom du groupe. Sibelius détermine quelles

portées forment chaque groupe et il est impossible de modifier le nom des groupes.

* Pour régler le volume de toutes les portées d’un groupe, il suffit de déplacer le curseur vers la

gauche ou vers la droite (comme on le fait pour les Rangées des portées ci-dessus). Sibelius

conserve la balance relative de tous les instruments du groupe quand vous modifiez le volume.

* Pour mettre en solo toutes les portées d’un groupe, cliquez sur le bouton solo (comme on le fait

pour les Rangées des portées ci-dessus).

* Pour éteindre complètement ou de moitié toutes les portées d’un groupe, cliquez sur le bouton

“éteint” (comme on le fait pour les Rangées des portées ci-dessus).

Si les rangées de portées sont visibles pendant le réglage des bandes de groupes, vous pourrez

observer que les changements réalisés dans une rangée de groupe sont répercutés dans chaque

rangée de portée.

Curseur de volume et 

indication de niveau Solo/éteintNom du groupe
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Rangées des instruments virtuels
Chaque instrument virtuel de votre configuration de lecture possède sa propre rangée:

* À gauche se trouve un écran affichant le nom de l’instrument.

* Pour afficher la fenêtre d’un instrument virtuel dans le but de le régler, cliquez sur . Cliquez de

nouveau pour masquer la fenêtre. Si vous faites des changements dans la fenêtre de l’instrument

virtuel qui doivent être réutilisés lors d’une session ultérieure de Sibelius, pensez à sauvegardez

la configuration d’exécution dans Exécution > Périphériques d’exécution (cf. Modifier une
configuration d’exécution à la page 371).

* Vous pouvez ajuster le niveau de sortie de chaque instrument virtuel en déplaçant le curseur de

volume.

* Le Sibelius Player compte des effets de réverb et de chorus intégrés, et le niveau de retour de ces

effets peut être réglé via les curseurs Réverbération et Chorus figurant dans la rangée de

l’instrument virtuel du Sibelius Player.

* Pour que toutes les portées exécutées par un instrument virtuel soient en solo ou éteintes,

cliquez sur le bouton solo ou éteint de la rangée de l’instrument virtuel. Les boutons solo et

éteint dans les rangées des portées reflètent les changements réalisés dans la rangée de

l’instrument virtuel.

* Les quatre boutons permettent de déterminer la quantité de signal envoyée de l’instrument

virtuel à chacun des quatre bus d’effets. Tourner un bouton dans un sens ou dans l’autre

augmente ou diminue la quantité envoyée dans chaque bus. Le bouton intitulé FX1 agit sur le

bus 1 d’effets, FX2 sur le Bus 2, etc... Cela signifie qu’il est possible d’envoyer le signal de

différents instruments virtuels vers différents bus d’effets. Pour que le même effet soit appliqué à

tous les instruments virtuels, utilisez plutôt les effets maîtres (cf. Rangée de volume maître
ci-dessous).

* Certains instruments virtuels (ex. Vienna Symphonic Library Vienna Instruments) ne

répondent pas aux messages panoramiques MIDI, et pour les tourner vers la gauche ou la droite,

vous pouvez régler la rangée de curseur du panoramique à la place. Pour d’autres instruments

virtuels, ce n’est pas nécessaire.

Ouvrir la rangée de
l’instrument virtuel

Quantité de signaux envoyés à

chaque bus d’effets

Cliquer sur la flèche pour

ouvrir ou fermer la rangée

Fermer la rangée de l’instru-

ment virtuel

Nom de l’instrument virtuel
Curseur de volume et 

indication de niveau

Masquer/afficher la 

fenêtre de l’instru-

ment virtuel

Quantité de signal envoyé vers

chaque bus d’effets

Curseur du 

panoramique

Solo/éteint

Reverb and Chorus 

(Sibelius Player 

uniquement)
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Bandes des effets de bus
Sibelius propose quatre bus d’effets, chacun permettant de charger deux effets, que vous pouvez

spécifier à la page Effets de Exécution > Périphériques d’exécution – cf. La page Effets à la

page 376. Chaque bus se présente sous une rangée propre:

À l’état fermé, la bande affiche le nom du bus et un curseur pour ajuster le gain de sortie du bus

vers la table de mixage.

Si vous ouvrez la rangée en cliquant sur la flèche, vous verrez un curseur supplémentaire intitulé

TRIM. Celui-ci permet d’ajuster les niveaux d’entrée qui arrivent dans les bus d’effets. En principe il

n’est pas nécessaire d’y toucher car le contrôle du gain de la plupart des effets se fait directement

dans leur fenêtre; pour ceux pour lesquels ce n’est pas possible, ce curseur est présent ici.

À gauche de la rangée ouverte se trouvent les écrans affichant chacun des effets présents dans le

bus. Pour afficher la fenêtre d’un effet en vue de le régler, cliquez sur . Cliquez de nouveau pour

masquer la fenêtre. Si vous faites des changements dans la fenêtre de l’effet qui doivent être

réutilisés lors d’une session ultérieure avec Sibelius, pensez à sauvegardez la configuration

d’exécution dans Exécution > Périphériques d’exécution (cf. Modifier une configuration
d’exécution à la page 371).

Rangée de volume maître
Tout en bas de la fenêtre de la table de mixage se trouve la rangée du volume maître, qui permet

d’ajuster le volume de tous les instruments virtuels et des effets à l’aide d’un seul curseur, et

d’apporter des changements aux effets maîtres, qui s’appliquent à la sortie de tous les instruments

virtuels et effets utilisés:

Quand la rangée du volume maître est fermée, le seul contrôle présent est le curseur de volume.

Durant l’exécution, l’arrière-plan du curseur s’allume indiquant le niveau de sortie. Notez que ce

curseur n’affecte uniquement que les instruments virtuels, de sorte que si des portées de la

partition sont exécutées par une carte-son ou un périphérique MIDI externe, ce curseur n’aura

aucun effet sur leur volume.

Gain de sortie du bus

Noms des effets
Niveau d’entrée Trim

Masquer/Afficher la fenêtre de l’effet

Cliquer sur la flèche pour ouvrir ou fermer la rangée 

Fermer la rangée de l’instrument virtuel

Curseur de volume et indication de niveau

Noms des effets

Masquer/Afficher la fenêtre de l’effet

Cliquer sur la flèche pour

ouvrir ou fermer la rangée

Fermer la rangée de

l’instrument virtuel
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Si vous ouvrez la rangée en cliquant sur la flèche, vous pouvez afficher la fenêtre de chacun des

quatre effets maîtres en cliquant sur . Pour en savoir plus sur les effets maîtres, cf. La page
Effets à la page 376.

Éteint et solo
Pour pouvoir faire des essais d’instruments individuels ou de groupes d’instruments, chaque

portée peut être exécutée à plein volume, à demi volume ou être éteinte. Il suffit de cliquer sur le

bouton “éteint” ( ) de la portée concernée pour passer d’un réglage à l’autre.

Une utilisation pratique de cette fonction est la production d’enregistrements “music minus one”:

mettre en avant un instrument pourra aider un musicien à apprendre sa partie de mémoire.

Rendre un instrument solo silencieux permettra soit de le jouer réellement avec Sibelius exécutant

l’accompagnement ou de n’entendre qu’une partie de cornemuse ou d’accordéon.

Une portée spécifique peut aussi être aussi réglée sur solo (ce qui éteint les autres portées) en

cliquant le bouton solo ( ). D’autres portées peuvent être ajoutées en cliquant sur leur bouton

solo respectif.

Pour entendre certains instruments d’une partition, il suffit de les inclure dans une sélection de

passage avant de lancer l’exécution (b 1.9 À propos des sélections et des passages). En

agissant de la sorte, si le réglage des portées exécutées est “éteint”, celui-ci sera ignoré – donc dans

le cas d’un quatuor à cordes par exemple, si le violon est sur éteint, le sélectionner avec le

violoncelle permettra de les entendre tous les deux. Sibelius part du principe que si vous

sélectionnez une portée pour l’exécuter, vous voulez l’entendre même si elle est réglée sur “éteint”.

Contrôler la table de mixage avec un périphérique d’entrée
Si vous avez un périphérique d’entrée MIDI externe, comme une surface de contrôle dédiée ou un

clavier de contrôleur avec curseurs, boutons ou autres contrôles supplémentaires, vous pouvez

utiliser votre périphérique pour contrôler directement la Table de mixage. Pour en savoir plus, cf.

Tables d’entrée à la page 66.

SoundStage
Même si l’on ne possède que deux oreilles (en principe), le cerveau est capable d’extrapoler une

image sonore tridimensionnelle de ces deux sources. Le fait qu’un périphérique d’exécution ne

puisse jouer qu’en stéréo est un facteur très limitant pour recréer la manière dont sonnent des

instruments placés en face de l’auditeur. L’impression tridimensionnelle créée par un son stéréo

bien préparé est appelé un “soundstage” – et c’est exactement ce que fait automatiquement la

fonction SoundStage de Sibelius.

Imaginons que vous souhaitiez recréer l’effet acoustique d’une salle de concert, avec un orchestre

sur scène. Plusieurs facteurs entrent en jeu:

* Chaque instrument est placé à une distance légèrement différente de l’auditeur et différents

pupitres sont formés d’un nombre variable de musiciens. Cela affecte le volume relatif des

instruments.

* Chaque instrument a par rapport à l’auditeur une position qui diffère légèrement vers la gauche

ou vers la droite.
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* Les caractéristiques acoustiques du bâtiment entraîne une réverbération dans laquelle intervient

non seulement la dimension mais aussi la forme de la salle.

* Les instruments les plus proches de l’auditeur sont moins réverbérés que les autres. Leur son

arrive directement aux oreilles avant d’être réfléchi par les murs. (À comparer avec la voix dans

un téléphone normal et celle diffusée par un haut-parleur.)

* Un instrument très éloigné, comme une trompette en dehors de la scène, sera très réverbérée car

aucun son direct ne parvient aux oreilles de l’auditeur; par contre le son est doux, avec peu de

volume.

SoundStage est toujours activé d’office, sans possibilité de le désactiver. Quand on crée des

instruments, Sibelius non seulement les place automatiquement dans un espace en 3D comme sur

une scène de concert – et pas seulement en stéréo (donc avec les positions panoramiques

adéquates), mais suggère la distance à laquelle ils se trouvent grâce à de subtils réglages de volume.

Les réglages de SoundStage correspondent aux dispositions habituelles des orchestres, brass

bands, ensembles de chœurs et de cordes – mais fonctionnent aussi pour toute autre combinaison.

Améliorer l’exécution quand il ya beaucoup d’instruments
L’exécution avec un grand nombre d’instruments peut parfois ressembler ce que produirait un

orgue. C’est évidemment dommage qu’il y ait une telle différence avec ce que donnerait un

enregistrement original.

Quatre causes principales peuvent expliquer ce problème, qu’il peut être facile de supprimer:

* Une balance incorrecte. Par exemple, si vous réglez tous les volumes d’une partition d’orchestre

au maximum, certains instruments seront trop forts et d’autres seront couverts.

* Manque d’expression. Réglez l’option Espressivo dans la boîte de dialogue Exécution >

Interprétation sur Espressivo ou Molto espressivo. Cela introduira des gradations de volume

qui aideront à séparer les différentes lignes musicales même dans une grande partition. En

général, plus il y a d’instruments et plus il faut ajouter d’effet Espressivo

(b 4.5 Interprétation).

* “Décalage” – Cela ressemble au son d’une radio mal réglée et cela survient quand deux

instruments identiques jouent à l’unisson. Si deux portées d’une partition sont souvent doublées,

comme les violons 1 et 2, utilisez les coches de Jouer lors de l’exécution dans les propriétés

(b 5.17 Propriétés) pour réduire au silence une des portées doublées. Cela devrait

considérablement améliorer les choses.

* Pas assez de positions panoramiques différentes. L’oreille ne parvient pas à séparer les différents

timbres instrumentaux. Il suffit de changer les positions panoramiques de manière adéquate.
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4.4 Sibelius Sounds Essentials

b 4.1 Utiliser du texte, 4.3 Table de mixage, 4.5 Interprétation, 9.10 Exporter des
fichiers audio.

Sibelius est fourni avec Sibelius Sounds Essentials, une bibliothèque de sons de

haute qualité consistant en un jeu complet de sons choisis avec soin dans la

bibliothèque primée Garritan Personal Orchestra, et dans celles de Garritan

Concert & Marching Band, Garritan Jazz and Big Band, et Virtual Drumline de

chez Tapspace. Le résultat est une collection variée de sons convenant à tous les

genres de musique.

Vous pouvez ajouter des bibliothèques de sons supplémentaires utilisables dans

Sibelius, notamment toutes les versions complètes des bibliothèques de sons qui

ont servi à créer Sibelius Sounds Essentials. Choisissez Aide > Sibelius Sounds pour parvenir sur

notre site web et obtenir plus d’informations.

Sibelius Sounds Essentials s’exécute à travers le lecteur intégré de Sibelius, un instrument virtuel

lecteur d’échantillons, basé sur la technologie de l’échantillonneur Structure de Pro Tools,

développé par le groupe phare Advanced Instrument Research de Digidesign.

Configuration requise
Soyez attentif au fait que les bibliothèques de sons occupent une grande quantité de l’espace du

disque dur, donc assurez-vous d’en avoir assez; quant au chargement de plusieurs sons ensemble,

cela nécessite beaucoup de RAM. Cf. Comment tirer le meilleur parti des instruments
virtuels et des effets à la page 390 pour obtenir des conseils sur le lecteur de Sibelius et les

autres instruments virtuels.

Réglages de Sibelius Sounds Essentials
Sibelius est réglé pour jouer via Sibelius Sounds Essentials par défaut mais si vous activez un autre

jeu de dispositifs d’exécution vous devrez peut être réactiver Sibelius Sounds Essentials, de la

manière suivante :

* Choisissez Exécution > Périphériques d’exécution

* Dans le menu Configuration en haut de la boîte de dialogue, choisissez Sibelius Sounds.

* Vous devriez ensuite voir Sibelius Player dans la liste Périphériques actifs à droite de la page

Périphériques actifs de la boîte de dialogue. Jeux de sons sera réglé sur Essentials.

* Cliquez Fermer.

Dès que vous ouvrez une partition, Sibelius charge automatiquement les sons nécessaires en

arrière-plan. Selon le nombre d’instruments dans votre partition, cela peut prendre quelques

secondes ou une demi-minute, pendant lequel vous pouvez saisir et éditer votre partition

normalement. Si vous essayez de lancer l’exécution avant que tous les sons ne soient chargés, vous

verrez une barre de progression pendant que les derniers sons sont chargés... puis l’exécution

commence.
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Comment fonctionne Sibelius Player
Sibelius Player peut reproduire jusqu’à 128 sons différentes à la fois, bien que le nombre maximum

dépende des ressources disponibles sur votre ordinateur. Par exemple, si votre ordinateur dispose

de moins d’1 Go de RAM, Sibelius limite le nombre de canaux disponibles à 32 ; si votre ordinateur

dispose de 2 Go de RAM, Sibelius vous autorise à utiliser 64 canaux ; si vous avez plus de 2 Go,

Sibelius autorise les 128 canaux. Vous pouvez régler cette limite si vous souhaitez sur la page

Exécution de Fichier > Préférences (sur la page Sibelius sur Mac). Notez que si vous augmentez

le nombre maximum, il est possible que l’ordinateur ne soit pas capable de gérer tous les sons,

provoquant une exécution sautante et ralentissant considérablement les performances de Sibelius

et de votre ordinateur.

Normalement, le nombre de canaux disponibles dépasse le nombre de sons requis dans la grande

majorité des partitions mais il est important de comprendre comment Sibelius répartit les sons par

canaux.

Une portée de la partition peut potentiellement utiliser plus d’un son en raison des changements

d’instrument (par ex. si une portée commence avec une clarinette mais change par la suite pour

continuer avec un saxophone) ou des changements de technique de jeux (par ex. si un violon

commence arco, puis joue plus tard pizzicato), ce qui peut augmenter le nombre total de sons

utilisés dans la partition au-delà de des canaux disponibles, en fonction du fait que Sibelius peut

jouer ou non les sons en utilisant le même canal.

Les sons peuvent partager le même emplacement s’ils peuvent être mis en route par un

interrupteur, ce qui signifie que Sibelius peut soit jouer une note spécifique qui déclenche un

changement de son(il s’agit d’une touche-contrôle (en anglais keyswitch) ou régler un contrôleur

MIDI sur une valeur spécifique, ou jouer une note à une certaine vitesse, etc. Plusieurs des sons de

Sounds Essentials fonctionnent de cette manière : par exemple, les violons de Garritan Personal

Orchestra peuvent passer de arco à pizzicato et trémolo non mesuré par le biais de touches-

contrôle, et la trompette de Garritan Jazz et Big Band peut passer du jeu normal avec celui à la

sourdine de la même manière.

Si vous devez changer complètement de son – par exemple de la clarinette au saxophone – cela

nécessite normalement un canal supplémentaire.

Cela signifie en pratique que, si votre partition utilise plus de sons au total que le nombre de canaux

disponibles, Sibelius décidera automatiquement des compromis concernant la meilleure façon de

la jouer. Pour les portées qui sont de la même famille instrumentale (par ex. bois, cuivres et

cordes), il doublera les portées dans le même emplacement de façon à ce qu’elles utilisent le même

son - vous vous retrouverez donc peut-être avec des clarinettes, des hautbois et des bassons jouant

tous avec (par ex.) un son de basson.

Sons inclus
Voici les sons inclus dans Sibelius Sounds Essentials:

Nom Techniques/instruments Tessiture

De Garritan Personal Orchestra

Piccolo Lite Params : Intonation, Timbre D5 to C8

Flute Solo Lite Params : Intonation, Timbre B3 to A7
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Flute Solo 2 Lite Params : Intonation, Timbre G3 to A7

Oboe Solo Params : Intonation, Timbre Bb3 to A6

Oboe Solo 2 Params : Intonation, Timbre Bb3 to A6

English Horn Solo Params : Intonation, Timbre E3 to C6

Bb Clarinet Solo Params : Intonation, Timbre G2 to C7

Bb Clarinet Solo 2 Params : Intonation, Timbre G2 to C7

Bass Clarinet Solo Params : Intonation, Timbre Bb1 to F5

Bassoon Solo Params : Intonation, Timbre B0 to E5

Bassoon Solo 2 Params : Intonation, Timbre Bb1 to E5

Contrabassoon Solo Params : Intonation, Timbre A0 to F3

French Horn Params : Intonation, Timbre

Keyswitches : open (C0) ; mute (D0)

E1 to F5

French Horn 2 Params : Intonation, Timbre E1 to F5

Trumpet Solo Params : Intonation, Timbre

Keyswitches : open (C0) ; mute (D0)

C3 to F6

Trumpet Solo 2 Params : Intonation, Timbre E3 to F6

Tenor Trombone Solo Params : Intonation, Timbre

Keyswitches : open (C0) ; mute (D0)

E1 to F5

Tuba Solo Params : Intonation, Timbre Bb0 to B4

Concert Piano Lite A0 to C8

Hauptwek All Stops C2 to G6

Harp Lite C1 to G7

Basic Orchestral Percussion Sons : Bass drum hit (B1) ; Bass drum hit 2 (C2), Bass drum roll (C#2) ;

Timpani hit (D2–G3) ; Side drum hit, snares off, left (G#3) ; Side drum

hit, snares off, right (A3) ; Side drum hit, snares off, roll (A#3) ; Side

drum hit, snares on, left (B3) ; Side drum hit, snares on, right (C4) ;

Side drum hit, snares on, roll (C#4)

Violin Solo Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

G3 to C8

Violin Solo 2 Lite Params : Intonation, Timbre G3 to C8

Violin Ensemble Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

G3 to A8

Viola Solo Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C3 to C7

Viola Solo 2 Lite Params : Intonation, Timbre C3 to C7

Viola Ensemble Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C3 to A6

Cello Solo Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C2 to E6

Cello Solo 2 Lite Params : Intonation, Timbre C2 to E6

Cello Ensemble Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C2 to E6

Double Bass Solo Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C0 to C5

Double Bass Solo 2 Lite Params : Intonation, Timbre C0 to C5

Nom Techniques/instruments Tessiture
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Double Bass Ensemble Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C0 to G4

Full String Ensemble Lite Params : Intonation, Timbre

Keyswitches : arco (C–1) ; pizzicato (F–1), tremolo (G–1)

C1 to D7

De Garritan Jazz and Big Band

Alto Saxophone Params : Intonation, Timbre C#3 to F6

Tenor Saxophone Params : Intonation, Timbre G#2 to C6

Baritone Saxophone Params : Intonation, Timbre C2 to C6

Jazz Trumpet Params : Intonation, Timbre

Keyswitches : open (C1) ; straight mute (D1) ; harmon mute (F1)

E3 to Bb6

Jazz Trombone Params : Intonation, Timbre

Keyswitches : open (C0) ; straight mute (D0) ; harmon mute (F0)

Bb0 to C6

Brush Drum Kit Lite Sons : High Q (D#1), Slap (E1), Scratch Push (F1), Scratch Pull (F#1),

Sticks (G1), Square Click (G#1), Metronome Click (A1), Metronome

Bell (A#1), Loose Kick (B1), Tight Kick (C2), Side Stick (C#2), Long

snare swirl (D2), Claps (D#2), Rim Shot with brushes (E2), Short snare

swirl (E2), Snares on with brushes (E2), Low Floor Tom (F2), Hi-Hat

Closed (F#2), High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack

Tom (A2), Hi-Hat Open (A#2), Mid Rack Tom (B2), High Mid-Rack

Tom (C3), Medium Crash (C#3), Hi Tom (D3), Medium Ride (D#3),

Sizzle Cymbal (E3), Ride bell with brush (F3), Ride bell with handle

(F#3), Ride bell (G3), Cowbell (G#3), High Crash (A3), Vibraslap

(A#3), High Ride (B3), High Bongo (C4), Low Bongo (C#4), Muffled

Slap (D4), Conga (D#4), Tumba (E4), High Timbale (F4), Low Timbale

(F#4), High Agogo (G4), Low Agogo (G#4), Cabasa (A4), Maracas

(A#4), Low Whistle (B4), High Whistle (C5), Short Guiro (C#5), Low

Guiro (D5), Claves (D#5), High Woodblock (E5), Low Woodblock (F5),

High Cuica (F#5), Low Cuica (G5), Mute Triangle (G#5), Open Trian-

gle (A5), Shaker (A#5), Jingle Bell (B5), Bell Tree (C6), Castanets

(C#6), Mute Surdo (D6), Open Surdo (D#6), Ride bell (E6)

Latin Percussion Lite Sons : Bata Low Open (C2), Bata Low Muff (C#2), Bata Low Slap (D2),

Bata Mid Open (Eb2), Bata Mid Muff (E2), Bata Mid Slap (F2), Bata

High Open (F#2), Bata High Muff (G2), Bata High Slap (Ab2), Bongo

Low Open (A2), Bongo Low Muff (Bb2), Bongo Low Slap (B2), Bongo

High Open (C3), Bongo High Muff (C#3), Bongo High Slap (D3),

Cajone Low (Eb3), Cajone Slap (E3), Cajone Stick Hit (F3), Conga Low

(F#3), Conga Open (G3), Conga Muff (Ab3), Conga Slap (A3), Djembe

Open (Bb3), Djembe Muff (B3), Djembe Slap (C4), Quinto Open (C#4),

Quinto Muff (D4), Quinto Slap (Eb4), Super Tumba Low (E4), Super

Tumba Open (F4), Super Tumba Muff (F#4), Super Tumba Slap (G4),

Surdo Open (Ab4), Surdu Muff (A4), Timbales Low (Bb4), Timbales

High (B4), Timbales Edge (C5), Tumba Low (C#5), Tumba Muff (D5),

Tumba Open (Eb5), Tumba Slap (E5), Udu Long (F5), Udu Short (F#5),

Cabasa Short (G5), Cabasa Long (Ab5), Cabasa Snap (A5), Maracas 1

Short (Bb5), Maracas 1 Long (B5), Maracas 2 Short (C6), Maracas 2

Long (C#6), Shaker Short 1 (D6), Shaker Short 2 (Eb6), Egg (E6), Egg 1

(F6), Egg 2 (F#6), Egg Shake (G6), Shekere Low (Ab6), Shekere High

(A6), Shekere Short 1 (Bb6), Shekere Short 2 (B6)

De Garritan Concert & Marching Band

Trumpet Ensemble Lite Params : Intonation, Timbre E3 to Bb6

Mellophone Ensemble Lite Params : Intonation, Timbre Bb1 to F5

Euphonium Ensemble Lite Params : Intonation, Timbre E1 to F5

Nom Techniques/instruments Tessiture
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Baritone Ensemble Lite Params : Intonation, Timbre E2 to F5

Sousaphone Ensemble Lite Params : Intonation, Timbre Bb0 to F4

Tuba Ensemble Lite Params : Intonation, Timbre Bb1 to F4

Trombone Ensemble Lite Params : Intonation, Timbre E1 to F5

De Sibelius Sounds Choral (sons de Garritan)

Sopranos 1 Ahs Lite Params : Intonation, Timbre G3 to C6

Altos 1 Ahs Lite Params : Intonation, Timbre E3 to G5

Tenors 1 Ahs Lite Params : Intonation, Timbre G2 to C5

Basses 1 Ahs Lite Params : Intonation, Timbre C2 to G4

De Garritan World Music

Ewe Drum Ensemble Les sons sont uniquement sur les notes blanches C2 to B4

Djembe Ensemble Les sons sont uniquement sur les notes blanches C3 to C4

Taiko Drums

De Virtual Drumline de Tapspace

Marching Snares (Manual) All with snares on : sustained roll (E6) ; RH hits (G#5) ; LH hits (F#5) ;

RH shots (G5) ; LH shots (F5) ; RH rims (Eb5) ; LH rims (Db5) ; ride

cymbal (E3) ; bell of ride cymbal (D3) ; cymbal crash (C3)

Marching Snares (Auto RL) All with snares on, automatic RL switching : sustained roll (B5) ; rim

shots (C5) ; main hits (B4) ; rims (A4) ; ride cymbal (E3) ; bell of ride

cymbal (D3) ; cymbal crash (C3)

Marching Tenor Drums (Manual) Sons : Spock 1 RH Hits (E5); Spock 1 LH Hits (Eb5); Spock 2 RH Hits

(D5); Spock 2 LH Hits (Db5); Drum 1 RH Hits (C5); Drum 1 LH Hits

(B4); Drum 2 RH Hits (Bb4); Drum 2 LH Hits (A4); Drum 3 RH Hits

(Ab4); Drum 3 LH Hits (G4); Drum 4 RH Hits (F#4); Drum 4 LH Hits

(F4); Sustained buzz roll spock 1 (Bb3); Sustained buzz roll spock 2

(A3); Sustained buzz roll drum 1 (Ab3); Sustained buzz roll drum 2

(G3); Sustained buzz roll drum 3 (F#3); Sustained buzz roll drum 4

(F3); Spock 1 RH shot/rim (E3); Spock 1 LH shot/rim (Eb3); Spock 2

RH shot/rim (D3); Spock 2 LH shot/rim (Db3); Drum 1 RH shot/rim

(C3); Drum 1 LH shot/rim (B2); Drum 2 LH shot/rim (Bb2); Drum 2

RH shot/rim (A2); Drum 3 RH shot/rim (Ab2); Drum 3 LH shot/rim

(G2); Drum 4 RH shot/rim (F#2); Drum 4 LH shot/rim (F2)

Marching Tenor Drums (Auto RL) Automatic RL switching : Spock 2 shots/rims (Db6); Spock 2 hits (B5);

Spock 1 shots/rims (Ab5); Spock 1 hits (G5); Drum 1 shots/rims (Gb5);

Drum 1 hits (E5); Drum 2 shots/rims (Db5); Drum 2 hits (C5); Drum 3

shots/rims (Bb4); Drum 3 hits (A4); Drum 4 shots/rims (F#4); Drum 4

hits (F4); Roll Spock 2 sustained buzz (A3); Roll Spock 1 sustained

buzz (F3); Roll Drum 1 sustained buzz (D3); Roll Drum 2 sustained

buzz (B2); Roll Drum 3 sustained buzz (G2); Roll Drum 4 sustained

buzz (E2)

Marching Bass Drums (Manual) Sons : Drum 1 RH hits (E5); Drum 1 LH hits (Eb5); Drum 2 RH hits

(D5); Drum 2 LH hits (C#5); Drum 3 RH hits (C5); Drum 3 LH hits

(B4); Drum 4 RH hits (Bb4); Drum 4 LH hits (A4); Drum 5 RH hits

(Ab4); Drum 5 LH hits (A4); Drum 5 RH hits (Ab4); Drum 5 LH hits

(G4); Drum 6 RH hits (F#4); Drum 6 LH hits (F4); Unison RH hits

(E4); Unison LH hits (Eb4); Unison RH rims (D4); Unison LH rims

(C#4); Unison sustained roll (Ab3)

Marching Bass Drums (Auto RL) Automatic RL switching : Unison sustained roll (B6); Drum 1 hits (G5);

Drum 2 hits (E5); Unison rims (D5); Drum 3 hits (C5); Unison hits

(B4); Drum 4 hits (A4); Drum 5 hits (F4); Drum 6 hits (D4)
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Marching Cymbals Unison cymbal section : hi hat choke (Bb5); sizzle/suck A (C#5); sizzle

(D5); vacuum suck (C5); crash choke fat (B4); flat crash (Bb4)

Unpitched Concert Percussion Sons : Brake drum RL (C7); wind chimes (B6); Finger cymbal (A6);

Triangle roll (G6); Triangle hit sustain/muted (F6); Bell plate (E6); Sus-

pended cymbal cresc. mp (D6); Suspended cymbal cresc. f (C6); Sus-

pended cymbal crash (B5); Suspended cymbal crash choke (A5);

Suspended cymbal w/stick tip (ride) (G5); Hand cymbals choke (F5);

Hand cymbals crash (E5); Concert snare drum roll (D5); Concert snare

drum hits RL (C5); Tambourine fist hits (B4); Tambourine roll shaken

(A4); Tambourine thumb roll (G4); Tambourine finger hits RL (F4);

Temple block high RL (E4); Temple block med-high RL (D4); Temple

block med RL (C4); Temple block med-low RL (B3); Temple block low

RL (A3); Concert tom high RL (G3); Concert tom med-high RL (F3);

Concert tom med-low RL (E3); Concert tom low RL (D3); Impact

drum hits RL (C3); Tam-tam hit p (B2); Tam-tam hit f (A2); Concert

bass drum roll (G2); Concert bass drum hit RL (F2)

Woodblock Sons : High Woodblock (E5), Low Woodblock (F5)

General MIDI Drum Set Sons : Bass Drum 2 (B1), Bass Drum 1 (C2), Side Stick (C#2), Snare

Drum 1 (D2), Hand Clap (Eb2), Rim Shot (E2), Low Tom 2 (F2), Closed

Hi-hat (F#2), Low Tom 1 (G2), Pedal Hi-hat (Ab2), Mid Tom 2 (A2),

Open Hi-hat (Bb2), Mid Tom 1 (B2), High Tom 2 (C3), Crash Cymbal 1

(C#3), High Tom 1 (D3), Ride Cymbal 1 (Eb3), Chinese Cymbal (E3),

Ride Bell (F3), Tambourine (F#3), Splash Cymbal (G3), Cowbell (Ab3),

Crash Cymbal 2 (A3), Vibra Slap (Bb3), Ride Cymbal 2 (B3), High

Bongo (C4), Low Bongo (C#4), Mute High Conga (D4), Open High

Conga (Eb4), Low Conga (E4), High Timbale (F4), Low Timbale (F#4),

High Agogo (G4), Low Agogo (Ab4), Cabasa (A4), Maracas (Bb4),

Short Whistle (B4), Long Whistle (C5), Short Guiro (C#5), Long Guiro

(D5), Claves (Eb5), High Wood Block (E5), Low Wood Block (F5),

Mute Triangle (F#5), Open Triangle (G5)

Marimba C2 to C7

Vibraphone Params : Fan Level, Fan Speed

Sustain; Damped

F3 to F6

Xylophone F4 to C8

Glockenspiel F5 to C8

Crotales (one octave) C6 to C7

Chimes C4 to G5

Timpani Params : Bass EQ, Mid EQ, High EQ C2 to C4

D’autres fournisseurs

Handbells (Garritan) C4 to C7

Recorder (Garritan) Params : Intonation, Timbre C0 to G9

Electric Stage Piano Params : Delay Mix, Key Off Level, Tremolo Depth, Tremolo Rate,

Chorus Mix

C–1 to G9

Soft B Organ Params : Lo Level, Hi Level, Rotary Mix, Rotary Speed, Percuss Level,

Percuss Length

C–1 to G9

Electric Clavichord Params : Amp Mix, Echo Mix, Cutoff, Release C–1 to G9

Nylon Guitar Params : Fret Noise, Release, Cutoff, High EQ C–1 to B5

Clean Electric Guitar Params : High EQ, Mid EQ, Low EQ, Compress C2 to F#6

Delay Electric Guitar Params : High EQ, Compress, Mid EQ, Delay Rate, Low EQ, Delay

Feedback 

C2 to F#6
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Distorted Electric Guitar Params : High EQ, Compress, Mid EQ, Distortion Headroom, Low EQ,

Distortion Drive

C2 to F#6

Overdriven Electric Guitar Params : High EQ, Compress, Mid EQ, Overdrive Headroom, Low EQ,

Overdrive

C2 to F#6

Flange Electric Guitar Params : High EQ, Compress, Mid EQ, Flange Rate, Low EQ, Flange

Mix

C2 to F#6

Tremolo Electric Guitar Params : High EQ, COmpress, Mid EQ, Tremolo Rate, Low EQ, Trem-

olo Depth

C2 to F#6

Bass Guitar Params : High EQ, Low EQ, Cutoff, Velocity Sens., Compress, Release C0 to B4

Slap Bass C–1 to B4

Contrebasse Params : High EQ, Mid EQ, Low EQ, Compress C1 to C5

Sitar C2 to C6

Atmosphere pad Params : Attack, Release, Cutoff, Velo C–1 to G9

New Age pad Params : Attack, Release, Cutoff, Resonance C–1 to G9

Lead Charang Params : Dirt Mix, Delay Mix, Cutoff, Resonance, Attack, Glide Time C–1 to G9

Synth Bass Params : Bass, Treble, Cutoff, Resonance, Attack, Release C–1 to G9

Synth Bass 2 Params : Bass, Treble, Cutoff, Resonance, Attack, Release C–1 to G9

Bass and Lead Params : High Gain, High Freq, Cutoff, Resonance, Filter Env., Sample

Start

C–1 to G9

Brass Section Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Synth Brass Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Synth Brass 2 Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Polysynth Pad Params : Attack, Release, Cutoff, Resonance C–1 to G9

Synth Voice Params : Ooh-Aah Crossfade, Air, Cutoff, Sample Start, Attack, Release C–1 to G9

Bright Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Echoes Params : Attack, Release, Cutoff, Filter Envelope, Delay C–1 to G9

Oohs Params : Attack, Release, Cutoff, Filter Envelope, Delay C–1 to G9

Metallic Shimmer Params : Attack, Release, Cutoff, Decay, Delay C–1 to G9

Sci-fi Params : Attack, Release, Cutoff, Resonance C–1 to G9

Warm Pad Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Bowed Pad Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Sweep Pad Params : Phaser Mix, Delay Mix, Cutoff, Resonance, Attack, Release C–1 to G9

Rain Synth Params : Attack, Release, Cutoff, Resonance, Delay C–1 to G9

Soundtrack Synth Params : Phaser, Delay, Cutoff, Filter Envelope, Attack, Release C–1 to G9

Sawtooth Params : Glide Time, Delay Mix, Cutoff, Resonance, Attack C–1 to G9

Square Params : Glide Time, Delay Mix, Cutoff, Resonance, Attack C–1 to G9

909 Drive Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Rimshot 2 (G1), Claps 2 (G#1), Tight Kick 2 (A1), Metronome

Bell (A#1), Loose Kick (B1), Tight Kick (C2), Side Stick (C#2), Rimshot

(D2), Claps (D#2), Snare Drum (E2), Low Floor Tom (F2), Hi-Hat

Closed (F#2), High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack

Tom (A2), Hi-Hat Open (A#2), Mid-Rack Tom (B2), High Mid-Rack

Tom (C3), Low Crash (C#3), High Rack Tom (D3), Low Ride (D#3),

High Crash (A3), High Ride (B3), Ride Bell (B3)

Nom Techniques/instruments Tessiture
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909 Clean Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Rimshot 2 (G1), Claps 2 (G#1), Tight Kick 2 (A1), Metronome

Bell (A#1), Loose Kick (B1), Tight Kick (C2), Side Stick (C#2), Rimshot

(D2), Claps (D#2), Snare Drum (E2), Low Floor Tom (F2), Hi-Hat

Closed (F#2), High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack

Tom (A2), Hi-Hat Open (A#2), Mid-Rack Tom (B2), High Mid-Rack

Tom (C3), Low Crash (C#3), High Rack Tom (D3), Low Ride (D#3),

High Crash (A3), High Ride (B3), Ride Bell (B3)

808 Clean Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Claps 2 (G#1), Tight Kick 2 (A1), Metronome Bell (A#1), Loose

Kick (B1), Tight Kick (C2), Side Stick (C#2), Rimshot (D2), Claps

(D#2), Snare Drum (E2), Low Floor Tom (F2), Hi-Hat Closed (F#2),

High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack Tom (A2), Hi-

Hat Open (A#2), Mid-Rack Tom (B2), High Mid-Rack Tom (C3), Low

Crash (C#3), High Rack Tom (D3), Low Ride (D#3), High Ride (E3),

Cowbell (G#3), Muffled Slap (D4), Conga (D#4), Tumba (E4), High

Timbale (F4), Low Timbale (F#4), Zap (G4), Zappy (G#4), Hat 1 (A#4),

High Woodblock (D#5)

808 Drive Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Claps 2 (G#1), Tight Kick 2 (A1), Metronome Bell (A#1), Loose

Kick (B1), Tight Kick (C2), Side Stick (C#2), Rimshot (D2), Claps

(D#2), Snare Drum (E2), Low Floor Tom (F2), Hi-Hat Closed (F#2),

High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack Tom (A2), Hi-

Hat Open (A#2), Mid-Rack Tom (B2), High Mid-Rack Tom (C3), Low

Crash (C#3), High Rack Tom (D3), Low Ride (D#3), High Ride (E3),

Cowbell (G#3), Muffled Slap (D4), Conga (D#4), Tumba (E4), High

Timbale (F4), Low Timbale (F#4), Zap (G4), Zappy (G#4), Hat 1 (A#4),

High Woodblock (D#5)

Club Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Claps 2 (G#1), Tight Kick 2 (A1), Metronome Bell (A#1), Loose

Kick (B1), Tight Kick (C2), Side Stick (C#2), Rimshot (D2), Claps

(D#2), Snare Drum (E2), Low Floor Tom (F2), Hi-Hat Closed (F#2),

High Floor Tom (G2), Hi-Hat Pedal (G#2), Low Rack Tom (A2), Hi-

Hat Open (A#2), Mid Rack Tom (B2), High Rack Tom (C3), Low Crash

(C#3), Low Tom (D3), Low Ride (D#3), Hi-Hat Open (E3), Cow-

bell (F#3), Muffled Slap (A3)

Fusion Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Tight Kick 2 (A1), Metronome Bell (A#1), Loose Kick (B1), Tight

Kick (C2), Side Stick (C#2), Rimshot (D2), Claps (D#2), Snare Drum

(E2), Low Floor Tom (F2), Hi-Hat Closed Pedal (F#2), High Floor Tom

(G2), Hi-Hat Pedal (G#2), Low Rack Tom (A2), Hi-Hat Open (A#2),

Mid-Rack Tom (B2), High Mid-Rack Tom (C3), Low Crash (C#3),

High Rack Tom (D3), Low Ride (D#3), Splash Cymbal (A3), Hi-hat

Open (B3)

Goa Kit Params : Delay Time, Delay Mix, Distortion Drive, Distortion Mix

Sons : Tight Kick 1 (A1), Metronome Bell (A#1), Loose Kick (B1), Tight

Kick (C2), Side Stick (C#2), Rimshot (D2), Claps (D#2), Snare Drum

(E2), Low Floor Tom (F2), Hi-hat Closed Pedal (F#2), High Floor Tom

(G2), Hi-Hat Pedal (G#2), Mid-Rack Tom (A2), Hi-Hat Open (A#2),

High Mid-Rack Tom (B2), High Tom (C3), Low Crash (C#3), Low Rack

Tom (D3), Low Ride (D#3), Splash Cymbal

Nom Techniques/instruments Tessiture



4.5 Interprétation

323

Exécutio
n

4.5 Interprétation

b 4.1 Utiliser du texte.

Sibelius propose plusieurs fonctions tellement efficaces pour l’exécution des partitions qu’on peut

quasi parler d’interprétation !

Les options pour le contrôle du style de l’interprétation sont toutes proposées dans la boîte de

dialogue Lecture > Interprétation (raccourci Maj-P), et sont décrites ci-dessous. Elles ont

également une incidence dans les partitions sauvegardées au format MIDI (b 9.9 Exporter des
fichiers MIDI), audio (b 9.10 Exporter des fichiers audio) ou page Web Scorch

(b 9.11 Exporter des pages Web Scorch).

Espressivo™
Espressivo (le terme italien pour “avec expression”) est une fonction exclusive de Sibelius qui

permet d’ajouter lors de l’exécution des éléments d’expression comme le fait un interprète réel.

Sibelius respecte bien sûr les nuances et les articulations écrites dans la partition mais les complète

de manière à ce que le phrasé et les autre éléments d’interprétation forment un tout. Lors de

l’exécution de partition comportant plusieurs instruments, voire un orchestre, Espressivo gère

l’expression pour chaque instrument.

Dans la boîte de dialogue Lecture > Interprétation, le menu déroulant Espressivo propose cinq

degrés d’expression à utiliser selon le style de musique :

* Meccanico (“mécaniquement”) joue la partition de manière absolument littérale, sans aucune

nuance ou articulation exceptée celles écrites

* Senza espress. (“sans expression”) ajoute de très légères fluctuations de volume et de légers

accents au début des mesures et des notes groupées comme le fait un interprète même s’il évite

de mettre de l’expression

* Poco espress. (“légèrement expressif”) exécute la partition avec des nuances légères qui suivent

le dessin musical, adaptée à un jeu rapide, relativement mécanique (idéal pour la musique

baroque)

* Espressivo est l’option par défaut, et propose assez bien de nuances

* Molto espress. (“très expressif”) produit un jeu très expressif, qui peut être excessif pour

certains genres musicaux. Dans les partitions où figurent de grands groupes d’instruments, le

rendu est excellent notamment pour permettre de distinguer les différentes lignes.

Rubato™
Rubato est le pendant rythmique d’Espressivo. Cette fonction permet d’ajouter de subtiles

variations de tempo à la partition pour augmenter l’effet expressif comme le fait un vrai interprète.

Dans la boîte de dialogue Lecture > Interprétation, la liste déroulante Rubato propose six styles

différents à utiliser selon le genre musical :
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* Meccanico : c’est l’option par défaut: la partition s’exécute absolument littéralement, sans

variation de tempo, excepté les indications écrites de tempo, de métronome, et les lignes de rit./

accel. lignes

* Senza Rubato : exécute la partition comme un vrai interprète en essayant de garder un tempo

strict, avec des fluctuations de tempo à peine perceptible

* Poco Rubato : ajoute très peu de rubato, de sorte que le tempo de la partition sera peu affecté

pendant une phrase

* Rubato : produit des variations modérées de tempo

* Più Rubato : ajoute pas mal d’effets de rubato

* Molto Rubato : ajoute le maximum de rubato possible en exagérant la conduite rythmique, ce

qui ne peut convenir dans un certain nombre de genres musicaux.

Le réglage recommandé de rubato est Rubato (le réglage moyen). Les réglages plus élevés peuvent

produire des effets d’instabilité rythmique dans les passages particulièrement chargés.

Étant donné que Sibelius se base sur le dessin des phrases, l’effet du rubato peut sembler atténué

quand il s’applique à de la musique répétitive ou uniforme. De même, plus le nombre

d’instruments de la partition est élevé et moins grand sera l’effet du rubato ; mais de toutes façons

un rubato appuyé ne convient pas pour les grands ensembles (ce serait quasi impossible à diriger).

Une alternative à la fonction de Rubato automatique de Sibelius consiste à enregistrer

l’interprétation même des nuances de tempo dans votre partition à l’aide de Live Tempo –

b 4.7 Live Tempo.

Style rythmique
Sibelius peut exécuter un large éventail de “styles rythmiques” dans des genres musicaux divers,

du jazz à la valse viennoise. Certains styles ajustent le rythme écrit, d’autres accentuent les temps,

et certains font les deux.

Les options de Style rythmique de la boîte de dialogue Lecture > Interprétation sont les

suivantes :

* Straight (pas de swing) : c’est le réglage par défaut

* Swing léger / Swing / Swing appuyé : c’est la convention en jazz selon laquelle deux croches

écrites sont jouées approximativement comme noire plus croche dans un rythme de triolet de

croches

* Swing ternaire : les deux croches sont jouées exactement comme une noire plus une croche

dans un rythme de triolet de croches

* Shuffle : un swing léger sur les double croches

* Doubles croches swing : identique au Swing mais avec effet sur les doubles plutôt que les

croches

* Croches pointées : c’est un swing extrême, mais peu usité.

* Notes inégales : une noire plus une croche dans un rythme de triolet de croches, similaire au

Swing ternaire, pour obtenir l’effet utilisé parfois en musique ancienne (même si les

conventions du jeu en notes inégales sont plus complexes)
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* Valse légère/ Valse viennoise : raccourcit le premier temps de la mesure (plus ou moins), pour

obtenir l’effet caractéristique de la valse

* Samba : s’applique sur les groupes de doubles en réduisant le premier et le quatrième temps

* Rock / Pop : accentue le premier et le troisième temps d’une mesure en 4/4, allège le deuxième et

le quatrième ainsi que ce qui est hors du temps, en Rock plus qu’en Pop

* Reggae : un schéma en doubles croches avec une accentuation forte sur les 3ème et 4ème

doubles 

* Funk – similaire au Pop, mais avec le second temps de la mesure (en 4/4) légèrement plus tôt.

Vous pouvez activer ou désactiver le style rythmique ou même passer d’un style à l’autre selon les

différentes parties d’une partition en ajoutant des indications telles que “Swing” ou “Straight” en

texte de tempo (et le masquer si nécessaire) – b Dictionnaire de l’exécution.

On aurait tendance à penser qu’une option de swing devrait à la fois gérer les croches et les double

croches, cependant c’est impossible : si des doubles tombent en même temps que des croches,

certaines seront trop longues et d’autres trop courtes les unes par rapport aux autres. L’effet

souhaité serait que le swing soit effectif en fonction des notes les plus rapides jouées, les croches à

certains moments, les doubles à d’autres. Pour obtenir cet effet, il suffit d’ajouter des indications de

textes entre les différents passages en croches et en doubles – b Dictionnaire de l’exécution.

En principe, l’option Changer seulement les temps de la boîte de dialogue Lecture >

Interprétation devrait être ignorée, étant donné que chaque style rythmique la règle

automatiquement. Avec cette option, il s’agit de contrôler si le style rythmique change seulement

l’accentuation ou le rythme des notes qui tombe sur le temps ; par exemple, Viennese waltz active

l’option, mais swing la désactive. Il n’y aucune raison de changer cela, sauf si vous avez du temps à

tuer.

Réverbération
Réverbération signifie écho, mais à vrai dire l’écho diffus obtenu dans une pièce, et non celui des

montagnes suisses. Le son atteint nos oreilles via différents chemins, certains plus courts (par ex.

celui qui vient directement de l’interprète à vos oreilles) que d’autres (par ex. celui qui rebondit sur

le mur avant d’arriver à vos oreilles). Les sons qui prennent un chemin plus long arrivent à l’oreille

plus atténués que ceux qui prennent une route directe, mais les différences de temps et de volume

sont si minimes que nous ne percevons pas chaque son comme une copie de l’original, mais plutôt

un seul son résultant de l’effet des séries de réflexion. Les simulations les plus réalistes de la réverb

sont produites par la circonvolution, qui consiste à prendre l’enregistrement de la “réponse à

l’impulsion” (un enregistrement de la réverbération d’un espace, tel qu’une salle de concert dont la

réponse est idéale) et à le combiner avec le signal audio d’entrée : le signal de sortie simule alors le

son résultant d’un espace ou d’un environnement spécifique. La réverb par circonvolution est

beaucoup plus complexe que d’autres types de réverb numérique, qui d’ordinaire utilisent

plusieurs circuits de retour avec retard pour produire un signal assez grand, formé de séries de

copies retardées du signal original.

Le Sibelius Player intégré comporte deux réverbérations: une réverbération de circonvolution de

haute qualité, qui produit la meilleure qualité sonore mais exploite davantage de puissance de

traitement ; et une réverbération stéréo standard, qui ne rend pas aussi bien, mais est plus
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économe en ressource pour votre ordinateur. Par défaut, la réverb de circonvolution sert à

l’exécution; pour utiliser la réverb standard, rendez-vous à la page Lecture de Fichier >

Préférences (dans le menu Sibelius sur Mac) et désactivez Utiliser réverb de circonvolution.

Un tel effet rend l’exécution des partitions très réaliste, car l’oreille humaine est aussi sensible à

l’acoustique d’une pièce qu’aux sons qu’on y produit. Les partitions pour petits ensembles

reçoivent une réverbération légère, caractéristique des pièces de dimension moyenne, tandis que

celles pour les grandes formations seront réglées pour obtenir une profondeur supplémentaire.

La boîte de dialogue de Sibelius Lecture > Interprétation propose six degrés de Réverbération de

Sèche à Cathédrale. Chaque préréglage produit un son de caractère différent dans le Sibelius

Player, et cela vaut la peine d’essayer quelques préréglages avec chaque partition. Vous pouvez

régler le mélange de réverb par rapport au signal dénommé sec, c.-à.-d. qui n’a pas traversé l’effet

de réverb, à l’aide du curseur de Réverb sur la rangée du Sibelius Player dans le Mélangeur – cf.

Rangées des instruments virtuels à la page 311.

Au bénéfice d’autres périphériques de lecture, les sept préréglages de Sibelius coïncident aussi avec

différentes valeurs pour le contrôleur de réverb MIDI standard (91) : Sèche n’envoie pas de réverb,

et Cathédrale envoie quasiment la réverb maximum. La plupart des cartes-sons et des

périphériques MIDI ainsi que quelques claviers peuvent ajouter de la réverbération, même si l’effet

obtenu dépend des périphériques utilisés.

Certains périphériques MIDI disposent d’effet supplémentaires tels qu’une réverbération plate, de

hall, etc., bien que les préréglages de Sibelius ne puissent pas concorder avec ces paramètres ; pour

en savoir plus consultez le manuel de votre périphérique MIDI.

Durées des notes
Vous pouvez ajuster la longueur des notes exécutées en réglant Notes sans liaison de phrasé. Par

défaut, Sibelius joue la longueur réelle de toutes les notes sans liaison, de sorte que le rendu lors de

l’exécution est toujours fluide (legato). Si vous allongez les notes au-delà de 100%, cela peut

améliorer le legato sur certains périphériques MIDI mais peut causer des problèmes sur d’autres si

la note est répétée ; le chevauchement peut raccourcir de manière excessive la seconde note ou au

contraire donner l’impression que certaines notes semblent être tenues (et sonnent indéfiniment).

La durée des notes sous les liaisons peut être modifiée dans la page Lignes de portée de Lecture >

Dictionnaire – b 4.9 Dictionnaire de l’exécution.

L’option Exécuter les liaisons rythmiques entre les voix (activée par défaut) indique à Sibelius

qu’il ne faut pas rejouer la seconde note de deux notes liées si cette seconde note appartient à une

voix différente de la première note, ce qui est fréquent dans la musique pour instruments à clavier.

Nuances entre les portées de clavier
Sibelius exécute automatiquement les nuances placées entre les deux portées des instruments à

clavier (ou d’autres comportant plusieurs portées, par exemple une flûte avec deux portées) –

Instruments à plusieurs portées à la page 304.

La boîte de dialogue Lecture > Interprétation permet de régler la distance minimum à laquelle

doit se trouver une nuance pour qu’elle s’applique à la portée adjacente (c’est-à-dire la portée
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inférieure si elle est attachée à celle supérieure et la portée supérieure si elle est attachée à celle

inférieure).

Si vous ne souhaitez pas que les nuances s’appliquent aux deux portées des instruments à clavier,

désactivez l’option Affecte la portée adjacente.

Espace après les barres de mesure finales
L’option Espace après les barres de mesure finales détermine le temps de silence laissé par

Sibelius à la fin d’une barre de mesure finale dans une partition qui contient plusieurs parties

(chansons, morceaux ou mouvements).

Si une chanson, un mouvement ou un morceau se termine par une barre de mesure autre que la

barre de mesure finale (par une double barre ou une barre de fin de reprise par exemple), Sibelius

la reconnaîtra alors comme étant la dernière barre de mesure de la partition, à condition d’avoir

activé la propriété Fin de section dans le panneau Mesures des propriétés, et que Jouer aussi les
espaces après les fins de section soit activé (activé par défaut).

ReWire
Plusieurs options Rewire existent dans Mode Tempo fixe et Piste de tempo à la page 399.
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4.6 Reprises

b 2.4 Barres de mesure, 2.21 Lignes, 2.31 Symboles, 3.1 Utiliser du texte,

4.1 Utiliser du texte, 4.9 Dictionnaire de l’exécution, 5.17 Propriétés.

Comme pour de nombreuses autres indications de jeu, Sibelius comprend les indications de

reprise dans la partition et les exécute automatiquement. Sibelius est même capable de jouer des

structures de reprises très compliquées.

Différents objets peuvent affecter l’exécution des reprises: les barres de mesure; les lignes telles que

1ère et 2de fin; du texte tel que D.C. al Coda ou 1ère fois mf et les symboles de coda et de “segno”.

Les fichiers MIDI sauvegardés à partir de Sibelius incorporent les reprises exactement de la même

façon qu’elles sont exécutées.

Boîte de dialogue Répétitions
L’exécution Répétitions est contrôlée par la boîte de dialogue Exécution > Reprises, identique à

celle-ci :

* Ne pas jouer les reprises indique à Sibelius d’ignorer toutes les barres de reprises, lignes de

fin, etc. de la partition.

* Répète l’exécution automatiquement est configuré par défaut et indique à Sibelius

d’exécuter les reprises de la partition selon sa propre interprétation automatique des barres de

reprise, lignes de fin, et de ne pas tenir compte des instructions telles que D.C. al Coda.

* Répète l’exécution manuellement vous permet de spécifier l’ordre dans lequel les mesures de

la partition doivent être exécutées – cf. Exécution manuelle des répétitions ci-dessous.

Barres de reprise
Pour créer une barre de reprise de début ou de fin, sélectionnez la barre de mesure sur laquelle

vous souhaitez placer la reprise et choisissez Créer > Barre de mesure > Début de reprise > ou Fin
de reprise. Pour en savoir plus, b 2.4 Barres de mesure.

Par défaut, les barres de reprise n’impliquent qu’une seule répétition (donc un passage se

terminant par un barre de fin de reprise sera joué deux fois). Si vous souhaitez qu’une section

répétée soit exécutée plus de deux fois, sélectionnez la barre de fin de reprise et cochez plus de

cases Jouer lors de l’exécution dans le panneau Exécution de la fenêtre de propriétés
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(cf ci-dessous); n’oubliez pas que si vous cochez, par exemple, les cases 1, 2 et 3 la section sera

répétée trois fois et sera par conséquent jouée quatre fois en tout. Cependant, si une barre de fin de

reprise (voir plus bas) est également présente dans la même mesure, ses propriétés d’exécution

auront priorité et la barre de reprise ne jouera que le nombre de fois imposé par la barre de fin.

Vous pouvez également écrire une instruction texte telle que Jouer 3 fois ou Répéter 2 fois
dans un style de texte système (p.e. Tempo) au-dessus d’une barre de reprise, ce qui vous permet

d’ignorer les cases Jouer lors de l’exécution.

1re et 2de ligne de fin
Pour en savoir plus sur la création de ces lignes, b 2.21 Lignes.

Terminer des lignes par des parenthèses ouvertes tout à droite règle automatiquement l’option

Passer à la dernière mesure; cela indique à Sibelius qu’il a terminé de jouer les lignes de fin

précédant celle-ci. Si vous comptez plusieurs lignes de fin dans votre partition, vous devez veiller à

ce que chaque terminaison de chaque section répétée ait une fin ouverte à droite pour que

l’exécution soit correcte :

Sibelius définit les propriétés d’exécution de ces lignes automatiquement lorsque vous les créez ; il

lit les numéros entre crochets et règle les cases Jouer lors de l’exécution de façon adéquate (cf.

Propriétés ci-dessous). Par exemple, une ligne de fin portant le texte 1,–3. Par exemple, une

barre de fin de reprise contenant le texte 1.–3. cochera les cases 1, 2 et 3 automatiquement; une

ligne avec le texte 1, 3, 5 cochera les cases 1, 3 et 5; et ainsi de suite.

Codas
Les codas – la musique qui vient à l’extrême fin d’une mélodie avec une structure répétitive – sont

normalement séparées de la musique qui précède par un espace. Pour créer une coda:

* Créez les mesures dans lesquelles la musique de la coda se placera.

* Sélectionnez la barre de mesure précédant la coda

* Choisissez Créer > Barre de mesure > Double (car les codas sont normalement précédées de

doubles barres de mesure, afin d’indiquer la fin de la section précédente)

* Il est également d’usage d’ajouter ici une indication textuelle informant l’interprète de la marche à

suivre lorsqu’il atteint cette mesure pour la première fois – cf. Dal segno (D.S.) et da capo
(D.C.) ci-dessous 

* Choisissez Mise en page > Saut > Diviser un système. Cela crée un espace après la barre de

mesure sélectionnée. Vous pouvez faire glisser la barre de mesure au début de la seconde moitié

du système de façon à augmenter ou diminuer l’espace (pour supprimer l’espace complètement,

sélectionnez la barre de mesure après l’espace et choisissez Mise en page > Réinitialiser les
positions). Pour contrôler si la clef, l’armure, etc. sont répétés après l’espace, sélectionnez la

barre de mesure à la fin de la première mesure après l’espace et ouvrez le panneau Mesures de la

fenêtre des propriétés (b 5.17 Propriétés).

1.  2.  1. 2.


Incorrect

      

1.  2.  1. 2.


Correct
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* Pour écrire le mot CODA au-dessus du début de la coda, appuyez sur Échap afin de vous

assurer que rien n’est sélectionné. Choisissez ensuite Créer > Texte > Tempo (raccourci

Ctrl+Alt+T ou zXT) et cliquez au-dessus du début de la coda. Faites un clic-droit (Windows)

ou Contrôle-clic (Mac) pour afficher le menu contextuel qui comprend le symbole de coda, puis

entrez le mot CODA de la manière habituelle.

Dal segno (D.S.) et da capo (D.C.)
Le terme italien “dal segno” signifie littéralement “à partir du signe”. Dans la plupart des partitions,

vous verrez le signe D.S. al Fine (ce qui signifie “retourner au signe $ et jouer la musique à

nouveau jusqu’à l’indication Fine et s’y arrêter”) ou D.S. al Coda (“retourner au signe $ et jouer

la musique à nouveau jusqu’à l’indication Al coda puis passer à la coda”).

De même, “da capo” signifie littéralement “de la tête”, c-à-d du début d’une mélodie ou d’un pièce.

Comme pour D.S., vous verrez en règle générale soit D.C. al Fine ou D.C. al Coda

Vous pouvez également simplement voir D.C. ou D.S. à la mesure finale d’une partition, ce qui

signifie répéter à partir du début de la partition ou à partir du signe $ respectivement, et s’arrêter à

la fin.

En musique, ces instructions apparaissent toujours à la fin de la mesure de laquelle vous devez

retourner en arrière (soit au signe $, soit au début de la pièce). Pour entrez ces instructions:

* Sélectionnez la barre de mesure de laquelle l’interprète doit retourner en arrière dans la mélodie

* Choisissez Créer > Texte > Autre texte de système > Reprise (D.C./D.S./Al coda). (Il est

important d’utiliser ce style de texte plutôt que du texte de tempo car il s’attache

automatiquement à la fin de la mesure.)

* Un signe d’insertion clignotant apparaît. Faites maintenant un clic-droit (Windows) ou

Contrôle-clic (Mac) pour afficher le menu contextuel qui inclut le texte dont vous avez besoin –

entrez-le dans la partition en cliquant simplement dans le menu. Si vous entrez les mots vous-

même, assurez-vous d’utiliser la casse correcte (c-à-d entrez “Fine” et pas “fine” car la seconde

orthographe ne serait pas exécutée correctement).

Créer un “segno”
Si l’interprète doit retourner à un “segno”, vous devez bien entendu placer le symbole de segno au

bon endroit. voici comment procéder:

* Sélectionnez la note au début de la mesure à laquelle l’interprète doit retourner

* Choisissez Créer > Symbole (raccourci Z pour “zymbole”)

* Le symbole segno ($) se trouve tout en haut de la boîte de dialogue, dans la rangée intitulée

Reprises. Cliquez dessus pour le sélectionner et assurez-vous que l’option Attacher à (au) est

réglée sur Système.

* Cliquez sur OK et le symbole segno sera inséré dans la partition.

Fine et al Coda
Les portions de texte finales utilisées dans les structures à répétitions sont Fine (qui indique où

l’interprète devrait arrêter de jouer la mélodie s’il est précédemment retourné à une indication

D.S. ou D.C. instruction), et Al Coda (qui indique où l’interprète devrait sauter pour la coda s’il

est précédemment retourné à une indication D.S. al Coda ou D.C. al Coda).
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Ces deux indications se présentent à la fin de mesures et sont entrées de la même manière que

D.S. et D.C. – cf. Dal segno (D.S.) et da capo (D.C.) ci-dessus.

Mesures répétées
Pour créer une mesure répétée, b 2.27 Mesures répétées. Sibelius exécute automatiquement

les mesures de reprise.

Propriétés
Le panneau Exécution de la fenêtre de propriétés contient les plupart des

paramètres permettant de contrôler l’effet qu’ont des lignes, du texte, et

même des notes sur l’exécution.

* Jouer lors de l’exécution: ces cases indiquent si l’objet sélectionné doit

être joué lors de la Nième exécution d’un passage, jusqu’à un total de 8

répétitions. Pour des barres de reprises et des lignes de 1ère et 2de fin, Sibelius règle ce

paramètre automatiquement (cf. Barres de reprise ci-dessous 1re et 2de ligne de fin et ).

Pour du texte, vous pouvez régler l’option vous même (cf. Quand jouer du texte et des
ligne ci-dessous ).

* Passer à la dernière mesure s’applique uniquement aux lignes de fin ouvertes sur la droite

(c-à-d sans crochet du côté droit) – cf. 1re et 2de ligne de fin ci-dessous.

* Sauter à la fin de la mesure indique à Sibelius s’il doit se conformer à un saut (par ex. à une

instruction textuelle telle que D.C. al Coda) au point précis de la mesure auquel le texte est

attaché, ou à la fin de la mesure (l’option par défaut). Vous n’aurez à décocher cette option que si

vous souhaitez qu’une indication de reprise soit appliquée au milieu d’une mesure.

Quand jouer du texte et des ligne
Les cases Jouer lors de l’exécution peuvent être utilisées pour indiquer à Sibelius lorsque le texte

de portée affectant l’exécution (généralement Expression ou Technique) doit être joué. Par

exemple, vous pourriez créer du texte de Technique indiquant “Au sax (2de fois uniquement)” et

cocher la case 2 sous Jouer lors de l’exécution ce qui indiquera à Sibelius de passer à un son de

saxophone la seconde fois qu’il joue cette mesure; de la même manière, vous pourriez créer un

texte d’expression tel que “1ère, 3ème et 5ème fois: mf ” (en cochant les cases Jouer lors de
l’exécution 1, 3 et 5) et un autre objet “2ème, 4ème fois: pp ” (en cochant les cases 2 et 4) au

début d’une section répétée, et Sibelius se conformera aux nuances en conséquence. Dans le même

ordre d’idée, vous pourriez créer une ligne de portée (telle qu’un soufflet ou un glissando) et la

paramétrer de façon à ce qu’elle ne soit exécutée que lors d’un seul passage.

Le texte de système (généralement du style Tempo ou Reprise (D.C./D.S./Al coda)) n’est pas affecté

par l’état des cases Jouer lors de l’exécution: Sibelius décide intelligemment quand prendre en

compte ces indications. En outre, les lignes de système autres que les lignes de fin, par ex. rit. /

accel. sont exécutées lors de chaque répétition d’un passage.

Quand jouer des notes
Les cases Jouer lors de l’exécution s’appliquent également aux notes, ce qui ouvrent la porte à

quelques possibilités excitantes: pour des mélodies ayant, par ex., différents rythmes dans

différentes strophes sous la ligne vocale, vous pourriez créer des notes de réplique selon le rythme
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de la seconde strophe et les paramétrer de façon à ce qu’elles ne soient exécutées que lors de la

seconde exécution; dans du jazz, vous pouvez écrire un solo dans les cuivres qui ne devrait être

exécuté que lors de la reprise; etc...

Vous pouvez même rendre une note complètement silencieuse en décochant toutes les cases de

Jouer lors de l’exécution! (Pour rendre silencieuse une tête de note au sein d’un accord, utilisez

plutôt un type de tête de note silencieuse – b 2.25 Têtes de note.)

Passer des mesures
Dans certains cas, vous pouvez souhaiter qu’une mesure particulière ne soit pas exécutée du tout.

Par exemple, la partition pourrait commencer par une portée liminaire (comme on le fait pour

indiquer les cloches manuelles utilisées) ou par une page de grilles de guitare, et vous préféreriez

qu’elles ne soient pas exécutées.

C’est assez facile à mettre en place, en utilisant du texte de système pour créer une paire de

“marqueurs” – un objet textuel pour définir l’endroit de départ duquel vous souhaiter sauter, et un

autre pour définir l’endroit d’arrivée auquel vous souhaitez sauter:

* Décidez d’un nom pour votre paire de marqueurs; celui-ci n’a pas d’importance. Pour prendre

un exemple, utilisons le mot “chat”.

* À la fin de la mesure précédent immédiatement la mesure que vous souhaitez passer, créez un

nouvel objet de texte de Reprise (D.C./D.S./Al coda) composé du texte “passer à” et du nom de

votre marqueur, par ex. passer à chat

* Au début de la mesure à partir de laquelle vous souhaitez reprendre l’exécution, créez un nouvel

objet de texte de Tempo composé du mot “marqueur” et du nom de votre marqueur, par ex.

marqueur chat

Vous ne souhaiterez probablement pas non plus que l’un ou l’autre objet texte dans votre paire de

marqueurs apparaisse lors de l’impression, auquel cas vous pouvez soit les sélectionner et les

masquer (via Edition > Masquer ou afficher > Masquer) ou en insérant un tilde (~) au début de

chaque objet texte, ce qui le masquera.

Sibelius se conformera toujours à une paire de marqueurs lorsqu’il en rencontre une pendant

l’exécution, car comme les autres objets de système, les marqueurs ne tiennent pas compte de l’état

des cases Jouer lors de l’exécution.

Fins optionnelles et répétitions jusqu’au silence
Dans des partitions de musique pop, vous rencontrerez parfois des fins alternatives; l’une sera

généralement Répéter jusqu’au silence, et l’autre sera la Fin optionnelle (l’idée étant que les

musiciens n’ayant pas la possibilité magique de réduire progressivement le volume jusqu’au silence

utilisent la fin optionnelle à la place).

Vous pouvez les faire jouer par Sibelius de différentes façons; voici une manière de faire utilisant la

fin optionnelle:

* Utilisez des lignes de fin avec extrémités droites fermées tant pour la mesure à Répéter
jusqu’au silence que pour la Fin optionnelle

* Réglez la ligne de fin Répéter jusqu’au silence de façon à ce qu’elle soit jouée deux fois (par

ex.) à l’aide des paramètres se trouvant sur le panneau Exécution de la fenêtre des propriétés;

assurez-vous que la case Passer à la dernière mesure soit bien décochée
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* Sélectionnez la ligne de Fin optionnelle et cochez la case Passer à la dernière mesure dans le

panneau Exécution de la fenêtre des propriétés.

Lorsque vous exécuterez la partition, Sibelius jouera la fin Répéter jusqu’au silence deux fois

puis jouera les mesures de la Fin optionnelle pour terminer.

Voici une autre manière de simuler une baisse progressive du volume jusqu’au silence:

* Régler la section finale de façon à ce qu’elle soit répétée plusieurs fois en sélectionnant la barre

de reprise et en cochant plusieurs cases Jouer lors de l’exécution dans le panneau Exécution
de la fenêtre des propriétés

* Créez un soufflet de diminuendo tout au long de la section répétée, et réglez-le de façon à ce qu’il

soit joué lors de la dernière répétition de la section finale; dans le même panneau, réglez son

changement de nuance sur 100% du maximum

* Masquez le soufflet en le sélectionnant et en choisissant Édition > Masquer ou afficher >

Masquer (raccourci Ctrl+Shift+H ou xXH).

Localiser des problèmes dans des structures de reprises complexes
Dans les partitions comprenant des structures de reprises complexes, il peut être utile d’activer le

code temporel Au-dessus de chaque mesure dans Exécution > Vidéo et Minutage > Code
temporel et durée. Dans les sections répétées, vous verrez plusieurs lignes de code temporel

superposées, une pour chaque exécution; en regardant le code temporel, vous pourrez déterminer

l’ordre selon lequel Sibelius exécutera ces mesures dans la partition. Pour en savoir plus,

b 4.11 Code temporel et points de montage.

Exécution manuelle des répétitions
Utilisateurs avertis uniquement

Dans les partitions aux structures de reprises complexes (p.e. des chansons possédant plus d’une

coda), l’interprétation automatique des reprises peut s’avérer insuffisante. Si vous estimez que c’est

le cas, choisissez Exécution > Reprises et choisissez Répète l’exécution manuellement.

Ceci vous permettra de spécifier l’ordre exact dans lequel les mesures de la partition doivent être

jouées, en saisissant des plages de numéros de mesure dans une liste séparée par des virgules. Pour

vous aider à démarrer, Sibelius affiche la séquence d’exécution automatique en cours. Vous pouvez

retourner à la séquence automatique en cliquant sur Restaurer l’ordre par défaut.

Si vous avez plusieurs chansons, morceaux ou mouvements au sein d’une même partition, laissez

une ligne blanche entre chaque ensemble de numéros de mesure correspondant à un(e) seul(e)

chanson, morceau ou mouvement afin d’indiquer à Sibelius d’y jouer un espace.

Pour les partitions utilisant des modifications des numéros de mesure, ou pour celles dont la

première mesure ne porte pas le numéro 1, notez bien que la boîte de dialogue Exécution >

Reprises exige que vous utilisiez des numéros de mesure internes, p.e. en comptant toutes les

mesures de la partition une seule fois, et que la première mesure dans la partition, même s’il s’agit

d’une anacrouse (mesure de levée), porte le numéro 1.

Attention également, si vous ajoutez ou supprimez des mesures, vous devez retourner à

Exécution > Reprises et mettre à jour la liste des mesures afin de vous assurer qu’elles soient

toujours jouées dans le bon ordre.
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4.7 Live Tempo

Live Tempo est un moyen simple de contrôler minutieusement le tempo de votre partition pendant

la lecture, ce qui vous permet de produire une interprétation personnelle de votre musique en

tapant simplement sur le clavier de votre ordinateur, clavier MIDI, ou pédale MIDI.

Lorsque vous enregistrez une performance avec Live Tempo, Sibelius répond de la manière dont le

ferait un véritable groupe de musiciens, en lisant les repères dans la partition et en interprétant

votre entrée. Vous pouvez choisir d’indiquer en avance à Sibelius là où vous allez faire du tapping

en créant des points de tapping ou l’autoriser simplement à interpréter votre entrée

automatiquement. Si vous souhaitez sous-diviser le temps pour apporter plus de précision à un

ritardando, ou si vous souhaitez accélérer et commencer à ne battre qu’une seule mesure par barre,

Sibelius vous suivra. Vous pouvez même arrêter le tapping quand vous le souhaitez, et Sibelius

continuera à jouer au dernier tempo atteint, jusqu’à ce que vous repreniez le tapping ou qu’il

rencontre un changement de tempo dans la partition.

On peut même dire qu’avec Live Tempo, vous êtes le chef d’orchestre, et Sibelius est votre orchestre.

Configurer l’enregistrement sous Live Tempo
Afin d’enregistrer votre performance, vous devez choisir votre dispositif d’entrée. Bien que vous

puissiez librement basculer entre vos clavier d’ordinateur, clavier MIDI et pédale MIDI à tout

moment, il est recommandé de choisir un périphérique d’entrée et de le conserver, au moins

pendant un seul enregistrement Live Tempo.

Avant l’enregistrement, vous devez calibrer votre périphérique d’entrée, pour que Sibelius puisse

déterminer la latence dans le système de lecture de votre ordinateur, et votre propre vitesse de

réponse (qui est une latence d’un genre différent !).

Ouvrez la partition où vous souhaitez enregistrer une performance Live Tempo, et choisissez

Lecture > Calibrer Live Tempo. La boîte de dialogue suivante apparaît :

Choisissez simplement le périphérique d’entrée que vous souhaitez calibrer à partir des boutons

radio en haut de la boîte de dialogue, puis cliquez sur Démarrer calibrage. Vous allez entendre un

clic : accompagnez simplement la mesure du clic, en appuyant sur une touche quelconque de votre

clavier d’ordinateur, de votre clavier MIDI, ou de votre pédale MIDI.
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Si Sibelius ne reçoit aucune mesure, il vous en informera, de sorte que vous pourrez corriger le

problème (ex. vous assurer que votre périphérique MIDI est bien branché) et réessayer. Mais, en

temps normal, vous vous apercevrez simplement que le bouton OK est activé, et que vous pouvez

cliquer dessus pour continuer.

Après avoir calibré votre périphérique d’entrée, plus besoin de le refaire à condition d’utiliser

toujours le même périphérique d’entrée et la même configuration de lecture (soit les mêmes

périphériques de lecture). Si vous souhaitez toutefois enregistrer Live Tempo avec un autre

périphérique d’entrée, ou si vous souhaitez passer à une autre configuration de lecture, il est

recommandé d’utiliser Lecture > Calibrer Live Tempo avant d’enregistrer votre performance Live

Tempo.

Options de Live Tempo
Avant de commencer votre enregistrement, choisissez Lecture > Options de Live Tempo pour

consulter les réglages que vous pouvez changer afin d’aider Sibelius à interpréter votre

performance :

* Décompte vous permet de spécifier le nombre de temps que vous allez fournir à Sibelius pour

établir le tempo avant le début de la lecture. Par défaut, Sibelius prévoit une barre de mesures

(ex. en 3/4, vous comptez trois temps, puis au quatrième, Sibelius commence de jouer), mais

vous pouvez changer ce réglage. Si votre partition commence par une mesure d’anacrouse

(levée), le décompte inclut l’anacrouse (ex. si votre partition est en 4/4 et commence par une

anacrouse en quart de note (noire), Sibelius commencera de jouer sur le quatrième temps, à

condition d’avoir précisé un décompte d’une mesure).

* L’option Autoriser plusieurs temps détermine si Sibelius est autorisé à interpréter vos

mouvements en sous-divisions (ex. jouer huit notes (croches) en 4/4) ou plusieurs temps (ex.

tapping une fois par mesure en 3/4). Activée par défaut, cette option est appréciée par beaucoup

de graveurs et d’éditeurs.

* Sensibilité est le réglage le plus important, et également celui qui dépend le plus de votre goût

personnel. Quand le curseur est placé à gauche, Sibelius suivra votre tapping individuel de manière



4. Exécution et vidéo

336

moins proche, au lieu de les adoucir pour établir un temps plus cohérent ; placé à droite, Sibelius

suivra votre tapping individuel de manière plus proche, et l’ajustement du tempo est plus

immédiat.

Une fois que vous êtes satisfait des réglages, cliquez sur OK. Vous êtes désormais prêt à enregistrer

votre performance.

Selon certains facteurs comme le nombre d’instruments et la gamme générale de tempos présents

dans la partition, il peut s’avérer utile de consulter les Options de Live Tempo quelques fois afin

de tester différents réglages. Les choix effectués ici sont sauvegardés dans la partition.

Enregistrer une performance Live Tempo
Il est recommandé d’activer Affichage > Panorama avant d’enregistrer Live Tempo, car il existe un

affichage spécial Live Tempo qui n’apparaît que dans Panorama – cf. Affichage Live Tempo
ci-dessous.

Après avoir calibré votre périphérique d’entrée et consulté les options Live Tempo pour

votre partition, positionnez la ligne de lecture à l’endroit où vous souhaitez que Live

Tempo commence l’enregistrement (ex. saisissez Ctrl+[ ou X[ pour déplacer la ligne de lecture au

début de la partition), puis cliquez sur le bouton rouge Enregistrer Live Tempo sur la fenêtre

Lecture (indiqué en haut à droite) ou choisissez Lecture > Enregistrer Live Tempo.

Si vous n’avez pas encore calibré de périphérique d’entrée, Sibelius vous informera que vous

risquez d’obtenir des résultats inattendus à moins de le faire, et vous demandera si vous souhaitez

calibrer un périphérique d’entrée maintenant : il est recommandé de cliquer sur Oui, ce qui vous

amènera directement à la boîte de dialogue Calibrer Live Tempo (cf. ci-dessus).

Dans le cas contraire, la ligne de lecture deviendra rouge, et Sibelius sera en attente de votre

premier mouvement. Selon le nombre de temps ou de mesures d’introduction défini dans

Lecture > Options de Live Tempo, Sibelius commencera la lecture et suivra votre tempo.

Pendant l’enregistrement de Live Tempo, la lecture de Sibelius pourra sembler un peu irrégulière

(notamment si vous avez défini le curseur de Sensibilité vers la droite dans Options de Live
Tempo). Cela s’explique par le fait que vous devez deviner la longueur de chaque temps afin de

jouer dans le rythme de votre tapping. Lorsque vous lisez votre enregistrement Live Tempo, les

changements de tempo sembleront plus fluides.

Si vous souhaitez que le tapping s’arrête à tout endroit mais que la lecture continue (ex. parce que vous

avez établi le tempo que vous espériez), arrêtez simplement le tapping : Sibelius continuera à la vitesse

atteinte. Quand vous souhaiterez participer à nouveau, reprenez simplement le tapping : Sibelius

commencera de vous suivre à nouveau.

L’enregistrement Live Tempo se poursuivra jusqu’à ce que vous ayez atteint la fin de la partition, à

moins que votre partition contienne plusieurs chansons, mouvements ou morceaux, auquel cas il

continuera jusqu’à la prochaine ligne de mesure ou au prochain repère Fin.

Si vous souhaitez interrompre l’enregistrement Live Tempo avant la fin de la partition, appuyez

simplement sur Échap ou cliquez sur le bouton d’arrêt dans la fenêtre Lecture.
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Affichage Live Tempo
Vous pouvez voir une représentation graphique des réglages de tempo via Live Tempo en activant

Affichage > Panorama. Lorsque vous enregistrez Live Tempo, Affichage > Live Tempo est activé,

et affiche un graphique au-dessus de la portée supérieure dans la partition :

Les lignes verticales dans le graphique sont alignées avec les lignes de mesure dans la partition.

Une ligne horizontale défile au milieu du graphique, qui représente le tempo par défaut à cet

endroit de la partition. Les variations de tempo produites par votre enregistrement Live Tempo

concernant le tempo par défaut sont indiquées sous forme de ligne défilant soit au-dessus ou en-

dessous de la ligne horizontale sur le graphique. (dans l’image ci-dessus, le graphique indique

l’accélération du tempo comparé au tempo de lecture normal, suivi de son ralentissement).

Lorsque vous effectuez une sélection de passage dans votre partition, le graphique reflète la

sélection, en bloquant les sections dans le graphique qui correspondent aux mesures sélectionnées.

Cela vous permet de voir où les données de Live Tempo seront effacées si vous utilisez Lecture >

Effacer Live Tempo.

Ajouter et enlever des points de tapping
En indiquant dans la portée l’endroit où vous allez frapper vous pouvez utiliser des techniques de

direction complexes, comme par exemple, des battements mélangés (où le chef d’orchestre

combine un ou plusieurs mouvements pour marquer le temps dans un seul mouvement tenu d’une

durée égale aux battements combinés).

Le moyen le plus rapide pour ajouter des points de tapping est de rechercher la portée dans

laquelle vous souhaitez frapper, faire une sélection de passage autour de ce passage (assurez-vous

que la portée avec le rythme que vous souhaitez frapper correspond à la portée supérieure de la

sélection), puis de choisir Lecture >Points de tapping Live Tempo. La boîte de dialogue suivante

apparaitra alors :
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* Ajouter des points de tapping ou Supprimer des points de tapping détermine si les options

définies ci-dessous dans la boîte de dialogue ajouteront ou supprimeront des points de tapping à

partir de la sélection ou de toute la partition.

* Les options Tessiture d’opération déterminent dans quelles barres de mesure les points de

tapping seront ajoutés ou supprimés :

% Si un passage était sélectionné lorsque de l’ouverture de la boite de dialogue, par défaut

l’option Utiliser sythme de la portée supérieure de la sélection sera activée. Sibelius

créera un point de tapping pour chaque note de la portée supérieure de la sélection ; si vous

activez Inclure silences, Sibelius créera également un point de tapping pour chaque silence.

% Vous pouvez également choisir Appliquer à un ensemble de sélections, pour ajouter ou

supprimer des points de tapping dans le passage sélectionné, en fonction des options définies

ci-dessous dans Fréquence des points de tapping plutôt que d’utiliser le rythme de la

portée supérieure du passage sélectionné.

% Appliquer à toute la partition ignore les sélections effectuées dans la partition et au lieu de

cela ajoute ou supprime des points de tapping dans toute la partition, en fonction des options

définies ci-dessous dans Fréquence des points de tapping.

* Lorsque de nouveaux points de tapping sont ajoutés, l’option Remplacer les points de tapping
existants vous permet de choisir si les points de tapping existants dans le passage affecté

doivent être remplacés ou non (dans ce cas, l’option doit être activée) ou si les nouveaux points

de tapping doivent être ajoutés sans répercussion sur les points de tapping existants (dans ce cas,

l’option doit être désactivée).

* Les options dans Fréquence des points de tapping déterminent les positions rythmiques

auxquelles les points de tapping doivent être ajoutés ou supprimés s’ils n’utilisent pas de rythme

dans la partition. Vous pouvez choisir d’ajouter ou de supprimer des points de tapping à chaque

battement, au début de chaque mesure ou toutes les demi-mesures.

Les points de tapping apparaissent sur l’affichage Live Tempo en panoramique sous forme

d’éléments plutôt ronds :

Vous pouvez également ajouter des points de tapping en cliquant directement sur l’écran Live

Tempo : choisissez Créer > Autres > Point de tapping Live Tempo, puis cliquez à l’endroit où vous

souhaitez ajouter un point de tapping : Sibelius dessine un trait d’union pour vous aider à aligner

votre point de tapping avec le rythme de la musique. Lorsque vous cliquez sur ce trait d’union,

Sibelius aligne le point de tapping avec la position rythmique la plus proche (en fonction des

réglages effectués sur la page Souris du menu Préférences).
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Si vous créez des points de tapping à partir du rythme d’un passage de musique puis modifiez le

rythme de ces mesures, les points de tapping ne seront pas automatiquement réactualisés : vous

pouvez modifier ou recréer les points de tapping via Lecture > Points de tapping Live Tempo.

Vous pouvez également ajouter ou supprimer des points de tapping en double-cliquant

simplement sur l’affichage Live Tempo.

Enregistrer Live Tempo avec des points de tapping
Une fois que vous avez créé des points de tapping, choisissez Lecture > Enregistrer Live Tempo
pour enregistrer votre performance. Pour les mesures avec des points de tapping, Sibelius attendra

de vous que vous frappiez à des endroits précis et vous attendra alors à chaque point de tapping au

lieu de laisser le volant continuer sans vous, comme c’est normalement le cas.

Vous êtes libre de mélanger des passages dans lesquels vous avez des points de tapping spécifiques

et des passages où Sibelius interprétera automatiquement votre tapping : après un passage de

points de tapping, Sibelius commencera automatiquement à interpréter normalement vos

tappings, dès lors qu’il rencontrera une mesure complète sans point de tapping.

Lire une performance Live Tempo
Pour lire votre performance Live Tempo, veillez simplement à ce que le bouton bleu Jouer

Live Tempo sur la fenêtre Lecture (affiché à droite) ou Lecture > Live Tempo soit activé

avant de lancer la lecture.

Votre performance Live Tempo est préservée quand vous exportez un fichier MIDI ou audio, publiez

votre partition sur SibeliusMusic.com, ou exportez une page Web Scorch, à condition que Lecture >

Live Tempo soit activé.

Effacer Live Tempo
Pour effacer la totalité d’une performance Live Tempo, choisissez Lecture > Effacer Live Tempo
sans avoir rien sélectionné, et répondez Oui à la question de savoir si vous souhaitez supprimer les

données Live Tempo de toute la partition.

Si vous souhaitez effacer les changements de tempo créés en enregistrant Live Tempo dans un

passage, sélectionnez simplement ces mesures et choisissez Lecture > Effacer Live Tempo. Cela

supprime les données Live Tempo du passage sélectionné. Si vous vous trouvez dans Panorama et

qu’Affichage > Live Tempo est activé, vous verrez que le graphique est effacé pour ces mesures.

Quand vous lisez votre partition après avoir effacé Live Tempo d’un passage, cela a la même

conséquence que si vous aviez cessé le tapping pour ce passage pendant l’enregistrement Live

Tempo : Sibelius poursuivra la lecture à la même vitesse que celle atteinte au dernier endroit avec

les données de Live Tempo, jusqu’aux prochaines données de Live Tempo ou au prochain repérage

dans la partition modifiant le tempo, selon le cas.

Sous-diviser le temps et plusieurs temps par tap
Si Autoriser plusieurs temps est activé dans les Options de Live Tempo, Sibelius vous

autorisera soit à sous-diviser le temps, ou à fournir moins de taps dans la mesure que de temps.

Dans une métrique simple (ex. 2/4, 3/4, 4/4), Sibelius vous autorise à sous-diviser le temps en

multiples de deux, ex. dans 4/4, deux huitièmes de note (croche) par temps, voire quatre 16èmes
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de note (double croche) par temps. Dans une métrique composée (ex. 6/8, 9/8, 12/8), Sibelius vous

autorise à sous-diviser le temps en multiples de trois ou six, ex. trois huitièmes de note (croche)

par temps en 6/8.

En règle générale, vous sous-divisez le temps lorsque vous souhaitez accélérer ou ralentir. Par

exemple, si vous allez attaquer un ritardando vers la fin d’un mouvement ou morceau en 4/4, vous

pouvez décider de sous-diviser le temps de quart de note (noire) de sorte que, lorsque vous

commencez de ralentir, vous avez plus de contrôle sur la fréquence de changement de tempo en

battant en huitièmes de note (croches). Vous n’avez pas besoin d’en avertir Sibelius : dès que vous

entamez le tapping environ deux fois plus vite que précédemment, le programme l’interprétera

comme une sous-division, et agira en fonction. Pour de meilleurs résultats, vous devez commencer

de sous-diviser le temps avant d’essayer de changer le tempo.

L’approche est semblable pour un tapping moins fréquent que le nombre de temps dans la mesure.

Dans une métrique à duolet simple, ex. 4/4, si vous commencez simplement le tapping à une

vitesse moitié moins rapide que précédemment, Sibelius l’interprétera comme un battement en

blanches (minimes). De même, dans une métrique à triolet simple, ex. 3/4, pour un tapping trois

fois moins rapide que précédemment, Sibelius l’interprétera comme un battement en blanches

pointées (minimes pointées). Sibelius part du principe que votre tapping ne passera jamais en

dessous d’une fréquence par mesure : si c’était le cas, il considérera que vous avez tout bonnement

cessé le tapping.

Armures irrégulières ou complexes
Pour des armures irrégulières comme 5/4, ou des indications de mesure complexes comme 3+2/8,

Sibelius examine les réglages de groupe de ligature pour l’indication de mesure afin d’interpréter

votre tapping pendant l’enregistrement Live Tempo. Si vous souhaitez diviser la mesure

différemment des méthodes de Sibelius, utilisez Notes > Réinitialiser groupes de ligature pour

changer les groupes de ligature utilisés par cette indication de mesure.

Pour les mesures irrégulières (c.-à.-d. les mesures ne contenant pas d’indication de mesure, mais

dont la durée ne correspond pas à celle de l’indication de mesure prédominante), Sibelius examine

la mesure pour voir si elle comporte un schéma temporel régulier ou non, puis interprète votre

tapping en fonction.

Pauses (fermatas)
Les pauses (fermatas) peuvent intervenir soit au milieu d’une phrase, comme point d’emphase ou

de repos, ou à la fin d’une phrase. Une pause à la fin d’une phrase peut parfois être suivie d’un bref

écart articulatoire, comme une levée, avant le début de la phrase suivante.

Par défaut, Sibelius lit les pauses en allongeant la longueur de la note mise en pause, puis poursuit

au tempo initial (à moins qu’il y ait un nouveau repère de tempo après la pause). Quand vous

rencontrez une pause lors de l’enregistrement de Live Tempo, Sibelius allongera la pause jusqu’au

prochain tapping, pour signaler le temps suivant.

Vous pouvez toutefois régler la lecture des notes en y incluant des pauses, soit via la boîte de

dialogue Lecture > Dictionnaire, ce qui change le comportement par défaut des pauses dans votre

partition, ou avec les commandes sur le panneau de Propriétés Lecture, ce qui change le

comportement d’une pause individuelle. Si vous spécifiez qu’une pause doit être suivie d’un écart
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grâce à l’une de ces méthodes, Sibelius le respectera lors de l’enregistrement de Live Tempo : un tap

pour lancer la pause, puis un autre pour lancer l’écart suivant la pause, et un troisième pour

signaler le temps suivant.

Sections répétées
Si une section de votre partition est répétée (ex. répétition de ligne de mesure ou repère de D.C. al

Coda), vous pouvez enregistrer une autre performance Live Tempo pour chaque exécution

musicale, et cela se réflète dans le graphique affiché dans Panorama. Si vous effacez toutefois Live

Tempo d’un passage répété, les données Live Tempo sont effacées de toutes les exécutions.

Ajouter des indications de tempo
Si vous ajoutez une nouvelle indication texte de Tempo ou repère de métronome à un passage de la

partition pour laquelle une performance Live Tempo a été enregistrée, la vitesse de lecture actuelle

de la partition ne changera pas à cet endroit si Lecture > Live Tempo est activé : la performance

Live Tempo prime les tempos référencés dans la partition. Vous verrez néanmoins que le

graphique Live Tempo s’actualise pour indiquer comment la performance Live Tempo correspond

au nouveau tempo écrit.

Pour appliquer une nouvelle indication de tempo dans la partition, vous devez effacer les données

Live Tempo – cf. Effacer Live Tempo ci-dessus.

Live Tempo et ReWire
Vous ne pouvez pas utiliser Live Tempo et ReWire en même temps : Live Tempo est désactivé

quand Sibelius est exécuté en mode ReWire.



4. Exécution et vidéo

342

4.8 Exécution enregistrée

b 1.4 Flexi-time™, 4.1 Utiliser du texte, 4.5 Interprétation, 9.5 Ouvrir des fichiers
MIDI.

Dans la réalité, une interprétation musicale ne correspond jamais exactement à ce qui est noté

dans la partition; elle est faite de toute une série de variations subtiles dans le tempo, les nuances et

le rythme impossible à produire, même par des fonctions aussi intelligentes que Espressivo,

Rubato ou Style rythmique (b 4.5 Interprétation).

Par conséquent, si vous fournissez à Sibelius une interprétation réelle, que ce soit un

enregistrement en temps réel via Flexi-time (b 1.4 Flexi-time™) ou en important un fichier

MIDI (b 9.5 Ouvrir des fichiers MIDI), il peut la préserver grâce à la fonction Exécution

enregistrée.

Exécution enregistrée conserve exactement la manière de jouer chaque note (même celles d’un

accord individuellement), avec les variations les plus fines de vélocité (l’intensité de la note), de

durée (le temps qu’elle est tenue), et le moment de l’attaque (la différence avec la pulsation).

Vous pouvez aussi modifier votre exécution, ou créer une exécution enregistrée d’une partition

saisie par d’autres moyens (par exemple la saisie pas-à-pas, celle alphabétique ou la numérisation

de partition imprimée) en utilisant le panneau Exécution de la fenêtre des propriétés ou la boîte

de dialogue de Exécution > Transformer l’exécution enregistrée.

Écouter l’exécution enregistrée
La fonction exécution enregistrée est activée par défaut pour toutes les partitions.

Pour l’activer ou la désactiver, choisissez Exécution > Exécution enregistrée (raccourci

Maj-L); le bouton de la barre d’outils s’allume lorsque Exécution enregistrée est activée, et apparaît

en gris lorsqu’elle ne l’est pas. Lorsque vous sauvegardez la partition, Sibelius se rappelle si vous

l’aviez activée ou pas.

L’exécution enregistrée est complètement séparée de l’interprétation de votre partition par Sibélius.

Par exemple, lorsque Exécution > Exécution enregistrée est activé (et lorsque des données

d’exécution sont enregistrées dans la partition), Sibelius joue la partition exactement comme elle a

été enregistrée. Tout ce qui est ajouté à la partition qui en affecterait normalement le volume ou la

durée- telles que les nuances, les soufflets et autres indications textuelles (comme les messages

MIDI), et des options comme Espressivo, Rubato et Style rythmique - ne sont pas prises en

compte, à moins qu’elles ne s’appliquent à des notes n’ayant aucune donnée d’exécution

enregistrée.

Par conséquent si, par exemple, dans un fichier MIDI importé, vous ajouter une nuance à l’une des

portées en utilisant du texte d’expression (b 3.1 Utiliser du texte), elle ne sera pas exécutée à

moins que vous ne désactiviez Exécution > Exécution enregistrée (raccourci Maj-L).

Inversement, si vous faites la saisie d’une partition en utilisant le mode pas-à-pas ou la saisie

alphabétique puis en faites la lecture, vous n’entendrez pas de différence entre l’exécution lorsque
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Exécution enregistrée est activé / désactivé, car aucune donnée d’exécution enregistrée n’est

sauvegardée dans la partition - cf. Créer des données d’exécution enregistrée ci-dessous .

Les indications de tempo, telles que le texte de tempo, les indications métronomiques et les lignes

de rit./accel. - sont toujours observées, que Exécution enregistrée soit activé ou pas.

Afficher les vélocités de l’interprétation enregistrée
Pour afficher les vélocités de l’interprétation enregistrée sauvegardées dans la partition, activez

Affichage > Vélocités de l’interprétation enregistrée. Cette option n’est disponible que lorsque

Exécution > Exécution enregistrée est activé. Les notes ayant des données d’exécution

enregistrée (et dont la case des propriétés de Vélocité (enreg.) est activée) affichent une colonne

verticale au-dessus de la portée, un peu comme les colonnes que vous voyez dans un tableau

graphique. La hauteur de la colonne représente la vélocité maximale possible (127) et la section

colorée partant du bas de la colonne représente la vélocité de l’exécution enregistrée pour la note

ou l’accord en question. Sibelius peut afficher les vélocités pour des notes seules ou des accords,

dans n’importe quel nombre de voix, de la manière suivante:

Modifier l’exécution enregistrée
Il y a trois façons principales de modifier les données d’exécution enregistrée :

* En modifiant directement les valeurs enregistrées pour chaque note dans le panneau Exécution
de la fenêtre des propriétés

Voix à une seule note Voix 1 accord

Voix 1 & 2 notes seules Voix 1 & 2 accords

Voix 1-4

La vélocité de notes seules est toujours indiquée. Lorsqu’aucune note n’est sélectionnée ou qu’au 

contraire elles le sont toutes, les vélocités les plus 

importantes et les moins importantes sont indiquées 

(respectivement en bleu foncé et en bleu clair). 

Sélectionner une tête de note individuelle permet de 

toujours indiquer la vélocité de celle-ci.

Lorsqu’elle n’est pas sélectionnée, la vélocité de la 

voix 1 est indiquée en bleu tandis que celle de la 

voix 2 est en vert.

Les voix 3 et 4 ont une colonne à part et se 

comportent comme les voix 1 et 2.

Lorsqu’elle n’est pas sélectionnée, la vélocité de la 

note avec la vélocité la plus importante dans 

chaque voix est indiquée.
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* En tirant sur les barres verticales affichées lorsque Affichage > Vélocités de l’exécution
enregistrée est activé

* En utilisant la boîte de dialogue Exécution > Transformer l’exécution enregistrée.

Propriétés
Vous pouvez utiliser le panneau Exécution de la fenêtre de Propriétés (raccourci Ctrl+Alt+P ou

zXP) pour modifier les données d’exécution enregistrée pour des notes individuelles, des

sélections multiples ou des passages sélectionnés. Ces contrôles ne sont disponibles que lorsque

Exécution > Exécution enregistrée est activé.

* La Vélocité (enreg.) est comprise dans l’étendue 0-127 127 est le plus fort, 0 le plus doux

* La Pos. départ (enreg.) est mesurée en tics ; 256 tics = 1 noire. Une valeur négative fait sonner

la note avant sa position notée dans la mesure (par ex. -64 la fera sonner une double croche plus

tôt que sa position écrite), et une valeur positive fait sonner la note après (par ex. 128 la fera

sonner une croche après sa position écrite). Vous pouvez même régler une note pour qu’elle soit

jouée dans une mesure différente de celle où elle est écrite, bien que généralement, vous ne ferez

que de petits ajustements qui affecte la sensation du rythme, pour obtenir par exemple une

sensation de relâchement ou de resserrement.

* La Durée (enreg.) est également mesurée en tics. Vous pouvez régler une note pour qu’elle aie

une durée arbitraire, et modifier sa durée ici n’affectera pas sa notation (donc vous pourriez

avoir une blanche écrite qui ne sonne que la durée d’une noire, ou même une noire écrite qui

sonne aussi longtemps qu’une blanche).

Pour modifier les données d’exécution enregistrée pour une note individuelle, sélectionnez

simplement la note et ajustez sa valeur dans le panneau Exécution. Vous pouvez sélectionner des

notes individuelles dans un accord et ajuster leurs données individuellement.

Si vous sélectionnez un passage ou plusieurs notes à la fois, les options du panneau Exécution
afficheront normalement --, indiquant que différentes valeurs sont enregistrées pour différentes

notes de la sélection (à moins que toutes les notes de la sélection aient les même données, auquel

cas elles s’afficheraient). Lorsque vous changez des données d’exécution enregistrée pour un

passage sélectionné, vous rendez en fait toutes les données identiques pour les notes sélectionnées.

Vous pouvez outrepasser l’un ou tous les paramètres d’exécution enregistrée pour des notes

individuelles en décochant simplement la case appropriée dans le panneau Exécution de la fenêtre

des propriétés - cf. Activez et désactiver Exécution enregistrée pour différentes
sections d’une partition ci-dessous.

Pour faire des transformations plus sophistiquées sur les données pour un passage sélectionné

(c’est-à-dire pour les manipuler de façon différente d’une simple activation / désactivation ou de

régler une valeur constante pour tout le passage), voyez ci-dessous Transformer l’exécution
enregistrée.

Modifier les vélocités de l’exécution enregistrée
Vous pouvez, pour modifier les vélocités de manière graphique, tirer sur les barres verticales

affichées lorsque Affichage > Vélocités de l’exécution enregistrée est activé. Avant de modifier

les vélocités, augmenter le niveau de zoom vous aidera à mieux voir ce que vous faites.
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* Pour modifier la vélocité d’une note individuelle (ou d’une note d’un accord), sélectionnez-la

puis cliquez et tirez sur la barre verticale vers le haut ou vers le bas.

* Pour régler la même vélocité pour toutes les notes d’un passage, sélectionnez le passage pour

lequel vous souhaitez régler les vélocités puis cliquez sur l’une des barres verticales ; toutes les

autres barres seront réglées sur la nouvelle valeur.

* Pour sélectionner différentes vélocités le long d’un groupe de notes, ne sélectionnez pas un

“passage” : à la place, cliquez sur la barre verticale de la première note dont vous souhaitez

modifier la vélocité et - en maintenant le bouton de la souris enfoncé - tirez-le sur les barres

verticales des notes suivantes. Tandis que le pointeur de souris passe au-dessus des barres

verticales, les vélocités sont réglées en fonction de la hauteur à laquelle le pointeur les croise. Il

est possible de créer des courbes expressives le long d’un passage de cette manière. (Notez bien

que si un passage contient des accords, toutes les notes de l’accord seront réglées sur la même

vélocité.)

* Si vous souhaitez modifier les vélocités des notes de, par exemple, la voix 2 uniquement, filtrez la

voix 2 (b 5.7 Rechercher et filtrer), puis utilisez l’une des méthodes mentionnées.

* Pour changer la distance entre les barres et le haut ou le bas de la portée, gardez Ctrl ou enfoncé

X et déplacez une des barres verticales avec la souris. Cette action modifie la position de toutes

les barres verticales de cette portée dans toute la partition et la distance depuis la portée peut

aller jusqu’à 20 dents.

Comme pour toutes les opérations dans Sibelius, si vous changez d’avis après avoir modifié les

vélocités, choisissez simplement Édition > Annuler (raccourci Ctrl+Z ou XZ).

Transformer l’exécution enregistrée 
La boîte de dialogue Exécution > Transformer l’exécution enregistrée (raccourci

Ctrl+Shift+Alt+L ou xzXL) vous permet d’appliquer des transformations complexes aux

données d’exécution enregistrées dans votre partition.

Pour utiliser cette boîte de dialogue, sélectionnez le passage que vous souhaitez transformer et

choisissez Exécution > Transformer l’exécution enregistrée (si vous ne faites pas de sélection, il

vous sera demandé si vous souhaitez que l’opération s’applique à toute la partition).



4. Exécution et vidéo

346

La boîte de dialogue est divisée en deux pages, Vélocités et Durées. Vous pouvez définir une

transformation sur l’une ou sur les deux pages à la fois, vous pouvez donc modifier simultanément

les vélocités et les durées si vous le désirez. Les options sont les suivantes:

* L’onglet Vélocités:

% Laisser tel quel: sélectionnez cette option si vous ne souhaitez faire des transformations que

sur l’onglet Durées

% Vélocité constante (étendue 0-127) : règle toutes les notes de la sélection sur la même vélo-

cité

% Plus fort : ajoute la vélocité à toutes les notes, jusqu’à la valeur maximale (127)

% Plus doux : soustrait la vélocité spécifiée de toutes les notes, jusqu’à un minimum de 0

% Crescendo / Diminuendo : spécifie la vélocité souhaitée de la première et de la dernière

note de la sélection, et Sibelius adaptera les vélocités des notes interposées pour produire un

crescendo ou un diminuendo.

% Échelle : compresse ou élargit les vélocités des notes de la sélection de façon à ce qu’elles ne

dépassent pas un minimum et un maximum spécifié ; cela permet de rendre la gamme

dynamique plus étroite ou plus large.

* L’onglet Durées :

% Laisser tel quel : sélectionnez cette option si vous ne souhaitez faire des transformations que

sur l’onglet Vélocités

% Réduire / augmenter les durées : réduit ou augmente les durées de toutes les notes de la

sélection du pourcentage spécifié, ce qui vous permet de rendre leur durée enregistrée plus

longue ou plus courte

% Définir la durée de note à x % de leur durée écrite: modifie les durées enregistrées des

notes sélectionnées à un pourcentage donné de leur durées écrites (c-à-d quelque soit leur

durée enregistrée actuelle)

% Durées constantes : règle la durée enregistrée de chaque note à un nombre spécifié de tics

(256 tics = 1 noire)

% Avancer : avance la position de départ des notes du nombre spécifié de tics ; vous pouvez

utiliser cette option pour faire sonner la musique “avant le temps”

% Reculer : recule la position de départ des notes du nombre spécifié de tics ; vous pouvez

utiliser cette option pour faire sonner la musique “derrière le temps”

% Avancer et reculer les positions de départ par rapport à la notation : vous permet

d’exagérer ou de réduire l’effet du décalage des positions de départ pour le passage

sélectionné. L’option Conserver les durées (cochée par défaut), comme son nom

l’indique, vous permet de choisir si vous souhaitez conserver les durées originales. Conserver

celles-ci a pour effet de faire sonner la musique plus ou moins avant ou derrière le temps, c-à-

d plus “relâché” ou plus “serré”.

Pour appliquer les transformations choisies, cliquez sur OK puis appuyez sur P pour entendre le

résultat.
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Créer des données d’exécution enregistrée
Si vous n’avez pas créé votre partition en utilisant Flexi-time ou en important un fichier MIDI,

aucune donnée d’exécution enregistrée n’existera. Vous pouvez cependant créer facilement des

données d’exécution enregistrée de la manière suivante :

* Sélectionnez le passage de musique pour lequel vous souhaitez créer des données d’exécution

enregistrée

* Ouvrez le panneau Exécution de la fenêtre des propriétés

* Cochez les cases à côté de Vélocité (enreg.), Pos. départ (enreg.) et Durée (enreg.). Sibelius

crée automatiquement des données d’exécution enregistrée avec des valeurs par défaut

raisonnables (tous les décalages de position de départ sont à 0, les durées sont réglées sur la

longueur de tics équivalente aux durées écrites, et les vélocités sont réglées sur 80).

Vous pouvez ensuite modifier les données d’exécution enregistrée de la manière habituelle.

Activez et désactiver Exécution enregistrée pour différentes sections d’une 
partition

Naturellement, vous pouvez activer et désactiver Exécution > Exécution enregistrée pour

basculer entre l’exécution enregistrée et l’interprétation de Sibelius. Cependant, dans certaines

circonstances vous souhaiterez peut-être désactiver les données de l’exécution enregistrée pour

certaines parties de la partition. Pour faire cela:

* Sélectionnez le passage pour lequel vous souhaitez désactiver les données d’exécution

enregistrée

* Ouvrez le panneau Exécution de la fenêtre des propriétés

* Décochez une ou plusieurs des cases à côté de Vélocité (enreg.), Durée (enreg.) et Pos.
départ (enreg.).

Vous pouvez désactiver ces options de manière indépendante, avec différents effets sur l’exécution.

Si vous décochez à la fois les case Durée (enreg.) et Pos. départ (enreg.) alors les fonctions

Rubato et Style rythmique intelligentes de Sibelius feront l’interprétation ; si vous décochez la case

Vélocité (enreg.), Sibelius utilisera Espressivo pour l’exécution, et répondra au texte d’expression,

etc. Cela signifie que vous pouvez sélectionner quels paramètres de l’exécution enregistrée vous

souhaiter conserver, et quels paramètres vous préférez laisser à l’interprétation de Sibelius.
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4.9 Dictionnaire de l’exécution

b 4.1 Utiliser du texte, 4.17 Messages MIDI, 4.18 SoundWorld™.

Quand il exécute une partition, Sibelius lit et interprète non seulement des indications textuelles

(telles que mf, pizz. et legato), mais aussi beaucoup d’autres indications, telles que les lignes (par

ex. les lignes d’octavas, les liaisons de phrasé, les trilles, les indications de pédale), les articulations

(par ex. staccato, tenuto, accent), et les symboles.

Bien qu’ en général cela ne soit pas nécessaire, vous pouvez modifier précisément la manière dont

les indications agissent sur l’exécution dans la boîte de dialogue Exécution > Dictionnaire de

l’exécution, et même ajouter vos propres indications dans le dictionnaire. La boîte de dialogue se

divise en six pages, dans lesquelles se retrouvent différents types d’éléments qui affectent

l’exécution:

* Texte de portée, pour exécuter des instructions s’appliquant à une seule portée, par ex. ff,

legato

* Texte de système, pour des instructions qui s’appliquent à tous les instruments, par ex. Fast,

Swing, Adagio
* Lignes de portée, pour les lignes de portées qui s’appliquent à une seule portée, par exemple les

trilles, les lignes d’octava, les liaisons de phrasé, les soufflets

* Articulations, par ex. staccato, tenuto. Notez que les trémolos d’une note et les roulements sont

aussi traités dans cette page.

* Têtes de note, pour les effets produits par les têtes de notes, par exemple les harmoniques, les

notes fantômes

* Symboles, par ex. les “scoops”, “falls”, mailloches et baguettes pour les percussions.

Chacune de ces pages est décrite en détail ci-dessous.
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La page Texte de portée

La liste des mots se trouve à gauche de la boîte de dialogue. Vous pouvez en changer l’ordre en

cliquant sur les boutons Vers le haut et Vers le bas; bien que cela n’ait aucun effet sur la manière

dont Sibelius exécute la partition, respecter l’ordre alphabétique est ce qu’il y a de plus pratique;

mais que cela ne vous empêche pas de vous amuser en cliquant sur ces boutons.

Pour modifier un mot, cliquez sur Renommer, qui affiche une simple boîte de dialogue dans

laquelle vous pouvez changer le texte. Pour ajouter un nouveau mot, sélectionnez un mot dont

l’effet est similaire à celui que vous souhaitez créer puis cliquez sur Nouveau, qui affichera une

simple boîte de dialogue dans laquelle vous pouvez spécifier le nouveau mot. Pour copier un mot

existant, cliquez sur Dupliquer. Pour enlever un mot, cliquez sur Suppr.

Chaque mot peut aussi se voir attribuer une combinaison des options suivantes:

* Casse prise en compte: si la casse est sans importance comme c’est le cas en général (pour que

“swing”, “Swing” ou “SWING” soit compris de la même manière), cette option doit être désactivée

* Mot entier signifie que le mot n’est pas une abréviation. Cependant, la plupart des termes

musicaux peuvent être abrégés, de sorte qu’en général cette option est désactivée. Par exemple,

Sibelius installera un pizzicato chaque fois qu’il sera confronté à un mot commençant par les

lettres “pizz”, de sorte que “pizz”, “pizz.” (avec un point) et “pizzicato” produiront le même effet.

(“pizza” fonctionnera aussi mais il y a peu de chance qu’il figure dans une partition.) Ne placez

pas de point à la fin du mot dans la boîte de dialogue s’il s’agit d’une abréviation. Si par contre le

mot n’est pas une abréviation, activez cette option.

* Les expressions régulières placées dans des chaînes de textes (strings) correspondent à certaines

actions, un sujet à éviter pour les cardiaques. En principe Expression régulière ne devrait

jamais être activée – Si cependant vous êtes curieux, voyez ci-dessous les Expressions
régulières.
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Pour déterminer l’effet sur l’exécution d’un mot spécifique, sélectionnez-le, puis choisissez-en le

type d’Effet dans la liste de droite. Le groupe Valeurs des effets affiche automatiquement les

options proposées pour chaque type d’Effet:

* Changement de contrôleur permet de régler un contrôleur MIDI sur une valeur spécifique:

% Contrôleur MIDI spécifie le numéro du contrôleur MIDI à changer (par ex. le contrôleur 1
est une modulation, le contrôleur 64 est une pédale de legato, le contrôleur 91 est une

réverbération, etc...)

% Valeur du contrôleur spécifie la valeur attribuée au contrôleur MIDI choisi, ; 0 est le

minimum et 127 est le maximum.

* Nuance permet de changer l’élément principal de la nuance ; c’est l’effet utilisé pour des

indications telles que mf, ff et fort:

% Nuance spécifie le volume auquel les notes qui suivent doivent être jouées, en utilisant une

échelle de 0 à 127. Selon le périphérique d’exécution, ce qui sera utilisé sera soit la vélocité de

la note, ou une expression MIDI (contrôleur 11), ou une modulation (contrôleur 1), ou

quelque chose d’autre.

% Attaque spécifie l’acuité de l’attaque des notes avec cette nuance en utilisant une échelle de 0
à 127. L’effet n’est audible qu’en fonction du périphérique d’exécution.

% Changement de Son ID permet de spécifier un son ID en option en plus d’un changement

de la nuance; cf. Changements de sons ID ci-dessous.

* Changement de la nuance permet de changer la nuance en cours d’une note ou des notes

suivantes (plutôt que de régler celle-ci en valeur absolue, comme Nuance le fait):

% Nuance n% de la nuance en cours permet de spécifier le changement de nuance en terme

de pourcentage de la nuance préexistante

% Attaque n% de l’attaque en cours permet de spécifier le changement d’attaque en terme

de pourcentage de l’attaque préexistante

% Changement de Son ID permet de spécifier un son ID en option en plus d’un changement

de la nuance; cf. Changements de sons ID ci-dessous.

% Changer pour est une liste avec deux choix, soit une note seulement (ce qui signifie que la

nuance affecte seulement la note à laquelle le texte d’instruction est attaché) ou toutes les
notes suivantes (ce qui signifie que les changements s’appliquent jusqu’à ce qu’apparaisse la

nuance suivante)

* Enveloppe de la nuance s’applique pour les effets de nuance qui diminuent ou augmentent

dans le temps, par ex. sfz ou fp:

% Nuance de départ spécifie la nuance au début de la note

% Variation détermine le temps mis par la nuance pour revenir au niveau de départ ou à la

Nuance finale, exprimée en pourcentage de la longueur de la note

% Nuance finale spécifie en option la nuance à la fin de la note.

* Changement de programme permet de changer de programme MIDI, pour pouvoir changer

le son utilisé par une portée. En général, évitez d’utiliser ce procédé: utilisez soit des

changements d’instrument (b 2.18 Instruments et portées) ou un changement de son ID
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(cf. ci-dessous). Si vous avez malgré tout une bonne raison de le faire, voici à quoi servent les

options:

% Programme spécifie le numéro de programme, en utilisant un nombre compris entre 0 et

127

% Envoyer le changement de banque permet de choisir si un changement de banque MIDI

sera envoyé ou non en plus d’un changement de programme. Si vous activez ceci, alors

Banque supérieure et Banque inférieure sont activés.

% Banque supérieure et Banque inférieure permettent de régler les éléments les plus

signifiants (“supérieur”) et les moins signifiants (“inférieurs”) requis pour réaliser un

message de changement de banque MIDI.

* Changement de Son ID permet d’ajouter ou d’enlever des techniques de jeu du son en cours.

On peut choisir un ou plusieurs éléments du son ID dans le menu – cf. Changements de
sons ID ci-dessous.

La page Texte de système

La page Texte de système présente des options similaires à celles de la page Texte de portée (cf.

La page Texte de portée ci-dessus ), mais les types d’Effets sont différents:

* Métronome est utilisé pour spécifier la signification des symboles placé à gauche du signe égal

dans l’indication métronomique. Par exemple, dans l’indication métronomique “q = 120”, le

symbole de noire correspond à la lettre “q” dans les polices musicales de Sibelius, de sorte que q
= est défini pour utiliser l’effet Métronome et est réglé sur 1 pulsations (noires). De la même

manière, avec “e = 160” la croche correspond à “e”, de sorte que e = est défini pour 0.5
pulsations (noires). Puisque les durées standard des notes sont définies automatiquement, il

est inutile de changer les mots concernant le Métronome, sauf pour inventer de nouvelles

durées.

* Reprise s’utilise pour spécifier l’effet d’un mot lors de l’exécution de sections répétées d’une

partition. Par exemple, un mot dont l’effet “Reprise” est D.C. al Coda entraîne le retour au début
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de la partition, et l’exécution jusqu’au mot al Coda; l’effet “Reprise” de ce dernier implique le

déplacement au mot Coda, dont l’effet “Reprise” signifie cette fois qu’il s’agit du début de la

coda elle-même. Les mots Reprise sont les seuls prédéfinis qui utilisent l’option Expression
régulière – cf. Expressions régulières ci-dessous. Comme pour les mots Métronome, il

n’est pas nécessaire de régler les mots Reprise, parce que tous ceux usités sont réglés

automatiquement. Pour en savoir plus sur la manière dont Sibelius exécute les reprises,

b 4.6 Reprises.

* Les mots Style rythmique changent le réglage de style rythmique de la partition à l’endroit

précis où le mot est rencontré. Par exemple, le mot “Swing” est défini avec le style rythmique

Swing. Pour en savoir plus sur le style rythmique, b 4.5 Interprétation.

* Rit./Accel. Les mots Rit./Accel. permettent de spécifier un rit. ou accel., bien qu’il soit

recommandé d’utiliser les lignes prévues à cet effet qui offrent un meilleur contrôle – cf. Rit. et
accel. à la page 302. Si vous décidez de définir un mot Rit./Accel., réglez Faire varier le
tempo de n% du tempo en cours sur la valeur appropriée, et réglez Sur n pulsations
(noires) sur la longueur de temps nécessaire pour réaliser la variation qui suit l’instruction.

* Les mots Tempo permettent de régler un tempo spécifique. Par exemple, “Allegro” est défini sur

Régler le tempo à 120 noires/min. et “Lento” sur Régler le tempo à 60 noires/min.

* Les mots Échelle de tempo permettent de régler le tempo en cours selon un pourcentage

spécifié. Par exemple, “Plus lent” est défini pour réduire le tempo à 90% du tempo original,

tandis que “Plus vite” règle le tempo à 110% du tempo original.

La page Lignes de portée

La page Lignes de portée permet de spécifier un changement de Son ID pour chaque type de

ligne existante dans la partition. Par exemple, pour une liaison de phrasé on pourra assigner un

changement de son ID +legato; le périphérique d’exécution utilisera alors un son bien lié quelque

soit la portée, violon, trompette, etc... – cf. Changements de sons ID ci-dessous
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À défaut de cela, si Sibelius ne détecte pas un son pour exécuter le changement de son ID spécifié,

ou si aucun changement de son ID n’est spécifié, il appliquera les effets par défaut proposés en

dessous de si aucun son ID prévu n’est disponible. Voici quels sont les choix possibles:

* Ajuster les durées des notes sous la ligne s’utilise pour les liaisons en produisant l’effet de

legato par allongement des notes, excepté la dernière qui est raccourcie (ce qui la sépare de la

note suivante). Pour changer ces options:

% si vous voulez changer les longueurs des notes sous la ligne, activez Ajuster la durée de n%;

les durées supérieures à 100% augmentent la durée, celles inférieures à 100% la réduisent

% pour réduire la dernière note sous la ligne, activez Écourter la dernière note de n

secondes.

* Transposer vers le haut/vers le bas de 1 ou 2 octaves est utilisé pour les lignes d’octavas (8va,

15ma, etc.) en réglant la transposition vers le haut ou vers le bas, de une ou deux octaves.

* Dérouler l’accord vers le haut/vers le bas en n millisecondes s’appliquent aux lignes d’arpège,

ou aux lignes dont le fonctionnement est similaire celui de l’arpège.

* Jouer les crescendos ou les diminuendos concerne les soufflets. Vous pouvez déterminer

l’effet précis lors de l’exécution d’un soufflet en particulier en le sélectionnant et en utilisant les

options du panneau Exécution des propriétés (cf. Soufflets à la page 300).

* Jouer les trilles est utilisé pour les trilles. Vous pouvez spécifier la vitesse de l’exécution et

l’intervalle d’un trille spécifique en le sélectionnant dans la partition et en utilisant les options

du panneau Exécution des propriétés (cf. Trilles à la page 301).

* Jouer la pédale de legato s’utilise pour les lignes de pédale.

* Jouer les glissando/portamento concerne les lignes de gliss. et port. Vous pouvez spécifier la

vitesse de l’exécution et l’intervalle d’une ligne spécifique en la sélectionnant et en utilisant les

options du panneau Exécution des propriétés (cf. Gliss. et port. à la page 303).

* Exécuter les bends de guitare est pour les lignes de bend (cf. Bend à la page 139).

* Pas d’effet lors de l’exécution signifie que Sibelius ignore la ligne durant l’exécution.

N’importe laquelle de ces options peut s’appliquer à n’importe quelle ligne, si bien qu’une liaison

pourra se comporter comme une ligne d’octave ou un bend de guitare comme un arpège, si

nécessaire.

Notez cependant que les lignes ajustables individuellement via le panneau Exécution de la fenêtre

des propriétés – c’est-à-dire les soufflets, les trilles, les lignes de gliss. et de port. – ne peuvent être

l’être effectivement que si elles sont basées sur le type de ligne approprié. En d’autres mots, même

si vous demandez à Sibelius d’exécuter par exemple une ligne Cadre comme un soufflet, elle sera

toujours exécutée par défaut et en ajuster les effets de l’exécution dans la fenêtre des propriétés sera

impossible.
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La page Articulations

Cette page permet de spécifier un Changement de son ID pour chaque type d’articulation ou de

trémolo. Par exemple, on pourra associer aux articulations de coup d’archet, talon ou pointe, les

changements de sons ID +upbow et +downbow, qui seront exécutés par le périphérique

d’exécution s’il les possède– cf. Changements de sons ID ci-dessous.

À défaut de cela, si Sibelius ne détecte pas un son pour exécuter le changement de son ID spécifié,

ou si aucun changement de son ID n’est spécifié, il appliquera les effets par défaut proposés en

dessous de si aucun son ID prévu n’est disponible. Voici quels sont les choix possibles:

* Jouer les notes répétées s’appliquent aux trémolos et aux roulements (z sur la hampe).

On peut choisir des notes exécutées de manière mesurée – dans ce cas choisissez Subdiviser et

réglez n fois sur la valeur appropriée – ou non mesurées pour des notes répétées le plus vite

possible.

* Ajuster les nuances, attaque et/ou durée s’appliquent à la plupart des autres articulations.

Par exemple, par défaut les staccatos raccourcissent la note de 50%, les accents augmentent la

nuance de 50%, un coup d’archet poussé augmente la nuance de 10% et raccourcit la note un

peu.

% Pour changer la nuance de la note sur laquelle l’articulation apparaît, activez Ajuster la
nuance de n% de la nuance en cours et réglez la valeur qui convient.

% Pour changer l’attaque de la note sur laquelle l’articulation apparaît, activez Ajuster
l’attaque de n% de l’attaque en cours et réglez la valeur qui convient.

% Pour changer la durée de la note sur laquelle l’articulation apparaît, activez Ajuster la durée
de n% de la durée écrite. (les points d’orgue possédant leurs propres options ne sont pas

concernés)

* Étendre la durée de n de la durée écrite pour les points d’orgue. Par défaut, un point d’orgue

normal est réglé sur 1,5 fois la durée écrite, un point d’orgue long (carré) sur 1,75 fois, et un

point d’orgue court (triangulaire) sur 1,25 fois, mais ces réglages peuvent être modifiés à volonté.
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Vous pouvez aussi Ajouter un espace de n% de durée écrite, ce qui ajoutera un degré de

silence suivant le point d’orgue avant la prochaine note.

* Pas d’effet lors de l’exécution pour que Sibelius ignore l’articulation lors de l’exécution.

Comme pour les lignes de portée, toutes ces options peuvent s’appliquer indifféremment à toute

articulation, si bien qu’il est possible de faire exécuter un staccato comme un point d’orgue.

La page Têtes de note

La page Têtes de note permet de spécifier un Changement de son ID pour chaque type de tête

de note de la partition. Par exemple, une tête de note en losange devrait être associée au

changement de son ID +harmonique, pour que lors de l’exécution, le son harmonique soit choisi

par le périphérique d’exécution si ce dernier possède ce son – cf. Changements de sons ID ci-

dessous.

À défaut de cela, vous pouvez définir pour chaque tête de note un effet à exécuter par défaut. Dans

le cas des têtes de notes, vous pouvez seulement spécifier une tête de note pour ajuster la nuance en

cours; ce procédé s’utilisera pour les notes “fantômes” dans la musique pour guitare qui sont

d’habitude écrites avec une tête en forme de croix et sonnent moins fort que les notes normales.
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La page Symboles 

La page Symboles permet de spécifier un Changement de son ID pour chaque type de symbole

de la partition. Par exemple, un symbole “fall” sera associé à un changement de son ID +fall, qui

entraînera automatiquement (par ex.) un son de trompette baissé sur le périphérique d’exécution,

si celui-ci possède ce son – cf. Changements de sons ID ci-dessous. Aucun autre effet

d’exécution n’est disponible pour les symboles.

Changements de sons ID
Si vous souhaitez une introduction aux sons ID,

b 4.18 SoundWorld™.

Les changements de sons ID permettent d’ajouter ou d’enlever

une ou plusieurs techniques de jeu au son en cours

d’utilisation sur la portée et cela n’importe où. Par exemple, le

mot “pizz” peut être défini pour produire un changement de

son ID +pizzicato, tandis que “arco” sera -pizzicato. On peut

aussi définir dans le dictionnaire un élément à ajouter ou à

retirer simultanément, par ex. -mute +sul ponticello.

Pour définir un changement de son ID, vous pouvez soit taper

dans le cadre les éléments du son ID à ajouter ou enlever, ou

les choisir dans le menu parmi les éléments habituels des

sons ID.

Pour ajouter un élément, ajouter + directement devant, sans

espace entre; de la même manière pour enlever un élément, ajouter -. Pour enlever tous les

éléments en cours, tapez [réinitialiser] (avec les parenthèses droites).

Sur les pages Texte de portée et Symboles, vous pouvez spécifier si le changement de son ID

prendra effet Jusqu’au changement suivant de son ID, Jusqu’au début de la note suivante,

ou Jusqu’à la fin de la note suivante. Normalement un changement de son ID agit jusqu’à une
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autre instruction inverse (par ex. l’instruction “sourdine”, ou un symbole de “timbre” pour une

caisse claire), mais il est parfois nécessaire de placer un changement de son ID qui agira pour une

seule note (par exemple les symboles “scoop” ou “fall”, ou une indication de texte au-dessus d’une

seule note pour une portée de percussion à sons indéterminés).

De la même manière sur la page Lignes de portée vous pouvez spécifier si le changement de son

ID agira jusqu’à Jusqu’à la fin de la ligne (qui est par ex. le réglage pour les lignes de trille) ou

Jusqu’à la fin de la dernière note sous la ligne (qui est par ex. le réglage pour les lignes de

phrasé, les lignes d’octavas, les soufflets, etc...).

Notez que définir simplement un nouveau changement de son ID dans Exécution > Dictionnaire
ne garantit pas qu’il sera exécuté – Sibelius peut seulement exécuter ces effets s’ils sont disponibles

dans la configuration d’exécution en cours – mais ce qui est formidable avec les sons ID, c’est qu’ils

sont indépendants d’un périphérique, de sorte que si le son est disponible sur un autre ordinateur

ou sur une configuration ultérieure, Sibelius l’exécutera automatiquement au bon endroit.

À quel moment les éléments du dictionnaire prennent-ils effet?
Lorsque vous insérez des mots du dictionnaire dans votre partition, gardez à l’esprit que Sibelius

traite les mots des listes de Texte de portée et de Texte de système différemment.

Les mots en texte de système (par ex. les indications de tempo ou de style rythmique) prennent

effet au début de la mesure à laquelle ils sont attachés.

Les mots en texte de portée (par ex. les nuances et les mots tels que pizz.) prennent effet sur la note

à laquelle ils sont attachés; les lignes de portées affectent de manière similaire l’exécution à partir

de l’endroit où elles commencent jusqu’à l’endroit où elles se terminent.

Expressions régulières
Les expressions régulières définissent, à l’aide de symboles ayant une signification spéciale, des

éléments à retrouver dans une chaîne textuelle. Sibelius utilise des expressions régulières pour

retrouver des termes utilisés pour l’exécution de structures de répétition telles que D.C. al Fine et

D.C. al Coda (b 4.6 Reprises).

Vous pouvez utiliser des expressions régulières dans le dictionnaire vous-même, mais soyez très

prudent - rien n’est plus facile que d’en créer une qui empêchera l’exécution de tout autre mot de la

partition (par ex. l’expression régulière a correspond à toute chaîne textuelle contenant un a, et ^
ou $ peuvent correspondre à tout).

* ^ définit le début d’une chaîne, par ex. ^au début; cf.ci-dessous

* $ définit la fin d’une chaîne, par ex. Amen$; cf. ci-dessous

*  . remplace n’importe quel caractère, par ex. c.t (retrouverait cat, cbt, cct, cdt etc!); pour

rechercher un point, utilisez \.

* * correspond à n’importe quel nombre d’occurrences du caractère précédent (ou du groupe de

caractère entouré de crochets [ ]). Cela comprend également l’absence d’occurrence, par

conséquent l’expression régulière a* correspond également à la chaîne b, en plus de a, aaaaa,

etc. Une expression régulière fort utile est.* qui signifie “correspondre à tout”, vous pouvez donc

écrire ^début.*fin$, qui retrouvera tout ce qui se trouve entre début et fin
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* + correspond à une ou plusieurs occurrences du caractère précédent, l’expression régulière a+
retrouve donc les chaînes a, aaaaa et baaa, mais pas b ou une chaîne vide

* [ ] sont les opérateurs de groupement, signifiant “correspondre à n’importe quel caractère dans

le groupe”, vous pouvez donc retrouver les nombres avec [0-9]. Les signes de ponctuation

perdent leur signification spéciale lorsqu’ils sont entre ces crochets, vous pouvez donc écrire des

choses telles que D[.$S]* al Coda

* \xNN correspond au caractère hexadécimal NN

* (x)|(y) sont les opérateurs de groupement étendus où la corde doit correspondre soit à x ou y.

Vous pouvez les utiliser pour retrouver des mots entiers, par ex. (pomme)|(banane)

Les expressions régulières correspondent à n’importe quelle partie d’une chaîne, par conséquent a
correspond tant appointement qu’à chat. Pour correspondre explicitement à un a isolé, vous

devez ajouter les balises de début et de fin: ^a$

Beaucoup de signes de ponctuation (. $ ^ [ ] ( ) * + \) ont une signification spéciale dans les

chaînes, et pour qu’ils leur correspondent littéralement (c-à-d pour retrouver une chaîne

contenant l’un de ces caractères), ils doivent être précédés d’un \

Copier les entrées du dictionnaire dans d’autres partitions
Après avoir édité les termes d’un dictionnaire pour l’exécution, il est possible d’en transférer la

forme mise à jour vers d’autres partitions. Exportez simplement le style maison de la partition de

laquelle vous avez modifié le dictionnaire, puis importez-le dans la nouvelle partition –

b 8.8 Style maison pour en savoir plus – ou sauvegardez votre partition en tant que papier à

musique – b 2.23 Papier à musique.
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4.10 Vidéo

b 4.1 Utiliser du texte, 4.11 Code temporel et points de montage.

Cet article explique comment relier une vidéo numérique à une partition, pour pouvoir composer

sur des images avec Sibelius.

Pouvoir composer directement avec la vidéo synchronisée est extrêmement utile à la fois pour les

compositeurs professionnels et dans l’enseignement. Beaucoup d’écoles de musique ont des

programmes avec des modules dans lesquels les étudiants doivent composer de la musique sur de

la vidéo; Sibelius propose une plateforme autonome dans laquelle il est possible de composer, de

réaliser et d’imprimer ses travaux.

Ajouter une vidéo
Pour ajouter une vidéo à une partition :

* Choisissez Exécution > Vidéo et Minutage > Ajouter une vidéo. Une boîte de dialogue

apparaît vous demandant de localiser le fichier vidéo à ajouter à la partition. Une fois le fichier

trouvé, cliquez sur Ouvrir.

* La vidéo apparaît dans la fenêtre vidéo de Sibelius, avec le nom de la vidéo dans la barre de titre

de la fenêtre.

Enlever une vidéo
Pour enlever une vidéo d’une partition:

* Choisissez Exécution > Vidéo et Minutage > Enlever une vidéo.

* Sibelius vous avertit que la vidéo ne va plus être associée à la partition et vous permet d’annuler

l’opération si vous le souhaitez.

Synchronisation
Une fois la vidéo ajoutée à la partition, la synchronisation avec la partition sera maintenue

constamment avec la partition, ainsi que le moment d’affichage, au fur et à mesure que la ligne

d’exécution change de position. Cela signifie que vous pouvez facilement passer d’un point à l’autre

de la vidéo en utilisant le curseur temporel de la fenêtre de lecture, ainsi que les boutons avance et

marche arrière rapide.

Enfoncés d’un seul coup, les boutons marche-arrière et avance rapide (raccourcis [ et ]) entraînent

un déplacement précis de 0,2 secondes; les maintenir enfoncé provoquent une accélération. Selon

les formats d’ordinateur et de vidéo, le rembobinage arrière de la vidéo peut sembler plus lent que

celui de l’avance rapide. Pour une précision maximale lors du déplacement dans la vidéo, utilisez

Maj-[ et Maj-] pour avancer dans la vidéo d’une seule image à la fois.

Exemples de vidéos
Sibelius propose un éventail de courtes vidéos idéales pour l’apprentissage de la composition dans

le cadre de projet multimédia sur www.sibeliuseducation.com.

http://www.sibeliuseducation.com/
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Formats de fichier 
Sibelius jouera toute vidéo dont le format est accepté par votre système d’exploitation. Sous

Windows cela comprend .avi, .mpg, .wmv et, si vous avez QuickTime installé, les fichiers. mov.

Les utilisateurs Mac pourront jouer les fichiers .avi, .mpg et .mov. Sibelius nécessite aussi que les

codecs nécessaires soient installés sur le système pour pouvoir jouer les fichiers vidéos

sélectionnés. Sinon certains fichiers avec ces extensions ne pourront être ouverts, alors que

d’autres de la même extension s’ouvriront sans problème. Si cela se produit, il est probable que le

problème soit identique avec les autres lecteurs vidéo installés sur votre ordinateur, preuve de

l’absence du codec adéquat. Si Sibelius n’arrive pas à reconnaître le format d’un fichier, il vous en

informera et la vidéo ne sera pas attachée à la partition.

Sauvegarder et ouvrir des partitions avec des fichiers vidéo
Quand vous sauvegardez une partition avec vidéo ajoutée, Sibelius sauvegarde l’emplacement du

fichier dans la partition. Pour pouvoir donner votre partition à un autre utilisateur de Sibelius,

vous devez aussi fournir le fichier vidéo lui-même si vous voulez que l’utilisateur puisse le voir (la

vidéo n’est pas intégrée dans le fichier Sibelius).

Quand vous ouvrez une partition avec vidéo ajoutée, Sibelius recherche d’abord le fichier vidéo

dans le dossier dans lequel il était ouvert. S’il ne trouve pas le fichier vidéo, il vous demandera si

vous souhaitez le localiser manuellement. Si vous cliquez sur Oui, une boîte de dialogue apparaît

dans lequel vous devez réentrer le nouveau chemin d’accès au fichier. Si vous cliquez sur Non,

alors Sibelius n’essaiera pas de jouer la vidéo.

Masquer et afficher la fenêtre de vidéo
Quand vous ajoutez une vidéo à une partition, Sibelius en affiche automatiquement la fenêtre.

Si vous désirez masquer ou afficher la fenêtre de vidéo, choisissez Fenêtre > Vidéo (raccourci

Ctrl+Alt+V ou zXV). Un bouton de la barre d’outils permet aussi d’activer ou de désactiver la

fenêtre vidéo. 

Masquer la vidéo n’enlève pas la vidéo de la partition. En fait, la vidéo continue la lecture en même

temps que la partition tout en restant invisible, de sorte que vous pouvez entendre la piste sonore

de la vidéo. Pour enlever définitivement la vidéo de la partition, cf. ci-dessous Enlever une
vidéo.

Point de montage

Taille à moitié Curseur de volume

Taille réelle

Double taille

Plein écran
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Réglage du niveau de volume de la vidéo
Sibelius vous permet d’ajuster le volume de la piste sonore des vidéos indépendamment de la

partition en déplaçant le curseur de volume au bas la fenêtre de vidéo. Quand il est positionné tout

à fait à gauche, la piste sonore de la vidéo est complètement silencieuse. 

Réglage de la taille de la fenêtre de vidéo
La fenêtre de vidéo propose quatre tailles préréglées à sélectionner pour afficher la vidéo aux

dimensions qui conviennent. Ces quatre boutons se trouvent en bas de la fenêtre de vidéo (cf. ci-

dessus) et des options figurent dans le sous-menu Exécution > Vidéo et Minutage. La vidéo peut

être réglée à 50%, 100% ou 200% de sa taille originale, ou ajustée en mode Plein écran (cf. ci-

dessous).

Mode plein écran
Utiliser le mode plein écran pour les vidéos est bien pratique, mais des problèmes peuvent

survenir en fonction du codec de la vidéo, du matériel et du logiciel utilisés pour restituer la vidéo.

* Si vous avez un système bi-écran, il peut arriver qu’il soit impossible de choisir l’écran pour la

vidéo, ce qui empêche de la voir sur un écran tandis que la partition apparaît sur l’autre. D’autres

problèmes peuvent apparaître par exemple la ligne de lecture qui n’apparaît pas convenablement

ou la fenêtre de vidéo apparaissant sur un écran avec des parasites tandis que la vidéo apparaît

en plein écran sur l’autre, etc.

* Sous Windows, si vous utilisez un codec QuickTime pour lire la vidéo, il apparaîtra en plein

écran sur l’écran primaire, quel que soit l’endroit où la fenêtre vidéo se trouve

* Sous Windows, si vous utilisez Windows Media pour lire vos vidéos, activer le plein écran fera

jouer la vidéo sur l’écran où la fenêtre vidéo était précédemment localisée. Si vous cliquez sur la

fenêtre de vidéo ou si vous arrêtez l’exécution de Sibelius, la vidéo quittera immédiatement le

mode plein écran: c’est une fonction du codec Windows Media.

Sur un système à un seul écran, le mode plein écran fonctionne en principe sans problème.

Cependant s’il en survenait, il suffit de rétablir la fenêtre à sa taille précédente en tapant Échap.

Windows Media et QuickTime
Sous Windows, certaines vidéos fonctionnent mieux avec Windows Media et d’autres avec

QuickTime. Sibelius vous permet de choisir votre lecteur préféré dans la page Affichage du menu

Fichier > Préférences.Si QuickTime n’est pas installé, cette option ne sera pas disponible.

Si vous attachez une vidéo qui n’est pas reconnue par le lecteur vidéo que vous avez choisi, Sibelius

essayera d’utiliser un autre lecteur, sans tenir compte du réglage. Cette situation peut se produire

quand, par exemple, vous essayez de lire un fichier QuickTime .mov avec Windows Media.

Sibelius affiche entre-parenthèses le nom du lecteur vidéo utilisé dans la barre de titre de la fenêtre

de vidéo juste après le nom du fichier vidéo.

Transparence de la fenêtre de Vidéo 
Sibelius permet de rendre la fenêtre de vidéo translucide comme d’autres fenêtres d’outils.

Ce réglage peut être réalisé dans Affichage du menu Fichier > Préférences (dans le menu Sibelius
sur Mac). Cependant, contrairement aux autres fenêtres d’outil, la transparence de la fenêtre de
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vidéo peut se désactiver indépendamment. Cette opération est parfois nécessaire car certaines

configurations matérielles et certains codecs peuvent altérer l’image durant la lecture quand la

fenêtre de vidéo est translucide.

Pour en savoir plus sur les fenêtres translucides, b 5.6 Paramètres d’affichage.

Moment du début
Vous pouvez régler la vidéo pour qu’elle commence à lire à partir d’un moment différent de son début

effectif, pour éviter, par exemple un générique pour lequel aucune musique n’est prévue dans Sibelius.

Vous pouvez aussi déterminer si Sibelius doit commencer la lecture de la vidéo à un point précis de la

partition. Voici les trois réglages dans Exécution > Vidéo et Minutage > Code temporel et durée
qui permettent d’établir la corrélation exacte entre la partition et la vidéo:

* Code temporel de la première mesure: ce réglage détermine la position temporelle de la

première mesure

* Commencer la vidéo à: c’est la position temporelle à laquelle la vidéo doit commencer la

lecture dans la partition. Elle s’exprime en temps absolu, de sorte que la position doit être

toujours égale ou plus élevée que le code temporel de la première mesure. Si vous souhaitez

que la vidéo commence à être lue en même temps que le début exact de la partition, alors

choisissez au début de la partition.

* Commencer la vidéo à partir de: ce réglage est utilisé quand la lecture de la vidéo doit

commencer à un autre moment que son début véritable. Par exemple, si un fichier vidéo

commence par deux secondes de guidage de bande, il est probable que l’on veuille ignorer ces

deux secondes et demander à Sibelius de commencer la lecture de la vidéo après. Pour réaliser

cela, régler Commencer la vidéo à partir de.

Cette boîte de dialogue peut comprendre plusieurs formats. 1’00”, 00:01:00:00 et 1:00’ équivalent

tous à “une minute”. De plus, Sibelius interprétera tout nombre complet entré dans un champ

quelconque comme des secondes, de sorte que, entrer 18 sera toujours considéré comme
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00:00:18:00. Si vous entrez des valeurs en images par seconde, vérifiez que vous utilisez la même

vitesse que celle sélectionnée dans Images.

Pour en savoir plus sur la mise en œuvre du code temporel et des points de montage,

b 4.11 Code temporel et points de montage.

Ajouter la musique au fichier vidéo
Windows XP et Mac OS X sont fournis tous les deux avec des programmes gratuits ou très bon

marché qui permettent d’ajouter la musique écrite dans Sibelius au fichier vidéo lui-même. Vous

devez d’abord exporter depuis Sibelius la partition sous forme de fichier audio –

b 9.10 Exporter des fichiers audio. C’est ce fichier créé qu’il est alors possible d’importer

dans l’éditeur de film pour l’incorporer à la vidéo. 

Windows Movie Maker est disponible gratuitement avec tous les systèmes Windows, et iMovie est

fourni gratuitement avec la plupart des ordinateurs Apple (visitez www.apple.com/ilife/imovie
pour en savoir plus).

Si vous utilisez Windows et que vous souhaitez faire un peu de composition pour agrémenter la

vision de vos photos, visitez www.picasa.com et chargez le logiciel gratuit qui permet de créer

rapidement des diaporamas de vos photos numériques.

Jouer une piste audio en synchronisation avec la partition
Vous pouvez utiliser la fonction vidéo de Sibelius pour jouer une piste audio en synchronisation

avec la partition, ce qui peut être utile pour une transcription, ou même pour ajouter des éléments

audio réels pour l’exécution de la partition (par ex. un enregistrement d’instrument acoustique ou

d’un chanteur jouant la mélodie).

Pour ajouter une piste audio, choisissez Exécution > Vidéo et Minutage > Ajouter la vidéo, et

dans la boîte de dialogue qui apparait, réglez le menu le type de fichier sur Tous les fichiers. Vous

pouvez ensuite choisir n’importe quel fichier audio dans un format adéquat (par ex. .wav, .mp3,

.aiff, etc.), et il sera relié à la partition. Notez que, quand vous ajoutez une piste audio à la partition,

la fenêtre vidéo se contracte de sorte que seuls les boutons et le curseur pour contrôler le volume

sont visibles.

Vous pouvez utiliser Extensions > Divers > Déterminer des indications métronomiques pour

faire correspondre le tempo de la partition au tempo de la piste audio. N’oubliez pas cependant que

si vous ajustez le tempo de la partition avec le curseur de la fenêtre de l’exécution, la hauteur des

notes de la piste se modifiera en fonction de la vitesse.
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4.11 Code temporel et points de montage

b 4.1 Utiliser du texte, 4.10 Vidéo.

Le code temporel est la manière d’indiquer la position dans le temps d’un endroit précis d’une

partition ou d’une vidéo. Le décompte commence en général au début de la partition ou au début

de la bobine pour une partition accompagnant un, ou encore tout autre endroit que l’on souhaite.

Quand vous exécutez une partition, le code temporel apparaît sur un écran affiché dans la fenêtre

d’exécution, en même temps que le tempo en temps par minute.

Sibelius peut aussi afficher le code temporel automatiquement sous forme de texte placé au-dessus

de chaque barre de mesure de la partition. Il calcule la position temporelle des barres de mesure

d’après le nombre de mesures, leur longueur et les indications métronomiques jusqu’à ce point.

Le code temporel est particulièrement utile pour travailler sur des minutages précis de passages de

musique spécifiques, ou pour synchroniser des moment importants de la partition avec les points

de montage (y compris dans un film).

Sibelius ne fait pas de synchronisation de l’exécution et de l’affichage avec un flux de données

SMPTE ou MTC. Cette fonctionnalité est fournie par des séquenceurs professionnels tels que Pro

Tools, qui peuvent être utilisés de cette manière avec de la musique sous forme de fichier MIDI

telle que Sibelius peut l’exporter (b 9.9 Exporter des fichiers MIDI). Cependant, Sibelius peut

synchroniser l’exécution avec des fichiers vidéos numériques qui peuvent être attachés facilement

à n’importe quelle partition Sibelius (b 4.10 Vidéo).

Écran code temporel
Durant l’exécution, le code temporel et le tempo apparaissent dans le petit écran de la fenêtre de

l’exécution:

Vous pouvez activer ou désactiver la fenêtre de l’exécution en utilisant Fenêtre > Exécution
(raccourci Ctrl+Alt+Y ou zXY) ou le bouton de la barre d’outil  . Le code temporel affiche

(dans le coin inférieur droit) le temps écoulé depuis le début de la partition (plutôt que le temps

écoulé depuis le début de l’exécution) – en d’autres mots, il affiche les valeurs absolues du

“minutage de la partition” spécifiées par Exécution > Vidéo et minutage > Code temporel et
durée (cf. ci-dessous), plutôt que “l’heure réelle”.
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Boîte de dialogue code temporel et durée
La boîte de dialogue Exécution > Vidéo et minutage > Code temporel et durée contient

différentes options liée au minutage, qui sont sauvegardées dans la partition.

Écrire le code temporel dans la partition
Pour écrire le code temporel dans la partition, activez Au-dessus de chaque mesure ou Au
début de chaque système. Pour changer la portée au-dessus de laquelle il doit apparaître,

choisissez-la dans la liste sous Position.Cette option place le code temporel sous forme de texte au-

dessus de chaque barre de mesure; pour le déplacer verticalement, choisissez Style maison >

Positions par défaut et ajustez la position verticale du style Code temporel comme il convient

(b 8.12 Positions par défaut).

Unités
Le code temporel peut être affiché sous plusieurs formats:

* Images (par ex. 01:23:04:13), qui est le format standard utilisé pour les partitions de film/TV

* 0.1 secondes (par ex. 1:23’4.5’’), qui est plus lisible, mais moins précis

* Secondes (par ex. 1:23’4), qui est moins précis mais pratique pour un minutage approximatif.

Si la partition comporte des reprises, les mesures répétées afficheront deux ou plusieurs codes

temporels empilés les uns sur les autres, correspondant à chaque “passage” de la musique –

b 4.6 Reprises.

Les codes temporels sont imprimés avec le conducteur, mais par défaut ne le sont pas dans les

parties. Si vous souhaitez qu’ils y apparaissent, utilisez la page Style maison de la boîte de

dialogue Présentation des parties multiples (b 7.3 Présentation des parties
multiples). 

Parce que les films et les vidéos peuvent défiler à des vitesses différentes, le code temporel est

calculé sur la base d’images par seconde. Les formats 15, 24, 25, 29.97 (non-drop), 29.97
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(drop) et 30 (non-drop) sont répandus dans les différents types de films et de vidéo et le format

100 (centisecondes), qui n’est pas un standard est inclus à toutes fins utiles.

Moment du début
Le Code temporel de la première mesure spécifie le code temporel au début de la partition

(dans le format Heures:Minutes:Secondes:Images).

Cette valeur sera la référence pour tous les heures affichées (c’est-à-dire celles du code temporel

qui s’affichent tant dans la fenêtre d’exécution que dans la partition). Si vous utilisez un format de

code temporel basé sur les images, la valeur en images de l’heure de début est calculée d’après le

réglage d’images par seconde établi dans la boîte de dialogue.

Changer le Code temporel de la première mesure peut être utile dans deux cas:

* si la partition est destinée à accompagner un film, l’heure de début est souvent nécessaire pour

spécifier l’emplacement exact dans le déroulement du film

* si la partition fait partie d’un ensemble plus grand, par exemple une symphonie dont elle n’est

qu’un mouvement, réglez l’heure de début de la partition sur celle de la fin du mouvement

précédent (indiquée à la dernière page de ce mouvement précédent). Tous les codes temporels

seront calculés relativement au début de la symphonie et non depuis le début du mouvement.

Pour en savoir plus sur les options Commencer la vidéo à et Commencer la vidéo à partir de,

b 4.10 Vidéo.

Durée en fin de partition
Il s’agit du calcul et de la mention de la durée de la partition donnée à la dernière page en secondes

par exemple 4’33’’.

Si vous réglez un heure de début, elle est ajoutée à la durée – de sorte que si vous divisez un

morceau en deux fichiers et réglez l’heure de début du second sur la durée du premier, la durée du

second fichier indiquée en fin de partition donnera le temps cumulé. (Cf. Moment du début
ci-dessus.)

Mode de calcul du code temporel et de la durée
Les valeurs du code temporel et de la durée de la partition sont calculées en tenant compte des

reprises (b 4.6 Reprises), des indications de tempo (par ex. Allegro) et métronomiques

(b 3.1 Utiliser du texte), des points d’orgue (pauses) et des lignes de rit./accel.

(b 2.21 Lignes) – et sont automatiquement mises à jour en cas d’ajout ou de modification de

ces éléments. Faites l’essai et admirez!

Cependant, les valeurs de code temporel ne tiennent pas compte des ajustements de la vitesse de

l’exécution réalisés avec le curseur de tempo.

Points de montage
Les points de montage sont les références temporelles installées dans la partition qui indiquent les

événements importants qui apparaissent dans un film ou dans une vidéo pour faciliter la mise en

correspondance de l’écriture avec ces moments. Sibelius permet de nommer ces points de montage

qui peuvent se déplacer dans le film ou la vidéo si le minutage de la partition change.
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Comment ajouter des points de montage dans une partition
Quand vous ajoutez un point de montage dans une partition, il est ajouté à la position où se trouve

la ligne d’exécution. Supposons que dans une vidéo, un moment important survient à 04’32”:

utilisez le curseur temporel de la fenêtre d’exécution pour naviguer jusqu’à ce point de la vidéo, et

puis utilisez les boutons marche arrière ou avance rapide pour avancer par paliers plus précis (0.2

seconde) dans un sens ou l’autre. 

Quand l’image souhaitée apparaît dans la vidéo, cliquez sur le bouton de la fenêtre vidéo Ajouter

un point de montage  sur la fenêtre Vidéo ou choisissez Insertion > Autres > Point de
montage. Un point de montage sera ajouté à cet endroit dans la partition.

Vous pouvez aussi ajouter des points de montage dans une partition grâce au bouton Nouveau
dans Exécution > Code temporel et durée > Points de montage. Cette méthode les ajoute

toujours au début de la partition, sans tenir compte de la ligne de lecture; vous pouvez ensuite

tapez le code temporel souhaité (cf. ci-dessous).

Vous pouvez déplacer les points de montage verticalement dans la partition en changeant la

position verticale du style de texte Points de montage dans Style maison > Positions par
défaut – b 8.12 Positions par défaut.

Modifier l’heure de position et le nom des points de montage
Vous pouvez modifier n’importe quel point de montage dans la partition avec Exécution > Vidéo
et minutage > Points de montage (raccourci Maj+Alt+P ou xzP). Cette boîte de dialogue

énumère tous les points de montage de la partition: 

* La colonne Code temporel affiche la position en temps absolu à laquelle se place chaque points.

Le format de cet affichage dépendra du réglage du code temporel choisi dans Exécution > Vidéo
et minutage > Code temporel et durée. Ce champ se modifie en double-cliquant la valeur que

vous souhaitez changer.

* La colonne Mesure.temps.100èmes affiche l’emplacement du point de montage dans la

partition selon sa position rythmique exprimée en mesure, temps et centième de temps. Par

exemple, 64.2.96 serait 64, temps 2.96. Si un point de montage tombe précisément sur un

temps, les centièmes sont omis. Vous pouvez changer cette valeur manuellement, mais elles se
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mettra à jour automatiquement si vous repositionnez le point de montage en modifiant son

Code temporel.

* La colonne Nom affiche le nom de chaque point de montage de la partition. Vous pouvez

modifier le nom de chaque point en double-cliquant sur le nom. Notez que vous devez enfoncer

Retour après avoir entré un nouveau nom pour qu’il figure dans le tableau.

Supprimer des points de montage existants
Si vous désirez enlever un point de montage de la partition,vous pouvez le faire depuis Exécution >

Vidéo et minutage > Points de montage. Sélectionnez le point de montage à supprimer, puis

cliquez sur Supprimer. Si vous désirez supprimer tous les points de montage d’une partition,

cliquez sur Supprimer tout.

Ajuster la sélection selon la durée
Si vous voulez qu’un point de montage tombe à un endroit précis de la partition, vous devez ajuster

le tempo de la partition. Sibelius propose une extension qui réalise les calculs nécessaires

automatiquement – cf. Ajuster la sélection selon la durée à la page 562.

Décaler tous les points de montage
Il arrive parfois que les points de montage de la partition ne coïncident plus avec la vidéo, suite à

des changements d’heure du début de la partition ou du démarrage de la vidéo. Pour rectifier ce

problème, vous pouvez déplacer de la même valeur temporelle tous les points de montage créés en

cliquant sur Décaler tout dans Exécution > Vidéo et minutage > Points de montage. Vous

pouvez entrer toute valeur positive ou négative dans différents formats (1’00”, 00:01:00:00 et 1:00’

équivalent tous à “une minute”). Sibelius interprétera tout nombre entier dans l’un des champs en

tant que seconde, de sorte que -4 sera considéré comme -00:00:04:00. Si vous entrez des valeurs

qui spécifient des images, veillez à utiliser la même vitesse que celle sélectionnée dans la section

Images de Exécution > Vidéo et minutage > Code temporel et durée (cf. ci-dessus).

Afficher les points de montage d’une portée
Certains compositeurs apprécient de pouvoir relier le plus précisément possible la position de

chaque point de montage à la position rythmique dans la partition, souvent en ajoutant des notes

en tête de croix sur une portée d’une ligne au-dessus ou en dessous de la partition. Sibelius propose

une extension capable de réaliser cela automatiquement – cf. Ajouter une portée de points
de montage à la page 559.

Styles de texte
Les codes temporels sont écrits avec le style de texte code temporel, et les points de montage avec le

style points de montage. La hauteur de leur position au-dessus de la portée est déterminée par la

valeur de la position verticale du style dans Style maison > Positions par défaut
(b 8.12 Positions par défaut).Vous pouvez ajuster la position verticale de la durée totale de la

partition qui apparaît en dessous de la barre de mesure finale en modifiant le style de texte Durée
en fin de partition.
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4.12 Périphériques d’exécution

Configuration MIDI pour Windows, Configuration MIDI sur Mac dans le Guide de

l’utilisateur; b 4.3 Table de mixage, 4.4 Sibelius Sounds Essentials, 4.15 Travailler
avec des instruments virtuels.

Cet article introduit le concept de configuration d’exécution, et explique comment régler les

configurations en utilisant la boîte de dialogue Exécution > Périphériques d’exécution.

Périphériques d’exécution
Un périphérique d’exécution est un périphérique matériel ou logiciel qui fournit un ou plusieurs

sons. Il existe plusieurs types de périphérique d’exécution tels que:

* les instruments virtuels qui utilisent la technologie VST ou Audio Unit, dont le Sibelius Player

intégré.

* du matériel MIDI interne, tels que les cartes-son à synthétiseurs intégrés;

* du matériel MIDI externe, tels que les modules de sons et les claviers avec sons intégrés;

Sibelius peut réaliser une exécution en utilisant n’importe quelle combinaison de périphériques

logiciel ou matériel, dans une seule et même configuration d’exécution.

Pour que Sibelius utilise pour l’exécution des périphériques MIDI externes (par ex. des modules de

son ou des synthétiseurs), il faut d’abord les connecter à l’ordinateur afin que Sibelius puisse les

“voir” – cf. Configuration MIDI pour Windows ou Configuration MIDI sur Mac dans le

Guide de l’utilisateur.

Si la terminologie MIDI ne vous est pas familière, b 4.13 MIDI pour les néophytes.

Pour une introduction au monde des instruments virtuels et des effets, b 4.14 Instruments
virtuels pour les débutants.

Configurations d’exécution
Une configuration d’exécution est un ensemble de réglages qui déterminent quels périphériques

d’exécution disponibles dans votre système doivent être utilisés pour l’exécution, quel jeu de sons

doit être utilisé pour chacun des périphériques, et comment utiliser leurs possibilités spécifiques

(par ex. si vous préférez tel périphérique pour le son de violon et tel autre pour les sons de cuivre),

de manière à ce que l’exécution de chaque partition se fasse avec le moins possible d’interventions.

On peut régler autant de configurations d’exécution que nécessaire, chacune avec des objectifs

différents et passer de l’une à l’autre à tout moment. Par exemple, on utilisera les sons prédéfinis de

l’ordinateur pour composer et arranger afin d’éviter d’attendre le chargement d’échantillons

volumineux avant de travailler, alors que pour produire une démo audio ou un CD de travail on

utilisera des échantillons d’orchestre. Selon le cas on utilisera l’une des deux configurations

d’exécution créées

Quand on passe d’une configuration à l’autre, aucun changement ne doit être apporté à la

partition: Sibelius utilisera automatiquement la configuration en cours de manière adéquate sans

qu’il faille s’astreindre à réassigner chacun des sons.
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Jeux de sons
Un jeu de sons est un fichier qui énumère tous les sons disponibles sur un périphérique MIDI ou

sur un instrument virtuel spécifique, et qui indique à Sibelius à quels sons d’instruments réels ces

sons correspondent, afin qu’il puisse les utiliser automatiquement le mieux possible.

Notez que le choix des jeux de sons disponibles sera fonction du type de périphérique sélectionné,

Sibelius n’étant pas livré avec des jeux de sons pour tous les périphériques MIDI et instruments

virtuels existants. Si votre périphérique est absent de la liste de la colonne Jeu de sons de la liste

des Périphériques actifs de la page Exécution > Périphériques d’exécution, peut-être en

trouverez-vous un fichier de jeu de sons dans le centre d’assistance en ligne – choisissez Aide >

Help Center.

Si vous possédez un périphérique pour lequel aucun jeu de sons n’est disponible, vous pouvez

l’utiliser avec Sibelius, en créant un jeu de sons manuel. Un jeu de sons manuel est un jeu de sons

réduit très spécifique. Par exemple, si vous possédez un instrument virtuel avec un seul son de piano,

un jeu de sons complet n’est pas nécessaire; il suffit de créer un jeu de sons manuel indiquant à

Sibelius que ce périphérique peut seulement jouer un son de piano. Si par contre vous utilisez un

instrument virtuel à plusieurs sons, mais pour lequel n’existe aucun jeu de sons, alors vous pouvez

créer un jeu de sons indiquant à Sibelius quel son est disponible sur chaque canal du périphérique.

Vous pouvez même créer votre propre fichier de jeu de sons en utilisant l’application Sound Set

Editor, disponible en chargement sur les pages d’assistance en ligne.

Configurations d’exécution par défaut
Sibelius crée trois configurations d’exécution par défaut pour vous:

* Sibelius Sounds: choisie par défaut, cette configuration utilise le Sibelius Player intégré pour

exécuter la bibliothèque d’échantillons Sibelius Sounds Essentials de haute qualité

(b 4.4 Sibelius Sounds Essentials). Selon les ressources disponibles de votre ordinateur,

cette configuration peut exécuter jusqu’à 128 instruments différents simultanément.

* General MIDI (avancé): cette configuration utilise un instrument virtuel compatible General

MIDI de haute qualité à partir de M-Audio, et peut exécuter jusqu’à 32 instruments différents

simultanément.

* General MIDI (basique): cette configuration utilise les sons intégrés de vote ordinateur. Sous

Windows, elle utilise le Microsoft GS Wavetable Synth, qui peut exécuter jusqu’à instruments

différents simultanément. Sous Mac, elle utilise deux exemples de DLS Music Device d’Apple, en

autorisant jusqu’à 32 instruments différents simultanément.

Si vous avez mis à niveau à partir de Sibelius 5, et possédez encore la version de Sibelius Sounds

Essentials incluse avec Sibelius 5 installée sur votre ordinateur, Sibelius créera aussi deux autres

configurations d’exécution pour vous: Sibelius Essentials (16 sons, Kontakt) et Sibelius
Essentials (32 Sons, Kontakt). Ces configurations vous permettent d’utiliser l’ancienne version

de Sibelius Sounds Essentials dans Sibelius 6 si vous le souhaitez, bien qu’il soit recommandé

d’utiliser la nouvelle configuration d’exécution Sibelius Sounds à la place. (En ouvrant pour la

première fois une partition Sibelius 5 définie pour utiliser Sibelius Sounds Essentials dans Sibelius

6, Sibelius la définit automatiquement pour utiliser la nouvelle configuration d’exécution Sibelius
Sounds, d’où la nouvelle version de la bibliothèque d’échantillons fournie.)
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Créer un nouvelle configuration d’exécution
Pour créer une nouvelle configuration, choisissez une entrée existante depuis le menu Configuration
sur base de laquelle vous construirez la nouvelle. Cliquez sur Nouveau; il vous sera demandé de taper

un nom et après quoi vous cliquerez sur OK. En fonction des périphériques utilisés, Sibelius peut

rester occupé un certain temps; dès qu’il a terminé vous pouvez cliquer sur OK.

Changer la configuration d’exécution en cours
Pour utiliser une configuration d’exécution différente, choisissez Exécution > Périphériques
d’exécution, et choisissez un élément de la liste Configuration en haut de la boîte de dialogue.

Sibelius peut rester occupé un certain temps, spécialement si la nouvelle configuration utilise un

ou plusieurs instruments virtuels.

Renommer et supprimer des configurations d’exécution
Pour renommer une configuration existante, il suffit de la choisir dans la liste en haut de la boîte de

dialogue et de cliquer sur Renommer. De la même manière, pour supprimer une configuration

existante, choisissez-la dans la liste, puis cliquez sur Suppr et répondez Oui à la question. Vous ne

pouvez pas renommer ni supprimer les configurations d’exécution que Sibelius crée par défaut.

Modifier une configuration d’exécution
Pour changer une configuration d’exécution existante, il faut utiliser les quatre pages de la boîte de

dialogue Exécution > Périphériques d’exécution, qui sont décrites en détail ci-dessous.

Vous ne pouvez pas modifier les configurations d’exécution existantes, sauf pour changer les jeux

de son utilisés par les périphériques actifs sur la page Périphériques actifs, et pour ajouter ou

supprimer des effets séparés sur la page Effets. Pour modifier l’un des défauts, créez une nouvelle

configuration basée dessus – cf. ci-dessus.

Notez que quand vous faites des changements dans la boîte de dialogue, une astérisque s’ajoute au

nom de la configuration dans le menu du haut. Pour sauvegarder votre configuration, il suffit de

cliquer sur Sauvegarder.

La page Périphériques actifs
Sur la page Périphériques actifs, vous pouvez choisir parmi les périphériques disponibles dans le

système ceux qui seront utilisés par cette configuration:
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* Le cadre Périphériques disponibles à gauche donne la liste des périphériques d’exécution

disponibles dans le système. Cette case est désactivée (grisée) si la configuration d’exécution

actuelle fait partie de celles par défaut créées par Sibelius. Chaque périphérique est répertorié

par son Nom, et fait partie de l’un des Types suivants:

% Le Sibelius Player est reconnu sous le type Sibelius.

% Kontakt Player et l’échantillonneur Kontakt complet de Native Instruments est indiqué sous le

type Kontakt. Sous Mac, Sibelius indiquera également si l’instrument virtuel utilise la

technologie VST ou Audio Unit. 

% Les instruments logiciels Garritan, comme Garritan Personal Orchestra et Authorized

Steinway, utilisent le lecteur d’échantillons the ARIA, et figurent sous le type Aria. Sous Mac,

Sibelius indiquera également si l’instrument virtuel utilise la technologie VST ou Audio Unit.

% Tous les autres instruments virtuels Windows, et certains sous Mac, figurent sous le type VST.

% Certains instruments virtuels sous Mac utilisent la technologie Audio Unit de Apple et

figurent sous le type AU.

% Les périphériques MIDI normaux, tels que les cartes-son internes avec synthétiseurs ou les

claviers externes et les modules de sons, seront affichés sous le type MIDI.

Pour activer un périphérique dans la configuration en cours, sélectionnez-la dans la liste

Périphériques disponibles et cliquez sur Activer. Quand vous activez le Sibelius Player ou un

périphérique MIDI, il est déplacé de la liste Périphériques disponibles vers la liste de droite

Périphériques actifs. Mais si vous activez un périphérique Kontakt, Aria, VST ou AU, il reste

dans Périphériques disponibles mais est aussi copié dans Périphériques actifs: cela permet

d’activer plusieurs occurrences d’un instrument virtuel, ce qui n’est pas possible avec un

périphérique MIDI.

* Le cadre Périphériques actifs à droite donne la liste des périphériques d’exécution qui sont

activés, c’est-à-dire disponibles pour que Sibelius puisse les utiliser durant l’exécution. En plus

des colonnes Nom et Type similaires à celles de la liste Périphériques disponibles, il y a une

colonne Jeux de sons. Vous pouvez cliquer sur la colonne jeu de sons pour choisir parmi les

jeux de sons disponibles. Si aucun jeu de son n’est disponible pour le périphérique que vous êtes

en train d’utiliser, réglez Jeu de sons sur (aucun), et ensuite utilisez la page Jeux de sons
manuels pour indiquer à Sibelius comment utiliser cet instrument virtuel pour l’exécution – cf.

ci-dessous.

Vous pouvez renommer les périphériques présents dans la liste Périphériques actifs en faisant

un double-clic sur leurs noms; Sibelius ajoutera le nom original du périphérique au nom choisi.

Cela peut s’avérer pratique si vous utilisez plusieurs occurrences du même instrument virtuel,

chacune chargée avec un jeu de sons ou un son individuel différent.

Pour désactiver un périphérique, sélectionnez-le dans la liste Périphériques actifs et cliquez

sur Désactiver pour l’enlever de la liste.

Page jeux de sons manuels
Les instruments virtuels de type Sibelius Player, Kontakt et Aria, et les périphériques de type

MIDI, procurent des fonctions spéciales permettant à Sibelius de charger automatiquement des

sons, si un jeu de sons approprié est disponible. Si aucun jeu de sons n’est disponible, ou si un

périphérique est un instrument virtuel de type VST ou AU, vous devez signaler à Sibelius quels
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sons sont disponibles, en créant un jeu de sons miniature pour chaque instrument virtuel, via la

page Jeux de sons manuels.

Une fois que vous avez indiqué à Sibelius les sons disponibles sur chaque canal, il pourra traiter ce

périphérique comme n’importe quel autre, et assigner à chaque portée le son adéquat lors de

l’exécution.

Voici les options de la page Jeux de sons manuels:

* En premier lieu choisissez l’instrument virtuel dans le menu périphérique situé au sommet de

la boîte de dialogue. Vous pouvez créer un jeu de sons manuel de n’importe quel type pour

n’importe quel périphérique, hormis pour le Sibelius Player intégré; en outre, les jeux de son

manuel ne sont pas disponibles pour les périphériques de type Kontakt car il est recommandé

d’autoriser Sibelius à charger les sons lui-même. Pour créer un jeu de sons manuel pour un

périphérique de type Kontakt, activez Autoriser les jeux de sons manuels sur la page

Exécution de Fichier > Préférences (dans le menu Sibelius sous Mac).

* Si vous créez un jeu de sons manuel pour un instrument virtuel, cliquez sur Afficher pour que

l’interface apparaisse dans une autre fenêtre; ce bouton est désactivé pour les périphériques de

type MIDI. Il y a de telles différences dans l’interface des instruments virtuels tant au niveau de

la présentation que du fonctionnement qu’il est impossible de fournir l’assistance pour le

fonctionnement de chacun d’eux. Consultez la documentation accompagnant l’instrument

virtuel pour en connaître les commandes. Laissez cette fenêtre ouverte – nous y revenons dans

une minute.

* Si vous avez déjà choisi un jeu de sons pour ce périphérique dans la page Périphériques actifs,

il pourra être choisi maintenant dans le menu Jeu de sons; si ce n’est pas le cas, choisissez-le

maintenant ici. Si aucun jeu de sons n’est disponible, choisissez (aucun).

* Activez Utiliser un jeu de sons manuel pour imposer les choix opérés ici. Si vous désactivez

cette option, votre jeu de sons manuel ne sera pas utilisé, mais les réglages seront sauvegardés en

tant qu’élément de la configuration d’exécution, de sorte que vous pourrez les réutiliser plus tard.
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* Si votre périphérique possède un jeu de sons, Nbre de canaux sera réglé sur le nombre

approprié de canaux, emplacements ou sons différents que l’instrument doit jouer en même

temps. Certains instruments virtuels sont conçus pour émuler un seul instrument, tels qu’un

piano électrique spécifique ou un synthétiseur, et comme ils ne jouent qu’un seul son à la fois, le

Nbre de canaux devrait être réglé sur 1. Les autres instruments virtuels, spécialement ceux

avec des bibliothèques d’échantillons, peuvent jouer plusieurs sons simultanément, de sorte que

le Nbre de canaux peut être réglé sur 8 ou 16. Remarquez le tableau à droite de la boîte de

dialogue mis à jour avec le nombre de canaux choisis ici.

Si le Nbe de canaux n’est pas automatiquement réglé correctement, réglez-le manuellement.

* Maintenant revenez à l’interface de votre instrument virtuel et chargez un son, ou réglez-la sur

un jeu prédéfini adéquat. Si votre instrument virtuel peut jouer plusieurs sons ensemble,

commencez par charger un son dans le premier canal ou emplacement. Si vous travaillez avec un

périphérique MIDI, définissez le premier canal pour qu’il utilise un patch approprié, au besoin.

* Maintenant regardez les options de Réglages des sons de la page Jeux de sons manuels.

Ensuite, soit cliquez sur la première entrée du tableau de droite ou utilisez le cadre déroulant

Canal pour choisir le canal.

* Si un jeu de sons a été choisi pour ce périphérique, les menus Programme et Son ID sont

désactivés.

% Si Programme est activé, choisissez le nom du programme que vous avez chargé dans votre

instrument virtuel et cliquez sur Appliquer.

% Activez Envoyer un changement de programme si un jeu de sons a été déjà choisi pour le

périphérique mais qu’il nécessite un changement de programme explicite envoyé au début de

l’exécution (dans ce cas Sibelius enverra le changement de programme stipulé par le jeu de

sons), ou si aucun jeu de sons n’a été choisi et que vous savez que le son souhaité peut être

choisi par un changement de programme spécifique au début de l’exécution (dans ce cas le

contrôle du numéro de programme sera activé et vous pouvez spécifier le changement de

programme à envoyer).

% Si Envoyer un changement de programme est activé, on peut activer Envoyer un
changement de banque si nécessaire; comme précédemment, si votre périphérique

possède un jeu de sons, activer Envoyer un changement de banque enverra le changement

de banque stipulé par le jeu de sons et sinon on peut spécifier les composants de Banque
supérieure et Banque inférieure du message de changement de banque à envoyer au début

de l’exécution.

% Si Son ID est activé, cliquez sur ... pour afficher un menu dans lequel vous choisirez le son qui

correspond le mieux au son chargé dans votre périphérique. Par exemple, si vous avez chargé

un son d’ensemble de violons, choisissez strings.violin.ensemble dans le menu; si c’est un

son de piano Steinway, choisissez keyboard.piano.grand.steinway. Soyez aussi précis que le

menu le permet, car cela aidera Sibelius à utiliser le son qui correspond le mieux possible.

Une fois que vous l’avez trouvé, cliquez sur Appliquer

% Activez Table de percussion compatible General MIDI plutôt que de choisir un seul son

ID ou un nom de programme, si vous savez que le programme sur ce canal est une table de

percussion à sons indéterminés qui correspond au standard General MIDI. Si le périphérique

n’est pas compatible General MIDI, il faudra un jeu de sons pour que votre périphérique soit

capable d’adresser des sons de percussions à sons indéterminés.
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* Vous verrez que la première entrée du tableau de droite est mise à jour. Si votre périphérique doit

jouer un autre son en même temps, répétez les étapes décrites ci-dessus jusqu’à ce que tous les

sons souhaités soit chargés et répartis dans le jeu de sons manuel.

N’oubliez pas de cliquer sur le bouton Sauvegarder en haut de la boîte de dialogue pour éviter de

perdre tout ce qui vient d’être fait!

Sibelius a besoin de recevoir un son ID (ou un nom de programme si un jeu de sons est disponible)

pour assigner automatiquement l’exécution à un canal. Si vous ne souhaitez pas qu’il fasse cela

automatiquement – parce que (par ex.) vous avez un modèle pré-existant que vous utilisez pour

tous vos projets et que vous maîtrisez l’assignation des portées manuellement – vous pouvez

choisir comme réglage un jeu de sons manuel vide. Il suffit de régler Nbre de canaux sur le

nombre approprié, d’activer Utiliser un jeu de sons manuel, et de ne pas faire d’autre choix.

Pour que Sibelius utilise ces canaux pour l’exécution, vous devez ouvrir la rangée de chaque portée

dans la table de mixage et choisir explicitement le périphérique à utiliser (de manière à ce son nom

ne figure plus entre-parenthèses), puis choisir explicitement le canal en utilisant les flèches à droite

de l’écran du canal. Pour en savoir plus, cf. Rangées des portées à la page 306.

Page des sons de préférence
Une fois que le choix de périphériques à utiliser pour l’exécution est réalisé, et que sont

éventuellement réglés les jeux de sons manuels, on peut à présent indiquer à Sibelius quels

périphériques utiliser pour chaque type de sons. Par exemple si on préfère les cuivres d’un

périphérique et les cordes d’un autre, on peut indiquer à Sibelius des les utiliser respectivement

quand c’est possible.

Le réglage de la page Sons préférés est facultatif car Sibelius est conçu pour choisir le meilleur son

disponible à tout moment. Vous pouvez donc le laisser faire et ignorer cette page.

Mais si malgré tout vous voulez intervenir, voici comment régler Sons préférés de Exécution >

Périphériques de lecture:
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* Utilisez l’affichage en arborescence des Sons IDs à gauche de la boîte de dialogue et sélectionnez

le groupe de sons dont voulez spécifier le périphérique préféré. Quand vous sélectionnez une

branche de l’arbre, vous en sélectionnez aussi implicitement toutes les sous-branches. Cela

signifie que, si par exemple, vous sélectionnez Strings, vous sélectionnez aussi Strings.Violin et

tout les couches inférieures telles que Strings.Violoncello et ce qui est en dessous encore.

* Une fois que la branche appropriée est choisie, vous verrez que Pour ce son ID affiche le nom

complet du son choisi. Maintenant faites votre choix dans la liste Utiliser de préférence ce
périphérique et cliquez sur Ajouter pour rendre effective votre préférence.

* Notez que la préférence que vous venez de déterminer s’affiche à présent dans la liste à droite de

la boîte de dialogue. Si vous souhaitez enlever un des choix existants, il suffit de le sélectionner

dans la liste et de cliquez sur Enlever.

Vous pouvez attribuer vos préférences comme vous l’entendez: si vous souhaitez qu’en général les

sons de cuivre soient joués par un périphérique spécifique, il suffit de sélectionner Brass et en

régler le son préféré; si d’autre part vous voulez toujours utiliser un périphérique spécifique qui

émule le son d’un orgue Hammond B3 quand une de vos partitions utilise un tel instrument, vous

pouvez sélectionner keyboard.organ.drawbar.percussive.with rotary speaker, et régler un son

de préférence uniquement pour ce son.

Tout comme pour les réglages des autres pages de cette boîte de dialogue, n’oubliez pas de cliquer sur

Sauvegarder pour que vos changements soient conservés.

La page Effets
La page Effets permet de charger des effets dans les différents bus fournis:

Les effets de Effets maîtres insérés sont appliqués à l’ensemble du signal audio avant qu’il ne

sorte du périphérique, et n’arrive à vos oreilles. Les effets de compression ou de limitation peuvent

être utilisés comme effets maîtres insérés, car ils s’appliquent normalement à l’ensemble des sons

produits par les instruments utilisés. La réverbération peut aussi être utilisée comme effet maître

inséré, mais cela impliquera l’impossibilité de modifier l’intensité de réverbération d’un seul
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instrument virtuel parmi d’autres utilisés. Vous pouvez enchaîner jusqu’à quatre effets maîtres

insérés: le signal audio passe par chaque effet, l’un après l’autre.

Sibelius fournit aussi quatre bus d’envoi, qui peuvent être utilisés pour diriger une partie du signal

audio sur un ou plusieurs effets. Ces bus sont dits après-curseur, ce qui signifie que la quantité de

signal de l’effet dépend du niveau du curseur de volume de sortie de l’instrument virtuel. Vous

pouvez choisir la quantité de signal de sortie de chaque instrument virtuel envoyée à chacun des

bus d’envoi en utilisant les contrôles de la fenêtre table de mixage (b 4.3 Table de mixage).

Vous pouvez enchaîner jusqu’à deux effets dans chacun des quatre bus.

Vous pouvez utiliser les bus d’envoi pour ajouter des effets à la sortie des instruments virtuels

individuels. Par exemple, si l’instrument virtuel est une guitare à laquelle on veut ajouter un effet

de pédale: chargez l’effet de pédale dans un des bus d’effets, et envoyez une partie de la sortie de

l’instrument virtuel jusqu’à ce bus d’envoi.

Ajouter un effet à une configuration de lecture est assez simple: il suffit de le choisir dans la liste

déroulante de l’emplacement dans lequel vous voulez que le bus apparaisse. Pour afficher une

interface graphique de l’effet, cliquez sur le bouton Afficher. Tous les changements réalisés dans

l’interface de l’effet sont sauvegardés quand la configuration est sauvegardée.

Notez que les effets peuvent seulement affecter le son produit par les instruments virtuels, car celui

des périphériques MIDI ne fait pas partie du même flux audio (en effet, le son des périphériques

MIDI externes n’est jamais à l’intérieur de l’ordinateur). D’autre part, le Sibelius Player intégré

inclut deux effets maîtres – réverb et chorus – propres, qui ne figurent pas ici sur la page Effets, et

qui ne s’appliquent qu’aux sons reproduits par le Sibelius Player.

Options du moteur audio
Pour régler l’interface audio que Sibelius doit utiliser pour l’exécution, cliquez sur Options du
moteur audio en bas de Exécution > Périphériques d’exécution. Voici la boîte de dialogue qui

apparaît:
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* Choisissez le périphérique souhaité pour l’exécution dans le menu déroulant Interface. Sous

Windows, vous pouvez voir le même périphérique plusieurs fois dans la liste, avec différents

acronymes entre parenthèses à la fin:

% Si vous voyez un périphérique avec (ASIO) en fin d’appellation, utilisez-le. L’ASIO (qui est

l’acronyme de “Audio Stream Input Output”) fournit une interface à latence basse, et est

idéale quand on utilise des instruments virtuels et des effets lors de l’exécution et de la saisie.

% Les périphériques avec (DS) en fin d’appellation utilise la technologie DirectSound de

Microsoft. Le DirectSound ne fournit pas une latence aussi basse que l’ASIO, mais est

recommandé si aucun périphérique ASIO n’est disponible. En fonction du matériel donné, un

périphérique DirectSound peut entraîner une latence plus ou moins basse lors de la saisie

avec Flexi-time.

% Les périphériques avec (MME) en fin d’appellation utilisent la technologie MultiMedia

Extension de Microsoft qui est plus ancienne que le DirectSound et l’ASIO. Certaines cartes-

son ou matériel intégré (comme dans les portables ou les ordinateurs bas de gamme) bon

marché ne supporte que le MME, qui fonctionne plutôt bien lors de l’exécution mais dont la

latence est assez élevée lors de la saisie avec Flexi-time.

Sous Windows, Sibelius choisira automatiquement un périphérique ASIO s’il est disponible;

autrement il choisira un périphérique DirectSound, puis un périphérique Multimédia en dernier

ressort.

Sur Mac, pratiquement tous les périphériques supportent le standard Core Audio intégré de Mac

OS X, de sorte que seul (CoreAudio) devrait figurer à la fin du nom du périphérique. Le Core

Audio est très similaire à l’ASIO et fournit une interface à latence basse. Sibelius utilisera par

défaut le périphérique choisi dans l’onglet Output du panneau Son des préférences du système.

* Sous Windows, quand vous utilisez un périphérique ASIO, le bouton Réglage ASIO est activé.

Cliquer sur ce bouton ouvre le panneau de contrôle de votre périphérique ASIO, dans lequel on

peut modifier facilement les réglages spécifiques au périphérique.

* Sorties: permet de choisir quelles sorties du périphérique doivent être utilisées pour l’exécution.

La plupart des cartes-son ont une seule paire de sortie stéréo de sorte que seul 1/2 devrait

apparaître dans ce menu. Si vous avez une carte-son avec plusieurs paires de sorties, chaque

paire apparaîtra ici.

* Taille du tampon: détermine - on pouvait s’y attendre - la taille du tampon fourni par l’interface

pour les données traitées, ce qui affecte la latence comme ceci: plus le tampon est grand, plus la

latence est élevée. Les tailles de tampon fournies varient selon le matériel, mais sur la plupart des

périphériques ASIO et Core Audio, une taille de tampon raisonnable est de 1024 échantillons.

* Vitesse d’échantillonnage: est la fréquence à laquelle l’audio est exécutée à travers l’interface

audio. Le réglage normal est 44100Hz.

* Latence : est le temps en millisecondes nécessaire pour que le périphérique joue une note après

avoir reçu l’instruction de Sibelius. Il n’est pas possible de modifier la latence directement; elle

est calculée par la combinaison de la taille du tampon et de la vitesse d’échantillonnage.

* Sous Windows, vous verrez aussi une option pour choisir le dossier à partir duquel Sibelius

chargera votre instrument virtuel et les effets (par défaut, C:\Program Files\Sibelius
Software\VSTPlugins). Si des instruments virtuels et des effets se trouvent déjà à un autre

endroit dans l’ordinateur, vous pouvez y accéder en cliquant sur Parcourir. (Sur Mac, tous les
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instruments virtuels et les effets sont placés dans un seul endroit spécifié par Mac OS X, de sorte

qu’il n’est jamais nécessaire de les déplacer.)

* Cliquez sur Rescanner si vous trouvez que des instruments virtuels ou effets censés apparaître

dans Périphériques d’exécution ne figurent pas. Quand vous redémarrez Sibelius, il réexamine

chacun des instruments virtuels et des effets du dossier spécifié. Attention, cela peut prendre un

certain temps! (Sibelius détecte automatiquement les nouveaux instruments virtuels ou effets

installés sans que vous ayez besoin de cliquer sur Rescanner.)

* Voici les options du groupe ReWire b 4.16 ReWire.

L’option Utiliser les instruments virtuels et les effets (nécessite un redémarrage) au sommet

de la boîte de dialogue permet de désactiver la prise en charge par Sibelius à la fois des instruments

virtuels et des effets. Désactivez cette option, puis relancez Sibelius si vous voulez que seuls les

périphériques MIDI-type apparaissent dans Exécution > Périphériques d’exécution.

Cliquez sur Fermer dès que vous avez terminé les changements dans la boîte de dialogue Options
du moteur audio

Préréglages pour les instruments virtuels et les effets
Certains instruments virtuels et effets proposent des préréglages définis par leurs concepteurs.

Vous pouvez visualiser lesquels sont disponibles en ouvrant le menu dans le coin supérieur gauche

de l’instrument virtuel ou de la fenêtre des effets:

Si le menu est vide ou ne contient qu’un seul élément, alors l’instrument virtuel ou l’effet utilisé ne

possède aucun préréglage. Si vous choisissez un préréglage dans le menu et que vous voulez être

sûr que votre choix sera mis en mémoire, n’oubliez pas de sauvegarder votre configuration

d’exécution dans Exécution > Périphériques d’exécution.

À droite du menu figurent deux boutons supplémentaires, pour charger et sauvegarder des fichiers

préréglés .fxp VST. Sauvegarder un fichier de préréglage sauvegarde l’état de l’instrument virtuel

ou l’effet sur le disque, et le charger à nouveau rétablit l’instrument virtuel ou l’effet au même état.

C’est pratique si vous devez ajuster les réglages d’un instrument virtuel ou d’un effet et puis

réutiliser les mêmes réglages dans une autre configuration d’exécution dans Sibelius ou même

dans une autre application.
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Préférences d’exécution
La page Exécution de Fichier > Préférences (menu Sibelius sur Mac) propose les options

suivantes:

* Dans le groupe Configuration d’exécution par défaut, vous pouvez indiquer à Sibelius de

toujours charger une configuration d’exécution spécifique au lancement du programme.

* Dans le groupe Ouvrir des fichiers, vous pouvez déterminer ce que Sibelius doit faire à

l’ouverture d’une partition utilisant une configuration d’exécution différente de celle

actuellement choisie. Par défaut, Me laisser choisir s’il faut passer à la nouvelle
configuration est choisi, ce qui signifie que Sibelius vous affichera un message à l’ouverture

d’une partition, vous permettant de basculer à la dernière configuration de sauvegarde de la

partition (cliquez sur Oui) ou de conserver la configuration actuelle (cliquez sur Non). Une

autre méthode consiste à choisir Toujours passer à la nouvelle configuration or Ne jamais
passer à la nouvelle configuration.

* Les options dans le groupe Options de lecture d’échantillons s’appliquent au Sibelius Player

intégré, et aux lecteurs d’échantillons de type Kontakt et Aria:

% Désactivez Charger les sons à l’ouverture des partitions si vous ne voulez pas que

Kontakt Player 2 charge les sons requis pour exécuter la partition jusqu’à ce que l’exécution

soit lancée ou qu’une note soit sélectionnée.

% Réutiliser les sons qui sont déjà chargés indique à Sibelius qu’il ne doit pas recharger

chaque son quand on passe d’une partition à l’autre. Il vaut mieux laisser cette option activée.

* Les options dans le groupe Options du Sibelius Player s’appliquent uniquement au Sibelius

Player intégré:

% Nombre maximum de canaux détermine combien de sons simultanés Sibelius Player peut

charger – cf. Comment fonctionne Sibelius Player à la page 316.

% Utiliser la réverb de circonvolution (meilleur son, plus gourmand en CPU) précise que

Sibelius doit utiliser la réverb de circonvolution de haute qualité intégrée au Sibelius Player

lors de l’exécution; Mais pas pendant l’entrée Flexi-time (pour une latence réduite)
indique à Sibelius d’utiliser la réverb standard pendant l’enregistrement pour améliorer la

latence - cf. Réverbération à la page 325.

% Décharger des sons en passant d’une partition à l’autre indique à Sibelius de décharger

tous les sons de Sibelius Player en basculant entre les partitions. Vous ne devez activer cette

option que si vous commutez entre deux grandes partitions ou plus partageant très peu

d’instruments en commun, et concernées par l’exploitation de mémoire.

* Dans la page Kontakt and Kontakt Player, activez Autoriser les jeux de sons manuels si

vous voulez contrôler vous-même le chargement des sons dans Kontakt Player ou dans le lecteur

Kontakt intégral. Sauf si vous savez ce que vous faites, laissez cette option désactivée.

* Dans le groupe Affichage, vous pouvez indiquer à Sibelius si vous voulez afficher les Sons ID ou

les Noms de programme (le réglage par défaut). Si vous choisissez d’afficher les noms des

programmes, Sibelius les affichera dans la table de mixage et dans les boîtes de dialogue de

Style maison > Modifier les instruments quand c’est possible.

* Dans le groupe Partage des emplacements et des canaux:
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% Désactivez Utiliser le même emplacement pour toutes les portées d’instrument à
clavier si vous voulez ajuster individuellement le son, le volume ou le panoramique de

chaque portée d’un instrument à portées multiples (par ex. le piano, l’orgue, etc.).

% Activer Utiliser le même emplacement pour les instruments similaires si vous devez

limiter le nombre d’emplacement et de canaux que Sibelius utilise pour exécuter la partition.

Avec cette option activée, Sibelius essaiera de partager des instruments similaires (par ex.

tous les bois, tous les cuivres, toutes les cordes) sur le même emplacement ou le même canal.

% Utiliser des variantes de son pour des instruments identiques indique à Sibelius qu’il

doit essayer de détecter des sons équivalents mais différents quand plusieurs instrument

utilisent le même son de base (par ex. les premiers et seconds violons dans une partition

d’orchestre, ou quatre saxophones dans un partition de big band) pour réduire l’homogénéité

du sons. L’efficacité de cette option dépend des possibilités des périphériques d’exécution

utilisés.

% Désactivez Assigner automatiquement un emplacement pour la piste du métronome
si vous n’utilisez jamais la saisie en mode Flexi-time ou que vous ne voulez jamais entendre le

métronome lors de l’exécution. En désactivant cette option, Sibelius ne réservera pas un

emplacement ou un canal pour la piste de métronome, la libérant pour un autre son (et cela

évitera à Sibelius le chargement d’un patch de percussion inutile). Cependant, si vous lancez

par la suite une saisie en mode Flexi-time ou si vous voulez entendre le métronome durant

l’exécution, Sibelius ne chargera pas le son du clic approprié sauf si vous réactivez cette

option. C’est pourquoi il est plutôt recommandé de la laisser activée.

* Dans le groupe Messages MIDI:

% Réinitialiser les contrôleurs au démarrage: impose à Sibelius de réinitialiser tous les

contrôleurs quand démarre l’exécution; si vous utilisez un Proteus 2, désactivez cette option

% Envoyer la banque supérieure (contrôleur 0) et Envoyer la banque inférieure
(contrôleur 32): ces options imposent à Sibelius d’envoyer les numéros de banque quand

sont envoyés des messages de changement de programme; si vous utilisez un Roland SC-88

ou un Korg 05RW, vous devriez désactivez cette option si l’envoi des messages de banque

change le mode du périphérique MIDI ou entraîne le choix d’une banque non GM. (Ces

réglages exercent un contrôle global quand Sibelius envoie les messages de banque, mais vous

pouvez aussi le faire portée par portée dans la fenêtre de Fenêtre > Table de mixage –

b 4.3 Table de mixage.)

% Envoyer les changements de programme: cette option indique à Sibelius s’il faut envoyer

des changements de programme quand commence l’exécution. Vous désactiverez cette option

si vous devez spécifier le patch utilisé par un canal MIDI spécifique dans la partition (par ex.

si vous utilisez un programme tel que Gigasampler pour l’exécution).

% Convertir les vélocités de l’exécution enregistrée en nuances pour les instruments
qui tiennent les notes signifient que les vélocités de l’exécution enregistrée sont converties

en nuances plutôt qu’en attaque pour les instruments qui tiennent les notes en utilisant la

molette de modulation pour le volume (par ex. dans Garritan Personal Orchestra).

% Envoyer commandes de “désactivation de toutes les notes” est une option spéciale de

“passage en force” pour les périphériques au comportement anormal qui ne répondent pas

aux messages MIDI standard lors de l’arrêt de l’exécution. Si vous estimez que les notes
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continuent souvent à retenir quand vous arrêtez l’exécution, essayez d’activer cette option:

Sibelius enverra ensuite un message de désactivation explicite pour chaque note retentissant

au moment où vous arrêtez l’exécution.

* Dans le groupe Erreur rapportée, vous pouvez décider si Sibelius doit vous Avertir en cas
d’erreurs de retour de périphériques MIDI. Désactiver cette option supprime les erreurs

renvoyées par le système MIDI du système d’exploitation. Il est recommandé de laisser cette

option activée, car le message d’erreur peut s’avérer utile en cas de problème lors de l’exécution et

de la saisie avec des périphériques MIDI externes. Sous Windows, les erreurs relatives à

l’exécution intègrent le code MMSYSTEM/OUT, celles relatives à la saisie le code MMSYSTEM/
IN .

Si vous voyez un message d’erreur au démarrage de Sibelius ou durant l’exécution, il faudra

obtenir du fabricant de la carte-son du périphérique audio impliqué une mise à jour du pilote. Si

aucune mise à jour n’est disponible, ou si aucune différence ne se produit, vérifiez si vraiment il y

a un problème avec l’exécution ou la saisie: certains messages d’erreur sont sans objet, et si cela

vous arrive, vous pouvez supprimer individuellement les messages d’erreur quand ils

apparaissent en activant Ne plus afficher ceci, ou les supprimer collectivement en désactivant

Avertir en cas d’erreurs de retour de périphériques MIDI.
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4.13 MIDI pour les néophytes

Cet article part du principe que le niveau de vos connaissances est quasi nulle. (Il était d’abord

intitulé “Le MIDI pour les idiots” ce qui pouvait passer pour une insulte malgré d’indéniables

qualités lexicologiques.) Lisez cet article si vous ne connaissez que peu de choses à propos du

MIDI. Passez-le, si le MIDI vous est familier.

Pour en savoir plus sur la manière de connecter les périphériques MIDI à l’ordinateur et comment

les configurer, b 4.12 Périphériques d’exécution, et MIDI setup for Windows et MIDI
setup for Mac dans le manuel.

Commençons par le début – qu’est-ce que le MIDI?
MIDI est l’acronyme de Musical Instrument Digital Interface. C’est la norme universelle – et non

pas une chose* – à respecter pour pouvoir connecter des instruments de musique électroniques

entre eux. Les claviers MIDI, les synthétiseurs, les modules de sons, les échantillonneurs et autres

gadgets électroniques peuvent être raccordés l’un à l’autre ainsi qu’à un ordinateur au moyen de

câbles MIDI. Les cartes son et les synthétiseurs logiciels (tels que le QuickTime Music intégré au

Mac) sont également compatibles MIDI, et comme ils sont déjà dans votre ordinateur, aucun câble

n’est à installer pour pouvoir jouer la musique.

Le MIDI est censé rendre la vie plus facile, un peu comme avec les imprimantes: aujourd’hui rien

n’est plus facile que de connecter une imprimante à un ordinateur. Vous souvenez-vous de l’époque

où il était impossible de faire fonctionner une imprimante sans une licence en informatique, et que

son manuel d’utilisation incluait un diagramme complet du circuit imprimé pour l’éventualité où

un composant additionnel devait être soudé ? Ah, le bon vieux temps !

Et bien, en ce qui concerne le MIDI, nous y sommes toujours. Les utilisateurs de périphériques

MIDI sont toujours supposés connaître, pour le moins, une foule de détails techniques tels que les

canaux MIDI, les numéros de programme, de banque, bref tout ce qui en principe ne devrait

concerner que les experts.

(* Cela paraît évident, et pourtant ... nous recevons fréquemment des questions du style:” Quelle est la taille du MIDI ?”)

Numéros de programme et General MIDI
Les sons disponibles à partir des instruments MIDI sont numérotés, généralement de 0 et 127.

Le son de piano pourrait avoir le numéro 0, et le son de flûte le numéro 73. L’idéal aurait été de

parler de numéros d’instrument ou de son, mais dans la pratique et pour d’obscures raisons

historiques, on les appelle “numéros de programmes”. (Parfois aussi on leur donne le nom de

“changement de programme” ou “numéro de patch” ce qui ajoute un peu plus de confusion.)

Jusqu’il y a peu, les numéros de programme n’étaient pas standardisés. Même si la plupart des

périphériques MIDI attribuait le programme 0 à un son de piano (comme ils le font encore

maintenant), le programme 73 pouvait être n’importe quel son. Avant la standardisation, il était

nécessaire d’indiquer à l’ordinateur le numéro de programme souhaité pour chaque instrument de

chaque partition, ce qui pouvait être assez fastidieux. De plus, la même partition jouée sur d’autres

périphériques MIDI, n’utilisait pas nécessairement les sons corrects; une situation loin d’être

satisfaisante.
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Heureusement un nouveau standard a émergé, dénommé General MIDI (GM pour les intimes).

Il s’agit d’une liste de 128 sons qui commence par le son du piano en programme 0, passe par la

plupart des instruments imaginables et se termine par un coup de théâtre, ou plutôt par un coup

de fusil en programme 127. Presque toutes les cartes son et un grand nombre de périphériques

MIDI respectent ce standard, mais proposent parfois des sons supplémentaires. Les instruments

MIDI professionnels sont moins susceptibles d’être compatibles avec la norme General MIDI.

Plus récemment, les fabricants de périphériques MIDI se sont réunis pour ratifier quelques

amendements au standard General MIDI, et il en a résulté la norme General MIDI 2, ou GM 2.

Cette nouvelle norme GM2 ajoute, entre autres, 128 sons supplémentaires à la liste standard, mais

n’est pas encore très répandue. Généralement les périphériques MIDI affichent un logo GM ou

GM2 pour indiquer avec quelle norme ils sont compatibles.

Voici comment fonctionnent les numéros de programme dans Sibelius: lorsqu’on crée une portée

de flûte, Sibelius règle son numéro de programme sur 73, qui est le numéro General MIDI pour un

son de flûte. Donc, quel que soit le périphérique General MIDI utilisé pour exécuter la partition, le

son correct sera reproduit. C’est aussi simple que cela.

De plus, si un périphérique non General MIDI lui est connecté, Sibelius sera capable de modifier le

numéro de programme de manière à en utiliser le meilleur son de flûte disponible. Il suffira

simplement d’avoir indiqué préalablement à Sibelius de quel périphérique il s’agissait. Par

conséquent Sibelius est compatible avec n’importe quel périphérique MIDI.

Numérotation à partir de 0
Le MIDI est affligé d’une autre complication dont on se serait bien passé: dans certains manuels, la

numérotation des programmes se fait de 0 à 127 alors que dans d’autres elle s’établit de 1 à 128.

(Cela est dû au fait que pour d’obscures raisons techniques, les programmeurs comptent à partir de

0, et lorsqu’ils conçoivent les rouages internes des périphériques MIDI, ils ont du mal à quitter leur

petit monde et à se rappeler que les gens normaux comptent à partir de 1.)

Conséquence: lors de la configuration de certains périphériques MIDI, il est nécessaire d’ajouter 1

aux numéros de programme pour obtenir le son correct. En principe, Sibelius réalise quasi

toujours la correction; inutile donc de trop s’en préoccuper

Banques: variantes de sous
Certains instruments MIDI peuvent jouer des centaines de sons différents, même si la

numérotation des programmes ne se réalise que jusqu’à 127. Cette limitation est dépassée en

organisant les sons supplémentaires en groupes ou “banques” de numéros de programme. Pour y

accéder, vous devez spécifier le numéro de banque tout autant que le numéro de programme.

Un numéro de banque consiste en deux valeurs, mais souvent les périphériques MIDI se

contentent d’en spécifier une seule (l’autre étant implicitement 0).

Canaux
Si vous commencez à être saturé de détails techniques sur le MIDI, sautez ce paragraphe.

Les canaux sont souvent la première chose dont on entend parler à propos du MIDI. Avec Sibelius,

ils sont presque sans importance. La plupart des instruments MIDI ne peuvent pas jouer plus de

16 sons différents à la fois (c’est-à-dire 16 timbres différents), même si le nombre maximum de
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notes qui peuvent être jouées simultanément est de 32 ou plus. Donc on peut considérer que le

périphérique MIDI contient 16 portées appelées “canaux” qui ne peuvent jouer qu’un timbre à la

fois. Sibelius, ou tout périphérique qui lui est connecté, produit différents timbres en spécifiant sur

quel canal chaque note ou accord est joué. D’autres paramètres tels que le volume (contrôlé au

moyen d’un curseur dans la table de mixage de Sibelius), la position dans l’espace (dite position du

panoramique pour l’effet stéréo) et les pédales de piano s’appliquent également au canal, pas aux

notes individuelles.

Autres termes MIDI
Bien d’autres termes MIDI existent tels que Glossaire: aftertouch, changement de contrôleur,

NoteOn, NoteOff, position du panoramique, pitch bend, piste, vélocité, volume.

Fichiers MIDI 
Les fichiers MIDI sont des fichiers musicaux au format standard – parfois appelé format Standard

MIDI File (SMF). Presque tous les programmes musicaux et quelques claviers peuvent les

sauvegarder (exporter) et les ouvrir (importer). De nos jours, il est possible d’acheter des

disquettes de fichiers MIDI de sa musique favorite chez son marchand de musique. Sur Internet,

on propose également des quantités de fichiers MIDI; ayez à l’esprit cependant que nombreux sont

les fichiers qui violent un copyright et donc sont illégaux.

Les fichiers MIDI peuvent s’utiliser comme un moyen de transférer de la musique entre Sibelius et

à peu près n’importe quel autre programme musical. Cependant, ils sont conçus pour jouer de la

musique plutôt que pour la noter et l’imprimer. Par conséquent, ils n’intègrent pas un grand

nombre d’informations importantes que nécessitent l’écriture d’une partition, telles que les liaisons

de phrasés, les articulations et la mise en page. Même la distinction entre Fa# et Solb est ignorée.

En raison de ces limitations et bien que ce soit un standard très largement utilisé, les fichiers MIDI

ne sont pas la panacée pour transférer une partition d’un ordinateur à un autre.

Heureusement, Sibelius est très habile pour convertir des fichiers MIDI en partition ou vice-versa,

et le fait en quelques secondes seulement; b 9.5 Ouvrir des fichiers MIDI et 9.9 Exporter
des fichiers MIDI. Mais n’espérez pas de miracles: convertir une partition en un fichier MIDI

équivaut à peu près à convertir un document texte complexe en document au format ASCII

(simple texte) et à le réimporter dans un traitement de texte: l’information de base est conservée

mais la mise en page et tout le reste est perdu.

Si vous souhaitez convertir de la musique dans Sibelius de Finale en exportant un fichier

MusicXML de Finale, Sibelius peut transférer bien plus d’informations qu’avec des fichiers MIDI –

b 9.6 Ouvrir des fichiers MusicXML.
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4.14 Instruments virtuels pour les débutants

La création musicale a été révolutionnée par les avancées de l’informatique personnelle durant les

deux dernières décades et il semble de plus en plus évident que l’utilisation croissante des

instruments virtuels – des programmes qui émulent l’instrument réel – remplace désormais les

périphériques dédiés (tels que les synthétiseurs MIDI et les modules de sons).

En prenant rapidement parti de la puissante croissante des ordinateurs présents sur nos bureaux et

dans les studios, les instruments virtuels sont devenus intéressants car ils permettent un éventail

infini de sons produits par le même matériel. Avec un périphérique matériel, votre choix de sons

est limité à ce qui a été inclus par le fabricant original; quand vous travaillez dans le monde du

logiciel, votre palette sonore est limitée seulement par l’éventail des instruments virtuels à votre

disposition, avec la possibilité de toujours pouvoir en installer de nouveaux.

Il existe littéralement des milliers d’instruments virtuels de tout type utilisable dans Sibelius, mais

cette profusion peut sembler confuse et intimidante pour un débutant. Essayons d’y voir un peu

plus clair et de dégager quelques lignes directrices.

Qu’est-ce qu’un instrument virtuel?
Comme déjà évoqué ci-dessus, un instrument virtuel est un programme d’ordinateur qui émule

(imite) un instrument réel, qu’il soit électronique comme un synthétiseur numérique ou

analogique, ou (et cela intéresse bien des gens) un instrument acoustique.

En général, les instruments virtuels réalisent cette émulation selon un de ces deux procédés:

exécution de sons échantillonnés, ou synthèse sonore. Un “échantillon” est simplement un

enregistrement numérique d’un son, dans ce cas toujours une note isolée, et de ce fait est le moyen

le plus direct pour reproduire le son d’un instrument acoustique (puisqu’il s’agit de

l’enregistrement original d’un instrument acoustique). “Synthèse” signifie qu’un son est produit

par des moyens mathématiques plutôt que par un enregistrement, sur la base soit d’un modèle qui

décrit le son réel (par exemple synthèse additive), ou d’un modèle qui décrit le mécanisme de

production du son (par exemple la synthèse par modèle).

Instruments virtuels à base d’échantillons
Un bon exemple d’instrument à base d’échantillons est le Sibelius Player intégré: il peut charger des

collections d’échantillons (qu’on appelle d’habitude des “bibliothèques”), les utiliser pour jouer et

charger jusqu’à 128 différents “programmes,” ou sons, en même temps.

À l’époque héroïque du MIDI, un “programme” signifiait un seul son – par exemple un son de violon

archet était un seul programme, et un son de violon pizzicato était un autre. Cependant, dans le

monde des instruments à base d’échantillons, un seul programme peut inclure plusieurs sons reliés –

pour continuer l’exemple du violon, non seulement arco et pizzicato mais aussi d’autres techniques

de jeu (parfois connues dans le monde des instruments virtuels sous le terme générique

“d’articulations”) telles que legato, staccato, spiccato, col legno, tremolo, etc...– qui sont tous chargés

dans le même canal et arrangé en couches (layers), ce qui signifie qu’ils font partie du même

programme mais restent cachés tant qu’on ne les appelle pas.
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Vous pouvez passez d’une couche à l’autre en utilisant diverses techniques spéciales, telles que

jouer une note très aiguë ou (ce qui est plus courant) une note très basse sur un clavier MIDI (ce

qu’on appelle une touche-contrôle (en anglais “keyswitch”)), ou en ajustant un contrôleur MIDI

continu (par exemple la molette de modulation sur le clavier MIDI). Les instruments virtuels à

base d’échantillons les plus sophistiqués peuvent assigner n’importe quelle combinaison de

touches-contrôle, de contrôleurs MIDI, et même de contrôleurs MIDI ésotériques tels que ceux

avec souffle (l’utilisateur semble alors jouer un harmonica invisible).

Heureusement, le moteur d’exécution de Sibelius est assez puissant pour pouvoir insérer les

touches-contrôle et pour modifier les contrôleurs MIDI, etc... de la plupart des instruments

virtuels bien connus à base d’échantillons et cela dans le but de sélectionner le son le plus

approprié à tout moment de sorte que vous ne devriez pas vous en soucier.

D’autres instruments virtuels basés sur des échantillons comportent la célèbre Vienna Symphonic

Library, Garritan Personal Orchestra, EastWest Quantum Leap Symphonic Orchestra, Sonivox

Symphonic Orchestra, Miroslav Philharmonik – et ce n’est qu’un petit nombre parmi ceux qui

reproduisent l’orchestre traditionnel! D’autres instruments virtuels sont ciblés sur des groupes

d’instruments ou des genres spécifiques tels que les fanfares et les percussions (par ex. Virtual

Drum Line de Tapspace), des pianos magnifiques (par ex. Synthogy Ivory), des instruments rares

ou ethniques (par ex. EastWest Quantum Leap Ra), des grands chœurs (par ex. EastWest

Symphonic Choirs), des orchestres au swing traditionnel ou des big bands (par ex. Garritan Jazz &

Big Band, Sonivox Broadway Big Band) ou des ensembles rythmiques des années 60 (par ex.

EastWest Fab Four), etc... Heureusement vous pouvez utiliser pratiquement n’importe lequel de

ces instruments virtuels avec Sibelius, de sorte que les possibilités sont quasi illimitées!

Les instruments à base d’échantillons ont tendance à nécessiter un espace disque conséquent ainsi

qu’une bonne quantité de mémoire vive pour pouvoir fonctionner. Certains échantillons sont

tellement lourds que seuls quelques sons peuvent être utilisés en même temps sur un seul

ordinateur (et leur chargement depuis le disque peut prendre jusqu’à 10 minutes avant de jouer

quoi que ce soit!), de sorte qu’il faut trouver le bon compromis entre la qualité et l’efficacité. À ce

sujet pour découvrir quelques astuces et considérations diverses, cf. Comment tirer le
meilleur parti des instruments virtuels et des effets ci-dessous.

Instruments virtuels basé sur la synthèse
Même si les instruments virtuels à base de synthèse sont depuis longtemps parfaits pour

reproduire les synthétiseurs analogiques ou numériques des années 70 et 80 – parfois même en

étant meilleur que l’original – et capable de reproduire fidèlement d’autres sons célèbres tels que

celui de l’orgue Hammond, ce n’est que récemment que les grands progrès dans les techniques de

modélisation physique ont commencé à porter leurs fruits permettant de reproduire de manière

convaincante des instruments acoustiques.

Les instruments virtuels à base de synthèse sont intéressants car ils ne nécessitent pas de

bibliothèques énormes d’échantillons pour produire des sons de qualité: au lieu d’enregistrer

chaque musicien jouant chaque note avec l’articulation désirée, ces instruments construisent un

modèle mathématique complexe pour construire le son, et le résultat est une simulation fidèle des

sons réels. Les instruments modélisés peuvent répondre en temps réel aux sollicitations du

musicien aussi bien que les instruments qu’ils simulent; cette approche peut aussi prendre en
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compte des facteurs subtils tels que la réverbération sympathique et les combinaisons

d’harmoniques selon des voies que les échantillons ne peuvent suivre. En adaptant le modèle

quelque peu, on peut prendre en compte par exemple les différences de conception d’instruments

similaires provenant de fabricants différents (telles que les différences entre des piano Steinway et

Bechstein); il est donc possible de produire une large éventail de sons sans avoir à jouer et à

enregistrer chaque note de chaque instrument.

Certains des instruments virtuels les plus impressionnants qui suivent cette approche de modèle

physique comprennent Pianoteq (avec des modèles de grand piano ou d’exemplaire historique),

Lounge Lizard (qui modélise les pianos électriques Wurlitzer et Rhodes electric pianos) et String

Studio (avec des modèles d’instruments à corde tels que la guitare, le clavinet et la harpe).

Un type intéressant d’instruments virtuels hybrides est aussi apparu en combinant à la fois

échantillons et synthèse pour produire des instruments virtuels qui capturent le caractère réel des

sons échantillonnés sans nécessiter des bibliothèques énormes d’échantillons. Un bel exemple

d’instrument virtuel qui suit cette approche est le Synful Orchestra.

Les instruments à base de synthèse, particulièrement ceux qui emploient le modèle physique

tendent à solliciter davantage la puissance du CPU que les instruments basés sur des échantillons,

mais nécessitent nettement moins d’espace disque et de RAM.

Les technologies d’instruments virtuels
Il existe de nombreuses technologies au nom parfois confus utilisées à la fois par les instruments

virtuels à base d’échantillons et de synthèse; certains sont spécifiques aux PC sous Windows,

d’autres aux Macs, et enfin, existent ceux qui ne fonctionnent qu’associés à certains logiciels.

Sibelius est compatible d’une manière générale avec les instruments virtuels qui suivent les

standards VST et Audio Units. VST est l’abréviation de “Virtual Studio Technology,” un format qui

a été inventé par Steinberg. Les instruments virtuels au format VST (parfois abrégés en “VSTi”)

peuvent être utilisés à la fois sous Windows et sur Mac. Le format Audio Units (parfois abrégés en

AU) a été inventé par Apple, et les instruments sous ce format ne peuvent être utilisés que sur Mac.

Il existe plusieurs autres formats d’instruments virtuels, tels que le RTAS (Real Time Audio Suite)

et le TDM (Time Division Multiplexing), tous les deux utilisés par Pro Tools, DXi (DirectX

Instrument) et MAS (MOTU Audio System). Pour le moment Sibelius n’en supporte aucun.

Cependant, la plupart des instruments virtuels sont disponibles à la fois aux formats VST et Audio

Unit.

Même s’il y a des différences significatives entre les technologies VST et AU (et aussi entre les

autres formats) pour autant, il n’y a aucune différence pratique au niveau de l’utilisateur.

Les instruments virtuels comme “extensions”
Vous entendrez couramment parler des instruments virtuels qui suivent le standard VST et en

particulier ceux appelés “extensions VST”. Le mot “extension” est utilisé pour décrire toute partie

de logiciel qui peut opérer à l’intérieur d’un autre environnement logiciel (un “programme dans le

programme” en somme). Par simplicité cependant, chaque fois que vous verrez le mot “extension”

dans cet ouvrage de référence, il fera référence aux extensions existant dans le menu Extensions
de Sibelius (b 6.1 Travailler avec des extensions), et non aux instruments virtuels.
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En plus d’une utilisation dans une application “hôte”, telle que Sibelius ou Pro-tools, beaucoup

d’instruments virtuels peuvent aussi fonctionner en mode “individuel”, ce qui signifie qu’ils

peuvent fonctionner de manière autonome sans hôte, ce qui est l’idéal pour une exécution en

concert.

Effets
En plus d’utiliser des instruments virtuels, Sibelius peut aussi ajouter des effets, ce qui mérite un

mot d’explication. Les effets sont des programmes qui produisent un signal audio permettant de

changer une ou plusieurs caractéristiques d’un son. Comme les instruments virtuels, ils imitent

des vrais périphériques, tels que des amplis de guitare ou des compresseurs à tube, et parfois ils

émulent des phénomènes sonores naturels telle que la réverbération.

Voici quelques uns des types d’effets les plus répandus que vous puissiez rencontrer:

* Filtres; ce sont des effets qui atténuent (réduisent) quelques fréquences du signal audio, sans

affecter les autres. En réalité, beaucoup d’effets (dont la plupart de ceux qui figurent ci-dessous)

sont des filtres d’une sorte ou de l’autre, mais quand les gens parlent de “filtres” ils pensent à des

choses comme le wah-wah, qui produit un son caractéristique en variant les fréquences qui

traversent le filtre, et à l’équalisation ou effets “EQ”, qui atténuent certaines gammes de

fréquences et en augmentent d’autres. Utiliser l’EQ peut permettre de compenser les

imperfections d’un signal audio ou d’une réponse de fréquences sans balance dans des

équipements de reproduction audio.

* Compresseurs; ce sont des effets qui compressent la gamme dynamique d’un signal audio,

rendant plus doux les sons très forts et plus forts les sons très doux. Le but est de parvenir un son

plus uniforme, plus compact. La compression est particulièrement utile pour les percussions, les

guitares basse et autres instruments du rock, même si beaucoup d’enregistrements – qu’ils soient

de musique rock & pop, jazz ou classique – font usage de cet effet. On rencontre aussi des

limiteurs, qui sont de simples compresseurs fournissant une grande compression, et qui sont

utilisés pour éviter la distorsion (ou “clipping”) lors d’émission de grands volumes sonores.

* Distorsion: c’est un effet qui altère la forme originale des ondes du signal audio. Bien que la

distorsion soit en général indésirable, c’est elle qui donne aux guitares électriques leur son

agressif caractéristique. Les types extrêmes d’effets de distorsion émulent le son appuyé et riche

en harmoniques des amplificateurs, des haut-parleurs et des pédales d’effets, mais aussi le son

chaleureux produit par les amplificateurs à tube ou les enregistreurs à bande.

* Retard: c’est un effet qui retient le signal audio à l’entrée, et ne joue qu’après un moment spécifié

(toujours très court). Le son retardé peut être joué plusieurs fois, ou rejoué dans le retard, créant

un effet d’écho s’affaiblissant. Ne confondez pas retard avec réverbération (cf. ci-dessous).

* Modulation: c’est un effet qui multiplie le signal audio d’entrée, soit avec en le copiant ou en le

combinant avec d’autres ondes. Les effets habituels de modulation sont le chorus, le flanging et le

phasing. L’effet de chorus consiste à mélanger le signal audio d’entrée avec une ou plusieurs

copies de lui-même, légèrement en retard et de hauteur modifiée, simulant le son de plusieurs

instruments ou de plusieurs voix alors qu’en réalité il n’y en a qu’un(e). L’effet de “flanging”

produit un son de soufflerie en se recopiant sur lui-même avec un léger retard variant de

manière continue. Il s’appelle ainsi, car selon la légende, il aurait été découvert par accident: lors

d’une session d’enregistrement des Beatles, on aurait touché le bord d’une bobine (en anglais
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“flange”) d’un enregistreur utilisé pour produire un effet de retard, ce qui changea la hauteur

légèrement. L’effet de phasing est similaire, excepté qu’il fait passer le signal audio d’entrée à

travers un filtre simultanément plutôt qu’avec un léger retard. Le filtre lui-même répond

différemment selon les différentes fréquences, ce qui produit des petits retards de longueur

différente en fonction des fréquences. Le résultant est un son moins soufflant que celui

caractéristique du “flanging”.

* Réverbération, ou “réverb” pour faire court, est un effet qui simule la manière dont le son se

réfléchit sur les différentes surfaces d’une pièce. Le Sibelius Player intégré de Sibelius inclut deux

effets de réverb de haute qualité, que vous pouvez découvrir dans Réverbération à la page

325.

Si vous avez le tournis après tout ceci, pas de panique. Commencez modestement en

expérimentant la réverbération, qui est peut-être l’effet qui produit la plus grande différence dans

les sons des instruments virtuels. Sibelius Player possède sa propre réverbération, mais vous

pouvez ajouter un effet de réverbération séparé, si vous le souhaitez. Une fois la réverbération

maîtrisée, jouez avec la compression, qui égalise les nuances. Réglez-en les limites à -3dB ou -6dB,

pour éviter de tout couper. (Vous voyez, vous êtes déjà un expert!)

Si vous voulez essayer des effets, vous pouvez en charger gratuitement un grand nombre sur le

web, telles que les séries Kjaerhus Classic (www.kjaerhusaudio.com; Windows uniquement) ou

les effets audio Unit de Smartelectronix (mda.smartelectronix.com/effects.htm; Mac

uniquement).

Mais prudence! En pénétrant dans le monde des effets, vous risquez rapidement de vous retrouver

à parler de “chaleur” et de “sensibilité” d’un son, puis à utiliser le jargon ad hoc tel que “riding the

gain,” jusqu’à vous enthousiasmer pour les “slapback echoes”... et à ce stade tout espoir est perdu.

Comment tirer le meilleur parti des instruments virtuels et des effets
L’inconvénient avec les instruments virtuels c’est qu’ils accaparent des ressources de l’ordinateur

essentielles pour le système d’exploitation et encore plus pour Sibelius. Vous constaterez que plus

vous voulez installer d’instruments basés sur les échantillons et plus d’espace disque est nécessaire;

de même, plus vous faites tourner de tels instruments ensemble et plus rapide doit être le

processeur et plus grande la RAM. (Avec les instruments virtuels à base de synthèse, la RAM et

l’espace disque sont moins importants, au contraire de la vitesse du processeur.)

Fournir assez d’espace disque est un problème simple à résoudre: les disques durs sont désormais

bon marché, de grande capacité et simple à ajouter (il ne faut même plus ouvrir l’ordinateur si vous

possédez une connexion USB 2.0 ou Firewire). D’habitude, il est recommandé d’installer les

échantillons sur un lecteur séparé de celui utilisé pour le système d’exploitation et les applications,

car cela améliore les temps d’accès.

Les spécifications pour la RAM se compliquent nettement plus vite, sans parler de la technique – si

les expressions “32-bit” et “64-bit” vous effraient ou n’évoquent rien, passez les deux paragraphes

suivants: la recommandation principale concernant la RAM est d’en avoir le plus possible,

idéalement 2GB ou plus.

La plupart des ordinateurs sous Windows vendus ces dix dernières années utilisent des

microprocesseurs à 32 bits, qui peuvent adresser un maximum de 4 Go de RAM (ils ne peuvent en

http://www.kjaerhusaudio.com/
http://www.kjaerhusaudio.com/
http://mda.smartelectronix.com/effects.htm
http://mda.smartelectronix.com/effects.htm
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“voir” plus même si vous en installez plus), mais les versions de Windows à 32 bits ont une

utilisation limitée de la mémoire supérieure à 2 Go ; de ce fait, la capacité maximum recommandée

est de 2 Go. Une fois que la mémoire est prise par le système d’exploitation et Sibelius, il ne vous

reste plus qu’approximativement 1 Go de RAM pour charger les échantillons. La situation est

similaire sur les Macs : bien qu’en théorie les Mac OS X peuvent adresser de manière aisée plus de

2 Go de RAM, les programmes individuels ne peuvent généralement pas exploiter plus de 4 Go de

RAM.

L’un des principaux avantages d’un ordinateur à 64 bits est sa capacité à franchir la barre des 4 Go.

Les ordinateurs qui utilisent des processeurs 64-bits peuvent en théorie adresser jusqu’à 32

exabytes de mémoire (c’est-à-dire 16 millions de GB!), bien qu’en pratique la plupart des

ordinateurs disponibles actuellement accepteront 6 GB. Cependant dans le but de tirer parti du

supplément de puissance d’un processeur 64 bits, vous devez avoir un système d’exploitation 64

bits, et toutes les applications, y compris les programmes hébergeant des instruments virtuels et

les instruments virtuels eux-mêmes doivent être mis à jour pour profiter de cette capacité accrue.

La plupart des applications – y compris Sibelius et bien des séquenceurs ou DAW – sont toujours à

32 bits. De ce fait, les avantages d’un matériel informatique à 64 bits sont largement théoriques, et

probablement une année ou deux seront nécessaires avant que les systèmes d’exploitations,

applications et instruments virtuels à 64 bits soient répandus.

Cependant, les applications à 32 bits telles que Sibelius peuvent avoir accès à jusqu’à 4 Go de RAM

sur des systèmes d’exploitation à 64 bits, donc si vous possédez un processeur et un système

d’exploitation à 64 bits, vous constaterez probablement les avantages en installant une mémoire

supérieure à 4 Go de RAM.

Pour le moment, des utilisateurs très avertis possèdent souvent plusieurs ordinateurs reliés entre

eux dans leur studio, chacun tournant avec différents instruments virtuels tous contrôlés par un

autre ordinateur. C’est tout à fait à éviter pour les cardiaques (ou les gens fauchés).

Si vous avez tenu le coup jusqu’ici, continuez parce cela va devenir encore plus intéressant.

Tout ceci signifie que pour la plupart des mortels que nous sommes il existe des limites au nombre

d’instruments virtuels ou de sons qui peuvent être joués simultanément sur un ordinateur, parce

que la sollicitation principale de l’ordinateur concerne l’exécution.

En partant du principe que vous possédez un ordinateur récent avec 2GB RAM, une rapide

estimation permet d’estimer que vous pouvez jouer environ entre 32 et 40 sons simultanément en

temps réel, même si cela dépend très fort de la nature des sons utilisés.

Il existe cependant deux bonnes astuces pour améliorer cela avec Sibelius. En premier lieu, vous

pouvez très facilement basculer entre différents jeux d’instruments virtuels, de sorte que vous

pouvez utiliser une combinaison légère puis passer à une combinaison plus complexe et plus

gourmande pour écouter une exécution. En second lieu, même si l’ordinateur piétine pour réaliser

l’exécution en temps réel, vous pouvez utiliser la fonction Fichier > Exporter > Audio pour

exporter un fichier audio de la partition, et Sibelius jouera la partition en interne, plus lentement

que le temps réel pour permettre à l’ordinateur de garder la maîtrise du processus –

b 9.10 Exporter des fichiers audio.
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Outre l’espace disque, la RAM et la vitesse du processeur dont il faut tenir compte, l’utilisation des

instruments virtuels implique de posséder une interface audio de qualité ou une carte-son audio

pro; cela est particulièrement important sur les PC sous Windows (La partie matérielle audio

intégrée des Macs actuels convient pour l’exécution), spécialement si vous voulez utiliser des

instruments virtuels pour produire des sons autant durant la saisie des notes que lors de

l’exécution.

Quand vous faites la saisie des notes avec un clavier de contrôle MIDI, il faut pouvoir entendre

quasi instantanément le retour (sinon on ne joue pas en mesure pour compenser le retard entre le

jeu et ce que l’on entend). Le retard entre l’ordre envoyé à l’ordinateur pour jouer une note et son

audition s’appelle la “latence”, et une latence de plus de 20ms est trop élevée et entraîne des erreurs

de saisie.

Pour réduire la latence, vous devez réduire le temps que prend le MIDI pour envoyer les messages

d’entrée dans l’ordinateur et, encore plus important, le temps pour la sortie audio. Une interface

audio ou une carte-son de haute qualité peut réduire la latence jusqu’à 5ms ou moins encore. Les

cartes-son dédiées à l’utilisation de jeux vidéo ne sont pas réellement propices pour les

applications audio en temps réel et l’utilisation des instruments virtuels; il vaut mieux s’intéresser

aux cartes spécifiquement conçues pour les applications audio. Pour les cartes-son sous Windows,

le support de l’ASIO est essentiel (ASIO est une autre des technologies de Steinberg qui fournit un

bon support pour des exécutions avec une latence basse). Les cartes-son avec un bon support ASIO

sont conçues par des fabricants tels que M-Audio, Digidesign, Presonus, RME, Echo Digital, et

d’autres. Une carte-son audio professionnelle d’entrée de gamme telle que la Audiophile 2496 de

chez M-Audio vaut autour de $100 (70€), et peut coexister de manière pacifique avec votre

matériel audio, mais fonctionnera bien mieux qu’une carte-son à vocation ludique qui coûtera

deux fois plus cher.

Pour en savoir plus
Il existe des centaines de sites web et d’autres ressources susceptibles de vous apporter de l’aide

pour approfondir vos connaissances du monde des instruments virtuels et des effets. En voici

quelques uns:

* Virtual Instruments magazine (www.virtualinstrumentsmag.com)

* Sound on Sound magazine (www.soundonsound.com)

* KVR Audio, une source importante d’instruments virtuels et d’effets gratuits, et des

informations à jour sur les produits commerciaux (www.kvraudio.com)

* Northern Sound Source, un des plus grands forums de technologie musicale et de compositeurs

sur le web (www.northernsounds.com)

* BigBlueLounge.com, une autre des plus grandes sources et communautés sur le web pour la

musique et la production audio (www.bigbluelounge.com)

http://www.virtualinstrumentsmag.com/
http://www.soundonsound.com/
http://www.kvraudio.com/
http://www.northernsounds.com/
http://www.bigbluelounge.com/
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4.15 Travailler avec des instruments 
virtuels

Cette rubrique procure quelques exemples sur la manière d’utiliser les différents instruments

virtuels avec Sibelius.

Si vous souhaitez une introduction au monde des instruments virtuels, b 4.14 Instruments
virtuels pour les débutants avant de commencer. Si vous n’êtes pas familiarisé avec la boîte de

dialogue Exécution > Périphériques de lecture, b 4.12 Périphériques d’exécution.

Il y a deux types d’instruments virtuels abordés dans cette rubrique:

* ceux qui peuvent jouer plusieurs sons simultanément, que nous appellerons les instruments

virtuels multi-canaux, tels que Kontakt, Steinberg Halion, MOTU MachFive, EastWest Play, etc.

* ceux qui ne peuvent jouer qu’un seul son à la fois, que nous appellerons les instruments virtuels à

un seul canal, tels que TruePianos, Pianoteq, Garritan Steinway, B4, Lounge Lizard, etc.

Le Sibelius Player intégré, et les lecteurs d’échantillons de type Kontakt Player ou ARIA font partie

du premier groupe, mais sont traités spécifiquement, parce que Sibelius peut charger les sons

automatiquement dans cet instrument virtuel. Pour tous les autres instruments virtuels, qu’ils

soient simples ou multi-canaux, vous devez charger les sons vous-même.

Sibelius Sounds Essentials
Sibelius Sounds Essentials est la bibliothèque de sons fournie avec Sibelius, et qui joue en utilisant

le Sibelius Player intégré – b 4.4 Sibelius Sounds Essentials.

Autres bibliothèques de sons Kontakt et ARIA
Le nombre de bibliothèques d’échantillons qui utilisent Kontakt Player et Aria n’arrête pas

d’augmenter, et toutes peuvent être utilisées avec Sibelius. Ces bibliothèques présentent l’avantage

que Sibelius est capable de charger les sons nécessaires pour jouer la partition automatiquement,

pourvu qu’un jeu de sons soit disponible.

Les bibliothèques les plus populaires comportent Garritan Personal Orchestra, Garritan Jazz et Big

Band, Garritan Concert et Marching Band, Tapspace Virtual Drumline, Vir2 VI.ONE, entre autres.

La manière la plus simple pour commencer avec une de ces librairies consiste à choisir parmi les

configurations d’exécution existantes, par ex. Sibelius Essentials (16 sounds), puis de cliquez sur

Nouveau et de tapez un nouveau nom, par ex. GPO. Il suffit ensuite de sélectionner dans la

colonne Jeu de sons ce qui convient pour la bibliothèque que vous utilisez, puis de cliquez sur

Fermer.

Pour en savoir plus:

* Garritan libraries: cf. le wiki Garritan à l’adresse http://www.garritan.info/.

* Virtual Drumline: cf. http://www.tapspace.com/support/.

http://www.garritan.info.
http://www.tapspace.com/support/
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Combiner différentes bibliothèques de sons
Il est très utile de pouvoir combiner des sons de plusieurs bibliothèques dans la même

configuration. Par exemple, Garritan Personal Orchestra ne possède aucun son de voix, de sorte

que pour une partition avec orchestre et chœur il faudrait combiner les sons de Sibelius Sounds

Choral avec vos sons d’orchestre.

Pour réaliser cela, il suffit de créer une nouvelle configuration d’exécution avec au moins une

occurrence de GPO (soit ARIA ou Kontakt Player 2, selon votre version de GPO), réglez le jeu de

sons approprié; puis activez Sibelius Player, et réglez-le sur le jeu de sons Choral (voire le jeu de

sons Essentials Choral Combo). Lors de l’exécution, Sibelius choisira automatiquement d’utiliser

Sibelius Sounds Choral et pour les autres portées d’utiliser GPO.

D’autre part, vous pouvez aussi, si vous le souhaitez, combiner des bibliothèques qui proposent des

sons pour les mêmes instruments. Par exemple, Garritan Jazz et Big Band ne proposent pas autant

de sons de claviers et de guitares que Sibelius Sounds Essentials, si bien qu’on peut imaginer

combiner les sons d’une guitare électrique de Sibelius Sounds Essentials avec les sons de Jazz and

Big Band.

Pour réaliser cela, créez une configuration d’exécution avec au moins une occurrence du lecteur

d’échantillons Jazz et Big Band (soit ARIA ou Kontakt Player 2), réglez sur le jeu de sons Garritan
JABB; puis activez Sibelius Player, et réglez-le sur le jeu de son Essentials.

À présent, indiquez à Sibelius d’utiliser les guitares de Sibelius Sounds Essentials, choisissez la

page Sons préférés de Exécution > Périphériques d’exécution, et dans la liste hiérarchique des

sons ID à gauche de la boîte de dialogue, sélectionnez Guitare > Électrique. A droite, choisissez

Sibelius Player, et cliquez sur Ajouter. Enfin, cliquez sur Fermer.

Traiter les périphériques de type Kontakt comme les autres instruments 
virtuels

Par défaut, Sibelius charge toujours les sons automatiquement dans Kontakt Player et

l’échantillonneur Kontakt intégral. Si vous ne voulez pas que Sibelius traite les périphériques de

type Kontakt comme les autres instruments virtuels, activez Autoriser des jeux de sons
manuels dans la page Exécution de Fichier > Préférences (dans le menu Sibelius sur Mac).

Quand cette option est activée, vous pouvez choisir Kontakt Player 2 et activez Utilisez un jeu de
sons manuel dans la page Jeu de sons manuels de Exécution > Périphériques de lecture, dans

le but de suivre les procédures décrites ci-dessous.

Utiliser un instrument virtuel multi-canal avec un jeu de sons
Dans le but que Sibelius puisse tirer le meilleur parti des caractéristiques évoluées des

bibliothèques d’échantillons actuelles, telles que les touches d’instruction pour choisir entre les

techniques de jeu et l’automatisation des contrôleurs qui agissent sur la qualité du son (par ex. les

nuances) il est recommandé d’avoir un jeu de sons pour chaque bibliothèque. Considérons que

nous allons utiliser les sons du Vienna Symphonic Library (VSL) Special Edition via l’application

Vienna Ensemble, qui vous permet de charger jusqu’à 16 instruments Vienna en même temps (à

condition que votre ordinateur compte suffisamment de mémoire).
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Pour commencer, créez une nouvelle configuration d’exécution: sur la page Activer
périphériques de Exécution > Périphériques de lecture, cliquez sur Nouveau et attribuez un

nom à votre configuration, puis sélectionnez Vienna Ensemble dans la liste Périphériques
disponibles et cliquez sur Activer pour l’ajouter à la liste Périphériques actifs. Choisissez le jeu

de sons VSL Ensemble Special Edition dans le menu de la colonne Jeu de sons.

Maintenant allons à la page Jeux de sons manuels. Il s’agit d’indiquer à Sibelius dans quel canal

de Vienna Ensemble se trouve chaque son. Cliquez sur Afficher pour afficher la fenêtre principale,

et procédez au chargement du son souhaité dans chaque canal. Dans la page Jeux de sons
manuels, activez Utiliser les jeux de sons manuels puis assurez-vous que Nbe. de canaux est

réglé sur la valeur appropriée. Maintenant pour chaque canal, choisissez le Programme dans la

liste proposée, et cliquez sur Appliquer pour chacun d’eux. Quand le chargement des sons dans

Vienna Ensemble et le choix du même programme pour chaque canal est terminé dans la page

Jeux de sons manuels, cliquez sur Fermer.

Lors de l’exécution Sibelius assignera désormais automatiquement à chaque portée le programme

approprié chargé dans Vienna Ensemble et tirera profit des touches d’instructions et autres

contrôleurs d’informations définis dans le jeu de sons.

Si vous voulez assigner manuellement une portée spécifique à un canal particulier, vous pouvez le

faire avec la table de mixage: tout d’abord, déployez la rangée de la portée, puis choisissez le

périphérique dans le menu périphérique (de manière à ce que son nom ne soit plus entre-

parenthèses), puis choisissez le son désiré dans le menu son. Vous pouvez aussi utiliser les flèches à

droite du numéro de canal pour changer de canal directement.

Pour en savoir plus sur l’utilisation de VSL Special Edition avec Sibelius, cf. www.sibelius.com/
helpcenter/en/a555.

Vous pouvez également trouver des informations sur l’utilisation de Synful Orchestra, un autre

instrument virtuel multi-canal, avec Sibelius à cette adresse : www.sibelius.com/helpcenter/
en/a554

Les jeux de sons pour d’autres instruments virtuels multi-canal sont disponibles depuis le site Web

de Jonathan Loving http://jonathanloving.googlepages.com/, mais veuillez noter que l’aide

technique de Sibelius ne peut apporter aucune assistance à ces jeux de sons tiers.

Utiliser un instrument virtuel multi-canal sans jeu de sons
Il est également possible d’utiliser une bibliothèque d’échantillons telle que EWQLSO sans jeu de

sons, même si cela empêche Sibelius d’utiliser des notes de touches d’instructions ou d’autres

données d’automatisme. Pourvu que vous connaissiez les capacités de votre bibliothèque

d’échantillons et que vous soyez à l’aise dans la programmation manuelle (par ex. en ajoutant

~Nx,y, des messages MIDI pour les touches d’instructions, et en utilisant Extensions >

Exécution > Ajouter des changements de contrôleur pour des données d’automatisme), vous

devriez obtenir un bon résultat.

La procédure pour effectuer le réglage est identique à la procédure Utiliser un instrument
virtuel multi-canal avec un jeu de sons décrite ci-dessus, jusqu’au moment où on affiche

l’interface de l’échantillonneur et on charge les programmes dans chaque canal. Sur la page Jeux

http://www.sibelius.com/helpcenter/en/a555
http://www.sibelius.com/helpcenter/en/a555
http://www.sibelius.com/helpcenter/en/a554
http://www.sibelius.com/helpcenter/en/a554
http://jonathanloving.googlepages.com/
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de sons manuels de Exécution > Périphériques d’exécution, activez Utiliser un jeu de son
manuel: notez que le menu Programme est désactivé, parce que vous n’avez pas de jeu de sons.

Si vous voulez que Sibelius tente d’assigner chaque canal à chaque portée automatiquement, vous

devez maintenant choisir un son ID approprié pour chaque canal. Par exemple, si vous avez une

section de violons chargée dans le premier canal, choisissez un son ID de

strings.violin.ensemble; si vous avez un son de hautbois chargé dans le second canal, choisissez

wind.oboes.oboe, et ainsi de suite. Cliquez sur Appliquer après avoir choisi chaque son ID, puis

cliquez sur Fermer quand vous avez terminé.

Si, cependant réaliser l’assignation de chaque portée manuellement est une tâche qui vous

épanouit, vérifiez simplement que Utiliser le jeu de son manuel est activé, et que le nombre

correct de canaux est choisi, puis cliquez sur Sauvegarder et Fermer. Si à ce moment vous lancez

l’exécution, vous n’entendrez rien car Sibelius ne sait pas quel canal produit quel son. En utilisant la

table de mixage, vous devez maintenant choisir explicitement le périphérique à utiliser pour

chaque portée (de manière à ce que son nom ne soit plus entre-parenthèses), et ensuite régler le

canal en utilisant les flèches à droite du numéro de canal.

Le plus gros inconvénient à l’utilisation d’une bibliothèque d’échantillons sans jeu de sons est

l’impossibilité de faire jouer des percussions à sons indéterminés sauf si le programme des

percussions à sons indéterminés est assigné de la même manière que les percussions General

MIDI. Pour faire jouer d’autres percussions à sons indéterminés, vous devez créer un fichier de

jeux de sons, au moins pour ces programmes.

Utiliser un instrument virtuel multi-canal avec plusieurs programmes par 
canal

Quelques échantillonneurs permettent de régler des banques, qui permettent d’accéder à plusieurs

programmes sur le même canal, en utilisant des changements de programmes MIDI. Cela signifie

qu’il est par exemple possible de régler les différentes techniques de jeu pour le même instrument

(par exemple une banque de violon chargée avec le coup d’archet en legato, en staccato, le trémolo

et le pizzicato, accessible par les changements de programmes 1 à 4).

Comme décrit ci-dessus, vous pouvez charger chaque banque directement dans l’interface de

l’échantillonneur manuellement.

Si vous voulez que Sibelius gère automatiquement l’exécution, il y a deux approches: si vous avez

un fichier jeu de sons, Sibelius peut non seulement assigner automatiquement chaque portée au

canal correct, mais aussi basculer entre les différentes techniques de jeu; si vous n’avez pas de jeu

de sons, vous pouvez choisir le son ID approprié pour le son de base de chaque canal, et ensuite

utiliser des messages MIDI explicites dans la partition pour passer d’une technique de jeu à l’autre

(par ex. ~P2 pour un coup d’archet en staccato).

(petite explication concernant la création d’un jeu de sons pour un arrangement de banques: vous

devez décider avant de commencer avec quelle banque sera chargé le canal de votre

échantillonneur, et donc vous devez régler le masque de canal de manière appropriée pour chaque

canal. Dans notre exemple, considérons que la banque de violon est chargée dans le canal 3: cela

signifie que dans la banque, il doit y avoir un réglage de masque de canal qui autorise ces

programmes uniquement sur le canal 3.)
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Si vous voulez assigner l’exécution vous-même, alors vous devrez vous assurer que Utiliser un jeu
de sons manuel est activé, et que vous avez choisi le nombre de canaux approprié. Si vos banques

nécessitent un changement de programme spécifique envoyé au début de l’exécution pour garantir

que le programme par défaut est sélectionné, vous pouvez le réaliser en activant Envoyer un
changement de programme et en réglant la valeur Changement de programme comme il

convient.

Maintenant vous devez utiliser la table de mixage pour choisir le périphérique approprié pour

chaque portée (de manière à ce que le nom n’apparaisse plus entre-parenthèses), et réglez le canal

en utilisant les flèches à droite de l’affichage du numéro de canal. Pour passer à d’autres

programmes dans la banque, vous devrez utiliser des messages MIDI explicites dans la partition.

Utiliser des instruments virtuels à un seul canal
Les instruments virtuels à un seul canal ne peuvent fournir qu’un son d’instrument à la fois, mais à

part cela ils se manipulent exactement comme les instruments virtuels multi-canal.

Autre exemple: vous pouvez avoir un instrument virtuel qui fournit un excellent son de piano, par

ex. Garritan Authorized Steinway, et vouloir l’utiliser en combinaison avec un lecteur tel que

Sibelius Sounds Essentials. Pour y parvenir, créez une nouvelle configuration d’exécution fondée

sur la configuration Sibelius Sounds par défaut, puis activez le Steinway. Dans la liste de droite

Périphériques actifs, réglez Jeu de sons sur (aucun), puis choisissez la page Jeux de sons
manuels. Activez Utiliser un jeu de son manuel et réglez Son ID sur ce qui convient, par ex.

keyboard.piano.grand, puis cliquez sur Appliquer. Enfin, rendez-vous à la page Sons préférés,

et choisissez Clavier > Piano > Grand dans la liste hiérarchique à gauche avant de choisir Steinway
du menu Préférer ce périphérique et cliquez sur Ajouter pour confirmer votre choix.

Maintenant cliquez sur Fermer pour conclure votre configuration.

Quand vous exécutez votre partition, Sibelius utilisera Garritan Authorized Steinway pour

n’importe quel piano, et Sibelius Sounds Essentials pour les autres instruments.

Utiliser des soundfonts avec des instruments virtuels 
Les soundfonts sont des collections de sons échantillonnés, qui existent dans l’un ou l’autre des

deux formats habituels (SF2 and DLS). Si au début, ils ont été conçus comme moyen pour changer

les sons existants des cartes-son de différents fournisseurs, désormais il est possible de les utiliser

sans passer par une carte-son spécifique.

Beaucoup de soundfonts sont disponibles en chargement sur le web. Les plus pratiques sont les

banques General MIDI complètes, qui ne nécessitent aucune configuration spéciale dans Sibelius.

Il n’existe pas de support intégré pour les soundfonts dans Windows, mais la manière la plus simple

d’utiliser les soundfonts dans Sibelius est d’utiliser un instrument virtuel qui peut les charger et les

jouer. Par exemple, sfz de Cakewalk (graticiel ; téléchargeable sur http://www.cakewalk.com/
support/project5/sfz.aspx) peut charger les SF2 et DLS.

Mac OS X comporte un support intégré pour les soundfonts. Pour utiliser un soundfont sur

Mac OS X:

* Copiez le fichier .sf2 ou .dls dans le dossier Bibliothèque/Audio/Son/Banques de votre

disque dur

http://www.cakewalk.com/support/project5/sfz.aspx
http://www.cakewalk.com/support/project5/sfz.aspx
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* Choisissez une configuration de lecture qui comporte le périphérique intégré DLSMusicDevice
dans la liste de Périphériques actifs dans Exécution > Périphériques de lecture (par exemple

la configuration de Sibelius Par défaut)

* Affichez l’interface DLSMusicDevice, par ex. via la table de mixage, et choisissez le soundfont

souhaité dans le menu Banque de sons.

Chaque occurrence de DLSMusicDevice n’accepte qu’une seule banque de soundfont, mais il est

possible d’activer plusieurs occurrences de DLSMusicDevice dans Exécution > Périphériques
d’exécution, tout en les réglant chacune sur un jeu de sons différent.
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4.16 ReWire

ReWire est ce qu’on appelle un câble audio virtuel vous permettant d’acheminer de

l’audio à partir de la lecture de Sibelius vers un logiciel DAW, comme Pro Tools. Il

vous procure également un moyen de synchroniser la lecture de Sibelius via la

lecture de DAWk.

Cela offre de nombreuses possibilités pour utiliser Sibelius avec d’autres logiciels audio. Par

exemple, vous pouvez ajouter une ligne d’instrument solo acoustique à la lecture de votre partition

en acheminant l’audio de Sibelius vers votre logiciel DAW et en enregistrant l’audio ici. Vous

pouvez aussi poursuivre un projet commencé dans votre logiciel DAW avec du texte écrit dans

Sibelius, le projet dans chaque application restant automatiquement synchronisé avec l’autre.

Applications synthé et table de mixage
Le standard ReWire compte deux type d’applications : applications synth, qui produit de l’audio à

alimenter, et applications de table de mixage, qui procure la capacité de manipuler, d’éditer et

d’émettre de l’audio. Vous pouvez également utiliser l’application synth comme esclave ou client et

l’application de table de mixage en maître ou hôte.

Sibelius est une application synth, et peut donc alimenter de l’audio vers votre application de table

de mixage choisie, qui sera généralement un logiciel DAW comme Pro Tools, Logic, Cubase, ou

Digital Performer. En retour, l’application de table de mixage fournit des informations temporelles

permettant à Sibelius de rester synchronisé pendant la lecture.

Bases de ReWire
Le processus de base visant à établir une connexion ReWire entre Sibelius et une autre application

consiste à exécuter d’abord l’application de table de mixage, ajouter un canal audio stéréo ou aux,

puis à charger Sibelius comme instrument ReWire multi-canal. L’application de table de mixage

lance automatiquement Sibelius, qui démarre dans un mode ReWire spécial, où toute la lecture

audio est acheminée vers l’application de table de mixage au lieu de votre carte-son.

Quand Sibelius est exécuté en mode ReWire, le logo ReWire figurant à droite apparaît dans

le panneau bleu en bas de la fenêtre Lecture. (si vous allez dans Lecture > Périphériques
de lecture et cliquez sur Options de moteur audio, vous vous apercevrez que les commandes

d’interface audio sont désactivées, car Sibelius bascule simplement son audio vers l’application de

table de mixage).

Lorsque vous démarrez la lecture dans Sibelius ou votre logiciel DAW, les deux applications se

mettront à lire. Pour mettre fin à la connexion ReWire, quittez Sibelius puis quittez votre logiciel

DAW ou supprimez la piste ReWire de la fenêtre de projet de votre logiciel DAW, puis quittez

Sibelius.

Mode Tempo fixe et Piste de tempo
Bien que ReWire constitue un moyen ingénieux de basculer des données audio et de

synchronisation entre les applications, il ne fournit pas d’ informations de synchronisation

complètes : l’application de table de mixage ne rapporte que la position de lecture vers l’application

synth en termes de temps à partir du début du projet, et ne procure pas d’informations de tempo.



4. Exécution et vidéo

400

Sibelius doit accorder ces informations au temps correspondant dans la partition, mais cela revient

à faire l’une des deux suppositions sur la manière dont l’application de table de mixage ReWire est

configurée :

* Tempo fixe : le projet dans l’application de table de mixage ne dispose pas de table de tempo, et

reproduit simplement à un tempo fixe (ex. si vous avez créé un nouveau projet dans Pro Tools et

n’avez pas configuré de changements de tempo)

* Piste de tempo : le projet dans l’application de table de mixage prévoit des changements de

tempo en même temps que la partition de Sibelius, de sorte que le tempo à tout endroit est

identique dans Sibelius comme dans l’hôte ReWire.

Vous pouvez basculer entre ces deux modes à l’aide des options dans la boîte de dialogue Lecture >

Performance de Sibelius et ce choix est enregistré dans votre partition.

Par défaut, Sibelius part du principe que l’application de table de mixage est exécutée avec une

table de tempo, soit en mode de tempo fixe. Cela s’avère utile, par ex. en prélevant simplement

l’audio de Sibelius pour l’intégrer à votre logiciel DAW afin d’enregistrer (disons) une piste vocale

ou d’instrument solo par-dessus.

Toutefois, si vous souhaitez mélanger des pistes MIDI ou d’instrument virtuel dans votre DAW

avec la lecture de Sibelius, alors les deux applications doivent partager la même piste de tempo.

Exportez un fichier MIDI depuis une application et importez-le dans une autre pour veiller à ce

que le projet dans votre DAW et votre partition Sibelius utilisent la même piste de tempo, puis

choisissez Lecture > Performance dans Sibelius et sélectionnez l’option Piste de tempo.

Configurer ReWire avec Pro Tools
Vous pouvez utiliser ReWire pour raccorder Sibelius à toute version de Pro Tools de la manière

suivante :

* Choisissez Piste > Nouvelle et spécifiez une piste d’Instrument (ou piste audio ou Entrée
auxiliaire), et cliquez sur Créer

* Dans la fenêtre Mélange, cliquez sur le sélecteur Insérer sur la piste et choisissez Extension
multi-canal > Instrument > Sibelius (stéréo)

* Sibelius va démarrer

* Assurez-vous que la sortie correcte (Mix L – Mix R) est choisie dans la fenêtre d’extension ReWire

dans Pro Tools

* Dans Sibelius, ouvrez la partition appropriée, ou démarrez-en une nouvelle

* Lancez la lecture soit dans Pro Tools ou Sibelius : les deux applications commenceront la lecture

* Si vous comptez utiliser le mode Piste de tempo dans Sibelius (voir ci-dessus), exportez un

fichier MIDI depuis votre partition Sibelius Pro ou votre session Pro Tools et importez-le dans

l’autre application pour veiller à ce que les deux applications utilisent la même piste de tempo.

Pour obtenir des informations plus détaillées, consultez le manuel des extensions Pro Tools

DigiRack correspondant à votre version de Pro Tools.
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Configurer ReWire avec d’autres applications
Vous pouvez utiliser ReWire pour raccorder Sibelius à plusieurs DAW, dont Cubase, Logic, Digital

Performer, Reaper, ou même Garageband sur Mac. Veuillez vous reporter à la documentation

fournie avec votre DAW pour savoir comment configurer les connexions ReWire.

Dépannage
Si Sibelius ne figure pas comme périphérique ReWire dans votre DAW, choisissez Lecture >

Périphériques de lecture dans Sibelius et cliquez sur Options de moteur audio. Cliquez sur le

bouton Réparer pour corriger l’association ReWire, puis quittez et redémarrez votre DAW.

Si la connexion ReWire semble fonctionner normalement (ex. les deux applications démarrent et

arrêtent la lecture correctement) mais vous estimez que vous ne percevez aucun audio en

provenance de Sibelius dans votre DAW, vérifiez si la configuration de lecture actuelle dans

Sibelius est prévue pour utiliser des instruments virtuels : l’application hôte ne recevra aucun son

en provenance des périphériques MIDI, qu’il soient internes (ex. la carte-son intégrée de votre

ordinateur) ou externes (ex. un module audio).

Si vous notez que Sibelius continue à démarrer en mode ReWire; même après avoir quitté votre

DAW, choisissez Lecture > Périphériques de lecture et cliquez sur Options de moteur audio,

puis cliquez sur Nettoyer. Maintenant, relancez Sibelius, qui devrait à nouveau démarrer et

fonctionner normalement.
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4.17 Messages MIDI

Utilisateurs avertis uniquement 

b 4.9 Dictionnaire de l’exécution 

Le MIDI est un étrange animal, un standard établi par plusieurs fabricants, adopté et utilisé de

manière universelle. Cela semble trop beau pour être vrai, et de fait, ça l’est, car pour pouvoir

comprendre comment fonctionne le MIDI, autant apprendre à parler chinois!

Les périphériques MIDI (tels que la carte son de l’ordinateur ou le clavier MIDI) envoient et

reçoivent des messages MIDI qui consistent en un octet de statut et en un ou deux octets de données

d’une valeur décimale comprise entre 0 et 127. Le décompte s’effectue à partir de 0 dans tous les

cas (y compris les changements de programme) et même si le périphérique MIDI utilisé part de 1.

Les messages MIDI sont classés soit comme messages de canal qui affectent un seul canal (dans

Sibelius, cela signifie la portée à laquelle ils sont attachés) soit comme messages de système qui

affectent tous les canaux (dans Sibelius, toutes les portées).

Les messages de canal contiennent la majorité des données musicales (par ex. quelles notes jouer,

combien de temps elles doivent durer, quel son utiliser) tandis que les messages système sont

utilisés pour des choses plus techniques comme la synchronisation avec d’autres périphériques

MIDI.

Sibelius comprend tout type de message MIDI (changements de contrôleur, pitch bend, SYSEX, ...).

Créer des messages MIDI dans Sibelius
Comme Sibelius lit à peu près toutes les indications dans la partition et les transforme

automatiquement en messages MIDI appropriés lors de l’exécution (b 4.2 Interprétation de
la partition), entrer des messages manuellement ne doit se faire que dans des circonstances très

spécifiques. C’est le cas des changements de son pour une portée en milieu de partition, par

exemple lorsque la clarinette double au saxophone dans la même pièce, ou si vous devez utiliser un

son différent pour différents timbres du même instrument, par exemple avec et sans sourdine. La

méthode la plus simple pour réaliser cela est de définir un nouveau mot dans le dictionnaire

d’exécution (b 4.9 Dictionnaire de l’exécution).

Cependant, il est possible à tout moment d’envoyer un message MIDI, en l’entrant sous forme de

texte au moyen des commandes de message MIDI décrites ci-dessous.

Ces messages MIDI peuvent être ajoutés à du texte ordinaire et sont masqués: si vous écrivez par

exemple la seconde fois molto vibrato ~C1,90 dans une section répétée de votre musique,

Sibelius remettra le contrôleur 1 (modulation) à 0 pour réduire au silence la portée au point exact où

la seconde fois molto vibrato apparaît à l’écran. L’indication ~C1,90 est complètement masquée

(et disparaîtra complètement si Affichage > Objets masqués est désactivé; il est donc préférable de

l’activer avant de travailler avec des messages MIDI).

Si c’est plusieurs portées qu’il faut réduire au silence, l’indication la seconde fois molto vibrato
~C1,90 peut être copiée en utilisant Alt+clic ou z-clic, ou vous pouvez l’ajouter au menu
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contextuel obtenu lorsque vous faites un clic-droit (Windows) ou Contrôle-clic (Mac), et lui

assigner un raccourci-clavier au passage – b 3.1 Utiliser du texte.

Quand on importe un fichier MIDI, on peut choisir d’afficher dans la partition tous les messages

MIDI; ils apparaîtront comme si on les avait entrés directement dans Sibelius.

Faut-il utiliser le dictionnaire ou les messages MIDI?
La plupart des situations sont mieux gérées avec la boîte de dialogue Exécution > Dictionnaire.

Seul les ajustements les plus ésotériques nécessitent des messages MIDI, en général pour exploiter

des subtilités de périphériques spécifiques. De toutes façons, si vous voulez que votre partition soit

lue de manière acceptable sur d’autres périphériques, évitez d’utiliser des messages MIDI quand

c’est possible.

Syntaxe
Les messages MIDI dans la partition peuvent être introduits dans une partition en utilisant

n’importe quel type de texte de portée - généralement du texte d’expression ou technique.

Les messages MIDI peuvent être écrits seuls, ou à la fin de n’importe quel texte (par ex.

“sourdine”).

Les messages prennent la forme suivante: ~ suivi d’une seule lettre de commande, suivie d’un ou

plusieurs nombres qui généralement séparés par des virgules.

Par ex.~C64,127

(le signe ~ est appelé tilde)

Bien que l’utilisation du système décimal (par ex. 0-127) soit la manière la plus évidente de

spécifier les valeurs dans les messages MIDI, Sibelius peut comprendre d’autres systèmes utilisés

par certains périphériques MIDI tels que le système binaire (7 bits précédés par un b, par ex.

b0111101) ou hexadécimal jusqu’à 7F (précédées par h, par ex. h5C), mais n’insistons pas trop. 

Notez que:

* les messages MIDI sont sensibles à la casse (c’est-à-dire que vous devez entrez les majuscules et

les minuscules comme indiquées): donc ~C0,0 est correct mais ~c0,0 ne fonctionnera pas

* Les nombres hexadécimaux eux-mêmes (par ex. 5C) ne sont pas sensibles à la casse, mais le h
qui précède le nombre doit toujours être en minuscule.

* Plusieurs messages peuvent s’écrire dans la même portion de texte, séparés par un espace ou

Retour (sur le clavier principal), le tout précédé d’un tilde comme par ex.:~P43 A65 C64,127

* Il est possible également d’ajouter des espaces ou Retours autour des virgules et des nombres..

Vous pouvez aussi désactiver l’option Transposer les noms des accords/note dans Style
maison > Modifier les styles de texte pour un style de texte choisi afin d’éviter que les lettres

capitales qui commencent les messages MIDI (par ex. ~C) ne soient transposés comme si c’était un

symbole d’accord – b 3.9 Modifier les styles de texte.
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Messages de canal
Il y en a deux sortes: les messages de canal de voix, pour les données musicales; et les messages de

canal de mode pour la manière dont les instruments MIDI sont affectés par ces mêmes données .

Examinons chacun des messages de canal l’un après l’autre.

Changements de programme / banque
Un changement de programme définit quel son sera utilisé pour jouer les notes ultérieures sur un

canal particulier. Sibelius envoie automatiquement le changement de programme correct pour

chaque portée, comme défini dans la Fenêtre > Table de mixage lorsqu’il commence à jouer.

Cependant, si vous souhaitez changer le son utilisé par une portée en milieu de partition, vous

pouvez utiliser un message de changement de programme.

Sibelius permet également de changer de banque et de programme dans le même message MIDI.

Si le périphérique MIDI utilisé ne comprend que les sons General MIDI, un changement simultané

ne sera jamais nécessaire; si par contre le périphérique comporte plus de sons (comme General

MIDI 2 ou Roland JV-1080), on pourra souhaiter choisir le son d’une autre banque.

Il y a trois types de messages de changement de programme:

* Changement de programme uniquement: ~P programme par ex.~P76

* Changement de programme et de banque envoyant le numéro de banque:~P banque,
programme par ex.~P24,76

* Changement de programme et de banque spécifiant le MSB et le LSB comme numéro de

banque:~P MSB, LSB, programme, par ex.~P64,2,36

(Pour l’explication de MSB et LSB, cf. Numéros de banque ci-dessous.

Dans tous les cas sus-mentionnés, la valeur du programme assume que votre instrument MIDI

compte les numéros de programmes à partir de 0 plutôt que 1 (b 4.13 MIDI pour les
néophytes). Si votre instrument MIDI compte à partir de 1, utilisez ~p au lieu de ~P.

Pour un message sous la forme ~P banque, programme, seul le LSB est envoyé si banque est

inférieur à 128. Si banque est supérieur à 128, le MSB et le LSB sont envoyés en concordance avec la

formule banque = (MSB x 128) + LSB.

Pour un message sous la forme ~P MSB, LSB, Programme, si vous spécifiez une valeur de -1 soit

pour le MSB ou pour le LSB, cet octet ne sera pas envoyé; cela vous permet de spécifier de n’envoyer

que le MSB ou le LSB (si vous ne souhaitez envoyer ni l’un ni l’autre, utilisez un simple changement

de programme).

Consultez la documentation de votre périphérique pour connaître la manière dont il compte - à

partir de 0 ou de 1 - et les valeurs pour le MSB et le LSB. Les MSB et LSB peuvent également être

repris comme Grossier et Fin, ou CC (changement de contrôleur) 0 et 32, respectivement.

Pour mieux faire comprendre ces notions quelque peu indigestes, voici quelques exemples:

Supposons qu’en milieu de la partition, on veuille changer le son de l’une des portées en lui

attribuant le son “aboiement de chien” proposé dans le module de sons Roland SC-88. Le manuel

du SC-88 donne “Chien, PC = 124, CC00 = 001”. Les instruments Roland comptent les

programmes à partir de 1 (puisque le manuel affiche le premier son GM, Acoustic Grand Piano,
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comme programme numéro 1). Le SC-88 est assez particulier dans la manière dont il se sert du

LSB pour établir une compatibilité avec le module SC-55 (à peu près similaire au SC-88 mais

proposant moins de sons). Pour cette raison, le LSB devrait normalement être sur 0, tandis que le

MSB détermine quelle banque utiliser.

Pour changer en un son de chien au milieu de la partition, entrez ~p1,0,124, ~p128,124 ou

~P1,0,123; chacun de ces messages fait exactement la même chose, tout comme pourrait le faire

un mot du dictionnaire d’exécution préalablement créé en ajoutant une entrée chien à laquelle est

attribuée la Valeur 123 et l’Unité 128.

Par contre, les périphériques qui utilisent le standard Yamaha XG conservent le MSB constant (à 0)

et change le LSB en fonction de la variante du son de la banque 0 (par ex. LSB 1 = localisé, 3 =

stéréo, etc.). Les programmes sont numérotés à partir de 1. Pour accéder au son “PianoStr”

(banque 40), une variante du son de piano de base (banque 0 programme 1) utilisez ~p0,40,1.

Numéros de banque
Les numéros de banque sont calculés à partir de 2 nombres, connus sous le nom de Most

Significant Byte (MSB) et Least Significant Byte (LSB, ou CC (changement de contrôleur) 0 et 32,

respectivement). La formule pour calculer les numéros de banque est (MSB x 128) + LSB. Ces

valeurs sont fournies par le manuel des périphériques MIDI. Voici un exemple de ce qu’il pourrait

donner::

Pour calculer le numéro de banque de la banque 2 dans l’exemple ci-dessus, le calcul est (64 x 128)

+ 2, ce qui donne un numéro de banque de 8194, qui est le numéro à utiliser dans le message MIDI

~P MSB,LSB,programme (cf. ci-dessus).

Certains manuels présentent des numéros de banque sous forme d’une seule valeur plutôt qu’un

MSB et un LSB séparé, et dans ce cas votre calculette est inutile.

Changement de contrôleur
Les changements de contrôleur sont utilisés pour un grand nombre de fonctions dans un

instrument MIDI. Bien que la fonction de chaque changement de contrôleur soit clairement

définie, tous les périphériques MIDI ne supportent pas tous les changements de contrôleur. Ceux-

ci sont scindés en groupes:

* Changements de contrôleur 0-31: données des boutons, des molettes de modulation, des

curseurs et des pédales sur le périphérique MIDI (y compris la modulation, le volume, la pédale

d’expression, etc.)

* Changements de contrôleur 32-63: envoient facultativement le LSB pour les changements de

contrôleur 0-31 respectivement

* Changements de contrôleur 64-67: fonctions à basculement (soit on ou off) telles que

portamento, pédale de maintien, pédale douce, etc.

Numéro de banque MSB LSB

Banque 0 64 0

Banque 1 64 1

Banque 2 64 2
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* Changements de contrôleur 91-95: profondeur ou niveau de certains effets tels que la

réverbération, le “chorus”, etc.

* Changements de contrôleur 96-101: utilisés conjointement avec les changements de contrôleur 6

et 38 (Entrée de données), ils peuvent être utilisés pour éditer les sons

* Changements de contrôleur 121-127: messages de canal (cf. Messages de canal ci-dessous).

La syntaxe pour les changements de contrôleur est ~Coctet1, octet2, où octet1 est le numéro du

changement de contrôleur (de 0 à 127) et octet2 est la valeur de contrôle (également 0-127). 

Pour de plus amples informations sur les changements de contrôleur pris en charge par votre

périphérique MIDI, consultez le manuel du fabricant.

Voici les changements de contrôleur les plus courants:

Pitch bend
Le Pitch bend vous permet normalement d’altérer la hauteur d’une note jusqu’à un ton vers le haut

ou vers le bas, bien qu’il y ait certains moyens d’augmenter cette étendue - ci-dessous.

La syntaxe du pitch bend est ~B0,bend de, par ex. ~B0,96.

Bend de est un nombre entre 0 et 127, où chaque nombre entier représente 1/32ème d’un demi ton.

~B0,64 produit une note à sa hauteur écrite; les valeurs inférieures à 64 descendent la note, et les

valeurs supérieurs à 64 la montent. Pour faire sonner une note un demi-ton plus haut qu’elle n’est

écrite, utilisez ~B0,96; pour la faire sonner un demi-ton plus bas, utilisez ~B0,32.

Vous pourriez par exemple utiliser ce changement de contrôleur pour faire sonner une note dièse

ou bémol sans ajouter une altération, par ex. si vous souhaitez qu’une altération de type ficta –

altération ajoutée par l’éditeur au-dessus de la partition - soit exécutée, vous pouvez insérer

l’altération à partir de la boîte de dialogue Insertion > Symbole, puis utiliser un message MIDI

comme par ex. ~B0,96 pour jouer la note un demi-ton plus haut. N’oubliez pas d’utiliser ~B0,64
pour rétablir le canal à son diapason normal à la note suivante ! C’est cela, en fait, que fait

automatiquement l’extension Ajouter l’altération ficta – b 6.1 Travailler avec des
extensions.

Vous pouvez également utiliser le changement de contrôleur pitch bend pour créer un effet de

portamento ou de glissando en créant plusieurs messages MIDI les uns à la suite des autres. Le

pitch bend ne dure pas seulement une note - il reste indéfiniment, vous placez donc normalement

un pitch bend dans la direction opposée sur la note suivante pour rétablir la hauteur normale.

Si vous souhaitez un contrôle plus fin sur le pitch bend, vous pouvez changer l’octet initial,

également entre 0 et 127, pour produire de très légères déviations dans le tempérament (1/128 x 32

demi-ton), par ex.~B127,64 fera monter la note écrite de très peu.

Pour créer un effet de pitch bend pour un intervalle plus grand qu’un ton, vous pouvez soit utiliser

le changement de contrôleur portamento (cf. ci-dessous Changement de contrôleur) pour

faire un pitch bend, ou utiliser la méthode suivante:

* Tout d’abord, définissez l’étendue sur laquelle le pitch bend peut agir: insérez les messages MIDI

~C101,0 C100,0 C6, demi-tons dans votre partition, où demi-tons l’étendue totale du pitch
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bend en demi-tons, de 0 à 12. Par exemple, pour régler le pitch bend sur un ambitus maximum

d’une octave, utilisez ~C6,12. Il est préférable de placer ces messages au début de la partition.)

* Lorsque vous voulez ajouter un pitch bend à la partition, insérez une commande ~B0,bend de la

manière habituelle, si ce n’est que vous devez maintenant diviser le paramètre bend de par le

nombre de demi-tons définis dans la commande ~C6. Si par exemple vous avez entré ~C6,12,

chaque demi-ton ajoute ou soustrait 5.3 (64 divisé par 12) à bend de. Pour faire un bend de

quatre demi-tons vers la haut, vous entreriez ~B0,85.

Cette méthode requiert de votre instrument MIDI qu’il prenne en charge le standard “Registered

Parameter Messages” (RPMs) qui est courant mais pas universel. Si vous avez l’intention d’utiliser

d’autres RPMs dans la même partition, il faut veiller à “fermer” les paramètres, en ajoutant

~C101,127 ~C100,127 après le message ~C6,demi-tons.

Aftertouch
L’aftertouch est la pression exercée sur une touche de clavier MIDI, par exemple, quand elle est

enfoncée. Cette information peut être utilisée pour contrôler certains aspects du son produit par

l’exécution, par ex. le vibrato sur un son de violon. L’effet exact de ce contrôleur est dépendant du

niveau de sophistication du périphérique MIDI utilisé.

L’aftertouch peut être appliqué soit à une note en particulier (aftertouch polyphonique) ou à toutes

les notes sur le même canal (aftertouch de canal). L’aftertouch polyphonique n’est pas aussi

implémenté dans les périphériques MIDI que l’aftertouch de canal.

La syntaxe est la suivante:

* Aftertouch de canal: ~A pression par ex. ~A64

* Aftertouch polyphonique: ~a note, pression par ex.~a60,64

Modulation
Le changement de contrôleur 1 contrôle le “tremblement” du vibrato généré par la molette de

modulation. Pour beaucoup de vibrato, utilisez ~C,127; pour aucun vibrato, utilisez ~C1,0.

Souffle
Le changement de contrôleur 2 n’est reconnu que par certains instruments MIDI tels que les

synthétiseurs d’instrument à vent et correspond à la “pression” du souffle utilisée pour jouer une

note.

Portamento
Le portamento est un “glissé” sans à-coup d’une note à une autre (un peu comme un glissando au

trombone). Cet effet est contrôlé en fait par deux changements de contrôleur:~C5,0-127 contrôle

la durée prise pour effectuer le portamento (0 est le plus rapide, 127 le plut lent), et ~C84,0-127

détermine la distance du portamento (les valeurs inférieures à 60 commencent en dessous de la

note, les valeurs supérieures au-dessus; l’intervalle exact dépend de votre instrument MIDI).

Vous devez d’abord préparer l’effet de portamento avec un message ~C5 puis attacher le message

~C84 à la note pour laquelle le portamento est effectué.

Ce changement de contrôleur n’est pas pris en charge par tous les instruments MIDI.
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Volume
Le changement de contrôleur 7 détermine le volume d’une note donnée,~C7,127 est le plus fort et

~C7,0 le moins fort.

En MIDI, le Volume n’est pas la même chose que la Vélocité. La vélocité est définie au moment où la

note est jouée (elle fait partie du message NoteOn – voir ci-dessus) et est analogue, par exemple, à

la vitesse à laquelle vous enfoncez une touche sur un piano. Les périphériques MIDI les plus

sophistiqués joueront la même note avec un timbre différent en fonction de la vélocité de la note.

Le volume, par contre, est similaire à un bouton de volume général sur un amplificateur. Donc une

trompette jouant une note fortissimo (c’est-à-dire avec une vélocité élevée) mais avec un volume

bas sonne toujours comme une trompette jouant fortissimo, mais avec le volume réglé très bas.

Les curseurs dans la Fenêtre > Table de mixage modifie le contrôleur de volume pour spécifier le

volume des portées de la partition. N’entrez ce message MIDI manuellement dans votre partition

que si vous souhaitez obtenir un changement de nuance sur une note tenue – l’extension

Exécution de cresc./dim. installe ce type de messages automatiquement (b 6.1 Travailler
avec des extensions).

Panoramique
Le changement de contrôleur 10 détermine la localisation panoramique pour un canal particulier,

par ex.~C10,0 signifie complètement à gauche, ~C10,64 signifie centré, et ~C10,127 signifie

complètement à droite.

Il n’est pas nécessaire d’utiliser ce message MIDI à moins que vous ne souhaitiez modifier la

localisation panoramique d’un instrument pendant l’exécution; la localisation initiale du

panoramique est définie dans la Fenêtre > Table de mixage.

Expression
Le changement de contrôleur 11 prend une fraction du volume de canal spécifié par le contrôleur

7, donc ~C11,127 utilise 100% du volume de canal, ~C11,64 utilise 50% du volume de canal, et

ainsi de suite. En pratique ~C7 est destiné à fonctionner comme un bouton de volume et ~C11 est

une façon d’ajuster le volume “général”.

Pédale de maintien
Sibelius produit automatiquement les messages MIDI pour la pédale forte si vous utilisez les lignes

de Ped. à partir de la boîte de dialogue Insertion > Ligne (b 2.21 Lignes). Cependant, si vous

souhaitez activer le maintien (la pédale forte) dans la partition sans utiliser ces lignes, utilisez

~C64,127. Levez ensuite la pédale avec ~C64,0. Les valeurs entre 0 et 127 produisent une demi-

pédale sur certains instruments MIDI.

Pédale douce
Le changement de contrôleur 67 simule l’effet produit par l’utilisation de la pédale una corda sur

un piano: pour activer la pédale douce, utilisez ~C67,127; pour la désactiver, utilisez ~C67,0. Ce

changement de contrôleur ne fonctionne pas sur tous les instruments MIDI.
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Messages de canal
Devoir utiliser les changements de contrôleur 121-127 dans Sibelius est peu probable; les voici

cependant:

* ~C121: réinitialise tous les contrôleurs

* ~C122: Contrôle local on/off

* ~C124–127: Mode omni on/off, mode Mono/Poly

NoteOn/NoteOff
Ces messages contrôlent la note qui est jouée, son volume, et combien de temps elle dure. Vous ne

devriez jamais avoir besoin d’utiliser ces messages dans Sibelius, car vous pouvez faire jouer les

notes en les entrant dans la partition (et en les masquant si nécessaire).

Cependant, et juste afin d’être complet, ils peuvent être entrés sous la forme: ~Nnote,vélocité pour

NoteOn, et ~Onote,vélocité pour NoteOff. (Vous devez entrer un message de NoteOff, sinon votre

note sonnera éternellement !)

note est le numéro de touche MIDI (par ex. 60 est le Do médian) et vélocité est une valeur entre 0 et

127 (127 étant le plus fort). Pour NoteOff, la plupart des instruments MIDI ignorent la vélocité

mais certains l’interprètent comme l’effet avec laquelle la note est relâchée; dans le doute, utilisez

(par ex.) 64.

Messages de système
Ceux-ci ne nécessitent pas de canal, par conséquent la portée à laquelle ils sont attachés ne

détermine que l’instrument MIDI vers lequel ils seront envoyés.

Les messages de systèmes sont divisés en trois types: messages de système communs, messages de

système en temps réel, et messages de système exclusif. Généralement, seuls les deux derniers sont

utiles dans Sibelius – le premier est essentiellement lié à la synchronisation du MIDI avec des

composants MIDI basé sur une horloge. Il n’est donc pas possible pour l’instant d’entrer des

messages de système communs dans Sibelius.

Les messages de système exclusif sont utilisés pour envoyer des données spécifiques à un

instrument MIDI particulier, et peuvent varier d’un instrument à l’autre.

Pour entrer des messages de système dans la partition: 

* Système exclusif: ~X octets par ex.~Xh40, h00, hf7. Vous devriez normalement placer hf7 à la

fin pour terminer le système exclusif, à moins que vous ne poursuiviez avec une commande D
contenant plus de données encore.

* Continuation des données système exclusif (sans octet de “commande”):~D octets par

ex.~Dh40, h00, h7f

* Système en temps-réel: ~S octets. Ces messages sont utiles pour synchroniser la lecture de

Sibelius avec d’autres séquenceurs ou échantillonneurs. Les trois commandes les plus utiles sont

~ShFA (démarrer le séquenceur), ~ShFB (mettre en pause / relancer le séquenceur), et ~ShFC
(arrêter le séquenceur).
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Masquer les messages MIDI
Chaque texte qui commence par un tilde (~) est masqué automatiquement par Sibelius, ce qui

évite de devoir masquer les messages MIDI un par un. Si le tilde est placé au milieu d’un texte seul

le ~ et le texte qui suit sont masqués, laissant visible la première partie du texte qui peut être une

instruction donnée aux instrumentistes telle que “sourdine”. Quand on modifie le texte, le ~ et le

message MIDI masqués réapparaissent.

Les messages MIDI sont affichés en grisé si Affichage > Objets masqués (raccourci Ctrl+Alt+H
ou zXH) est activé.

Plus d’informations
Si cet article n’a pas épuisé votre appétit pour les codes de lettres et de chiffres, beaucoup

d’informations sur les messages MIDI sont proposées sur le site Internet suivant: http://
www.harmony-central.com/MIDI/ 

http://www.harmony-central.com/MIDI/
http://www.harmony-central.com/MIDI/
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4.18 SoundWorld™

Réservés aux utilisateurs expérimentés.

SoundWorld est un standard développé par Sibelius pour désigner et classer les sons. Cela

remplace le patchwork confus des numéros de “patch” et des noms (souvent obscurs) utilisés par

les claviers MIDI, modules de sons et bibliothèques de sons pour désigner leurs sons. À la place,

vous pouvez choisir des noms standardisés et pratiques à utiliser. Parce que les appellations sont

indépendantes d’un périphérique de lecture spécifique, Sibelius peut exécuter une partition qui a

été créée au départ pour d’autres périphériques que ceux de votre système. Ainsi, si un son n’est pas

disponible dans la configuration d’exécution en cours, Sibelius peut trouver intelligemment la

meilleure alternative et l’utiliser à la place. Vous pouvez aussi exécuter des techniques

instrumentales (tels que les liaisons et les accents) en utilisant des sons spécialisés s’ils sont

disponibles, plutôt que de faire des approximations en changeant la durée ou le volume.

Si vous voulez découvrir comment SoundWorld fonctionne, lisez la suite. Il n’est pas nécessaire de

comprendre ceci pour utiliser Sibelius, mais cela peut présenter un certain intérêt.

Sound IDs, SoundWorlds and sound sets
SoundWorld utilise pour chaque son un nom structuré appelé son ID, tels que

woodwind.flutes.flute, woodwind.flutes.piccolo.flutter-tongue ou

strings.violin.ensemble.pizzicato. Notez que chaque son ID commence en général avec une

famille d’instrument, puis le nom de l’instrument, parfois suivi par une technique de jeu

spécifique à l’instrument.

Le terme SoundWorld désigne simplement un ensemble de sons ID, organisés en arborescence.

Le Sounworld spécifique de Sibelius s’appelle Sibelius Standard SoundWorld (ou S3W en abrégé),

qui est une liste intelligente de sons disponibles dans les bibliothèques de sons et périphériques

MIDI les plus communs. Dès que des plusieurs sons deviennent disponibles, ils sont ajoutés au

S3W.

Pour jouer un son ID spécifique, Sibelius a besoin de savoir quels sons sont disponibles sur les

périphériques de lecture. Pour pouvoir les détecter, Sibelius possède pour chaque périphérique un

jeu de son, qui est un fichier XML avec la liste de tous les sons IDs que le périphérique peut jouer et

les messages MIDI (par exemple les changements de programme, les changements de contrôleur,

même les interrupteurs) nécessaires pour les jouer. Un jeu de son contient aussi la liste des autres

possibilités du périphérique, comme le nombre de sons joués simultanément et d’éventuels canaux

spéciaux (par exemple le canal 10 dédié à la percussion sur les périphériques General MIDI).

Où apparaissent les sons ID dans Sibelius?
Les sons ID apparaissent dans Sibelius chaque fois que sont spécifiés des sons. Par exemple:

* Chaque instrument possède son ID de préférence, qui peut être modifié dans Style maisons >

Modifier les Instruments

* La table de mixage affiche le son ID de chaque portée de la partition
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* Chaque tête de note d’une portée de percussion possède son propre son ID de préférence, qui

peut être changé en modifiant l’instrument

* Toutes les techniques de jeux et les articulations des instruments sont décrites par les sons ID, et

peuvent être modifiées dans Exécution > Dictionnaire.

Comment Sibelius choisit le son ID à utiliser?
Pour jouer une portée, Sibelius commence avec le son ID initial (comme affiché dans la table de

mixage): par exemple, un violon solo par défaut commence avec le son ID strings.violin. Les

indications de la partition telles que des articulations, des liaisons, des instructions pour des

techniques de jeux spécifiques telles que pizz., etc..., toutes modifient le son ID en y ajoutant ou en

y soustrayant des éléments. Ces changements sont spécifiés dans le dictionnaire de l’exécution.

Dans l’exemple ci-dessous vous pouvez voir au-dessus de la portée les changements apportés aux

sons ID, et les sons ID résultant en dessous:

Sibelius sait maintenant quels sons ID produiraient la meilleure exécution. Cependant, il arrive

assez souvent qu’un son ID ne soit pas disponible, soit parce qu’il est absent des périphériques de

lecture, ou parce qu’il n’y a pas assez d’emplacements ou de canaux disponibles pour jouer tous les

sons requis en même temps. Sibelius doit alors trouver la meilleure alternative possible en fonction

de ces restrictions.

Comme exemple, supposons que Sibelius veuille exécuter strings.violin.staccato.mute (comme

illustré au-dessus) mais que ce son ID ne soit pas disponible. Pour en trouver la meilleure

alternative possible, Sibelius utilise une règle de substitution qui suit l’arborescence des sons ID

dans SoundWorld. Cette règle exploite le fait que, par exemple, strings.violin.staccato.mute est

un type de son de violon staccato (un “enfant” de strings.violin.staccato), lui-même un type de

son de violon (un enfant de strings.violin). L’ordre de priorité de la règle relie aussi les “frères” tels

que par exemple strings.violin et strings.viola.

Donc en partant du son indisponible strings.violin.staccato.mute, Sibelius essaie d’abord de

trouver le premier “descendant” du son ID disponible, c’est-à-dire son premier enfant (qui pourrait

être strings.violin.staccato.mute.stradivarius), ensuite le premier de ce son ID; s’il atteint un

son ID sans enfant, Sibelius essaie le premier frère et ses enfants. Si aucun descendant du son ID

original n’est disponible, il essaie son parent, dans ce cas strings.violin.staccato, puis de la même

manière, le premier enfant des parents et les autres descendants; ensuite éventuellement le grand
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parent strings.violin, et ainsi de suite jusqu’à trouver le premier son qui peut être joué. S3W a été

structuré de manière à obtenir ce qui est le plus proche possible du son original.

Structure arborescente des sons ID
Pourquoi un son ID s’appelle-t-il strings.violin.staccato.mute et non

strings.violin.mute.staccato? Pour que la substitution fonctionne, une convention suivie dans

SW3 est que différents types de techniques de jeu apparaissent dans les sons ID dans l’ordre

spécifique suivant, en descendant par ordre de priorité:

* Qualité principale (par. ex. pizzicato, pizzicato.snap, pizzicato.secco, bisbigliando, col
legno, snares on, snares off, etc.)

* Ensemble (la présence de l’élément ensemble signifie que le son est un son d’ensemble; son

absence signifie que le son est un son solo)

* Durée (par ex. staccato, staccato.wedge, staccato.detaché, spiccato, portato, legato)

* Attaque/nuance (par ex. accent, crescendo, diminuendo, fortepiano, sforzato,

sforzato.sforzatissimo, non vibrato, vibrato, etc.)

* Qualité accessoire (par ex. sul tasto, sul pont, sul tasto.flautando, mute, mute.harmon,

mute.cup, mute.straight, open, etc.)

* Ornement (par ex. trill, tremolo, mordent, turn, flutter-tongue, glissando, scoop, fall, etc.)

* Musiciens (par ex. 2 players, signifie un son ensemble d’un nombre spécifique de musiciens)

* Vitesse de répétition (par ex. slow, fast)

* Longueur modifiée (par ex. long, short)

* Variante n (par ex. strings.violins.violin.solo.1 et strings.violins.violin.solo.2, pour des sons

presque identiques mais qui nécessitent malgré tout un son ID unique)

Les éléments de durée (tel que staccato) sont plus importants que des éléments de qualité

accessoire (tel que mute) et apparaissent en premier dans le son ID. Cela signifie que, quand

Sibelius recherche un substitut pour strings.violin.staccato.mute, il trouvera d’abord

strings.violin.staccato avant strings.violin.mute; si les deux sont disponibles il prendra le

premier qui est meilleur comme substitut.

De plus, les techniques de chaque groupe d’éléments énumérés ci-dessus s’excluent mutuellement.

Cela signifie que si une portée est en train d’utiliser strings.violin.pizzicato puis que survient

l’instruction “col legno”, Sibelius sait qu’il faut remplacer l’élément pizzicato par col legno (plutôt

que d’ajouter col legno à la fin), ce qui donnera strings.violin.col legno (plutôt que

strings.violin.pizzicato.col legno)
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5.1 Arranger

b 5.2 Modifier les styles d’arrangement.

La fonction Arranger est conçue pour aider les étudiants qui apprennent à arranger ou à orchestrer

ainsi que pour faire gagner du temps aux professionnels qui ont des projets précis.

Arranger transcrit intelligemment la musique depuis un certain nombre de portées vers tout autre

nombre de portées, en décidant (selon les nécessités) quels instruments utiliser. Elle s’utilise pour

effectuer des réductions de piano ou au contraire pour “distribuer” des accords sur plusieurs

portées. Mais surtout sa puissance est telle qu’elle est capable d’arranger et d’orchestrer pour un

large éventail de styles et d’ensembles, depuis la musique chorale jusqu’au band en passant par

l’orchestre.

L’utilisation d’Arranger peut se faire de manière très souple. Dans le cas où votre choix

d’instruments est déjà établi, vous pouvez l’utiliser simplement comme moyen rapide de les copier

entre eux, par exemple pour répartir intelligemment des notes d’accords entre des cuivres.

Cependant, les nombreux styles d’arrangement prêts à l’emploi permettent aussi à n’importe quels

utilisateurs, tels les étudiants, d’expérimenter des arrangements et des orchestrations les plus

divers.

En résumé
La fonction Arranger est une sorte de super “copier - coller” dont voici résumée la mise en œuvre:

* Copiez la musique que vous voulez arranger dans le presse-papiers en utilisant Édition > Copier
(raccourci Ctrl+C ou XC). Point important: les parties d’origine copiées doivent utiliser un

nombre constant de voix, c’est-à-dire, soit une voix, soit deux, mais pas d’alternance entre une

ou deux voix à travers la partition. Ne copiez pas non plus de partie de percussions à sons

indéterminés, car arranger ne fonctionne qu’avec des parties à sons déterminés.

* Sélectionnez les portées qui doivent recevoir le résultat de l’arrangement, soit dans la même

partition, soit dans une autre. Il n’est pas nécessaire de sélectionner le nombre exact de mesures

dans les portées de destination, il suffit juste de sélectionner une seule mesure.

Si vous voulez arranger un passage commençant au milieu d’une portée, créez les silences

appropriés dans toutes les portées de destination afin de pouvoir sélectionner l’endroit précis où

l’arrangement doit être collé.

Si vous sélectionnez un ensemble de portées adjacentes au moyen de Maj-clic, arranger prendra

aussi en compte les portées invisibles contenues dans la sélection. Pour éviter ce phénomène,

sélectionnez les portées à arranger une à une avec Ctrl+clic ou X-clic.

* Choisissez Notes > Arranger (raccourci Ctrl+Maj+V ou xX V).

* La fenêtre Style d’arrangement apparaît; Choisissez le style désiré dans la liste déroulante et

cliquez sur OK.

Un curseur d’état apparaît et en quelques secondes Sibelius aura réalisé l’arrangement, en

choisissant la partie idéale pour chaque instrument et en transposant la musique à l’octave si

nécessaire pour qu’elle sonne à la bonne tessiture.
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Pour tester Arranger, ouvrez la partition d’exemple Arranger dans le dossier Autres, lui-même

dans le dossier Partitions et suivez les instructions se trouvant au-dessus de la partition. Cela vous

donnera un avant-goût de ce que Arranger peut réaliser.

Ce paragraphe, résumé de la fonction Arranger était indispensable pour expliquer les différentes

façons d’utiliser cette fonction. Soyez sûrs d’avoir tout compris avant de commencer, sinon relisez!

Obtenir un résultat musical avec Arranger
Tout comme la composition, l’arrangement et l’orchestration font appel à des aptitudes musicales

et requièrent inévitablement un investissement personnel. Pour obtenir un résultat satisfaisant - ce

que la fonction Arranger n’a pas la prétention de produire seule – voici ce que vous devriez faire:

Choisissez soigneusement le passage à arranger.

* Limitez-vous de préférence à une phrase, voire moins – certainement pas toute la partition – (cf.

ci-dessous). Un projet réaliste serait par exemple d’arranger une partie de piano, la main droite

jouant les bois et la main gauche les cordes.

* L’idéal consiste à préparer la partition de départ en fonction des instruments que vous utiliserez.

Arranger ne modifie jamais les parties originales et ce qui convient pour le piano ne peut pas

convenir à un orchestre de vents ou à une section de cordes sans adaptation spécifique. Pour

améliorer préalablement la partition de départ, voyez Préparation de la musique à
arranger; pour améliorer l’arrangement réalisé, voyez Après avoir utilisé la fonction
Arranger.

* Choisissez le Style d’arrangement et sélectionnez les portées avec soin; les styles d’arrangement à

utiliser pour différents ensembles sont détaillés plus loin. Si le résultat ne vous plaît pas,

choisissez Édition > Annuler et réessayez d’autres combinaisons.

* Variez souvent le style d’arrangement et les portées sélectionnées afin de produire un

arrangement intéressant.

* Évitez un traitement global et permanent de tous les instruments!Une stratégie souvent

appropriée pour un résultat optimum consiste à changer d’octave ou à appliquer, comme en

orchestration, la substitution d’un instrument par un autre.

Il est important de comprendre que la fonction Arranger maintient la même instrumentation de

tout le passage traité à la même tessiture. Par exemple, si un trait commence très haut et descend

très bas (ou vice-versa), Sibelius ne va pas substituer les instruments les uns aux autres pour

obtenir la meilleure tessiture. Arranger pourra toutefois varier l’instrumentation entre chaque

passage tel qu’il se présente.

Donc, il vaut mieux éviter d’arranger plus d’une phrase à la fois, sinon certains instruments

risquent d’être écrits hors tessiture. L’arrangement de courts passages permet à Sibelius d’adapter

l’instrumentation et la hauteur à la tessiture des instruments mais aussi d’obtenir un résultat

sonore plus intéressant. Sibelius vous avertit si le passage que vous arrangez risque d’être trop long.
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Comment fonctionne Arranger
Voici comment fonctionne Arranger pour tous les styles, excepté Distribution et Réduction, qui

sont particuliers et expliqués plus loin):

* Sibelius effectue les choix appropriés d’instruments en fonction des portées de destination.

La plupart des portées sélectionnées de départ sont normalement utilisées sauf si le style

s’applique à des instruments spécifiques (par exemple les styles par Famille et Mélangés décrits

ci-dessous) et dans ce cas aucun autre instrument même sélectionné n’est pris en compte.

* Normalement, Sibelius répartit la musique de façon à obtenir une seule ligne mélodique par

portée, et cela dans la mesure du possible.

* Certains passages peuvent être transposés à l’octave pour que l’instrument soit dans une

tessiture plus confortable ou pour obtenir un meilleur effet de couleur. (Notez que Arranger tient

compte des tessitures d’instruments que vous auriez modifiées vous-même –

b 2.18 Instruments et portées.)

* ; Sibelius peut affecter différents traits à différentes sections (par exemple les traits rapides pour

les bois, les lents pour les cordes), selon le style d’arrangement choisi. Surtout dans le cas des

styles d’orchestration Sections dédiées et Sections mélangées, comme expliqué ci-dessous.

* Sibelius peut orchestrer en faisant des doublures appropriées, par exemple le piccolo une octave

au-dessus de la flûte. Encore une fois, ceci dépend du style d’arrangement.

Mis à part la scission et la transposition, Arranger ne modifie en rien la musique initiale.

Styles d’arrangement
La manière spécifique dont Sibelius réalise l’arrangement est déterminée par le style

d’arrangement choisi. Le style d’arrangement spécifie quels instruments peuvent être utilisés, ceux

qui font des doublures et quel genre de lignes de notes sera affecté à tel ou tel instrument.

b 5.2 Modifier les styles d’arrangementPlus de 130 styles d’arrangement sont proposés en

plus de ceux que vous pourriez créer vous-mêmes (). On peut dire, en gros, que les styles englobent

les opérations d’orchestration et de réduction, en arrangeant pour une large éventail d’ensembles,

du chœur jusqu’au big band.

Les styles d’arrangement sont nommés selon des critères successifs en général au nombre de 4:

* en 1, figure le type d’ensemble pour lequel l’arrangement sera réalisé (par ex. Orchestre,

Orchestre d’harmonie, 1 Famille: Cuivres);

* en 2, figure le style particulier d’arrangement (par ex. Impressionniste ou Musique de film);

* en 3, se trouvent parfois certaines mentions d’instruments ajoutés ou omis (par ex. Sans
trompettes ou Solo de bois et cordes);

* en 4, est désignée la texture qui sera utilisée pour l’orchestration en Sections dédiées ou en

Sections mélangées (cf. ci-dessous).

Chaque style d’arrangement est aussi décrit de façon plus détaillée sur la partie droite de la fenêtre

Arranger lorsque vous sélectionnez le style; vous obtenez alors des informations utiles et des

conseils sur le choix du meilleur style à utiliser.
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Le style des sections dédiées ou mélangées
Deux styles d’arrangement existent pour l’orchestre: Sections dédiées et Sections mélangées.

* Le type Sections dédiées oriente certains types de traits vers certaines familles d’instruments.

Le matériau est scindé selon la rapidité, ainsi l’arrangement orchestral pourrait confier les traits

plus rapides aux bois et les plus lents aux cuivres. De façon typique, la mélodie est souvent plus

virtuose que l’accompagnement mais pas toujours.

Très souvent, deux styles sont proposés pour des groupes identiques, par exemple l’un avec les

bois jouant les traits les plus rapides, l’autre avec les bois jouant les traits les plus lents.

* Les styles en Sections mélangées permettent de doubler des instruments de diverses familles;

des pupitres de même tessiture tels que les violons et les flûtes peuvent jouer la même chose.

Si aucune des options Sections dédiées ou Sections mélangées n’est sélectionnée, le style

d’arrangement qui s’applique sera celui de l’orchestration en Sections mélangées.

Distribution
Pour “distribuer” un accord (c’est-à-dire répartir ses notes) sur un grand nombre de portées:

* Sélectionnez le matériau que vous voulez distribuer (qui peut se trouver sur une ou plusieurs

portées), et copiez-le dans le presse-papier avec Editer> Copier (raccourci Ctrl+C ou XC)

* Sélectionnez les portées sur lesquelles vous voulez distribuer (n’importe où dans la partition en

cours ou même dans une autre). Choisissez Notes > Arranger (raccourci Ctrl+Maj+V ou

xXV)

* Choisissez le style d’arrangement Distribuer, et cliquez sur OK. Sibelius va instantanément

répartir la musique sur les portées de destination.

S’il y a moins de portées que de notes à distribuer, Sibelius mettra deux notes sur une portée avec

deux voix séparées. Si vous souhaitez réduire deux voix en accords pour une seule voix,

sélectionnez le passage et choisissez, par exemple, Editer > Voix > 1 (raccourci Alt+1 ou z1).

Sibelius transposera aussi des notes à l’octave si nécessaire pour les rendre plus faciles à jouer par

les instruments de destination.

Si vous distribuez un long passage, Sibelius pourrait afficher le message “Nous vous

recommandons de ne pas arranger plus de quelques mesures à la fois”; ignorez-le et cliquez sur

Oui.

Si vous distribuez le contenu d’une portée sur un maximum de quatre portées et que vous

souhaitez un contrôle plus précis sur la manière dont Sibelius distribue les notes sur chacune des

portées de destination (en particulier quand il faut éviter les transpositions d’octave), utilisez

plutôt Extensions > Outils de composition > Distribution – cf. Distribution à la page 560.

Flûte

Hautbois

Clarinette en Sib

Basson
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Réduction
Pour réduire de la musique depuis un certain nombre de portées vers un nombre plus restreint:

* Sélectionnez le matériau dont vous voulez faire la réduction et copiez-le dans le presse-papier à

l’aide de Editer > Copier (raccourci Ctrl+C ou XC)

* Sélectionnez les portées dont vous voulez obtenir une réduction (n’importe où dans la partition

en cours ou dans une autre). Choisissez Notes > Arranger (raccourci Ctrl+Maj+V ou xXV).

* Choisissez un des styles Réduction, et cliquez sur OK.

Plusieurs styles de Réduction sont proposés pour des usages quelque peu différents; lisez la

description de chaque style afin de trouver le plus adapté au résultat que vous souhaiter obtenir.

Pour une réduction pour clavier, le style qui convient le mieux dépendra de la complexité de la

musique originale. Dans la plupart des cas, nous recommandons le style Réduction pour clavier:
Jusqu’à 2 voix par portées, mais si le résultat vous paraît trop confus, choisissez plutôt 1 voix
par portée; évitez également d’intégrer les portées originales dont le contenu n’est manifestement

pas adapté au jeu du clavier.

Si vous réduisez un long passage, Sibelius pourrait afficher le message “Nous vous recommandons

de ne pas arranger plus de quelques mesures à la fois” – ignorez-le et cliquez sur Oui.

Avec les Styles de réduction, il arrive parfois qu’un certain nombre d’indications de nuances

apparaissent en double au-dessus de l’une ou l’autre portée de la musique réduite (elles

proviennent des portées originales); si c’est le cas, sélectionnez le passage de musique concerné et

choisissez Editer > Filtre > Nuances (raccourci Maj+Alt+D ou xzD), puis appuyez sur Suppr
pour les enlever. (Dans les rares cas où des liaisons redondantes apparaîtraient après réduction,

utilisez également des filtres pour les enlever.)

Si la partition à réduire contient des triolets ou d’autres multiplets, ou si vous voulez un contrôle

plus précis sur la manière dont Sibelius réduit, utilisez plutôt Extensions >  Outils de
composition > Réduire – cf. Réduire à la page 563.

Arrangements pour familles d’instruments
Les styles 1 Famille et 2 Familles n’arrangeront que pour les instruments spécifiés par le nom du

style; vous pourriez donc, par exemple, choisir toutes les portées d’une partition pour orchestre ou

harmonie puis utiliser le style d’arrangement 1 Famille: Bois; la musique ne sera alors arrangée

que pour les bois. Toutefois, si vous sélectionnez par exemple toutes les portées des bois sauf les

flûtes, ces dernières ne seront pas utilisées.

Ces styles sont également paramétrables pour les arrangements destinés aux petits ensembles

comme les quatuors de bois, les quintettes de cuivres ou un orchestre à cordes.

Les styles 2 familles sont accessibles tant dans les configurations de Sections dédiées que dans

celles des Sections mélangées mais elles produisent des textures et des couleurs différentes.

Flûte

Hautbois

Clarinette en Sib

Basson
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Arrangements pour orchestre
Les styles Orchestre sont groupés selon leur esthétique musicale et proposent un éventail de

styles variés, du Baroque au Moderne, en passant par l’Impressionnisme et la Musique de film.

La plupart des styles Orchestre produisent des tutti même si on n’a sélectionné que quelques

portées de destination et bien qu’il soit possible d’en sélectionner n’importe quel nombre; c’est

pourquoi, en ne sélectionnant par exemple que les portées de flûtes, clarinettes et alto dans le

passage de destination, seul ces instruments seront utilisés dans l’arrangement. Pour éviter une

orchestration continuellement en tutti, variez le choix des portées sélectionnées et celui du style!

D’autres styles, tels que Famille et Ensemble varié peuvent être utilisés pour l’orchestre afin de

produire des coloris particuliers, puisqu’ils utilisent des groupes d’instruments plus restreints. Il

n’est pas nécessaire de sélectionner des portées particulières en utilisant ces styles; vous pouvez

vous contenter de sélectionner la totalité et le style n’utilisera que les instruments appropriés. Lisez

attentivement la description de chaque style d’arrangement pour voir quels instruments il utilise.

Essayez l’un ou l’autre style plus exotique, vous pourriez découvrir un résultat séduisant produit

par davantage d’instruments inhabituels.

Aucun style n’inclut les percussions à sons indéterminés. Seuls quelques styles utilisent des

percussions à sons déterminés pour leur coloris (par exemple des timbales dans les styles

Romantique et des percussions à clavier dans les styles Moderne). Pour éviter les percussions à

sons déterminés il suffit de ne sélectionner aucune portée de cette catégorie dans les portées de

destination.

Arrangements pour bands
Les styles Band conviennent à la fois aux orchestres de vents, d’harmonie et scolaires, ainsi qu’aux

fanfares et aux percussions militaires. N’omettez pas d’en lire les descriptions: certains styles

produisent des tuttis, d’autres combinent des ensembles plus restreints. Beaucoup de styles

incluent des percussions à clavier mais aucun n’utilise des percussions à sons indéterminés.

Les styles Orchestre d’harmonie (cuivres) sont destinés aux ensembles du même nom.

Le paragraphe Arrangements pour orchestre qui précède donne des conseils généraux

concernant l’usage des différents instruments et des styles d’arrangement (entre autres les styles

Famille et Ensembles dédiés) afin de produire l’arrangement le plus intéressant possible.

Arrangements pour ensembles dédiés
Les styles Ensembles dédiés sont surtout conçus comme des éléments d’orchestration prêts à

l’emploi pour orchestres, bands et grands ensembles. Chacun d’entre eux n’utilise que quelques

instruments. Tout comme les styles Famille, leur usage évite la monotonie dans les arrangements!

Arrangements pour chœur
Les styles Chœur proposent un éventail d’effets variés pour chœur, tels que les sopranos doublées à

l’octave par les ténors ou la mélodie en voix intérieure avec l’accompagnement aux autres voix, etc.

Les styles peuvent être utilisés pour toutes combinaisons de voix. Dès lors, créer des arrangements

pour des chœurs formés de SSAA ou TBB est aussi facile que de créer pour SATB.
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Si vous voulez créer une réduction pour piano d’une partition chorale, utilisez simplement le style

d’arrangement Réduction pour piano approprié.

Arrangements pour ensembles de jazz
Différents styles Jazz sont fournis pour un bon nombre d’ensembles différents, dont le quintet (qui

peut aussi être utilisé pour un quartet ou un trio), le big band et le trad jazz band. Les styles

Famille peuvent être aussi adaptés pour le big band et le jazz band. Encore une fois, variez le style

et les portées de votre sélection afin d’obtenir un arrangement intéressant.

Arrangements pour ensembles rock et pop
Les styles Rock et Pop comprennent des combinaisons standardisées guitare / basse / claviers

(toutefois sans batterie). Faites-en l’essai avec les styles inclus dans un orchestre!

Arrangements pour instrument(s) soliste(s)
Les styles Solo avec accompagnement confient la mélodie au soliste et le reste de la musique

aux autres instruments. Pour utiliser ces styles, il convient de sélectionner les instruments

accompagnateurs tels qu’ils sont spécifiés par le style (guitare, harpe, clavier ou cordes) et

sélectionner aussi la portée du soliste. Vous pouvez sélectionner plus d’une portée soliste (par

exemple flûte et clarinette) ce qui donnera dans ce cas une doublure.

Les simples styles Solo sont proposés pour une extraction rapide de la mélodie vers un soliste

spécifié. La partie d’accompagnement n’est pas utilisée. Elle peut être arrangée séparément pour

d’autres instruments en utilisant d’autres styles d’arrangement.

Tous ces styles supposent que la mélodie est formée des lignes de notes les plus rapides du

matériau original. C’est le cas fréquent mais parfois c’est les notes les plus aiguës qui forment la

mélodie; si cela arrive les filtres vous seront fort utiles (b 5.7 Rechercher et filtrer). 

Arrangements pour d’autres ensembles
Si l’ensemble pour lequel vous voulez arranger est absent de la liste, par exemple un sextuor de

violoncelles, utilisez le style Arrangement standard: le résultat est très souvent acceptable.

Préparation de la musique à arranger
Afin d’obtenir le meilleur résultat possible, il n’est pas inutile de consacrer un peu de temps à

améliorer la partition avant d’utiliser la fonction Arranger.

Puisque Sibelius ne touche pas à la musique originale (si ce n’est la transposition à l’octave, le cas

échéant suivant l’instrument de destination), c’est à vous d’apporter les ajustements préalables

pour que l’écriture soit la plus appropriée aux instruments de destination. Même si toute

intervention ultérieure reste possible, cela évite de devoir effectuer les mêmes changements dans

toute une série d’instruments différents. Voici un certain nombre de choses à bien retenir:
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* Essayer de faire en sorte que la musique originale comporte un nombre constant de voix sur

chaque portée. (Cela pourrait changer le nombre de voix entre différents passages que vous

arrangeriez séparément.) Par exemple considérons le cas suivant:

Pour que la seconde voix de la main droite soit complète et non partielle, il faudrait séparer les

notes graves des accords de la voix 1 pour qu’elles deviennent la seconde voix. Pour cela,

sélectionnez le passage concerné (ici, dans la portée supérieure) et choisissez Edition > Filtrer >

Notes inférieures puis passez la musique dans la voix 2 en choisissant Edition > Voix > 2
(raccourci z2 ou Alt+2); voici ce que vous devriez obtenir:

Ceci vous garantit que Sibelius mettra toute cette voix 2 à la même partie instrumentale. Si vous

ne le faites pas, Sibelius va d’abord vous avertir puis confier les notes originales de la voix 2 à un

instrument séparé avec tous les silences que cela suppose des deux côtés. La raison en est que

Sibelius traite la voix 2 comme se déroulant au travers de tout le passage et qu’il va ajouter des

silences là où il n’y a rien dans la voix 2 afin de créer une ligne continue de notes ou de silences.

* Les styles d’arrangement baroques tels Orchestre: Baroque sont conçus pour la musique de

cette période. N’espérez cependant rien de baroque avec du jazz orchestré pour instruments

baroques!

* Vous pouvez aussi diviser de la musique existante en différentes voix pour l’adapter aux

instruments que vous arrangez. Par exemple, un chiffre de basse “om-pah-pah” fonctionne

mieux si le “oom” dure pendant une mesure dans, par ex., voix 2 alors que les accords “pah-pah”

sont dans la voix 1:

* La fonction Arranger copie les nuances et autres objets de portée (comme les symboles, les

lignes, etc.) mais pas les éléments du système (tels que les armures, indications de mesure, etc.).

Si la musique que vous arrangez contient des changements de mesure, vous devriez créer ces

changements dans le passage de destination (plutôt avant qu’après l’arrangement).

Piano Piano

deux voixune voix

Avant arrangement

Cordes

Après
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* Suppression des éléments inutiles. Par exemple, si vous arrangez du piano pour ensemble de

vents, vous devriez supprimer toutes les indications de pédale avant de commencer – mais ne

supprimez pas les éléments tels que les indications de nuances, les liaisons et les trilles qui

doivent figurer dans les portées de destination.

* Supprimez tous les octavas et rétablissez les notes à leur hauteur réelle avant l’arrangement.

En effet, excepté dans la musique pour clavier, les octavas sont rarement utilisés. Enfin, Sibelius

ne prend pas en compte les octavas lorsqu’il décide de l’attribution d’une ligne à un instrument

en fonction de la tessiture la plus appropriée.

* Si l’aventure vous tente, voici une piste intéressante. Essayez un arrangement par exemple en

n’utilisant que les premiers temps de chaque mesure de la musique préalablement sélectionnés

avec Edition > Filtre > Filtre avancé. Pour produire des accompagnements de texture légère:

n’utilisez que quelques éléments de votre musique originale.

Après avoir utilisé la fonction Arranger
* La fonction Arranger essaye de maintenir la musique transcrite dans la tessiture de chaque

instrument mais dans certains cas, c’est impossible: ainsi dans le cas où vous obtenez des notes

hors de la tessiture, il vous faudra soit assigner ces notes à un autre instrument, soit les octavier.

* Si beaucoup de notes sont hors tessiture, cela signifie que vous avez tenté d’arranger un passage

trop long. En arrangeant une phrase à la fois, vous réduirez les corrections de fin d’opération.

* Si une portée en particulier demande deux voix, vous découvrirez après l’arrangement que

Sibelius a écrit la musique sur deux voix dans tout le passage de destination, même là où les voix

étaient à l’unisson). Dans le cas où la seconde apparaîtrait au-dessus de la première, pour les

inverser, utiliser Édition > Voix > Intervertir 1 et 2 (raccourci Maj.-V). Si les voix sont à

l’unisson ou homophoniques, il est parfois nécessaire de simplifier l’écriture en fusionnant une

bonne partie ou toute la musique sur une portée à une seule voix; sélectionnez le passage et

choisissez Édition > Voix > 1 (raccourci Alt+1 ou z1).

* Si dans un de vos essais d’arrangement, il vous semble que les instruments de destination

reçoivent une partie trop difficile (p. ex. des traits rapides et graves au cor), utilisez Annuler et

recommencez l’arrangement, soit en évitant de placer ces instruments dans la sélection, soit en

choisissant un autre style. Par exemple, le style pour 2 familles d’instruments en ensembles

dédiés, propose des alternatives où les cuivres jouent les traits soit rapides, soit lents.
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5.2 Modifier les styles d’arrangement

b 5.1 Arranger.

Utilisateurs avertis uniquement 

Plus de 130 styles d’arrangement prédéfinis sont proposés dans Sibelius, mais si vous souhaitez

créer les vôtres, cet article vous dira comment faire.

Pour créer des styles d’arrangement efficaces, il convient cependant de bien comprendre au

préalable comment fonctionne la fonction Arranger de Sibelius.

Comment cela fonctionne
L’algorithme de la fonction Arranger de Sibelius est complexe, mais il consiste fondamentalement

à scinder la musique sélectionnée en “lignes de notes” monophoniques formées de notes

individuelles et de silences. Celles-ci sont alors distribuées parmi les portées de destination,

éventuellement transposées à l’octave, en doublant d’autres portées (à l’unisson ou à l’octave), ou

en utilisant plusieurs voix selon la nécessité.

Sibelius détermine les lignes de notes de la manière suivante:

* Toute voix sur une portée qui contient une ou plusieurs notes (ou silences ou mesures de silence)

est traitée comme une ou plusieurs lignes de notes.

* Si le nombre de notes dans la voix n’est pas constant (par exemple, si un passage en tierces est

suivi d’un passage de notes seules), c’est les notes supérieures qui sont choisies pour former la

ligne la plus complète de toutes les lignes créées.

* Chaque ligne de notes inclut tous les autres objets attachés à la voix ou à la portée; toutes les

notes conservent donc leurs articulations, liaisons rythmiques, têtes de note spécifiques, etc.,

ainsi que les objets attachés tels que le texte et les lignes comme les liaisons de phrasé.

Ces lignes de notes sont alors arrangées dans les portées de destination en fonction du style

d’arrangement choisi. Les styles d’arrangement spécifient les “ groupes d’instruments ” pour

lesquels un type similaire de musique sera arrangé.

Les principes généraux suivants sont d’application:

* Sibelius s’efforcera de placer toute la musique à arranger dans les portées sélectionnées, ce qui

donne parfois un grand nombre de doublures (s’il y a trop peu de lignes de note pour le nombre

de portées sélectionnées) ou beaucoup de portées à plusieurs voix (s’il y a trop de lignes de notes

pour le nombre de portées sélectionnées).

* Sibelius n’assignera qu’une ligne de notes à chaque groupe, sauf s’il y a moins de lignes que de

groupes. Si, par exemple et pour prendre un cas extrême, la musique à arranger consiste en une

seule ligne monophonique destinée à un grand orchestre, Sibelius ne composera pas la musique

pour accompagner la ligne unique; il la doublera simplement à travers les portées

* Sibelius ajuste les hauteurs de chaque ligne de notes à une tessiture confortable pour

l’instrument de destination. (L’utilisateur peut spécifier en option si Sibelius doit “étirer” la

musique de départ sur une étendue de notes déterminée; cf. ci-dessous.)
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Lorsque qu’il arrange, Sibelius trie les lignes de notes de quatre manières déterminées par le style

d’arrangement:

* Du plus rapide au plus lent: les lignes de notes avec la valeur de note moyenne la plus courte sont

attribuées au premier groupe d’instruments de la liste, le dernier groupe de la liste se voyant

confié la ligne de notes avec la valeur de note moyenne la plus longue.

* Du plus haut au plus bas: la ligne de notes avec la hauteur de note moyenne la plus élevée est

confiée premier groupe d’instruments, etc.

* Le plus chargé (jouant le plus de notes): les ligne de notes avec le plus grand nombre de notes sont

attribuées aux premiers groupes d’instruments, et les lignes avec le moins de notes aux derniers

groupes

* Le plus chargé (jouant presque tout le temps): les lignes de notes qui jouent la plus grande

proportion de la durée totale du matériel source sont données aux premiers groupes

d’instruments, etc...

Modifier les styles d’arrangement
* Choisissez Notes > Modifier les styles d’arrangement:

% Pour modifier un style existant, sélectionnez-le dans la liste déroulante et cliquez sur

Modifier

% Pour créer un nouveau style, sélectionnez le style existant le plus approprié pour servir de

base à votre nouveau style puis cliquez sur Nouveau

* Voici la boîte de dialogue qui apparaît:

Au sommet de la boîte de dialogue vous pouvez modifier le Nom du style et écrire une

description appropriée si vous le désirez. La moitié inférieure de la boîte de dialogue affiche la

liste des groupes d’instruments pour lesquels Sibelius va arranger la musique.
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* Supprimez un groupe d’instruments existants en sélectionnant son nom et en cliquant sur

Supprimer; pour modifier l’ordre des groupes sélectionnez-en un et cliquez sur Monter ou

Descendre

* Pour ajouter un nouveau groupe d’instruments, cliquez sur Nouveau et choisissez les

instruments à inclure dans le groupe.

Plusieurs méthodes sont possibles: vous pouvez placer les instruments mélodiques (par exemple

les bois aigus et les cordes) dans un groupe, et les instruments de soutien (par exemple les

cuivres et les cordes graves) dans un autre.

Vous pouvez également spécifier si un instrument doit doubler l’instrument se trouvant au-

dessus dans la liste à l’intervalle spécifié (par exemple si vous désirez que la flûte soit doublée à

l’octave par un piccolo, ou si vous voulez que certains instruments jouent en tierces).

Si vous souhaitez que deux instruments en doublent un seul, par exemple si vous souhaitez que

les flûtes soient doublées par le piccolo et la clarinette, les instruments doivent être placés dans le

champ Instruments dans le groupe de la façon suivante:

En d’autres termes, plusieurs instruments peuvent n’en doubler qu’un. L’instrument qui sera

doublé lorsque vous activerez l’option Doubler l’instrument indiqué ci-dessus sera le premier

instrument au-dessus de l’instrument sélectionné qui n’est pas réglé pour doubler un autre

instrument.

Même si vous n’en spécifiez aucune, des doublures peuvent survenir (si vous arrangez des lignes

de notes sur un grand nombre de portées, par exemple).

* Quand tous les instruments ont été ajoutés au groupe, cliquez sur OK

* Donnez un nom au groupe (par ex. V. I + Fl.) en double-cliquant sur l’espace vierge de la

colonne Nom

* Si vous souhaitez spécifier un ambitus à l’intérieur duquel Sibelius doit arranger la musique pour

ce groupe, réglez Ambitus sur Oui puis choisissez la Hauteur min et la Hauteur max
appropriée. Sibelius transposera alors la musique à l’octave de façon à ce qu’elle se tienne à

l’ambitus spécifié, et à ce que les différents instruments du groupe remplisse collectivement

l’entièreté de l’étendue.

Flute pas réglée pour doubler

Piccolo double à l’octave supérieure

Clarinette double à l’unisson
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Ambitus est utile si, par exemple, votre matériau source est une pièce pour piano qui par

nécessité utilise une étendue limitée pour les accords (généralement un ambitus inférieur à un

intervalle de dixième par main), et que vous souhaitez que la musique soit jouée sur l’étendue

entière d’une section de cordes; ou pour s’assurer que le matériau se retrouve dans un ambitus

particulier, par ex., l’aigu des bois, même si ces instruments peuvent également jouer dans le

grave.

* Nombre de lignes min détermine le nombre minimum de lignes qui peuvent être assignées au

groupe sélectionné. Le réglage par défaut de 0 est recommandé; il signifie que le groupe ne doit

pas jouer tout le temps.

* Nombre de lignes max détermine le nombre maximum de lignes qui peuvent être attribuées

au groupe sélectionné. Le réglage par défaut (un blanc) autorise tout nombre de lignes à être

confié au groupe.

Vous ne devriez modifier ce réglage que si vous désirez des effets particuliers; régler par ex.

Nombre de lignes max sur 1 impose à tous les instruments du groupe de doubler le même

matériau.

* Nombre de lignes max par portée et Nombre de voix max par portée contrôlent la

distribution des lignes de note parmi les instruments du groupe. Le réglage par défaut (de 2 et 2
respectivement) convient à la plupart des genres de musique.

De manière générale, Sibelius n’utilisera des voix multiples sur un portée que lorsqu’il n’a pas

d’autre choix, par ex. s’il y a plus de lignes de notes assignées à un groupe qu’il n’y a de portées

dans celui-ci.

Si le Nombre max de lignes par portée est réglé sur un chiffre supérieur à celui du Nombre
max de voix par portée Sibelius fusionnera des lignes de notes en accord dans une même voix.

(Il n’y a évidemment pas d’intérêt à régler le Nombre max de lignes par portée sur un chiffre

inférieur au Nombre max de voix.) Si vous désirez n’avoir qu’une seule note par portée, réglez

ces deux options sur 1.

Quelques réglages utiles pour ces options:

* Tous les instruments d’un groupe se voient attribuer la même musique. La façon dont les lignes

de notes sont assignées aux groupes est définie par l’option Quelles lignes sont affectées au
premier groupe; si vous réglez par exemple cette option sur Le plus haut, les lignes les plus

hautes vont au premier groupe de la liste, les secondes les plus hautes au groupe suivant, etc.

Modifiez l’ordre des groupes d’instruments en cliquant sur Déplacer vers le haut ou Déplacer
vers le bas. (Voyez plus bas pour plus de détails sur ceci.)

* Lorsque vous avez terminé de définir votre style d’arrangement, cliquez sur OK.

Clavier Nombre max. de lignes par portée = 4, Nombre max. de voix = 2

Bois seul Nombre max .de lignes par portée = 1, Nombre max. de voix = 1

Bois par deux Nombre max. de lignes par portée = 2, Nombre max. de voix = 2

Cuivre Nombre max. de lignes par portée = 2, Nombre max. de voix = 2

Cordes Nombre max. de lignes par portée = 2, Nombre max. de voix = 2

Chanteurs Nombre max .de lignes par portée = 1, Nombre max. de voix = 1
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Les styles d’arrangement sont sauvegardés automatiquement dans le sous-dossier Styles
d’arrangement de votre dossier Sibelius, vous pouvez donc les partager avec d’autres utilisateurs

en leur envoyant simplement le fichier .sar approprié se trouvant dans ce dossier – Fichiers que
peut créer l’utilisateur dans b 9.1 Manipuler les fichiers.

Si vous créez des styles pour d’autres personnes, vous devriez inclure tous les instruments

appropriés possibles dans chaque style (ce que nous avons fait pour les styles prédéfinis).

Par exemple, un style d’arrangement pour cuivres devrait de préférence inclure des instruments

rares tels que les trompettes piccolo ou les cors avec tons de rechange, au cas où quelqu’un

désirerait arranger pour ceux-ci.

Quelles lignes sont attribuée au premier groupe
Les styles d’arrangement fournis sont adaptés à la plupart des arrangements, mais si vous désirez

tout de même créer les vôtres, il est important de comprendre comment la distribution des notes

affecte l’arrangement produit.

Les quatre méthodes de tri des lignes de notes - qui sont déterminées par l’option Quelles lignes
sont attribuées au premier groupe - donnent lieu à des distributions très différentes de la

musique. En termes généraux:

* Si le critère du tri est la hauteur de note (c’est-à-dire Le plus aigu), les groupes devraient être

disposés de manière à ce que les instruments de chaque groupe puissent jouer dans leur registre

correct, par exemple le premier groupe serait formé par les instruments aigus (comme les

violons et les flûtes), un second groupe par les instruments médium (par ex. altos, clarinettes et

cors) et un troisième groupe par les instruments graves (par exemple violoncelles, bassons et

trombones). Le tri par hauteur de note permet aux doublures conventionnelles dans une

orchestration à sections mélangées (par exemple les violons doublés par les flûtes et les

clarinettes, les altos doublés par les hautbois, les violoncelles doublés par les bassons, etc...)

d’être définies facilement. Ce genre de style d’arrangement devrait en général contenir trois à

quatre groupes. Les styles en Sections mélangées sont définis de cette manière.

* Si le critère du tri est la vitesse (c’est-à-dire Le plus rapide ou Le plus chargé), chaque groupe

devrait contenir une répartition d’instruments capable de jouer sur toute l’étendue du registre,

comme par exemple les instruments des familles instrumentales conventionnelles (bois, cuivres

et cordes). Cela rend possible l’orchestration en “sections dédiées”, dans laquelle chaque famille

joue un type particulier de matériau (par ex. les bois jouent la musique la plus rapide, les cuivres

la plus lente). Ce genre de style d’arrangement devrait en général contenir trois à quatre groupes.

Les styles en Sections dédiées sont définis de cette manière, en triant par Le plus rapide qui

est notre réglage recommandé pour les orchestrations en sections dédiées.

* Si vous hésitez sur le choix du critère de tri, Le plus aigu (c’est-à-dire orchestration en sections

mélangées) donne généralement les meilleurs résultats par défaut.
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5.3 Classroom Control

Si vous êtes un enseignant et que vous exploitez Sibelius dans une ou plusieurs classes ou

laboratoires à l’école, au lycée ou à l’université, via Licence Server de Sibelius, vous pouvez utiliser

la fonction Classroom Control pour exécuter des taches de gestion de classe utiles depuis votre

poste de travail. Vous pouvez recevoir des fichiers à partir d’autres copies de Sibelius sur le réseau,

envoyer des fichiers à certains étudiants, “geler” des copies de Sibelius pour centrer l’attention de la

classe vers vous, et plus encore.

Classroom Control n’est disponible que si vous exploitez une licence de site réseau de Sibelius.

Définir le mot de passe d’enseignant
Avant de pouvoir utiliser la fonction Classroom Control, vous devez changer le mot de passe pour

votre licence de site réseau. Cela s’effectue dans le panneau de configuration de Licence Server, qui

doit être installé sur votre poste de travail, ou sur le serveur sur lequel le Licence Server de Sibelius

a été installé.

A des fins de sécurité, le mot de passe par défaut n’est pas imprimé ici, mais imprimé sur le manuel

d’utilisateur de Licence Server, avec les instructions de changement de mot de passe.

Se connecter à Classroom Control
Pour lancer Classroom Control, exécutez Sibelius sur votre poste de travail. Votre copie de Sibelius

doit être l’une des copies en réseau de votre licence de site réseau. Choisissez Fichier > Classroom
Control, et vous êtes invité à vous connecter :

(si vous ne voyez pas l’élément de menu Fichier > Classroom Control, votre copie de Sibelius ne fait

pas partie d’une licence de site réseau. Contactez votre gestionnaire de réseau ou l’administrateur

système pour recevoir plus d’aide).

Saisissez le mot de passe que vous avez défini dans le panneau de configuration de Licence Server,

et cliquez sur OK. Si vous activez Rester connecté sur cet ordinateur, Sibelius enregistrera votre

mot de passe et ne vous demandera pas de le saisir quand vous utilisez Classroom Control dans les

sessions suivantes. Vous ne devez l’activer que si vous êtes sûr que les étudiants n’ont pas accès à

votre poste de travail.
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Protéger votre mot de passe
Sachez que l’élément de menu Fichier > Classroom Control figure dans les menus de toutes les

copies de Sibelius exécutées sur votre réseau. Afin de vous protéger contre les étudiants

malveillants capables de se connecter à Classroom Control, il est important de choisir un mot de

passe astucieux dans le panneau de configuration de Licence Server, et de ne pas le divulguer aux

étudiants.

Utiliser Classroom Control
Après vous être connecté en saisissant votre mot de passe d’enseignant, la boîte de dialogue

suivante apparaît :

Le tableau à gauche de la boîte de dialogue recense les informations sur chaque copie de Sibelius en

cours d’exécution sur votre réseau :

* Nom d’utilisateur recense la longueur du nom de compte de l’utilisateur, le cas échéant, ou le

nom d’utilisateur court utilisé par cet utilisateur pour se connecter à l’ordinateur.

* Nom d’hôte répertorie le nom d’hôte de l’ordinateur auquel un utilisateur donné est

actuellement connecté ; si aucun nom d’hôte  n’est disponible, vous verrez une adresse IP

numérique à la place.

* Statut recense le nom de fichier de la partition sur laquelle l’utilisateur travaille, ou Pas de
partition ouverte si l’étudiant n’a pas de fichier ouvert actuellement ; si vous avez gelé cette

copie de Sibelius, il affichera Gelé.

Pour exécuter les fonctions de gestion de classe, sélectionnez une ou plusieurs rangées dans le

tableau, ou cliquez sur le bouton Tout sélectionner en bas de la fenêtre pour sélectionner toutes

les rangées en un clic.



5.3 Classroom Control

433

O
utils 

Pour fermer la boîte de dialogue Classroom Control, cliquez sur Fermer. Cliquer sur Se
déconnecter et fermer ferme la boîte de dialogue et efface le mot de passe d’enseignant de

Sibelius. Vous serez alors invité à le saisir la prochaine fois que vous choisissez Fichier >

Classroom Control ; c’est plus sûr, mais également moins pratique.

Les options de gestion de classe à droite sont divisées en trois groupes, décrits ci-dessous.

Geler et dégeler
Geler vous permet de verrouiller provisoirement Sibelius sur l’ordinateur d’un utilisateur. Quand

vous sélectionnez un ou plusieurs utilisateurs dans la liste et cliquez sur Geler, la copie de Sibelius

exécutée sur chacun des ordinateurs sélectionnés affichera un message informant l’utilisateur que

sa copie de Sibelius a été gelée par l’enseignant. Vous pouvez choisir d’envoyer un message

personnalisé (ex. “10 minutes à gauche !”) en activant l’option Envoyer message personnalisé
lors d’un gel avant de cliquer sur Geler : vous serez ensuite invité à fournir un message à afficher

aux utilisateurs concernés. Pour déverrouiller une copie gelée de Sibelius, sélectionnez-la dans le

tableau et cliquez sur Dégeler.

Si vous tentez de fermer la boîte de dialogue Classroom Control alors que certaines copies de

Sibelius sur le réseau sont encore gelées, Sibelius vous invitera à les dégeler.

Recevoir et envoyer des partitions
Les options dans le groupe Fichiers vous permettent de recevoir la partition actuellement ouverte

sur l’ordinateur de n’importe quel utilisateur, ou d’envoyer une partition depuis votre propre poste de

travail vers l’un des ordinateurs en réseau. C’est utile, par ex. pour afficher le travail d’un étudiant sur

le projecteur numérique ou le tableau interactif relié à votre propre poste de travail, ou pour

distribuer une fiche de travail ou un exercice aux étudiants de votre classe.

Avant de recevoir la partition d’un utilisateur, décidez d’abord de ce que vous souhaitez en faire, et

configurez les boutons radio dans le groupe Fichiers de manière adéquate : choisissez Enregistrer
les partitions reçues si vous ne souhaitez pas consulter la partition maintenant, mais préférez

simplement l’enregistrer sur votre poste de travail ; choisissez Ouvrir partitions reçues si vous

souhaitez juste y jeter un coup d’oeil, sans obligatoirement l’enregistrer sur votre poste de travail ;

ou choisissez Enregistrer et ouvrir partitions reçues si vous souhaitez regarder la partition

maintenant et l’enregistrer sur votre poste de travail. Si vous choisissez d’enregistrer la partition,

Sibelius créera un dossier dans votre dossier Partitions portant le nom de l’utilisateur dont vous

recevez la partition, et enregistrera la partition à cet endroit.

Pour recevoir des partitions actuellement ouvertes sur d’autres ordinateurs en réseau, choisissez

simplement une ou plusieurs rangées dans la liste à gauche, puis cliquez sur Recevoir partition.

Une barre de progression apparaît quand Sibelius sollicite les partitions de chaque copie

sélectionnée de Sibelius, et les transfère sur le réseau ; selon la taille des partitions, la vitesse et le

trafic de votre réseau, cela peut prendre quelques secondes. Si vous choisissez d’ouvrir, ou

d’enregistrer et d’ouvrir les partitions reçues, Sibelius ouvre chaque partition à son arrivée sur le

réseau.

Vous pouvez aussi envoyer une partition vers une ou plusieurs copies de Sibelius sur le réseau : si

une partition est actuellement ouverte dans votre copie de Sibelius, cliquer sur Envoyer partition
actuelle l’enverra sur le réseau aux copies de Sibelius que vous avez sélectionnées dans la liste à
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gauche, en l’ouvrant automatiquement sur chaque copie. Si aucune partition n’est ouverte, ou si

vous souhaitez envoyer une autre partition que celle consultée actuellement, cliquez sur Envoyer
autre partition, qui affiche une fenêtre de sélection de fichier standard. Choisissez le fichier que

vous voulez envoyer et cliquez sur Ouvrir. Le fichier est envoyé sur le réseau et ouvert sur chaque

copie de client sélectionnée.

Réaliser des versions
Si vos étudiants travaillent sur un projet à long terme, comme un contrôle continu, vous noterez

que les fonctions de version de Sibelius constituent un moyen très utile pour que les étudiants

puissent suivre leur progression. Dans la boîte de dialogue Classroom Control, vous pouvez cliquer

sur Réaliser Version, ce qui invitera les utilisateurs sélectionnés à fournir un commentaire sur

leur travail en cours et enregistrer leur partition. Vous pouvez cliquer sur ce bouton quelques

minutes (par ex.) avant la fin d’un cours pour veiller à ce que chaque étudiant ait enregistré son

travail correctement, et eu l’occasion d’émettre un commentaire sur le déroulement de cette séance.

Pour en savoir plus sur les versions, b 5.22 Versions.
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5.4 Couleur

b 5.10 Surbrillance.

Sibelius est capable de colorer un grand nombre d’objets d’une partition. Cela peut s’avérer très utile

pour produire des partitions qui sollicitent le regard: on peut, par exemple, colorer toutes les

indications de tempo de direction ou tous les repères de répétition dans une couleur spécifique

pour attirer l’attention du chef ou des interprètes. De même cette option peut s’avérer très

intéressante pour des partitions à visées pédagogiques: les différentes couleurs s’utiliseront pour

permettre de différencier les doigtés et les diagrammes d’accord, ou pour colorer chaque hauteur

sur une portée, tout cela dans le but de favoriser l’apprentissage de la musique.

Comment colorer un objet
Changer la couleur d’un (ou de plusieurs) objets ne pose aucun problème:

*  Sélectionner l’objet ou les objets à colorer

* Choisissez Édition > Couleur (raccourci Ctrl+J ou XJ), ou cliquez sur le bouton de la barre

d’outils

* Une palette de couleurs standard apparaît: choisissez la couleur souhaitée et cliquez sur OK.

Pour colorer un objet avec la couleur précédemment appliquée à un autre, sélectionnez l’objet et

choisissez Édition > Réappliquer la couleur (raccourci Ctrl+Maj+J ou xXJ).

Les objets peuvent se colorer individuellement ou ensemble. Par exemple, pour changer la couleur

de toutes les notes d’une mesure, sélectionnez la mesure de manière à ce qu’elle soit entourée d’un

simple cadre bleu clair, puis choisissez Édition > Couleur. Vous pouvez aussi utilisez les filtres

(b 5.7 Rechercher et filtrer) pour sélectionner, par exemple, toutes les paroles d’une chanson

et les colorer en une seule opération.

Réinitialiser la couleur d’un objet
Pour réinitialiser la couleur d’un objet en noir, sélectionnez-le et choisissez Mise en page >

Rétablir l’aspect original (raccourci Ctrl+Shift+D ou xXD).

Afficher les notes en couleur
La possibilité de voir les notes mises en couleur dépend de l’option choisie dans le sous-menu

Affichage > Couleurs. Si Couleur par voix est activé, toutes les notes sont colorées selon l’une de

ces deux options, et non d’après une des couleurs individuelles que vous auriez choisie. Les

couleurs choisies par l’utilisateur ne sont visibles qu’en activant soit l’option Aucune soit l’option

Notes hors tessiture. b 5.23 Menu affichage.

Imprimer en couleur
Les partitions peuvent être imprimées en couleur selon la nécessité; vérifiez que l’option Imprimer
en couleur dans la boîte de dialogue Fichier > Imprimer est activée. Si vous possédez une

imprimante noir et blanc, les objets en couleur seront imprimés en gris. D’office, si cette option est

désactivée, tous les objets colorés seront imprimés en noir – b 5.16 Imprimer.
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Quels objets peuvent être colorés?
À quelques exceptions près, pratiquement tout ce qui se sélectionne peut être coloré, c’est-à-dire

les notes, les lignes, le texte, les diagrammes d’accord, les symboles, etc...

Quand les notes sont colorées, les éléments associés reçoivent la même couleur que la tête de note;

ce sont les altérations, les articulations, le point de rythme, les crochets et les liaisons rythmiques.

Par contre, ne sont pas concernés par la couleur de la tête de note et restent toujours en noir:

ligatures, lignes supplémentaires, hampes, barres des acciaccaturas; trémolos; tronçons de ligature

et crochets.

Quels sont les objets qui ne peuvent être colorés?
* Les notes d’un accord prises individuellement (si on colore une note d’un accord, toutes les

autres notes recevront la même couleur)

* Le nom des instruments placé à gauche du système

* Les numéros de mesure (même si on peut colorer les changements de numéros de mesure)

* Les clefs initiales au début des systèmes (même si on peut colorer les changements de clefs)

* L’armure initiale au début des portées (même si on peut colorer les changements d’armures )

* le nom des notes indiquant l’accordage des portées de tablature en début de système

* Les barres de mesure normales (bien qu’il soit possible de colorer des barres de mesures

spéciales, telles que des barres de mesure de répétition, les doubles barres et les barres finales)

* Les lignes de portée.

Conserver les couleurs dans les palettes de couleur
Pour conserver des couleurs afin de les réutiliser plus tard, il faut les conserver dans la section

Couleurs personnalisées de la palette de couleur. Ce n’est pas aussi simple que cela n’y paraît, car

toute nouvelle couleur se conserve comme première couleur personnalisée (ce qui remplace votre

nouvelle couleur dans la partie droite de la boîte) sauf si une couleur personnalisée a été

sélectionnée préalablement.

Si vous parcourez une partition à la recherche de plusieurs couleurs déjà utilisées et que vous

souhaitez les ajouter à la liste des couleurs personnalisées, voici comment procéder:

* Sélectionnez l’objet qui utilise la couleur à mémoriser

* Choisissez Édition > Couleur (raccourci Ctrl+J)

* Tapez Alt+C pour sélectionner la première couleur personnalisée

* Utilisez les flèches pour que le cadre actif se déplace jusqu’à la case dans laquelle la couleur de

l’objet doit être conservée

* Cliquez sur Ajouter aux couleurs personnalisées.

Conserver les couleurs dans la palette de couleur sur Mac
Pour ajouter une couleur personnalisée sur Mac:

* Sélectionnez l’objet qui utilise la couleur à mémoriser

* Choisissez Édition > Couleur (raccourci XJ)

* Cliquez et maintenez enfoncé le bouton gauche de la souris dans le cadre affichant la couleur de

l’objet au sommet de la boîte de dialogue

* Déplacez la souris dans une des cases pour couleur personnalisée situées en bas de la boîte de

dialogue
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5.5 Commentaires

Les commentaires sont des “bulles” que vous pouvez créer dans votre partition, et qui servent de

rappels de ce que vous devez faire, ou éventuellement de moyen pratique pour communiquer avec

des gens avec qui vous collaborez, qu’ils soient enseignants ou étudiants, arrangeurs ou éditeurs.

Créer un commentaire
Pour ajouter un commentaire à votre partition, cliquez simplement sur le bouton de

commentaire de la barre d’outils (affiché à droite), choisissez Créer > Commentaire, ou

utilisez le raccourci clavier Shift+Alt+C ou xzC. Cliquez à l’endroit où vous souhaitez

insérer le commentaire, saisissez le texte que vous souhaitez voir apparaître dans le commentaire

et appuyez sur Esc.

Si vous aviez sélectionné de la musique avant de créer le commentaire, le commentaire apparaîtra

automatiquement joint à la portée supérieure dans la sélection, et le texte du commentaire

affichera les noms des portées sélectionnées et les mesures sélectionnées. Cette option s’avère

pratique pour faire office de rappel propre à certaines mesures chez certains instruments.

Modifier un commentaire
Pour modifier un commentaire, double-cliquez simplement sur la partie principale du

commentaire. Modifier un commentaire s’apparente exactement à la modification de tout autre

texte dans la partition  : vous pouvez changer la police, le format (ex. gras, italique) et la taille d’un

commentaire individuel à l’aide des contrôles dans le panneau de Propriétés Texte.

Si vous souhaitez changer la police par défaut, la taille ou le format des commentaires dans votre

partition, choisissez Style maison > Modifier styles de texte et modifiez le style de texte

Commentaire (b 3.9 Modifier les styles de texte).

Redimensionner un commentaire
Lors de la saisie, Sibelius veille automatiquement à ce que votre commentaire soit assez grand pour

contenir tout le texte, mais les commentaires peuvent également être redimensionnés en cliquant

sur l’un des bords inférieurs du commentaire ou le bord droit du commentaire, puis en glissant/

déposant.
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Les commentaires peuvent également être réduits en double-cliquant sur la mesure indiquant

votre nom et la date à laquelle le commentaire a été créé ou modifié pour la dernière fois. Voici à

quoi ressemble un commentaire réduit :

Couleurs de commentaire
Sibelius attribue automatiquement une couleur aux commentaires ajoutés à la partition par

chaque utilisateur individuel, ce qui vous permet de voir en un coup d’oeil quels commentaires ont

été ajoutés par différentes personnes. Vous ne pouvez pas modifier la couleur choisie par chaque

utilisateur par défaut, mais vous pouvez changer la couleur d’un commentaire existant en

sélectionnant et en choisissant Editer > Couleur (b 5.4 Couleur).

Supprimer des commentaires
Pour supprimer un commentaire, sélectionnez-le et appuyez simplement sur Supprimer. Si vous

souhaitez rapidement plusieurs commentaires, sélectionnez le passage dont vous souhaitez

supprimer les commentaires, ou sélectionnez toute la partition, et choisissez Editer > Filtre >

Commentaires, puis appuyez sur Supprimer.

Consulter des commentaires
Vous pouvez choisir si les commentaires doivent être visibles ou non dans votre partition en

choisissant Affichage > Commentaires, pour activer ou désactiver tous les commentaires. Si vous

ouvrez une partition contenant des commentaires mais que Affichage > Commentaires est

désactivé, Sibelius vous demandera si vous souhaitez afficher les commentaires dans la partition.

Imprimer des commentaires
Pour imprimer des commentaires, assurez-vous que Affichage > Commentaires est activé, et que

toute autre option dans le menu Affichage que vous ne souhaitez pas inclure dans votre

impression est désactivée. Choisissez maintenant Fichier > Imprimer, et veillez à ce que les

Options du menu Aperçu avant impression soit activé (sur la page de Sibelius de la boîte de

dialogue sur Mac).

Changer le nom d’utilisateur affiché sur un commentaire
Par défaut, Sibelius utilise le nom associé au compte d’utilisateur auquel vous êtes connecté sur

votre ordinateur. Parfois, cela peut donner un nom comme Utilisateur par défaut apparaissant

dans vos commentaires. Pour changer le nom affiché dans un commentaire, choisissez Fichier >

Préférences (dans le menu Sibelius sur Mac), et allez à la page Autre, où figurent des options

pour préciser l’apparence des commentaires dans vos partitions :
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* Désactivez Afficher nom d’utilisateur dans les
commentaires si vous souhaitez seulement voir

la date et l’heure auxquels le commentaire a été

créé ou modifié pour la dernière fois.

* Activez Ignorer le nom d’utilisateur par défaut
si vous souhaitez changer le nom d’utilisateur

figurant dans chaque commentaire que vous créez

par la suite.

* Désactivez Afficher la date et l’heure dans les commentaires si vous souhaitez seulement

voir le nom d’utilisateur dans l’en-tête de chaque commentaire.

* Si le nom d’utilisateur ainsi que la date et l’heure sont réglés à l’affichage dans la barre de titre de

commentaires, l’option Ordre du texte dans l’intitulé de commentaire vous permet de

préciser si le nom d’utilisateur ou la date et l’heure doivent d’abord être affichés. Si la largeur

d’un commentaire est insuffisante pour contenir le nom d’utilisateur et la date, Sibelius

n’affichera que celui ou celle qui apparaît en premier et masquera l’autre.
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5.6 Paramètres d’affichage

b 5.23 Menu affichage.

Les paramètres pour l’affichage ont une influence directe sur la vitesse et le confort visuel dans

l’utilisation de Sibelius. Prendre le temps de bien les régler vaut donc vraiment la peine.

Résolution d’écran
Sibelius nécessite une résolution minimum de 1024 x 768 pixels, mais une résolution supérieure

est recommandée. Pour modifier votre résolution d’écran:

* Sous Windows:

% Réduisez tous les programmes ouverts, puis faites un clic-droit sur le bureau et choisissez

Propriétés dans le menu contextuel

% Cliquez sur l’onglet Paramètres

% Déplacez le curseur de Résolution de l’écran vers la droite pour augmenter la résolution

d’écran, et cliquez sur Appliquer pour tester les changements. Si votre ordinateur est déjà

ancien, vous aurez peut-être à réduire la valeur dans Qualité couleur de manière à pouvoir

afficher de plus hautes résolutions; cf. Nombre de couleurs ci-dessous. 

* Sur Mac:

% À partir du dock, lancez les Préférences système et double-cliquez sur l’icône Moniteurs

% Choisissez une nouvelle définition d’écran dans la liste; votre Mac passe automatiquement à la

résolution choisie.

En fonction de la carte graphique de votre ordinateur, des résolutions plus élevées peuvent quelque

peu ralentir la mise à jour de l’écran; si vous vous apercevez que c’est le cas, essayez de réduire le

nombre de couleurs, ce qui réduira ainsi la charge de travail de votre carte graphique.

Nombre de couleurs
Sur Mac, l’affichage de Sibelius devrait être agréable quelle que soit la “profondeur” de couleur

(nombre de couleurs), de 256 à plusieurs millions de couleurs. Vous ne devriez modifier le nombre

de couleurs utilisées pour l’affichage que si la mise à jour de l’écran vous semble particulièrement

lente à une certaine profondeur de couleur.

Sous Windows, par contre, il est recommandé de régler l’affichage à une profondeur de couleur

d’au moins 16 bits. Ceci est dû au fait que certains boutons du pavé peuvent ne pas s’afficher

correctement sur des écrans utilisant 256 (ou moins) couleurs.

Pour modifier la profondeur de couleur utilisée pour l’affichage, suivez les instructions décrites

dans Résolution d’écran ci-dessus.

Textures
Dans Sibelius, l’utilisation de textures de haute qualité permet de rendre l’apparence du bureau et

du papier virtuel plus agréable. Vous pouvez facilement changer de textures, à choisir dans un

large éventail de papiers, bois, marbres etc. proposé dans la page Textures de Fichier >

Préférences (dans le menu Sibelius sur Mac).
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Le menu de la commande Modifier les textures pour permet de régler les textures de manière

indépendante pour la Partition, les Parties et les Idées, et de visualiser les versions en lecture

seule indépendamment.

Quelques propositions de textures

amusantes: Peau de tigre pour le bureau,

Papier, tache de café pour le papier lors

d’une session nocturne! Mais peut-être la

texture la plus pratique est Papier,
quadrillé, qui est très utile pour aligner

visuellement des objets dans la partition –

les lignes de la grille sont espacées d’une dent quand l’affichage est à 100%.

Si la mise à jour de l’écran semble particulièrement lente, essayez d’activer l’option Affichage
alternatif des textures dans cette boîte de dialogue puis quittez et relancez Sibelius; cela accélère

Sibelius sur certains ordinateurs. (cette option n’est pas disponible sous Mac OS X lorsque

l’optimisation est activée.)

Si la mise à jour de l’écran est toujours lente, vous constaterez probablement que désactiver les

textures (en réglant les options sur Utiliser une couleur, pas une texture) permet de l’accélérer.

Il est possible d’ajouter ses propres textures dans Sibelius – placez simplement une image

appropriée au format Windows bitmap (BMP ) dans le sous-dossier Textures du dossier du

programme Sibelius (dans Fichiers que peut créer l’utilisateur à la page 716), et elle sera

alors disponible dans la page Textures de la boîte de dialogue. Lors du prochain redémarrage de

Sibelius, les nouvelles textures seront disponibles dans la page Textures page de la boîte de

dialogue Fichier > Préférences.

Optimisation de l’affichage
Sous Windows, vous pouvez régler la manière et ce qui est affecté par l’optimisation en

sélectionnant Affichage dans Fichier > Préférences.

Vous pouvez choisir une optimisation préréglée dans le menu réglages (Sibelius utilise par défaut

Fluide et rapide), ou vous pouvez changer les réglages individuellement, c’est-à-dire d’optimiser

ou non Liaisons de phrasé et rythmiques, Ligatures, Lignes en diagonales (par ex. des

soufflets) et Lignes droites (par ex. des lignes de portée). L’optimisation des symboles et du texte

peut être soit désactivée, soit utiliser le réglage par défaut du système ou être activée. Le réglage par

défaut peut être modifié en cliquant sur le bouton Effets de la page Apparence des propriétés
d’Affichage du système. (Choisissez Démarrer > Réglages > Panneau de configuration et

double-cliquez sur Affichage.)

Sur Mac, Sibelius utilise l’affiche intégré Quartz, qui lisse en permanence. Aucune option n’est

nécessaire pour Quartz, et donc aucune option d’Optimisation n’apparaîtra à l’écran sur Mac.

Astuces pour accélérer
Voici quelques moyens d’améliorer la vitesse à laquelle Sibelius tourne sur l’ordinateur:

* Si déplacer le papier paraît lent, essayez Texture alternative ou désactivez les textures de papier

et de bureau (cf. Textures ci-dessus ). Vous pouvez aussi changer le niveau d’optimisation et de

profondeur de couleur et activer Fenêtres translucides.
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* Sous Windows, utiliser les versions Adobe Type 1 (PostScript) de Opus, Reprise, Inkpen2 et

Helsinki fonts peut aussi ralentir le rafraîchissement de l’écran; donc si possible utilisez les

polices TrueType. (Elles sont utilisées par défaut de sorte que vous ne devriez pas vous en

soucier, sauf si vous avez spécifiquement changé les polices Sibelius.)

* Si la sélection des objets paraît lente, fermez tous les “panneaux” ouverts de la fenêtre des

propriétés dont vous n’avez pas l’usage, ou masquez-la complètement en choisissant Fenêtre >

Propriétés (raccourci Ctrl+Alt+P ou zXP).

* Une fois que vous avez tout mémorisé sur le clavier, le masquer en désactivant Fenêtre > Clavier
(raccourci Ctrl+Alt+K ou zXK) procurera une légère augmentation de la vitesse.

* Désactiver les réglettes dans le sous-menu Affichage > Réglettes peut aussi améliorer la vitesse.

* Lors de la saisie ou de l’édition, Sibelius vérifie toujours si ce que vous entendez en cliquant sur

une note est le meilleur son disponible (par ex. si vous cliquez sur une note staccato, Sibelius

essaiera de jouer un son staccato s’il en existe un disponible). Si votre périphérique de lecture

propose de nombreuses techniques de lecture, déterminer le son à jouer à un moment donné

peut prendre un certain temps, notamment si vous jouez sur une grande partition. Pensez dès

lors à désactiver Jouer les notes en cours de modification sur la page Saisie des notes de

Fichier > Préférences (dans le menu Sibelius sur Mac), ou à passer à une configuration de

lecture qui utilise des périphériques de lecture plus simples ; par ex. choisissez Lecture >

Périphériques de lecture, et choisissez General MIDI (avancé) dans le menu Configuration
en haut de la boîte de dialogue, puis cliquez Fermer. Vous pouvez passer à une configuration de

lecture plus adaptée lorsque vous avez effectué la plus grande partie du travail de saisie et

d’édition.

Fenêtres translucides
Vous pouvez activer l’option Fenêtre des outils translucide dans la page Affichage de Fichier >

Préférences (dans le menu Sibelius sur Mac) pour rendre translucides les fenêtres du navigateur,

du pavé, de la table de mixage, de la vidéo et de la fenêtre des propriétés de manière à voir la

musique à travers. Si vous rencontrez des problèmes de type images tremblantes pendant

l’exécution, activez Excepté la fenêtre vidéo ce qui devrait suffire à résoudre le problème

(b 4.10 Vidéo).

Sibelius vous permet de régler le niveau de transparence grâce au curseur Transparence.

Une valeur de 0% signifie que les fenêtres sont complètement opaques, tandis que 100% les rend

pratiquement invisibles.

Cette option activée tend également à accélérer la mise à jour de l’écran; il est donc recommandé

d’activer cette option.

Plusieurs moniteurs
Il est possible d’utiliser Sibelius avec plusieurs moniteurs, ce qui est vraiment pratique car cela

permet d’ouvrir une partition différente sur chaque écran, ou même d’afficher deux pages de la

même partition réparties sur deux écrans.
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5.7 Rechercher et filtrer

b 1.9 À propos des sélections et des passages.

L’une des fonctions intelligentes de Sibelius est sa capacité à rechercher des objets dont les

caractéristiques sont spécifiées: rechercher tous les soufflets, ou seulement les notes supérieures d’un

passage en accords, ou tous les cresc. écrits dans le style expression, ou encore tous les Do (du milieu)

croches dans la seconde voix avec une articulation de lourré et de marcato.

On peut sélectionner les objets en définissant tous les critères en une fois à l’aide des options du

sous-menu Édition > Filtrer, ou en définissant les critères un par un avec Édition > Rechercher
(raccourci Ctrl+F ou XF) et Édition > Rechercher le suivant (raccourci Ctrl+G ou XG).

L’opération finie, on peut agir à volonté sur la sélection: la modifier, la copier, la supprimer, etc...

Comment utiliser les filtres
* Sélectionnez le passage de musique duquel vous voulez sélectionner des objets, ou la partition

entière (Ctrl+A ou XA)

* Choisissez l’un des “filtres rapides” du menu Édition > Filtrer, ou choisissez Filtre avancé
(raccourci Ctrl+Maj+Alt+F ou xzXF) pour sélectionner des caractéristiques plus complexes

(cf. ci-dessous)

* Vous pouvez ensuite faire ce que vous désirez de la sélection, par exemple la supprimer, la copier,

la déplacer avec les flèches, ajouter des articulations, modifier les valeurs de notes

* Si nécessaire, on peut aussi sélectionner d’autres caractéristiques dans le menu Édition > Filtrer
pour restreindre encore la sélection (cf. ci-dessous).

Filtres rapides
Le menu Édition > Filtrer contient une sélection de filtres standards pour un traitement rapide:

Le premier groupe de filtres rapides concerne les différents genres de texte dans votre partition:

* Numéros de mesure: sélectionne tous les changements de numéro de mesure et tous les

numéros de mesure

* Symboles d’accord: sélectionne tous les symboles d’accord (et symboles d’accord

patrimoniaux)

* Commentaires: sélectionne tous les commentaires “à bulle”

* Nuances: sélectionne tout le texte d’expression et les soufflets (raccourci Maj+Alt+D ou xzD)

* Texte d’expression: sélectionne tout le texte du style expression

* Paroles: sélectionne toutes les paroles

* Changements de numéros de page: sélectionne tous les changements de numéros de page

* Repères de répétition: sélectionne tous les repères de répétition

* Texte de portée: sélectionne tout le texte dans tout style de texte de portée (ex. Technique,

Expression, Texte normal, Texte encadré)

* Texte de système: sélectionne tout le texte d’un style de texte de système (ex. Tempo, Texte

système simple), si vous avez une sélection de système
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* Texte technique: sélectionne tout le texte du style Technique.

Le groupe de filtres rapides suivant concerne les objets non-texte:

* Notes ornementales: sélectionne toutes les notes ornementales, dont les acciaccaturas,

appoggiaturas et notes ornementales sans hampe

* Soufflets: sélectionne toutes les lignes de soufflet

* Objets masqués: sélectionne tous les objets masqués, de tout type

* Changements d’instruments: sélectionne tous les changements d’instrument

* Notes et accords: sélectionne toutes les notes et tous les accords (ainsi que leurs altérations,

articulations, etc.) mais ne sélectionne pas les autres objets tels que les objets textuels

* Lignes de pédale: sélectionne tous les genres de lignes de pédale de clavier

* Mesures répétées: sélectionne toutes les répétitions de 1 mesure, 2 mesures et 4 mesures

* Silences: sélectionne tous les silences, mais ne sélectionne pas de note ni d’autres objets

* Liaisons de phrasé: sélectionne toutes les liaisons de phrasé (magnétiques et non-

magnétiques)

* Symboles: sélectionne tous les symboles (dont les symboles de système, si vous avez une

sélection de système)

* Multiplets: sélectionne les crochets et chiffres de multiplets; utile pour masquer, afficher ou

réinitialiser la position des crochets de multiplets en une seule opération

Le sous-menu Edition > Filtre > Voix vous permet de sélectionner des objets dans certaines voix:

* Voix 1/2/3/4 (raccourcis Ctrl+Maj+Alt+1/2/3/4 ou xzX1/2/3/4): sélectionne tous les

objets dans la voix choisie (par ex. les notes, les silences, le texte, les lignes, etc.) y compris les

objets partagés avec une autre voix: par exemple, si vous filtrez la Voix 1, les objets textuels

communs aux voix 1 et 2 seront également sélectionnés. Cela est particulièrement utile pour

copier une seule voix sur une autre portée, pour que tous les objets tels que les nuances soient

copiés avec les notes.

* Voice 1/2/3/4 Uniquement: sélectionne les objets qui sont uniquement dans cette voix; cela

ne sélectionnera donc pas les objets qui sont dans plusieurs voix: par exemple, si vous filtrez

Voix 2 uniquement, les objets textuels qui s’appliquent à la fois aux voix 1 et 2 ne seront pas

sélectionnés. Cela permet principalement de supprimer une voix particulière d’un passage, sans

supprimer les objets qui s’appliquent également aux voix restantes sur la portée,

Éditer > Filtrer > Notes dans accords (pour copie) et Notes dans accords (pour suppression)
contiennent des ensembles de filtres identiques, mais avec une différence fondamentale: les filtres

pour copie incluent des numéros de multiplet et crochets, contrairement aux filtres pour

suppression. Lors de la copie de musique incluant des multiplets, les numéros de multiplet et

crochets doivent être inclus dans la sélection, autrement les notes collées utiliseront la mauvaise

durée. Inversement, lors de la suppression de musique incluant des multiplets, les numéros de

multiplet et crochets doivent être exclus de la sélection, autrement le multiplet entier sera

supprimé, ainsi que toute autre note incluse dans ces multiplets qui étaient d’abord incluses dans le

passage filtré. Les filtres rapides dans ces deux sous-menus sont les suivants:
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* Notes supérieure / 2e note / 3e / Note inférieure: sélectionne seulement la note spécifiée

dans les accords de toutes les voix sur la portée; si vous choisissez le filtre Note supérieure ou

Note inférieure, les notes seules seront également sélectionnées. Cela est utile si vous voulez

supprimer des notes des accords mais souhaitez par exemple laisser la mélodie intacte. 2e et 3e
signifient la seconde ou la troisième note en comptant à partir du sommet, pas à partir du bas.

* Note supérieure/2e/3e/Note inférieure ou notes seules (raccourcis Ctrl+Alt+1/2/3/B ou

zX1/2/3/B): si un passage contient à la fois des accords et des notes seules, ce filtre

sélectionnera les notes spécifiées dans les accords et les notes seules dans toutes les voix, vous

obtiendrez donc une ligne continue de musique. Cela est utile pour arranger à partir d’une

ébauche pour clavier, lorsque vous souhaitez copier des lignes de musique sur d’autres portées.

Enfin, en bas du sous-menu Edition > Filtrer figure Partie 1/2 (suppression): ces filtres sont

conçus pour faciliter la séparation d’une portée pour, par exemple, les 1e et 2e flûtes dans les

parties séparées pour les instrumentistes. Vous pouvez également l’utiliser pour scinder deux

instruments d’une portée sur des portées séparées dans une partition, dans des situations

complexes non supportées par les autres filtres par exemple quand la musique est quelquefois à

une voix et quelquefois à deux. Cf. Extraire individuellement les musiciens d’un pupitre
page 623.

Utiliser les filtres pour copier et supprimer
On utilise principalement les filtres pour copier et/ou supprimer de la musique, d’où le large

éventail de filtres rapides intégrés à Sibelius. La distinction entre ceux utiles pour la copie et les

autres pour la suppression n’est pas nécessairement évidente au début; voici donc un exemple

concret:

Dans un passage pour, par exemple, deux flûtes écrites à deux voix sur la même portée, vous

souhaitez que la ligne de la seconde flûte soit jouée par une clarinette. Pour réaliser cela

rapidement, sélectionnez le passage dans la portée de flûte puis choisissez Édition > Filtrer > Voix
2 qui sélectionnera toutes les notes de la 2e flûte ainsi que les nuances, les phrasés, etc. associés.

Copiez alors simplement la musique dans la portée de clarinette avec Alt+clic ou z-clic et

basculez la nouvelle musique pour clarinette en voix 1 avec Alt+1 ou z1. Pour supprimer ensuite

la musique de la 2e flûte de la portée de flûte, sélectionnez le passage à nouveau et choisissez

Édition > Filtrer > Voix 2 uniquement. Ceci sélectionnera toutes les notes, et seulement les

dynamiques, etc. qui s’appliquent uniquement à la voix 2, de façon à ce que lorsque vous

Supprimez, vous ne perdiez pas le texte (etc.) qui s’applique également à la voix 1.

Lorsque vous supprimez une voix, appuyez deux fois sur Suppr - le premier Suppr changent les

notes en silences, et le second Suppr supprime les silences.

boîte de dialogue de filtre avancé
Si vous désirez créer un filtre plus complexe, comme par exemple un filtre utilisant une

combinaison de caractéristiques, vous devriez utiliser la boîte de dialogue Édition > Filtrer > Filtre
avancé (raccourci Ctrl+Maj+Alt+F ou xzXF):

Elle est divisée en deux parties: sur la gauche se trouvent les valeurs générales qui doivent être

réglées pour le fonctionnement du filtre telles que Rechercher dans la partition entière ou le

passage sélectionné, quels types d’objet inclure (Texte, Lignes, etc.) et quelles voix inclure; sur la
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droite sont détaillées les valeurs pour chaque type d’objet général; au nombre de six, chacun

propose des options spécifiques sur une page, sélectionnée à partir de la liste dans la fenêtre

Afficher:

Les quatre cases de Voix indiquent quelles voix de la partition doivent être filtrées; par défaut,

toutes les voix sont filtrées.

Si vous sélectionnez un passage ou faites de multiples sélections avant de choisir Édition > Filtrer >

Filtre avancé, vous aurez la possibilité de choisir si le filtre s’applique à la Sélection ou à la

Partition entière. Si vous ne sélectionnez rien avant de filtrer, le filtre s’appliquera

automatiquement à la partition entière.

Construisez des filtres aussi complexes que vous le désirez à l’aide des six pages d’options

accessibles via la liste Afficher: à gauche. Cochez la case Rechercher: d’une page particulière pour

l’ajouter au filtre; décochez-la pour l’en enlever. Bien entendu, l’une des cases Rechercher: doit

être activée pour pouvoir filtrer quelque chose!

Cliquez sur Réinitialiser dans la boîte de dialogue remet toutes le options du filtre à leur position

par défaut de manière à ce que vous puissiez recommencer du début.

Voici les options de la page Notes et accords:

* En haut de la boîte de dialogue, choisissez si vous souhaitez filtrer les Notes normales (soit des

notes non-ornementales, mais incluant des notes de réplique) et/ou Notes ornementales.

* Activer ou non Multiplets dépend si vous réalisez un filtre pour copier ou supprimer. Si vous

sélectionnez des notes à copier ailleurs, activez Multiplets; si vous sélectionnez des notes en vue

de les supprimer, désactivez Multiplets; si vous décochez des notes à partir d’accords afin de

copier le reste des notes sélectionnées, désactivez Multiplets; si vous décochez des notes à partir

d’accords afin de supprimer le reste des notes sélectionnées, activez Multiplets.
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* Notes / Accords avec n têtes de note au moins/au plus/exactement: filtre les accords avec

le nombre spécifié de notes

* Note dans accord Notes supérieure / 2e note en partant du haut / 3e en partant du haut / Note

inférieure: filtre la note concernée.

* Type de tête de note : filtre Tout type de tête de note par défaut, mais vous laisse choisir un

Type de note spécifique, ce qui est utile pour travailler avec des portées de percussion sans

hauteur de note, par ex.

* Hauteur de note: filtre seulement les notes de la hauteur de note Individuelle ou d’un

ensemble de hauteurs de notes (Toutes les hauteurs de note intermédiaires), et

facultativement dans une octave spécifiée. Vous pouvez choisir de filtrer les hauteurs Réelles ou

Ecrites; par défaut, Sibelius filtre les notes de Toute hauteur réelle, de sorte que vous n’avez pas

à vous préoccuper des instruments transpositeurs. Si vous filtrez une hauteur de notes

spécifique ou un ensemble de hauteurs de notes, l’enharmonie des notes équivalentes est traitée

séparément, de sorte que si vous sélectionnez (par ex.) F#4 et Gb4, vous devez filtrer Toutes les
hauteurs intermédiaires entre ces deux hauteurs de notes.

* Valeurs de notes: sélectionne uniquement les notes/silences d’une certaine durée Individuelle
ou d’un ensemble de longueurs (Toutes les valeurs de notes intermédiaires). Choisissez une

valeur de note dans la liste ou tapez-la sur le pavé numérique (avec Verr Num activé). Les

liaisons rythmiques sont ici ignorées; si une blanche est liée à une croche, les deux notes sont

traitées séparément. Par défaut, Sibelius filtre les notes de Toute durée.

* Position dans la mesure: par défaut, filtre les notes placées à Toute position rythmique, mais

filtre optionnellement les notes et accords placés à une Position spécifique après le début de la

mesure. Laissez la case Position spécifique pour ne filtrer que les notes au début des mesures.

Si donc vous choisissez une noire, seules les notes après la première noire seront filtrées. Si vous

choisissez également Et multiples, toutes les notes sur la subdivision en noire seront filtrées.

Mais si vous choisissez Et multiples et valeur de note, chaque note sur la subdivision en noire

et ses multiples de la durée spécifiée est filtrée.

* Articulations: filtre les notes / accords en fonction de leurs articulations. Si Tout critère est

sélectionné, un(e) note/accord sera filtré quel que soit le critère qui lui est attaché; Si L’un de ces
critères est sélectionné, une note / accord sera sélectionné si l’un des critères sélectionnées lui

est attaché; si Tous les critères est sélectionné, une note / accord ne sera filtrée que si elle a

toutes les articulations spécifiées.

La page Silences et mesures de silence contient certaines options identiques à la page Notes et
accords pour rechercher des silences de durées déterminées, et vous pouvez activer Rechercher
des pauses de mesure pour sélectionner ou décocher des pauses de mesure.

La page Texte vous permet de rechercher un terme déterminé (ex. “legato”, “mf”) pour filtrer tout

le texte correspondant dans la sélection; par défaut, ce champ est sensible à la casse (“legato”,

“Legato”, “LEGATO” feront donc l’objet de la même recherche), mais vous pouvez activer Sensible
à la casse si vous préférez tenir compte de la casse. Vous pouvez spécifier en option un ou

plusieurs styles de texte à filtrer - cliquez sur un style de texte pour l’ajouter à la sélection, et

cliquez le à nouveau pour l’en enlever. Les boutons Aucun et Tous devraient être suffisamment

clairs! Si vous souhaitez filtrer les styles de texte de système, veillez à filtrer toute la partition, ou à

avoir une sélection de système avant d’ouvrir la boîte de dialogue.
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La page Lignes permet de sélectionner ou décocher un ou plusieurs types de ligne. Vous pouvez

aussi filtrer tous les types de ligne en activant Toutes les lignes. Si vous souhaitez filtrer les lignes

de système, veillez à bien filtrer toute la partition, ou à avoir une sélection de système avant

d’ouvrir la boîte de dialogue.

La page Clefs permet de sélectionner ou décocher des changements de clefs (mais pas les clefs

initiales au tout début de la partition, car ces objets ne peuvent pas être sélectionnés). Vous pouvez

filtrer des changements de clef pour une ou plusieurs clef(s) spécifique(s), ou pour tous les

changements de clef en activant Toutes les clefs.

La page Symboles vous permet de sélectionner ou de décocher une portée individuelle ou un

symbole de système, ou tous les symboles (en activant Tous les symboles). Si vous souhaitez

filtrer pour un symbole de système, veillez à filtrer toute la partition, ou faites une sélection de

système avant d’ouvrir la boîte de dialogue.

Une fois définies les options souhaitées, vérifiez que les cases Rechercher: appropriées sont bien

cochées, puis cliquez sur Sélectionner pour sélectionner tous les objets dans la sélection ou la

partition entière qui correspondent aux caractéristiques filtrées, ou Désélectionner pour

supprimer tous les objets qui correspondent aux caractéristiques du filtre.

Sélectionner des objets aux caractéristiques x et y
Supposons que vous souhaitiez sélectionner toutes les Do centraux blanches dans un passage, de

manière à leur ajouter un accent. Concevez ceci comme sélectionner tout ce qui est à la fois une

blanche et un Do central.

Pour faire cela, vous sélectionnez toutes les blanches puis filtrez tous les Do centraux parmi elles,

comme ceci:

* D’abord, sélectionnez un passage

* Choisissez Édition > Filtrer > Filtre avancé (raccourci Ctrl+Maj+Alt+F ou xzXF)

* Dans Valeur de note choisissez une blanche

* Dans Hauteur de note, choisissez Simple, puis dans la première liste, choisissez Do, et dans la

liste Octave choisissez 4

* Cliquez sur Sélectionner, et le filtre est appliqué à la partition, laissant uniquement les Do

centraux blanche sélectionnés.

* Ajoutez les accents en utilisant le premier pavé.

Sélectionner des objets aux caractéristiques x ou y
Supposons que vous souhaitiez (pour quelqu’étrange raison) sélectionner toutes les notes d’un

passage qui soient ou des blanches ou des Do centraux pour y placer un accent. Ce genre de cas est

plutôt improbable, il n’y a donc pas de voie directe pour y arriver. Voici une manière indirecte, d’y

parvenir:

* Sélectionnez un passage, puis en utilisant Édition > Filtre > Filtre avancé, sélectionnez toutes les

blanches

* Accentuez-les en utilisant le premier pavé
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* Sélectionnez le passage à nouveau, puis en utilisant Édition > Filtre > Filtre avancé, sélectionnez

tous les Do centraux

* Accentuez-les également

Rechercher des objets
Rechercher fonctionne à peu près de la même manière que filtrer, si ce n’est que les objets

correspondants sont sélectionnés les uns à la suite des autres plutôt que tous en une fois. La boîte

de dialogue Édition > Rechercher est très similaire à la boîte de dialogue Filtre avancé. Pour

rechercher des objets:

* Choisissez Édition > Rechercher (raccourci Ctrl+F ou XF) et choisissez une combinaison de

caractéristiques que vous souhaitez rechercher dans la partition; cf. boîte de dialogue de
filtre avancé ci-dessus pour en savoir plus sur l’utilisation de la boîte de dialogue

* Cliquez sur Rechercher pour rechercher le premier objet de la partition qui correspond aux

critères que vous avez définis; si rien n’est trouvé, Sibelius affichera un message vous en

informant.

Lorsque vous avez défini une opération de Recherche, vous pouvez utiliser Édition > Rechercher
le suivant (raccourci Ctrl+G ou XG) pour rechercher l’objet correspondant suivant dans la

partition.

 L’ordre de recherche est le suivant:

* La recherche commence au début de la partition, avec la première mesure de la portée

supérieure

* Sibelius recherche jusqu’à la fin de cette portée (à la fin de la partition) puis passe à la seconde

portée et recherche dans cette portée à partir du début de la partition jusqu’à la fin, et ainsi de

suite

* Si la fin de la partition est atteinte (en d’autres termes, la fin de la portée inférieure), Sibelius

vous demandera si vous souhaitez arrêter la recherche, ou continuer celle-ci à partir de la portée

supérieure au début de la partition.

Rechercher et remplacer du texte
Si vous souhaitez rechercher et remplacer un texte particulier dans la partition, utilisez l’extension

Extensions > Texte > Rechercher et remplacer du texte – Trouver et remplacer le texte à
la page 593.

Rechercher des motifs
Si vous souhaitez rechercher un motif mélodique ou rythmique particulier dans la partition,

utilisez l’extension Extensions > Analyse > Rechercher le motif – Trouver un motif à la page

548.
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5.8 Portées en vue ciblée

b 2.29 Portées, 4.1 Utiliser du texte, 5.13 Panorama.

Lorsqu’on travaille sur des partitions pour grandes formations tels que l’orchestre ou l’harmonie, il

peut s’avérer bien pratique de n’avoir à l’écran que les portées en cours de travail; par exemple, les

portées de cordes, ou seulement les cors. Combinée avec Affichage > Panorama cette manière de

travailler est particulièrement pratique.

On peut aussi trouver utile de préparer des partitions dont certaines portées contenant de la

musique sont masquées pendant l’exécution; on pourrait par exemple souhaiter imprimer un

conducteur (“lead sheet”), mais en entendre l’accompagnement masqué pendant l’exécution.

Tout cela, la fonction Affichage > Portées en vue ciblée (raccourci Ctrl+Alt+F ou zXF) le

réalise facilement.

Choisir les portées à cibler
Utiliser Portées en vue ciblée est très simple:

* Sélectionnez les portées que vous souhaitez voir (donc les autres, non sélectionnées, seront

masquées); sélectionner une seule mesure de chaque portée à cibler suffit: utilisez Maj-clic pour

sélectionner des portées adjacentes ou Ctrl+clic ou X-clic pour sélectionner des portées non

adjacentes (b 1.9 À propos des sélections et des passages). Pour cibler une seule

portée, en sélectionner une note ou un autre objet suffit.

* Cliquez sur le bouton de la barre d’outils (affiché à droite), ou choisissez Affichage >

Portées en vue ciblées (raccourci Ctrl+Alt+F ou zXF)

* Instantanément, les portées non sélectionnées sont masquées.

* Vous pouvez maintenant travailler sur les portées ciblées de la manière habituelle, saisir ou

modifier des notes, ajouter du texte, etc

* Vous pouvez en plus activer Affichage > Panorama, pour visualiser les portées dans un seul

système qui se déroule en continu, sans tenir de la mise en page (b 5.13 Panorama)

* Pour quitter le mode cible, cliquez à nouveau sur le bouton de la barre d’outils, ou désactivez

Affichage > Portées en vue ciblée.

Si votre sélection initiale de portées inclut une ou plusieurs portées masquées par Mise en page >

Masquer les portées vides (b 2.29 Portées), celles-ci s’affichent lorsque Affichage > Portées
en vue ciblée est activé et disparaissent à nouveau lorsqu’il sera désactivé s’il elle(s) est (sont)

toujours vide(s).

Sibelius garde en mémoire la dernière combinaison de portées ciblées, si bien qu’elles-ci peuvent

être ciblées à nouveau sans sélection préalable en activant Affichage > Portées en vue ciblée.
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Exécution
Si vous lancez la lecture pendant que Portées en vue ciblée est activé, toutes les portées joueront, et

non pas seulement les portées ciblées. Cela peut-être très utile, car cela permet de créer des

partitions dans lesquelles des portées ne sont pas affichées, mais jouent tout de même. 

Pour ne pas entendre les portées masquées pendant la lecture, utilisez la table de mixage pour les

étouffer (b 4.3 Table de mixage).

Parce que les réglages de Affichage > Portées en vue ciblée sont sauvegardés dans la partition,

vous pouvez utiliser cette fonction pour obtenir dans Sibelius Scorch un effet vraiment étonnant

(b 5.19 SibeliusMusic.com), puisque les versions exécutées seraient différentes de ce qui est

imprimé. 

Sélections et passages
Lorsque Affichage > Portées en vue ciblée est activé, des lignes bleues discontinues peuvent

apparaître entre les portées ciblées afin de montrer où des portées masquées sont présentes.

(Remarquez qu’il s’agit des mêmes lignes discontinues qui peuvent apparaître lorsque la fonction

Mise en page > Masquer les portées vides est activée – b 2.29 Portées pour en savoir plus.) 

Ayez à l’esprit que si vous faites une sélection à travers plusieurs portées avec Affichage > Portées
en vue ciblée activé, toutes les portées masquées se trouvant entre deux portées visibles seront

également sélectionnées. Ceci peut avoir des conséquences inattendues: par exemple, en copiant

un tel passage ailleurs dans la partition, la musique des portées masquées est également copiée et

va donc apparaît.

Pour ces raisons, il est recommandé de:

* Laisser Affichage > Marques de mise en page activé de manière à pouvoir déterminer où se

trouvent les portées masquées avant de copier quoi que ce soit;

* Ne copier de préférence que des passages sur une seule portée à la fois, de façon à éviter de

copier de la musique masquée;

* Désactiver Affichage > Portées en vue ciblée si vous souhaitez réaliser des opérations de copie

complexes impliquant plusieurs portées, à moins d’être sûr qu’aucune portée masquée n’est

inclue dans la sélection.

Mesures de comptage
Si vous activez Regrouper les mesures à compter lorsque vous ciblez des portées, cela

fonctionnera exactement de la même manière que lorsque vous affichez la partition entière. Donc,

les mesures de comptage n’apparaîtront que dans le cas de deux mesures de silence consécutives

dans toutes les portées de la partition (et pas seulement dans les portées ciblées).

Confusions possibles
Ne confondez pas Portées en vue ciblée avec Mise en page > Masquer les portées vides
(b 2.29 Portées). Portées en vue ciblée peut masquer des portées contenant de la musique,

affecte les portées sur toutes les pages et n’est normalement utilisé que temporairement (à moins

que vous ne masquiez un accompagnement ou une réalisation prévu pour l’exécution). Mise en
page > Masquer les portées vides fonctionne sur des systèmes individuels, n’a d’effet que sur les

portées vides et est essentiellement conçu pour gagner de l’espace dans les partitions complètes.
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5.9 Masquer des objets

Il arrive parfois de devoir masquer certains objets présents dans une partition. C’est le cas par

exemple de passages en notes de réplique qui doivent apparaître dans les parties séparées, mais

être masqués dans la partition complète; 

un autre exemple est la réalisation de basse chiffrée ou d’accompagnement en jazz dont on sou-

haite que la partition les joue sans les afficher.

Sibelius vous permet de masquer n’importe quel objet, et de contrôler si l’objet sera visible dans le

conducteur, dans les parties séparées ou pas du tout.

Masquer un objet
Pour masquer un objet, sélectionnez-le et choisissez une des options suivantes dans Édition >

Masquer ou afficher:

* Masquer/Afficher (raccourci Ctrl+Maj+H ou xXH): masque ou affiche un objet dans le conduc-

teur ou la partie en cours

* Afficher dans la partition: affiche un objet dans le conducteur uniquement (et le masque dans

toutes les parties)

* Afficher dans les parties: affiche un objet dans les parties séparées uniquement (et le masque dans

le conducteur)

* Afficher dans tout: affiche un objet, à la fois dans la partition complète et dans les parties séparées.

Toutes ces options, le panneau Général de la fenêtre des propriétés les propose également ; sélec-

tionnez l’objet à masquer/afficher et choisissez l’option souhaitée dans le menu déroulant.

Lorsque vous masquez un objet ou sélectionnez un objet masqué, il sera affiché en couleur pâle à

l’écran. Lorsque vous aurez désélectionné l’objet, il disparaîtra, encore que vous puissiez choisir

d’afficher tous les objets masqués en grisé; cf. Afficher les objets masqués ci-dessous.

Ce qui peut être masqué
Tout objet d’une partition peut se masquer: notes, silences, modifications d’armure ou de mesure,

lignes, etc. En outre masquer une note en masque également les altérations, ligatures, hampes et arti-

culations associées (seule exception: les altérations, ligatures et tronçons de ligature peuvent se mas-

quer indépendamment si nécessaire; b 2.1 Altérations et 2.6 Groupement des ligatures.)

Pour approfondir la manière dont les objets se masquent, consultez les articles correspondants

dans ce manuel, et pour spécifiquement masquer les lignes, b 2.21 Lignes.

Voici quelques utilisations d’objets masqués:

* Notes: crée des répliques qui sont masquées et silencieuses dans la partition complète, mais qui

sont affichées dans les parties séparées (b 2.14 Notes ornementales); permet des solos

“improvisés” et des réalisations exécutées mais invisibles dans la partition.

* Texte: masque les indications métronomiques ou les nuances; ajoute des indications techniques

pour les interprètes qui ne seront visibles que dans les parties séparées; ajoute des indications

pour le chef d’orchestre visibles dans la directrice mais pas dans les parties séparées.
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* Lignes: ajoute des indications, par exemple des soufflets ou des lignes d’accel./rit., qui sont exécu-

tées mais masquées.

Afficher les objets masqués
Pour afficher les objets masqués d’une partition, activez Affichage > Objets masqués (raccourci

Ctrl+Alt+H ou zXH). Lorsque cette option est activée (en principe elle l’est par défaut), les objets

masqués apparaissent en grisé (mais ils ne sont pas imprimés; cf. Exécuter et imprimer les
objets masqués ci-dessous). Un objet masqué se sélectionne et se modifie comme tout objet

normal.

Lorsque Affichage > Objets masqués est désactivé, les objets masqués de la partition sont com-

plètement invisibles et ne peuvent être sélectionnés ou modifiés individuellement. Ils s’affichent

cependant quand un passage ou un système est sélectionné, ou même toute la partition (Ctrl+A ou

XA); de plus le déplacement à l’aide des flèches ou de la touche Tab s’effectuent à travers les objets

masqués et visibles.

Cette option contrôle également l’affichage d’objets qui ne sont normalement pas écrits.

Par exemple:

* les barres de mesure invisibles (b 2.4 Barres de mesure) affichées en grisé

* les changements d’armure (b 2.20 Armure) et les changements d’instruments

(b 2.18 Instruments et portées) desquels ne résultent l’apparition d’aucune altération,

affichés par un rectangle gris

* les silences et les mesures de silence masqués dans certains types de portée, par exemple pour la

guitare, affichés en grisé.

Notez également que si on supprime un silence il sera masqué, et apparaîtra donc en grisé si

l’option Affichage > Objets masqués (raccourci Ctrl+Alt+H ou zXH) est activée. Si vous le sup-

primez encore une fois, il disparaîtra entièrement.

Objets masqués dans les parties séparées
Quand un objet est masqué dans le conducteur mais visible dans une partie séparée, ou vice-versa,

et que Affichage > Différences dans les parties est activé, la version visible apparaîtra en orange

(pour indiquer qu’il y a une différence entre le conducteur et la partie); la version masquée appa-

raîtra en grisé comme d’habitude si Affichage > Objets masqués est activé, et deviendra orange

pâle en cas de sélection.

Exécuter et imprimer les objets masqués
Par défaut, les objets masqués ne sont pas imprimés mais sont exécutés, quel que soit le statut de

Affichage > Objets masqués. Il arrive parfois que l’on souhaite que certains objets masqués ne

soient pas exécutés, par exemple une réplique masquée dans la partition complète mais affichée

dans les parties séparées; si tel est le cas, utilisez des têtes de note silencieuse ou désactivez les

cases Jouer au passage dans la fenêtre des propriétés – b 2.25 Têtes de note et

4.6 Reprises.

Si vous souhaitez imprimer des objets masqués, par exemple dans le cadre d’une correction

d’épreuves, activez Affichage > Objets masqués puis imprimez la partition, en ayant activé

Options du menu Affichage dans la boîte de dialogue Fichier > Imprimer (b 5.16 Imprimer).
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5.10 Surbrillance

b 5.4 Couleur.

Sibelius permet d’appliquer une surbrillance à divers éléments d’une partition, ce qui est très

pratique pour se rappeler des sections à retravailler, ou simplement pour attirer l’attention sur un

point particulier de la partition.

Créer une surbrillance
Pour créer une surbrillance dans la partition, on peut soit:

* Choisir Créer > Surbrillance puis cliquer et tirer le long du passage à sélectionner; ou

* Sélectionner un passage puis choisir Créer > Surbrillance pour créer en une fois une

surbrillance pour tout le passage. Comme la surbrillance ne s’applique qu’une seule portée à la

fois, si on sélectionne un passage contenant plusieurs portées, la surbrillance n’apparaîtra que

sur la portée supérieure de la sélection. (Bien entendu, il est possible de mettre les autres portées

en surbrillance séparément.)

Les surbrillances sont en jaune par défaut, mais on peut changer leur couleur après les avoir créées,

comme pour les autres objets; b 5.4 Couleur.

Sélectionner des surbrillances et des objets en surbrillance
Toutes les notes et autres objets en surbrillance peuvent être sélectionnés, déplacés ou supprimés

normalement. Pour pouvoir déplacer, copier ou supprimer la surbrillance elle-même, il suffit de la

sélectionner préalablement avant de cliquer sur son extrémité. 

Déplacer une surbrillance
* Pour déplacer une surbrillance vers la gauche ou vers la droite, cliquez sur son extrémité

supérieure ou inférieure et tirez-la ensuite avec la souris, ou utilisez les touches 0/1 (avec Ctrl
ou X pour de plus grands incréments)

* Pour ajuster la longueur d’une surbrillance sélectionnée, cliquez sur la ligne de gauche ou de

droite l’entourant et tirez-la avec la souris, appuyez sur Espace pour l’étendre d’une note (Maj-
Espace rétracte d’une note), ou utilisez les touches 0/1 (avec Ctrl ou X pour de plus grands

incréments).

Supprimer une surbrillance
Pour supprimer une surbrillance, cliquez sur son extrémité et appuyez sur Suppr; pour supprimer

toutes les surbrillances de la partition, utilisez l’extension Extensions > Autre > Supprimer toutes
les surbrillances (cf. page 454).

Afficher les surbrillances
Pour masquer ou afficher les surbrillances présentes dans la partition choisissez Affichage >

Surbrillances.

Imprimer des surbrillances
Vous pouvez choisir d’imprimer ou non les surbrillances
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* Pour être sûr de ne pas les imprimer, assurez-vous que la case Options du menu Affichage
dans la boîte de dialogue Fichier > Imprimer (raccourci Ctrl+P ou XP) n’est pas cochée lors de

l’impression de la partition

* Pour les imprimer, activez Affichage > Surbrillances (et désactivez toute autre option du menu

Affichage dont vous ne souhaitez pas l’impression), puis imprimez la partition en vous assurant

que la case Options du menu Affichage de la boîte de dialogue Fichier > Imprimer (raccourci

Ctrl+P ou XP) est bien cochée.

Pour en savoir plus sur l’impression, b 5.16 Imprimer.
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5.11 Idées

Souvent quand les compositeurs sont au travail, des morceaux de mélodie, de rythme,

d’accompagnement ou des progressions d’accords qui paraissent intéressants leur viennent à

l’esprit. Quant aux arrangeurs et aux copistes, ils ont souvent à utiliser et à réutiliser des fragments

de notation, tels que des indications de texte, des symboles ou des diagrammes d’accord

spécifiques, etc...

Nous appelons tous ces fragments des idées: peu importe leur longueur, leur nature et le nombre

d’instruments concernés. Il suffit de frapper une touche pour capturer une idée et la mémoriser

pour l’utiliser plus tard. Vous pouvez éditer n’importe quelle idée capturée, la décrire avec vos

propres mots-clé (par ex. canon, lyrique, riff) pour en faciliter la recherche et en plus la mettre en

couleur codée. La fenêtre des idées permet de naviguer et de rechercher parmi l’ensemble des idées

disponibles, et toutes peuvent être écoutées. Utiliser une idée est aussi simple que de coller à partir

du presse-papiers; même la transposition selon la tonalité et la tessiture est gérée par Sibelius.

Vous pouvez importer et exporter des ensembles d’idées pour les partager avec d’autres personnes

– via Internet par exemple. Et pour les enseignants, il est possible de sauvegarder des ensembles

d’idées dans une partition pour créer des exercices de composition destinés aux étudiants.

De plus, Sibelius propose plus de 2000 idées prédéfinies, pour une multitude d’instruments et de

genres différents, de sorte que si vous êtes en panne d’inspiration ou si vous recherchez un élément

stylistique précis pour lancer votre processus de création, quelques secondes suffiront pour trouver

celui qui convient.

Qu’est-ce qu’une idée
Une idée, c’est pratiquement tout ce qu’il est possible d’écrire dans Sibelius. Quelque soit

l’importance du matériau - de la simple note sur une portée à des centaines de mesures sur un

nombre illimité de portées - vous pouvez le sélectionner et le capturer en tant qu’idée. La nature

des objets elle aussi, peut être variée: lignes, symboles, objets textuels et même images importées

peuvent être capturés comme idées, qu’il y ait ou non des notes.

Outre la musique qu’elle contient, une idée est toujours associée à des mots-clé. Ceux-ci servent à la

décrire et à permettre de la retrouver facilement par la suite. Quand il s’agit d’examiner plusieurs

milliers d’idées, c’est vraiment pratique! Pour chaque idée, en plus des mots-clé que vous avez

spécifiés, Sibelius en ajoute d’autres, créés d’après les informations suivantes:

* Armure 

* Indication de mesure 

* Tempo

* Longueur de l’idée, en nombre de mesures

* Instruments utilisés dans l’idée

* Date de création

* Date de modification
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Vous pouvez rechercher des idées en utilisant n’importe quels mots-clé choisis soit parmi les

vôtres, soit parmi ceux créés automatiquement par Sibelius. Vous pouvez aussi attribuer une

couleur spécifique à n’importe quelle idée.

La fenêtre des idées
D’une manière générale, le travail sur les idées s’effectue dans la fenêtre des idées, que l’on

affiche ou masque avec la commande Fenêtre > Idées (raccourci Ctrl+Alt+I ou zXI), ou en

cliquant sur le bouton de la barre d’outils illustré ci-contre à droite.

La fenêtre des idées peut s’afficher sous deux formes différentes, compacte et détaillée. Par défaut,

elle s’ouvre en affichage compact, qui a l’aspect suivant:

Pour retrouver des idées, il suffit de rentrer un ou plusieurs mots-clé dans la boîte au sommet de la

fenêtre. Si vous en ignorez le type, cliquez sur la petite flèche à droite de la fenêtre et un menu

déroulant vous dévoilera les mots-clé utilisés le plus fréquemment dans les idées disponibles.

Il suffit de cliquer sur un des mots-clé pour l’ajouter dans la boîte. Dès qu’un ou plusieurs mots

figurent dans la boîte, vous pouvez dérouler le menu de nouveau, et Sibelius affichera les mots-clés

qui apparaissent le plus souvent dans les idées qui utilisent aussi les mots-clés déjà choisis. Chaque

fois que vous ajoutez un mot dans la boîte et que vous tapez la touche Retour, Sibelius met à jour la

liste des idées dans la partie principale de la fenêtre.

Les boutons Partition et Bibliothèque vous permettent de choisir si les idées proviennent de la

partition en cours, ou de la bibliothèque, qui recense toutes les idées disponibles quelle que soit la

partition ouverte (on y trouve les idées prédéfinies et les idées que vous y auriez introduites), ou

des deux (cf. Où les idées sont-elles sauvegardées? ci-dessous ). Remarquez que si la

partition en cours ne contient aucune idée, le bouton Partition sera désactivé, et le bouton

Bibliothèque ne pourra être désactivé.

Entrer les mots-clé ici...

...ensuite choisir d’afficher les

idées soit de la partition en

cours, soit celles de la Biblio-
thèque ou Toutes Un cadre indique l’idée sélectionnée; 

pour changer d’idée sélectionnée, 

utilisez 2/3

Copier

Coller 

Éditer

Éditer la fenêtre d’infor-

mations sur l’idée Info

Supprimer

Ajouter des idées à la partition

Ajouter à la bibliothèque

Passer à l’affi-

chage détaillé

...ou cliquer sur cette flèche pour 

dérouler la liste...

Capturer une idée
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La partie principale de la fenêtre affiche les idées qui correspondent aux mots-clé que vous avez

introduits, avec les plus pertinentes pour commencer la liste. Si vous n’avez rien introduit dans la

boîte supérieure, alors toutes les idées disponibles s’afficheront (de la partition et/ou de la

bibliothèque), avec en premier lieu celles dont la capture est la plus récente. Les idées sont toujours

affichées en hauteur réelle.

Le contenu, notes et objets, de chaque idée de la liste peut être prévisualisé ; normalement, on doit

en voir deux ou trois mesures de la portée supérieure. Des mots-clé importants sont affichés aux

quatre coins de la prévisualisation: en haut à gauche le nom de l’idée, en bas à droite la lettre L - qui

apparaît si l’idée est contenue dans la bibliothèque plutôt que dans la partition en cours, en bas à

gauche, l’indication de mesure de l’idée et en bas à droite, son tempo. Si vous faites glisser la souris

sur l’idée, un bloc de texte opaque apparaît dans lequel figurent les autres mots-clé, dont

l’instrumentation. Si vous ne souhaitez pas voir la prévisualisation et que vous vous contentez du

nom de l’idée et de son tempo, vous pouvez désactivez Afficher la prévisualisation de la
musique dans la fenêtre des idées en affichage compact dans la page Fichiers du menu Fichier >

Préférences (dans le menu Sibelius sur Mac).

Chaque idée est affichée avec un arrière-fond en couleur, qui peut être modifié selon une catégorie

donnée. (Toute nouvelle idée que vous avez capturée reçoit par défaut un arrière-fond blanc.)

Un clic droit (Windows) ou Contrôle-clic (Mac) sur une idée de la liste appelle un menu pourvu

de nombreuses options utiles, les mêmes que celles des boutons situés dans le bas de la fenêtre:

* Copier: copie l’idée sélectionnée dans le presse-papiers, de manière à ce qu’on puisse la copier

dans la partition; cf. Coller une idée ci-dessous

* Coller: colle le contenu du presse-papiers dans la partition; si une sélection y est faite, le contenu

sera collé directement à cet endroit; s’il n’y en a pas, le pointeur de la souris deviendra bleu et

vous pourrez cliquer dans la partition à l’endroit souhaité

* Éditer: édite l’idée sélectionnée; cf. Éditer une idée ci-dessous 

* Éditer les informations de l’idée: permet de modifier les mots-clé de l’idée et sa couleur, ainsi

que les mots-clé attribués automatiquement à l’idée

* Supprimer: supprime l’idée sélectionnée de la collection d’idées sauvegardées dans la partition

ou dans la bibliothèque, selon le cas

* Ajouter des idées à la partition: seulement activée si l’idée sélectionnée est en bibliothèque,

cette option permet de la copier de la bibliothèque dans la partition en cours

* Ajouter: seulement activée si l’idée sélectionnée fait partie de la collection d’idées contenues

dans la partition, cette option permet de la copier de la partition en cours à la bibliothèque
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* Affichage détaillé: voici à quoi devrait ressembler la fenêtre en affichage détaillé:

L’affichage détaillé propose quasi les mêmes fonctions que l’affichage compact, mais (sans

surprise) avec plus de détails. Ainsi à la place de quelques notes, c’est toute la musique de chaque

idée que l’on peut voir dans le panneau inférieur de la fenêtre. La liste du panneau supérieur

affiche tous les mots-clé appartenant à chaque idée et le tri peut se réaliser en fonction du contenu

d’une colonne donnée en cliquant sur son intitulé. La largeur des colonnes (de même que leur

ordre) peut se régler en tirant avec la souris. La hauteur de chaque panneau peut également être

modifiée en déplaçant verticalement la ligne séparatrice.

Remarquez que la fenêtre des idées ne se modifie qu’en hauteur en affichage compact, et dans les

deux directions en affichage détaillé.

L’affichage détaillé comporte deux boutons supplémentaires, pour importer ou exporter les idées –

consultez Où les idées sont-elles sauvegardées? ci-dessous.

Écouter une idée
Pour entendre à quoi ressemble une idée, il suffit de cliquer dessus dans la fenêtre des idées et de

maintenir le bouton gauche de la souris enfoncé pour lancer la lecture; Sibelius va jouer l’idée en

boucle en la répétant jusqu’à huit fois. Si vous préférez ne l’entendre qu’une fois désactivez Répéter
automatiquement l’idée lors de la lecture dans la page Idées du menu Fichier > Préférences
(dans le menu Sibelius sur Mac).

Capturer une idée
Pour créer une idée, sélectionnez dans la partition ce que vous souhaitez et choisissez Éditer >

Capturer une idée (raccourci Maj-I). Vous pouvez capturer une idée à partir de tout type de

sélection, à savoir:

* Des sélections de passage de n’importe quel nombre de mesures ou de portées. Si la sélection est

de type passage de système, prenez garde au fait que les objets de système (tels que les

indications de mesure, les lignes de reprise, le texte de tempo, etc...) seront exclus de l’idée; en

effet les idées ne peuvent contenir des objets de système. De même, il est aussi impossible de

capturer une idée d’une sélection de portées non adjacentes.

Déplacer la ligne de division verticale-

ment pour modifier la hauteur de la liste

et visualiser les panneaux

Cliquer sur l’intitulé de la colonne pour

que la liste s’établisse selon son contenu;

déplacer les colonnes pour les réorganiser

Revenir à la vue compacteExporterImporter
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* Un seul objet sélectionné, par ex. une note, un objet texte, une ligne, etc... De nouveau, rappelez-

vous qu’il est impossible de capturer sous forme d’idée un objet de système.

* des sélections multiples de notes, par ex. les premier et troisième temps d’une mesure,

sélectionnés par Ctrl+clic ou X-clic, ou avec un filtre. Les sélections multiples sont

transformées en sélection de passage quand elles sont capturées comme idées, de sorte que,

quand vous modifiez ou collez votre idée, elle ne se complète avec les silences appropriés.

* Les sélections multiples de choses diverses autres que les notes, par exemple une série d’objets

textuels d’expression et de soufflets, sélectionnés via Ctrl+clic ou X-clic, ou avec un filtre.

(Pour en savoir plus sur les différents types de sélection, b 1.9 À propos des sélections et
des passages.)

Quelques objets ne peuvent évidemment pas être capturés comme idée. C’est le cas par exemple

des altérations, ligatures ou articulations qui ne peuvent être dissociés des notes qu’elles affectent.

La règle à retenir, c’est que tout ce qui peut être copié-collé peut être capturé comme idée.

Si la fenêtre des idées est affichée, et si aucun mot-clé n’a été entré dans la boîte au sommet de la

fenêtre, l’idée apparaîtra au sommet de la fenêtre. Sibelius lui assignera automatiquement un nom

(déterminé d’après le titre de la partition ou du nom de fichier, suivi d’un numéro d’attribution

unique). Vous pouvez modifier ce nom par la suite.

Rechercher une idée
Pour rechercher une idée, entrez un ou plusieurs mots-clé dans la boîte au sommet de la fenêtre

des idées, puis choisissez une idée dans la liste.

Au fur et à mesure que l’on entre des mots dans la boîte, Sibelius déroule en dessous un menu qui

contient les mots-clé correspondant à ce qui est entré (par ex. si vous tapez “cl”, “clarinette”,

“closed”, “classique”, pourront s’afficher mais si on ajoute “a”, “closed” disparaîtra de la liste). On

peut soit continuer à taper, ou utiliser les touches de flèche ou la souris pour sélectionner un des

mots-clé de la liste. Aussitôt qu’on a choisi un mot-clé ou que l’on a tapé espace pour indiquer que

le mot-clé est entièrement entré, la liste des idées de la partie principale de la fenêtre est mise à

jour.

Vous pouvez aussi entrer une autre donnée. Dès qu’une seconde donnée est ajoutée, seules les idées

qui correspondent à la fois à la donnée originale et à la nouvelle donnée seront affichées dans la liste.

Comme précédemment, quand vous commencez à taper dans la boîte, le menu se déroule pour vous

montrer les mots-clé possibles qui correspondent aux lettres déjà tapées.

Au fur et à mesure que ajoutez un autre mot-clé dans la boîte, le choix des idées dans la partie

principale de la fenêtre va se réduire, car plus il ya de mots-clé moins d’idées leur correspondent.

Pour sélectionner une idée dans la liste, cliquez dessus.

Les idées se présentent dans la liste de la partie principale de la fenêtre des idées en ordre

décroissant de pertinence. Si le mot-clé que vous avez tapé est le Nom de l’idée alors c’est un

critère hautement pertinent; si le mot-clé apparaît dans la liste générale des Mots-clé, alors il est

considéré comme assez pertinent, si le mot-clé est généré par Sibelius, il est considéré comme peu

pertinent.
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Coller une idée
Avant de coller une idée, il faut la copier dans le presse-papiers. Pour cela, il suffit de sélectionner

la fenêtre des idées, puis de taper Ctrl+C ou XC, ou de cliquer sur le bouton Copier qui figure

dans le bas de la fenêtre, ou de faire un clic droit (Windows) ou Contrôle-clic (Mac) et choisir

Copier dans le menu contextuel.

Coller une idée dans une partition est exactement pareil à toute forme de collage: soit vous

sélectionnez l’emplacement dans la partition où doit figurer l’idée et vous choisissez Édition >

Coller (raccourci Ctrl+V ouXV); soit si rien n’est sélectionné, choisissez Édition > Coller puis

cliquez à l’emplacement dans la partition où doit figurer l’idée. On peut aussi cliquer sur le bouton

Coller qui figure dans le bas de la fenêtre des idées.

Comme avec toute forme de collage, il est possible de coller une idée en plusieurs exemplaires soit

en utilisant la copie multiple (consultez Copie multiple d’un passage page 63), soit avec la

commande Édition > Répéter (raccourci R) utilisée immédiatement après collage pour répéter

l’idée de manière consécutive.

Contrairement à un collage normal, lors d’un collage d’idée, Sibelius réalise automatiquement

quelques opérations supplémentaires: il transpose l’idée pour qu’elle corresponde à la tonalité qui

prévaut à l’emplacement de la partition où a lieu le collage, et il transpose aussi les octaves de

manière à ce que les notes correspondent à la tessiture de l’instrument dans lequel est collée l’idée.

Quand Sibelius transpose une idée pour qu’elle corresponde à la tonalité en cours, toutes les notes

sont transposées vers le haut ou vers le bas selon le même intervalle, ce qui signifie qu’une idée en

majeur collée dans une tonalité mineure, continuera à sonner en majeur. (vous pouvez cependant

réaliser une transposition modale si nécessaire grâce à l’extension Transformer une gamme –

consultez Transformer une gamme à la page 600). Si vous préférez que Sibelius ne transpose

pas vos idées, désactivez Transposer selon l’armure en cours dans la page Idées du menu

Fichier > Préférences (dans le menu Sibelius sur Mac).

De la même manière, si vous ne souhaitez pas que Sibelius adapte votre idée à la tessiture de

l’instrument, désactivez Transposer les octaves selon la tessiture de l’instrument dans le

même menu.

Quand vous collez une idée qui utilise un instrument de percussion à sons indéterminés sur la

portée d’un instrument de percussion à sons indéterminés différent, Sibelius créera

automatiquement un changement d’instrument au début de l’idée collée (et restaurera

l’instrument original à la fin de l’idée), pour que l’exécution soit exacte. Si vous ne voulez pas que

Sibelius fasse cela, désactivez Créer des changements d’instruments dans les idées avec sons
indéterminés.

Si dans une partition vous souhaitez mémoriser les endroits où figurent des idées (ce qui est

pratique pour un professeur qui veut savoir où les élèves les ont utilisées), activez Créer un
surlignage en couleur, commande qui se trouve elle aussi à la page Idées du menu Fichier >

Préférences (dans le menu Sibelius sur Mac). À l’endroit du collage sera créé un surlignage avec

la couleur de fond de l’idée.
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Idées intégrés
Sibelius propose plus de 2000 idées, conçues pour stimuler l’inspiration des compositeurs de tous

les âges et qui recouvrent un éventail de genres le plus large possible dès le niveau élémentaire.

Chaque idée a un nom, en principe un nom de genre, suivi de l’instrument utilisé (ou de plusieurs

selon le cas) et terminé par un numéro. En général plus le nombre est élevé, plus la musique de

l’idée est complexe. Les idées prédéfinies sont aussi colorées selon leur genre (comme affiché dans

la liste ci-dessous). 

Pour rechercher une idée d’un genre spécifique, entrez d’abord l’un des mots-clé suivants:

Vous pouvez affiner la recherche en utilisant des mots-clé supplémentaires tels que:

* Instrument, par exemple guitare, percussion, piano

* Tempo, par exemple rapide, lent, moderato

* Type d’idée, par exemple mélodie, accompagnement, rythme

* Complexité, par exemple élémentaire, modéré, complexe

* Humeur, par exemple joyeux, triste, pensif

* Qualification, par exemple excité, vivant, relax, majestueux, majeur, mineur, swing, dramatique,

humoristique

Tapez un ou plusieurs mots-clé pour une ou plusieurs catégories et vous trouverez des idées qui

correspondent à ce que vous recherchez.

Voici quelques astuces supplémentaires pour utiliser des idées prédéfinies dans vos partitions:

* Les idées peuvent être de longueur différente, en général entre deux et huit mesures. Les idées

peuvent convenir par exemple pour illustrer des points spécifiques de composition, de style ou

technique de jeu, tandis que les idées les plus courtes conviendront mieux pour s’intégrer dans

vos compositions en les traitant de manières diverses telles qu’une transformation, une répétition

ou autre chose.

* Pratiquement toutes les idées sont pour instrument seul (comme leur nom le spécifie), et

fonctionnent mieux si elles sont collées dans l’instrument pour lequel elles ont été conçues, ou

sinon un instrument très proche. Cependant vous pouvez coller une idée sur une portée dans

votre partition et Sibelius la transposera en fonction de la tessiture de l’instrument; donc ne vous

privez de le faire.

* Africain (pêche)

* Chill Out (vert pastel)

* Classique (vert citron)

* Concert Band (vert vif)

* Country (jaune)

* Dance (gris)

* Film (bleu ciel)

* Folk (olive)

* Funk (gris-rose)

* Garage (bleu voilé)

* Groovy (rose pastel)

* Hip Hop (bleu pastel)

* Jazz (rose intermédiaire)

* Latin (orange)

* Marching Band (turquoise)

* Classique moderne (vert foncé)

* Motown (beige)

* Pop (bleu vif)

* Reggae (violet)

* Rock (rose vif)
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* Toutes les idées d’un genre ont été conçues pour fonctionner ensemble, même si elles ne

partagent pas nécessairement les mêmes structures harmoniques et séquences d’accord. Les

idées avec instrument de même numéro tels que Reggae Bass 1 et Reggae Keyboard 1, en

général fonctionnent bien ensemble.

* Les idées prédéfinies ont été conçues pour sonner le mieux possible avec Sibelius Sounds

Essentials (b 4.4 Sibelius Sounds Essentials) et l’option Exécution > Exécution
enregistrée activée (b 4.8 Exécution enregistrée), mais naturellement vous pouvez les

jouer sur n’importe quel périphérique.

Utiliser les idées dans l’enseignement
Si vous êtes enseignant, il est plus que probable que vous avez déjà entrevu les multiples manières

d’intégrer la fonction idées dans votre enseignement; voici cependant quelques suggestions

pratiques pour que vos étudiants puissent en tirer le meilleur parti:

* Écouter les idées écrites: Les élèves qui lisent mal pourront facilement entendre les idées en

cliquant dessus, ce qui permettra de stimuler leur créativité.

* Créer des ostinatos de forme ABA: Montrez-leur comment créer un instrument approprié dans la

partition avec Insertion > Instruments (raccourci I), puis comment coller une idée sur la portée.

Montrez-leur ensuite comment répéter rapidement une idée après l’avoir collée en utilisant

Édition > Répéter (raccourci R). Avec ces techniques faciles, les élèves seront capables de

construire leurs propres morceaux en utilisant les idées prédéfinies.

* Conserver les traces de leur créativité avec des surlignages colorés: il peut être intéressant d’activer

Créer des surlignages colorés (dans la page Idées de Fichier > Préférences, dans le menu

Sibelius sur Mac) pour aider les élèves à voir par la présence ou l’absence de surlignages les

structures produites avec plusieurs idées, et où elles sont utilisées ou créées.

* Créer des modèles de partition: Vous pouvez créer des projets simples pour les élèves en leur

préparant des modèles dans lesquels figurent des idées choisies précisément. Par exemple, vous

pouvez créer des portées vides pour un petit ensemble de jazz (percussions, clavier, basse, et un

leader, par exemple un saxophone). Vous prendrez ensuite les idées adéquates dans la

bibliothèques des idées prédéfinies et les ajouterez à la partition (en les sélectionnant et en

choisissant Ajouter à la partition dans la fenêtre des idées) pour donner aux étudiants une

structure sur laquelle ils pourront construire par exemple un blues de 12 mesures, avec quelques

lignes de basse, des riffs de clavier et un support rythmique. Si vous activez Afficher les idées
de cette partition uniquement (dans la page Fichier de Fichiers > Info sur la partition) les

élèves ne pourront voir que les idées que vous avez sélectionnées pour ce fichier.

* Improviser une mélodie: Encouragez vos élèves les plus doués à essayer d’improviser une mélodie

sur leur instrument après avoir construit un accompagnement de basse, piano et batterie avec

les idées fournies.
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La fonction idées de Sibelius peut aussi se prêter à:

* l’étude des éléments de la musique

* utiliser les idées dans des activités de questions-réponses

* expérimenter les changements de timbres des instruments

* entraîner l’oreille par des dictées et des idées répétées en boucle

* permettre aux élèves de capturer leurs propres idées qui seraient partagées avec de plus jeunes

élèves

* aider les étudiants à créer dans le genre pop/dance music .

Un certain nombre d’idées prédéfinies (particulièrement celles avec le mot-clé “Classique”) ont été

conçues en tant que point de départ spécifique pour des travaux de composition, couvrant le

programme des niveaux GCSE et AS / A2.

Pour avoir plus d’informations, visitez www.sibeliuseducation.com.

Limiter l’accès à la bibliothèque
Si vous voulez rendre impossible l’affichage des idées de la bibliothèque quand vous travaillez sur

une partition spécifique (par ex. dans le cas où vous préparez une leçon pour des étudiants et que

vous souhaitez qu’ils ne puissent travailler qu’avec un ensemble d’idées déterminées par vous et

sauvegardées dans la partition), activez Afficher les idées de cette partition uniquement dans

la page Fichier du menu Fichier > Informations sur la partition.

Quand cette option est activée, le bouton Bibliothèque de la fenêtre des idées est éteint et

désactivé, de sorte que seules les idées sauvegardées dans la partition sont visibles quand cette

partition est ouverte.

Éditer une idée
Vous pouvez éditez à la fois la musique et les mots-clé des idées.

Pour éditer les mots-clé d’une idée, sélectionnez-les dans la

fenêtre des idées, puis cliquez sur le bouton Éditer les
informations de l’idée, ou faites un clic droit et choisissez

Éditer les informations de l’idée dans le menu contextuel. La

boîte de dialogue telle qu’illustrée à droite apparaît.

Vous pouvez éditer le Nom de l’idée et les mots-clé en tapant

simplement dans les boîtes adéquates. Pour changer la couleur

de fond d’une idée, cliquez sur Couleur et choisissez la couleur

dans la palette qui apparaît.

Vous pouvez aussi voir dans cette boîte de dialogue les mots-clé

créés automatiquement par Sibelius, sans qu’il soit possible des

les éditer; en effet, ils sont mis à jour automatiquement dès que

la musique de l’idée est éditée.

Pour éditer la musique d’une idée, sélectionnez-la dans la fenêtre des Idées, puis cliquez sur le

bouton Éditer une idée en bas de la fenêtre, ou faites un clic droit et choisissez Éditer une idée
dans le menu contextuel.

http://www.sibeliuseducation.com
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Une nouvelle fenêtre va apparaître, comme si une autre partition était ouverte. L’idée est affichée

en Panorama (b 5.13 Panorama), et peut s’éditer comme n’importe quelle autre partition

Quand vous avez terminé d’éditer votre idée, sauvegardez-la avec la commande Fichier >

Sauvegarder (raccourci Ctrl+S ou XS), puis fermez la fenêtre avec la commande Fichier >

Fermer (raccourci Ctrl+W ou XW) pour revenir à la partition originale.

Si vous décidez de ne pas sauvegarder les changements réalisés, il suffit de choisir Fichier >

Fermer, puis de cliquer sur Non quand il vous est demandé si vous voulez sauvegarder les

changements réalisés.

Où les idées sont-elles sauvegardées?
Une idée peut être sauvegardée soit dans la partition en cours, soit dans la bibliothèque. Quand

une idée est sauvegardée dans une partition, elle peut seulement apparaître dans la fenêtre des

idées quand la partition est ouverte et quand le bouton Partition est activé. Quand une idée est

sauvegardée dans la bibliothèque, elle peut apparaître dans la fenêtre des idées quelle que soit la

partition ouverte, pourvu que le bouton Bibliothèque soit activé.

Par défaut quand vous capturez une idée, elle s’ajoute à la partition en cours, ce qui signifie qu’elle

est seulement disponible pour cette partition, à moins de la sélectionner et de cliquer sur Ajouter
à la bibliothèque dans la fenêtre des idées. Si vous préférez que les idées soit directement

envoyées dans la bibliothèque, activez Ajouter les nouvelles idées dans: la bibliothèque à la

page Fichier > Préférences (dans le menu Sibelius sur Mac).

La bibliothèque est un gros réservoir d’idées que vous pouvez utiliser dans différentes partitions,

plutôt qu’une seule; c’est aussi l’endroit où toutes les idées prédéfinies sont conservées; si vous ne

voulez pas les y voir, mais à la place ne voir que vos idées, désactivez Afficher les idées
prédéfinies.

Les idées prédéfinies sont sauvegardées dans le dossier du programme Sibelius (Windows) ou dans

l’entité de l’application (Mac) et vous devriez éviter de les manipuler. Les idées que vous avez

créées sont sauvegardées dans un dossier appelé Idées dans le dossier de l’application de votre

compte d’utilisateur, mais vous devriez éviter de manipuler ces fichiers directement (cf. Fichiers
que peut créer l’utilisateur à la page 716), parce que Sibelius possède des fonctions intégrées

d’importation ou d’exportation de ces fichiers, ce qui permet de les partager avec d’autres

utilisateurs.

Partager des idées
Si vous souhaitez partager vos idées avec d’autres personnes, voici deux manières de procéder: soit

vous sauvegardez les idées à partager dans une partition spécifique et ensuite vous distribuez cette

partition (ce qui est pratique pour la mise au point de projets avec des étudiants - consultez

Utiliser les idées dans l’enseignement ci-dessus); soit vous exportez une sélection d’idées

sous forme de fichier .ideas que quelqu’un d’autre pourra importer dans sa bibliothèque.

Pour sauvegarder des idées dans une partition, sélectionnez les idées qui doivent être déplacées

avec la partition et cliquez sur le bouton Ajouter à la partition qui se trouve dans le bas de la

fenêtre des idées, ou faites un clic-droit et choisissez Ajouter à la partition dans le menu

contextuel. Si vous êtes en affichage détaillé, il est possible de sélectionner plusieurs idées à la fois,

ce qui est fort pratique pour ce genre d’opération. Pour vérifier si les idées sont bien dans la
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partition, désactivez le bouton Bibliothèque de la fenêtre des idées, ce qui a pour effet de

n’afficher que les idées sauvegardées dans la partition.

Pour exporter une sélection d’idées, vous devez utiliser l’affichage détaillé de la fenêtre des idées.

Sélectionnez les idées que vous voulez exporter de la manière habituelle – utilisez Maj-clic pour

sélectionner une suite continue d’idées dans la liste ou Ctrl+clic ou X-clic pour sélectionner

plusieurs idées réparties en divers endroits de la liste – ensuite cliquez sur le bouton Exporter qui

se trouve dans le bas de la fenêtre, ou faites un clic-droit (Windows) ou Contrôle-clic (Mac) et

choisissez Exporter dans le menu contextuel. Vous serez invité à donner un nom de fichier et un

emplacement de sauvegarde des idées; quand vous cliquez sur Sauvegarder, un fichier .ideas est

sauvegardé à l’endroit choisi. Vous pouvez envoyer à quelqu’un ce fichier .ideas (par ex. par

courriel) ou le déposer sur SibeliusEducation.com.

Importer des idées
Pour importer des idées dans votre bibliothèque, par exemple si vous avez reçu un fichier .ideas
d’un autre utilisateur de Sibelius, activez l’affichage détaillé de le fenêtre des idées, puis cliquez sur

Importer. Vous serez invité à choisir le fichier .ideas à importer; cliquez sur Ouvrir et une boîte de

dialogue apparaît, vous proposant de spécifier si les idées importées doivent être ajoutées à la

bibliothèque ou à l’une des partitions ouvertes.
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5.12 Menus et raccourcis

Pratiquement chaque fonction de Sibelius peut être exécutée en utilisant seulement le clavier.

L’utilisation de Sibelius vous paraîtra bien plus facile et plus rapide dès que vous aurez appris les

raccourcis-clavier pour les fonctions qui vous sont les plus utiles.

Les raccourcis figurent dans les menus de Sibelius ; ils sont également indiqués dans cet Ouvrage

de référence pour chaque fonction mentionnée possédant un raccourci ; la liste complète des

raccourcis se trouve dans les pages suivantes; les raccourcis indispensables figurent au dos du

Manuel.

La plupart des raccourcis peuvent être personnalisés ; de même il est possible d’activer ou

désactiver certaines fonctions dans les menus, ce qui peut s’avérer utile dans l’enseignement ; cf. ci-

dessous.

Pour en savoir plus à propos des conventions utilisées dans cet Ouvrage de référence pour nommer

les menus et les raccourcis, consultez le début du Manuel.

Organisation des raccourcis
Voici l’organisation des raccourcis conçue de manière à les mémoriser facilement :

* Les opérations usuelles (par ex. Nouveau, Copier, Imprimer, Rechercher, Sauvegarder,

Annuler) utilisent les raccourcis standards, généralement Ctrl ou X plus la lettre initiale (en

anglais) de l’opération (exceptions notables : Annuler, Ctrl+Z ou XZ, et Coller, qui est Ctrl+V
ou XV)

* La majorité des raccourcis du menu Créer utilise une seule lettre, en général la première du mot

anglais (par ex. L pour Ligne, K pour Key Signature ou Armure).

* Les raccourcis du menu Créer > Texte sont Ctrl ou X, ou Ctrl+Alt ou zX, plus la lettre initiale

(en Anglais) (par ex. Ctrl+E ou XE pour Expression, Ctrl+T ou XT pour Technique,

Ctrl+Alt+T ou zXT pour Tempo)

* La plupart des raccourcis des menus Notes, Mise en page et Style maison sont Ctrl+Maj ou

xX plus la lettre initiale (anglaise). Pour les options Mise en page > Réinitialiser... la lettre

initiale de ce qui est à réinitialiser est utilisée (par ex. Ctrl+Shift+P ou xXP pour Réinitialiser
les positions)

* Les raccourcis de la fenêtre d’outil sont Ctrl+Alt ou zX plus la lettre initiale en anglais (ou une

lettre du nom) de la fenêtre que l’on veut afficher ou masquer

* Ctrl ou X avec les flèches ou Début/Fin/Page préc./Page suiv. signifie “en grands incréments”,

par ex. lorsqu’une note est sélectionnée ; Ctrl+3 ou X3 transpose d’une octave; lors-qu’une

mesure est sélectionnée, Ctrl+Maj+Alt+1 ou xzX1 augmente l’espacement des notes

* Maj avec les flèches ou un clic de souris signifie “étendre la sélection”, quand par exemple une

mesure sélectionnée; Maj-3 étend la sélection à la portée supérieure.
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Différences Mac / Windows
Sibelius et les raccourcis sont virtuellement identiques sur Windows et Mac. La touche

Commande (X) sur les claviers Mac est équivalente à la touche Ctrl des claviers Windows, et la

touche Option (z) du Mac est équivalente à la touche Alt sous Windows. Par conséquent presque

tous les raccourcis sont interchangeables du moment que, par exemple, est substitué à la place de

X Ctrl. Il y a quelques exceptions, mais celles-ci sont clairement expliquées quand elles se

produisent.

De même, les conceptions plus anciennes de la souris Mac standard n’ayant qu’un seul bouton, sur

Mac, l’accès aux menus contextuels se fait par Contrôle-clic alors que sous Windows et Mac avec

souris à boutons multiples on utilise le clic-droit.

Menus et raccourcis pour l’enseignement
Sibelius est fourni avec un jeu de menus et de raccourcis appelé Mode enseignement qui

désactive toutes les fonctions avancées du programme. Pour utiliser ce jeu de menus et raccourcis,

choisissez Fichier > Préférences Menus et raccourcis (dans le menu Sibelius sous Mac OS),

sélectionnez Mode enseignement dans la liste et cliquez sur OK.

Les fonctions activées sont les plus susceptibles d’être utilisées par des élèves (par ex. saisie de notes

et d’autres objets communs, exécution de base, impression), mais les fonctions plus avancées (ou

celles à interdire pour éviter toute distraction !) sont désactivées, comme celles des menus Style
maison et Mise en page, celles d’exécution avancées, et les liens Internet du menu Aide.

Sibelius n’interdit pas aux élèves l’accès à la boîte de dialogue Menus et raccourcis pour rétablir les

fonctions désactivées, mais vous pouvez les menacer d’une punition en cas de tentative.

Vous pouvez également utiliser le Mode enseignement comme base pour votre propre jeu de

menus et raccourcis ; cf. Activer et désactiver des fonctions ci-dessous.

Fonctions pour les portables
Sibelius propose une fonction conçue spécialement pour les utilisateurs de portables sans pavé

numérique. Pour utiliser cette fonction, choisissez Fichier > Préférences puis Menus et raccourcis.

Sélectionnez Fonctions de portable dans la liste, puis cliquez sur OK. Cf. Accéder aux touches
du pavé numérique sur un ordinateur portable à la page 18 pour en savoir plus.

Personnaliser les raccourcis-clavier
Vous pouvez personnaliser les raccourcis clavier dans Sibelius en fonction de vos préférences.

Par exemple, si vous utilisez souvent les triolets et que vous trouvez la combinaison Ctrl+3 ou X3
peu pratique, vous pourriez assigner une seule touche au raccourci, comme par exemple U.
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Pour commencer, choisissez la page Menus et raccourcis page of Fichier > Préférences (dans le

menu Sibelius sous Mac) pour afficher cette boîte de dialogue :

Avant de pouvoir définir un nouveau raccourci, vous devez créer un nouveau jeu de menus et

raccourcis, qui sera un ensemble de raccourcis clavier et de fonctions activées spécifiques (cf.

Activer et désactiver des fonctions ci-dessous). Par défaut, Sibelius utilise le jeu de Menus
et raccourcis standard (même si d’autres jeux sont aussi inclus – cf. ci-dessus), mais il est

possible de créer autant de jeux de menus et raccourcis qu’on le souhaite. Créons-en un :

* Cliquez sur la liste déroulante en haut de la boîte de dialogue et cliquez sur Ajouter un jeu de
menus et raccourcis pour créer le nouveau jeu de menus et raccourcis

* Dans la boîte de dialogue Nouveau jeu de menus et raccourcis, entrez un nom approprié.

L’option Baser sur le jeu par défaut (cochée par défaut) est recommandée: elle conserve tous

les raccourcis standard de Sibelius et permet d’en ajouter ; si vous désactivez cette option, vous

aurez à définir tous les raccourcis à partir de rien.

* Cliquez sur OK, et votre nouveau jeu de menus et raccourcis est automatiquement sélectionné

dans la boîte de dialogue Menus et raccourcis 

* Si un jeu de menus et raccourcis doit être supprimé ou renommé, choisissez Modifier un jeu de
menus et raccourcis dans la liste. Vous pouvez également faire un double d’un jeu existant, ce

qui est utile pour baser par exemple un nouveau jeu sur le jeu Mode enseignement fourni.

Maintenant, attelez-vous à la tâche et commencez par définir vos propres raccourcis :

* Toutes les fonctions dont on peut personnaliser les raccourcis sont organisées selon leur Menu
ou Catégorie ; choisissez l’option appropriée dans la liste ; dans notre cas, il s’agit de Multiplets

* La liste Fonction affiche les fonctions disponibles dans le menu ou la catégorie choisie ;

choisissez Triolet

* Dans la boîte Raccourcis clavier à droite sont affichés tous les raccourcis en cours tel que celui

pour créer un triolet par exemple
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* Vous pouvez choisir le raccourci existant et cliquer sur Suppr pour l’enlever, mais cela est

rarement nécessaire car il est possible de définir plusieurs raccourcis pour la même fonction (le

premier raccourci de la liste est celui affiché dans les menus de Sibelius, si la fonction a une

entrée dans un menu). Ajoutons donc un raccourci supplémentaire : cliquez sur Ajouter

* La boîte de dialogue Ajouter un raccourci clavier apparaît. Entrez le raccourci (dans notre cas,

appuyez sur W) puis cliquez sur OK. Même si une combinaison de touches comme Ctrl+Alt+U
ou zXU), peut être entrée, les raccourcis à une touche sont recommandés car moins fatigants.

* Si le raccourci que vous choisissez est déjà utilisé par une autre fonction, Sibelius vous

demandera si vous souhaitez passer outre

* Lorsque vous aurez terminé de personnaliser les raccourcis, cliquez sur OK pour fermer la boîte de

dialogue Menus et raccourcis.

Voici un certain nombre de choses à ne pas perdre de vue quand on personnalise des raccourcis :

* Il est théoriquement possible de réassigner des touches au pavé (cela pourrait être utile pour

émuler d’autres programmes musicaux), mais le pavé à l’écran ne sera pas réarrangé pour

refléter les modifications : si le 3 du pavé est assigné pour le triolet, aucun petit triolet ne s’y

affichera

* Sur Mac, les combinaisons suivantes ne peuvent être réassignées, car elles sont interceptées par

le système d’exploitation: xX0–9, F1–F12, zXT, XM et XH.

* Sous Windows, les touches principales qui ne peuvent être réassignées sont Alt+F, Alt+E, Alt+V,

Alt+N, Alt+C, Alt+P, Alt+L, Alt+S, Alt+U, Alt+W, Alt+H – il s’agit des raccourcis pour

chacun des menus de Sibelius. N’essayez pas non plus de réassigner d’autres raccourcis standard

dans Windows tels que Ctrl+F4, Alt+F4, Ctrl+Échap, Ctrl+Tab, Alt+Tab, etc.

Pour personnaliser les raccourcis pour les entrées des menus contextuels, b 3.1 Utiliser du
texte.

Rechercher les raccourcis-clavier inutilisés
Le jeu de raccourcis standard de Sibelius n’utilise pas tous les raccourcis claviers possibles.

De manière générale, la plupart des combinaisons de lettres seules, Ctrl ou X plus des lettres, et

Ctrl+Maj ou xX plus des lettres (et un nombre plus restreint de Ctrl+Maj+Alt ou xzX plus

des lettres) sont déjà utilisés par défaut. Cependant, sans les réaffecter vous pourriez utiliser :

* Ctrl+Maj ou xX, ou Ctrl+Maj+Alt ou xzX, plus des chiffres sur le clavier principal

* Ctrl ou X, Ctrl+Maj ou xX, ou Ctrl+Maj+Alt ou xzXplus la plupart des touches de fonction

* Les raccourcis d’une seule touche utilisant les touches de ponctuation (par ex., . / # ; etc.)

Activer et désactiver des fonctions
De la même manière qu’elle permet de personnaliser les raccourcis, la page Menus et raccourcis
dans la boîte de dialogue Préférences permet également de désactiver des fonctions de Sibelius de

manière sélective, ce qui peut s’avérer utile dans un contexte éducatif, lorsqu’on souhaite que les

élèves n’utilisent pas certaines fonctions du programme.

Le moyen de réaliser cela consiste à créer un jeu de menus et de raccourcis à partir par ex. du jeu

Mode enseignement fourni ; car dans le jeu par défaut les fonctions ne peuvent être

désactivées) ; cf. Personnaliser les raccourcis-clavier ci-dessus . Choisissez ensuite la
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fonction que vous souhaitez désactiver dans la liste Fonction: et décochez la case Activer la
fonction. Les fonctions désactivées ne disparaissent pas des menus de Sibelius, mais elles

s’affichent en grisé et le raccourci-clavier habituel pour les appeler est inopérant.

Partager des jeux de menus et raccourcis
Les jeux de menus et raccourcis sont sauvegardés dans le sous-dossier Menus et raccourcis du

sous-dossier Ressources de votre dossier Sibelius (cf. Fichiers que peut créer l’utilisateur à
la page 716), et possèdent l’extension .sfs. Les jeux de menus et raccourcis peuvent être transférés

d’un ordinateur à un autre en copiant simplement le fichier, puis en choisissant le jeu copié sur le

second ordinateur dans la boîte de dialogue Menus et raccourcis située dans

Fichier > Préférences (dans le menu Sibelius sur Mac).

Les jeux de menus et raccourcis sont dépendants du système d’exploitation ; donc un jeu créé sous

Windows ne fonctionnera pas sur Mac, et vice-versa (les touches Windows et Mac étant

différentes).

Rétablir les raccourcis-clavier par défaut
Pour rétablir les raccourcis sur leurs réglages par défaut, resélectionnez simplement le jeu Menus
et raccourcis standard dans la boîte de dialogue Fichier > Préférences > Menus et raccourcis
(dans le menu Sibelius sous Mac) et cliquez sur OK.

Fonction Raccourcis Windows Raccourcis Mac

Fichiers

Nouveau Ctrl+N XN

Ouvrir Ctrl+O XO

Fermer Ctrl+F4 / Ctrl+W XW

Fermer tout Ctrl+Alt+W zXW

Sauvegarder Ctrl+S XS

Sauvegarder sous Ctrl+Shift+S xXS

Saisie des notes

Saisie des notes N N

y / x / e / q / h / w 1/2/3/4/5/6 (sur le pavé) 1/2/3/4/5/6 (sur le pavé)z

§ / # / b (activé/désactivé) 7/8/9 (sur le pavé) 7/8/9 (sur le pavé)

> . – (activé/désactivé) / * - = / *

Point de rythme . (point) . (point)

Créer une note A/B/C/D/E/F/G ou jouer une note 

/ un accord sur un clavier MIDI

A/B/C/D/E/F/G ou jouer une note / 

un accord sur un clavier MIDI

Créer un silence 0 (sur le pavé) 0 (sur le pavé)

Ajouter l’intervalle au-dessus 1/2/3/4/5/6/7/8/9
(sur le clavier principal)

1/2/3/4/5/6/7/8/9
(sur le clavier principal)

Ajouter l’intervalle en dessous Maj+1/2/3/4/5/6/7/8/9
(sur le clavier principal)

x1/2/3/4/5/6/7/8/9
(sur le clavier principal)

Ajouter une note au-dessus Maj+A-G xA-G

Liaison rythmique (on/off) Entrée sur le pavé numérique Entrée sur le pavé numérique

Commencer une nouvelle voix N Alt+2/3/4 N z2/3/4

Flexi-time™

Flexi-time Ctrl+Maj+F FxX

Arrêter Flexi-time Espace Espace

Options Flexi-time Ctrl+Maj+O xXO
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Éditer les notes

Ressaisir les hauteurs Ctrl+Maj+I IxX

Modifier la hauteur A/B/C/D/E/F/G ou jouer une note 

/ un accord sur un clavier MIDI

A/B/C/D/E/F/G ou jouer une note / 

un accord sur un clavier MIDI

Modifier la valeur de note: y / x / e / q / h / w; 

démarrer / arrêter de ressaisir les hauteurs de note

1/2/3/4/5/6 (sur le pavé) 1/2/3/4/5/6 (sur le pavé)

Modifier l’altération: § / # / b (activé/désactivé) 7/8/9 (sur le pavé) 7/8/9 (sur le pavé)

Modifier l’ (les) altération(s): > . – (activé/désac-

tivé)

/ * - = / *

Changer en silence(s) Suppr / Ret. arrière Suppr / Ret. arrière 

Changer en silence(s) individuel(s) 0 sur le premier pavé 0 sur le premier pavé

Enharmonie -Retour (sur le clavier principal) -Retour (sur le clavier principal)

Enjambement de portée (portée sup./ infér.) Ctrl+Maj+3/2 xX3/2

Tête de note standard Maj+Alt+0 (sur le clavier princi-

pal)
xz0 (sur le clavier principal)

Modifier la tête de note Maj+Alt+0/1/2/3… 

(ou deux chiffres)
xz 0/1/2/3… (ou deux chiffres) 

Type de tête de note suivante Maj+= x=

Type de tête de note précédente Maj+– x–

Intervertir les voix 1 et 2 Maj+V xV

Transposition Maj+T xT

Arranger Ctrl+Maj+V xXV

Fenêtre Clavier

Basculer en mode QWERTY Maj+Alt+Q xzQ

Augmenter d’un octave (en mode QWERTY) X X

Réduire d’un octave (en mode QWERTY) Z Z

C (en mode QWERTY) A A

C# (en mode QWERTY) W W

D (en mode QWERTY) S S

Eb (en mode QWERTY) E E

E (en mode QWERTY) D D

F (en mode QWERTY) F F

F# (en mode QWERTY) T T

G (en mode QWERTY) G G

Ab (en mode QWERTY) Y Y

A (en mode QWERTY) H H

Bb (en mode QWERTY) U U

B (en mode QWERTY) J J

C (en mode QWERTY) K K

Créer des objets

Menu Créer Maj+F10 / clic-droit 

(lorsque rien n’est sélectionné)

Contrôle-clic 

(lorsque rien n’est sélectionné)

Mesure à la fin Ctrl+B XB

Une seule mesure (en milieu de partition) Ctrl+Maj+B xXB

Autre (multiple / irrégulière) Alt+B zB

Clef Q Q

Symbole d’accord Ctrl+K XK

Commentaire Maj+Alt+C xzC

Instruments I I

Changement d’instruments Ctrl+Maj+Alt+I xzXI

Fonction Raccourcis Windows Raccourcis Mac
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Armure K K

Ligne L L

Liaison de phrasé / inversée S/Maj+S (puis Espace pour pro-

longer)
Sx/S (puis Espace pour prolonger)

Soufflet de crescendo / diminuendo H/Maj+H 

(puis Espace pour prolonger)
H/xH (puis Espace pour prolon-

ger)

Repère de répétition Ctrl+R XR

Symbole Z Z

Indication de mesure T T

Triolet Ctrl+3 (sur le clavier principal) X3 (sur le clavier principal)

Multiplet Ctrl+2–9 (sur le clavier principal) X2–9 (sur le clavier principal)

Création de texte

Expression Ctrl+E XE

Paroles ligne 1 Ctrl+L XL

Paroles ligne 2 Ctrl+Alt+L zXL

Technique Ctrl+T XT

Tempo Ctrl+Alt+T zXT

Modifier le texte

Commencer l’édition Retour (sur le clavier principal) / 

F2 / double-clic

Retour (sur le clavier principal) 

double-clic

Arrêter l’édition Échap / X. Échap / X. 

Déplacer vers la gauche / droite d’un caractère 0�1 0/1

Déplacer vers la gauche / droite d’un mot Ctrl+0/1 z0/1

Déplacer au début / à la fin de la ligne Début/Fin aucun

Déplacer au début / à la fin du texte Ctrl+Début/Fin X0/1

Sélectionner le mot double-clic double-clic

Sélectionner le caractère suivant / précédent Maj+01/ x0/1

Sélectionner jusqu’à la fin / le début du mot Ctrl+Maj+0/1 xz0/1

Sélectionner jusqu’à la fin / le début du texte Ctrl+Maj+Début/Fin xX0/1

Sélectionner tout le texte Ctrl+A XA

Supprimer le caractère précédent / suivant En arrière / Suppr Ret. arrière

Supprimer le mot précédent / suivant Ctrl+Ret. arrière/Suppr z-En arrière / Suppr

Remplacer le texte sélectionné entrer du nouveau texte entrer du nouveau texte

Nouvelle ligne Retour/Entrée Retour/Entrée 

Gras/italique/souligné on/off Ctrl+B/I/U XB/I/U

Polices par défaut Ctrl+Alt+Espace ^z-Espace

Avancer à la note/au temps suivant (paroles/sym-

boles d’accord/basse chiffrée/doigté)

espace espace 

Traits d’union jusqu’à la note suivante (paroles) – (trait d’union) – (trait d’union)

Élision (paroles) _ (souligné) _ (souligné)

Espace sans rupture/trait d’union sans rupture

(paroles/symboles d’accord)

Ctrl+Espace/trait d’union z-Espace/trait d’union

Menu contextuel Maj+F10 / clic-droit Contrôle-clic

f / m /  p / r / s / z (texte d’expression) Ctrl+F/M/N/P/R/S, Ctrl+Maj+Z XF/M/N/P/R/S, xXZ

cresc. / dim. (texte d’expression) Ctrl+Maj+C/D xXC/D

y / x / e / q / h / w / § / # / b Ctrl+1/2/3… (sur le pavé) X1/2/3… (sur le pavé)

à / è / ì / ò / ù Ctrl+Maj+Alt+A/E/I/O/U z` suivi de la lettre (par ex.z’A)

á / é / í / ó / ú Ctrl+Maj+A/E/I/O/U zE suivi de la lettre

Fonction Raccourcis Windows Raccourcis Mac
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ä / ë / ï / ö / ü Alt+nombre dans la Table des 
caractères

zU suivi de la lettre

â / ê / î / ô / û Alt+nombre dans la Table des 
caractères

zI suivi de la lettre

ç / Ç Alt+nombre dans la Table des 
caractères

zC / xzC

Autres caractères spéciaux Alt+nombre dans la Table des 
caractères

utilisez l’utilitaire Keyboard Viewer

“ / ” (guillemets intelligents) Alt+2 / Maj+Alt+2 z] / xz]

‘ / ’ (demi guillemets intelligents) Alt+’ / Maj+Alt+’ z[ / xz[

... (points de suspension) Alt+0133 (sur le pavé) z;

© Ctrl+Maj+C xXC

| (Texte/Titre/Copyright) Ctrl+Maj+P xXP

$ (Tempo) Ctrl+Maj+4 ($) xX4 ($)

Ø (Tempo) Ctrl+0 (zéro) X0 (zero)

< / > (dans des modulations métriques) Ctrl+[ / ] X[ / ]

Diagramme de pédales de harpe (Texte tech-

nique)

Ctrl+Alt+7/8/9/+ (sur le pavé) zX7/8/9/+ (sur le pavé)

Tablature de guitare

Changer de frette 0/1/2/3… (ou deux chiffres, sur le 

clavier principal) 

0/1/2/3… (ou deux chiffres, sur le 

clavier principal) 

Déplacer vers la gauche/droite dans une mesure 0/1 0/1

Déplacer d’une corde vers le haut/bas 3�2 3/2

Déplacer à la corde supérieure/inférieure Ctrl+3/2 X3/2

Bend J (puis Espace pour prolonger) J (puis Espace pour prolonger)

Préparation de Bend/glissé/tête de note en crochet – / . (point) / 1
 sur le second pavé

* /. (point) / 1
 sur le second pavé

Demi-dièse (affiché comme 0.5) = (sur le clavier principal) = (sur le clavier principal)

Lecture et vidéo

Jouer ou mettre en pause Espace Espace

Rejouer Ctrl+Espace z-Espace

Jouer à partir de la sélection P P

Marche arrière/avance rapide(par palier de 0.2

seconde)

[ / ] [ / ]

Avancer/Reculer d’une image Maj-[ / ] x[ / ]

Arrêt Échap / X. Échap / X. 

All Notes Off Maj+O xO

Ramener la ligne de lecture au début Ctrl+[ X[

Déplacer la ligne de lecture à la fin Ctrl+] X]

Déplacer la ligne de lecture jusqu’à la sélec-
tion

Y Y

Aller à la ligne de lecture Maj+Y xY

Exécution enregistrée Maj+L xL

Transformer l’exécution enregistrée Ctrl+Maj+Alt+L xzXL

Table de mixage (afficher/masquer) Ctrl+Alt+M M

Point de montage Maj+Alt+P xzP

Modifier des objets

Annuler Ctrl+Z XZ

Rétablir Ctrl+Y XY

Fonction Raccourcis Windows Raccourcis Mac
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Histoire des annulations Ctrl+Maj+Z xXZ

Historique de rétablissements Ctrl+Maj+Y xXY

Couper Ctrl+X XX

Copier Ctrl+C XC

Copier à l’endroit du clic Alt+clic z-click

Copier à l’endroit du clic aux poistions verticales

par défaut

Maj+Alt+clic xz-click

Capturer une idée Maj-I Ix

Coller Ctrl+V XV

Coller en tant que réplique Ctrl+Maj+Alt+V xzXV
Répéter (note/accord/passage/texte/ligne/etc.) R R

Supprimer En arrière / Suppr En arrière0 () / Suppr

Supprimer des mesures Ctrl+En arrière X0 (Ret. arrière)

Retourner (hampe, liaison, multiplet, liaison

rythmique, etc.)

X X

Voix 1/2/3/4/Toutes les voix Alt+1/2/3/4/5 (sur le clavier 

principal)
1/2/3/4/5 z(sur le clavier princi-

pal)

Masquer/Afficher Ctrl+Maj+H xXH

Couleur Ctrl+J XJ

Réappliquer la couleur Ctrl+Maj+J xXJ

Texte d’accord équivalent Ctrl+Shift+K xXK

Resélectionner le voicing du diagramme
d’accord

Ctrl+Shift+Alt+K xzXK

Navigation

Sélectionner le premier objet sur la page (lorsque

rien n’est sélectionné)

Tab Tab

Sélectionner l’objet suivant / précédent Tab/Maj+Tab Tab/x-Tab

Sélectionner la note / l’accord / le silence suivant /

précédent
0�1 0/1

Sélectionner le début de la mesure suivante /

précédente
Ctrl+0/1 X0/1

Sélectionner une partie d’un note/d’un accord/

d’un silence, ou la fin / le milieu / l’entièreté d’une

ligne

Alt+0/1 z0/1

Sélectionner la note/le tremolo/la hampe/l’articu-

lation au-dessus/en-dessous de l’accord
Alt+3/2 z3/2

Sélectionner la note la plus proche dans la voix

suivante dans la même portée
Maj+Alt+3/2 xz3/2

Sélectionner la note la plus haute/basse de la por-

tée suivante
Ctrl+Alt+3/2 zX3/2

Déplacer la partition déplacer le navigateur/le papier déplacer le navigateur/le papier

Descendre / monter d’un écran Page vers le haut/vers le bas 89/ ou -Page précédente/suiv-
ante

Déplacer d’un écran ou d’une page à gauche/à

droite

Début/Fin 4/7 (x4) ou Début/Fin

Monter/descendre un peu Alt+Page précédente/suivante z89/ ou zPage précédente/

suivante

Aller à gauche/à droite un peu Alt+Début/Fin z4/7 ou zDébut/Fin

Aller en haut / en bas de la page Ctrl+Page précédente/suivante X8/9 ou XPage précédente/

suivante
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Aller à la première / dernière page Ctrl+Début/Fin /7 (xX4) ou X-Début/FinX4

Aller au début de la sélection Maj+Début  ou x4Débutx

Aller à la fin de la sélection Maj+Fin  ou x7Finx

Aller à la mesure Ctrl+Alt+G zXG

Aller à la page Ctrl+Maj+G xXG

Augmenter/Diminuer le zoom t Ctrl+=/– ou +/– sur le pavé (ou 

clic/clic-droit avec l’outil zoom)
X=/– or +/– sur le pavé (ou clic/-

clic avec l’outil zoom)z 

Zoom à 100% Ctrl+1 X1

Ajuster la page Ctrl+0 X0

Déplacer les objets

Déplacer l’ (les) objet(s) (en grands incréments ;

par défaut 1 dent)
3/2/0/1 (Ctrl+3/2/0/1) 3/2/0/1 (X3/2/0/1)

Déplacer des objets, le long des positions du qua-

drillage
Maj-tirer x-tirer

Déplacer la (les) portée(s) vers le haut / vers le bas 

(en grands incréments ; par défaut 1 dent)
Alt+/3 (2Ctrl+Alt+3/2 

ou tirer

z3/2 (zX3/2) ou tirer

Déplacer la (les) portée(s) vers le haut / vers le bas

indépendamment (en grands incréments ; par

défaut 1 dent)

Maj+Alt+3/2 

(Ctrl+Maj+Alt+3/2) 

ou Maj+tirer

xz3/2 (xzX3/2) 

ou x-tirer

Déplacer la note/le silence/l’altération/le point

rythmique/la fin d’une liaison rythmique

(en grands incréments ; par défaut 1 dent)

Maj+Alt+0/1 

(Ctrl+Maj+Alt+0/1)

xz0/1 (xzX0/1)

Déplacer la ligne (de n’importe quelle extrémité)

ou les paroles à la note suivante / précédente

Espace/Maj+Espace xEspace/-Espace

Sélections multiples & passages

Sélectionner la mesure cliquer sur la portée (en évitant les 

notes, etc.)

cliquer sur la portée (en évitant les 

notes, etc.)

Sélectionner une mesure dans toutes les portées Ctrl+clic sur la portée X-clic sur la portée

Sélectionner toutes les mesures d’une portée (d’un

système)

double-clic sur la portée double-clic sur la portée

Sélectionner toutes les mesures de toutes les por-

tées (sur un système)

Ctrl+double-clic sur la portée X-double-clic sur la portée

Sélectionner toutes les portées dans la portée pour

toute la partition

triple-clic sur la portée triple-clic sur la portée

Modifier > Sélectionner > Sélectionner les
mesures

Ctrl+Alt+A zXA

Sélection de passage de système Maj+Alt+A xzA

Étendre le passage à l’objet Maj+clic x-click

Étendre le passage d’une note / d’un silence Maj+0/1 x0/1

Étendre le passage d’une mesure Ctrl+Maj+0/1 xX0/1

Étendre le passage d’une portée Maj+3/2 x3/2

Sélectionner tout dans une partition Ctrl+A XA

Sélectionner toutes les notes d’un accord (Sélec-
tionner plus)

Ctrl+Maj+A ou double-clic AxX ou double-clic

Sélectionner tout le texte du même style sur la

portée (Sélectionner plus)

Ctrl+Maj+A xXA

Sélectionner les objets à la souris Maj+tirer sur le papier X-tirer sur le papier

Ajouter / supprimer l’objet de la sélection Ctrl+clic X-click

Sélectionner une image Alt+G zG

Sélectionner - rien Échap / X. Échap / X.
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Rechercher et filtrer

Filtre avancé Ctrl+Maj+Alt+F FxzX

Filtrer les Nuances Maj+Alt+D xzD

Filtrer Voix 1/2/3/4 Ctrl+Maj+Alt+1/2/3/4 xzX1/2/3/4

Filtrer les Notes supérieures/2ndes notes/

3èmes notes/Notes inférieures ou notes
seules 

Ctrl+Alt+1/2/3, 

Ctrl+Maj+Alt+B
zX1/2/3, xzXB

Rechercher Ctrl+F FX

Rechercher le suivant Ctrl+G XG

Mise en page

Paramètres du document Ctrl+D XD

Masquer les portées vides Ctrl+Maj+Alt+H xzXH

Afficher les portées vides Ctrl+Maj+Alt+S xzXS

Saut de système activé/désactivé -Retour (sur le clavier principal) -Retour (sur le clavier principal)

Saut de page activé/désactivé Ctrl+Retour (sur le clavier princi-

pal)
X-Retour (sur le clavier principal)

Sauts de page spéciaux Ctrl+Maj+Retour (sur le clavier 

principal)
xX-Retour (sur le clavier princi-

pal)

Verrouiller la mise en forme Ctrl+Maj+L xXL

Déverrouiller la mise en forme Ctrl+Maj+U xXU

Assembler en un système Maj+Alt+M xzM

Assembler en une page Ctrl+Maj+Alt+M xzXM

Aligner sur une rangée / Colonne Ctrl+Maj+R/C xXR/C

Réinitialiser l’espacement des notes Ctrl+Maj+N xXN

Réinitialiser les positions Ctrl+Maj+P xXP

Réinitialiser l’aspect original Ctrl+Maj+D xXD

Réinitialiser la position dans le partition Ctrl+Maj+Alt+P xzXP

Rétablir l’aspect original d’après le con-
ducteur

Ctrl+Maj+Alt+D xzXD

Condenser / élargir l’espacement de note

(en grands incréments)
Maj+Alt+0/1 

(Ctrl+Maj+Alt+0/1)

xz0/1 (xzX0/1)

Utiliser les mesures de comptage (dans la

mise en page automatique) activé/désactivé

Ctrl+Maj+M xXM

Style maison

Règles de gravure Ctrl+Maj+E xXE

Modifier les styles de texte Ctrl+Maj+Alt+T xzXT

Menus affichage et fenêtres

Panorama Maj-P xP

Portée en vue ciblée Ctrl+Alt+F FzX

Objets masqués (afficher/masquer) Ctrl+Alt+H zXH

Objets réglettes (afficher/masquer) Maj+Alt+R xzR

Réglettes de portée (afficher/masquer) Ctrl+Maj+Alt+R xzXR

Partition transposée Ctrl+Maj+T xXT

Navigateur (afficher/masquer) Ctrl+Alt+N zXN

pavé (afficher/masquer) Ctrl+Alt+K zXK

Clavier (afficher/masquer) Ctrl+Alt+B zXB

Grille d’accord (afficher/masquer) Ctrl+Alt+E zXE
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Exécution (afficher/masquer) Ctrl+Alt+Y zXY

Table de mixage (afficher/masquer) Ctrl+Alt+M M

Idées (afficher/masquer) Ctrl+Alt+I IzX

Parties (afficher/masquer) Ctrl+Alt+R zXR

Comparer (afficher/masquer) Ctrl+Alt+C zXC

Vidéo (afficher/masquer) Ctrl+Alt+V zXV

Propriétés (afficher/masquer) Ctrl+Alt+P zXP

Afficher/masquer Fenêtres d’outil Ctrl+Alt+X zXX

Passer au conducteur/parties W W

Partie suivante Ctrl+Alt+Tab zX~

Partie précédente Ctrl+Maj+Alt+Tab xzX~

Plein écran (Windows uniquement) Ctrl+U aucun

Menus et boîtes de dialogue

Aller dans le menu Alt+lettre soulignée aucun

Choisir dans le menu lettre soulignée aucun

Choisir dans la boîte de dialogue Alt+lettre soulignée aucun

Déplacer à la boîte suivante / précédente de la

boîte de dialogue

Tab/Maj-Tab Tab/x-Tab

Sélectionner des objets consécutifs de la liste Maj+clic ou tirer tirer

Sélectionnez des objets séparés de la liste Ctrl+clic X-click

OK (ou le bouton par défaut) Retour/Entrée Retour/Entrée 

Annuler Échap / X. Échap / X.

Agencements du pavé F7–F12 F7–F12

Agencement du pavé suivant + (sur le pavé) + (sur le pavé)

Retourner au premier pavé F7 / Maj-+ — (sur le pavé) / F7 

Menu d’édition contextuel Maj+F10 / clic-droit sur l’ (les) 

objet(s) sélectionné(s)

Contrôle-clic sur l’ (les) objet(s) 

sélectionné(s)

Changer de fenêtre Ctrl+Tab X~

Masquer la fenêtre aucun XH 

Réduire la fenêtre aucun XM 

Divers

Référence de Sibelius F1 X?

Imprimer Ctrl+P XP

Préférences Ctrl+, X,

Quitter/Terminer Alt+F4 / Ctrl+Q XQ
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5.13 Panorama

b 5.8 Portées en vue ciblée, 5.23 Menu affichage.

Panorama est une manière différente (parfois appelée mode défilement dans certains pro-

grammes) d’afficher la partition. Au lieu de figurer à l’écran page par page comme elle sera impri-

mée, la partition se déroule en continu sur un seul système comme sur un rouleau de papier.

Ce type d’affichage est parfois appelé vue déroulante ou vue en galerie dans certains programmes.

Avec Panorama, vous vous concentrez sur la saisie et l’édition sans tenir compte de la mise en page.

La saisie dans Panorama est très pratique, surtout pour les partitions de plusieurs systèmes par

page; Panorama élimine les mouvements verticaux de système à système car la partition se déplace

seulement de manière horizontale. On évite ainsi la sensation d’être un peu perdu comme cela

arrive parfois en affichage normal.

Activation de Panorama
Pour activer Panorama, il suffit de choisir Affichage > Panorama (raccourci Maj-P), ou de

cliquer sur le bouton de la barre d’outils tel qu’illustré à droite. L’activation a pour effet:

* Désactivation du navigateur, puisqu’il n’y a plus qu’une page

* Activation de Affichage > Barres de défilement

* Activation de Affichage > Noms des portées et numéros de mesures.

Pour désactiver Panorama, il suffit de choisir de nouveau Affichage > Panorama.

Si, lors d’une session en Panorama, vous désactivez les Barres de défilement ou les Noms des por-
tées et numéros de mesures, ces réglages sont conservés tant que Panorama reste actif, mais

aussi lors de son utilisation ultérieure.

Se déplacer dans Panorama
On travaille dans Panorama quasi comme en affichage normal; tous les raccourcis habituels de

navigation (par ex. Début, Fin, Vers le haut ou 8, Vers le bas ou 9, etc.) ainsi que les fonctions

comme le zoom fonctionnent normalement. Le niveau de zoom Ajuster selon la hauteur de la
page est particulièrement utile car il permet de voir toutes les portées en même temps.

Vous remarquerez que si vous déplacez le début de la partition vers la gauche de l’écran, la clé et

l’armure de chaque portée s’affichent en bleu en guise d’aide-mémoire.

Saisie et édition dans Panorama
Que ce soit dans Panorama ou en affichage normal, la saisie et l’édition se réalisent de manière pra-

tiquement identique. Seules quelques opérations sont impossibles dans Panorama car elles

n’auraient aucun sens puisqu’il n’y a pas de page:

* Il est impossible dans Panorama de voir ou d’introduire du texte aligné sur la page (tels que

Titre, En-tête (après la première page), etc.)

* Si Affichage > Marques de mise en page est activé, Sibelius affiche les marques de mise en page

au-dessus des barres de mesure, mais les sauts de système ou de page existants ou nouveaux qui

seraient créés resteront sans effet
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* Il est impossible d’imprimer dans Panorama (vu le peu d’imprimantes capables d’imprimer sur

rouleau infini!); de sorte que si vous choisissez Fichier > Imprimer, la partition sera imprimée telle

qu’elle se présente en affichage normal

* Mise en page > Masquer les portées vides ne peut s’utiliser puisqu’il faut plusieurs systèmes

pour l’appliquer alors qu’il n’en existe qu’un en Panorama; par conséquent toutes les portées mas-

quées en affichage normal apparaissent dans Panorama

* Édition > Aller à la page et Insertion > Autres > Changement de numéros de page est désactivé

* Mise en page > Aligner les portées est désactivé

* Quand vous choisissez Fichier > Exporter > Images, seule une Sélection d’images peut s’exporter

et non des systèmes ou des pages spécifiques – b 9.8 Exporter des images.

Espacement des notes dans Panorama
Dans Panorama, Sibelius utilise un espacement de notes “non justifié”; en d’autres mots, il va rap-

procher ou éloigner les notes, spécifié par une option sur la page Affichage de Fichier > Pré-
férences (dans le menu Sibelius sur Mac), au lieu de recourir à un facteur de justification variable

sur chaque système en vue normale de manière à remplir les pages.

Remarquez, que, si vous réalisez dans Panorama des ajustements dans l’espacement des notes, tel

qu’agrandir une mesure (par ex. pour éviter des collisions entre symboles d’accords), ces change-

ments seront réalisés et affichés dans Panorama comme en affichage normal. Prenez garde cepen-

dant que si l’ajustement est fait dans Panorama et donc réalisé sans prise en compte de la largeur de

la page, le résultat dans l’affichage normal sera différent, plus étendu ou plus serré en fonction de la

largeur de page, cette fois prise en compte.

Espacement des portées dans Panorama
Dans Panorama, Sibelius utilise l’espace entre les systèmes définis dans les pages Portées du menu

Style maison > Règles de gravure multiplié par un facteur fixe de justification spécifié dans Affi-
chage de Fichier > Préférences (dans le menu Sibelius sur Mac). Puisqu’il n’y a pas de hauteur de

page déterminée, Sibelius ignore la valeur de Justifier les portées quand la page et remplie à
au moins x%, si bien que parfois les portées paraissent plus proches qu’en affichage normal. Si

vous les trouvez trop proches, modifiez la valeur dans Préférences.

Cependant de manière fort pratique, il est possible dans Panorama d’ajuster l’espacement entre les

portées sans affecter l’affichage normal; par ce procédé on évitera les collisions entre notes et objets

de portées différentes; pour réaliser cela, il suffit de déplacer les portées comme d’habitude.

(b 8.10 Espacement des portées).

Utilisation de Panorama en combinaison avec Portées en vue ciblée
Quand Affichage > Portées en vue ciblée est utilisé avec deux portées ou un peu plus, l’affichage

normal peut sembler parfois bizarre en raison de l’absence des autres portées; mais si vous activez

en même temps Affichage > Panorama, Portées en vue ciblée devient vraiment pratique.

b 5.8 Portées en vue ciblée.

Ouverture de partitions dans Panorama
Quand vous sauvegardez une partition, Sibelius mémorise l’état de Panorama, ce qui garantit que

s’il était actif à la sauvegarde, il le sera à l’ouverture ultérieure de la partition. Il est même possible

pour tout lancement de Sibelius de choisir entre Panorama et affichage normal et cela dans la page

Fichier de Fichier > Préférences (dans le menu Sibelius sur Mac) – b 5.15 Préférences.
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5.14 Ordre

b 9.4 Importer des images.

Ordre se rapporte à l’ordre dans lequel les objets dans votre partition sont portés à l’écran.

Normalement, les lignes de portée sont déposées en premier, puis les objets comme les clefs, notes,

liaisons rythmiques, liaisons de phrasé, etc. sont portés de gauche à droite, comme si vous les

écriviez vous-même sur papier. Mais parfois, il est utile de pouvoir changer l’ordre dans lequel les

objets sont portés ; par exemple, si vous souhaitez qu’un graphique importé figure derrière les

notes mais devant la portée, ou si vous souhaitez créer des effets spéciaux comme des liaisons se

rompant de chaque côté d’une indication de mesure.

Couches
Sibelius propose 32 couches : les objets dans la couche 1 sont déposés en premier (et par

conséquent derrière tous les autres objets), et les objets dans la couche 32 déposés en dernier (et

par conséquent devant tous les autres objets). Chaque type d’objet comporte une couche par

défaut, en contrôlant sa place dans l’ordre de dépose, lequel peut être modifié dans Mise en page >

Options magnétiques de mise en page (voir Options de mise en page magnétique à la

page 636).

Les couches ne doivent pas être confondues avec les voix – b 2.36 Voix.

Changer l’ordre de dépose d’un objet
Pour changer l’ordre de dépose d’un objet, sélectionnez-le et choisissez l’option appropriée dans le

sous-menu Editer > Ordre :

* Passer à l’avant : transfère l’objet à la 32ème couche, devant tous les autres objets

* Passer à l’arrière : transfère l’objet à la couche suivante (ex. si l’objet se trouve actuellement sur

la 14ème couche, cela le déplace à la 15ème couche)

* Envoyer vers l’arrière : déplace l’objet à la couche précédente (ex.. de la 18ème couche à la

17ème)

* Envoyer à l’arrière : déplace l’objet à la 1ère couche, derrière tous les autres objets

* Rétablir aux paramètres par défaut : replace l’objet à sa couche par défaut.

Vous pouvez également déplacer un objet entre les couches via le panneau de Propriétés Général :
activez la case Ordre personnalisé, puis saisissez soit le numéro de couche souhaité, ou utilisez

les commandes de paddle pour déplacer l’objet dans l’ordre de dépose. Désactivez Ordre
personnalisé pour replacer l’objet à sa couche d’origine.

En changeant l’ordre de dépose d’un objet, il est possible que vous ne voyiez pas de changement

visible. C’est parce que la plupart des objets se situent aux couches 10–12 par défaut.
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Utiliser des couches pour rompre des liaisons sur les indications de mesure
L’une des applications utiles pour les ordres personnalisés, c’est de permettre que les liaisons sur

des notes ou accords liés rompent de chaque côté d’une indication de mesure, comme cela :

Pour accomplir cela, entrez simplement la musique normalement, puis :

* Choisissez Style maison > Modifier styles de texte

* Sélectionnez le style de texte Indications de mesure, puis cliquez sur Editer

* Dans la boîte de dialogue Style de texte système qui apparaît, allez à la page Bordure 

* Activez la case Effacer l’arrière-plan, cliquez sur OK, puis Fermer.

Les liaisons sont déposées en premier, puis l’indication de mesure avec son arrière-plan effacé, qui

“blanchit” les liaisons, et les lignes de portée sont finalement déposées en haut.

Graphiques importés
Par défaut, un graphique importé (créé via Créer > Graphique) sera établi à la 1ère couche, ce qui

signifie qu’il figurera derrière tous les autres objets. C’est normalement souhaitable car, autrement,

tout arrière-plan en blanc autour du rebord du graphique “blanchirait” les lignes de portée, notes,

etc. Vous pouvez néanmoins déplacer un graphique importé vers n’importe quelle couche, ce qui

peut mener à divers effets intéressants (et même utiles).
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5.15 Préférences

Les préférences sont des options qui s’appliquent à l’ensemble du programme, et non aux

partitions créées, et dont l’action est permanente tant qu’elles ne sont pas modifiées. Il s’agit par ex.

des réglages d’affichage, des raccourcis-claviers ou des menus contextuels de saisie rapide du texte.

Si plusieurs personnes utilisent Sibelius sur le même ordinateur, et sont identifiées chacune

comme utilisateur, elles conserveront leurs propres réglages à chaque ouverture de Sibelius.

La boîte de dialogue Fichier > Préférences (dans le menu Sibelius sur Mac; raccourci Ctrl+, ou

X,) contient tout un ensemble de préférences présentées par catégorie sur 16 pages.

Affichage
La page Affichage vous permet de régler divers aspects de la présentation :

* Les options dans Outil fenêtres sont traitées dans Fenêtres translucides à la page 442.

* Les réglages Panorama sont traités dans Espacement des notes dans Panorama et

Espacement des portées dans Panorama à la page 480.

* Afficher les numéros de mesure sur toutes les portées est décrit dans Noms des
portées et numéros de mesure à la page 518.

* Les options Barre d’outils sont couvertes dans Barre d’outils à la page 522.

* Les options Optimisation de l’affichage (exclusivement sous Windows) sont traitées à la

Optimisation de l’affichage à la page 441.

* Exécution de vidéo, également pour Windows exclusivement, est traité dans Windows
Media et QuickTime à la page 361.
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Fichiers
La page Fichiers gère comment Sibelius ouvre, sauvegarde et imprime les fichiers:

* Ouvrir avec la valeur de zoom détermine si Sibelius ouvre la partition avec le niveau de zoom

fixé ici ou avec le niveau de zoom utilisé quand la partition a été sauvegardée.

* À l’ouverture des partitions utiliser permet de choisir si Sibelius ouvre les partitions dans

Panorama (b 5.13 Panorama), en affichage normal, ou comme la dernière fois (par défaut).

* Pour la visualisation de page, utiliser vous permet de choisir la disposition de page par défaut

que Sibelius doit utiliser à l’ouverture d’une partition – cf. Pages à la page 518.

* Si la partition utilise la mise en page magnétique, utilisez-la aussi dans Panorama
détermine si Sibelius doit ou non utiliser Mise en page magnétique dans Panorama – cf. Mise
en page magnétique dans Panorama à la page 638.

* Quand Restaurer taille et positions de fenêtre est activé, Sibelius retiendra la taille et la

position de chaque fenêtre de partition (et partie dynamique) que vous ouvrez, et restaurera

chaque fenêtre à cette position quand vous rouvrez la partition (ou partie). Sous Windows,

Toujours ouvrir les partitions maximisées doit être désactivé pour que Sibelius restaure vos

positions de fenêtre.

* Ouvrir nouvelles fenêtres de partition à la largeur de page indique à Sibelius de créer de

nouvelles fenêtres de partition (et partie dynamique) à la largeur de la page. C’est utile si, par

exemple, vous avez un écran large: quand vous créez une nouvelle partition, Sibelius adaptera

simplement la fenêtre à la largeur de la première page de la partition, au lieu de la largeur de

votre affichage complet. A nouveau, sous Windows, Toujours ouvrir les partitions
maximisées doit être désactivé pour que cette option s’applique.

* Toujours ouvrir les partitions maximisées est une option exclusivement sous Windows,

activée par défaut, qui indique à Sibelius si toutes les fenêtres de partition doivent être ouvertes

maximisées (c.-à.-d. de la même largeur que la fenêtre de l’application Sibelius elle-même).
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Quand vous désactivez cette option, Sibelius ouvrira des partitions à leur taille préalablement

sauvegardée, ou une taille sauvegardée par défaut.

* Réparer associations de fichier est une option exclusivement sous Windows. Si vous possédez

plusieurs versions de Sibelius installées sur votre ordinateur, et découvrez que les partitions

s’ouvrent dans la mauvaise version lorsque vous double-cliquez dessus, ou qu’un autre

programme exécuté en même temps essaie de les ouvrir, cliquez sur Réparer pour restaurer

l’association par défaut des fichiers Sibelius.

* Activer la sauvegarde automatique contrôle la fonction de sauvegarde automatique de

Sibelius – Sauvegarde automatique à la page 715.

* Imprimer la date et l’heure en pied de page spécifie le contenu du pied de page en option qui

peut combiner la date du jour, celle de la dernière sauvegarde, le nom du fichier et celui de

l’utilisateur sur chaque page. Vous pouvez choisir une grande variété de formats de date et

d’heure et si Sibelius doit imprimer le nom de fichier ou le chemin entier – cf. Pied de page
avec la date et l’heure à la page 492.

* Taille de page par défaut vous permet de choisir si Sibelius doit utiliser Tailles européennes
(A4, A3, etc.) ou Tailles US (Lettre, Tabloïde, etc.) lors de la création de nouvelles partitions.

Sibelius définit cette option par défaut en fonction des paramètres régionaux sur votre

ordinateur, mais vous pouvez la modifier ici si vous le souhaitez.

Polices de substitution
Pour en savoir plus sur les Polices équivalentes, b 3.11 Polices de substitution.

Idées
Pour en savoir plus sur la page Idées, b 5.11 Idées.

Périphériques d’entrée
Pour la page Périphériques de saisie, b 1.10 Périphériques d’entrée.

Menus et raccourcis
Pour la page Menus et raccourcis, b 5.12 Menus et raccourcis.

Souris
La page Souris permet de choisir comment se comportera Sibelius lors de la saisie avec la souris:
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* Quand vous créez un objet détermine si Celui-ci apparaît près de la sélection en cours
(réglage recommandé) ou si vous Cliquez sur la souris pour le placer. Cette option est

destinée aux utilisateurs habitués de Sibelius 1.4 ou une version antérieure dans laquelle les

objets étaient toujours placés à la souris; cependant, dans cet ouvrage de référence il est admis

que cette option est toujours réglée par défaut (Celui-ci apparaît près de la sélection en
cours).

* Activer la copie avec la souris (Windows uniquement) contrôle si cliquer le bouton central, ou

les boutons de droite et de gauche ensemble, ou si la mollette de défilement équivaut à Alt+clic. 

* Pour déplacer le papier (plutôt que de créer une boîte de sélection) x est réglé par défaut

sur Déplacer, mais si vous préférez, vous pouvez choisir Tenir enfoncé Maj et déplacer (ou

Tenir enfoncé Commande et déplacer sur Mac).

* Afficher l’ombre des notes: détermine si les ombres des notes est affichée lors de la saisie des

notes – b 1.1 Saisie des notes

* Utiliser la 2e voix en cas de conflit rythmique: avec cette option activée, si vous faites la

saisie à la moitié de la valeur d’une note existante, Sibelius créera la nouvelle note en voix 2, sans

modifier la note existante seule; si vous la désactivez, Sibelius raccourcira la note existante

* Ajustement des positions: ces options contrôlent la manière dont les mesures sont divisées

lors de la saisie à la souris ou lors de la saisie de tablature de guitare:

% Positions rythmiques à ajuster sur: il s’agit de l’unité de division des mesures; le réglage

par défaut est la noire;

% Ajuster lors de la saisie des tablatures: quand cette option est activée, lors de la saisie des

tablatures taper 0/1 fait avancer la saisie dans la mesure selon l’unité spécifiée dans

Positions rythmiques à ajuster sur ; si l’option est désactivée taper 0/1 fait avancer de la

valeur choisie sur le pavé – cf. Saisie de tablature de guitare à la page 52

% Ajuster lors de la saisie des notes: quand cette option est activée, vous pouvez créer des

notes et des silences aux positions établies selon les unités spécifiées Positions rythmiques à

ajuster sur; si cette option est désactivée, vous pouvez seulement créer des notes/silences avec

la souris là où commencent des notes, des silences ou des mesures de silence.

Polices musicales
Pour en savoir plus sur la page Polices musicales, cf. b 8.11 Polices musicales.

Saisie des notes
Pour en savoir plus sur la page Saisie des notes, cf. Options pour la saisie des notes à la

page 13.

Coller en tant que réplique
Pour en savoir plus la page Coller en tant que réplique, cf. Préférences de coller une
réplique à la page 133.

Exécution
Pour en savoir plus sur la page Exécution, cf. Préférences d’exécution à la page 380.
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Position de la partition
La page Position de la partition permet de régler comment et quand se positionne la partition à

l’écran:

* Quand Suivre la sélection est activée, Sibelius vérifie que la sélection qui suit est toujours

visibles. En outre, vous pourrez activez ou désactivez les options suivantes:

% Pendant la saisie, suivre le curseur; si cette option est activée le curseur sera toujours
visible quand une note est entrée 

% Centrer la sélection impose le placement de la sélection au centre de l’écran à tout moment.
Quelques personnes préfèrent travailler avec cette option car elle permet de se focaliser au
milieu plutôt que sur les côtés. Cette option est particulièrement recommandée pour les
utilisateurs malvoyants.

% Éviter la fenêtre d’outils garantit que Sibelius n’essaiera pas de positionner la sélection en
cours sur une des fenêtres d’outil

% Afficher complètement la largeur du système garantit que durant la saisie des notes,
Sibelius règle l’affichage de manière à ce que tout le système soit visible. Si le système est plus
large que la largeur de l’affichage, Sibelius conserve la position horizontale de la partition.

% Afficher complètement la hauteur du système garantit que durant la saisie des notes,

Sibelius réglera l’affichage de manière à ce que tout la hauteur du système soit visible.

* Si vous préférez que Sibelius ne repositionne jamais la partition automatiquement, désactivez

Suivre la sélection. (Vous pouvez assigner un raccourci-clavier à cette option si vous voulez) –

b 5.12 Menus et raccourcis.)

* Sibelius suit la partition durant l’exécution avec une ligne verte qui affiche la position en cours.

Si vous souhaitez que Sibelius ne le fasse pas (par exemple pour économiser les ressources du

processeur), désactivez Suivre la ligne de lecture.

* Masquer les fenêtres des outils qui ne sont pas nécessaires est activé par défaut; toutes les

fenêtres excepté celles d’exécution, de vidéo, de Kontakt et du navigateur sont masquées durant

l’exécution quand cette option est activée

* Utiliser différents zooms permet de régler spécifiquement le niveau de zoom pour l’exécution,

indépendamment du niveau utilisé durant l’édition. Vous pouvez régler le niveau souhaité en

utilisant la liste de cette boîte de dialogue; sinon, si cette option est activée, vous pouvez le

changer durant l’exécution, et il deviendra le niveau utilisé par la suite lors de chaque exécution.
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* Déplacer n temps plus tôt permet de déterminer de combien de temps à l’avance le passage qui

suit la sélection est visible. Ceci est très pratique si vous utilisez Sibelius comme

accompagnateur, ou si vous lisez la partition avec attention et que voulez voir le passage de

musique avant que Sibelius ne le joue.

Textures
Pour en savoir plus sur la page Textures, cf. Textures à la page 440.

Versions
Par exemple, les options pour les Versions sont détaillées dans b 5.22 Versions.

Menus contextuels
Pour en savoir plus sur la page Menus contextuels, cf. Créer et modifier des menus
contextuels dans page 238.

Autres
La page Autres permet de changer diverses autres options:

* Réglettes détermine les unités de mesure utilisées par les réglettes – cf. Réglettes à la page
519

* Annuler permet de régler le nombre de changements apportés dans la partition dont doit se

souvenir Sibelius – b 5.21 Annuler et rétablir.

* Afficher les parties dans des nouvelles fenêtres permet de choisir si Sibelius ouvre les

parties dans la même fenêtre ou s’il crée une nouvelle fenêtre pour chaque partie – Afficher
plusieurs parties à la page 606.

* Les options du groupe Commentaires sont détaillées dans Changer le nom d’utilisateur
affiché sur un commentaire à la page 438.

* Les options du groupe Symboles d’accord sont détaillées dans Saisie de symbole d’accord
Legacy à la page 126.



5.15 Préférences

489

O
utils 

* Afficher tous les messages rétablit tous les messages d’avertissement supprimés– cf.

Messages d’avertissement ci-dessous.

* Coller des images dans d’autres programmes permet de choisir si Sibelius exportera des

images dans le presse-papiers en Monochrome, et quelle sera la résolution de l’image qui peut

être modifiée dans Points par pouce – b 9.8 Exporter des images.

* Les options dans le groupe Coller les paroles dans le presse-papiers détermine si Sibelius

divise automatiquement en syllabes les paroles collées dans la partition – b 3.3 Paroles.

* Les options sous Lors du démarrage contrôle si au démarrage, un court extrait musical est joué,

si la boîte de dialogue Fichier > Démarrage rapide apparaît automatiquement, et si tous les 90

jours Sibelius doit vérifier les mises à jour.

* Si vous exécutez une copie de licence de site réseau de Sibelius sous Windows, vous verrez un

autre bouton, Définir les préférences globales. Cela permet à votre administrateur réseau ou

administrateur système, ou encore à vous-même de définir les préférences actuelles comme

préférences globales pour tous les utilisateurs qui se connectent à cet ordinateur. C’est utile si

votre politique de réseau interdit aux comptes d’utilisateur limités d’écrire des données sur le

Registre Windows ou d’autres zones similaires, mais que vous souhaitez tout de même appliquer

un certain ensemble de préférences par défaut pour les utilisateurs de votre ordinateur. Veuillez

vous reporter au guide d’utilisateur Sibelius de Licence Server pour en savoir plus.

Messages d’avertissement
S’ils vous énervent, les messages qui apparaissent en cours d’utilisation de Sibelius peuvent être

supprimés en activant Ne plus afficher ceci.

Si subitement vous ne savez plus utiliser Sibelius et que vous voulez revoir ces messages, cliquez

sur Afficher tous les messages. Par cette action, tous les messages supprimés vont réapparaître.
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5.16 Imprimer

Pour obtenir des informations détaillées sur les formats de papier standard ainsi que quelques

conseils sur les dimensions de page et de portées à utiliser, b 8.6 Paramètres du document.

Si votre objectif est la production de nombreuses partitions de haute qualité, b 8.18 Édition.

Régler le format du papier
Avant toute impression dans Sibelius, il convient de vérifier si le pilote de l’imprimante est réglé

pour utiliser le format de papier exact. Sur Mac, chaque programme de l’ordinateur conserve son

propre format par défaut, si bien qu’il suffit de s’assurer que le format exact est bien celui qui est

réglé dans la boîte de dialogue Fichier > Mise en page.

Sous Windows, vous pouvez changer le format de papier via la boîte de dialogue de Sibelius

Fichier > Imprimer mais cela n’affecte que les documents imprimés dans Sibelius et uniquement

pendant la durée de la session de travail. Au prochain lancement de Sibelius, le format du papier

est réglé sur celui par défaut défini par le pilote de l’imprimante. Il faut donc s’assurer que ces

réglages par défaut sont corrects. voici comment procéder :

* Sous Windows XP : 

% Choisissez Démarrer > Imprimantes et télécopieurs

% Sélectionnez l’imprimante par défaut, puis choisissez Fichier > Options d’impression

% Dans la boîte de dialogue du pilote de l’imprimante, cliquez sur le panneau Mise en page,

puis cliquez sur Avancée (dans le coin inférieur de la boîte de dialogue)

% Choisissez le format de papier par défaut, puis cliquez sur OK deux fois pour confirmer les

changements.

* Sous Windows Vista :

% Choisissez Démarrer > Panneau de configuration, puis cliquez sur Imprimantes

% Faites un clic-droit sur l’icône de l’imprimante et choisissez Sélectionner les préférences
d’impression

% Dans la boîte de dialogue du pilote de l’imprimante, cliquez sur le panneau Mise en page,

puis cliquez sur Avancée (dans le coin inférieur de la boîte de dialogue)

% Choisissez le format de papier par défaut, puis cliquez sur OK deux fois pour confirmer les

changements.

Imprimer
Choisissez Fichier > Imprimer (raccourci Ctrl+P ou XP). Une boîte de dialogue standard

Imprimer apparaît proposant quelques options supplémentaires.

* Sous Windows, si plus d’une imprimante est connectée à l’ordinateur, celle que l’on souhaite uti-

liser se choisit dans la liste déroulante au sommet de la boîte de dialogue. On peut en modifier

les options spécifiques du pilote en cliquant sur Propriétés.

* Sur Mac, choisissez la page d’options Sibelius pour afficher une boîte de dialogue contenant les

options pour imprimer en livret, en vis-à-vis, etc... Vous pouvez également définir quelles pages

imprimer sur la page Copies & Pages de la boîte de dialogue.
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Réglez les options d’impression décrites ci-dessous selon la nécessité, puis cliquez sur OK (Win-

dows) ou Imprimer (Mac) pour lancer l’impression.

Astuce : sous Windows vous pouvez imprimer les fichiers Sibelius sans lancer Sibelius: faites un

clic-droit sur l’icône du fichier et choisissez Imprimer dans le menu contextuel qui apparaît.

Les options de la boîte de dialogue Fichier > Imprimer sont les suivantes. À moins qu’il n’en soit

spécifié autrement, les options se trouvent sur la boîte de dialogue principale Fichier > Imprimer
sous Windows, ou dans la page Sibelius de la boîte de dialogue Fichier > Imprimer sur Mac

Étendue de pages
Si vous ne souhaitez pas imprimer la partition entière, vous pouvez spécifier une liste de pages à

imprimer (par ex.1, 3, 8), et / ou une étendue de pages (par ex. 5-9), qui peut être à l’envers pour

imprimer dans l’ordre inverse (par ex. 9-5).

Les numéros de page que vous spécifiez ne sont pas nécessairement les numéros de page affichés

dans la partition si y figurent des changements de numéros de page. Il faut donc se référer au pages

physiques de la partition : si vous voulez imprimez la seconde, la troisième et la quatrième page de

la partition, même si elles sont numérotées ii, iii et iv, vous devez tapez 2-4 dans le cadre de

contrôle Pages. b 3.6 Numéros de page.

Copies et copies assemblées
Par défaut, un exemplaire sera imprimé, mais vous pouvez définir n’importe quelle autre quantité

dans le cadre Copies (à la page Copies & Pages sur Mac). Plusieurs exemplaires de chaque page

sont imprimés l’un après l’autre, si donc vous choisissez deux exemplaires, les pages sortiront selon

l’ordre 1, 1, 2, 2, 3, 3, etc.

Cependant, si vous cochez Copies assemblées, chaque exemplaire de la partition sera assemblé

correctement, et les pages sortiront donc selon l’ordre 1, 2, 3, 4... 1, 2, 3, 4.... Cela évite d’avoir à

trier les pages soi-même, mais sur une imprimante laser l’impression peut durer plus longtemps.

Certains pilotes d’imprimante Windows comportent des bugs empêchant l’option Copies assem-
blées de fonctionner correctement. Si votre pilote d’imprimante ne gère pas correctement la copie

assemblée, Sibelius vous conseillera d’essayer d’obtenir des pilotes mis à jour pour votre impri-

mante, et vous propose d’imprimer quand même. Si Sibelius détecte un problème avec l’assistance

à la copie assemblée pour votre imprimante, il fera de son mieux pour que les pages s’impriment

tout de même dans le bon ordre, mais ce n’est pas toujours possible.

Bordure
Cette option imprime une fine bordure autour de la page. Lorsque vous imprimez sur du papier de

grande taille, cela rend les pages plus faciles à lire, et plus facile à massicoter que de simples

marques de coupe. C’est également très utile pour la correction d’épreuves réduites à par ex. 65%,

avec Bordure et Vis-à-vis (cf. ci-dessous) activés.

Marques de coupe
Ce sont les petits réticules utilisés dans l’édition professionnelle pour indiquer les coins de page.

Les marques de coupe sont nécessaires car les livres sont imprimés sur du papier sur-dimensionné

massicoté ensuite à la taille requise.
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Les marques de coupes ne sont utiles que lorsque vous imprimez sur du papier plus grand que le

format de page de votre partition.

Options du menu affichage
Ceci permet d’imprimer les options activées dans le menu Affichage, tels que les surlignages, les

objets masqués et les notes en couleur – b 5.23 Menu affichage pour en savoir plus sur ces

options.

Imprimer en couleur
En activant cette option, Sibelius imprimera tous les objets en couleur d’une partition (ou en gris si

vous possédez une imprimante noir & blanc). Les couleurs de toutes les images qui se trouvent

dans la partition seront aussi imprimées. Si l’option est désactivée, les objets en couleur seront

imprimés en noir.

Pied de page avec la date et l’heure
Sibelius imprimera les pieds de page avec la date et l’heure sur chaque page de la partition si

l’option est activée. L’intérêt est de pouvoir identifier les différentes version d’une partition. Pour en

savoir plus sur le paramétrage et la personnalisation de ce pied de page, b 5.15 Préférences.

Ajuster au papier
Ceci réduit la taille de la partition à l’échelle si nécessaire, de façon à ce que toute la musique tienne

à l’intérieur des marges d’impression de la page et à éviter que les bords de la musique ne soient

coupés. Cela est particulièrement utile pour imprimer des partitions au format Lettre sur du papier

A4 (et vice-versa) ou pour réduire des partitions au format A3 / Tabloïde sur du papier Lettre / A4.

Par contre Ajuster au papier n’augmente pas la taille de la musique afin de remplir le papier si

celui si est plus grand que le format de la page.

Les formats de papier US tels que Lettre et Tabloïde n’ayant pas exactement la même forme, les

marges de page peuvent donner un résultat différent de ce à quoi vous vous attendiez. Un tel pro-

blème ne se pose pas avec les formats de papier européens.

Cette option ajuste automatiquement le réglage de l’Échelle (cf. plus bas), donc si vous avez coché

Ajuster au papier, vous ne devriez plus modifier le réglage de l’Échelle vous-même.

Échelle
N’importe quel pourcentage peut être utilisé, même si normalement les partitions s’impriment à

100%. Pour réduire la partition de manière à l’imprimer sur du papier plus petit, activez Ajuster
au papier plutôt que de procéder vous-même au réglage de l’échelle.

Options de remplacement
Ces options peuvent d’une part apporter une solution aux problèmes d’impression qui surviennent

parfois, et d’autre part améliorer la vitesse et la qualité d’impression. Prenez le temps de les tester

pour découvrir si différentes combinaisons de ces options sont bénéfiques.

Les options sont les suivantes :

* Lignes : certains pilotes d’imprimante sont incapables d’imprimer les lignes des portées de

manière régulière et parfois n’arrivent même pas à les imprimer ; d’autres pilotes impriment les
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lignes telles que les barres de mesure et les hampes avec des extrémités arrondies plutôt que

plates. Quelques imprimantes PostScript affichent des erreurs de “mémoire insuffisante” quand

plusieurs pages sont imprimées en même temps. Activer cette option peut résoudre certains pro-

blèmes et augmenter la vitesse d’impression, mais peut diminuer légèrement la régularité de

l’épaisseur des lignes de portée.

* Accolades : quelques pilotes impriment les accolades soit à un mauvais endroit, soit avec le

mauvais symbole. Désactivez cette option si ces problèmes se présentent.

* Arpèges, gliss., etc. : quelques pilotes d’imprimantes sous Windows ont un bogue qui leur fait

imprimer les textes en oblique et les lignes ondulées des glissandos et des arpèges, soit de

manière erronée, soit au mauvais endroit ; si ces problèmes se présentent, activez cette option.

* Symboles (Windows uniquement): cette option affecte le rendu des polices de symboles utili-

sées par exemple pour les notes, les indications de mesure, les clefs et d’autres symboles. Font

partie des polices de symboles, Opus, Reprise, Inkpen2, Opus Percussion, Opus Special, etc...,

ainsi que des polices telles que Symbol, Wingdings, et d’autres polices de type fantaisie. Si cette

fonction est mal réglée pour l’imprimante, les polices de symboles peuvent ne pas s’afficher ou

ne pas s’imprimer du tout. Voici les options possibles :

% Par défaut : Sibelius utilise par défaut l’encodage ANSI pour toutes les polices de symboles

% Automatique : Sibelius détecte si les polices de symboles sont au format TrueType ou Post-

Script (Type 1) et adapte l’impression en fonction ; c’est le réglage par défaut sur Windows

% PostScript : Sibelius considère que toutes les polices sont au format PostScript (Type 1)

% TrueType : Sibelius considère que toutes les polices de symboles sont au format TrueType.

Impression recto-verso
Pour imprimer une partition en recto-verso :

* Sous Format, sélectionnez Normal et Impaires. Imprimez la partition. Seules les pages

impaires (c’est-à-dire de droite) seront imprimées.

* Introduisez à nouveau les pages dans l’imprimante, éventuellement face vers le haut (en fonction

de la méthode d’alimentation du papier de votre imprimante). Si la première page de la partition

est paire - c’est-à-dire si c’est une page de gauche - vous devriez introduire une page vierge sup-

plémentaire au début, puisque la première page ne devrait rien avoir d’imprimé au recto.

* Sélectionnez maintenant Paires. Imprimez la partition à nouveau afin d’imprimer les pages

paires (de gauche) au dos des pages impaires.

Si les pages sortent de votre imprimante face vers le bas, vous aurez peut-être à renverser l’ordre

des pages avant d’imprimer le second côté, ou inversement à imprimer le second côté dans l’ordre

opposé (en entrant une étendue de page inversée, telle que 8-1). Vous aurez à faire quelques essais

car ceci varie d’une imprimante à l’autre.

Les imprimantes laser ont tendance à faire légèrement gondoler le papier lors de l’impression. Cela

peut provoquer des problèmes d’alimentation du papier quand il est replacé afin d’imprimer sur

l’autre face. Le problème sera réduit si vous laisser reposer le papier pendant une heure après avoir

imprimé la première face, ou si vous alimentez l’imprimante manuellement pour le second côté (ce

qui est une vraie corvée). Certains problèmes d’alimentation du papier sont également causés par



5. Outils puissants

494

de l’électricité statique résiduelle provenant de l’effet corona utilisé par la plupart des imprimantes

laser ; ce problème peut être réduit en “feuilletant” le papier avant de l’introduire à nouveau.

Vis-à-vis
Ceci imprime deux pages consécutives côte à côte sur chaque feuille de

papier, et les pages impaires sont toujours imprimées à droite du papier.

Ce format se prête bien à la correction d’épreuve.

Lorsque Vis-à-vis est sélectionné :

* assurez-vous que le papier est d’un format deux fois supérieur à celui

des pages dans Sibelius (par ex. Tabloïde / A3 pour Lettre / A4) ; ou

* utilisez le même format de page que la taille du papier mais réduisez

l’Échelle en conséquence, par ex. imprimez des pages au format Lettre

/ A4 à 68% sur du papier Lettre / A4.

Imprimez ensuite normalement, en utilisant les autres options telles que

Bordure.

2-Up
Cette option est identique à vis-à-vis, excepté que la première page spécifiée est imprimée à

gauche.

Livret
Un “livret” est un petit livre formé de feuilles imprimées en recto-verso agrafées au centre.

Les livrets sont imprimés avec les pages en vis-à-vis sur des feuilles deux fois plus grandes que

celles utilisées au tirage définitif.

Pour qu’un livret assemblé soit fonctionnel, la numérotation des pages imprimées sur les feuilles

peut sembler étrange. Par exemple, la feuille la plus extérieure doit recevoir les pages 16 et 1 en vis-

à-vis au recto et les pages 2 et 15 au verso. Fort heureusement Sibelius réalise automatiquement

cette procédure de mise en page, connue sous le nom “d’imposition”.

Pour imprimer un livret, il faut soit :

* utiliser du papier dont la dimension est deux fois plus grande que celle définie dans Sibelius

pour la partition à imprimer (par exemple du papier A3 pour des pages A4), ou

* utiliser un format de papier identique à celui défini pour les pages et réduire l’Echelle propor-

tionnellement, à 70% par exemple pour imprimer deux pages A4 sur du papier A4.

Ensuite :

* Cliquez sur Livret et Pages extérieures

* Imprimez normalement. Une face du papier sera imprimée.

* Cliquez sur Pages intérieures

* insérez papier dans l’imprimante, et imprimez à nouveau pour faire l’autre côté.

Comme pour l’impression recto-verso ordinaire, si les pages sortent de votre imprimante face vers

le bas vous aurez peut-être à inverser leur ordre avant d’imprimer le second côté, ou inversement à

1

2 3

4 5

6

1 2

3 4

5 6

Vis-à-vis 2- up

Différence entre les 

vis-à-vis et “2-up” 

sur un document de 

six pages :
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imprimer l’autre côté dans l’ordre opposé (en entrant un étendue de page inversée telle que 8-1).

Vous aurez à faire quelques essais car ceci varie d’une imprimante à l’autre.

Vous pouvez, lorsque vous imprimez des livrets, utiliser toutes les autres options, par ex. Pages,

Marques de coupe, Impaires et Paires, etc... Copies assemblées est particulièrement utile

pour produire une pile d’exemplaires que vous n’avez plus qu’à plier.

Sibelius assume que la première page du livret est numérotée 1, même si la première page de votre

partition ne l’est pas. Par conséquent si votre partition commence à la page 2, elle apparaîtra

comme page intérieure gauche du livret, et non comme la page qui précède. Cela permet de laisser

la première page blanche si on veut ajouter une couverture spéciale produite dans un autre logiciel.

Lors de l’impression des Pages extérieures Sibelius imprime d’abord la double-page contenant la

page 1, puis 3, 5, 7, etc. De la même manière, lors de l’impression des Pages intérieures, Sibelius

commence avec la double-page contenant la page 2 puis 4, 6, etc.

L’ordre d’impression d’un livret de 8 pages par exemple est le suivant :

* Pages extérieures : 1 & 8 (ensembles, la page 1 à droite), 3 & 6

* Pages intérieures : 2 & 7, 4 & 5.

Notez également que l’addition des deux numéros de page adjacents sur une feuille donne toujours

le nombre total de pages (arrondi à un multiple de quatre) plus ; dans le cas ci-dessus, 9.

Si vous souhaitez imprimer une double-page spécifique d’un livret - par ex. les pages 8 & 1 d’un

livret de 7 pages - spécifiez simplement l’une des pages (par ex. page 1) et Sibelius imprimera la

page appropriée à côté.

Imprimer plusieurs partitions ou plusieurs parties en une fois
Pour imprimer plusieurs fichiers en une fois (par exemple un dossier complet) utilisez l’extension

Imprimer des copies multiples ; b 6.1 Travailler avec des extensions. Pour imprimer des

parties multiples, utilisez Fichier > Imprimer toutes les parties pour les imprimer toutes, ou le

bouton Imprimer des partie(s) dans la fenêtre des parties pour imprimer les parties sélection-

nées ; b 7.1 Travailler avec des parties séparées.

Choisir un papier de qualité
Investir dans du papier de très bonne qualité peut améliorer radicalement le niveau de vos impres-

sions. Un papier de qualité doit être d’un blanc lumineux, très opaque pour éviter tout effet de

transparence et suffisamment rigide pour ne pas tomber d’un pupitre. Évitez le papier léger ordi-

naire pour machine à écrire ou photocopieur – un papier de 100 gr. est recommandé.

Problèmes avec les marges
Certaines imprimantes peuvent couper les bords des partitions, en particulier le bord inférieur.

Cela est du au fait qu’elles ont besoin d’une partie de la feuille pour accrocher le papier.

Une solution à ce problème est d’éloigner la musique du bord inférieur en augmentant les marges

de la page dans Mise en page > Paramètres du document (raccourci Ctrl+D ou XD).

Si seul le bas de la page est coupé et que modifier la mise en page est difficile, pour l’éviter il suffit

de réduire la marge supérieure de par ex. 5mm et d’augmenter la marge inférieure de 5mm, de
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façon à faire remonter légèrement la musique sur la page. Sinon, utilisez Verrouiller la mise en
forme avant d’ajuster les marges (b 8.1 Mise en page et mise en forme).

Problèmes lors de l’impression recto-verso
Si le recto-verso entraîne des bourrages sur votre imprimante, voici quelques pistes pour y remé-

dier :

* Laissez le papier refroidir un moment après l’impression de la première face

* Utilisez l’introduction manuelle

* Ouvrez le volet extérieur de l’imprimante (s’il existe), par lequel le chargement se fait plus à plat.

Si des bandes de toner apparaissent sur le premier côté quand le second est imprimé :

* Laissez le papier refroidir un moment après l’impression de la première face

* S’il existe des réglages pour charger le papier plus vite (comme c’est le cas avec les résolutions

inférieures), essayez-les pour imprimer la seconde face.
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5.17 Propriétés

Utilisateurs avertis uniquement 

Presque tous les objets d’une partition ont des propriétés qui peuvent être éditées via la Fenêtre >

Propriétés (raccourci Ctrl+Alt+P ou zXP).

Par exemple, la police et la taille d’un objet texte peuvent être modifiés depuis le panneau Texte de

la fenêtre des propriétés; la position horizontale d’une note peut être changée depuis le panneau

Général; et ainsi de suite.

En général, ces propriétés sont plus facilement attribuées lors de la création de l’objet, mais il arrive

qu’il faille les modifier par la suite. De nombreuses propriétés peuvent aussi être affichées ou

modifiées depuis les menus, ou à l’aide de raccourcis.

Afficher les propriétés
Par défaut, la fenêtre des propriétés n’apparaît pas à l’écran, parce qu’il n’est pas nécessaire d’en

ajuster les réglages. Si vous l’utilisez beaucoup, c’est que vous êtes très exigeant !

Vous pouvez afficher la fenêtre des propriétés (et par la suite la faire disparaître à nouveau) en

choisissant Fenêtre > Propriétés (raccourci Ctrl+Alt+P ou zXP). Vous pouvez déplacer cette

fenêtre n’importe où sur l’écran en la tirant par sa barre de titre.

Le titre de la fenêtre des propriétés reflète la sélection courante; si rien n’est sélectionné, il sera

indiqué “Pas de sélection”; si le titre ou les marques de tempo sont sélectionnés dans un morceau,

il sera indiqué “Modifier Texte”; si une note est sélectionnée, il sera indiqué “Modifier Note”; si un

passage est sélectionné, il sera indiqué “Modifier Passage”; si le signe d’omission est visible, il sera

indiqué “Créer des Notes/Silences”; et plutôt que d’essayer de lister tous les éléments dans une

sélection multiple, il indiquera simplement “Modifier Sélection Multiple”.

En cas de sélection multiple ou de passage sélectionné, seules les propriétés communes à tous les

objets sélectionnés seront affichées. Par exemple, si vous sélectionnez deux notes, dont une seule

porte un accent, le bouton d’accent sur le pavé ne sera pas éclairé. Si vous cliquez sur le bouton

d’accent, les deux notes termineront par un accent, et le bouton d’accent s’allumera.

Pour ouvrir et fermer chacun des six panneaux, cliquez sur la barre de titre appropriée. Chaque

panneau peut s’ouvrir de façon indépendante, ou en combinaison avec d’autres. Si trop de pan-

neaux sont ouverts en même temps et qu’ils ne peuvent tous être affichés sur l’écran, Sibelius va

fermer automatiquement un ou plusieurs panneaux pour en laisser d’autres visibles à l’écran.

Les options de chaque panneau sont détaillées plus bas.
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Le panneau Général
Le panneau Général de la fenêtre des propriétés permet de changer la

position, etc. de(s) l’objet(s) sélectionné(s), de le(s) masquer si néces-

saire et indique sur quelle portée et sur quelle mesure il(s) se

trouve(nt).

Les options de ce panneau sont les suivantes :

* La première ligne du panneau indique le nom de la portée à laquelle

l’objet est attaché (ou du “système” pour les objets de système)

* Page x de y indique sur quelle page de la partition est faite la sélec-

tion

* Mesure et Position indique la mesure et la position rythmique dans la mesure à laquelle l’objet

est attaché. La lecture de Position se fait toujours en noire en fonction de l’indication de mesure;

pour les lignes et multiplets, Sibelius se base sur la position à gauche; si aucune position n’est

fixée, l’objet sera attaché au début de la mesure. Vous pouvez éditer ces paramètres directement,

en bougeant simplement l’objet avec la souris ou les touches à flèches.

* Afficher et Masquer etc... détermine si l’objet est masqué ou non; b 5.9 Masquer des
objets.

* X vous indique le déplacement horizontal de l’objet depuis la position à laquelle il est attaché.

(Par exemple, la fin d’un soufflet peut être attachée à une note, même s’il est placé légèrement à

droite ou à gauche de celle-ci.)

Cette valeur est particulièrement utile pour positionner des notes, des silences et des accords en

dehors de l’alignement lorsque vous utilisez deux ou plusieurs voix, ou pour déplacer des

marques de répétitions d’une mesure.

* Y peut signifier différentes choses selon les objets. Pour les notes et les accords, cette valeur

détermine la longueur des hampes. Pour les lignes et les textes, il s’agira de la distance au-dessus

de la position verticale.

* Echelle n% consiste à échelonner les diagrammes d’accord individuels et tablatures de guitare ;

cf. Modifier les dimensions des diagrammes d’accord à la page 121.

* Utiliser mise en page magnétique indique si l’objet sélectionné est défini pour utiliser la mise

en page magnétique; cf. Ne pas tenir compte de l’anti-collision à la page 635.

* Ordre personnalisé indique si l’objet sélectionné adopte une position personnalisée dans

l’ordre de dépose ; b 5.14 Ordre.

* Retourner permet de changer l’orientation des hampes des notes sélectionnées, et retourne cer-

tains objets au-dessus ou en-dessous des notes, comme les liaisons de phrasé, les accolades de

multiplets, les articulations et la courbure des liaisons rythmiques. Pour retourner un objet, utili-

sez cette option ou choisissez Edition > Retourner (X), plutôt que d’utiliser la souris.

* Taille de note de réplique permet de mettre en taille de note de réplique les notes, les lignes,

les symboles et les objets textuels de portée sélectionnés, tout comme le fait le bouton (F8) du

deuxième pavé; b 2.12 Répliques.
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Le panneau Texte
Le panneau Texte permet de modifier le style du texte sélectionné, sa

police, sa taille et aussi d’indiquer s’il est en gras, souligné ou italique.

Les options sont les suivantes :

* Le premier menu déroulant affiche le style du texte sélectionné; chan-

gez de style simplement en en sélectionnant un autre dans le menu.

Vous devez aussi choisir des styles compatibles; vous ne pouvez pas modifier un texte système

(par exemple un texte de tempo) en un texte de portée (par exemple un texte d’expression).

b 3.1 Utiliser du texte pour en savoir plus.

* Le second menu affiche la police du texte sélectionné; changez de police en en sélectionnant une

autre depuis le menu. Pour changer la police (ou la taille) de tous les textes dans ce style en une

fois, b 3.9 Modifier les styles de texte.

* Taille est la taille de la police (en points)

* B, I et S déterminent si le texte sélectionné est en gras, en italique ou souligné. Les raccourcis

sont Ctrl+B/I/U ou XB/I/U.

Le panneau Exécution
Le panneau Exécution permet d’ajuster l’exécution de lignes et modifie

les réglages de répétitions de jeu. Les options sont les suivantes :

* Jouer lors de la répétition : les cases de contrôle, numérotées de 1 à

8, déterminent si le texte, la ligne ou la note sélectionnée doit être

exécuté lors d’une répétition donnée à travers un passage –

b 4.6 Reprises pour en savoir plus

* Passer à la fin de la mesure est utilisé pour les répétitions qui pren-

nent effet au milieu d’une mesure – b 4.6 Reprises pour en savoir

plus

* Sauter à la fin de la mesure consiste à appliquer des sauts de répé-

tition au milieu d’une mesure – b 4.6 Reprises pour en savoir plus

* Vélocité (enreg.), Pos. départ (enreg.) et Durée (enreg.) sont les

trois paramètres d’une note qui peuvent être modifiés lorsque vous

utilisez Exécution enregistrée – b 4.8 Exécution enregistrée

* Point d’orgue vous permet de modifier la durée des points d’orgue

(pauses) – b 4.2 Interprétation de la partition.

* Gliss./Rit./Accel. permet de modifier l’effet du jeu de ces types de lignes –

b 4.2 Interprétation de la partition.

* Soufflet : on peut en régler la nuance finale, ou le pourcentage de changement dans la nuance

d’un soufflet sélectionné. Par défaut, le réglage Auto permet à Sibelius de le faire à votre place.

b 4.2 Interprétation de la partition.

* Trille permet de choisir si l’exécution est Diatonique ou non; si vous voulez régler l’intervalle

vous-même, désactivez Diatonique, puis choisissez l’intervalle Demi-tons, la Vitesse (en

notes par seconde), et si l’exécution doit Commencer sur la note supérieure du trille

sélectionné. Par défaut, Sibelius exécute les trilles avec quelques irrégularités rythmiques afin de
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donner plus de réalisme – si vous n’aimez pas cet effet, activez l’option Jouer strictement.

b 4.2 Interprétation de la partition.

* Tremolo permet de déterminer si Sibelius doit jouer un trémolo d’une note ou un roulement (“z

sur la hampe”). Si votre périphérique de lecture joue des trémolos via des échantillons spéci-

fiques, désactivez ceci pour éviter que Sibelius ne les joue lui-même.

Panneau Lignes
Le panneau Lignes permet de changer les propriétés d’une liaison de

phrasé sélectionnée.

Fin contrôle les décalages horizontaux (X) et verticaux (Y) de l’extré-

mité droite de la liaison.

Courbe de liaison gauche, Courbe de liaison droite et Epaisseur
de liaison s’appliquent uniquement aux liaisons – b 2.28 Liaisons
de phrasé.

Ouverture de terminaison des soufflets et Ouverture de contin-
uation des soufflets s’appliquent uniquement aux soufflets –

b 2.17 Soufflets.

Le panneau Mesure
Pour modifier les propriétés d’une mesure, sélectionnez la mesure, qui

s’entourera d’un cadre bleu, ou la barre de mesure à la fin de la mesure,

et modifiez dans le panneau Mesures les options suivantes :

* Crochets/Barre de mesure initiale/Clefs/Armures détermine la

position, au début de la mesure lorsque la mesure est au début d’un

système ou après un espace dans un système “divisé” comme une

coda ou une portée incipit).

* Diviser les mesures de comptage oblige cette barre de mesure à

scinder une barre de silence vide – b 2.24 Mesures de
comptage pour en savoir plus

* Fin de section spécifie que la barre de mesure est la fin d’une section et que les noms des instru-

ment s’afficheront au début de la suivante dans le format choisi dans la boîte de dialogue Style
maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE). Vous pouvez aussi installer un

saut de système ou de page à cet endroit.

* Le menu déroulant affiche quels sauts affectent la barre de mesure ; vous pourrez donc ajouter

ou enlever un saut de système ou de page à la barre de mesure sélectionnée. Cela peut se faire

depuis le sous-menu Mise en page > Saut (ou en utilisant les raccourcis). Ignorez Milieu de
système/page, qui sont utilisés par Verrouiller le Format, Garder les barres ensembles et

Mettre en Système/Page.

* Espace avant la mesure altère le retrait avant la mesure sélectionnée au début d’un système ou

installe un espace pour créer un système scindé avant une coda.



5.17 Propriétés

501

O
utils 

Le panneau Notes
Le panneau Notes permet de modifier les têtes des notes sélection-

nées, d’altérer la position horizontale des altérations, et d’ajuster la

position et la forme des liaisons rythmiques. Pour ajuster une altéra-

tion ou une liaison rythmique depuis ce panneau, vous devez sélec-

tionner sa note (pas l’altération/la liaison elle-même). Les options sont

les suivantes :

* Le menu situé au-dessus du panneau montre la tête de note sélec-

tionnée; pour modifier cette tête, choisissez-la depuis le menu

déroulant. Pour changer les têtes en utilisant le clavier, maintenez

Maj+Alt ou xz et tapez le numéro de la tête sur le clavier –

b 2.25 Têtes de note.

* Altération : X contrôle le décalage horizontal de l’altération attachée à la note sélectionnée. Les

valeurs positives bougent l’altération vers la droite, les négatives vers la gauche. Vous pouvez

aussi bouger les altérations en les sélectionnant et en tapant Alt+0/1 ou z0/1.

* Silence : Y contrôle la position verticale des silences sélectionnés. Vous pouvez également

déplacer un silence en saisissant 3/2 (avec Ctrl ou X pour de plus grands incréments).

* Cambrure de la liaison : % contrôle l’incurvation de la liaison (la première note liée étant préa-

lablement sélectionnée). Une valeur élevée produit des extrémités plates, tandis que qu’une

valeur basse produit une forme en boomerang. Cliquez sur Déf (pour défaut) pour rétablir la

cambrure à sa valeur d’origine selon le réglage de la page Liaisons rythmiques1 de la boîte de

dialogue Style maison > Règles de gravure, ce qui peut s’avérer utile si le boomerang ne

revient pas – b 2.32 Liaisons rythmiques.

* Milieu de liaison : Y contrôle la hauteur au milieu de la liaison (la première note liée étant pré-

alablement sélectionnée). Vous pouvez aussi l’ajuster en sélectionnant la liaison et en tapant

3/2.

* Fin de liaison : Y contrôle la position verticale de l’extrémité droite de la liaison attachée à la

note sélectionnée. L et R contrôlent la position horizontale des extrémités gauches et droites de

la liaison respectivement. On peut aussi ajuster en sélectionnant la liaison et en tapant

Maj+Alt+0/1 ou xz0/1.

* Multiplet permet de changer l’apparence du multiplet sélectionné, par exemple en décidant si le

crochet est affiché ou non, et où l’extrémité droite du crochet doit terminer. b 2.35 Triolets
et autres multiplets pour en savoir plus.

* Inverser les ligatures divisées permet d’inverser une ligature secondaire divisée, Inverser
les ligatures divisées à la page 107.
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5.18 SibeliusEducation.com

b 5.19 SibeliusMusic.com, 5.25 Créateur d’exercices.

SibeliusEducation.com est un site web dédié au chargement de ressources d’enseignement et

d’apprentissage, partagées entre tous les enseignants du monde entier.

À qui est-ce destiné?
Il s’agit d’un moyen facile pour vous et vos étudiants d’accéder à des feuilles d’exercices et à des

ressources via Internet. Cela permet de simplifier votre organisation, vous évite d’imprimer ou de

photocopier des paquets de feuilles d’exercices et vos étudiants ne risquent plus de perdre les

travaux qu’ils ont réalisés.

Parce que les partitions sont affichées avec Scorch, vos étudiants peuvent exécuter la partition

pour entendre comment elle sonne, ce qui est beaucoup plus stimulant qu’une feuille de papier.

De plus, s’ils utilisent Sibelius (à l’école) ou Sibelius Student (à la maison), ils peuvent charger et

continuer le travail sur leur ordinateur.

Fonctions
Au fur et à mesure que SibeliusEducation.com grandit nous y ajoutons de plus en plus de

fonctions; d’ores et déjà vous pouvez:

* Assembler des feuilles d’exercices et du matériel pédagogique comme vous l’entendez

* Proposer à vos étudiants les travaux que vous leur avez préparés et qu’ils peuvent visualiser,

imprimer et télécharger. Il peuvent soit le faire sur papier, ou s’ils utilisent Sibelius (à l’école) ou

Sibelius Student (à la maison), ils peuvent charger et continuer le travail sur leur ordinateur et le

rendre terminé en le replaçant sur le site

* Accéder à des matériaux didactiques produits par d’autres enseignants et d’autres écoles
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* Discuter avec d’autres enseignants du monde entier pour échanger des informations et des idées

* Obtenir des ressources supplémentaires et des informations de Sibelius Software, telles que des

feuilles d’exercices et des vidéos sur lesquelles composer

* Obtenir des ressources provenant de la gamme des produits Sibelius Educational Suite.

Toutes les informations figurent sur le site web.

Les services sur SibeliusEducation.com
Pour s’inscrire sur SibeliusEducation.com, il suffit de choisir Aide > SibeliusEducation.com, ou

visitez www.sibeliuseducation.com. En créant un compte vous pouvez bénéficier de services

supplémentaires tel que poster des messages sur le forum et déposer des feuilles d’exercices sur le

site.

Publier des feuilles d’exercices sur SibeliusEducation.com
* Dès que vous avez créé votre feuille d’exercices, sauvegardez-la sur le disque

* Si vos étudiants peuvent ouvrir le fichier avec une version antérieure de Sibelius ou de Sibelius

Student, choisissez Fichier > Exporter > Sibelius 2, 3 or 4 ou Fichier > Exporter > Sibelius
Student pour sauvegarder le fichier

* Choisissez Fichier > Publier sur SibeliusEducation.com, pour que votre navigateur se rende

sur le site, inscrivez-vous et rendez-vous sur la section My work du site. (pour cela il est

indispensable d’être inscrit.)

* Suivez les instructions à l’écran pour déposer votre fichier sur le site dans l’espace des feuilles

d’exercices.

SibeliusMusic.com
SibeliusMusic.com propose des milliers de partitions créées par des compositeurs, des arrangeurs,

des enseignants et des étudiants. Vous pouvez y trouvez des partitions utiles pour l’enseignement.

On peut les visualiser et les exécuter gratuitement. Un bon nombre d’entre elles peuvent être

imprimées gratuitement et certaines peuvent s’acheter. b 5.19 SibeliusMusic.com pour en

savoir plus.

http://www.sibeliuseducation.com/
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5.19 SibeliusMusic.com

b 5.18 SibeliusEducation.com, 9.11 Exporter des pages Web Scorch.

Internet est le medium idéal pour donner à votre musique une audience mondiale pour un coût

minimum. Sibelius est le seul programme au monde permettant à chacun de voir, d’exécuter, de

transposer et d’imprimer des partitions sur Internet.

Les compositeurs, les arrangeurs et tout personne intéressée peut éditer sur notre site web d’auto-

édition SibeliusMusic.com – que ce soit pour les morceaux de piano, les partitions d’orchestre, la

musique ancienne ou d’avant-garde et le rock & pop. Outre que c’est entièrement gratuit, vous

pouvez gagner de l’argent si vous voulez vendre vos partitions (plutôt que de les proposer

gratuitement); vous recevrez un taux très avantageux de 50% du prix!

Scorch
Sibelius Scorch est une surprenante extension gratuite pour navigateur web qui permet à tout un

chacun de voir, d’exécuter, de modifier la tonalité ou les instruments et même d’imprimer des

partitions directement à partir d’Internet, même sans posséder Sibelius.

Les visiteurs de votre site seront automatiquement conviés à télécharger Scorch, et en quelques

minutes ils pourront voir et entendre les partitions de votre site et de centaines d’autres, y compris

les sites de grands éditeurs tels que www.sheetmusicdirect.com (rock/pop/chansons) et

www.boosey.com (musique classique/éducation musicale).

Pour en savoir plus pour installer Scorch, voyez Installer Sibelius dans la section

Introduction du Manuel. Scorch ne s’installe automatiquement qu’avec Internet Explorer sous

Windows, mais il fonctionne avec d’autres navigateurs, y compris Firefox et Opera, tant sur

Windows que sur Mac.

Réglages recommandés
Pour que votre partition ait la meilleure apparence et le meilleur son possible lorsque d’autres

personnes la visualisent, voici ce qu’il faut en standardiser avant de la publier sur Internet:

Contrôles de la lecture et curseur de tempo (Windows uniquement).

Cliquez sur Lecture pour démarrer l’exécution ou cliquez n’importe 

où dans la partition pour démarrer la lecture à partir de ce point.

Tourner les 

pages

Choisir l’instrument MIDI 

à utiliser pour l’exécution

Sauvegarder 

la partition 

sur le disque*

Imprimer la 

partition*

Changer l’instrument 

principal*
Informations et mises à 

jour de Scorch

Modifier la tonalité*

* option indisponible dans certaines partitions

La barre d’outils de Scorch
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* les polices - toutes les polices ne sont pas disponibles sur tous les ordinateurs

* le format du papier -l’impression doit être acceptable sur différents types de papier

* les paramètres d’Exécution - doivent correspondre aux capacités de base des ordinateurs

courants

Limitez les polices utilisées pour le texte aux plus courantes, telles que Times, Times New Roman,

Arial et Helvetica (même si Scorch substitue des polices équivalentes à celles que vous avez

utilisées dans le cas où la personne qui visualise votre page web ne les possède pas). Assurez-vous

également que les seules polices musicales que vous utilisez sont les polices standards de Sibelius,

Opus et Inkpen2, car celles-ci seront disponibles sur tout ordinateur sur lequel Scorch est installé.

Lorsque vous préparez vos partitions pour leur publication sur SibeliusMusic.com avec possibilité

d’impression, utilisez de préférence l’orientation portrait et un format de papier standard (par ex.

Lettre, Tabloïde, A4 ou A3). Scorch réduira ou agrandira la musique à la taille du papier.

Gardez à l’esprit qu’une partition qui sonne bien avec votre carte-son ou avec votre périphérique

MIDI peut moins bien sonner sur d’autres ordinateurs. Vérifiez préalablement comment sonne

votre partition avec des sons General MIDI standards, pour avoir une idée du résultat avec Scorch.

Publier sur SibeliusMusic.com
Pour commencer, ouvrez le fichier Sibelius que vous souhaitez publier en ligne, puis choisissez

Fichier > Publier en ligne sur SibeliusMusic.com .

* Si vous n’avez pas sauvegardé le fichier récemment, il vous sera demandé de le faire;

sauvegardez-le, puis cliquez sur Publier à nouveau sur SibeliusMusic.com

* Votre navigateur web ouvrira et affichera un page web dans laquelle vous pourrez spécifier les

informations de base à propos de votre partition, comme son titre (ceci sera rempli

automatiquement si vous l’avez entré préalablement dans la boîte de dialogue Fichier >

Nouveau ou Fichier > Informations sur la partition)

* Localisez sur votre disque dur la partition que vous souhaitez publier en ligne - cliquez sur

Parcourir pour rechercher la partition

* Lorsque vous l’aurez trouvée, cliquez sur Suivant. Votre ordinateur se connectera ensuite à

Internet et transférera votre partition sur SibeliusMusic.com.

* D’autres informations à votre sujet et sur votre partition vous seront encore demandées - suivez

simplement les instructions à l’écran.

SibeliusMusic.com ne publie que des partitions dont vous avez l’entièreté des droits de

reproduction, c’est-à-dire des compositions originales ou des arrangements dont le copyright est

expiré. Il est interdit de publier des transcriptions ou des arrangements de musique dont vous

n’avez pas le copyright, des transcriptions ou éditions littérales de musique hors copyright, ou des

partitions avec paroles protégées par le droit d’auteur dont vous n’avez pas d’autorisation de

reproduction. Pour en savoir plus sur les restrictions liées aux droits de reproduction, visitez

www.sibeliusmusic.com.

Si vous rencontrez le moindre problème ou si vous avez des questions à propos de l’auto-édition

sur SibeliusMusic.com, envoyez un courriel à info@sibeliusmusic.com.
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5.20 Transposition

Pour en savoir plus sur les instruments transpositeurs et les partitions transposées,

b 2.18 Instruments et portées.

Pour en savoir plus sur la manière de simplifier les armures et l’écriture enharmonique,

b 2.20 Armure.

Boîte de dialogue Transposition
Pour transposer:

* Sélectionnez ce que vous souhaitez transposer, un passage ou une partition complète (raccourci

Ctrl+A ou XA)

* Choisissez Notes > Transposition (raccourci Maj-T)

* Choisissez si vous voulez transposer par Tonalité ou par Intervalle

* Si vous choisissez de transposer par Tonalité:

% Choisissez la tonalité à transposer dans le menu

% Décidez si Sibelius transpose selon vers la tonalité la plus proche (Voisine), ou Ascendante
ou Descendante.

* Si vous choisissez de transposer par Intervalle:

% Cliquez sur Ascendant ou Descendant.

% Dans le second cadre, choisissez l’intervalle.

% Dans le premier cadre, Majeur / parfait ne modifie pas l’intervalle, Augmenté ajoute un

demi-ton, Mineur/Diminué enlève un demi-ton.

% Diatonique déplace les notes dans la gamme spécifiée par l’armure en cours ; donc

transposer d’une seconde diatonique transforme la troisième note de la gamme en quatrième,

transforme la quinte diminuée en sixte diminuée, etc.

* Régler les deux autres options si nécessaire:

% Transposer les armures (disponible uniquement pour une sélection de système ou pour la

partition entière) transpose également toute armure ou changement d’armure dans le pas-
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sage sélectionné. En principe cette option doit rester activée. Si elle est désactivée, les notes

transposées reçoivent les altérations qui autrement auraient été spécifiées par l’armure.

% Si Transposer les armures est activé, vous pouvez aussi activez Changer la tonalité du
début, ce qui créera une nouvelle armure au début du passage transposé si nécessaire.

% Si vous voulez que Sibelius crée un changement de tonalité pour restaurer la tonalité originale

à la fin du passage transposé, activez Autoriser la conservation des changements de
tonalités.

% Utiliser les double dièses / bémol indique à Sibelius d’utiliser des double dièses et des

double bémols plutôt que des bécarres dans les tonalités éloignées. Désactivez cette option

pour la musique atonale. Laissez-la si vous êtes un Rachmaninov, ou un Alban Berg en pleine

jeunesse.

* Cliquez sur OK, et Sibelius transpose instantanément.

Déplacer sans altérations
Pour déplacer des notes dont vous ne souhaitez pas qu’elles se retrouvent avec des altérations,

sélectionnez-les simplement et tapez 2/3 une ou plusieurs fois.

Transposer d’une ou de plusieurs octaves
La méthode la plus rapide consiste à sélectionner le passage et à taper Ctrl+3/2 ou X3/2.

Transposition de plus de deux octaves
Pour une question de concision, la boîte de dialogue Notes > Transposition (raccourci Maj-T)

propose des intervalles de maximum deux octaves. Pour utiliser des intervalles plus grands, trans-

posez d’abord du nombre d’octaves nécessaires puis tapez Ctrl+3/2 ou X3/2 avant ou après

avoir réalisé la transposition dans la boîte de dialogue.

Transposition d’un demi-ton
Même si la plupart des transpositions sont évidentes, celle-ci mérite une petite explication: on sou-

haite, par exemple, qu’une partition en Ré majeur soit transposée en Ré mineur. Si on utilise une

transposition de seconde mineure descendante, on obtiendra Do # majeur; c’est donc une transpo-

sition descendante d’un unisson augmenté qu’il convient d’utiliser.

Transpositions extrêmes
Pour réaliser des transpositions extrêmes non proposées dans la boîte de dialogue, par exemple Si

en ré bémol (soit une tierce doublement augmentée), procédez en deux étapes; d’abord transposez

d’une tierce mineure jusqu’à Ré, puis descendez d’un unisson augmenté vers Ré bémol.

Les symboles d’accord
Ceux-ci se transposent automatiquement.

Déplacement des autres objets
Lors de la transposition, Sibelius déplace d’autres objets comme bon lui semble. Par exemple, les

liaisons rythmiques et de phrasé se déplaceront en fonction des notes. Si la transposition est

importante, de nombreuses hampes changeront de direction et certaines liaisons de phrasé

devront être inversées avec Édition > Retourner (raccourci X) pour être à la bonne place
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5.21 Annuler et rétablir

Annuler
Cliquez sur le bouton figurant à gauche ou choisissez Édition > Annuler (raccourci

Ctrl+Z ou XZ) pour annuler la dernière action réalisée.

Le menu Édition indique la dernière action réalisée dans le cas où vous auriez la

mémoire courte. (Évidemment, il s’agit de la dernière action réalisée dans Sibelius, donc on n’y

trouvera pas Annuler Éternuement même si c’est plus amusant.)

Annuler fonctionne par niveaux; il est possible d’annuler quasi toutes les opérations réalisées pré-

cédemment. Édition > Historique des annulations (cf. ci-dessous) permet de revenir à une étape

antérieure précise.

Rétablir
Rétablir annule l’annulation (ou plutôt, Rétablir rétablit ce qui a été annulé). Pour réta-

blir une opération qui ne devait pas être annulée, cliquez sur le bouton montré ci-contre

ou choisissez Édition > Rétablir (raccourci Ctrl+Y ou XY).

 De nouveau, le menu Édition indiquera ce qui vient d’être annulé.

Histoire des annulations
Le menu Édition > Historique des annulations (raccourci Ctrl+Shift+Z ou xXZ) énumère

toutes vos opérations récentes, et vous permet de revenir à une étape antérieure précise.

La dernière opération est en haut de la liste, il suffit de cliquer dessus pour l’annuler, de même que

pour chacune des opérations réalisées précédemment. Le nombre d’opérations que l’historique des

annulations peut mémoriser est paramétrable; cf. Niveau des annulations ci-dessous.

Historique de rétablissements
Édition > Historique des rétablissements (raccourci Ctrl+Shift+Y ou xXY) est identique à

l’Historique des Annulations, mais énumère tout ce qui a été rétabli après annulation.

La dernière opération annulée est au-dessus de la liste (comme pour l’Historique des rétablisse-
ments). En cliquant dessus on rétablit d’un niveau (donc seule cette dernière opération est réta-

blie); en cliquant sur la deuxième opération énumérée deux niveaux sont rétablis (donc cette

opération ainsi que la première); si on clique sur la dernière tous les niveaux sont rétablis et on est

ramené à son point de départ. (Est-ce clair?)

Niveau des annulations
Pour établir le nombre d’annulations possibles, ouvrez la page Autre de Fichier > Préférences
(dans le menu Sibelius sur Mac OS X) et faites glisser le curseur jusqu’à la valeur désirée. Vous

pouvez annuler jusqu’à 10.000 opérations, un niveau tel que vous pourriez certainement revenir à

l’état initial de la partition au moment de son ouverture.

Aucun problème donc pour tout annuler, et même remonter au moment où vous n’aviez pas

encore Sibelius (et par la même occasion en annuler l’achat!).
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5.22 Versions

Lorsque vous travaillez sur un projet déterminé à long terme, assurer le suivi de votre progression

peut s’avérer problématique dans la plupart des logiciels. En règle générale, vous devez retenir de

choisir Fichier > Enregistrer sous pour enregistrer chaque brouillon de votre travail sous un nom

de fichier différent. Heureusement, Sibelius vous permet d’enregistrer plusieurs versions de votre

partition dans le même document, de sorte que les versions plus anciennes ne peuvent pas être

perdues, mal placées ou confondues avec la version actuelle.

Vous pouvez ajouter des commentaires à chaque version, qui feront office de rappels du travail que

vous avez effectué ou restant à effectuer, exporter une version plus anciennne en partition séparée,

voire comparer deux versions pour obtenir une liste détaillée de toutes les différences entre

versions.

Enregistrer automatiquement une nouvelle version
Par défaut, Sibelius vous rappellera de créer une nouvelle version quand vous fermez une partition

après l’avoir éditée sur une certaine durée. Par défaut, voici la boîte de dialogue qui s’affiche :

Vous pouvez changer le Nom de version fourni à votre gré : le nom que Sibelius vous propose

inclut un numéro de version, et la date et l’heure auxquelles la version a été commencée. Vous

pouvez également intégrer un Commentaire, aussi court ou long que vous le souhaitez. Ce

commentaire ne figure pas dans la partition comme les commentaires à “bulle”

(b 5.5 Commentaires), et cette fonction est utile pour écrire un commentaire général sur

votre progression, au lieu d’éléments spécifiques mieux adaptés pour être joints à une mesure

déterminée.

Cliquez sur OK pour enregistrer votre version, et fermez la partition ; si vous cliquez sur Annuler,

vous aurez néanmoins l’occasion d’enregistrer votre partition sans créer de nouvelle version.

Si vous préférez ne pas être invité à créer une version à la fermeture de votre partition, désactivez

Créer une nouvelle partition à la fermeture de la partition sur la page Versions de Fichier >

Préférences (dans le menu Sibelius sur Mac).

Enregistrer manuellement une nouvelle version
Vous pouvez bien entendu enregistrer une nouvelle version à tout moment : choisissez

simplement Fichier > Enregistrer version, ou cliquez sur le bouton de la barre d’outils

affiché à droite. Le bouton n’est activé qu’après avoir enregistré votre partition une fois et

attribué un nom de fichier.
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Quand vous enregistrez une nouvelle version, vous serez invité à fournir un nom et, par défaut, un

commentaire (voir ci-dessus). Si vous préférez ne pas fournir de commentaire, choisissez Fichier >

Préférences (dans le menu Sibelius sur Mac) et allez à la page Versions. Dans le groupe

Commentaires, vous pouvez choisir trois options :

* Ne pas proposer de commentaires : se limite à revoir le nom que Sibelius a choisi par défaut

pour votre version ; aucun espace n’est prévu pour saisir un commentaire.

* Proposer un commentaire optionnel : réglage par défaut, cela vous permet de saisir un

commentaire si vous le souhaitez, mais vous pouvez enregistrer une version sans fournir de

commentaire si vous le préférez.

* Solliciter un commentaire : vous devrez saisir un commentaire quelconque avant de pouvoir

enregistrer une nouvelle version. C’est un réglage utile si vous enseignez avec Sibelius en classe et

que vous souhaitez vous assurer que les étudiants fournissent un commentaire avant de mettre

fin à leur projet pour la journée.

Si vous enseignez avec Sibelius en cours, vous pouvez inviter un ou plusieurs étudiants en classe

pour enregistrer une nouvelle version à tout moment via la boîte de dialogue Classroom Control
– b 5.3 Classroom Control.

Visualiser des versions
Vous pouvez visualiser les versions enregistrées dans votre version via

le menu déroulant sur la barre d’outils indiquée à droite. (si ces

contrôles ne figurent pas sur votre barre d’outils, la résolution d’écran

de votre ordinateur est trop basse – voir Barre d’outils à la page

522.)

La version actuelle de votre partition s’appelle toujours Version actuelle, et figure toujours en

haut de la liste dans le menu : la version la plus ancienne est référencée en bas, et la version la plus

récente juste en dessous de Version actuelle.

Vous pouvez également visualiser des versions en choisissant Version suivante ou Version
précédente dans le sous-menu Fichier > Versions. (si vous le faites souvent, il vous sera

certainement utile d’attribuer des raccourcis clavier vers ces éléments de menu.)

Lorsque vous choisissez une autre version dans la liste, ou que vous choisissez une autre version

dans le sous-menu Fichier > Versions, Sibelius ouvre une nouvelle fenêtre, et attribue à la partition

un arrière-plan de papier chiffonné, pour vous rappeler qu’il s’agit d’une ancienne version. (Si vous

souhaitez changer les textures que Sibelius utilise pour visualiser des versions, voir Textures à la

page 440.)

Par défaut, Sibelius réutilise la fenêtre affichant la version précédemment visualisée. Si vous

préférez que Sibelius crée une fenêtre séparée pour chaque version, parce que vous voulez peut-

être les étaler sur grand écran, activez Affichage des versions dans de nouvelles fenêtres sur la

page Versions de Fichier > Préférences (dans le menu Sibelius sur Mac).
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Ce que vous pouvez faire avec les versions
Seule la version actuelle de votre partition est éditable. Par conséquent, lorsque vous avez réalisé

une version, vous ne pouvez plus apporter de changements à cette ancienne version. Lorsque vous

visualisez une version, cependant, vous pouvez réaliser de nombreuses choses utiles, dont la

lecture, l’impression voire copier de la musique et des objets sur le presse-papiers pour pouvoir les

coller dans votre version actuelle, ou une autre partition.

Pour copier à partir d’une ancienne version, effectuez simplement une sélection comme pour une

autre partition, puis choisissez Editer > Copier (raccourci Ctrl+C ou XC) pour copier vers le

presse-papiers. Puis passez à la version actuelle ou à l’autre partition vers laquelle vous souhaitez

coller le contenu, et choisissez Editer > Coller (raccourci Ctrl+V ou XV). Vous ne pouvez pas

utiliser Alt+clic (ou accord-clic) pour copier à partir d’une ancienne version.

Vous pouvez aussi comparer une version avec une autre – voir Comparer des versions ci-

dessous.

Modifier des versions
Vous pouvez réaliser de nombreuses taches de gestion de fichier importantes sur les

versions dans votre partition via la boîte de dialogue Fichier > Versions > Modifier
versions, que vous pouvez également ouvrir à l’aide du bouton de la barre d’outils affiché à

droite.

Le tableau à gauche de la boîte de dialogue recense les versions dans la partition. Vous pouvez

choisir de trier par Nom, la date à laquelle la version a été Démarrée, ou la date à laquelle la

version a été Complétée. A droite figure un aperçu indiquant la version sélectionnée. Vous pouvez

parcourir les pages de la version sélectionnée via les boutons situés sous l’aperçu.

Sous le tableau figure une liste de tous les commentaires enregistrés dans la version sélectionnée,

dont les commentaires à “bulle”, et tout commentaire fourni lorsque la version a été créée.
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Vous pouvez Ajouter, Editer et Supprimer des commentaires ici en cliquant sur le bouton

approprié.

Les boutons situés entre le tableau de versions et l’aperçu de la version sélectionnée sont les

suivants :

* Nouveau crée une nouvelle version, ce qui équivaut à choisir Fichier > Enregistrer version.

* Renommer renomme la version sélectionnée

* Visualiser ferme la boîte de dialogue Modifier versions et ouvre une fenêtre pour visualiser la

version sélectionnée.

* Actualiser vous permet de réaliser une version sélectionnée dans la version actuelle. Une

nouvelle version est automatiquement créée pour enregistrer l’état de la version actuelle, et la

version sélectionnée est ensuite réalisée dans la nouvelle version actuelle.

* Exporter comme partition exporte la version sélectionnée sous une partition séparée,

contenant seulement une version unique. Vous pouvez sélectionner Version actuelle et cliquer

sur Exporter comme partition pour effectuer rapidement une copie de l’état actuel de votre

partition sans inclure l’une des anciennes versions.

* Supprimer supprime la version sélectionnée, après un avertissement.

* Exporter journal exporte un fichier Rich Text Format (RTF) répertoriant les différences entre

chaque version, tous les commentaires associés, et un graphique de chaque page– voir Exporter
un journal de versions ci-dessous.

Cliquez sur Fermer pour fermer la boîte de dialogue Modifier versions.

Exporter un journal de versions
Sibelius peut exporter un fichier Rich Text Format (RTF) incluant :

* Une liste des différences entre chaque paire de versions

* Tous les commentaires enregistrés dans chaque version

* Une diapo graphique de chaque page de chaque version, avec les différences signalées en

couleur.

Ce fichier peut être ouvert dans n’importe quel traitement de texte et de nombreux éditeurs de

texte, bien que les diapos graphiques de chaque page puissent apparaître dans certaines versions

de certains traitements de texte, ex. Microsoft Word 2002 ou supérieur pour Windows, et

Microsoft Word 2008 ou supérieur pour Mac SE X.
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Pour exporter un journal de versions, choisissez Fichier > Versions > Modifier versions,

sélectionnez une version, et cliquez sur Exporter journal. Une boîte de dialogue apparaît :

Dans la liste à gauche, vous pouvez choisir les versions à inclure ; par défaut, toutes les versions

sont sélectionnées. Voici les options à droite de la liste :

* Inclure commentaires détermine si les commentaires (à “bulle” joints à certaines mesures et

les commentaires créés lors de l’enregistrement d’une nouvelle version ou dans la boîte de

dialogue Modifier versions) doivent ou non être inclus dans le fichier RTF. Activée par défaut,

cette option est appréciée par beaucoup de graveurs et d’éditeurs.

* Inclure différences détermine le niveau de détail des listes de différences entre chaque

version : Toutes les différences inclut à la fois un résumé des différences (ex. “Transposition de

toute la partition, notes ajoutées dans quatre mesures”) et un tableau répertoriant chaque

différence en détail, mesure par mesure ; Simple résumé seulement exclut le tableau et ne

procure qu’un résumé des différences ; Aucun exclut toutes les informations sur les différences

entre l’ensemble des versions. Le réglage par défaut est Toutes les différences.

* Inclure graphique de chaque page détermine si le fichier RTF doit inclure un graphique de

chaque page pour chaque version. Selon la longueur de votre partition ou le nombre de versions,

vous souhaiterez peut-être le désactiver : générer des graphiques pour chaque page peut exiger

du temps, et rend le fichier RTF résultant bien plus grand. Si vous décidez d’inclure des

graphiques, choisissez entre Ajuster à la page, qui adaptera une page individuelle de chaque

version à une seule page du fichier RTF, ou 4 et plus, qui ajustera quatre pages de chaque

version à une seule page du fichier RTF. Activez Afficher différences dans partition pour

référencer les différences entre les versions en affichant des couleurs derrière les objets ayant été

ajoutés, modifiés ou supprimés dans les graphiques de chaque page.

Sibelius procure un nom de fichier par défaut, et propose d’enregistrer le fichier RTF au même

emplacement que la partition, mais vous pouvez changer ces deux éléments si vous le souhaitez.

Une fois satisfait de ces choix, cliquez sur OK pour créer le journal de version. Une barre de

progression apparaît lors du déroulement.
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Par défaut, l’option Ouvrir le fichier dans l’éditeur RTF par défaut après l’enregistrement est

activée, et lance l’application par défaut pour traiter les fichiers RTF une fois que le fichier a été

exporté ; sous Windows, ce sera WordPad par défaut, et TextEdit sur Mac. Si vous disposez d’un

traitement de texte plus perfectionné installé sur votre ordinateur, comme Microsoft Word,

envisagez de l’établir comme application par défaut pour ouvrir des fichiers RTF sur votre

ordinateur.

Comparer des versions
Sibelius propose un moyen simple de comparer deux versions de la même partition, et de voir les

différences entre ces dernières sous forme de liste tabulée, et visuellement affichées dans les

partitions elles-mêmes.

Pour comparer deux versions, choisissez Fenêtre > Comparer (raccourci Ctrl+Alt+C ou

zXC), ou cliquez sur le bouton de la barre d’outils affiché à droite. Voici la fenêtre qui

apparaît :

Choisissez la version la plus récente dans la première liste, étiquetée Comparer, et l’ordre des deux

versions dans la seconde liste, étiquetée Avec, puis cliquez sur le bouton .

Une barre de progression lorsque les deux versions sont comparées ; après quelques secondes, la

version la plus ancienne s’affiche dans une fenêtre à gauche, et la version la plus récente est

indiquée dans une fenêtre à droite, étalée à la verticale. Si vous préférez que Sibelius n’étale pas les

deux fenêtre à la verticale, rendez vous à la page Versions de Fichier > Péférences (dans le menu

Sibelius sur Mac) et désactivez Etaler les fenêtres lors de la comparaison des versions.

Une fenêtre intitulée Résumé des différences apparaît alors. Cela vous donne un aperçu

minutieux des changements entre deux versions : par exemple, vous apercevrez peut-être une

ligne “Paroles ajoutées à 82 mesures”, ou “Expression ajoutée à 40 mesures”. Cliquez sur Fermer
pour supprimer cette fenêtre. Si vous préférez ne pas le voir, désactivez Afficher un simple
résumé des différences dans Préférences.

La fenêtre Comparer recense une liste détaillée de toutes les différences entre les deux versions :

* Nouvelles mesures recense le numéro de mesure ou la plage de numéros de mesure dans la

partition choisie dans le menu déroulant Comparer où la différence est détectée.
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* Anciennes mesures recense le numéro de mesure ou la plage de numéros de mesure dans la

partition choisie dans le menu Avec qui correspond aux numéros de mesure indiqués dans

Nouvelles mesures. (elles peuvent être identiques ou non, cela dépend du fait que les mesures

aient été insérées ou supprimées).

* Portées recense la ou les portées concernées par la différence. Si la différence concerne toutes

les portées (ex. ajout ou suppression de mesures), il indiquera Toutes ; sinon, il indiquera le

nom de la portée.

* Différences répertorie la nature de la différence détectée. Ce qui figure dans cette colonne

dépend entièrement des différences décelées : voir Que compare Sibelius ci-dessous.

Par défaut, l’affiche du tableau est trié par la colonne Nouvelles mesures, dans l’ordre ascendant,

mais vous pouvez modifier le tri du tableau en cliquant sur l’un des intitulés de colonne.

Lorsque vous double-cliquez sur un élément dans la liste, Sibelius déplace l’affichage dans les deux

fenêtres de partition pour afficher les mesures appropriées. Sibelius tient compte du fait que les

objets aient ou non été ajoutés, modifiés ou supprimés, comme suit :

* Les objets qui ont été ajoutés dans la version la plus récente sont affichés avec un arrière-plan

vert dans la version plus récente.

* Les objets qui ont été modifiés dans la version la plus récente sont affichés avec un arrière-plan

orange dans les versions plus ancienne et plus récente.

* Les objets qui ont été supprimés dans la version la plus récente sont affichés avec un arrière-plan

rouge dans la version plus ancienne.

Si vous ne souhaitez pas voir les différences visuellement dans la partition, désactivez

Affichage > Différences entre versions, ou cliquez sur le bouton dans la barre d’outils en

bas de la fenêtre Comparer indiquée à droite.

Vous pouvez également exporter la liste des différences comme indiqué dans la fenêtre

Comparer sous un fichier Rich Text Format (RTF). Cliquez simplement sur le bouton

Enregistrer différences dans la barre d’outils en bas de la fenêtre Comparer, comme indiqué à

gauche. Vous serez invité à procurer un nom de fichier, et un fichier RTF, pouvant être ouvert dans

n’importe quel éditeur RTF comme WordPad, TextEdit, ou Microsoft Word, est enregistré.

Que compare Sibelius
Sibelius ne conserve pas un suivi de chaque édition individuelle apportée à votre partition entre

versions : au lieu de cela, il compare les deux versions et fait de son mieux pour analyser les

changements rencontrés. En raison de cette approche heuristique, il peut exister plus d’une

manière de caractériser une différence spécifique entre deux versions.

Sibelius ne relève pas les diférences dans la mise en page, la mise en forme, l’espacement des notes

ou la configuration de document : il ne s’occupe que du contenu musical des partitions comparées

et pas de leur apparence.
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Les types d’objets suivants sont pris en compte lors de la comparaison des versions :

* Instruments et portées : si le nombre de portées est différent, Sibelius établit quelles portées ont

été ajoutées ou supprimées ; si un instrument qui était présent dans l’ancienne version ne l’est

plus dans la version plus récente, Sibelius examine le contenu de chaque portée pour établir si

l’utilisateur a changé un instrument contre un autre, ou en a supprimé un et ajouté un autre.

* Mesures : si le nombre de mesures est différent, Sibelius établit où des mesures ont été ajoutées

ou supprimées.

* Notes : Sibelius détermine si des notes ont été ajoutées ou supprimées, et si la hauteur de note et/

ou le rythme a été changé ; il fait la distinction entre changements individuels de hauteur de note

et transposition diatonique ou chromatique.

* Articulations : si les notes dans une mesure données sont au moins 80% similaires, Sibelius

compare les articulations sur les notes, et rapporte les ajouts, changements ou suppressions.

* Transposition : si de la musique a été transposée, Sibelius rapporte la plage de mesures

concernée, et l’intervalle auquel la musique a été transposée.

* Symboles d’accord : Sibelius rapporte si des symboles d’accord ont été ajoutés, modifiés ou

supprimés.

* Dynamiques : si les notes dans une mesure donnée sont au moins 50% similaires, Sibelius

compare le texte Expression et les soufflets dans cette mesure, et rapporte si des dynamiques ont

été ajoutées, modifiées ou supprimées.

* Texte de portée : si du texte dans un style de texte de portée autre qu’Expression ou l’un des styles

de texte de parole a été ajouté, modifié ou supprimé dans une mesure, Sibelius le signale.

* Texte de système : si du texte dans un style de texte de système autre que Tempo, repère de

Métronome ou modulation Métrique a été ajouté, modifié ou supprimé dans une mesure,

Sibelius le signale.

* Repères de tempo : Sibelius signale si des repères de tempo ont été ajoutés, modifiés, déplacés ou

suprimés.

* Paroles : si les notes dans une mesure donnée sont au moins 50% similaires, Sibelius compare les

paroles dans cette mesure, et rapporte si elles ont été ajoutées, modifiées ou supprimées.

* Lignes : si les notes dans une mesure donnée sont au moins 80% similaires, Sibelius compare les

liaisons de phrasé, trilles, lignes de pédale, lignes de glissando/portamento, lignes d’arpeggio et

lignes d’octave dans cette mesure, et signale s’ils ont été ajoutés, modifiés ou supprimés.

* Clefs : si les notes dans une mesure donnée sont au moins 50% similaires, Sibelius compare tout

changement de clef dans cette mesure.

* Lignes de mesure : Sibelius signale si des lignes de mesure spéciales (ex. lignes de mesure doubles

ou répétées) ont été ajoutées, modifiées ou supprimées.

* Armures : Sibelius compare l’armure initiale et les changements de clé ultérieurs, et signale s’ils

ont été ajoutés, modifiés ou supprimés.

* Changements d’instrument : Sibelius signale si des changements d’instrument ont été ajoutés,

modifiés ou supprimés.
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* Symboles : si les notes dans une mesure donnée sont au moins 80% similaires, Sibelius compare

des symboles de portée dans cette mesure ; il compare des symboles de système (ex. signes coda

et segno) dans toutes les mesures indépendamment de leur similitude.

* Commentaires : Sibelius compare les commentaires dans les deux versions ou partitions, en

notant s’ils ont été ajoutés, modifiés ou supprimés.

Comparer deux partitions séparées
La fenêtre Comparer peut également servir à comparer deux partitions séparées. Ouvrez

simplement les deux partitions que vous souhaitez comparer, choisissez la partition la plus récente

dans le menu déroulant Comparer et la plus ancienne dans le menu déroulant Avec, et cliquez sur

le bouton .

Il existe aussi une extension pouvant comparer deux portées de la même partition : voir

Comparer les portées à la page 547.
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5.23 Menu affichage

b 5.6 Paramètres d’affichage, 5.24 Fenêtre (menu).

Le menu Affichage propose différentes options pour contrôler l’affichage des partitions et de

l’interface de Sibelius.

Il est possible d’imprimer les options du menu Affichage dans une partition (par exemple des

commentaires, les objets masqués en grisé, tout ce qui est surligné en jaune, et les indications de

mise en page en bleu) – b 5.16 Imprimer.

Pages
Le sous-menu Affichage > Pages comporte des options permettant de déterminer comment

Sibelius doit traiter la mise en page de votre partition à l’écran:

* Vis-à-vis horizontal est le réglage par défaut, avec les pages traitées de gauche à droite en

vis-à-vis.

* Pages individuelles horizontalement traite les pages individuelles de gauche à droite.

Cela s’avère utile pour la musique qui n’est normalement pas présentée sous forme de livret ou

de vis-à-vis, par ex. les parties pliées en éventail où la première page peut être numérotée 1 mais

n’est pas la page à droite d’un vis-à-vis.

* Vis-à-vis vertical traite les paires de pages verticalement, par ex. les pages 2 et 3 sont disposées

côte à côte, avec les pages 4 et 5 en dessous.

* Pages individuelles verticalement traite les pages de votre partition en une seule colonne,

avec la page 2 en dessous de la page 1, la page 3 en dessous de la page 2, etc.

Sibelius sauvegarde le réglage Affichage > Pages pour chaque partition (et chaque partie

dynamique), et restaurera votre réglage lors de la réouverture de la partition (ou de la partie). Vous

pouvez changer ce comportement sur la page Fichiers de Fichier > Préférences (dans le menu

Sibelius sous Mac) – b 5.15 Préférences.

Panorama
Cette option affiche la partition sous forme d’un système continu sur une page de largeur infinie.

b 5.13 Panorama.

Portée en vue ciblée
Cette option affiche uniquement les portées sélectionnées, en masquant toutes les autres. C’est très

utile lors de la saisie et de l’édition (particulièrement en conjonction avec Panorama) et pour

masquer des portées lors d’une exécution. b 5.8 Portées en vue ciblée.

Noms des portées et numéros de mesure
Quand on utilise une valeur de zoom élevée dans les partitions pour grands ensembles, il est très

utile d’être informé du nom de la portée et du numéro de la mesure en cours pour éviter de devoir

effectuer de fréquents déplacements au début du système.
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Cette option affiche les numéros de mesure en bleu au dessus de chaque mesure de la portée

supérieure visible de chaque système ainsi que le nom de l’instrument à gauche de l’écran.

Si vous préférez voir les numéros de mesure au-dessus de chaque portée, activez Afficher les
numéros de mesure sur toutes les portées sur la page Affichage de Fichier > Préférences
(dans le menu Sibelius sous Mac).

Marques de mise en page
Cette option affiche dans la partition les sauts de système et de page; elle montre au moyen de

diverses indications si la mise en page a été modifiée et souligne d’une ligne bleue en pointillés

l’endroit où des portées sont masquées. b 8.5 Les sauts.

Il est souvent bien utile de savoir si des portées sont masquées. L’option Affichage > Marques de
mise en page peut être en même temps désactivée quand on travaille avec l’option Affichage >

Portées en vue ciblée, et activée quand on travaille sur la partition complète, ou vice-versa;

Sibelius se souvient du réglage choisi pour chaque option.

Marges des pages
Cette option affiche un rectangle bleu en pointillé correspondant aux marges déterminées dans

Mise en page > Paramètres du document. b 8.6 Paramètres du document.

Réglettes
Voici les trois options du sous-menu Affichage > Réglettes qui peuvent être activées:

* Réglettes de sélection: affiche une réglette entre l’ (les) objet(s) sélectionné(s) et la portée à

laquelle il est (sont) attaché(s)

* Réglettes d’objet (raccourci Maj+Alt+R ou xzR): affiche une réglette pour tous les objets

attachés aux portées, tels que du texte, des symboles, des lignes, etc., qu’ils soient sélectionnés

ou non

* Réglettes de portée (raccourci Ctrl+Shift+Alt+R ou xzXR): affiche une réglette entre les

portées et les extrémités de la page, et entre des portées adjacentes.

Réglette de portée : affiche la dis-

tance entre des portées adjacentes 

et entre les portées et le bord des 

pages.

Réglette de sélection : affiche la dis-

tance entre l’objet sélectionné et la 

portée à laquelle il est attaché.
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Vous pouvez choisir l’unité de mesure des réglettes dans la page Autres de la boîte de dialogue

Fichier > Préférences (dans le menu Sibelius sur Mac). Vous pouvez choisir entre des pouces, des

points (1 point = 1/72 de pouce), des millimètres et des dents.

L’utilisation des réglettes d’objets et de portées peut ralentir l’affichage de manière importante ;

désactivez-les si Sibelius vous paraît trop lent.

En plus des réglettes, on peut choisir un papier millimétré pour afficher la partition ;

b 5.6 Paramètres d’affichage.

Lignes d’attache
Cette option fait apparaître en gris pointillé la ligne d’attache entre l’objet sélectionné et sa position

rythmique dans la portée. Pour éviter toute surcharge, aucune ligne d’attache n’apparaît pour les

objets tels que les notes, les silences et les objets de système. b 8.7 Attaches.

Poignées
Si cette option est activée, les poignées sur divers objets (ex. hampes de note, liaisons de phrasé,

barres de mesure, etc.) sont toujours affichées sur votre partition en gris clair. Du fait que,

autrement, les poignées apparaissent seulement quand les objets sont sélectionnés, cela est

particulièrement utile pour les poignées difficiles à trouver, par ex. les points de courbe de liaison

de phrasé (b 2.28 Liaisons de phrasé) ou la poignée à droite d’un système

(b 2.29 Portées).

Objets masqués
Quand cette option est activée, les objets masqués sont affichés dans la partition en gris clair et

peuvent être édités; si l’option n’est pas activée, ils sont invisibles et ne peuvent pas être édités.

Comme il est plus rapide d’utiliser les raccourcis-clavier que les menus, voici le raccourci à retenir

Ctrl+Alt+H ou zXH. b 5.9 Masquer des objets.

Commentaires
Désactivez cette option pour masquer les commentaires “à bulle” dans la partition.

b 5.5 Commentaires.

Différences dans les parties
Quand cette option est activée, Sibelius affiche en orange les objets dont la position ou l’aspect

diffère entre une partie et le conducteur. Dans le conducteur, Sibelius met en couleur tout objet dès

qu’il y a une différence avec ne fusse qu’une seule partie. b 7.1 Travailler avec des parties
séparées.

Différences entre les versions
Désactivez cette option pour masquer les surbrillances colorées derrière les objets ayant été colorés

en comparant deux versions ou partitions. b 5.22 Versions.

Surbrillances
Si des surbrillances ont été créées dans la partition, activer cette option les affichera à l’écran.

b 5.10 Surbrillance.
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Collisions de mise en page magnétique
Désactivez cette option pour éviter que les objets entrant en collision avec d’autres objets

s’affichent en rouge. b 8.2 Mise en page magnétique.

Couleurs de note
Le menu Affichage > Couleurs de note contient quatre options qui modifient l’affichage de la

partition:

* Couleur par Voix: colore toutes les notes dans un teinte foncée de la couleur de la voix, de sorte

que la voix 1 est en bleu foncé, la voix 2 est en vert, la voix 3 est en orange et la voix 4 est en rose

(b 2.36 Voix)

* Notes hors tessiture: colore en rouge automatiquement et par défaut les notes trop hautes ou

trop basses pour l’instrument. Les notes difficiles mais que peuvent jouer des professionnels

sont en rouge foncé. D’un coup d’œil avant une répétition, il est possible de dépister les notes

difficiles ou impossibles (b 2.18 Instruments et portées).

* Aucune: affiche les notes en noir; les notes sélectionnées sont colorées d’après les voix

auxquelles elles appartiennent (c’est-à-dire la voix en bleu foncé, la voix 2 en vert, etc.).

Vélocités de l’exécution enregistrée
Dans chaque partition pour lesquelles des données d’exécution enregistrée existent, cette option

affiche au-dessus de chaque note des colonnes colorées, représentant les vélocités MIDI.

b 4.8 Exécution enregistrée.

Ligne de lecture
Désactivez cette option pour masquer la ligne verte de lecture quand il n’y a pas d’exécution en

cours.

Live Tempo
Désactivez cette option pour masquer l’affichage graphique indiquant comment l’interprétation

Live Tempo varie dans le temps; le graphique ne figure que dans Panorama. b 4.7 Live Tempo.

Plein écran (Windows uniquement)
Cette option (raccourci Ctrl+U) permet d’augmenter la surface d’affichage en masquant les menus

et la barre des tâches (la barre inférieure qui affiche les programmes en cours). Pour afficher les

menus, il suffira alors de déplacer simplement la souris au sommet de l’écran.

Barres de défilement
Cette commande ajoute des barres de défilement verticales et horizontales dans la fenêtre

principale de la partition. L’utilisation du navigateur étant bien plus rapide et aisée, l’usage des

barres de défilement n’est pas recommandé.

Sous Windows, si vous avez une souris avec molette, vous pouvez également utiliser celle-ci pour

déplacer la partition, que vous ayez ou non activé Affichage > Barres de défilement:

* Entraînez la roulette vers le haut ou vers le bas pour déplacer la page vers le haut ou vers le bas;

maintenez Alt ou z pour vous déplacer d’un écran en une fois
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* Maintenez enfoncé Maj et entraînez la roulette pour déplacer la page vers la gauche ou vers la

droite; maintenez enfoncé Alt ou z pour vous déplacer d’un écran en une fois (ou d’une page à

la fois si la largeur de page correspond à l’écran). Si vous avez une Mighty Mouse Apple, déplacer

la souris horizontalement déplace la page à gauche ou à droite, de sorte qu’il ne faut pas

maintenir Maj enfoncé (Mac uniquement).

* Vous pouvez aussi utiliser la roulette pour le zoom en maintenant enfoncé Ctrl ou X.

Pour modifier la vitesse de défilement, utilisez l’utilitaire de configuration Souris de votre panneau

de configuration Windows. Les options disponibles dépendent des pilotes installés pour votre

souris, cependant la plupart des pilotes proposent une option pour le défilement accéléré;

augmenter le facteur d’accélération permet de déplacer la partition plus rapidement avec la

molette.

Barre d’outils
Cette option masque ou affiche la barre d’outils. La désactiver permet de gagner un peu d’espace

sans inconvénient particulier puisque la plupart des boutons ont un équivalent sous forme de

raccourci-clavier.

Si votre résolution d’écran n’est pas assez grande pour englober tous les boutons de la barre d’outils

(une résolution de 1280 x 1024 minimum est recommandée), Sibelius masquera automatiquement

un groupe ou plus de sorte que la barre d’outils ne s’échappe pas côté droit de votre écran. Vous

pouvez désactiver ce comportement sur la page Affichage de Fichier > Préférences (dans le menu

Sibelius sous Mac): sélectionnez Me laisser choisir ce qui figure sur la barre d’outils au lieu de

Ajouter ou supprimer automatiquement des éléments de la barre d’outil pour s’ajuster à
l’affichage. Vous pouvez ensuite choisir de masquer ou d’afficher certains groupes de boutons

vous-même si vous le souhaitez.

Zoom
Utiliser les options du menu Affichage > Zoom ou le bouton Zoom de la barre d’outils produit le

même effet. Les fonctions du zoom peuvent s’activer de différentes manières:

* Utiliser les raccourcis Ctrl++ ou X+ (agrandir l’affichage) et Ctrl+– ou X– (réduire l’affichage).

De même les + et – du pavé numérique ou du clavier principal.

* Si vous possédez une souris à roulette, y maintenir la touche Ctrl enfoncée ou X et actionner la

roulette de haut en bas pour agrandir ou diminuer la valeur du zoom (Windows uniquement).

* Cliquer le bouton en forme de loupe sur la barre d’outils et cliquer sur la partition pour agrandir;

faire un clic-droit (Windows) ou z-clic (Mac) pour diminuer de nouveau. Appuyez sur Échap
pour interrompre le zoom.

* Cliquer sur le bouton en forme de loupe sur la barre d’outils, et déplacer la partition pour

sélectionner l’endroit à agrandir. Appuyez sur Échap pour interrompre le zoom.

* Utiliser le raccourci Ctrl+0 ou X0 pour changer la valeur du zoom sur Ajuster à la page, et

Ctrl+1 ou X1 pour régler la valeur du zoom sur 100%. Vous pouvez aussi définir vos propres

raccourcis-clavier pour d’autres valeurs de zoom – b 5.12 Menus et raccourcis.
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Quand le bouton loupe est activé, il le reste, même après avoir cliqué ou déplacé la partition, de

sorte qu’on peut continuer à l’utiliser en cliquant: pour l’arrêter, taper Échap ou appuyez à nouveau

sur le bouton loupe.

Un facteur de zoom à 100% offre une taille d’affichage confortable pour travailler mais qui ne

correspond pas à ce qui sera imprimé. L’option Taille réelle (dans la liste de la barre d’outils) affiche

en principe la musique à la taille réelle d’impression mais cela dépend aussi des dimensions de

l’écran.

Les options telles que Ajuster à la largeur de page sont explicites. Cependant l’idéal consiste à

choisir des valeurs de zoom qui affichent les notes le plus distinctement possible et l’espace le plus

constant entre les lignes des portées. Vous pouvez tapez directement dans la barre d’outil une

valeur de zoom qui est celle du meilleur affichage.

Par défaut, Sibelius active le niveau de zoom sur Ajuster à la page pendant l’exécution, mais

cela peut être modifié si nécessaire (on peut aussi empêcher tout changement de zoom pendant

l’exécution) dans la page Position de la partition de Fichier > Préférences (dans le menu

Sibelius menu sur Mac), ou simplement en changeant le niveau de zoom pendant l’exécution;

b 4.1 Utiliser du texte.

La page Fichiers de la boîte de dialogue Fichier > Préférences (dans le menu Sibelius menu sur

Mac) propose une option pour régler le niveau de zoom par défaut à utiliser au moment de

l’ouverture des partitions; b 5.15 Préférences.
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5.24 Fenêtre (menu)

b 5.23 Menu affichage.

Le menu Fenêtre comporte une combinaison d’options standard que vous connaissez peut-être via

d’autres applications, et des commandes propres à Sibelius pour la manipulation, le masquage et

l’affichage de fenêtres de partition et d’outil.

Réduire (Mac uniquement)
Minimise la fenêtre de partition actuelle à partir du Dock, avec des tas d’effets géniaux.

Tout comme cliquer sur l’icône jaune dans le coin supérieur gauche de la fenêtre de la partition),

raccourci XM.

Zoom (Mac uniquement)
A ne pas confondre avec les fonctions de zoom propres à Sibelius (cf. Zoom à la page 522), cela a

le même effet que de cliquer sur le bouton de “signal de trafic” sur la barre de titre de la partition,

c.-à.-d. agrandit la fenêtre à la taille réelle de votre écran.

Passer tout à l’avant (Mac uniquement)
Si plusieurs fenêtres de partition sont ouvertes, mais que l’une ou plusieurs est actuellement

derrière une fenêtre dépendant d’une autre application, cela amène toutes les fenêtres de partition

au sommet de la pile.

Nouvelle fenêtre
Nouvelle fenêtre crée un nouvel affichage de la partition en cours. Cela permet voir plusieurs

endroits de la partition en même temps ou d’en voir le même endroit mais avec des valeurs de

zoom différentes. Un premier affichage à 25% permettrait par exemple de voir la totalité d’une

page tandis qu’un deuxième affichage à 200% offrirait de voir un endroit précis en détail.

Une méthode de travail particulièrement utile quand on possède plusieurs moniteurs.

Organiser les fenêtres horizontalement, Organiser les fenêtres verticalement 
 Organiser les fenêtres consiste à redimensionner les fenêtres de partition ouvertes pour pouvoir

s’ajuster à l’écran, et être disposées de manière à ne pas se chevaucher. Organiser les fenêtres
verticalement redimensionne les fenêtres à la largeur de l’affichage et les dispose l’une au-dessus

de l’autre. Organiser les fenêtres verticalement, en revanche, redimensionne les fenêtres à la

hauteur de l’affichage, et les dispose côte à côte.

Sibelius organise automatiquement les fenêtres de partition pour comparer deux versions ou deux

partition via la fenêtre Comparer – b 5.22 Versions.

Cascade (Windows uniquement)
Cascade redimensionne les fenêtres de partition ouvertes de sorte qu’elles soient plus petites que

la hauteur et la largeur de l’affichage, puis les dispose de manière à ce que la barre de titre de

chaque fenêtre soit visible, en les organisant en cascade descendante en partant du haut à gauche

de la fenêtre de Sibelius.
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Fenêtres d’outil

* Navigateur: affiche et masque le Navigateur (raccourci Ctrl+Alt+N ou zXN). Si vous

connaissez les raccourcis pour déplacer la partition (Page précédente ou 8, Page suivante ou

9, etc.) vous serez vite content de pouvoir vous en passer. Vous pouvez déplacer le navigateur

comme toute fenêtre d’outil, en cliquant et en déplaçant la barre de titre .

* Pavé: affiche et masque le pavé (raccourci Ctrl+Alt+K ou zXK). Il faut être un utilisateur averti

de Sibelius pour pouvoir utiliser les touches des différents pavés sans regarder. Faites l’essai de le

désactiver quand vous avez atteint une certaine maîtrise. Apprenez au moins le premier pavé de

cette manière.

* Clavier: affiche et masque la fenêtre Clavier (raccourci Ctrl+Alt+B ou zXB) –

b 1.3 Fenêtre Clavier.

* Grille d’accord: affiche et masque le la fenêtre Grille d’accord (raccourci Ctrl+Alt+E ou zXE)

– b 1.8 Fenêtre Manche.

* Exécution: affiche et masque la fenêtre Exécution (raccourci Ctrl+Alt+Y ou zXY).

* Table de mixage: affiche et masque la fenêtre Table de mixage (raccourci Ctrl+Alt+M ou M) –

b 4.3 Table de mixage.

* Idées: affiche et masque la fenêtre Idées (raccourci Ctrl+Alt+I ou zXI) – b 5.11 Idées.

* Parties: affiche et masque la fenêtre Parties (raccourci Ctrl+Alt+R ou zXR) –

b 7.1 Travailler avec des parties séparées.

* Comparer: affiche et masque la fenêtre Comparer (raccourci Ctrl+Alt+C ou zXC) –

b 5.22 Versions.

* Vidéo: affiche et masque la fenêtre Vidéo (raccourci Ctrl+Alt+V ou zXV) – b 4.10 Vidéo.

* Propriétés: affiche et masque la fenêtre Propriétés (raccourci Ctrl+Alt+P ou zXP).

Les fenêtres des propriétés et du pavé disparaissent (par défaut) durant la lecture pour que

l’écran soit le plus dégagé possible. b 5.17 Propriétés.

* Masquer les fenêtres d’outil: si par exemple, vous procédez à des réglages sur la table de

mixage et composez avec de la vidéo, l’écran devient rapidement encombré avec tant d’outils

ouverts. Sibelius permet de masquer en même temps toutes les fenêtres d’outil ouvertes, puis de

les réouvrir par la suite selon la même disposition . Utilisez Fenêtre > Masquer les fenêtres
d’outil Ctrl+Alt+X ou zXX. 

Passer des parties au conducteur et vice-versa
Quand vous travaillez sur une partition avec des parties, cette option permet de passer du

conducteur vers une partie et vice-versa. La partie affichée dépend de la sélection réalisée dans le

Navigateur

Pavé

Exécution

Table de 

mixage

Idées

Parties Vidéo

Propriétés

Masquer les 

fenêtres d’outil 

sous Windows

Grille 

d’accord

Clavier Comparer
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conducteur avant d’utiliser Passer aux parties/au conducteur. Sibelius essaie toujours d’afficher

la partie la plus pertinente d’une sélection, de sorte que, par exemple, si vous sélectionnez une note

de la seconde partie de flûte, Sibelius affichera de manière bien pratique cette partie de flûte.

Si vous n’avez pas fait de sélection, ou si la sélection contient des objets de plusieurs parties,

Sibelius affichera la partie affichée en dernier lieu. Le menu affiche Passer au conducteur si vous

êtes dans une partie et Passer aux parties si le conducteur est ouvert. Vous pouvez aussi passer de

l’un(e) à l’autre avec le raccourci W.

Partie suivante
Cette option affiche la partie suivante du conducteur en cours; vous pouvez aussi utiliser

Ctrl+Alt+Tab ou zX~. Si vous affichez la dernière partie, Sibelius affichera le conducteur pour

suivre. 

Partie précédente
Cette option affiche la partie précédente du conducteur en cours; vous pouvez aussi utiliser

Ctrl+Maj+Alt+Tab ou xzX~. Si vous affichez la première partie, Sibelius affichera le

conducteur pour suivre.

Pour en savoir plus sur la mise en œuvre des parties, b 7.1 Travailler avec des parties
séparées.
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5.25 Créateur d’exercices

Pour les professeurs de musique, le matériel pédagogique doit être particulièrement adapté au

programme à suivre. Le créateur d’exercices propose un choix de plus de 1700 exercices,

projets, pièces de répertoire, affiches, matériaux de référence et diverses ressources. Ceux-ci ont

été soigneusement conçus pour les programmes des USA, Royaume-Uni, Australie, Nouvelle

Zélande et Canada, et adaptés à toutes les tranches d’âge des élèves musiciens. Certains matériaux

(tels que Répertoire sélectionné et Référence) sont à usage des collèges et universités.

Vous pouvez produire à la fois une feuille d’exercice pour l’étudiant et son corrigé pour faciliter la

correction. Vous pouvez même générer des exercices à questions aléatoires, histoire de n’être

jamais à court d’exercices. Et tout cela se réalise en quelques secondes.

Vous pouvez aussi ajouter vos propres feuilles d’exercices dans le créateur d’exercices (autant dans

votre exemplaire de Sibelius que celui de vos collègues) – b 5.26 Ajouter ses propres
feuilles d’exercices.

Utiliser le créateur d’exercices
Pour démarrer, Choisissez Fichier > Créateur d’exercices; La boîte de dialogue suivante apparaît :

* Choisissez si vous voulez Matières d’enseignement et d’études ou Modèle. Un modèle est

une feuille d’exercices sans note, servant de base pour créer ses propres exercices ; cf. ci-dessous.

* Des feuilles d’exercices supplémentaires générées par les utilisateurs de Sibelius sont disponibles

sur SibeliusEducation.com, que vous pouvez visiter en cliquant sur le bouton Visiter le site
web SibeliusEducation, affiché dans la boîte de dialogue– b 5.18 SibeliusEducation.com

* Choisissez le format de papier de la feuille d’exercices que vous voulez créer; vous pouvez choisir

entre A4 et Lettre 
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* Les options sous À ajouter à la feuille d’exercices détermine différentes choses à imprimer

sur la feuille de l’élève et le corrigé. Sur la feuille de l’élève:

% Date du jour imprime la date sous la forme 18 April, 2005. (Cette option est disponible à la

fois pour la feuille de l’élève et le corrigé)

% Espaces pour le nom de l’élève et la classe imprime des lignes dans le coin supérieur

droit de la feuille sur lesquelles l’élève peut écrire son nom et sa classe.

* Sur le corrigé

% Comment compléter imprime un rappel qui indique si une activité spécifique est conçue

pour être réalisée sur papier, à l’ordinateur ou en l’exécutant

% Rôle du professeur imprime un rappel qui indique si le professeur est impliqué dans la

réalisation de l’activité et s’il a besoin d’un accès à Sibelius

% Taille du groupe imprime un rappel qui indique si une activité spécifique est conçue pour

être réalisée par une seule personne, un petit groupe ou un groupe plus grand

% Niveaux du programme imprime les éléments d’un programme spécifique sur lesquels

porte l’activité et où les informations sont disponibles.

Si vous envisagez d’imprimer quelque chose des sections Ressources, Référence, Répertoire
sélectionné ou Posters, Cartes et Jeux, il vaut mieux désactiver toute ces options.

Une fois vos choix établis dans Matières d’enseignement et d’études, cliquez sur Suivant pour

cibler le type de matériau recherché:

Parce qu’il existe une grande variété de matériaux dans le créateur d’exercice, vous pouvez choisir

seulement ceux qui suivent certains critères. Par exemple, si vous souhaitez trouver des matériaux

qui conviennent à un groupe d’étudiants plutôt que des élèves seuls, choisissez Matériaux pour
petits groupes et Groupes de toute taille, puis cliquez sur Suivant. Si vous voulez seulement
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trouver des feuilles d’exercices à remplir dans Sibelius, choisissez à utiliser À l’ordinateur et

cliquez sur Suivant. 

(L’option Rechercher par nom de fichier est utile si vous avez déjà imprimé une feuille

d’exercices spécifique et que vous voulez la réutiliser. Chaque corrigé contient un Nom de fichier:

qui se trouve dans le coin inférieur droit de la première page. Tapez-le ici et cliquez sur Suivant
pour retrouver cette feuille directement et l’imprimer à nouveau.)

Si c’est la première fois que vous utilisez cette fonction depuis que vous avez installé Sibelius, vous

constaterez que quelques minutes suffisent à Sibelius pour générer une liste des matériaux

disponibles.

Voici les catégories dans lesquelles vous pouvez choisir votre matériau:

Les matériaux sont divisés en six catégories principales:

* Éléments de musique couvre 14 champs de la théorie et de la pratique musicale, concernant la

lecture et l’audition des rythmes et des hauteurs

* Écrire et créer de la musique couvre la notation, la transposition, l’arrangement, la

composition et l’improvisation

* Répertoire sélectionné propose plus de 400 morceaux pour la voix, le piano et d’autres

instruments, dont des chansons dans 14 langues différentes et 50 morceaux pour le clavier de

Bach, tous convenant à l’étude, l’arrangement, l’interprétation et à la création d’exercices. On y

trouve aussi plus de 45 poèmes à mettre en musique par les élèves.

* Référence propose une bibliothèque raisonnée sur la musique avec environ 80 modes et

gammes convenant à différents instruments

* Posters, Cartes & jeux au nombre d’environ 200, offrent des supports pour l’apprentissage des

concepts musicaux. Les sujets abordent les notes, les clés et des dizaines d’illustrations

d’instruments sont proposées
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* UK KS3 & GCSE Projects sont des programmes spécifiques au Royaume-Uni sur

l’interprétation, l’audition et la composition qui vont des percussions africaines jusqu’au

sérialisme!

Pour en savoir plus sur ces catégories, consultez le tableau Catégories ci-dessous.

Chacune des catégories et sous-catégories sont numérotées avec un préfixe, par ex. 16 lectures à
vue. Cela rend plus facile la recherche dans la masse des matériaux fournis et montrent aussi la

progression pédagogique des matériaux de chaque catégorie, qui va du plus simple au plus

compliqué.

Les numéros à la fin de chaque catégorie, par exemple (8 de 27), affichent le nombre total de

matériaux de la catégorie qui correspondent aux critères spécifiés (affiché à proximité du bas de la

boîte de dialogue.) Le nombre 0, par exemple (0 de 27), signifie qu’il n’y a rien à choisir dans cette

catégorie, puisque rien ne correspond. Si vous estimez qu’il y a trop peu de choix et que vous

voulez l’élargir, changez les critères en cliquant sur le bouton Changer le type de matériau.

Choisissez la catégorie que vous voulez explorer, puis cliquez soit dans la liste de gauche ou sur

Suivant. La même page de la boîte de dialogue apparaîtra de nouveau mais cette fois avec les sous-

catégories de la catégorie choisie selon le chemin que vous avez suivi jusque là. Si vous voulez

retourner à la catégorie au-dessus de la sous-catégorie, il suffit de cliquer sur Précédent.

Quand vous serez parvenu à la sous-catégorie finale d’une catégorie donnée, vous pourrez choisir

dans une liste la feuille d’exercices ou le matériau souhaité:

Quand vous faites une sélection dans la liste, des informations la concernant s’affiche dans la

partie droite de la boîte de dialogue. Le champ Description vous donne des explications sur la

manière dont les élèves doivent compléter la feuille ou réaliser l’activité.

Il y a trois options en bas de cette page qui sont activées ou désactivées en fonction du matériau

choisi:
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* Nombre de questions permet de choisir le nombre de questions qui figurent sur la feuille

imprimée. Cette option n’est disponible que si la feuille d’exercices propose beaucoup de

questions tirées d’une série aléatoire. Ces feuilles d’exercices sont réutilisables ; en effet, si vous

choisissez d’inclure par exemple 10 questions, et reprenez la feuille par la suite, Sibelius choisira

10 autres questions (éventuellement certaines pourront réapparaître).

* Afficher un cadre contenant les réponses possibles est disponible si vous choisissez une

feuille d’exercices basée sur des questions à choix multiple

* Créer une feuille de réponse crée une feuille de réponse (corrigé) pour le professeur (dans la

quelle les réponses figurent, histoire de gagner du temps) en même temps que la feuille de

l’élève. Cette option n’existe pas pour les matériaux tels que les posters, répertoires, etc... Notez

que de nombreuses feuilles d’exercices peuvent recevoir plusieurs réponses et dans ce cas le

corrigé contiendra un exemple de réponse possible avec l’indication que d’autres réponses

peuvent exister.

Une fois vos choix réalisés, cliquez sur Suivant pour afficher une prévisualisation:

La feuille d’exercices de l’étudiant est affichée à gauche. Si un corrigé est disponible et que vous avez

choisi de le créer, il s’affiche à droite.

Si la feuille d’exercices ne correspond pas à ce que vous souhaitez, cliquez sur Précédent, une ou

plusieurs fois pour revenir en arrière et refaire de nouveaux choix. Sinon, cliquez sur Terminer
pour créer la feuille d’exercices.
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Si vous choisissez de créer en même temps une feuille pour l’élève et une autre pour le professeur,

Sibelius créera deux partitions. Vous pouvez les imprimer, les sauvegarder pour plus tard, ou les

modifier pour produire vos propres feuilles d’exercices.

Niveaux de difficulté pour le rythme (RL1-4) et les modes (SL1-4)
Les feuilles d’exercices sont classées par niveau de difficulté de rythme ou de mode, en fonction de

la complexité des rythmes et des modes qu’elles contiennent. Voici résumés les niveaux de rythme:

* RL1: indications de mesure 2/4 et 3/4, croche jusqu’à la blanche pointée, silence simple

* RL2: aussi 4/4, ronde, double croche, silences supplémentaires

* RL3: aussi 6/8, C, notes pointées, rythmes simples en 6/8, syncope, rythme lombard, silences

supplémentaires pointés

* RL4: toutes les autres indications de mesure, triolets, rythmes complexes en 6/8

Voici les niveaux pour les modes:

* SL1: majeur, naturel (éolien) mineur, pentatonique majeur, pentatonique mineur

* SL2: aussi chromatique, hexatonique ionien (six premières notes de la gamme majeure)

* SL3: aussi harmonique mineur, mineur mélodique, dorien, dorien hexatonique

* SL4: aussi d’autres modes liturgiques ou pour le jazz, gamme pour le Blues, gammes par tons

entiers

Certains termes concernant les modes sont proposés plus pour votre édification personnelle que

dans le but d’être enseigné aux élèves. Tous les informations se trouvent sur

www.sibeliuseducation.com (ou choisissez Aide > SibeliusEducation.com).
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Modèles
Pour créer un modèle vierge qui servira de base à vos propres exercices, sur la première page de la

boîte de dialogue Fichier > Créateur d’exercices, choisissez l’option modèle et cliquez sur

Suivant. Les modèles disponibles sont affichés, chacun pouvant être prévisualisé:

Choisissez le modèle que vous voulez créer et cliquez sur Terminer. Une partition sera créée à

partir de laquelle vous pouvez créer votre propre feuille d’exercices. Si vous avez plus d’ambition,

vous pouvez ajouter vos propres exercices dans le créateur d’exercices pour des utilisations futures

(surtout s’il s’agit de questions aléatoires) – b 5.26 Ajouter ses propres feuilles
d’exercices.
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Catégories

Catégorie principale Contenu Description

01 Elements of Music 01 Notes & Rests

02 Dynamics

03 Timbre & Tone Color

04 Meter & Tempo

05 Rhythm

06 Scales & Key Signatures

07 Intervals, Chords, Progressions &

Cadences

08 Score Analysis,

09 Conducting

10 Dictation/Transcription,

11 Sight Reading

12 Ear Training

13 Auditory Discrimination

14 Aural Recall

Les activités sont proposées par séquences 

d’apprentissage couvrant tous les champs de la 

musique. Elles introduisent le vocabulaire et 

les termes musicaux, développent les bases de 

la pratique musicale, introduisent les aspects 

de la théorie et permettent d’apprendre à ana-

lyser la tonalité, la forme et les structures, les 

textures et les genres.

02 Writing and Creating 

Music

01 Notation 

02 Adapting, Transposing & Arranging

03 Composing

04 Improvising

Les activités sont orientées pour permettre 

l’acquisition des éléments de base de la 

notation et pour l’exploration créative, grâce à 

des travaux sur les sons, les rythmes, les 

mélodies, les accompagnements, les textures, 

les paroles et l’orchestration.

03 Selected Repertoire 01 Bach Piano Repertoire 

02 Other Piano Repertoire

03 Instrumental Repertoire

04 Songs for Teaching

05 Rounds and Canons Collection

06 Poetry for Lyrics

07 Texts for Incidental Music

08 Rhythm Collection

Près de 500 morceaux de musique et de poésie, 

souvent utilisés dans les feuilles d’exercices et 

tous prêts à être exploités, soit en classe ou 

pour créer des exercices. On y trouve près de 

100 pièces du répertoire pour clavier dont une 

50 de Bach et le reste d’autres grands maîtres; 

environ 150 chansons, dont 50 comptines et 

canons en 13 langues; et enfin 45 poèmes.

04 Reference 01 Encyclopedia of Scales & Modes

02 Chord Library

03 Instrumental & Vocal Ranges

04 US & British Music Terms Compared

05 Keyboard Handouts

Une bibliothèque pratique sur la musique avec 

environ 80 modes et échelles et environ 150 

accords avec leurs symboles. À utiliser dans les 

activités créatives pour chercher, explorer et 

intégrer.

05 Posters, Flashcards & 

Games

01 Posters

02 Flashcards

03 Games

Environ 200 posters, cartes et jeux comme 

support pour enseigner et réviser les concepts 

musicaux. Les sujets sont les notes, les 

silences, les modes, les tonalités, l’échelle des 

quintes, les symboles, le vocabulaire, l’écriture 

en bâton pour le rythme et 100 illustrations 

d’instruments qui peuvent être utilisées autant 

pour décorer une classe qu’être intégrées dans 

vos matériaux pédagogiques.

06 UK KS3 & GCSE Projects 01 African DrummingKS3

02 Blues (12 bar) KS3

03 Composing to create a specific mood

KS3/GCSE

04 Pop Songs (Reggae) KS3/GCSE

05 Pop Songs (Dance Grooves) GCSE

06 Serialism GCSE

07 Blues (Arranging) GCSE

Sept projets pédagogiques spécifiques au 

Royaume-uni portant sur trois champs d’étude 

importants– exécution, composition et 

audition – pour le Key Stage 3 et le GCSE, avec 

des notes explicatives pour le professeur et des 

idées à exploiter.
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5.26 Ajouter ses propres feuilles 
d’exercices

b 5.25 Créateur d’exercices.

Ajouter ses propres feuilles d’exercices
Sibelius permet de créer soi-même du matériel pédagogique “intelligent” et de l’ajouter au créateur

de feuilles d’exercices (soit dans votre exemplaire de Sibelius ou celui de vos collègues). Vous

pouvez facilement créer des partitions qui contiennent à la fois les questions et les réponses, et

créer des fichiers capables de produire des questions de manière aléatoire, ce qui permet de les

réutiliser à l’infini.

Format de page et dimension des marges
Pour obtenir quelque chose qui présente bien, il faut être attentif à la mise en page et à la mise en

forme de la partition.

Vous pouvez baser votre feuille d’exercices sur un modèle prêt à l’emploi (b 5.25 Créateur
d’exercices); si c’est le cas, choisissez le format de papier A4 plutôt que Lettre. (Une fois la feuille

d’exercices ajoutée dans le créateur d’exercices vous pourrez la créer au format lettre.) Au contraire,

si vous créez de toute pièce une feuille d’exercices, alors, dans Mise en page > Paramètres du
document:

* utilisez A4 comme format de page

* utilisez des marges supérieure et inférieure de 24mm et latérales de 15mm. Ces marges

compensent les différences de dimension entre le format A4 et le format Lettre.

* utilisez 12mm pour la marge de portée supérieure et 24mm la marge de portée inférieure.

Ces marges de portée laissent l’espace nécessaire en haut et en bas de page pour le texte créé par

le créateur d’exercices.

Corrigé
Si vous voulez produire le corrigé d’une feuille d’exercices, il faudra constamment utiliser les

différentes voix dans la partition pour pouvoir en supprimer certaines en fonction de ce qui doit

figurer sur la feuille. En effet certains éléments doivent apparaître uniquement sur la feuille de

l’élève, d’autres sur le corrigé et enfin certains apparaîtront sur les deux feuilles. Imaginons par

exemple une feuille d’exercices dans laquelle l’étudiant doit écrire le nom d’un intervalle donné en

dessous de la portée, tandis que ce nom doit apparaître dans le corrigé imprimé.

* Installez chaque intervalle, par exemple dans la voix 1. Les notes apparaîtront à la fois dans la

feuille de l’élève et dans le corrigé. D’habitude, il vaut mieux réserver les voix 1 et 2 (les voix

normales utilisées en général pour écrire la musique) pour tout ce qui est commun aux deux

feuilles.

* Créez le corrigé avec par exemple le texte Paroles ligne 1, en voix 4. Vous pouvez spécifier plus

tard les éléments de la voix 4 qui apparaîtront uniquement sur la feuille du professeur.
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* Vous pouvez aussi inclure une ligne sous chaque intervalle pour que l’étudiant puisse écrire la

réponse. Créez des lignes horizontales par exemple en voix 3. De nouveau, vous pouvez spécifier

plus tard les éléments de la voix 4 qui apparaîtront uniquement sur la feuille de l’élève.

Questions déterminées ou aléatoires
Il existe deux types fondamentaux de feuilles d’exercices: celles à questions aléatoires et celles à

questions déterminées. Celles à questions déterminées sont plus faciles à produire, car leur mise en

page sera exactement telle que souhaitée quand elles seront générées par le créateur, mais pour les

deux types, il faut toujours utiliser les voix avec précaution.

Si vous souhaitez produire une feuille à questions aléatoires, il ne faut ajouter aucun texte à la

partition, et ne pas s’occuper de la mise en page car le créateur le fait automatiquement. Donc on

ne placera ni titre, ni numéro de question ni instruction pour les élèves.

Si vous envisagez de produire une feuille d’exercices à questions déterminées, il faudra alors

introduire différents éléments textuels sur la page, par exemple:

* Un titre – pour notre exemple, nous pourrions lui donner comme titre “Noms des intervalles”

* Des instructions pour l’élève – on pourrait créer une instruction en texte technique au-dessus de

la première mesure de la partition telle que “Écrivez le nom de l’intervalle sur la ligne

correspondante”.

* Des numéros de question – par ex. on pourra placer du texte au-dessus de chaque mesure avec le

numéro de la question. Vous pouvez le faire rapidement avec Extensions > Texte > Numéro de
mesures.

Pour que tous ces objets apparaissent à la fois sur les feuilles des élèves et le corrigé, il faut les créer

dans la voix 1.

Autant pour les feuilles d’exercices à questions aléatoires que pour celles à questions déterminées,

il faut parfois procéder à des ajustements de mise en page. Par exemple, il faut veiller à ce qu’il y ait

assez d’espace pour que le créateur puisse ajouter la date et que l’élève puisse écrire son nom et

celui de sa classe. Vous pouvez aussi placer des espaces entre chaque question, ce qui se fait en

sélectionnant une mesure et en tapant par exemple 4 dans Espace avant la mesure dans le

panneau Mesures de la fenêtre des Propriétés. Vous pouvez aussi imposer un nombre spécifique

de numéros de mesure par système en utilisant les sauts automatiques (avec Mise en page > Mise
en page automatique).

Une fois que le texte est ajouté et la mise en page ajustée, vous êtes prêt à ajouter votre feuille

d’exercices dans le créateur d’exercices.

Utiliser des idées dans les feuilles d’exercices
La fonction idées de Sibelius peut constituer un puissant outil de production d’exercices destinés à

vos élèves – b 5.11 Idées pour une introduction.

Toute idée peut être utilisée, qu’elle soit une des 1500 idées prédéfinies de la bibliothèque ou une

idée de votre cru provenant d’une de vos partitions. Comme exemple typique, vous pourriez

sauvegarder un jeu d’idées d’une partition et empêcher les élèves d’utiliser toute autre idée que

celles-là pour élaborer un morceau. Pour en savoir plus, cf. Limiter l’accès à la bibliothèque à
la page 464.
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Pour obtenir plus d’informations générales sur l’utilisation des idées dans l’enseignement, cf.

Utiliser les idées dans l’enseignement à la page 463.

Ajouter dans le créateur de feuilles d’exercices
Dès que vous avez créé une feuille d’exercices et que vous voulez l’ajouter au créateur, choisissez

Fichier > Ajouter au créateur de feuilles d’exercices:

* En premier lieu, choisissez le type de matériau à ajouter. Pour ajouter un modèle, il suffit de

choisir Modèle et de cliquer sur OK. Sinon, choisissez Matières d’enseignement et d’études.

* Passez à droite de la boîte de dialogue et réglez Questions aléatoires ou Questions fixées
selon ce qui convient. Les champs restants de la boîte de dialogue seront disponibles en fonction

de votre réponse.

* Nom (dans la boîte de dialogue) est le nom qui apparaîtra dans le créateur de feuilles

d’exercices. Donnez de préférence un nom le plus court possible.

* Titre (dans la partition) est le titre que Sibelius créera si vous choisissez Questions
aléatoires. (Si vous choisissez Questions déterminées, vous devriez ajouter le titre dans la

partition avant de l’ajouter ici.)

* Description (pour le professeur) est le texte qui apparaîtra dans le créateur de feuilles

d’exercices pour décrire la feuille

* Instructions (pour l’élève) sera le texte créé au-dessus de la première question dans la feuille

de l’élève si vous choisissez Questions aléatoires. (Si vous choisissez Questions déterminées,

vous devriez créer les instructions pour l’élève dans la partition avant de l’ajouter ici.)

* Niveau de programme, si c’est d’application, devrait contenir de l’information sur le 

programme spécifique auquel les exercices de la feuille se rapportent,

* Faites une sélection sous Méthode de réalisation pour spécifier comment il est prévu de

remplir la feuille

* Choisissez le Rôle du professeur selon ce qui convient

* Spécifiez le Mode de participation pour lequel la feuille est prévue
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* L’option Mesures par question est seulement disponible si vous choisissez Questions
aléatoires. Cette option indique à Sibelius le nombre de mesures à consacrer à chaque question:

il est très important que cette option soit réglée correctement.

* L’option Questions par système indique à Sibelius comment obtenir la meilleure mise en page.

Si vos questions occupent 1,2 ou 4 mesures, vous pouvez laissez cette option sur Défaut. Sinon,

en réglant l’option vous imposez à Sibelius le nombre de mesures à placer sur un système avant

un saut de système.

* Voix affichées sur la feuille de l’élève spécifie quelles voix doivent figurer dans la feuille de

l’élève. Dans notre exemple donné ci-dessus, ce serait 1 et 3.

* Corrigé détermine si vous voulez que Sibelius offre le choix de réaliser un corrigé ou non.

Si vous activez cela, vous devrez aussi spécifier les Voix affichées sur le corrigé. Dans notre

exemple, ce serait 1 et 4.

* Enfin, choisissez la catégorie où placer la feuille d’exercices. Utilisez les boutons Choisir et

Retour pour parcourir les catégories. Dès que le bon endroit est trouvé, cliquez sur OK pour y

ajouter votre feuille d’exercices.

Modifier les feuilles d’exercices
Si vous devez créer une nouvelle catégorie ou modifier une déjà ajoutée, utilisez la boîte de

dialogue Modifier les feuilles d’exercices accessible en cliquant sur le bouton Modifier dans la

boîte de dialogue Ajouter au créateur d’exercices, ou en choisissant Fichier > Modifier les
feuilles d’exercices:

Les options à gauche de la boîte s’organisent selon les catégories et sous-catégories plutôt que

selon, les fichiers eux-mêmes:

* Choisissez Matières d’enseignement et d’étude ou Modèle au sommet de la boîte pour

choisir entre les deux types de contenu
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* Choisir et Retour permettent de parcourir la liste des catégories présentées à gauche de la boîte,

tout comme dans la boîte de dialogue Ajouter au créateur de feuilles d’exercices 

* Déplacer vers le haut et Déplacer vers le bas déplace la sous-catégorie sélectionnée vers le

haut ou vers le bas dans l’ordre de succession de la catégorie en cours

* Ajouter ajoute une nouvelle sous-catégorie: cliquez sur le bouton pour en choisir le nom

* Renommer renomme la sous-catégorie sélectionnée

* Supprimer enlève la sous-catégorie sélectionnée, et toutes les sous-catégories et feuilles

d’exercices qu’elle contient. Attention à cette option!

* Importer importe une catégorie de matériau provenant d’une source extérieure, par exemple

SibeliusEducation.com (b 5.18 SibeliusEducation.com).

* Exporter exporte la catégorie sélectionnée et ses sous-catégories dans un nouveau dossier à

l’intérieur du dossier Partitions, de manière à pouvoir le partager avec vos collègues, qui

peuvent ensuite l’Importer.

Les options à droite de la boîte concernent les feuilles d’exercices et les modèles eux-mêmes.

(La liste contient des éléments quand est atteinte une sous-catégorie qui contient des feuilles

d’exercices.)

* Déplacer vers le haut et Déplacer vers le bas déplace la sous-catégorie sélectionnée vers le

haut ou vers le bas dans l’ordre de succession de la catégorie en cours

* Modifier les éléments ouvre la boîte de dialogue Modifier les éléments d’une feuille
d’exercices, de sorte que vous pouvez en changer les réglages quand vous exportez la feuille. Les

options dans Modifier les éléments d’une feuille sont les mêmes que celles de la boîte de

dialogue Ajouter au créateur de feuilles d’exercices, excepté qu’il est impossible de

transformer une feuille d’exercices en modèle et vice-versa – cf. Ajouter dans le créateur de
feuilles d’exercices ci-dessus.

* Ouvrir une partition ouvre la partition musicale d’exercices afin de pouvoir y procéder à des

modifications de la musique ou des questions, etc... Quand les modifications sont terminées,

sauvegardez-la et fermez-la; il n’est pas nécessaire de l’ajouter de nouveau au créateur d’exercices.

* Renommer renomme la feuille d’exercices sélectionnée, en changeant le champ Nom (dans la
boîte de dialogue).

* Supprimer enlève la feuille sélectionnée de manière permanente. Attention à cette option!

Quand toutes les modifications sont faites, cliquez sur le bouton Fermer.
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6.1 Travailler avec des extensions

Sibelius prend en charge des extensions, qui sont des fonctions supplémentaires créées à l’aide

d’un langage de programmation appelé ManuScript. Plusieurs extensions très utiles sont prévues

dans le menu Extensions, organisé en autres sous-menus par catégorie, et décrits dans les thèmes

suivants. Vous pouvez également attribuer des raccourcis aux extensions que vous utilisez

fréquemment – b 5.12 Menus et raccourcis.

Vous pouvez arrêter une extension lors de son exécution : cliquez simplement sur le bouton

Arrêter extension qui apparaît en haut à gauche de l’écran. Vous pouvez aussi annuler la tache

qu’une extension effectue sur votre partition de la manière habituelle, en choisissant Editer >

Annuler (raccourci Ctrl+Z ou XZ) après l’avoir exécuté.

Extensions supplémentaires
De nouvelles extensions sont constamment développées pour Sibelius. D’autres extensions

gratuites sont ajoutées sur le site Web de Sibelius de temps à autre – choisissez Aide > Rechercher
des actualisations ou allez sur www.sibelius.com/download/plugins pour consulter ce qui est

disponible.

Si vous écrivez une extension que vous estimez utile pour d’autres utilisateurs de Sibelius, veuillez

envoyer les détails par e-mail à sibhelpUK@sibelius.com et nous envisagerons de les inclure sur

notre site Web ou dans des versions ultérieures de Sibelius. Les bonnes extensions sont bien

rémunérées !

Et si vous avez une idée pour une extension mais que vous ne vous ne vous sentez pas capable de

l’écrire vous-même, dites-le nous.

Installer de nouvelles extensions
Pour installer une nouvelle extension, copiez le fichier d’extension (portant l’extension .plg) dans le

dossier Extensions du dossier de vos données d’application. L’extension sera automatiquement

chargée la prochaine fois que vous exécuterez Sibelius. Pour obtenir plus d’aide avec l’installation

des extensions, allez à www.sibelius.com/download/plugins.

Modifier des extensions
Extensions > Modifier extensions vous permet de décharger, recharger, supprimer, éditer et

créer de nouvelles extensions.

Sélectionnez une extension dans la liste et cliquez sur le bouton approprié :

* Décharger une extension la supprime de Sibelius ; cela ne la supprime pas de votre disque dur,

mais l’enregistre en mémoire. Les extensions déchargées sont décrites ainsi dans la liste.

* Recharger une extension la récupère après l’avoir déchargée

* Supprimer une extension l’efface de votre disque dur

* Nouveau et Editer servent à créer vos propres extensions.

http://www.sibelius.com/download/plugins/
http://www.sibelius.com/download/plugins/
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Créer vos propres extensions
Cela exige certaines connaissances du langage ManuScript, qui est assez simple à assimiler mais

échappe aux ambitions de cette Référence. Choisissez Aide > Documentation > Référence de
langage ManuScript pour tout savoir.

Extensions > Afficher fenêtre d’extension affiche une fenêtre de tracé, qui est utile pour

déboguer les extensions que vous développez. Consultez la documentation Manuscript pour en

savoir plus.
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Ajouter des altérations à toutes les notes
Permet de forcer le placement des altérations avant chaque note, mêmes les naturelles, ou les dièses/

bémols qui sont déjà dans l’armure ou même si la note est liée à la précédente. Cette notation est parfois

utilisée dans les partitions atonales ou dans les partitions qui n’utilisent pas d’armures. Pour utiliser

l’extension, sélectionnez le passage que auquel vous souhaitez ajouter des altérations et choisissez

Extensions > Ajouter des altérations à toutes les notes. Il est recommandable de faire Mise en
page > Réinitialiser l’espacement des notes ensuite pour faire de la place pour toutes les altéra-

tions ajoutées.

Les altérations de quart de ton ne sont pas encore gérées par cette extension : elles seront étique-

tées avec le texte Q, que vous pouvez rechercher en utilisant Modifier > Rechercher pour vous

assurez que toutes les notes sur la même ligne ou espace après la mesure sont précédées du sym-

bole pertinent.

Extension écrite par Peter Hayter.

Ajouter des altérations à toutes les notes dièses ou bémols
Cette extension ajoute des altérations à toutes les notes dièses ou bémols même si elles apparais-

sent tôt dans la même mesure, sauf si elles existent déjà dans l’armure.

Extension écrite par Stefan Behrisch (www.werklabor.de).

Ajouter l’altération Ficta
Dans la musique ancienne, les altérations sont souvent utilisées mais pas écrites dans le manuscrit

original en raison des pratiques interprétatives de l’époque. Les éditions modernes montrent sou-

vent ces musica ficta en plaçant des petites altérations au dessus des notes en question. Cette exten-

sion insère des symboles d’altérations au-dessus des notes ainsi que des messages de pitch bend

MIDI, nécessaires pour rendre les notes dièses ou bémols le cas échéant.

Pour utiliser l’extension, sélectionnez la ou les note(s) sur lesquelles vous souhaitez ajouter la ficta

et choisissez Extensions > Altérations > Ajouter l’altération Ficta. Une boîte de dialogue appa-

raît : sélectionnez si vous souhaitez ajouter des dièses, des bémols ou des signes naturels... puis cli-

quez sur OK.

L’extension occulte l’altération “normale” de la note puis ajoute le symbole approprié au-dessus de

la note.

Extension écrite par Chris May.

Réorthographier les dièses en bémols/Réorthographier les bémols en dièses
Modifie l’orthographe des altérations dans le passage sélectionné. Sélectionnez simplement un

passage, choisissez Extensions > Altérations > Réorthographier les bémols en dièses ou

Extensions > Altérations > Réorthographier les dièses en bémols, et tous les dièses/bémols

dans le passage sélectionné seront réorthographiés. Les têtes de notes spéciales et les données

d’exécution enregistrée seront perdues lors de l’utilisation de cette extension.
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Simplifier les altérations
Cette extension réorthographie toutes les altérations dans une partition ou un passage choisi aux

armures correctes ; c’est particulièrement pratique pour retirer les altérations errantes qui peuvent

avoir été laissées après certaines opérations d’édition (p.e. la transposition ou l’ajout d’une armure

à de la musique existante). Pour utiliser l’extension, sélectionnez un passage (ou la partition

entière) et choisissez Extensions > Altérations > Simplifier les altérations.

Extension écrite par Peter Hayter.
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Ajouter les degrés de l’échelle schenkerienne
Cette extension analyse votre partition et ajoute une notation de degrés de l’échelle schenkerienne au-

dessus ou au-dessous de la portée.

Pour utiliser l’extension, sélectionnez un passage dans une armure unique (p.e. qui ne contient

aucun changement d’armure) ou votre partition entière (si elle est dans une seule armure) et

choisissez Extensions > Analyse > Ajouter les degrés de l’échelle schenkerienne. Voici la boîte

de dialogue qui apparaît:

* Empiler verticalement détermine si les symboles ^ ou v doivent être dessinés au-dessus du

degré de l’échelle (p.e. option activée) ou sur sa gauche (p.e. option désactivée).

* Voix vous permet de sélectionner la voix sur la portée à analyser.

* Style de texte détermine l’apparence (p.e. encadré, italique, etc.) des degrés de l’échelle et où ils

doivent être écrits : tous les styles de texte sauf la basse figurée les place au-dessus de la porté, la

basse figurée les place au-dessous.

* Ajouter au passage sélectionné/partition entière vous permet de définir l’étendue du

fonctionnement de l’extension ; sélectionnez la partition entière uniquement si celle-ci ne

contient aucun changement d’armure.

Quand vous cliquez OK, les dégrées de l’échelle sont ajoutés à votre partition avec les paramètres

corrects.

Extension écrite par John Kennedy.

Comparer les portées
Compare deux portées d’un même fichier et souligne les différences entre elles. Pour utiliser cette

extension, sélectionnez un passage sur deux portées de votre partition (utilisez Ctrl+clic ou X-clic

pour sélectionner deux portées non-adjacentes si vous le désirez), puis choisissez Extensions >

Analyse > Comparer les portées. Une boîte de dialogue apparaît :

* Notes et silences : cherche les différences de valeur de notes, de pitch, de voix, de note de

réplique, de masquage, etc.

* Lignes : cherche les différences de types de lignes, longueur, etc. Naturellement, cette option ne

fonctionne qu’avec les lignes de portées car les lignes de système s’appliquent à toutes les portées

également.

* Clefs : cherche les différentes clefs dans les deux portées.

* Texte : cherche les différences dans les objets de texte ; elle ne soulignera pas les différences de

police ou de taille de point entre deux portées mais elle le fera parmi les mots eux-mêmes

permettant ainsi de vérifier des paroles sur deux portées vocales qui partagent les mêmes

rythmes. Comme avec les lignes, cette option ne fonctionne qu’avec le texte de portée, pas avec

le texte de système.

* Souligner les différences dans : vous permet de sélectionner si vous souhaitez souligner dans

la Portée supérieure, la Portée inférieure ou les deux (en cochant les deux options).

* Passage sélectionné/Partition entière : sélectionne si la comparaison s’applique juste au

passage sélectionné ou à l’intégralité de la partition.
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Quand vous cliquez OK, l’extension examine votre partition ; à la fin de la procédure, une boîte de

message s’affiche, vous indiquant le nombre de différences trouvé.

Si vous souhaitez retirer l’affichage créé par l’extension, reportez-vous à Retirer tout le
soulignage à la page 571.

Extension écrite par Neils Sands.

Trouver un motif
Examine votre partition pour les motifs assortissant soit les relations d’intervalles soit les

rythmiques (ou les deux) dans un passage donné et souligne les correspondances

(b 5.10 Surbrillance). C’est particulièrement pratique pour l’analyse, comme pour trouver

toutes les occurrences d’un sujet de fugue ou examiner la manière dont un patron rythmique

donné est utilisé dans une pièce.

Pour utiliser cette extension, sélectionnez le motif que vous souhaitez assortir et choisissez

Extensions > Analyse > Trouver un motif. Une boîte de dialogue apparaît vous permettant de

régler quelques options.

* Assortir le rythme : activez cette option si vous souhaitez trouver des correspondances

rythmiques ; vous pouvez préciser la quantité de variation autorisée par rapport au motif

spécifié (une valeur de 0% indique que vous n’accepterez que des correspondances exactes).

* Assortir les hauteurs : activez cette option si vous souhaitez chercher des correspondances

d’intervalles. De nouveau, vous pouvez préciser la quantité de variation autorisée ; réglé sur 0%,

seules les transpositions exactes du motif sont assorties alors que les transpositions inexactes ou

diatoniques ne le sont pas ; par conséquent (et par exemple) dans une fugue, l’extension trouvera

de vraies réponses mais aucune tonale. Augmentez la variation autorisée pour trouver des

transpositions inexactes.

* Le motif original est dans la voix x : vous permet de choisir dans quelle voix l’extension

devrait trouver le motif original. (Cette option détermine uniquement où se trouve le motif à

assortir - l’extension cherchera toujours les correspondances dans toutes les voix du reste de la

partition).

Activez Assortir le rythme et Assortir les hauteurs pour trouver uniquement les occurrences

qui correspondent aux deux.

Cliquez OK et une barre de progression s’affiche, vous indiquant la portée examinée par

l’extension. Après un moment, l’extension vous indique combien de correspondances elle a trouvé,

les soulignant en jaune.

Extension écrite par James Larcombe et Byron Hawkins.

Trouver une tessiture
Calcule la tessiture (p.e. les notes les plus basses et les plus hautes), le pitch moyen et les pitchs les

plus fréquents, tous en pitch de concert, d’un passage donné. C’est pratique si, par exemple, vous

être en train d’écrire de la musique vocale et souhaitez savoir quels genres de demandes vous

placez à vos chanteurs.

Pour lancer cette extension, sélectionnez un passage (ou triple-cliquez sur une portée pour

calculer sa tessiture sur l’ensemble de la partition) et choisissez Extensions > Analyse > Trouver
tessiture.
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Calculer les statistiques
Créez un rapport indiquant combien de mesures, portées, pages et autres objets sont dans la

partition ouverte ou dans toutes les partitions d’un dossier donné ; c’est un outil particulièrement

pratique pour les copistes qui souhaitent déterminer leurs tarifs pour des travaux de copie.

Pour lancer l’extension sur une seule partition, sélectionnez Extensions > Traitement global >
Calculer les statistiques puis cliquez sur Partition en cours dans la boîte de dialogue qui

apparaît. Si vous souhaitez calculer les statistiques pour, par exemple, un mouvement sur une pièce

multi-mouvement dans la même partition, sélectionnez les mesures en question avant de lancer

l’extension, puis cliquez sur Partition en cours.

Pour lancer l’extension dans un dossier, sélectionnez Extensions > Traitement global > Calculer
les statistiques puis cliquez sur Traiter le dossier. Sélectionnez le dossier dont vous souhaitez

calculer les statistiques. Lorsque vous cliquez sur OK, Sibelius traite chacun des fichiers, un par un

(aucune modification n’est effectuée aux fichiers).

Quand la partition ouverte ou toutes les partitions du dossier ont été traitées, Sibelius affiche une

boîte de dialogue indiquant la quantité de chaque type d’objet trouvé. Cliquez Écrire un fichier
texte pour enregistrer les résultats sous la forme d’un fichier texte dans le dossier choisi ou dans

celui de la partition ouverte.

Extension écrite par Bob Zawalich. 

Convertir un dossier de fichiers MIDI
Le traitement convertit tous les fichiers MIDI dans le dossier spécifié, tout en les enregistrant avec

les mêmes noms de fichiers en remplaçant l’extension par .sib. Ces fichiers doivent être des fichiers

MIDI standards (avec l’extension .mid sous Windows) plutôt que d’autres formats de séquenceur –

b 9.5 Ouvrir des fichiers MIDI.

Convertir un dossier de fichiers MusicXML
Le traitement convertit tous les fichiers MusicXML dans le dossier spécifié, tout en les enregistrant

avec les mêmes noms de fichiers en remplaçant l’extension par .sib.

Pour utiliser cette extension, sélectionnez Extensions > Traitement global > Convertir un
dossier de fichiers MusicXML et choisissez le dossier que vous souhaitez convertir. Sibelius

convertit chaque fichier MusicXML qu’il trouve dans le dossier indiqué, en les sauvegardant sous la

forme de partition Sibelius avec le même nom de fichier que l’original.

Pour en savoir plus sur les fichiers MusicXML, b 9.6 Ouvrir des fichiers MusicXML.

Convertir un dossier de partitions vers une version antérieure
Exporte toutes les partitions dans un dossier donné sous la forme de partitions pour Sibelius 5,

Sibelius 4, Sibelius 3 ou Sibelius 2 – b 9.12 Exporter vers des versions antérieures.

Pour utiliser cette extension, sélectionnez Extensions > Traitement global > Convertir un
dossier de partitions vers une version antérieure et choisissez le dossier que vous souhaitez
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convertir. Une boîte de dialogue simple s’affiche. Indiquez le dossier de destination des fichiers

exportés, la version de Sibelius vers laquelle réalisée la conversion et comment modifier les noms de

fichier pour éviter d’écraser les fichiers originaux. Cliquez sur OK pour confirmer vos choix.

Extension écrite par Bob Zawalich.

Convertir un dossier de partitions vers des images
Convertit un dossier de partitions en fichiers images au format indiqué – b 9.8 Exporter des
images.

Pour utiliser cette extension, sélectionnez Extensions > Traitement global > Convertir un
dossier de partitions vers des images et choisissez le dossier que vous souhaitez convertir. On

vous demandera de sélectionner le format des images ; vous pouvez aussi choisir d’utiliser ou non

les paramètres par défaut. Généralement, vous pouvez laisser Utiliser les paramètres par défaut
activé et cliquez simplement sur OK pour enregistrer tous les fichiers ; désactivé, on vous

demandera de sélectionner les paramètres pour chaque fichier dans le dossier.

Convertir un dossier de partitions vers le format MIDI
Le traitement convertit toutes les partitions dans un dossier au format MIDI standard en utilisant

les mêmes noms de fichier mais avec une extension .mid – b 9.9 Exporter des fichiers MIDI.

Convertir un dossier de partitions sous forme de pages web
Sauvegarde des pages web Scorch pour toutes les partitions d’un dossier, ainsi que pour générer une

page d’index avec des liens vers toutes les partitions individuelles, prêtes à être chargées sur votre site

web - cf. b 9.11 Exporter des pages Web Scorch.

Choisissez Extensions > Traitement global > Convertir un dossier de partitions sous forme
de pages web Une boîte de dialogue apparaît :

* Sélectionnez le dossier source en cliquant sur le bouton Parcourir sous Convertir toutes les
partitions dans ; pour inclure celles des sous-dossiers, assurez-vous que Convertir aussi les
partitions dans les sous-dossiers est activé

* Sélectionnez le dossier de destination en cliquant sur le bouton Parcourir sous Mettre les
pages web dans, ou activez l’option Utiliser le même dossier pour enregistrer les pages web

dans le même dossier que les partitions originales.

* Désactivez Créer une page d’index si vous ne souhaitez pas que l’extension génère une page

d’index avec les liens vers toutes les autres pages web Scorch ; nous vous recommandons de

laisser cette option activée.

* Sélectionnez le Style de pages web dans la liste fournie ; ces modèles sont intégrés à l’extension

et ne peuvent être modifiés, même en les éditant depuis le dossier Papier à musique de

Sibelius.

* Dimensions de la partition dans la page web règle la largeur de la fenêtre Scorch pour

chaque page web ; la valeur par défaut de 720 pixels est la correcte dans la plupart des cas.

* Si vous souhaitez que les gens puissent imprimer ou enregistrer les partitions depuis votre page

web, sélectionnez Autoriser l’impression et l’enregistrement.
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Cliquez OK et Sibelius traite chaque fichier, un par un. Quand l’extension a terminé, vous

disposerez d’un dossier plein de fichiers, prêts à être chargés sur votre site web ou votre intranet !

Extension écrite par Neils Sands.

Exporter chaque portée sous forme d’audio
Exporte chaque portée de la partition sous forme d’un fichier audio séparé, ce qui se révèle

particulièrement pratique si vous souhaitez les mélanger les uns aux autres dans un système audio

numérique (DAW) comme Pro Tools.

D’abord, assurez-vous que votre copie de Sibelius est réglée pour la lecture en utilisant des

instruments virtuels, p.e. en utilisant la bibliothèque Sibelius Sounds Essentials inclue – voir

Réglages de Sibelius Sounds Essentials à la page 315.

Si vous souhaitez exporter seulement certaines portées de votre partition, sélectionnez-les avant de

lancer l’extension ; dans le cas contraire, pour exporter toutes les portées, assurez-vous que rien

n’est sélectionné. Puis sélectionnez Extension > Traitement global > Exporter chaque portée
sous forme d’audio. Une simple boîte de dialogue s’affiche, dans laquelle vous pouvez choisir

entre Exporter les instruments multi-portées ensemble (ce qui exporte, p.e., les portées main

gauche et main droite d’un piano ensemble) ou Exporter chaque portée séparément (ce qui les

exporte en tant que fichiers audio séparés).

Vous pouvez aussi choisir le format ou le nom de fichier à utiliser, ainsi que l’emplacement où les

fichiers audio seront conservés ; par défaut, ils seront sauvegardés avec la partition. Cliquez OK et

une barre de progression apparaît au fur et à mesure de l’exportation de chaque fichier ; cela peut

prendre un certain temps, soyez patient.

Extension écrite par Bob Zawalich.

Importer un Style maison dans un dossier de partitions
Applique un style maison donné à tous les fichiers d’un dossier sélectionné.

Pour utiliser l’extension, sélectionnez Extension > Traitement global > Importer un style
maison dans un dossier de partitions. On vous demandera de sélectionner le fichier de

bibliothèque de style maison (.lib) que vous souhaitez appliquer puis de sélectionner le dossier de

fichiers sur lequel l’appliquer.

Un certain nombre de styles maison prédéfinis sont fournis dans le dossier Styles maison dans

votre dossier de Sibelius – b 8.8 Style maison.

Extension écrite par Michael Kilpatrick.

Imprimer plusieurs copies
Vous permet d’imprimer plusieurs copies d’une sélection de partitions dans un dossier (ainsi que

des éventuels sous-dossiers contenant des partitions, le cas échéant). Pour imprimer plusieurs

copies de parties, il est plus facile d’utiliser les options Copies et Imprimer partie(s) de la fenêtre

Parties (b 7.1 Travailler avec des parties séparées).
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Pour utiliser cette extension, fermez toutes les partitions ouvertes puis sélectionnez Extensions >

Traitement global > Imprimer plusieurs copies. On vous demandera de choisir un dossier. Faites

votre sélection et une boîte de dialogue apparaît :

* Sélectionnez le dossier dans la liste Dossiers contenant des partitions sur la gauche

* Sélectionnez dans la liste Partitions dans le dossier sélectionné, réglez le menu déroulant

Copies sur le nombre de copies que vous souhaitez imprimer puis cliquez sur Ajouter fichier.

Cliquez Ajouter-les toutes pour ajouter toutes les partitions du dossier sélectionné à la liste En
attente d’impression, avec le nombre de copies désiré.

* Élaborez la liste dans En attente d’impression sur la droite en ajoutant les fichiers désirés.

Quand vous êtes prêt à imprimer, cliquez sur Imprimer.

L’extension imprime toutes les partitions dans la file d’attente le nombre de fois indiqué avec les

options par défaut (il n’est pas possible de régler les options comme le livret, etc... pour l’extension).

Le bouton Lire les copies ouvre chaque fichier dans le dossier choisi et cherche le texte

~copies=n connexe dans les cinq premières mesures des cinq premières portées, où n est le

nombre de copies à imprimer et les ajoute à la liste En attente d’impression avec le nombre

approprié de copies. Si un fichier contient plus d’un objet texte de ~copies=n, la partition est

considérée en attente d’extraction de parties et est écartée de l’impression.

Extension écrite par Peter Hayter et Gunnar Hellquist.
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6.5 Extensions de symboles d’accord

Ajouter les symboles d’accord avec capo
Ajoute un ou plusieurs jeux de symboles d’accord supplémentaires, généralement au-dessus des

symboles d’accord existants, correspondant aux accords que la guitare devrait jouer avec un capo

sur une frette donnée. C’est particulièrement pratique pour les guitaristes qui trouvent difficile de

jouer dans l’armure indiquée ; la guitare peut plutôt fixer un capo sur sa guitare et jouer des

accords plus simples.

Pour lancer l’extension, sélectionnez la portée qui contient les symboles d’accord existants et

choisissez Extensions > Symboles d’accord > Ajoute les symboles d’accord avec capo. Une

boîte de dialogue apparaît vous permettant de choisir la frette sur laquelle placer le capo et vous

indique l’armure à laquelle elle correspond. Vous pouvez choisir si les nouveaux symboles d’accord

doivent ou non être en gras, en italique ou entre parenthèses. Vous pouvez aussi choisir le style de

texte que vous souhaitez (bien qu’en général celui par défaut des Symboles d’accord est approprié).

L’extension dispose de sa propre boîte de dialogue Aide, si vous avez besoin d’une assistance

complémentaire.

Extension écrite par Bob Zawalich.

Ajouter des symboles d’accord 
Analyse l’harmonie de votre musique et ajoute automatiquement les symboles d’accord appropriés

au-dessus des portées sélectionnées. Vous pouvez choisir d’analyser n’importe laquelle ou toutes

les portées dans votre partition et sélectionnez où les symboles d’accord seront créés.

Pour lancer l’extension, sélectionnez les portées sur lesquelles se trouve l’harmonie (p.e. les deux

portées d’un piano) puis choisissez Extensions > Symboles d’accord > Ajouter des symboles
d’accord. Une boîte de dialogue apparaît :

Généralement, vous pouvez laisser les paramètres par défaut - cliquez simplement sur OK pour

ajouter les symboles d’accord à votre partition.

Si vous souhaitez modifier les paramètres, il y a de nombreuses options pour contrôler les résultats

:
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* Ajouter des symboles d’accord : au début de chaque mesure ou de chaque valeur de note

depuis le début de la mesure (où la valeur de note est sélectionnée dans un menu déroulant) :

cette option détermine la fréquence d’ajout de symboles d’accord à la partition.

* Option de notation : ces options contrôlent s’il faut écrire un symbole d’accord à chaque

position indiquée dans Ajouter des symboles d’accord (en haut de la boîte de dialogue) ou s’il

faut éviter d’écrire ceux qui se répètent :

% Insérer un symbole d’accord à chaque position indiquée écrit toujours un symbole

d’accord, même si l’accord en cours est le même.

% Insérer un symbole d’accord uniquement si la note fondamentale a changé : cette

option sélectionnée, l’extension ne créera pas de symbole d’accord si la note fondamentale n’a

pas changé depuis le dernier symbole d’accord. L’accord lui-même pourrait changer, p.e. de

Do à Do7, mais le symbole d’accord sera toujours omis avec cette option sélectionnée.

% Insérer un symbole d’accord uniquement si le nom de l’accord a changé : cette option

sélectionnée, l’extension omettra uniquement un symbole d’accord s’il est identique au

dernier symbole créé, p.e. le deuxième accord de Do consécutif ne sera pas créé, mais un Do7
suivant un Do sera écrit.

% Écrire les symboles d’accord sur la portée suivante : cette option détermine le nom de la

portée de la partition sur laquelle créer les symboles d’accord. Si l’extension semble ne pas

ajouter de symboles d’accord, c’est peut être parce que vous avez choisi de créer les symboles

d’accord sur une portée occultée.

Extension écrite par James Larcombe et Bob Zawalich.

Symboles d’accord sous forme de fractions
Convertit les symboles d’accord qui ont des notes de basse sous le format “barre oblique” (p.e.

Fmaj7/G) au format fractionnel, où le nom de l’accord, la barre et la note de basse sont empilés

verticalement, comme une fraction ( ). Pour utiliser cette extension, sélectionnez la musique

contenant les accords dont le format doit changer et choisissez Extensions > Symboles d’accord >

Symboles d’accord sous forme de fractions. Vous pouvez choisir si l’extension doit diviser

chaque élément individuellement, en créant trois objets texte individuels pour chaque accord

(Utiliser un caractère tiret bas séparé) ou s’il doit plutôt créer uniquement deux objets, dont le

supérieur sera souligné (Utiliser une police soulignée). Pour régler l’espace entre les accords,

cliquez sur le bouton Règles de gravure. Cliquez sur OK pour lancer la conversion.

L’extension modifie les symboles d’accord existants de manière à ce qu’ils deviennent des symboles

d’accord “legacy” (voir Saisie de symbole d’accord Legacy à la page 126), ce qui signifie qu’ils

ne seront pas pris en compte lors de l’utilisation de la Mise en page > Réinitialiser l’espacement
des notes, qu’ils ne répondront pas aux modifications sur la page Symboles d’accord de Style
maison > Règles de gravure ou aux options du sous-menu Modifier > Symbole d’accord.

Extension écrite par Bob Zawalich.

Fma 7
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Réaliser les symboles d’accord 
Créez un accompagnement simple de guitare ou piano dans une variété de styles, selon les

symboles d’accord et/ou les diagrammes d’accord dans votre partition. Sélectionnez Extensions >

Symboles d’accord > Réaliser des symboles d’accord. Si vous n’avez pas sélectionné de

passage, on vous demandera si vous souhaitez que le processus soit appliqué à toute la partition. La

boîte de dialogue suivante apparaît ensuite :

* Vous pouvez choisir entre trois instruments différents à ajouter : Piano, ce qui ajoute deux

portées à votre partition et divise les accords sur les deux portées ; Piano (uniquement main
gauche), qui écrit un accompagnement sur une seule portée, idéal si la mélodie que vous

réalisez est sur la portée de main droite ; Guitare (notation), qui ajoute une seule portée de

notation à votre partition ; et Guitare (tab), qui ajoute une portée de tablature en utilisant

l’accordage standard pour guitare à six cordes (bien que vous puissiez le changer ensuite si vous

le souhaitez). Pour les autres instruments, vous devriez sélectionner une de ces options puis

copier la musique au long de votre instrument choisi après avoir lancé l’extension.

* Le menu Style d’accord vous permet de contrôler comment les accords sont réalisés : Accord
pour chaque symbole d’accord crée un nouvel accord à chaque fois que l’accord change ;

Accord pour chaque battement crée un nouvel accord pour chaque battement (quelque soit la

fréquence des changements d’accords) ; Accords suivent le rythme de la partition vous

permet de réaliser les accords au même rythme que l’un des portées existantes dans votre partition

; Croche Alberti crée un patron à la manière Alberti en utilisant des croches ; Double-croche
Alberti crée le même genre de patron en utilisant des double-croches ; Arpèges de croches crée

des patrons d’arpèges montants avec des croches et Arpèges de double-croches crée des arpèges

montants en utilisant des double-croches.
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Les résultats obtenus pour chacune de ces six options sur une portée de notation de guitare sont

indiqués ci-dessous :

* Options pour ‘Accords suivent le rythme de la partition’ vous permettent de choisir la

portée (et la voix sur cette portée) utilisée comme base pour le rythme du style d’accord

d’Accords suivent le rythme de la partition 

* Si vous sélectionnes des styles d’accords Alberti ou arpèges, vous pouvez choisir de ne pas voir le

dernier accord du morceau arpégé ; dans ce cas, assurez-vous que Ne pas arpéger le dernier
accord est activé

* Avertissement concernant les symboles d’accord non-reconnus affiche une boîte de

dialogue si l’extension rencontre un symbole d’accord qu’il ne sait pas interpréter.

Cliquez sur OK et la barre de progression apparaît pendant un moment lorsque les accords sont

écrits dans votre partition. L’extension crée un nouvel instrument sur lequel écrire sa réalisation. Il

peut chevaucher vos symboles ou diagrammes d’accord. Utilisez Mise en page > Optimiser
l’espacement des portées (voir page 672) pour le corriger.

Vous pouvez utiliser cette extension plus d’une fois dans la même partition, de manière à créer

plusieurs couches d’accompagnement : par exemple, vous pouvez désirer ajouter un piano

exécutant les accords par bloc et une guitare interprétant un style aux doigts. Pour ce faire, lancez

de nouveau l’extension et elle créera un nouvel instrument Si vous n’aimez pas le résultat, vous

pouvez toujours effacer les dernières portées à l’aide de la boîte de dialogue Créer > Instruments.

Extension écrite par Bob Zawalich. 
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6.6 Extensions d’outils de composition

Matrice 12-tons
Génère une matrice 12-tons pour une rangée de tons spécifiques (rangée de notes) qui peut soit

être saisie manuellement dans l’extension ou prise dans une sélection faite dans la partition

ouverte. Choisissez Extensions > Outils de composition > Matrice 12-tons. La boîte de

dialogue suivante apparaît :

Pour saisir la rangée manuellement, entrez les classes de hauteur en utilisant les numéros 0 à 11,

séparés par des espaces, dans le champ en haut, puis cliquez Rangée saisie (vous pouvez penser

que les nombres 0 à 11 représentent les notes de Do à Si respectivement). Pour lire la rangée dans

la partition, cliquez simplement sur Partition. 

Quand Régler la matrice de manière à ce que P0/I0 soit la première rangée et colonne est

activé, l’extension transpose la rangée de sorte que la première note soit de classe de hauteur 0.

Cela n’a aucun effet lors de la lecture de la rangée dans la partition.

Le tableau sera rempli pour vous montrer toutes les variantes possibles de la rangée. La première

rangée, quand elle est lue de gauche à droite, montre la rangée des tons primaires ; en la lisant de

droite à gauche montre le rétrograde. La première colonne, quand elle est lue de haut en bas,

montre l’inversion de la rangée ; de bas en haut, la rétrograde inversion. Les colonnes et rangées

suivantes montrent la même information en utilisant toutes les permutations de rotation possibles.

L’extension peut aussi noter toutes les rangées générées en notation. Pour ce faire, cliquez sur le

bouton Rangées en notation.

Extension écrite par Bob Zawalich.
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Ajouter un motif de batterie
Crée une portée de batterie dans votre partition et écrit un motif de batterie dans l’un des 24 styles

pré-définis. Pour utiliser l’extension, choisissez simplement Extensions > Outils de
composition > Ajouter motif de batterie. (Vous n’avez pas à créer une portée de batterie

préalablement). La boîte de dialogue suivante apparaît :

* Choisissez un Style depuis la liste déroulante. Les styles disponibles dans la liste - qui incluent

blues, rock, pop, jazz, Latin et Country - sont appropriés pour l’armure : l’extension ne vous

proposera jamais un motif de valse en 4/4 ou un rythme bluesy en 3/4 ! Les motifs proposent

tous un tempo recommandé dans lequel ils sonnent le mieux. Il est recommandé de choisir un

motif qui corresponde au même genre de tempo que votre partition.

* Ajouter une indication métronomique crée une indication métronomique au début de la

partition (ou du passage sélectionné si vous travaillez sur une partie d’une partition), réglant le

tempo d’exécution sur le tempo recommandé par le motif de batterie choisi.

* Débuter avec une mesure d’intro détermine si vous souhaitez que le motif débute avec un fill

d’introduction, menant au motif régulier.

* Mesure de fill/break toutes les n mesures vous permet de choisir si le motif devrait inclure

une mesure de fill ou de break et sa fréquence.

* Finir avec une mesure d’outro indique si l’extension devrait terminer le motif avec une ou

deux mesures de conclusion (selon le motif).

Dès que vous avez choisi les options correctes, cliquez sur OK. Une barre de progression apparaît

pendant un moment alors que l’extension crée le motif de batterie, puis vous êtes prêt à l’exécuter.

Si vous décidez que vous voulez modifier le motif, vous pouvez simplement choisir Extensions >

Outils de composition > Ajouter un motif de batterie de nouveau ; le motif de batterie existant

est automatiquement effacé et remplacé avec le nouveau.

Si votre partition utilise une variété d’armures, quand vous choisissez Notes > Ajouter un motif
de batterie, un message apparaît vous demandant de sélectionner un passage avec une armure

unique, puis essayez de nouveau. 

Extension écrite par Gunnar Hellquist. 
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Ajouter une portée de points de montage
Ajoute une portée de percussion au bas de votre partition avec des têtes de notes en forme de croix

à la position rythmique la plus proche de l’emplacement de chaque point de montage. Pour utiliser

l’extension, choisissez simplement Extensions > Outils de composition > Ajouter une portée
de points de montage.

Cela permet de visualiser facilement la relation entre le point de montage et la musique. Sibelius

ajoute une note à la double-croche de l’emplacement de chaque point de montage. Si vous changez

le tempo de votre partition ou ajouter/supprimer des points de montage, vous pouvez lancer

l’extension de nouveau ; elle écrasera les notes existantes avec les nouvelles.

Extension écrite par Bob Zawalich.

Ajouter une harmonie simple
Ajoute une harmonisation simple sur un passage mélodique sélectionné dans la partition ouverte. 

* Choisissez votre style d’accompagnement dans Style d’accord : accords par bloc, arpèges ou

basse Alberti 

* L’extension détectera automatiquement l’armure de la pièce, mais ne peut détecter les mineurs

relatifs. Si l’armure est, par exemple, Sol majeur au lieu de Mi mineur, vous devrez sélectionner

l’armure manuellement.

* Modifiez Mélodie dans la voix dans le cas, peu probable, que la mélodie à laquelle vous

souhaitiez ajouter l’harmonisation ne se trouve pas dans la voix 1.

* Modifier accord vous permet de régler le taux du rythme d’harmonisation généré par

l’extension. Chaque groupe de temps fonctionne généralement mieux. Mais si les

changements d’harmonie sont trop fréquents ou pas assez, vous pourrez peut-être préférer

Chaque mesure ou Chaque temps, respectivement.

* Écrire l’harmonie pour vous permet de choisir l’instrument (piano ou guitare) que l’extension

devrait utiliser pour l’harmonisation. Vous pouvez bien entendu copier ou arranger l’harmonie

sur d’autres instruments ensuite.

* Forcer l’accompagnement de plage moyenne peut être utile si vous demandez à l’extension

d’harmoniser une mélodie qui couvre une plage particulièrement importante ou si vous

harmonisez une mélodie sur un instrument particulièrement bas ou haut. Cela est du au fait

que, sans cette option activée, l’harmonisation générée sera écrite dans une tessiture similaire à

celle de la mélodie harmonisée. Par conséquent, si vous harmonisez une mélodie pour le piccolo,

vous obtiendrez de meilleur résultat avec cette option étant donné que dans le cas contraire vous

risquez d’attirer le chien du voisin !

Extension écrite par Bob Zawalich, Andrew Davis et Daniel Spreadbury.

Dessiner une barre de mesure à rythme non mesuré
Permet de créer une barre de mesure au niveau d’une note sélectionnée, divisant alors la mesure à

cet endroit.

Cette option vous permet d’écrire de la musique directement dans Sibelius, sans avoir à vous

préoccuper des longueurs de mesure ou des indications de mesure : il vous suffit d’entrer des notes

et de lancer l’extension lorsque vous souhaitez dessiner une barre de mesure à la fin d’une mesure.
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L’extention dessine alors la barre de mesure, calcule l’indication de mesure appropriée puis avance

le curseur de saisie des notes pour traiter la note suivante..

Pour de meilleurs résultats, assignez un raccourci-clavier à cette extension (b 5.12 Menus et
raccourcis), pour que vous n’ayez qu’à saisir un raccourcir pour insérer une barre de mesure

pendant la saisie des notes.

Pour utiliser cette extension :

* Sélectionnez Affichage > Panorama pour basculer en affichage panoramique.

* Créez une grande variété d’indications de mesure pour pouvoir avoir plein d’endroit où écrire,

par exemple 124/4.

* Commencez maintenant à saisir normalement des notes.

* Lorsque vous souhaitez insérer une barre de mesure, sans avoir à désélectionner la dernière note

saisie, tapez simplement le raccourci-clavier assigné à cette extension, ou choisissez

Extensions > Outils de composition > Dessiner une barre de mesure à rythme non
mesuré.

* Une barre de mesure est insérée à la suite de la dernière note saisie et une indication de mesure

appropriée est créée au début de la nouvelle barre de mesure.

* Le curseur de saisie des notes est déplacé au début de la nouvelle barre de mesure pour vous

permettre de continuer à saisir des notes.

N’oubliez pas que l’extension ne peut pas dessiner une barre de mesure à la moitié d’un multiplet

que vous êtes en train de saisir : si vous essayez de le faire, la barre de mesure sera ajoutée à la suite

du multiplet.

L’extension essaie de chercher une indication de mesure appropriée pour chaque mesure, à partir

des valeurs des notes utilisées dans la mesure ; vous pouvez bien évidemment modifier l’indication

de mesure normalement, si vous le souhaitez. Si vous ne souhaitez pas que l’extension ajoute

d’indication de mesure, lancez-la sans sélectionner quoi que ce soit dans la partition, et dans la

boîte de dialogue qui apparaît à l’écran, réglez Utiliser indications de mesure sur Non.

Vous pouvez également utiliser cette extension pour ajouter des barres de mesure à une mesure

longue et irrégulière existante : il vous suffit de sélectionnez la note après laquelle vous souhaitez

insérer une barre de mesure puis de lancer l’extension. L’extention insérera une barre de mesure à

cette position rythmique sur toutes les portées du système, et peut même diviser des multiplets sur

d’autres portées de chaque côté de la nouvelle barre de mesure.

Extension écrite par Neils Sands.

Distribution
“Distribue” (p.e. sépare) la musique d’une portée sur un plus grand nombre. Pour utiliser cette

extension :

* Soit vous sélectionnez un passage sur une simple portée, la copiez dans le presse-papiers avec

Ctrl+C ou XC, puis sélectionnez les portées sur lesquelles vous souhaitez la “distribuer” et

choisissez Extensions > Outils de composition > Distribuer. Sibelius va instantanément

répartir la musique sur les portées de destination en utilisant les paramètres par défaut ;
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* Ou sélectionnez le passage sur une portée simple que vous souhaitez distribuer et choisissez

Extensions > Outils de composition > Distribuer, qui affichera une boîte de dialogue vous

demandant sur combien de portées vous souhaitez la distribuer puis de sélectionner celles-ci.

Il existe des options pour créer de nouvelles portées ou pour utiliser celles existantes (cf. ci-

dessous).

Vous pouvez aussi lancer l’extension sans sélection, ouvrant ainsi une boîte de dialogue vous

permettant de paramétrer la manière dont la musique devrait être distribuée.

* Quand Remplacer le matériel existant est activé, l’extension écrase la musique existante dans

les portées de destination.

* Quand Placer les notes dans toutes les parties sauf celles indiquées (par a1, 1, etc.) est

activé, l’extension assume que les notes seules doivent aller dans toutes les parties (et quand il y a

plus d’une partie ou voix, elle place les notes dans toutes les parties, en doublant la note

spécifiée). Quand cette option est activée, les notes seules vont dans une seule partie.

Quand un passage de notes seules est marqué avec des directions spécifiques en texte technique

(comme par exemple 1., 2., 3., 4., a1., a2., a3., a4.), l’extension les interprète et les considère

lors de la distribution. Elle continue jusqu’à trouver une autre direction ou un autre accord.

Après un accord, l’extension revient à son réglage par défaut pour les notes seules (comme

indiqué dans les options Placer les notes dans toutes les parties...) à moins qu’elle ne

rencontre une autre direction.

* Doubler la partie n si nécessaire vous permet de choisir quelles notes doivent être doublées

s’il y a moins de notes à un moment donné.

* Notes supplémentaires vers la partie n vous permet d’indiquer quelle partie reçoit les notes

supplémentaires s’il y a davantage de notes à un moment donné. L’extension distribue

automatiquement les notes quand il y a deux fois plus de parties ou davantage (p.e., un accord de

croches, quatre parties reçoivent deux notes).

* Quand Copie le texte, les lignes et les symboles dans toutes les voix est activé, l’extension

copie les objets dans toutes les voix de la portée source sur les portées de destination. Quand elle

est désactivée, l’extension ajoute uniquement les objets de la voix qui contient les notes qu’elle

copie (ou les objets dans toutes les voix).

* Répliquer les solos dans les autres parties crée des passages de réplique et vous pouvez

choisir si la réplique doit être étiquetée avec la version longue ou courte des noms des

instruments, ou avec aucun nom. Si Uniquement les mesures entières est activé, l’extension

crée une réplique dans une mesure si elle aurait à l’inverse été laissée vide. Dans le cas contraire,

Créer une mesure de silence dans la voix 2 ajoute une mesure entière de silence dans les

mesures qui contiennent uniquement des répliques. Si vous souhaitez que le texte “Lecture” soit

créé à la fin de la réplique, activez Ajouter texte “Lecture”.

Si vous avez besoin de distribuer la musique depuis plus d’une portée sur un plus grand nombre de

portées ou si vous avez besoin de distribuer la musique sur plus de quatre parties, vous devriez

plutôt utiliser l’option Arranger de Sibelius – cf. Distribution à la page 420.

Extension écrite par Dave Foster.



6. Extensions

562

Ajuster la sélection selon la durée
Modifie le tempo du passage sélectionné de façon à le terminer à un code temporel donné ou à le

faire durer un temps déterminé.

Pour lancer l’extension, sélectionnez la musique dont vous souhaitez changer la durée et choisissez

Extensions > Outils de composition > Ajuster la sélection selon la durée. Une boîte de

dialogue simple apparaît, vous permettant de choisir si vous souhaitez spécifier une Nouvelle fin
ou une Nouvelle durée. L’extension insère un changement de tempo au début de la sélection pour

garantir qu’elle corresponde à votre temps de fin ou durée indiqué.

Vous pouvez choisir alternativement un point de montage existant depuis la liste Temps du point
de montage sélectionné ; l’extension insère un changement de tempo pour déplacer le point de

montage à la fin de la sélection.

L’extension supprime les indications métronomiques dans la sélection, mais si vous souhaitez un

changement de tempo graduel, vous pouvez créer des lignes de ryt./accel. le cas échéant avant de

lancer l’extension, qui les utilisera.

Extension écrite par Bob Zawalich.

Insérer une note ou un silence
Vous permet d’insérer une note ou un silence avant le changement de la durée ou l’effacement

d’une note, d’un accord ou d’un silence existant, et de répartir la musique suivante de la manière

correcte.

Pour utiliser l’extension, sélectionnez la note, l’accord ou le silence avant lequel vous souhaitez

insérer une note ou un silence ou dont vous souhaitez changer la durée - ou que vous souhaitez

effacer - et choisissez Extensions > Outils de composition > Insérer une note ou un silence.

Une boîte de dialogue apparaît :

La boîte de dialogue dispose de trois colonnes de boutons qui représentent les valeurs des notes en

commençant par Changer la durée, Insérer une note et Insérer un silence. Cliquez simplement

la valeur de la note dans la colonne correspondante avec l’action que vous voulez que l’extension

réalise ; la boîte de dialogue se ferme et l’édition est réalisée sur la partition.
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Si vous choisissez Insérer note, la note insérée reçoit la hauteur de la note sélectionnée avant de

lancer l’extension (ou la note inférieur de l’accord sélectionné) et le reste de façon à ce que vous

puissiez en changer la hauteur immédiatement.

La colonne Changer la durée dispose de trois boutons supplémentaires : Supprimer le point de
rythme, Ajouter un point de rythme et Ajouter un double point. L’effet est assez évident.

Toutefois, l’insertion d’une note pointée doit se faire en deux étapes : d’abord, vous insérez la durée

de base puis vous lancez de nouveau l’extension pour ajouter le point de rythme.

Pour effacer la note, l’accord ou le silence sélectionné, cliquez sur le bouton Effacer la note ou le
silence.

Déplacer vers la mesure suivante déplace la note, l’accord ou le silence et la musique qui le suit

vers la mesure suivante.

Par défaut, les modifications effectuées par l’extension affectent toutes les mesures jusqu’à la

mesure vide suivante, que l’extension considère comme le point d’arrêt naturel. Vous pouvez

modifier ce réglage en paramétrant un point d’arrêt manuel : sélectionnez une note, un accord ou

un silence, lancez l’extension et cliquez sur Placer la mesure “Stop”. C’est particulièrement

pratique si vous souhaitez réaliser une ou plusieurs modifications sur les notes dans la zone mais

ne souhaitez pas que les mesures suivantes soient affectées. Pour retirer un point d’arrêt manuel,

lancez l’extension de nouveau (avec une note sélectionnée) et choisissez Effacer tous les “Stops”.

Défragmenter automatiquement les notes et vérifier les silences (plus lent) essaye de

conserver les durées des notes et des silences produits par la procédure d’édition de l’extension les

plus simples possibles. Nous vous recommandons de le conserver activé. Toutefois, vous pouvez

toujours vous retrouver avec des représentations de durées peu orthodoxes et trouver utile

d’utiliser une ou plusieurs des extensions de Simplifier la notation après avoir utilisé Insérer
Note ou Silence – b 6.11 Extensions pour simplifier les notations.

Vous pouvez incorporer cette extension à votre flux de travail de saisie et de modification des notes

en lui affectant un raccourci – b 5.12 Menus et raccourcis.

Extension écrite par Hort Kuegelgen.

Réduire
Condense la musique d’un grand nombre de portées sur une seule. Pour utiliser cette extension :

* Soit vous sélectionnez un passage sur plusieurs portées, les copiez dans le presse-papiers avec

Ctrl+C ou XC, puis sélectionnez les portées sur lesquelles vous souhaitez les “réduire” et

choisissez Extensions > Outils de composition > Réduire. Sibelius va instantanément répartir

la musique sur les portées de destination en utilisant les paramètres par défaut ;

* Ou sélectionnez le passage sur plusieurs portées que vous souhaitez réduire et choisissez

Extensions > Outils de composition > Réduire, qui affiche une boîte de dialogue vous

demandant si vous souhaitez les réduire sur une portée existante (et dans ce cas, laquelle) ou si

vous souhaitez créer une nouvelle portée.

Vous pouvez aussi lancer l’extension sans sélection, ouvrant ainsi une boîte de dialogue vous

permettant de paramétrer la manière dont la musique devrait être réduite :
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* Choisissez si Utiliser le nombre minimum de voix ou si Séparer toutes les parties sur des
voix séparées ; par défaut, les notes sont combinées sur le nombre minimum de voix possibles

et pour indiquer les notes solos et dupliquées avec 1. et a 2 (dont vous pouvez choisir

l’apparence précise dans le menu de presets).

* Activez Ignorer les passages répliqués si vous souhaitez garantir que l’extension n’essaye pas

de réduire les passages répliqués dans les portées sources vers les portées de destination.

* Ignorer le texte, les lignes et les symboles dupliqués dans vous permet de dire à Sibelius

d’ignorer les repères identiques sur les portées de source s’ils apparaissent sur les mêmes (ou

très proches) positions rythmiques sur plusieurs portées. Réglez la distance à laquelle Sibelius

ignore les repères identiques pour quart de note (noir), une croche ou une double-croche.

* Quand Remplacer le matériel existant est activé, l’extension écrase la musique existante dans

la portée de destination.

Si vous avez besoin de réduire la musique sur un plus petit nombre de portées (mais plus d’une),

vous devriez plutôt utiliser l’option Arranger de Sibelius – cf. Réduction à la page 421.

Extension écrite par Dave Foster.

Afficher les cloches nécessaires
Cette extension, uniquement pertinente pour les partitions contenant de la musique pour un

ensemble de cloches ajoute une mesure au début de votre partition indiquant toutes les cloches

nécessaires pour interpréter la pièce. Pour utiliser cette extension, choisissez Extensions > Outils
de composition > Afficher les cloches nécessaires. Une fois l’extension lancée, vous pouvez

trouver utile d’effacer les silences ou les clefs dans la mesure que l’extension a créée.

Extension écrite par Neils Sands.
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Appliquer les formes de note
Modifie les têtes de notes selon leur hauteur dans le respect des conventions de formes à 4 ou 7

notes.

Pour utiliser cette extension, choisissez simplement Extensions > Notes et silences > Appliquer
les formes de note ; choisissez la convention de forme de note que vous préférez et cliquez sur

OK. Si vous souhaitez ensuite revenir à la notation régulière avec des têtes de note normales,

lancez de nouveau l’extension et choisissez Rétablir les têtes de note normales.

Extension écrite par Gunnar Hellquist. 

Couleurs de note Boomwhackers®
Cette extension colorise les notes selon le schéma de couleur des tubes de percussion accordés de

Boomwhackers® (visitez www.boomwhackers.com pour en savoir plus). Pour utiliser

l’extension, choisissez Extensions > Notes et silences > Couleurs de note Boomwhackers,

sélectionnez le bouton radio Appliquer les couleurs Boomwhacker et cliquez sur OK. Sibelius

change la couleur de toutes les notes dans la partition.

Pour rétablir les couleurs originales des notes, lancez l’extension de nouveau, choisissez

Réinitialiser les couleurs par défaut et cliquez OK.

Extension écrite par Bob Zawalich.

Hauteurs en couleurs
Cette extension colorise les notes selon leur hauteur, une convention utilisée parfois dans la

musique éducative. Pour utiliser cette extension, choisissez le passage dont vous souhaitez changer

les couleurs des notes (ou ne sélectionnez rien pour appliquer les couleurs sur l’ensemble de la

partition) et choisissez Extensions > Notes et silences > Hauteurs en couleurs. Une simple

boîte de dialogue s’affiche dans laquelle vous pouvez sélectionnez une couleur pour chacune des

douze hauteurs de la gamme chromatique. Quand vous avez fait vos choix, cliquez sur OK et les

couleurs sont appliqués aux notes de la sélection.

Sachez que toutes les notes dans les accords de la sélection sont colorisées selon la hauteur de la

note plus haute dans l’accord.

Extension écrite par Andrew Davis.

Convertir les mesures simples en mesures composées
Ré-écrit les passages dans les indications de mesure 4/4, 3/4, etc. sous la forme 12/8, 9/8, etc., en

doublant la durée des croches de chaque mesure. (Seules exceptions à cette règle, les triolets de

croches, noires et blanches sont laissés tel quel).

Pour utiliser cette extension, sélectionnez le passage que vous souhaitez convertir et choisissez

Extensions > Notes et silences > Convertir les mesures simples en mesures composées.

Vous avez l’option de lancer l’extension Aplatir le swing écrit (voir ci-dessous) avant de lancer

celle-ci, transformant ainsi le swing des notes pointées en mesures composées.

http://www.boomwhackers.com
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S’il n’y a pas d’indication de mesure dans le passage sélectionné, l’extension considère qu’elle est en 4/4.

La notation convertie est ajoutée à la partition à la fin de la sélection. Quand un multiplet n’a pas

été converti, un avertissement est ajouté dans la partition indiquant le nombre de mesures qui

contiennent le multiplet d’origine, de façon à le corriger. L’extension copie uniquement les notes :

articulations, lignes, lignes de mesure spéciales, paroles, etc. ne seront pas copiées. Vous devrez

donc les copier ou les créer après avoir passé cette extension.

Extension écrite par Peter Hayter. 

Copie les articulations et les liaisons
Cette extension vous permet de copier les articulations et les liaisons d’une phrase musicale à une

autre avec le même rythme ou similaire. Pour utiliser cette extension :

* D’abord, copiez les articulations et les liaisons que vous souhaitez dupliquer dans le presse-

papiers en sélectionnant la phrase puis choisissez Modifier > Copier (raccourci Ctrl+C ou XC).

* Si vous souhaitez copier ces articulations et liaisons sur un passage donné de la partition,

sélectionnez-le maintenant. Vous pouvez copier les articulations et les liaisons sur des phrases

multiples d’un seul bloc en les incluant toutes dans le passage sélectionné. (Vous n’avez pas à être

exacte dans votre sélection, car seules les articulations et les liaisons seront copiées vers les

phrases dans un rythme correspondant à l’original).

* Puis, choisissez Extensions > Notes et silences > Copier les articulations et les liaisons.

* Assurez-vous que les cases Copier les articulations et Copier les liaisons sont réglées selon ce

que vous voulez copier.

* Si vous souhaitez que l’extension efface les articulations existantes ou les notes nécessaires à la

copie des articulations, choisissez Remplacer les articulations existantes

* Si vous souhaitez copier les articulations et les liaisons vers des passages avec des valeurs de

notes qui sont le double ou la moitié de celles de la sélection d’origine, choisissez Copier aussi
les augmentations et les diminutions

* Sous Options de destination, sélectionnez l’option appropriée :

% Copier vers la sélection copie les articulations et les liaisons dans le passage sélectionné

% Copier vers la sélection avec des correspondances approximatives permet que le

passage de destination soit un peu moins exact rythmiquement parlant que le passage source ;

par exemple, si votre passage source a des articulations sur des noires et que votre passage de

destination est composé de croches, si vous sélectionnez cette option l’extension copie les

articulations sur la première paire de croches dans la destination, même si la correspondance

n’est pas exacte.

% Copier vers l’ensemble de la partition copie les articulations et les liaisons vers les

passages qui correspondent sur l’ensemble de la partition.

* Cliquez sur OK.

L’extension copie les articulations et les liaisons de la phrase originale vers toutes les phrases

correspondantes dans la sélection.

Extension écrite par Neils Sands.
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Rendre les hauteurs constantes
Règle toutes les notes dans une sélection à une même hauteur, en changeant en option les têtes de

note utilisées et en remplissant la mesure avec des notes d’une autre voix (p.e. remplir une mesure

avec des notes barrées tout en affichant un rythme spécifique que l’interprète souhaite utiliser).

Par exemple, cette extension peut transformer la mesure sur la gauche dans la mesure sur la droite

en quelques clics :

Pour utiliser cette extension, sélectionnez le passage des hauteurs à rendre constantes, puis

choisissez Extensions > Notes et silences > Rendre les hauteurs constantes. Une boîte de

dialogue apparaît, divisée en deux :

* La moitié supérieure de la boîte modifie les notes existantes. Indiquer la voix sur laquelle se

trouvent les notes à transposer, et si vous souhaitez changer aussi les têtes de note, indiquez le

type de têtes de note. L’option Déplacer les silences avec les notes déplace les éventuels

silences dans le passage verticalement pour correspondre à la hauteur des notes transposées.

* La moitié inférieure de la boîte vous permet d’ajouter de nouvelles notes à une autre voix dans le

même passage ; c’est particulièrement pratique pour créer une notation barrée. Choisissez la

voix à utiliser pour les nouvelles notes (assurez-vous qu’elle est différente à celle des notes que

vous souhaitez transposer), réglez la hauteur, le type de tête de note et la valeur des notes puis

cliquez OK.

Extension développée par Stefan Behrisch (www.werklabor.de).

Coller dans la voix
Colle un passage de musique que vous avez copié dans le presse-papiers vers le passage

sélectionné, en utilisant la voix indiquée. C’est particulièrement pratique pour coller p.e. un

passage de la voix 1 sur une portée directement dans la voix 2 sur une autre portée. Pour utiliser

cette extension :

* Sélectionnez le passage qui contient les notes que vous souhaitez copier ailleurs et copiez-le dans

le presse-papier à l’aide de Modifier > Copier (raccourci Ctrl+C ou XC)

* Sélectionnez le passage de destination, p.e. les mesures où vous souhaitez que la musique soit

collée puis choisissez Extensions > Notes et silences > Coller dans la voix.

* Une boîte de dialogue apparaît :


Dsus4


D7

  


 


  

Dsus4

 
D7

      



6. Extensions

568

* Assurez-vous que la voix source correcte est choisie dans Copier depuis la voix et que la voix de

destination correcte est sélectionnée dans Coller dans la voix ; si vous ne souhaitez voir copié

que quelques notes de votre sélection, sélectionnez Notes sélectionnées.

* Cliquez OK et la musique copiée est collée dans la voix donnée dans le passage sélectionné.

Pour en savoir plus sur l’utilisation des voix, b 2.36 Voix.

Extension écrite par Dave Foster.

Supprimer les liaisons orphelines
Parfois une note continue de sonner indéfiniment lors de l’exécution si vous avez involontairement

utilisé une liaison rythmique au lieu d’utiliser une liaison ; cette extension vérifie la présence de ces

liaisons “orphelines” dans votre partition - c’est-à-dire non liées à une autre note.

Pour utiliser l’extension, sélectionnez le passage que vous souhaitez corriger et choisissez

Extensions > Notes et silences > Supprimer les liaisons orphelines.

Diviser les silences de noires pointées
Dans les indications rythmiques composées telles que 6/8, Sibelius marque un silence rythmé, p.e.

une noire, avec la convention moderne. Certains musiciens préfèrent la lecture de ces silences s’ils

sont divisés en silence de noires et de croches divisées. Cette extension remplace automatiquement

ces silences, de la manière suivante :

Pour utiliser le plug-in, sélectionnez le passage auquel vous souhaitez diviser les silences et

choisissez Extensions > Notes et silences > Diviser les silences de noires pointées. Le passage

peut bien entendu inclure des notes qui sont laissées seules.

Aplatir le swing écrit

Convertit le rythme du swing écrit  en croches égales.

Pour utiliser cette extension, sélectionnez le passage que vous souhaitez convertir et choisissez

Extensions > Notes et Silences > Aplatir le swing écrit. Vous avez l’option d’ajouter ou non le

texte de tempo Swing au passage réécrit.

Sachez que le passage écrit perdra ses articulations ; les paroles ne sont pas réécrites et peuvent se

retrouver à une mauvaise position dans la mesure. D’autres éléments alignés avec le rythme

original peuvent aussi requérir d’être réglés manuellement.

Extension écrite par Peter Hayter.

Par défaut Une fois l'extension lancée
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Ajouter les indications de pédale de harpe
Ajoute automatiquement les diagrammes de pédale de harpe ou les instructions textuelles de

changements de pédale aux parties de harpes ainsi que des avertissements quand les changements

de pédale sont trop proches pour être joués confortablement ou quand la musique est injouable.

Pour utiliser cette extension, sélectionnez d’abord le passage auquel vous souhaitez ajouter les

indications de pédale (sélectionnez uniquement les portées de harpe) puis choisissez Extensions >

Autres > Ajouter les indications de pédale de harpe. Voici la boîte de dialogue qui apparaît :

* Ajouter pour vous permettre de choisir entre le traitement de la Partition entière ou juste le

Passage sélectionné

* Noire requise pour changer les pédales vous permet de régler le délai nécessaire pour

changer toutes les pédales ; pour la musique à des tempi plus rapides, vous devriez augmenter ce

numéro de manière appropriée

* Vous pouvez choisir si les indications de pédale ajoutées à votre partition seront sous la forme de

Diagrammes ou de Texte encadré

* Finalement, choisissez si vous souhaitez que les indications de pédales insérées soit soulignées

(cela permet de les identifier plus rapidement si vous voulez y jeter un œil ensuite). Souligner
les autres changements se réfère aux changements de pédale qui doivent être réalisés juste

avant qu’une note soit nécessaire ; l’extension essayera de les éviter si elle peut trouver un endroit

de façon à effectuer le changement à l’avance.

Quand vous cliquez OK, l’extension ajoute les indications de pédale. Notez que les dièses et les

bémols doubles ne peuvent être réglés à l’aide des pédales de harpe ; si vous les avez utilisé dans

votre musique, l’extension vous avertit quand vous elle termine d’écrire les autres changements.

Extension écrite par Neils Sands.

Ajouter les noms des notes aux têtes de note
Écrit le nom de la note dans la tête de note grâce à la police Opus Note Names fournie comme ceci :

Pour utiliser cette extension, sélectionnez le passage qui doit recevoir le nom des notes, ou la

partition entière et choisissez Extensions > Autres > Ajouter le nom des notes sur les têtes de
note. Une boîte de dialogue simple apparaît, dans laquelle vous pouvez choisir si vous soulez que

les noms de note soient écrits dans les têtes de note pour inclure des altérations. Cliquez OK et la

partition est mise à jour.

Si vous ajoutez davantage de notes ou changer les hauteurs des notes de la partition, vous aurez

besoin de lancer cette extension de nouveau pour mettre à jour les noms des notes dans les têtes de

note.

Extension écrite par Neils Sands
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Marquage musicale Groovy
Ajoute des notes (sous la forme de messages MIDI) à la partition ouverte qui agissent comme des

“marqueurs” spéciaux lors de l’importation d’un fichier MIDI généré depuis la partition vers

Groovy Jungle ou Groovy City. Groovy Music est une série de trois programmes qui rend

l’enseignement de la musique à des enfants de primaire facile et amusant - reportez-vous à

www.sibelius.com/products/groovy pour en savoir plus.

Sélectionnez un passage sur une seule portée ou une ou plusieurs notes simples, puis choisissez

Extensions > Autres > Marquage musicale Groovy. On vous demandera de choisir vers quel

produit Groovy Music vous souhaitez exporter : Dans la boîte de dialogue qui apparaît, choisissez

si vous souhaitez marquer un élément de Mélodie, Basse, Rythme, Accord, Arpège, etc. puis

cliquez OK. Faites une nouvelle sélection et lancez l’extension de nouveau pour marquer un autre

élément et répétez jusqu’à avoir entièrement marqué votre partition.

Une fois que vous êtes satisfait par le marquage complet de la partition, choisissez Fichier >

Exporter > Fichier MIDI et exporter un fichier MIDI (b 9.9 Exporter des fichiers MIDI) puis

chargez ce dernier dans Groovy en cliquant sur Ouvrir un morceau.

Si vous avez besoin d’aide, l’extension dispose d’un bouton Aide qui vous fournira davantage de

détails.

Rendre la mise en page homogène
Force votre partition à disposer d’un nombre donné de mesures par système et de systèmes par

page. Par défaut, 4 et 4 sont les valeurs recommandées pour une voix et un instrument solo avec un

accompagnement au clavier. La musique pour clavier seul a généralement quatre mesures par

système et six systèmes para page. La musique pour un instrument à une seule portée dispose

généralement de 4 mesures par système et 10 systèmes par page.

La première page d’une partition a souvent moins de systèmes que les pages suivantes pour faire de

l’espace pour le titre ; cette extension vous permet de régler le nombre de systèmes sur la première

page indépendamment du reste de la partition.

Sibelius peut automatiquement mettre en page votre partition dans son intégralité avec un nombre

uniforme de mesures par système et reformate la partition dynamiquement quand elle change

(b 8.4 Sauts de page automatiques). Par conséquent, vous devriez normalement utiliser

cette extension si vous souhaitez qu’uniquement une partie de la partition dispose d’une uniformité

de mise en page.

Sélectionnez le passage à uniformiser et choisissez Extensions > Autres > Uniformiser la mise en
page.

Créer une mise en page pour piano à quatre mains
Réalise à partir d’une partition écrite pour deux pianos (ou n’importe quel instrument à deux

claviers) une nouvelle partition dans le format conventionnel de la musique pour piano à quatre

mains, avec la partie du premier pianiste (partie supérieure) sur les pages de droite et celle du

second (partie inférieure) à gauche

Pour utiliser cette extension, préparez d’abord votre partition source. Elle doit contenir

uniquement deux instruments à clavier. Puis, utilisez Créer > Page de titre pour ajouter une page

http://www.sibelius.com/products/groovy


6.8 Autres extensions

571

Extensio
ns

de garde à votre partition, si elle n’en a pas déjà une, ou assurez-vous que la première page de

musique soit la page de gauche. Cela permet d’aider l’extension à produire les changements de

pages corrects dans la partition créée. Finalement, sélectionnez la partition entière et effectuez

Mise en page > Format > Verrouiller le format puis choisissez Extensions > Autres > Créer une
mise en page pour piano à quatre mains.

Une boîte de dialogue simple apparaît. Vous pouvez alors choisir les noms des instruments à

utiliser pour chaque instrument dans la partition nouvelle. L’option Maintenir la
synchronisation des pages indique à l’extension qu’elle doit s’assurer que les mêmes mesures

apparaissent sur chaque système des pages main droite et main gauche. Cliquez OK et regardez

comment les barres de progression avancent sur l’écran. En un rien de temps, votre nouvelle

partition est créée.

Quelques retouches seront surement nécessaires : l’extension crée des objets textuels commençant

par “P4H” à chaque fois qu’une retouche est nécessaire. Vous pouvez les chercher en utilisant

Edition > Rechercher de manière à décider quoi faire dans chaque cas.

Extension écrite par Hans-Christoph Wirth.

Fusionner des mesures
Permet de fusionner les mesures adjacentes en une seule mesure plus longue. Cette option

nécessite un passage contenant au minimum deux mesures ; toute partie non sélectionnée de la

première et de la dernière mesure de la sélection sera coupée en mesure séparée. Toutes les pages

blanches liées à des barres de mesures fusionnées seront perdues. L’extension vous permet de

dessiner des barres de mesure à l’endroit où elles se trouvent, mais vous devez toutefois ajuster leur

espacementmanuellement. Avec cette option, vous pouvez également réinitialiser la numérotation

des mesures des mesures suivantes.

Pour utiliser l’extension, sélectionnez au minimum deux mesures puis choisissez Extensions >

Autres > Fusionner mesures.

Extension écrite par Bob Zawalich.

Préférences
Cette extension est uniquement prévue pour les développeurs d’extensions. Voir Aide >

Documentation > Référence de langage ManuScript pour en savoir plus.

Retirer tout le soulignage
Cette extension retire simplement tout le soulignage de la partition. Pour utiliser cette extension,

choisissez Extensions > Autres > Retirer tout le soulignage.

Gammes et arpèges
Crée des feuilles de travail contenant des douzaines de gammes et d’arpèges en quelques clics. Pour

utiliser cette extension, choisissez Extensions > Autres > Gammes et arpèges. Vous êtes guidés

au fil d’une série de dialogues, de la manière suivante :

* Si une partition est déjà ouverte, on vous demander d’abord si vous souhaitez ajouter des

gammes à la partition existante ou de créer une nouvelle partition. Faites votre choix et cliquez

Suivant.
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* Si vous créez une nouvelle partition, on vous demandera si vous souhaitez créer des gammes

pour un instrument à une portée ou pour un instrument à clavier. (Vous pouvez aussi demander

à l’extension de produire un seul exemple de chaque type de gamme et d’arpège qu’il peut créer).

Faites votre choix, puis cliquez Suivant.

* On vous proposera de choisir entre plusieurs types de gamme ou d’arpège : gammes majeures,

gammes mineures, gammes modales, gammes altérées, gammes de jazz et arpèges. De nouveau,

faites votre choix et cliquez Suivant.

* La boîte de dialogue suivante vous permet de régler les options spécifiques des gammes ou des

arpèges que vous souhaitez créer : le type de gamme, le nombre d’octaves et dans quelle octave

elle devrait commencer, la direction, la valeur des notes à utiliser, la clé, etc. Inclure l’armure
insère une nouvelle armure au début de chaque gamme.

Si vous souhaitez créer des gammes pour clavier, vous pouvez indiquer que vous souhaitez

ajouter un intervalle de tierce ou d’octave au dessus des notes dans la portée main droite.

Si vous souhaitez créer une série de gammes, vous pouvez choisir si chaque nouvelle gamme

devrait être dans l’armure de la nouvelle note de début ou si elle doit rester dans l’armure

d’origine tout en commençant à un degré différent de la gamme.

Quand vous êtes satisfait avec les options :

% Si vous créez des gammes ou des arpèges pour un instrument à une seule portée, cliquez

Terminé.

% Si vous créez des gammes pour un instrument clavier, cliquez Suivant. Vous pouvez faire des

choix supplémentaires, tels que si les gammes doivent être créées dans le même sens ou dans

le sens inverse si la portée main gauche doit commencer dans la même octave ou une octave

différente que la portée de main droite, etc.

* Après avoir cliqué sur Terminé, l’extension crée les gammes et les arpèges désirés en quelques

secondes.

Extension écrite par Gunnar Hellquist. 

Déterminer des indications métronomiques
Vous permet de créer des indications métronomiques aux vitesses spécifiques en cliquant le pouls

avec la souris. Pour utiliser l’extension, sélectionnez la mesure dans laquelle vous souhaitez créer

l’indication métronomique (ou ne sélectionnez rien si vous souhaitez la créer dans la première

mesure) puis choisissez Extensions > Autres > Placer une indication métronomique.

Dans la boîte de dialogue qui apparaît, cliquez sur le gros bouton au tempo désiré. Après douze

clics, l’extension vous indique le tempo moyen que vous venez de cliquer et vous permet de créer

un repère métronomique à ce tempo précis ou au tempo le plus proche de celui d’un métronome

traditionnel.

Extension écrite par Neils Sands et Michael Eastwood. 

Diviser une mesure
Divise une mesure en deux mesures irrégulières de longueurs appropriées, insère un changement

de numéro de mesure et, si vous choisissez d’insérer un saut de système où la mesure est divisée,

insère une ligne de mesure invisible entre les deux moitiés de la mesure.



6.8 Autres extensions

573

Extensio
ns

Choisissez simplement la note avant l’endroit où vous souhaitez réaliser la division et sélectionnez

Extensions > Autres > Diviser une mesure. Une boîte de dialogue simple apparaît, vous

permettant de choisir quel type de ligne de mesure doit être utilisé à la fin de la première moitié de

la mesure divisée (Invisible par défaut), et si le numérotage de mesure doit ou non compter les

deux moitiés de la mesure séparément.

Vous pouvez désactiver Afficher cette boîte de dialogue de nouveau (cette session) si vous

souhaitez utiliser le même jeu d’options pour la durée de votre session Sibelius sans devoir à

nouveau les choisir à chaque fois ; si vous le désactivez, le dialogue réapparaitra quand vous

redémarrerez Sibelius.

Extension écrite par Bob Zawalich.

Suggérer des emplacements de réplique
Marque votre partition avec des emplacements pertinents pour les passages en réplique, selon un

nombre minimum de mesures de silence ou une longueur minimum de silences en secondes.

Sélectionnez le passage dans lequel vous souhaitez que l’extension suggère les emplacements

pertinents pour les répliques, p.e. triple-cliquez une portée puis lancer l’extension ou si vous

souhaitez traiter toute la partition, sélectionnez simplement Extensions > Autres > Suggérer des
emplacements de réplique. Une boîte de dialogue apparaît :

Bien que vous puissiez demander à l’extension de suggérer des emplacements après un certain

nombre de mesures de silence et un délai donné, il est généralement plus pratique de choisir l’un

ou l’autre.

Les trois options de Marquer les emplacements de réplique dans présentent les résultats de

l’extension :

* Partition en tant que texte crée un objet de texte technique, en rouge, au dessus de la

première note suivant chaque emplacement suggéré pour une réplique

* Fichier texte crée un fichier texte appelé filename cue locations.txt dans le même dossier que

votre fichier de partition, faisant une liste des emplacements suggérés

* Fenêtre de Trace de l’extension écrit chaque emplacement suggéré dans la fenêtre Trace de

l’extension.

Si vous utilisez l’option Partition en tant que texte, vous pouvez utiliser Modifier > Rechercher
et Edition > Rechercher le suivant pour trouver les textes commençant par “Cue:” pour vous

rendre à chaque emplacement suggéré.

Extension écrite par Neils Sands.
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6.9 Extensions d’exécution

Ajouter des modifications de contrôleur continu
Génère des messages de contrôleur MIDI dans votre partition, facilitant l’application de

modifications de contrôleur continu requis pour la manipulation de l’exécution, p.e. pour certains

instruments virtuels ou autres dispositifs d’exécution.

Pour utiliser l’extension, créez d’abord une ou plusieurs lignes dans la partition à la ou les positions

où vous souhaitez appliquer les données d’automatisation. Utilisez la ligne horizontale du panneau

Lignes de portée de la boîte de dialogue Créer > Ligne et assurez-vous qu’elle commence et

termine au dessus des notes auxquelles vous souhaitez ajouter des données de contrôleur MIDI.

Puis sélectionnez une ligne ou un passage content une ou plusieurs de ces lignes et choisissez

Extensions > Exécution > Ajouter des modifications de contrôleur continu.

L’extension est fournie avec un certain nombre de presets pour plusieurs bibliothèques

d’échantillons tierce-partie. Sélectionnez un preset s’il en existe un disponible et cliquez Charger
Preset. Si vous n’avez pas besoin de faire davantage de changements, cliquez OK et l’extension

écrira les messages de contrôleur MIDI appropriés dans la partition.

Vous pouvez, bien entendu, régler les presets existants et créer le votre. Réglez les options dans la

boîte de dialogue comme vous les voulez puis cliquez Ajouter Preset. On vous demande le nom

d’un preset ; indiquez-le et cliquez OK. Si vous changez ensuite ce preset, cliquez sur Enregistrer
le Preset pour vous assurer que les modifications sont conservées.

L’extension vous permet d’écrire les contrôleurs qui décrivent un certain nombre de formes d’onde

et de courbes (p.e. sinus, carré, triangle, dent de scie, exponentielle, etc.) que vous pouvez choisir

dans le déroulant Type de signal. Selon votre choix pour Type de signal, différents paramètres

ont besoin d’être indiqués dans les options du côté droit de la boîte de dialogue. Reportez-vous à la

boîte de dialogue d’Aide de l’extension pour en savoir plus.

Extension écrite par David Budde.

Exécution Cresc./Dim.
Cette extension est uniquement nécessaire si votre dispositif d’exécution n’est pas compatible

automatiquement avec les modifications de dynamiques sur les notes soutenues pour les

instruments appropriés (p.e. vents, cuivre, cordes et chanteurs) ; la plupart des instruments

virtuels, dont la bibliothèque d’échantillons fournie Sibelius Sounds Essentials, le font

automatiquement - voir Soufflets à la page 300.

Pour les dispositifs MIDI plus anciens, p.e. les modules MIDI externes ou la carte son intégrée de

votre ordinateur, Sibelius peut ne pas jouer automatiquement les soufflets sur des notes simples

car ils utilisent des vitesses MIDI pour obtenir des graduations des dynamiques sur des notes

successives. Cette extension insère une série de messages d’expression ou de volume MIDI de façon

à modifier les dynamiques pendant une seule note.

Pour lancer cette extension, créez d’abord des soufflets où vous voulez que le volume change puis

sélectionnez une mesure ou un passage les contenant. Si vous souhaitez uniquement traiter un

soufflet, la meilleure manière de le faire est de le sélectionner.
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Quand vous avez fait votre sélection, choisissez Extensions > Exécution > Exécution Cresc./Dim.
Une boîte de dialogue apparaît vous permettant de choisir si vous souhaitez traiter chaque soufflet

dans le passage sélectionné ou simplement le premier soufflet et d’indiquer le début et la fin des

dynamiques du cresc./dim.

Vous pouvez aussi choisir s’il faut utiliser les contrôleurs MIDI 7 ou 11 pour produire le

changement de dynamique. Par défaut, l’extension utilise le contrôleur 7 (volume) étant donné

qu’il est compatible avec tous les dispositifs MIDI alors que le contrôleur 11 (expression) n’est pas

aussi communément compatible. Vous pouvez vous trouver dans la situation où après avoir créé

une série de messages MIDI, vous devrez insérer un message MIDI supplémentaire pour

réinitialiser le niveau du volume ou de l’expression sur cette portée en particulier -

b 4.17 Messages MIDI pour en savoir plus.

L’extension requiert que vous placiez un soufflet dans votre partition avant de la lancer, de sorte

que si vous ne souhaitez pas que le soufflet apparaisse, vous pouvez en créer un temporairement et

l’effacer après avoir lancé l’extension (qui n’effacera pas les messages MIDI).

Les messages MIDI créés par l’extension sont automatiquement occultés, ils ne seront visibles que

si vous avez activé Affichage > Objets cachés (raccourci Ctrl+Alt+H ou zXH).

Exécution des harmoniques
Cette extension active l’exécution des harmoniques, p.e. sur les portées de cordes, en utilisant les

options de messages MIDI et de Live Playback de Sibelius. Pour utiliser l’extension, sélectionnez le

passage dont vous souhaitez modifier les harmoniques à exécuter et choisissez Extensions >

Exécution > Exécution des harmoniques. Une boîte de dialogue simple apparaît, dans laquelle

vous pouvez choisir quel type d’harmoniques vous souhaitez que l’extension traite ; généralement

vous pouvez simplement accepter les valeurs par défaut et cliquez OK. Vous serez averti

d’enregistrer votre partition puis l’extension traite le passage sélectionné.

Assurez-vous que Lecture > Live Playback est activé quand vous exécutez votre partition pour

écouter les harmoniques. Notez que si vous transposez la musique ou modifier les hauteurs des

notes avec des harmoniques après avoir lancé l’extension, vous devriez effacer le texte de message

MIDI au-dessus des notes et lancer de nouveau l’extension pour assurer une exécution correcte.

Extension écrite par Michael Eastwood. 

Exécution des ornements
Insère les messages MIDI nécessaires pour exécuter les mordants et les gruppetti. Pour utiliser

l’extension, sélectionnez la note (ou les notes) à laquelle vous souhaitez ajouter un ornement puis

choisissez Extensions > Exécution > Lecture des ornements. Une boîte de dialogue simple

apparaît avec les options suivantes :

* Mordant ou Gruppetto : vous permet de choisir le type d’ornement à ajouter

* Si vous choisissez Mordant, Inférieur et Supérieur contrôlent si le mordant doit jouer la note

sous celle écrite ou celle au dessus.

* Si vous choisissez Gruppetto, Inversé contrôle si le Gruppetto doit ou non être inversé.

* Chromatique : produit un ornement chromatique ; quand cette option est inactive, l’ornement

produit est diatonique.
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* À la fin des notes : uniquement pour les gruppetti, cette option permet à Sibelius d’insérer un

gruppetto à la fin de la note sélectionnée (p.e. juste avant la note suivante)

* Ajouter un symbole : cette option ajoute le symbole approprié pour l’ornement au-dessus de la

note sélectionné (ou les notes).

Quand vous avez choisi les options désirées, cliquez OK et les messages MIDI appropriés seront

ajoutés à votre partition (activez Affichage > Objets cachés pour les voir).

Exécution des demi-dièses
Insère des messages MIDI pour l’exécution des demi-dièses. Pour utiliser cette extension,

sélectionnez un passage ou la partition entière (en utilisant Ctrl+A ou XA), puis choisissez

Extensions > Exécution > Exécution des demi-dièses.

Une boîte de dialogue apparaît vous permettant de choisir la quantité de pitch bend nécessaire

pour produire un demi-dièse. Généralement vous pouvez laisser cette valeur par défaut - cliquez

donc sur OK.

Les messages MIDI créés par l’extension sont automatiquement cachés, vous ne pourrez donc pas

les voir sauf si vous activez Affichage > Objets cachés (raccourci Ctrl+Alt+H ou zXH).

Cette extension dispose d’une boîte de dialogue Aide qui décrit le fonctionnement et les

limitations dans le détail.

Strummer
Change les propriétés de Live Playback des notes dans les accords pour fournir un effet

d’interprétation réaliste. L’extension est conçue pour la guitare mais peut être appliqué à d’autres

instruments (vous pouvez essayer d’expérimenter en l’utilisant sur les parties pour harpe,

harpsichord ou pizzicato.

Pour lancer cette extension, sélectionnez un passage puis choisissez

Extensions > Exécution > Strummer. Une boîte de dialogue apparaît avec des options pour

choisir quels accords doivent être joués de cette manière (les accords avec au moins quatre notes

sont les meilleurs), comment alterner les coups vers le haut ou le bas (dans la terminologie de la

guitare, un coup vers le bas correspond au jeu de la note la plus basse à la plus haute), comment

s’étend l’accord, 256 tics correspondent à une noire et comment noter le patron de jeu (sans

notation, en ajoutant d ou u pour “down” (bas) ou “up” (haut) respectivement ou en utilisant des

articulations, dans ce cas les symboles haut et bas sont utilisés).

Les options de blanche, noire et croche placent les coups vers le bas sur des battements spécifiques,

avec les coups vers le haut placés sur tous les autres battements. Les options - alternance stricte,

tous vers le bas, tous vers le haut - parlent d’elles-mêmes. 

L’option “utiliser patron” est la plus flexible et peut être utilisé pour produire des motifs flamenco

impressionnants. Saisissez le motif comme un corde (avec “d” et “u”) : ce patron sera appliqué

séquentiellement sur tous les accords sélectionnés, en les repérant le nombre de fois nécessaire

(par conséquent si vous saisissez un motif dud et avez sélectionné huit accords, le résultat sera un

patron en dudduddu).

Extension écrite par David Harvey.
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6.10 Extensions de correction

Correction
Cette extension permet à l’utilisateur de lancer une combinaison de six extensions de correction

depuis le même menu : 

* Vérifier les clefs écrit des avertissements dans la partition où une clef est répétée sans raison,

p.e. une clef alto serait répétée si vous avez omis un changement de clef aiguë dans une partie

d’Alto

* Vérifier les répliques – voir ci-dessous

* Vérifier les cinquièmes/huitièmes parallèles – voir ci-dessous

* Vérifier les indications de pédales de harpe écrit des avertissements dans la partition si des

notes dans le passage sélectionné ne sont pas interprétables sur une harpe avec la configuration

de pédale indiquée dans la boîte de dialogue. Pour de meilleurs résultats, vous devriez

sélectionner simplement la portée de harpe avant de lancer cette extension en particulier et

indiquer un passage qui ne contient aucun changement de pédale. L’extension peut aussi ajouter

en option un diagramme de pédale de harpe à votre partition, correspondant à la combinaison

indiquée dans la boîte de dialogue.

* Vérifier les arrêts multiples – voir ci-dessous

* Vérifier les pizzicatos écrit des avertissements dans la partition où un “arco” ou un “pizz.”

semble en excès ou manquant

* Vérifier les barres de mesure écrit des avertissements dans la partition où un début ou une fin

de répétition semble en excès ou manquant (p.e. les barres de mesure ne correspondent pas).

Si votre partition est très longue, vous pouvez utiliser l’option Modifier > Rechercher de Sibelius

(b 5.7 Rechercher et filtrer) pour faire défiler les avertissements que l’extension a introduit

dans votre partition.

Si vous le souhaitez, vous pouvez lancer n’importe laquelle de ces extensions individuellement en

la sélectionnant dans le sous-menu Extensions > Correction.

Vérifier les attaches
Cette extensions est très pratique pour localiser les instances pour lesquelles vous pouvez avoir, par

exemple, mal placé un repère d’expression qui est incorrectement attaché à la portée au-dessus ou

au-dessous de celle désirée. Pour utiliser cette extension, choisissez Extensions > Correction >

Vérifier les attaches. L’extension peut soit vérifier la partition ouverte ou traiter un lot de fichiers

dans un dossier donné en même temps. Sélectionnez l’option appropriée depuis la première boîte

de dialogue indiquée par l’extension puis cliquez Suivant. La boîte de dialogue suivante apparaît:
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* Supprimer les couleurs existantes avant de coloriser sert à confirmer la correction des

problèmes antérieurs après avoir passé une première fois l’extension. Cette option garantit que

tous les objets en couleurs dans la partition sont restaurés en noir avant de passer cette

extension.

* Écrire dans un fichier log inscrit les problèmes potentiels dans un fichier texte appelé Sibelius
Attachment Log.txt, situé dans votre dossier Partitions 

* Écrire dans la fenêtre Trace de l’extension affiche les éventuels problèmes dans la fenêtre

Trace de l’extension de Sibelius

* Utilisez cette couleur pour marquer les attaches suspectes vous permet de choisir la
couleur que l’extension doit utiliser pour afficher les problèmes dans la partition

* Les paramètres Options d’emplacement spécial vous permettent de régler où sont placés les

textes de styles les plus fréquents dans votre partition par défaut, de manière à ce que l’extension

soit capable de détecter correctement les problèmes d’attaches.

Quand vous avez réglé les options ci-dessus correctement, cliquez sur le bouton OK et l’extension

analyse votre ou vos partitions et attire votre attention sur les éventuels problèmes d’attaches.

Extension écrite par Bob Zawalich.

Vérifier les répliques
Vérifie que les passages de réplique dans la partition correspondent aux notes dans les portées

dont elles sont copiées. C’est pratique si vous avez continué à faire des modifications dans la

partition depuis l’ajout des répliques aux parties et souhaitez désormais vérifier que ces

modifications sont bien reflétées dans les répliques pertinentes.

Sélectionnez le passage dans lequel vous souhaitez que l’extension vérifie vos répliques, p.e. triple-

cliquez une portée puis lancer l’extension ou si vous souhaitez traiter toute la partition,

sélectionnez simplement Extensions > Correction > Vérifier les répliques. Une boîte de dialogue

apparaît:
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Les trois options de Marquer les répliques suspectes dans présentent les résultats de

l’extension :

* Partition en tant que texte crée un objet de texte technique, en rouge, au dessus de la première

note de chaque réplique suspecte

* Fichier texte crée un fichier texte appelé filename suspect cue.txt dans le même dossier que

votre fichier de partition, faisant l’emplacement des répliques suspectes

* Fenêtre de Trace de l’extension écrit chaque emplacement de réplique suspecte dans la

fenêtre Trace de l’extension.

Si vous utilisez l’option Partition en tant que texte, vous pouvez utiliser Modifier > Rechercher
et Modifier > Rechercher le suivant pour trouver les textes commençant par “Suspect Cue:” pour

vous rendre à chaque réplique suspecte.

Extension écrite par Neils Sands.

Vérifier les contrepoints d’espèces primaires
Vérifie les erreurs dans les contrepoints d’espèces primaires, tels que définis dans le traité du

18ème de Johann Fux, Gradus ad Parnassum.

L’extension requiert que le cantus et le contrepoint soient sur des portées séparées. Faites une

sélection de passage qui contient les portées que vous souhaitez vérifier puis choisissez

Extensions > Correction > Vérifier les contrepoints d’espèces primaires. La boîte de dialogue

suivante apparaît :

Choisissez si le cantus ou le contrepoint sont sur la portée supérieure ou inférieure et si vous

préférez que l’extension annote la partition existante ou crée une nouvelle partition. Les diverses

vérifications que l’extension peut réaliser sont les suivantes :

* Tonalités principales vérifie la présence d’une tonalité principale, déterminée par l’armure actuelle.

* Résolutions des tonalités principales vérifie que les tonalités principales sont correctement

résolues par la tonique.

* Croisement de voix vérifie si le cantus et le contrepoint se chevauche.
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* Sauts mélodiques vérifie la présence de sauts mélodiques questionnables ou pauvres, tels que

déterminés par les principes de Fux. Cette option marque aussi des conventions mélodiques plus

avancées si elles sont résolues correctement, p.e. le saut d’une sixième mineure est résolue dans

la direction opposée, la partition note alors à ce point “après saut correct”.

* Sauts vers le haut successifs vérifie la présence de succession de saut mélodique vers le haut.

* Sauts vers le bas successifs vérifie la présence de succession de saut mélodique vers le bas.

* Mauvais intervalles harmoniques vérifie les dissonances entre le cantus et le contrepoint.

* Mouvement oblique étendu vérifie la présence de succession de mouvements obliques

(quand une voix reste sur la même hauteur alors que l’autre monte ou descend).

* Tritons mélodiques vérifie la présence de sauts tritonaux mélodiques.

* Tritons harmoniques vérifie l’intervalle d’un triton entre le cantus et le contrepoint.

* Quintes parallèles vérifie les quintes parallèles ou consécutives.

* Octaves parallèles vérifie les octaves parallèles ou consécutives.

* Battuta (Italien pour “battu”) vérifie pour un dixième inversé dans une octave. C’est interdit

dans le contrepoint stricte mais Fux le permet car il considère que les motifs de son interdiction

son légère.

* Parfaits cachés et battus vérifie les parfaits cachés, quand deux voix approchent un intervalle

parfait dans un mouvement similaire et les parfaits battus, quand deux voix se déplace

inversement et par saut mélodique qui arrive à un intervalle parfait ; ces deux formes sont

interdites dans le contrepoint stricte. (“Parfait battus” sont ainsi appelés par Fux car, il dit, que

pour les vieux maitres du contrepoint cette figure sonnerait comme si les intervalles parfaits

étaient battus dans leurs têtes.) Les quintes battues sont marquées dans la partition en tant que

“quinta battuta” et les octaves battues en tant que “ottava battuta”.

* Unissons de contrepoint moyen vérifie que les unissons apparaissent ailleurs qu’entre les

premières et les dernières notes d’un contrepoint. Dans les premières formes de contrepoint,

c’est interdit car cela crée l’illusion d’une seule voix.

* Plage entre les voix vérifie que la plage entre le cantus et le contrepoint n’est jamais supérieure

à une 12ème parfaite.

Une fois que vous avez choisi ce que vous voulez vérifier, cliquez OK et l’extension traite la

partition... en annotant votre partition ou en créant une nouvelle partition, en copiant votre

passage et en l’annotant.

Extension écrite par Roman Molino Dunn.

Vérifier les quintes/octaves parallèles
Vérifie la présence de quintes et d’octaves entre les notes sur les voix et sur les portées. L’extension

vérifie la présence de quintes et d’octaves “cachées” (p.e. elles sont inversées).

Si vous souhaitez vérifier toute la partition, sélectionnez Modifier > Sélectionner > Selectionner
tout (raccourci Ctrl+A ou XA) puis choisissez Extensions > Correction > Vérifier les
cinquièmes/huitièmes parallèles ; à l’inverse, sélectionnez simplement un passage à vérifier

avant de lancer l’extension. Dans la boîte de dialogue, choisissez si vous voulez vérifier les quintes

ou les octaves, ou les deux. Cliquez OK – puis, après un moment d’activité, Sibelius vous indique
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combien d’erreurs il a trouvé, qui sont marquées dans la partition sous forme de texte. (Le texte

d’avertissement début juste avant la première note gênante des quintes/octaves parallèles).

Si votre partition est très longue, vous pouvez utiliser l’option Modifier > Rechercher de Sibelius

pour faire défiler les avertissements que l’extension a introduit dans votre partition.

Vérifier les césures
Vérifie les césures des paroles dans votre partition, à l’aide du placement intelligent intégré à

Sibelius.

Pour utiliser l’extension, sélectionnez un passage spécifique de votre partition puis choisissez

Extensions > Correction > Vérifier les césures.

Vous pouvez choisir de vérifier la partition entière ou un passage sélectionné, ainsi que la langue

de ces paroles (anglais, français, allemand, italien, espagnol et latin).

Choisissez si vous souhaitez que l’extension Afficher les césures incorrectes en rouge et si vous

souhaitez qu’elle Corriger les paroles dans la partition (qui remplacera les césures incorrectes

par des correctes). Les options Lister les corrections enregistrera un fichier texte listant les

césures incorrectes dans le même dossier que la partition ou dans la fenêtre Trace de l’extension.

Extension écrite par Neils Sands.

Vérifier les arrêts multiples
Vérifie la présence d’accords qui présentent un arrêt multiple injouable dans votre partition.

Chaque accord (qu’il soit sur une voix seule ou une partie d’un passage en contrepoint) est soit

facile, difficile ou impossible : les accords faciles sont laissées tels quels, les difficiles et impossibles

sont marquées comme tels.

Pour utiliser l’extension, sélectionnez un passage spécifique de votre partition puis choisissez

Extensions > Correction > Vérifier les arrêts multiples. Une boîte de dialogue apparaît, dans

laquelle vous pouvez choisir s’il faut vérifier le passage sélectionné ou toute la partition, et si vous

souhaitez seulement vérifier les portées des instruments à cordes (paramètre recommandé) ou

toutes les portées. Cliquez OK et une barre de progression apparaît au fur et à mesure que

l’extension examine les portées une par une.

Chaque accord difficile ou impossible sera étiqueté correctement avec un texte technique ; utilisez

les options Modifier > Rechercher et Modifier > Rechercher le suivant de Sibelius

(b 5.7 Rechercher et filtrer) pour trouver chaque accord que l’extension a identifié.

L’extension vous conseille chaque arrangement possible pour chaque note de l’accord sur chaque

corde de l’instrument, joué par chaque doigt et détermine l’arrangement le plus simple pour
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l’accord ; c’est l’étiquette qui est appliquée à l’accord dans la partition. Pour ce faire, certaines

assomptions ont été faites sur la manière dont les interprètes peuvent écarter les doigts sur chaque

instrument ; bien évidemment, certains interprètes (avec de longs doigts !) pourraient jouer

certains accords considérés impossibles par l’extension.

Les accords avec plus de quatre têtes de note sont automatiquement considérés impossibles, étant

donné que toutes les cordes ont un maximum de quatre cordes.

Étant donné que les archets sont droits et que les manches des cordes sont courbes, seules deux

notes peuvent être jouées en même temps sur un instrument réel ; l’extension vous permet ceci

mais indique que les deux notes supérieures doivent être réalisées sur des cordes adjacentes, dans

le cas contraire, elles ne pourraient être maintenues. Tout accord dont les deux notes supérieures

ne sont pas sur des cordes adjacentes est considéré impossible.

Les accords étiquetés comme difficile incluent généralement des écartements peu confortables

(pas forcément impossibles) ou une position de main étrange (la position de main idéale utilise le

premier doigt pour la corde la plus basse et le second sur la plus basse suivante, etc ; par

conséquent les accords de deux cordes sont généralement jouables mais ceux de trois ou quatre

cordes doivent être réalisés de la bonne manière pour être faciles).

L’extension travaille quelque soit le contexte musical, p.e. un passage composé de 24 accords

double-cordes “faciles” de suite seront traités sans commentaire. De la même manière, elle ne

prend pas en compte les questions telles que le tempo.

Extension écrite par Neils Sands.

Vérifier les redondances
Cette extension est capable de localiser les indications de mesure, les clefs, les armures, les

changements d’instruments et les repères de répétitions redondantes, p.e. deux changements de clef

identique l’une après l’autre. À la différence de Vérifier les clefs (voir ci-dessus), Vérifier les
redondances vous permet de sélectionner, occulter ou effacer les éléments redondants d’un seul

coup.

Pour utiliser cette extension, choisissez Extensions > Correction > Vérifier les redondances. La

boîte de dialogue suivante apparaît :

Pour chaque type d’objet, choisissez sur vous souhaitez Sélectionner, Occulter o Effacer les

objets redondants en utilisant le bouton radio approprié. Si vous ne voulez pas que l’extension

vérifie, disons, les changements d’instruments, désactivez la case Traiter les changements
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d’instruments. Choisissez si vous souhaitez que l’extension affiche les résultats dans un fichier log

ou dans la fenêtre Trace de l’extension et cliquez OK.

Extension écrite par Roman Molino Dunn.

Quoi est où ?
Cette extension crée un jeu de statistiques montrant quels objets existent dans la sélection faite

dans la partition ouverte. Vous pouvez choisir quels objets doivent être inclus dans les statistiques

et si l’extension doit colorisée les objets inclus dans son analyse. Quand Écrire dans le fichier log
est activé, l’analyse est enregistrée dans un fichier appelé where.txt, que vous trouverez dans le

même dossier que la partition analysée. Vous pouvez aussi afficher la sortie de l’extension dans la

fenêtre Trace de l’extension en activant Écrire dans la fenêtre Trace de l’extension.

Utilisez Supprimer les couleurs existantes avant de coloriser quand vous avez déjà utilisé

l’extension et souhaitez effacer les couleurs précédentes avant de faire une nouvelle analyse.

Extension écrite par Bob Zawalich.
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6.11 Extensions pour simplifier les 
notations

Modifier le point de scission
Modifie le point de scission des notes entre les portées de main gauche et de main droite sur un

piano ou un autre instrument qui utilise deux portées. C’est particulièrement pratique pour

nettoyer la musique pour clavier saisie via Flexi-time ou importation MIDI.

Pour utiliser l’extension, sélectionnez le passage dans lequel vous souhaitez modifier le point de

scission et choisissez Extension > Simplifier la notation > Modifier le point de scission. Dans la

boîte de dialogue qui apparaît, indiquez le nouveau point de scission et si vous souhaitez que les

notes au-dessus du point de scission soit sur la portée de main droite ou de main gauche puis

cliquez OK. L’extension répartit alors correctement les notes sur les portées.

Extension écrite par Bob Zawalich.

Combiner les notes liées et les silences
Regroupe les notes liées et les groupes de silences en valeurs de notes plus longues.

C’est particulièrement pratique pour nettoyer les partitions travaillées de nombreuses fois ou des

partitions saisies via Flexi-time ou importation MIDI.

Pour utiliser cette extension, choisissez Extensions > Simplifier la notation > Combiner les
notes liées et les silences. Si rien n’a été sélectionné, on vous proposera d’effectuer l’opération

sur l’ensemble de la partition ; dans le cas contraire, l’extension travaille uniquement sur le passage

sélectionné.

Vous pouvez choisir si vous souhaitez combiner les notes liées ou les silences ou les deux.

Cette extension peut modifier drastiquement l’apparence de votre partition, vous pouvez aussi

créer un fichier texte log qui répertorie tous les changements effectués (vous pouvez même créer

un fichier log qui liste les changements que l’extension effectuera sans toutefois réaliser ces

changements).

Cette extension sophistiquée dispose d’une documentation complète intégrée : Aide dans la boîte

de dialogue initiale pour en savoir plus sur ces règles et comment elle combine les notes liées et les

silences... ainsi que ses limites.

Extension écrite par Bob Zawalich. 

Doublons sur les portées
Travaille sur une sélection contenant deux portées et mets en couleur les notes similaires qui

apparaissent en même temps sur les deux portées. Vous pouvez choisir la couleur utilisée pour

marquer les doublons et l’extension vous informe des doublons trouvés dans la fenêtre Trace.

Un message vous avertissant du nombre de doublons trouvés s’affiche une fois le processus

terminé.

Cela peut s’avérer très utile pour (par exemple) identifier facilement les instruments sur une

partition qui peuvent être dédoublés à un moment donné.

Extension écrite par Bob Zawalich.
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Déplacer sur une autre portée
Déplace une seule note ou accord sélectionné d’un clavier ou d’un autre instrument à grande

portée sur la portée du dessus ou du dessous. C’est utile pour corriger les erreurs de point de

scission note par note - si vous souhaitez modifier le point de scission pour un passage plus

important, reportez-vous à Modifier le point de scission au-dessus. Pour utiliser l’extension,

sélectionnez simplement la note ou l’accord que vous souhaitez déplacer de la portée actuelle à la

portée du dessus ou du dessous et choisissez Extensions > Simplifier la notation > Déplacer sur
une autre portée.

Extension écrite par Geoff Haynes.

Supprimer les notes qui se chevauchent
Cette extension supprimer les notes qui se chevauchant sur la portée et a été conçue pour nettoyer

la musique saisie via Flexi-time (tout particulièrement depuis une guitare MIDI) ou par

l’importation d’un fichier MIDI. Elle fonctionne en supprimant les notes qui sonnent déjà quand la

note suivante commence à sonner et vérifie aussi (et supprime) les liaisons “orphelines” (p.e. les

liaisons qui ne sont pas liées à la note suivante).

Pour utiliser l’extension, sélectionnez la portée ou les portées sur lesquelles vous souhaitez passer

l’extension (ou ne sélectionnez rien pour appliquer l’extension à la partition entière) puis choisissez

Extensions > Simplifier la notation > Supprimer les notes qui se chevauchent. Vous serez

averti de sauvegarder votre partition et quand vous cliquerez sur OK, l’extension traitera le passage

sélectionné ou toute la partition. Quand l’extension a terminé, l’extension vous indique combien de

notes se chevauchant ont été supprimées.

Extension écrite par Bob Zawalich. 

Supprimer les silences
Supprime les silences dans le passage de musique sélectionné. Si vous trouvez des silences non

désirés après la saisie Flexi-time ou l’importation d’un fichier MIDI, vous pouvez utiliser cette

extension pour “nettoyer” la musique.

Par exemple, cette extension réécrit la musique suivante :

en tant que :

Pour utiliser l’extension, sélectionnez simplement le passage dans lequel vous souhaitez supprimer

les silences et choisissez Extensions > Simplifier la notation > Supprimer les silences. Une boîte

de dialogue apparaît, vous rappelant les limites de l’extension ; quand vous cliquez sur OK, une

nouvelle partition est créée, contenant la musique nettoyée, que vous pourrez copier sur l’originale.

Les limites de l’extension sont les suivantes :

* Les multiplets ne sont pas traités, mais le reste des mesures dans laquelle ils apparaissent sont

correctement copiées

* Les notes ornementales ne sont pas copiées
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* Les ligatures personnalisées apparaissent sous la forme de groupes de ligatures par défaut

* Les hampes inversées par l’utilisateur ne sont pas copiées

* Les têtes de note spéciales, les repères d’articulation et les barres de mesure spéciales ne sont pas

copiés

* Les mesures de longueur irrégulière, telles que les anacrouses (mesure de levée), ne sont pas

copiées correctement.

Extension améliorée par Geoff Haynes

Supprimer les notes à l’unisson
Supprime les notes à l’unisson (deux têtes de note de même hauteur sur la même hampe ou de

même hauteur sur différentes voix) qui apparaissent parfois lors de l’importation d’un fichier

MIDI ou lorsque vous utiliser Arranger pour produire des réductions de la musique existante.

Pour utiliser cette extension, choisissez Extensions > Simplifier la notation > Supprimer les
notes à l’unisson. S’il n’y a aucune sélection, on vous demande si vous souhaitez que la procédure

soit appliquée sur l’ensemble de la partition ; dans le cas contraire, elle ne s’applique qu’au passage

sélectionné. Une boîte de dialogue apparaît dans laquelle vous pouvez régler certaines options :

* Sélectionnez si vous souhaitez supprimer les unissons Uniquement sur chaque voix (p.e.

deux notes de même hauteur à la même position rythmique mais sur des voix séparées seront

laissées intactes) ou Sur et entre toutes les voix (p.e. si deux notes de même hauteur sur des

voix séparées apparaissent à la même position rythmique, l’une d’elle sera supprimée)

* Choisissez si vous souhaitez ou non créer un fichier texte log, listant toutes les modifications

effectuées par l’extension, de façon à pouvoir les vérifier ensuite (vous pouvez même demander

de créer un fichier log des modifications à faire, sans réellement modifier la partition). Vous

pouvez sélectionner si vous souhaitez utiliser les noms de notes américaines ou britanniques

dans le fichier log.

Cliquez OK et l’extension traite la partition.

Extension écrite par Bob Zawalich.

Réécrire l’interprétation
Réécrit la notation produite par une interprétation Flexi-time ou importée depuis un fichier MIDI

pour la rendre plus lisible. Cette extension fait indirectement le même travail que Supprimer les
notes qui se chevauchent et Supprimer les silences, par conséquent vous n’aurez pas à lancer

ces extensions. L’extension est idéale pour une paire de portées clavier mais vous pouvez l’utiliser

avec d’autres instruments si vous le souhaitez. L’extension peut régler les types de problèmes

suivants :

* Des notes sont écrites sur la mauvaise portée, intervenant sur trop de lignes supplémentaires

* Le voicings des accords est injouables car les écartements sont trop grands

* Voicing incohérent en raison de l’option Utiliser des voix multiples pour la saisie Flexi-time

* Des notes courtes sont notées comme des accords car l’option Durée minimum de Flexi-time a

été réglée trop haute
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* Des notes sont notées avec des valeurs plus courtes que désirées car elles étaient jouées trop

staccato.

L’extension vise à produire une notation rythmiquement et visuellement plus simple que l’originale

sans laisser de côté aucune note de l’interprétation originale en réorthographiant et requantifiant

la musique. Au fur et à mesure que l’extension réorthographie votre interprétation, elle réduit les

notes à une seule voix sur chaque portée ; des voix internes sont suggérées par l’ajout de notes où

elles fonctionnent le mieux sans utiliser de liaisons pour noter leur durée. La musique est

requantifiée en utilisant la même unité de Durée minimum que celle utilisée lors de la saisie Flex-

time ou de l’importation MIDI mais cette unité est automatiquement réduite le cas échéant, p.e. où

vous jouiez des double-croches alors que l’unité de Durée minimum était réglée sur des croches

ou si vous avez arpégé un accord, jouez une petite note ou tout autre ornement.

Pour utiliser l’extension, sélectionnez simplement un passage sur la portée ou les portées que vous

souhaitez noter à nouveau puis choisissez Extensions > Simplifier la notation > Réécrire
l’interprétation. Une boîte de dialogue simple apparaît, vous permettant d’écraser les choix de

l’extension d’unité de quantification et indiquez si vous voulez ou non Remplacer le passage
sélectionné. Si cette option est activée, la musique sélectionnée est remplacée ; si elle est

désactivée, Sibelius ajoutera un nouvel instrument et écrira la musique notée à nouveau sur cette

portée, idéal pour pouvoir comparer le passage original et sa réécriture.

Extension écrite par Geoff Haynes.
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6.12 Extensions de texte

Ajouter des crochets dans le script Reprise
Dans certaines partitions écrites à la main, le texte est marqué par des crochets qui indiquent si le

texte s’applique à la portée du dessus ou du dessous, de la manière suivante :

La police du Script Reprise de Sibelius inclue des caractères spéciaux qui peuvent produire ce

genre de crochets. La manière la plus simple de les obtenir est de sélectionner un passage

contenant le texte que vous souhaitez mettre entre crochets puis de choisir Extensions > Texte >

Ajouter des crochets au Script Reprise. Une boîte de dialogue simple apparaît vous permettant

de choisir si vous souhaitez ajouter ou supprimer des crochets : faites votre choix et cliquez OK.

L’extension détermine si le texte est au-dessus ou au-dessous de la portée et crée le genre de

crochets adéquat automatiquement.

Si vous avez changé la police du texte entre crochets, vous verrez que les crochets ne sont plus

affichés correctement : lancez de nouveau l’extension et sélectionnez Supprimer les crochets
pour corriger l’apparence de la partition.

Extension écrite par Dave Foster.

Ajouter des doigtés de cuivre
Ajoute les doigtés appropriés pour un certain nombre de cuivres fréquents : trompettes en Sib, Do,

Ré et Mib, cors utilisant des doigtés en Fa et Sib et euphoniums à 3 ou 4 pistons.

Pour utiliser cette extension, sélectionnez le passage auquel vous souhaitez ajouter les doigtés (p.e.

triple-cliquez sur la portée du cuivre en question) et choisissez Extensions > Texte > Ajouter les
doigtés des cuivres. Sélectionnez l’instrument dans la boîte de dialogue et cliquez OK pour

ajouter les doigtés à votre partition dans le style de texte Doigtés ; s’ils entrent en collision avec des

notes ou d’autres repères, utilisez l’extension Repositionner le texte pour les régler (cf. ci-

dessous).

Ajouter des dynamiques depuis Live Playback
Ajoute des dynamiques, sous forme de texte d’expression, au passage sélectionné ou sur l’ensemble

de la partition, selon les vitesses Live Playback des notes. C’est pratique pour ajouter des

dynamiques à la musique saisie via Flexi-time ou via importation d’un fichier MIDI.

Pour lancer l’extension, sélectionnez un passage et choisissez Extensions > Texte > Ajouter des
dynamiques depuis Live Playback. Une boîte de dialogue apparaît vous permettant de modifier

divers réglages :

* Changer la dynamique si la vitesse de note est hors de la plage d’au moins n détermine

la sensibilité de l’extension pour les changements de dynamiques ; un numéro plus grand

produira moins de dynamiques dans la partition, à l’inverse avec un plus petit.
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* Insérer des dynamiques vous permet de choisir si les nouvelles dynamiques créées doivent

apparaître quand le niveau des dynamiques change (le réglage par défaut) ou collées au temps

suivant ou au début de la mesure suivante.

* Réajuster les dynamiques après plusieurs mesures de silences vous permet de réajuster

automatiquement la dernière dynamique après un passage de silences.

* Les valeurs des Niveaux des dynamiques vous permettent d’indiquer la vitesse MIDI

maximale qui correspond à chaque dynamique possible. Ces valeurs reviennent aux valeurs par

défaut réglées dans les Papiers à musique de Sibelius, mais vous pouvez les changer si vous

voulez.

* Effacer le texte d’expression existant efface les dynamiques existantes dans le passage

sélectionné avant d’ajouter de nouvelles dynamiques.

* Chaque voix a des dynamiques séparées permet à l’extension d’ajouter des dynamiques sur

plusieurs voix, si le passage source contient des notes sur plusieurs voix.

* Combiner les dynamiques pour les instruments multi-portées indique à l’extension

d’examiner toutes les portées des instruments à grande portée (p.e. piano) pour créer un seul jeu

de dynamiques pour toutes les portées.

* Police de texte musical pour le texte d’expression en gras vous permet d’indiquer quelle

police doit être utilisée pour les dynamiques : normalement vous pouvez laisser cette option sur

Opus Text.

Une fois que vous êtes satisfait de vos choix, cliquez OK. Une barre de progression apparaît et les

dynamiques seront ajoutées à la partition.

Extension écrite par Bob Zawalich.

Ajouter les noms des notes
Écrit La, Do#, etc. au-dessus de chaque note dans la partition.

Pour lancer l’extension, sélectionnez simplement un passage (ou assurez-vous que rien n’est

sélectionné si vous souhaitez ajouter les noms des notes sur toutes les portées dans l’ensemble de la

partition) et choisissez Extensions > Texte > Ajouter les noms des notes. Une boîte de dialogue

simple apparaît, vous permettant d’indiquer si les noms des notes sont ajoutés en minuscules ou

majuscules, dans quel style de texte, si l’extension doit utiliser la hauteur écrite ou celle qui sonne

(pour les instruments transposés), si elle doit inclure le numéro d’octave ainsi que le nom de note

et si les noms de note doivent être ajoutés au passage sélectionné ou à toute la partition. Vous

pouvez aussi choisir la langue à utiliser pour écrire les noms des notes.

Si vous trouvez que le texte ajouté entre en collision avec des notes ou d’autres repères,

sélectionnez l’un des objets texte et choisissez Edition > Sélectionner > Sélectionner plus
(raccourci Ctrl+Shift+A ou xXA) et déplacez la rangée entière avec les touches 3/2 .

Ajouter des liaisons aux paroles
Il est habituel de lier les mots chantés sur plus d’une note, permettant au chanteur de voir quand le

prochain mot change. Cette extension ajoute des liaisons aux portées avec des paroles, en suivant

cette convention.
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Pour utilise l’extension, sélectionnez un passage sur lequel vous souhaitez lancer l’extension (bien

qu’elle ne s’attarde que sur les portées avec des paroles, par conséquent, ne sélectionnez rien si

vous voulez qu’elle s’attache à toute la partition), puis choisissez Extensions > Texte > Ajouter des
liaisons aux paroles. Une boîte de dialogue apparaît, vous permettant de choisir si vous voulez

ajouter des liaisons normales, pointées ou discontinues et vous donne l’option de souligner les

liaisons existantes si elles sont mal placées ou de souligner les mélismes de paroles suspects (p.e.

sans traits d’union ou lignes de paroles). Cliquez sur OK et les liaisons sont ajoutées à la partition.

Extension écrite par Michael Kilpatrick. 

Ajouter les doigtés des cordes
Cette extension ajoute les doigtés appropriés pour la musique de violon, alto, violoncelle et

contrebasse.

Pour utiliser cette extension, sélectionnez le passage auquel vous souhaitez ajouter les doigtés (p.e.

triple-cliquez sur la portée du cuivre en question) et choisissez Extensions > Texte > Ajouter les
doigtés des cordes. Sélectionnez l’instrument désiré dans la boîte de dialogue ; vous pouvez aussi

sélectionner la ou les positions de doigtés à utiliser (le réglage par défaut est 1 et 3, qui ajoute les

doigtés pour la première position puis essaye d’interpréter les doigtés vers la troisième position).

Cliquez OK pour ajouter les doigtés à votre partition dans le style de texte Doigtés ; s’ils entrent en

collision avec des notes ou d’autres repères, utilisez l’extension Repositionner le texte pour les

régler (cf. ci-dessous).

Ajouter un Sol-Fa tonique
Ajoute une notation sol-fa tonique au passage sélectionné ou à la partition entière. La sol-fa

tonique est une notation musicale utilisée dans la musique vocale et un système d’enseignement

qui en dépend.

Inventée par John Curwen dans l’Angleterre des années 1840 et modifiée depuis par Kodály au

XXème siècle, la notation sol-fa tonique est basée sur le système doh déplaçable de solmisation. Les

notes de la gamme majeur sont nommées (dans l’ordre ascendant) doh, ray, me, fah, soh, lah, te où

doh est la tonique, les autres notes sont alors liées à la tonique du moment, qui change si la pièce

module. Les clefs mineures sont traitées comme des modes de la majeure relative, la gamme

mineure solmisée sous la forme lah, te, doh, ray, etc. En notation, les notes sont abréviées d, r, m, f,

s, l, t. Les dièses et les bémols sont indiqués en changeant la voyelle, les dièses en e, les bémols en a

(prononcé ao) ; p.e. doh dièse est notée de ; me bémol est notée ma. Deux points (:) séparent un

temps du suivant, les points (.) sont utilisés quand un temps es divisé en deux demi-temps et les

virgules les demi-temps en quart-de-temps. Les lignes horizontales montrent que les notes sont

maintenues au delà d’un temps (ou sous-temps) ; un blanc indique un silence.

L’exemple suivant, pris dans The Standard Course of Lessons on the Tonic Sol-fa Method of Teaching

to Sing de John Curwen montre à quoi ressemble la notation une fois mise en pratique :

Doh est Mi
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Pour utiliser cette extension, sélectionnez un passage puis choisissez Extensions > Texte > Ajouter
sol-fa tonique. Une boîte de dialogue apparaît, dans laquelle vous pouvez indiquer la clef du

passage sélectionné. Vous pouvez aussi indiquer quelle voix solmiser et diverses options

concernant la manière dont la notation sol-fa tonique doit s’afficher. Quand vous êtes prêt à faire le

traitement, cliquez OK et la notation sol-fa est ajoutée à votre partition.

Si votre partition inclue des changements d’armure, l’extension ne peut les lire automatiquement,

vous devriez alors passer l’extension pour chaque section dans les différentes clefs de votre

partition. Remarquez également que, par défaut, la notation sol-fa tonique est ajoutée dans le style

de texte Paroles ligne 1, vous devriez par conséquent ajouter les paroles réelles pour votre

musique dans le style de texte Paroles ligne 2 ou déplacez manuellement les paroles existantes

avant de lancer l’extension pour éviter que la notation sol-fa n’apparaisse sur les paroles.

L’extension a les limites suivantes :

* L’espacement des barres de mesure peut ne pas être correct (facilement modifiable

manuellement ensuite)

* Les anacrouses vides peuvent ne pas être notées correctement

* L’extension utilise une notation “note pont” non-standard pour la modulation ; il est habituel

d’utiliser les caractères subscript et superscript, mais ils ne peuvent être créés. Pour cette raison,

l’extension écrit plutôt [vieille note] nouvelle note

* L’extension utilise aussi des repères multiplets non-standard (> au lieu de la virgule inversée)

* Certains repères rythmiques peuvent être espacées trop proches (de nouveau, c’est facilement

modifiable manuellement ensuite).

Ajouter des numéros aux strophes
Ajoute des numéros au début des strophes de paroles, alignés sur une colonne et utilisant le style

de texte Paroles ligne n.

Pour utiliser l’extension, sélectionnez la mesure contenant le début des strophes de paroles et

choisissez Extensions > Texte > Ajouter des numéros aux strophes. Il n’y a pas d’options ;

l’extension avance et ajoute les numéros automatiquement.

Si vous souhaitez sélectionnez la strophe des paroles, et même son numéro, sélectionnez la strophe

et choisissez Edition > Sélectionner > Sélectionner tout (raccourci Ctrl+Shift+A ou xXA). Si

vous cliquez sur une syllabe, le numéro de strophe ne sera pas sélectionné. Edition > Filtre >

Paroles ne sélectionne pas non plus les numéros de strophes.

Extension écrite par Peter Hayter. 

Aligner les paroles
Règle l’espacement vertical de plusieurs strophes de paroles tel que :

* les paroles de la première strophe sont alignées verticalement avec la syllabe la plus basse dans la

strophe ; 

* les paroles de la dernière strophe sont alignées verticalement avec la syllabe la plus haute dans la

strophe ;

* Il y a une quantité égale d’espace entre chaque strophe des paroles.
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L’extension est conçue pour vous aider à éviter les collisions avec les notes lorsque vous déplacez les

paroles vers le haut ou vers le bas. Si vous le faites sans soin ou que le système reformate après-

coup, vous pouvez vous retrouver avec des paroles non alignées ou des espaces inégaux entre les

strophes. Il n’est pas nécessaire de déplacer les paroles verticalement si la fonction Mise en page >

Mise en page magnétique est activée.

Pour utiliser l’extension, sélectionnez la mesure contenant le début des paroles et choisissez

Extensions > Texte > Aligner les paroles. Il n’y a pas d’options ; l’extension traite et aligne les

paroles automatiquement.

S’il n’y a qu’une seule strophe, les paroles sont alignées sur une rangée et positionnées grâce aux

syllabes les plus hautes et les plus basses dans le passage sélectionné. En général, vous devriez

appliquer cette extension sur une partition sur la base de système par système, étant donné que les

paroles sont généralement positionnées indépendamment sur différents systèmes.

Extension écrite par Peter Hayter. 

Changer les dynamiques
Règle toutes les dynamiques dans la sélection ou dans la partition d’un ton vers le haut ou vers le

bas – p.e. toutes les dynamiques mp en p ou toutes les mf en f – ou vous pouvez définir une

répartition personnalisée des dynamiques existantes vers de nouvelles dynamiques.

Pour utiliser l’extension, sélectionnez le passage sur lequel vous souhaitez travailler (ou ne faites

aucune sélection si vous souhaitez l’appliquer sur toute la partition) et choisissez Extensions >

Texte > Changer les dynamiques. Une boîte de dialogue apparaît, dans laquelle vous pouvez

choisir la police de texte musical pour vos dynamiques (généralement Opus Text ou Helsinki Texte

pour les partitions “gravés” et Inkpen 2 Text ou Reprise Text pour les partitions “à la main”) et si

vous souhaitez que les dynamiques soit plus forte ou plus douce ou d’utiliser une répartition

personnalisée ; quand vous cliquez OK, si vous avez choisi de régler une répartition personnalisée,

vous devrez alors choisir les nouvelles dynamiques dont vous souhaitez voir les dynamiques

réparties.

Cette extension dispose d’une fenêtre Aide, à partir de laquelle vous pouvez obtenir plus de détails.

Extension écrite par Michael Kilpatrick.

Exporter les paroles
Exporte les paroles depuis votre partition sous forme de fichier texte. Pour utiliser cette extension,

choisissez Extensions > Texte > Exporter les paroles. Une boîte de dialogue simple apparaît, vous

permettant de choisir si l’extension doit essayer de Séparer les lignes (p.e. ajoute les sauts de ligne

après la ponctuation qui est suivi d’une majuscule ou d’un numéro) et si l’extension doit

Enregistrer en tant qu’Unicode (que vous pouvez activer si vous utilisez des paroles qui n’utilise

pas l’alphabet romain, tel que le japonais). Quand vous cliquez OK, un fichier texte est créé dans le

même dossier que le fichier Sibelius.

Si vous souhaitez copier les paroles d’un passage particulier ou d’une portée, sélectionnez-la avant

de lancer l’extension ; dans le cas contraire, l’extension enregistrera uniquement les paroles de la

portée supérieure contenant paroles dans la partition.
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L’utilisation constante des styles de texte dans votre partition offrira les meilleurs résultats avec

cette extension, car elle permet de séparer chaque strophe. Utilisez Paroles ligne 1 pour les

paroles de la première strophe, Paroles lignes 2 pour les paroles de la seconde strophe, etc. ;

utilisez Paroles (chorus) pour les chorus ; utilisez le style de texte Paragraphes pour les

paragraphes de paroles à la fin d’une partition, etc.

Si la partition contient des répétitions, des prima et secunda volta, etc., le fichier texte créé requiert

probablement des retouches. L’extension n’a pas été conçue pour traiter les partitions contenant

plusieurs morceaux : pour chaque morceau, un par un, sélectionnez simplement le morceau en

tant que passage et lancez l’extension.

Si vous lancez l’extension plus d’une fois sur la même partition (p.e. pour exporter des paroles vers

différentes portées ou morceaux), assurez-vous de renommer le fichier texte enregistré ou il

remplacera le fichier créé par l’extension précédemment.

Extension écrite par Lydia Machell.

Trouver et remplacer le texte
Recherche le texte spécifique dans votre partition et le remplacer par un autre texte. Pour utiliser

cette extension, choisissez Extensions > Texte > Trouver et remplacer le texte. Une boîte de

dialogue apparaît : saisissez le texte que vous voulez trouver et le texte par lequel vous souhaitez le

remplacer ; indiquez si l’extension doit chercher le texte exact ou un mot dans l’objet texte ou une

partie d’un mot dans un objet texte. Vous pouvez choisir de mettre en couleur le texte traité pour

faciliter le suivi, le cas échéant. Cliquez OK et l’extension trouve et remplace le texte spécifié dans la

partition.

L’extension préserve les sauts de ligne dans les objets texte multi-lignes lorsqu’elle y remplace du

texte mais les formatages gras, italique ou souligné seront perdus.

Extension écrite par Stefan Behrisch (www.werklabor.de) et mise à jour par Bob Zawalich. 

Numéroter les mesures
Ajoute des numéros au-dessus des mesures ; c’est particulièrement pratique pour numéroter les

mesures répétées ou celles de silences. Sélectionnez les mesures que vous souhaitez numéroter

puis choisissez Extensions > Texte > Numéroter les mesures. Une boîte de dialogue apparaît :
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Numérote toutes les Nèmes mesures quand N vaut vous permet d’indiquer la fréquence des

numéros et si l’extension doit ou non numéroter la première mesure du groupe ou la dernière.

Activez Numéroter les premières et dernières mesures sélectionnées dans tous les cas si

vous souhaitez que l’extension indique un numéro sur la première et la dernière mesure, même si

elles ne correspondent pas au patron indiqué.

Démarrer le compteur à détermine où l’extension doit commencer à compter et vous pouvez

choisir de redémarrer le numérotage aux repères de répétition ou aux barres de mesure. Régler le
compteur aux changements de numéro de mesures indique à l’extension de prendre en

compte les changements de numéro de mesures.

Les options d’Apparence vous permettent de choisir entre les numéros, les lettres minuscules ou

majuscules et d’indiquer un préfixe et un suffixe (comme des parenthèses) le cas échéant. Par défaut,

l’extension utilise le texte technique mais une poignée d’autres styles de texte sont aussi fournis en

options. Finalement, vous pouvez choisir si le texte doit être positionné du côté gauche de la mesure

ou au centre de la mesure.

Quand vous cliquez OK, l’extension numérote toutes les mesures selon les options choisies dans la

boîte de dialogue.

Extension écrite par Hans-Christoph Wirth.

Numéroter les temps
Cette extension numérote les temps dans une mesure pour un passage sélectionné ; par exemple :

Pour utiliser cette extension, sélectionnez le passage désiré et choisissez Extensions > Texte >

Numéroter les temps. La durée du temps est sélectionnée selon l’indication de mesure, p.e. 6/8 a

des temps de noire pointée en 6/8. Le texte est ajouté dans le style de texte technique ; si vous

trouvez des collisions avec les notes ou d’autres marques, sélectionnez un objet de texte et

choisissez Edition > Sélectionner > Selectionner plus (raccourci Ctrl+Shift+A ou xXA) et

déplacez toute la rangée à l’aide des touches 3/2 .

Repositionner le texte
Extension généraliste qui peut régler la position d’un texte de portée, p.e. positionner les doigtés de

clavier précisément. Pour utiliser cette extension :

* Pour repositionner un seul objet texte (p.e. une dynamique), sélectionnez-le puis choisissez

Extensions > Texte > Repositionner le texte. L’extension règle automatique la position de

l’objet texte sélectionné, le déplaçant au-dessus ou au-dessous de la note.

* Pour repositionner de grandes quantités de texte, assurez-vous que rien n’est sélectionné (pour

traiter toute la partition), filtrez le texte spécifique que vous souhaitez repositionner

(b 5.7 Rechercher et filtrer) ou sélectionnez un passage ; puis choisissez Extensions >

Texte > Repositionner le texte.
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Si vous choisissez de repositionner de grandes quantités de texte, une boîte de dialogue apparaît

vous permettant de choisir si vous souhaitez placer le texte toujours au-dessus de la note, toujours

au-dessous de la note, au-dessus ou au dessous de la note (pratique p.e. pour les textes de doigtés)

ou si vous souhaitez que le texte ne soit déplacé qu’horizontalement.

Cliquez soit sur OK pour traiter le texte ou cliquez sur Options avancées pour donner des

instructions supplémentaires à l’extension : vous pouvez indiquer un style de texte donné pour

repositionner le passage sélectionné et réglez la taille et le décalage verticale/horizontale du texte,

qui affecte la distance à laquelle l’extension déplacera le texte pour éviter les collisions avec les

notes.

Cette extension offre deux fenêtres d’Aide pratiques que vous pouvez consulter pour en savoir

plus.

Extension écrite par Marc Nijdam.

Rendre les guillemets intelligents
Remplace les guillemets et les apostrophes des objets de texte dans la partition ouverte ou dans un

jeu de fichiers dans un dossier spécifique de manière à ce qu’ils apparaissent “recourbés” avec une

forme plus agréable. La première boîte de dialogue de l’extension vous permet de choisir si la

procédure doit s’appliquer à la partition ouverte ou à un jeu de fichiers. La boîte de dialogue

suivante s’affiche quand vous cliquez Suivant :

Vous pouvez choisir quels styles de texte doivent être rendus “intelligents”, si l’extension doit

travailler en mode correction uniquement (dans ce cas, un log est généré mais aucun changement

n’est effectué sur la partition), régler les options de log et sélectionner comment les éléments

doivent être modifiés dans la partition. Si vous activez Écrire dans un fichier log, un log de tous

les changements effectués sera enregistré dans un fichier appelé Sibelius Quotes Log.txt, que

vous trouverez dans votre dossier Partitions.

À la différence de nombreux autres programmes, cette extension traite aussi avec des cas complexe

comme ‘Twas, ainsi que les repères imbriqués.

Extension écrite par Bob Zawalich.
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Ligature traditionnelle des paroles
Les notes ligaturées selon la construction des paroles, p.e. les ligatures sont rompues à chaque

nouveau mot ou syllabe. Pour utiliser cette extension, sélectionnez les portées sur lesquelles vous

souhaitez travailler (ou ne sélectionnez rien, pour travailler sur toute la partition ; seules les notes

liées à des paroles seront modifiées, les portées non vocales ne seront pas affectées) et choisissez

Extensions > Texte > Ligature traditionnelle des paroles.

Une boîte de dialogue apparaît vous permettant de choisir si vous souhaitez traiter uniquement le

passage sélectionné ou toute la partition et si vous souhaitez ou non rompre les ligatures des notes

sans paroles (dans ce cas, vous pouvez faire souligner les changements pour les vérifier ensuite).

Cliquez OK et la ligature est modifiée dans votre partition.

Extension écrite par Michael Kilpatrick.
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6.13 Extensions de transformations

Les extensions dans le sous-menu Extensions > Transformations fournissent une ample variété

d’outils pratiques pour générer rapidement de nouveaux matériaux musicaux à partir d’une

mélodie ou d’un rythme existant... et pour apprendre (ou enseigner) sur les principes derrières les

manipulations fréquentes de hauteur et de rythme. La plupart des extensions sont conçues pour

traiter un passage sélectionné qu’ils transforment. Certains n’ont pas d’options et, par conséquent,

n’affichent aucune boîte de dialogue ; parmi celles qui affichent une boîte de dialogue vous

permettent de la supprimer après avoir exécuté l’extension une première fois, en appliquant les

mêmes réglages dans le futur.

Pour les extensions qui peuvent modifier le rythme, les multiplets sont toujours déplacés d’un seul

bloc et les notes ornementales déplacées avec les notes régulières auxquelles elles sont liées. Les

notes liées présentent certaines complexités dans certaines de ces transformations, vous devriez

vérifier les résultats lors de la transformation de passages contenant des notes liées.

Vous pouvez trouver utile d’affecter des raccourcis claviers à certaines de ces extensions pour les

assimiler facilement dans votre flux de travail – b 5.12 Menus et raccourcis.

Toutes les extensions de transformations sont écrites par Bob Zawalich, sauf mention contraire.

Augmenter/réduire les intervalles
Augmente ou réduit les intervalles entre les notes successives dans la sélection, pour une quantité

donnée.

Sélectionnez un passage et choisissez Augmenter Intervalles ou Réduire Intervalles depuis le

sous-menu Extensions > Transformations. Une boîte de dialogue apparaît dans laquelle vous

pouvez choisir la quantité avec laquelle les intervalles doivent être augmentés ou réduits.

Conserver les altérations doubles détermine si Sibelius doit ou non réorthographier les

altérations doubles sous une forme enharmonique équivalente et plus simple. Cliquez OK et le

passage sélectionné est transformé.

Si vous souhaitez lancer l’extension plusieurs fois avec les mêmes options, activez Ne plus afficher
cette boîte de dialogue (jusqu’au redémarrage de Sibelius) dans la boîte de dialogue de

l’extension ; la boîte de dialogue n’apparaît plus jusqu’à ce que vous redémarriez Sibelius.

Doubler ou réduire de moitié les valeurs des notes
Il est parfois utile de réduire de moitié ou de double les valeurs des notes dans votre partitions, p.e.

si vous transcrivez de la musique ancienne dans laquelle les valeurs des notes sont deux fois plus

longues que celles des éditions modernes.

Pour lancer ces extensions, sélectionnez un passage de la musique et choisissez Doubler les
valeurs des notes ou Réduire de moitié la valeur des notes depuis le sous-menu Extensions >

Transformations. Une boîte de dialogue apparaît vous avertissant des limites de l’extension.

Quand vous cliquez sur OK, une nouvelle partition est créée avec le passage sélectionné copié sous

sa nouvelle forme. L’extension copie aussi les indications de mesure (les doublant ou les réduisant

de moitié le cas échéant) et crée les liens appropriés.
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Inverser
Effectue une inversion du passage sélectionné autour d’une hauteur donnée. Cette extension

remplace la musique originale.

Pour utiliser l’extension, sélectionnez la musique que vous souhaitez inverser et choisissez

Extensions > Transformations > Inverser. Une boîte de dialogue apparaît dans laquelle vous

pouvez régler la hauteur à laquelle vous invertirez le matériel et si vous souhaitez l’inverser

Chromatiquement or Diatoniquement.

Extension écrite par James Larcombe et Jürgen Zimmermann. 

Répartition des hauteurs
Parfois vous pouvez désirer générer des variations d’un passage existant, en le transposant, par

exemple, en mode mineur. Cette extension vous permet d’indiquer de nouvelles hauteurs pour

chaque degré d’une gamme chromatique et modifie (“répartit”) les hauteurs dans le passage

sélectionné en fonction.

Pour utiliser l’extension, sélectionnez le passage que vous souhaitez répartir et choisissez

Extensions > Transformations > Répartition des hauteurs. Choisissez les hauteurs désirées dans

les menus déroulants de l’extension dans la boîte de dialogue puis cliquez sur OK.

Par défaut, l’extension traite toutes les notes d’une même hauteur de la même manière (donc Solb
et Fa# sont les mêmes), mais si vous avez besoin de répartir des hauteurs enharmoniques

équivalentes de manières différentes, cliquez sur le bouton Plus de choix, qui vous permettra de le

faire.

Vous pouvez aussi choisir si Sibelius doit répartir les notes existantes vers des notes plus hautes ou

plus basses en cliquant sur Nouvelle hauteur supérieure ?. Une nouvelle boîte de dialogue

s’affiche vous permettant de choisir si Sibelius doit ou non répartir toutes les notes vers le haut ou

vers le bas ou, au contraire, la largeur des intervalles entre les anciennes et les nouvelles hauteurs

avant que les notes ne soient transposées.

L’extension examine toutes les notes dans la sélection et calcule la hauteur de chaque note relative à

Do (donc 0 pour Do, 1 pour Do#/Réb, etc). Puis, elle altère la hauteur de chaque note selon les

paramètres de la boîte de dialogue de l’extension. Imaginez que vous avez réglé une répartition de

Ré vers La# dans la boîte de dialogue : tous les Ré dans la sélection seront remplacés par des La#
dans la même octave que les notes originales (les octaves vont de Do à Si).

Par conséquent, si vous avez réglé une répartition de Sol vers Ré, l’extension la remplacera par un

Ré sous la note originale. Ce n’est pas toujours ce que vous voulez, à cet effet utilisez Déplacer
toutes les notes supérieures à cette note vers l’octave suivante. Avec cette option activée, si

une note est supérieure à celle donnée ici, elles seront réparties vers la nouvelle hauteur puis

transposées d’une octave vers le haut.

Hauteurs aléatoires
Remplace les hauteurs existantes dans la sélection par des hauteurs nouvelles aléatoires.

Sélectionnez un passage et choisissez Extensions > Transformations > Hauteurs aléatoires. Les

rythmes des notes dans le passage sélectionné sont inchangés mais les hauteurs sont changées

aléatoirement.
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Rétrograder
Crée une version rétrogradée du passage sélectionné - en d’autres mots, la musique est inversée.

Par exemple, cette extension réécrit la musique suivante :

sous la forme :

Pour utiliser cette extension, sélectionnez le passage que vous souhaitez rétrograder et choisissez

Extensions > Transformations > Rétrograder. Une boîte de dialogue apparaît, vous avertissant

des limites de l’extension. En cliquant sur OK, la partition est créée avec la nouvelle musique.

Rétrograder les hauteurs
Réécrit la sélection de façon à ce que l’ordre des hauteurs soit inversé (la dernière hauteur devient

la première, l’avant dernière devient la seconde, etc) sans modifier la durée des notes.

Sélectionnez un passage et choisissez Extensions > Transformations > Rétrograder les
hauteurs. Le passage est réécrit.

Rétrograder les rythmes
Réécrit la sélection de façon à ce que l’ordre des rythmes soient inversé (la durée de la dernière

note devient celle de la première, etc) sans modifier la hauteur des notes.

Sélectionnez un passage et choisissez Extensions > Transformations > Rétrograder les rythmes.

Le passage est réécrit.

Rétrograder les rythmes et les hauteurs
Réécrit la sélection de manière à inverser l’ordre des hauteurs et des rythmes.

Sélectionnez un passage et choisissez Extensions > Transformations > Rétrograder les rythmes
et les hauteurs. Le passage est réécrit.

Faire tourner les hauteurs
Réécrit la sélection de manière à ce que les hauteurs des notes soient “décalées” vers la droite d’une

note (par conséquent la hauteur de la dernière note devient celle de la première, celle de la

première devient celle de la seconde, etc) sans modifier les rythmes des notes.

Sélectionnez un passage et choisissez Extensions > Transformations > Faire tourner les
hauteurs. Le passage est réécrit.

Faire tourner les rythmes
Réécrit la sélection de manière à ce que les durées des notes soient “décalées” vers la droite d’une

note (par conséquent la durée de la dernière note devient celle de la première, celle de la première

devient celle de la seconde, etc) sans modifier la hauteur des notes.

Sélectionnez un passage et choisissez Extensions > Transformations > Faire tourner les
rythmes. Le passage est réécrit.
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Faire tourner les rythmes et les hauteurs
Réécrit la sélection de façon à ce que les durées et les hauteurs des notes dans la sélection soient

décalées vers la droite, d’une note (de sorte que la dernière note de la sélection se convertit en la

première, la deuxième en seconde, etc).

Sélectionnez un passage et choisissez Extensions > Transformations > Faire tourner les
rythmes et les hauteurs. Le passage est réécrit.

Mélanger les hauteurs
Réécrit la sélection de façon à ce que les hauteurs existants des notes soient redistribuées au

hasard, en changeant le contour mélodique de manière aléatoire sans introduire de nouvelles

hauteurs.

Sélectionnez un passage et choisissez Extensions > Transformations > Mélanger les hauteurs.

Le passage est réécrit.

Transformer une gamme
Modifie les hauteurs dans la partition ouverte depuis la gamme actuelle vers une nouvelle gamme,

p.e. pour changer la modalité d’une mélodie de majeure à mineure ou pour changer une

pentatonique en gamme par tons entiers, etc.

Pour utiliser l’extension, sélectionnez le passage que vous souhaitez transformer et choisissez

Extensions > Transformations > Transformer une gamme. Une boîte de dialogue apparaît dans

laquelle vous indiquez la gamme actuelle et la nouvelle gamme dans laquelle vous aimeriez la voir

transformée. Aimanter les tons hors gamme vers la gamme détermine si l’extension doit

“aimanter” une note hors de la gamme à la note la plus proche dans la gamme (p.e. Mib n’est pas

dans la gamme de Sol majeur, vous pouvez alors choisir si l’extension la laisse telle quelle ou

l’aimante vers la note la plus proche dans la gamme, dans ce cas le Ré). Faites votre choix et cliquez

OK.

L’extension a de nombreuses options supplémentaires, que vous pouvez afficher en cliquant sur

Afficher les options dans la boîte de dialogue qui apparaît :

* Définit les types supplémentaires de gammes en cliquant sur Ajouter/Modifier les gammes

* Sauvegarder et récupérer les transformations que vous utilisez le plus souvent en cliquant sur

Sauvegarder/Restaurer la table

* Détermine la direction dans laquelle Sibelius doit transformer les notes quand la gamme est

modifiée en cliquant sur Nouvelle hauteur supérieure ?

Chacune de ces boîtes de dialogue contiennent des informations détaillées sur son utilisation et

l’extension dispose aussi d’un bouton Aide pour afficher des détails supplémentaires.
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6.14 Extensions de multiplets

Toutes les extensions dans le sous-menu Extensions > Multiplets peuvent intervenir sur la

musique en utilisant de nombreuses voix. Quand vous utilisez les extensions sur la sélection d’un

passage, ils n’affectent que la voix 1. Si vous souhaitez manipuler les voix 2, 3 ou 4, faites

simplement une sélection multiple, p.e. sélectionnez la première note du multiplet dans la voix 2,

puis Ctrl+cliquez ou X-cliquez la dernière note du multiplet avant de lancer l’extension.

Extensions de multiplet écrites par Hans-Christoph Wirth.

Ajouter des notes au multiplet
Ajoute des notes au multiplet en cours, tout en conservant la même durée d’ensemble (p.e. en

augmentant son rapport). Pour utiliser l’extension, sélectionnez autant de notes que de multiplets

existants à ajouter (p.e. si vous avez un septuplet et souhaitez en faire un nontuplet, sélectionnez

deux des notes du septuplet), puis choisissez Extensions > Multiplets > Ajouter des notes au
multiplet.

Modifier le rapport des multiplets
Change le rapport des multiplets, en conservant la durée d’ensemble identique. Vous pouvez

doubler ou réduire de moitié le rapport (p.e. rendre un multiplet 3:2 en 3:4, 6:4 ou 6:8, etc). Pour

utiliser l’extension, réalisez la sélection d’un passage incluant toutes les notes du multiplet ou

sélectionnez le nombre de multiplet et choisissez Extensions > Multiplets > Modifier le rapport
des multiplets. Une boîte de dialogue simple apparaît ; choisissez le rapport souhaité et cliquez

sur OK. La boîte de dialogue dispose d’un bouton Options ; en cliquant vous affichez la boîte de

dialogue (voir Préférences des multiplets ci-dessous).

Allonger les multiplets
Allonge un multiplet en combinant le multiplet avec les notes de chaque côté. Pour utiliser

l’extension, sélectionnez toutes les notes des multiplets existants et les notes (avant ou après le

multiplet) que vous souhaitez ajouter au multiplet et choisissez Extensions > Multiplets >

Allonger les multiplets. Si vous sélectionnez toutes les notes de deux ou davantage de multiplets,

ils seront joints dans un unique multiplet.

Créer un multiplet
Transforme une sélection de notes en multiplet. Pour utiliser l’extension, sélectionnez les notes que

vous souhaitez transformer en multiplet puis choisissez Extensions > Multiplets > Créer un
multiplet. Une boîte de dialogue simple apparaît vous permettant de choisir le rapport du

multiplet et s’il faut faire correspondre le multiplet avec les silences sur la gauche ou la droite. La

boîte de dialogue dispose d’un bouton Options ; en cliquant vous affichez la boîte de dialogue

(voir Préférences des multiplets ci-dessous).
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Supprimer des notes des multiplets
Supprime des notes au multiplet en cours, tout en conservant la même durée d’ensemble (p.e. en

réduisant son rapport). Pour utiliser l’extension, sélectionnez autant de notes que de multiplets

existants à ajouter (p.e. si vous avez un quintuplet et souhaitez en faire un triplet, sélectionnez

deux des notes du quintuplet), puis choisissez Extensions > Multiplets > Supprimer des notes
au multiplet.

Raccourcir les multiplets
Raccourci un multiplet en retirant des notes de ce dernier et en les écrivant hors des crochets. Pour

utiliser l’extension, sélectionnez les notes que vous souhaitez conserver dans le multiplet puis

choisissez Extensions > Multiplets > Raccourcir les multiplets. Les notes dans le multiplet non-

sélectionnées sont écrites sous la forme de notes “normales” avant ou après le multiplet raccourci.

Si vous sélectionnez une ou deux notes, l’extension supprime le multiplet complètement et le

remplace par des notes régulières.

Diviser ou relier les multiplets
Divise un seul multiplet en deux multiplets plus courts ou relie deux ou davantage multiplets

adjacents en un seul plus long.

Pour diviser un multiplet, sélectionnez la première note du second multiplet puis choisissez

Extensions > Multiplets > Diviser ou relier les multiplets.

Pour relier des multiplets, sélectionnez un passage contenant deux ou davantage multiplets

adjacents puis choisissez Extensions > Multiplets > Diviser ou relier les multiplets. Quand vous

reliez les multiplets, l’extension évite d’altérer le timing précis d’exécution des notes dans le

nouveau multiplet relié. Dans certains cas, le multiplet résultant peut être plus agréable pour un

mathématicien que pour un interprète. Si vous n’aimez pas le résultat, sélectionnez Modifier >

Défaire, sélectionnez les deux multiplets puis essayez Extensions > Multiplets > Allonger le
multiplet (voir ci-dessous).

Préférences des multiplets
Indique les préférences à utiliser par les autres extensions dans le

sous-menu Extensions > Multiplets. Vous pouvez aussi accéder à

l’extension en cliquant sur Options dans les boîtes de dialogue de

Créer un multiplet et Modifier le rapport des multiplets.

Les options parlent d’elles-mêmes. Les deux premières affectent les

rapports des multiplets créés par les extensions, car il existe

plusieurs manières de décrire le rapport d’un même multiplet. Par exemple, cinq notes au lieu de

trois seront notées 5:3 ou 5:6 quand vous réglez Conserver le rapport des multiplets dans
l’intervalle sur 1:1 ... 2:1 ou 1:2 ... 2:2 respectivement. Pour modifier le rapport d’un seul

multiplet, utilisez Extensions > Multiplets > Modifier le rapport des multiplets (voir ci-dessus).
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7.1 Travailler avec des parties séparées

La musique pour plusieurs instruments est normalement produite à la fois dans une partition et

dans des “parties” séparées qui contiennent chacune la musique d’un seul instrument (ou parfois

plusieurs). Les parties sont évidemment différentes du conducteur: elles contiennent uniquement

la notation qui concerne l’instrument; elles peuvent être dans une autre tonalité dans le cas

d’instruments transpositeurs; la mise en page est différente et souvent d’ailleurs, un format de

papier différent est utilisé.

Heureusement, Sibelius s’occupe de tout cela à votre place, en réalisant automatiquement la mise

en forme, la transposition et la mise en page des parties

Que signifie “parties dynamiques”?
Les autres programmes de notation nécessite “d’extraire” les parties pour chaque instrument sous

forme de fichiers séparés, ce qui signifie que tout changement réalisé dans le conducteur (après la

première répétition, par exemple) doit être reporté dans les parties, et parfois même celles-ci

doivent être extraites de nouveau, ce qui représente une perte de temps importante.

Cependant, Sibelius utilise une approche révolutionnaire grâce à laquelle tout changement réalisé

dans le conducteur est automatiquement réalisé dans les parties, et vice-versa: c’est ce phénomène

que nous appelons parties dynamiques™.

Les parties dynamiques se travaillent exactement de la même manière que le conducteur.

Vous pouvez déplacer, ajouter et supprimer des notes, des liaisons, des indications d’expression,

etc... comme d’habitude. Mais ce qui est changé dans le conducteur, est instantanément mis à jour

dans les parties et vice-versa.

Il n’est donc pas nécessaire d’extraire les parties dynamiques, car en fait elles sont contenues dans

le même fichier – ce qui représente une organisation beaucoup plus simple.

Afficher les parties dynamiques
Quand on crée ou qu’on ouvre un fichier Sibelius, la partition qui s’affiche est celle du conducteur.

Se rendre dans une partie ou la quitter se fait simplement à l’aide de la liste déroulante présente sur

la barre d’outils où est indiquée Partition complète. Quand on clique sur cette indication, une

liste apparaît commençant par partition complète, suivie de tous les noms des parties. Cliquez le

nom d’une partie et Sibelius l’ouvrira dans une nouvelle fenêtre. 

Vous pouvez passer rapidement du conducteur à la partie affichée la plus récente grâce au bouton

de la barre d’outils Basculer entre le conducteur et les parties  (raccourci W). Si vous

sélectionnez une note ou une autre portée avant d’utiliser Basculer entre le conducteur et les
parties, Sibelius affichera la partie qui la contient. Si rien n’est sélectionné, Sibelius affichera la

dernière partie affichée. Vous pouvez aussi basculer d’une partie à l’autre dans la fenêtre des

parties (cf. ci-dessous).

Il est aussi possible de passer d’une partie à l’autre avec Fenêtre > Partie suivante et Partie
précédente (raccourcis Ctrl+Alt+Tab ou zX~ et Maj+Ctrl+Alt+Tab ou xzX~). Après la

dernière partie, ce qui sera affiché sera le conducteur.
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Afficher plusieurs parties
Par défaut, Sibelius créera seulement deux fenêtres par partition: une pour le conducteur, et l’autre

pour les parties. Quand vous passez d’une partie à l’autre, Sibelius réutilise la fenêtre de la partie

affichée précédemment. Si vous préférez que Sibelius crée une fenêtre séparée pour chaque partie,

parce que peut-être vous voulez les étaler sur grand écran, activez Affichage des parties dans
des nouvelles fenêtres sur la page Autres de Fichier > Préférences (dans le menu Sibelius sur

Mac), raccourci Ctrl+, ou X+.

Distinguer le conducteur d’une partie
Sibelius utilise des textures pour le bureau et le papier différentes selon qu’on affiche le conducteur

ou les parties, ce qui permet de les distinguer instantanément. Par défaut, Sibelius affiche les

parties sur un papier de couleur crème et le conducteur sur un papier blanc. Pour changer l’aspect

de ces textures, utilisez la page Textures de Fichier > Préférences (dans le menu Sibelius sur

Mac) – b 5.6 Paramètres d’affichage.

La fenêtre des parties
la fenêtre des parties permet d’imprimer, de créer, de modifier, de supprimer et d’extraire des

parties. Cette fenêtre n’a pas à être utilisée très souvent (par exemple, on peut imprimer en

utilisant directement Fichier > Imprimer ou Fichier > Imprimer toutes les parties), et donc

devrait être désactivée en général. Cependant pour l’afficher, choisissez Fenêtre > Parties
(raccourci Ctrl+Alt+R ou zXR), ou cliquez sur le bouton de la barre d’outils correspondant. 

Tout comme la liste déroulante de la barre d’outils, on y trouve une liste de toutes les parties

existantes dans le conducteur. Pour afficher une partie, il suffit de double-cliquer sur son nom.

Vous pouvez appliquer des changements à plusieurs parties en même temps. Pour sélectionner

une seule partie, cliquez sur son nom. Si vous désirez sélectionner plusieurs parties, utilisez

Ctrl+clic ou X-clic pour ajouter une partie à une sélection, ou faites Maj-clic pour étendre la

sélection.

Nombre de copies à 

imprimer (cliquer 

pour modifier)
Nom de la partie 

(cliquer pour 

modifier)

Imprimer

Partie(s)

Nouvelle partie Présentation 

des parties multiples
Nouveau

Portées dans les parties

Supprimer ExtractionCopier partie

Mise en page
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Une fois qu’une ou plusieurs parties sont sélectionnées, vous pouvez cliquer sur un des six boutons

au bas de la fenêtre:

* Imprimer une (des) Partie(s): imprimer les parties sélectionnées en cours; la colonne Copies
permet de spécifier le nombre de copies de chaque partie souhaitée – cf. Imprimer des
parties multiples ci-dessous

* Présentation des parties multiples: Sibelius vous demandera si vous voulez faire les

changements dans toutes les parties du conducteur ou seulement celles sélectionnées, les

changements se faisant en une seule opération sur les parties choisies – b 7.3 Présentation
des parties multiples

* Copier la mise en page d’une partie: copie la mise en page de partie en cours d’affichage dans

la (les) partie(s) sélectionnées de la fenêtre des parties – cf. Copier la mise en page des
parties à la page 614

* Nouvelle partie: permet de créer une nouvelle partie manuellement, qui contient n’importe

quel nombre de portées du conducteur

* Portées dans la partie: utilisez cette option pour ajouter ou enlever des portées d’une partie.

(Cela fonctionne uniquement avec une seule sélection.)

* Supprimer une (des) partie(s): enlève la (ou les) partie(s) sélectionnées

* Extraire des parties: extrait des parties dans des fichiers Sibelius séparés– b 7.4 Extraction
des parties.

Imprimer des parties multiples
Quand on imprime une partition d’orchestre, d’habitude on a besoin que d’un seul exemplaire de la

première partie de flûte, mais de beaucoup plus d’exemplaires de la partie de premier violon que

doivent recevoir tous les musiciens concernés. Sibelius permet de régler le nombre de copies

souhaitées pour chaque partie. Sélectionnez la partie souhaitée dans la fenêtre des parties et

cliquez une fois sur la colonne Copies. Un curseur apparaît, tapez le nombre de copies entre 0 et

99.

Avec cette possibilité de spécifier un nombre de copies pour chaque partie, imprimer un jeu

complet de parties peut littéralement être fait en un ou deux clics de souris. Vous pouvez imprimer

n’importe quelle combinaison de parties dans une seule session d’impression.

Pour imprimer toutes les parties, choisissez Fichier > Imprimer toutes les parties. Pour

imprimer quelques parties, sélectionnez-les dans la fenêtre des parties et cliquez sur le bouton

Imprimer les (la) partie(s) ( ). Vous pouvez aussi imprimer une seule partie de la manière

normale en utilisant Fichier > Imprimer. Si vous imprimez plus d’une seule partie, il ne sera pas

possible d’ajuster le nombre de copies dans la boîte de dialogue Imprimer.

Vous pouvez imprimer les parties directement dans des fichiers PDF, ce qui est très pratique pour

les envoyer par courriel. Sous Windows vous devez installer un pilote d’imprimante PDF pour

utiliser cette fonction (cf. Créer des fichiers PDF à la page 744). Sur Mac, il suffit de cliquer

simplement sur Sauvegarder en tant que PDF dans la boîte de dialogue Imprimer. À la fois sous

Windows et sur Mac, Sibelius sauvegardera chaque partie sous forme de fichier PDF séparé, en

attribuant un nom de fichier adéquat pour chacun.
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Créer des nouvelles parties
Sibelius crée automatiquement une partie pour chaque instrument du conducteur. Quand vous

ouvrez une partition dans Sibelius 3 ou une version antérieure, vous pouvez choisir si vous

souhaitez créer ou non un jeu de parties (b 9.7 Ouvrir des fichiers de versions
anciennes). 

Si vous devez ajouter manuellement une partie supplémentaire dans la partition pour une raison

ou l’autre, cliquez sur le bouton Nouvelle Partie ( ) dans la fenêtre des parties. Vous verrez une

boîte de dialogue dans laquelle vous pouvez choisir les portées disponibles dans la partition dont

vous souhaitez qu’elles deviennent une nouvelle partie. C’est exactement la même chose que la

boîte de dialogue Portées dans les parties (cf. ci-dessous).

Ajouter ou enlever des portées des parties
Sibelius permet d’inclure n’importe quelle combinaison de portées du conducteur dans une partie.

Voici par exemple, le cas d’une partition de réduction de chant-piano d’un opéra créée avec tous les

chanteurs plus un accompagnement de clavier.

Pour réaliser cela, vérifiez que le conducteur contient tous les instruments nécessaires, y compris

les portées de clavier. Cependant, les portées de réduction pour clavier ne sont pas toujours

imprimées avec le conducteur; il faut donc comme pour la réduction de chant-piano, créer une

partie qui sera la partition du chef car contenant tous les instruments excepté l’accompagnement

de clavier. Quand vous imprimez les partitions, imprimez cette partie “conducteur pour le chef” et

la partie “réduction” au lieu d’imprimer le conducteur d’origine qui contient tous les instruments.

Pour changer les portées d’une partie existante, sélectionnez la partie et cliquez sur le bouton

Portées dans les parties ( ) de la fenêtre des parties. La boîte de dialogue suivante apparaît:

La liste Portées disponibles sur la gauche affiche les portées disponibles dans le conducteur qui

ne sont pas contenues dans la partie. Quand une portée a été ajoutée à une partie, elle apparaît

dans la liste à droite Portées dans les parties. Pour ajouter des portées à une partie, sélectionnez

les portées souhaitées dans la liste de gauche et cliquez sur le bouton Ajouter à la partie.

De même, pour enlever des portées d’une partie, sélectionnez-les dans la liste de droite et cliquez

sur le bouton Enlever de la partie (cela n’enlève pas l’instrument du conducteur).
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Quand vous enlevez ou ajoutez une ou plusieurs portées d’une partie, l’espacement des notes est

recalculé, pour garantir que l’espacement reste correct.

Supprimer des parties
Pour supprimer une partie, sélectionnez-la dans la fenêtre des Parties et cliquez sur le bouton

Suppr ( ). Sibelius vous demandera de confirmer si vous voulez poursuivre. Si vous désirez

supprimer plus d’une partie en une fois, il suffit de cliquer sur le bouton Suppr en ayant fait une

sélection multiple. Supprimer une partie ne supprime pas l’instrument de la partition.

Cependant, conserver dans la liste des parties non utilisées ne pose aucun problème, de sorte qu’il

ne faut pas ressentir d’obligation à devoir les supprimer à tout prix.

Présentation des parties et du conducteur
Voici les éléments qui sont toujours identiques dans le conducteur et dans toutes les parties; donc

qu’on se trouve dans l’un ou les autres, tout changement affecte l’ensemble:

* Les styles de texte: bien qu’il soit possible de régler les tailles de point différemment dans le

conducteur et pour toutes les parties séparées dans Modifier les styles de texte

* Les positions par défaut: bien que, de même, il soit possible de les régler différemment dans le

conducteur et pour toutes les parties séparées dans la boîte de dialogue Positions par défaut

* La plupart des règles de gravure Style maison > Règles de gravure (par ex. la position des

altérations, des points de rythme, des crochets, des clés, des armures, des multiplets, la

présentation des barres de mesure, des diagrammes d’accords, des soufflets, des repères de

répétition, des liaisons de phrasé et rythmiques; les position des ligatures, les tailles des notes;

les encadrements de texte et les options des paroles).

Voici les éléments qui peuvent se régler différemment dans le conducteur et les parties, si bien que

seul les changements affectent ce qui est affiché, le conducteur ou les parties:

* Format de page et taille des portées, etc... (dans Mise en page > Paramètres du document)

* Mise en page, y compris les sauts et Mise en page > Mise en page automatique

* Espacement des notes (y compris Style maison > Règle d’espacement des notes)

* Tailles des textes (cf. Styles de texte dans les parties a la page 612)

* Quelques règles de Style maison > Règles de gravure (par ex. format des numéros de mesures,

mesures de comptage, noms des instruments, indications de mesure, présentation des

séparateurs de système, espacement des portées et des systèmes)

* Présentation du code temporel et des points de montage (Exécution > Vidéo et minutage >

Code temporel et durée et Points de montage).

Il est utile de pouvoir réaliser ces changements dans les parties indépendamment les unes des

autres. Cependant il peut aussi être pratique de le faire sur toutes les parties ou sur un ensemble de

partie en même temps plutôt que l’une après l’autre. C’est l’utilité de la boîte de dialogue

Présentation des parties multiples – b 7.3 Présentation des parties multiples.
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7.2 Modifier les parties

Modifier une partie se fait exactement de la même manière que modifier un conducteur; en fait

pratiquement tout ce qu’il est possible de faire dans un conducteur est possible dans une partie.

Créer et supprimer des objets dans une partie est automatiquement répercuté dans le conducteur

et vice-versa.

Déplacer des objets dans les parties
Cependant, déplacer des objets (à part changer la hauteur des notes) c’est un autre sujet. Vous

pouvez positionner des choses de manière légèrement différente dans un conducteur et une partie,

pour des raisons de mise en page et pour éviter des collisions qui peuvent survenir dans l’une mais

pas dans l’autre. Voici comment cela fonctionne:

* Si vous déplacez un objet dans une partition, il se déplace aussi dans la partie concernée (comme

on pouvait s’y attendre)

* Mais si vous déplacez un objet dans une partie, il ne bougera pas dans le conducteur. La même

chose se produit avec l’aspect d’un objet; si vous déplacez le milieu d’une liaison pour en changer

la forme dans la partie, elle ne changera pas dans le conducteur. Il est donc possible de faire des

ajustements finaux sans affecter le conducteur. L’objet devient orange dans la partie pour

montrer qu’il est différent dans le conducteur (cf. Différences dans les parties ci-dessous).

* Après avoir déplacé un objet dans une partie de cette manière, le déplacer dans la partition ne le

déplacera pas une nouvelle fois dans la partie (parce qu’il changerait de nouveau alors que

l’ajustement définitif était déjà réalisé), à moins que vous ne le déplaciez tellement loin dans le

conducteur qu’il s’attacherait à une autre note (sinon le conducteur et la partie ne

correspondraient plus), ou à moins que vous ne régliez l’objet pour qu’il redevienne de nouveau

identique dans le conducteur et la partie (cf. ci-dessous Régler les objets dans les parties).

* Vous devriez éviter de déplacer un objet trop loin dans une partie (par ex. sur une note

différente), parce qu’il ne bougera pas dans le conducteur et dès lors ne correspondra plus avec.

Si vous le faites, la ligne d’attache en gris deviendra rouge, pour vous avertir qu’il est trop loin

par rapport à son emplacement d’origine dans le conducteur.

Par conséquent, en général on réalisera la saisie dans le conducteur plutôt que dans les parties;

seuls les ultimes ajustements de position et de présentation des objets se feront dans les parties.

Notez cependant que, outre le déplacement des objets, vous pouvez réaliser des changements de

mise en page tels que déplacer des portées, ajuster les sauts de système et de page et changer

l’espacement des notes car il n’y a aucun problème au fait que le conducteur et les parties se

présentent sous des mises en page identiques.

Différences dans les parties
Quand vous modifiez ou déplacez un objet dans une partie, Sibelius affiche de manière fort

pratique qu’il y a une différence entre le conducteur et la partie en colorant l’objet en orange. (Si

cela vous gêne, désactivez Affichage > Différences dans les parties.)

Par exemple:
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* Les objets de portée (par exemple du texte d’expression, des soufflets, des altérations, etc...)

apparaissent en orange s’ils ont été déplacés dans les parties

* Les notes dont la hampe a été inversée ou qui ont été réduites en notes de réplique dans les

parties apparaissent en orange

* Les objets affichés dans la partie mais masqués (ou absents) dans le conducteur, ou vice-versa,

apparaissent en orange.

Vous pouvez aussi activez affichage > Différences dans les parties dans le conducteur et Sibelius

mettra en couleur tout objet déplacé ou modifié dans une ou plusieurs parties. Cela permet de voir

plus facilement par exemple sur quels objets appliquer Mise en page > Réinitialiser la position
d’après le conducteur (cf. ci-dessous).

Régler les objets dans les parties
Si vous devez rétablir la position d’un objet dans une partie, vous pouvez soit le remettre sur sa

position par défaut, ou sur la position identique à celle qu’il occupe dans le conducteur.

* Pour rétablir la position par défaut (c’est-à-dire les valeurs définies dans Style maison >
Positions par défaut), choisissez Mise en page > Réinitialiser les positions (raccourci

Ctrl+maj+P ou xXP).

* Pour rétablir la position d’un objet d’après le conducteur, choisissez Mise en page >

Réinitialiser la position d’après le conducteur (raccourci Ctrl+Maj+Alt+P ou xzXP). Si

Affichage > Différences dans les parties était activé, l’objet n’apparaîtra plus en orange.

Quand vous travaillez dans le conducteur, vous pouvez utiliser Mise en page > Réinitialiser la
position d’après le conducteur pour rétablir un objet d’après sa position dans le conducteur

pour toutes les parties dans lesquelles il apparaît.

Vous pouvez aussi rétablir l’aspect d’un objet dans une partie (par ex. une liaison de phrasé) soit

d’après son aspect original, ou d’après l’aspect qu’il présente dans le conducteur: 

* Pour rétablir un ou plusieurs objets selon son aspect par défaut, choisissez Mise en page >

Rétablir l’aspect original (raccourci Ctrl+Maj+D ou xXD)

* Pour rétablir l’aspect du même objet d’après le conducteur, choisissez Mise en page > Rétablir
l’aspect d’après le conducteur (raccourci Ctrl+maj+Alt+D ou xzXD). De nouveau l’objet

n’apparaîtra plus en orange (sauf si sa position a aussi changé).

Dès que vous avez restauré la position d’après le conducteur, en étant dans le conducteur,

choisissez Mise en page > Rétablir l’aspect original pour rétablir l’aspect de l’objet sélectionné

d’après le conducteur pour toutes les parties dans lesquelles il apparaît.

Masquer et afficher dans les parties et le conducteur
Excepté quelques cas (tels que les changements de clé et les passages de réplique), tous les objets

d’une partition sont par défaut visibles à la fois dans le conducteur et toutes les parties qui le

contiennent. Si vous souhaitez masquer un objet dans une partition de manière à ce qu’il

n’apparaisse que dans une partie, sélectionnez l’objet en question (dans le conducteur ou la partie)

et choisissez Édition > Masquer ou afficher > Afficher dans les parties. De même, si vous

voulez qu’un objet n’apparaisse que dans le conducteur et pas dans les parties, choisissez Édition�>
Masquer ou afficher > Afficher dans le conducteur.



7. Parties

612

Si vous êtes en train d’afficher le conducteur, choisir Édition > Masquer ou afficher > Masquer
masque l’objet dans le conducteur et toutes les parties. Si vous affichez une partie, choisir Édition >

Masquer ou afficher > Masquer masque l’objet dans la partie uniquement sans affecter le

conducteur. (Vous pouvez aussi masquer/afficher les objets dans les parties individuelles à partir

de l’onglet Général des Propriétés.)

Modifier les noms des parties
Les noms des parties peuvent être modifiés directement dans la fenêtre des parties en modifiant le

champ Nom ou dans la boîte de dialogue Fichier > Partition > Infos sur la partition quand vous

visualisez une partie. Pour modifier à partir de la fenêtre des parties, choisissez la partie à

renommer et cliquez une fois sur la colonne Nom. Un curseur apparaît permettant de taper le

nouveau nom de la partie. Modifier le nom d’une partie en modifie aussi le nom sur la première

page et les pages suivantes. 

Si vous devez énumérer plusieurs instruments sur des lignes séparées par exemple dans l’en-tête

des pages, utilisez \n\.Vous pouvez aussi indiquer à Sibelius d’utiliser la police de texte musical

pour des caractères individuels en précédant de a ^ le caractère dont la police doit changer (par ex.

Clarinette en B^b apparaîtra sous la forme “Clarinette en Bb”) – cf. Ajouter des
changements de format dans les infos sur la partition à la page 291 pour en savoir plus

sur les caractères spéciaux que vous pouvez taper.

Pour en savoir sur le nom des parties, cf. Nom des parties et changements d’instrument à

la page 289. Pour en savoir plus sur les noms d’instruments, b 3.8 Noms d’instrument.

Styles de texte dans les parties
Chaque style de texte dans Sibelius possède deux tailles: l’une pour le conducteur et l’autre pour

toutes les parties. Pour changer la taille du texte des parties indépendamment du conducteur,

cliquez sur Modifier les styles de texte, soit dans le menu Style maison ou dans la page Style
maison page de Présentation des parties multiples. La boîte de dialogue Modifier les styles
de texte apparaîtra. Sélectionnez le nom du style de texte que vous souhaitez modifier et cliquez

sur Modifier. une boîte de dialogue apparaît:
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Pour ajuster la taille du point du style de texte dans les parties, entrez une nouvelle taille de point,

soit relative à une portée de 7mm ou comme valeur absolue. Si vous ne voulez pas que le texte

soit mis à l’échelle proportionnellement de la taille de la portée activez Conserver en absolu. Pour

en savoir plus sur la manière de modifier les styles de texte, b 3.9 Modifier les styles de
texte.

Si vous souhaitez que du texte apparaisse à des tailles différentes dans le conducteur et les parties,

par exemple pour le titre, – qui est en général plus grand dans le conducteur que dans les parties –

n’utilisez jamais le panneau Texte des propriétés pour en ajuster la taille. Tout changement

apporté à la taille du texte de cette manière affecte à la fois le conducteur et les parties. À la place, il

con-vient de changer les tailles par défaut du style de texte dans Style maison > Modifier les
styles de texte.

Si vous rencontrez du texte beaucoup trop gros ou trop petit dans le conducteur ou les parties, vous

en avez sans doute modifié la taille en utilisant les propriétés; sélectionnez-le et choisissez Mise en
page > Rétablir l’aspect original (raccourci Ctrl+maj+D ou zXD), puis allez dans Style
maison > Modifier les styles de texte et réglez les tailles qui conviennent pour le conducteur et

les parties.

Changements de clés dans les parties
Sibelius permet de créer des changements de clés dans les parties qui n’apparaissent pas dans le

conducteur; de telles clés sont mises en couleur orange (si Affichage > Différences dans les
parties est activé). Prenez garde cependant au fait que si la clé initiale dans la partie est différente

de la clé initiale pour cet instrument dans le conducteur, l’option Ne pas tenir compte des
changements de clés de la page Style maison de présentation des parties multiples
(b 7.3 Présentation des parties multiples) peut empêcher l’apparition de tout

changement de clé créé dans la partie, auquel cas Sibelius vous préviendra.

Soyez attentif au fait que si un changement de clé existe dans le conducteur et est visible dans la

partie, si vous déplacez la clé dans la partie, elle se déplacera aussi dans le conducteur. Si vous

devez déplacer la clé dans la partie sans qu’elle ne se déplace dans le conducteur, créez une nouvelle

clé dans la partie directement au-dessus de la clé existante; cette nouvelle clé sera indépendante

dans cette partie spécifique, et pourra être déplacée de manière indépendante de celle présente

dans le conducteur.

Codas dans les parties
Sibelius vous permet de régler si la scission de système qui apparaît parfois devant une coda doit

aussi apparaître dans les parties. Une coda est installée par une barre de mesure dont Diviser les
mesures à compter est activé avec Espace avant la mesure est plus grand que 0. (Quand vous

choisissez Mise en page > Saut > Diviser un système, Sibelius réalise cela automatiquement –

b 4.6 Reprises.) Si vous souhaitez que le système se divise automatiquement aux mêmes

endroits dans les parties, activez Conserver les espaces avant les codas (dont les mesures de
silence sont divisées) dans la page Mise en page de Présentation des parties multiples. Pour

supprimer les scissions dans les parties, désactivez-le – b 7.3 Présentation des parties
multiples.
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Copier la mise en page des parties
Dans certains styles de musique, particulièrement ceux pour les films, la TV ou le théâtre, il est

d’usage que la mise en page de toutes les parties instrumentales soient très proches, avec les sauts

de systèmes et de page placés aux mêmes endroits dans toutes les parties. Copier la mise en page

d’une partie dans les autres est très simple avec Sibelius:

* Tout d’abord, ajustez la mise en page d’une des parties, y compris la position verticale des objets

de système tels que les repères de répétition, les indications de tempo, etc. jusqu’à obtention du

résultat souhaité pour les autres parties aussi

* Tout en visualisant la partie dont la mise en page doit être copiée:

% Pour copier la mise en page vers toutes les autres parties, cliquez sur le bouton Copier la

mise en page d’une partie ( ) avec toutes (ou aucune) partie(s) sélectionnée(s) dans la

fenêtre 

% Pour copier la mise ne page vers une ou plusieurs parties, sélectionnez les parties à mettre à

jour, et cliquez sur le bouton Copier la mise en page d’une partie

* À la question de savoir si vous souhaitez faire l’opération, cliquez sur Oui.

Instantanément, la mise en page de la partie en cours est copiée dans les parties sélectionnées.

Le format et l’orientation de la page et la taille des portées, les marges de page et de portée, les sauts

de système, de page et spéciaux, les réglages de Mise en page > Sauts de page automatiques, et

les positions des objets de système sont tous mis à jour pour correspondre à la partie choisie.

Exporter les styles maisons depuis les parties
Si vous avez réglé la présentation d’une partie via les boîtes de dialogue Présentation des parties
multiples, Sauts de page automatiques et Règles de gravure, vous pouvez en exporter le style

maison, soit pour l’importer vers les autres parties de la même partition ou pour l’importer plus

tard dans les parties d’une autre partition.

Pour exporter un style maison d’une partie, veillez à afficher cette partie, et choisissez Style
maison > Exporter le style maison.

Pour importer le style maison dans d’autres parties de la même partition (ou d’une autre),

sélectionnez ces parties dans la fenêtre des parties, cliquez sur le bouton Présentation des
parties, puis cliquez sur Importer style maison dans la page Style maison de la boîte de

dialogue. 

Quand vous exportez un style maison depuis une partie, il comporte des choses telles que les

réglages de Sauts de page automatiques et paramètres du document qui donne l’aspect d’une

partie. C’est pourquoi ce style maison ne convient que pour être importé dans d’autres parties et

pas dans un conducteur. De même, si vous exportez un style maison depuis un conducteur, il ne

conviendra pas pour des parties. Il convient donc d’exporter des styles maison différents pour les

conducteurs et les parties.

Parties existant sous différentes transpositions
Il est parfois nécessaire que dans la même partie figurent plusieurs transpositions (par exemple

des orchestres de vents peuvent nécessiter des parties de cuivres en Sib et en Mib, en fonction des

instruments disponibles), ce que Sibelius permet de réaliser très facilement:
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* Tout d’abord, créez une nouvelle partie contenant l’instrument pour lequel vous voulez créer une

partie dans une autre transposition – cf. Créer des nouvelles parties à la page 608

* Changez le nom de la partie de manière à la différencier, par ex. 1er Cor (Mib) – cf. Modifier
les noms des parties ci-dessus 

* Maintenant affichez la partie, en double-cliquant sur son nom dans la fenêtre des parties, ou en

la choisissant dans le menu de la barre d’outils

* Pour changer la transposition d’une partie, veillez à ce que rien ne soit sélectionné dans la partie

(tapez Échap), puis choisissez Créer > Autres > Changement d’instrument. Choisissez la

variante de l’instrument dans la transposition désirée et cliquez sur OK, puis cliquez au tout

début de la première portée de la partie à créer. Ce changement d’instrument existe seulement

dans cette partie et n’affectera pas le conducteur ou les autres parties.

* Vous pouvez aussi devoir changer l’armure utilisée par la nouvelle partie transposée.

De nouveau, veillez à ce que rien ne soit sélectionné (tapez Échap), choisissez Créer > Armure
(raccourci K), sélectionnez l’armure souhaitée, et cliquez sur OK, puis cliquez tout au début de la

partie. Comme le changement d’instrument, cette armure n’existe que dans cette partie.

* Enfin, pour des transpositions particulièrement extrêmes, il faudra peut-être changer la clé. Rien

n’étant sélectionné, choisissez Créer > Clé (raccourci Q), sélectionnez la clé désirée, et cliquez sur

OK, puis cliquez tout au début de la portée. Il sera peut-être nécessaire de devoir placer aussi des

changements de clé supplémentaires – cf. Changements de clés dans les parties ci-

dessus.

Bien que cela soit moins souvent nécessaire, on peut aussi créer des changements d’instrument, de

clé et d’armure à n’importe quel endroit d’une partie dynamique sans affecter le conducteur ou les

autres parties basées sur le même instrument dans le conducteur. Prenez garde cependant au fait

que si vous ajoutez une armure à une partie, elle n’affectera que la partie en cours et pas le

conducteur. Si vous voulez ajouter un changement de clé dans tout le conducteur et toutes les

parties, il faut le faire dans le conducteur.
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7.3 Présentation des parties multiples

La boîte de dialogue Présentation des parties multiples peut être utilisée pour changer en une

seule opération la présentation des parties quel que soit leur nombre. Sélectionnez tout d’abord la

(les) partie(s) à changer dans la fenêtre des parties, puis cliquer sur .

Si vous avez changé la présentation des parties multiples, il peut y avoir des occurrences dont

certains réglages sont différents dans différentes parties; dans ce cas elles apparaissent en blanc.

Si aucun changement n’a été apporté dans cet état, alors les valeurs individuelles pour chaque

partie n’ont pas été changées.

La boîte de dialogue se divise en trois  pages accessibles par des onglets:

La page Paramètres du document
La page Paramètres du document permet de régler le format et l’orientation de la page, et la

taille des portée des parties séparées: 

* Régler le format de pages sur Identique à celui du partition règle à la fois le format et

l’orientation des pages dans les parties de manière identique au partition. Si vous souhaitez

d’autres réglages, choisissez-les dans la liste déroulante et cliquez sur Portrait ou Paysage.

* Régler la taille des portées Identique à celle du partition garantit que toutes les portées des

parties ont une taille identique à celle du partition. Cependant, comme les parties ont

généralement des portées plus grandes, on peut changer la taille de la portée et choisir d’en

exprimer la valeur soit en mm ou en pouces.

* L’option Marges permet de changer les marges de la page et des portées indépendamment du

partition – cf. Marges des pages et Marges des portées à la page 657. Augmenter la

marge supérieure de la première page peut être utile pour libérer de l’espace pour le titre, etc...

* Sur Mac, vous pouvez cliquer sur Mise en page (et un bouton supplémentaire non illustré ici)

pour ajuster les réglages d’impression par défaut pour les parties, par exemple si un papier

spécifique est requis lors de l’impression – b 5.16 Imprimer.
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La page Mise en page
La page Mise en page propose les options suivantes; en cas de doute, conservez les réglages par

défaut (qui sont tout à fait pertinents):

* Pour changer les réglages de Mise en page automatique, cliquez sur Mise en page
automatique. Cette boîte de dialogue permet de choisir comment Sibelius va gérer le

placement des systèmes, la répartition des pages et des mesures de silence (b 8.4 Sauts de
page automatiques).

* Les sauts de système, de page et sauts de page spéciaux ajoutés manuellement dans le partition

peuvent être supprimés, conservés ou modifiés dans les parties (en cas de doute, conservez les

options telles quelles):

% Pour que les pages blanches au début de la partition (c’est-à-dire avant la première mesure de

musique) apparaissent dans les parties, activez Conserver les pages de titre

% Pour que d’autres pages blanches (c’est-à-dire celles qui apparaissent après la première

mesure de musique) apparaissent dans les parties de la même manière que dans le partition,

activez Conserver les autres sauts de page spéciaux

% Pour que d’autres sortes de saut soient utilisés, activez la case privilégier les tournes aux, et

choisissez lesquels, sauts de page ou sauts de système

% Pour conserver les sauts de page du partition, activez Conserver les sauts de page

% Pour qu’ils soient changés en sauts de système, activez privilégier les tournes aux sauts de
système

% Si vous voulez que les sauts de système du partition apparaissent aussi dans les parties,

activez Conserver les sauts de système

% D’autres instructions de mise en forme (par ex. les systèmes verrouillés, “les mesures

solidaires”) du partition peuvent aussi apparaître dans les parties si vous activez Conserver
les autres sauts

% Conserver les espaces avant les codas (dont les mesures de silence sont divisées) –
cf. Codas dans les parties à la page 613 pour en savoir plus.
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* Il est d’usage d’indenter à droite le premier système d’une partie séparée. Sibelius vous permet

d’indenter toutes les parties automatiquement en réglant Indenter le premier système de par

ex. 4 dents. Si le réglage est zéro, les portées apparaîtront dans la position normale.

* pour régler la manière dont les portées sont justifiées dans les parties, régler Justifier les
portées quand le taux de remplissage de la page est de n%. (cf. Justification verticale
à la page 671.)

* La valeur déterminée dans Distance entre les systèmes contrôle la distance standard entre les

systèmes dans les parties ou dans celles sélectionnées. Diminuer la valeur fait gagner de la place.

Sur les pages où la musique est justifiée verticalement la distance entre les portées peut être plus

grande que la valeur spécifiée.

* Pour changer la présentation des mesures à compter dans les parties, choisissez le style adéquat

dans la liste Présentation. Si vous souhaitez que Sibelius place le chiffre 1 au-dessus des

mesures de silence isolées, activez Afficher ‘1’ au-dessus des pauses (mesure de silence
isolée) (b 2.24 Mesures de comptage).

* Par défaut, la numérotation des pages des parties commence par 1. Si vous voulez un autre

numéro pour la première page, spécifiez-le en changeant Premier numéro de page. Ou si

exceptionnellement, vous souhaitez que les parties utilisent les mêmes numéros de page que le

partition:

% Conserver les changements de numéros de page des pages de titre du partition, est

une option disponible seulement si Conserver les pages de titre est activé (parce que les

changements de page sont toujours attachés aux sauts de page), qui fait apparaître dans les

parties tout changement (pour autant qu’il existe) de numéro de page attaché à une page de

titre du partition.

% Conserver les autres changements de numéros de page du partition, est une option

disponible seulement si Conserver les autres sauts de page spéciaux est activé, qui fait

apparaître dans les parties les changements de numéro de page présents après le début dans

le partition.

Si vous souhaitez masquer tous les numéros de page de vos parties, activez masquer les
numéros de page par défaut. Pour en savoir plus sur les numéros de page, b 3.6 Numéros
de page.
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La page Style maison
Voici les options de la page Style maison:.

* Sibelius peut ajouter des noms d’instrument à chacune des parties. Par défaut, ceux-ci

apparaissent dans le coin supérieur gauche de la Première page, et au sommet des Pages
suivantes. Si vous ne voulez pas de nom d’instrument, désactivez une ou les deux options.

(Les en-têtes de nom d’instrument sont automatiquement générés d’après le nom de chaque

partie grâce aux formules magiques – b 3.10 Formules magiques – et existent toujours

dans chaque partie. Si vous désactivez les en-têtes ici, Sibelius va masquer les objets textuels

concernés dans les parties, sans les supprimer, permettant ainsi de les faire réapparaître plus

tard.)

* Par défaut, le code temporel et les points de montage ne sont pas affichés dans les parties. Pour

rendre visible le code temporel, choisissez soit Au-dessus de chaque portée ou Au début de
chaque système dans Affichage du code temporel. Pour afficher les points de montage,

activez Afficher les points de montage (b 4.11 Code temporel et points de
montage).

* Les indications de mesure apparaissent par défaut, placées normalement entre la ligne

supérieure et inférieure de la portée. Si vous voulez utiliser des indications de mesure Grande
ou Géante dans les parties, choisissez l’option adéquate Taille des indications de mesure (cf.

Indications de mesure géantes, etc.... à la page 215).

* Cliquer sur le bouton Modifier les styles de texte vous conduit directement dans la boîte de

dialogue Modifier les styles de texte (cf. Styles de texte dans les parties à la page 612)

* Vous pouvez importer un style maison dans toutes les parties sélectionnées en cliquant sur

Importer un style maison – cf. Exporter les styles maisons depuis les parties à la

page 614. Seules les options de Règles de gravure et paramètres du document et Règle
d’espacement des notes sont activées quand on importe dans une partie.
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* Désactiver Ne pas tenir compte des changements de clés garantit que tous les changements

de clés apparaissent dans les parties. Pour supprimer tous les changements de clés dans les

parties, activez Ne pas tenir compte des changements de clés et choisissez Toujours.

Quelques instruments transpositeurs (telle la clarinette basse) peuvent utiliser dans les parties

une clé différente de celle utilisée dans le partition, de sorte que les changements de clé

nécessaires dans le partition n’ont pas de sens dans la partie. Dans ce cas, activez Ne pas tenir
compte des changements et cliquez sur Si le partition et la partie présentent des clés
différentes. Dans une partie, on peut ajouter tous les changements de clé nécessaires; ceux-ci

n’apparaîtront pas dans le partition – cf. Changements de clés dans les parties à la

page 613.

* Certains compositeurs préfèrent masquer les segments de portée des instruments qui ne jouent

pas (cela donne un aspect un peu fragmenté) – cf. Portées interrompues par des espaces
à la page 198). Cependant, cette convention ne s’appliquant pas aux parties, Sibelius propose en

option de supprimer tous les changements d’instrument de type portée sans ligne (masquée); il

suffit d’activer Ne pas tenir compte des changements de type de portée “sans lignes
(masquée)”.

* Pour régler la fréquence des numéros de mesure dans les parties, choisissez Toutes les n

mesures, À chaque système ou Pas de numéro de mesure. Vous pouvez aussi centrer les

numéros en choisissant Centré dans la mesure. Si vous ne voulez pas que les numéros de

mesure apparaissent aux mêmes mesure que des repères de répétition, activez Masquer si un
repère de répétition est présent. Si vous désirez que l’aspect des numéros des parties soit

différent du partition, choisissez le style de texte à utiliser dans la liste déroulante Style de texte
des numéros de mesure. (Le style de texte numéros de mesure (parties) est conçu pour

cela.) Mais normalement, il suffit de le laisser sur Numéros de mesure.



7.4 Extraction des parties

621

Parties

7.4 Extraction des parties

Extraire des parties signifie tout simplement que n’importe quelle partie dynamique choisie pour

être extraite sera exportée comme fichier autonome, mais avec les notes, la mise en forme et la

mise en page conservées précisément. Les parties dynamiques originales ne subissent aucune

modification.

Pourquoi extraire des parties?
En pratique, il est rarement nécessaire d’extraire des parties d’une partition et à moins d’avoir un

réel besoin, on doit pouvoir éviter les désagréments d’une telle manœuvre; il existe cependant des

situations pour lesquelles cela peut s’avérer nécessaire:

* Les parties qui présentent dans le conducteur, soit un nombre variable de portées, soit des portées

sur lesquelles jouent plusieurs musiciens en même temps: si un conducteur contient une portée

pour “Cors 1+3” et des portées séparées pour “Cor 1” et “Cor 3” utilisées à différents points du

conducteur pour des raisons de clarté, il n’est pas possible de créer une partie de “Cor 1” ou “Cor

3” automatiquement, même si vous pouvez créer une seule partie dynamique commune aux

Cors 1 et 3.

Si un conducteur contient une portée pour deux musiciens, tels que “Flûtes 1.2.,” il n’est pas

possible de créer automatiquement des parties individuelles de “Flûte 1” et “Flûte 2”. Vous devez

extraire les parties “Flûtes 1.2.” en deux fichiers séparés, puis dans chacun d’eux, enlever l’autre

instrument – mais consultez Plusieurs musiciens sur la même portée ci-dessous avant de

poursuivre et d’extraire les parties.

* Si vous souhaitez que les parties puissent être ouvertes par Sibelius Student ou une version

antérieure de Sibelius: Vous devrez extraire les parties du conducteur et ensuite en exporter les

fichiers au format souhaité correspondant aux versions 2, 3, 4 ou Student.

* Si vous voulez publier les parties sur SibeliusMusic.com: Comme Scorch est incapable d’afficher

les parties dynamiques, il est nécessaire d’extraire les parties du conducteur et de les placer

séparément sur SibeliusMusic.com.

Veillez à extraire les parties le plus tard possible. En effet, en cas de révision d’une partition, cela

permet de réduire au minimum les changements à reporter dans les parties.

Si vous faites des révisions ultérieures d’une partition, il est d’ailleurs parfois plus rapide de

recommencer l’extraction de toutes les parties que de les réviser.
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Boîte de dialogue d’extraction des parties
Pour extraire les parties, cliquez sur le bouton Extraire les parties ( ) dans la fenêtre des

parties. La boîte de dialogue suivante apparaît:

À gauche de la boîte de dialogue, vous pouvez sélectionner les parties à extraire. Vous pouvez

sélectionner une seule partie à extraire, ou ajouter des parties individuelles à la sélection avec

Ctrl+clic ou X-clic, ajouter des parties consécutives avec Maj-clic, ou cliquez et glisser avec la

souris dans la liste pour ajouter des parties consécutives.

En passant les options (envisagées plus bas), cliquez sur OK, et en quelques secondes la (les)

partie(s) est (sont) sauvegardée(s) et ouverte(s) dans Sibelius sous forme de fichier séparé.

Voici les autres options de cette boîte de dialogue:

* Sibelius sauvegarde les parties extraites dans le chemin entré dans Sauvegarder dans le
dossier. Vous pouvez entrer un chemin manuellement ou cliquer sur Parcourir pour localiser le

répertoire.

Sibelius permet de créer des noms pratiques pour chacune des parties en utilisant des codes.

Sibelius affiche dans la boîte de dialogue la liste des codes reconnus. Si par exemple, votre

partition s’appelle Opus 1 et que vous en extrayez la partie de deuxième hautbois, entrer un

nom de fichier de %f - %p (partie %n de %o).sib donnerait Opus 1 - 2nd Hautbois (partie
4 de 29).sib.

Par défaut, Sibelius donne un nom aux parties dans un format pratique qui comprend le nom du

fichier de la partition, le nom de la partie, la date et l’heure de la sauvegarde.

* Si vous désactivez Afficher les parties maintenant, vous pouvez extraire et sauvegardez un

ensemble de parties sans qu’elles apparaissent à l’écran. Si vous laissez l’option activée, vous

devrez fermer toutes les parties (en utilisant Fichier > Fermer tout) après les avoir extraites.

Plusieurs musiciens sur la même portée
Même si les parties dynamiques ne peuvent pas toujours convenir dans les cas de plusieurs

musiciens sur la même portée (par ex. Cors 1+2), elles peuvent faire gagner du temps si le
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conducteur comporte à la fois la portée de Cors 1+2 et les portées séparées Cor 1 et Cor 2, ce qui

facilite les changements sur les trois portées que l’on peut visualiser ensemble. Pour faire cela:

* Dans le conducteur, écrivez les notes sur une portée qui combine le Cor 1+2 (ou alternez-la avec

des portées séparées)

* Une fois la musique entrée, ajoutez deux portées séparées, l’une pour le Cor 1 et l’autre pour le

Cor 2; reportez la musique correspondante dans chacune des deux portées par copier / filtrer,

comme décrit ci-dessous Extraire individuellement les musiciens d’un pupitre.

* Créez une “partie” dynamique (appelée par ex., “partition du chef”) qui contient tous les

instruments excepté les deux nouvelles portées séparées de Cor 1 et de Cor 2 (cf. Ajouter ou
enlever des portées des parties à la page 608). Imprimez cette partition pour le chef. Pour

les parties de cors, imprimez les portées séparées de Cor 1 et de Cor 2 (à la place de la portée

combinée).

* Si par la suite vous devez réviser quelque chose dans les cors, il suffit simplement de faire les

mêmes révisions (dans le conducteur) à la portée combinée de Cors 1+2 et aux portées séparées

de Cor 1 et de Cor 2.

Extraire individuellement les musiciens d’un pupitre
Comme décrit dans b 2.18 Instruments et portées, il arrive parfois de devoir faire des

parties individuelles pour chaque musicien que compte un pupitre – par ex.Trompettes 1, 2 et 3. La

méthode diffère selon les cas:

* Si les musiciens passent d’une portée à l’autre, vous devrez extraire plus d’une portée dans la

même partie. Par exemple, si la partition présente des instruments appelés “Trompettes 1.2.3,”

“Trompettes 1.2” et “Trompette 3,” pour obtenir une partie de Trompette 3, il faut extraire

Trompettes 1.2.3, et Trompette 3 dans la même partie et supprimer toutes les notes qui ne sont

jouées par la trompette 3. Pour cette dernière étape, vous pouvez vous aider des filtres

(b 5.7 Rechercher et filtrer). Comme pour un conducteur, placez dans la partie des sauts

de systèmes là où un musicien passe d’une portée à l’autre, de manière à masquer les portées non

utilisées de part et d’autre du saut.

* S’il y a seulement deux musiciens (par ex. Flûte 1 et 2) qui partagent parfois ou toujours la même

portée, faites l’extraction des deux dans la même partie puis enlevez les notes inutilisées à l’aide

des filtres – lisez la suite.

Le plus répandu des cas évoqués ci-dessus est celui des deux musiciens qui partagent la même

portée comme dans l’exemple pour deux flûtes que voici:

Dans cet exemple, les notes sont parfois en accord de deux notes, parfois à l’unisson (a 2) et parfois

à deux voix.

Les filtres intégrés dans Sibelius permettent d’extraire en quelques clics de souris ce que chaque

musicien joue. Les filtres Édition > Filtre > Partie 1 (pour suppression) et Partie 2 (pour
suppression) sont spécifiquement conçus pour cela.

Flûtes
1 & 2

rall.
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* Afficher la (ou les) portée(s) de Flûtes 1 & 2 comme partie dynamique individuelle. Faites

ensuite tous les changements nécessaires communs aux deux flûtes, tels qu’enlever les collisions

entre objets ou l’ajout de répliques.

* Faites l’extraction de la partie

* Faites une copie de la partie extraite en utilisant Fichier > Sauvegarder sous, en l’appelant par

exemple, Flûte 2

* Pour faire la partie de Flûte 1, sélectionnez sous forme de passages l’une à près l’autre chaque

section où figurent les 2 flûtes, choisissez Édition > Filtrer > Partie 2 (pour suppression), tapez

deux foix Suppr pour supprimer la musique de la flûte 2 – La première fois la commande Suppr
transforme les notes indésirables en silences, et la seconde fois Suppr masque ces silences. Pour

les sections d’accords à une voix, comme l’exemple ci-dessus, utilisez les filtres pour supprimer

de nouveau les silences spécifiquement, tandis que Suppr supprimera les notes de la flûte 1

restantes après avoir tapé Suppr la première fois.

* Ne touchez pas aux sections où la flûte joue, ce qu’indique le ’1.’ au-dessus de la portée. Mais tous

les endroits à 2 voix l’une joue et l’autre reçoit des silences doivent être traités avec le filtre

Édition Filtrer Partie 2 (pour suppression).

* Voici la partie de flûte, complète avec toutes les nuances et le texte que vous devriez obtenir. Il ne

reste qu’à modifier le nom pour que s’affiche “Flûte 1”:

* Pour faire la partie de flûte 2, ouvrez la copie de la partie extraite et suivez la même procédure,

en utilisant Édition > Filtre > Partie 1 (pour suppression). Après avoir changé le nom, vérifier

les articulations, etc., voici ce que vous devriez obtenir : 

Voici cependant un cas pour lequel les filtres ne peuvent pas être utilisés de la même manière; il

s’agit d’un mélange d’accords de deux notes et de deux voix différenciées dans la même mesure:

Dans cette illustration, utiliser par exemple le filtre Partie 2 (Pour
suppression) ne sélectionnerait pas les deux croches à la fin de la

mesure. En effet, Sibelius considère toujours que dans une mesure

individuelle, s’il y a plusieurs voix, chaque voix est celle d’un musicien;

donc pour que cela fonctionne, il faut veiller à ce que les voix soient utilisées dans toute la même

mesure. Dans ce cas précis, l’astuce consiste à sélectionner la paire des deux croches graves et à les

basculer en voix 2 (raccourci Alt+2 ou z2).

Ces filtres “Partie” peuvent seulement s’utiliser avec deux musiciens séparés et non trois (comme

l’exemple avec les trois trompettes illustré ci-dessus).

N’utiliser pas les filtres “Partie” pour sélectionner un musicien précis et le copier - le résultat ne

donnera pas la musique voulue. Pour en savoir plus sur les filtres, b 5.7 Rechercher et filtrer.

^

^
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8.1 Mise en page et mise en forme

b 2.29 Portées, 7.1 Travailler avec des parties séparées, 5.23 Menu affichage,

8.3 Gravure musicale, 8.4 Sauts de page automatiques, 8.5 Les sauts,

8.6 Paramètres du document, 8.7 Attaches, 8.9 L’espacement entre les notes,

8.10 Espacement des portées

La mise en page signifie comment la musique apparaît sur la page. La mise en forme est le

processus de création d’une bonne mise en page. Sibelius en sait tellement sur la gravure musicale

qu’il fait automatiquement la mise en forme de la musique pour produire une mise en page

instantanée et excellente. Dans la plupart des autres programmes de notation, la mise en forme est

laissée pour la plus grande part à l’utilisateur, ce qui peut parfois faire perdre plusieurs heures.

Mais Sibelius vous laisse aussi mettre au point la mise en page. L’outillage à votre disposition pour

ce faire est décrit ci-dessous; la plupart de ces options se trouvent dans le menu Mise en page. Par

exemple, vous pouvez définir vos propres tournes de page dans les parties extraites, ou forcer une

partition à tenir dans un nombre de pages commode.

Comme Sibelius refait la mise en forme de la partition en une fraction de seconde, vous pouvez

ajuster la mise en page à tout moment, même lorsque la musique est terminée, ce qui élimine la

nécessité de planifier à l’avance.

Votre arsenal de mise en forme comporte trois armes: l’ajustement des dimensions de la page et

des portées, l’espacement vertical et l’espacement horizontal. Certaines options sont aussi prévues

pour forcer un passage musical à s’ajuster à un système ou une page, et pour verrouiller la musique

de sorte que la mise en forme reste identique.

Dimensions de la page et taille des portées
Un premier dégrossissage consiste à modifier les dimensions des portées, des marges et / ou de la

page à l’aide de la boîte de dialogue Mise en page > Paramètres du document (raccourci Ctrl+D
or XD). La modification de ces paramètres est l’une des manières d’augmenter ou de réduire le

nombre de pages d’une partition, ou de libérer de l’espace entre les portées.

L’ajustement de la taille des portées (la distance entre la ligne supérieure et la ligne inférieure d’une

portée à cinq lignes) est généralement la plus efficace. Vous constaterez qu’un ajustement minime

a souvent un effet spectaculaire sur la quantité de musique que peut contenir une page, sans

affecter la lisibilité des notes. Dans une partition orchestrale, par exemple, cela peut faire pencher

la balance entre faire tenir un système par page, ou en placer deux, diminuant par là la longueur de

la partition de moitié.

De la même manière, un ajustement minime fait aux marges ou même aux dimensions de la page

peut avoir un grand effet sur la mise en page. Bien entendu, pour des raisons pratiques, la

modification de ces paramètres ne sera peut-être pas une option idéale dans votre situation.

Pour en savoir plus sur ces options, b 8.6 Paramètres du document.
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Espacement vertical
Modifier l’espace vertical signifie en fait, déplacer les portées. Cela doit être réalisé avec précaution,

et il est recommandé de comprendre les concepts sous-tendant l’espacement vertical pour que

Sibelius puisse faire automatiquement ce que vous souhaitez. Pour en savoir plus sur ces options,

b 8.10 Espacement des portées.

Outre modifier la distance entre les portées, vous pouvez économiser de l’espace en masquant les

portées vides (b 2.29 Portées). Autre moyen de réduire le nombre de portées sur une page,

notamment dans les parties: créer un saut de page. Les portées restantes seront espacées en

proportion sans que vous ayez besoin de les tirer (b 8.5 Les sauts).

Espacement horizontal
Modifier l’espacement horizontal signifie modifier la distance entre les notes, les silences et les

barres de mesure; b 8.9 L’espacement entre les notes.

Sauts de système et sauts de page
Si vous devez modifier la mise en forme par défaut de Sibelius, vous pouvez insérer des sauts de

page et de système manuels au-dessus de n’importe quelle barre de mesure; b 8.5 Les sauts.

Assembler en un système/ en une page
Vous pouvez contraindre n’importe quel passage à tenir en un système ou sur une page.

Sélectionnez simplement le passage, puis à partir du sous-menu Mise en page > Mise en forme
choisissez Assembler en un système (raccourci Shift+Alt+M ou xzM) ou Assembler en une
page (raccourci Ctrl+Shift+Alt+M ou xzXM). Il restera dorénavant verrouillé en un système

ou en une page, même si vous refaites la mise en forme de la partition.

Pour annuler cela, déverrouiller la mise en forme (voyez ci-dessous) .

Comme pour les autres commandes en mode manuel, vous ne devriez pas systématiquement

assembler des passages en système / page. En effet, cette opération peut produire à un autre

endroit que celui souhaité des effets secondaires indésirables – l’opération est prévue pour être

utilisée lors de circonstances spéciales.

Garder les mesures ensemble
Parfois, on souhaite s’assurer que deux ou trois mesures apparaissent toujours sur le même

système. Pour garantir ce résultat, sélectionnez les mesures que vous voulez garder ensemble, et

choisissez Mise en page > Mise en forme > Garder les mesures ensemble.

Rendre la mise en page homogène
Si vous voulez définir un nombre constant de mesures par système, et / ou de systèmes par page,

choisissez Extensions > Autre > Rendre la mise en page homogène - cf. Rendre la mise en
page homogène à la page 570.

Verrouiller la mise en forme
Si vous avez entré un passage de musique qui demande une mise en forme très particulière que

vous ne voulez pas gâcher, vous pouvez la verrouiller. Cela empêche les mesures d’être redistribuées

sur d’autres systèmes (bien que cela n’empêche pas les modifications d’espacement à l’intérieur du

système, par ex. pour déplacer une note vers la gauche / droite). Pour verrouiller la mise en forme,
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sélectionnez simplement le passage en question et choisissez Mise en page > Mise en forme >

Verrouiller la mise en forme (raccourci Ctrl+Shift+L ou xXL).

Lorsque vous verrouillez la mise en forme ou utilisez Mise en page > Mise en forme > Assembler
en un système / une page, des petits lutins invisibles placent des symboles de mise en page à

chaque barre de mesure pour empêcher celles-ci de se déplacer. Ces icônes sont visibles lorsque

l’option Affichage > Marques de mise en page est activée.

Déverrouiller la mise en forme
Pour annuler Verrouiller la mise en forme, resélectionnez les mesures et choisissez Mise en
page > Mise en forme > Déverrouiller la mise en forme (raccourci Ctrl+Shift+U ou xXU).

Cela fera disparaître les icônes bleues, et les mesures sont à nouveau libres de passer d’un système

à un autre.

Déverrouiller la mise en forme supprime également les sauts de pages, les sauts de système et

annule les fonctions Assembler en un système / une page, Garder les mesures ensembles
ainsi que les effets de l’extension Rendre la mise en page homogène.

Mise en page automatique
La boîte de dialogue Mise en page automatique permet de spécifier les endroits sensibles où

Sibelius peut placer automatiquement des sauts de système et de page, spécialement dans les

parties séparées – b 8.4 Sauts de page automatiques.

Indentation des portées
Vous pouvez tirer sur les extrémités droite et gauche des systèmes pour créer des indentations –

b 2.29 Portées.

Réinitialiser les positions
Vous pouvez déplacer les objets à leur position par défaut en effectuant une sélection et en

choisissant Mise en page > Réinitialiser la position (raccourci Ctrl+Shift+P ou xXP).

Voici quels sont les effets spécifiques de cette opération sur certains objets précis :

* Textes et repères de répétition: sont alignés avec les notes, et les lignes de paroles ou les symboles

d’accords sont réalignés.

* Symboles: sont alignés avec les notes - par ex. pour ajouter un ornement au-dessus d’une note

* Lignes: les terminaisons se referment sur les notes, et les liaisons de phrasé non magnétiques le

deviennent. La boîte de dialogue Style maison > Positions par défaut permet de définir la

position par défaut exacte par rapport à la note.

* Multiplets: les multiplets non magnétiques (comme ceux créés avec Sibelius 1.4 ou antérieur)

deviennent magnétiques

* Altérations: la position horizontale des altérations est réinitialisée

* Angles de ligatures et longueurs de hampe: sont réinitialisés à leurs réglages par défaut (comme

pour Notes > Réinitialiser les hampes et les positions des ligatures).

Vous pouvez également utiliser la souris pour déplacer des objets vers un position judicieuse: lors

de la copie d’objets texte via Alt+clic ou z-clic, vous pouvez maintenir enfoncé Maj, qui place

automatiquement les objets copiés directement à leurs positions par défaut.
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Réinitialiser la position dans le partition
Cette fonction agit comme Réinitialiser la position, si ce n’est que les objets dans la partie sont

réglés pour utiliser la même position qu’ils occupaient à l’origine dans le conducteur. Si cette

fonction est utilisée dans le partition, Sibelius réinitialisera la position dans toutes les parties dans

lesquelles l’objet apparaît.

Réinitialiser l’aspect original
Si vous avez modifié l’aspect (plutôt que la position) d’un objet, vous pouvez rétablir son aspect par

défaut en utilisant Mise en page > Réinitialiser l’aspect original (raccourci Ctrl+Maj+D ou

xXD).

Les effets spécifiques sur certains objets précis sont les suivants:

* Démasque les ligatures, tronçons de ligature et crochets

* Démasque les occurrences effacées de texte de système (par ex. du texte de tempo ou des repères

de répétition)

* Réinitialise l’échelle des images importées

* Réinitialise la courbure et la symétrie des liaisons (rythmiques / de phrasé)

* Réinitialise les objets textuels à leur format par défaut.

Réinitialiser l’aspect original de la partition
Cette fonction agit comme Réinitialiser l’aspect original, si ce n’est que les objets dans la partie

sont réglés pour utiliser le même aspect que celui qu’ils avaient à l’origine dans le conducteur. Si

cette fonction est utilisée dans le conducteur, Sibelius rétablira l’aspect dans toutes les parties dans

lesquelles l’objet apparaît.

Pour en savoir plus sur Réinitialiser la position dans le partition et Réinitialiser l’aspect
original de la partition, b 8.4 Sauts de page automatiques et Régler les objets dans
les parties à la page 611.

Aligner des objets
Pour aligner horizontalement ou verticalement plusieurs objets sélectionnés, choisissez Mise en
page > Aligner sur une rangée (raccourci Ctrl+Maj+R ou xXR) ou Mise en page > Aligner sur
une colonne (raccourci Ctrl+Maj+C ou xXC). La ligne sur laquelle les objets s’alignent est la

ligne moyenne de leur positions horizontales / verticales.

Ceci est particulièrement utile pour aligner les paroles, les symboles d’accord, les diagrammes

d’accord, etc. le long d’une portée. Si vous sélectionnez un nombre d’objets attachés à différentes

portées (par ex. avec Ctrl+clic ou X-clic), Mise en page > Aligner sur une rangée les aligne de

manière fort pratique à la même distance au-dessus et en dessous de la portée à laquelle ils sont

attachés.

Mise en page > Aligner sur une rangée fonctionne également pour les styles de texte de système:

vous pouvez l’utiliser pour aligner par ex. des indications de tempo ou des indications

métronomiques. La fonction ne peut cependant être utilisée pour aligner des objets de système

avec des objets de portée, ni pour aligner entre eux des styles de texte ayant des positions verticales
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par défaut différentes (par ex. vous ne pouvez pas aligner du texte de compositeur avec du texte de

sous-titre, etc.).

Astuce: pour sélectionner tous les objets similaires (par ex. toutes les paroles, ou tous les repères de

répétition) dans une portée ou un système avant d’aligner, sélectionnez un objet et choisissez

Édition > Sélectionner > Sélectionner Plus (raccourci Ctrl+Maj+A ou xXA).

Réglettes et papier millimétré
Sibelius peut afficher des réglettes à l’écran pour faciliter l’alignement des objets et permettre

d’ajuster précisément la mise en page d’une partition; b 5.23 Menu affichage.

Vous pouvez aussi choisir Papier, millimétré comme texture de votre bureau dans le menu

Fichier > Préférences (dans le menu Sibelius sur Mac) pour installer une grille sur la partition.

Les lignes de la grille sont séparées d’une dent quand l’affichage est à 100%.



8. Mise en page et gravure

632

8.2 Mise en page magnétique

Mise en page magnétique est l’option unique anti-collision de Sibelius, conçue pour positionner les

objets comme les dynamiques, les repères de répétition, les numéros de mesure, les paroles, les

symboles d’accord, etc., sans que vous ayez à le faire manuellement. Sibelius comprend les règles

suivant lesquelles les objets particuliers doivent être alignés, tant horizontalement sur un système

que verticalement à travers les portées, avec un résultat qui, dans la plupart des types de partitions,

exige rarement de repositionner les objets.

Ce que la mise en page magnétique fait
Dans la notation musicale conventionnelle, il existe, pour ainsi dire, un ordre naturel dans la

relation entre la portée et les différents types d’objets. Par exemple, les notes sont toujours situées

sur ou au plus près de la portée, ainsi que les objets qui les accompagnent (p.e. altérations,

articulations, liaisons, points de rythme, liaisons de phrasé) et les éléments connexes comme les

armures, les indications de mesure, etc. D’autres types d’objets s’étendent à partir de la portée, dans

un ordre important, comme les paroles, les dynamiques et les techniques d’interprétation, au plus

près de la portée au-dessus ou au-dessous. Après ces objets viennent les symboles d’accord, qui

s’alignent sur toute la largeur du système et le plus près possible pour être lus le plus

confortablement possible avec les notes. Au-dessus des symboles d’accord viennent les éléments

du système, comme les repères de tempo, les 1re et 2de lignes de fin et autres instructions de

reprise et repères de répétition. Sous la portée, on trouve le texte qui courre tout au long du

système comme la basse figurée et les numérotions romaines, au plus proche de la portée pour

faciliter une lecture confortable et, enfin, les lignes de pédale pour les instruments à clavier.

La mise en page magnétique fonctionne en maintenant cet ordre naturel de préférence des objets

avec la partition. Elle examine tous les objets liés à une portée dans un système donné et les replace

dans l’espace disponible en respectant ces règles de façon à résoudre toutes les collisions en

regroupant intelligemment les objets à aligner au-dessus et au-dessous du système. Tout se fait

dynamiquement, en temps réel : au fur et à mesure que vous saisissez la musique et la modifier

dans votre partition. Sibelius déplace instantanément les objets pour éviter les collisions et

conserver lisibilité et clarté à tout moment.

La position d’origine des objets déplacés par la mise en page magnétique (c’est à dire, là où ils

seraient si la mise en page magnétique était désactivée) est indiqué en grise quand vous les

sélectionnez :
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Alors que vous déplacez les objets, ils seront attirés vers des positions où ils n’entrent pas en

collision, plutôt que de suivre le curseur de votre souris avec exactitude. Si vous souhaitez que

l’objet suive le curseur de la souris avec exactitude, maintenez Ctrl ou Xenfoncé une fois que vous

déplacez l’élément, désactivant ainsi temporairement la mise en page magnétique.

Ce que la mise en page magnétique ne fait pas
La mise en page magnétique ne change pas l’espace entre les notes, qui détermine la quantité

d’espace horizontale disponible, ou l’espace entre les portées, qui détermine la quantité d’espace

verticale entre les portées. Cela signifie que Sibelius peut uniquement résoudre les collisions entre

les objets dans l’espace disponible : il ne créera pas lui-même d’espace supplémentaire.

Cela signifie que vous pouvez vous trouver dans une situation où Sibelius est incapable de résoudre

les collisions de manière satisfaisante, dans laquelle les objets peuvent apparaître dans une

position incorrecte marquée en rouge (cf. Trouver les collisions ci-dessous). Dans la majorité

des cas, vous devrez simplement aider Sibelius à résoudre la collision en sélectionnant la portée

affectée et la portée supérieure ou inférieure puis en choisissant Mise en page > Optimiser
l’espacement entre les portées, qui arrangera l’espace suffisant pour résoudre la collision –

b 8.10 Espacement des portées.

Plus rarement, vous devrez donner un peu plus d’espace horizontale à Sibelius pour résoudre la

collision en élargissant l’espacement entre les notes : sélectionnez les mesures affectées et pressez

Maj+Alt+1 ou xz1(maintenez Ctrl ou Xenfoncé pour des espacements plus importants) –

b 8.9 L’espacement entre les notes.

Trouver les collisions
Quand Sibelius est incapable de résoudre une collision par lui-même, l’objet problématique

apparaît en rouge. Pour trouver les objets en collision, sélectionnez Edition > Collisions > Trouver
la suivante ou Trouver la précédente. L’objet suivant ou précédent en collision sera sélectionné

et centré à l’écran de façon à ce que vous puissiez décider comment résoudre sa situation (cf. Ce
que la mise en page magnétique ne fait pas au-dessus).

Les objets en collision apparaissent en rouge uniquement si Affichage > Collisions de la mise en
page magnétique est activé.

Regroupement des objets similaires
Sibelius regroupe intelligemment les objets tant horizontalement, sur la largeur du système, que

verticalement, à travers les différentes portées.
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Quand vous sélectionnez un objet qui fait partie d’un groupe, une ligne discontinue en bleu clair

apparaît derrière l’objet pour vous indiquer l’étendu du groupe.

Par exemple, si vous modifiez la hauteur d’une note sur une portée vocale qui entrerait alors en

collision avec les paroles du dessous, Sibelius déplace les paroles liées à la portée, dans la mesure

où il y a un espace suffisant au-dessus de la portée inférieure. Il déplace toutes les paroles, tout au

long du système, d’un seul bloc car celles-ci doivent toujours être alignées sur toute la largeur du

système.

De la même manière, si vous ajoutez une liaison sous un passage de notes qui entrerait en collision

avec une dynamique sous la portée, Sibelius déplace la dynamique. S’il y a plusieurs dynamiques

(incluant texte d’expression et soufflets) proche les unes des autres, Sibelius déplace toutes les

dynamiques de façon à ce qu’elles restent correctement alignées les unes par rapport aux autres.

Sibelius ne regroupe toutefois pas toutes les dynamiques sur l’ensemble de la largeur du système

entier : il regroupe plutôt les dynamiques les plus proches. Ce qui signifie que si les dynamiques

sont très éloignées de la portée au début du système (p.e. en raison d’une note particulièrement

basse), elles ne le seront pas nécessairement plus loin dans le système, vous permettant un

meilleur usage de l’espace disponible.

De plus, les dynamiques sur la même position rythmique sur des portées adjacentes seront elles-aussi

regroupées. Par conséquent, si Sibelius en déplace une vers la gauche ou la droite pour éviter une

collision, toutes les dynamiques des portées adjacentes seront elles-aussi déplacées. Cela permet d’un

coup d’œil de situer les instruments qui ont subi des modifications de dynamiques à la même position

quand vous lisez la partition.

Les types d’objets suivants seront regroupés sur toute la largeur d’un système :

* Numéros de mesure

* Paroles

* Dynamiques (texte d’expression et soufflets)

* Les symboles d’accord

* 1re et 2de ligne de fin

* Repères de répétition

* Indications de tempo (texte de tempo, indication métronomique, texte de modulation métrique,

et lignes de ryt./accel. ).

* Basse chiffrée 

* Chiffres romains

* Symboles de fonction



8.2 Mise en page magnétique

635

M
ise en page

* Lignes de pédale

Les types d’objets suivants sont aussi regroupés verticalement s’ils se trouvent dans les mêmes

positions rythmiques :

* Dynamiques sur des portées adjacentes

* Repères de répétition

* Indications de tempo

Pour supprimer un objet d’un groupe, vous pouvez soit :

* Déplacer l’objet de façon à ce qu’il ne soit plus situé horizontalement ou verticalement avec les

autres objets du groupe ; quand l’objet quitte le groupe, la ligne discontinue bleu clair disparaît ;

soit

* Désactiver l’anti-collision pour cet objet en particulier, laissant les autres objets en place - cf. Ne
pas tenir compte de l’anti-collision ci-dessous.

Dans de rares cas, vous pouvez préférer qu’un type particulier d’objet ne soit pas regroupé du tout.

Dans ce cas, sélectionnez Mise en page > Options de mise en page magnétique pour effectuer

le changement - cf. Options de mise en page magnétique ci-dessous.

Ne pas tenir compte de l’anti-collision
Vous pouvez parfois souhaiter désactiver le positionnement magnétique d’un objet. Vous pouvez

toujours déplacer les objets situés magnétiquement en les sélectionnant puis en les déplaçant avec

la souris ou en utilisant les touches fléchés (en pressant Ctrl ou X pour des espacements plus

importants) mais vous remarquerez que l’objet ne se déplace pas exactement ou vous le dirigez : la

mise en page magnétique fait toujours de son mieux pour déplacer l’objet de façon à éviter les

collision.

Vous pouvez alors souhaiter désactiver la mise en page magnétique pour cet objet en particulier.

Vous pouvez le faire en sélectionnant l’objet et en sélectionnant Edition > Mise en page
magnétique > Off. Vous pouvez aussi trouver cet élément dans le menu contextuel qui apparaît

quand vous cliquez-droit (Windows) ou Control-cliquez (Mac) un objet déterminé.

Vous pouvez voir si la mise en page magnétique est activée ou non pour un objet donné en

regardant dans le panneau Général des propriétés quand il est sélectionné : le menu Mise en
page magnétique affiche Par défaut quand les objets n’ont pas été volontairement déplacés (ce

qui signifie généralement que la mise en page magnétique est active car seules quelques objets l’ont

désactivés par défaut), Off pour les objets sans mise en page magnétique et On pour les objets

dont vous avez spécifiquement activé celle-ci.

Quand vous désactivez la mise en page magnétique pour un objet, il ignorera celle-ci toujours,

provoquant d’éventuelles collisions avec d’autres objets.

Pour réactiver la mise en page magnétique, sélectionnez l’objet de nouveau et choisissez Edition >

Mise en page magnétique > Par défaut, qui annule la désactivation. (Il est préférable de faire

ainsi plutôt que de choisir On directement, car cela signifie que tous les changements effectués sur

le comportement par défaut pour ce type d’objet dans Mise en page > Options de mise en page
magnétique seront appliqués automatiquement.)
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Bloquer les positions de mise en page magnétique
Quand la mise en page magnétique est activée, la position de chaque objet dans votre partition est

dynamique et changera au fur et à mesure de l’évolution de votre partition. Vous souhaiterez peut

être de temps en temps dire à Sibelius de verrouiller la position d’un objet mis en page

magnétiquement.

Pour les grandes partitions, cela permettra de réduire le travail d’édition car Sibelius n’aura pas à

constamment recalculer toutes les positions de mise en page magnétique de tous les objets.

Pour bloquer les positions, sélectionnez un objet, un passage ou même une partition entière et

choisissez Mise en page > Bloquer les positions de la mise en page magnétique. Cela règle la

position des objets dans la sélection sur leur position actuelle, puis désactive leur mise en page

magnétique de façon à ce qu’ils ne soient plus modifiés par celle-ci.

Si vous décidez dans un deuxième temps de réactiver la mise en page magnétique, sélectionnez de

nouveau puis choisissez Edition > Mise en page magnétique > Par défaut. Vous pourrez aussi

souhaiter choisir Mise en page > Réinitialiser la position pour permettre à Sibelius de repasser

l’ensemble des positions des objets.

Désactivation de l’ensemble de la mise en page magnétique
Si vous souhaitez désactiver l’ensemble de la mise en page magnétique, désactivez Mise en page >

Mise en page magnétique. Tous les objets reviendront à leur position d’origine, produisant des

collisions sur l’ensemble de votre partition. Pour cette raison, nous vous recommandons de

bloquer les positions des objets dans votre partition (cf. ci-dessus) plutôt que de désactiver la mise

en page magnétique.

Options de mise en page magnétique
Réservé aux utilisateurs expérimentés.

Bien que vous ayez rarement besoin de régler les options de mise en page magnétique par défaut,

vous aurez peut-être envie d’effectuer quelques changements. Pour ce faire, choisissez Mise en
page > Options de mise en page magnétique. Voici la boîte de dialogue qui apparaît :
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La liste des types d’objets sur le côté gauche propose quatre colonnes :

* Pri. : diminutif de “priorité”, affiche l’ordre de précédence de ce type d’objet ; plus le numéro est

petit, plus grande est la précédence et plus l’objet sera proche de la portée.

* Type d’objet : le nom de l’objet ou du groupe d’objets.

* Ordre : la position par défaut dans l’ordre d’affichage pour ce type d’objet. La valeur de 0 les

dessine derrière tous les autres objets alors que la valeur de 31 les dessine devant

(b 5.14 Ordre).

* Mag. : diminutif de “magnétique”, détermine si ce type d’objet doit éviter ou non les collisions

avec les objets par défaut.

Les options à droite de la boîte concernent les valeurs en cours pour le type d’objet sélectionné :

* Si Mag. est cochée pour un type d’objet donné, la case Éviter les collisions par déplacement
(espaces) est disponible. Si vous la cochez, vous pouvez souhaiter déterminer si ce type d’objet

peut être déplacé vers le Haut, le Bas, la Gauche ou la Droite, et combien d’espaces lui sont

autorisés dans chaque direction.

* Distance minimum autour d’un objet (espaces) vous permet d’indiquer combien d’espaces

blancs Sibelius doit maintenir autour d’un objet. Pour le texte d’expression, cela fournit la

quantité d’espaces blancs de chaque côté de la dynamique quand elle tronque un soufflet.

* Regrouper les objets similaires dans le groupe primaire et Regrouper les objets
similaires dans le groupe secondaire vous permet de spécifier si ce type d’objet doit ou non

être regroupé tout au long du système. Vous ne pouvez créer de nouveaux groupes entièrement,

mais vous pouvez ajouter des objets dans les groupes existants.

Encore plus pratique, vous pouvez trouver qu’un objet a été regroupé et préféreriez qu’il ne le

soit pas. Par exemple, les numéros de mesure sont regroupés sur l’ensemble du système par
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défaut et si vous préférez qu’ils puissent être déplacés individuellement, vous pouvez désactiver

Regrouper les objets similaires dans le groupe primaire pour le type d’objet Numéro de
mesure.

Seule une poignée d’objets de ce type sont regroupés dans un groupe primaire et un groupe

secondaire. Le texte d’expression est le plus important, regroupé tant dans les Dynamiques
regroupées (horizontale) et Dynamiques regroupées (verticale).

Si vous ajoutez un objet à un groupe, pour déterminer les directions dans lesquelles l’objet peut

être déplacé pour éviter les collisions, vous devriez spécifier la valeur de Éviter les collisions
par déplacement (espaces) pour le groupe dont il fait partie plutôt que pour l’objet lui-même.

* Les objets regroupés doivent être dans n espaces horizontalement / n espaces
verticalement indique la proximité d’alignement horizontale et verticale des objets pour qu’ils

soient considérés d’un même groupe.

* Avec un espace maximum entre les objets de n espaces horizontalement / n espaces
verticalement indique la proximité des objets entre eux pour qu’ils soient considérés d’un

même groupe. Remarquez que, par exemple, les Paroles regroupées ne présentent pas d’espace

maximum car les paroles doivent toujours être regroupées tout au long de l’ensemble du

système, alors que les Dynamiques regroupées (verticale), un espace maximum de 16 est

spécifié, car seules les dynamiques sur des portées adjacentes doivent être regroupées.

* Diviser le groupe par contrainte détermine si Sibelius est autorisé ou non à diviser le groupe

dans le cas où il serait impossible de maintenir tous les objets dans le groupe alignés tout en

évitant les collisions. Cette option est uniquement disponible si vous indiquez un espace

maximum entre les objets d’un même groupe.

Le bouton Rétablir par défaut, comme son nom l’indique, réinitialise tous les paramètres dans la

partition aux valeurs par défaut de Sibelius.

Les modifications faites aux Options de mise en page magnétique sont conservées dans la

partition et peuvent être transférées vers d’autres partitions via les styles maison – b 8.8 Style
maison.

Mise en page magnétique dans Panorama
De nombreux règles de positionnement et d’alignement des objets quand la mise en page

magnétique est activée dépendent du fait de travail sur un système à la fois. Par exemple, les

paroles sont alignées tout au long du système et les dynamiques sur la même position rythmique

sur plusieurs portées peuvent être alignées sur l’ensemble du système.

Quand Affichage > Panorama est activé, la partition est dessinée sous la forme d’un seul système

infini. Par conséquent, le positionnement d’objets qui dépendent de l’emplacement de la mesure

sur un système n’aura pas les mêmes résultats en Panorama. Ne considérez pas la position d’un

objet en Panorama comme celle de celui-ci dans l’affichage normal.

Si vous préférez ne pas utiliser du tout la mise en page magnétique dans Panorama (permettant à

celui-ci de travailler plus vide mais affichant les objets à leur position d’origine et leurs collisions),

désactivez Si la partition utilise la mise en page magnétique, utilisez-la aussi dans
Panorama dans la page Fichiers de Fichier > Préférences (dans le menu Sibelius sur Mac).
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8.3 Gravure musicale

b 8.1 Mise en page et mise en forme, 8.8 Style maison, 8.9 L’espacement entre les
notes, 8.10 Espacement des portées.

Cet article résume les principes clefs de la gravure musicale, cet art subtil qui sous-tend presque

tout ce que fait Sibelius. Même s’il ne s’agit que d’une très brève introduction à ce vaste sujet, les

quelques notions abordées devraient vous permettre d’améliorer l’aspect de vos partitions et vous

aider à développer votre goût pour la gravure musicale de qualité.

Bref historique
Sibelius représente la dernière étape d’une tradition vieille de plusieurs siècles. La notation

musicale date du 12ème siècle, et la gravure du 15ème siècle. Diverses méthodes ont été utilisées

pour reproduire (“graver”) la musique, dont notamment:

* La copie manuscrite

* La gravure sur planche: le découpage et poinçonnage de la musique directement sur des

planches d’imprimerie à l’aide d’outils spécialisés. Cette technique de très haute qualité mais

extraordinairement laborieuse a été la technique principale pendant des siècles.

* Les caractères mobiles: également largement utilisés au 15ème siècle.

* Les machines à écrire musicales, l’application d’encre au pinceau à travers des pochoirs, et le

“Not-a-set” (symboles de transfert sur feuille transparente, comme les feuilles Letraset®) ont

également été utilisés durant le 20ème siècle.

Les techniques de la gravure musicale ont peu évolué à travers les siècles; un copiste préparant de

la musique à la publication en 1990 n’était pas très différent d’un moine s’attelant à la même tâche

en 1190.

Mais pendant les années 1990, l’informatisation a provoqué une révolution soudaine et totale de la

gravure musicale, révolution dans laquelle Sibelius a joué un rôle majeur. En une décennie, les

anciennes techniques ont été presque complètement abandonnées (à l’exception de la plus

ancienne de toutes, écrire la musique à la main).

Même l’impression sur papier n’est plus le résultat final essentiel de la gravure musicale, grâce à la

publication électronique par Internet (b 5.19 SibeliusMusic.com). L’Histoire est donc en train

de s’écrire.

Qu’est-ce que la gravure musicale
La gravure musicale est l’art de reproduire la notation musicale clairement. Elle ressemble assez à

la typographie; de la même manière que la typographie concerne la présentation et le

positionnement des lettres et la disposition du texte sur la page, la gravure musicale gouverne le

design et le positionnement des symboles musicaux et la disposition de la musique sur la page.

Il ne faut pas confondre la gravure musicale et la notation musicale; quiconque peut lire la musique

connaît la notation musicale, mais peu de musiciens connaissent la gravure musicale.. Pour

continuer le parallélisme avec l’écriture normale, la notation musicale est comme l’orthographe et
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la grammaire; elles donnent des prescriptions sur la manière générale d’écrire la musique, mais ne

donne pas de règles précises sur la manière de placer les symboles; ces détails cruciaux sont du

domaine de la gravure musicale.

Il faut une expérience considérable pour pouvoir reconnaître et évaluer les subtilités de la gravure

musicale. L’œil exercé peut facilement identifier l’éditeur d’une partition, ou dire quel logiciel

informatique ou quelle autre méthode ont été utilisés pour la produire, alors que pour la plupart

des musiciens, la gravure de toutes les partitions est presque partout pareille. (Cela est dû au fait

que la gravure bien faite devrait passer inaperçue à l’œil non-exercé; la gravure ne saute aux yeux

que lorsqu’elle est mal faite.)

Cela signifie également que la gravure musicale est un art hautement raffiné, plein de subtilités

dont certaines pourraient sembler relever de la pédanterie (c’est en fait parfois franchement le cas).

Heureusement, comme Sibelius gère automatiquement la plupart de ces subtilités, vous ne devez

donc pas les connaître absolument.

Règles de gravure
Peu de littérature existe sur la gravure musicale; c’est une tradition qui pendant des siècles fut

transmise oralement, de maître à apprenti. Elle est régie par des centaines de règles de gravure,

dont de nombreuses datent du 19ème siècle lorsque la gravure musicale a atteint un haut niveau de

qualité.

Un ensemble de règles de gravure, conjointement au design des symboles musicaux, constituent le

style maison d’un éditeur. Bien qu’elles soient appelées “règles” de gravure, la plupart sont

simplement des conventions, car peu sont utilisées universellement et même des éditeurs

respectés divergent dans les règles auxquelles ils adhèrent. Néanmoins, les graveurs et éditeurs

peuvent devenir très attachés aux règles particulières qu’ils utilisent, et affirment farouchement

que les leurs sont les meilleures et même les seules “correctes”.

Sibelius applique automatiquement des centaines de règles de gravure à votre partition, dont

certaines n’ont jamais été formulées auparavant. Il utilise par défaut les règles les plus standards, et

les utilisateurs avertis peuvent adapter celles-ci selon leurs préférences à partir de la boîte de

dialogue Style maison > Règles de gravure. Sibelius met à jour la mise en forme de la partition

selon ces règles en un dixième de seconde lorsque vous les modifiez de quelle que façon que ce

soit, même s’il s’agit de modifications drastiques telles qu’un changement de format de papier.

Malgré tout cela, Sibelius n’est pas un graveur de musique parfait.

Cela est simplement dû au fait que les règles de gravure elles-mêmes sont imparfaites: certaines

sont trop vagues pour être informatisées, et beaucoup ne s’appliquent pas à tous les cas, et

demandent des ajustements manuels. Quelquefois des règles entrent en conflit, en rendant

nécessaire d’enfreindre une règle de façon à éviter d’en enfreindre une plus importante encore. Ces

situations sont laissées à l’appréciation des graveurs qui sont des humains; Sibelius ne peut être

meilleur que les règles elles-mêmes. Nous pouvons exprimer ceci en un syllogisme aristotélicien:

* Les règles de gravure musicale sont imparfaites (et nécessitent parfois des modifications à vue)

* Sibelius utilise les règles de gravure

* Par conséquent la gravure musicale de Sibelius est imparfaite (et nécessite parfois des

modifications à vue).
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Il y a cependant quelques règles universelles, et une règle absolument fondamentale:

Règle 1: la clarté
Une partition doit être aussi claire que possible. 

Aucune autre règle de gravure ne peut l’emporter sur celle-ci; si une chose est difficile à lire, elle est

incorrecte. En vertu de cela, les modifications faites aux ordres donnés par les règles de gravure

sont souvent faites “à vue”; et dans diverses situations pour lesquelles aucune règle précise n’a été

formulée, la solution est également de se “fier à son œil”.

Lorsque vous serez plus expérimenté en gravure musicale, vous devrez vous attendre à faire pas

mal de modifications à votre partition à vue. Pour le moment, il est suffisant de vous reposer sur

Sibelius pour suivre les règles.

Pourquoi la clarté est-elle la règle fondamentale? Le but de la gravure musicale est de rendre

possible la lecture d’une partition sans y penser, sans avoir à examiner ce qu’est exactement un

rythme ou un accord particulier, ou à se demander à quelle note se rapporte un mot, une

articulation ou une nuance particulière, etc. A l’opposé, un partition mal gravée (peu claire) peut

facilement vous entraîner à faire des erreurs, en particulier lors de lectures à vue, sans que vous

sachiez vraiment pourquoi. Nous sommes tous tombés sur des partitions de ce genre – même des

partitions éditées.

Règle n°2: Éviter les collisions
En notation musicale, lorsque des objets se chevauchent ils deviennent confus et difficiles à lire.

Par conséquent, pour éviter d’enfreindre la règle n1, vous devriez suivre cette seconde règle:

Évitez les collisions entre différents objets. 

De nombreuses règles de gravure sont en réalité des manières d’éviter les collisions, et

heureusement Sibelius en incorpore la plupart. Lorsque deux voix se croisent, par exemple,

Sibelius en déplace une vers la gauche ou vers la droite afin d’éviter qu’elles n’entrent en collision;

lorsque vous écrivez de longues syllabes dans les paroles, Sibelius leur laisse de la place

supplémentaire en augmentant l’espace entre les notes.

Bien que Sibelius incorpore ces règles, il ne peut pas toujours éviter les collisions, car il n’y a pas de

règles strictes permettant de résoudre toutes les collisions; dans des situations très resserrées il faut

parfois réorganiser la gravure afin d’intégrer un objet. Par exemple, si une nuance entre en

collision avec la hampe d’une note, on souhaitera peut-être déplacer la nuance vers la gauche ou

vers la droite ou peut-être même dans la portée, en fonction de la lisibilité obtenue; ou dans une

situation très resserrée on peut même décider de ne pas déplacer la nuance mais plutôt de

raccourcir la hampe.

Ce genre de décision de haut niveau ne peut être formulée en règles, et elles sont donc de votre

ressort, pas de celui de Sibelius. Même si vous n’êtes pas un graveur expérimenté, vous devriez

néanmoins supprimer toutes les collisions qui pourraient survenir.

Quelques rares types de collisions sont autorisés car ils sont presque inévitables et ne nuisent pas

particulièrement à la clarté. Les principaux sont lorsque des liaisons rythmiques ou de phrasé et

des soufflets traversent une barre de mesure qui connecte deux portées. Les liaisons de phrasé sont
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également autorisées à entrer dans des portées, bien que le texte et la plupart des symboles ne le

soient pas (sauf dans certaines situations très resserrées).

Unités
L’unité principale en gravure musicale est la dent qui correspond à l’espace entre deux lignes d’une

portée. Cette unité est relative plutôt qu’absolue car tout en gravure musicale est proportionnel à la

taille de la portée; la taille absolue des notes, du texte, etc. est moins importante. (Sibelius utilise

même un corps de texte relatif plutôt qu’absolu pour le texte.) Presque toutes les règles de gravure

utilisent la dent comme unité; les millimètres et les pouces ne sont réellement utiles que lorsque

vous décidez de la taille de la page et des marges.

Disposition horizontale: espacement des notes
La disposition horizontale de la musique concerne fondamentalement l’espacement des notes. Il y

a bien d’autres objets que les notes, mais ceux-ci sont essentiellement positionnés par rapport aux

notes; par ex. les articulations, les liaisons de phrasés, les paroles et les nuances vont au-dessus / en

dessous des notes auxquelles elles se rapportent.

Les notes et les silences sont espacés en fonction de leur valeur rythmique. Les règles d’espacement

qu’utilise Sibelius se trouvent dans la boîte de dialogue Style maison > Règle d’espacement des
notes. Une noire, par exemple, est suivie d’un espacement de 3,5 dents, une blanche de 5,94 dents

et une ronde de 8.19 dents. Selon les éditeurs les espacements utilisés peuvent être légèrement

différents.

Un rapide calcul mental vous prouvera que l’espacement qui suit une note n’est pas proportionnel à

sa valeur de note: s’il l’était, une ronde aurait un espacement de 3,5 (pour une noire) x 3,5 dents =

12,25 dents après elle, plutôt que 8,19. La raison pour laquelle l’espacement de note n’est pas

proportionnel est que, s’il l’était, les notes très courtes devraient être serrées les unes contre les

autres au point d’en être illisibles, et les longues notes gaspilleraient de grandes quantités d’espace.

Si plusieurs portées ou voix différentes ont des rythmes différents en même temps, quelles sont les

notes utilisées pour définir l’espacement général ? La réponse est qu’à tout moment la note ou le

silence le plus court détermine l’espacement: si donc la main droite d’un piano joue des noires

tandis que la main gauche joue des rondes, ce sont les noires qui déterminent l’espacement, et les

rondes sont simplement alignées sur elles. Cependant, il devient plus difficile de garder un

espacement correct lorsqu’il y a beaucoup de portées (par ex. dans les partitions d’orchestre ou

d’harmonie) ou quand des rythmes compliqués tels que des multiplets se croisent.

Comme l’espacement des notes n’est pas proportionnel, les mesures ne sont pas de largeur égale –

les mesures avec des notes plus courtes sont plus larges (de façon peut-être paradoxale).

Cela signifie qu’il n’y a pas normalement un nombre constant de mesures par système. (le Jazz et la

musique commerciale sont souvent écrits avec par exemple 4 mesures par système, mais c’est une

exception.)
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L’espacement de base doit s’adapter à la justification: les notes doivent être réparties de façon à ce

qu’un nombre entier de mesure remplisse la largeur de page. Le principe consiste à placer le plus

de mesures possible sur la largeur de page (en utilisant les règles d’espacement précitées), puis à

répartir l’espace restant uniformément entre toutes les notes, les étalant jusqu’à ce qu’elles

atteignent la marge de droite. C’est exactement la façon dont fonctionne la justification des mots

afin de remplir une ligne dans un logiciel de traitement de texte.

Divers autres ajustements à l’espacement des notes sont également réalisés: de la place

supplémentaire doit être laissée pour divers éléments tels que des altérations, des points

rythmiques, des lignes supplémentaires, des crochets sur des hampes pointant vers le haut (car ils

dépassent), des barres de mesure, des notes ornementales, des “notes noires” (des têtes de note du

mauvais côté de la hampe dans des accords en cluster), des croisement de voix, des paroles et des

changements de clef, d’armure ou d’indication de mesure.

Encore une fois, Sibelius automatise tout ceci par un algorithme complexe appelé la règle

d’espacement optique – ce qui ne veut pas dire qu’il n’est pas nécessaire de faire des modifications à

vue de temps en temps. En particulier il faut envisager de modifier l’espacement des notes lorsqu’il

est très irrégulier en raison de valeurs de note très différentes ou de paroles compliquées;

b 8.9 L’espacement entre les notes pour quelques conseils sur la question.

Disposition verticale: espacement des portées
La disposition verticale est plutôt moins précise que la disposition horizontale. Mais, de la même

manière que la disposition horizontale concerne essentiellement la disposition des notes (les

autres objets étant positionnés par rapport à elles), la disposition verticale concerne

essentiellement l’espacement des portées. Les positions verticales des autres objets tels que les

notes, les silences, les clefs, les indications de mesure, les noms d’instrument, les titres, les

numéros de mesure et les repères de répétition sont déterminés par rapport à la portée à laquelle

ils appartiennent.

En règle générale, les portées devraient avoir la même distance entre elles, avec un intervalle

légèrement plus grand entre les systèmes, et souvent un intervalle plus grand entre les familles

d’instruments dans de grandes partitions (par ex. pour orchestre ou harmonie). Il se trouve que

Sibelius n’ajoute pas automatiquement ce dernier espace, mais vous pouvez facilement le faire

vous-même (en sélectionnant la portée supérieure d’une famille à travers la partition en en la

déplaçant vers le bas).

Les partitions sont souvent justifiées verticalement afin d’étaler les portées jusqu’à la marge

inférieure, de façon similaire à la justification horizontale des notes. Sibelius fait cela

automatiquement si la page est remplie à plus de la moitié (et, comme d’habitude, vous pouvez

paramétrer des options précises dans la boîte de dialogue Règles de gravure).

Cependant, il est quelquefois nécessaire de laisser de l’espace supplémentaire entre les portées ou

de repositionner d’autres objets afin d’éviter les collisions entre, par exemple, les notes aiguës ou

graves d’une portée et les objets de la portée adjacente. C’est un exemple classique de l’ajustement à

vue que vous devriez faire vous-même.

Une autre raison de déplacer les portées est la nécessité d’aligner les portées correspondantes sur

des pages en vis-à-vis. Cela est utile pour des partitions d’orchestre ou d’harmonie, afin de faciliter
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pour le chef d’orchestre la lecture de la musique d’un instrument spécifique d’une page à l’autre.

La boîte de dialogue Mise en page > Aligner les portées de Sibelius réalise cela automatiquement

(b 8.10 Espacement des portées).

Plus d’informations
En particulier, b 8.9 L’espacement entre les notes et 8.1 Mise en page et mise en
forme pour découvrir différentes manières d’améliorer l’aspect d’une partition dans Sibelius.

La gravure musicale comporte donc une multitude de règles. Si certaines ne valent pas la peine

d’être évoquées ici, la plupart le sont dans les différents articles, soit sous forme d’encadré (et

particulièrement quand aucun automatisme, donc aucune règle stricte ne s’applique) ou sous

l’intitulé habituel de fin d’article, Options des règles de gravure. Comme la plupart des règles

sont gérées automatiquement par Sibelius, l’utilisateur est dispensé d’en avoir une connaissance

approfondie.

Si cet article a aiguisé votre appétit de connaissances en gravure musicale, le récent Essential

Dictionary of Music Notation (Alfred Publishing) est un ouvrage concis, clair et bon marché à

recommander pour les néophytes. Pour les graveurs aguerris, ils existent divers ouvrages souvent

volumineux, chers et indigestes.

Enfin, s’il y a bien deux choses à retenir de cet article, ce sont les règles n1 et 2 énoncées ci-dessus:

évitez les collisions, et surtout, surtout faites en sorte que votre partition soit lisible et aérée le plus

possible.
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8.4 Sauts de page automatiques

b 2.24 Mesures de comptage, 7.1 Travailler avec des parties séparées, 8.1 Mise en
page et mise en forme, 8.5 Les sauts.

Sibelius peut créer des sauts de système et de page automatiquement aux endroits qui conviennent

en utilisant Mise en page > Mise en page automatique, ce qui permet de gagner beaucoup de

temps lors de la mise en forme des parties. Vous pouvez aussi utiliser ces options dans les parties si

nécessaire.

Mise en page des parties
Afin d’assurer une bonne tourne dans les parties, les sauts de page doivent se placer de préférence

sur la page de droite quand une ou plusieurs mesures sont à compter. La fonction de Sibelius Mise
en page > Mise en page automatique réalise cela automatiquement et de manière dynamique

lorsque vous insérez des mesures, remplissez de notes les mesures vides, etc. Les sauts de page se

déplacent alors aux endroits adéquats. 

Il est aussi très utile de placer des sauts de système à des endroits spécifiques de la partition, par

exemple aux changements de tempo et de clés, aux repères de répétition ou aux mesures de

comptage, pour que ces objets puissent se voir au premier coup d’œil.

Par défaut, l’automatisme des sauts de page est désactivé, excepté dans les parties. Pour modifier la

manière dont Sibelius traite la mise en page, choisissez Mise en page > Mise en page
automatique, ou pour modifier une partie ou plusieurs en même temps, cliquez sur Mise en
page automatique de la page Mise en page de Présentation des parties multiples
(b 7.3 Présentation des parties multiples). Dans tous les cas voici la boîte de dialogue qui

s’affichera:
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Sauts de système automatiques
* Utiliser les sauts de pages automatiques permet à l’utilisateur de choisir si les sauts de

système automatique seront utilisés ou non. Sibelius peut créer des sauts de systèmes de manière

régulière après un nombre spécifié de mesures, ou autrement ajouter des sauts de système dans

les parties aux endroits où le matériel musical change complètement, ce que le saut permet de

mieux appréhender.

* Si vous souhaitez que Sibelius ajoute des sauts de systèmes à intervalles réguliers, choisissez

Toutes les n mesures et entrez le nombre de mesures souhaitées par système. Si vous souhaitez

des sauts de système pour une section de musique plutôt que pour toute la partition, utilisez

alors l’extension Rendre la mise en page uniforme (b 6.1 Travailler avec des
extensions).

* En utilisant Quand se présentent ou juste devant, Sibelius ajoutera des sauts de système là

où les objets spécifiés apparaissent: 

% Repères de répétition: avec cette option activée, Sibelius place les mesures avec repères de

répétition au début d’un système

% Texte de tempo: Sibelius place les mesures avec un texte de tempo au début d’un système

% Double barre de mesure indique en général la fin d’une section, de sorte que si vous

souhaitez rendre la séparation plus évidente, activez cette option pour ajouter un saut de

système là où une double barre de mesure apparaît

% Changement d’armure: avec cette option activée, Sibelius ajoute un saut avant un

changement de tonalité, de sorte que la nouvelle tonalité est affichée au début d’un système.

(Cela s’applique aux changements de tonalité ou d’instrument placés en fin de mesure, et pas

au milieu.)

% Mesures de comptage de n mesures ou plus: pour ajouter des sauts de systèmes après des

mesures de comptage d’une longueur donnée, activez cette option

% Le système doit être rempli à au moins n% : pour éviter un espacement trop grand des

notes, utilisez cette option en réglant une valeur minimum avant qu’un saut n’apparaisse.

Les sauts de système apparaissent sous forme d’indication en pointillé, comme ceci: . Ils sont

oranges quand ils apparaissent dans une partie et pas dans le conducteur (si Affichage >

Différences dans les parties est activé).

Sauts de page automatiques
* Utiliser les sauts de page automatiques permet de choisir si Sibelius créera des sauts de page

automatiques aux endroits adéquats. Toutes les autres options de Sauts de page seront

désactivées si Utiliser les sauts de page est désactivé.

* Aux barres de mesure finales: quand cette option est activée, Sibelius ajoute un saut de page

après la barre de mesure finale. C’est très utile quand on travaille sur des partition qui

contiennent plusieurs mouvements, morceaux ou chansons.

* Après les mesures de silence: avec ceci, Sibelius place un saut de page après des silences pour

faciliter les tournes de page, selon les options suivantes: 
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% Choisissez si Sibelius place les sauts Après chaque page ou Après les pages de droite
(c’est-à-dire après les pages impaires). Si les musiciens jouent sur des pages imprimées sur

une face, il vaut mieux choisir Après chaque page; si les pages sont imprimées en vis-à-vis

choisissez Après les pages de droite.

% Après n mesure(s) de silence au moins détermine le nombre minimum de mesures à

compter avant un saut de page automatique (et donc le temps nécessaire pour tourner la

page)

% Choisir de préférence les silences plus longs avant un saut de page impose à Sibelius

de placer un saut après une mesure de comptage la plus longue possible (selon le choix qui se

présente) pour qu’il y ait plus de temps pour la tourne, même si cela signifie moins de

musique sur la page.

* La page doit être à n% complet évite que Sibelius ne place une tourne trop vite car si une

page n’est pas assez remplie le résultat est inélégant.

* Ajouter des avertissements aux tournes difficiles imprime un avertissement dans la marge

après la dernière mesure de la page dont la tourne n’est pas idéale. Par défaut, l’avertissement est

“V.S.” (abréviation de verso subito, qui signifie “tournez vite” en italien), mais vous pouvez aussi

utilisez le symbole Lunettes si vous préférez.

(Si vous voulez utilisez un symbole différent, modifiez le symbole de lunettes dans la rangée

Marques de mise en page de la boîte de dialogue Style maison > Modifier les symboles –

b 8.17 Modifier les symboles.)

Si vous voulez enlever un avertissement à la fin d’une page spécifique, placez-y un saut de page

manuel (cf. ci-dessous) pour indiquer que le saut est intentionnel.

Si vous activez Affichage > Marques de mise en page, un symbole indiquant si Sibelius a trouvé

un bon ( ) ou un mauvais ( ) saut de page apparaîtra à l’écran (mais ne sera pas imprimé) à la

fin de chaque page de droite (ou sur chaque page).

Supprimer des sauts de page et de système automatiques
Il peut y avoir des circonstances particulières pour lesquelles on souhaitera supprimer un saut de

système ou de page automatique. Pour faire cela:

* Sélectionnez la barre de mesure dont vous voulez supprimer le saut automatique

* Dans le sous-menu Mise en Page > Saut, choisissez Saut de système (raccourci Retour, sur le

clavier principal) ou Saut de page (raccourci Ctrl+Retour ou X -Retour). Le symbole de saut

automatique va apparaître avec une croix pour indiquer qu’il a été supprimé.

Parce que Sibelius suit les sauts normaux de page et de système et d’autres critères de mise en

forme quand il place un saut automatique, vous pouvez outrepassez ces sauts automatiques en

sélectionnant les mesures à placer sur la page ou le système en utilisant Mise en page > Mise en
forme > Assembler sur une page ou (moins souvent) Mise en page > Mise en forme >

Assembler en un système.

Si vous sélectionnez une barre de mesure sur laquelle est placée un saut de système ou de page

automatique, le saut peut exister sous trois formes: automatique, supprimé ou manuel.
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Mesures de comptage
Mise en page > Mise en page automatique contient aussi des options pour déterminer la

présentation des mesures de comptage dans les parties (ou même dans la partition si nécessaire):

* Utiliser les mesures de comptage: comme déjà mentionné, quand cette option est activée,

Sibelius écrit les mesures de silence consécutives sous forme de mesures de comptage.

Cette option est activée par défaut dans les parties. Quand elle est désactivée, les autres réglages

concernant la présentation des mesure de comptage sont désactivés. 

* Sections vides entre les barres de mesure finales: Si dans une partition un passage est vide

entre le début de la partition et la barre de mesure finale ou entre deux barres de mesure finales

consécutives, Sibelius peut empêcher les mesures de comptage d’être divisées par des

changements d’indications de mesure, de texte de tempo, etc. et afficher une seule mesure de

comptage de “tacet” s’étendant sur la largeur d’un système. Vous pouvez utiliser cette option à la

fois dans les conducteurs et les parties qui ne contiennent pas de musique. Vous pouvez aussi

régler manuellement le texte pour qu’il apparaisse au-dessus des mesures de comptage. 

* Diviser automatiquement les mesures de comptage: par défaut Sibelius divise les mesures

de comptage dans le conducteur ou les parties là où c’est absolument nécessaire (par ex. aux

changements d’indications de mesure ou aux double barres de mesure). Cependant si le

morceau suit un schéma régulier de phrase, on peut estimer utile d’activer ce réglage en

choisissant l’une des deux options suivantes:

% Diviser en groupes de n mesures: avec cette option activée, Sibelius divisera les mesures de

comptage en groupes de n mesures. Par exemple, si une partie présente 14 mesures de silence

et que cette option est réglée sur 8, Sibelius écrira deux mesures de comptage, la première

d’une longueur de huit mesures et la seconde de six.

% Diviser à l’endroit où les numéros de mesures sont des multiples de n divise les

mesures de comptage en multiple de n mesures à partir d’une mesure donnée, et en prenant

en compte les changements de mesure. Par exemple, si vous tapez 8 ici, et qu’une mesure de

comptage de 12 mesures commence à la mesure 3, la mesure de comptage sera divisée en

deux mesures de 6 mesures chacune, la division entre les deux tombant à la mesure 9; cela

signifie que les mesures de comptage sont toujours divisée à la fin d’une phrase régulière de 8

mesures, comme c’est le cas souvent dans le jazz, la musique pop et de scène.

Pour en savoir plus sur les mesures de comptage, b 2.24 Mesures de comptage.
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8.5 Les sauts

b 3.6 Numéros de page, 8.1 Mise en page et mise en forme, 8.4 Sauts de page
automatiques, 8.6 Paramètres du document.

Les sauts sont les endroits où l’on impose la fin d’un système ou d’une page, par exemple quand se

termine une section. En fait, cela ressemble fort au retour à la ligne ou au saut de page des

traitements de texte: en général, un traitement de texte répartit automatiquement les mots et les

phrases dans les paragraphes, et il suffit de taper Retour pour commencer un nouveau

paragraphe; en général, il faut moins souvent taper Ctrl+Retour ou X-Retour pour insérer un

saut de page avant de commencer une nouvelle page.

C’est la même chose avec Sibelius : il répartit les mesures et les systèmes dans les pages

automatiquement, et il n’est nécessaire de placer un saut à la fin d’une mesure spécifique que si on

souhaite que la suivante suive le début d’un nouveau système ou de page, excepté dans les cas

spéciaux des pages de titre ou des pages sans musique (par ex. pour faciliter une tourne dans une

partie instrumentale). Pour renforcer l’analogie avec le traitement de texte, le raccourci-clavier

pour un saut de système est Retour (sur le clavier principal).

Sibelius est capable de créer automatiquement les sauts de page et de système, ce qui représente un

sérieux gain de temps pour les parties – b 8.4 Sauts de page automatiques.

Pour des conseils généraux sur la mise en page, b 8.1 Mise en page et mise en forme.

Ajouter ou supprimer manuellement des sauts de page ou de système
Pour ajouter manuellement un saut de système ou de page à n’importe quel endroit d’une partition

ou d’une partie:

* Sélectionnez la barre de mesure où le saut doit être placé

* Dans le sous-menu Mise en Page > Saut, choisissez Saut de système ((raccourci Retour, sur

le clavier principal) ou Saut de page (raccourci Ctrl+Retour ou X-Retour).

La musique va se déployer de manière à se terminer au point spécifié. Plus précisément, Sibelius va

répartir les deux systèmes conducteurs jusqu’à l’endroit du saut. Par la suite, la mesure se

terminant avec le saut restera toujours à la fin d’un système ou d’une page.

Pour supprimer un saut précédemment créé, faites exactement la même chose que décrite ci-

dessus, ou sélectionnez le symbole de marque de mise en page qui apparaît au-dessus de la barre

de mesure (cf. Visualisation des sauts ci-dessous ) et tapez Suppr.
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Où faut-il insérer des sauts de page manuels
Même si la fonction Mise en page le fait automatiquement, voici des cas on peut vouloir installer

soi-même des sauts de système:

* à la fin d’une section (par exemple à une barre de reprise)

* à la fin d’une section dans une partie séparée, spécialement lorsque la section suivante

commence par un nouveau titre. Dans les parties séparées, il est généralement préférable

d’utiliser des sauts de système plutôt que des sauts de page afin d’éviter les blancs dans la mise en

page

* là où les instruments se divisent en deux portées ou se rejoignent en une seule, afin de ne pas

avoir une succession de mesures inutiles qui ne sont jouées par personne.

Comme pour les sauts de page, n’abusez pas systématiquement des sauts de système à la fin d’un

système normal pour éviter les problèmes si par la suite le contenu musical était modifié. En cas de

doute, abstenez-vous de mettre un saut de système.

Où faut-il insérer des sauts de page
Même si la fonction Mise en page le fait automatiquement, voici des cas on peut vouloir installer

soi-même des sauts de page:

* sur une page de droite, à un endroit pratique où l’interprète ne doit pas tourner la page en jouant

* aux fins de sections, spécialement quand la section suivante comporte un nouveau titre.

Toutefois, évitez de placer systématiquement des sauts de page manuels à la fin de chaque page car

cela pourrait compromettre les changements de mise en page si par la suite le contenu musical

était modifié. Si vous voulez réellement utiliser un saut, installez de préférence un saut de système

(parce qu’un saut de système sur le dernier système d’une page agit comme un saut de page, mais

avec moins d’impact sur la mise en page si vous reformatez la partition); En cas de doute,

abstenez-vous de mettre un saut de page.

Sauts de page spéciaux
Parfois il est nécessaire que des pages d’une partition soient sans musique; par exemple pour une

ou plusieurs pages de titre en préambule de la partition ou pour une page comportant des

instructions d’exécution entre des mouvements, ou même une page blanche pour faciliter une

tourne dans une partie instrumentale. Vous pouvez aussi devoir changer les marges de certaines

pages de la partition, par exemple pour laisser plus de place pour les titres et d’autres textes au

sommet de la première page.

Sibelius permet de créer facilement de telles pages grâce à un type de saut spécial appelé (de

manière fort créative) saut de page spécial, qui permet de créer une ou plusieurs pages blanches,

aussi bien que de changer les marges des pages suivantes (sans qu’il soit nécessaire de créer une

page blanche pour changer les marges).

Pour créer un saut de page spécial:

* Sélectionnez la barre de mesure où doit apparaître le saut; si vous voulez créer des pages

blanches au début de la partition, sélectionnez la barre de mesure initiale de la première mesure
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(c’est-à-dire la barre à gauche de la clé et de l’armure), ou utilisez plutôt Insertion > Page de
titre – cf. ci-dessous

* Choisissez Mise en page > Saut > Saut de page spécial (raccourci Ctrl+Maj+Retour ou xX -

Retour). Voici la boîte de dialogue qui apparaît:

* Si vous voulez créer une ou plusieurs pages blanches, activez la case Page(s) blanche(s), puis

choisissez le type que vous voulez créer parmi les trois proposés:

% Nombre de pages blanches n insère un nombre fixé de pages blanches

% La musique recommence sur la page de gauche suivante insérera seulement une page

blanche si la barre de mesure à laquelle est attaché le saut de page est attachée à la fin d’une

page de gauche (donc comportant un numéro pair). Cette option est utile quand on prépare

des parties instrumentales et que l’on veut s’assurer qu’un certain nombre de pages

apparaîtront en vis-à-vis sans tourne entre elles. Si la mise en page de la partition change (par

exemple si vous ajoutez ou enlevez des mesures là où des sauts de page spéciaux

apparaissent), la page blanche apparaîtra ou disparaîtra comme il convient.

% La musique recommence sur la page de droite suivante insérera seulement un page

blanche si le saut de page se place sur une page de droite (donc comportant un numéro

impair). Comme ci-dessus, c’est très utile pour la préparation de certaines parties

instrumentales.

* Si vous voulez changer les marges des pages suivant le saut de page spécial, activez Nouvelles
marges, puis cliquez sur Marges, qui affiche une autre boîte de dialogue; cf. Changer les
marges des pages et des portées avec des sauts ci-dessous. (Notez que vous pouvez

choisir Pages blanches et Nouvelles marges indépendamment l’un de l’autre, ce qui permet

de changer des marges de page et de portée sans insérer une page blanche et vice-versa.)

* Cliquez sur OK et le saut de page spécial est créé. Comme pour les autres types de sauts, Sibelius

affiche de manière bien pratique un symbole de couleur bleue au-dessus de la barre de mesure

où s’applique le saut.

Une autre méthode pour créer facilement un saut de page blanche consiste à sélectionner la barre

de mesure concernée par le saut (ou choisir la barre de mesure initiale au début de la mesure 1 s’il

s’agit de créer une page de titre avant la première page de musique), puis de choisir Saut de page
spécial dans le menu du panneau Mesures des propriétés (b 5.17 Propriétés).
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Créer une page de titre
Vous pouvez créer une page de titre quand vous créez une partition en activant l’option Créer une
page de titre dans la page finale de la boîte de dialogue Fichier > Nouveau. Si vous voulez créer

un page de titre par la suite, il suffit de choisir Insertion > Page de titre. Vous pouvez choisir le

nombre de pages blanches à ajouter au début de la partition, et Sibelius ajoutera le texte du titre et

du compositeur automatiquement sur la première page blanche.

Quand des pages de titre sont ajoutées dans les parties et que l’on souhaite que le nom de

l’instrument de la partie soit imprimé sur la page de titre, il suffit d’activer l’option Inclure le nom
de la partie.

Insérer du texte et des images sur des pages blanches
Si vous avez créé des pages sans musique, il est peu probable que ce soit pour les laisser vides.

Notez que vous ne pouvez pas créer du texte normal de portée, de paroles ou de système sur une

page blanche parce que ces types de texte sont attachés aux mesures ou aux notes, qui n’existent pas

sur des pages blanches. (par conséquent, il est également impossible de copier et de coller la portée

ou le système d’une page de musique sur une page blanche.)

À la place, vous pouvez ajouter du texte sur des pages blanches en utilisant les styles de texte

énumérés dans le sous-menu Insertion > Texte > Texte de page blanche – b 3.1 Utiliser du
texte. Les en-têtes et pieds de page (par exemple les numéros de page ou le texte En-tête (après
la première page) apparaîtront sur les pages blanches comme ils apparaissent sur les pages de

musique.

Vous pouvez aussi ajouter des images en utilisant Insertion > Image. Contrairement au texte, vous

pouvez copier et coller des images entre les pages blanches et celles de musique comme vous

l’entendez. Pour en savoir plus sur l’importation d’images, b 9.4 Importer des images.

Modifier des sauts de page spéciaux
Si vous voulez modifier un saut de page spécial existant (par ex. pour changer le numéro de page

d’une page blanche ou pour en ajuster les marges), il suffit de sélectionner où apparaît le saut, ou la

marque de mise en page au-dessus de la barre et de choisir Mise en page > Saut > Saut de page
spécial.

La boîte de dialogue Saut de page spécial apparaîtra, affichant les options en cours pour ce saut

de page spécial. Faites les changements requis, puis cliquez sur OK. Si vous réduisez le nombre de

pages blanches, Sibelius vous avertira que tous les textes ou images seront supprimés. Quand vous

supprimez des pages Sibelius procède à partir de la droite, c’est-à-dire qu’il supprime la page

blanche la plus à droite.

Supprimer des sauts de page spéciaux
Pour supprimer un saut de page spécial, soit sélectionnez la marque de mise en page au-dessus de

la barre de mesure et tapez Suppr. Autrement, vous pouvez remplacer le saut de page spécial par

une autre sorte de saut (c’est-à-dire un saut de système ou de page) de la manière habituelle.

Quand vous supprimez un saut de page spécial d’une ou plusieurs pages, tous les textes et images

qui y figuraient sont aussi supprimés.
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Changer les marges des pages et des portées avec des sauts
Vous pouvez changer en même temps ou séparément les marges des pages et des portées qui sui-

vent un saut de page spécial. Dans la boîte de dialogue Saut de page spécial, activez Nouvelles
marges, puis cliquez sur le bouton Marges.

La boîte de dialogue qui apparaît est basée sur Mise en page > Paramètres du document, mais

les options de format de page et taille de portée sont désactivées. Pour en savoir plus sur

l’utilisation de cette boîte de dialogue, b 8.6 Paramètres du document.

Sauts et parties dynamiques
Les sauts crées dans un conducteur affectent les parties dynamiques de manière différente selon

les options choisies dans Présentation des parties multiples (b 7.3 Présentation des
parties multiples). Par défaut cependant:

* Les sauts de page spéciaux ne s’affichent pas dans les parties, parce qu’en général les pages de

titres et de préface ne sont pas imprimées sur chaque partie

* Les sauts de page du conducteur sont convertis en sauts de systèmes dans les parties, parce qu’en

général ils indiquent le début d’une section ou d’un mouvement qui ne nécessitent pas d’être en

début de page dans les parties, ce qui permet d’économiser de la place.

* Les sauts de système du conducteur ne sont pas affichés dans les parties, parce qu’en général ils

sont utilisés pour organiser la mise en forme du conducteur et ne conviennent pas dans la mise

en page des parties.

Vous pouvez aussi créer n’importe quel saut dans une partie dynamique sans affecter le conducteur.

Si par exemple vous devez installer une page blanche pour faciliter une tourne, il suffit de créer le

saut de la manière habituelle dans la partie concernée.

Notez que les marques de mise en page qui apparaissent au-dessus des barres de mesure pour

indiquer la présence de sauts sont d’une couleur différente dans les parties – cf. ci-dessous

Visualisation des sauts.

Enlever un grand nombre de sauts
Pour enlever des sauts de page ou de système dans une partition ou dans un passage de mesures:

* Sélectionnez les mesures concernées (ou tapez Ctrl+A ou XA pour sélectionner toute la

partition)

* Choisissez Mise en page > Mise en forme > Déverrouiller la mise en forme (raccourci

Ctrl+Shift+U ou xXU).

La musique va reprendre son format d’origine en annulant en plus le résultat produit par les

options de Mise en page > Mise en forme. Cependant, les sauts de page spéciaux ne seront pas

enlevés par Déverrouiller la mise en forme.



8. Mise en page et gravure

654

Visualisation des sauts
L’option Affichage > Marques de mise en page (activée par défaut) affiche les sauts de système et

de page et les autres indications de mise en forme au moyen des symboles suivants:

Il est possible de supprimer des sauts de page et de système automatiques, en changeant le statut

du saut (par ex. pour supprimer un saut de système, sélectionnez la barre de mesure et tapez

Retour pour le supprimer). Sibelius affiche que le saut a été supprimé en le barrant d’une croix.

Les marques de mise en page peuvent être de différentes couleurs:

* Les marques en bleu indiquent des sauts placés dans le conducteur ou dans les parties.

* Les marques en orange apparaissent seulement dans les parties et signifie que les sauts existent

uniquement dans les parties (Quand Affichage > Différences dans les parties est activé) –

b 7.1 Travailler avec des parties séparées. 

* Les marques en rouge apparaissent seulement quand on utilise les sauts automatiques et

signifient qu’un “mauvais” saut est placé à un endroit qui ne convient pas – b 8.1 Mise en
page et mise en forme.

Notez que les marques de mise en page apparaissent des deux côtés du saut: un saut de système par

exemple s’affiche au-dessus de la barre de mesure à la fin du système et au-dessus de la barre de

mesure initiale au début du système suivant; un saut de page spécial s’affiche au-dessus de la barre

de mesure à la fin de la page et au-dessus de la barre de mesure initiale au début de la page suivante

qui comporte de la musique. Vous pouvez sélectionner n’importe quel symbole de marque de mise

en page et taper Suppr pour supprimer le saut.

Garder les mesures 

ensemble

Saut de système manuel Saut de système 
automatique

Saut de système 
automatique supprimé

Saut de page manuel Saut de page 
automatique

Aucun saut 
de page automatique 

disponible

Saut de page 
automatique 

supprimé

Saut de page 
spécial

Saut de page 
spécial supprimé

Au-dessus 
de chaque barre 

de mesure
Après Assembler 

en une page

Fin de section

Scinder une mesure de comptage
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8.6 Paramètres du document

b 5.16 Imprimer, 8.1 Mise en page et mise en forme, 8.5 Les sauts.

La boîte de dialogue Mise en page > Paramètres du document (raccourci Ctrl+D ou XD)

permet de régler la dimension de la page, des portées et des marges de la partition. Sibelius effectue

automatiquement la mise en page en fonction de ces paramètres. Les modifier permet donc

d’essayer différents formats et orientation de la page, ou différentes tailles de portée et de juger

immédiatement de la meilleure présentation.

Puisque ces réglages détermine la quantité de musique par page et le nombre de pages dans la

partition, Mise en page > Paramètres du document est donc l’outil idéal pour imposer un nombre

de pages déterminé à une partition. b 8.1 Mise en page et mise en forme pour des conseils

d’ordre général sur la mise en page.

Modifier les paramètres de la pages
Choisissez Mise en page > Paramètres du document (raccourci Ctrl+D or XD). La manière

d’ajuster les dimensions et l’orientation de la page et la taille des portées est détaillée ci-dessous.

La prévisualisation montre comment apparaîtrait la première page avec les réglages choisis;

cliquez sur les flèches pour afficher les pages suivantes.
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En cliquant sur OK, la partition est mise en forme instantanément selon les nouveaux paramètres.

(Si le résultat n’est pas satisfaisant, choisissez simplement Édition > Annuler!)

Formats de page
La liste de Format de la page inclut les formats européens et américains suivants (on peut aussi

créer d’autres formats):

(Les termes “Octavo” et “Quarto” sont parfois utilisés pour désigner d’autres formats.)

Les valeurs peuvent être affichées au choix en pouces, millimètres ou points en utilisant les

boutons ad hoc. Voici leur correspondance: 1 pouce = 25,4mm (exactement), 1 mm = 0,0397

pouces (presque exactement) et 1 point = exactement 1/72 pouce = 0,353 mm

(approximativement).

Voici quelques formats de page et tailles de portée recommandés:

* Clavier, Chansons, Instrument solo: Lettre/A4, portées de 0.25–0.3”/6–7mm

* Partitions d’orchestre/band : Lettre/Tabloïde/A4/A3, portées de 0.1–0.2”/3–5mm

* Parties séparées: Lettre/Concert/A4/B4, portées de 0.25–0.3”/6–7mm

* Partition de chœur: Lettre/A4 ou plus petit, portées de 0.2”/5mm

* Ouvrages pour débutants: Lettre/A4, portées de 0.3–0.4”/8–10mm

Toutes ces formats de papier sont proposés en orientation portrait; l’orientation paysage est

rarement utilisée, à part pour la musique d’orgue, de fanfares ou de brass band. Il est à souligner

que la musique éditée ne correspond que rarement à un format de papier standard.

lettre 8.5 x 11” 216 x 279 mm

tabloïde 11 x 17” 279 x 432 mm (parfois appelé format “B”)

A5 5.9 x 8.3” 149 x 210 mm (A4 plié en 2)

B5 6.9 x 9.8” 177 x 250 mm

A4 8.3 x 11.7” 210 x 297 mm

B4 9.8 x 13.9” 250 x 354 mm

A3 11.7 x 16.5” 297 x 420 mm (deux fois plus grand qu’A4)

band 5 x 7” 127 x 178 mm (généralement appelé paysage)

Statement 5.5 x 8.5” 140 x 216 mm

hymne 5.75” x 8.25” 146 x 205 mm

octavo 6.75 x 10.5” 171 x 267 mm

executive 7.25 x 10.5” 184 x 266 mm

quarto 8.5 x 10.8” 215 x 275 mm

concert 9 x 12” 229 x 305 mm

folio 8.5 x 13” 216 x 330 mm

legal 8.5 x 14” 216 x 356 mm

Partie 9.5 x 12.5” 241 x 317 mm

Partie 10 x 13” 254 x 330 mm
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Dimension des portées
La dimension de la portée est la distance entre le centre de la ligne supérieure et le centre de la

ligne inférieure. Tout le contenu d’une partition, les notes, les clefs, le texte, etc... est mis à l’échelle

en rapport avec les dimensions de la portée.

Les dimensions de la portée peuvent être entrées directement, ou modifiées par petits incréments

en cliquant sur les flèches. Si vous faites cette opération en maintenant les flèches enfoncées, vous

verrez dans la fenêtre de prévisualisation les portées s’agrandir ou se rétrécir.

Même si toutes les dimensions de portée peuvent être utilisées, il importe de définir cette valeur

avec soin en fonction du type de musique que vous écrivez. En général, une dimension de portée

trop petite peut gêner à leur insu les interprètes. Pour éviter cela, référez-vous aux dimensions de

papier et de portée recommandées ci-dessus.

Sibelius ne modifie pas les dimensions de la portée sans instruction de l’utilisateur; par conséquent

sur une petite page comportant de nombreux instruments les portées peuvent être très serrées (ou

même s’enchevêtrer !). Pour y remédier, choisissez une taille de portée inférieure (ou une page de

dimensions supérieures).

Marges des pages
Les marges de la page se définissent dans la boîte de dialogue Mise en page > Paramètres du
document. La musique peut s’étendre jusqu’aux marges, mais pas en dehors.

Pour rendre les marges visibles sur la partition (lignes bleues pointillées), choisissez Affichage >

Marges . 

Une partition peut avoir des marges Identiques sur les pages de gauche et de droite (recommandé

pour l’impression simple face), des marges Symétriques (parfois appelées marges “intérieures” et

“extérieures”), ou des marges Différentes pour les pages de gauche et de droite. Les marges

supérieures et inférieures sont toujours identiques sur les pages de gauche et de droite.

Plus spécifiquement, les marges sont définies comme suit (si Identiques est choisi):

* Marge supérieure: là ou se trouve le sommet du numéro de page, s’il est au sommet de la page

* Marge inférieure: là ou se trouve le bas du numéro de page, s’il est en bas de la page

* Marge gauche: l’extrémité gauche du nom d’instrument le plus à gauche

* Marge droite: l’extrémité droite des portées.

Marges des portées
Les Marges des portées contrôlent la distance entre les portées supérieures et les portées

inférieures et les marges supérieures et inférieures, et également la distance entre les noms

d’instrument et la marge gauche de la page. Ceci permet de définir la position par défaut des

portées sur la page.
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D’habitude, on attribue à la première page des marges supérieure et inférieure différentes, pour

permettre le placement d’éléments tels que le titre et le nom du compositeur en haut et le copyright

ou les coordonnées de l’éditeur en bas. Heureusement, c’est très facile à réaliser:

Entrez dans les cadres à gauche les valeurs souhaitées de marges des portées à utiliser pour la

première page de la partition, puis activer Après la première page et en dessous entrez les

valeurs souhaitées pour les pages suivantes.

Il y a, pour les marges de gauche, trois valeurs différentes, selon que les portées affichent un nom

d’instrument complet, un nom d’instrument abrégé (par exemple après la première page) ou pas

de nom d’instrument. (les réglages concernant l’affichage des noms d’instrument sont proposés

dans la page Instruments de la boîte de dialogue Style maison > Règles de gravure –

b 2.18 Instruments et portées.) 

Ces valeurs sont mises à jour automatiquement en cas de modification des dimensions de la portée

ou de la longueur des noms d’instrument (par exemple en modifiant un nom existant ou en

ajoutant un nouvel instrument). Vous ne pouvez pas les spécifier séparément pour certaines pages

de la partition, car elles s’ajustent sur la longueur du nom d’instrument le plus long utilisé dans

toute la partition.

Changer les paramètres du document d’une section d’une partition
Il est impossible de changer le format de page, son orientation ou la taille des portées pour une

section d’un endroit d’une partition, mais vous pouvez changer les marges des pages et des portées

n’importe où en utilisant les sauts de page spéciaux – cf. Changer les marges des pages et
des portées avec des sauts à la page 653.
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Dans Sibelius, tout objet dans la partition (y compris les notes, les lignes, le texte, etc.) est attaché à

la fois horizontalement et verticalement à la musique, si bien qu’il se déplace correctement lors des

changements de mise en page.

Ce processus garantit que la position relative des objets entre eux reste conforme lors de tout

changement apporté et évite une recherche fastidieuse d’objets à remettre en place après une

modification majeure telle que l’ajout d’un nouvel instrument.

Visualisation des attaches
Lorsqu’un premier objet est sélectionné, si un deuxième objet lui est attaché, une ligne pointillée

grise apparaît les reliant et indiquant la localisation rythmique du deuxième. Si cette ligne

pointillée est gênante, désactivez Affichage > Lignes d’attache. Si par contre, vous souhaitez voir

toutes les lignes d’attache de la partition, tapez Ctrl+A ou XA pour sélectionner tous les objets de

la partition. De même, pour voir tous les objets attachés à une portée, faites un triple-clic dessus.

b 5.23 Menu affichagePour connaître les distances précises entre les portées et les objets qui

lui sont attachés, il suffit de faire apparaître les réglettes prévues à cet effet; .

Visualiser les attaches dans les parties
Visualiser les attaches dans les parties fonctionne exactement de la même manière que dans le

conducteur. Cependant, les lignes d’attaches peuvent être colorées en rouge; l’intensité de cette

couleur augmente au fur et à mesure que l’objet est déplacé de l’endroit où il est attaché, pour

signaler l’importance du déplacement; il faut d’ailleurs éviter qu’il ne soit trop grand –

b 7.1 Travailler avec des parties séparées.

Attache horizontale
Tous les objets sont attachés horizontalement à une position rythmique de la musique. Déplacer

une note à gauche ou à droite, déplace aussi tout objet occupant la même position rythmique.

Si un objet est attaché à une note, sa flèche d’attache se pointera vers la note (ou vers la position

horizontale de la note). Tout ce que vous placez directement au-dessus ou près de la note restera

attaché à cette note. Ainsi par exemple, une liaison de phrasé commençant au-dessus d’une note,

s’étirera ou se contractera pour suivre tout futur déplacement éventuel de cette note.

Si un objet se situe entre deux notes, il sera attaché à une position rythmique intermédiaire.

Cela signifie qu’un objet à mi-chemin entre deux notes restera toujours à la même position

relative, même si l’espace entre ces deux notes devait changer. Voici un cas typique où les

extrémités des soufflets et les f restent positionnés de façon relative entre les notes, même lorsque

l’espacement change:
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La gestion automatique de ce type de situation par Sibelius représente un gain de temps important

dans les manœuvres nécessaires de nettoyage lors de changements majeurs, telles que la création

de mesures supplémentaires ou l’extraction de parties séparées.

Attache verticale
La plupart des objets attachés à une portée sont positionnés de façon relative à celle-ci.

Par exemple, un trille à la trompette ne concerne que cette portée et devrait toujours y rester

attaché si la portée bouge. Les objets qui appartiennent à une portée spécifique sont appelés

“objets de portée”.

Si une portée est déplacée vers le haut ou vers le bas, tous les objets qui lui sont attachés suivront.

Et surtout, si on réalise une extraction de partie séparée, tous les objets attachés à cette portée

seront présents dans le matériel d’orchestre. Il est donc important que chaque objet soit attaché à la

bonne portée.

Pour vous en assurer, surveillez les flèches pointillées, particulièrement lorsque du texte se trouve

dans une position ambiguë entre deux portées et pourrait être attaché à celle qui ne convient pas.

Attache à une autre portée
Si un objet entre deux portées est attaché à la mauvaise d’entre elles, glissez-le jusqu’à ce qu’il

touche la bonne portée et il s’attachera de nouveau à cette dernière. La flèche pointillée vous le fera

apparaître. Ensuite remettez l’objet dans sa position originale.

Sibelius est livré avec une extension appelée Vérifier les attaches qui détecte intelligemment tout

ce qui pourrait avoir été déplacé par inadvertance trop loin de la portée concernée –

b 6.1 Travailler avec des extensions.

Un mot d’avertissement: ne placez aucun objet entre deux portées en pensant qu’il les affectera

toutes les deux. C’est une façon de noter courante dans un manuscrit mais incorrecte en matière

d’édition. Tout objet de portée ne sera automatiquement attaché qu’à une et une seule portée.

Donc lors de l’extraction des parties, l’objet ne sera présent que sur une seule des portées extraites.

Par contre quand un instrument s’écrit sur deux portées, comme c’est le cas des instruments à

clavier, alors, les indications de nuance s’écriront entre les deux portées; et puisque de toute façon

elles ne forment qu’une seule partie, cela ne posera aucun problème lors de l’extraction.

Ajuster les attaches dans les parties
Il est impossible de changer le point d’attache d’un objet dans une partie. Si vous éloignez un objet

de sa position par défaut dans une partie, son point d’attache restera fixe; seuls les réglages

horizontal et vertical sont modifiés. Si vous souhaitez changer le point d’attache d’un objet,

déplacez-le dans le conducteur et il se déplacera aussi dans la partie.

Objets de système
Certains objets s’appliquent à toutes les portées d’un même système et non à une portée en

particulier. Ils sont appelés “objets de système”. Les objets de système sont en couleur violette

lorsqu’ils sont sélectionnés. Des exemples typiques d’objets de système sont les titres, les

indications de tempo, les repères de répétition et les primos et secundos. Quoique ces objets

apparaissent au-dessus du système (et sont parfois répétés plus bas), ils se réfèrent réellement à
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chaque portée du système. C’est ainsi qu’en cas d’extraction, ils seront insérés dans chaque partie

séparée et pas seulement dans le premier instrument du système.

Certains menus et fenêtres de dialogue font la distinction entre les objets de portée et ceux de

système. Par exemple, dans le menu Insérer > Texte, les styles de texte pour les objets de système

se trouvent en dessous des objets de portée.

Pour définir quels objets de système apparaissent au-dessus, consultez Positions des objets de
système dans b 8.12 Positions par défaut.

Placement des objets dans des endroits spéciaux
Parfois, il est nécessaire de placer un fragment de texte ou un autre objet loin de la musique, dans

la marge par exemple. C’est possible, à condition d’être conscient du fait que tous les objets sont

attachés à la musique et non pas fixés à un endroit précis sur la page. Par exemple, les objets de

système dans la marge sont en général attachés à la mesure la plus proche du système et resteront à

une distance fixe de cette mesure.

Si la mise en page est modifiée, la mesure sera déplacée et par conséquent l’objet qui lui serait

attaché pourrait apparaître à un endroit bizarre. Dans ce cas, pour éviter toute modification, la

solution consiste à verrouiller la mise en forme du système ou de la page ; b 8.1 Mise en page
et mise en forme.



8. Mise en page et gravure

662

8.8 Style maison

b 2.23 Papier à musique, 3.9 Modifier les styles de texte, 4.11 Code temporel et
points de montage, 8.3 Gravure musicale, 8.1 Mise en page et mise en forme,

8.12 Positions par défaut, 8.18 Édition.

L’esthétique et la présentation d’une partition imprimée sont définies par son style maison.

Tout comme les éditeurs ont chacun leur propre style maison, chaque utilisateur de Sibelius peut

définir le sien suivant une multitude de paramètres.

Voici la liste de toutes les commandes qui permettent de se constituer un style maison:

* Les options des règles de gravure - cf. ci-dessous

* Les styles de texte – b 3.9 Modifier les styles de texte

* Les polices de symboles et leur design b 2.31 Symboles, 8.11 Polices musicales –

8.17 Modifier les symboles.

* Le design des têtes de note –b 2.25 Têtes de note, 8.16 Modifier les têtes de note. 

* Les définitions des instrument et ensembles – b 8.14 Modifier les instruments

* Le design des lignes – b 2.21 Lignes, 8.15 Modifier les lignes.

* Les positions des objets – b 8.12 Positions par défaut.

* La règle d’espacement des notes– b 8.9 L’espacement entre les notes

* Les paramètres du document (par exemple la dimension de la page et de la portée) –

b 8.6 Paramètres du document.

* Le dictionnaire pour l’exécution – b 4.9 Dictionnaire de l’exécution.

* Les réglages par défaut de la présentation des parties multiples – b 7.1 Travailler avec des
parties séparées.

La plupart des ces paramètres peuvent être modifiés dans le menu Style maison.

Styles maison prédéfinis
Quand on crée une nouvelle partition ou qu’on importe un style maison (cf. ci-dessous), on peut

choisir des styles maison prédéfinis selon le type de musique et l’aspect que l’on souhaite donner à la

partition.

Chaque style maison évoque par son nom le style concerné (par ex. jazz), la police musicale

utilisée (Opus, Helsinki, Reprise ou Inkpen2) et en option la police de texte (Times, Georgia ou

Arial). Opus est une police musicale d’aspect standard, Helsinki est plus traditionnelle, et Reprise

et Inkpen2 ont un aspect manuscrit.

Times est une police de texte très standard, Georgia est police avec sérif moins répandue (avec un

aspect plus traditionnel), et Arial (inspirée de la fameuse Helvetica) est une police moderne sans

sérif au look plus contemporain (et peut-être moins élégant). Les styles maison Reprise utilisent

tous la police Reprise aussi bien pour la musique que pour le texte; de la même manière, les styles

maison Inkpen2 utilisent tous Inkpen2, pour le texte aussi.
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Voici les différents types de musique:

* Standard: est le style utilisé par le papier à musique Vierge; il convient pour la plupart des

genres de musique

* Jazz: est identique à Standard mais avec des barres de répétition à ailettes, et toutes les

articulations au-dessus de la portée, comme c’est l’usage en jazz

* Clavier: convient pour la musique pour clavier solo. Est identique à Standard avec toutefois les

nuances exactement entre les mains, pas de nom d’instrument, pas de justification de portée.

* Grandes notes: est identique à Standard mais avec une tête de note alternative qui suit les

recommandations de l’association des éditeurs de musique des États-Unis

* Lead sheet: identique à Jazz avec toutefois les barres de mesure initiales écrites sur des

systèmes d’une seule ligne.

Avant d’importer un de ces styles maison dans une partition déjà existante, il est prudent de noter

les paramètres (format de page, taille de portée et marges) de votre partition dans Mise en page >

Paramètres du document. En effet, en important les règles de gravure et les paramètres de
document, le format du document est aussi importé; votre partition utilisera ainsi le papier A4 et

les portées 6 mm. Donc, une fois l’importation réalisée, vous pourrez restaurer si nécessaire les

réglages d’origine préalablement notés dans Mise en page > Paramètres du document.

Les styles maison Reprise et Inkpen2 
Les styles maison Reprise comportent beaucoup de réglages spéciaux. Par exemple, les repères de

répétition apparaissent dans un cadre avec une ombre, les titres semblent être imprimés au

tampon grâce à la police appelée Reprise Title (dans laquelle tous les caractères sont en capitales,

mais selon qu’on tape la minuscule ou la majuscule, la même lettre apparaît avec différentes

imperfections), tandis que les noms d’instruments dans le coin supérieur gauche de la première

page des parties dynamiques utilisent une autre police de type tampon appelée Reprise Stamp.

Vous pouvez aussi ajouter des parenthèses spéciales pour les instructions de texte au-dessus ou en

dessous de la portée – cf. Ajouter des crochets dans le script Reprise à la page 588.

Les styles maison Inkpen2 house ne sont pas aussi spectaculaires que ceux de Reprise, mais les

caractères en sont plus fins ce qui donnent l’impression qu’ils ont été écrits avec une plume plus

fine. D’autres lignes telles que les lignes de portée, les barres de mesure, les liaisons de phrasé, etc.

sont en général plus fines que celles des styles maison Reprise.

Pour la musique de clavier, essayez d’imprimer en désactivant l’option Remplacer les accolades
dans la boîte de dialogue Fichier > Imprimer (raccourci Ctrl+P ou XP), pour que les accolades

aient l’air dessinées à la main (comme elles le sont à l’écran). Cela ne fonctionnera cependant pas

avec quelques imprimantes.

Dans le même ordre d’idée, essayez d’activer Donner une apparence manuscrite au symbole
H sur la page Mesures à compter de la boîte de dialogue Style maison > Règles de gravure
(raccourci Ctrl+Maj+E ou xXE) pour donner une apparence manuscrite aux mesures à compter,

bien que certains pilotes d’imprimante puissent avoir des bogues les empêchant d’imprimer cela

correctement (et dans des cas extrêmes peuvent même provoquer un plantage).
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Règles de gravure
Sibelius propose de nombreuses règles de gravure musicale à appliquer qu’il est possible de

personnaliser de manière à créer sa propre griffe, ou pour créer différents styles maison pour

différents styles de musique. Ces règles sont toutes définies dans la boîte de dialogue Style
maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE). 

Les options des règles de gravure permettent de définir la position des articulations, la distance

entre les notes et d’autres objets, la justification de portée, etc.

La description précise des options se trouve dans les articles de cet Ouvrage de référence en

relation avec le sujet. Par exemple, les options pour les Numéros de mesure sont détaillées dans

b 3.5 Numéros de mesure. Consultez l’entrée “ Règles de gravure ” dans l’Index pour

obtenir la liste des options et leur emplacement.

Régler des styles maison pour toutes vos partitions
Les réglages du style maison s’appliquent uniquement à la partition en cours d’édition, par

conséquent, si vous voulez utiliser les mêmes réglages pour tous les fichiers, deux possibilités

existent:

* Créer des papiers à musique pour les instrumentations que vous utilisez le plus souvent

contenant votre style maison favori (b 2.23 Papier à musique), ou

* Exportez vos styles maison favoris en utilisant Style maison > Exporter un style maison et

importez-les dans d’autres fichiers. Vous pouvez importer un style maison dans plusieurs

fichiers à la fois (cf. Importer un style maison ci-dessous ).

Exporter un style maison
Vous pouvez exporter un style maison d’une partition vers un fichier de façon à ce qu’il puisse être

importé dans d’autres partitions:

* Choisissez Style maison > Exporter un style maison

* Entrez un nom pour le style maison et cliquez sur OK.

Sibelius va sauvegarder le nouveau style maison dans le dossier de l’application de l’utilisateur (cf.

Fichiers que peut créer l’utilisateur dans b 9.1 Manipuler les fichiers). À moins que

vous ne souhaitiez partager un style maison avec un autre utilisateur, ne vous souciez pas de

l’emplacement de ce fichier, car Sibelius le détectera comme style maison disponible à chaque

démarrage du programme.

Si vous êtes éditeur de musique, pour assurer une présentation uniforme à votre production, vous

pouvez envoyer des fichiers de style maison à tous vos compositeurs, arrangeurs et copistes pour

qu’ils les utilisent, ou vous pouvez importer votre style maison dans n’importe quelle partition .

Pour en savoir plus sur l’exportation des styles maisons dans les parties dynamiques, cf. Exporter
les styles maisons depuis les parties à la page 614.

Importer un style maison
Pour importer un fichier de style maison dans une autre partition:
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* Si la partition comporte des parties, veillez afficher le conducteur plutôt qu’une partie (de

manière à importer le style maison dans le conducteur et toutes les parties en même temps).

Vous pouvez aussi importer un style maison dans les parties – cf. page 619.

* Choisissez Style maison > Importer un style maison:

* Sélectionnez dans la liste le fichier de style maison que vous souhaitez importer

* Notez que les cases à droite sont indentées, pour indiquer que certaines des options sont

requises par d’autres, et ne peuvent donc être désactivées individuellement. Vous pouvez, par

exemple, transférer uniquement les Styles de texte à partir d’un fichier de style maison vers

votre partition sans importer d’autres paramètres, mais si vous souhaitez importer, par exemple,

des Têtes de note, il faudra aussi importer des Symboles et des Styles de texte.

* Désactivez toutes les options que vous ne souhaitez pas importer, pour qu’elles n’ignorent pas les

paramètres existants; il peut s’avérer plus rapide de cliquer sur Sélectionner Aucun puis

d’activer seulement les options que vous souhaitez importer.

* Cliquez sur OK

* La police de texte musical (qui est utilisée pour les nuances, les indications métronomiques,

etc...) ne sera pas mise à jour automatiquement, de sorte dans Style maison > Modifier toutes
les polices il faudra choisir celle qui est correcte dans la liste de Police de texte musical (Opus

Text, Helsinki Text, Reprise Text ou Inkpen2 Text, en fonction de la police musicale choisie).

Plusieurs styles maison prédéfinis sont fournis avec Sibelius – cf. Styles maison prédéfinis ci-

dessus. Sibelius inclut également une extension qui permet d’importer en une fois un style maison

particulier dans un dossier rempli de partitions – Importer un Style maison dans un
dossier de partitions à la page 551.

Si vous importez une nouvelle règle d’espacement des notes, l’espacement existant n’est pas affecté.

La nouvelle règle n’est utilisée que lorsque vous créez plus de notes ou lorsque vous utilisez Mise
en page > Réinitialiser l’espacement des notes (raccourci Ctrl+Maj+N ou xXN). Ce qui signifie

que vous pouvez utiliser différents espacements de notes pour différentes sections d’une partition.

Lorsque vous importez un style maison qui altère la position par défaut des objets, la plupart des

objets ne seront pas repositionnés à moins que vous ne les sélectionniez (par ex. en utilisant un

filtre) puis choisissiez Mise en page > Réinitialiser les positions.
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8.9 L’espacement entre les notes

b 8.3 Gravure musicale, 8.1 Mise en page et mise en forme, 8.10 Espacement des
portées.

Modifier l’espacement des notes signifie en réalité modifier l’espacement entre les notes, les

accords, les silences et les barres de mesure. Voici les diverses options proposées:

* Déplacer des notes et des silences individuels vers la gauche / droite à la souris ou en appuyant

sur Maj+Alt+0/1 ou xz0/1, avec Ctrl ou X pour obtenir de grands incréments

* Pour resserrer ou étaler un passage de musique horizontalement, sélectionnez le passage et

appuyez un certain nombre de fois sur Maj+Alt+0/1 ou xz0/1. À nouveau, maintenez Ctrl
ou X en même temps pour obtenir de plus grands incréments.

* Utilisez Mise en page > Mise en forme > Assembler en un système / une page pour

condenser ou étaler le passage sélectionné afin qu’il tienne sur un système ou une page;

b 8.1 Mise en page et mise en forme

* Pour modifier la règle d’espacement des notes, cf. ci-dessous.

* Si l’espacement des notes a été perturbé et nécessite de rétablir les positions par défaut,

sélectionnez un passage et choisissez Mise en page > Réinitialiser l’espacement des notes
(raccourci Ctrl+Maj+N ou xXN). Par cette action, les clefs, altérations, paroles, etc... seront

aussi rétablies

Règle d’espacement des notes
Sibelius utilise pour l’espacement des notes un algorithme élaboré appelé espacement optique

(Optical™). Il fonctionne d’une manière bien plus complexe qu’un simple série d’espacements qui

serait attribuée aux différentes valeurs de note; cependant, il est possible de spécifier les

espacements de base dans la boîte de dialogue Style maison > Règle d’espacement des notes:
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* Pour chaque valeur de note, il est possible de spécifier l’espace non justifié qui la suit. (“Non

justifié” car la justification horizontale augmente l’espace après les notes / silences d’une valeur

dépendant du contexte.)

* Les espacements sont mesurés de la gauche d’une note à la gauche de la suivante (ils

comprennent l’épaisseur de la tête de note)

* On peut spécifier l’espace avant la première note / silence dans une mesure, et la largeur d’une

mesure vide, qui par défaut est identique à l’espace attribué à une note qui occuperait une

mesure de l’armure actuelle, par ex. une ronde en 4/4, ou une blanche pointée en 6/8.

* Allouer de l’espace supplémentaire lors de collisions de voix s’applique au cas précis dans

lequel une note dans une autre voix et à un intervalle de seconde doit être déplacée vers la droite;

lorsque cette option est activée, Sibelius ajoute de l’espace supplémentaire pour compenser le

déplacement, afin d’éviter un espacement de notes trop serré.

* L’option Notes ornementales contrôle l’espace par défaut autour des notes ornementales et

l’espace entre la dernière note ornementale et la note normale suivante

* Les options Symboles d’accord vous permettent de choisir si Sibelius doit envisager des

symboles d’accord lors de l’espacement de notes (ce qui est le cas par défaut), et, dans ce cas,

l’écart minimum entre les symboles d’accord.

* Les paramètres repris sous Espace minimum définissent l’espace minimal que Sibelius laissera

autour des notes, des altérations, des lignes supplémentaires, des crochets, ainsi qu’au début et à

la fin de mesures dans des situations extrêmement resserrées; ces valeurs sont généralement

bien plus petites que les valeurs d’espacement “idéales” de la partie gauche de la boîte de

dialogue. Sibelius tiendra compte de ces valeurs minimales dans son calcul de l’espacement, avec

pour résultat que les collisions entre objets solides seront rares, même dans des situations très

resserrées. Si malgré tout Sibelius n’arrive pas à maintenir des espacements minimaux de tous

les objets sur un système, il aura à tendance à compresser davantage les objets, et à ce moment-

là des collisions pourront se produire.

* Les options Liaisons contrôlent la longueur minimum des liaisons pour éviter qu’elles soient

minuscules ou invisibles quand l’espacement est très serré. Vous pouvez régler différentes

longueurs minimum pour les liaisons placées au-dessus ou en dessous des notes ainsi que pour

celles entre les notes.

* La partie Paroles de la boîte de dialogue permet: de déterminer si la largeur des paroles doit être

prise en compte lors de l’espacement de la musique; de définir l’espace par défaut entre les

paroles; de choisir si Sibelius doit laisser de l’espace supplémentaire pour les traits d’union; enfin

de choisir si les longues syllabes au début d’une mesure sont autorisées à chevaucher la barre de

mesure qui précède; b 3.3 Paroles.

Pour en savoir plus sur la manière dont ces paramètres contrôlent l’espacement, b 8.3 Gravure
musicale.

La boîte de dialogue Style maison > Règles de gravure comprend les réglages pour l’espace entre

les objets autres que les notes et les silences. En outre, la page Notes et trémolos laisse Sibelius

contracter légèrement l’espacement de notes afin de placer les mesures de manière plus nette sur

une portée.
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Notez que les valeurs que vous entrez dans la boîte de dialogue Règle d’espacement des notes
peuvent être légèrement différentes lorsque vous ouvrez la boîte de dialogue à nouveau. Cela est dû

au fait que Sibelius mesure l’espacement en 1/32ème de dent; pour que les valeurs dans la boîte

soient accessibles pour le commun des mortels ce sont des divisions décimales qui sont utilisées,

bien plus faciles à utiliser que les divisions en 32ème; par conséquent toute valeur entrée dans la

boîte de dialogue est arrondie au 1/32 de dent le plus proche.

Notes non alignées
Sibelius gère l’alignement des notes automatiquement, même dans des cas complexes impliquant

plusieurs voix. Cependant, il peut être parfois nécessaire de modifier la position horizontale d’une

note individuelle dans une mesure. Pour faire cela, sélectionnez la note, ouvrez le panneau

Général de la fenêtre des propriétés, et attribuez une valeur au paramètre X ce qui ajustera le

décalage horizontal. Des valeurs négatives déplacent la note à gauche, des valeurs positives la

déplacent vers la droite. L’unité est la dent; b 5.17 Propriétés.

Optimiser l’espacement de notes
Comme tant d’autres choses en gravure musicale, l’espacement des notes est un art ésotérique pour

lequel il n’y a pas de règles absolues (b 8.3 Gravure musicale).

Les notes ne sont pas et ne devraient pas être espacées proportionnellement à leur valeur

(b 8.3 Gravure musicale), et il est donc normal que la largeur des mesures varie en fonction

de leur contenu. Toutefois, s’il y a de très grandes variations dans les valeurs de note,

particulièrement lorsqu’il y a des rythmes croisés entre les différentes portées, l’espacement peut

devenir très irrégulier, comme par exemple pour les notes encadrées ci-dessous:

Ceci demande un compromis entre l’utilisation de l’espacement par défaut, trop irrégulier, et

l’utilisation d’un espacement proportionnel tout au long de la mesure (rendant la seconde moitié

de la mesure 1 identique à la première), ce qui rendrait la mesure 2 trop étroite par comparaison.

Une bonne stratégie est de donner une apparence régulière à l’espacement des notes temps par

temps ou mesure par mesure. Dans le cas présent, nous pouvons rendre la première mesure plus

ou moins régulière et la seconde régulière mais pas trop étroite par rapport à la première, comme

ceci:

Espacement par défaut

Meilleur :  après ajustement manuel

Espacement inégal dû à un bémol
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Nous avons en fait rendu la seconde partie de la 1ère mesure légèrement plus étroite afin d’adoucir

la transition avec la seconde mesure plus étroite encore. Il y a un espace supplémentaire pour

l’altération entre les double croches sol et le sib dans la portée inférieure; cela est tout à fait

acceptable dans un espacement serré.

Optimiser l’espacement des paroles
La musique avec des paroles présente des problèmes d’espacement des notes particuliers,

spécialement si les valeurs de notes sont courtes et les paroles larges. En espaçant la musique en

fonction des notes uniquement, voici ce qu’on obtiendrait:

Fort heureusement, Sibelius alloue automatiquement de l’espace supplémentaire entre les notes

pour les syllabes extra-larges, de manière à ce qu’elles n’entrent pas en collision. Cependant, si

certaines syllabes sont larges et d’autres ne le sont pas, l’espacement des notes peut devenir très

irrégulier, comme ceci:

Les paroles sont bien espacées mais avec pour conséquence que les notes ne le sont pas et

présentent même des variations d’espacement extrêmes, particulièrement celles qui figurent dans

le cadre; il s’agit bien entendu d’un exemple particulièrement délicat. “Scratched” et “stretched”

sont, à neuf lettres chacune, parmi les syllabes les plus longues en Anglais (un honneur qu’elles

partagent avec “squelshed”), mais “through” est presque aussi gênant, et apparaît souvent.

Rendre à la fois l’espacement des paroles et l’espacement des notes acceptable demande toujours un

compromis. Comme pour l’harmonisation de l’espacement des notes (cf. ci-dessus), une bonne

stratégie consiste à rendre l’espacement régulier sur une échelle de temps par temps ou de mesure

par mesure; si donc vous avez un temps ou une mesure avec une syllabe extra-large, ajustez

l’espacement de toutes les notes de ce temps ou de cette mesure en conséquence.

Dans des situations très resserrées, il peut également être utile de déplacer quelques syllabes

horizontalement afin de tirer parti de l’espace libre autour de syllabes antérieures ou ultérieures.

Avec l’exemple précédent voici probablement le meilleur résultat qu’il soit possible d’obtenir:

Espacé en fonction des notes sur pales 

Espacement par défaut : plus large de Sibelius pour les paroles larges 
(pour éviter les collisions)  

Meilleur :  espacement des notes et des paroles équilibrées
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8.10 Espacement des portées

Cet article explique comment modifier la position verticale des portées d’une partition. Pour

obtenir des informations générales sur les outils de mise en page dans Sibelius, b 8.1 Mise en
page et mise en forme. Pour obtenir des informations sur le masquage des portées vides, ou

l’indentation du côté gauche ou droit du système, b 2.29 Portées. Pour obtenir des

informations sur la création de système et sauts de page, et placer moins de mesures sur un

système ou une page, voir b 8.5 Les sauts (et voir b 8.4 Sauts de page automatiques
pour obtenir des informations sur la manière dont Sibelius l’effectue automatiquement dans les

parties instrumentales). Pour savoir comment réduire ou agrandir les portées, ou changer la taille

de page de votre partition, b 8.6 Paramètres du document.

Espacement des portées par défaut
Les portées figurant dans votre partition sont espacées en fonction d’un ensemble de valeurs par

défaut sur la page Portées de Style maison > Règles de gravure, et Sibelius utilise une justification

verticale pour veiller à ce que les portées et systèmes soient répartis pour remplir la page.

Si vous imaginez une page avec un système unique, la ligne supérieure de la portée supérieure est

positionnée sur la marge de portée supérieure par défaut, et la ligne inférieure de la portée inférieure

est positionnée sur la marge de portée inférieure, avec les autres portées espacées à distances égales.

En règle générale, la première page comportera une marge de portée supérieure et inférieure plus

grande, pour laisser de l’espace au texte qui figure normalement ici (ex. titre et compositeur en haut

de la page, et les informations de copyright ou de l’éditeur en bas), et Sibelius l’effectue

automatiquement aussi. (les marges de portée sont définies dans Mise en page > Paramètres du
document, et sont expliquées sur page 657.)

La distance par défaut entre les portées au sein d’un système est spécifiée par la valeur n espaces
entre portées. Toutefois, du fait que la justification verticale répartit des portées pour remplir la

hauteur de la page, cette valeur est généralement la valeur minimum qu’utilisera Sibelius. Seule

exception notable : les instruments comportant deux portées reliées par une accolade par défaut,

comme le piano et la harpe : par défaut, Sibelius ne justifie (répartit) pas la distance entre deux

portées de ces instruments, c’est pourquoi la valeur n espaces entre portées sera toujours utilisée

de manière littérale. (si vous souhaitez néanmoins que Sibelius justifie la distance entre les portées

reliées par une accolade, désactivez Justifier les deux portées d’instruments de grand
ensemble).

Imaginez maintenant que notre partition contient des instruments de différentes familles, ex. à vent,

cuivres et cordes. Chaque famille d’instruments est généralement reliée par un crochet ou une

accolade dans la partition (b 2.9 Crochets et accolades), et pour améliorer la clarté de la

page, Sibelius ajoute automatiquement un peu plus d’espace entre la portée inférieure contenue entre

crochet ou accolade et la portée suivante en dessous, contrôlée par la valeur n espaces
supplémentaires entre groupes de portées. Comme précédemment, cette valeur est

effectivement un écart minimum, car elle est mise à l’échelle de la même manière que d’autres écarts

entre systèmes par justification verticale.

Ensuite, imaginons que notre partition contient également des portées vocales pour les chanteurs.

Vous avez généralement besoin de plus d’espace en dessous des portées vocales pour laisser de la
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place aux paroles, et Sibelius l’effectue automatiquement à votre place, contrôlé par la valeur n

espaces supplémentaires sous les portées vocales (pour les paroles). Cette valeur est aussi

mise à l’échelle par justification verticale.

Notre partition imaginaire compte assez d’instruments pour qu’un seul système s’ajuste à la page,

et il est donc probable que des objets de système comme des repères de répétition, des instructions

de tempo et des numéros de mesure apparaissent non seulement au-dessus d’une ou de deux

autres portées dans le système - par ex. au-dessus des cordes, ou au-dessus des portées vocales.

Sibelius laisse automatiquement un peu de place au-dessus des portées sur lesquelles les objets de

système doivent apparaître, contrôlés par la valeur n espaces supplémentaires au dessus pour
les positions d’objet de système. (les positions d’objet de système sont définies dans Style
maison > Positions d’objet de système, et sont expliquées sur page 682.)

Enfin, imaginez un instant que notre partition comporte moins de portées, de sorte que deux voire

trois systèmes puissent aisément tenir sur la page. La distance entre la portée inférieure d’un

système et la portée supérieure du suivant est définie par la valeur n espaces entre systèmes.

Comme pour les autres valeurs par défaut, cette valeur est mise à l’échelle par justification

verticale.

Sibelius autorisera les portées à être plus rapprochées que les distances spécifiées ci-dessus

seulement si vous utilisez par ex. Mise en page > Format > Assembler en une page pour forcer

un système supplémentaire sur une page, ou si vous définissez L’espacement des systèmes peut
se contracter jusqu’à n% à une valeur inférieure à 100% sur la page Portées de Règles de
gravure (par défaut, il est réglé sur 97%, ce qui autorise quelque marge de manoeuvre pour

rapprocher davantage les portées que les valeurs spécifiées). Toutefois les portées seront, le plus

souvent, plus éloignées que les distances spécifiées ci-dessus, en raison de la justification verticale.

Justification verticale
Bien que les distances entre portées individuelles et systèmes puissent varier entre les pages – pour

compter des éléments comme des notes très basses ou élevées à certains endroits de la partition – la

distance entre le haut de la page et la ligne de portée supérieure de la première portée, et la distance

entre le bas de la page et la ligne de portée inférieure de la dernière portée coïncident normalement

sur toutes les pages de la partition, sauf pour la première page, qui doit laisser de la place pour plus

de texte en haut et en bas.

La justification verticale répartit les portées et systèmes de manière à remplir la hauteur de la page,

en apportant la cohérence sur les pages décrites ci-dessus, ce qui augmente proportionnellement la

distance entre les portées et systèmes le cas échéant pour améliorer la clarté et la lisibilité, sans gêner

votre capacité à ajuster la distance entre portées et systèmes, comme requis sur une base

individuelle.

Par défaut, la justification verticale s’applique si la hauteur totale des portées et systèmes (avec leurs

écarts) dépasse de 65% la hauteur de la distance entre la marge de portée supérieure et inférieure.

Cela est contrôlé par la valeur complète Justifier les portées quand la page est remplie à n% sur

la page Portées de Style maison > Règles de gravure.

La justification verticale ne dépasse ce seuil que parce qu’une page est aux deux tiers remplie

(comme c’est le cas par ex. pour les mises en page d’hymne avec paragraphes sous deux ou trois
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systèmes de musique, ou sur la page finale d’une partition pour un petit ensemble), répartir les

portées et systèmes plutôt que laisser un écart plus grand en bas de la page présenterait moins bien.

Si vous souhaitez désactiver la justification verticale, pour produire un “ragged bottom”

(pardonnez-moi l’expression !), définissez Justifier les portées quand la page est remplie à
n% à 100%. Toutefois, cela serait très rarement recommandé : à part peut-être pour produire des

documents qui ne sont pas des partitions au sens propre du terme (par exemple, lors de la

préparation d’échantillons musicaux à exporter sous forme de graphiques vers une autre

application, ou lors de la création d’exercices à fort contenu texte).

Une fois que vous avez compris le principe de la justification verticale et comment elle interagit

avec les distances entre les portées et systèmes sur la page Portées de Règles de gravure, vous

verrez que c’est un outil incroyablement utile pour produire une mise en page claire et cohérente

de manière entièrement automatique.

Ajuster les distances entre portées et systèmes
Si une page semble trop lourde verticalement, avant d’ajuster l’espacement de portée, la première

chose à faire consiste souvent à légèrement réduire la taille de portée dans Mise en page >

Paramètres du document. Le moindre changement de taille de portée peut avoir une

conséquence radicale sur la mise en page de la portée. Mais ne pensez pas que vous devez toujours

réduire la taille de portée : parfois, une petite augmentation de la taille de portée revient à

soustraire un système par page, ce qui multipliera le nombre de pages, tout en procurant

également une partition plus claire à déchiffrer pour les artistes ou chefs d’orchestre. Voir page 656

pour lire des instructions sur les combinaisons de page et taille de portée adaptées à différents

styles de musique.

Si vous estimez que les portées sont encore trop proches ou trop éloignées après avoir ajusté la

taille de portée, vous devez ajuster les distances entre portées et systèmes via la page Portées de

Style maison > Règles de gravure : cela change l’espacement de portée et système par défaut, et

est de loin le moyen le plus rapide pour expérimenter et effectuer des changements.

Grâce à ces deux outils, vous serez normalement capable de produire une mise en page claire et

aérée sans trop d’édition manuelle à réaliser. Pour de nombreuses partitions en revanche, la texture

et la densité des changements musicaux dans le temps, qui peuvent engendrer des collisions entre

les notes sur des portées adjacentes, ou plus couramment entre des objets joints aux portées

adjacentes (ex. une dynamique en dessous d’une portée en collision avec une liaison de phrasé au-

dessus des notes sur la portée ci-dessous), sur certains systèmes.

Sibelius peut normalement résoudre ce genre de collisions automatiquement à votre place, via

Mise en page > Optimiser l’espacement des portées. Cette option permet d’examiner chaque

portée, calcule le volume d’espace idéal devant y être attribué sur la largeur du système (en tenant

compte de cette portée et de tous les objets joints séparément, comme si aucune autre portée était

présente), puis entremêle les portées aussi étroitement que possible, en les ajustant seulement de la

plus courte distance nécessaire pour résoudre les collisions entre elles. Par exemple, si une portée

comporte des notes basses à gauche du système, et que la portée en dessous comporte des notes

aiguës à droite du système, Sibelius sait qu’il n’a pas besoin de laisser de la place pour des notes

basses sur la première portée à droite du système, et peut donc déplacer la portée du dessous plus

près de la portée au-dessus sans engendrer de collisions.
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Vous pouvez contrôler la quantité de distance horizontale et verticale Optimiser l’espacement
de portée à laisser entre les objets sur chaque portée sur la page Portées de Style maison >

Règles de gravure.

Pour obtenir le meilleur effet, vous devez sélectionner au moins tout un système ou, de préférence,

toute une page avant de choisir Mise en page > Optimiser l’espacement de portée : plus

Sibelius aura de contexte, meilleur sera le résultat. Vous pouvez évidemment sélectionner toute la

partition avant d’utiliser Optimiser l’espacement de portée.

Dans certaines situations particulièrement serrées, Sibelius risque de ne pas pouvoir résoudre

toutes les collisions, auquel cas vous devrez ajuster les résultats manuellement. Pour trouver des

collisions, voir Trouver les collisions à la page 633. Après avoir détecté une collision, vous

déciderez peut-être que la meilleure manière de résoudre la collision consiste à déplacer un ou

plusieurs objets, ou souhaiter ajuster l’espacement de portée vous-même.

Déplacer les portées manuellement
La plupart des opérations de déplacement des portées implique qu’elles soient préalablement

sélectionnées avant d’agir:

* Cliquer sur un endroit vide d’une mesure d’une portée sélectionne la mesure (double-cliquer

sélectionne la portée, mais sélectionner une mesure suffit pour déplacer les portées)

* Triple-cliquer sur un endroit vide d’une mesure sélectionne une portée à travers la partition

* Sélectionner un passage à travailler sur plusieurs portées.

Pour en savoir plus sur les sélections, b 1.9 À propos des sélections et des passages.

Voici les deux manières fondamentales pour déplacer les portées:

* Déplacement normal - sélectionnez une ou plusieurs portées et déplacez-les avec la souris

(raccourci Alt+3/ 2 ou z3/2, plus Ctrl ou X pour des incréments plus importants); il s’ensuit

que la distance entre la/les portée(s) sélectionnée(s) et la portée supérieure (ou le sommet de la

page s’il s’agit de la portée supérieure) est modifiée ainsi que l’espace entre les autres portées.

Sibelius peut ainsi comprimer les autres portées pour libérer de la place, si la page est très

remplie.

* Déplacement indépendant - sélectionnez une ou plusieurs portées, maintenez d’abord Shift
enfoncé puis cliquez et déplacez (raccourci Shift + Alt+3/2 ou xz3/2, avec Ctrl ou X pour

des incréments plus importants) ; cette fois, seulement la/les portée(s) sélectionnée(s) se

déplace(nt) en laissant les autres à leur place sur la page. Même s’il est possible de déplacer les

portées quasi l’une sur une autre, il est impossible de les intervertir par ce moyen et de changer

l’ordre des portées dans votre partition (si cela est vraiment nécessaire, b 2.18 Instruments
et portées).

Activer l’option Affichage > Réglettes > Réglettes de portée (raccourci Ctrl+Shift+Alt+R ou

xzXR) peut s’avérer utile avant de déplacer des portées - b 5.23 Menu affichage.

L’étendue de la sélection initiale détermine précisément quels systèmes et quelles portées sont

déplacés. Cela signifie que vous pouvez modifier l’espacement entre les portées d’un système, d’une

page ou de plusieurs, simplement en sélectionnant le passage à modifier. (De même, un passage de

plusieurs portées peut être déplacé indépendamment vers le haut ou vers le bas, ce qui modifie

l’espace au-dessus de la portée supérieure et/ou celui de la portée inférieure de la sélection.)
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Toutefois, il est recommandé de réaliser le réglage le plus petit possible (ex. une seule portée sur un

seul système), car ajuster la portée manuellement évite que les changements apportés à

l’espacement de portée par défaut s’appliquent avant d’avoir réinitialisé la position des portées.

Rétablir l’espacement des portées par défaut
Pour rétablir l’espacement des portées par défaut (c’est-à-dire les réglages de la page Portées de la

boîte de dialogue Style maison > Règles de gravure) à appliquer à une ou plusieurs portées,

sélectionnez le passage souhaité et choisissez Mise en page > Réinitialiser l’espace au-dessus
de la portée ou Mise en page > Réinitialiser l’espace en dessous de la portée.

aligner les portées
Pour appliquer la disposition spatiale des portées et des systèmes d’une page à d’autres pages d’une

même partition, choisissez Mise en page > Aligner portées.

La sélection des pages où s’appliquent les options de cette boîte de dialogue s’établit facilement

puisqu’une mesure quelconque d’une page sélectionnée implique la sélection entière de cette page;

donc sélectionner un passage qui va d’une mesure d’une page à une mesure d’une autre page suffit

à établir la sélection des pages qui seront alignées. Les options sont les suivantes:

* Verrouiller la mise en forme avant d’appliquer les changements - cette option garantit que

les mesures seront toujours dans le même système, après l’opération d’alignement des portées

* Réinitialiser la position des portées: les deux options proposées restaure la distance par

défaut des portées supérieure et inférieure par rapport aux marges de la page (comme spécifié

dans Mise en page > Paramètres du document)

* Aligner les portées sur les pages sélectionnées: permet le choix parmi quatre sous-options:

% Avec la première page sélectionnée: les pages s’alignent sur la première sélectionnée

% Avec la dernière page sélectionnée: les pages s’alignent sur la dernière sélectionnée 

% Les pages de droite avec les pages de gauche leur faisant face: aligne chaque page de

droite sur la page de gauche qui lui face

% Les pages de gauche avec les pages de droite leur faisant face: aligne chaque page de

droite sur la page de gauche.

Évidemment pour que ces options fonctionnent, il faut que plus d’une page soit sélectionnée.

Aligner les portées avec cette boîte de dialogue n’est possible que si les pages à aligner ont le même

nombre de systèmes, et les systèmes le même nombre de portées. Sinon, seules celles du haut et

celles du bas seront alignées. Si l’une ou l’autre page comporte un seul système, seule la portée

supérieure sera alignée.
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8.11 Polices musicales

b 3.9 Modifier les styles de texte, 8.8 Style maison, 8.17 Modifier les symboles.

Les têtes de note, les clefs, les altérations et la plupart des autres objets qui apparaissent dans les

partitions de Sibelius sont dessinés à l’aide d’un symbole qui lui-même est un caractère ou une

combinaison de caractères d’une police musicale.

Les polices de caractères musicaux ont proliféré de façon un peu anarchique au cours des ans ; la

plupart d’entre elles sont souvent formées d’un mélange assez hétéroclite de caractères présents (et

ne parlons pas des absents). Chacun a ses propres préférences en matière de polices de caractères ;

comme de plus chaque police a des qualités et des défauts, aucune n’est donc idéale.

À cause de cela, nous avons veillé attentivement à ce que la famille de police standard de Sibelius,

Opus™, comprenne pratiquement tous les symboles souhaitables et disponibles dans d’autres

polices et que le design des symboles se prête à une édition de la plus haute qualité.

Cependant, comme les goûts en matière de polices diffèrent énormément (et parfois violemment),

nous avons également fait le tri dans la confusion inhérente aux autres polices musicales, et nous

avons conçu Sibelius de façon à ce qu’il soit compatible avec n’importe quelle police musicale que

vous pourriez posséder – à savoir Petrucci™, Chaconne™, Sonata™, Susato™, Jazz™, Franck™, Maes-

tro™, November™, Partita™, Swing™, Tamburo™, Piu™ et Ghent™. Vous pouvez même mélanger

toutes ces polices entre elles dans une partition.

Changer de police musicale rapidement
La façon la plus simple de changer la police utilisée dans une partition est de choisir Style mai-
son > Modifier toutes les polices, de sélectionner une nouvelle police dans la liste Police musi-
cale principale, puis de cliquer sur OK.

Les polices suivantes apparaîtront comme options dans la boîte de dialogue Modifier toutes les
polices si elles sont installées sur votre système : Opus, Helsinki, Reprise, Inkpen2, Maestro,

Petrucci, Sonata, Partita, Franck, Virtuoso, Chaconne, November, Jazz, Swing, LeeMusic, Russ-

Music, et AshMusic.

Pour que d’autres polices puissent apparaître dans cette liste, cf. Utiliser d’autres polices que
celles fournies avec Sibelius ci-dessous.

La plupart des partitions Sibelius utilisent Opus font. Si vous souhaitez changer l’apparence

manuscrite de Reprise ou de Inkpen2, il est préférable d’importer au préalable un des styles mai-

son Reprise ou Inkpen2, car cela changera également l’apparence des autres objets tels que les

portées et les barres de mesures, les phrasés, les liaisons de legato, les soufflets, etc. –

b 8.8 Style maison.

Vous pouvez aussi utilisez la police musicale Sibelius Helsinki, qui présente un aspect plus tradi-

tionnel et plus élégant. Comme pour les polices Reprise et Inkpen2 fonts, vous pouvez importer un

style maison Helsinki pour bénéficier des nombreuses subtilités que le style maison apporte à tous

les aspects de la présentation d’une partition – b 8.8 Style maison.
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Changer la police d’un jeux de symboles
Si vous souhaitez changer de police musicale, vous n’êtes pas obligé de changer tous les symboles

de Sibelius. Vous pouvez modifier uniquement les clés, ou les symboles de percussion, ou même

changer un seul symbole.

Chaque symbole dans Sibelius est dessiné en utilisant la police spécifiée par un style de texte parti-

culier. En modifiant les paramètres d’un style de texte vous pouvez modifier l’apparence d’un jeu

complet de symboles en une fois :

* Symboles usuels : ceci couvre à peu près tous les symboles utilisés couramment – les notes

standard, les altérations, les clés, les articulations, etc.

Vous souhaiterez peut-être changer les Symboles usuels en Reprise, Inkpen2, Helsinki,

Petrucci, Susato ou Sonata. Sonata place les clefs à des endroits non standard, mais vous pouvez

facilement les déplacer.

* Têtes de note spéciales etc. : ceci comprend les têtes de note inhabituelles et les micro-inter-

valles. Vous souhaiterez peut-être changer pour Inkpen2, Tamburo ou Piu.

* Percussions : d’étranges images de mailloches, de brosses, de pièces ou n’importe quoi d’autre

avec lequel vous pouvez frapper des objets. Vous souhaiterez peut-être y substituer Ghent.

* Symboles spéciaux : ceci contient des symboles absents des autres polices, à l’exception d’Opus

Special et de Inkpen2 Special, vous ne souhaiterez donc pas y substituer d’autre police (à moins

de concevoir la vôtre).

* Crochets de note: vous pouvez changer entre Opus, Inkpen2 et Petrucci – les polices Susato,

Sonata, etc., sont inappropriées car elles ont des crochets incompatibles.

Pour modifier la police de l’un de ces jeux de symboles :

* Dans la boîte de dialogue Style maison > Modifier les symboles, cliquez sur Polices musi-
cales

* Cliquez sur le jeu de symboles que vous souhaitez modifier et cliquez sur Modifier

* Modifiez la police et éventuellement la taille, puis cliquez sur OK et encore sur OK pour fermer

la boîte de dialogue Modifier les symboles.

Si vous avez l’intention de modifier la taille, la taille standard pour tous les symboles est 19.8pt

(relatif) – si vous réduisez ou augmentez ceci, les symboles deviendront plus grands ou plus petits.

Vous pouvez utiliser cela pour, par exemple, faire des têtes de note géantes dans les méthodes pour

débutant, ou pour réduire à l’échelle un symbole (en créant son propre style de texte) – cf. Créer
un nouveau style de texte de symbole dans b 8.17 Modifier les symboles.

(Pour les curieux : modifier la police de caractères musicaux et sa taille se fait dans la boîte de dia-

logue Style maison > Modifier les styles de texte. Cela est du au fait que les symboles sus-men-

tionnés sont traités en fait comme des styles de texte par Sibelius, même si la police et la taille sont

les seules options que vous pouvez modifier. Que cela ne vous empêche pas de dormir.)

Pour en savoir plus sur la personnalisation des symboles de Sibelius, b 8.17 Modifier les
symboles.
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Police de texte musical
Divers symboles musicaux tels que f, p et q peuvent être entrés dans des styles de texte tels que

expression ou encore indication métronomique. Ces caractères de texte musical sont dessinés par

défaut en utilisant la police Opus Text, comme le sont les chiffres 0–9 et le: (deux points) utilisés

pour les multiplets.

Vous pouvez modifier la police utilisée pour du texte musical dans la boîte de dialogue Style mai-
son > Modifier toutes les polices. Nous vous recommandons de ne la changer que pour une

police italique ou italique gras, et de ne la changer pour une police de texte normale que si vous

n’utilisez pas d’indication métronomique, car les polices de texte ne contiennent pas les petits sym-

boles de note.

(Cependant, si vous souhaitez vraiment modifier la police de texte musical et souhaitez tout de

même utiliser des indications métronomiques, vous pouvez remettre manuellement la police des

indications métronomiques sur Opus Text ou Inkpen2 lorsque vous les entrez.)

Lorsque vous modifiez la police de texte musical, il vous est demandé si vous souhaitez ou non

appliquer les modifications au texte existant de la partition. Cela vous permet, par exemple, de

modifier la police de texte utilisée pour les nuances déjà présentes dans la partition. (Cette opéra-

tion est impossible en modifiant le style de texte d’expression car les styles de texte ne définissent

que la police utilisée pour du texte normal tel que cresc. et pas les caractères musicaux tels que mf.)

Utiliser d’autres polices que celles fournies avec Sibelius
Sibelius permet d’utiliser n’importe quelle police musicale pour donner à vos partitions la présen-

tation que vous souhaitez. Tout autant qu’un ordinateur n’est qu’un ordinateur, une police n’est

qu’une police; vous devez donc indiquer à Sibelius quelles polices de votre système sont des polices

musicales avant de pouvoir les utiliser en tant que telles.

Les polices musicales acceptées sont énumérées dans la boîte de dialogue Style maison >Modifier
toutes les polices ; quand vous indiquez une nouvelle police à Sibelius, celle-ci apparaît dans la

liste Police musicale principale.

Choisissez la page Polices musicales de la boîte de dialogue Fichier > Préférences (dans le menu

Sibelius sur Mac). La boîte de dialogue suivante apparaît :
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La liste des polices à gauche affiche celles que Sibelius reconnaît comme polices musicales. Si vous

voulez ajouter une nouvelle police à la liste :

* Tapez le nom de la nouvelle police dans le champ Police musicale à gauche, ou cliquez sur le

bouton Choisir pour la sélectionner dans la liste des polices installées sur l’ordinateur. Une fois

entré le nom de la police, cliquez sur le bouton Ajouter une police. La police sera ajoutée à la

liste.

* Une fois la nouvelle police sélectionnée sur la liste de gauche, entrez le nom de la police que vous

voulez utiliser pour chaque élément de la notation dans les différents champs à droite, ou cliquez

sur le bouton Choisir pour sélectionner une police dans la liste. Quand vous avez rempli tous les

champs, cliquez sur le bouton Jeu de substitutions.

Très peu de polices disponibles possèdent des polices séparées pour tous les styles de texte de sym-

boles de Sibelius, de sorte qu’en général il est nécessaire de prévoir une police de substitution à

celle choisie pour les Symboles usuels.

Installer des polices musicales de Type 1
Les polices de caractères musicaux Opus, Helsinki, Reprise et Inkpen2 sont fournies à la fois au

format TrueType et Adobe Type 1 (PostScript), et les polices TrueType sont installées par défaut.

Vous pouvez imprimer sur des imprimantes PostScript et créer des fichiers EPS en utilisant l’un ou

l’autre de ces formats de police.

Toutefois, pour certaines applications, les polices Adobe Type 1 sont préférables aux polices

TrueType, bien que vous ayez généralement besoin d’installer des logiciels supplémentaires pour

pouvoir les utiliser. Les dernières versions des polices PostScript sont disponibles sur le site Inter-

net de Sibelius.

Concevoir votre propre police de caractères musicaux
Pour créer des polices en tout genre, nous recommandons le logiciel FontLab (www.font-
lab.com) ; cependant, la conception de polices est un art complexe, et ce n’est donc pas recom-

mandé aux âmes sensibles.

Les familles de polices Opus, Helsinki, Reprise et Inkpen2 sont protégées par les lois sur les droits

d’auteur, il n’est donc pas autorisé d’inclure des symboles de l’une d’elles dans une police que vous

créez.

http://www.fontlab.com/
http://www.fontlab.com/
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8.12 Positions par défaut

Utilisateurs avertis uniquement 

La boîte de dialogue Style maison > Positions par défaut permet de modifier la façon dont se

positionnent le texte, les lignes et d’autres objets divers lorsque vous les créez, les déplacez et lors-

que vous réinitialisez leur position. Les réglages par défaut de Sibelius sont pertinents, donc

normalement, vous n’aurez pas à les modifier. Toutefois, si vous succombez à un besoin impérieux

de le faire, cette article vous dira comment procéder.

La boîte de dialogue se présente comme sui:

Pour modifier la position par défaut d’un objet, choisissez-en la catégorie dans le coin supérieur

gauche (soit Styles de texte, Lignes ou Autres objets) puis sélectionnez le style de texte ou

l’objet souhaité dans la liste. Vous pouvez même sélectionner plusieurs styles ou objets pour

modifier en même temps leurs propriétés communes.

Les options qui ne sont pas applicables au style de texte ou à l’objet sélectionné seront désactivées,

de manière très logique (donc pour les styles de texte, on ne peut pas définir les options Création
de lignes, et vice versa). De la même manière, si on sélectionne plusieurs lignes (par ex.), les

valeurs que les objets sélectionnés ont en commun seront affichées dans la boîte de dialogue tandis

que les valeurs qui ne sont pas communes apparaîtront en grisé.

Les options de la boîte de dialogue sont les suivantes:

Création d’objet
Il y a des options séparées pour la création d’objet au clavier et à la souris. Lorsque vous créez des

objets à la souris, vous pouvez cliquer précisément à l’endroit où vous souhaitez que l’objet se place;

par contre, lorsque vous créez des objets au clavier, vous ne pouvez pas indiquer précisément

l’endroit où vous souhaitez que l’objet soit placé; ils apparaissent donc à une position logique près

du signe d’insertion (si vous êtes en mode de saisie de notes) ou de l’objet sélectionné.

Certains objets peuvent être réglés par défaut pour apparaître à une place différente dans les

parties et dans la partition. Même si ce n’est pas toujours indispensable, des objets tels que les

repères de répétition sont mieux positionnés quand ils sont plus près du sommet d’une portée

dans les parties que dans la partition. Sibelius permet, par exemple, de positionner ces repères à

cinq dents de distance de la portée dans le conducteur et seulement à deux dans les parties.
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Les options Au clavier (ou position initiale) contrôle les règles de positionnement de l’objet lors-

qu’il est créé au clavier, ou lorsque vous le sélectionnez et choisissez Mise en page > Réinitialiser
les positions (raccourci Ctrl+Maj+P ou xX P):

* Position horizontale x dent(s) à droite de la note définit la position horizontale par défaut;

entrez une valeur négative si vous désirez positionner les objets à la gauche de la note à laquelle

ils sont attachés (pour, par ex., des nuances)

* Position verticale x dents de la portée positionne automatiquement l’objet verticalement

pour vous, relativement à l’option choisie en bas de la boîte de dialogue sous Position verticale
(Au-dessus de la portée, En dessous au bas de la portée, Au-dessus au milieu de la
portée et Sous le milieu de la portée. Si vous le souhaitez, vous pouvez saisir d’autres valeurs

pour la partition et ses parties.

* Autre position par défaut sur portées vocales vous permet de spécifier que l’objet doit être

positionné différemment sur les portées vocales et portées instrumentales; si vous l’activez, vous

pouvez alors spécifier une Position verticale au-dessus de la portée pour l’objet sélectionné.

Cela est effectué par défaut pour le texte Expression et les diverses lignes de soufflet, telles

qu’elles apparaissent au-dessus des portées vocales, mais en-dessous des portées instrumentales.

Les options À la souris détermine simplement si, lorsque qu’il est créé à la souris, l’objet devrait

être positionné à sa position horizontale / verticale par défaut (tel que définie dans les réglages Au
clavier ci-dessus) plutôt qu’à la position du pointeur de souris, par exemple:

* Du texte tel que des symboles d’accord, de la basse chiffrée, des doigtés et des paroles sont tous

préférablement créés à leur position verticale et horizontale par défaut;

* du texte de système tel que le titre, le compositeur, les notes en bas de page, etc. sont tous créés à

de préférence à leur position verticale par défaut;

* certains autres styles de texte, tel que du texte de tempo ou une indication métronomique sont

créés de préférence à la position du pointeur de souris - pour obtenir ce comportement,

décochez simplement les deux options À la souris.

Déplacement d’objet
Bien que tous les objets puissent être déplacés à la souris, un plus grand degré de contrôle est

possible en déplaçant les objets avec les flèches et leur modificateurs (par ex. 0/1 pour de petits

incréments et Ctrl+ 0/1 ou X0/1 pour de grands incréments). Les options Déplacement
d’objet vous permettent de contrôler le comportement de ces opérations:

* Les flèches déplacent de est la distance de laquelle un objet bougera lorsqu’il sera déplacé avec

les flèches

* Ctrl+flèches / Commande-flèches déplace de est la distance de laquelle un objet bougera

lorsqu’il sera déplacé avec les flèches en conjonction avec la touche Ctrl ou X.

* Seuil de déplacement à la souris indique de combien vous avez à tirer sur un objet avec la

souris avant qu’il ne se déplace de sa position actuelle; réglez ceci sur une valeur élevée si vous

désirez rendre les objets plus “collants” et moins enclins à être déplacés par erreur.

Vous pouvez ajuster ces options pour les styles de texte et les lignes séparément, mais pas pour les

styles de texte ou de lignes individuels; tout changement fait à ce réglage affecte donc tous les

objets similaires (par ex. modifiez le seuil de déplacement pour du texte technique et vous le
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modifierez pour tous les autres styles de texte). Les options Déplacement d’objet (contrairement

aux autres options de cette boîte de dialogue) sont des préférences globales et ne sont donc pas

associées à une partition particulière - ils s’appliquent à toutes les partitions sur lesquelles vous

travaillez dans Sibelius.

Création de lignes
Position horizontale de l’extrémité droite comme son nom l’indique, détermine combien de

dents à la droite de l’extrémité droite de la ligne se fera la terminaison.

Création de texte
Au-dessus/En dessous du sommet/du milieu/du bas de la portée spécifie la position de la

ligne de base (c-à-d le bas de lettres majuscules) relativement à la ligne de portée spécifiée. La

distance de la ligne de portée est spécifiée sous Au clavier (ou position initiale) en haut de la

boîte de dialogue.

Certains styles de texte, comme les paroles, la basse chiffrée et le doigté sont créés en sautant de

note à note en utilisant la touche espace (b 3.3 Paroles, 3.1 Utiliser du texte). Les options

sous Saisie de paroles contrôle ce fonctionnement:

* Le trait d’union / la barre d’espacement déplace à la note suivante agissent comme

indiqué par leur nom.

* La barre d’espacement déplace au temps suivant est utilisée pour les symboles d’accord, de

manière à ce que vous puissiez écrire différents symboles d’accord à chaque temps de la mesure,

même si la note dure plusieurs temps.

Si les deux options inférieures sont activées, appuyer sur espace pendant la saisie de texte

déplacera le signe d’insertion soit à la note suivante soit au temps suivant, selon ce qui se produit le

plus tôt.

Cas spéciaux
Certains détails sont à garder à l’esprit lorsque vous utilisez la boîte de dialogue Style maison >

Positions par défaut:

* Les options de Création d’objet n’ont aucun effet sur les clefs, les armures, les barres de mesure

spéciales, les indications de mesure ou les transpositions. Pour réinitialiser la position de l’un de

ceux-ci, faites une sélection de système autour de l’objet et choisissez Mise en page >

Réinitialiser l’espacement des notes (raccourci Ctrl+Maj+N ou xXN).

* Pour les objets de système (par ex. les styles de texte tels que Titre, Tempo, les lignes de rit./accél.,

etc.) la position verticale par défaut ainsi que les réglages de Au-dessus / en dessous de la
portée du haut / milieu / bas sont rétroactifs - en d’autres termes, tous les changements

appliqués à ces réglages modifieront automatiquement tous les objets de système de la partition.

* Cependant, pour les objets de portée (par ex. les symboles d’accord, les paroles ou les crochets)

les modifications n’affectent que les objets nouvellement créés - si vous avez, par exemple, du

texte d’expression dans la partition et que vous changez la position par défaut du style de texte

expression, le texte d’expression existant de la partition ne sera pas modifié automatiquement. 

Si vous désirez modifier la position de certains ou de tous les objets existants de la même

manière que les nouveaux, utilisez les filtres pour les sélectionner (b 5.7 Rechercher et
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filtrer), puis choisissez Mise en page > Réinitialiser les positions (raccourci Ctrl+Maj+P ou

xXP).

* Les paramètres de la boîte de dialogue Style maison > Modifier le style de texte pour

l’alignement du texte par rapport à la page ont priorité sur les paramètres dans la boîte de

dialogue Style maison > Positions par défaut

* Pour les liaisons de phrasé, si aucune des options de Créer à la position horizontale /
verticale par défaut n’est cochée, la création d’une liaison de phrasé à la souris produira une

liaison non magnétique. Si vous activez l’une de ces options (ou les deux), la souris créera des

liaisons magnétiques. La création de liaisons magnétiques à la souris peut être un peu

déroutante - si, par exemple, vous voulez entrer une liaison de phrasé courbée vers le haut

(raccourci S) et que vous essayer de la placer au-dessus de notes dont les hampes pointent vers le

haut en utilisant la souris, la liaison apparaîtra en fait en dessous des têtes de note. La fonction

peut toutefois vous être utile, si vous êtes marié à votre souris !

* La position horizontale des repères de répétition est déterminée par les réglages dans la section

Autres objets, et leur position verticale est déterminée dans les réglages dans la section Styles
de texte.

* Les positions de certains autres objets aux règles de positionnement complexes (tels que les

liaisons de phrasé magnétiques et les multiplets) ne peuvent être modifiées que par la boîte de

dialogue Style maison > Règles de gravure et non par Style maison > Positions par défaut.

Positions des objets de système
Dans les grandes partitions, certains objets de système, comme les repères de répétition et les

indications de tempo peuvent apparaître simultanément à plusieurs endroits verticaux d’un

système, par exemple au-dessus de la portée supérieure et au-dessus des cordes dans une partition

d’orchestre: Pour modifier les positions de destination de ces objets :

* Choisissez Style maison > Positions des objets de système

* Cliquez les portées sur lesquelles vous souhaitez que les objets de système apparaissent, jusqu’à

cinq occurrences au total. La portée supérieure est comptée d’office. Les objets de système

peuvent se placer sous la portée inférieure.

Les objets de système ne doivent pas tous figurer obligatoirement à ces positions. L’onglet Position
verticale de Style maison > Modifier les styles de texte (raccourci Ctrl+Maj+Alt+T ou

xzXT) vous permet de spécifier à quelles positions spécifiques vous souhaitez qu’un style de

texte apparaisse. Cela vous permet (par exemple) de placer des repères de répétition au-dessus de

la portée supérieure, au-dessus des cordes et en dessous de la portée inférieure, tandis que le texte

de tempo ne figurerait qu’au sommet. b 3.9 Modifier les styles de texte .

Vous pouvez aussi supprimer des occurrences individuelles d’objet de système; ainsi, si par

exemple une indication de tempo apparaît trois fois dans la partition, vous pouvez supprimer avec

Suppr. les deux occurrences inférieures individuellement sans incidence sur les autres, tandis que

supprimer l’occurrence supérieure supprimera les trois d’un coup. Pour restaurer des occurrences

d’objet de systèmes supprimées, sélectionnez l’occurrence supérieure et choisissez Mise en page >

Rétablir l’aspect original (Ctrl+Maj+D ou xXD).
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8.13 Modifier les symboles d’accord 

b 2.10 Les symboles d’accord.

Sibelius fournit des possibilités incroyables de contrôles sur l’apparence des symboles d’accord.

Pour faire des changements globaux sur l’apparence par défaut des symboles d’accord, utilisez la

page Symboles d’accord de Style maison > Règles de gravure (expliqué en détails sur

page 123). Si vous souhaitez régler le texte d’accord ou le diagramme d’accord utilisé par un type

d’accord spécifique, utilisez Style maison > Modifier les symboles d’accord.

Les modifications effectuées dans Règles de gravure s’appliquent uniquement aux partitions sur

lesquelles elles sont effectuées et peuvent être transférées entre partitions par le biais de

l’exportation du style maison et son importation dans d’autres partitions (b 8.8 Style maison).

Au contraire, les changements effectués dans Style maison > Modifier les symboles d’accord
sont conservés dans une bibliothèque indépendante des fichiers de partition et les réglages dans

votre fichier bibliothèque sont utilisés à chaque fois que vous créez un symbole d’accord dans une

partition.

Choisir un symbole d’accord à modifier
Style maison > Modifier les symboles d’accord ressemble à ceci :

La liste des types d’accord du côté gauche de la boîte de dialogue est divisée en cinq catégories :

Accords fréquents, Plus d’accords majeurs, Plus d’accords mineurs, Plus d’accords de
dominante et Autres accords. La catégorie Accords fréquents contient environ 100 des types

d’accords les plus fréquents. Le reste, 500 plus ésotériques, est divisé entre les quatre autres

catégories. Pour modifier les réglages pour un type d’accord donné, sélectionnez-le simplement

dans la liste sur la gauche.
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Dans le coin supérieur gauche se trouve un champ dans lequel vous pouvez saisir un type d’accord

particulier pour le trouver plus rapidement dans la liste du dessous. Pour trouver un accord,

saisissez son extension directement sous forme de texte, en laissant de côté sa fondamentale (p.e.

“maj13#11”), et cliquez sur Aller à ; Sibelius sélectionne alors immédiatement le type d’accord

donné dans la liste.

Une fois que vous avez sélectionné un type d’accord, vous verrez les paramètres que vous pouvez

modifier, sous forme de groupes :

* Saisie de texte vous permet de définir un jeu de texte alternatif pour saisir un symbole

d’accord rapidement - cf. Modification des noms de saisie de texte ci-dessous.

* Texte d’accord vous permet de modifier l’apparence de chaque élément suffixe qui compose le

texte d’accord du symbole d’accord - cf. Modifier les suffixes de symboles d’accord ci-

dessous.

* Diagramme d’accord vous permet de choisir le diagramme d’accord par défaut que vous

souhaitez voir apparaître pour un type d’accord, vous permettant d’indiquer un diagramme

d’accord différent pour chaque accordage de guitare différent que vous appréciez - cf. Modifier
les diagrammes d’accord de guitare ci-dessous.

* Saisie MIDI vous permet de définir la combinaison de notes sur votre clavier MIDI que vous

jouez pour saisir un type d’accord – cf. Modification des voicings de saisie MIDI ci-

dessous.

Le bouton Importer vous permet d’importer les bibliothèques de symboles d’accord créés par

d’autres utilisateurs de Sibelius ou créés dans des versions antérieures de Sibelius - cf.

Importation des bibliothèques de diagramme d’accord ci-dessous.

Modification des noms de saisie de texte
Par défaut, vous saisissez un symbole d’accord en entrant une version simple sous forme de texte :

facile (et expliqué en détails sur page 117) ! Mais vous pouvez vous trouver face à des accords qui

requièrent une longue saisie, comme “13#11b9omit3”. En définissant un nom de saisie de texte

personnalisé, vous pouvez au contraire saisir “bob”, par exemple, pour obtenir ce symbole

d’accord.

Pour définir un nom de saisie de texte personnalisé, introduisez-le dans le champ Nom de saisie
de texte et cliquez sur Appliquer. Souvenez-vous que vous ne devriez pas saisir la note

fondamentale ici. Si le nom de saisie de texte défini est déjà utilisé par un autre type d’accord,

Sibelius vous avertit et vous propose de soit appliquer le nom personnalisé au nouveau type

d’accord ou de le laisse affecté à l’ancien.

Modification des voicings de saisie MIDI
La saisie de symboles d’accord via clavier MIDI est réellement très pratique (et expliquée en détails

à page 118). Sibelius comprend un voicing donné pour chaque type d’accord par défaut,

généralement la position fondamentale de toutes les notes de l’accord joué (et Sibelius interprète

les inversions correctement si vous jouez l’accord dans une inversion).

Une fois que vous aurez utilisé un bon moment un clavier MIDI pour introduire les symboles

d’accord, toutefois, vous pouvez préférer utiliser votre propre jeu de voicings personnalisés pour
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gagner un peu de temps. Par exemple, vous pouvez souhaiter que toutes les inversions d’une triade

majeure produisent un symbole d’accord en position fondamentale, de façon à ce que vous

puissiez passer entre différents accords proches sans trop déplacer votre main. Pour ce faire, vous

devriez définir les voicings en position fondamentale, première inversion et seconde inversion

pour le type d’accord triade majeure. (Si vous souhaitez ensuite saisir un accord majeur avec une

note de basse altérée, vous devriez le faire en jouant l’accord dans l’une des inversions avec une

main et jouez la note fondamentale désirée une octave au-dessous avec l’autre).

Vous pouvez aussi penser qu’il est encore plus facile de saisir avec des versions raccourcies : par

exemple, une dyade de tierce majeure pourrait introduire une triade, une dyade de tierce mineure

une triade mineure, une seconde majeure un accord de 9, une quinte diminuée un accord

diminuée, etc.

De la même manière, il existe de nombreux types d’accords composés des mêmes notes - p.e. DoØ7
et Dom7(b5) – et vous pouvez vous trouver face au fait que Sibelius traite un symbole d’accord

différent à celui que vous attendiez quand vous l’avez joué sur votre clavier MIDI. Pour éviter ceci,

trouvez le type d’accord que vous voulez afficher par défaut et paramétrez votre propre voicing

personnalisé : il peut être identique à celui existant si vous le souhaitez.

Pour créer un voicing de saisie MIDI personnalisé, cliquez Nouveau voicing, et cette boîte de

dialogue apparaît :

Jouez simplement les notes que vous voulez utiliser pour saisir le symbole d’accord comme si vous

jouiez l’accord sur une fondamentale de Do ; vous pouvez sinon cliquer sur les notes du clavier de

la boîte de dialogue. Par défaut, l’option Exécuter dans n’importe quelle octave est activée ; si

vous voulez pouvoir définir le même patron d’intervalles dans des octaves séparées pour la saisie

de symboles d’accord différents, désactivez cette option. Sibelius montre alors le numéro d’octave

de chaque note dans la lecture Notes de l’accord. Vous pouvez faire défiler verticalement par

octaves en cliquant sur les flèches du côté droit.

Quand vous enregistrez un voicing personnalisé pour un type d’accord donné, assurez-vous que

votre voicing soit le plus unique et spécifique que possible et surtout essayez de ne pas jouer la

même hauteur dans différentes octaves. Cela facilitera la tâche à Sibelius de façon à obtenir les

meilleurs résultats quand vous saisissez des symboles d’accord depuis un dispositif MIDI : plus le

voicing sera ambigu, plus il sera difficile pour Sibelius de choisir l’accord que vous cherchez.
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Une fois satisfait de votre voicing personnalisé, cliquez sur OK. Sibelius vous avertit si le voicing a

déjà été affecté à un autre type d’accord, vous permettant de choisir si vous préférez enregistrer le

nouveau type d’accord ou au contraire laisser l’ancien.

Pour modifier un voicing existant, cliquez Modifier voicing, qui affiche le dialogue suivant ; pour

effacer un voicing existant cliquez simplement sur Effacer voicing.

Modifier les suffixes de symboles d’accord
Si vous souhaitez changer l’apparence d’un composant de texte d’accord pour le symbole d’accord,

vous devriez d’abord vérifier si un réglage global peut être effectué sur la page Symboles d’accord
de Style maison > Règles de gravure qui vous évitera d’avoir à effectuer tout un tas de réglages

pour chaque type d’accord. Par exemple, si vous souhaitez toujours que l’élément “mineur” des

symboles d’accord soit représenté par, disons, . plutôt que par m, vous devriez effectuer cette

modification dans Règles de gravure – cf. Options des règles de gravure à la page 124.

Si vous souhaitez régler l’apparence d’un symbole d’accord donné, cliquez Modifier suffixe :

Le menu Elément suffixe en haut de la boîte de dialogue vous permet de choisir entre les éléments

suffixe qui composent le symbole d’accord en question. Dans l’exemple ci-dessus, vous pouvez

sélectionner entre Majeur 09/07/11/13, ce qui correspond à la partie 7 et les altérations
dièses, qui correspondent à la partie (#11). Selon votre choix d’élément suffixe, les choix dans le

reste de la boîte de dialogue seront mis à jour.

La liste Apparence des suffixes montre toutes les différentes apparences que Sibelius connaît

pour un élément suffixe donné. Pour modifier l’apparence utilisée, activez Apparence manuelle,

puis choisissez l’apparence désirée dans la liste. La prévisualisation sur la droite se met à jour pour

afficher la manière dont l’accord pourrait apparaître.

Les options sous Parenthèses vous permettent de voir quelle est l’apparence par défaut pour cet

élément suffixe en l’ajoutant au bouton radio Utiliser les règles de gravure ; il indiquera (avec
parenthèses) ou (sans parenthèses). Si vous souhaitez remplacer l’apparence, sélectionnez soit
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Placer le suffixe entre parenthèses ou Ne pas placer le suffixe entre parenthèses. Sibelius

sélectionne automatiquement les grandes ou les petites parenthèses le cas échéant.

Les optons Altérations/Extensions s’appliquent uniquement aux symboles d’accord avec au

moins deux extensions ou altérations et vous permettent d’indiquer si vous préférez qu’elles soient

empilées verticalement (p.e. [äÈ]) ou linéairement (p.e. (b13#11)). Comme pour les options de

Parenthèses, Sibelius vous indique si ces altérations sont empilées verticalement ou dessinées

linéairement par défaut, vous permettant ensuite de remplacer cette option en sélectionnant

Utiliser l’arrangement par piles ou Utiliser l’arrangement linéaire. Si l’arrangement linéaire

est utilisé, vous pouvez aussi indiquer si elles doivent l’être de manière ascendante ou descendante

de gauche à droite.

Activez Utiliser numéro d’extension de la ligne de base pour utiliser un grand chiffre de ligne de

base pour les types d’accord dont les extensions comportent un chiffre, par exemple, C7, C9, C11.

Tout changement effectué dans la boîte de dialogue Modifier le suffixe de l’accord évitera que

les changements effectués ensuite dans Règles de gravure n’aient un effet sur le symbole d’accord

de ce type dans votre partition.

Modifier les diagrammes d’accord de guitare
Quand vous créez un symbole d’accord, un diagramme d’accord apparaît par défaut si vous avez

créé le symbole d’accord sur une portée de notation de guitare ou d’un autre instrument à frettes,

bien que vous puissiez le changer si vous souhaitez - cf. Sélectionner quand les diagrammes
d’accords doivent apparaître à la page 120.

Le diagramme d’accord qui apparaît par défaut quand vous créez un symbole d’accord est

considéré comme le diagramme d’accord préféré. Il peut exister un diagramme d’accord préféré

pour chaque accordage de guitare ou instrument à frettes différent que Sibelius connaît, et pour

chaque combinaison de note fondamentale et note de basse. Vous pouvez voir ces diagrammes

préférés en changeant les menus Instrument, Fondamentale et Basse dans le groupe

Diagramme d’accord dans Modifier les symboles d’accord.

Pour changer un diagramme d’accord préféré, choisissez l’accordage, la note fondamentale et la

basse de guitare ou d’instrument à frettes approprié, puis cliquez Sélectionnez votre préférence,

qui affiche cette boîte de dialogue :
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En haut du dialogue, vous pouvez choisir quels diagrammes d’accord doivent être affichés :

* Diagrammes d’accord par défaut est un jeu de diagrammes d’accord choisi spécialement pour

la guitare à six cordes en accordage standard, pour la plupart des types d’accords fréquents. Il y a

généralement trois diagrammes d’accord pour chaque type d’accord : près du sillet, près de la

cinquième frette et près de la neuvième frette.

* Diagrammes d’accord de l’utilisateur affiche tous les diagrammes d’accord que vous avez

créé ou édité - en savoir plus.

* Diagrammes d’accord générés automatiquement affiche un (grand) nombre de

diagrammes d’accord que Sibelius a généré automatiquement pour ce type d’accord. L’option

Écartement max . n frettes détermine la distance maximale entre les frettes à jouer dans les

diagrammes d’accord générés ;  3 est la valeur par défaut mais si vous souhaitez générer un plus

grand nombre d’accords, vous pouvez augmenter ce numéro au prix de créer des accords plus

difficiles à jouer.

Le contrôle de prévisualisation sous les cases affiche les diagrammes d’accord. Une fois que vous

avez trouvé le diagramme d’accord que vous souhaitez convertir en diagramme de préférence pour

ce type d’accord, sélectionnez-le et cliquez sur OK. Si, toutefois, vous ne trouvez pas le diagramme

d’accord que vous cherchez, vous pouvez modifier un diagramme existant ou en créer un nouveau

qui réponde à vos besoins : sélectionnez le diagramme d’accord le plus proche à celui que vous

avez à l’esprit, puis cliquez Nouveau ou Edition. Dans tous les cas voici la boîte de dialogue qui

s’affichera :

Vous pouvez choisir si le diagramme doit être dessiné Horizontalement (comme ci-dessus, le

sillet du côté gauche) ou Verticalement (le sillet en haut). Vous pouvez désactiver le nombre de

frets par défaut sur le diagramme (comme indiqué sur la page Guitare de Style maison > Règles
de gravure) en basculant l’option Toujours affiché n frets par diagramme et en sélectionnant le

nombre de frets (de 3 à 15).

Pour ajouter un point à une corde, cliquez simplement sur la position désirée ; Maj-cliquez pour

faire défiler les formes de points disponibles (cercle noir, cercle blanc, losange noir, losange blanc,

diamant noir, diamant blanc). Pour supprimer un point, cliquez-droit sur le point que vous
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souhaitez supprimer. Pour ajouter un marqueur de corde à vide sur le sillet, cliquez simplement

sur la gauche ou en haut, selon le cas échéant ; cliquez de nouveau pour afficher une X (indiquant

que la corde ne doit pas être jouée). Pour retirer un O ou un X, cliquez simplement droit sur lui.

Vous pouvez aussi ajouter un numéro de doigt ou un nom de note sur un point en double-cliquant

dessus : un curseur clignotant apparaît. Saisissez le numéro ou la lettre que vous souhaitez voir

apparaître dans le point et cliquez-droit (Windows) ou Control-cliquez (Mac) pour voir un menu

texte, sur lequel vous pouvez sélectionner les altérations.

Au contraire, vous pouvez ajouter des numéros de doigté au-dessus ou au-dessous du diagramme

d’accord en double-cliquant sur les numéros en gris au bas de la fenêtre et en saisissant le numéro

désiré : pressez espace pour avancer à la corde suivante sans saisir de numéro puis pressez Ret.
arrière pour revenir à la corde antérieure.

Une fois satisfait de votre diagramme, cliquez sur OK. Le diagramme est ajouté automatiquement

à votre bibliothèque d’utilisateur et apparaîtra quand la case Diagrammes d’accord de
l’utilisateur sera cochée dans la boîte de dialogue Sélectionner un diagramme d’accord.

Si vous souhaitez modifier rapidement le diagramme d’accord appartenant à un symbole d’accord

existant dans votre partition, sélectionnez-le et choisissez Edition > Symbole d’accord > Modifier
le diagramme d’accord, ce qui fait apparaître la boite de dialogue ci-dessus. Tout changement

effectué au diagramme d’accord sera instantanément mis à jour sur la partition quand vous cliquez

OK.

Options des règles de gravure
La page Guitare de Style maison > Règles de gravure contient certaines options liées à la

tablature de guitare, expliqué à page 144, et certaines options pour le contrôle de l’apparence des

composants du diagramme d’accord pour les symboles d’accord (et les diagrammes de gamme de

guitare - b 2.16 Diagrammes de gammes guitare) :
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* Les options dans le groupe Présentation des diagrammes d’accord et de gamme vous

permet de modifier la taille par défaut des diagrammes d’accord. La manière la plus simple de le

faire est de manipuler le curseur Taille par défaut, qui modifie toutes les autres valeurs de

manière adéquate. Certains éditeurs aiment indiquer que le manche de la guitare continue au

delà de la dernière frette du diagramme en montrant que les cordes dépassent un peu de la

dernière ligne de frette ; si vous souhaitez émuler cette édition, Étendre les cordes de n

espaces sous le diagramme, et réglez-le à votre gout.

* Les options de Numéro de frette vous permettent de choisir si vous souhaitez que l’étiquette de

texte de la première frette du diagramme d’accord ou de la gamme si elle commence à mi-

chemin sur le manche (p.e. “5fr”) apparaisse sur À gauche/en bas ou À droite/en haut (par

défaut).

* Texte d’accord de n espaces au-dessus du diagramme vous permet d’indiquer l’espace entre

le haut du diagramme d’accord et le bas du texte de l’accord sur le dessus.

* Afficher le texte de doigté détermine si le doigté doit être affiché Sous le diagramme (réglage

par défaut) ou Au-dessus du diagramme. Si le doigté est affiché au-dessus du diagramme, des

lignes sont utilisées avec les symboles O et X. Les doigtés sont prioritaires par rapport aux symboles

O et X, de sorte que si un doigté et un O ou un X apparaissent ensemble sur la même corde, seul le

doigté sera affiché.

* Texte de doigté à n espaces de distance du diagramme détermine la distance depuis le haut

ou le bas du diagramme d’accord à laquelle s’affichera le texte de doigté (par défaut, la valeur est

de 0,5 espace). Si le texte de doigté est réglé au-dessus du diagramme, ce paramètre modifie

aussi la distance des symboles O et X depuis le cadre, pour garantir que le doigté apparaît aligné

avec les symboles.

* Afficher les hauteurs de notes du côté gauche (désactivé par défaut) est pratique pour les

diagrammes d’accord et de gamme horizontaux et étiquette l’extrémité gauche de chaque corde

avec le nom de la note.

* Frettes numéro 3e, 5e, 7e, 9e, 12e (activé par défaut) affiche les numéros des frettes sous les

diagrammes d’accord et de gamme.

Modification des polices utilisées dans les diagrammes d’accord
Vous pouvez changer davantage l’apparence des diagrammes d’accord de manière subtile en

réglant la police, le style (p.e. gras, italique) et la taille du point de différentes parties du texte

utilisé. Choisissez Style maison > Modifier les styles de texte et modifier les textes de style

suivants :

* Doigté des diagrammes d’accord modifie les numéros des doigtés au-dessus ou au-dessous

d’un diagramme d’accord.

* Frette des diagrammes d’accord modifie le texte “5fr” qui apparaît sur la droite d’un

diagramme d’accord.

* Numéros des frettes des diagrammes d’accord modifie les numéros de frettes sous le

diagramme horizontal.

* Noms des cordes des diagrammes d’accord modifie les noms des cordes sur la gauche d’un

diagramme horizontal.
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Soyez prudents dans les choix que vous effectuez pour ces styles de texte, en particulier pour la

taille des points : Sibelius ne redimensionne pas automatiquement le diagramme et ce même si

vous avez doublé la taille des numéros de doigté.

Importation des bibliothèques de diagramme d’accord 
Vous pouvez importer des bibliothèques de symboles d’accord créées dans Sibelius 6 ou de

bibliothèques de diagrammes d’accord créées dans Sibelius 3, 4 ou 5. Le contenu de n’importe

quelle bibliothèque importée peut être mélangé avec celui de votre bibliothèque de symbole

d’accords existante. L’importation d’une bibliothèque de symboles d’accord n’ajoute ni ne retire

aucun types d’accords : elle vous permet simplement de modifier l’apparence de types d’accord

individuels, de modifier les diagrammes d’accord disponibles pour chaque type d’accord et de

modifier les noms de saisie de texte et les voicings de saisie MIDI.

Pour commencer, sélectionnez Style maison > Modifier les symboles d’accord et cliquez

Importer pour ouvrir la boîte de dialogue Importer une bibliothèque d’accords.

Pour importer une bibliothèque de symboles d’accord de Sibelius 6, sélectionnez Indiquer
l’emplacement d’une bibliothèque de symboles d’accord de Sibelius 6 (.xml) et cliquez

Parcourir pour choisir le fichier. Vérifiez les options dans le groupe Bibliothèques de symboles
d’accord de Sibelius 6 du côté droit ; Elles sont facilement compréhensibles et vous permettent de

choisir les données à importer de la bibliothèque et de savoir quoi faire en cas de conflits avec les

données de votre bibliothèque. Une fois que vous êtes satisfait de vos choix, cliquez sur OK pour

terminer l’importation.

Si vous disposez d’une version antérieure de Sibelius sur votre ordinateur, Sibelius 6 localisera

automatiquement toutes vos bibliothèques de diagrammes d’accord pour cette version et les

ajoutera à la liste dans Sélectionnez une bibliothèque de diagrammes d’accord dans une
version précédente. Si votre bibliothèque n’est pas dans la liste, sélectionnez Indiquer
l’emplacement d’une bibliothèque de diagramme d’accord pour une version antérieure
(.scl) et cliquez Parcourir pour sélectionner le fichier. Dans le groupe Bibliothèques de
diagrammes d’accord de Sibelius 3, 4 et 5 du côté droit, nous vous recommandons de choisir

Identifier les accords par nom ou hauteurs pour garantir que les diagrammes d’accord sont

importés le plus précisément possible. Cliquez sur OK pour terminer l’importation.
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8.14 Modifier les instruments

b 2.18 Instruments et portées, 2.29 Portées, 3.8 Noms d’instrument.

Même si Sibelius propose une liste exhaustive de plus de 400 instruments prédéfinis, on peut parfois

éprouver le besoin de modifier un type d’instrument utilisé dans une partition (par exemple pour une

combinaison spécifique de percussions sur une seule portée non proposée par Sibelius), ou, plus

rarement vouloir créer un type d’instrument qui n’existe pas dans la liste Créer > Instruments.

C’est très simple dans Sibelius grâce à Style maison  > Modifier les instruments. Tout

instrument nouveau ou modifié est sauvegardé dans la partition et peut être utilisé dans d’autres

partitions par exportation du style maison ou en le sauvegardant dans un papier à musique.

Boîte de dialogue Modifier les instruments
Style maison > Modifier les instruments permet de créer, de modifier et de supprimer des types

d’instruments, de les organiser en ensemble, un mot simple pour désigner les groupes

d’instruments présents dans la liste Choisir parmi de Créer > Instruments. Chaque ensemble

contient une ou plusieurs familles (qui sont normalement organisées d’après les familles

d’instruments comme par exemple les Cuivres, Vents, Cordes, etc.) et chaque famille contient un

ou plusieurs instruments.

Si une partition est ouverte, choisissez Style maison > Modifier les instruments. Conseil utile : si

vous sélectionnez une mesure dans une portée avant de choisir Modifier les instruments,

Sibelius sélectionnera automatiquement le type d’instrument approprié dans la boîte de dialogue :

Parcourons cette boîte de dialogue de gauche à droite :

* La liste Ensembles à gauche énumère tous les ensembles utilisables pour la partition en

cours ; la liste juste à droite Familles par ensemble énumère les familles dans l’ensemble

sélectionné ;

* Instruments d’une famille énumère les instruments disponibles dans la famille sélectionnée ;
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* Enfin, Instruments hors de l’ensemble énumère tous les instruments qui sont définis pour la

partition mais qui ne figurent dans aucune des familles de l’ensemble sélectionné. L’intérêt c’est

de pouvoir régler vos propres ensembles contenant uniquement les instruments que vous

utilisez. (Notez que l’ensemble Tous les instruments doit toujours contenir tous les

instruments définis dans la partition.)

Toutes les partitions Sibelius contiennent plusieurs ensembles prédéfinis (cf. Créer des
instruments à la page 150 pour en obtenir une liste), et il est impossible de les renommer ou de

les supprimer ; cependant, vous pouvez en changer les familles et les instruments.

Créer et supprimer un ensemble
Il n’est pas nécessaire de créer un ensemble pour créer un nouvel instrument ou pour en modifier

un existant, mais si vous utilisez souvent la même combinaison d’instruments ou que vous avez

des exigences précises sur l’ordre dans lequel les instruments doivent apparaître verticalement

dans la partition, créer son propre ensemble avec autant d’instruments que nécessaire et dans

l’ordre de votre choix peut être une solution adaptée.

Pour créer un nouvel ensemble :

* Sélectionnez un ensemble dans la liste Ensembles qui servira de base à votre nouvel ensemble

* Cliquez sur Nouvel Ensemble ; Sibelius vous demandera si vous voulez créer un nouvel

ensemble à partir de celui-là ; cliquez sur Oui.

* Une simple boîte de dialogue apparaîtra dans laquelle vous pouvez donner un nom à votre

ensemble ; entrez un nom et cliquez sur OK.

Pour supprimer un ensemble créé, sélectionnez-le dans la liste Ensembles et cliquez sur

Supprimer Ensemble ; à la demande de confirmation de suppression, cliquez sur Oui.

Créer et supprimer une famille
Pour créer une nouvelle famille dans un ensemble :

* Choisissez l’ensemble dans la liste Ensembles, puis cliquez sur Nouvelle famille

* Dans la boîte de dialogue qui apparaît, entrez le nom de la nouvelle famille, puis cliquez sur OK

* La nouvelle famille est vide par défaut

* Déplacez la famille dans la liste des familles existantes avec les boutons Vers le haut et Vers le
bas sous la liste Familles dans l’ensemble. L’ordre des familles est important car il détermine

l’ordre vertical par défaut quand les instruments sont créés dans la partition ; si la famille

Cuivres est au-dessus de la famille Cordes, alors tout instrument ajouté dans la partition dans la

famille Cuivres sera positionné au-dessus de tout instrument ajouté dans la famille Cordes.

Pour renommer une famille, sélectionnez-la et cliquez sur Renommer une famille, puis entrez le

nouveau nom dans la boîte de dialogue qui apparaît et cliquez sur OK. Pour supprimer une

famille, sélectionnez-la et cliquez sur Supprimer une famille ; après un avertissement elle sera

supprimée.
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Ajouter et enlever des instruments existants
Pour ajouter des instruments (qui ont déjà été définis) dans une famille :

* Trouver l’instrument ou les instruments que vous voulez ajouter dans la liste Instruments hors
de l’ensemble et sélectionnez-le. Notez qu’il est impossible d’ajouter le même instrument à plus

d’une famille dans le même ensemble, de sorte que si l’instrument est déjà dans une autre

famille, il n’apparaîtra pas dans la liste Instruments hors de l’ensemble. (Vous pouvez

cependant créer un nouvel instrument à partir d’un instrument existant pour que des

instruments identiques apparaissent dans différentes familles.)

* Cliquez sur Ajouter à une famille pour déplacer le(s) instrument(s) sélectionné(s)o de la liste

Instruments hors de l’ensemble dans la liste Instruments d’une famille.

* Déplacer le(s) instrument(s) vers le haut ou vers le bas dans la liste avec les boutons Vers le
haut et Vers le bas sous la liste Instruments d’une famille. Comme l’ordre des familles, l’ordre

des instruments établi ici détermine l’ordre des instruments créés dans la partition.

Pour enlever des instruments d’une famille, il suffit de les sélectionner dans la liste Instruments
d’une famille et de cliquer sur Enlever d’une famille (ou pour enlever tous les instruments d’une

famille, il suffit de supprimer la famille elle-même).

Créer, modifier et supprimer des instruments
Vous pouvez seulement supprimer un instrument à la fois s’il n’est pas utilisé dans la partition et

s’il n’est pas un des types d’instrument prédéfinis inclus dans toutes les partitions – Sibelius

n’activera le bouton Supprimer un instrument que si les instruments sélectionnés peuvent être

supprimés.

Vous pouvez modifier un instrument existant en le sélectionnant soit dans la liste Instruments
d’une famille ou dans celle Instruments hors de l’ensemble, puis en cliquant sur Modifier
l’instrument. Si l’instrument est utilisé dans la partition, vous serez averti que modifier

l’instrument peut changer la présentation de la partition ; cliquez sur Oui pour réaliser l’opération.

Pour créer un type d’instrument entièrement nouveau, sélectionnez l’instrument existant qui

ressemble le plus à celui que vous souhaitez créer, puis cliquez sur Nouvel Instrument. À la

question de savoir si vous souhaitez faire l’opération, cliquez sur Oui.
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Que vous modifiez un instrument existant ou en créiez un nouveau, voici la boîte de dialogue :

Les options de Nom permettent de déterminer les trois formes de nom d’instrument utilisées dans

Sibelius :

* Langue ne peut être modifiée à moins que vous utilisiez une version localisée (langue autre

qu’anglaise) de Sibelius. Dans les versions localisées, vous pouvez choisir entre afficher les noms

d’instruments en anglais ou dans la langue de votre exemplaire de Sibelius, mais dans les

versions anglaises, Langue est toujours réglé sur Anglais.

* Nom dans les boîtes de dialogue est le nom qui apparaît dans Style maison > Modifier les
instruments et Créer > Instruments. Ces noms peuvent être plus descriptifs que ceux qui

apparaissent dans la partition elle-même, pour par exemple décrire une transposition

inhabituelle ou le fait que l’instrument n’affiche pas d’armure.

* Nom complet dans la partition est le nom par défaut qui apparaît à gauche de la portée,

d’habitude sur le premier système et au début des nouvelles sections – b 3.8 Noms
d’instrument.

* Nom abrégé dans la partition est le nom par défaut qui apparaît à gauche de la portée après le

premier système de la partition.

* Nom de changement d’instrument est le nom figurant au-dessus de la portée à l’endroit où

vous créez un changement d’instrument ; par défaut, il est identique au Nom complet dans la
partition.
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* Nom d’avertissement de changement d’instrument est le nom figurant au-dessus de la

portée si vous choisissez de créer un avertissement avant un changement d’instrument ; par

défaut, il est identique au Nom abrégé dans la partition.

Si vous voulez utiliser des caractères de police de texte musical dans la partition, par exemple pour

le symbole bémol à placer dans un nom tel que “Clarinette en Sib”, tapez sur la touche accent

circonflexe (^) avant les caractères qui correspondent à bémol (lettre b) et à dièse (symbole #) – il

est en effet possible d’utiliser les codes de formatage énumérés dans Ajouter des
changements de format dans les infos sur la partition à la page 291.

Les options dans le groupe Options de notation déterminent le comportement de la ou des

portées dans la partition :

* Choisissez le Type de portée :

% Les instruments à sons déterminés peuvent avoir soit une portée (p.e. flûte, clarinette,

violon) ou deux portées (p.e. piano, harpe, célesta, marimba) ; régler le Nombre de portées
de manière adéquate

% Les instruments à sons indéterminés (p.e. les sets de batterie, les woodblocks) ne peuvent

recevoir qu’une seule portée, et il est impossible d’en régler les options Clé pour les sons
transposés, Tessiture ou Transposition

% Les instruments à Tablature (p.e.. la guitare, le luth, le dulcimer) ne peuvent recevoir qu’une

seule portée, mais contrairement aux instruments à sons indéterminés, et comme pour les

instruments à sons indéterminés, il est impossible d’en régler Clé pour les sons transposés,

Tessiture ou Transposition

* Activez Portée vocale si l’instrument exige normalement des paroles ; cette option détermine

plusieurs comportements spéciaux, comme assurer des nuances figurant au-dessus de la portée

(tel que défini dans Style maison > Positions par défaut – b 8.12 Positions par défaut),

de même que des multiplets (b 2.35 Triolets et autres multiplets), et autoriser plus

d’espace entre les portées pour faire de la place aux paroles (b 8.10 Espacement des
portées).

* Pour modifier les propriétés de la portée utilisée par l’instrument, cliquez sur Modifier le type
de portée – cf. Modifier le type de portée ci-dessous 

* Clé pour les sons réels détermine la clé normale à utiliser. Pour un instrument à sons

déterminés à deux portées comme par exemple le piano, c’est la clé utilisée sur la portée

supérieure. Cliquez sur Choisir pour déterminer la clé – b 2.11 Clés s’il vous faut de l’aide à

ce sujet.

* Clé pour les sons transposés détermine la clé utilisée par un instrument à sons déterminés

d’une seule portée qui est transpositeur et dont l’intervalle de transposition est suffisamment

grand pour qu’il soit justifié d’utiliser une clé différente pour les sons transposés de celle pour les

sons réels (par exemple pour des cuivres graves et des instruments à vent). Pour utiliser cette

option, activez Clé pour les sons transposés, puis cliquez sur Choisir pour déterminer la

clé ; c’est celle utilisée quand Notes > Partition transposée est activé. Cette option n’est pas

disponible pour les instruments à sons déterminés à deux portées et pour ceux à sons

indéterminés ou à tablature.
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* Clé pour la seconde portée détermine la clé à utiliser pour la portée inférieure d’un

instrument à sons déterminés de deux portées, par exemple la clé de fa pour la main gauche du

piano. Cliquez sur Choisir pour déterminer la clé.

* Crochet avec détermine si Sibelius installe le crochet de l’instrument quand il est créé dans la

partition. Sibelius suit les conventions habituelles qui régissent la manière d’installer les crochets

par famille d’instruments. La liste présentée ici ne reflète pas les familles d’un ensemble

spécifique (parce qu’elles peuvent être différentes selon les ensembles dans la partition) mais

énumère plutôt les familles d’instrument standard. Donc si vous voulez par exemple que

l’instrument soit uni avec un crochet aux autres instruments à cordes, choisissez Cordes.

Soyez attentif cependant au fait que l’option Crochet avec ne détermine pas l’ordre selon lequel

les instruments sont créés dans la partition ; celui-ci est déterminé par l’ordre des instruments

dans les familles et l’ordre des familles elles-mêmes dans l’ensemble. L’instruction ici consiste à

connecter avec un crochet tout nouvel instrument créé avec un autre qui possède le même

réglage de Crochet avec. Petit détail supplémentaire : les instruments à sons déterminés de

deux portées (p.e. le piano) reçoivent toujours une accolade et ne sont jamais connectés aux

autres instruments avec des crochets.

Les options sous Tessiture sont utilisées par Sibelius pour afficher les notes en rouge quand

Affichage > Couleurs de note > Notes hors tessiture est activé (cf. Couleurs de note à la

page 521). Vous pouvez régler uniquement la tessiture pour les instruments à sons

déterminés ; pour les instruments à tablature, la tessiture est décrite par les hauteurs de corde

définies dans le type de portée d’instrument.

Les options sous Transposition permettent de régler la manière dont les instruments

transpositeurs transposent :

* Les instruments parfois référencés avec une tonalité spécifique comme par exemple les

clarinettes en La/Sib, ou les familles d’instruments identiques si ce n’est la taille et qui sont dans

différentes tonalités, par exemple les saxophones alto/ténor, ou (si le dix-neuvième siècle vous

fascine) les cors à tons de rechange, ces instruments transposent quand Notes > Partition
transposée est activé. Pour ces types d’instruments, réglez les listes déroulantes sous Partition
transposée de manière appropriée ;  par exemple, pour une clarinette en la, réglez le La sur

octave 3, parce que le do central écrit d’une clarinette en la sonne comme le la sous do moyen

(Do moyen = Do4). Do moyen = C4.

* L’option de Partition non transposée est requise pour les instruments tels que le piccolo, la

contrebasse et la voix de ténor, qui sont habituellement écrits une octave plus haut ou plus bas

qu’ils ne sonnent, même dans les partitions non transposées. L’option vous laisse déterminer à

quelle octave sonnent ces instruments. Comme tous ces instruments sont prédéfinis

automatiquement, en principe il ne faut pas s’en soucier dans des circonstances normales.

Cependant (prenons une grande inspiration), si vous utilisez cette option, et que vous voulez

donner à l’instrument un signe de 8 ou de 15, rappelez-vous que Sibelius ne prend pas en

compte ces petits symboles car ils sont optionnels ; l’information concernant l’octave jouée par

l’instrument dépend exclusivement du réglage présenté ici. En effet la transposition d’octave est

une propriété de l’instrument (p.e. le piccolo), et pas de la clé.
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Les options sous Réglages d’exécution par défaut indique à Sibelius comment exécuter ce qui

est écrit pour l’instrument :

* Meilleur son est le son ID qui décrit aussi spécifiquement que possible le son que l’instrument

produit. Il faut penser cela en termes de sons produit réellement par l’instrument plutôt qu’en

son spécifique pour un périphérique de lecture. Pour en savoir plus sur les sons ID,

b 4.18 SoundWorld™.

* Panoramique est la position panoramique par défaut de l’instrument ajouté dans la partition ;

-100 est complètement à gauche et 100 est complètement à droite

* Distance est la distance entre l’instrument et l’auditeur qui détermine la valeur relative de

réverbération attribuée par défaut

* Volume spécifie le niveau de volume par défaut pour l’instrument que vous voulez ajouter à la

partition

* Type de glissando détermine si l’instrument jouera des glissandi soit en utilisant un glissando

Continu (avec le pitch bend), soit des notes discrètes (Touches noires, Touches blanches,

Chromatique), ou ne les jouera pas (Aucun).

Les options du groupe Symboles d’accord sont détaillées dans :

* L’option individuelle dans le groupe Symboles d’accord, Instrument à tablature à utiliser pour

les accordages de guitare, vous permet de spécifier l’instrument à tablature le plus proche à

l’instrument que vous définissez. Cela sert à déterminer l’accordage des diagrammes d’accord

dans le cadre des symboles d’accord (cf. Sélectionner quand les diagrammes d’accords
doivent apparaître à la page 120) et comment afficher des notes dans la fenêtre de Grille

d’accord (b 1.8 Fenêtre Manche).

* Afficher le diagramme d’accord de guitare par défaut vous permet de spécifier que certains

instruments ne doivent pas afficher de diagramme d’accord, même si cela aurait été

normalement le cas à partir des réglages effectués via la page Symboles d’accord de Style
maison > Règles de gravure. Par défaut, cette option est désactivée pour les basses, mais est

activée pour tous les autres types de guitares.

Dès que vous avez terminé, cliquez sur OK pour confirmer les changements.

Si vous avez créé un nouvel instrument, il sera automatiquement ajouté à l’ensemble Tous les
instruments, dans la même famille que l’instrument sur lequel vous vous êtes appuyé pour le

réaliser.

Modifier le type de portée
Quand vous cliquez sur Modifier le type de portée dans une des boîtes de dialogue Nouvel
instrument ou Modifier l’instrument, vous verrez s’afficher une boîte de dialogue formée des

deux ou trois pages suivantes : Lire les pages :

* Général s’applique à tous les types d’instruments; on peut y régler le nombre de lignes de

portées, etc.

* Notes et silences s’applique aussi à tous les types d’instruments ; on peut y régler l’orientation

des hampes, leur longueur, etc.
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* Percussion est seulement disponible pour les instruments à sons indéterminés, et permet de

spécifier l’attribution des têtes de note aux différentes percussions

* Tablature est seulement disponible pour les instruments à tablature et permet de spécifier la

hauteur de chaque corde, etc.

Les options de chaque page sont décrites ci-dessous.

La page Général

* Nombre de lignes de portée permet de choisir le nombre de lignes pour la portée (ou de

cordes pour une tablature)

* Espace entre les lignes de portée permet de changer la distance entre les lignes de portée, et

donc la hauteur de la portée. Notez cependant que changer ce paramètre ne transforme pas les

autres objets en les agrandissant ou en les rapetissant en fonction de la nouvelle hauteur; dès lors

il vaut mieux éviter de changer ce paramètre à moins de rechercher un effet très spécifique (sur

les méthodes appropriées pour changer la taille d’une portée, b 2.29 Portées.)

* Crochet contrôle si les crochets et/ou les accolades s’affichent au début de la portée

* Clé initiale agit sur la clé au début de chaque système, et pas simplement sur la clé en début de

partition. Les “Lead sheets” et les parties de fanfare omettent souvent les clés sur la plupart des

systèmes.

* Armures/Accordage détermine si les armures et les accordages de guitare apparaissent sur la

portée. De nouveau c’est souvent omis dans les “Lead sheets” et les parties de fanfare.

* Étirer de n espaces d’interligne au-dessus de la ligne médiane de la portée détermine

jusqu’à quelle distance au-dessus de la ligne médiane de la portée la barre de mesure devra

s’étirer. Dans le cas d’une portée à 5 lignes, le réglage doit être 2 pour que la barre de mesure

s’étire jusqu’à la ligne supérieure de la portée.
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* Étirer de n espaces d’interligne sous la ligne médiane de la portée détermine jusqu’à

quelle distance en dessous de la ligne médiane de la portée la partie inférieure de la barre de

mesure devra s’étirer. Vous pouvez utiliser des nombres négatifs pour raccourcir la partie

inférieure de manière à ce qu’elle ne dépasse pas la ligne médiane de la portée.

* Barre de mesure initiale détermine si la barre de mesure initiale s’affiche au début de chaque

système. (Cette option ne détermine pas la présence d’une barre de mesure initiale sur un

système formé d’une seule portée; vous pouvez contrôler cela dans la page Barres de mesure de

la boîte de dialogue Style maison  > Règles de gravure.)

* Barres de mesure contrôle s’il y a ou non des barres de mesures sur la portée.

Page Notes et silences

* Rythme (hampes, ligatures, liaisons, etc.) contrôle les hampes et crochets de hampe et les

points de rythme. En général c’est désactivé pour les types de portée en tablature dont les

rythmes ne sont pas indiqués (d’habitude une autre portée en notation normale affiche le

rythme).

* Mesures de silence peut être désactivé si vous ne voulez pas que des mesures de silence

apparaissent sur une portée spécifique. Cette option devrait être désactivée si Rythme est aussi

désactivé.

* Articulations toujours au-dessus de la portée s’utilise pour des portées de chant et des

portées de percussion à une ligne ; placer les articulations au-dessus des portées permet d’éviter

les collisions par exemple avec les paroles

* Ligatures toujours horizontales oblige toutes les ligatures à être au même niveau. C’est

particulièrement utile dans les partitions pour percussion, et c’est souvent utilisé dans certains

styles de tablature qui affichent les rythmes avec des hampes et des ligatures à l’extérieur de la

portée.
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* Lignes supplémentaires détermine s’il y a des lignes supplémentaires quand des notes se

trouvent au-dessus ou en dessous de la portée. C’est toujours désactivé dans les portées de

percussions.

* Les options de Longueurs des hampes permettent de déterminer si les hampes sont de

longueur normale (le réglage par défaut pour la majorité des portées), ou si elles doivent

s’étendre en dehors de la portée (ce qui s’utilise dans les types de portées de tablature affichant le

rythme).

* Si Prolonger les hampes en dehors de la portée est activé, vous pouvez choisir si les hampes

doivent apparaître entièrement hors de la portée (c’est-à-dire ne pas s’étendre sur le numéro/la

lettre de frette ou sur la tête de note) en activant Ne dessiner la hampe qu’en dehors de la
portée ; cette présentation s’utilise dans les tablatures de luth et certaines tablatures de guitare.

* Laisser l’espace pour n ligatures détermine de combien les ligatures peuvent être étendues en

dehors de la portée; par défaut la longueur est équivalente à trois ligatures, soit une triple croche.

L’option Laisser un espace supplémentaire est très utile pour déterminer la distance entre la

ligne de portée la plus éloignée et le point le plus à l’intérieur de la hampe placée au-dessus ou en

dessous de la portée si Ne dessiner la hampe qu’en dehors de la portée est activé.

* Les options de Hampes de note dans une seule voix détermine si les hampes des notes sur la

ligne médiane dans une seule voix s’orientent vers le bas (ce qui est l’usage pour la plupart des

types de portée) ou vers le haut (ce qui est la convention pour les portées de percussion d’une

ligne), ou si toutes les hampes d’une portée s’orientent vers le bas (ce qui est la convention pour

les tablatures de banjo) ou vers le haut (ce qui est la convention pour la plupart des tablatures de

guitare et de luth ainsi que pour les partitions de cornemuse). Quand il y a deux voix ou plus, ces

réglages sont ignorés et les hampes s’orientent selon leur voix de la manière normale.

* Les options sous Positions des silences permettent de déterminer comment les silences seront

positionnés sur cette portée.

Normalement, les pauses de mesure se placent sur la seconde ligne de portée d’une portée à 5

ligne, en réglant Distance des pauses de mesure à partir de la ligne médiane n espaces
d’interligne sur 1 ; si on change cette valeur par une valeur supérieure à 0 la position est au-

dessus de la ligne médiane, si la valeur est négative la position est sous la ligne médiane.

Les autres silences sont (pour faire vite) centrés sur la ligne médiane de la portée, le réglage de

Distance des autres silences à partir de la ligne médiane n espaces d’interligne étant sur

0, ce qui peut être modifié.

Vous pouvez aussi ajuster les positions des silences déplacés, c’est-à-dire des silences déplacés de

leur position normale à cause de la présence de notes ou de silences dans une autre voix. Sibelius

déplacera seulement automatiquement les notes et les silences dans les voix 1 et 2. Notez que,

par exemple, les pauses de mesure déplacées de la voix 1 s’accrochent à la ligne supérieure de la

portée, et celles de la voix 2 s’accrochent à la quatrième ligne de la portée.
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Page Percussion

* La représentation de la portée affiche représente la table d’assignation des percussions sur la

portée (cf. Instruments à sons indéterminés à la page 180) – Notez que vous pouvez régler

les différentes têtes de note, ou la même tête de note avec différentes articulations, pour produire

différents sons sur la même ligne ou le même entreligne

* Pour enlever une tête de note existante, sélectionnez-la (en cliquant dessus) et cliquez sur

Supprimer

* Pour changer une tête de note, sélectionnez la tête de note que vous voulez changer, puis utiliser

le menu déroulant Tête de note pour choisir l’aspect souhaité

* Pour ajouter une articulation à la tête de note, utilisez le menu déroulant Articulation

* Le son utilisé par la tête de note sélectionnée est affiché soit comme son ID (p.e.

unpitched.wood.high.woodblock) ou comme son de percussion présent sur un périphérique

spécifique (p.e. High Woodblock), en fonction de l’option Affichage de la page Exécution de

Fichier > Préférences (dans le menu Sibelius sur Mac) réglée soit sur Son ID ou Nom de
programme (cf. Préférences d’exécution à la page 380).

Pour changer le son utilisé par la tête de note sélectionnée, cliquez sur le bouton Choisir un son.

Si vous travaillez avec des sons ID, vous verrez un menu hiérarchique des sons ID indéterminés,

dans lequel vous choisirez le son ID qui correspond le mieux au son que vous voulez entendre.

Grâce à son système SoundWorld, Sibelius choisira le meilleur son disponible pour l’exécution

(b 4.18 SoundWorld™).

Si en revanche vous travaillez avec les noms de programme, vous verrez un menu hiérarchique

dans lequel chaque jeu de sons de votre configuration d’exécution active figure en premier

niveau, les programmes de percussions en deuxième niveau et finalement chaque nom

d’instrument à percussion en troisième niveau. Notez qu’il faut éviter de choisir des sons de

différents programmes dans le même type de portée, car Sibelius peut seulement utiliser un seul

programme de percussion pour exécuter tous les sons requis pour un instrument donné.
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* Pour ajouter une nouvelle tête de note, choisissez la tête de note et le son souhaité dans les listes

Tête de note, Articulation et Son puis cliquez sur Nouveau. Le pointeur de la souris va

changer de couleur ; cliquez ensuite sur la portée pour placer la nouvelle tête de note.

* Si pour écrire les notes d’un set de batterie vous utilisez la saisie pas-à-pas ou Flexi-time, vérifiez

que le réglage pour chaque tête de note dans le menu Saisie en jouant la note correspond à la

touche enfoncée sur le clavier MIDI pour produire le même son (cf. Saisie des notes pour
les percussions à sons indéterminés à la page 181)

* Quand vous ajoutez une nouvelle tête de note à la table d’assignation, les réglages par défaut de

Saisie en jouant la note sont notés comme s’il s’agissait d’une portée en clé de sol. Si une tête

de note est déjà présente sur la ligne ou sur l’interligne, Sibelius ajoutera un dièse à la note.

Page Tablature

* Pour changer l’accordage d’une corde, cliquez sur la corde dans la grande fenêtre au-dessus de la

boîte de dialogue, puis choisissez la nouvelle note dans le menu du dessous Hauteur de note

* Vous pouvez spécifier si la note doit être jouée avec un dièse ou avec un bémol (ce que

nécessitent certains accordages inhabituels) en sélectionnant le bouton adéquat

* Si vous devez changer le numéro des cordes, cliquez sur l’ongle Général et changer le numéro

des cordes, puis revenez à la page Tablature pour changer l’accordage

* Les options de Notes de tablature détermine si la portée de tablature va Utiliser des chiffres
(ce qui est la convention pour les tablatures de guitare) ou Utiliser des lettres (ce qui est la

convention pour les styles de tablature de luth) ; Installer des notes entre les lignes de
portée ou non (sur les lignes est la convention pour les tablatures de guitare, entre les lignes est

la convention pour les styles de tablature de luth) ; si les lettres et les chiffres doivent être mis sur

fond blanc (ce qui est utile dans les portées de tablature pour les types de portée qui affichent le

rythme) ; et si les hampes doivent figurer entre les notes dans les accords (par défaut, les hampes

s’étirent tout le long des notes d’un accord, mais dans certains styles de tablature rythmique elles

ne s’écrivent que jusqu’à la première note atteinte).
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8.15 Modifier les lignes

b 2.21 Lignes, 2.28 Liaisons de phrasé, 8.8 Style maison.

Utilisateurs avertis uniquement 

Sibelius permet de modifier l’aspect des lignes et, en modifiant celles existantes, de créer vos

propres lignes. Si une ligne existante est modifiée, tous les changements réalisés affecteront toutes

les occurrences de cette ligne déjà présentes dans la partition, ainsi que toutes celles à venir.

Modifier une ligne
Pour modifier une ligne, choisissez Style maison > Modifier les lignes. Une fois la ligne

sélectionnée dans la liste, vous pouvez soit la Modifier, la Supprimer (si c’est une ligne que vous

avez créée vous-même) ou à partir d’elle, créer une nouvelle ligne en cliquant sur Nouveau.

Créer une nouvelle ligne doit se faire en prenant comme base une ligne déjà existante ayant des

caractéristiques de positionnement et d’exécution similaires à la nouvelle; par exemple, pour créer

une ligne qui doit s’exécuter comme un trille, il faut partir de la ligne “trille” existante.

Cliquer sur Modifier fait apparaître une boîte de dialogue dans laquelle peuvent se modifier les

caractéristiques des ligne.

En général, une ligne est formée de cinq éléments:

* Un début optionnel, qui est soit un symbole (tel que “Ped”), soit un objet textuel (tel que “1. 2.”)

plus éventuellement une terminaison, par exemple une tête de flèche ou une courte ligne à angle

droit appelée “crochet”, comme celui utilisé dans la ligne “première fin” (prima volta)

* La ligne proprement dite, qui peut être continue, pointillée, discontinue ou sinueuse, de

différentes épaisseurs et de direction soit horizontale soit diagonale

* Du texte optionnel le long de la ligne, par exemple gliss.

* Un symbole de prolongement optionnel, qui apparaît au début d’un nouveau système quand la

ligne commencée au système précédent s’y prolonge, par exemple (8) pour une ligne d’8va
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* Une fin optionnelle; comme pour le début, ce peut être un symbole, un crochet ou une flèche.

La manière de modifier les cinq éléments d’une ligne est assez explicite dans la boîte de

dialogue.Voici cependant quelques explications:

* Les options de Ligne contrôlent l’apparence de la ligne elle-même:

% Style: spécifie si la ligne est continue, pointillée, discontinue ou sinueuse

% Trait: détermine la longueur du trait pour les lignes discontinues

% Espace: détermine la longueur de l’espace entre les traits d’une ligne discontinue ou entre les

points d’une ligne pointillée

% Horizontal: contraint la ligne à être horizontale (par exemple pour un trille)

% Optimiser l’affichage: optimise (anti-crénelage) la manière dont la ligne apparaît à l’écran,

sans en affecter la qualité d’impression (Sibelius imprime toujours de manière optimisée!); en

général, il vaut mieux laisser cette option activée

% A droite des symboles / texte: place l’extrémité gauche de la ligne juste après l’élément qui

forme le début de la ligne.

* Les options du Début définissent si la ligne commence par un symbole, un objet textuel et/ou

une terminaison.

% Aucun / Texte / Symbole est assez explicite. En cliquant sur le bouton Texte une boîte de

dialogue apparaît dans laquelle il suffit de taper le texte souhaité et d’en choisir le style et la

position par rapport à la ligne.

Pour positionner le texte à mi-hauteur, il faut donner une valeur de X dent en haut; avec le

style texte en petits caractères, une valeur de 0.5 dent est idéale.

% dents à droite / en haut détermine la position du symbole, du texte ou du crochet suivant

les valeurs entrées.

% Terminaison propose un crochet (et permet d’en définir le décalage par rapport à la ligne) ou

une flèche à partir d’une liste prédéfinie.

* Les options de Prolongement déterminent le comportement de la ligne si celle-ci continue au-

delà d’un système ou d’un saut de système:

% Symbole permet de choisir le symbole par lequel le prolongement commence

% dents à droite / en haut détermine la position du symbole optionnel suivant les valeurs

entrées

% Le bouton Texte définit le texte affiché le long de la ligne

* Les options de Fin sont similaires aux options de Début, sauf pour l’option texte qui n’est pas

proposée, puisqu’on ne termine pas une ligne avec du texte.

La prévisualisation affiche la ligne telle qu’elle apparaît lorsqu’elle est divisée sur deux systèmes de

manière à voir le prolongement aussi bien que le début, le milieu et la fin.

Voici une petite illustration de l’utilisation de cette boîte de dialogue: pour remplacer le symbole

habituel 8va placé au début d’une ligne d’octava (comme dans l’image ci-dessus) par un simple 8,

cliquez sur Sélectionner dans la section Début de la boîte de dialogue Modifier les lignes et

choisissez ce nouveau symbole dans la fenêtre symbole. Pour modifier le symbole de

Prolongement il suffit de procéder de la même manière.
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8.16 Modifier les têtes de note

b 2.25 Têtes de note, 2.30 Hampes et lignes supplémentaires.

Utilisateurs avertis uniquement 

Pour modifier l’aspect d’une tête de note ou pour en définir une nouvelle:

* Choisissez Style maison > Modifier les têtes de note

* Dans la boîte de dialogue qui apparaît, cliquez sur Nouveau... pour créer un nouveau type de

tête de note, ou sélectionnez l’un des types de la liste et cliquez sur Modifier pour le modifier.

(Vous pouvez aussi Supprimer les têtes de notes que vous auriez créées auparavant.)

La boîte de dialogue Tête de note qui apparaît ensuite permet de configurer tous les aspects de la

tête de note:

* Nom: est le nom du type de tête de note (c’est une donnée sans grande importance)

* Joue: détermine si le type de tête de note est exécuté. Par défaut, certaines têtes de note (par

exemple les barres obliques) ne sont pas exécutées

* Altération: cette case doit être décochée si on souhaite que les têtes de note ne puissent pas

recevoir d’altérations (par exemple les têtes de note en forme de barres obliques)

* Transpose: détermine si la tête de note est transposée (dans les cas par exemple où la

commande Notes > Partition transposée est activée, lors d’une transposition ou durant

l’extraction des parties séparées). Par défaut, certaines têtes de note (par exemple les barres

obliques) ne sont pas transposées

* Lignes supplémentaires: détermine si la tête de note doit pouvoir apparaître avec des lignes

supplémentaires.

* Hampe: détermine si la tête de note doit apparaître sur une hampe.

* Pour modifier le symbole utilisé pour la tête de note, sélectionnez une des valeurs de note, cliquez

sur Changer de symbole et sélectionnez le symbole à utiliser parmi la liste de Symboles qui
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s’affiche (b 2.31 Symboles). La tête de note de noire est également utilisée pour les croches et

les valeurs de note inférieures.

En dessous des symboles de tête de note se trouvent trois options distinctes pour le

positionnement des hampes et des têtes de note lorsque celles-ci pointent vers le haut et vers le bas:

* Raccourcir la hampe de: vous permet de faire une jointure plus soignée entre la hampe et

certaines têtes de note telles que les croix (cette option est seulement disponible si la case plus

haut Hampe est cochée)

* Déplacer la tête de note de x dents vers la droite / gauche: déplace la tête de note du

nombre indiqué de dents à droite ou à gauche de la hampe, à nouveau pour permettre une

jointure plus soignée

* Déplacer la tête de note de x dents vers le haut / bas: déplace la tête de note du nombre

indiqué de dents vers le haut ou vers le bas de la hampe.

Une fois les options choisies, cliquez sur OK suivi à nouveau de OK pour fermer la boîte de

dialogue Modifier les têtes de note.

Voici une subtilité à souligner concernant les options de Lignes supplémentaires et de Hampe:

pour les accords, ce sont les réglages de ces deux options de la tête de note supérieure d’un accord

qui s’appliquent aux autres têtes de notes même si elles diffèrent. Voici l’exemple d’un accord de

deux notes écrites avec des lignes supplémentaires; si on demande que la note supérieure n’utilise

pas de lignes supplémentaires, aucune des deux notes n’aura de lignes supplémentaires.

Inversement, pour le même accord, si c’est la note inférieure qui est réglée pour ne pas utiliser de

lignes supplémentaires, les deux notes seront imprimées avec des lignes supplémentaires (parce

que la note supérieure de l’accord utilise des lignes supplémentaires).

Chaque nouveau type de tête de note créé, apparaît en fin de liste dans la boîte de dialogue Style
maison > Modifier les têtes de note et dans la liste de têtes de note du panneau Notes de la

fenêtre de propriétés, et comme les autres têtes de note il peut être sélectionné par un raccourci

numérique.
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8.17 Modifier les symboles

b 2.31 Symboles, 8.11 Polices musicales.

Utilisateurs avertis uniquement 

Les symboles utilisés par Sibelius pour les objets usuels tels que les têtes de note, les clefs et les arti-

culations figurent dans la boîte de dialogue Insertion > Symbole (raccourci Z) et peuvent être

modifiés en utilisant la boîte de dialogue Style maison > Modifier les symboles.

Modifier les symboles existants
Très logiquement, toute action réalisée dans la boîte de dialogue Style maison > Modifier les
symboles sur des symboles d’objets usuels a une incidence particulière. En effet, si on modifie le

symbole dièse par un caractère d’euro, Sibelius le traitera toujours comme un dièse (par exemple

lors de l’exécution ou de la transposition).

Il continuera à le traiter comme un dièse même si on le transforme en bémol (car ce qui compte, ce

n’est pas l’apparence des symboles mais leur position dans la grille). Cela ne posera donc aucun

problème à Sibelius, mais l’utilisateur risque la confusion. Dès lors il vaut mieux éviter de modifier

les symboles existants si ce n’est en les remplaçant par d’autres dont l’apparence est similaire.

Une illustration de ceci consisterait à modifier les symboles utilisés pour les altérations microto-

nales. Les neuf premiers symboles de la rangée Altérations de la boîte de dialogue Insertion >

Symbole correspondent aux symboles du cinquième pavé (raccourci F12). Une liste de symboles

alternatifs est proposée dans le tableau des symboles de l’article 2.31 Symboles. Si avec la boîte

de dialogue Style maison > Modifier les symboles, l’un d’eux est utilisé pour remplacer un sym-

bole du pavé, celui-ci continuera à afficher l’ancien symbole, mais effectuera la saisie du nouveau.

Nouveaux symboles
Pour disposer d’un nouveau symbole autre qu’un dérivé d’un déjà existant, on peut utiliser un des

nombreux espaces vides de Style maison > Modifier les symboles pour l’y placer, soit dans

l’espace vide d’une rangée appropriée, soit dans la rangée inférieure Symboles personnalisés.

Si tous les espaces de la rangée Symboles personnalisés sont utilisés, cliquez sur Nouveau dans

la boîte de dialogue Style maison > Modifier les symboles pour créer un nouveau symbole sur

une nouvelle rangée.

Symboles composites
Certains symboles sont formés par l’ajout d’un ou plusieurs symboles supplémentaires. Cela com-

porte deux avantages :

* Pouvoir créer de tels symboles composites présente deux avantages:même s’il n’est pas dispo-

nible dans une police de caractères musicale, un nouveau symbole peut être créé en combinant

d’autres symboles. Par exemple, le symbole pour une clef de ténor (clef de sol avec un 8 en des-

sous) est composé d’une clef de sol et d’un 8.

* Si on change la police de caractère, la taille ou la présentation d’un symbole (tel que la clef de

sol), tous les symboles composites qui l’intègrent changeront également, ce qui garantit une

apparence cohérente et évite d’avoir à modifier un grand nombre de symboles en même temps.
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Modifier ou créer de nouveaux symboles
* Choisissez Style maison > Modifier les symboles

* Sélectionnez un symbole à modifier et cli-

quez sur Modifier; pour créer un nouveau

symbole, sélectionnez une case vide dans la

boîte de dialogue et cliquez sur Modifier ou

cliquez sur Nouveau pour créer un nouveau

symbole dans une nouvelle rangée

* Pour modifier le symbole en un caractère dif-

férent, cliquez sur un nouveau symbole dans

le tableau à gauche dans la boîte de dialogue

ou entrez un numéro de caractère dans

Numéro. (Si on utilise une combinaison de

polices de caractères musicales on peut éga-

lement choisir la police à utiliser dans la liste de Police de caractère musicale (cf. ci-dessous.)

* Pour que le symbole n’existe plus (case vide), ou pour en faire un composite de symboles exis-

tants (sans caractère choisi directement dans une police musicale), réglez le Numéro sur 0

* Vous pouvez également changer le Nom du symbole; ce nom est utile pour l’identification lors-

que vous incorporez ce symbole dans un symbole composite

* Pour déplacer le symbole par rapport à sa position d’origine, cliquez sur les flèches à droite

* Pour ajouter un autre symbole afin de créer un symbole composite, cliquez sur Ajouter, cliquez

sur un autre symbole puis cliquez sur OK. Vous pouvez déplacer ces symboles supplémentaires

de manière indépendante en utilisant les boutons de flèches.

Créer un nouveau style de texte de symbole
Ce concept important assez abstrait mérite une illustration: on souhaite par ex. que toutes les clefs

utilisent une police musicale spécialement dédiée du nom de PoliceClefdeSol. (Pour en savoir

plus sur les polices musicales et leur rapport avec les symboles, b 8.11 Polices musicales.)

Pour y arriver, impossible de modifier la police du style de texte Symboles usuels, car alors,

seront également modifiées les notes, les altérations, etc... Il faut donc créer un nouveau style de

texte appelé par exemple Clefs, le régler sur PoliceClefdeSol et régler tous les symboles de clef

pour qu’ils utilisent le style de texte Clefs et donc par conséquent cette police. Pour faire cela:

* Dans la boîte de dialogue Style maison > Modifier les symboles, cliquez sur Polices musi-
cales

* Dans la boîte de dialogue Polices musicales, sélectionnez un style de texte existant (par exemple

Symboles usuels) sur lequel baser votre nouveau style, cliquez sur Nouveau et ensuite sur Oui

* Dans la boîte de dialogue qui apparaît, entrez Clefs comme nom pour votre nouveau style de

texte, et modifiez la police en choisissant PoliceClefdeSol

* Cliquez sur OK, puis encore sur OK pour fermer la boîte de dialogue Polices musicales

* Enfin, pour chaque clef dans la boîte de dialogue Style maison > Modifier les symboles, sélec-

tionnez la clef, cliquez sur Modifier, changez la Police musicale (en fait le style de texte qui spé-

cifie la police et la taille du symbole) en Clefs et cliquez sur OK.

Cette procédure est à répéter même pour créer un seul symbole dans une police ou taille spéciale.
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8.18 Édition

Cet article vous indique comment produire des partitions imprimées de haute qualité en petit ou

en grand tirage, de façon à ce que vous puissiez faire votre propre édition du début à la fin.

Être votre éditeur
Une large partie de la musique écrite est auto publiée. L’industrie d’édition musicale a subi

d’importants changements ces dix dernières années, et la popularisation de logiciels tels que

Sibelius a conduit un grand nombre de compositeurs à quitter les maisons d’édition et prendre

contrôle de leur musique. Beaucoup de compositeurs n’envisagent même pas l’idée de passer via

une maison d’édition, ou bien ne méritent pas l’attention d’un éditeur, les contraignant par

conséquent à publier leur propre musique.

Grâce à Sibelius, plusieurs outils et services sont mis à disposition pour faciliter les démarches. Si

vous souhaitez distribuer votre musique rapidement et facilement, vous pouvez la publier via

Internet – b 5.19 SibeliusMusic.com pour plus d’informations. Mais Sibelius peut également

vous aider à concrétiser un projet de partition en gestation dans votre esprit vers un entrepôt

rempli de matériel d’impression et de reliure, en apportant un soupçon de savoir-faire et

d’équipement.

Gravure musicale et style maison
Les bons éditeurs ont tous des standards de gravure musicale élevés. Cela prend du temps et

demande de l’expérience de produire de la gravure de haute qualité ; cependant, commencez par

lire b 8.3 Gravure musicale et 8.1 Mise en page et mise en forme.

De plus, les éditeurs établissent leur propre style maison. b 8.8 Style maison pour définir le

vôtre, et choisir de polices de bon goût et distinguées sera très utile; b Polices de bon goût à la

page 286.

Petits tirages
Bon nombre de compositeurs et éditeurs ont déjà adopté le modèle impression à la demande,

permettant d’imprimer et de relier une partition dès la commande passée, pour ensuite l’envoyer

au client. Cette méthode peut s’avérer plutôt rentable et efficace, et vous évite d’avoir à stocker des

boîtes de musiques dans votre entrepôt (ou votre cave).

Mais il existe également une autre méthode vous permettant d’imprimer de petites quantitiés de

partitions afin de les stoker et les garder à portée. Cette méthode s’appelle l’impression à petits

tirages. Généralement, il s’agit d’impressions à 500 copies ou moins. Beaucoup d’imprimeurs du

commerce vous proposeront ce service, et ils possèdent la plupart du temps des machines

permettant l’impression sur de grands formats de papier (tels que des formats 18 x 12”, pouvant

être pliés en livrets 9 x 12”, agrafés au milieu ou reliés). Une impression de ce type a l’avantage

d’être moins coûteuse par livre par rapport à une impression à l’unité ; mais il faut de la place pour

stocker le tout.

Ce type d’impression est réalisé sur des machines numériques très proches des imprimantes laser

acceptant des fichiers PDF comme source. Vous pouvez même imprimer vos propres partitions à

l’aide d’une imprimante laser qui accepte les grands formats de papier (les Hewlett-Packard
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LaserJet 5200, par exemple, impriment sur du papier 18 x 12”) et d’une agrafeuse peu coûteuse.

Les machines numériques de ce type impriment en reliant le toner et le papier à très haute

température. La netteté d’une partition finale peut être très prononcée, notamment avec des

résolutions telles que 1200 dpi. Il est recommandé d’utiliser ce type de résolution si vous souhaitez

imprimer des livres destinés à la vente.

Plus gros tirages
Si vous avez besoin d’un livre de plus de 500 copies, ou si vous souhaitez un type de livre en

particulier (comme une couverture brillante et stratifiée, ou une reliure cousue avec couverture en

tissu) il vous faudra alors envoyer votre partition à un imprimeur commercial offset. 

C’est le procédé d’impression pour la plupart des livres (musique et autres), via lequel l’encre est

déposée sur le papier à l’aide de grandes presses d’impression commerciales. Cette technique

s’appelle l’offset (“reporter” en français) car l’image est d’abord gravée sur une plaque de métal,

imbibée d’encre, puis l’encre est reportée vers un rouleau en caoutchouc avant d’être en contact

avec le papier. Si vous augmentez le nombre de copies à imprimer, le coût à l’unité diminuera

notablement. En effet, la plus grande partie des dépenses vient de la configuration de la presse à

imprimer. 

La plupart des imprimeurs ont adopté un flux de travail numérique permettant de travailler à

partir de fichiers PDF. Pour ce type d’impression, l’imprimeur fournit généralement les réglages

spécifiques à utiliser pour que le fichier soit correctement préparé pour les systèmes. Le fichier

PDF est utilisé pour la création des plaques d’impression, ce qui élimine une grande partie du

travail à faire. Ces étapes, laborieuses et onéreuses, étaient avant réalisées individuellement

(création des négatifs, découpage, gaufrage). 

Il est préférable de discuter au préalable avec l’imprimeur, afin de définir vos envies et les options

qui se présentent à vous. Ne soyez pas pressé, les livres sont généralement réalisés en plusieurs

semaines. Il vous faudra également passer du temps à la révision et approuver les diverses étapes.

Mais le résultat peut être impressionnant et valoir l’attente.

Facteurs affectant la qualité d’impression
* Resolution : lorsque vous passez au-delà de 600 dpi, les résolutions des épreuves deviennent

difficiles à distinguer sur des portées de grande taille, mais sur des portées plus petites la

différence est perceptible. Par contre entre 1200 dpi et 2540 dpi, la différence est à peine

perceptible

* Papier : la plupart des livres et des partitions sont imprimés sur du papier mat de haute qualité.

L’indication “g/m2” (signifiant grammes par mètre carré) donne le poids et donc l’épaisseur du

papier. Du papier à 80 g/m2 est utilisé pour du papier pour photocopieuse, pour imprimante à

jet d’encre ou laser et pour des livres assez épais. Du papier d’environ 100 g/m2 est préférable

pour les partitions car moins translucide et les feuilles non reliées risquent moins de s’envoler

d’un pupitre.

* Planches : les planches d’impression sont faites de divers matériaux. Votre imprimeur décide

généralement quel est le matériau le plus adapté. Les planches en métal produisent la qualité la

plus élevée, celles en polyester sont meilleur marché pour une qualité presque équivalente et
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celles en papier sont de moindre qualité et ne sont adaptées que pour des posters et d’autres

document peu détaillés.

A propos de la correction
Il est très important que vous gardiez un oeil sur vos copies tout au long de l’impression. La

correction doit être minutieuse. Imaginez imprimer 1000 copies avant de vous rendre compte

d’une faute d’orthographe sur la couverture. Un éditeur de grande renommée a une fois imprimé

des centaines de partitions pour piano d’un certain Wolfgang Amadeus Mozark, et personne ne

remarqua l’erreur avant l’emballage. C’est une anecdote à retenir pour nous tous.

En résumé
Il est utile de préciser que bon nombre d’éditeurs et de graveurs professionnels utilisent Sibelius

pour la publication de leurs partitions. Ils apportent avec eux des dizaines d’années d’expérience

(car ils sont capables de résoudre des problèmes complexes concernant la gravure musicale), un

design pratique et efficace, et une profonde compréhension des techniques d’impression. Il existe

probablement moins de 10 imprimeurs aux Etats-Unis imprimant pratiquement chaque morceau

musical qui y est vendu. Pour parfaire votre compréhension et acquérir un peu d’expérience, vous

pouvez étudier la configuration d’impression et la gravure d’un livre (par exemple un vieux livre de

musique, si vous en possédez un). Vous apprendrez beaucoup en vous intéressant simplement aux

techniques plus anciennes.
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9.1 Manipuler les fichiers

Cette rubrique explique comment sont sauvegardées les partitions au format Sibelius, et (pour les

utilisateurs confirmés) comment accéder à des fichiers contenant des réglages personnalisés (par

exemple les styles maison). Les autres rubriques de cette section vous explique comment partager

vos fichiers avec d’autres personnes, qu’elles possèdent ou non Sibelius, et comment importer ou

exporter sous différents formats.

Créer une partition
Pour en savoir plus sur la manière de commencer une nouvelle partition, cf. le Manuel.

Taille de fichier
Les fichiers Sibelius occupent en général environ 20K plus 1-2K par page (en excluant les images

importées), même pour la musique orchestrale ou pour les orchestres d’harmonie. Cela signifie

que vous pouvez conserver des milliers de pages sur votre disque dur, et que même de très grandes

partitions peuvent facilement être envoyées par courriel. Par conséquent, même si vous vous

appelez J.S. Bach, il est peu probable que l’espace disque soit un problème pour l’utilisation de

Sibelius.

Sauvegarde
La sauvegarde fonctionne comme pour tout autre programme, en utilisant Fichier > Sauvegarder
sous (raccourci Ctrl+Maj+S ou xXS) et Fichier > Sauvegarder (raccourci Ctrl+S ou XS).

En plus de la possibilité de sauvegarder des partitions Sibelius, vous pouvez également sauvegarder

dans d’autres formats tels que MIDI, audio et image ; pour en savoir plus, consultez l’article

correspondant dans l’ouvrage de référence de Sibelius. Pour sauvegarder les paroles, cf. Exporter
les paroles à la page 592.

Un emplacement pratique pour sauvegarder est le dossier Partitions installé par Sibelius sur votre

disque dur. Sous Windows, le dossier Partitions se trouve dans le dossier Mes Documents; sur

Mac, il est à l’intérieur de votre dossier Documents utilisateur.

Vous pouvez modifier le dossier de sauvegarde par défaut dans la boîte de dialogue Fichier >

Préférences (dans le menu Sibelius sur Mac).

Chaque fois que vous ouvrez une partition qui a déjà été sauvegardée, elle s’ouvre à l’endroit exact

où vous l’aviez laissée lorsque vous avez sauvegardé; même le niveau de zoom est conservé. Si vous

préférez que Sibelius ouvre les partitions à un niveau de zoom par défaut plutôt que le niveau

auquel vous travailliez, activez Ouvrir avec la valeur de zoom par défaut dans la boîte de

dialogue Fichier > Préférences (dans le menu Sibelius sur Mac).

Sauvegarde automatique
Sibelius peut automatiquement sauvegarder la partition en cours à des intervalles réguliers de

façon à ce que, si l’ordinateur était victime d’un crash, seules quelques minutes de travail seraient

perdues. Plutôt que de sauver votre fichier réel, Sibelius fait une copie de votre partition et la

sauvegarde dans un dossier appelé Sauvegarde automatique à l’intérieur du dossier

Sauvegarde (cf. ci-dessous).
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Si Sibelius ne se ferme pas correctement (par exemple, si votre ordinateur “plante” ou s’il y a une

interruption de courant), dès le démarrage suivant, il vérifiera s’il trouve une (des) partition(s)

dans le dossier Sauvegarde automatique et vous demandera si vous souhaitez la (les) restaurer.

Lorsque vous fermez Sibelius normalement, il efface tous les fichiers dans le dossier Sauvegarde
automatique ; il est donc essentiel que vous n’y sauvegardiez aucun fichier vous-même !

La sauvegarde automatique est activée par défaut. Si pour une raison ou l’autre, vous souhaitez la

désactiver, faites-le dans la page Fichiers de la boîte de dialogue Fichier > Préférences (dans le

menu Sibelius sur Mac). Vous pouvez spécifier dans cette boîte de dialogue à quelle fréquence

Sibelius sauvegarde automatiquement votre partition ; l’intervalle par défaut est de 10 minutes.

Copies de sauvegarde
Chaque fois que vous sauvegardez, la partition est également sauvegardée (avec un numéro de

version ajouté au nom) dans le sous-dossier Sauvegarde de votre dossier Partitions. Si jamais

vous supprimez ou abîmez accidentellement une partition, regardez dans ce dossier de copies de

sauvegarde pour retrouver non seulement la dernière version sauvegardée, mais aussi d’autres

versions antérieures. Le dossier conserve les 40 dernières partitions sauvegardées ; les copies

antérieures sont supprimées progressivement pour éviter que votre disque ne se remplisse trop,

n’utilisez donc pas ce dossier pour conserver vos propres copies de sauvegarde !

Les copies de sauvegarde sont créées lorsque vous sauvegardez manuellement, et donc pas lors de

la sauvegarde automatique; mais à la différence des sauvegardes automatiques, les copies de

sauvegarde ne sont pas supprimées lorsque vous fermez Sibelius.

Informations sur la partition
La boîte de dialogue Fichier > Infos sur la partition peut être utilisée pour entrer les informations

de catalogue à propos de la partition en cours, telles que le titre, le compositeur, l’arrangeur, le

copyright, etc. qui sont automatiquement utilisés lorsque vous publiez votre partition sur Internet

(b 9.11 Exporter des pages Web Scorch). Vous pouvez également entrer ces informations

dans la page finale de la boîte de dialogue Fichier > Nouveau lorsque vous créez une nouvelle

partition. L’onglet Fichier de la boîte de dialogue Fichier > Informations sur la partition affiche

les informations utiles à propos de la partition, comme la date de création, celle de la dernière

sauvegarde, le nombre de pages, de portées et de mesures, etc. Cet onglet n’apparaît que si le fichier

a été sauvegardé au moins une fois.

Les données entrées dans les champs de la boîte de dialogue Infos sur la partition peuvent être

aussi utilisées comme Formules magiques dans des objets textuels dans toute la partition. Pour en

savoir plus sur les formules magiques et la manière de les utiliser dans Sibelius,

b 3.10 Formules magiques.

Fichiers que peut créer l’utilisateur
Sibelius vous permet de créer vos propres fichiers sous les formats suivants :

* Idées (b 5.11 Idées)

* Styles maison (b 8.8 Style maison)

* Extensions (b 6.1 Travailler avec des extensions)

* Exercices (b 5.25 Créateur d’exercices)
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* Styles d’arrangement (b 5.2 Modifier les styles d’arrangement)

* Bibliothèques de symbole d’accord (b 2.10 Les symboles d’accord)

* Bibliothèques de tablatures de guitare (b 2.16 Diagrammes de gammes guitare)

* Polices équivalents de texte et pour la musique (b 3.1 Utiliser du texte, 8.11 Polices
musicales)

* Papiers à musique (b 2.23 Papier à musique)

* Jeux de fonction (b 5.12 Menus et raccourcis)

* Menus contextuels (b 3.1 Utiliser du texte)

Sibelius étant fourni avec un jeu où figure chacun de ces types de fichiers, tous ceux que vous

ajouteriez seront sauvegardés dans un endroit séparé de ceux du programme. Les fichiers

standards fournis avec Sibelius ne peuvent être supprimés ; il est préférable de ne rien changer

dans le dossier de l’application lui-même (ou de tout l’ensemble de l’application– ce qu’on appelle

parfois le “bundle”), où ils sont sauvegardés.

Vos propres fichiers (ceux que vous pouvez créer ou modifier) sont sauvegardés dans les dossiers

spécifiques à l’application dans votre compte d’utilisateur sur l’ordinateur, dont l’emplacement peut

différer selon votre système d’exploitation :

* Windows Vista : C:\Users\username\Application Data\Sibelius Software\Sibelius 6\

* Windows XP : C:\Documents and Settings\username\Application Data\
Sibelius Software\Sibelius 6

* Mac : /Users/username/Library/Application Support/Sibelius Software/Sibelius 6

Notez que sous Windows, le dossier des données de l’application est masqué par défaut et n’est pas

visible par Windows Explorer. Si vous désirez accéder à ce dossier, choisissez Outils > Options des
dossiers qui ouvre une fenêtre de l’explorateur. Cliquez sur l’onglet Affichage et sous la liste

Fichiers et dossiers choisissez Afficher fichiers et dossiers cachés.

À l’intérieur du dossier de données de l’application Sibelius, vous trouverez différents dossiers

dont le nom indique ce qu’ils contiennent. (Il est possible qu’il n’y ait aucun dossier, car ceux-ci

sont créés uniquement lorsque un fichier correspondant est créé de toute pièce ou par

modification.)

Vous pouvez copier n’importe quel fichier adéquat dans les répertoires d’utilisateur et Sibelius les

utilisera lors du lancement suivant du programme. Les fichiers que vous avez créés ou modifiés

peuvent aussi être supprimés sans effet secondaire.

Modèles Scorch et textures
Vous pouvez créer vous-même des modèles Scorch et des textures de papier ou de bureau. Placez-

les dans le sous-dossier adéquat du dossier de l’application, et Sibelius les détectera. Les modèles
Scorch se placent dans le dossier appelé Modèles Scorch, et les textures dans le dossier appelé

Textures.
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Quick Look (Mac OS X 10,5 et supérieur uniquement)
Quick Look est une fonction intégrée à Mac OS X 10,5 et aux versions supérieures pour vous

permettre de prévisualiser instantanément le contenu de vos documents directement à partir du

Finder, sans avoir à attendre l’ouverture des applications à partir desquelles ces documents ont été

créés : il vous suffit en effet de sélectionner le document en question dans le Finder et d’appuyer

sur Espace. De nombreux documents affichent également des prévisualisations réduites sur le

bureau et les fenêtres du Finder. En réglant les fenêtres du Finder pour qu’elles utilisent Cover

Flow, vous pourrez alors parcourir très rapidement les dossier des différents documents.

Sibelius prend entièrement en charge Quick Look. Ainsi, à la place de l’icône de document

classique, vous verrez un aperçu miniature de la première page de la partition : sélectionnez-le

puis appuyez sur Espace (ou cliquez sur l’icône Quick Look dans le Finder) pour obtenir un plus

grand aperçu de la partition. Vous pouvez parcourir les différentes pages en pages en cliquant sur

la barre de défilement à droite de l’aperçu.

Zoom (Mac uniquement)
Spotlight est un moteur de recherche intégré à Mac OS X. Il vous suffit de cliquer sur l’icône

Spotlight en haut à droite de l’écran, ou de taper le raccourci-clavier X-Espace, et de saisir le terme

à rechercher. Vous pouvez rechercher des partitions Sibelius à partir de Spotlight. Pour ce faire, il

vous suffit de saisir le nom du fichier ou une partie du texte contenu dans le nom de fichier (par

exemple, le titre, le compositeur, des paroles le nom des instruments, etc.). Une fois que vous avez

trouvé une ou plusieurs partitions, cliquez sur Espace pour les prévisualiser avec Quick Look (cf.

ci-dessus) ou double-cliquez pour les ouvrir dans Sibelius.
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Il est très facile de partager avec d’autres personnes des partitions créées dans Sibelius.

Partager des fichiers avec d’autres utilisateurs de Sibelius
Si les personnes à qui vous souhaitez communiquer la partition possèdent Sibelius, il suffit de leur

envoyer le fichier par e-mail (cf. ci-dessous), ou sur un support amovible tel qu’un CD-R.

Renseignez-vous pour savoir quelle version de Sibelius ces personnes utilisent. Si elles possèdent la

même version que vous ou une version supérieure, vous pouvez sauvegarder le fichier

normalement et leur envoyer tel quel. Si, cependant, elles possèdent une version plus ancienne, ou

Sibelius Student ou G7, vous devrez exporter la partition sous le format correspondant –

b 9.12 Exporter vers des versions antérieures.

Partager des fichiers avec des personnes qui n’utilisent pas Sibelius
Si le destinataire ne possède pas Sibelius, il y a un certain nombre d’autres moyens de partager les

fichiers avec lui:

* Demandez-lui de télécharger et d’installer la version de démonstration gratuite de Sibelius

disponible sur www.sibelius.com, puis envoyez-lui le fichier. Notez cependant que la version

de démonstration ne peut imprimer qu’une seule page avec un filigrane; si vous souhaitez qu’il

puisse imprimer la partition, cette procédure n’est dès lors pas la meilleure solution.

* Publiez la musique sur SibeliusMusic.com ou sur votre propre site web –

b 5.19 SibeliusMusic.com, 5.18 SibeliusEducation.com et 9.11 Exporter des
pages Web Scorch.

* Créez une fichier PDF de votre partition et envoyez-le lui - voyez Créer des fichiers PDF à la

page 744

* Exportez la partition en tant qu’ “image”, et envoyez-le lui – b 9.8 Exporter des images

* Sauvegardez la partition au format de page web Scorch web et envoyez un courriel avec les deux

fichiers générés en pièces attachées (cf. ci-dessous)

* Si le destinataire possède un autre programme musical et veut écouter et peut-être modifier

votre morceau, envoyez-lui un fichier MIDI – b 9.9 Exporter des fichiers MIDI

* Si vous voulez envoyer un morceau à quelqu’un pour qu’il puisse l’écouter, sans la partition, vous

pouvez exporter un fichier audio de Sibelius et ensuite le graver sur un CD audio ou le

compresser au format MP3 et l’envoyer par courriel – b 9.10 Exporter des fichiers audio.

Envoyer de fichiers par courriel
Envoyer des fichiers par courriel est très simple, mais la procédure exacte diffère selon le

programme de courriel que vous utilisez:

* Windows Mail, Outlook Express ou Mozilla Thunderbird: commencez un nouveau message, puis

cliquez sur le bouton (avec un trombone) Joindre, localisez le fichier et cliquez sur Joindre pour

l’attacher au message. Envoyez-le ensuite comme d’habitude.

* Apple Mail: commencez un nouveau message, puis faites glisser le fichier à attacher au message

dans la fenêtre du message, puis envoyez-le comme d’habitude.

* Netscape Messenger: commencez un nouveau message, puis cliquez sur le bouton Attacher et

choisissez Fichier dans la liste déroulante. Localisez le fichier à attacher, et double-cliquez sur

http://www.sibelius.com


9. Fichiers

720

son nom pour l’attacher au message, qu’il suffit ensuite d’envoyer normalement.

* Eudora: commencez un nouveau message, faites un clic droit (Windows) ou Contrôle-clic (Mac)

dans le corps du message, et choisissez Joindre un fichier. Localisez le fichier à attacher, et

double-cliquez sur son nom pour l’attacher au message, qu’il suffit ensuite d’envoyer

normalement.

Si vous n’utilisez pas l’un des programmes ci-dessus, consultez la documentation pour votre

programme de courriel pour en savoir plus sur l’envoi de pièces jointes.

Si vous envoyez un fichier Sibelius en tant que page web Scorch par courriel:

* Tout d’abord, exportez-le (b 9.11 Exporter des pages Web Scorch)

* rappelez-vous qu’il faut attacher les deux fichiers .sib et .htm à votre message

* informez le destinataire qu’il a besoin d’avoir Scorch installé sur son ordinateur; dites-lui de

sauvegarder les deux fichiers dans un seul répertoire de son ordinateur (par ex. sur le bureau) et

de double-cliquer ensuite sur le fichier .htm sauvegardé pour afficher la partition dans son

navigateur.

Fichiers sous Windows et sur Mac
Sibelius pour Mac et Sibelius pour Windows utilisent exactement le même format de fichier. Une

partition Sibelius peut donc passer de l’un à l’autre sans la moindre conversion - voyez ci-dessous.

Les deux formats utilisent Unicode, un jeu de caractère au standard international, qui garantit la

compatibilité des caractères spéciaux (comme les lettres accentuées) entre Mac et Windows.

De même, les polices musicales et textuelles sont substituées intelligemment – b 3.11 Polices
de substitution.

Sous Windows, les fichiers Sibelius ont l’extension “.sib”. Sur Mac, les fichiers Sibelius sont un

genre de “document Sibelius” (en interne, le créateur est “SIBE” et le type est “SIBL”).

Ouvrir des partitions Mac sous Windows
Si vous essayez d’ouvrir un fichier créé sur Mac et sauvegardé sur un CD-Rom ou un autre disque,

assurez-vous que le disque est formaté pour Windows; bien que le Mac puisse lire les disques

Windows, Windows ne peut lire les disques Mac.

Pour ouvrir sous Windows le fichier Sibelius créé sur Mac, vous devrez ajouter l’extension .sib.

Bien que Sibelius ajoute les extensions de fichier par défaut tant sur Mac que sous Windows,

certains utilisateurs Mac préfèrent ne pas les utiliser; Sous Windows, cela pose un problème car

c’est l’extension qui indique à Windows qu’il s’agit d’un fichier Sibelius.

Sous Windows, voici comment ajouter l’extension: faites un clic droit sur l’icône du fichier (dans le

Poste de travail ou l’explorateur Windows) et sélectionnez Renommer. Modifier l’extension puis

appuyez sur Retour (sur le clavier principal). Vous aurez probablement un avertissement vous disant

que modifier les types de fichier peut les rendre inutilisables, car Windows estime que l’utilisateur

n’est pas sûr de lui. S’il vous demande si vous êtes sûr de vouloir continuer, cliquez sur Oui.

Une fois le fichier renommé, vous pourrez l’ouvrir de la manière habituelle en le double-cliquant.

Ouvrir sur Mac des partitions créées sous Windows
Pour ouvrir un fichier créé sur Sibelius pour Windows, choisissez simplement Fichier > Ouvrir et

double-cliquez sur le nom du fichier (qui aura une extension .sib) dans la boîte de dialogue.
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Vous pouvez écrire plusieurs mouvements, chansons ou pièces dans le même fichier, ou les écrire

dans des partitions séparées et les combiner par la suite. Vous pouvez aussi diviser une partition

contenant plusieurs morceaux en partitions individuelles.

Plusieurs mouvements, mélodies ou pièces
Il est préférable de placer plusieurs sections (par ex. des mouvements, des mélodies ou des pièces

de musique) en une seule partition plutôt que d’avoir une partition séparée pour chaque. Si vous

voulez qu’une nouvelle section soit sur la même page que la précédente, dans la partition ou dans

les parties séparées, vous devez les entrer dans le même fichier.

Si vous souhaitez joindre deux ou plusieurs sections différentes réparties dans des fichiers

différent cf. ci-dessous Joindre une partition.

Pour écrire, par exemple, quelques exercices à deux systèmes sur la même page:

* Entrez le premier exercice normalement

* Sélectionnez la barre de mesure à la fin du premier exercice et appuyez sur Retour (sur le clavier

principal) pour créer un saut de système

* Si vous avez également besoin des noms d’instruments complets et d’une portée en alinéa,

sélectionnez la mesure à la fin du système précédent, ouvrez le panneau Mesures des propriétés

et activez Fin de section 

* Créez une double barre de mesure ou une barre de mesure finale à la fin du premier exercice si

vous le désirez (Créer > Barre de mesure > Finale ou Double)

* Si l’armure est différente au début du second exercice, créez-en une nouvelle de la manière

habituelle, en vous assurant toutefois d’activer Masquer dans la boîte de dialogue Créer >

Armure; cela masquera le changement d’armure à la fin du système précédent

* De la même façon, si vous avez besoin d’une indication de mesure différente dans l’exercice

suivant, créez-la de la manière habituelle, en vous assurant toutefois de désactiver Annoncer le
changement de mesure à la fin du système précédent dans la boîte de dialogue Indication
de mesure; cela évitera qu’une indication de mesure de précaution soit ajoutée à la fin du

système précédent

* Réinitialisez le numéro de mesure au début du second exercice si vous le désirez (Créer >

Autres > Changement de numéro de mesure).

Saisir une partition en plusieurs fichiers
Si vous voulez entrer une partition en plusieurs fichiers - peut-être si plusieurs personnes la

copient et l’orchestrent en même temps - vous pouvez ajuster le premier numéro de mesure, de

page, et le premier repère de répétition de chaque fichier de manière à ce que les mesures, pages et

repères de répétition suivent la numérotation du fichier précédent.

Prenez garde au fait que si vous envisagez d’extraire les parties séparées, chaque section dans

laquelle la partition complète était divisée commencera sur une nouvelle page dans les parties

séparées, ce qui peut provoquer des tournes inconfortables. Par conséquent, une fois que la
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partition est terminée et avant d’en extraire les parties séparées, il est préférable de joindre les

fichiers ensemble en utilisant la fonction Fichier > Joindre une partition - cf. ci-dessous. 

Joindre une partition
Il arrive qu’on doive joindre deux partitions ensemble, par exemple, pour créer des recueils de

chansons à partir de fichiers séparés. Sibelius propose une fonction pour ajouter une partition à la

fin d’une partition existante. Avant de joindre, elle vérifie automatiquement si les portées des deux

partitions correspondent, et assure que la partition ajoutée commence sur une nouvelle page.

Pour utiliser cette fonction, ouvrez la première partition et choisissez Fichier > Joindre une
partition. Une boîte de dialogue apparaît à partir de laquelle vous pouvez choisir une autre

partition à ajouter (le fichier qui sera ajouté ne sera lui-même pas modifié).

Si le nombre de portées n’est pas identique, Sibelius vous en informera (il ne joindra pas la

partition à moins que le nombre de portées ne corresponde exactement). Si le nombre de portées

est identique mais que certains noms d’instruments sont différents, Sibelius vous en informera

mais vous permettra de continuer la jonction si vous le souhaitez.

Les styles de texte, les symboles, les têtes de note des deux fichiers sont fusionnés; si deux styles de

texte ont le même nom mais sont réglés différemment, celui de la première partition sera utilisé.

Sibelius fait différentes choses pour s’assurer que la jointure entre les partitions soit impeccable: les

changements de métrique, d’armures, de clef, de transposition et de type de portée sont créés à la

jointure si nécessaire. La barre de mesure finale de la première partition est transformée en saut de

page et en “fin de section” de façon à ce que la partition ajoutée commence sur une nouvelle page

avec (normalement) les noms d’instrument complets. Par conséquent, la mise en page de la

partition ajoutée sera conservée.

Il est peut être nécessaire de masquer les clés, les armures et les indications de mesure de

précaution là où les deux partitions sont jointes, particulièrement s’il s’agit d’un espace entre deux

mouvements ou pièces – b 5.9 Masquer des objets.
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Cet article explique comment placer des images dans les partitions en important des fichiers

bitmap au format TIFF dans Sibelius.

Si vous souhaitez transformer un fichier graphique (par ex. une image numérisée) en une

partition, b 1.5 Numérisation.

Si vous souhaitez transformer une partition en un fichier graphique (par ex. un fichier EPS) pour

la publication ou pour placer des extraits de musique dans un document, b 9.8 Exporter des
images.

Formats de fichier 
Sibelius peut importer des fichiers d’images au format TIFF format, quel que soit le niveau de

couleur (autrement dit, en noir et blanc, en échelle de gris, ou en couleurs de nombre illimité).

Si l’image n’est pas au format TIFF, vous pouvez la convertir en fichier TIFF. Il existe de nombreux

programmes de mise en page disponibles en téléchargement gratuit sur Internet. Sous Windows,

par exemple, essayez IrfanView (www.irfanview.com). Sur Mac, l’application de prévisualisation

intégrée peut convertir la plupart des graphiques en TIFF: ouvrez simplement le graphique que

vous souhaitez convertir, choisissez Fichier > Sauvegarder sous, et choisissez TIFF dans le menu

déroulant Format.

Importer une image
Pour importer un fichier TIFF :

* Sélectionnez une note, un silence, une mesure ou un autre objet de la partition à l’endroit où doit

apparaître l’image

* Choisissez Créer > Image. Une boîte de dialogue apparaît vous demandant de localiser le fichier

TIFF que vous désirez importer. Une fois le fichier trouvé, cliquez sur Ouvrir.

* L’image est créée dans la partition et vous pouvez la déplacer, la copier, etc.

* Si vous préférez placer l’image avec la souris ou l’installer sur une page blanche (b 8.5 Les
sauts), assurez-vous que rien n’est sélectionné dans la partition puis choisissez Créer > Image;

le pointeur de la souris changera alors de couleur pour indiquer qu’il est “chargé” d’un objet:

cliquez dans la partition pour placer l’image.

Les images importées apparaissent généralement mieux à l’écran quand la texture du papier est

réglée sur blanc, de façon à ce que l’arrière-plan autour des formes non rectangulaires se fonde

dans le papier (b 5.6 Paramètres d’affichage). Les images seront cependant imprimées

correctement quelle que soit la texture.

Copier, modifier et supprimer des images
Dès que l’image apparaît sur la partition, vous pouvez la manipuler à peu près de la même manière

que n’importe quel autre objet :

* copiez-la avec Alt+clic ou z-clic

http://www.irfanview.com/
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* déplacez-la en cliquant sur l’image de façon à ce qu’elle devienne ombragée sur fond bleu puis

tirez-la avec la souris ou utilisez les flèches (avec Ctrl ou X pour de plus grands incréments)

* réduisez ou agrandissez-la tout en gardant ses proportions, en cliquant sur la poignée dans le

coin inférieur droit, de façon à ce qu’elle soit entourée d’un cadre bleu clair, puis tirez avec la

souris ou utilisez 3/2 (avec Ctrl ou X pour de plus grands incréments)

* réduisez ou agrandissez-la en modifiant ses proportions, en maintenant Ctrl ou X avant de

cliquer sur le coin inférieur droit de l’image (où apparaît la poignée); relâchez Ctrl ou X, puis

tirez avec la souris ou utilisez 3/2(avec Ctrl ou X pour de plus grands incréments)

* supprimez-la avec Suppr.

Pour réinitialiser une image après l’avoir manipulée, choisissez Mise en page > Rétablir l’aspect
original (raccourci Ctrl+Maj+D ou xXD), qui rétablit la taille et les proportions originales de

l’image.

Changer l’ordre de dépose des images importées
Par défaut, les images importées sont déposées derrière tous les autres objets. Vous pouvez

changer ce paramètre si vous le souhaitez, à l’aide des commandes dans le sous-menu Edition >

Ordre – b 5.14 Ordre.

Taille de fichier
Importer une image dans votre partition augmente considérablement sa taille de fichier.

Pour conserver une taille de fichier aussi petite que possible, Sibelius compresse le fichier TIFF en

l’important, et si vous utilisez plusieurs fois la même image dans votre partition, vous pouvez et

devriez la copier plutôt que de l’importer à nouveau.
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9.5 Ouvrir des fichiers MIDI

Pour en savoir plus sur le MIDI, b 4.13 MIDI pour les néophytes, une explication plus

complète y est donnée concernant les fichiers MIDI. Si vous vous demandez comment et où

obtenir des fichiers MIDI, cf. Télécharger des fichiers MIDI ci-dessous.

Importer un fichier MIDI
Ouvrez un fichier MIDI exactement comme un fichier Sibelius: choisissez Fichier > Ouvrir
(Ctrl+O ou XO) ou cliquez sur Ouvrir dans la barre d’outil, localisez le fichier (sous Windows, les

fichiers MIDI utilisent habituellement l’extension .mid), et cliquez sur Ouvrir.

Une boîte de dialogue apparaît avec les options d’importation que vous pouvez régler (détaillées ci-

dessous). En principe, il suffit de cliquer sur OK, et le fichier s’ouvre après quelques secondes.

Certains fichiers MIDI ne contiennent pas de messages de changement de programme (bien qu’ils

contiennent les noms d’instrument), et donc les instruments doivent être devinés. Dans ce cas,

Sibelius vous avertira que les noms d’instrument, les sons, les clés et autres détails peuvent être

erronés. Il faudra soit ajuster les clés d’instrument, etc. manuellement, ou (de préférence)

réimporter le fichier MIDI contenant cette fois les indications de changements de programme.

S’il vous semble que le fichier MIDI importé n’est pas aussi bon que vous l’auriez espéré, essayez de

modifier les réglages d’importation; cf. ci-dessous Options d’importation.

Une fois le fichier MIDI importé, vous pouvez l’exécuter, l’éditer, le sauver, l’imprimer et extraire les

parties comme si vous aviez encodé la musique vous même. Les fichiers MIDI importés jouent

avec toutes les nuances de la séquence originale – la vélocité et la durée exacte pour chaque note–

grâce aux caractéristiques d’exécution de Sibelius (b 4.8 Exécution enregistrée).

Options d’importation

Les options des onglets Fichier MIDI de la fenêtre Ouvrir un fichier MIDI sont les suivantes:

* Les fichiers MIDI utilisent cette configuration de sons vous permet de spécifier si les

numéros de programme et de banques utilisent le standard General MIDI ou une autre

configuration de sons. Cela aide Sibelius à deviner quels sont les instruments. Normalement,
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vous pouvez laisser cette option sur Général MIDI ou désactiver cette option si vous voulez

importer le fichier MIDI “tel quel”.

* Uniquement une portée par piste est utile si vous ouvrez un fichier MIDI qui indique un

piano avec deux pistes de piano, une pour la main gauche et l’autre pour la main droite. Activez

cette option et chacune des parties sera écrite sur une portée et non deux; vous pouvez alors

créer une portée de piano et copier les deux parties dessus. Enfin, effacez les portées originales.

* Maintenir l’ordre des pistes est désactivé par défaut; ce qui laisse à Sibelius le choix de l’ordre

des instruments. Activez cette fonction pour garder les instruments dans le même ordre que les

pistes du fichier MIDI.

* Garder les noms de piste: Sibelius utilisera le nom de chaque piste comme nom d’instrument;

désactivez cette option pour utiliser le nom des instruments par défaut que Sibelius devinera

* Masquer les portées vides est activé par défaut; avec cette option, Sibelius masque toutes les

portées vides dans la partition obtenue, ce qui est souvent utile car de nombreux fichiers MIDI

présentent des pistes souvent vides sauf pour de brefs passages; la partition obtenue avec les

portées masquées sera plus facile à lire

* Importer les marqueurs comme points de montage oblige Sibelius à convertir tous les

marqueurs du fichier MIDI en points de montage dans la partition créée. Si c’est désactivé,

Sibelius importera les marqueurs comme objets de texte standard.

* Utiliser la vitesse de lecture vidéo d’après l’en-tête SMPTE oblige Sibelius à régler la

vitesse d’image Exécution > Vidéo et Minutage > Code temporel et Durée d’après les

réglages du fichier MIDI – cf. SMPTE offset ci-dessous.

* Utiliser une tablature pour les guitares spécifie si Sibelius doit importer les pistes de guitare

du fichier MIDI en portée de tablature; si l’option est désactivée, les guitares sont importées en

notation normale

* Utiliser des voix multiples détermine si Sibelius doit utiliser deux voix si nécessaire pour

obtenir une notation claire; cette option doit normalement rester activée

* Afficher les indications métronomiques rend toutes les marques de métronome visibles. S’il

y a de nombreux changements de tempo (par exemple rits. ou accel.) vous pourrez désactiver

cette option, ce qui masquera les marques de métronome dans la partition, en la rendant plus

nette tout en lisant à l’identique.

* Les options de Paramètres de document permettent de choisir le format de la page, le style
maison et l’orientation (Portrait ou paysage) de la partition obtenue

Pour plus de détails sur les options de la Notation sur tablature, cf. Options Flexi-time à la

page 24.

Options d’importations recommandées
La combinaison précise des options que vous devriez spécifier dans la boîte de dialogue Ouvrir un
fichier MIDI dépend d’un certain nombre de facteurs:

* Si vous importez un fichier MIDI pour créer une notation propre, vous devriez désactiver

l’onglet Notation pour noter les staccatos et tenutos, et essayer plusieurs réglages dans Valeur
de note minimum jusqu’au moment où vous obtenez le résultat le plus net.
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* Si vous importez un fichier MIDI uniquement pour l’exécution, les options choisies n’auront pas

d’importance puisque Sibelius exécutera le fichier MIDI

* Si vous importez un fichier créé par une autre personne, probablement sur un matériel différent

(par exemple un fichier MIDI téléchargé depuis Internet), spécifiez le matériel sur lequel il a été

créé dans Le fichier MIDI utilise cette configuration, et réglez Exécutez en utilisant ce

matériel en concordance avec votre matériel

* Si vous importez un fichier utilisant le standard General MIDI, spécifiez General MIDI dans Le
fichier MIDI utilise cette configuration.

Les réglages par défaut de l’onglet Notation fonctionnent bien dans la plupart des cas: activez

Ajuster les rythmes, La valeur de note minimum est une double croche, Staccato et Tenuto.

Si vous lisez un fichier dont le rythme est exact (déjà quantifié), désactivez l’option Ajuster le
rythme.

Si vous spécifiez une valeur trop longue dans Valeur de note minimum – par exemple des

croches alors que le fichier MIDI contient de nombreuses doubles croches – Sibelius ne pourra pas

assurer une exécution correcte du fichier. (Sibelius devra déterminer les tirages des doubles

croches à l’aide de multiplets de croches ou en associant des paires de doubles croches ensemble

pour former des accords de croches).

Les options pour les multiplets sont les suivantes: 

* Simple signifie que les multiplets sont indiqués uniquement s’ils contiennent des valeurs de

notes égales

* Modéré et Complexe pour des rythmes irréguliers.

Souvenez vous que si un triolet est utilisé dans un fichier MIDI, vous devez laisser cette option sur

Simple, ou il ne sera pas lu correctement! Soyez attentif et prudent avec le fait que si vous réglez

les multiplets sur Complexe, Sibelius pourra découvrir des rythmes de multiplets élaborés là où

on ne s’y attendait pas.

Conversion globale d’un ensemble de fichiers
Sibelius inclut une extension qui convertit un dossier de fichiers MIDI en une seule opération.

Pour utiliser cette option, choisissez Extensions > Conversion par lot > Convertir un dossier de
fichiers MIDI. Spécifiez comme demandé l’emplacement du dossier à convertir, puis cliquez sur

OK. Tous les fichiers MIDI se trouvant dans le répertoire seront convertis en fichiers Sibelius.

Clarifier des fichiers MIDI
Les fichiers MIDI ne contenant aucune information de notation, ils peuvent paraître “chargés” lors

de leur ouverture dans Sibelius. Voici quelques astuces pour améliorer leur aspect, avant et après la

conversion:

* Si le fichier MIDI utilise un numéro de programme non standard (par exemple s’il est réglé pour

jouer sur un instrument MIDI inhabituel), Sibelius ne pourra pas identifier les instruments

correctement et des erreurs peuvent apparaître, telles que des clés erronées. De façon similaire,

si le fichier utilise le canal 10 pour autre chose que des instruments de percussion, ils peuvent

être interprétés par Sibelius comme instruments de percussion. Tout cela dépend en fait du

matériel MIDI spécifié lors de l’ouverture du fichier MIDI.
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* Si c’est le cas, essayez d’ouvrir le fichier à nouveau en utilisant d’autres réglages.

* Si le fichier n’est pas entièrement ou correctement quantifié, vous pourriez trouver que les

rythmes ne sont pas indiqués aussi précisément que vous l’auriez désiré. Si vous avez un

séquenceur, vous pouvez requantifier le fichier avant de l’ouvrir dans Sibelius. Sinon, utilisez

Extensions > Simplifier la notation > Réécrire l’exécution enregistrée, qui peut à la fois

répartir les voix et quantifier les notes intelligemment (cf. Réécrire l’interprétation à la page

586 pour en savoir plus).

La chose la plus indispensable à faire lors de l’ouverture d’un fichier MIDI est de rendre le plus

possible lisible la partie de percussion à sons indéterminés qui y figurerait– cf.

b 2.26 Percussion pour en savoir plus.

Lorsque Sibelius importe des parties de percussions à sons indéterminés dans un fichier MIDI,

chaque son de percussion est converti en une tête de note et une position (par exemple ligne ou

espace) défini dans le type de portée 5 Lignes (réglage de percussion). Si un son de percussion

est utilisé alors que la notation n’est pas définie dans ce type de portée, Sibelius l’indiquera en

utilisant une notation normale, des têtes de notes en forme de croix ou de losange dans les

positions vides sur la portée.

Si vous trouvez qu’il y a de nombreux silences entre les notes, ou qu’il y a des unissons non désirés

(deux têtes de notes se partageant le même hauteur). Utilisez Extensions > Simplifier la
notation > Supprimer les silences et Extensions > Simplifier la notation > Enlever les
unissons – b 6.1 Travailler avec des extensions.

SMPTE offset
La valeur d’événement offset MIDI SMPTE est importée (si elle existe) et règle Temps de départ
dans la boîte Exécution > Vidéo et Minutage > Code temporel et Durée. Elle peut aussi être

utilisée pour régler la vitesse d’image utilisée par le code temporel dans la partition; cependant,

comme la valeur d’événement offset MIDI SMPTE ne décrit pas tous les formats de vitesse d’image

utilisés par les programmes de séquenceurs, si vous connaissez la vitesse d’image que vous voulez

utiliser, choisissez Régler la vitesse de lecture vidéo sur la page Fichier MIDI de la boîte de

dialogue Ouvrir un fichier MIDI, et sélectionnez la vitesse souhaitée dans le menu. (Si vous n’avez

aucune idée de ce que cela signifie, pas de panique; laissez les options telles quelles.)

Détails techniques
Sibelius importe les fichiers MIDI de type 0 et 1. Lors de l’importation, Sibelius va déterminer quel

instrument utiliser (en utilisant les noms des pistes s’ils sont présents, sinon en utilisant les sons),

étant aussi capable de différencier un instrument d’un autre (par exemple un violon d’un alto, une

clarinette d’une clarinette basse, une voix soprano d’une voix alto) par l’étendue de la musique dans

chaque piste. Sibelius va améliorer l’affichage des rythmes en utilisant les algorithmes de Flexi-

time, et retiendra autant de messages que vous l’aurez spécifié (par exemple les indications

métronomiques, les changements de programme, etc...). Sibelius réduira aussi automatiquement

la taille des portées s’il y a trop d’instruments par rapport à la taille de la page.
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Télécharger des fichiers MIDI 
Il existe énormément de ressources en ligne pour les fichiers MIDI. Si vous recherchez un morceau

spécifique, faites votre recherche avec www.google.com en entrant par exemple le nom du

morceau suivi des mots “fichier MIDI.” Sinon visitez l’un des sites suivants:

* www.prs.net: Plus de16000 fichiers de musique classique, tous dans le domaine public

* www.musicrobot.com: Un moteur de recherche sur le web pour les fichiers Midi de musique

pop

* www.cpdl.org: Un excellent site pour la musique chorale dans le domaine public avec des

centaines de fichiers

* www.cyberhymnal.org: Tous les grands hymnes, avec les paroles en sus.

Les fichiers présents sur ces sites ne sont pas tous au format MIDI – on peut rencontrer entre

autres des fichiers au format Finale et PDF. Il y en a parfois au format audio, comme le MP3, qui ne

peuvent être ouverts par Sibelius. Regardez bien le format du fichier avant de le télécharger.

(Sibelius peut cependant ouvrir des fichiers de différents formats – consultez les autres rubriques

de ce chapitre pour en savoir plus.)

Une fois découvert avec votre navigateur web, le fichier MIDI recherché, identifiez le lien pour le

télécharger; normalement les liens sont soulignés. Ne cliquez pas sur le lien directement car il sera

simplement lu à l’intérieur du navigateur web; or l’objectif est de le télécharger, pas de l’écouter.

Voici plutôt ce qu’il faut faire:

* Faites un clic-droit (Windows) ou Control-clic (Mac) sur le lien, et un menu apparaîtra.

* Choisissez Sauvegarder le lien, Enregistrer la cible ou Télécharger le lien (les termes exacts

dépendent du navigateur utilisé)

* Selon le navigateur, il vous sera peut être demandé de choisir où sauvegarder le fichier, à un

endroit facile à retrouver, par exemple sur le bureau

* Maintenant, le fichier se charge. Comme en général, les fichiers MIDI sont très petits, cela ne

doit prendre qu’une seconde ou deux.

Félicitations! Vous avez maintenant chargé un fichier MIDI – en fait toutes les étapes décrites ci-

dessus peuvent être utilisées pour n’importe quel type de fichier sur le web.

Vérifiez le nom du fichier MIDI et l’endroit où il est sauvegardé (normalement sur le bureau), puis

ouvrez Sibelius, et suivez les étapes décrites début de cette rubrique dans Importer un fichier
MIDI.

Faites attention au fait que si vous chargez ou publiez les fichiers MIDI de quelqu’un d’autre sans

autorisation, vous ne respectez probablement pas les règles de copyright. Outrepasser le copyright

est illégal et dans tous les cas est interdit dans le contrat de licence de Sibelius.

La plupart des partitions mentionne un copyright et leur titulaire. Si vous n’êtes pas sûr du statut

du copyright du fichier MIDI chargé, contactez-en l’éditeur, le compositeur ou l’arrangeur.

http://www.google.com/
http://www.prs.net/
http://www.musicrobot.com/
http://www.cpdl.org/
http://www.cyberhymnal.org/
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9.6 Ouvrir des fichiers MusicXML

Le convertisseur intégré de Sibelius vous permet d’ouvrir des fichiers au format MusicXML créés

avec de nombreux programmes de musique dont Finale version 2003 et ultérieure et SharpEye.

Le but du convertisseur de fichier est de vous faire gagner du temps, pas de convertir chaque parti-

tion de façon à ce qu’elle soit parfaitement identique à l’originale.

Qu’est-ce le format MusicXML?
Le MusicXML est un format de fichier de conversion pour les programmes d’écriture musicale.

Il permet de transférer de la notation entre différents programmes bien mieux que d’autres for-

mats comme celui des fichiers MIDI.

Créer des fichiers MusicXML dans Finale
La manière de créer des fichiers MusicXML dans Finale dépend de la version de Finale que vous

utilisez :

* Finale 2006 ou ultérieure : choisissez Fichier > MusicXML > Exporter

* Finale 2003, 2004 ou 2005 (Windows uniquement) : choisissez Extensions > Exporter

MusicXML > Export

Si vous utilisez Finale 2004 ou Finale 2005 sur Mac OS X, ou si vous utilisez une version antérieure

à Finale 2003 sous Windows, l’extension Dolet est nécessaire pour exporter les fichiers MusicXML.

Si vous utilisez Dolet, vous pouvez exporter un fichier MusicXML en choisissant Extensions >

MusicXML > Exporter MusicXML.

L’extension Dolet complète vous permet de bénéficier du support de fichiers Finale supplémen-

taires, d’une plus grande précision dans les conversions des fichiers réalisés avec Dolet pour Sibe-

lius, et la possibilité d’exporter la notation des percussions, les tablatures, les styles de portée, les

lignes personnalisées et les crochets. Rendez-vous sur www.recordare.com pour en savoir plus.

Ouvrir un fichier MusicXML
Les fichiers MusicXML possèdent en général un ou deux fichiers d’extensions: les fichiers

MusicXML non compressés ont l’extension .xml, et les fichiers compressés MusicXML 2.0 ou supé-

rieur ont l’extension .mxl. Sibelius peut ouvrir ces deux types de fichiers MusicXML.

Ouvrir un fichier MusicXML se fait comme un fichier Sibelius

normal: choisissez Fichier > Ouvrir (raccourci Ctrl+O ou XO),

localisez le fichier et cliquez simplement sur Ouvrir. Sibelius

affichera une boîte de dialogue, telle qu’illustrée ici à droite avec

les options suivantes:

* Utiliser le format de page et la taille de portée du fichier
MusicXML est activé par défaut si le fichier MusicXML ouvert

a été créé avec la version 1.1 ou ultérieure ; avec cette instruc-

tion Sibelius essayera de conserver le format de page et la

taille de la portée du fichier MusicXML file. Si vous la désacti-

vez, vous pourrez régler le format de papier et son orientation

http://www.recordare.com/
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pour le fichier MusicXML importé, et Sibelius utilisera la taille de portée par défaut telle que

déterminée par le style maison choisi plus bas dans la boîte de dialogue.

* Utiliser la mise en page et la mise en forme du fichier MusicXML est aussi activé par

défaut si le fichier MusicXML ouvert a été créé avec la version 1.1 ou ultérieure; avec cette ins-

truction Sibelius essayera de conserver la mise en page et la mise en forme (par exemple les dis-

tances entre les portées, les sauts de système et de page, etc.) du fichier MusicXML original.

Si vous désactivez cette option, Sibelius débloquera la mise en forme de la partition obtenue et

utilisera la mise en page et la mise en forme par défaut.

* Style maison permet d’importer un style maison spécifique dans la partition obtenue ; si vous

laissez ce réglage sur Inchangé, Sibelius utilisera le style maison par défaut. Si vous choisissez

un autre style maison, notez que le format de page et la taille des portées spécifiés dans le style

maison ne seront pas utilisés dans la partition obtenue sauf si Utiliser le format de page et la
taille des portées du fichier MusicXML est désactivé.

* Laissez à Sibelius le choix des instruments donne l’instruction à Sibelius de tenter d’identi-

fier automatiquement les instruments dans le fichier MusicXML. Si malgré tout Sibelius crée des

instruments incorrects, importez le fichier à nouveau, et désactivez cette option, ce qui, après

avoir cliqué sur OK, entraînera l’affichage de cette boîte de dialogue :

% La liste de gauche Instruments dans le fichier affiche les parties individuelles dans le fichier

MusicXML file

% Dans le but que les portées soit affichées dans la liste Instruments dans le fichier, utilisez les

listes Ensemble, Famille et Disponible pour choisir les instruments Sibelius que vous voulez

utiliser pour chaque partie (un peu comme dans la boîte de dialogue Instruments) ; ensuite,

soit double-cliquez sur l’instrument soit cliquez sur Ajouter pour l’ajouter à la liste de droite

Instruments à créer.

% Quand toutes les parties ont été assignées comme instruments Sibelius, le bouton OK devient

actif; cliquez-le pour finir l’ouverture du fichier.

* Utiliser les noms d’instruments du fichier MusicXML donne l’instruction à Sibelius de

régler les noms d’instruments en début de système selon les noms spécifiés dans le fichier

MusicXML. Si vous souhaitez que Sibelius utilise plutôt les noms d’instruments par défaut,

désactivez cette option.
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Quand toutes ces options sont réglées comme il convient, cliquez sur OK, et le fichier MusicXML

sera importé. Vous pouvez ensuite vérifier et modifier le fichier selon ce qui est nécessaire.

Messages d’avertissement
Certains fichiers MusicXML peuvent contenir des erreurs, qui seront affichées dans une boîte de

dialogue énumérant chaque erreur et l’endroit où elle apparaît dans le fichier ouvert. Les erreurs

peuvent être de trois types :

* Erreurs fatales : si le fichier n’est pas d’un format de XML valide, l’erreur est fatale et le fichier ne

peut être ouvert

* Erreurs de validation : Si le fichier est d’un format XML valide, mais dont certains éléments pré-

sentent des erreurs ou des incohérences de syntaxe spécifique au MusicXML, alors Sibelius ten-

tera d’ouvrir le fichier, mais la partition obtenue pourra ne pas correspondre à ce qui est attendu,

et donc l’opération pourrait s’avérer délicate

* Avertissements : La fonction de validation du XML affiche parfois des messages d’alerte à

l’ouverture des fichiers XML. Cela ne devrait pas empêcher l’ouverture correcte du fichier.

Importer des fichiers MusicXML sauvegardés dans un séquenceur
La fonction de Sibelius pour importer des fichiers MusicXML est optimisée pour donner le meilleur

résultat en ouvrant des fichiers MusicXML sauvegardés directement depuis Finale ou en utilisant

l’extension de Finale, Dolet. Dans des circonstances exceptionnelles, certains fichiers MusicXML,

particulièrement ceux créés avec des séquenceurs sans possibilité de notation, ne pourront rien

produire comme notation.

Versions supportées
Le convertisseur MusicXML de Sibelius s’appuie sur le MusicXML 2.0. Les fichiers créés avec une

version antérieure des formats MusicXML s’ouvrent correctement, pourvu qu’ils soient valides. Les

fichiers créés avec les futures versions de MusicXML devraient aussi s’ouvrir, mais la majorité des

nouvelles fonctions ne seront pas importées.

Sibelius peut seulement ouvrir des fichiers MusicXML qui sont appelés partwise.dtd top-level

DTD (Document Type Definition). Si vous utilisez le timewise.dtd DTD, vous devrez utiliser

XSLT pour convertir votre fichier timewise MusicXML en fichier partwise MusicXML. Un tel

convertisseur est disponible à l’adresse: www2.freeweb.hu/mozartmusic/pttp/con-
verter.html.

Conversion globale d’un ensemble de fichiers
Sibelius inclut une extension qui convertit en une opération un dossier complet de fichiers

MusicXML. Pour l’utiliser, choisissez Extensions > Traitement global > Convertir un dossier de
fichiers MusicXML Convertir un dossier de fichiers MusicXML à la page 549.
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Restrictions
Les restrictions sont résumées ci-dessous.

Fonction Restrictions

Armure Seul les modes majeur et mineur sont reconnus par l’élément mode.

Si l’élément quintes est manquant, l’armure sera importée comme une armure atonale.

Les éléments pour les enfants Autre armure (par ex. Intervalle-armure et modifier-armure) sont

ignorés

Si une partie a plus d’une portée, les armures sont omises sur une ou plusieurs de ces portées.

L’armure placée après la barre de mesure peut se retrouver sur la barre dans Sibelius.

Articulations Quelques articulations sont positionnées du mauvais côté de la note ou de l’accord.

Les éléments technique et ornements ne sont pas importés.

Barres de mesure Si différentes portées présentent plusieurs types de barres de mesure en même temps, Sibelius

utilisera le type de la partie supérieure.

Les barres de mesure Épaisse, demi-épaisse et très épaisse ne sont pas importées.

Clés Les clés de percussion et de tablature du fichier MusicXML seront remplacées par les clés de Sibelius

qui correspondent le mieux..

MusicXML ne peut pas faire la différence entre les clés au début ou à la fin d’une mesure.

Hampes Les valeurs de hampe aucune et double ne sont pas importées.

Indications de mesure Sibelius n’importera pas les mesures composées (par ex. 2/4 + 6/8); seules les divisions au numérateur

(par ex. 2+3 / 4) seront importées.

Les éléments Senza-misura ne sont pas importés.

La valeur d’attribut chiffre seul pour le symbole n’est pas importé (si elle existe elle est importée

comme normale)

Si différentes indications de mesure apparaissent sur différentes portées en même temps, Sibelius

utilisera l’indication de la portée supérieure.

Indications

métronomiques

Les indications métronomiques contenant des quintuple, quadruple, triple croches ou des maximes

ne sont pas importées par Sibelius.

Toutes les indications métronomiques suivent les positions de Sibelius par défaut.

Seule l’indication métronomique au-dessus de la portée supérieure est lue lors de l’importation du

XML.

Les indications métronomiques peuvent être dédoublées si la partie supérieure d’un fichier comporte

plus d’une portée.

Les lignes de reprise La position des lignes de reprise de fin doit parfois être ajustée manuellement après importation.

Les silences Les silences supplémentaires qui apparaissent quand il y a plusieurs voix sur la même portée sont

automatiquement enlevés, mais des silences supplémentaires peuvent apparaître, par ex. dans les pas-

sages entre portées.

Les symboles d’accord Quelques symboles d’accord peuvent ne pas être importés (quand ils utilisent un élément fonction).

Le MusicXML spécifie que tous les accords se placent au-dessus de la portée d’une partie exclusive-

ment.

Les différents Types, napolitain, italien, français, allemand, pédale (pédale de basse
tenue) et Tristan sont tous importés comme accords majeurs.

Si l’élément fonction n’est pas présent dans l’élément harmonie, le symbole d’accord n’est pas

importé.

Liaisons de legato L’attribut continue n’est pas importé

Les attributs position et bezier ne sont pas importés.

placement et orientation ne sont pas importés.

Liaisons rythmiques L’élément Liaison est complètement ignoré ; seules les liaisons spécifiées par l’élément lié sont impor-

tées.

L’attribut Chiffre est ignoré.

Toutes les liaisons sont importées comme liaisons solides.

Les attributs position, placement, orientation, bezier-offset, bezier-x et bezier-y ne sont pas

importés.
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Ligatures Les ligatures secondaires ne sont pas importées.

Mise en page Sibelius ne peut utiliser qu’un seul format de page pour toute la partition importée.

Les objets qui sont seulement graphiques dans le fichier d’origine peuvent être exécutés dans Sibelius.

Multiplets Certaines versions de l’extension Dolet pour Finale ne placent pas les extrémités des multiplets au

bons endroits, ce qui peut provoquer une mauvaise importation

Les attributs Multiplet placement, position, afficher-type, afficher-chiffre, crochet et

forme de ligne ne sont pas importés.

Notes entre portées Si des voix passent d’une portée à l’autre, certaines notes peuvent se retrouver sur la mauvaise portée.

Les fichiers contenant des notes dans des portées différentes peuvent être mal importés.

Ornements Quelques ornements ne sont pas importés. Les mordants, les trilles et les grupetti sont importés.

Paroles Les éléments rire, fredonnement, fin de ligne, fin de paragraphe et éditorial sont ignorés.

Portées Les changements de type de portée ne sont pas importés.

Symboles Les symboles ne sont pas importés.

Texte Certains éléments de texte sont importés par l’élément nuances, mais aucun attribut des nuances

n’est importé.

Des éléments de la basse chiffrée tels que parenthèses, élision et étendue ne sont pas importés.

L’élément directif n’est pas importé

Fonction Restrictions
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9.7 Ouvrir des fichiers de versions 
anciennes

Sibelius est totalement rétro-compatible. Sibelius 6 peut ouvrir les fichiers de toutes les versions

précédentes de Sibelius, y compris des fichiers sauvegardés dans Sibelius Student, Sibelius First et

G7. Il suffit de choisir Fichier > Ouvrir et d’ouvrir la partition normalement.

Boîte de dialogue Mise à jour de partition
Comme chaque nouvelle version de Sibelius présente un

nouveau jeu de fonctions, à l’ouverture d’une partition déjà

existante, vous sera proposée la boîte de dialogue Mise à jour
de partition dans laquelle vous pouvez choisir quels aspects

de la partition doivent être mis à jour, s’il y a lieu de le faire.

(vous ne pourrez choisir que les options qui ne sont pas

disponibles dans la version de Sibelius avec laquelle la

partition a été sauvegardée.)

Les options sur la boîte de dialogue principale Mise à jour de
partition sont les plus importantes, et donnent ces résultats :

* Créer des parties dynamiques va créer un jeu de parties

dynamiques par défaut s’il est activé (b 7.1 Travailler
avec des parties séparées).

* Utiliser les mêmes sons que la version précédente (où
c’est possible) permet de choisir si Sibelius va essayer de

conserver pour chaque portée de la partition le même son qui était utilisé dans la version 4 ou

antérieure. Cette option ne fonctionnera que si des jeux de sons compatibles avec les

périphériques utilisés la dernière fois que la partition a été sauvegardée.

* Jouer les reprises détermine si Sibelius doit tenir compte de toutes les barres de reprise de la

partition. Normalement cette option est désactivée car elle était activée par défaut dans les

versions antérieures de Sibelius; si cependant ce réglage par défaut était désactivé, il faut le

réactiver ici pour garantir une exécution et un affichage correct des numéros de mesure dans la

partition.

* Conserver des groupements de ligature personnalisés détermine si Sibelius doit conserver

toute modification individuelle apportée aux groupes de ligature dans la partition.

Normalement, cette case doit rester cochée pour veiller à ce que les groupes de ligature ne soient

pas modifiés quand vous ouvrez la partition: si vous souhaitez ensuite réinitialiser les groupes de

ligature à leurs nouveaux réglages par défaut, utilisez Notes > Réinitialiser les groupements
(b 2.6 Groupement des ligatures).

* Utiliser mise en page magnétique vous permet d’éviter automatiquement la collision pour

votre partition. Il vaut mieux laisser cette option activée: Si vous souhaitez ensuite désactiver la

mise en page magnétique dans votre partition, désactivez simplement Mise en page > Mise en
page magnétique (b 8.2 Mise en page magnétique).
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* Convertir le texte Symbole d’accord met à jour les symboles d’accord basés sur du texte dans

Sibelius 5 et antérieur en objets de symbole d’accord plus récents et plus intelligents. Leur aspect

d’origine sera conservé jusqu’à ce que vous les sélectionniez et choisissiez Mise en page >

Rétablir l’aspect original. Sibelius ne parvient qu’à mettre à jour des symboles d’accord

utilisant l’une des propres polices de symbole d’accord de Sibelius; si vous avez utilisé une police

de symbole d’accord non fournie avec Sibelius, il ne pourra pas les convertir (b 2.10 Les
symboles d’accord).

Cliquer sur le bouton Plus d’options vous permettra d’utiliser des nouvelles options qui

permettent d’améliorer la présentation de la partition :

* Liaisons magnétiques sur les notes normales rend magnétiques les liaisons au-dessus ou en

dessous des notes, de sorte que les deux extrémités de chaque liaison sont attachées à la note ou

à l’accord le plus proche (b 2.28 Liaisons de phrasé)

* Liaisons magnétiques sur les notes qui enjambent les portées fonctionne de manière

identique, mais s’applique uniquement aux notes qui enjambent les portées (par ex. dans la

musique pour clavier) (b 2.28 Liaisons de phrasé)

* Règle de longueur des hampes Version 1.3 est une option qui, activée, allonge les hampes

des hampes de 0.25 dents de plus que ne le fait l’option désactivée, et cela de part et d’autre de la

ligne médiane de la portée, ce que préfère la plupart des graveurs et des éditeurs

* La règle de positionnement des voix a été améliorée dans Sibelius 2 ; dès lors si vous souhaitez
l’appliquer aux anciennes partitions, activez Règle de position des voix Version n°2
(b 2.36 Voix)

* Multiplets magnétiques garantit que les chiffres et les crochets des multiplets sont positionnés

correctement au-dessus ou en dessous des notes du multiplet en fonction de sa position sur la

portée (b 2.35 Triolets et autres multiplets)

* Adapter l’enharmonie des notes des instruments transpositeurs dans les tonalités
éloignées établit que l’enharmonie des notes des instruments transpositeurs est correcte

(b 2.18 Instruments et portées)

* Autoriser la contraction des espaces entre les notes et les portées permet de se

conformer avantageusement aux algorithmes d’espacement améliorés de Sibelius pour resserrer

l’espacement horizontal et vertical dans les nouvelles partitions (b 8.9 L’espacement entre
les notes)

* Position des ligatures en mode Optical applique les positions des ligatures en mode Optical

(b 2.7 Positions des ligatures).

* Liaisons en mode Optical applique les positions des liaisons en mode Optical

(b 2.32 Liaisons rythmiques).

* Espacement en mode Optical ne tient pas compte des ajustements de l’espacement réalisés

manuellement mais applique à la place la règle de Sibelius en mode Optical

(b 8.9 L’espacement entre les notes).

* Ne pas tenir compte des objets masqués pour l’orientation des hampes et le
placement des silences devrait resté activé, à moins que vous vous rappeliez avoir inversé les

hampes et changé la position verticale des silences dans la partition et que vous souhaitiez

conserver ces modifications.
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* Règle de position du texte vertical selon la version 5 devrait être activé, à moins que vous

ayez ajusté la position verticale des objets textuels (tels que les numéros de mesure) placés trop

près d’une portée dont le nombre de lignes de portée a été modifié après un changement

d’instrument.

* Modifier la longueur des hampes pour éviter les silences dans les ligatures applique une

règle améliorée pour la position des ligatures, en les déplaçant de manière à ce qu’elles n’entrent

pas en collision avec les silences (b 2.7 Positions des ligatures).

* Indications de précaution automatiques active la fonction automatique des altérations de

précaution de Sibelius, qui indique une altération de précaution pour une note dans la mesure

précédente comportant une altération (b 2.1 Altérations).

* Positionnement des liaisons sur notes à hampes mélangées au-dessus des notes une

règle améliorée pour la direction des liaisons de legato : si toutes les notes sous l’ambitus de la

liaison comportent des hampes pointant vers le haut, la liaison s’incurvera en dessous des notes;

si l’une des notes comporte des hampes pointant vers le bas, la liaison s’incurvera au-dessus des

notes (b 2.28 Liaisons de phrasé).

* Etendre les crochets des multiplets à la dernière note du multiplet réinitialise la durée

des multiplets pour vous permettre d’utiliser un positionnement amélioré des extrémités droite

et gauche des crochets de multiplets (b 2.35 Triolets et autres multiplets).

Autres réglages à prendre en compte
Il existe plusieurs réglages plus subtils à prendre en compte après avoir ouvert une partition créée

dans une version antérieure de Sibelius :

* Pour les articulations, il est recommandé d’activer Nouvelle règle de positionnement
d’articulation sur la page Articulations de Style maison > Règles de gravure. Cette option

changera la position des articulations figurant hors de la partition sur les notes à hampe basse

au-dessus de la ligne intermédiaire de la portée, et modifiera également la position des

articulations (ex. staccato, tenuto) à l’intérieur de la portée pour les notes à hampe haute au-

dessus de la ligne intermédiaire de la portée (ex. notes inversées). Si vous avez auparavant tiré

une articulation afin de parvenir au positionnement correct, vous devez sélectionner ces notes et

utiliser Mise en page > Réinitialiser la position pour voir l’effet de la Nouvelle règle de
positionnement d’articulation. De même, si vous préférez suivre la convention par laquelle

les accents doivent être positionnés à l’intérieur des liaisons, activez la case appropriée Dans la

liaison de phrasé pour cette articulation.

* Pour les altérations, en plus d’activer les options automatiques d’altération de précaution sur la

page Altérations de Style maison > Règles de gravure, vous pouvez aussi désactiver

Réinitialiser les altérations à l’armure actuelle au changement de clef sur la page Clefs et
armures, qui veille à ce que les notes suivant les changements de clé au milieu d’une mesure

suivent les conventions normales concernant les altérations avant le changement de clé dans la

même mesure.

* Pour l’espacement de portée, envisagez de désactiver Justifier les deux portées d’instruments
de grande portée et de configurer des valeurs pour les nouvelles options n dents
supplémentaires… sur la page Portées de Style maison > Règles de gravure.



9. Fichiers

738

* Pour les nuances sur les portées vocales, désactivez la nouvelle option Portée vocale dans la

boîte de dialogue Modifier l’instrument pour les instruments vocaux dans votre partition, puis

activez la nouvelle case Autre position par défaut sur portées vocales dans Style maison >

Positions par défaut pour le texte d’expression et les divers styles de ligne de soufflet et

définissez des valeurs adaptées pour les positionner au-dessus de la portée par défaut.

* Pour la mise en page magnétique, essayez de sélectionner des objets et de choisir Mise en
page > Réinitialiser la position pour améliorer notablement l’aspect de votre partition.

La plupart des options ci-dessous peuvent être rapidement définies à leurs réglages recommandés

en important l’un des styles maison proposés – b 8.8 Style maison.
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9.8 Exporter des images

Avec Sibelius, on peut exporter (sauvegarder) un passage ou une page de musique sous divers

formats de fichiers d’images, et même copier-coller des images directement dans une autre

application telle que Microsoft Word. Il est donc possible d’inclure des partitions ou des extraits

dans d’autres documents, par exemple des articles, des essais, des couvertures de livres de

musique, etc.

D’ailleurs tous les exemples de cet ouvrage de Référence ont été exportés directement de Sibelius

dans Adobe FrameMaker – sans colle, ni ciseaux !

Au contraire, si votre document final contient principalement de la musique, vous pourrez utiliser

Sibelius comme programme pour assembler la musique et les images importées –

b 9.4 Importer des images.

Copier des images dans le presse-papiers 
Sibelius permet de copier une surface d’une partition dans le presse-papiers, que vous pouvez

ensuite coller directement dans un autre programme en tant qu’image.

* Si vous voulez exporter une mesure ou un passage spécifique, sélectionnez-le d’abord

* Choisissez Édition > Sélection > Sélectionner une image (raccourci Alt+G ou zG)

* Si vous avez fait une sélection, un cadre en pointillé apparaît autour de la sélection. Si vous

n’avez pas fait de sélection, le curseur se transformera en croix et en cliquant et déplaçant la

souris, vous pourrez sélectionner la surface de la partition à exporter.

* Ajustez la taille de la surface (cf. ci-dessous) en englobant exactement ce qu’il faut copier

* Choisissez Édition > Copier (raccourci Ctrl+C ou XC)

* Activez l’application de destination et choisissez Édition > Coller (raccourci probable Ctrl+V ou

XV) ou Édition > Collage spécial.

Vous pouvez régler la résolution de l’image et choisir dans la page Autres de Fichier > Préférences
(dans le menu Sibelius sur Mac) de l’exporter en monochrome ou en couleur –

b 5.15 Préférences.

Quand vous utilisez le copier-coller pour exporter une image, Sibelius produit une image bitmap.

Si vous souhaitez une image vectorielle, utilisez plutôt la boîte de dialogue Exporter des images –

cf. Exporter des images ci-dessous .

Ajuster la surface
Pour ajuster la surface, vous pouvez :

* Cliquer et déplacer une poignée pour étendre la surface dans une direction

* Vous pouvez faire correspondre les bords de la surface avec des barres de mesure en maintenant

Ctrl ou Xenfoncé et en déplaçant les poignées vers la gauche ou vers la droite

* Modifiez de manière proportionnelle la surface, par exemple pour englober une portée, en

maintenant enfoncée la touche Maj tout en déplaçant une poignée.
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Si avant de faire les opérations décrites ci-dessus vous avez préalablement fait une sélection de

passage ou de système, en choisissant Édition > Sélectionner > Sélectionner des images,
Sibelius installera automatiquement un cadre autour de cette surface.Le cadre correspondra au

sommet et au bas des portées, nécessitant probablement d’étendre la sélection au-delà, au-dessus

et en dessous. Pour réaliser cela, maintenez Maj enfoncé et déplacez la poignée supérieure vers le

haut.

Insérer des images dans Microsoft Word
Voici comment faire pour placer dans un document Word une image créée dans Sibelius et copiée

dans le presse-papiers:

* Positionnez le curseur dans votre document Word à l’endroit d’insertion de l’image

* Choisissez Édition > Coller, raccourci Ctrl+V ou XV. L’image apparaîtra dans votre document.

* Maintenant, augmentez ou diminuez la taille de la musique en déplaçant avec la souris un coin

du cadre. Ne déplacez pas un bord, sinon la musique va rétrécir sans conserver ses proportions.

(Tapez Ctrl+Z ou XZ pour annuler si d’aventure cela vous arrivait.)

Dans quelques versions de Microsoft Word, il peut arriver que coller une image créée dans un

autre programme ne fonctionne pas convenablement. Si vous êtes dans ce cas, choisissez Édition >

Coller de manière spéciale et dans la liste des formats disponibles, choisissez Bitmap.

Attention avec l’édition d’images dans Word ; son éditeur graphique ne gère pas parfaitement la

musique et peut parfois produire des résultats inattendus. L’idéal est d’utiliser un programme de

mise en page capable de gérer spécifiquement les images.

Exporter des images
Au lieu d’utiliser le presse-papiers, vous pouvez exporter un fichier d’images sur le disque.

Parce que la plupart des gens n’aiment pas trop ce qui est technique, Sibelius s’occupe de tout lors

de l’exportation des fichiers d’images ; il n’est donc pas nécessaire de connaître le type de fichiers

qu’il faut exporter ; seul connaître le programme de destination suffit.

Sibelius peut exporter très simplement toute la partition, une seule page, voire plusieurs systèmes :
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* Pour exporter un ou plusieurs systèmes, sélectionnez les passages désirés et choisissez Fichier >

Exporter > Images .Dans la boîte de dialogue Exporter des Images, cliquez sur Systèmes
sélectionnés.

* Pour exporter une ou plusieurs pages, ou toute la partition, choisissez Fichier > Exporter >

Images. Dans la boîte de dialogue Exporter des Images, cliquez sur Toutes ou Pages et entrez

les numéros de page que vous souhaitez exporter.

* Pour exporter une partie spécifique de la partition, faites une sélection de passage de la surface à

exporter, puis choisissez Édition > Sélectionnez > Image (raccourci Alt+G ou zG). Avec le

curseur affiché sous forme de croix, sélectionnez la surface voulue en déplaçant les poignées (cf.

ci-dessus), puis choisissez Fichier > Exporter >Images et cliquez sur Sélection d’image.

La boîte de dialogue Exporter des Images propose les options suivantes :

* Programme/Format : énumère tous les programmes directement supportés par Sibelius; vous

verrez aussi les différents formats dans lesquels vous pouvez exporter votre partition, de sorte

que si le programme choisi ne se trouve pas dans la liste, vous pourrez choisir le format le plus

approprié

* Nom de fichier : détermine le nom de fichier attribué au fichier d’images exporté: si vous

sauvegardez plusieurs pages, le nom entré ici forme la base de chaque nom de fichier (qui est

suivi par le numéro de page de la partition), et en option aussi le nom du fichier

* Sauvegarder dans le dossier : vous permet de choisir l’emplacement de sauvegarde du ou des

fichiers d’images ; cliquez sur Parcourir et choisissez le dossier adéquat

* Créer un sous-dossier : si vous choisissez d’exporter plusieurs pages ou toute la partition et que

cette option est active, Sibelius créera un dossier pour mettre tous les fichiers graphiques, et par

défaut, ce dossier portera le même nom que le fichier ; ainsi, si vous nommez un fichier

Concerto 1er mouvt et que vous l’exportez en EPS, le dossier portera le nom Concerto 1er
mouvt EPS.

* Images EPS : cette option (comme le nom le suggère) permet d’exporter des fichiers au format

EPS :

% Inclure une prévisualisation TIFF : permet d’inclure une prévisualisation au format TIFF

monochrome dans le fichier EPS, ce qui autorisera la plupart des programmes graphiques à

afficher une prévisualisation en basse résolution du fichier EPS avant l’impression

% Polices incorporées : avec cette option activée, Sibelius incorpore dans le fichier EPS toutes

les polices utilisées dans le document. Bien que l’incorporation de polices augmente la taille

de chaque fichier EPS créé, cela garantit que l’éditeur ou l’imprimeur qui recevra ce fichier

pourra l’imprimer correctement sans devoir gérer séparément des copies de polices. Il est

recommandé de laisser cette option activée, sauf si vous avez une bonne raison de ne pas le

faire.

* Taille : ces options contrôlent la taille des fichiers d’image sauvegardés ; différentes options sont

disponibles pour différents formats :

% Points par pouce (TIFF, PNG, BMP uniquement) : vous permet de contrôler la résolution

des images exportées. Plus élevée sera cette valeur, meilleure sera la résolution du fichier

exporté. La valeur donnée ici correspond à celle d’une imprimante laser ; ainsi, une valeur de

300 ppp donnera la même qualité qu’une impression laser à 300 ppp.
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% Ajuster la taille pour améliorer les portées (TIFF, PNG, BMP uniquement) : cette option

permet à Sibelius de faire des réglages plus fins aux paramètres Points par pouce/Échelle
afin de s’assurer que la distance entre toutes les portées du fichier exporté présente le même

nombre de pixels, ce qui améliorera leur apparence.

% Utiliser les plus petites dimensions : définit les dimensions du fichier graphique résultant.

Si cette option est désactivée, le fichier graphique utilisera les dimensions de la page (marges

comprises). Avec cette option activée, le fichier sera ramené à la plus petite taille possible, par

exemple juste la taille de la musique.

* Options : options avancées, certaines options ne sont valables que pour certains formats :

% Monochrome (TIFF, PNG, BMP uniquement) : à moins que vous ne deviez exporter une

partition contenant des objets colorés (ou des graphiques importés qui contiennent de la

couleur), laissez cette option activée. Sauvegarder des fichiers graphiques monochromes

réduira leur taille, sans diminuer leur qualité.

% Anti-crénelage (TIFF, PNG, BMP uniquement) : si vous exportez des images bitmap à une

faible résolution pour l’affichage plutôt qu’une impression de haute qualité, activer cette

option améliorera leur apparence ; cette option est disponible uniquement si Monochrome
est désactivé.

% Inclure les options du menu Affichage : cette option spécifie si les options du menu

Affichage (comme les objets cachés, surlignés, les notes en couleur, etc.) doivent être visibles

dans le fichier d’image. Cette option est par défaut désactivée.

% Inclure les objets colorés : si cette option est désactivée (ou si l’option Monochrome est

activée) tous les objets colorés de la partition seront noirs dans le fichier d’image exporté.

% Substituer : cette option aura la même utilité que dans la boîte de dialogue Imprimer

(b 5.16 Imprimer), c’est-à-dire qu’elle corrigera les bogues de certaines logiciels d’image

dans lesquels les lignes et les accolades pourraient ne pas être affichées correctement.

Lorsque vous avez spécifié ces options, cliquez sur OK pour exporter le(s) fichier(s) d’image.

Conversion globale d’un ensemble de fichiers
Sibelius comprend une extension qui peut automatiquement convertir toutes les partitions d’un

dossier en images – cf. dans Convertir un dossier de partitions vers des images à la page

550.

Formats d’image
Il y a deux types de formats d’image : vectoriel et bitmap. 

Les images vectorielles peuvent être étirées – en d’autres mots, vous pouvez les rendre plus

grandes ou plus petites sans dégradation de qualité – et les fichiers ont tendance à utiliser moins

de mémoire que les images bitmap.

Les images bitmap ont une qualité moindre que les images vectorielles (à moins d’utiliser une très

haute résolution) et occupent habituellement plus de mémoire, mais sont supportés par un plus

grand nombre d’applications.

Les formats disponible dans Sibelius sont :

* Vectoriel : EPS (Windows et Mac)
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* Bitmap : TIFF (Windows et Mac), BMP (Windows).

Chacun de ces formats est détaillé ci-dessous. Vous pouvez également créer des fichiers au format

PDF depuis Sibelius - cf. ci-dessous Créer des fichiers PDF.

Fichiers PostScript (EPS) encapsulés
La plupart des éditeurs et imprimeurs préfèrent recevoir la musique dans le format EPS ou PDF

pour la publication, et Sibelius vous permet d’exporter votre musique directement dans ce format.

Les fichiers EPS ne sont pas imprimés sur les imprimantes non-PostScript avec la plupart des

programmes. En imprimant un fichier EPS sur une imprimante non-PostScript on peut obtenir

soit une page blanche, soit un avertissement indiquant l’impossibilité d’imprimer un fichier EPS

sur une imprimante qui ne supporte pas ce format, ou encore une impression en basse qualité de la

prévisualisation TIFF intégrée dans le fichier EPS.

Nous recommandons que vous incorporiez les polices dans les fichiers EPS ; Sibelius vous donne

l’autorisation d’utiliser les polices Opus et Inkpen2 chez l’éditeur ou l’imprimeur qui imprimera

vos fichiers EPS, mais vous devez vous assurer que vous avez la permission d’utiliser les polices

d’autres compagnies.

Vous pouvez créer des fichiers EPS dans Sibelius si vous utilisez les polices TrueType ou Type 1 ; les

polices TrueType sont installées par défaut (vous ne pouvez pas avoir les polices TrueType et

PostScript Type 1 installées simultanément) – reportez vous à Installer des polices musicales
de Type 1 dans b 8.11 Polices musicales. Cependant, il y a certaines restrictions à

l’utilisation des polices incorporées dans les fichiers EPS générés par Sibelius :

* Les polices de Type 42 ne sont pas supportées. Le format de police de Type 42 est une version

PostScript du standard TrueType. Tous les interpréteurs PostScript de niveau 3 (comme les

imprimantes) peuvent afficher les polices TrueType tant qu’ils sont conditionnés dans le format

de police PS Type 42 .

* Les contours des polices TrueType sont légèrement différents des contours des polices Postscript

de sorte que pour pouvoir être incorporées dans les fichiers EPS sans perte d’informations, elles

doivent être converties du TrueType vers le Type 3. Il peut y avoir de légères différences d’aspect

entre les polices intégrées d’un fichier EPS et la police originale au format TrueType, bien que

dans la plupart des cas cette différence soit indétectable.

* Seules les polices avec des caractères latins peuvent être incorporées

* Les polices OpenType avec des bordures TrueType peuvent être incorporées ; les polices

OpenType avec les bordures PostScript ne pourront pas l’être.

* Les polices Multiple Master peuvent être incorporées, mais les polices incorporées ne seront pas

affichées exactement de la même manière que les polices multiple master utilisées

* Les polices Macintosh PostScript Type 1 (SFNT) et Macintosh PostScript Type 1 CID (SFNT/

CID) ne peuvent pas être incorporées.

Certains programmes graphiques sur MAC (par exemple Corel Draw 8) peuvent générer une

erreur lors de l’ouverture de fichiers EPS créés avec Sibelius ; si vous obtenez un message d’erreur,

essayez de sauvegarder le fichier EPS depuis Sibelius sans l’option de prévisualisation TIFF.
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Si vous importez des fichier EPS dans Adobe Illustrator version 9.0, nous vous recommandons de

désactiver l’option, Type > Smart Punctuation, car cette fonction a pour effet de changer certains

caractères, ce qui peut faire disparaître certains symboles des polices Opus and Inkpen2 .

Si vous importez des fichiers EPS dans Adobe PageMaker, vous pouvez voir apparaître un message

lors de l’impression du document vous avertissant que la police dans le fichier EPS ne peut pas être

trouvée. Le fichier EPS ayant les polices incorporées, le document s’imprimera correctement,

malgré cet avertissement.

Fichiers TIFF
TIFF (Tagged Image File Format) est un format bitmap largement supporté, et particulièrement

adapté à la musique car il peut être compressé efficacement. Si vous ne pouvez pas utiliser

d’images EPS (par exemple parce que vous ne possédez pas d’imprimante PostScript), nous vous

recommandons d’utiliser ce format.

L’exportation d’un fichier TIFF peut prendre beaucoup de mémoire ; cependant, il est possible

d’exporter des pages entières à plus de 1200 ppp sans aucun problème. A moins que vous n’ayez

besoin de couleur dans vos fichiers TIFF, gardez la fonction Monochrome activée car ceci

minimise la taille des fichiers sauvegardés.

Fichiers PNG
Le PNG (Portable Network Graphics) est un autre format bitmap répandu dont le taux de

compression est excellent. Le PNG n’est pas aussi répandu que le TIFF dans les programmes de

mise en page, mais c’est le format idéal pour placer des images de vos partitions sur Internet,

notamment lorsque l’option anti-crénelage est activée.

Fichiers BMP
Le format BMP est similaire au TIFF et au PNG bien que moins largement supporté. La résolution

des couleurs du fichier BMP créé sera identique à celle des réglages d’affichage, à moins que ne soit

activée l’option Monochrome dans la boîte de dialogue Fichier > Exporter > Images, ce qui

rendra le fichier moins volumineux. En général, il est recommandé d’utiliser le format PNG plutôt

que le format BMP car les fichiers produits sont plus petits, même s’ils comportent de la couleur.

Créer des fichiers PDF
Le format de fichier PDF (Portable Document Format) permet à des documents générés par des

logiciels de traitement de texte ou de mise en page d’êtres publiés électroniquement en préservant

leur apparence originale, pour être consultés et imprimés sur n’importe quel système.

Sur Mac, aucun logiciel additionnel n’est requis. Pour sauvegarder un fichier PDF de votre

partition, choisissez Fichier > Imprimer, et cliquez sur le bouton Sauvegarder au format PDF.

Sous Windows, Sibelius supporte la création de fichiers PDF pourvu que vous possédiez un logiciel

de création de PDF sur votre ordinateur. Le logiciel officiel pour cela est Adobe Acrobat, qui est un

produit commercial disponible à la fois pour Mac et pour Windows sur www.adobe.com, mais

dont plusieurs alternatives gratuites existent, dont notamment PDFCreator, que vous pouvez

télécharger sur:

http://pdfcreator.sourceforge.net

http://pdfcreator.sourceforge.net/


9.8 Exporter des images

745

Fichiers

Les fichiers PDF sont générés par des logiciels qui installent et agissent comme un pilote

d’imprimante. Cela signifie que la création d’un fichier PDF est aussi simple que l’impression d’un

fichier depuis Sibelius. Pour en savoir plus, consultez la documentation fournie avec votre logiciel

de création de fichiers PDF.

Pour visualiser des fichiers PDF, vous devez avoir le logiciel (libre d’utilisation) Adobe Reader

installé sur votre ordinateur (sur Mac OS X vous pouvez utiliser l’application Prévisualisation

incluse). Vous pouvez télécharger la dernière version de Adobe Reader à l’adresse:

http://www.acrobat.com

http://www.acrobat.com
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9.9 Exporter des fichiers MIDI

Toute partition peut être sauvegardée au format de fichier MIDI, ce qui permet de la transférer

dans n’importe quel autre programme de musique. Il n’est pas nécessaire de posséder une interface

MIDI pour faire cette sauvegarde.

Exporter un fichier MIDI
* Choisissez Fichier > Exporter > Fichier MIDI. Une simple

boîte de dialogue apparaît telle qu’illustrée à droite.

* On peut choisir d’exporter un fichier MIDI selon soit Les
périphériques de lecture usuels soit Un autre
périphérique de lecture. Par défaut, Sibelius exporte un

fichier MIDI lisible par un périphérique General MIDI, ce

qui est l’idéal pour, par exemple, envoyer la partition à

quelqu’un qui souhaite l’écouter. Cependant, si vous

utilisez un instrument virtuel et que vous souhaitez

exporter un fichier MIDI lisible par un instrument tel

qu’un séquenceur Pro Tools pour continuer à travailler sur

une exécution MIDI, choisissez le jeu de son approprié

dans la liste Un autre périphérique de lecture. Sibelius

exportera le fichier MIDI avec les changements adéquats de contrôleurs MIDI, de touches, etc.

* On peut aussi choisir d’exporter le fichier MIDI selon le Type 0 ou le Type 1. En général, le fichier

de Type 1 est recommandé. Cependant, certains périphériques tels des pianos électroniques et

des claviers, n’acceptent que des fichiers MIDI de Type 0. Consultez la documentation de votre

périphérique pour connaître le type de fichier MIDI compatible ; en cas de doute, choisissez le

Type 1.

* Résolution des impulsions est une option d’une clarté assez rassurante. Le réglage par défaut

de 256 PPQN (“Pulses Per Quarter Note” - Impulsion à la noire) correspondant à la résolution

interne de Sibelius est celui recommandé. Là encore, certains périphériques ne sont capables de

jouer les fichiers MIDI que selon un réglage spécifique de PPQN. Consultez la documentation de

votre périphérique pour savoir si un réglage précis est requis ; en cas de doute laissez ce réglage

sur 256. (Choisir une valeur de PPQN plus élevée n’améliore pas la précision du fichier MIDI

exporté, puisque la résolution interne de Sibelius est fixée à 256.)

* Exporter des mesures d’anacrouse en tant que mesures complètes avec des silences
vous permet de choisir la manière dont Sibelius doit traiter les mesures d’anacrouse (ou mesures

de levée) au début de la partition : avec cette option (activée par défaut), Sibelius exporte une

mesure d’anacrouse en tant que mesure de durée complète avec des silences à son lancement, ce

qui est idéal pour l’exécution. Toutefois, si vous exportez un fichier MIDI depuis Sibelius afin de

pouvoir l’utiliser en tant que piste de tempo dans un séquenceur ou un DAW pour ReWire sync,

il est plus utile d’exporter une mesure d’anacrouse initiale en tant que mesure courte avec une

indication de mesure différente de celle de la première mesure complète. Dans ce cas, cette

option doit être désactivée.



9.9 Exporter des fichiers MIDI

747

Fichiers

* Si vous avez mis en sourdine l’un des instruments dans votre partition, Sibelius n’inclura pas ces

instruments dans un fichier MIDI exporté (en partant du principe que le fichier MIDI doit lire

pareillement la partition que dans Sibelius). En revanche, vous souhaiterez peut-être inclure

tous les instruments dans votre fichier MIDI pour pouvoir travailler dessus dans votre

séquenceur. Dans ce cas, désactivez Ignorer instruments mis en sourdine.

* Dès que vous avez choisi les options correctes, cliquez sur OK. Tapez ensuite le Nom du fichier
que vous souhaitez utiliser – pour éviter toute confusion, prenez un nom différent du fichier

Sibelius original ! Déterminez l’emplacement de sauvegarde et cliquez sur Sauvegarder.

Lors de l’exportation de fichiers MIDI, Sibelius incorpore toutes les options d’exécution telles que

Espressivo, Rubato et style rythmique. De sorte que vous pouvez utiliser Sibelius comme un

ingénieux “improvisateur de fichier MIDI” – il suffit d’ouvrir le fichier MIDI, d’activer les réglages

d’exécution intéressants et de sauvegarder le fichier MIDI!

Conversion globale d’un ensemble de fichiers
Sibelius propose une extension qui convertit en une fois toutes les partitions contenues dans un

dossier en fichiers au format de fichier MIDI- cf. Convertir un dossier de partitions vers le
format MIDI à la page 550.

Rubato
Si cette option est activée dans la boîte de dialogue Exécution > Interprétation (raccourci Maj-P),

et que la partition est sauvegardée au format de fichier MIDI, les changements de tempo

provoqués par Rubato apparaîtront dans le fichier, et par conséquence, les notes seront “décalées”

lorsqu’on l’ouvrira dans un séquenceur.

Ceci est dû au fait que Rubato modifie la position de départ des notes directement, bien que des

changements de tempo soient créés. Donc, si vous voulez sauvegarder un fichier MIDI pour

l’utiliser dans d’autres programmes, réglez Rubato sur Meccanico avant d’opérer la sauvegarde

pour garantir une quantifié correcte.

Reprises
Par défaut, les fichiers MIDI contiendront toutes les reprises se trouvant dans la partition

originale. Si pour une raison quelconque, vous préférez qu’elles ne soient pas incluses, activez

l’option Ne pas jouer les reprises dans la boîte de dialogue Lecture > Répétitions avant de

sauvegarder le fichier MIDI.
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9.10 Exporter des fichiers audio

b 4.4 Sibelius Sounds Essentials.

Sibelius peut sauvegarder un fichier audio de votre partition, prêt à être gravé sur CD ou à être

converti en fichier MP3 idéal pour la diffusion sur Internet. Pour réaliser cette sauvegarde, vous

devez utiliser une configuration de lecture qui utilise un ou plusieurs instruments virtuels tels que

la bibliothèque livrée d’origine Sibelius Sounds Essentials (b 4.4 Sibelius Sounds
Essentials).

Exporter une piste Audio
Pour créer un fichier audio de votre partition en format WAV (on Windows) ou AIFF (Mac):

* Si vous utilisez des instruments virtuels en même temps que d’autres instruments MIDI pour

l’exécution, seules les portées exécutées avec les instruments virtuels pourront être sauvegardées

dans le fichier audio. C’est pourquoi avant de commencer, il convient de vérifier que la

configuration de lecture n’utilise que des instruments virtuels (b 4.12 Périphériques
d’exécution).

* Choisissez Fichier > Exporter > Audio ou cliquez sur le bouton de la barre d’outils

illustré ci-contre.

* Une boîte de dialogue apparaît, vous permettant de choisir l’emplacement de la sauve-

garde ainsi que le nom du fichier. Sibelius vous informera sur la longueur et sur la taille que le

fichier occupera sur le disque dur.

* Lorsque vous êtes satisfait du résultat, cliquez Sauver et l’exécution débutera. Sibelius exporte

les fichiers audio en off, c’est-à-dire qu’il ne joue pas la partition pendant qu’il travaille; en fait, il

dirige directement le flux des données audio dans le disque dur. Selon le niveau de complexité de

la partition et la vitesse de l’ordinateur, l’exportation peut prendre un temps plus ou moins long.

Cela présente l’avantage que si la partition est trop complexe pour que l’ordinateur soit capable

de la jouer sans défaut, comme des hoquets ou autres parasites, vous obtenez une bande-son

impeccable. Le temps de gravure est juste plus long que la lecture elle-même.

* Pour stopper l’enregistrement à n’importe quel moment, cliquez sur Annuler dans la barre de

progression des tâches que vous verrez à l’écran. Le fichier audio partiel sera sauvegardé jusqu’à

l’endroit spécifié. Vous pouvez utiliser cet enregistrement par exemple pour ouvrir une grande

partition.

Graver des fichiers audio sur CD
Si vous possédez un graveur de CD-R/RW et un logiciel adéquat, vous pourrez graver vos fichiers

nouvellement créés sur un CD. Veuillez vous reporter à la documentation fournie avec votre

logiciel pour connaître la marche à suivre pour graver votre CD.
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Créer des fichiers MP3
Le MP3 (ou MPEG Audio Layer 3 ) est le format le plus utilisé pour échanger de la musique par

Internet ou par courriel, car les fichiers sont moins lourds que ceux réalisés au format WAV ou

AIFF. Une fois que vous avez créé une piste audio depuis Sibelius, vous pouvez le convertir en

format MP3 en utilisant des logiciels gratuits. Par exemple:

* Mac: mAC3dec (http://sourceforge.net/projects/mac3dec/) réalise la conversion entre les

fichiers AIFF et les MP3 avec une simple interface de type glisser-déposer

* Windows: dbPowerAmp Music Converter (http://www.dbpoweramp.com/dmc.htm) permet

la conversion entre différents formats audio, d’un simple clic-droit dans Windows Explorer.

Beaucoup d’autres programmes peuvent convertir d’après et vers du MP3, comme par exemple

l’éditeur audio Audacity (http://audacity.sourceforge.net/), et QuickTime Pro

(http://www.apple.com/quicktime/pro/).

http://sourceforge.net/projects/mac3dec/
http://www.dbpoweramp.com/dmc.htm
http://audacity.sourceforge.net/
http://www.apple.com/quicktime/pro/
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9.11 Exporter des pages Web Scorch

b 5.18 SibeliusEducation.com, 5.19 SibeliusMusic.com.

Internet est le medium idéal pour donner à votre musique une audience mondiale pour un coût

minimum. L’extension gratuite de Sibelius, Scorch, permet à n’importe qui de lire, jouer,

transposer et imprimer les partitions que vous aurez déposées sur votre site web

(b 5.19 SibeliusMusic.com).

Réglages recommandés
b 5.19 SibeliusMusic.com pour les différents réglages à faire pour permettre à quiconque de

visualiser, de lire et d’imprimer quel que soit son équipement.

Lorsqu’on prépare des partitions pour les publier sur son site web, on souhaite en général exercer

un contrôle accru sur l’aspect de la partition, et vouloir changer la taille du papier et de la portée

pour rendre la partition aussi lisible que possible à l’écran. Pour des partitions pour petits

ensembles en orientation portrait, essayez de régler la taille de papier de façon à ce qu’un seul

système tienne par page; cela évitera aux visiteurs de votre site web de faire défiler la page de haut

en bas pour voir chaque système. Certains modèles de pages web fournis sont réglés pour

n’afficher qu’un système à la fois - cf. Modèles de page web ci-dessous.

Exporter
* Tout d’abord choisissez Fichier > Informations sur la partition, cliquez sur l’onglet

Compositeur / Titre et entrez les informations à-propos de votre partition (si vous ne l’avez pas

fait dans la boîte de dialogue Nouvelle partition lorsque vous avez créé la partition) - la page

web générée considère que les champs Titre et Compositeur sont remplis et qu’elle peut les

inclure.

* Choisissez Fichier > Exporter > Page Web Scorch

* Entrez un nom de fichier. Sibelius supprimera tous les espaces du nom des fichiers Sibelius (.sib)

et HTML (.htm) et raccourcira leur nom à 27 caractères plus une extension de 3 caractères pour

les rendre compatibles avec tous les serveurs web.

* Si vous n’avez rien entré dans la boîte de dialogue Fichier > Informations sur la partition, vous

serez averti, par exemple, que les champs Titre et Compositeur sont vides

* Vous devrez ensuite choisir un modèle de page web dans lequel insérer votre partition - voyez

Modèles de page web ci-dessous. Vous pouvez également ajuster la largeur et la hauteur que

doit avoir la partition à l’intérieur de la page web. Si vous ne vous sentez pas trop aventureux,

choisissez simplement le modèle Classique en laissant les autres réglages pour le moment et

cliquez sur OK.
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Définir une Largeur plus grande rend la page, et par conséquent la musique, plus grande; il n’est

pas nécessaire d’entrer une valeur pour la Hauteur si vous souhaitez que la page conserve le

même format, ce qui est préférable.

L’option Conserver les proportions (activée par défaut) ajuste automatiquement la taille de la

portée pour que les lignes de portées apparaissent toujours équidistantes. Laissez cette option

activée.

Autoriser l’impression et la sauvegarde, comme son nom l’indique, vous permet de choisir si

les visiteurs de votre site web peuvent imprimer et sauvegarder votre musique, ou simplement

l’exécuter - cf. Imprimer et sauvegarder à partir de Scorch ci-dessous.

* Sibelius sauvegarde ensuite deux fichiers à l’emplacement choisi: un fichier HTML (avec

l’extension .htm) et une partition Sibelius (avec l’extension .sib).

Vous êtes maintenant prêt à télécharger ces deux fichiers sur votre site web. Selon la façon dont

votre site web est hébergé, vous aurez peut-être à utiliser un programme FTP ou pourrez les

télécharger par votre navigateur internet.

Vous devez inclure les deux fichiers, le fichier Sibelius et la page web dans le même dossier sur votre

site web. Ne renommez pas le fichier Sibelius - la page HMTL renvoie à ce fichier.

Conversion globale d’un ensemble de fichiers
Sibelius inclut une extension pour sauvegarder des pages Scorch pour toutes les partitions d’un

dossier, ainsi que pour générer une page d’index avec un lien vers toutes les partitions individuelles

- cf. Convertir un dossier de partitions sous forme de pages web à la page 550.

Imprimer et sauvegarder à partir de Scorch
Si vous activez l’option Autoriser l’impression et la sauvegarde lorsque vous sauvegardez la

partition au format Scorch, les visiteurs de votre site seront autorisés à imprimer votre partition

sur leur imprimante, et également à sauvegarder la partition en un fichier Sibelius sur leur disque

dur de façon à ce qu’ils puissent l’ouvrir eux-mêmes dans Sibelius.

Cela rend le partage de votre musique avec d’autres personnes très facile: les professeurs peuvent

placer des feuilles d’exercice sur le site web de l’école, et les étudiants peuvent les imprimer

directement depuis leur navigateur internet, ou, s’ils possèdent Sibelius, les télécharger sur leur

ordinateur et compléter l’exercice dans Sibelius.

L’option Autoriser l’impression et la sauvegarde ne comprend pas certains des avantages offerts

pour la publication de votre musique sur SibeliusMusic.com:

* Vous n’êtes pas autorisé à utiliser Scorch dans un but commercial sur votre propre site web sans

une licence spéciale - c-à-d vous ne pouvez faire payer les visiteurs de votre site pour imprimer et

sauvegarder votre musique

* La musique sur votre site web n’est pas sécurisée par cryptage, ce qui veut dire que tous les

visiteurs de votre site qui utilisent Sibelius peuvent télécharger votre musique sur leur

ordinateur en cliquant simplement sur le bouton Sauvegarder dans Scorch, et ils pourront alors

la modifier dans Sibelius.
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Notez bien que même si vous n’autorisez pas l’impression et la sauvegarde, vos partitions sont tout

de même téléchargées sur l’ordinateur du visiteur de façon non cryptée. Chaque fois que vous

affichez quelque chose dans votre navigateur web, que ce soit du texte, une image ou même une

partition Sibelius utilisant l’extension Scorch - cela a été téléchargé dans le dossier de fichiers

temporaires Internet de votre disque dur. Cela signifie que quiconque regarde la musique sur votre

page web personnelle peut potentiellement modifier le fichier original (s’il possède Sibelius).

En d’autres termes, si vous publiez votre musique sur votre site web, vous le ferez de manière non

sécurisée. Si vous la publiez sur SibeliusMusic.com, elle sera sécurisée.

SibeliusMusic.com utilise un format de fichier crypté lisible uniquement par l’extension Scorch -

cela signifie que si quelqu’un retrouvait le fichier temporaire sur son disque dur, il ne serait pas en

mesure de l’ouvrir (pas même avec Sibelius) si ce n’est avec Scorch. Cela garantit également que si

quelqu’un affiche un fichier crypté dans Scorch, il ne peut l’imprimer, car l’impression de ces

fichiers dépend du lien entre Scorch et le serveur SibeliusMusic.com.

Si vous souhaitez publier la musique sur votre site de manière sécurisée, contactez Sibelius

Software à-propos de la licence Sibelius Internet Edition, une version spéciale de Sibelius pour la

publication en ligne à but commercial.

Informations sur la partition
Vous pouvez inclure les informations de catalogue telles que le compositeur, le titre, etc. sur votre

site web. Tout ce que vous avez à faire est d’entrer les informations dans la boîte de dialogue

Fichier > Nouveau lorsque vous créez une partition, ou ultérieurement dans la boîte de dialogue

Fichier > Informations sur la partition; ensuite lorsque vous sauvegardez en tant que page web,

Sibelius peut inclure ces informations automatiquement comme balises HTML, ainsi que placer les

informations principales comme texte sur la page web.

Vous avez d’abord à créer un modèle de page web affichant le type d’informations de catalogue que

vous souhaitez inclure (cf. ci-dessous Personnaliser votre site web).

Si vous avez un talent pour la programmation, vous pouvez écrire un programme pour créer un

catalogue en ligne (et même un moteur de recherche) des partitions sur votre site web

automatiquement à partir de ces balises, avec des liens vers les partitions.

Modèles de page web
Un certain nombre de modèles de page web vous sont fournis, dans divers styles et combinaisons.

Certains des modèles utilisent l’une des fonctions les plus utiles de Scorch: exécution fractionnelle.

L’exécution fractionnelle est conçue pour permettre de jouer avec Scorch sans devoir se préoccuper

des tournes de page - c’est comme avoir un tourneur de page en permanence à votre disposition.

Lorsque Scorch atteint la fin d’un système pendant la lecture, il remplace automatiquement le

système qu’il vient juste d’exécuter par un système ultérieur. Votre œil suit naturellement la

musique jusqu’en bas de la page, et lorsque vous arrivez en bas, vous vous apercevrez que les

systèmes suivants sont déjà visibles au sommet de la fenêtre Scorch.

L’exécution fractionnelle fonctionne le mieux pour un instrument soliste ou des petits ensembles

(tels qu’instrument soliste et clavier). Choisissez parmi les modèles exécution fractionnelle 2
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systèmes, exécution fractionnelle 3 systèmes ou exécution fractionnelle 4 systèmes pour

essayer cette fonction.

Le modèle exécution fractionnelle 1 système et affichage 1 système n’affiche qu’un système

à la fois: cela est utile si vous souhaitez que les visiteurs de votre site web puissent suivre la musique

sans avoir à faire défiler la fenêtre du navigateur de haut en bas. (exécution fractionnelle 1
système affiche une page entière lorsque Scorch ne joue pas, mais seulement un système pendant

la lecture.)

Si vous avez autorisé l’impression et la sauvegarde à partir de Scorch, vos partitions seront

sauvegardées et imprimées exactement comme elles apparaissent dans Sibelius - en d’autres

termes l’exécution fractionnelle n’a pas d’incidence sur les partitions elles-mêmes; c’est

simplement un méthode alternative d’afficher les partitions dans Scorch.

Personnaliser votre site web
Si vous ne souhaitez pas utiliser les modèles de page web fournis avec Sibelius ou si vous désirez les

améliorer, vous aurez besoin d’une connaissance basique de HMTL (ou un ami parlant le HTML).

La page web produite par Sibelius est très simple, et vous pouvez y faire toutes les modifications

que vous souhaitez - vous pouvez y ajouter votre propre arrière-plan ou image, plus

d’informations, des liens ou ce que vous voulez.

Vous pouvez créer vos propres modèles de page web et les sauvegarder avec l’extension .htm dans

le dossier Modèles Scorch du dossier de l’application de l’utilisateur. (cf. Fichiers que peut
créer l’utilisateur à la page 716). Ils apparaîtront alors dans la liste des modèles de page web.

Un modèle de page web est un fichier HTML standard avec quelques balises spéciales dans

lesquelles sont insérés le nom et la taille du fichier lorsque vous sauvegardez au format Scorch. Il y

a également des balises optionnelles qui sont remplacées par les champs Titre, Compositeur, etc.

de la boîte de dialogue Fichier > Informations sur la partition. La liste complète des balises (qui

ne sont pas toutes utilisées dans le même modèle) est:

Consultez les modèles de page web fournis pour des exemples d’utilisation de ces balises.

Les seuls éléments requis sont les balises imbriquées <object> et <embed>, qui devraient

ressembler à quelque chose comme ceci:

object id="ScorchPlugin"
classid="clsid:A8F2B9BD-A6A0-486A-9744-18920D898429"
width="x"
height="y"
codebase="http://www.sibelius.com/download/software/win/ActiveXPlugin.cab"

param name="src" value="filename.sib"
embed src="filename.sib"

width="x"
height="y"

$FILENAME$ nom et extension du fichier Sibelius

$PATHNAME$ chemin de fichier Sibelius

$WIDTH$, $HEIGHT$ de la boîte de dialogue Sauvegarder en tant que page Web

$TITLE$, $COMPOSER$, 
$ARRANGER$, $LYRICIST$,
$ARTIST$, $MOREINFO$

de la boîte de dialogue Fichier > Nouveau et Fichier > Informations sur la 
partition
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type="application/x-sibelius-score"
pluginspage="http://www.sibelius.com/cgi/plugin.pl"

</object>

où filename.sib est le chemin vers le fichier Sibelius, x est la largeur de la fenêtre Scorch en pixels,

et y est sa hauteur en pixels. Ces champs seront remplis pour vous si vous utilisez Fichier >

Sauvegarder sous > Page web Scorch dans Sibelius et que vous les définissiez dans votre page

web comme $FILENAME$, $WIDTH$ et $HEIGHT$ respectivement.

Ne modifiez pas les attributs de classid, codebase, type ou pluginspage, car ceux-ci informeront

le navigateur à propos de Scorch et lui diront où le chercher s’il n’est pas encore installé.

Problèmes et solutions
Certains serveurs web peuvent ne pas afficher les pages web Scorch, auquel cas vous serez informé

par votre navigateur qu’une extension appropriée n’a pu être trouvée. Cela est du au fait que le

serveur ne reconnaît pas l’extension de fichier .sib.

Si cela se produit sur votre site, contactez votre FAI ou l’administrateur système de votre serveur

web et demandez leur d’ajouter le type-MIME Sibelius à la configuration du serveur, ce qui réglera

le problème.

Utiliser le courriel et le CD-ROM
Si vous souhaitez envoyer un fichier Sibelius à quelqu’un pour l’afficher en Scorch,

b 9.2 Partager des fichiers.

Vous pouvez tout aussi bien utiliser la fonction de publication en ligne de Sibelius pour

promouvoir votre musique sur CD-ROM ou disquette. Sauvegardez simplement votre site web sur

disque - d’autres personnes pourront alors y accéder à partir du disque de la même manière qu’à

partir d’Internet.

Notez cependant que les utilisateurs devront tout de même télécharger Scorch à partir d’Internet,

ce qu’ils peuvent faire en suivant simplement le lien affiché sur n’importe laquelle des pages web

Scorch sur le disque. Vous n’êtes pas autorisé à distribuer Scorch vous-même (cf. Mentions
légales ci-dessous ).

Mentions légales
Il est illégal de placer de la musique sous copyright sur Internet sans avoir la permission de

titulaire du copyright. Cela est également le cas si vous avez fait votre propre arrangement d’un

morceau de musique sous copyright.

Vous n’êtes autorisé à utiliser la fonction de publication en ligne de Sibelius que pour une

utilisation non commerciale. (consultez le contrat de licence de Sibelius pour plus d’informations.)

Vous n’êtes pas autorisé à distribuer Scorch, par ex. en le plaçant placer sur votre site web - les

visiteurs de votre site doivent suivre le lien fourni pour télécharger Scorch. Les conditions de

licence pour l’extension sont affichées lorsque vous l’installez.
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9.12 Exporter vers des versions antérieures

Sibelius est totalement rétro-compatible. Sibelius 6 peut ouvrir les fichiers de toutes les versions

précédentes Sibelius pour Windows et Mac, y compris des fichiers sauvegardés dans Sibelius Stu-

dent, Sibelius First et G7.

Les anciennes versions ne peuvent pas ouvrir les fichiers sauvegardés avec cette version, mais vous

pouvez utiliser Fichier > Exporter > Sibelius 2, 3, 4 ou 5 pour sauvegarder des fichiers qui pour-

ront être ouverts par Sibelius 2, Sibelius 3, Sibelius 4 ou Sibelius 5. (Le programme G7 pour la gui-

tare utilise le même format que Sibelius 3 et Sibelius Student.) Notez cependant que ces anciennes

versions ne possèdent pas toutes les fonctions de Sibelius 6, de sorte que les partitions ne se pré-

senteront pas exactement de la même manière que dans Sibelius 6. Voici en particulier ce qui est

changé ou omis (c’est-à-dire ce qui n’est pas exporté dans le fichier).

Pour exporter les fichiers pouvant être ouverts par Sibelius 3 Student ou Sibelius 5 Student, choi-

sissez Fichier > Exporter > Sibelius Student. Notez que Sibelius 3 Student peut seulement ouvrir

des partitions de huit portées maximum, et Sibelius 5 Student d’un maximum de 12 portées.

Différences dans toutes les versions précédentes et lite de Sibelius
Tout ce qui suit est omis ou modifié quand on exporte des fichiers vers d’autres versions de Sibe-

lius:

* Les lignes d’arpège jointes aux notes, telles qu’elles sont créées sur le clavier, seront converties en

lignes d’arpège normales.

* Articulations :

% Les Articulations en-dessous de la note, qui ont été déposées indépendamment dans leur

position par défaut, à moins que les articulations au-dessus de la note n’aient pas été déposées

(auquel cas la position inférieure sera utilisée)

% Les Articulations dans la portée peuvent être déplacées à des positions moins idéales

% Les coups d’archet positionnés en dehors des liaisons de phrasé au-dessus de la portée tandis

que d’autres se trouvent dans la liaison de phrasé figurent dans la liaison de phrasé.

* Mesures de silence : Les silences sur deux mesures en 4/2 figureront comme pauses normales.

* Ligatures:

% Le statut des options Ligatures à travers des silences et Ligaturer depuis et vers les
silences dans Règles de gravure est défini dans chaque indication de mesure dans la parti-

tion, ce qui produira des résultats de ligature proches de l’identique dans les versions précé-

dentes sans être obligatoirement les mêmes.

% Les ligatures peuvent entrer en collision avec les silences, car les versions précédentes de Sibe-

lius ne comportent pas l’option Modifier la longueur des hampes pour éviter les silences
dans les ligatures.

% Les divisions des ligatures secondaires automatiques pour les silences dans les ligatures

n’apparaîtront pas, car les versions antérieures de Sibelius ne comportent pas l’option Diviser
ligatures secondaires.

% Les hampes courtes n’apparaîtront pas.
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* Indications de précaution sera omis.

* Symboles d’accord:

% Les diagrammes d’accord de guitare horizontaux figureront en tant que diagrammes d’accord

verticaux.

% Le doigté indiqué en pointillés sur les diagrammes d’accord de guitare n’apparaîtront pas.

% Tous les pointillés de doigté figureront sous la forme de pointillés noirs, indépendamment de

l’aspect utilisé dans Sibelius 6.

% Les diagrammes d’accord définis pour indiquer un nombre de frettes différent du réglage par

défaut sur la page Guitare de Style maison > Règles de gravure apparaîtront avec le

nombre de frettes par défaut.

% Les diagrammes d’accord ne comportant pas de pointillé sur une corde spécifique et ne por-

tant pas non plus de O ou de X au-dessus du cadre porteront un O au-dessus de l’accord.

% Les diagrammes d’accord définis à une taille par défaut avec la commande Echelle dans le

panneau de propriétés Général figureront dans leur taille par défaut.

* Commentaires sera omis.

* Diagrammes d’échelle de guitare sera omis.

* Symboles jazz (plop, scoop, fall, doit) sera converti en symboles normaux.

* Les données Live Tempo seront omises.

* Les positions magnétiques de mise en page seront bloquées, et les objets ne figureront pas tous

aux mêmes positions que dans les versions précédentes, ex. segments de continuité de ligne

après sauts de système ou de page.

* Alternatives aux têtes de note peut figurer à différentes positions sur la portée pour les instru-

ments transpositeurs.

* Liaisons de phrasé apparaît dans ses épaisseur, forme et aspect par défaut; elles peuvent égale-

ment s’incurver dans le sens contraire (c.-à.-d. que les liaisons de phrasé figurant en-dessous de

la portée dans Sibelius 6 peuvent apparaître au-dessus dans les versions précédentes)

* Espacement des portées sera différent, car les versions précédentes de Sibelius justifient toujours la

distance entre les portées d’instruments à plusieurs portées. (l’espace supplémentaire prévu pour

les paroles, les positions des objets de système, et les groupes d’instruments intermédiaires entre

parenthèses/crochets seront maintenus jusqu’à ce que l’espacement de portée soit réinitialisé dans

la version précédente.)

* Liaisons rythmiques figurera à la même épaisseur que les liaisons de phrasé.

* Les mesures répétées à deux et quatre mesures ne sembleront pas correctes, et toute mise en

forme automatique produite par ces mesures répétées ne sera pas retenue dans les versions précé-

dentes, de sorte que des mesures peuvent apparaître sur différents systèmes.

* Les objets dessinés suivant des couches personnalisées (ex. derrière la portée) seront tous dessi-

nés sur la même couche.

* Les positions verticales des objets de système comme les repères de répétition aux positions

d’objet de système ailleurs qu’au-dessus de la portée supérieure peuvent être différentes.

* Tout point d’orgue dont les paramètres de lecture ont été réglés individuellement sera lu avec les

paramètres par défaut dans les versions précédentes.
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* Les mesures répétées ne seront pas lues dans les versions précédentes.

Différences dans Sibelius 2, 3, 4, G7 et Sibelius 3 Student
Les éléments suivants sont retenues dans Sibelius 5, mais omis ou modifiés dans les versions pré-

cédentes :

* Numéros de mesures :

% Si les numéros de mesure sont réglés pour apparaître toutes les n mesures, n sera converti

selon les options existantes des versions précédentes, si bien que les numéros de mesure

pourront apparaître sur des mesures différentes ;

% Les changements de numéro de mesure qui comportent des nouveaux formats de numéro de

mesure seront transformés en changements de numéro de mesure normaux.

% Les changements de numéro de mesure qui comportent du texte avant ou après le numéro

seront transformés en changements de numéro de mesure normaux.

% Les numéros de mesure sont automatiquement masqués quand les repères de répétition appa-

raissent.

% La numérotation des mesures ne prend pas en compte les répétitions.

% Les numéros de mesure apparaîtront sur les portées réglées dans Mise en page > Positions
des objets de système, et pas dans les portées réglées dans Style maison > Règles de gra-
vure.

* Les objets en taille de note de réplique autres que les notes apparaîtront en taille “normale”

* Les idées sauvegardées dans la partition sont omises

* Les changements d’instruments sont convertis en type de portée et en changements de transposi-

tion adéquats. Notez cependant que les sons de l’exécution ne changent pas au changement

d’instrument quand la partition est jouée sur des versions antérieures de Sibelius.

* Les changements de marge (y compris ceux produits par l’option Après la première page dans

Mise en page > Paramètres du document, et les sauts de page spéciaux) sont omis; toutes les

pages de la partition utiliseront les marges définies pour la première page de la partition

* Les mesures de comptage dans les parties peuvent se diviser différemment dans Sibelius 4 et les

versions antérieures, car le texte de système attaché au page n’entraîne pas la division des

mesures de comptage dans Sibelius 5 et supérieur.

* Les changements de numéros de page sont omis ; à l’ouverture dans les versions antérieures, les

pages sont numérotées à partir de la première.

* Les sauts de page spéciaux sont convertis en sauts de page réguliers, et tout ce qui apparaît sur les

pages blanches, textes, symboles ou images sont supprimés de la partition, en même temps que

les styles de page blanche

* La direction des hampes et le placement des silences peuvent varier, si Ne pas tenir compte des
objets masqués pour la direction des hampes et la position des silence est activé (dans la

page Notes et Trémolos de Style maison > Règles de gravure)

* Le Texte technique comme “pizz.” et “arco” ne sera pas lu correctement comme dans la version

précédente.

* Toutes les nouvelles définitions d’instruments, les nouveaux types de portées et les nouvelles

données d’ensemble sont omises (b 8.14 Modifier les instruments).
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Différences dans Sibelius 2, 3, 4, G7 et Sibelius 3 Student
Les éléments suivants sont omis ou modifiés uniquement les versions antérieures à Sibelius 4:

* Les parties dynamiques : toutes les parties liées au conducteur sont omises (b 7.1 Travailler
avec des parties séparées), mais vous pouvez les extraire dans Sibelius 5 et les exporter de

la même manière que le conducteur.

* Les options de mise en page automatique : toutes les options de mise en page automatique sont

omises. Ceci inclut les sauts de système automatiques, les divisions de mesure de comptage et de

mesures de tacet, et les réglages avancés de saut de page.

* Les positions des ligatures en mode Optical : les ligatures changeront légèrement de position à

l’ouverture dans les versions antérieures (b 2.7 Positions des ligatures).

* Les liaisons en mode Optical : les liaisons changeront légèrement de position à l’ouverture dans

les versions antérieures (b 2.32 Liaisons rythmiques).

* Justification : la justification horizontale et verticale des notes et des systèmes peut changer à

l’ouverture dans les versions antérieures (b 8.10 Espacement des portées).

* Les styles de texte dont la taille est réglée sur Conserver en absolu ne seront pas à l’échelle cor-

recte sur les petites portées (b 3.9 Modifier les styles de texte).

Différences supplémentaires dans Sibelius 2
Les éléments suivants son retenus dans Sibelius 4, Sibelius 3, G7 et Sibelius Student mais sont omis

ou modifiés dans Sibelius 2 :

* Espacement des notes : certaines options d’espacement des notes (par ex. l’espace minimum

autour des notes, les crochets, etc.) sont omises ; l’espacement des notes peut changer légère-

ment, surtout quand l’espacement est très serré ou très large, mais l’ensemble de la mise en page

ne changera pas (nombre de mesures par système ou par page).

* Exécution : Toutes les données d’exécution enregistrée sont omises (b 4.8 Exécution
enregistrée); les options Jouer lors de l’exécution (b 4.6 Reprises) ; les termes de

Exécution > Dictionnaire qui utilisent des instructions de répétition ou des expressions

régulières (b 4.9 Dictionnaire de l’exécution) ; les sauts entre les mouvements dans la

même partition (b 4.5 Interprétation).

* Mise en page : L’état de portées en vue ciblée sera omis (b 5.8 Portées en vue ciblée).

* Règles de gravure : L’option Autoriser les ligatures après les silences est omise

(b 2.8 Silences ligaturés et petites hampes), Centrer les staccatos sur les hampes
est converti en Centrer à moitié les staccatos sur les hampes de note
(b 2.3 Articulations).

* Les objets colorés (y compris la couleur des surlignages) n’apparaîtra pas en couleur si vous

ouvrez la partition dans Sibelius 2, mais seront préservés et apparaîtront en couleur si l’ouverture

se fait dans Sibelius 3 ou 4 (pour autant qu’il n’y ait pas eu de sauvegarde entretemps dans Sibe-

lius 2).

Utilisateurs de Sibelius 1.4
Si vous connaissez des personnes qui utilisent encore Sibelius 1.4 et que vous souhaitez partager

des fichiers avec elles, elles doivent mettre à jour leur version car vous ne pouvez pas exporter un

fichier Sibelius 5 dans un format 1.4.
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Glossaire
Dans ce glossaire figurent un ensemble de termes musicaux et informatiques considérés comme

rares, techniques ou d’une signification particulière pour le logiciel Sibelius. Les renvois sont

indiqués en gras.

Acciaccatura : petite note ornementale généralement jouée avant le temps, et symbolisée par

une ligne oblique sur sa hampe.

Accolade : { à gauche des instruments à clavier ou de tout autre instrument utilisant une grande

portée (également utilisé à la place d’un crochet secondaire dans les partitions d’orchestre

anciennes, notamment pour les cors).

Accord : dans cet ouvrage de référence, le terme “accord” signifie spécifiquement deux têtes de

note ou plus sur une seule et même hampe (ou, dans le cas d’une carrée et d’une ronde, dans la

même voix). Les têtes de note dans des voix ou portées différentes sont considérées dans des

accords différents.

Aftertouch : en format MIDI, degré de pression exercé sur une touche enfoncée, habituellement

utilisé pour contrôler les modulations (vibrato).

Altération : symbole (ex : bémol, dièse) indiquant que la hauteur de note doit être augmentée ou

diminuée d’un petit intervalle – généralement d’un demi-ton, ou, plus rarement, d’un ton ou

encore d’un micro-intervalle.

Appogiature : longue note ornementale généralement jouée sur le temps ; contrairement à

l’acciaccatura, sa hampe n’est pas barrée d’une ligne oblique.

Articulation : symbole parfois représenté au-dessus ou au-dessous d’une note ou d’un accord,

indiquant la manière de jouer – ex : staccato, tenuto, pousser, accentuer, point d’orgue (pause).

ASIO : (acronyme de “Audio Stream Input/Output”), format créé par Steinberg fournissant une

entrée et une sortie audio à faible latence.

Attache : les notes, texte, lignes, symboles, etc. sont dits “attachés” à des portées et à des

positions rythmiques particulières dans la musique. Cela signifie qu’ils appartiennent à cette

portée / position et évoluent avec elle lors d’une nouvelle mise en forme de la musique. Lors de la

sélection de la plupart des objets, une ligne pointillée grise apparaît pour indiquer ce à quoi l’objet

est attaché.

Audio Unit (ou AU) : nom d’un format pour instruments virtuels et effets mis au point par

Apple. Les Audio Units ne sont compatibles qu’avec des ordinateurs Mac.

Banque : ensemble des numéros de programmes (jusqu’à 128). Les périphériques MIDI

possédant plus de 128 sons rassemblent ces derniers en banques.

Barre de mesure initiale : barre de mesure située à l’extrémité gauche de chaque système

permettant de relier les portées entre elles, automatiquement ajoutée par Sibelius. La barre de

mesure initiale n’apparaît généralement pas dans les systèmes à une seule portée. 
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Barre en H : ligne horizontale et épaisse, généralement utilisée pour les mesures de
comptage.

Canal : équivalent MIDI d’une portée, généralement déterminé par un numéro allant de 1 à 16.

La plupart des périphériques MIDI n’acceptent pas plus de 16 canaux. Chaque canal ne peut être

configuré qu’avec un seul numéro de programme, position panoramique, etc. à la fois.

Caret : ligne verticale, parfois appelée curseur ou point d’insertion, indiquant lorsque des notes

sont composées ou qu’un texte est saisi.

Changement de contrôleur : message MIDI contrôlant les effets, tels que la réverbération,

la position panoramique ou encore le maintien.

Changement de programme : message MIDI modifiant le numéro de programme d’un

canal MIDI.

Cithare : instrument à cordes en forme de boîte, populaire en Hongrie uniquement. (n’apparaît

en réalité pas dans cet ouvrage de référence, mais commence par un C.)

Code temporel : nombres indiquant la position temporelle dans une partition ou une vidéo ; le

code temporel indique généralement les heures, minutes, secondes et dixièmes de secondes.

Codec : (acronyme pour compression / décompression ou codage / décodage) composant d’un

logiciel permettant de traduire des données vidéo ou audio entre ses formes non compressées et

compressées.

Configuration : (pour l’exécution) ensemble des réglages de périphérique de lecture permettant

de configurer les périphériques disponibles pour Sibelius et la manière de les exécuter.

Contrôleur : périphérique d’entrée MIDI, tel que le clavier, la pédale de maintien, la molette de

modulation ou de pitch bend, etc.

Convertir : permet de changer le format d’un fichier. 

Couche : utilisée par certains programmes de notation pour désigner voix ; peut également se

référer à plusieurs sons au sein d’un même programme dans un instrument virtuel,
accessible de plusieurs façons, par exemple par les touches de contrôle ou encore les

changements de contrôleur. Ce terme peut également désigner des couches graphiques,

autrement dit, l’ordre dans lequel les objets sont insérés.

Crochet : (a) crochet vertical et épais [ permettant de regrouper les portées d’instruments dans

une même famille. Le crochet vertical et fin [ qui regroupe les instruments divisés est appelé

crochet secondaire.

(b) crochet horizontal [ permettant de regrouper parfois un ensemble de notes en multiplets.

Crochet : petite partie d’une ligature apparaissant en rythmes pointés, également appelée ligature

divisée.

crochet secondaire b crochet. 

Curseur : bouton coulissant utilisé dans l’équipement audio, comme les tables de mixage par

exemple, pour contrôler notamment le volume d’un canal audio donné. La fenêtre Table de mixage

de Sibelius est dotée de curseurs permettant de contrôler le volume ainsi que la position

panoramique de portées individuelles.
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Curseur temporel : curseur situé sur la fenêtre de lecture qui permet de déplacer la ligne de

lecture (et de vidéo) à n’importe quel endroit de la partition.

DAW (Digital Audio Workstation) : système enregistreur et éditeur audio présent sur

l’ordinateur ou sur le disque dur. Il renvoie précisément à des applications telles que Pro Tools,

Cubase, Logic, etc.

Dialogue (ou boîte de dialogue) : fenêtre demandant des informations, comprenant des

boutons (tels que OK ou Annuler) sur lesquels vous devez appuyer dès lors que vous avez terminé.

Diatonique : une échelle diatonique est une échelle majeure ou mineure. Transposer en

diatonique signifie déplacer des notes vers le haut ou vers le bas de l’échelle. Par exemple, sur

l’échelle de Do majeur, transposer une triade de Sol majeur vers une deuxième diatonique produit

un La mineur ; transposer vers une troisième diatonique produit une triade diminuée de Si.

Distribuer : répartir les notes d’un accord ou d’un passage d’accords d’une ou deux portées vers

un plus grand nombre de portées. Contraire de réduire.

Dpi (dots per inch) : (“points par pouce” en français), unité de résolution d’impression et de

numérisation. Plus vous imprimez ou numérisez de dpi, plus la résolution est importante et plus

l’impression ou numérisation sera, de fait, détaillée.

Lors de l’impression, les points deviennent invisibles à partir de 1 200 dpi ou plus, ce qui rehausse

la qualité. 600 dpi (résolution standard pour la plupart des imprimantes laser) est d’une qualité

presque égale, et souvent suffisante pour la publication musicale. 

Pour numériser de la musique, la résolution normale se situe généralement entre 200 et 400 dpi.

Des résolutions plus élevées, telles que 600 dpi, sont utilisées pour la numérisation de photos et

d’images de haute qualité.

Echantillon : enregistrement numérique d’un son, généralement un court passage, comme par

exemple un loop de batterie ou encore une seule note.

Echelle de gris : (numérisation) échelles de gris, par opposition aux couleurs ou au noir et blanc.

Effet : programme informatique produisant un signal audio dans le but de modifier une ou

plusieurs caractéristiques propre(s) à un son, pour générer, par exemple, une réverbération.

Elément : partie d’un Son ID entre deux points. Par exemple : les éléments d’un son ID

cordes.violon.ensemble sont “cordes”, “violons” et “ensemble”.

EMF (Enhanced MetaFile) : format de fichiers d’images vectorielles standard de Windows.

En-tête : texte apparaissant en haut de chaque page d’un document lors de son impression,

souvent appelé un “en-tête permanent”. Cf. Pied de page.

Ensemble : collection d’instruments, regroupé en une ou plusieurs famille(s), chaque famille

contenant ainsi un ou plusieurs instrument(s). Il est possible de choisir entre plusieurs ensembles

à partir du menu Créer > Instruments.

EPS (Encapsulated PostScript) : (“PostScript encapsulé” en français) format de fichier

d’images vectorielles standard très proche du format PostScript. Contrairement à un fichier

PostScript, un fichier EPS est utilisé pour placer une seule page de texte ou d’images en tant
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qu’illustration dans un programme de mise en page tel que Quark XPress. Les fichiers EPS sont

principalement utilisés dans le cadre de l’édition professionnelle.

Espace : distance entre deux lignes de portée, correspondant à la principale unité de mesure dans

le domaine de la gravure musicale. Les ligatures par exemple ont généralement une épaisseur

de 0,5 espace, et par définition, une taille de portée de quatre espaces.

Exercice : feuille de papier comprenant un exercice à exécuter par un étudiant en classe ou seul à

la maison. Avec Sibelius, le terme est plus fréquemment utilisé pour désigner tout élément produit

par le créateur de feuilles d’exercices, pouvant également inclure entre autres, du contenu de

référence, des affiches, etc.

Exporter : sauvegarder dans un fichier de format utilisé par un programme différent. Contraire

d’importer.

Extension : logiciel pouvant opérer à l’intérieur-même d’un autre environnement logiciel. Dans

Sibelius, une extension est un petit programme, écrit sous un format texte appelé ManuScript, qui

permet d’ajouter de nouvelles fonctionnalités . Par ailleurs, le terme “extension” est généralement

utilisé pour décrire des instruments virtuels pouvant être chargés dans des applications hôtes

telles que Sibelius.

Extraire : Créer un fichier séparé d’une partie.

Famille : instruments du même genre figurant ensemble dans une partition, tels que les bois, les

cuivres, les percussions ou encore les cordes. Parfois également appelée “section” instrumentale.

Fichier BMP : format d’image graphique bitmap standard de Windows.

Fichier MIDI : fichier au format standard MIDI, reconnu par presque tous les programmes

musicaux. Les fichiers MIDI sont conçus spécifiquement pour l’exécution, et ne sont donc pas

prévus pour le transfert de notation de musique entre les différents programmes.

Filtre : option de Sibelius permettant de sélectionner des objets d’un genre particulier (ex :

soufflets, texte) ou avec des caractéristiques particulières (ex : accord à trois notes).

Flexi-time™ : méthode de saisie intelligente en temps réel de Sibelius. b Saisie en mode
pas-à-pas, Saisie alphabétique, Saisie à la souris.

Formule magique : code utilisé dans un objet texte pour insérer un bout de texte spécifique tiré

d’un autre emplacement, comme par exemple la date, le nom de l’instrument, ou encore le numéro

de page.

Fraction de ligature : crochet recourbé d’une huitième de note (croche) ou d’une note plus

courte. (terme utilisé parfois à tort pour désigner une hampe.)

General MIDI (GM) : nom donné au jeu de sons le plus répandu.

Gravure musicale : art de représenter la notation musicale, couvrant des sujets tels que la

conception de symboles musicaux, le positionnement et l’espacement des notes ou d’autres objets,

la mise en page, ou encore l’utilisation de polices ou de tailles de texte spécifiques. La plupart des

gravures musicales ont été formulées en règles de gravure.

Groupe : liste d’instruments dans laquelle Sibelius copie des lignes de notes identiques à partir

de l’option Arranger.
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Hampe : ligne verticale, parfois appelée, à tort, “fraction de ligature” sur les notes et les accords.

b fraction de ligature.

Importer : permet d’ouvrir ou incorporer un fichier d’un format utilisé par un programme

différent. Contraire d’exporter.

Impulsion : plus petite unité de temps dans Sibelius. Il existe 256 impulsions par quart de note

(noire).

Instrument : tout ce qui, dans Sibelius, possède son propre nom indiqué à gauche d’un système.

Le terme comprend alors chanteurs, cassette électronique, etc. Les instruments peuvent avoir plus

d’une portée (ex : claviers), et leur partition partagée par plus d’un joueur (ex : instruments à vent

dans des orchestres ou musique de groupe)

Instrument transposé : instrument qui délivre un son à une hauteur de note différente que la

musique écrite à l’origine, comme la clarinette, le cor ou encore le piccolo. La transposition (ou

“clef”) de l’instrument est indiquée par la hauteur produite lorsque l’instrumentiste lit un C ;

lorsqu’un trompettiste “en Bb” lit par exemple un C, cela produit un Bb.

Instrument virtuel : programme qui imite le son d’un instrument réel, comme par exemple un

synthétiseur ou un instrument analogue, en produisant généralement des sons à partir

d’échantillons ou de synthèses.

Instrumentistes : différents musiciens partageant les mêmes portées, mais généralement

différenciés par un numéro. Les joueurs de cor par exemple partagent généralement une ou deux

portées, et sont souvent distingués par les numéros 1, 2, 3 et 4.

Interlignage : (terme technique : plombage, rime avec “mariage” et non avec “désherbage”)

distance entre les lignes de texte successives. Un interlignage standard est de120% dans les livres,

ce qui signifie que la séparation entre les lignes de texte représente 1,2 fois la taille du point ; en

musique, on préfère généralement 100%.

Jeu de sons : ensemble complet de sons disponible sur un périphérique MIDI ou un

instrument virtuel. Sibelius permet par ailleurs de choisir entre les sons d’un General MIDI, ou

encore d’un Garritan Personal Orchestra, etc.

Justifier : aligner horizontalement ou verticalement afin de remplir une page jusqu’aux marges.

Par exemple, la grande majorité du texte de cet ouvrage est justifié horizontalement, de sorte qu’il

atteigne la marge de droite. De la même manière, les mesures d’une musique sont presque toujours

justifiées horizontalement. Les portées sont souvent justifiées verticalement, de sorte qu’elles

s’étalent jusqu’à la marge du bas d’une page au lieu d’y laisser un espace.

Latence : délai nécessaire à Sibelius pour envoyer un message au périphérique audio pour

déclencher une note et la jouer. La latence est généralement plus élevée (c’est-à-dire que le délai est

plus long) avec les périphériques logiciel, comme les instruments virtuels, qu’avec les

périphériques matériels, tels que les modules audio.

Multiplet : certaines personnes rapprochent ce terme de celui de “duolet”, et d’autres encore de

celui de “triolet”. Fait référence à un rythme joué à une fraction de sa vitesse normale, tel un triolet.

Il est représenté sous la forme d’un seul chiffre ou d’un rapport au-dessus ou en-dessous des notes,

souvent avec un crochet de manière à montrer la note à laquelle il est appliqué, et quelque fois
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avec une petite note pour montrer l’unité rythmique à laquelle il est fait référence avec le(s)

nombre(s).

Le terme de “multiplet” appartient en réalité au jargon des logiciels musicaux. Dans le monde de la

musique, les multiplets sont généralement appelés groupes irréguliers ou éventuellement

polyrythmies ou contre-métries.

Ligatures : lignes épaisses reliant les groupes de croches et les valeurs de note inférieures.

Une ligature divisée est un autre nom utilisé pour désigner un crochet de note.

Ligne : soufflet, liaison, 8va, glissando ou tout autre objet de la boîte de dialogue Créer > Ligne. 

Ligne de lecture : ligne verticale verte indiquant le passage de la portée en cours de lecture ou lu

plus tard par Sibelius. Cette ligne est également utilisée lors d’un enregistrement avec Flexi-time,

lorsqu’elle est rouge.

Ligne de notes : succession de notes et de silences individuels pris depuis le passage d’origine

dans le cadre du traitement de la fonction Arranger. En d’autres termes, cela signifie qu’une série

d’accords à trois notes est transformée en trois lignes de notes séparées.

Ligne de parole : ligne horizontale accompagnant chaque mot dont la syllabe finale représente

plus d’une note à chanter.

Live : mode d’enregistrement spécial capable de capturer chaque nuance de votre performance

originale, jusqu’à la vélocité et la durée exacte de chaque note.

Magnétique : décrit le comportement intelligent des liaisons, multiplets, altérations,

articulations, liaisons rythmiques, slides, bends, etc., qui restent accolés aux notes et se

repositionnent automatiquement en cas de modification de la hauteur de note.

Marques de coupe : (“crops”) petits réticules fins utilisés dans l’impression offset, pour

indiquer les coins d’une page figurant sur une plus grande feuille de papier. Le papier est alors

découpé le long des lignes indiquées par les marques de coupe.

Menu raccourci : terme susceptible de porter à confusion, qui décrit le menu obtenu après un

clic-droit (sous Windows) ou un Contrôle-clic (sous Mac). (Attention : à distinguer des raccourcis

clavier) Il est parfois appelé “menu contextuel”, dans la mesure où les contenus du menu

dépendent des éléments cliqués.

Messages MIDI : commandes envoyées aux périphériques MIDI pour obtenir des effets

d’exécution particuliers, tels que les changements du numéro de programme et le pitch
bend. Sibelius génère ces commandes automatiquement lors de l’exécution, mais il est également

possible d’ajouter des commandes explicites à la partition concernée à l’aide d’objets textuels un

peu plus compliqués.

Mesure : segment de temps défini par un nombre de temps donné d’une durée donnée.

Mesure de comptage : indication pour plusieurs mesures de silence, utilisée dans les parties ;

les mesures de comptage plus longues sont habituellement représentées par un chiffre au-dessus

de la barre en H.

Micro-intervalle : fraction d’un demi-ton, utilisée en musique d’avant garde et ethnique.

Le micro-intervalle le plus courant est le quart de ton, qui correspond à la moitié d’un demi-ton.
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Les micro-intervalles sont définis par une large tessiture d’altérations à caractères particuliers,

généralement conçues à partir de dièses, bémols et coupures naturelles ou avec des éléments

supplémentaires accolés. Pour produire des micro-intervalles, il convient d’ajouter ou supprimer

des éléments à certains instruments.

MIDI : (rime avec “étourdi”) Musical Instrument Digital Interface – format standard universel

utilisé pour les instruments musicaux électroniques, ou encore les cartes-son d’ordinateurs.

b Fichier MIDI : (ci-dessous).

Mise en forme : option permettant de composer de la musique dans le but de remplir les

systèmes et les pages. Sibelius remet instantanément en forme l’ensemble de la partition en cas de

modification, de manière à avoir un aperçu du résultat tel qu’il apparaîtra lors de l’édition finale.

MusicXML : format de fichier permettant de transférer la notation de musique d’un programme à

un autre. Il est recommandé d’utiliser MusicXML pour déplacer de la musique depuis Finale 2004

ou supérieur vers Sibelius.

Navigateur : vue miniature de la partition, située dans le coin inférieur gauche. Le rectangle

blanc peu être déplacé n’importe où sur la partition avec la souris.

Note : tête de note simple munie d’une hampe (sauf dans le cas d’une ronde ou d’une carrée).

Les notes peuvent également avoir des altérations, articulations, points de rythme, ligatures, lignes

supplémentaires ou encore trémolos. Les hauteurs de note individuelles d’un accord sont appelées

têtes de note, et non “notes”.

Note de réplique : petite note (taille de note de réplique), appelée ainsi car elle est le plus

souvent utilisée pour l’écriture de répliques dans les parties instrumentales. Contrairement aux

notes ornementales, les notes de réplique ont une durée réelle – c’est-à-dire qu’elles ajoutent

un espace rythmique à la mesure. Chaque note, silence ou pause peut être converti(e) en taille de

note de réplique – qu’il s’agisse d’une note normale, ornementale ou de tête spéciale. Il est

également possible de saisir des notes de réplique sur de petites portées, qui apparaîtront alors

encore plus petites.

Note ornementale : petite note qui (contrairement à une note de réplique) n’est d’aucune

durée dans la mesure, et qui est jouée presque simultanément avec la note précédente ou suivante.

Les notes ornementales dont la hampe est barrée d’une ligne oblique sont appelées acciacaturas, et

les autres (sans ligne) appogiaturas.

NoteOn / NoteOff : messages MIDI qui débutent ou terminent une note.

Nuances : texte (ex : mf) ou soufflets déterminant l’intensité ou encore des changements

d’intensité.

Numériser :(a) obtenir une page de musique, de texte ou encore d’images dans un programme

informatique via un scanner.

(b) image résultant de la numérisation d’une page. Avec PhotoScore Lite, les numérisations

apparaissent toujours sur un fond coloré, de manière à bien les distinguer de la musique lue ainsi

que de la musique dans Sibelius.

Numéro de programme (également appelé numéro de patch) : numéro indiquant le son

produit par un instrument sur un périphérique MIDI. Les numéros de programme vont de 0 à 127
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ou encore de 1 à 128. Si plus de128 numéros de programmes sont disponibles, ces derniers seront

alors regroupés dans des banques supplémentaires.

Objet : tout ce qui peut être inséré dans une partition, comme par exemple une note, une

altération, une clef, un texte, une liaison de phrasé, etc. b objet de portée, objet de
système.

Objets de portée : objets attachés à (et faisant référence à) une portée particulière. Parmi ceux-

ci figurent notamment les notes, les accords, les silences, ainsi que les changements de clef, sans

oublier la plupart des lignes, styles de texte et symboles. b Objets de système.

Objets de système : objets s’appliquant à l’ensemble des instruments plutôt qu’à une seule

portée, comme par exemple les indications de mesure, les armures, le tempo, le texte de titre, ou

encore les repères de répétition et certains symboles et lignes. La plupart des objets de système

sont affichés au-dessus du système, et parfois également au milieu. Les objets de système ne sont

pas rattachés à une portée spécifique et figurent par ailleurs dans toutes les parties. b Objets
de portée.

OCR (numérisation) : de l’anglais “optical character recognition” ; généralement utilisé pour

numériser une page de texte mais également une page de musique.

Optical™ : décrit certaines règles de gravure spécifiques propres à Sibelius qui permettent

d’obtenir des résultats de gravure de très bonne qualité, nécessaires notamment pour positionner

les notes, les liaisons ou encore les ligatures.

Original (numérisation) : page ou partition à partir de laquelle la numérisation est effectuée.

Orthographe : manière dont une note est inscrite en tant que nom de note avec altération. La

plupart des notes possèdent trois orthographes différentes : ainsi, un Ré bécarre peut également

être “orthographié” B# ou Dbb.

Ossia : mesure - ou mesure approximative - d’un format de portée de petite taille qui, placée au-

dessus d’une portée normale, propose une solution alternative pour jouer un morceau.

Page : (a) face d’une partition telle qu’elle apparaît lors de sa publication. La dimension de la page

ne correspond pas nécessairement au format du papier, de sorte qu’il est possible d’imprimer une

petite page sur un papier de grand format.

(b) ensemble complet d’options au sein d’une boîte de dialogue (par exemple, Style Maison >

Règles de gravure) accessibles à partir d’une tablature ou d’un élément d’une liste.

Panoramique (ou pan) : orientation gauche-droite d’un son, indiquée dans le cas d’une

exécution stéréo.

Papier à musique : dès lors qu’une partition est créée, celle-ci s’inscrit sur un type particulier de

“papier à musique” qui peut être défini au moment de lancer le programme. Le papier à musique

permet de préciser les instruments, ainsi que d’autres options telles que les réglages de style

maison, par exemple.

Par défaut : statut provisoire d’une option jusqu’à une quelconque modification. Sibelius a été

conçu avec des options par défaut intelligentes, de manière à ne pas avoir besoin de changer

manuellement une option : le logiciel s’en charge automatiquement.
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Parcourir (numérisation) : permet de déterminer toutes les notes et les autres objets de la

numérisation.

Partie d’un morceau de musique comportant un ou plusieurs instruments tirée d’une partition

complète, souvent appelée partie instrumentale, orchestrale ou encore partie de fanfare. Les

musiciens lisent à haute voix des parties afin qu’ils n’aient qu’à voir la musique interprétée. Partie

dynamique : partie sauvegardée dans le même fichier que la partition complète, et

automatiquement mise à jour au moment d’éditer la partition. Partie extraite : partie sauvegardée

dans un fichier autre que celui de la partition et qui n’est pas automatiquement mise à jour.

Partie dynamique : Cf. Partie.

Partition : tout document d’annotation de musique ; terme généralement utilisé pour désigner

une partition complète. Cf. Partition complète, Partie, Partition transposée.

Partition complète : partition contenant tous les instruments jouant un morceau de

musique, par opposition à une partie. 

Partition transposée : partition dans laquelle il existe une différence entre la hauteur de note

de la musique d’instruments transposés écrite et les véritables sons produits. Une partition

non-transposée est généralement décrite comme étant une partition en C, ou encore une partition

écrite en sons réels ou hauteur réelle.

Passage : ensemble continu de musique sur une ou plusieurs portées, qui peut ou non être

verticalement continu (comme une flûte et un violoncelle dans une partition orchestrale par

exemple). Il peut être perçu comme un “rectangle” de musique. Un passage peut s’étendre sur

différents systèmes, voire sur toute une partition. Les passages sont généralement délimités par un

cadre bleu clair. Il existe également un type particulier de passage appelé passage de système,

délimité par un double cadre violet, qui comprend tous les instruments.

Passage de système : passage sélectionné regroupant toutes les portées dans la partition,

délimité par un double cadre violet. Les principales différences entre un passage de système et un

passage normal sont les suivantes : copier un passage de système insère des éléments dans la

partition au lieu de remplacer une musique déjà existante ; copier un passage de système copie des

objets de système en plus des objets de portée ; supprimer un passage de système

supprime par ailleurs les barres elles-mêmes, au lieu de les changer en mesures de silence.

Pavé : fenêtre à partir de laquelle il est possible, à l’aide de la souris ou du pavé numérique, de

sélectionner notamment des notes, des articulations, des altérations, etc. En appuyant sur les cinq

petits boutons du haut, situés sous les chiffres (ou en saisissant + sur le clavier, ou bien F7–F12), il

est possible de choisir entre six différents pavés, appelés premier pavé, second pavé, etc.

PDF (Portable Document Format): format de fichier répandu qui permet à des documents

générés par des logiciels de traitement de texte ou de mise en page d’êtres publiés

électroniquement en préservant leur apparence originale, pour être consultés et imprimés à partir

de n’importe quel système. Utilisé la plupart du temps par Adobe Acrobat et Adobe Reader.

Photocomposeuse : imprimante de haute-résolution (habituellement de 2540 dpi or plus)

utilisée pour produire les planches d’impression offset. Les photocomposeuses utilisent

PostScript. Elles sont généralement de la marque Linotronic, et peuvent éditer des pages de très

grand format.
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PhotoScore : programme permettant de numériser de la musique imprimée dans Sibelius. Deux

versions sont disponibles : PhotoScore Lite, inclus avec Sibelius, et PhotoScore Ultimate, pouvant

être acheté séparément, avec certaines fonctionnalités supplémentaires.

PICT : format de fichier Mac standard pour la lecture d’images vectorielles.

Pied de page : texte apparaissant au bas de chaque page d’un document, parfois appelé “pied de

page permanent”. Cf. En-tête.

Pilote de numérisation : programme, similaire au pilote d’une imprimante, indiquant à

l’ordinateur le type de scanner utilisé.

Piste : fichier MIDI équivalent à une portée. (les canaux MIDI étaient utilisés à cet effet dans

les anciens fichiers MIDI (type 0), mais présentaient l’inconvénient d’être limités à 16, tandis que le

nombre de pistes avec les fichiers MIDI type 1 est quant à lui illimité.

Pitch bend en MIDI : “fléchissement” d’une note vers le haut ou vers le bas grâce à l’activation

d’un levier ou d’une molette, ou encore à l’envoi d’un message MIDI de pitch bend.

PNG (Portable Network Graphics) : format de fichiers d’images bitmap standard.

Point de montage : scène d’un film (ex : une fusillade) devant être synchronisée à une partie

musicale dans la partition (par exemple, un accord puissant ou encore une intonation marquée

dans une phrase). Les points de montage sont déterminés par un texte encadré spécial au sein-

même de la partition.

Police de texte musical : police spéciale (ex : Opus Text) contenant des symboles musicaux qui

apparaissent dans le texte, tels que mf�ou � = 60.

Police roman (ou “police Roman”) : toute police sérif médium non-italique.

Police sans serif : police sans sérifs, généralement utilisée pour de petites zones de texte, tels

les titres par exemple.

Portée : en anglais, “staff” ou “stave”.

PostScript : format de fichier d’images vectorielles utilisé par certaines imprimantes laser et par

la plupart des photocompeuses pleine page. Cf. EPS.

Presse-papiers : emplacement (invisible) sur lequel une musique coupée ou copiée est

temporairement enregistrée avant d’être collée à un autre endroit de la partition.

Programme : son (ou ensemble de sons dans différentes couches) accessible via un simple

numéro de programme.

Propriétés : caractéristiques des objets de la partition tels que, entre autres, la position, le

comportement d’exécution, ou encore la police et la taille, accessibles à partir de la fenêtre

Propriétés.

Réduire (ou imploser) : permet de placer les notes de différents instruments sur une ou deux

portées, de manière à créer par exemple un accompagnement de clavier ou encore une réduction.

Contraire de distribuer.
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Règles de gravure : règles utilisées pour graver de la musique. Toutes les règles de gravure

standard sont intégrées dans Sibelius et peuvent être sélectionnées à partir des différentes options

présentes, notamment, dans la boîte de dialogue Style maison > Règles de gravure.

Remise en forme b Mise en forme.

Repères de répétition : grande lettre et / ou nombre, généralement dans un cadre, utilisés dans

les longues partitions pour faciliter le repérage.

Résolution : niveau de définition, mesuré en dpi, à partir duquel une page est imprimée ou

numérisée ; quantité de pixels affichés à l’écran de l’ordinateur, par exemple, 1024 x 768.

Réverbération : effet semblable à un écho brouillé à l’intérieur d’une pièce. Plus les pièces sont

grandes, plus la réverbération est importante. La quantité de réverbération est parfois indiquée par

le temps de réverbération, qui correspond au temps nécessaire à un son pour s’éteindre (à 60

décibels).

ReWire : protocole de transfert utilisé pour le transfert de données audio et MIDI entre plusieurs

DAW.

Saisie à la souris : permet de composer de la musique à partir de la souris. Il s’agit

généralement du mode de saisie le plus lent. b Saisie alphabétique, Saisie en mode pas-à-
pas, Flexi-time™.

Saisie alphabétique : permet de composer une musique à partir du clavier, en utilisant

essentiellement les lettres A–G ainsi que le pavé numérique. Cf. Saisie en mode pas-à-pas,

Saisie à la souris, Flexi-time™.

Saisie en mode pas-à-pas : saisie de notes et d’accords à partir de la spécification de hauteurs

sur un clavier MIDI et de valeurs de notes, etc., sur le pavé. b Flexi-time™, saisie
alphabétique, saisie à la souris.

Saisie en temps réel : saisie musicale sur un clavier MIDI à partir d’un clic pour indiquer les

rythmes utilisés, ainsi que les différentes hauteurs. La méthode de saisie en temps réel de Sibelius

est appelée Flexi-time™.

Saut de page : résiliation forcée d’une page au niveau d’une barre de mesure spécifique,

généralement à la fin d’une section, ou pour éviter des tournes de page indésirables dans

certaines parties. b Saut de système.

Saut de système : résiliation forcée d’un système au niveau d’une unité de mesure spécifique,

située généralement à la fin d’un passage musical. b Saut des page.

Sauts : Cf. Sauts de page, Sauts de système.

Section : sous-division d’une partition, telle qu’une chanson d’un album ou encore un

mouvement d’une symphonie. Les nouvelles sections commencent généralement par un nouveau

titre ainsi que par l’énumération des noms d’instruments complets. Les numéros de mesure

peuvent parfois redémarrer à 1, et les repères de répétition à A ou 1.

Sélection : tout ce qui est sélectionné. Une seule sélection correspond à la sélection d’un seul

objet ; une sélection multiple correspond à la sélection de deux objets ou plus. Cf. Passage.
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Sélectionner : permet de cliquer sur un ou plusieurs objets ou encore un passage à modifier,

copier, déplacer, ou encore supprimer. L’élément sélectionné apparaîtra en couleur. La couleur

indique dans quelle voix l’objet se trouve ou encore s’il s’agit d’un objet de système.

Séparateurs de système : doubles lignes diagonales épaisses tracées entre les systèmes de

longues partitions, de manière à insister sur les endroits où il figure plus d’un système par page.

Séquenceur : programme informatique surtout conçu pour enregistrer, modifier ou encore

exécuter un morceau de musique sous MIDI. La plupart des séquenceurs peuvent également

imprimer, si nécessaire, des notations. Toutefois, dans la mesure où ils sont à l’origine davantage

conçus pour une utilisation MIDI plutôt que pour les notations, ils diffèrent de fait nettement des

véritables programmes de notation musicaux. De nombreux séquenceurs peuvent également

enregistrer et modifier des morceaux audio, comme des passages chantés par exemple, en plus de

MIDI.

Sérif : pointe située au niveau des coins et des extrémités des lettres de certaines polices, appelées

polices à sérif. Les polices à sérif sont généralement plus lisibles que les polices sans sérif et donc

plus adaptées pour d’importantes quantités de texte, comme les livres par exemple.

Son ID : nom structuré décrivant un son particulier, comme woodwind.flutes.flute,

woodwind.flutes.piccolo.flutter-tongue ou encore strings.violin.ensemble.pizzicato.

Un ensemble de sons ID constitue un SoundWorld.

Sortie (numérisation) : musique lue à partir de numérisations.

Soufflet : crescendo ou diminuendo représenté sous la forme de deux crochets réunis.

Soundfont : ensemble de sons échantillonnés, qui existent généralement dans un ou deux

formats (SF2 et DLS). Conçus à l’origine pour modifier les sons existants sur les cartes-son de

certains fournisseurs, les soundfonts peuvent désormais être utilisés sans carte-son spécifique, en

les chargeant normalement dans un instrument virtuel.

SoundWorld : standard conçu par Sibelius Software pour remplacer le patchwork confus des

noms et numéros de programmes utilisés par les périphériques MIDI et instruments
virtuels. Le terme SoundWorld est employé pour désigner un ensemble de sons ID, organisés en

arborescence. 

Style de texte : indique, dans chaque partie du texte d’une partition, la police, la taille, le

positionnement, etc. Il existe un style différent pour chaque utilisation de texte : les nuances �mp
par exemple) sont exprimées dans le style Expression.

Style maison : “vue” d’ensemble d’une partition, telle qu’elle est définie par un éditeur ; dans

Sibelius, le style maison est principalement déterminé par les éléments qui composent le menu

Style maison, qui comprend notamment, les règles de gravures, les styles de texte, les

types de ligne ou encore de tête de note.

Symbole : objet de forme fixe pouvant être placé n’importe où sur une partition, et utilisé pour

des objets divers, comme les ornements ou les symboles de percussion. Les symboles sont

personnalisables : ils peuvent prendre la forme de n’importe quelle police, ou encore être un

composite d’un nombre de symboles déjà existants.
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Symbole d’accord : texte situé au-dessus d’une portée précisant un accord à jouer ou un accord

à partir duquel l’interprète pourra improviser, par exemple : Sibm (Si bémol mineur). Les

symboles d’accord peuvent également comprendre des diagrammes d’accord de guitare, qui vous

indiquent graphiquement la manière dont peut être jouée une voix partiuclière d’un accord sur

une guitare.

Synthèse : production de sons par des moyens mathématiques.

Système : ensemble de portées exécutées simultanément et généralement jointes sur la gauche

par une barre de mesure initiale. La musique pour instrument solo est généralement écrite

sur une seule et même portée. Dans ce cas, les termes de “système” et “portée” renvoient à la même

notion.

Tab : (a) tablature de guitare (abréviation de “tablature”) : notation à travers laquelle les lignes de

portée représentent les cordes de guitare, et les numéros des frettes indiquent où placer les doigts.

(b) un ou plusieurs des boutons en haut d’une boîte de dialogue qui permet(tent) de basculer entre

différentes pages d’options. Le pavé comprend également six tablatures qui permettent de

choisir différents agencements de celui-ci.

Table de mixage : fenêtre dans Sibelius permettant d’ajuster le volume, la position
panoramique ou encore de couper le son d’une portée.

Taille de la portée : hauteur d’une portée de cinq lignes, mesurée entre le milieu des lignes

supérieure et inférieure. La taille de chacun des éléments d’une portée (notes, lignes, texte et tous

les autres objets) est proportionnelle à la taille de la portée elle-même. Par définition, la taille d’une

portée équivaut à 4 espaces.

Taille du point : hauteur d’une police, mesurée à partir du sommet des majuscules jusqu’au pied

des lettres minuscules descendantes (comme le p par exemple). Cette hauteur est indiquée en

points (1 point ou pt ≈ 0,353mm).

Tête de note : élément plutôt rond, ou de toute autre forme (ex : en forme de croix ou en

losange) dans une note ou un accord, chargé de définir la hauteur ou la valeur de note, voire

parfois la technique de jeu.

TIFF (Tagged Image File Format)  : format standard d’images bitmap.

Touche de contrôle : technique utilisée par beaucoup d’instruments virtuels. Lorsqu’une

note est trop basse pour produire un son lorsqu’elle est jouée, l’instrument virtuel sait qu’il doit

utiliser un son différent pour les notes suivantes dans la tessiture normale.

TWAIN : norme de communication utilisée entre les programmes et les scanners. Analogue aux

normes MIDI.

Voix : série de notes, accords et silences dans une succession rythmique sur une portée (parfois

connue sous le terme de “couche”, ou encore “partie” ou “ligne”). En temps normal, une portée ne

compte qu’une seule voix. Dans ce cas, les hampes peuvent être orientées vers le haut ou vers le bas

en fonction de la hauteur des notes.

Toutefois, une seule et même portée peut comprendre deux voix, lorsque deux rythmes

indépendants nécessitent d’être indiqués séparément. Les voix sont différenciées par la direction
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des hampes : ainsi, les notes de la voix 1 et des accords provoquent l’inclinaison vers le haut des

hampes, tandis que la voix 2 provoque l’inclinaison des hampes vers le bas.

En guitare et (parfois) au clavier, il est possible d’utiliser une troisième ainsi qu’une quatrième voix.

Avec ces deux voix supplémentaires, les hampes pourront également être orientées vers le haut ou

vers le bas.

Lors de la sélection d’une note ou de tout autre objet, la couleur de sélection indiquera la voix dont

il est question.

USB (Universal Serial Bus) : la plupart des ordinateurs modernes possèdent deux ports USB ou

plus pour permettre de relier un grand nombre de périphériques, y compris des imprimantes et

des périphériques MIDI.

Valeur de note : longueur d’une note, d’un accord ou d’un silence, ex : croche, demi-note

(blanche).

Vélocité en MIDI : vitesse (et par conséquent force) à laquelle un bouton est pressé sur un clavier

MIDI, qui va permettre par la suite de déterminer le volume de cette note. (ce terme est également

utilisé fréquemment pour désigner la vitesse à laquelle un bouton est relâché, et déterminer ainsi

la vitesse à laquelle la note s’éteint.)

Vis-à-vis : format d’impression dans lequel deux pages à la suite l’une de l’autre sont imprimées

en vis-à-vis sur la même feuille de manière à avoir un aperçu de la partition finale mise à plat.

Volume en MIDI : volume général d’un canal MIDI, par opposition à la vélocité, qui

détermine le volume de notes individuelles.

VST (Virtual Studio Technology) : nom d’un format, inventé par Steinberg, pour les

instruments virtuels et les effets. Les instruments virtuels VST et les effets VST peuvent tous

deux être exécutés sur des ordinateurs Windows et Mac.
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Choral
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Convention de licence

Par le fait d’installer ou d’utiliser tout composant du Logiciel, ou d’enregistrer le Produit, vous (per-

sonne privée, ou entité légale) marquez votre accord, avec le Donneur de Licence, à être lié par les

termes de la présente Licence, qui régiront votre utilisation du Produit. Si vous n’acceptez pas ces

termes, vous pouvez, dans les 14 jours qui suivent l’achat, retourner le Produit, son emballage et sa

Documentation, non utilisés et intacts, à votre fournisseur, accompagnés de la preuve d’achat

datée, et obtenir un remboursement.

Le Produit est l’objet d’un Copyright © d’Avid Technology, Inc. et ses donneurs de licence 1987–

2009.

La présente convention de licence ne concerne pas Sibelius Internet Edition.

1. Définitions

Dans cette Licence les mots et expressions suivants ont la signification ci-après:

“Documentation”: le Guide Sibelius de l’Utilisateur, la Notice d’Aide Technique, l’aide à l’écran, et toute autre documentation ayant trait au

Logiciel qui vous est fourni, sous quelque forme que ce soit, par le donneur de licence, ou avec le Logiciel.

“Licence”: il s’agit de la présente convention entre vous et le Donneur de licence, et, si le contexte le permet, de la licence conditionnelle

qui vous est concédée dans la présente convention.

“Concédant” : Sibelius Software Limited, compagnie anglaise (enregistrement n°3338819) de la Old Toy Factory, 20-22 City North, Fonthill

Road, London N4 3HF, UK.

“Copie Réseau” : un Produit fourni pour être utilisé sur plusieurs terminaux informatiques d’un réseau.

“Produit”: le Logiciel et la Documentation.

“Copie Simple”: Produit fourni pour une utilisation sur un seul terminal informatique.

“Logiciel”: Sibelius pour Windows/Mac, Sibelius Scorch, Opus, Helsinki, Reprise les familles de polices Inkpen 2, fichiers musicaux

d’exemples, PhotoScore Lite, Kontakt Player Silver, installeurs, démonstrations d’autres logiciels, et tous autres programmes

ou fichiers qui vous sont fournis sur ou avec le CD-ROM Sibelius, ou par téléchargement.

“Licence multipostes isolés”: Un Produit fourni pour être utilisé sur plusieurs terminaux d’ordinateurs, non mis en réseau.

2. License

2.1(1) Le Donneur de licence vous concède une licence non-exclusive et non-cessible d’utiliser le Logiciel selon la Documentation, licence sujette aux

termes de toute offre, schème ou discount, éducationnels ou autres, selon lesquels le Produit aurait pu être obtenu. De plus les exemplaires pour

l’enseignement à prix réduits ne sont pas à usage commercial. Certains composants du logiciels sont sujets à des licences séparées et vous devez

obtenir l’autorisation de les utiliser

(2) Si le Produit est un Exemplaire Individuel, vous avez le droit d’installer le Logiciel sur un ordinateur individuel. Vous pouvez aussi installer un

second exemplaire sur un ordinateur additionnel, pourvu que vous vous engagez à être la seule personne qui utilisera le Logiciel sur l’un ou

l’autre de ces deux ordinateurs, et pour autant que le Logiciel ne soit jamais utilisé simultanément sur les deux ordinateurs 

(3) Si le Produit est une Licence multipostes isolés, vous ne pouvez faire usage du Logiciel qu’en tant qu’application hors réseau, et seulement sur

le nombre de terminaux d’ordinateurs autorisé par la Licence, et situés en un même lieu géographique.

(4) Si le Produit est un Exemplaire Réseau, vous ne pouvez installer le Logiciel que sur des ordinateurs d’un unique réseau, et situés en un même

lieu géographique (excepté si autorisé autrement par le Donneur de licence, par écrit), et vous ne pouvez pas l’utiliser davantage que pour le nom-

bre de terminaux d’ordinateurs autorisé par la Licence. Toute autre utilisation est interdite.

(5) Vous n’êtes pas titulaire du Produit. La propriété du Produit demeure attribuée au Donneur de licence et ses donneurs de licence, et sujette

aux droits qui vont sont concédés par la présente Licence. Tous autres droits sont réservés.

(6) Si le Logiciel a été fourni en tant que mise à jour d’une version précédente, vous retenez le contrat d’utilisation de l’ancienne version. L’utilisation

d’une version précédente fait l’objet d’accord de licence originaux. Comme stipulé dans la Section 6.2, les versions antérieures et actuelles du logiciel

ne sont pas cessibles.

2.2Vous pouvez faire une copie imprimée, pour votre propre usage, de toute partie de la Documentation fournie sous forme électronique. Il ne vous

est pas permis de faire, ou de permettre à un tiers de faire, toute autre copie supplémentaire de quelque partie que ce soit du Produit, ni pour lec-

ture par œil humain, ni pour lecture par machine.

2.3Il ne vous est pas permis d’effectuer vous-même ou de faire effectuer ou permettre d’effectuer par des tiers, la traduction, l’embellissement, la

modification, l’altération, l’adaptation ou la création de dérivés basés sur le Produit ou quelque partie que ce soit du Produit, dans quelque des-

sein que ce soit (y compris sans limitation le dessein de correction d’erreur), ni faire en sorte que l’entièreté ou toute partie du Produit soit com-
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biné avec, ou incorporé dans un autre programme, fichier, ou produit quel qu’il soit, et dans quelque but que ce soit, - excepté si la

Documentation le permet expressément.

2.4Il vous est interdit de faire, ou de faire faire ou permettre à des tiers, les opérations suivantes: décompilation, décodage, désassemblage, ou

reverse-engineering du Logiciel, en entier ou en partie, dans quelque but que ce soit.

2.5Il vous est interdit de faire, ou de faire faire ou permettre à des tiers, les opérations suivantes: traduction, conversion, décodage, ou reverse-engi-

neering, de tout fichier dans quelque version que ce soit des formats Sibelius ou Sibelius Scorch (que ce soit créé par votre exemplaire du Logiciel

ou non), ni non plus modification de tout fichier de ce genre (excepté par l’utilisation du Logiciel en accord avec la Documentation), en entier ou

en partie, dans quelque but que ce soit.

2.6En conformité avec la Documentation et pour autant que ce soit conforme avec la Section 2.1, l’élément “Sauvegarder comme page Scorch Web”

du Logiciel, ainsi que l’extension logicielle du Sibelius Scorch web browser, peuvent être utilisés pour publier des partitions musicales sur l’Inter-

net, ou au moyen de CD-ROM, de disquettes, ou autre moyen similaire, étant entendu toutefois que vous vous interdisez, et interdisez à tout tiers,

directement ou indirectement, de facturer ou de recevoir toute rémunération, tout payement ou autre rétribution, pour visionner, jouer,

imprimer ou autre usage, via Sibelius Scorch ou via l’Internet, tout fichier créé par le Logiciel (ou basé sur un fichier créé par le Logiciel), à moins

que la chose ne soit expressément permise par écrit par le Donneur de licence.

2.7Le Produit, ou toute partie du Produit, ne peut pas être utilisé pour enfreindre quelque droit que ce soit, en matière de copyright, de publicité, de

personnalité, de droit à la vie privée, et plus généralement tout droit quelconque de quelque personne ou entité que ce soit, y compris, sans limita-

tion, enfreindre tout droit que ce soit par l’utilisation du Produit en conjonction avec l’un ou l’autre des programmes de numérisation PhotoScore

Lite, PhotoScore MIDI, ou PhotoScore Professional, ou par l’utilisation des possibilités du Produit en matière d’édition sur Internet.

2.8 Le matériel pédagogique, les idées, le contenu, les fichiers de musique et les vidéos sont fournis avec le Produit uniquement dans le cadre d’une

utilisation privée ou scolaire dans votre institution avec vos étudiants. Il est interdit d’éditer ou de faire un usage commercial d’un extrait ou du

tout.

3. Copyright

3.1Vous acquiescez à ce que le Copyright sur le Produit, en son entier, et sur les composants du Produit, existant entre vous et le Donneur de licence,

appartient au Donneur de licence, ou à ses licenciés, et à ce qu’il est protégé par les lois sur le Copyright, nationales et internationales, et toutes

autres lois applicables. Des détails complémentaires sur la propriété de tout copyright relatif aux composants du Produit, sont exposés dans le

Produit.

4. Responsabilité du donneur de licence

4.1Le Donneur de licence garantit que le Produit est exempt de défectuosités tant dans ses matériaux que dans sa confection, et se comportera sub-

stantiellement en conformité avec la Documentation, ceci en utilisation normale, pendant une période de 90 jours à dater de l’achat original (la

“Période de Garantie”). Si un défaut dans le Produit apparaissait pendant la Période de Garantie, le Produit peut être renvoyé, avec la preuve

d’achat datée, au Donneur de licence qui, à sa discrétion, soit en remboursera le prix payé, soit le réparera ou le remplacera à ses frais.

4.2Le Donneur de licence ne sera pas responsable pour toute réclamation relevant de la liste suivante:

(1) tout manquement ou dysfonctionnement résultant en totalité, ou dans une proportion matérielle, de votre négligence, erreur d’opérateur,

utilisation autre qu’en conformité avec la Documentation, ou tout autre mauvais usage ou usage abusif du Produit;

(2) toute perte de données, ou corruption de données, quelles qu’en soient les causes, lorsque de telles pertes ou corruption de données auraient

pu être évitées ou corrigées ou substantiellement réduites, si vous aviez pris, et conservé en lieu sûr, des copies de backup appropriées;

(3) la décompilation ou modification du Logiciel ou sa fusion avec un autre programme, ou toute maintenance, réparation, ajustement, altération

ou embellissement du Logiciel par toute personne autre que le Donneur de licence ou son agent autorisé;

(4) le manquement par vous de prendre en considération les recommandations conseillées par le Donneur de licence au sujet de fautes dans le

Produit, ou de solutions vis-à-vis de fautes dans le Produit;

(5) toute perte ou dommage, quelle que ce soit, résultant d’omissions ou d’imprécisions dans toute information ou données contenues dans le

Produit.

(6) À l’exception de ce qui est par ailleurs expressément mentionné en Section 4.1, toutes conditions, garanties, objections aux clauses, explicites

ou implicites, statutaires ou autrement, ayant trait au Produit, sont par les présentes expressément exclues.

(7) À l’exception de ce qui est expressément mentionné en Section 4.1, le Donneur de licence n’aura aucune responsabilité vis-à-vis de vous en ce

qui concerne toute perte de profits, de revenus ou de goodwill, ou tout type de perte spéciale, indirecte ou consécutive (y compris perte ou dom-

mages encourus par vous en suite d’une action intentée par un tiers), que ladite perte soit causée par manquement par le Donneur de licence à

ses obligations contractuelles ici concernées, ou toute négligence ou autre acte dommageable ou omission.

(8) La responsabilité intégrale du Donneur de licence concernant les manquements à ses engagements et les garanties accordées par cette

Licence, et pour tout défaut ou erreur dans le Produit, sera (excepté ce qui est expressément mentionné en Section 4.1) limitée au montant du

prix payé par vous pour le Produit.
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5. Terme

5.1Cette Licence sera terminée automatiquement lors de la destruction du Produit. En outre le Donneur de licence peut décider de mettre fin à cette

Licence dans le cas d’un manquement matériel par vous à l’une ou l’autre condition de cette Licence ou de tout engagement, garantie, convention

ou obligation ici concernées. A la notification de cette décision de mettre fin à la Licence par le Donneur de licence, vous supprimerez immédi-

atement toutes copies du Logiciel de votre (vos) ordinateur(s) et détruirez toutes autres copies du Produit ou toutes parties desdites copies, et

retournerez le Produit au Donneur de licence

6. Divers

6.1Le fait par le Donneur de licence de manquer d’exercer un droit, pouvoir ou privilège, quels qu’ils soient, émanant des présentes, ne signifiera

jamais une renonciation à ceux-ci, et le fait de n’avoir exercé que d’une manière isolée ou partielle un des tels droits, pouvoir ou privilèges

n’exclura en aucune façon ou ultérieurement, de les exercer, ou d’exercer tout autre droit, pouvoir ou privilège. Les droits et recours du Donneur

de licence en relation avec ceci, n’excluent pas tout autre droit ou recours mis à disposition par la Loi.

6.2Vous ne pouvez pas distribuer, prêter, sous-licencier, louer, leaser (y compris, sans limitation, la mise en location ou le leasing d’un ordinateur sur

lequel le Produit est installé) ou transférer de quelque manière que ce soit, le Produit à un tiers, sans avoir au préalable le consentement écrit du

Donneur de licence, que ce dernier peut concéder, conditionner ou refuser à sa seule discrétion.

6.3Vous marquez votre accord pour l’utilisation de vos données personnelles selon la politique du Donneur de licence en matière de protection de

vie privée (texte disponible auprès du Donneur de licence ou sur www.sibelius.com) laquelle peut se modifier de temps à autre.

6.4Il est convenu entre les parties des présentes que cette Licence est bien l’expression finale de leurs conventions au sujet des matières qui y sont

traitées, et expriment de façon complète et exclusive les termes desdites conventions. Cette Licence remplace tout autre arrangement antérieur

quel qu’il soit, qu’il ait été écrit ou oral, entre vous et le Donneur de licence, relatif aux sujets des présentes.

6.5(Cette section ne s’applique que si vous êtes résident dans l’Union Européenne: ) Cette Licence sera régie et gouvernée par les lois d’Angle-terre,

et les deux parties sont d’accord pour soumettre les litiges à la juridiction exclusive des tribunaux anglais.

6.6(Cette section ne s’applique que si vous n’êtes pas résident dans l’Union Européenne: ) Les termes de cette Licence sont à interpréter et appliquer

selon, et régis par, les lois de l’Etat de Californie. Toute action en justice, assignation ou procès, émanant de, ou de quelque façon que ce soit, rela-

tifs ou en connexion avec la présente Licence, sera exclusivement portée à, et traitée par, la U.S. District Court for the Northern District of Califor-

nia, siégeant en la ville de San Francisco. Chacune des parties soumettra le cas irrévocablement, à la juridiction de ladite cour fédérale, en ce qui

concerne toute action en justice, poursuite ou procès. Chacune des parties renonce volontairement, irrévocablement et en connaissance de cause,

à un procès devant jury, en ce qui concerne toute action, poursuite ou procès (y compris toute contre-accusation) que ce soit par voie de justice

ou autrement, qui pourraient résulter d’une manière ou d’une autre de, ou être en relation avec, la présente Licence ou les matières dont elle

traite.

(License v6, 24 février 2009)
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